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Inleiding

Dit is de gebruikershandleiding voor de software voor het geografische informatiesysteem (GIS) QGIS. QGIS is
uitgebracht onder de GNU General Public Licentie. Meer informatie is beschikbaar op de thuispagina van QGIS
https://www.qgis.org.
De inhoud van dit document is geschreven en gecontroleerd met de beste kennis van auteurs en bewerkers. Toch
kunnen er fouten in voorkomen.
Daarom nemen de auteurs, redacteuren en uitgevers geen enkele verantwoordelĳkheid of aansprakelĳkheid voor
fouten in dit document en hun mogelĳke gevolgen. We raden u aan om mogelĳke fouten aan ons te rapporteren
Dit document is gemaakt met reStructuredText. De broncode in de vorm van reST broncode is beschikbaar op github
en via internet als HTML en PDF via https://www.qgis.org/en/docs/. Ook kunnen vertaalde versies van dit document
worden doorgebladerd en worden gedownload vanaf het documentatiegedeelte van het project QGIS.
Bezoek https://qgis.org/nl/site/getinvolved/index.html voor meer informatie over bĳdragen aan dit document en over
vertalingen.
Koppelingen in dit Document
Dit document bevat interne en externe koppelingen. Door een interne koppeling te selecteren zult u naar een ander
gedeelte van het document springen, bĳ het selecteren van een externe koppeling wordt een internetadres geopend.
Auteurs en redactie van de documentatie
De lĳst met personen die hebben bĳgedragen aan het schrĳven, nakĳken en vertalen van de volgende documentatie
is beschikbaar op Deelnemers.
Copyright (c) 2004 - 2020 QGIS Development Team
Internet: https://www.qgis.org
Licentie van dit of document
Iedereen heeft het recht om dit document te kopiëren, verspreiden en aan te passen onder de voorwaarden van de
GNU Free Documentation License, Version 1.3 of een latere versie gepubliceerd door de Free Software Foundation;
De Voor- en achterkant en de inhoudelĳke indeling van het document dient gelĳk te blĳven. Een kopie van de licentie
is toegevoegd in Appendix Appendix B: GNU Free Documentation License.
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1.1 Wat is er nieuw in QGIS 3.28

Deze uitgave van QGIS bevat honderden opgeloste fouten en veel nieuwe functionaliteit en verbeteringen, vergeleken
met QGIS 3.28. Bekĳk, voor een lĳst met nieuwe mogelĳkheden, het log met visuele wĳzigingen op https://qgis.org/
nl/site/forusers/visualchangelogs.html.
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Voorwoord

Welkom in de wondere wereld van Geografische Informatie Systemen (GIS)!
QGIS is een Open Bron Geografisch Informatie Systeem. Het project werd gestart in mei 2002 en werd als een project
gehuisvest op SourceForge in juni van datzelfde jaar.We hebben hard gewerkt omGIS-software (dat traditioneel dure
merkgebonden software is) beschikbaar te maken voor iedereen die toegang heeft tot een persoonlĳke computer.
QGIS kan momenteel worden uitgevoerd op de meeste Unix-platforms, Windows, en macOS. QGIS is ontwikkeld
met de Qt toolkit (https://www.qt.io) en C++. Dit betekent dat QGIS er fris uitziet en een prettige, gemakkelĳk-te-
gebruiken grafische gebruikersinterface (GUI) heeft. Er zĳn ook onafhankelĳk gemaakte toepassingen waarmee u
QGIS mee kan nemen in het veld. Deze toepassingen kunnen worden uitgevoerd op Android en iOS.
QGIS richt zich er op een gebruikersvriendelĳk GIS te zĳn dat algemene functies en mogelĳkheden bied. In het
begin was QGIS alleen voor het bekĳken van gegevens. QGIS heeft het punt in zĳn evolutie bereikt waarop het wordt
gebruikt voor het dagelĳks noodzakelĳk zichtbaar maken van gegevens voor GIS, voor het vastleggen van gegevens,
voor geavanceerd GIS-analyses, en voor presentaties in de vorm van geavanceerde kaarten, atlassen en rapporten.
QGIS ondersteunt een groot aantal indelingen voor raster- en vectorgegevens, waarbĳ nieuwe indelingen gemakkelĳk
kunnen worden toegevoegd met behulp van de architectuur voor plug-ins.
QGIS wordt uitgegeven onder de GNU Public License (GPL). Deze licentie staat iedereen toe om de broncode te
bekĳken en te bewerken en garandeert de vrĳe beschikbaarheid van GIS software die door iedereen kan worden
aangepast of uitgebreid. U zou een actuele versie van de licentie hebben moeten ontvangen met uw kopie van QGIS.
De licentie is ook te lezen in Appendix Appendix A: GNU General Public License.

Tip: Meest recente documentatie
De laatste versie van dit document kan altĳd gevonden worden in het gedeelte documentatie van de webpagina van
QGIS op https://www.qgis.org/nl/docs/
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Conventies

Hier worden een aantal uniforme stĳlen beschreven die gebruikt worden in deze handleiding.

3.1 Conventies GUI

De GUI stĳlen voor conventie zĳn bedoeld om de weergave in de GUI zo goed mogelĳk na te bootsen. Zo kan een
gebruiker binnen de toepassing van QGIS snel vinden wat er in de handleiding getoond wordt.

• Menu-opties: Kaartlagen ► Laag toevoegen ► Rasterlaag toevoegen… of Beeld ►Werkbalken ► Digitaliseren

• Knop in werkbalk: Rasterlaag toevoegen

• Knop: Opslaan als standaard

• Titel dialoogvenster: Laageigenschappen
• Tab: Algemeen

• Keuzevak: (Her)teken

• Optieknop: Postgis SRID EPSG ID

• Selecteer een numerieke waarde:

• Selecteer een alfanumerieke waarde:
• Bladeren naar een bestand:…

• Selecteer een kleur:

• Schuifbalk:

• Tekstinvoer:
Een schaduw geeft aan dat het om een aanklikbaar GUI-component gaat.
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3.2 Conventies tekst of toetsenbord

Deze handleiding bevat ook stĳlen voor teksten, sneltoetsen voor het toetsenbord en codes waarmee verschillende
zaken, zoals klassen en functies, worden aangegeven. Deze komt niet overeen met de werkelĳke weergave van tekst
of code binnen QGIS.

• Hyperlinks: https://qgis.org
• Toetsencombinaties: De sneltoets Ctrl+B betekent, houdt de Ctrl-toets ingedrukt en druk dan op de toets B.
• Bestandsnaam: lakes.shp
• Naam van een klasse: NewLayer
• Functie: classFactory
• Server: myhost.nl

• Invoer door gebruiker: qgis --help

Regels met programmacode worden getoond in een lettertype met vaste breedte:

PROJCS["NAD_1927_Albers",
GEOGCS["GCS_North_American_1927",

3.3 Platform-specifieke instructies

Reeksen voor de GUI en kleine stukken tekst mogen in de regel worden opgemaakt: Selecteer Bestand QGIS
► QGIS afsluiten. Dit betekent dat onder de besturingssystemen Linux, Unix en Windows, u eerst het menu Bestand
moet kiezen en daarna Afsluiten, maar onder macOS u eerst het menu QGIS opent en daarna Afsluiten.
Grotere teksten kunnen als lĳst zĳn opgemaakt:

• Doe dit
• Doe dat

• Of doe dat
of als alinea’s:

Doe dit en dit en dit. Doe daarna dit en dit en dit, en dit en dit en dit, en dit en dit en dit en dit.
Doe dat. Doe daarna dat en dat en dat, en dat en dat en dat, en dat en dat en dat, en dat en dat.

Schermvoorbeelden die in de handleiding voorkomen zĳn gemaakt op verschillende platforms.

6 Hoofdstuk 3. Conventies
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Functionaliteit

QGIS biedt een weelde aan functies voor GIS, verschaft door bronmogelĳkheden en plug-ins. De balk Lokaliseren
maakt het gemakkelĳk om te zoeken naar functies, gegevenssets en meer.
Een kort overzicht van zes algemene categorieën vanmogelĳkheden en plug-ins wordt hieronder weergegeven, gevolgd
door een eerste verkenning van de geïntegreerde console voor Python.

4.1 Gegevens bekijken

U kunt combinaties van vector- en rastergegevens (in 2D of 3D) in verschillende indelingen en projecties bekĳken,
zonder dat u deze eerst moet omzetten naar een interne of veelgebruikte indeling. Ondersteunde indelingen zĳn:

• Ruimtelĳke tabellen en weergaven met behulp van PostGIS, SpatiaLite en MS SQL Spatial, Oracle Spatial,
vectorindelingen ondersteund door de geïnstalleerde bibliotheek van OGR, waaronder ESRI Shapefile,
MapInfo, SDTS, GML en vele andere. Zie gedeelteWerken met vectorgegevens.

• Raster- en afbeeldingsindelingen ondersteund door de geïnstalleerde bibliotheek GDAL (Geospatial Data
Abstraction Library), waaronder GeoTiff, ERDAS IMG, ArcInfo ASCII GRID, JPEG, PNG en vele andere,
zie gedeelteWerken met rastergegevens.

• Gegevens voor mazen (TIN’s en normale rasters worden ondersteund). BekĳkWerken met gegevens met mazen.
• Vectortegels
• GRASS raster- en vectorindelingen vanuit databases van GRASS (location/mapset). Zie gedeelte Integratie van

GRASS GIS.
• Ruimtelĳke gegevens die als OGCWeb-services worden aangeboden, inclusief WMS, WMTS, WCS, WFS en
WFS-T. Zie gedeelteWerken met protocollen van OGC / ISO.
De infrastructuur voor authenticatie van QGIS helpt u gebruikersnaam/wachtwoord, certificaten en sleutels
voor web services en andere bronnen te beheren.

• Werkbladen (ODS / XLSX)
Gegevens met tĳden worden ondersteund.
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4.2 Bevragen van gegevens en het maken van kaarten

Men kan kaarten maken en interactief ruimtelĳke gegevens bevragen via een gebruiksvriendelĳke interface. Handige
gereedschappen die dit ondersteunen zĳn o.a.:

• QGIS Browser
• Gelĳktĳdige CRS-transformatie
• 2D- en 3D-kaarten renderen
• DB Manager
• Afdruklay-out
• Rapport
• Overzichtskaart
• Favoriete plaatsen (Spatial Bookmarks)
• Annotatie-gereedschappen
• Objecten identificeren/selecteren
• Attributen bewerken/bekĳken/zoeken
• Data-bepaald labelen van objecten
• Data-bepaalde vector en raster symbologie gereedschappen
• Atlas kaartcompositie met gridlĳnen als laag
• Noordpĳl, schaalbalk en Label copyright voor kaarten
• Ondersteuning voor het opslaan en weer inladen van projecten

4.3 Gegevens maken, bewerken, beheren en exporteren

U kunt vector- en rasterlagen aanmaken, bewerken, onderhouden en exporteren in en naar verschillende indelingen.
QGIS biedt o.a. het volgende:

• Gereedschap voor digitaliseren van vectors
• Mogelĳkheid om meerdere bestandsindelingen en vectorlagen voor GRASS te maken en te bewerken
• Gereedschap Georeferencer voor het geocoderen van vectors en afbeeldingen
• GPS tools om van/naar GPX formaat te importeren/exporteren en converteren van andere GPS-indelingen
naar GPX of direct down-/uploaden naar GPS-apparaten. (onder Linux is usb: toegevoegd aan de lĳst van
GPS-apparaten)

• Ondersteuning voor bekĳken en bewerken van gegevens van OpenStreetMap
• Mogelĳkheid om ruimtelĳke databasetabellen vanuit bestanden aan te maken met de plug-in DB Manager
• Verbeterde ondersteuning van ruimtelĳke databasetabellen
• Gereedschap voor het beheren van vector-attributentabellen
• Optie om schermafdrukken als afbeeldingen met geoverwĳzingen op te slaan
• Gereedschap DXF-Export met verbeterde mogelĳkheden om stĳlen en plug-ins te exporteren omCAD-achtige
functies uit te voeren

8 Hoofdstuk 4. Functionaliteit
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4.4 Gegevens analyseren

Ukunt ruimtelĳke gegevensanalyses uitvoeren op ruimtelĳke databases en andere doorOGRondersteunde indelingen.
QGIS biedt momenteel gereedschap voor vectoranalyse, rasteranalyse, sampling, geo-processing, geometrie en
databasebeheer. Men kan ook de geïntegreerde gereedschappen voor GRASS gebruiken, die de volledige set vanmeer
dan 400 modules aan functionaliteit van GRASS bevat (zie gedeelte Integratie van GRASS GIS). Of u kunt werken
met de plug-in Processing die QGIS voorziet van een krachtig geo-ruimtelĳk framewerk voor analyse waarmee eigen
algoritmes en algoritmes van derde partĳen kunnen worden aangeroepen vanuit QGIS zoals GDAL, SAGA, GRASS,
OTB, R. en meer. (zie gedeelte Introductie). Alle analysefuncties worden op de achtergrond uitgevoerd, wat u in staat
stelt door te gaan met uw werk voordat de verwerking is voltooid.
Grafische modellen bouwen stelt u in staat functies te combineren / achter elkaar uit te voeren in een volledige
werkstroom in een intuïtieve grafische omgeving.

4.5 Kaarten op het internet publiceren

QGIS kan gebruikt worden als cliënt voor WMS, WMTS, WMS-C, WFS, OAPIF en WFS-T (zie gedeelte Werken
met protocollen van OGC / ISO), en als QGIS Server (bekĳk QGIS-Server-manual) wat u in staat stelt uw gegevens
op het internet te publiceren via de protocollen WMS, WCS, WFS en OAPIF met een webserver.

4.6 Functionaliteit voor QGIS uitbreiden met plug-ins

QGIS kan aangepast worden aan uw speciale behoeften door gebruik te maken van de architectuur voor plug-ins en
functiebibliotheken waarmee u zelf plug-ins kunt maken. U kunt hiermee zelfs nieuwe toepassingen voor GIS maken
met C++ of Python!

4.6.1 Bronplug-ins

Bronplug-ins zĳn:
1. DBManager (voor het uitwisselen, bewerken en bekĳken van kaarten en tabellen van/naar databases; uitvoeren

van query’s van SQL)
2. Geometrie controleren (geometrieën controleren op fouten)
3. Georeferencer GDAL (Het toevoegen van een geoverwĳzing aan rasterkaarten m.b.v. GDAL)
4. GPS-gereedschap (Laden en importeren van GPS-gegevens)
5. GRASS (GRASS GIS integreren)
6. MetaSearch Catalogue Client (interactief werken met metadata catalogus services, die de standaard OGC

Catalog Service voor het web (CSW) ondersteunen)
7. Offline bewerken (Offline wĳzigen en synchroniseren met database toestaan)
8. Processing (het framewerk voor verwerken van ruimtelĳke gegevens voor QGIS)
9. Topologie Checker (Topologische fouten zoeken in vectorlagen)

4.4. Gegevens analyseren 9
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4.6.2 Externe plug-ins voor Python

QGIS biedt een groeiend aantal externe plug-ins voor Python, die worden aangeboden door gebruikers, waarmee de
functionaliteit van QGIS uitgebreid kan worden. Deze plug-ins zĳn aanwezig in de officiële opslagplaats voor plug-ins
en deze kunnen erg eenvoudig worden gevonden en geïnstalleerd via Plug-ins beheren en installeren. Zie gedeelte Het
dialoogvenster Plug-ins.

4.7 Python-console

Maak, om scripts te schrĳven, gebruik van de geïntegreerde console voor Python, die kan worden geopend met:
Plug-ins► Python-console. De console opent als een niet-modaal venster voor gebruik. Voor directe interactie met de
omgeving van QGIS, is er de variabele qgis.utils.iface die een instantie is van de klasse QgsInterface.
Deze interface verschaft toegang tot het kaartvenster, menu’s, werkbalken en andere onderdelen van de toepassing
QGIS. U kunt een script maken, dat dan slepen en laten vallen in het venster van QGIS, waarna het automatisch zal
worden uitgevoerd.
Voor meer informatie over het werken met de console voor Python en het programmeren van plug-ins en toepassingen
voor QGIS, bekĳk dan QGIS Python-console en PyQGIS-Developer-Cookbook.

4.8 Bekende problemen

4.8.1 Beperking van aantal geopende bestanden

Wanneer u een project van QGIS met veel lagen opent en u weet zeker dat alle kaartlagen goed zĳn, maar voor enkele
lagen wordt aangegeven dat deze niet goed zĳn, dan heeft u te maken met dit probleem. Voor Linux (en andere
besturingssystemen) is er een limiet voor het aantal bestanden dat tegelĳkertĳd geopend kan worden voor een proces.
Via overerving geldt deze beperking voor elk proces. Met de shell-opdracht “limit” kan deze limiet worden gewĳzigd
voor het huidige shell proces; die limiet zal worden overgedragen op elk proces dat vervolgens wordt gestart binnen
de shell.
U kunt de huidige informatie over ulimit bekĳken met de volgende opdracht:

$ ulimit -aS

U kunt het huidige aantal toegestane aantal geopende bestanden per proces zien met de volgende opdracht in een
console:

$ ulimit -Sn

Om de limiet voor een bestaande sessie te veranderen, kunt u een opdracht geven als:

$ ulimit -Sn #number_of_allowed_open_files
$ ulimit -Sn
$ qgis

Als alternatief kunt u de nieuwere mogelĳkheid prlimit gebruiken. Meer informatie: https://manpages.ubuntu.
com/manpages/latest/man1/prlimit.1.html
Repareren voor altĳd
Op de meeste Linux-systemen worden bronbeperkingen tĳdens het inloggen ingesteld door de module “pam_limits”
volgens de instellingen die zĳn opgeslagen in het bestand /etc/security/limits.d/*.conf. Wanneer
u beheerdersrechten heeft (root/sudo), kunt u dit configuratiebestand wĳzigen, de limiet verhogen, en vervolgens
opnieuw inloggen om te kĳken of dit het probleem oplost.
Meer informatie:
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Beginnen

Dit hoofdstuk verschaft een snel overzicht van het installeren van QGIS, voorbeeldgegevens van QGIS die gedownload
kunnen worden en een eerste eenvoudige sessie waarbĳ raster- en vectorlagen zichtbaar worden gemaakt.

5.1 QGIS installeren

Het project QGIS verschaft verschillende manieren om QGIS te installeren, afhankelĳk van uw platform.

5.1.1 Installeren vanuit binaries

Standaard installatiepakketten zĳn beschikbaar voor MSWindows en macOS. Binaire pakketten (rpm en deb)
of opslagplaatsen van software worden verschaft voor vele smaken van GNU/Linux .
Bekĳk, voor meer informatie en instructies voor uw besturingssysteem, https://download.qgis.org.

5.1.2 Installeren vanuit broncode

Wanneer u QGIS moet bouwen vanuit de bron, bekĳk dan de instructies voor het installeren. Zĳ worden verspreid
met de broncode van QGIS in het bestand genaamd INSTALL. U kunt ze ook online vinden op https://github.com/
qgis/QGIS/blob/release-3_28/INSTALL.md.
Als u een bepaalde uitgave wilt bouwen en niet de versie die in ontwikkeling is, zou u master moeten vervangen
door de branch van de uitgave (gewoonlĳk in de vormrelease-X_Y) in de bovenstaande link (Installatie-instructies
zouden kunnen verschillen).
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5.1.3 Installatie op een extern medium

Het is mogelĳk QGIS (met alle plug-ins en instellingen) te installeren op een flash drive. Dat kan worden gedaan
door een optie –profiles-path te definiëren die het standaard pad voor het gebruikersprofiel overschrĳft enQSettings
forceert om deze map ook te gebruiken. Bekĳk het gedeelte Systeeminstellingen voor aanvullende informatie.

5.1.4 Voorbeeldgegevens downloaden

Deze gebruikershandleiding bevat voorbeelden die zĳn gebaseerd op de QGIS voorbeeldgegevensset (ook
wel de Alaska dataset genoemd). Download de voorbeeldgegevens vanaf https://github.com/qgis/
QGIS-Sample-Data/archive/master.zip en pak het archief uit op een voor u handige locatie op uw systeem.
De gegevensset Alaska bevat alle GIS-gegevens die worden gebruikt in de voorbeelden en in de schermafdrukken van
deze gebruikershandleiding; het bevat ook een kleine database van GRASS. De gebruikte projectie voor de QGIS
voorbeeld gegevenssets is Alaska Albers Equal Area met als lengte-eenheid de Engelse lengtemaat feet. De EPSG-
code is 2964.

PROJCS["Albers Equal Area",
GEOGCS["NAD27",
DATUM["North_American_Datum_1927",
SPHEROID["Clarke 1866",6378206.4,294.978698213898,
AUTHORITY["EPSG","7008"]],
TOWGS84[-3,142,183,0,0,0,0],
AUTHORITY["EPSG","6267"]],
PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],
UNIT["degree",0.0174532925199433,
AUTHORITY["EPSG","9108"]],
AUTHORITY["EPSG","4267"]],
PROJECTION["Albers_Conic_Equal_Area"],
PARAMETER["standard_parallel_1",55],
PARAMETER["standard_parallel_2",65],
PARAMETER["latitude_of_center",50],
PARAMETER["longitude_of_center",-154],
PARAMETER["false_easting",0],
PARAMETER["false_northing",0],
UNIT["us_survey_feet",0.3048006096012192]]

Wanneer u QGIS wilt gebruiken als de grafische gebruikersinterface om te werken met databases van GRASS, kunt
u een selectie van voorbeeld-locations (Spearfish of South Dakota) vinden op de officiële website van het GRASS
GIS, https://grass.osgeo.org/download/data/.

5.2 Starten en afsluiten van QGIS

QGIS kan worden gestart zoals elke toepassing op uw computer. Dat betekent dat u QGIS kunt starten door:

• het menu Applications, het menu Start of het Dock te gebruiken
• dubbel te klikken op het pictogram van QGIS in de map Applications of op de koppeling op het Bureaublad
• dubbel te klikken op een bestaand projectbestand van QGIS (met de extensie .qgz of .qgs). Onthoud dat
dit ook het project zal openen.

• qgis te typen in de prompt voor de opdrachtregel (er van uit gaande dat QGIS is toegevoegd aan uw PATH
of dat u in de map van de installatie staat)

Gebruik, om QGIS af te sluiten:

• de menuoptie Project ► QGIS afsluiten of gebruik de sneltoets Ctrl+Q
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• QGIS ► Quit QGIS, of gebruik de sneltoets Cmd+Q
• of gebruik het rode kruis in de rechterbovenhoek van het hoofdvenster van de toepassing.

5.3 Voorbeeld sessie: Raster- en vectorlagen laden

Nu u QGIS hebt geïnstalleerd en een voorbeeld gegevensset beschikbaar hebt, zullen we een eerste voorbeeldsessie
demonstreren. In dit voorbeeld zullen we een raster- en vectorlaag zichtbaar maken. We zullen gebruiken:

• de rasterlaag landcover (qgis_sample_data/raster/landcover.img)
• en de vectorlaag lakes (qgis_sample_data/gml/lakes.gml)

Waar qgis_sample_data het pad naar de uitgepakte gegevensset weergeeft.
1. Start QGIS zoals te zien is in Starten en afsluiten van QGIS.
2. De gegevens waarmee we zullen werken zĳn in het Albers Equal Area, dus laten we het project-CRS

overeenkomstig instellen:

1. Klik op de knop Projectie selecteren aan de rechteronderzĳde van de interface van QGIS. Het
dialoogvenster voor de project-eigenschappen opent met de tab CRS actief.

2. Typ ̀`2964` in het tekstgebied Filter.
3. Selecteer de rĳ met de naam NAD27 / Alaska Albers voor het CRS.

5.3. Voorbeeld sessie: Raster- en vectorlagen laden 15
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Fig. 5.1: Het Coördinaten ReferentieSysteem voor de gegevens selecteren

4. Klik op OK

Notitie: U kunt voor nu het bericht met de “ballpark transform”, die zou kunnen worden weergegeven,
negeren/sluiten.

3. Laad de bestanden in QGIS:

1. Klik op het pictogram Databronnen beheren openen. Databronnen beheren zou moeten openen in de modus
Browser.

2. Blader naar de map qgis_sample_data/raster/

3. Selecteer het ERDAS IMG-bestand landcover.img en dubbelklik er op. De laag landcover wordt op
de achtergrond toegevoegd terwĳl het venster van Databronnen beheren geopend blĳft.
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Fig. 5.2: Gegevens toevoegen aan een nieuw project in QGIS

4. Blader, om de gegevens voor de meren te laden, naar de map qgis_sample_data/gml/ en sleep
het bestand lakes.gml op het hoofdvenster van QGIS en zet het neer. (Of dubbelklik er eenvoudigweg
op, zoals hierboven vermeld.)

5. Het dialoogvenster Toe te voegen items selecteren opent en scant het bestand. Dit vanwege het feit dat de
bestandsindeling .gml in staat is om meer dan één laag per keer op te slaan.

5.3. Voorbeeld sessie: Raster- en vectorlagen laden 17
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Fig. 5.3: Lagen in een bestand selecteren

6. In ons geval is er slechts één enkele laag lakes. Selecteer die en druk op Lagen toevoegen.
7. De laag is toegevoegd aan het paneel Lagen

4. Sluit het dialoogvenster Databronnen beheren

In het paneel Lagen zou u kunnen zien dat de laag lakes weergeeft: Laag heeft nog geen Coördinaten ReferentieSysteem ingesteld

ernaast. Laten we dat aanpassen.

1. Klik op het pictogram . Het dialoogvenster CRS selecteren opent.
2. Selecteer, net zoals eerder, het item NAD27 / Alaska Albers

3. Klik op OK

U heeft nu twee lagen beschikbaar in uw project in enkele willekeurige kleuren. Laten we wat aanpassingen doen op
de laag lakes.

1. Selecteer het gereedschap Inzoomen op de werkbalk Navigatie

2. Zoom in op een gebied met enkele meren.
3. Dubbelklik op de laag lakes in de legenda van de kaart om het dialoogvenster Laageigenschappen te openen
4. Wĳzigen van de kleuren van de meren:

1. Klik op de tab Symbologie

2. Selecteer blauw als vulkleur.

18 Hoofdstuk 5. Beginnen



QGIS Desktop 3.28 User Guide

Fig. 5.4: Kleur voor meren selecteren

3. Druk op OK. Meren worden nu blauw weergegeven in het kaartvenster.
5. De namen van de meren weergeven:

1. Open het dialoogvenster Laageigenschappen van de laag lakes opnieuw
2. Klik op de tab Labels

3. Selecteer Enkele labels in het keuzemenu om labelen in te schakelen.
4. Kies het veld NAMES uit de lĳst Labelen met.
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Fig. 5.5: Namen van meren weergeven

5. Druk op Apply. Namen zullen nu over de grenzen worden geladen.
6. U kunt de leesbaarheid van de labels vergroten door er een witte buffer omheen toe te voegen:

1. Klik op de tab Buffer in de lĳst aan de linkerkant

2. Selecteer Teken tekstbuffer

3. Kies 3 als grootte voor de buffer
4. Klik op Apply

5. Controleer of het resultaat er goed uitziet en werk de waarde bĳ indien nodig.
6. Klik tenslotte opOK om het dialoogvenster Laageigenschappen te sluiten en dewĳzigingen door te voeren.

20 Hoofdstuk 5. Beginnen



QGIS Desktop 3.28 User Guide

Fig. 5.6: Buffers rond labels weergeven

Laten we nu nog enkele decoraties toevoegen om de kaart vorm te geven en die uit QGIS te exporteren:
1. Selecteer het menu Beeld ► Decoraties ► Schaalbalk

2. Selecteer, in het dialoogvenster dat opent, de optie Schaalbalk inschakelen

3. Pas de opties in het dialoogvenster aan zoals u dat wilt
4. Druk op Apply

5. Voeg op dezelfde wĳze, vanuit het menu Decoraties, meer items (noordpĳl, copyright…) met aangepaste
eigenschappen toe aan het kaartvenster.

6. Klik op Project ► Importeren/Exporteren ► Kaart als afbeelding exporteren…

7. Druk op Save in het geopende dialoogvenster
8. Selecteer een locatie voor het bestand, een indeling en bevestig die door opnieuw op Opslaan te drukken.

9. Druk op Project ► Opslaan… om uw wĳzigingen op te slaan als een projectbestand .qgz.

5.3. Voorbeeld sessie: Raster- en vectorlagen laden 21



QGIS Desktop 3.28 User Guide

Fig. 5.7: Geëxporteerde kaart met decoraties weergeven

Dat is alles! U ziet hoe eenvoudig het is om raster- en vectorgegevens weer te geven in QGIS, ze te configureren en
uw kaart te maken in een indeling voor afbeeldingen die u in andere software kunt gebruiken. Laten we verder gaan
naar de volgende gedeelten om meer te leren over de beschikbare functionaliteiten, mogelĳkheden en instellingen en
hoe deze te gebruiken.

Notitie: Volg de Trainingshandleiding om door te gaan met het leren gebruiken van QGIS door stap-voor-stap
oefeningen.
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Werken met projectbestanden

6.1 Introductie van projecten van QGIS

De status van uw sessie voor QGIS wordt een project genoemd. QGIS werkt op één project per keer. Een instelling
kan project-specifiek zĳn of een toepassingsbrede standaard voor nieuwe projecten (zie het gedeelte Opties). QGIS
kan de status van uw werkruimte opslaan in een QGIS projectbestand met de menuopties Project ► Opslaan of
Project ► Opslaan als….

Notitie: Als het project is aangepast zal het symbool * worden weergegeven in de titelbalk en zal QGIS, standaard,
vragen of u de wĳzigingen wilt bewaren. Dat gedrag wordt beheerd door de instelling Vraag om het project en
wĳzigingen in brondata op te slaan indien nodig onder Extra ► Opties ► Algemeen.

U kunt bestaande projecten laden in QGIS vanuit het paneel Browser of via Project► Openen…, Project►Nieuw
uit sjabloon of Project ► Recent geopend ►.
Bĳ het opstarten zal een lĳst met Projectsjablonen en Recente projecten worden weergegeven, inclusief
schermafdrukken, namen en bestandspaden (voor maximaal tien projecten). De lĳst Recente projecten is handig om
toegang te verkrĳgen tot recent gebruikte projecten. Dubbelklik op een item om het project of projectsjabloon te
openen. Klik met rechts op een item voor Vastzetten in Lĳst, Map openen… of Verwĳderen uit Lĳst. U kunt ook een
laag toevoegen om automatisch een nieuw project te maken. De lĳsten zullen dan verdwĳnen om ruimte te maken
voor het kaartvenster.

Ga naar Project► Nieuw als u de huidige sessie wilt opschonen en met een nieuwe wilt beginnen. Dit zal met de
vraag komen of u het bestaande project wilt opslaan wanneer er wĳzigingen zĳn geweest sinds de laatste keer dat het
werd geopend of voor het laatst werd opgeslagen.
Wanneer u een nieuw project opent, zal de titelbalk Naamloos project weergeven, totdat u het opslaat.
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Fig. 6.1: Een nieuw project in QGIS beginnen.

De informatie die wordt opgeslagen in een projectbestand omvat:
• De toegevoegde lagen
• Welke lagen kunnen worden bevraagd
• De eigenschappen van de laag, inclusief symbologie en stĳlen
• Opmerkingen laag
• 2D- en 3D-kaarten weergaven
• Projectie voor elke weergave van de kaart
• Laatste bereik van weergave voor elke kaart
• Afdruklay-outs
• Elementen van afdruklay-out met instellingen
• Instellingen voor atlas van afdruklay-out
• Instellingen voor digitaliseren
• Relaties voor tabellen
• Projectmacro’s
• Standaardstĳlen voor project
• Instellingen voor plug-ins
• Instellingen voor QGIS Server van de tab QGIS Server in de Projecteigenschappen
• Opgeslagen query’s in DB Manager

Het projectbestand wordt opgeslagen in de indeling XML (zie QGS/QGZ - De QGIS indeling voor projectbestand).
Dat betekent dat het mogelĳk is het bestand buiten QGIS te bewerken als u weet wat u doet. De indeling van het

24 Hoofdstuk 6. Werken met projectbestanden



QGIS Desktop 3.28 User Guide

projectbestand is verschillende malen opgewaardeerd. Projectbestanden uit oudere versies van QGIS zouden niet
meer correct kunnen werken.

Notitie: Standaard zal QGIS u waarschuwen over verschillen tussen versies. Dit gedrag wordt beheerd op de tab
Algemeen van Extra ► Opties ( Geef een waarschuwing bĳ het openen van een projectbestand uit een oudere versie
van QGIS).

Iedere keer als u een projectbestand .qgs opslaat in QGIS, wordt een back-up van het bestand gemaakt in dezelfde
map als het projectbestand, met de extensie .qgs~.
De extensie voor projecten van QGIS is .qgs, maar indien het wordt opgeslagen vanuit QGIS is de standaard om op
te slaan een gecomprimeerde indeling met de extensie .qgz. Het bestand .qgs wordt ingebed in het bestand .qgz
(een ZIP-archief), samen met de daaraan geassocieerde database van SQLite (.qgd) voor hulpgegevens. U kunt bĳ
deze bestanden komen door het bestand .qgz uit te pakken.

Notitie: Het mechanisme Eigenschappen Hulpopslag maakt een gecomprimeerd project bĳzonder nuttig, omdat het
hulpgegevens inbedt.

Projecten kunnen ook worden opgeslagen/geladen in/uit een database van PostgreSQL, GeoPackage of Oracle met
de volgende items van het menu Project:

• Project ► Openen vanuit

• Project ► Opslaan naar

Beide menu-items hebben een submenu met een lĳst van extra implementaties voor opslaan van een project
(PostgreSQL, GeoPackage en Oracle). Klikken op de actie zal een dialoogvenster openen om een verbinding voor
GeoPackage en een project te kiezen of een verbinding naar PostgreSQL, schema en project of verbinding, eigenaar
en project naar Oracle.
In GeoPackage, PostgreSQL of Oracle opgeslagen projecten kunnen ook worden geladen vanuit het paneel Browser
van QGIS, door te dubbelklikken op de naam of door het te slepen en neer te zetten in het kaartvenster.

6.2 Afhandelen defecte bestandspaden

Bĳ het openen van een project zou QGIS kunnen falen in het bereiken van enkele databronnen wegens onbeschikbare
service/database, of vanwege een hernoemd of verplaatst bestand. QGIS opent dan het dialoogvensterNiet beschikbare
lagen afhandelen dat verwĳst naar de niet gevonden lagen. U kunt:

• Dubbelklik in het veld Databron, pas het pad naar elke laag aan en klik opWĳzigingen toepassen;
• Selecteer een rĳ, druk op Bladeren om de juiste locatie aan te geven en klik opWĳzigingen toepassen;
• Druk op Auto-zoeken om door de mappen te bladeren en automatisch te proberen alle of geselecteerde
verbroken pad(en) te repareren.Weet dat het bladeren enige tĳd kan vergen. Klik dan opWĳzigingen yoepassen.

• Negeer het bericht en open uw project met de/het verbroken pad(en) door te klikken op Niet beschikbare
lagen behouden. Uw laag wordt dan weergegeven in het paneel Lagen, maar zonder gegevens totdat u het pad
repareert met het pictogram Niet beschikbare laag! ernaast in het paneel Lagen, of Databron repareren… in he
contextmenu van de laag.
Met het gereedschapDatabron repareren…, als een pad voor een laag eenmaal is gerepareerd, scant QGIS door
alle foutieve paden en probeert automatisch die te repareren die hetzelfde foutieve pad hebben.

• Niet beschikbare lagen verwĳderen uit het project.
Starten van QGIS van de opdrachtregel met de optie --skipbadlayers kan helpen het dialoogvenster Niet beschikbare
lagen afhandelen bĳ het opstarten over te slaan.

6.2. Afhandelen defecte bestandspaden 25



QGIS Desktop 3.28 User Guide

6.3 Uitvoer maken

Er zĳn verschillende manieren om uitvoer te maken vanuit uw sessie van QGIS. We hebben het opslaan als een
projectbestand al besproken in Introductie van projecten van QGIS. Andere manieren om uitvoerbestanden te maken
zĳn:

• Afbeeldingen maken: Project ► Importeren/Exporteren ► Kaart als afbeelding exporteren… voert het
kaartvenster uit en rendert het naar een indeling voor afbeeldingen (PNG, JPG, TIFF…) met aangepaste
schaal, resolutie en grootte. De geëxporteerde afbeelding voorzien van geoverwĳzingen is mogelĳk, schakel
eenvoudigweg Informatie voor geoverwĳzingen toevoegen (ingebed of via world file) in. Bekĳk De
kaartweergave exporteren voor meer details.

• Exporteren naar PDF-bestanden: Project ► Importeren/Exporteren ► Kaart als PDF exporteren… voert het
kaartvenster uit en rendert het naar PDFmet aangepaste schaal, resolutie, en met enkele gevorderde instellingen
(vereenvoudiging, geoverwĳzingen, …). Bekĳk De kaartweergave exporteren voor meer details.

• Exporteren naar DXF-bestanden: Project► Importeren/Exporteren► Exporteer project naar DXF… opent een
dialoogvenster waar u de ‘Symbologie modus’ kunt definiëren, de ‘Symbologie schaal’ en de vectorlagen die u
wilt exporteren naar DXF. Met de ‘Symbologie modus’, kunnen symbolen uit de originele QGIS Symbologie
worden geëxporteerd met hoge precisie (bekĳk het gedeelte Nieuwe DXF-bestanden maken).

• Kaarten ontwerpen: Project ► Nieuwe afdruklay-out… opent een dialoogvenster waar u het huidige
kaartvenster kunt opmaken en afdrukken (bekĳk het gedeelte De kaarten opmaken).
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Gebruikersinterface van QGIS

De grafische gebruikersinterface (GUI) van QGIS wordt weergegeven in de afbeelding hieronder (de nummers 1 tot
en met 5 in gele cirkels geven belangrĳke elementen van de GUI van QGIS aan, en worden hieronder besproken).

Fig. 7.1: Gebruikersinterface van QGIS met Alaska voorbeeld gegevensset

Notitie: De weergave van uw venster (titelbalk, etc) kan enigszins afwĳken, afhankelĳk van uw besturingssysteem
en vensterbeheer.

De hoofd-GUI van QGIS GUI (Fig. 7.1) bestaat uit vĳf componenten / typen componenten:
1. Menubalk

2. Werkbalken

3. Panelen

4. Kaartweergave
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5. Statusbalk

Scroll naar beneden voor gedetailleerde uitleg hiervan.

7.1 Menubalk

De Menubalk verschaft toegang tot functies van QGIS met standaard hiërarchische menu’s. De menu’s, hun opties,
geassocieerde pictogrammen en sneltoetsen voor het toetsenbord worden hieronder beschreven. De sneltoetsen voor
het toetsenbord kunnen anders worden geconfigureerd (Extra ► Toetsenbord sneltoetsen).
De meeste menuopties hebben een corresponderend gereedschap en vice versa. De menu’s zĳn echter niet exact
hetzelfde georganiseerd als de werkbalken. De locaties van menuopties in de werkbalken worden onder in de tabel
aangegeven. Plug-ins kunnen nieuwe opties aan menu’s toevoegen. Voor meer informatie over gereedschappen en
werkbalken, bekĳkWerkbalken.

Notitie: QGIS is een cross-platform toepassing. Gereedschappen zĳn over het algemeen beschikbaar op alle
platforms, maar zĳ zouden kunnen zĳn geplaatst in verschillende menu’s, afhankelĳk van het besturingssysteem.
De lĳsten hieronder geven de meest voorkomende locaties aan, inclusief bekende variaties.

7.1.1 Project

Het menu Project verschaft toegang tot en uitgang uit projectbestanden. Het verschaft gereedschappen voor:
• Maken van een Nieuw projectbestand vanaf niets of een ander projectbestand als sjabloon gebruiken (zie Opties

voor projectbestanden voor het configureren van sjablonen)
• Openen… van een project uit een bestand, een GeoPackage of een database van PostgreSQL of Oracle
• Sluiten van een project of terugkeren naar zĳn laatste bewaarde status
• Opslaan van een project in de bestandsindeling .qgs of .qgz, ofwel als een bestand of binnen een database
van GeoPackage, PostgreSQL of Oracle

• Exporteer het kaartvenster naar verschillende indelingen of gebruik een afdruklay-out voor meer complexe
uitvoer

• Instellen van projecteigenschappen en opties voor snappen voor het bewerken van geometrie.
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Tabel 7.1: De menu-items voor Project
Menuoptie Snelkoppeling Werkbalk Verwijzing

Nieuw Ctrl+N Project Introductie van projecten van
QGIS

Nieuw uit sjabloon ► Introductie van projecten van
QGIS

Openen… Ctrl+O Project Introductie van projecten van
QGIS

Openen vanuit ► Introductie van projecten van
QGIS

► GeoPackage… Introductie van projecten van
QGIS

► PostgreSQL… Introductie van projecten van
QGIS

► Oracle… Introductie van projecten van
QGIS

Open recent ► Alt+J + R Introductie van projecten van
QGIS

Sluiten Introductie van projecten van
QGIS

Opslaan Ctrl+S Project Introductie van projecten van
QGIS

Opslaan als… Ctrl+Shift+S Project Introductie van projecten van
QGIS

Opslaan naar ► Introductie van projecten van
QGIS

► Sjablonen… Introductie van projecten van
QGIS

► GeoPackage… Introductie van projecten van
QGIS

► PostgreSQL… Introductie van projecten van
QGIS

Terugdraaien…

Eigenschappen… Ctrl+Shift+P Projecteigenschappen
Opties voor ‘snappen’… Opties voor snappen en

digitaliseren
Importeren/Exporteren ►

► Kaart als afbeelding exporteren… De kaartweergave exporteren

► Kaart als PDF exporteren… De kaartweergave exporteren
► Exporteer project naar DXF… Nieuwe DXF-bestanden maken
► Lagen importeren vanuit DWG/DXF… Een DXF- of DWG-bestand

importeren

Nieuwe afdruklay-out… Ctrl+P Project De kaarten opmaken

Nieuw rapport… Een rapport maken

Lay-out beheren… Project De kaarten opmaken
Lay-outs ► De kaarten opmaken
Modellen ► Grafische modellen ontwerpen

QGIS afsluiten Ctrl+Q

Onder macOS komt de opdracht QGIS afsluiten overeen met QGIS ► Quit QGIS (Cmd+Q).
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7.1.2 Bewerken

Het menu Bewerken verschaft de meeste eigen gereedschappen die nodig zĳn voor het bewerken van attributen van
de laag of de geometrie. Voor het inschakelen van opties voor het menu Bewerken moet u schakelen naar de modus
Bewerken door te klikken op Bewerken aan/uitzetten (bekĳk Bewerken voor details).

Tabel 7.2: De menu-items voor Bewerken
Menuoptie Snelkoppeling Werkbalk Verwijzing

Ongedaan maken Ctrl+Z Digitaliseren Ongedaan maken en
Opnieuw

Opnieuw Ctrl+Shift+Z Digitaliseren Ongedaan maken en
Opnieuw

Objecten knippen Ctrl+X Digitaliseren Objecten knippen,
kopiëren en plakken

Objecten kopiëren Ctrl+C Digitaliseren Objecten knippen,
kopiëren en plakken

Objecten plakken Ctrl+V Digitaliseren Objecten knippen,
kopiëren en plakken

Objecten plakken als ► Werken met de
attributentabel

► Nieuwe vectorlaag… Werken met de
attributentabel

► Tĳdelĳke tekenlaag… Ctrl+Alt+V Werken met de
attributentabel

Geselecteerde verwĳderen Digitaliseren Geselecteerde objecten
verwĳderen

Selecteren ► Objecten selecteren

► Object(en) selecteren Selectie Objecten selecteren

► Objecten met een polygoon selecteren Selectie Objecten selecteren

► Objecten selecteren door er overheen te
tekenen

Selectie Objecten selecteren

► Objecten met een cirkel selecteren Selectie Objecten selecteren

► Objecten selecteren met een waarde… F3 Selectie Objecten selecteren

► Objecten selecteren met een expressie… Ctrl+F3 Selectie Objecten selecteren

► Objecten uit alle lagen deselecteren Ctrl+Alt+A Selectie Objecten selecteren

► Objecten deselecteren van huidige actieve
laag

Ctrl+Shift+A Selectie Objecten selecteren

► Objecten opnieuw selecteren Objecten selecteren

► Alle objecten selecteren Ctrl+A Selectie Objecten selecteren

► Selectie van objecten omdraaien Selectie Objecten selecteren

Object toevoegen Ctrl+. Digitaliseren

Object Punt toevoegen Ctrl+. Digitaliseren Objecten toevoegen

Object lĳn toevoegen Ctrl+. Digitaliseren Objecten toevoegen

Object Polygoon toevoegen Ctrl+. Digitaliseren Objecten toevoegen
Vervolgt op volgende pagina
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Tabel 7.2 – Vervolgd van vorige pagina
Menuoptie Snelkoppeling Werkbalk Verwijzing

Cirkel-tekenreeks toevoegen Regelmatige
vorm
digitaliseren

Cirkel-tekenreeks per
straal

Cirkel-tekenreeks per straal toevoegen Regelmatige
vorm
digitaliseren

Cirkel-tekenreeks per
straal

Cirkel toevoegen ► Regelmatige
vorm
digitaliseren

Cirkels tekenen

► Cirkel uit 2 punten toevoegen Regelmatige
vorm
digitaliseren

Cirkels tekenen

► Cirkel uit 3 punten toevoegen Regelmatige
vorm
digitaliseren

Cirkels tekenen

► Cirkel uit 3 tangens toevoegen Regelmatige
vorm
digitaliseren

Cirkels tekenen

► Cirkel uit 2 tangens en een punt toevoegen Regelmatige
vorm
digitaliseren

Cirkels tekenen

► Cirkel toevoegen dmv middelpunt en een
ander punt

Regelmatige
vorm
digitaliseren

Cirkels tekenen

Rechthoek toevoegen ► Regelmatige
vorm
digitaliseren

Rechthoeken tekenen

► Rechthoek toevoegen uit bereik Regelmatige
vorm
digitaliseren

Rechthoeken tekenen

► Rechthoek toevoegen uit middelpunt en een
punt

Regelmatige
vorm
digitaliseren

Rechthoeken tekenen

► Rechthoek toevoegen uit 3 punten (Afstand
van 2e en 3e punt)

Regelmatige
vorm
digitaliseren

Rechthoeken tekenen

► Rechthoek toevoegen uit 3 punten (Afstand
vanaf geprojecteerde punt op segment p1 en p2)

Regelmatige
vorm
digitaliseren

Rechthoeken tekenen

Gewone polygoon toevoegen ► Regelmatige
vorm
digitaliseren

Normale polygonen
tekenen

► Gewone polygoon toevoegen uit middelpunt
en een punt

Regelmatige
vorm
digitaliseren

Normale polygonen
tekenen

Vervolgt op volgende pagina
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Tabel 7.2 – Vervolgd van vorige pagina
Menuoptie Snelkoppeling Werkbalk Verwijzing

► Gewone polygoon toevoegen uit middelpunt
en een hoek

Regelmatige
vorm
digitaliseren

Normale polygonen
tekenen

► Gewone polygoon toevoegen uit 2 punten Regelmatige
vorm
digitaliseren

Normale polygonen
tekenen

Ellips toevoegen ► Regelmatige
vorm
digitaliseren

Ellipsen tekenen

► Ellips toevoegen uit middelpunt en 2 punten Regelmatige
vorm
digitaliseren

Ellipsen tekenen

► Ellips toevoegen uit middelpunt en een punt Regelmatige
vorm
digitaliseren

Ellipsen tekenen

► Ellips toevoegen uit bereik Regelmatige
vorm
digitaliseren

Ellipsen tekenen

► Ellips toevoegen uit foci Regelmatige
vorm
digitaliseren

Ellipsen tekenen

Annotatie toevoegen ► Gereedschappen voor
annotatie

► Tekst-annotatie Annotaties Gereedschappen voor
annotatie

► Formulier-annotatie Annotaties Gereedschappen voor
annotatie

► HTML-annotatie Annotaties Gereedschappen voor
annotatie

► SVG-annotatie Annotaties Gereedschappen voor
annotatie

Attributen bewerken ►

► Attributen van geselecteerde objecten
aanpassen

Digitaliseren Attribuutwaarden
bewerken

► Attributen van geselecteerde objecten
samenvoegen

Geavanceerd
digitaliseren

Samenvoegen
attribuutwaarden van
geselecteerde objecten

Geometrie bewerken ►

► Object(en) verplaatsen Geavanceerd
digitaliseren

Object(en) verplaatsen

► Object(en) kopiëren en verplaatsen Geavanceerd
digitaliseren

Object(en) verplaatsen

► Object(en) draaien Geavanceerd
digitaliseren

Object(en) roteren

► Object(en) op schaal brengen Geavanceerd
digitaliseren

Object op schaal brengen

Vervolgt op volgende pagina
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Tabel 7.2 – Vervolgd van vorige pagina
Menuoptie Snelkoppeling Werkbalk Verwijzing

► Object vereenvoudigen Geavanceerd
digitaliseren

Object vereenvoudigen

► Ring toevoegen Geavanceerd
digitaliseren

Ring toevoegen

► Deel toevoegen Geavanceerd
digitaliseren

Deel toevoegen

► Ring vullen Geavanceerd
digitaliseren

Ring vullen

► Ring verwĳderen Geavanceerd
digitaliseren

Ring verwĳderen

► Deel verwĳderen Geavanceerd
digitaliseren

Deel verwĳderen

► Objecten opnieuw vormen Geavanceerd
digitaliseren

Object vervormen

► Verschuiving boog Geavanceerd
digitaliseren

Verspring curve

► Objecten splitsen Geavanceerd
digitaliseren

Kaartobjecten splitsen

► Delen splitsen Geavanceerd
digitaliseren

Delen splitsen

► Geselecteerde objecten samenvoegen Geavanceerd
digitaliseren

Geselecteerde objecten
samenvoegen

► Gereedschap Punten (Alle lagen) Digitaliseren Gereedschap Punten

► Gereedschap Punten (Huidige laag) Digitaliseren Gereedschap Punten

► Lĳn omdraaien Geavanceerd
digitaliseren

Lĳn omdraaien

► Object verkleinen/vergroten Geavanceerd
digitaliseren

Object
verkleinen/vergroten

Puntsymbolen roteren Geavanceerd
digitaliseren

Puntsymbolen roteren

Puntsymbolen verschuiven Geavanceerd
digitaliseren

Verschuiving
puntsymbolen

Gereedschappen die afhankelĳk zĳn van het type geometrie van de geselecteerde laag, d.i. punt, polylĳn of polygoon,
worden overeenkomstig geactiveerd:

Tabel 7.3: De op “Object verplaatsen” op geometrie gebaseerde
pictogrammen

Menuoptie Punt Polylijn Polygoon

Object(en) verplaatsen

Object(en) kopiëren en verplaatsen
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7.1.3 Beeld

De kaart wordt gerenderd in kaartweergaven. U kunt interactief werken met deze weergaven via de gereedschappen
van Beeld. U kunt bĳvoorbeeld:

• Nieuwe 2D- of 3D-kaartweergaven maken naast het hoofdkaartvenster
• Zoomen of verschuiven naar elke plaats
• De attributen of geometrie van de weergegeven objecten bevragen
• De kaartweergave verbeteren met modi voorbeeld, annotaties of decoraties
• Toegang verkrĳgen tot elk paneel of werkbalk

Het menu geeft u ook de mogelĳkheid om de interface van QGIS zelf te reorganiseren met acties als:
• Volledig scherm aan/uit: bedekt het gehele scherm terwĳl het de titelbalk verbergt
• Zichtbaarheid paneel aan/uit: geeft ingeschakelde panelen weer of verbergt ze - nuttig bĳ het digitaliseren
van objecten (voor maximale zichtbaarheid van het kaartvenster) als ook voor (geprojecteerde/opgenomen)
presentaties met het kaartvenster van QGIS

• Alleen kaart schakelen: verbergt panelen, werkbalken, menu’s en de statusbalk en geeft alleen het kaartvenster
weer. Gecombineerd met de optie Volledig scherm zorgt het er voor dat uw scherm alleen de kaart weergeeft

Tabel 7.4: De menu-items voor Beeld
Menuoptie Snelkoppeling Werkbalk Verwijzing

Nieuwe kaartweergave Ctrl+M Kaart
navigeren

2D-kaartweergave

3D-kaartweergaven ► 3D-kaartweergave

► Nieuwe 3D-kaartweergave Ctrl+Alt+M Kaart
navigeren

3D-kaartweergave

3D-kaartweergaven beheren 3D-kaartweergave

Kaart verschuiven Kaart
navigeren

De kaartweergave
verkennen

Kaart verschuiven naar selectie Kaart
navigeren

De kaartweergave
verkennen

Inzoomen Ctrl+Alt++ Kaart
navigeren

De kaartweergave
verkennen

Uitzoomen Ctrl+Alt+- Kaart
navigeren

De kaartweergave
verkennen

Objecten identificeren Ctrl+Shift+I Attributen Objecten identificeren
Meten ► Attributen Meten

► Lĳn meten Ctrl+Shift+M Attributen Meten

► Gebied meten Ctrl+Shift+J Attributen Meten

► Richting meten Attributen Meten

► Hoek meten Attributen Meten

Statistisch overzicht Attributen Paneel Statistisch
overzicht

Hoogteprofiel Weergave Hoogteprofiel

Volledig uitzoomen Ctrl+Shift+F Kaart
navigeren

De kaartweergave
verkennen

Vervolgt op volgende pagina
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Tabel 7.4 – Vervolgd van vorige pagina
Menuoptie Snelkoppeling Werkbalk Verwijzing

Inzoomen op selectie Ctrl+J Kaart
navigeren

De kaartweergave
verkennen

Zoomen naar la(a)g(en) Kaart
navigeren

De kaartweergave
verkennen

Zoom naar eigen resolutie (100%) Kaart
navigeren

De kaartweergave
verkennen

Laatste zoomniveau Kaart
navigeren

De kaartweergave
verkennen

Zoom naar volgende Kaart
navigeren

De kaartweergave
verkennen

Decoraties ► Alt+V + D De kaart decoreren

► Raster… Raster

► Schaalbalk… Schaalbalk

► Afbeelding… Decoratie Afbeelding

► Noordpĳl… Noordpĳl

► Titellabel… Titellabel

► Label Copyright… Label Copyright

► Bereiken lay-outs… Bereiken lay-out
modus Voorbeeld ►
► Normaal
► Monochroom simuleren
► Kleurenblindheid achromatopsie simuleren
(grĳswaarden)
► Kleurenblindheid protanopie simuleren
(geen rood)
► Kleurenblindheid deuteranopie simuleren
(geen groen)
► Kleurenblindheid tritanopie simuleren (geen
blauw)

Kaarttips weergeven Attributen Tonen

Nieuwe Favoriete plaats…. Ctrl+B Kaart
navigeren

Favoriete plaatsenmaken
van bereiken op de kaart

Favoriete plaatsen weergeven Ctrl+Shift+B Kaart
navigeren

Favoriete plaatsenmaken
van bereiken op de kaart

Favoriete plaatsen beheren weergeven Favoriete plaatsenmaken
van bereiken op de kaart

Bĳwerken F5 Kaart
navigeren

Zichtbaarheid laag ► Paneel Lagen

► Alle lagen tonen Ctrl+Shift+U Paneel Lagen

► Alle lagen verbergen Ctrl+Shift+H Paneel Lagen

► Geselecteerde lagen tonen Paneel Lagen

► Geselecteerde lagen verbergen Paneel Lagen
Vervolgt op volgende pagina
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Tabel 7.4 – Vervolgd van vorige pagina
Menuoptie Snelkoppeling Werkbalk Verwijzing

► Geselecteerde lagen schakelen Paneel Lagen
►Geselecteerde lagen onafhankelĳk schakelen Paneel Lagen

► Niet geselecteerde lagen verbergen Paneel Lagen
Panelen ► Panelen en werkbalken
Werkbalken ► Panelen en werkbalken
Volledig scherm aan/uit F11
Zichtbaarheid paneel aan/uit Ctrl+Tab
Alleen kaart schakelen Ctrl+Shift+Tab

Onder Linux KDE zĳn, Panelen ►,Werkbalken ► en Volledig scherm geplaatst in het menu Extra.

7.1.4 Kaartlagen

Het menu Kaartlagen verschaft een grote verzameling aan gereedschappen om nieuwe gegevensbronnen te maken ,
om ze toe te voegen aan een project of aanpassingen op te slaan die er in zĳn gemaakt. Met dezelfde gegevensbronnen
kunt u ook:

• Laag dupliceren van een laag om een kopie te maken waar u de naam, opmaak (symbologie, labels, …),
samenvoegingen, … kunt aanpassen. De kopie gebruikt dezelfde bron als het origineel.

• Lagen of groepen Kopiëren en Plakken vanuit het ene project naar een ander als een nieuwe instantie waarvan
de eigenschappen onafhankelĳk kunnen worden aangepast. Net als voor Laag dupliceren, zĳn de lagen nog
steeds gebaseerd op dezelfde databron.

• of Lagen en groepen inbedden… uit een ander project, als alleen-lezen kopieën die u niet kunt aanpassen (bekĳk
Lagen inbedden vanuit externe projecten)

Het menu Kaartlagen bevat ook gereedschappen om eigenschappen van lagen (stĳl, schaal, CRS…) te configureren,
te kopiëren of te plakken.

Tabel 7.5: De menu-items voor Lagen
Menuoptie Snelkoppeling Werkbalk Verwijzing

Databronnen beheren Ctrl+L Databronnen
beheren

Gegevens openen

Laag maken ► Nieuwe vectorlagen maken

► Nieuwe laag voor GeoPackage… Ctrl+Shift+N Databronnen
beheren

Een nieuwe laag voor
GeoPackage maken

► Nieuwe Shapefile-laag… Databronnen
beheren

Nieuwe Shapefile-laag
maken

► Nieuwe SpatiaLite-laag… Databronnen
beheren

Het maken van een nieuwe
SpatiaLite-laag

► Nieuwe tĳdelĳke tekenlaag… Databronnen
beheren

Een nieuwe tĳdelĳke
tekenlaag maken

► Nieuwe laag met mazen… Databronnen
beheren

Een nieuwe laag met mazen
maken

► Nieuwe GPX-laag… Databronnen
beheren

Een nieuwe GPX-laag
maken

Vervolgt op volgende pagina
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Tabel 7.5 – Vervolgd van vorige pagina
Menuoptie Snelkoppeling Werkbalk Verwijzing

► Nieuwe virtuele laag… Databronnen
beheren

Virtuele lagen maken

Laag toevoegen ► Gegevens openen

► Vectorlaag toevoegen… Ctrl+Shift+V Lagen beheren Een laag uit een bestand
laden

► Rasterlaag toevoegen… Ctrl+Shift+R Lagen beheren Een laag uit een bestand
laden

► Laag met mazen toevoegen… Lagen beheren Laden van een laag met
mazen

► Tekstgescheiden laag toevoegen… Ctrl+Shift+T Lagen beheren Een tekstgescheiden bestand
importeren

► Laag voor PostGIS toevoegen… Ctrl+Shift+D Lagen beheren Database gerelateerde
gereedschappen

► SpatiaLite-laag toevoegen… Ctrl+Shift+L Lagen beheren SpatiaLite-lagen

► MS SQL Server-laag toevoegen… Lagen beheren Database gerelateerde
gereedschappen

► Oracle Spatial-laag toevoegen… Lagen beheren Database gerelateerde
gereedschappen

► SAP HANA Spatial-laag
toevoegen….

Lagen beheren Database gerelateerde
gereedschappen

► Virtuele laag
toevoegen/bewerken…

Lagen beheren Virtuele lagen maken

► WMS/WMTS-laag toevoegen… Ctrl+Shift+W Lagen beheren Laden van lagen
WMS/WMTS

► XYZ-laag toevoegen… XYZ Tile-services gebruiken

► WCS-laag toevoegen… Lagen beheren WCS-cliënt

► WFS-laag toevoegen… Lagen beheren WFS- en WFS-T-cliënt

► ArcGIS REST Server-laag
toevoegen…

Lagen beheren ArcGIS REST-servers
gebruiken

► Vector tegellaag toevoegen… Vector tegelservices
gebruiken

► Laagmet puntenwolk toevoegen… Werken met puntenwolken

► GPX-laag toevoegen… Introduceren van gegevens
van GNSS/GPS

Lagen en groepen inbedden… Lagen inbedden vanuit
externe projecten

Uit Laag-definitiebestand toevoegen… Laag-definitiebestand

Georeferencer… Georeferencer

Stĳl kopiëren Laageigenschappen opslaan
en delen

Stĳl plakken Laageigenschappen opslaan
en delen

Vervolgt op volgende pagina
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Tabel 7.5 – Vervolgd van vorige pagina
Menuoptie Snelkoppeling Werkbalk Verwijzing

Laag kopiëren

Laag/Groep plakken

Attributentabel openen F6 Attributen Werken met de
attributentabel

Attributentabel filteren ► Werken met de
attributentabel

► Attributentabel openen
(geselecteerde objecten)

Shift+F6 Attributen Werken met de
attributentabel

► Attributentabel openen (zichtbare
objecten)

Ctrl+F6 Attributen Werken met de
attributentabel

► Attributentabel openen (bewerkte
en nieuwe objecten)

Attributen Werken met de
attributentabel

Bewerken aan/uitzetten Digitaliseren Het digitaliseren van een
bestaande kaartlaag

Wĳzigingen laag opslaan Digitaliseren Bewerkte lagen opslaan

Huidige wĳzigingen ► Digitaliseren Bewerkte lagen opslaan
► Opslaan voor geselecteerde laag/lagen Digitaliseren Bewerkte lagen opslaan
► Terugdraaien voor geselecteerde
laag/lagen

Digitaliseren Bewerkte lagen opslaan

► Afbreken voor geselecteerde
laag/lagen

Digitaliseren Bewerkte lagen opslaan

► Opslaan voor alle lagen Digitaliseren Bewerkte lagen opslaan
► Terugdraaien voor alle lagen Digitaliseren Bewerkte lagen opslaan
► Afbreken voor alle lagen Digitaliseren Bewerkte lagen opslaan
Opslaan als… Nieuwe lagen uit een

bestaande laag maken
Opslaan als Laag-definitiebestand… Laag-definitiebestand

Laag/Groep verwĳderen Ctrl+D

Laag/lagen dupliceren
Zichtbaarheidsschaal instellen Schaal zichtbaarheid

selecteren
Instellen laag-CRS Ctrl+Shift+C Laag coördinaten

referentiesystemen
Project-CRS van laag overnemen Project coördinaten

referentiesystemen
Laageigenschappen… Het dialoogvenster

Vectoreigenschappen,
Dialoogvenster
Laageigenschappen,
Eigenschappen gegevensset
met mazen, Eigenschappen
Puntenwolken,
Eigenschappen vectortegels
gegevensset

Filteren… Ctrl+F Querybouwer
Labels Labeleigenschappen

Tonen in overzichtskaart Paneel Overzichtskaart
Vervolgt op volgende pagina
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Tabel 7.5 – Vervolgd van vorige pagina
Menuoptie Snelkoppeling Werkbalk Verwijzing

Alles tonen in overzichtskaart Paneel Overzichtskaart

Alles in overzichtskaart verbergen Paneel Overzichtskaart

7.1.5 Instellingen

Tabel 7.6: De menu-items voor Extra
Menuoptie Verwijzing
Gebruikersprofielen ► Werken met gebruikersprofielen
► standaard Werken met gebruikersprofielen
► Actieve profielmap openen Werken met gebruikersprofielen
► Nieuw profiel… Werken met gebruikersprofielen

Stĳlmanager… De Stĳlmanager

Aangepaste projecties… Aangepast Coördinaten ReferentieSysteem

Toetsenbord sneltoetsen… Snelkoppelingen toetsenbord

Aanpassen van de interface… Aanpassingen
Opties… Opties

Onder Linux KDE vindt u meer gereedschappen in het menu Extra, zoals Panelen►,Werkbalken► en Volledig
scherm aan/uit.

7.1.6 Plug-ins

Tabel 7.7: De menu-items voor Plug-ins
Menuoptie Snelkoppeling Werkbalk Verwijzing

Plug-ins beheren en installeren… Het dialoogvenster Plug-ins

“ Python Console Ctrl+Alt+P Plug-ins QGIS Python-console

De eerste keer wanneer QGIS wordt gestart worden niet alle bronplug-ins geladen.

7.1.7 Vector

Dit is hoe het menu Vector er uitziet als alle bronplug-ins zĳn ingeschakeld.

Tabel 7.8: De menu-items voor Vector
Menuoptie Snelkoppeling Werkbalk Verwijzing

Geometrieën controleren… Plug-in Geometrieën controleren

Topologie controleren Vector Plug-in Topologie Checker
Geoprocessing-gereedschap ► Alt+O + G

► Buffer… Buffer
Vervolgt op volgende pagina
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Tabel 7.8 – Vervolgd van vorige pagina
Menuoptie Snelkoppeling Werkbalk Verwijzing

► Clippen… Clippen

► Bolle schil… Convex hull (Bolle schil)

► Verschil… Verschil

► Samenvoegen… Samensmelten

► Kruising… Kruising

► Symmetrisch verschil… Symmetrisch verschil

► Verenigen… Verenigen

► Geselecteerde polygonen opruimen… Geselecteerde polygonen opruimen
Geometrie-gereedschappen ► Alt+O + E

► Zwaartepunten… Zwaartepunten

► Geometrieën verzamelen… Geometrieën verzamelen

► Punten uitnemen… Punten uitnemen

► Meervoudige naar enkelvoudige…. Meerdelige naar enkele

► Polygonen naar lĳnen… Polygonen naar lĳnen

► Vereenvoudigen… Vereenvoudigen

► Geldigheid controleren… Geldigheid controleren

► Delaunay-triangulatie… Delauney-triangulatie

► Verdichten op aantal… Verdichten op aantal

► Attributen voor geometrie
toevoegen…

Attributen voor geometrie toevoegen

► Lĳnen naar polygonen… Lĳnen naar polygonen

► Voronoi-polygonen… Voronoi-polygonen
Analyse-gereedschap ► Alt+O + A

► Kruisingen van lĳnen… Kruisingen van lĳnen

► Gemiddelde coördina(a)t(en)… Gemiddelde coördina(a)t(en)

► Basisstatistieken voor velden… Basisstatistieken voor velden

► Punten in polygonen tellen… Punten in polygonen tellen

► Afstandsmatrix… Afstandsmatrix

► Lĳst Unieke waarden… Lĳst unieke waarden

► Nearest Neighbour-analyse… ‘Dichtstbĳzĳnde buur’-analyse

► Lĳnlengtes sommeren… Lĳnlengtes sommeren
Datamanagement-gereedschap ► Alt+O + D

► Vectorlagen samenvoegen… Vectorlagen samenvoegen

► Laag opnieuw projecteren… Laag opnieuw projecteren

► Ruimtelĳke index aanmaken… Ruimtelĳke index maken

► Koppel attributen op basis van
plaats…

Koppel attributen op basis van plaats

Vervolgt op volgende pagina
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Tabel 7.8 – Vervolgd van vorige pagina
Menuoptie Snelkoppeling Werkbalk Verwijzing

► Vectorlaag splitsen… Vectorlaag splitsen
Onderzoeksgereedschap ► Alt+O + R

► Grid maken… Grid maken

► Bereik laag uitnemen… Bereik laag uitnemen

► Willekeurige punten in bereik… Willekeurige punten in bereik

► Willekeurige punten in polygonen… Willekeurige punten in polygonen

► Willekeurige punten op lĳnen… Willekeurige punten op lĳnen

► Selecteren op plaats… Selecteren op plaats

► Willekeurige punten binnen grenzen
van laag…

Willekeurige punten binnen grenzen
van laag

► Willekeurige punten binnen
polygonen…

Willekeurige punten binnen polygonen

► Willekeurige selectie… Willekeurige selectie

► Willekeurige selectie binnen subsets… Willekeurige selectie binnen subsets

► Regelmatige punten… Regelmatige punten

Standaard voegt QGIS algoritmes van Processing toe aan het menu Vector, gegroepeerd in submenu’s. Dit verschaft
sneltoetsen voor veel voorkomende op vector gebaseerde taken voor GIS van verschillende providers. Indien niet al
deze submenu’s beschikbaar zĳn, schakel dan de plug-in Processing in Plug-ins ► Plug-ins beheren en installeren…
in.
Onthoud dat de lĳst met algoritmes en hun menu kan worden aangepast/uitgebreid met algoritmes van Processing
(lees Configureren van het framework Processing) of sommige externe plug-ins.

7.1.8 Raster

Dit is hoe het menu Raster er uitziet als alle bronplug-ins zĳn ingeschakeld.

Tabel 7.9: De menu-items voor Raster
Menuoptie Snelkoppeling WerkbalkVerwijzing

Rasterberekeningen… Rasterberekeningen
Rasters uitlĳnen… Raster uitlĳnen
Analyse ►

► Aspect… Aspect

► ‘Geen gegevens’ vullen… ‘Geen gegevens’ vullen

► Grid (Gemiddelde verplaatsing)… Grid (Moving average)

► Grid (Metrieken gegevens)… Grid (Data metrics)

► Grid (Omgekeerde afstand tot een
macht)…

Grid (Inverse distance to a power)

► Grid (Dichtstbĳzĳnde buur)… Raster (IDW met zoeken naar Nearest
neighbor)

► Bĳna zwart… Near black
Vervolgt op volgende pagina
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Tabel 7.9 – Vervolgd van vorige pagina
Menuoptie Snelkoppeling WerkbalkVerwijzing

► Schaduw voor heuvels… Schaduw voor heuvels

► Nabĳheid(afstand raster)… Proximity (raster afstand)

► Ruwheid… Ruw

► Zeven… Sieve

► Helling… Helling

► Topografische Positie Index (TPI)… Topografische Positie Index (TPI)

► Terrein Ruwheid Index (TRI)… Terrein Ruwheid Index (TRI)
Projecties ►

► Projectie toekennen… Projectie toekennen

► Projectie uitnemen… Projectie uitnemen

► Warp (Opnieuw projecteren)… Warp (opnieuw projecteren)
Diversen ►

► Virtueel raster bouwen… Virtueel raster bouwen

► Rasterinformatie… Rasterinformatie

► Samenvoegen… Samenvoegen

► Overzichten bouwen (Piramiden)… Overzichten aanmaken (Piramiden)

► Tegel-index… Tegelindex
Extractie ►

► Raster op bereik clippen… Raster op bereik clippen

► Raster op maskerlaag clippen… Raster op maskerlaag clippen

► Contour… Contour
Conversie ►

► PCT naar RGB… PCT naar RGB

► Polygoniseren (raster naar vector)… Polygoniseren (raster naar vector)

► Rasteriseren (vector naar raster)… Rasteriseren (vector naar raster)

► RGB naar PCT… RGB naar PCT

► Vertalen (indeling converteren)… Vertalen (indeling converteren)

Standaard voegt QGIS algoritmes van Processing toe aan het menu Raster, gegroepeerd in submenu’s. Dit verschaft
een sneltoets voor veel voorkomende op raster gebaseerde taken voor GIS van verschillende providers. Indien niet al
deze submenu’s beschikbaar zĳn, schakel dan de plug-in Processing in Plug-ins ► Plug-ins beheren en installeren…
in.
Onthoud dat de lĳst met algoritmes en hun menu kan worden aangepast/uitgebreid met algoritmes van Processing
(lees Configureren van het framework Processing) of sommige externe plug-ins.
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7.1.9 Database

Dit is hoe het menu Database er uitziet als alle bronplug-ins zĳn ingeschakeld. Indien er geen plug-ins voor databases
zĳn ingeschakeld is er geen menu Database.

Tabel 7.10: De menu-items voor Database
Menuoptie Snelkoppeling Werkbalk Verwijzing
Offline bewerken… Alt+D + O Plug-in Offline bewerken

► Naar offline project converteren… Database Plug-in Offline bewerken

► Synchroniseren Database Plug-in Offline bewerken

DB Manager… Database Plug-in DB Manager

De eerste keer wanneer QGIS wordt gestart worden niet alle bronplug-ins geladen.

7.1.10 Web

Dit is hoe het menu Web er uitziet als alle bronplug-ins zĳn ingeschakeld. Indien er geen plug-ins voor het web zĳn
ingeschakeld, is er geen menuWeb.

Tabel 7.11: De menu-items voor Web
Menuoptie Snelkoppeling Werkbalk Verwijzing
MetaSearch ► Alt+W + M MetaSearch Catalog Client

► Metasearch Web MetaSearch Catalog Client
► Help MetaSearch Catalog Client

De eerste keer wanneer QGIS wordt gestart worden niet alle bronplug-ins geladen.

7.1.11 Mazen

Het menu Mazen verschaft gereedschappen die nodig zĳn om lagen met mazen te bewerken. Plug-ins van derde
partĳen kunnen items aan dit menu toevoegen.

Tabel 7.12: De menu-items voor Mazen
Menuoptie Snelkoppeling Werkbalk Verwijzing

Mazen berekenen… Mazen berekenen

Zĳden en punten opnieuw indexeren Herindexeren van lagen met
mazen
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7.1.12 Processing

Tabel 7.13: De menu-items voor Processing
Menuoptie Snelkoppeling Werkbalk Verwijzing

Toolbox Ctrl+Alt+T De Toolbox

Grafische modellen
bouwen…

Ctrl+Alt+G Grafische modellen ontwerpen

Geschiedenis… Ctrl+Alt+H Beheren van de geschiedenis

Resultaten bekĳken Ctrl+Alt+R Configureren externe toepassingen

Objecten op hun plaats
bewerken

De Processing Op-de-plaats aanpassen

De eerste keer wanneer QGIS wordt gestart worden niet alle bronplug-ins geladen.

7.1.13 Help

Tabel 7.14: De menu-items voor Help
Menuoptie Snelkoppeling Werkbalk Verwijzing

Inhoudsopgave F1 Help
API documentatie
Plug-ins ►
Een fout melden
Commerciële ondersteuning nodig?

QGIS startpagina Ctrl+H
QGIS op updates controleren

Info

QGIS dragende leden

7.1.14 QGIS

Dit menu is alleen beschikbaar onder macOS en bevat enkele aan het besturingssysteem gerelateerde opdrachten.

Tabel 7.15: De menu-items voor QGIS
Menuoptie Snelkoppeling
Voorkeuren
Over QGIS
QGIS verbergen
Alles tonen
Andere verbergen
QGIS afsluiten Cmd+Q

Preferences correspondeert met Extra ► Opties, About QGIS correspondeert met Help ► Over en Quit QGIS
correspondeert met Project ► QGIS afsluiten voor andere platforms.
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7.2 Panelen en werkbalken

Vanuit het menu Beeld (of Extra), kunt u widgets (Panelen ►) en werkbalken (Werkbalken ►) van QGIS in- en
uitschakelen. Klik met rechts op de menubalk of de werkbalk en kies het item dat u wilt om het te (de)activeren.
Panelen en werkbalken kunnen worden verplaatst en neergezet worden waar u wilt binnen de interface van QGIS. De
lĳst kan ook worden uitgebreid met het activeren van Bron- of externe plug-ins.

7.2.1 Werkbalken

De werkbalken verschaffen toegang tot de meeste functies in de menu’s, plus aanvullende gereedschappen voor het
werken met de kaart. Elk item voor de werkbalk heeft pop-up Help beschikbaar. Ga met uw muis over het item en
een korte beschrĳving over het doel van het gereedschap zal worden weergegeven.
Beschikbare werkbalken zĳn:

Tabel 7.16: QGIS werkbalken
Naam werkbalk Belangrijkste verwijzing voor gereedschappen
Geavanceerd digitaliseren Geavanceerd digitaliseren
Annotaties Gereedschappen voor annotatie
Attributen Werken met de attributentabel, Algemeen gereedschap
Databronnen beheren Databronnen beheren
Database Plug-in DB Manager
Digitaliseren Het digitaliseren van een bestaande kaartlaag
GRASS Integratie van GRASS GIS
Help
Label De werkbalk Label
Lagen beheren Gegevens openen
Kaart navigeren De kaartweergave verkennen
Mazen digitaliseren Een laag met mazen bewerken
Plug-ins Plug-ins
Project Werken met projectbestanden, De kaarten opmaken, De Stĳlbibliotheek
Algoritmes van Processing Configureren van het framework Processing
Raster Plug-ins
Selectie Objecten selecteren
Regelmatige vorm digitaliseren Vorm digitaliseren
Snappen Tolerantie voor snappen en zoekradius instellen
Vector Plug-ins
Web Plug-ins, MetaSearch Catalog Client

Notitie: Plug-ins van derde-partĳen kunnen de standaard werkbalk uitbreiden met hun eigen gereedschappen of hun
eigen werkbalk verschaffen.

Tip: Werkbalken weer terugzetten

Als u per ongeluk een werkbalk hebt verborgen, kunt u die terughalen met Beeld ► Werkbalken ► (of Extra ►
Werkbalken►). Als, om enige reden, een werkbalk (of enig ander widget) totaal uit de interface verdwĳnt, zult u tips
vinden om het terug te krĳgen in initiële GUI herstellen.
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7.2.2 Panelen

QGIS verschaft vele panelen. Panelen zĳn speciale widgets waarmee u kunt werken (opties selecteren, vakken
selecteren, waarden vullen…) om meer complexe taken uit te voeren.
Hieronder staat een lĳst met de standaardpanelen die worden verschaft door QGIS:

Tabel 7.17: QGIS panelen
Naam paneel Snelkoppeling Verwijzing
Geavanceerd digitaliseren Ctrl+4 Het paneel Geavanceerd digitaliseren
Browser Ctrl+2 Het paneel Browser
Browser (2) Het paneel Browser
Gereedschappen
Debuggen/Ontwikkeling

F12 Paneel Gereedschappen voor debuggen/ontwikkeling

Hoogteprofiel
Geometrie valideren Digitaliseren
GPS informatie Ctrl+0 GPS-informatie
GRASS-gereedschap Integratie van GRASS GIS
Volgorde laag Ctrl+9 Paneel Laagvolgorde
Laag opmaken Ctrl+3 Paneel Laag opmaken
Lagen Ctrl+1 Paneel Lagen
Logberichten Paneel Logboekmeldingen
Overzicht Ctrl+8 Paneel Overzichtskaart
Processing Toolbox De Toolbox
Resultaten bekĳken De Toolbox
Opties voor snappen en digitaliseren Tolerantie voor snappen en zoekradius instellen
Favoriete plaatsen beheren Ctrl+7 Favoriete plaatsen maken van bereiken op de kaart
Statistieken Ctrl+6 Paneel Statistisch overzicht
Tĳdbeheer Het paneel Tĳdbeheer
Schaal tegel Tegelsets
Ongedaan maken/Opnieuw Ctrl+5 Paneel Ongedaan maken/Opnieuw
Puntenbewerker Het paneel Puntenbewerker

7.3 Statusbalk

De Statusbalk verschaft u algemene informatie over de kaartweergave, en verwerkte of beschikbare acties en biedt u
gereedschappen om de kaartweergave te beheren.

7.3.1 balk Lokaliseren

Aan de linkerkant van de statusbalk, de balk Lokaliseren, een widget om snel te zoeken, helpt u enkele mogelĳkheden
of opties in QGIS te zoeken en uit te voeren:

1. Klik in de tekstwidget om de zoekbalk Lokaliseren te activeren of druk op Ctrl+K.
2. Typ een tekst die is geassocieerd aan het itemwaar u naar zoekt (naam, tag, sleutelwoord,…). Standaardworden

de resultaten teruggegeven voor de ingeschakelde filters voor Lokaliseren, maar u kunt de zoekactie beperken
tot een bepaald bereik door uw tekst te laten voorafgaan door het voorvoegsel voor filters van Lokaliseren, d.i.
typen van l cad zal alleen de lagen teruggeven waarvan de naam cad bevat.
Het filter kan ook worden geselecteerd met een dubbelklik in het menu dat wordt weergegeven bĳ het activeren
van de widget Lokaliseren.

3. Klik op een resultaat om de overeenkomstige actie uit te voeren, afhankelĳk van het type item.

Tip: Beperken van het opzoeken tot bepaalde velden van de actieve laag
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Standaard wordt een zoekactie met het filter “Objecten in alle lagen” (f) uitgevoerd op de gehele attributentabel van
de laag. U kunt de zoekactie beperken tot een bepaald veld door het voorvoegsel @ te gebruiken. Bĳv. f @name sal
of @name sal geeft alleen de objecten terug waarvan het attribuut “name” ‘sal’ bevat. Tekst automatisch aanvullen
is actief bĳ het schrĳven en de suggestie kan worden toegepast met de toets Tab
Een meer geavanceerd beheer voor de bevraagde velden is mogelĳk vanaf de tab Velden van de laag. Lees
Eigenschappen Velden voor de details.

Zoeken wordt afgehandeld met threads, zodat resultaten altĳd zo snel mogelĳk beschikbaar komen, zelfs als een traag
filter is geïnstalleerd. Zĳ verschĳnen ook zodra zĳ worden tegengekomen door een filter, wat betekent dat bĳv. een
zoekfilter voor bestanden de resultaten één voor één zal teruggeven omdat de boom met bestanden moet worden
gescand. Dit zorgt er voor dat de gebruikersinterface altĳd reageert, zelfs als er een bĳzonder traag filter aanwezig is
(bĳv. een die een online service gebruikt).

Notitie: Het locatie-gereedschap Nominatim kan zich anders gedragen (niet zoeken met automatisch invullen,
vertraging in opgehaalde resultaten, …) ten opzichte van het OpenStreetMap Nominatim gebruiksbeleid.

Tip: Snelle toegang tot de configuratie van Lokaliseren

Klik op het pictogram op de widget Lokaliseren op de Statusbalk om de lĳst met filters weer te geven die u kunt
gebruiken en een item Configureren dat de tab Lokaliseren van het menu Extra ► Opties… opent.

7.3.2 Acties rapporteren

In het gebied naast de Locatiebalk zal een overzicht van de acties die u hebt uitgevoerd worden weergegeven indien
nodig (zoals het selecteren van objecten in een laag, laag verwĳderen, afstand en richting verschuiven) of een lange
beschrĳving van het gereedschap waar u overheen gaat (niet beschikbaar voor alle gereedschappen).
In het geval van langdurige bewerkingen, zoals het verzamelen van statistieken in rasterlagen, het uitvoeren van
algoritmes van Processing of het renderen van verscheidene lagen in de kaartweergave, wordt een voortgangsbalk
weergegeven in de Statusbalk.

7.3.3 Het kaartvenster beheren

De optie Coördinaten geeft de huidige positie van de muis weer en volgt die bĳ het verplaatsen over de
kaartweergave. U kunt de eenheid instellen (en de precisie) op de tab Project ► Eigenschappen… ► Algemeen. Klik
op de kleine knop aan de linker zĳde van het tekstvak om te schakelen tussen de optie Coördinaten en de optie

Bereiken dat de coördinaten van de huidige meest linksonder en meest rechtsboven gelegen punten van de kaart
weergeeft, in kaarteenheden.
Naast de weergave van de coördinaten vindt u de weergave Schaal. Het geeft de schaal weer van het kaartvenster. Er
is een keuzelĳst die u in staat stelt te kiezen uit vooraf gedefinieerde en aangepaste schalen.

Druk, aan de rechterkant van de weergave van de schaal, op de knop om de schaal vast te zetten bĳ het gebruiken
van het vergrootglas voor in- en uitzoomen. Het vergrootglas stelt u in staat in te zoomen op een kaart zonder dat de
schaal van de kaart wordt gewĳzigd, wat het eenvoudiger maakt de positie van labels en symbolen nauwkeuriger aan
te passen. Het niveau voor de vergroting wordt uitgedrukt als een percentage. Als het Vergrootglas een niveau heeft
van 100%, dan wordt de huidige kaart niet vergroot, d.i. is gerenderd op de accurate schaal, relatief aan de resolutie
van de monitor (DPI). Een standaardwaarde voor vergroting kan worden gedefinieerd in Extra► Opties► Rendering
► Gedrag bĳ renderen, wat erg handig is voor schermen met hoge resolutie om kleine symbolen te vergroten. In
aanvulling daarop beheert een instelling in Extra► Opties► Kaartvenster & Legenda► DPI of QGIS de fysieke DPI
voor elke monitor respecteert of de algemene logische DPI voor het systeem gebruikt.

7.3. Statusbalk 47

https://operations.osmfoundation.org/policies/nominatim/


QGIS Desktop 3.28 User Guide

Rechts naast het gereedschap Vergrootglas kunt u een huidige rotatie met de klok mee, in graden, definiëren voor uw
kaartweergave.

Aan de rechterkant van de Statusbalk kan het keuzevak (Her)teken worden gebruikt om tĳdelĳk te voorkomen
dat lagen worden gerenderd naar de kaartweergave (zie gedeelte Controle over het renderen van de kaart).

Rechts van de functie (Her)teken vindt u de knop EPSG:code met het huidige project-CRS. Klikken hierop
opent het dialoogvenster Projecteigenschappen en kunt u de kaartweergave opnieuw projecteren of enige andere
eigenschap van het project aanpassen.

Tip: Berekenen van de correcte schaal in het kaartvenster
Wanneer u QGIS start is het standaard CRS WGS 84 (EPSG 4326) en zĳn graden de eenheid. Dat betekent
dat QGIS een coördinaat in uw laag zal interpreteren als zĳnde gespecificeerd in graden. U kunt, om de juiste
schaalwaarden te verkrĳgen, ofwel handmatig deze instelling wĳzigen, bĳv. naar meters, op de tab Algemeen onder
Project► Eigenschappen… of u kunt het pictogram EPSG:code gebruiken zoals hierbovenweergegeven. In het laatste
geval worden de eenheden ingesteld op wat de projectie voor het project specificeert (bĳv. +units=us-ft).
Onthoud dat de keuze voor het CRS bĳ het opstarten kan worden ingesteld in Extra ► Opties ► Afhandelen CRS.

7.3.4 Berichten

De knop Berichten ernaast opent het paneel Logboekmeldingen met informatie over onderliggende processen
(opstarten van QGIS, laden van plug-ins, verwerken van gereedschappen…)
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Het paneel Browser

• Bronnen die kunnen worden geopend / uitgevoerd vanuit de Browser

• Paneel Browser items bovenste niveau

– Favorieten

– Favoriete plaatsen

– Thuis voor project

– Schĳven en bstandssysteem

– Items voor databases

– Tegels en webservices

• Bronnen

Het paneel Browser van QGIS is een fantastisch gereedschap voor het bladeren door, zoeken naar, inspecteren van,
kopiëren en laden van bronnen voor QGIS. Alleen bronnen die QGIS weet af te handelen worden in de browser
weergegeven.
Met het paneel Browser kunt u gegevens lokaliseren, inspecteren en toevoegen, zoals beschreven in Het paneel
Browser. In aanvulling daarop ondersteunt het paneel Browser slepen en neerzetten van veel bronnen voor QGIS,
zoals projectbestanden, scripts voor Python, scripts en modellen voor Processing.
Scripts voor Python, scripts en modellen voor Processing kunnen ook worden geopend voor bewerken in een externe
bewerker en Grafische modellen bouwen.
U kunt lagen slepen-en-neerzetten vanuit het paneel Lagen naar het paneel Browser, bĳvoorbeeld in een Geopackage
of een database van PostGIS.
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Fig. 8.1: Het paneel Browser

Het paneel Browser (Fig. 8.1) is georganiseerd in een uit te breiden hiërarchie met enkele vaste items op het bovenste
niveau, die de bronnen beheren die worden afgehandeld door de browser. Knoopitems kunnen worden uitgebreid door

te klikken op , links van de naam van het item. Een tak wordt ingeklapt door te klikken op . De knop
Alles inklappen laat alle items op het bovenste niveau inklappen.
In Extra ► Aanpassen van de interface is het mogelĳk bronnen uit te schakelen. Als u bĳvoorbeeld geen scripts voor
Python weer zou willen geven in de browser, kunt u het item Browser ► py deselecteren, en als u uw thuismap wilt
verwĳderen uit de browser, kunt u het item Browser ► special:Home deselecteren.

Een filter ( Filter browser) kan worden gebruikt om te zoeken, gebaseerd op namen van items (zowel bladitems als
knoopitems in de hiërarchie). Met het keuzemenu Opties, naast het tekstveld van het filter, kunt u

• schakelen met Hoofdlettergevoelig zoeken
• het Filterpatroon syntaxis instellen op één van

– Normaal

– Jokerteken(s)
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– Reguliere expressies

Dewidget Eigenschappen, dat nuttige informatie over enkele items / bronnen weergeeft, kan worden in- / uitgeschakeld
met de knop Widget Eigenschappen in-/uitschakelen. Indien ingeschakeld opent het aan de onderzĳde van het paneel
Browser, zoals weergegeven in Fig. 8.2.

Fig. 8.2: De widget Eigenschappen

Een tweede paneel Browser kan worden geopend door paneel Browser (2) te activeren in Beeld ► Panelen. Twee
panelen Browser hebben kan nuttig zĳn bĳ het kopiëren van lagen tussen bronnen die diep zĳn opgeslagen in
verschillende takken van de hiërarchie van de Browser.
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8.1 Bronnen die kunnen worden geopend / uitgevoerd vanuit de
Browser

Veel kan worden bereikt in het paneel Browser
• Voeg vector-, raster- en lagen met mazen toe aan uw kaart door te dubbelklikken, slepen naar het kaartvenster

of door te klikken op de knop Geselecteerde lagen toevoegen (na het selecteren van lagen)
• Voer scripts voor Python uit (inclusief algoritmes voor Processing), door dubbel te klikken of te slepen naar
het kaartvenster

• Voer modellen uit door dubbel te klikken of te slepen naar het kaartvenster
• Symbolen uitnemen… uit QGIS projectbestanden met het contextmenu
• Open bestanden met hun standaard toepassingen (<file type> extern openen… in het contextmenu).
Voorbeelden: HTML-bestanden, werkbladen, afbeeldingen, PDF’s, tekstbestanden, …

• Items kopiëren
• Hernoemen en verwĳderen van (meerdere) lagen (contextmenu: Beheren ►)
• Open een venster van de bestandsbeheerder en selecter het bestand direct inWeergeven in bestanden

Bronspecifieke acties zĳn voor de verschillende brongroepen gesorteerd vermeld onder de items op het bovenste
niveau, hieronder vermeld.

8.2 Paneel Browser items bovenste niveau

8.2.1 Favorieten

Vaak gebruikte locaties op het bestandssysteem kunnen worden getagd als Favorieten. Die welke u hebt getagd zullen
hier verschĳnen.
In aanvulling op de bewerkingen die zĳn beschreven onder Home, geeft het contextmenu u de mogelĳkheid voor
Favoriet hernoemen… en Favoriet verwĳderen.

8.2.2 Favoriete plaatsen

Dit is waar u uw Favoriete plaatsen zult vinden, georganiseerd in Favoriete plaatsen Project of Favoriete plaatsen
Gebruiker.
Vanuit het contextmenu voor het bovenste niveau, kunt u een Favoriete plaats maken (Nieuwe Favoriete plaats…),
Favoriete plaatsen beheren tonen…, Favoriete plaatsen importeren… en Favoriete plaatsen exporteren….
Voor groepsitems van Favoriete plaatsen kunt u Favoriete plaatsen exporteren…, een nieuwe Favoriete plaats maken
(Nieuwe Favoriete plaats…), Groep Favoriete plaatsen hernoemen, en Groep Favoriete plaatsen verwĳderen.
Voor items Favoriete plaatsen kunt u Naar Favoriete plaats zoomen, Favoriete plaatsen bewerken… en Favoriete
plaatsen verwĳderen…
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8.2.3 Thuis voor project

Beschikbaar als het projectbestand eenmaal is opgeslagen is het item Thuis voor project een map die gegevens
en andere inhoud (scripts, modellen, tekst, …) bevat die binnen het huidige project kunnen worden gebruikt.
Weergegeven in het paneel Browser geeft het u de mogelĳkheid om snel toegang te krĳgen tot gegevens en andere
bestanden van het project.
Het gaat standaard naar de map met het projectbestand, maar kan worden gewĳzigd via de optie Project ►
Eigenschappen… ► Algemene instellingen ► Thuis voor project, of door met rechts te klikken op het item Thuis
voor project van het paneel Browser en te selecteren Thuis voor project instellen…. Wĳzigen van die map is speciaal
nuttig in contexten waar projecten van QGIS niet zĳn opgeslagen in de map root van een ‘project’ in eenorganisatie,
naast de gegevenssets.

8.2.4 Schijven en bstandssysteem

De volgende items van het paneel Browser zĳn afhankelĳk van het gebruikte besturingssysteem en betreffende items
op het bovenste niveau van het bestandssysteem.
Dat zĳn voornamelĳk:

• De map Home, wĳzend naar de huidige thuismap van de gebruiker
• op op Unix gebaseerde machines, de bronmap /

• de verbonden schĳven, ofwel lokaal of netwerk. Afhankelĳk van het besturingssysteem, worden zĳ direct
vermeld (bĳv, C:\, D:\) of via het item /Volumes.

Vanuit het contextmenu van elk van deze mappen of schĳven kunt u:
• de inhoud vernieuwen
• een nieuw subitem Nieuw ► maken dat een Map, GeoPackage of ESRI Shapefile-indeling gegevensset is
• de map verbergen (Verbergen in browser)
• Kleur instellen: de kleur van het pictogram van de map wĳzigen, wat helpt bĳ het snel navigeren met Browser
in complexe mapstructuren

• Scannen instellen:

– Monitoren op wĳzigingen: maakt het mogelĳk handmatig te beheren of een bepaalde map zou moeten
worden gemonitord en automatisch moet worden bĳgewerkt. Deze instelling is van toepassing op de
geselecteerde map en alle submappen. Dit betekent dat u handmatig kunt kiezen voor het monitoren van
netwerkschĳven als u weet dat er geen problemen zĳn, of er handmatig voor kunt kiezen voor het niet
monitoren van grote mappen waarvan u om andere redenen niet wilt dat zĳ worden gemonitord. Standaard
worden schĳven op afstand of netwerkschĳven niet automatisch gemonitord.

– Scan deze map snel

• de map openen in uw bestandsbeheerder (Map openen…)
• de map openen in een terminal (In terminal openen…)
• de Eigenschappen… of de ouder Mapeigenschappen… inspecteren
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8.2.5 Items voor databases

Afhankelĳk van uw besturingssysteem en geïnstalleerde stuurprogramma’s zou u toegang kunnen hebben tot
verschillende typen te gebruiken databases in QGIS. Hieronder worden de verschillende items vermeld van het
contextmenu op elk niveau van de boom voor gegevensset.

Niveau Contextmenu Type database

GeoPackage
(1)

SpatiaLite PostGIS
SAP

HANA
MS

SQL
Server

Oracle

Bovenste
menu

Maak
een Nieuwe
verbinding…
naar een
bestaande
database
Database
maken…

Verbindingen
opslaan…
details
naar een
bestand
Verbindingen
laden…

Verbinding
/ Database

Bĳwerken
van een
verbinding
instellingen
Verbinding
bewerken…

Verbinding
verwĳderen

Verwĳderen
<database_name>

Compact
database
(VACUUM)

Een Nieuw
schema…
maken
Een
Nieuwe
tabel…
maken
SQL
uitvoeren…
query

Schema Bĳwerken
van een
schema

Vervolgt op volgende pagina
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Tabel 8.1 – Vervolgd van vorige pagina

Schema-
bewerkingen
► Schema
hernoemen…

Schema-
bewerkingen
► Schema
verwĳderen…

Een
Nieuwe
tabel…
maken
SQL
uitvoeren…
query

Tabel /
Laag

Tabel-
bewerkingen
► Tabel
hernoemen…

Tabel-
bewerkingen
► Tabel
afbreken…

SQL
uitvoeren…
query
Laag
exporteren
► Naar
bestand…

Beheren
► Laag
hernoemen
<layer_name>…

Beheren
► Laag
verwĳderen
<layer_name>…

Beheren ►
Geselecteerde
lagen
verwĳderen

Beheren
► Laag
aan project
toevoegen

Beheren ►
Geselecteerde
lagen aan
project
toevoegen

Vervolgt op volgende pagina
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Tabel 8.1 – Vervolgd van vorige pagina

Dialoogvenster
Laageigenschappen…
openen
Dialoogvenster
Bestandseigenschappen…
openen

Velden Nieuw veld
toevoegen…

Veld Veld
verwĳderen…

8.2.6 Tegels en webservices

Niveau Contextmenu Type services

WMS /
WMTS

VectortegelsXYZ-
tegels

WCS
WFS /

OGC API -
Features

ArcGIS
REST-
servers

GeoNode

Bovenste
menu

Een Nieuwe
verbinding… maken
Een Nieuwe algemene
verbinding… maken
Een Nieuwe ArcGIS
Vector Tile-service
verbinding… maken
Verbindingen opslaan…
details naar een bestand
Verbindingen laden…

VerbindingBĳwerken verbinding
instellingen verbinding
Bewerken…

verbinding Verwĳderen

Info service bekĳken in
webbrowser

Tabel
/
Laag

Laag exporteren ►
Naar bestand…

Laag aan project
toevoegen

Dialoogvenster
Laageigenschappen…
openen
Info service bekĳken in
webbrowser

1 De verschillende items kunnen ook beschikbaar zijn voor enkele door GDAL ondersteunde indelingen voor`vectorbestanden <https://gdal.
org/drivers/vector/index.html>`_, zoals ESRI File Geodatabase, FlatGeobuf, GeoParquet, NetCDF, … indien compatibel.
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8.3 Bronnen

• Projectbestanden. Het contextmenu voor QGIS projectbestanden stelt u in staat om:
– het te openen (Project openen)
– symbolen uit te nemen (Symbolen uitnemen…) - opent de Stĳlmanager die u in staat stelt symbolen te
exporteren naar een bestand XML, symbolen toe te voegen aan de standaard stĳl of als PNG of SVG te
exporteren.

– eigenschappen te inspecteren (Bestandseigenschappen…
U kunt het projectbestand uitbreiden om de lagen ervan te zien. Het contextmenu van een laag biedt dezelfde
acties als voor elders in de Browser beschreven.

• QGIS Laagdefinitie-bestanden (QLR). De volgende acties zĳn beschikbaar in het contextmenu:
– het exporteren (Laag exporteren ► Naar bestand…)
– het aan het project toevoegen (Laag aan project toevoegen)
– eigenschappen inspecteren (Laageigenschappen…

• Modellen voor Processing (.model3). De volgende acties zĳn beschikbaar in het contextmenu:
– Model uitvoeren…)
– Model bewerken…)

• QGIS sjablonen afdruklay-out (QPT). De volgende acties zĳn beschikbaar in het contextmenu:
– (Nieuwe lay-out uit sjabloon)

• scripts voor Python (.py). De volgende acties zĳn beschikbaar in het contextmenu:
– Script uitvoeren…)
– (In externe bewerker openen)

• Herkende indelingen voor rasters. De volgende acties zĳn beschikbaar in het contextmenu:
– het verwĳderen (Bestand <dataset name> verwĳderen)
– het exporteren (Laag exporteren ► Naar bestand…)
– het aan het project toevoegen (Laag aan project toevoegen)
– eigenschappen inspecteren (Laageigenschappen…, Bestandseigenschappen…)

Voor sommige indelingen kunt u ook <file type> extern openen…

• Herkende indelingen voor vectors. De volgende acties zĳn beschikbaar in het contextmenu:
– het verwĳderen (Bestand <dataset name> verwĳderen)
– het exporteren (Laag exporteren ► Naar bestand…)
– het aan het project toevoegen (Laag aan project toevoegen)
– eigenschappen inspecteren (Laageigenschappen…, Bestandseigenschappen…)

Voor sommige indelingen kunt u ook <file type> extern openen…
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QGIS Configureren

QGIS is zeer goed te configureren. Via het menu Extra verschaft het verschillende gereedschappen om:

• Stĳlmanager…: symbolen, stĳlen en kleurverlopen te maken en te beheren.

• Aangepaste projecties…: maak uw eigen coördinaten referentiesystemen.

• Toetsenbord sneltoetsen…: uw eigen set van toetsenbord sneltoetsen te definiëren. Ook kunnen zĳ gedurende
elke sessie van QGIS worden overschreven door de projecteigenschappen (toegankelĳk in het menu Project).

• Aanpassen van de interface…: configureer de interface van de toepassing, verberg dialoogvensters of
gereedschappen die u niet nodig hebt.

• Opties…: globale opties in te stellen om toe te passen in verschillende delen van de software. Deze voorkeuren
worden opgeslagen inde instellingen van het actieve gebruikersprofiel en standaard toegepast wanneer u een
nieuw project opent met dit profiel.

9.1 Opties

Sommige basisopties voor QGIS kunnen worden geselecteerd met behulp van het dialoogvenster Opties. Selecteer
de menuoptie Extra ► Opties. U kunt de opties naar uw wensen aanpassen. Sommige van de wĳzigingen zouden
het opnieuw starten van QGIS nodig kunnen hebben vóórdat zĳ effectief zouden worden.
De tabs waar u uw opties kunt aanpassen worden hieronder beschreven.

Notitie: Plug-ins kunnen hun instellingen inbedden in het dialoogvenster Opties
Hoewel hieronder alleen bron-instellingen worden weergegeven, onthoud dat deze lĳst kan worden uitgebreid door
geïnstalleerde plug-ins die hun eigen opties implementeren in het standaard dialoogvenster van Opties. Dit vermĳdt
dat elke plug-in zĳn eigen dialoogvenster voor configuratie met extra menuitems alleen voor zichzelf nodig heeft…
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9.1.1 Algemene instellingen

Fig. 9.1: Algemene instellingen

Landinstelling negeren
Standaard vertrouwt QGIS op de configuratie van uw besturingssysteem om de taal in te stellen en numerieke waarden
te bewerken. Inschakelen van deze groep stelt u in staat dit gedrag aan te passen.

• Selecteer de voor de GUI toe te passen taal uit Vertaling gebruikers-interface

• Selecteer in Landinstelling (indelingen voor getallen, datum en valuta) het systeem waarvoor datum en
numerieke waarden zouden moeten worden ingevoerd en gerenderd

• Scheidingsteken (duizendtallen) voor groep weergeven

Een samenvatting van de geselecteerde instellingen, en hoe zĳ zoudenworden geïnterpreteerd, wordt aan de onderzĳde
van het frame weergegeven.
Programma

• Selecteer Stĳl (QGIS herstart nodig) d.i. het uiterlĳk en plaatsing van de widget in dialoogvensters. Mogelĳke
waarden zĳn afhankelĳk van uw besturingssysteem.

• Definieer het Thema UI (Opnieuw opstarten QGIS vereist) . Het kan zĳn ‘default’, ‘Night Mapping’, of
‘Blend of Gray’
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• Definieer de Grootte pictogram

• Definieer het Lettertype en zĳn Grootte. Het lettertype kan zĳn Qt default of een door de gebruiker
gedefinieerd

• Wĳzigen van de Zichtbaarheidstĳd voor berichten of dialogen

• Openingsscherm bĳ opstarten verbergen

• QGIS nieuwsfeed weergeven op welkomstpagina: geeft een gecureerde QGIS nieuwsfeed weer op de
welkomstpagina, wat u een directe manier geeft om direct op de hoogte te zĳn van projectnieuws (datums voor
samenkomsten gebruikers/ontwikkelaars en samenvatting, onderzoekjes van de gemeenschap, aankondigingen
van uitgaven, verschillende tips…)

• Versie van QGIS bĳ opstarten controleren om u geïnformeerd te houden of er een nieuwere versie is
uitgegeven

• Eigen dialoogvensters voor kleurkeuze gebruiken (zie Kleur selecteren)
Projectbestanden

• Project bĳ het opstarten openen

– ‘Welkomstpagina’ (standaard): kan de “Nieuws”feed weergeven, de sjablonen voor het project en de meest
recente projecten (met miniaturen) van het gebruikersprofiel. Standaard wordt er geen project geopend.

– ‘Nieuw’: opent een nieuw project, gebaseerd op de standaardsjabloon
– ‘Meest recente’: heropent het laatste opgeslagen project
– en ‘Specifiek’: opent een bepaald project. Gebruik de knop … om het standaard te gebruiken project te
definiëren.

• Maak een nieuw project op basis van het standaardproject. U heeft de mogelĳkheid om het huidige project in
te stellen als standaardproject met de knop [Huidige project als standaardproject opslaan] of terug te gaan
naar het standaardproject met de knop [Standaard terugzetten]. U kunt met de knop [Bladeren] een map
(Sjabloonmap) instellen waar de sjablonen voor het project komen te staan. Er zal een sjabloonproject gekozen
kunnen worden bĳ de menuoptie Project► Nieuw van sjabloon, indien eerst het keuzevak Maak een nieuw
project op basis van het standaardproject is geactiveerd en vervolgens het project in de map met sjablonen is
opgeslagen.

• Vraag om project en wĳzigingen in brondata op te slaan indien nodig om te voorkomen dat u de wĳzigingen
die u maakte zult verliezen.

• Vraag om bevestiging wanneer een laag wordt verwĳderd

• Geef een waarschuwing bĳ het openen van een projectbestand uit een oudere versie van QGIS. U kunt altĳd
projecten openen die zĳn gemaakt met een oudere versie van QGIS, maar als het project eenmaal is opgeslagen
zou het proberen te openen met de oudere versie kunnen mislukken omdat mogelĳkheden in die versie niet
beschikbaar zouden kunnen zĳn.

• Macro’s toestaan . U kunt daarbĳ kiezen tussen ‘Nooit’, ‘Vragen’, ‘Alleen voor deze sessie’ en ‘Altĳd
(wordt afgeraden)’.

• Standaard paden: definieert of paden naar bestanden en lagen, gebruikt in nieuwe projecten, worden opgeslagen
als ‘Absoluut’ of ‘Relatief’ ten opzichte van het projectbestand. Deze instelling kan op projectniveau worden
overschreven.

• Standaard indeling projectbestand

– QGZ-archief bestandsindeling, ondersteunt hulpgegevens (zie :ref:`hulpgegevens
<vector_auxiliary_storage>)
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– QGS-project opgeslagen in gewone tekst, ondersteunt geen hulpgegevens: de hulpgegevens worden
opgeslagen in een afzonderlĳk bestand .qgd, naast het projectbestand.

9.1.2 Systeeminstellingen

SVG-paden
Pad(en) voor Scalable Vector Graphic (SVG)-symbolen toevoegen of verwĳderen. Deze SVG-bestanden zĳn dan
beschikbaar om de objecten te symboliseren of te labelen of de compositie van uw kaart te decoreren.
Lees ook Bestand op afstand of ingebed bestand selecteren voor verschillende manieren om te verwĳzen naar SVG-
bestanden in een pad van QGIS.
Plug-in paden
Voeg toe of verwĳder Pad(en) om naar aanvullende C++ plug-inbibliotheken te zoeken

Paden voor documentatie
Voeg toe of verwĳder Pad(en) voor documentatie om te zoeken naar QGIS Help. Standaard wordt een link toegevoegd
naar de officiële online Gebruikershandleiding voor de gebruikte versie. U kunt echter andere links toevoegen en ze
prioriteren van boven naar beneden: elke keer als u klikt op een knop Help in een dialoogvenster wordt de bovenste
link geselecteerd en als er geen corresponderende pagina wordt gevonden wordt de volgende geprobeerd enzovoort.

Notitie: Documentatie is alleen voor QGIS Long Term Releases (LTR) geversioneerd en vertaald, wat betekent dat
als u een normale uitgave gebruikt (bĳv, QGIS 3.0), zal de knop Help standaard de pagina voor de handleiding van
volgende LTR openen (bĳv. 3.4 LTR), wat de beschrĳving van mogelĳkheden in nieuwere uitgaven kan bevatten (3.2
en 3.4). Indien geen documentatie voor LTR beschikbaar is worden documenten van testing, met mogelĳkheden uit
nieuwere en ontwikkelversies, gebruikt.

Instellingen
Helpt u Gebruikersinterface terugzetten naar standaard instellingen (opnieuw starten vereist) indien u enige
aanpassingen maakte.
Systeem
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Fig. 9.2: Systeem omgevingsvariabelen

Systeem omgevingsvariabelen kunnen worden bekeken, en veel ervan geconfigureerd, in de groep Omgeving. Dit
is nuttig voor platforms zoals macOS, waar een GUI-toepassing niet noodzakelĳkerwĳze de shell-omgeving van de
gebruiker erft. Het is ook nuttig voor het instellen en bekĳken van omgevingsvariabelen voor de externe sets met
gereedschappen, die worden beheerd door de Toolbox van Processing (bĳv. SAGA, GRASS), en voor het inschakelen
van uitvoer voor debuggen voor specifieke gedeelten van de broncode.

Selecteer Aangepaste variabelen gebruiken (opnieuw opstarten vereist - inclusief scheidingstekens) en u kunt
systeemvariabelen Toevoegen en Verwĳderen. Voor elk nieuw item kun u een naam Variabele configureren, de
Waarde ervan en de methode voor het Toepassen, waaronder:

• Overschrĳven: vervang elke bestaande waarde van de variabele
• Indien niet gedefinieerd: gebruik deze waarde voor de variabele indien nog niet op een hoger niveau gedefinieerd
(bĳv. niveau van besturingssysteem of toepassing)

• Niet ingesteld: verwĳder de variabele uit de omgeving (de parameterWaarde wordt niet gebruikt)
• Vooraf vastgesteld: bepaal de waarde op de bestaande waarde van de variabele
• Toevoegen: voeg de waarde van de bestaande waarde van de variabele toe
• Overslaan: het item wordt behouden in de lĳst voor toekomstig gebruik, maar wordt niet gebruikt

Reeds gedefinieerde omgevingsvariabelen worden weergegeven in Huidige omgevingsvariabelen, en het is mogelĳk
ze te filteren met Alleen QGIS-specifieke variabelen weergeven.
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9.1.3 Instellingen voor CRS en transformaties

Notitie: Voormeer informatie over hoeQGIS projecteren van lagen afhandelt, bekĳk daarvoor het bestemde gedeelte
inWerken met projecties.

Afhandeling CRS

Op de tab Afhandeling CRS kunt u configureren welk CRS moet worden gebruikt voor een nieuw project of laag.

Fig. 9.3: Instellingen voor CRS

CRS voor projecten
Er is een optie om automatisch het CRS voor nieuwe projecten in te stellen:

• CRS van eerst toegevoegde laag gebruiken: het CRS van het project zal worden ingesteld op het CRS van de
eerste laag die erin geladen wordt

• Een standaard CRS gebruiken: een vooraf geselecteerd CRS wordt standaard toegepast op elk nieuw project
en wordt niet gewĳzigd bĳ het toevoegen van lagen aan het project.

De keuze zal worden opgeslagen om te gebruiken in volgende sessies van QGIS. Het Coördinaten ReferentieSysteem
van het project kan nog steeds worden overschreven vanaf de tab Project ► Eigenschappen… ► CRS.
CRS voor lagen
Standaard CRS voor lagen: selecteer een standaard te gebruiken CRS wanneer u een laag maakt
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U kunt ook de te nemen actie definiëren als een nieuwe laag wordt gemaakt, of wanneer een laag zonder CRS wordt
geladen.

• Als een onbekend CRS laten (geen actie ondernemen)

• Prompt voor CRS

• Gebruik huidige project CRS

• Standaard laag-CRS gebruiken

Waarschuwingen voor nauwkeurigheid
Alleen CRS waarschuwingen voor nauwkeurigheid weergeven voor onnauwkeurigheden die groter zĳn dan een
opgegeven afstand: treedt op wanneer u een gegevensset maakt of aanpast en een CRS selecteert, gebaseerd op een
datumsamenstelling met lagere nauwkeurigheid. Standaard is om de waarschuwing Toon altijd weer te geven
bĳ een onnauwkeurigheid. Vereist een versie van QGIS die tenminste PROJ 8.0 gebruikt.

CRS waarschuwingen voor nauwkeurigheid voor lagen weergeven in legenda van project: Indien geselecteerd
zal elke laag met problemen met nauwkeurigheid (d.i. een dynamisch CRS zonder een beschikbare epoch voor
coördinaten, of een CRS gebaseerd op een datumsamenstelling met inherente onnauwkeurigheid die de door d
gebruiker ingestelde limiet overschrĳdt) het waarschuwingspictogram naast zich bebben staan in het paneelLagen,
wat aangeeft dat het een laag met lage nauwkeurigheid is.
Dit is ontworpen voor gebruik bĳ ontwerpen, BIM, beheer van goederen, en andere velden waar onnauwkeurigheden
op het niveau van meter/submeter potentieel heel gevaarlĳk of erg kostbaar zĳn!

Planimetrische metingen: stelt de standaard in voor de eigenschap :ref:`planimetrische metingen
<measurements_ellipsoid> ` in voor nieuw gemaakte projecten.

Coördinaten transformeren

De tab Coördinaten transformaties helpt u transformaties voor coördinaten en bewerkingen in te stellen diemoeten
worden toegepast bĳ het laden van een laag in een project of het opnieuw projecteren van een laag.

Fig. 9.4: Instellingen voor transformaties
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Standaard datumtransformaties
Hier kunt u beheren of het opnieuw projecteren van lagen naar een ander CRS zou moeten worden:

• automatisch verwerkt met instellingen voor standaard transformaties van;
• en/of meer door u moet worden beheerd met aangepaste voorkeuren zoals:

– Vraag naar datumtransformatie als meerdere beschikbaar zĳn

– een vooraf gedefinieerde lĳst met datumtransformaties om standaard toe te passen. Bekĳk
Datumtransformaties voor meer details.

U kunt transformaties Toevoegen, Verwĳderen of Bewerken, dat zal worden gebruikt in elk nieuw gemaakt project.

Gebruikergedefinieerd CRS

De tab Gebruikergedefinieerd CRS helpt u om een aangepast CRS te definiëren, dat moet voldoen aan een
tekenreeksindeling voor WKT of Proj.

Fig. 9.5: Gebruikergedefinieerd CRS

Stel een Naam in en gebruik Nieuw CRS toevoegen. Als u een bestaande wilt verwĳderen kunt u CRS verwĳderen

gebruiken.
Definitie

• Indeling

– WKT (aanbevolen)
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– Proj-tekenreeks (historisch - niet aanbevolen)
• Parameters

– Parameters van een bestaand CRS kopiëren.
– Valideren test of uw expressie correct is.

Testen
Hier kunt u uw gemaakte definitie voor het CRS testen op Latitude en Longitude. Gebruik een bekend coördinaat
om te controleren of uw definitie nauwkeurig is.

9.1.4 Instellingen voor Databronnen

Fig. 9.6: Instellingen voor Databronnen

Object-attributen en tabel

• Attributentabel openen als vastgezet venster

• Objecten kopiëren als ‘Platte tekst, geen geometrie’, ‘Platte tekst,WKT geometrie’, of ‘GeoJSON’ bĳ het plakken
van objecten in andere toepassingen.

• Gedrag attributentabel : filter instellen bĳ het openen van de attributentabel. Er zĳn drie mogelĳkheden:
‘Alle attributen tonen’, ‘Geselecteerde objecten tonen’ en ‘Op kaart zichtbare objecten tonen’

• Standaard weergave modus voor weergave definiëren van de attributentabel bĳ elke opening. Het kan zĳn
‘Laatste weergave onthouden’, ‘Tabelweergave’ of ‘Formulierweergave’.
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• Rĳcache attributentabel . Deze rĳcache zorgt ervoor dat het laatste geladen aantal N rĳen met attributen
in de cache (=geheugenruimte) worden opgeslagen, zodat het werken met de attributentabel sneller gaat. De
gegevens in de cache worden verwĳderd bĳ het sluiten van de attributentabel.

• Weergave van waarden NULL Hier kunt u, voor velden die een waarde NULL bevatten, een andere waarde
opgeven om te laten zien.

Tip: Verbeterd openen van attributentabel voor big data
Bĳ het werken met lagen met zeer grote hoeveelheden records, zou het openen van de attributentabel enorm traag
kunnen zĳn omdat het dialoogvenster alle rĳen in de laag opvraagt. Instellen van het Gedrag attributentabel op Op
kaart zichtbare objecten tonen zal er voor zorgen dat QGIS alleen de objecten in het huidige kaartvenster opvraagt
bĳ het openen van de tabel, wat het snel laden van gegevens mogelĳk maakt.
Onthoud dat gegevens in deze instantie van de attributentabel altĳd zullen zĳn gebonden aan het bereik van het
kaartvenster waarmee het werd geopend, wat betekent dat het selecteren van Alle objecten tonen in een dergelĳke
tabel geen nieuwe objecten zal laten weergeven. U kunt echter de set met weergegeven objecten bĳwerken door
het bereik van het kaartvenster te wĳzigen en de optie Op kaart zichtbare objecten tonen te selecteren in de
attributentabel.

Omgang met databron

• Zoek naar geldige items in het browser dock . U kunt kiezen tussen ‘Extensie controleren’ en
‘Bestandsinhoud controleren’.

• Zoek naar de inhoud van gecomprimeerde (.zip) bestanden in het browser-dock definieert hoe
gedetailleerd de informatie in de widget is aan de onderzĳde van het paneel Browser bĳ het bevragen van
dergelĳke bestanden. ‘Nee’, ‘Basisscan’ en ‘Volledige scan’ zĳn de opties.

• Suggereer sublagen tĳdens het openen. Enkele rasterindelingen ondersteunen sublagen — deze worden
subdatasets in GDAL genoemd. Een voorbeeld is het netCDF bestandsformaat - wanneer er veel netCDF-
variabelen zĳn, dan ziet GDAL elke variabele als een subdataset. De optie wordt gebruikt om controle te
krĳgen hoe om te gaan, tĳdens het laden van, met een rasterbestand dat sublagen bevat. De volgende keuzes
zĳn mogelĳk:

– ‘Altĳd’: Altĳd vragen (wanneer er sublagen aanwezig zĳn)
– ‘Indien nodig’: Vragen indien de laag geen bandlagen maar wel sublagen heeft
– ‘Nooit’: Nooit vragen, laad geen sublagen
– ‘Alles laden’: Nooit vragen, gewoon alle sublagen laden

• Automatisch mappen in dock van browser verversen als hun inhoud wĳzigt: Stelt u in staat om het standaard
monitoren van mappen in het paneel Browser handmatig uit te schakelen (bĳv, om potentiële vertragingen door
traagheid van het netwerk te vermĳden).

Gelokaliseerde gegevenspaden
Het is mogelĳk gelokaliseerde gegevenspaden te gebruiken voor elke soort op bestanden gebaseerde databron. Zĳ zĳn
een lĳst van paden die worden gebruikt om de locatie voor de databron uit te nemen. Als, bĳvoorbeeld, C:\my_maps
is vermeld in de gelokaliseerde gegevenspaden, zal een laag die C:\my_maps\my_country\ortho.tif als
databron heeft worden opgeslagen in het project met localized:my_country\ortho.tif.
De gegevenspaden worden vermeld in volgorde van voorkeur, met andere woorden: QGIS zal eerst zoeken naar het
bestand in het eerste pad, dan in het tweede, etc.
Verborgen paden in browser
Dit widget vermeld alle mappen die u kunt kiezen om te verbergen in het paneel Browser. Verwĳderen van een map
uit de lĳst zal die weer beschikbaar maken in het paneel Browser.
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Instellingen voor GDAL

GDAL is een uitwisselingsbibliotheek voor georuimtelĳke gegevens dat een groot aantal indelingen voor vector-
en rasterbestanden ondersteunt. Het verschaft stuurprogramma’s om gegevens in deze indelingen te lezen en (vaak)
te schrĳven. De tab GDAL geeft momenteel de stuurprogramma’s weer voor raster- en vectorindelingen met hun
mogelĳkheden.
GDAL raster en vector stuurprogramma’s
De tabs Raster stuurprogramma’s en Vector stuurprogramma’s stellen u in staat te definiëren welk stuurprogramma
voor GDAL is ingeschakeld voor het lezen en/of schrĳven van bestanden, omdat in sommige gevallen meer dan één
stuurprogramma van GDAL beschikbaar is.

Fig. 9.7: Instellingen voor GDAL - Raster stuurprogramma’s

Tip: Dubbelklikken op een raster stuurprogramma dat toegang voor lezen en schrĳven toestaat (rw+(v)), opent
het dialoogvenster Schrĳf-opties aanpassen om aan te passen.

Opties raster stuurprogramma’s
Dit frame verschaft manieren om het gedrag van stuurprogramma’s voor rasters, die toegang voor lezen en schrĳven
ondersteunen, aan te passen:

• Schrĳf-opties aanpassen: stelt u in staat verschillende profielen voor bestandstransformaties te bewerken
of toe te voegen, d.i. een set van vooraf gedefinieerde combinaties van parameters (type en niveau van
compressie, blokgrootten, overzicht, kleurbepaling, alfa…) om te gebruiken bĳ de uitvoer van rasterbestanden.
De parameters zĳn afhankelĳk van het stuurprogramma.
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Fig. 9.8: Voorbeeld van schrijf-opties voor profiel (voor GeoTiff)

Het bovenste gedeelte van het dialoogvenster vermeldt het/de huidige profiel(en) en stelt u in staat nieuwe toe
te voegen of bestaande te verwĳderen. U kunt het profiel ook terugzetten naar zĳn standaard parameters als u
ze hebt gewĳzigd. Sommige stuurprogramma’s (bĳv. GeoTiff) hebben enkele voorbeeldprofielen waarmee u
kunt werken.
Aan de onderzĳde van het dialoogvenster:

– De knop laat u rĳen toevoegen om ze te vullen met de naam en waarde van de parameter

– De knop verwĳdert de geselecteerde parameter
– Klik op de knop Controleren om te controleren of de ingevoerde schrĳf-opties geldig zĳn voor de
opgegeven indeling

– Gebruik de knop Help om naar de te gebruiken parameters te zoeken, of bekĳk de documentatie voor
GDAL raster drivers.

• Opties voor piramiden aanpassen
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Fig. 9.9: Voorbeeld van profiel voor piramiden

9.1.5 Instellingen voor renderen

De tab Renderen verschaft instellingen voor het beheren van het renderen van lagen in het kaartvenster.
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Fig. 9.10: Instellingen voor renderen

Gedrag bĳ renderen

• Standaard zullen nieuw toegevoegde lagen aan de kaart direct worden afgebeeld: deselecteren van deze optie
kan handig zĳn bĳ het laden van meerdere lagen om te vermĳden dat elke nieuwe laag in het kaartvenster wordt
gerenderd en het proces vertraagt

• Stel het Maximum aantal te gebruiken cores voor het renderen van de kaart in

• Het kaartvenster rendert op de achtergrond in een afzonderlĳke afbeelding en elke updateKaart-update interval
(standaard 250 ms) zal de inhoud van deze (niet op het scherm) afbeelding worden genomen om de zichtbare
weergave op het scherm bĳ te werken. Als het renderen echter sneller is voltooid dan deze duur, zal het direct
worden weergegeven.

• Vergrotingsniveau (zie het Vergrootglas)
Kwaliteit renderen

• Maak de lĳnen minder rafelig ten koste van de tĳd dat het tekenen kost
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Instellingen voor renderen vectors

De tab Vector bevat specifieke instellingen voor het renderen van vectorlagen.

Fig. 9.11: Instellingen voor renderen vectors

• Vereenvoudiging van objecten standaard inschakelen voor nieuw toegevoegde lagen u vereenvoudigt de
geometrie van objecten (minder knopen) en als resultaat worden ze sneller weergegeven. Onthoud dat dit ook
inconsistenties kan veroorzaken door het renderen. Beschikbare instellingen zĳn:

– Drempel vereenvoudiging (hogere waarden resulteren in meer vereenvoudiging)

– Algoritme Vereenvoudigen: Deze optie voert een lokale “directe” vereenvoudiging uit op objecten en
versnelt het renderen van de geometrie. Het wĳzigt niet de geometrie die wordt opgehaald van de
gegevensproviders. Dit is belangrĳk als u expressies heeft die de geometrie van een object gebruiken
(bĳv. bĳ berekening van een gebied) - we willen er zeker van zĳn dat de berekeningen worden uitgevoerd
op de originele geometrie, niet op de vereenvoudigde. Voor dit doel verschaft QGIS drie algoritmes:
‘Afstand’ (standaard), ‘SnapToGrid’ en ‘Visvalingam’.

– Vereenvoudigen bĳ de bron indien mogelĳk: de geometrieën worden vereenvoudigd door de provider
(PostGIS, Oracle…) en anders dan de vereenvoudiging aan de lokale zĳde, kunnen op geometrie
gebaseerde berekeningen worden beïnvloed

– Maximale schaal waarmee de laag vereenvoudigd zou moeten worden (vereenvoudigt altĳd 1:1)

Notitie: Naast de globale instelling kan vereenvoudigen van objecten worden ingesteld voor een specifieke
laag vanuit zĳn menu Laageigenschappen ► Rendering.

• Segmentatie boog

– Tolerantie voor segmentatie: deze instelling beheert de manier waarop cirkelvormige bogen worden
gerenderd. Hoe kleiner de maximum hoek (tussen de twee opeenvolgende punten en het midden van
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de boog, in graden) of maximum verschil (afstand tussen de twee punten en de lĳn van de boog, in
kaarteenheden), des te meer segmentenmeer rechte lĳnen zullen worden gebruikt bĳ het renderen.

– Type tolerantie: het kan zĳn ‘Maximum hoek’ of ‘Maximum afstand’ tussen benadering en boog.

Instellingen voor renderen rasters

De tab Raster bevat specifieke instellingen voor het renderen van rasterlagen.

Fig. 9.12: Instellingen voor renderen rasters

onder Banden en hersamplen

• met RGB-band selectie kan men het nummer voor de Rode, de Groene en de Blauwe band opgeven.
• De methoden Ingezoomd op resampling en Uitgezoomd op resampling kunnen worden gedefinieerd. Voor

Ingezoomd op resampling kunt u kiezen uit drie methoden voor resamplen: ‘Dichtstbĳzĳnde buur’, ‘Bilineair’
en ‘Kubisch’. Voor Uitgezoomd op resampling kunt u kiezen tussen ‘Dichtstbĳzĳnde buur’ en ‘Gemiddelde’. U
kunt ook de waarde Oversampling instellen (tussen 0.0 en 99.99 - een hogere waarde betekent meer werk voor
QGIS - de standaardwaarde is 2.0).

• Vroeg hersamplen: maakt hetmogelĳk het renderen van het raster te berekenen op het niveau van de provider
waarbĳ de resolutie van de bron bekend is, en zorgt voor een beter renderen bĳ inzoomen met aangepaste
opmaak voor QGIS. Echt handig voor tegelrasters die worden geladen met een interpretatie methode. De optie
kan ook worden ingesteld op het niveau van de laag (eigenschappen Symbology)

Opties voor Contrast verbetering kunnen worden toegepast op Enkelbands grĳs, Multiband kleur (byte/band) of
Multiband kleur (>byte/band). Voor elk kunt u instellen:

• het te gebruiken Algoritme, waarvan de waarden kunnen zĳn ‘Geen Stretch’, ‘Uitstrekken tot MinMax’,
‘Uitstrekken en clippen tot MinMax’ of ‘Clip naar MinMax’.

• het toe te passen Bereik (minimum/maximum), met waarden zoals ‘Cumulatieve telling deel van pixels’,
‘Minimum/Maximum’, ‘Gemiddelde +/- standaardafwĳking’.
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De opties voor Contrast verbetering bevatten ook:
• Bereik Cumulatieve telling van pixels

• Vermenigvuldigingsfactor voor standaardafwĳking

9.1.6 Instellingen kaartvenster en legenda

Fig. 9.13: Instellingen kaartvenster en legenda

Deze eigenschappen laten u instellen:
• de Standaardwaarden kaart (worden door projectwaarden overschreven): de Selectiekleur en

Achtergrondkleur.
• interactie met Legenda van de lagen :

– Dubbelklik actie in legenda . U kunt kiezen uit ‘Open Laageigenschappen’, ‘Open attributentabel’
of ‘Paneel voor het opmaken van de stĳl openen’ met dubbelklikken.

– Aantal objecten voor nieuw toegevoegde lagen weergeven: geeft in het paneel Lagen het aantal objecten
weer naast de laagnaam. Telling van het aantal klasse, indien aanwezig, wordt ook weergegeven. U kunt
met rechts klikken op een laag om de telling van de objecten aan/uit te zetten.

– Namen voor classificatie weergeven in het paneel Lagen, bĳv. bĳ het toepassen van een renderer
Categorieën of Regel-gebaseerd (bekĳk Eigenschappen Symbologie voor meer informatie).

– de resolutie voor WMS getLegendGraphic

– Minimum en Maximum grootte symbool legenda om de weergave van de grootte van het symbool in het
paneel Lagen te beheren

• de Vertraging in milliseconden voor het weergeven van kaarttips van lagen
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• Of QGIS zou moeten DPI voor scherm respecteren: Indien ingeschakeld zal QGIS proberen het kaartvenster
weer te geven met een fysiek nauwkeurige schaal op het scherm, afhankelĳk van het fysieke DPI van de
monitor. Symbologie met gespecificeerde grootte voor weergave zal ook nauwkeurig worden gerenderd, bĳv.
een symbool van 10mm zal worden weergegeven als 10mm op het scherm. Echter, grootten van lettertypen
van labels op het kaartvenster zouden kunnen verschillen van die in de gebruikersinterface van QGIS of
andere toepassingen. Als deze instelling is uitgeschakeld zal QGIS het logische DPI van het besturingssysteem
gebruiken, wat consistent zal zĳn met andere toepassingen op het systeem. Echter, schaal van het kaartvenster
en grootte van symbologie zou fysiek onnauwkeurig kunnen zĳn op het scherm. In het bĳzonder, op hoge-DPI-
schermen, lĳkt symbologie waarschĳnlĳk te klein te verschĳnen.

Voor de beste ervaring wordt aanbevolen om DPI voor scherm respecteren te selecteren, speciaal bĳ
het gebruiken van meerdere of verschillende monitoren en voorbereiden van visueel hoge kwaliteit kaarten.
Uitschakelen van DPI voor scherm respecteren zal uitvoer maken die meer geschikt zou kunnen zĳn voor het
in kaart brengen die bedoeld is om alleen op het scherm te gebruiken, speciaal waarbĳ grootten van lettertypen
zouden moeten overeenkomen met andere toepassingen.

Notitie: Renderen in lay-outs wordt niet beïnvloedt door de instelling DPI voor scherm respecteren; het respecteert
altĳd de gespecificeerde DPI voor het doel-uitvoerapparaat. Onthoud ook dat deze instelling de fysieke scherm-DPI
gebruikt, zoals die wordt gerapporteerd door het besturingssysteem, wat niet nauwkeurig zou hoeven te zĳn voor alle
weergaven.

9.1.7 Instellingen kaartgereedschap

Fig. 9.14: Instellingen kaartgereedschap
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Deze tab biedt enkele opties met betrekking tot het gedrag van het gereedschap Objecten identificeren.
• Zoekradius voor de identificatie van objecten en het tonen van kaarttips is een afstand voor tolerantie waarbinnen
het gereedschap Objecten identificeren resultaten zal weergeven, zolang u klikt binnen deze tolerantie.

• Markeerkleur stelt u in staat te kiezen met welke kleur objecten, die worden geïdentificeerd, zouden moeten
worden geaccentueerd.

• Buffer bepaalt een bufferafstand die moet worden gerenderd vanaf de omtrek van het geaccentueerde object.
• Minimale breedte bepaalt hoe dik de rand van een geaccentueerd object moet worden weergegeven.

Meetgereedschap
• Geef de Kleur elastiek voor het meetgereedschap
• Definieer het aantal te gebruiken Decimale posities

• Vasthouden aan basiseenheid om niet automatisch grote getallen te converteren (bĳv. meters naar
kilometers)

• Voorkeur eenheden voor afstand: opties zĳn ‘Meters’, ‘Kilometers’, ‘Voet’, ‘Yards’, ‘Mĳlen’, ‘Zeemĳlen’,
‘Centimeters’, ‘Millimeters’, ‘Graden’ of ‘Kaarteenheden’

• Voorkeur eenheden voor gebieden: opties zĳn ‘Vierkante meters’, ‘Vierkante kilometers’, ‘Vierkante voet’,
‘Vierkante yards’, ‘Vierkante mĳlen’, ‘Hectares’, ‘Acres’, ‘Vierkante zeemĳlen’, ‘Vierkante centimeters’,
‘Vierkante millimeters’, ‘Vierkante graden’ of ‘Kaarteenheden’

• Voorkeur hoekeenheden: opties zĳn ‘Graden’, ‘Radialen’, ‘Gon/gradians’, ‘Minuten van de boog’, ‘Seconden van
de boog’, ‘Draaiingen/omwentelingen’, milliradialen (SI-definitie) of mil (NATO/militaire definitie)

Weergave coördinaten en richting
Dit gedeelte verschaft manieren om te Configureren:

• Standaard indeling voor coördinaten voor nieuwe projecten, zoals weergeven in het vak Coördinaten op de
statusbalk van QGIS en in het gedeelte Afgeleid van de resultaten van het gereedschap Objecten identificeren

• Standaard indeling voor richting voor nieuwe projecten, zoals weergegeven in de statusbalk voor de richting van
het verplaatsen in het kaartvenster en het gereedschap Richting meten.

Deze opties kunnen worden overschreven op het projectniveau.
Schuiven en zoomen

• Stel een Zoomfactor in voor gereedschappen om te zoomen of het muiswiel
Vooraf ingestelde schalen
Hier vindt u een lĳst met vooraf gedefinieerde schalen om standaard weer te geven in de schaal-gerelateerde keuze,
widgets, zoals Schaal van de statusbalk, de keuzelĳst voor zichtbaarheid van schalen of instellingen voor secundaire
2D-kaartweergave,…. Met de knoppen en kunt u uw persoonlĳke schalen toevoegen of verwĳderen. U
kunt ook schalen im-/exporteren uit/naar een .XML-bestand. Onthoud dat u nog steeds de mogelĳkheid hebt om uw
wĳzigingen te verwĳderen en de vooraf gedefinieerde lĳst te herstellen.
Vanuit het dialoogvenster voor het project kunt u ook uw eigen set schalen instellen, die deze globale in de widgets
overschrĳft.
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Instellingen voor digitaliseren

Fig. 9.15: Instellingen voor digitaliseren

Deze tab helpt u algemene instellingen te configureren bĳ bewerken van vectorlaag (attributen en geometrie).
Object maken

• Voorkom tonen van attributenformulier na intekenen object: deze keuze kan in elk dialoogvenster
Laageigenschappen worden overschreven.

• Laatst ingevoerde attribuutwaarden gebruiken: onthoud de laatste gebruikte waarde van elk attribuut en
gebruik dat als standaard voor het volgende object dat wordt gedigitaliseerd. Werkt per laag. Dit gedrag kan
ook worden beheerd op een basis per-veld (bekĳk Het gedrag van velden configureren).

• Valideer geometrieën tĳdens het bewerken van complexe lĳnen/polygonen bestaande uit veel punten kan dat
het tekenen vertragen. Dit komt omdat de standaardvalidatie in QGIS veel tĳd kan kosten. U kunt ook, om
het tekenen tĳdens het bewerken te versnellen, kiezen voor de GEOS geometrievalidatie (beschikbaar vanaf
GEOS 3.3) of om het valideren uit te zetten. De validatie met GEOS is veel sneller maar het nadeel is dat deze
alleen het eerste probleem met geometrie rapporteert.
Onthoud dat, afhankelĳk van de selectie, rapporten of geometriefouten zouden kunnen verschillen (zie Typen
foutberichten en hun betekenissen)

• Standaardwaarde Z te gebruiken bĳ het maken van nieuwe 3D-objecten.
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Elastiek
• Definieer de Lĳndikte, Lĳnkleur en Vulkleur van het elastiek.
• Elastiek niet bĳwerken gedurende bewerken van punt.

Snappen

• Snappen standaard inschakelen activeert snappen als een project is geopend

• Definieer de Standaard ‘snap’-modus (‘Hoekpunt’, ‘Segment’, ‘Centroïde’, ‘Midden van segmenten’, Lĳn-
eindpunten’, ‘Vlak’)

• Stel de Standaard ‘snapping’-tolerantie in kaarteenheden of pixels in
• Definieer de Zoekradius voor aanpassingen hoekpunten in ‘kaarteenheden’ of ‘pixels’
• Hoofdvenster weergeven als (opnieuw starten vereist): ingesteld of het dialoogvenster Gevorderd snappen zou
moeten worden weergegeven als ‘Dialoogvenster’ of ‘Vastzetten’.

• Markeringskleur voor snappen

• Helptips voor snappen weergeven zoals de naam van de laag waarvan u het object zult gaan snappen. Nuttig
als meerdere objecten elkaar overlappen.

• Snappen aan niet-zichtbare objecten inschakelen (niet weergegeven in het kaartvenster)

Hoekpunten

• Markeringen alleen gebruiken voor geselecteerde objecten heeft betrekking op het tonen ervan

• Wĳzig de Markeringstĳl naar (‘Kruis’ (standaard), ‘Semi-transparante cirkel’ of ‘Niets’)
• Definiëren punt Markeringsgrootte (in millimeter)

Gereedschap Verspringing boog

De volgende 3 opties hebben betrekking op het gereedschap Verspring curve, zie Geavanceerd digitaliseren. Met
de verschillende instellingen is het mogelĳk om de vorm van de versprongen lĳn te beïnvloeden. Deze opties zĳn
beschikbaar sinds GEOS 3.3.

• Verbindingsstĳl: ‘Rond’, ‘Puntig’ of ‘Hoekig’
• Segmenten per Kwadrant

• Maximale puntlengte bĳ scherpe hoeken

Traceren

Door Traceren naar boog converteren kunt u boogsegmenten maken tĳden het digitaliseren. Onthoud dat uw
gegevensprovider deze mogelĳkheid moet ondersteunen.
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9.1.8 3D-instellingen

Fig. 9.16: 3D-instellingen

Het menu 3D helpt u enkele standaard instellingen te configureren om te gebruiken voor een 3D-kaartweergave.
Deze mogen verwĳzen naar Standaard camera-instellingen:

• Type projectie: wat het mogelĳk maakt de 3D-scene te bekĳken in een:
– Perspectief projectie (standaard): Parallelle lĳnen schĳnen elkaar in de verte te ontmoeten. Objecten
schĳnen kleiner te worden als zĳ verder van de camera af staan.

– of een Loodrechte projectie: Parallelle lĳnen lĳken parallel. Objecten lĳken van dezelfde grootte, ongeacht
de afstand.

• Camera’s Veld voor weergave: alleen relevant in Perspectief projectie, specificeert het huidige verticale veld
voor weergave in graden en bepaalt hoeveel van de scene zichtbaar is voor de camera. Standaardwaarde is 45°.

• Modus Navigatie: verschaft verschillende manieren voor interactie met de 3D-scene. Beschikbare modi zĳn:
– Terrein gebaseerd: de camera volgt rondom een vaste positie op het oppervlakte van het terrein als door
de scene wordt genavigeerd.

– Modus Wandelen (eerste persoon)

Afhankelĳk van de geselecteerde modus verschillen de opdrachten voor navigatie.
• Snelheid van verplaatsing

• Verticale as inverteren: Beheert of bewegingen rondom de verticale as moeten worden geïnverteerd ten opzichte
van hun normale gedrag. Beïnvloedt alleen bewegingen in de Modus Wandelen. Het kan worden ingesteld op:

– Nooit

– Alleen bĳ slepen: zorgt er voor dat de verticale beweging alleen wordt geïnverteerd bĳ het uitvoeren van
een klik-en-sleep draaien van de camera
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– en Altĳd: zorgt er voor dat bewegingen worden geïnverteerd bĳ zowel klik-en-sleep als wanneer de
beweging van de camera is vastgezet naar de cursor (via een druk op de toets ~)

9.1.9 Kleurinstellingen

Fig. 9.17: Kleurinstellingen

Dit menu stelt u in staat paletten of kleuren te maken of bĳ te werken, die door de gehele toepassing heen worden
gebruikt, in de widget Kleur selecteren. U kunt kiezen uit:

• Recente kleuren geeft recent gebruikte kleuren weer
• Standaardkleuren, het standaard palet kleuren
• Projectkleuren, een set kleuren specifiek voor het huidige project (bekĳk Eigenschappen Stĳlen voor meer
details)

• Kleuren nieuwe laag, een standaard te gebruiken set kleuren als nieuwe lagen worden toegevoegd aan QGIS
• of aangepast(e) palet(ten) die u kunt maken of importeren met de knop … naast het combinatievak voor het
palet.

Standaard kunnen de paletten Recente kleuren, Standaardkleuren en Projectkleuren niet worden verwĳderd en zĳn
ingesteld om te verschĳnen in de keuzelĳst voor de kleuren. Aangepaste paletten kunnen ook aan dit widget worden
toegevoegd met de optie In Kleurknoppen weergeven.
Voor elk van de paletten kunt u de lĳst met kleuren beheren met de set gereedschappen naast het frame, d.i.:

• kleur Toevoegen of Verwĳderen

• kleur Kopiëren of Plakken
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• de set kleuren vanuit/naar bestand .gpl Importeren of Exporteren.
Dubbelklik op een kleur in de lĳst om die aan te passen of te vervangen in het dialoogvenster Kleur selecteren. U kunt
het ook hernoemen door erop te dubbelklikken in de kolom Label.

9.1.10 Instellingen voor lettertypen

Fig. 9.18: Instellingen voor lettertypen

De tab Lettertypen verschaft ondersteuning voor het beheren van lettertypen die in alle projecten worden gebruikt:
• Lettertypen vervangingen: geeft de mogelĳkheid een lĳst te vullen met automatisch vervangende lettertypen om
toe te passen bĳ het laden van projecten of stĳlen, wat betere ondersteuning voor projecten en stĳlen geeft om
te worden gebruikt in de verschillende besturingssystemen (bĳv. vervang “Arial” door “Helvetica”).

• Lettertypen gebruiker: Stelt u in staat lettertypen TTF of OTF te plaatsen in de submap fonts van het
gebruikersprofiel. Deze lettertypen kunnen automatisch worden geladen bĳ het opstarten van QGIS. Dit
verschaft een manier om lettertypen te gebruiken zonder dat ze zĳn geïnstalleerd op het niveau van het
besturingssysteem, wat vaak geblokkeerd is in zakelĳke omgevingen. Het paneel vermeld alle geïnstalleerde
gebruikergedefinieerde lettertypen en stelt u tevens in staat eerder geïnstalleerde lettertypen voor gebruiker te
beheren (d.i. verwĳderen).

Het is mogelĳk om Automatisch ontbrekende vrĳ gelicenseerde lettertypen downloaden: Bĳv. als u een
project of stĳl opent, of probeert een vector tegellaag te laden die verwĳst naar lettertypen die momenteel niet
beschikbaar zĳn, dan wordt een hard-gecodeerde lĳst met vrĳ gelicenseerde lettertypen geraadpleegd om te
bepalen of het mogelĳk om het lettertype automatisch te downloaden naar de map voor de lettertypen van het
gebruikersprofiel (met notificatie van de licentie van het lettertype).
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9.1.11 Instellingen voor Lay-outs

Fig. 9.19: Instellingen voor Lay-outs

Standaardwaarden opmaak
U kunt het Standaard lettertype definiëren dat wordt gebruikt binnen de afdruklay-out.
Ruitennetweergave

• Definieer de Ruitennetstĳl (‘Doorgetrokken’, ‘Stippels’, ‘Kruisjes’)
• Definieer de Gridkleur

Standaarden voor raster en hulplĳnen
• Definieer de Rasterafstand
• Definieer de Ruitennetverspringing voor X en Y
• Definieer de ‘Snap’ tolerantie

Paden voor lay-outs
• Definieer Pad(en) om te zoeken naar extra sjablonen voor afdrukken: een lĳst met mappen met aangepaste
sjablonen voor afdruklay-out die kunnen worden gebruikt bĳ het maken van nieuwe.
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9.1.12 Instellingen voor Variabelen

De tab Variabelen vermeldt alle variabelen die beschikbaar zĳn op het niveau globaal.

Het stelt de gebruiker in staat om variabelen op het niveau globaal te beheren. Klik op de knop om een nieuwe
aangepaste variabele op globaal niveau toe te voegen. Selecteer op dezelfde wĳze een aangepaste variabele op het
globale niveau en klik op de knop om hem te verwĳderen.
Meer informatie over variabelen in het gedeelteWaarden opslaan in Variabelen.

Fig. 9.20: Instellingen voor Variabelen

9.1.13 Instellingen voor Authenticatie

Op de tab Authenticatie kunt u configuraties voor authenticatie instellen en certificaten voor PKi beheren. Bekĳk
Authenticatiesysteem voor meer details.
U kunt de lĳst met gereedschappen naast het frame gebruiken om authenticaties te beheren, d.i.:

• Nieuwe configuratie voor authenticatie toevoegen

• Geselecteerde configuratie voor authenticatie verwĳderen

• Geselecteerde configuratie voor authenticatie bewerken
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Fig. 9.21: Instellingen voor Authenticatie

9.1.14 Instellingen voor Netwerk

Algemeen
• Definieer de ‘Time-out’ voor netwerkaanvragen (ms) - standaard ingesteld op 60000
• Definieer Standaard vervalperiode van WMS Capabilities (uren) - standaard is 24
• Definieer Standaard verlooptĳd van WMS-C/WMTS tegels (uren) - standaard is 24
• Definieer Max. aantal keren opnieuw proberen in geval van fouten bĳ ophalen van tegels of objecten

• Geef de User-Agent

9.1. Opties 85



QGIS Desktop 3.28 User Guide

Fig. 9.22: Instellingen voor netwerk en proxy

Cache-instellingen
Definieert de Map en een Grootte voor de cache. Biedt ook gereedschappen om Automatisch cache voor toegang
netwerk authenticatie bĳ fouten in SSL leegmaken (aanbevolen).
Proxy gebruiken voor toegang tot web

• Proxy gebruiken voor toegang tot web

• Stel het Proxy type in naar behoeften en definieer ‘Host’ en ‘Poort’. Beschikbare typen proxy zĳn:
– Default proxy: Proxy wordt bepaald gebaseerd op de proxy van het systeem
– Socks5Proxy: Een algemene proxy voor elk soort verbinding. Ondersteunt TCP, UDP, directe verbinding
op poort (binnenkomende connecties) en authenticatie.

– HttpProxy: Gebruikt de opdracht “CONNECT”, ondersteunt alleen uitgaande TCP-verbindingen;
ondersteunt authenticatie.

– HttpCachingProxy: Gebruikt normale HTTP opdrachten, deze is alleen geschikt bĳ het gebruik van HTTP
requests

– FtpCachingProxy: Gebruikt een FTP proxy, is alleen goed bruikbaar in de context van FTP requests.
Inloggegevens voor de proxy worden ingesteld met de widget Authenticatie.
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Uitsluiten van enkele URL’s kan aan het tekstvak onder de proxy-instellingen worden toegevoegd (zie Fig. 9.22). Geen
proxy zal worden gebruikt als de doel_URL begint met één van de tekenreeksen die zĳn vermeld in het tekstvak.
Wanneer u meer gedetailleerde informatie nodig hebt over de verschillende instellingen voor proxy’s, verwĳzen we
naar de handleiding voor de documentatie van de onderliggende bibliotheek voor QT op https://doc.qt.io/archives/
qt-5.9/qnetworkproxy.html#ProxyType-enum.

Tip: Proxy’s gebruiken
Het gebruiken van proxy’s kan soms erg lastig zĳn. Gebruik de methode ‘trial and error’ om de verschillende typen
proxy te testen en controleer of deze voor u werken.

9.1.15 Instellingen voor GPS

Opties voor visualisatie GPS

Fig. 9.23: Instellingen voor GPS

Dit dialoogvenster helpt u de weergave voor apparaten voor GPS te configureren indien verbonden met QGIS:
• GPS markering locatie voor het beheren van het symbool voor de markering die wordt gebruikt voor de huidige
GPS-locatie

• Markering locatie draaien zodat die overeenkomt met de GPS-rcihting: of het markeringssymbool zou moeten
draaien om overeen te komen met de richting van GPS
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GPSBabel

GPSBabel converteert waypoints, tracks en routes tussen populaire ontvangers voor GPS, zoals Garmin of Magellan
en programma’s voor kaarten, zoals Google Earth of Basecamp. Letterlĳk honderden ontvangers van GPS en
programma’s worden ondersteund. QGIS heeft GPSBabel nodig om te interacteren met deze apparaten en hun
gegevens te bewerken.

1. Eerst moet u het Pad naar GPSBabel naar de binaries definiëren.

2. Dan zou u uw apparaat willen toevoegen. U kunt de lĳst met apparaten bĳwerken met de knop
Nieuw apparaat toevoegen of Apparaat verwĳderen.

3. Voor elk apparaat:
• geeft u een Apparaatnaam op
• configureert u verschillende Opdrachten die QGIS zal gebruiken als het ermee interacteert, zoals:

– Download waypoint vanaf het apparaat
– Upload waypoint naar het apparaat
– Route downloaden vanaf het apparaat
– Route uploaden naar het apparaat
– Track downloaden vanaf het apparaat
– Track uploaden naar het apparaat

Waar de opdrachten gewoonlĳk opdrachten van GPSBabel zĳn, kunt u ook elk ander programma voor
de opdrachtregel gebruiken dat een GPX-bestand kan maken. QGIS zal de sleutelwoorden %type, %in,
en %out vervangen als het de opdracht uitvoert.
Als voorbeeld: als u een type apparaat maakt met de opdracht voor downloaden gpsbabel %type
-i garmin -o gpx %in %out en die dan gebruikt om waypoints te downloaden vanaf poort
/dev/ttyS0 naar het bestand output.gpx, zal QGIS de sleutelwoorden vervangen en de opdracht
gpsbabel -w -i garmin -o gpx /dev/ttyS0 output.gpx uitvoeren.
Lees de handleiding van GPSBabel voor de opties van oor de opdrachtregel die specifiek voor uw geval
zouden kunnen zĳn.

Als u eenmaal een nieuw type apparaat heeft gemaakt, zal het worden vermeld in de lĳsten met apparaten voor de
algoritmes voor GPS Downloaden en Uploaden.
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Fig. 9.24: Instellingen voor GPSBabel

9.1.16 Instellingen voor Lokaliseren

De tab Lokaliseren laat u de werkbalk Lokaliseren configureren, een snel widget om te zoeken, beschikbaar op
de Statusbalk, om u te helpen zoekacties uit te voeren in de toepassing. Het verschaft enkele standaardfilters (met
voorvoegsel) om te gebruiken:
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Fig. 9.25: Instellingen voor Lokaliseren

• Projectlagen (l): zoekt en selecteert een laag in het paneel Lagen.
• Projectlay-outs (pl): zoekt en opent een afdruklay-out.
• Acties (.): zoekt en voert een actie voor QGIS uit; acties kunnen elk gereedschap of menu in QGIS zĳn, openen
van een paneel…

• Objecten op actieve laag (f): zoekt naar overeenkomende attributen in een veld van de huidige actieve laag en
zoomt naar het geselecteerde object. Druk op om het maximum aantal resultaten te configureren.

• Objecten in alle lagen (af): zoekt naar overeenkomende attributen in de laagnaam van elke doorzoekbare laag
en zoomt naar het geselecteerde object. Druk op om het maximum aantal resultaten en het maximum
aantal resultaten per laag te configureren.

• Calculator (=): maakt evalueren van een expressie van QGIS mogelĳk en, indien geldig, geeft een optie om het
resultaat naar het klembord te kopiëren.

• Favoriete plaatsen (b): zoekt en zoomt naar het bereik van de Favoriete plaats.
• Instellingen (set): bladert en opent het dialoogvenster voor project- en toepassingsbrede eigenschappen.
• Ga naar coördinaat (go): verschuift het kaartvenster naar een locatie die wordt gedefinieerd door een komma
of spatie gescheiden paar X- en Y-coördinaten of een opgemaakte URL (bĳv. OpenStreetMap, Leaflet,
OpenLayer, Google Maps, …). Het coördinaat wordt verwacht in WGS 84 (EPSG:4326) en/of CRS van
het kaartvenster.

• Nominatim geocodering (>): geocodes met behulp van de service voor geocodering Nominatim van de
OpenStreetMap Foundation.

• Algoritmes van Processing (a): zoekt en opent een dialoogvenster voor een algoritme van Processing.
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• Geselecteerde objecten bewerken (ef): geeft snel toegang tot en voert een compatibel op-de-plaats bewerken
algoritme van Processing uit op de actieve laag.

In het dialoogvenster, kunt u:
• het Voorvoegsel voor het filter aanpassen, d.i. het sleutelwoord dat wordt gebruikt om het filter te activeren
• instellen of het filter is Ingeschakeld: het filter kan worden gebruikt in zoekacties en sneltoets is beschikbaar
in het menu van de balk Lokaliseren

• instellen of het filter Standaard is: een zoekactie die geen filter gebruikt geeft alleen resultaten terug uit de
standaard categorieën voor filters.

• Sommige filters verschaffen een manier om het aantal resultaten in een zoekactie te configureren.
De set standaardfilters voor Lokaliseren kan worden uitgebreid door plug-ins, bĳv. voor zoekacties van OSM
Nominatim, direct in een database zoeken, zoekacties in catalogus van lagen, …

9.1.17 Instellingen voor Acceleratie

Instellingen voor acceleratie met OpenCL.

Fig. 9.26: Instellingen voor Acceleratie

Afhankelĳk van uw hardware en software zou umisschien aanvullende bibliothekenmoeten installeren om acceleratie
via OpenCL in te schakelen.
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9.1.18 Instellingen voor de IDE

Instellingen voor codebewerker

Op de tab Codebewerker kunt u het uiterlĳk en gedrag van de widgets voor codebewerker beheren (Python
interactieve console en bewerker, widget Expressie en functiebewerker, …).

Fig. 9.27: Instellingen voor codebewerker

Boven in het dialoogvenster verschaft een widget een levend voorbeeld van de huidige instellingen, in verscheidene
coderingstalen (Python, QGIS-expressie, HTML, SQL, JavaScript). Een handige manier om instellingen aan te
passen.

• Selecteer Lettertype codebewerker overschrĳven om het standaard Lettertype en Grootte aan te passen.
• In de groep Kleuren kunt u:

– een Kleurenschema selecteren: vooraf gedefinieerde instellingen zĳn Standaard, Gesolariseerd
(Donker) en Gesolariseerd (Licht). Een schema Aangepast wordt geactiveerd zodra u
een kleur aanpast en kan worden hersteld door een vooraf gedefinieerd schema te kiezen.

– de kleur van elk element bĳ het schrĳven van code wĳzigen, zoals de te gebruiken kleuren voor
opmerkingen, quotes, functies, achtergrond, …
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Instellingen voor Python-console

De instellingen voor Python Console helpen u het gedrag van de bewerkers voor Python te beheren en te
controleren (interactieve console, codebewerker, projectmacro’s, aangepaste expressies, …). Het kan ook worden
bereikt met de knop Opties… vanuit:

• de werkbalk van Python console

• het contextmenu van de widget Python console

• en het contextmenu van de codebewerker.

Fig. 9.28: Instellingen voor Python-console

U kunt specificeren:

• Automatisch aanvullen: Schakelt Automatisch aanvullen van code in. U kunt Automatisch aanvullen vanuit
het huidige document, vanuit geïnstalleerde API-bestanden of beide.

– Drempel Automatisch aanvullen: Stelt de drempel in voor het weergeven van de lĳst van Automatisch
aanvullen (in tekens).

• onder Typen

– Automatisch haakjes invoegen: Schakelt het automatisch sluiten van haakjes in

– Automatisch invoegen van ‘import’ na ‘from xxx’ : Schakelt invoegen van ‘import’ in bĳ specificeren
van imports

• onder Uitvoeren en debuggen
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– Object inspecteren aanzetten (zou wisselen tussen tabs trager kunnen maken)

– Automatisch opslaan script voor starten: Slaat het script dat wordt uitgevoerd automatisch op. Deze
actie zal een tĳdelĳk bestand opslaan (in de tĳdelĳke systeemmap) dat automatisch zal worden verwĳderd
na het uitvoeren.

Voor API’s kunt u specificeren:

• Gebruik het ingeladen API’s-bestand: U kunt er voor kiezen om de reeds ingeladen bestanden voor de API’s
te gebruiken. Als dit niet is geselecteerd kunt u bestanden voor de API toevoegen en u kunt ook kiezen of u
reeds voorbereide API-bestanden wilt gebruiken (zie volgende optie).

• Gebruik een geprepareerd API’s bestand: Indien geselecteerd zal het gekozen *.pap-bestand worden
gebruikt voor het aanvullen van de code. U dient tenminste een *.api-bestand te laden en dat dan te
compileren door te klikken op de knop Api’s compileren… om een geprepareerd API-bestand te maken.

Onder GitHub toegangstoken kunt u een persoonlĳk token maken dat u in staat stelt codesnippers te delen vanuit de
codebewerker van Python. Meer details op GitHub authentication

9.1.19 Instellingen voor Processing

De tab Processing verschaft u algemene instellingen voor gereedschappen en gegevensproviders die worden
gebruikt in het framewerk QGIS Processing. Meer informatie in QGIS framework Processing.

Fig. 9.29: Instellingen voor Processing
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9.1.20 Geavanceerde instellingen

Fig. 9.30: Geavanceerde instellingen

Alle instellingen die zĳn gerelateerd aan QGIS (UI, gereedschappen, gegevensproviders, configuraties voor
Processing, standaardwaarden en paden, opties voor plug-ins, expressies, controles voor geometrie…) worden
opgeslagen in een bestand QGIS/QGIS3.ini in de map van het actieve gebruikersprofiel. Configuraties kunnen
worden gedeeld door dit bestand naar andere installaties te kopiëren.
Vanuit QGIS biedt de tabGeavanceerd eenmanier om deze instellingen te beheren via de Bewerker voor geavanceerde
instellingen. Nadat u belooft voorzichtig te zĳn, wordt de widget gevuld met een boom van alle bestaande instellingen,
en kunt u hun waarde bewerken. Klik met rechts boven een instelling of een groep en u kunt het verwĳderen (om
een instelling of groep toe te voegen, moet u het bestand QGIS3.ini bewerken). Wĳzigingen worden automatisch
opgeslagen in het bestand QGIS3.ini.

Waarschuwing: Blindelings gebruiken van de instellingen op de tab Geavanceerd vermĳden
Wees uitermate voorzichtig bĳ het aanpassen van items in dit dialoogvenster, mede gelet op het feit dat wĳzigingen
automatisch worden toegepast. Wĳzigingen aanbrengen zonder de benodigde kennis kan uw installatie van QGIS
op meerdere manieren beschadigen.
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9.2 Werken met gebruikersprofielen

Het menu Extra ► Gebruikersprofielen verschaft functies om gebruikersprofielen in te stellen en er toegang toe te
krĳgen. Een gebruikersprofiel is een geünificeerde configuratie voor de toepassing die het mogelĳk maakt in één
enkele map op te slaan:

• alle globale instellingen, inclusief locale, projecties, instellingen voor authenticatie, kleurpaletten, sneltoetsen…
• configuraties en aanpassingen van de GUI
• rasterbestanden en andere Proj-hulpbestanden geïnstalleerd voor datumtransformatie
• geïnstalleerde plug-ins en hun configuraties
• projectsjablonen en geschiedenis van opgeslagen projecten met hun voorbeeldafbeelding
• instellingen voor Processing, logs, scripts, modellen.

Standaard bevat een installatie van QGIS één enkel gebruikersprofiel, genaamd default. Maar u kunt net zoveel
gebruikersprofielen maken als u wilt:

1. Klik op het item Nieuw profiel….
2. U zult worden gevraagd een naam voor het profiel op te geven, een map te maken met dezelfde naam onder

~/<UserProfiles>/ waar:
• ~ geeft de map HOME weer, die op Windows gewoonlĳk iets is als C:\Users\<username>.
• en <UserProfiles> staat voor de hoofdmap voor profielen, d.i.:

– .local/share/QGIS/QGIS3/profiles/

– %AppData%\Roaming\QGIS\QGIS3\profiles\

– Library/Application Support/QGIS/QGIS3/profiles/

De map voor de gebruikersprofielen kan vanuit QGIS worden geopend met Actieve profielmap openen.
3. Een nieuwe instantie voor QGIS, met een schone configuratie, wordt gestart. U kunt dan uw aangepaste

configuraties instellen.
Als u meer dan één profiel in uw installatie van QGIS heeft, wordt de naam van het actieve profiel, tussen vierkante
haken, weergegeven in de titelbalk van de toepassing.
Omdat elk gebruikersprofiel geïsoleerde instellingen, plug-ins en geschiedenis bevat, kunnen zĳ goed zĳn voor
verschillende werkstromen, demo’s, gebruikers van dezelfde machine, of instellingen om te testen, etc. En u kunt
schakelen van de ene naar de andere door ze te selecteren in het menu Extra ► Gebruikersprofielen. U kunt ook
QGIS uitvoeren met een specifiek gebruikersprofiel vanaf de opdrachtregel.
Tenzĳ gewĳzigd zal het profiel van de laatst afgesloten sessie van QGIS worden gebruikt in de volgende sessies van
QGIS.

Tip: QGIS uitvoeren onder een nieuw gebruikersprofiel om het voortbestaan van een probleem te controleren
Wanneer u vreemd gedrag tegenkomt bĳ het gebruiken van enkele functies in QGIS, maak dan een nieuw
gebruikersprofiel en voer de opdrachten opnieuw uit. Soms zĳn problemen gerelateerd aan enkele achterblĳfselen
in het huidige gebruikersprofiel en het maken van een nieuw zou ze kunnen oplossen als QGIS opnieuw start met het
nieuwe (schone) profiel.
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9.3 Projecteigenschappen

In het venster voor eigenschappen voor het project onder Project ► Eigenschappen kunt u project-specifieke opties
instellen. De project-specifieke opties overschrĳven hun equivalent in het hierboven beschreven dialoogvensterOpties.

9.3.1 Algemene eigenschappen

Op de tab Algemeen laten de Algemene instellingen u:
• de locatie van het projectbestand zien
• de map instellen voor de thuisplek voor het project (beschikbaar in het item Thuis voor project van het paneel

Browser). Het pad mag relatief zĳn naar de map van het projectbestand (typ het in) of absoluut. Thuis voor
project kan worden gebruikt voor het opslaan van gegevens en andere inhoud die nuttig is voor het project.
Handig als gegevensset en projectbestanden niet op dezelfde plaats zĳn opgeslagen. Indien niet gevuld is het
Thuis voor project standaard de map met het projectbestand.

• een titel opgeven voor het project naast het bestandspad voor het project
• de te gebruiken kleur kiezen voor objecten als zĳ geselecteerd zĳn
• de achtergrondkleur kiezen: de kleur die moet worden gebruikt voor het kaartvenster
• instellen of het pad naar de lagen in het project moet worden opgeslagen als absoluut (volledig) of als relatief
ten opzichte van de locatie van het projectbestand. U zou een voorkeur kunnen hebben voor relatieve paden
als zowel de lagen als de projectbestanden moeten kunnen worden verplaatst of gedeeld, of als het project
toegankelĳk is voor computers op verschillende platformen.

• kiezen voor vermĳden van artefacten wanneer project wordt gerenderd als kaarttegels. Onthoud dat het
selecteren van deze optie kan leiden tot vertragingen in de uitvoering.

• Onthoud vensters en docks voor attributentabellen tussen sessies: Indien geselecteerd voor een project, dan zullen
geopende attributentabellen worden opgeslagen in het project en onmiddellĳk worden hersteld bĳ het laden van
dat project. Dit kan werkstromen verbeteren wanneer u een project naar uw wensen hebt geconstrueerd met
een bepaalde set configuraties voor de attributentabel, en het opnieuw instellen van deze attributentabellen veel
werk is.

Berekenen van gebieden en afstanden is een veel voorkomend gebeuren in GIS. Deze waarden zĳn echter verbonden
aan de onderliggende instellingen voor projectie. Het frame Meten laat u deze parameters beheren. U kunt feitelĳk
kiezen voor:

• de Ellipsoïde, waarop berekeningen voor afstanden en gebieden volledig zĳn gebaseerd; het kan zĳn:
– Geen/Planimetrisch: teruggegeven waarden zĳn in dit geval Cartesiaanse metingen. Deze optie kan
worden ingesteld als standaard voor nieiwe projecten in het menu Instellingen ► Opties ► CRS
afhandelen

– een Aangepaste: u dient de waarden voor de assen semi-major en de semi-minor in te stellen.
– of een bestaande uit een vooraf gedefinieerde lĳst (Clarke 1866, Clarke 1880 IGN, New International
1967, WGS 84…).

• de Eenheden voor metingen van afstanden voor lengte en omtrek en de Eenheden voor meten van gebied. Deze
instellingen, die standaard zĳn ingesteld op de eenheden die zĳn ingesteld in de Opties van QGIS maar die dan
overschrĳven voor het huidige project, worden gebruikt in:

– Balk voor bĳwerken van veld Attributentabel
– Berekeningen in Veldberekening
– De uit het gereedschap Objecten identificeren afgeleide waarden voor lengte, omtrek en gebied
– De weergegeven standaardeenheid in het dialoogvenster Meten

DeWeergave coördinaat en richting laat u de weergave aanpassen van:
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• de coördinaten die worden weergeven in het vak Coördinaten op de statusbalk van QGIS en in het gedeelte
Afgeleid van de resultaten van het gereedschap Objecten identificeren

• de waarde voor de richting zoals die wordt weergegeven in de statusbalk voor de richting van het verplaatsen
in het kaartvenster en het gereedschap Richting meten.

Beschikbare parameters zĳn:
• Coördinaten weergeven met behulp van ofwel:

– Kaarteenheden, gebaseerd op het CRS voor het project
– Geografische kaart (graden): gebaseerd op het project-CRS als dat van het type geografisch
is, anders gebruikt het zĳn geassocieerde geografisch CRS. Dit is handig bĳv. voor niet-aardse
hemellichamen.

– of Eenheden aangepaste projecties: maakt het mogelĳk te vertrouwen op een CRS dat u
wilt gebruiken voor de weergave van coördinaten

• In de optie Coördinaat CRS kunt u het CRS bekĳken of definiëren dat u wilt gebruiken, afhankelĳk van uw
modus voor weergave.

• Indeling coördinaten: u kunt ze configureren als Decimale garden, Graden, minuten of Graden,
minuten, seconden, en of het zou moeten weergeven:

– Achtervoegsel voor richting weergeven

– Voorloopnullen voor minuten en seconden weergeven

– Voorloopnullen voor graden weergeven

– Achterliggende nullen weergeven

• Coördinaat precisie: het aantal decimale plaatsen kan automatisch zĳn (afgeleid van het type CRS) of handmatig
worden ingesteld

• Volgorde coördinaten: u kunt er voor kiezen de coördinaten weer te geven in de eigen volgorde van het
CRS (Standaard) of schakelen naar ofwel de volgorde Easting, Northing (Longitude,
Latitude) of Northing, Easting (Latitude, Longitude)

• Indeling richting mogelĳke waarden zĳn 0 tot en met 180°, met achtervoegsel O/W, -180
tot en met +180° of 0 tot en met 360°. Het aantal Decimale plaatsen als ook Achterliggende
nullen weergeven kunnen worden ingesteld.
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Fig. 9.31: Tab Algemeen van het dialoogvenster Projecteigenschappen

9.3.2 Eigenschappen Metadata

De tab Metadatamaakt het mogelĳk gedetailleerde metadata te definiëren, inclusief (naast andere): auteur, datum
maken, taal, abstracten, categorieën, sleutelwoorden, contactdetails, links, geschiedenis. Er is ook een functie voor
valideren die controleert of specifieke velden zĳn ingevuld, maar dit wordt niet afgedwongen. Bekĳk vectorlaag
eigenschappen metadata voor enkele details.
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9.3.3 Instellingen voor weergave

Fig. 9.32: Tab Instellingen voor weergave van het dialoogvenster Projecteigenschappen

De tab Instellingen voor weergave verschaft middelen om het kaartvenster van het project te beheren. U kunt:
• set Vooraf gedefinieerde schalen voor project: de lĳst met weer te geven schalen in aan schaal gerelateerde
keuzewidgets, zoals de statusbalk Schaal, de selectie voor de zichtbaarheid van de schaal of instellingen voor
secundaire 2D-kaartweergave,… ter vervanging van de globale vooraf gedefinieerde schalen.

• Volledig bereik project instellen: dit bereik zal worden gebruikt in plaats van het bereik van alle lagen bĳ
het zoomen naar het volledige kaartbereik ( ). Het is nuttig wanneer een project weblagen/nationale
lagen/globale lagen bevat maar als het feitelĳke gebied van interesse voor het project een kleiner geografisch
gebied is. De coördinaten van het volledige bereik van het project kunnen worden ingesteld met de widget
bereik selecteren.

9.3.4 Eigenschappen voor CRS

Notitie: Voor meer informatie over hoe QGIS projecteren van projecten afhandelt, bekĳk daarvoor het bestemde
gedeelte inWerken met projecties.

De tab CRS helpt u het te gebruiken coördinaten referentiesysteem voor dit project in te stellen. Het kan zĳn:

• Geen CRS (of onbekende niet-Aardse projectie): lagen worden getekend gebaseerd op hun ruwe coördinaten
• of een bestaand coördinaten referentiesysteem, dat mag zĳn geografisch, geprojecteerd of gebruikergedefinieerd.
Lagen die worden toegevoegd aan het project worden direct naar dit CRS vertaald, om ze te kunnen overleggen,
ongeacht hun originele CRS.
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9.3.5 Eigenschappen voor transformatie

De tab Transformaties helpt u de instellingen voor het opnieuw projecteren van lagen te beheren door de
voorkeuren voor datumtransformatie te configureren die moeten worden toegepast in het huidige project. Zoals
gewoonlĳk overschrĳven deze overeenkomende globale instellingen. Bekĳk Datumtransformaties voor meer details.

9.3.6 Eigenschappen Stijlen

Op de tab Stĳlen kunt u symbolen en kleuren configureren inherent aan het project, wat het mogelĳk maakt het
project veilig te delen op verschillende andere machines.
De groep Standaard symbolen laat u beheren hoe nieuwe lagen in het project zullen worden getekend wanneer ze
geen bestaande stĳl .qml hebben gedefinieerd. U kunt Markering, Lĳn, Vulling instellen om toe te passen op het
type geometrie van de laag, als ook standaard Kleurverloop en Tekstindeling (bĳv. bĳ het inschakelen van labelen). Elk
van deze items kan worden hersteld met het item Huidige symbool leegmaken uit de corresponderende keuzewidget.
In de groep Opties kunt u:

• Toepassen van een standaard Doorzichtbaarheid op nieuwe lagen

• Willekeurige kleuren aan symbolen toekennen, aanpassen van de vulkleuren voor de symbolen, om hetzelfde
renderen voor alle lagen te vermĳden.

Fig. 9.33: Tab Stijlen
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Er is ook een aanvullend gedeelte waar u specifieke kleuren kunt definiëren voor het lopende project. Net als globale
kleuren, kunt u:

• kleur Toevoegen of Verwĳderen

• kleur Kopiëren of Plakken

• de set kleuren vanuit/naar bestand .gpl Importeren of Exporteren.
Dubbelklik op een kleur in de lĳst om die aan te passen of te vervangen in het dialoogvenster Kleur selecteren. U kunt
het ook hernoemen door erop te dubbelklikken in de kolom Label.
Deze kleuren worden geïdentificeerd als Projectkleuren en vermeld als deel van de widgets Kleuren.

Tip: Projectkleuren gebruiken om snel toe te wĳzen en widgets Kleuren bĳ te werken
Naar projectkleuren kan worden verwezen met hun label en de widgets Kleuren waarin zĳ worden gebruikt zĳn aan
hen verbonden. Dit betekent dat in plaats van herhaaldelĳk dezelfde kleur in te stellen voor veel eigenschappen en,
om omslachtig bĳwerken te voorkomen, kunt u:

1. De kleur definiëren als een projectkleur
2. Klik op de widget Data-bepaalde ‘override’ naast de eigenschap van de kleur die u wilt instellen
3. Ga over het menu Kleur en selecteer de projectkleur. De eigenschap wordt dan toegewezen aan de expressie

project_color('color_label') en de kleurwidget geeft die kleur weer.
4. Herhaal de stappen 2 en 3 zoveel als nodig
5. Werk de projectkleur een keer bĳ en de wĳziging wordt, OVERAL waar hĳ wordt gebruikt, zichtbaar.

9.3.7 Eigenschappen Databronnen

Op de tab Databronnen, kunt u:
• Modus Transactie: definiëren hoe bewerkingen worden verzonden naar de gegevensprovider.

– Buffer Lokaal bewerken: bewerkingen worden lokaal gebufferd en verzonden naar de provider bĳ het
schakelen van de modus voor het bewerken van de laag of door te klikken opWĳzigingen laag opslaan.

– Automatische transactiegroepen: voor ondersteunde databronnen (databases van PostgreSQL en
Geopackage) wordt de staat van bewerken voor alle tabellen die afkomstig zĳn uit dezelfde database
gesynchroniseerd en uitgevoerd in een transactie aan de zĳde van de server. Ook, in plaats van wĳzigingen
door bewerken lokaal te bufferen, worden zĳ direct verzonden naar een transactie in de database die wordt
ingediend bĳ het schakelen van de modus voor het bewerken van de laag of door te klikken opWĳzigingen
laag opslaan.

– Gebufferde transactiegroepen: alle te bewerken lagen, ongeacht van welke provider, worden synchroon
geschakeld en alle bewerkingen worden opgeslagen in een lokale buffer voor bewerkingen. Opslaan van
wĳzigingen wordt uitgevoerd met één enkele transactie op alle lagen (per provider).

Onthoud dat u deze optie alleen kunt wĳzigen als er geen laag wordt bewerkt in het project.

• Standaard waarden aan de zĳde van de provider evalueren: Bĳ het toevoegen van nieuwe objecten in een
tabel van PostgreSQL moeten velden met de beperking standaardwaarde worden geëvalueerd en gevuld op het
moment van openen van het formulier, en niet op het moment van indienen. Dit betekent dat in plaats van een
expressie zoals nextval('serial'), het veld in het formulier Object toevoegen de verwachte waarde zal
weergeven (bĳv. 25).

• Onthoud status bewerkbare laag tussen sessies: zorgt er voor dat alle lagen die bewerkbaar zĳn in een project
ls zodanig zullen worden herinnerd bĳ het opslaan van het project, als ook door er voor te zorgen dat die lagen
onmiddellĳk bewerkbaar worden gemaakt als het project wordt hersteld.
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• Configureren van de servicemogelĳkheden voor de Laag Capabilities, d.i.:
– In- (of uitschakelen) welke lagen identificeerbaar zĳn, d.i. zullen reageren op het gereedschap

Objecten identificeren. Standaard worden lagen als te bevragen ingesteld.
– Instellen of een laag als Alleen-lezen zou moeten verschĳnen, wat betekent dat hĳ niet door de
gebruiker kan worden bewerkt, ongeacht de mogelĳkheden van de gegevensprovider. Hoewel dit een
beperkte beveiliging is, blĳft het een snelle en handige configuratie om te voorkomen dat eindgebruikers
gegevens aanpassen bĳ het werken met lagen die zĳn gebaseerd op bestanden.

– Definiëren welke lagen doorzoekbaar zĳn, d.i. kunnen worden bevraagd met de widget Lokaliseren.
Standaard worden lagen als te doorzoeken ingesteld.

– Definiëren welke lagen zĳn gedefinieerd als vereist. Geselecteerde lagen in deze lĳst zĳn beveiligd
tegen het per ongeluk verwĳderen uit het project.

– Definieer welke lagen privé zĳn, d.i. verborgen in het paneel Lagen. Dit is bedoeld voor accessoire-
lagen (basiskaart, samenvoeging, opzoeken van waarde-relaties, meest waarschĳnlĳk geen ruimtelĳke
lagen, …) die u wel nodig hebt in een project, maar waarvan u niet wilt dat zĳ de boom van de legenda
en andere gereedschappen voor selecteren vervuilen. Indien ingesteld als zichtbaar, worden zĳ nog steeds
weergegeven in het kaartvenster en gerenderd in de legenda van de afdruklay-out. Gebruik de optie
Legenda filteren ► Private lagen weergeven op de werkbalk boven in het paneel Lagen om ze tĳdelĳk in
te schakelen voor enige interactie.

De tabel Laag Capabilities verschaft enkele handige gereedschappen om:
– Meerdere cellen te selecteren en drukken op Selectie wisselen om de status van hun selectievak te wĳzigen;

– Alleen ruimtelĳke lagen weergeven, niet ruimtelĳke lagen uit de lagenlĳst te filteren;

– Lagen filteren… en snel een bepaalde laag te zoeken om te configureren.

• Onder de groep Geavanceerde instellingen kunt u selecteren Project vertrouwen als databron geen metadata
heeft: Laden van projecten versnellen door controles van gegevens over te slaan. Nuttig in context van QGIS
Server of in projecten met enorme databaseweergaven/gematerialiseerde weergaven. Het bereik voor de lagen
zal worden gelezen uit het projectbestand van QGIS (in plaats van de databronnen) en bĳ het gebruiken van de
provider PostgreSQL zal het uniek zĳn van de primaire sleutel niet worden gecontroleerd voor weergaven en
gematerialiseerde weergaven.
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Fig. 9.34: Tab Databronnen

9.3.8 Eigenschappen Relaties

De tab Relaties wordt gebruikt voor het definiëren van 1:n-relaties en polymorfische relaties. De relaties worden
gedefinieerd in het dialoogvenster voor de projecteigenschappen. Als eenmaal voor een laag relaties bestaan zal een
nieuw element voor de gebruikersinterface in de Formulierweergave (bĳv. bĳ het identificeren van een object en
het openen van het formulier daarvan) de gerelateerde entiteiten weergeven. Dit verschaft een krachtige manier om,
bĳvoorbeeld, de geschiedenis over het inspecteren van de lengte van een pĳplĳn of wegsegment uit te drukken. U
vindt meer over de ondersteuning voor 1:n-relaties in het gedeelte Een tot veel- of veel-tot-veel-relaties maken.

Fig. 9.35: Tab Relaties
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9.3.9 Eigenschappen Variabelen

De tab Variabelen vermeldt alle variabelen die beschikbaar zĳn op het niveau van het project (dat ook alle globale
variabelen omvat). Daarnaast stelt het de gebruiker in staat om variabelen op het niveau van het project te beheren.
Klik op de knop om een nieuwe aangepaste variabele op het niveau van het project toe te voegen. Selecteer op
dezelfde wĳze een aangepaste variabele op het niveau van het project en klik op de knop om hem te verwĳderen.
Meer informatie over het gebruik van variabelen in het gedeelte Algemene gereedschappen Waarden opslaan in
Variabelen.

9.3.10 Eigenschappen Macro’s

De tab Macro’s kan worden gebruikt om macro’s voor Python te bewerken. Momenteel zĳn er drie macro’s
beschikbaar: “openProject()”, “saveProject()” en “closeProject()”.

Fig. 9.36: Instellingen voor Macro’s
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9.3.11 Eigenschappen QGIS Server

De tab QGIS Server stelt u in staat uw project te configureren om het online te publiceren. Hier kunt u informatie
definiëren over de QGIS Server WMS en WFS capabilities, bereik en beperkingen voor CRS. Meer informatie is
beschikbaar in het gedeelte Creatingwmsfromproject en volgende.

Fig. 9.37: Instellingen QGIS Server
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9.3.12 Eigenschappen Tijdbeheer

De tab Tĳdbeheer wordt gebruikt om de tĳdsperiode voor uw project in te stellen, ofwel door handmatige invoer
in Startdatum en Einddatum of door die te berekenen uit de huidige tĳden van de lagen in het project. De tĳdsperiode
voor het project kan dan worden gebruikt in het paneel Tĳdbeheer om het kaartvenster te beheren in navigatie voor
tĳdbeheer.

Fig. 9.38: Project tab Tijdbeheer

9.3.13 Eigenschappen terrein

De tab Terrein helpt u standaard instellingen te configureren voor het terrein en hoogte. Wanneer een nieuwe
3D-weergave in het project wordt gemaakt, zal de kaart standaard dezelfde instellingen voor het terrein gebruiken
als die welke zĳn gedefinieerd voor het project. De instellingen voor de hoogte van het project zullen ook worden
gerespecteerd door het gereedschap Profiel.

Fig. 9.39: Project tab Tijdbeheer
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Opties voor terrein en hoogte zĳn beschikbaar voor:
• Vlak terrein met instelling Terrein hoogte

• DEM (Rasterlaag): met instelling voor het definiëren van de DEM laag, een Verticale schaal-factor om toe te
passen op de bandwaarden en een verticale Verschuiving

• Mazen: met instelling voor het definiëren van de Laag met mazen, een Verticale schaal-factor om toe te passen
op de waarden van de punten Z en een verticale Verschuiving

Deze instellingen kunnen worden overschreven vanuit het 3D-kaart dialoogvenster voor configuratie.

9.4 Aanpassingen

Het dialoogvenster Aanpassingen laat u bĳna elk element (de)activeren in de gebruikersinterface van QGIS. Dit
kan erg handig zĳn als u uw eindgebruikers een ‘lichte’ versie van QGIS wilt verschaffen, die alleen bestaat uit de
pictogrammen, menu’s en panelen die ze nodig hebben.

Notitie: Vóórdat de wĳzigingen worden doorgevoerd, dient u QGIS opnieuw te starten.
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Fig. 9.40: Dialoogvenster Aanpassingen

Selecteren van het keuzevak Aanpassingen toestaan is de eerste stap op weg naar aanpassingen in QGIS. Dit
schakelt het paneel voor de werkbalken en widgets van waaruit u enkele items voor de GUI kunt deselecteren en dus
uitschakelen.
Het te configureren item kan zĳn:

• eenMenu of een van diens sub-menu’s uit de Menubalk

• een volledig Paneel (bekĳk Panelen en werkbalken)
• de Statusbalk beschreven in Statusbalk of items daarvan
• eenWerkbalk: de gehele balk of enkele van zĳn pictogrammen
• of enig widget uit enig dialoogvenster in QGIS: label, knop, combinatievak…

Met Schakel naar widgets in de hoofdapplicatie, kunt u klikken op een item in de interface van QGIS dat u wilt verbergen en
QGIS deselecteert automatisch het overeenkomende item in het dialoogvenster Aanpassen van de interface. U kunt
ook het vak Zoeken gebruiken om items te zoeken op hun naam of label.
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Als u de configuratie eenmaal heeft ingesteld, klik dan op Toepassen of OK om uw wĳzigingen te valideren. Deze
configuratie wordt die welke standaard wordt gebruikt door QGIS bĳ de volgende keer opstarten.

De aanpassingen kunnen ook worden opgeslagen in een .ini-bestand met behulp van de knop Opslaan naar bestand.
Dit is een handige manier om een algemene interface van QGIS te delen met meerdere gebruikers. Klik gewoon
op Laden uit bestand op de doelcomputer om het .ini-bestand te importeren. U kunt ook gereedschappen voor de
opdrachtregel uitvoeren en de verscheidene instellingen voor verschillende gebruiksgevallen ook opslaan.

Tip: Eenvoudig opslaan van vooraf gedefinieerd QGIS
De initiële configuratie voor de QGIS GUI kan worden hersteld op één van de onderstaande manieren:

• deselecteren van de optie Aanpassingen toestaan in het dialoogvenster Aanpassingen of klik op de knop
Alles selecteren

• drukken op de knop Terug naar beginwaarde in het frame Instellingen onder het menu Extra ► Opties, tab
Systeem

• starten van QGIS vanaf de opdrachtregel met de volgende regel als opdracht qgis --nocustomization

• instellen van de waarde false voor de variabele UI► Aanpassingen► Ingeschakeld onder het menu Extra►
Opties, tab Geavanceerd (bekĳk de waarschuwing).

In de meeste gevallen dient u QGIS opnieuw te starten om de wĳzigingen doorgevoerd te krĳgen.

9.5 Snelkoppelingen toetsenbord

QGIS verschaft voor veel mogelĳkheden standaard sneltoetsen. Deze worden in het gedeelte Menubalk beschreven.
Daarnaast geeft de menuoptie Extra► Toetsenbord sneltoetsen… de mogelĳkheid om de standaard sneltoetsen aan te
passen en nieuwe snelkoppelingen toe te voegen voor mogelĳkheden in QGIS.

110 Hoofdstuk 9. QGIS Configureren



QGIS Desktop 3.28 User Guide

Fig. 9.41: Opties voor snelkoppelingen definiëren

Configureren is erg eenvoudig. Gebruik het zoekvak boven in het dialoogvenster om een bepaalde actie te zoeken,
selecteer die uit de lĳst en klik op :

• Aanpassen en druk op de nieuwe combinatie die u wilt toewĳzen als de nieuwe sneltoets
• Geen instellen om een toegewezen sneltoets te verwĳderen
• of Standaard instellen om de sneltoets terug te zetten naar zĳn originele en standaardwaarde.

Ga door zoals hierboven voor alle andere gereedschappen die u wilt aanpassen. Als u eenmaal klaar bent met uw
configuratie, druk op Sluiten om eenvoudigweg het dialoogvenster te sluiten en uw wĳzigingen door te voeren. U kunt
ook de wĳzigingen Opslaan, ofwel als een bestand .XML met alleen de Snelkoppelingen van gebruiker of met Alle
snelkoppelingen of als een bestand .PDF met alle snelkoppelingen en ze Laden in een andere installatie van QGIS.

9.6 QGIS uitvoeren met geavanceerde instellingen

9.6.1 Variabelen voor opdrachtregel en omgeving

We hebben gezien dat QGIS opstarten wordt gedaan als voor elke toepassing op uw besturingssysteem. QGIS
verschaft opties voor de opdrachtregel voor meer geavanceerde gebruiksgevallen (in sommige gevallen kunt u een
omgevingsvariabele gebruiken in plaats van de optie voor de opdrachtregel). Voer qgis --help in op de
opdrachtregel om een lĳst te verkrĳgen van de opties, wat teruggeeft:
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QGIS is a user friendly Open Source Geographic Information System.
Usage: /usr/bin/qgis.bin [OPTION] [FILE]
OPTION:

[-v, --version] display version information and exit
[-s, --snapshot filename] emit snapshot of loaded datasets to given file
[-w, --width width] width of snapshot to emit
[-h, --height height] height of snapshot to emit
[-l, --lang language] use language for interface text (changes␣

↪→existing override)
[-p, --project projectfile] load the given QGIS project
[-e, --extent xmin,ymin,xmax,ymax] set initial map extent
[-n, --nologo] hide splash screen
[-V, --noversioncheck] don't check for new version of QGIS at startup
[-P, --noplugins] don't restore plugins on startup
[-B, --skipbadlayers] don't prompt for missing layers
[-C, --nocustomization] don't apply GUI customization
[-z, --customizationfile path] use the given ini file as GUI␣

↪→customization
[-g, --globalsettingsfile path] use the given ini file as Global␣

↪→Settings (defaults)
[-a, --authdbdirectory path] use the given directory for authentication␣

↪→database
[-f, --code path] run the given python file on load
[-d, --defaultui] start by resetting user ui settings to default
[--hide-browser] hide the browser widget
[--dxf-export filename.dxf] emit dxf output of loaded datasets to␣

↪→given file
[--dxf-extent xmin,ymin,xmax,ymax] set extent to export to dxf
[--dxf-symbology-mode none|symbollayer|feature] symbology mode for dxf␣

↪→output
[--dxf-scale-denom scale] scale for dxf output
[--dxf-encoding encoding] encoding to use for dxf output
[--dxf-map-theme maptheme] map theme to use for dxf output
[--take-screenshots output_path] take screen shots for the user␣

↪→documentation
[--screenshots-categories categories] specify the categories of␣

↪→screenshot to be used (see QgsAppScreenShots::Categories).
[--profile name] load a named profile from the user's profiles␣

↪→folder.
[-S, --profiles-path path] path to store user profile folders. Will␣

↪→create profiles inside a {path}\profiles folder
[--version-migration] force the settings migration from older version if␣

↪→found
[--openclprogramfolder] path to the folder containing the sources␣

↪→for OpenCL programs.
[--help] this text
[--] treat all following arguments as FILEs

FILE:
Files specified on the command line can include rasters,
vectors, and QGIS project files (.qgs and .qgz):
1. Rasters - supported formats include GeoTiff, DEM

and others supported by GDAL
2. Vectors - supported formats include ESRI Shapefiles

and others supported by OGR and PostgreSQL layers using
the PostGIS extension

Tip: Voorbeeld gebruik argumenten opdrachtregel
U kunt QGIS starten door één of meerdere gegevensbestanden op te geven op de opdrachtregel. Bĳvoorbeeld wanneer
u zich in de folder qgis_sample_data bevindt kunt u QGIS starten en tegelĳkertĳd een raster en een vectorbestand
openen tĳdens het opstarten met de volgende opdracht: qgis ./raster/landcover.img ./gml/lakes.
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gml

--version

Deze optie geeft informatie over de versie van QGIS terug.

--snapshot

Deze optie geeft de mogelĳkheid om een schermafdruk te maken in de indeling PNG van de huidige weergave.
Dit is handig wanneer u veel projecten hebt en u schermafdrukken wilt maken van uw gegevens of wanneer u
schermafdrukken nodig hebt van hetzelfde project met bĳgewerkte gegevens.
Momenteel maakt dit een PNG-bestand met een resolutie van 800x600 pixels. Dit kan worden aangepast door de
opties –-width en –-height mee te geven op de opdrachtregel. Een bestandsnaam kan worden toegevoegd na
–-snapshot. Bĳvoorbeeld:

qgis --snapshot my_image.png --width 1000 --height 600 --project my_project.qgs

--width

Deze optie geeft de breedte terug van de schermafdruk die moet worden gemaakt (gebruikt met --snapshot).

--height

Deze optie geeft de hoogte terug van de schermafdruk die moet worden gemaakt (gebruikt met --snapshot).

--lang

Gebaseerd op de ingestelde standaardtaal van uw systeem selecteert QGIS de juiste taal. Wanneer u echter toch QGIS
in een andere taal wilt opstarten dan kunt u dit doen door een taalcode op te geven. Bĳvoorbeeld: qgis --lang=it
start QGIS in het Italiaans.

--project

Opstarten van QGIS met een bestaand projectbestand is ook mogelĳk. Voeg aan de opdrachtregel de optie
--project toe, gevolgd door de naam van uw project en QGIS zal het openen met alle lagen in het opgegeven
bestand geladen.

--extent

Gebruik deze optie om op te starten met een specifiek kaartbereik. U dient het begrenzingsvak van uw bereik in de
volgende volgorde toe te voegen, gescheiden door een komma:

--extent xmin,ymin,xmax,ymax

Deze optie heeft waarschĳnlĳk meer zin als die is gekoppeld aan de optie --project om een specifiek project met
het gewenste bereik te openen.
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--nologo

Deze optie verbergt het openingsscherm bĳ het opstarten van QGIS.

--noversioncheck

Zoeken naar een nieuwe versie van QGIS overslaan bĳ het opstarten.

--noplugins

Wanneer het opstarten met plug-ins problemen geeft, kunt u met deze optie vermĳden dat ze bĳ het opstarten geladen
worden. Zĳ zullen daarna nog steeds beschikbaar zĳn vanuit Plug-ins beheren en installeren.

--nocustomization

Met deze optie zal een bestaande aanpassing van de gebruikersinterface niet worden toegepast bĳ het opstarten. Dit
betekent dat verborgen knoppen, menu-items, werkbalken, enzovoort, zullen worden weergegeven bĳ het opstarten
van QGIS. Dit is geen permanente wĳziging. De aanpassingen zullen weer worden toegepast als QGIS wordt opgestart
zonder deze optie.
Deze optie is nuttig voor het tĳdelĳk toegang geven tot gereedschappen die bĳ het aanpassen zĳn verwĳderd.

--skipbadlayers

Door deze optie te gebruiken kunt u vermĳden dat QGIS u vraagt, in het dialoogvenster Afhandelen niet beschikbare
lagen, bĳ het opstarten. Het projectbestand wordt geladen, met ontbrekende lagen behouden als onbeschikbaar. Meer
details over dit onderwrep in Afhandelen defecte bestandspaden.

--customizationfile

Met deze optie kunt u een bestand voor aanpassingen aan de gebruikersinterface opgeven dat wordt gebruikt bĳ
opstarten.

--globalsettingsfile

De equivalente omgevingsvariabele is QGIS_GLOBAL_SETTINGS_FILE.
Door deze optie te gebruiken kunt u het pad voor een bestand met globale instellingen (.ini), ook bekend als de
standaardinstellingen, specificeren. De instellingen in het gespecificeerde bestand vervangen de originele inregelige
standaarden, maar de instellingen van het gebruikersprofiel zullen hier bovenop worden gezet.
QGIS zoekt naar het bestand met de standaard globale instellingen in de volgende volgorde en alleen het eerste
gevonden bestand zal worden gebruikt:

• pad gespecificeerd door de parameter van de opdrachtregel
• pad gedefinieerd door de omgevingsvariabele
• de map AppDataLocation, waar persistent gegevens voor toepassingen kunnen worden opgeslagen; hĳ wordt
beheerd door de gebruiker of systeembeheerder en wordt niet geraakt door het installatieprogramma en vereist
geen aanvullende instelling, zoals het doorgeven van parameters voor de opdrachtregel of instelling voor
omgevingsvariabelen. Afhankelĳk van het besturingssysteem is het:

– $HOME/.local/share/QGIS/QGIS3/

– C:\Users\<username>\%AppData%\Roaming\QGIS\QGIS3\
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– $HOME/Library/Application Support/QGIS/QGIS3/

• de map van het installeren, d.i. uw_QGIS_pakket_pad/resources/qgis_global_settings.
ini.

Momenteel is er nog geen manier om een bestand te specificeren om de instellingen naar toe te schrĳven; daarom
kunt u een kopie maken van het originele bestand met instellingen, het hernoemen en aanpassen.
Instellen van het pad van het bestand qgis_global_setting.ini naar een op het netwerk gedeelde map stelt
een systeembeheerder in staat om globale instellingen en standaarden op verschillende machines te wĳzigen door
slechts één bestand te bewerken.

--authdbdirectory

Deze optie is soortgelĳk aan --globalsettingsfile, maar definieert het pad naar de map waar de database
voor authenticatie zal worden opgeslagen en geladen.

--code

Deze optie kan worden gebruikt om een opgegeven bestand van Python uit te voeren, direct nadat QGIS is gestart.
Als u bĳvoorbeeld een bestand voor Python heeft, dat is genaamd load_alaska.py, met de volgende inhoud:

from qgis.utils import iface
raster_file = "/home/gisadmin/Documents/qgis_sample_data/raster/landcover.img"
layer_name = "Alaska"
iface.addRasterLayer(raster_file, layer_name)

Er van uitgaande dat u in de map staat waar het bestand load_alaska.py is opgeslagen, kunt u QGIS starten,
het rasterbestand landcover.img laden en de laag de naam ‘Alaska’ geven met de volgende opdracht:

qgis --code load_alaska.py

--defaultui

Bĳ het laden wordt de gebruikersinterface (UI) permanent teruggezet naar de standaardinstellingen. Deze optie zal
de zichtbaarheid van panelen en werkbalken, positie en grootte herstellen. Tenzĳ het opnieuw wordt gewĳzigd, zullen
de standaardinstellingen voor de gebruikersinterface in de volgende sessies worden gebruikt.
Onthoud dat deze optie geen effect heeft op aanpassingen van de gebruikersinterface. Items die zĳn verborgen
door aanpassingen van de GUI (bĳv. de Statusbalk) zullen verborgen blĳven, zelfs bĳ het gebruiken van de optie
--defaultui. Bekĳk ook de optie --nocustomization.

--hide-browser

Verbergt bĳ het laden het paneel Browser in de gebruikersinterface. Het paneel kan worden ingeschakeld door met
rechts te klikken op een ruimte in een werkbalk of met Beeld ► Panelen (Settings ► Panelen in Linux KDE).
Tenzĳ het opnieuw wordt ingeschakeld, blĳft het paneel Browser in de volgende sessies verborgen.
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--dxf-*

Deze opties kunnen worden gebruikt om een project van QGIS te exporteren naar een DXF-bestand. Verscheidene
opties zĳn beschikbaar:

• –dxf-export: de DXF-bestandsnaam waarnaar de lagen moeten worden geëxporteerd;
• –dxf-extent: het bereik van het uiteindelĳke DXF-bestand;
• –dxf-symbology-mode: verscheidene waarden kunnen hier worden gebruikt: none (geen symbologie),
symbollayer (symbologie voor Symboollaag), feature (symbologie voor objecten);

• –dxf-scale-deno: de noemer voor de schaal van de symbologie;
• –dxf-encoding: de bestandscodering;
• –dxf-map-theme: kies een kaartthema uit de configuratie voor de boom van lagen.

--take-screenshots

Neemt schermafdrukken voor de gebruikersdocumentatie. Kan samen worden gebruikt met
--screenshots-categories om te filteren welke categorieën/gedeelten van de schermafdrukken voor
de documentatie zouden moeten worden gemaakt (bekĳk QgsAppScreenShots::Categories).

--profile

Laad QGIS met een specifiek gebruikersprofiel uit de map met gebruikersprofielen. Tenzĳ gewĳzigd zal het
geselecteerde profiel worden gebruikt in de volgende sessies van QGIS.

--profiles-path

Met deze optie kunt u een pad kiezen om de profielen te laden en op te slaan (instellingen voor gebruiker). Het
maakt profielen in een map {pad}\profiles, die instellingen, geïnstalleerde plug-ins, modellen en scripts voor
Processing, enzovoort bevat.
Deze optie stelt u bĳvoorbeeld in staat om al uw plug-ins en instellingen mee te nemen op een flashdrive, of,
bĳvoorbeeld, de instellingen tussen verschillende computers te delen met een service voor het delen van bestanden.
De equivalente omgevingsvariabele is QGIS_CUSTOM_CONFIG_PATH.

--version-migration

Als instellingen uit een oudere versie worden gevonden (bĳv. de map .qgis2 uit QGIS 2.18), zal deze optie ze
importeren in het standaardprofiel voor QGIS.

--openclprogramfolder

Met deze optie kunt u een alternatief pad specificeren voor uw programma’s van OpenCL. Dit is nuttig voor
ontwikkelaars bĳ het testen van nieuwe versies van het programma zonder noodzaak om de bestaande te vervangen.
De equivalente omgevingsvariabele is QGIS_OPENCL_PROGRAM_FOLDER.
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9.6.2 QGIS uitrollen in een organisatie

Wanneer u QGIS binnen een organisatie moet uitrollen met een aangepast configuratiebestand, moet
u eerst de inhoud van het standaard bestand met instellingen, geplaatst in uw_QGIS_pakket_pad/
resources/qgis_global_settings.ini, kopiëren/plakken. Dit bestand bevat al enkele standaard
gedeelten, geïdentificeerd door een blok dat begint met []. We raden aan om deze standaardwaarden te behouden
en uw eigen gedeelten toe te voegen aan de onderzĳde van het bestand. Als een gedeelte in het bestand wordt
gedupliceerd, zal QGIS de laatste nemen, gerekend van boven naar beneden.
U kunt allowVersionCheck=false wĳzigen om de controle voor de versie van QGIS uit te schakelen.
Als u niet het migratievenster wilt weergeven na een verse installatie, heeft u het volgende gedeelte nodig:

[migration]
fileVersion=2
settings=true

Als u een aangepaste variabele in het globale bereik wilt toevoegen:

[variables]
organisation="Your organization"

We stellen voor, om de mogelĳkheden van de instellingen voor het bestand INI te ontdekken, dat u de configuratie
die u wilt gebruiken in QGIS Desktop instelt en er dan met een tekstbewerker naar zoekt in uw INI-bestand, dat is
geplaatst in uw profiel. Veel van de instellingen kunnen worden ingesteld met het bestand INI, zoals WMS/WMTS,
verbindingen naar PostGIS, proxy-instellingen, kaarttips…
Tenslotte dient u de omgevingsvariabele QGIS_GLOBAL_SETTINGS_FILE in te stellen naar het pad van uw
aangepaste bestand.
In aanvulling daarop kunt u ook bestanden uitrollen, zoals macro’s voor Python, kleurpaletten, sjablonen voor
afdruklay-outs, sjablonen voor projecten…, ofwel in de systeemmap van QGIS of in het gebruikersprofiel van QGIS.

• Sjablonen voor afdruklay-out moeten worden geplaatst in de map composer_templates.
• Sjablonen voor het project moeten worden geplaatst in de map project_templates.
• Aangepaste macro’s voor Python moeten worden geplaatst in de map python.
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Werken met projecties

Een Coördinaten ReferentieSysteem, of CRS, is een methode van het koppelen van numerieke coördinaten aan een
positie op het oppervlak van de aarde. QGIS heeft ondersteuning voor ongeveer 7.000 standaard CRS-en, elk met een
verschillend doel voor het gebruik, voor- en nadelen! Kiezen van een toepasselĳk referentiesysteem voor uw project
en gegevens van QGIS kan een complexe taak zĳn, maar gelukkig helpt QGIS u bĳ het maken van deze keuze, en
maakt het werken met verschillende CRS-en zo transparant en nauwkeurig als mogelĳk is.

10.1 Overzicht ondersteuning van projecties

QGIS heeft ondersteuning voor ongeveer 7.000 bekende CRS-en. Deze standaard CRS-en zĳn gebaseerd op die
welke zĳn gedefinieerd door de European Petroleum Search Group (EPSG) en het Institut Geographique National
de France (IGNF), en worden in QGIS beschikbaar gemaakt door de onderliggende bibliotheek voor projectie
“Proj”. Gewoonlĳk worden deze standaard projecties geïdentificeerd door een combinatie van autoriteit:code, waar de
autoriteit de naam van een organisatie is, zoals “EPSG” of “IGNF”, en de code een uniek nummer is dat is gekoppeld
aan een specifiek CRS. Bĳvoorbeeld: het veel voorkomende CRS WGS 84 latitude/longitude is bekend onder de
identificatie EPSG:4326, en het standaard CRS voor het in kaart brengen op het web is EPSG:3857.
Aangepaste, door gebruikers gemaakte CRS-en worden opgeslagen in een gebruikersdatabase voor CRS. Bekĳk het
gedeelte Aangepast Coördinaten ReferentieSysteem voor informatie over het beheren van uw aangepaste coördinaten
referentiesystemen.

10.2 Laag coördinaten referentiesystemen

Om gegevens correct te projecteren in een specifiek doel-CRS, moeten uw gegevens ofwel informatie bevatten over
zĳn coördinaten referentiesysteem of u zult handmatig het juiste CRS toe moeten wĳzen aan de laag. Voor PostGIS-
lagen gebruikt QGIS de ruimtelĳke verwĳzingsidentificatie die werd gespecificeerd toen die laag van PostGIS werd
gemaakt. Voor gegevens die worden ondersteund door GDAL vertrouwt QGIS op de aanwezigheid van een herkende
manier van specificeren van het CRS. Voor de indeling Shapefile is dat bĳvoorbeeld een bestand dat een ESRI Well-
Known Text (WKT)-weergave van het CRS van de laag bevat. Dit projectiebestand heeft dezelfde basisnaam als
het bestand .shp en de extensie .prj. Bĳvoorbeeld: alaska.shp zou een corresponderend projectiebestand,
genaamd alaska.prj, hebben.
Wanneer een laag wordt geladen in QGIS, probeert QGIS automatisch het juiste CRS voor die laag te bepalen. In
sommige gevallen is dat niet mogelĳk, bĳv. als een laag is verschaft zonder dat die die informatie bevat. U kunt het
gedrag van QGIS configureren als het niet automatisch het juiste CRS voor een laag kan bepalen:
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1. Open Extra ► Opties… ► CRS

Fig. 10.1: De tab CRS in het dialoogvenster Opties van QGIS

2. Stel, onder de groep CRS voor lagen, de uit te voeren actie inWanneer een nieuwe laag is gemaakt, of wanneer
een laag zonder CRS is geladen. Één van:

• Als een onbekend CRS laten (geen actie ondernemen): er zal niet worden gevraagd een CRS te
selecteren wanneer een laag zonder CRS wordt geladen, wat het kiezen van een CRS uitstelt tot een
later tĳdstip. Handig bĳ het laden van veel lagen in één keer. Dergelĳke lagen zullen in het paneel Lagen
te identificeren zĳn door het pictogram ernaast. Zĳ zullen ook geen verwĳzingen hebben, waarbĳ de
coördinaten van de laag worden behandeld als puur numeriek, niet-aardse waarden, d.i. hetzelfde gedrag
als dat wat alle lagen krĳgen als een project is ingesteld om geen CRS te hebben.

• Prompt voor een CRS: het zal u vragen handmatig het CRS te selecteren. Selecteren van de juiste
keuze is cruciaal, omdat een verkeerde keuze uw laag op de verkeerde positie op het oppervlak van de
Aarde zal plaatsen! Soms zal bĳgeleverde metadata het juiste CRS voor een laag beschrĳven, in andere
gevallen zult u contact dienen op te nemen met de originele auteur van de gegevens om het juiste te
gebruiken CRS te bepalen.

• Project-CRS gebruiken

• Een standaard laag-CRS gebruiken, zoals ingesteld in het combinatievak Standaard CRS voor lagen
erboven.

Tip: Om hetzelfde CRS in te stellen voor meerdere lagen die geen CRS hebben, of een verkeerde hebben ingesteld,
in één bewerking:

1. Selecteer de lagen in het paneel Lagen
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2. Druk op Ctrl+Shift+C. U zou ook met rechts op één van de geselecteerde lagen kunnen klikken of kunnen
gaan naar Laag ► Instellen laag-CRS

3. Zoek en selecteer het juiste te gebruiken CRS
4. En druk op OK. U kunt controleren of het juist is ingesteld op de tab Bron van het dialoogvenster Laag-

eigenschappen.
Onthoud dat het wĳzigen van het CRS in deze instelling op geen enkele wĳze de onderliggende gegevensbron wĳzigt,
in plaats daarvan wĳzigt het slechts hoe QGIS de ruwe coördinaten van de laag in het huidige project van QGIS
interpreteert.

10.3 Project coördinaten referentiesystemen

Elk project in QGIS heeft ook een geassocieerd Coördinaten ReferentieSysteem. Het project-CRS bepaalt hoe
gegevens worden geprojecteerd vanuit de onderliggende ruwe coördinaten naar de vlakke kaart die wordt gerenderd
in uw kaartvenster van QGIS.
QGIS ondersteunt “directe” CRS-transformatie voor zowel raster- als vectorgegevens. Dit betekent dat, ongeacht het
onderliggende CRS van bepaalde lagen in uw project, zĳ altĳd automatisch getransformeerd naar het algemene CRS
dat is gedefinieerd voor uw project. Achter de schermen projecteert QGIS transparant alle in uw project opgenomen
lagen opnieuw naar het CRS van het project, zodat zĳ allemaal zullen worden gerenderd op de juiste positie in
verhouding tot elkaar!
Het is belangrĳk een toepasselĳke keuze te maken voor het CRS van uw projecten van QGIS. Kiezen voor een niet-
toepasselĳk CRS kan er voor zorgen dat uw kaarten er vervormd uitzien, en de relatieve grootten en posities van
objecten in de echte wereld slecht weergeven. Gewoonlĳk, bĳ het werken met kleinere geografische gebieden, zullen
er een aantal standaard CRS-en worden gebruikt binnen een bepaald land of binnen administratieve gebieden. Het is
belangrĳk te onderzoeken welke CRS-en toepasselĳk zĳn of standaard keuzes voor het gebied dat u in kaart brengt,
en er voor te zorgen dat uw project van QGIS deze standaarden volgt.
Standaard begint QGIS elk nieuw project door een globale standaard projectie te gebruiken. Dit standaard CRS is
EPSG:4326 (ook bekend als “WGS 84”), en het is een globaal, op latitude/longitude gebaseerd, referentiesysteem.
Dit standaard CRS kan worden gewĳzigd via de instelling CRS voor projecten op de tab CRS onder Extra► Opties…
(zie Fig. 10.1). Er is een optie om automatisch het CRS van het project zo in te stellen, dat het overeenkomt met het
CRS van de laag die in een project is geladen, of als alternatief kunt u een ander standaard CRS selecteren om te
gebruiken voor alle nieuw gemaakte projecten. Deze keuze zal worden opgeslagen om in volgende sessies van QGIS
te gebruiken.
Het project-CRS kan ook worden ingesteld op de tab CRS van het dialoogvenster Project► Eigenschappen…. Het zal
ook worden weergegeven in de rechterbenedenhoek van de statusbalk van QGIS.
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Fig. 10.2: Dialoogvenster Projecteigenschappen

Beschikbare opties zĳn:

• Geen CRS (of onbekende/niet-aardse projectie): Selecteren van deze instelling zal ALLE afhandeling van
projectie binnen het project van QGIS uitschakelen, wat er voor zorgt dat alle lagen en kaartcoördinaten worden
behandeld als eenvoudige 2D Cartesiaanse coördinaten, zonder relatie met posities op het oppervlak van de
Aarde. Het kan worden gebruikt om naar een laag-CRS te raden (gebaseerd op zĳn ruwe coördinaten of
wanneer QGIS wordt gebruikt voor niet-Aards gebruik, zoals role-playing gamekaarten, bouwen van dingen
voor in kaart brengen of microscopische dingen. In dat geval:

– Er wordt geen opnieuw projecteren uitgevoerd bĳ het renderen van lagen: objecten worden getekend met
behulp van hun ruwe coördinaten.

– De ellipsoïde wordt buitengesloten en geforceerd naar Geen/Planimetrisch.
– De eenheden voor afstanden en gebieden, en de weergave van coördinaten worden uitgesloten en
geforceerd naar “onbekende eenheden”; alle metingen worden uitgevoerd in onbekende kaarteenheden
en er is geen conversie mogelĳk.

• of een bestaand coördinaten referentiesysteem, dat mag zĳn geografisch, geprojecteerd of gebruikergedefinieerd.
Een voorbeeld van het bereik op aarde van het CRS wordt weergegeven om u te helpen de toepasselĳke
te kiezen. Lagen die worden toegevoegd aan het project worden direct naar dit CRS vertaald, om ze te
kunnen overleggen, ongeacht hun originele CRS. Gebruiken van de instelling voor eenheden en ellipsoïde
zĳn beschikbaar en kloppen en u kunt dus overeenkomstige berekeningen uitvoeren.

Wanneer u een nieuw CRS kiest voor uw project van QGIS, zullen de maateenheden automatisch worden gewĳzigd op
de tab Algemeen van het dialoogvenster Projecteigenschappen (Project► Eigenschappen…) om overeen te komen met
het geselecteerde CRS. Bĳvoorbeeld: sommige CRS-en definiëren hun coördinaten in voet in plaats van in meters,
dus instellen van het CRS voor uw project naar een van deze CRS-en zal uw project ook instellen op het standaard
meten in voet.

Tip: Het project-CRS instellen vanuit een laag
U kunt een CRS toewĳzen aan het project met een laag-CRS:

122 Hoofdstuk 10. Werken met projecties



QGIS Desktop 3.28 User Guide

1. Klik met rechts, in het paneel Lagen, op de laag waaruit u het CRS wilt halen
2. Selecteer Project-CRS van laag overnemen.

Het CRS van het project wordt opnieuw gedefinieerd met het CRS van de laag. Bereik van het kaartvenster, weergave
van coördinaten worden overeenkomstig bĳgewerkt en alle lagen in het project worden direct vertaald naar het nieuwe
CRS voor het project.

10.4 Keuze Coördinaten ReferentieSysteem

Dit dialoogvenster helpt u een Coördinaten ReferentieSysteem toe te wĳzen aan een project of een laag, door een set
projectiedatabases te verschaffen. Items in het dialoogvenster zĳn:

• Filter: Wanneer u de EPSGcode weet, of de identificatie of de naam van een Coördinaten ReferentieSysteem,
kunt u gebruik maken van een zoekterm om deze te vinden. Geef de EPSGcode, de identificatie of de naam
op als zoekterm.

• Recent gebruikte coördinaten referentie systemen: wanneer u bepaalde CRS-en vaker gebruikt, dan zullen
deze getoond worden onder in de tabel van het dialoogvenster Projectie. Klik op één van deze items om het
daarbĳ behorende CRS te selecteren.

• Coördinaten ReferentieSysteem: Dit is een lĳst van alle CRSen die ondersteund worden door QGIS, inclusief
geografische, geprojecteerde en zelf gedefinieerde coördinaten referentiesystemen. Selecteer, om een CRS in
te stellen, deze uit de lĳst door de bĳbehorende lĳst uit te klappen en het CRS te selecteren. Het actieve CRS
is vooraf geselecteerd.

• Proj text: Dit is de CRS-tekst die gebruikt wordt door het PROJ projectieprogramma. Deze tekst is alleen-lezen
en wordt ter informatie gegeven.

De keuze voor het CRS geeft ook een ruw voorbeeld van het geografische gebied waarvoor een geselecteerd CRS
geldig is om te gebruiken. Veel CRSen zĳn alleen ontworpen om te gebruiken in kleine geografische gebieden, en
u zou deze niet moeten gebruiken buiten het gebied waarvoor zĳ werden ontworpen. De voorbeeldkaart geeft een
geschat te gebruiken gebied weer wanneer een CRS uit de lĳst wordt geselecteerd. In aanvulling daarop geeft deze
voorbeeldkaart ook een indicatie weer van het huidige kaartbereik van het kaartvenster.

10.5 Aangepast Coördinaten ReferentieSysteem

Indien QGIS niet het coördinaten referentiesysteem levert dat u nodig heeft, kunt u zelf een CRS maken. Kies,
om een CRS te maken, Aangepast CRS via het menu Extra. Zelfgemaakte CRSen worden opgeslagen in een
gebruikersdatabase van QGIS. Deze database bevat ook de Favoriete plaatsen en andere eigen instellingen.
Zelf een CRS definiëren in QGIS vereist wel dat u de functiebibliotheek voor projecties PROJ goed moet begrĳpen.
Bekĳk, om te beginnen, de “Cartographic Projection Procedures for the UNIX Environment - A User’s Manual” door
Gerald I. Evenden, U.S. Geological Survey Open-File Report 90-284, 1990 (beschikbaar op https://pubs.usgs.gov/
of/1990/of90-284/ofr90-284.pdf).
Deze handleiding beschrĳft het gebruik van proj en de daarbĳ behorende programma’s voor de opdrachtregel. De
cartografische parameters die gebruikt worden voor proj worden beschreven in de gebruikershandleiding en deze
kunnen ook worden gebruikt in QGIS.
Het dialoogvenster Definitie aangepast Coördinaten ReferentieSysteem heeft slechts twee parameters nodig om een
gebruikers CRS te maken:

1. Een beschrĳvende naam
2. De cartografische parameters in indeling PROJ of WKT

Een nieuw CRS maken:

1. Klik op de knop Nieuw CRS toevoegen
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2. Voer een beschrĳvende naam in
3. Selecteer de indeling: het mag zĳn Proj String ofWKT

4. Voeg de Parameters voor het CRS toe.

Notitie: Voorkeur voor opslaan van de CRS-definitie in indeling WKT
Hoewel zowel de indelingen Proj String als WKT worden ondersteund, wordt ten zeerste aanbevolen om
definities voor projectie op te slaan in de indeling WKT. Daarom, als de beschikbare definitie in de indeling
proj is, selecteer die indeling, voer de parameters in en schakel dan over naar de indeling WKT. QGIS zal de
definitie converteren naar de indeling WKT, die u later kunt opslaan.

5. Klik op Valideren om te testen of de definitie van het CRS een acceptabele definitie voor projectie is.

Fig. 10.3: Dialoogvenster Aangepast CRS

U kunt de opgegeven parameters voor het CRS testen om te zien of deze goede resultaten geven. Geef, om dit te doen,
bekende coördinaten in waarden lat/long voor WGS84 op in de velden Noord en Oost. Klik op Bereken en vergelĳk
de resultaten met de bekende waarden in uw Coördinaten ReferentieSysteem.
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10.5.1 Een NTv2-transformatie integreren in QGIS

U heeft één extra stap nodig om een NTv2-transformatiebestand in QGIS te integreren:
1. Plaats het bestand voor NTv2 (.gsb) in demap CRS/Proj die QGIS gebruikt (bĳv. C:\OSGeo4W64\share\

proj voor gebruikers van Windows)
2. Voeg nadgrids (+nadgrids=nameofthefile.gsb) toe aan de definitie van Proj in het veld Parameters

van de Definitie aangepast Coördinaten ReferentieSysteem (Extra ► Aangepaste projecties…).

Fig. 10.4: Een NTv2-transformatie instellen

10.6 Datumtransformaties

In QGIS is ‘directe’ CRS-transformatie standaard ingeschakeld, wat betekent dat, elke keer als u lagen gebruikt met
verschillende coördinatensystemen, QGIS ze transparant opnieuw projecteert naar het CRS van het project. Voor
sommige CRSen zĳn er enkele mogelĳke transformaties beschikbaar om opnieuw naar het CRS van het project te
projecteren!
Standaard zal QGIS proberen de meest nauwkeurige beschikbare transformatie te gebruiken. In sommige gevallen
zou dit echter mogelĳk kunnen zĳn, bĳv. wanneer aanvullende bestanden voor ondersteuning zĳn vereist om een
transformatie te gebruiken. Wanneer een meer nauwkeurige transformatie beschikbaar is, maar momenteel niet
te gebruiken is, zal QGIS een informatief waarschuwingsbericht weergeven, dat u zal adviseren over de meer
nauwkeurige transformatie en hoe die op uw systeem in te schakelen. Gewoonlĳk vereist dit het downloaden van
een extern pakket van bestanden voor ondersteuning van de transformatie, en deze uit te pakken naar de map proj
onder uw map gebruikersprofiel in QGIS.
Indien gewenst kan QGIS het u ook vragen als er meerdere mogelĳke transformaties kunnen worden uitgevoerd tussen
twee CRSen, en u toestaan een geïnformeerde selectie te maken over wat de meest van toepassing zĳnde te gebruiken
transformatie voor uw gegevens is.

Deze aanpassing wordt gemaakt in het tabmenu Extra ► Opties ► Transformaties onder de groep Standaard
datumtransformaties:

• Vraag naar datumtransformatie als meerdere beschikbaar zĳn gebruiken: indien meer dan één toepasselĳke
datumtransformatie bestaat voor een combinatie van bron-/doel-CRS, zal automatisch een dialoogvenster
worden geopend, dat gebruikers vraagt te kiezen welke van deze datumtransformaties te gebruiken voor het
project. Als het keuzevak Standaard maken is geselecteerd bĳ het selecteren van een transformatie uit dit
dialoogvenster, dan wordt de keuze onthouden en automatisch worden toegepast op alle nieuw gemaakte
projecten van QGIS.

• of het definiëren van een lĳst met als standaard te gebruiken toepasselĳke datumtransformaties bĳ het laden
van een laag in een project of het opnieuw projecteren van een laag.

Gebruik de knop om het dialoogvenster Datumtransformaties selecteren te openen. Dan:

1. Kies het Bron-CRS van de laag uit het keuzemenu of de widget CRS selecteren.
2. Geef op dezelfde manier het Doel-CRS op.
3. Een lĳst met beschikbare transformaties van bron naar doel zal in de tabel worden weergegeven. Klikken

op een rĳ zal de details van de toegepaste instellingen weergeven en de corresponderende nauwkeurigheid
en gebruikt gebied van de transformatie.
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Fig. 10.5: Een voorkeur standaard datumtransformatie selecteren

In sommige gevallen zou een transformatie niet te gebruiken kunnen zĳn op uw systeem. In dat geval
zal de transformatie nog steeds weergegeven worden (uitgegrĳsd) in deze lĳst, maar kan niet worden
geselecteerd totdat u het vereiste pakket voor ondersteuning van de transformatie hebt geïnstalleerd.
Gewoonlĳk wordt een knop verschaft om het overeenkomstige raster te downloaden en te installeren.
wat dan wordt opgeslagen in de map proj in de map van het actieve gebruikersprofiel.

4. Zoek naar de transformatie van uw voorkeur en selecteer die

5. Stel in of u wilt Terugvallen op transformaties, als voorkeursbewerking mislukt, toestaan

6. Klik op OK.
Een rĳ wordt toegevoegd in de tabel onder Standaard datumtransformatiesmet informatie over Bron-CRS
enDoel-CRS, de toegepaste Bewerking voor de transformatie en of Terugvallen op transformaties toestaan
is ingeschakeld.

Vanaf nu gebruikt QGIS automatisch de geselecteerde datumtransformaties voor verdere transformaties tussen
deze twee CRSen, totdat u hem verwĳdert ( ) uit de lĳst of het item wĳzigt ( ) in de lĳst.

Datumtransformaties die zĳn ingesteld op de tab Extra► Opties► Transformaties zullen worden geërfd door nieuw
gemaakte projecten voor QGIS op het systeem. Aanvullend zou een bepaald project zĳn eigen specifiek ingestelde
set van transformaties kunnen hebben, gespecificeerd via de tab CRS van het dialoogvenster Projecteigenschappen
(Project ► Eigenschappen…). Deze instellingen zĳn alleen van toepassing voor het huidige project.
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Kaarten visualiseren

Het maken van kaarten is een van de “zakelĳke doelen” van QGIS. Kaartweergaven zĳn kaartvensters om ruimtelĳke
lagen in het project te visualiseren, met de verschillende instellingen voor renderen op hen toegepast. Ze kunnen zĳn
van het type 2D of 3D of geplot langs een profiellĳn, verschillende schaal of bereik weergeven, of een verschillende
set van de geladen lagen weergeven dankzĳ kaartthema’s.

11.1 2D-kaartweergave

De 2D-kaartweergave (ook wel kaartvenster genoemd) is de centrale plaats waar kaarten worden weergegeven.
QGIS opent standaard met één enkele kaartweergave (genaamd hoofdkaart), die lagen weergeeft in 2D, en strak
verbonden is met het paneel Lagen. Dat venster geeft het renderen weer (symbologie, labelen, zichtbaarheden…) die
u hebt toegepast op de geladen lagen.

Fig. 11.1: Gebruikersinterface van QGIS
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11.1.1 De kaartweergave verkennen

Wanneer u een laag toevoegt (bekĳk bĳv. Gegevens openen), zoekt QGIS automatisch naar het CRS ervan. Als
standaard een ander CRS is ingesteld voor het project (zie Project coördinaten referentiesystemen), dan wordt het
laagbereik “direct” vertaald naar dat CRS, en de kaartweergave wordt gezoomd naar dat bereik als u begint met een
blanco project van QGIS. Als er al lagen in het project staan, wordt geen aanpassing van het kaartvenster uitgevoerd,
dus zullen alleen objecten, die vallen binnen het huidige bereik van het kaartvenster, zichtbaar zĳn.
Klik op de kaartweergave en u zou er mee moeten kunnen interacteren, verschuiven of zoomen naar verschillende
gebieden van de kaart. Aangewezen gereedschappen worden verschaft op deWerkbalk Navigatie en in het menu Beeld,
met een handvol sneltoetsen voor het toetsenbord of de muisknoppen.

Tabel 11.1: Gereedschappen voor navigatie kaartvenster
Gereedschap Gebruik

Kaart
verschuiven • Enkele klik met links: de kaart wordt gecentreerd op het aangeklikte punt, op

dezelfde schaal
• Houd de linkermuisknop ingedrukt en versleep het kaartvenster.

Inzoomen
• Enkele klik met links: de kaart wordt gecentreerd op het aangeklikte punt, terwĳl
de schaal wordt verdubbeld

• Sleep een rechthoek in het kaartvenster met de linkermuisknop om in te zoomen
op een gebied.

• Houd de Alt-toets ingedrukt om te schakelen naar het gereedschap Uitzoomen.

Uitzoomen
• Enkele klik met links: de kaart wordt gecentreerd op het aangeklikte punt, terwĳl
de schaal wordt gehalveerd

• Sleep een rechthoek in het kaartvenster met de linkermuisknop om uit te zoomen
van een gebied.

• Houd de Alt-toets ingedrukt om te schakelen naar het gereedschap Inzoomen.

Kaart verschuiven naar selectie
Verschuif de kaart naar de geselecteerde objecten van alle geselecteerde lagen in het
paneel Lagen.

Inzoomen op selectie Zoom naar de geselecteerde objecten van alle geselecteerde lagen in het paneel Lagen.
Ook beschikbaar in het contextmenu van de laag

Zoomen naar la(a)g(en) Zoom naar het bereik van alle geselecteerde lagen in het paneel Lagen.
Ook beschikbaar in het contextmenu van de laag

Volledig uitzoomen Zoom naar het bereik van alle lagen in het project of naar het volledige bereik van project.
Laatste zoomniveau De kaart naar het vorige bereik in de geschiedenis zoomen.
Zoom naar volgende De kaart naar het volgende bereik in de geschiedenis zoomen.

Zoom naar eigen resolutie
De kaart naar een niveau zoomen waarbĳ één pixel van de actieve rasterlaag één
schermpixel bedekt.
Ook beschikbaar in het contextmenu van de laag

Vervolgt op volgende pagina
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Tabel 11.1 – Vervolgd van vorige pagina
Gereedschap Gebruik
Muiswiel

• Kaart verschuiven: Houd het muiswiel ingedrukt en versleep.
• Zoomen: Rol het muiswiel om in of uit te zoomen. Met de Ctrl-toets ingedrukt
tĳdens het rollen geeft het muiswiel een fĳnere zoom.

• Druk op de knop terug of voorwaarts om door de geschiedenis van het zoomen in
het kaartvenster te bladeren.

Toetsenbord
• Kaart verschuiven: Houd de :kbd:`Spatie`balk ingedrukt en verplaats de muis. Druk
op de pĳltjestoetsen om te verschuiven naar boven, beneden, links en rechts.

• Inzoomen: Druk op PgUp of Ctrl++
• Uitzoomen: Druk op PgDown of Ctrl+-
• Zoom naar gebied: Als bepaalde kaartgereedschappen actief zĳn (Objecten
identificeren, Meten…), houd de Shift-toets ingedrukt en sleep een rechthoek
op de kaart om naar dat gebied te zoomen. Niet compatibel met actieve selectie of
gereedschappen Bewerken.

Klik met rechts boven de kaart en u zou in staat moeten zĳn om Coördinaten kopiëren te gebruiken voor het
aangeklikte punt in het kaart-CRS, in WGS84 of in een aangepast CRS. De gekopieerde informatie kan dan worden
geplakt in een expressie, een script, tekstbewerker of werkblad…

11.1.2 Controle over het renderen van de kaart

QGIS zal standaard automatisch de zichtbare lagen opnieuw opbouwen, renderen, als het kaartvenster wordt
vernieuwd. De gebeurtenissen die het verversen van het kaartvenster starten bevatten:

• wĳzigen van de zichtbaarheid van een laag
• aanpassen symbologie van een zichtbare laag
• een laag toevoegen
• verschuiven of in-/uitzoomen
• wĳzigen van de grootte van het venster van QGIS

QGIS geeft u op een aantal manieren controle over het proces van renderen.
• op het globale niveau
• per laag, gebruiken van de Schaalafhankelĳke zichtbaarheid
• of met aangewezen gereedschappen in de gebruikersinterface.

Druk op de ESC-toets om het tekenen van de kaart te stoppen. Dit zal het opnieuw tekenen van de kaart onderbreken
waardoor de kaart slechts gedeeltelĳk getekend is. Het kan echter even duren voordat het tekenen stopt na het
indrukken van de ESC-toets.

Klik op het keuzevak (Her)teken in de rechterbenedenhoek van de statusbalk om het renderen uit te stellen.
Wanneer het keuzevak (Her)teken niet is geselecteerd, zal QGIS het kaartvenster niet opnieuw opbouwen bĳ de
gebeurtenissen die beschreven zĳn in het gedeelte Controle over het renderen van de kaart. Voorbeelden voor wanneer
u het opnieuw renderen wilt uitstellen bevatten:

• toevoegen van veel kaartbladen en die van symbologie voorzien vóór het tekenen
• toevoegen van een of meer grote lagen en instellen schaalafhankelĳkheid vóór het tekenen
• toevoegen van één of meer grote lagen en inzoomen tot een specifieke weergave vóór tekenen
• elke combinatie van bovenstaande
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Het weer selecteren van (Her)teken zal onmiddellĳk het opnieuw opbouwen van het kaartvenster starten.

11.1.3 Op tijd gebaseerd beheer in het kaartvenster

QGIS kan Tĳdbeheer afhandelen op geladen lagen, d.i. het renderen van het kaartvenster aanpassen, gebaseerd op
variatie in tĳd. U moet, om dit te kunnen bereiken:

1. Lagen hebben die dynamische eigenschappen voor tĳd hebben ingesteld. QGIS ondersteunt tĳdbeheer voor
verschillende gegevensproviders, met aangepaste instellingen. Het is voornamelĳk het instellen van het
tĳdbereik waarin de laag zou moeten weergeven:

• rasterlagen: beheert om de laag al dan niet weer te geven.
• WMTS-lagen: beheert of de gegevens zouden moeten worden gerenderd gebaseerd op een statische
tĳdsperiode of een dynamische tĳdsperiode moeten volgen

• vectorlagen: objecten worden gefilterd, gebaseerd op tĳdwaarden die zĳn geassocieerd aan hun attributen
• lagen met mazen: geven dynamisch de actieve waarden van de groepen in de gegevensset

Wanneer dynamische opties voor tĳdbeheer voor een laag zĳn ingeschakeld, wordt een pictogram
weergegeven naast de laag in het paneel Lagen om u eraan te herinneren dat op de laag Tĳdbeheer wordt
toegepast. Klik op het pictogram om de instellingen voor tĳdbeheer bĳ te werken.

2. Schakel de navigatie voor Tĳdbeheer in het kaartvenster in met het paneel Tĳdbeheer. Het paneel wordt
geactiveerd:

• met het pictogram paneel Tĳdbeheer dat is geplaatst op de werkbalk Kaartnavigatie

• of vanuit het menu Beeld ► Panelen ► Tĳdbeheer

Het paneel Tijdbeheer

Het paneel Tĳdbeheer heeft de volgende modi:

Fig. 11.2: Paneel Tijdbeheer in modus Navigatie

• Navigatie voor tĳd uitschakelen: alle instellingen voor tĳdbeheer worden uitgeschakeld en zichtbare lagen worden
gerenderd zoals gewoonlĳk

• Vast bereik voor navigatie voor tĳd: een tĳdbereikwordt ingesteld en alleen lagen (of objecten) waarvan het tĳdbereik
overlapt met dit bereik worden op de kaart weergegeven.

• Geanimeerde navigatie voor tĳd: een tĳdbereik wordt ingesteld, gesplitst in stappen, en alleen lagen (of objecten)
waarvan het tĳdbereik van Tĳdbeheer overlapt met elk frame worden op de kaart weergegeven.

• Instellingen voor algemeen beheer van de animatie
– Framesnelheid: aantal stappen die per seconde worden weergegeven

– Op volledig bereik instellen: alle frames voor de animatie zullen dezelfde begindatum/-tĳd hebben,
maar verschillende einddatums en -tĳden. Dit is nuttig als u gegevens in uw visualisatie van Tĳdbeheer
wilt accumuleren, in plaats van een ‘bewegend tĳdvenster’ weer te geven van uw gegevens.
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Animeren van een navigatie in Tijdbeheer

Een animatie is gebaseerd op een variërende set van zichtbare lagen op bepaalde tĳden binnen een tĳdbereik. Een
animatie voor Tĳdbeheer maken:

1. Schakel het gereedschap Geanimeerde navigatie voor tĳd in, wat de widget voor de speler van animaties zal
weergeven

2. Voer het Tĳdbereik in. Gebruik de knop Vernieuwen, deze kan worden gedefinieerd als:
• Op volledig bereik instellen voor alle voor tĳd ingeschakelde lagen
• Op voorkeur projectbereik instellen zoals gedefinieerd in de project-eigenschappen
• Op bereik van enkele laag instellen genomen uit een voor tĳd ingeschakelde laag

3. Voer de tĳd in Stap om het tĳdbereik te splitsen. Verschillende eenheden worden ondersteund, van seconden
tot en met eeuwen. Een optie bron tijdstempels is ook beschikbaar als stap: wanneer geselecteerd
zorgt dit er voor dat de navigatie voor tĳdbeheer door alle beschikbare tĳdbereiken uit de lagen in het project
stapt. Dit is nuttig wanneer een project lagen bevat met niet aaneensluitende beschikbare tĳden, zoals een
WMS-T-service die afbeeldingen verschaft die beschikbaar zĳn op onregelmatige datums. Deze optie zal
u ook toestaan om alleen door de tĳdbereiken te stappen waar de volgende beschikbare afbeelding wordt
weergegeven.

4. Klik op de knop om een voorbeeld van de animatie te zien. QGIS zal scenes maken met het renderen
van lagen op ingestelde tĳden. Weergaven van lagen is afhankelĳk van het feit of zĳ een individueel tĳdframe
overlappen.
De animatie kan ook worden bekeken door de schuifbalk voor tĳd te verplaatsen. Selecteren van het keuzevak

Lus zal de animatie herhaald afspelen, terwĳl het klikken op een uitgevoerde animatie stopt. Een
volledige set van knoppen voor de videospeler is beschikbaar.
Horizontaal scrollen met het muiswiel (indien ondersteund) met de cursor in het kaartvenster zal u ook toestaan
om te navigeren, of de schuifbalk van de navigatie voor Tĳdbeheer naar achteren en naar voren te “schrobben”.

5. Klik op de knop Animatie exporteren als u een reeks afbeeldingen wilt maken die de scene weergeven. Zĳ
kunnen later in videobewerker-software worden gecombineerd:
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Fig. 11.3: Exporteren van scenes van de animatie in het kaartvenster als afbeeldingen

• De bestandsnaam Sjabloon: de #### worden vervangen door het reeksnummer van het frame
• De Map voor uitvoer

• Onder Instellingen kaart, kunt u:
– het te gebruiken bereik opnieuw definiëren
– de Resolutie van de afbeelding beheren (Breedte uitvoer en Hoogte uitvoer)
– Actieve decoraties tekenen: of actieve decoraties zouden moeten worden behouden in de uitvoer

• Onder Instellingen Tĳdbeheer, kunt u opnieuw definiëren:
– het tĳd-Bereik voor de animatie
– de Stap (framelengte) in de eenheid van uw keuze

11.1.4 Favoriete plaatsen maken van bereiken op de kaart

Favoriete plaatsen stellen u in staat een “bladwĳzer” te maken van een geografische locatie en daar later naar terug
te keren. Standaard worden Favoriete plaatsen opgeslagen in het gebruikersprofiel (als Favoriete plaatsen Gebruiker),
wat betekent dat zĳ beschikbaar zĳn vanuit elk project dat de gebruiker opent. Zĳ kunnen ook worden opgeslagen
voor één enkel project (genaamd Favoriete plaatsen Project) en opgeslagen in het projectbestand, wat nuttig kan zĳn
als het project moet worden gedeeld met andere gebruikers.
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Favoriete plaats maken

Een favoriete plaats maken:
1. Zoomen verschuiven naar het interessegebied.

2. Selecteer de menuoptie Beeld ► Nieuwe Favoriete plaats…, druk op Ctrl+B of klik met rechts op het

item Favoriete plaatsen in het paneel Browser en selecteer Nieuwe Favoriete plaats. Het dialoogvenster
Favoriete plaatsen bewerken opent.

Fig. 11.4: Het dialoogvenster Favoriete plaatsen bewerken

3. Voer een beschrĳvende naam in voor de Favoriete plaats
4. Voer een groepsnaam in of selecteer die waarin gerelateerde plaatsen moeten worden opgeslagen
5. Selecteer het bereik van het gebied dat u wilt opslaan, gebruik de widget bereik selecteren

6. Geef het te gebruiken CRS aan voor het bereik
7. Selecteer of de Favoriete plaats moet worden Opgeslagen in Favoriete plaatsen Gebruiker of Favoriete plaatsen

Project (standaard is deze keuzelĳst ingesteld op Favoriete plaatsen Gebruiker)
8. Druk op Opslaan om de Favoriete plaats aan de lĳst toe te voegen

Men kan meerdere favorieten onder dezelfde naam opslaan.
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Werken met Favoriete plaatsen

U kunt, om Favoriete plaatsen te gebruiken en te beheren, ofwel het paneel Favoriete plaatsen of Browser gebruiken.

Selecteer Beeld► Favoriete plaatsen beheren tonen of druk op Ctrl+7 om het paneel Favoriete plaatsen beheren

weer te geven. Selecteer Beeld ► Favoriete plaatsen tonen of Ctrl+Shift+B om het item Favoriete
plaatsen in het paneel Browser weer te geven.
U kunt de volgende taken uitvoeren:

Tabel 11.2: Acties voor Favoriete plaatsen beheren
Taak Favoriete plaatsen beheren Browser
Naar Favoriete
plaats zoomen

Dubbelklik er op, of selecteer de Favoriete
plaats en druk op de knop Naar
Favoriete plaats zoomen.

Dubbelklik er op, sleep het naar het
kaartvenster en zet het neer, of klik met
rechts en selecteer Naar Favoriete
plaats zoomen.

Een Favoriete
plaats verwĳderen

Selecteer de Favoriete plaats en klik op
de knop Favoriete plaats verwĳderen.
Bevestig uw keuze.

Klik met rechts op de Favoriete plaats en
selecteer Favoriete plaats verwĳderen.
Bevestig uw keuze.

Favoriete plaatsen
exporteren naar
XML

Klik op de knop Favoriete plaatsen

im-/exporteren en selecteer Exporteren.
Alle Favoriete plaatsen (gebruiker of
project) worden opgeslagen in een XML-
bestand.

Selecteer één of meer mappen (gebruiker
of project) of submappen (groepen),
en klik dan met rechts en selecteer

Favoriete plaatsen exporteren…. De
geselecteerde subset van favoriete plaatsen
wordt opgeslagen.

Favoriete plaatsen
importeren vanuit
XML

Klik op de knop Favoriete plaatsen

im-/exporteren en selecteer Importeren.
Alle Favoriete plaatsen in het XML-bestand
worden geïmporteerd als Favoriete plaatsen
Gebruiker

Klik met rechts op het item Favoriete
plaatsen of één van zĳn mappen (gebruiker
of project) of submappen (groepen) om
te bepalen waar de Favoriete plaatsen
moeten worden geïmporteerd, selecteer dan

Favoriete plaatsen importeren. Indien
uitgevoerd op het item Favoriete plaatsen,
worden de Favoriete plaatsen toegevoegd
aan Favoriete plaatsen Gebruiker.

Een Favoriete
plaats bewerken

U kunt een Favoriete plaats wĳzigen door
zĳn waarden in de tabel te veranderen. U
kunt de naam, de groep, het bereik en of
het al dan niet is opgeslagen in het project
bewerken.

Klik met rechts op de gewenste Favoriete
plaats en selecteer Favoriete plaatsen
bewerken…. Favoriete plaatsen bewerken
zal openen, en u staat stellen elk aspect van
de Favoriete plaats opnieuw te definiëren
alsof u het voor de eerste keer maakte.
U kunt de Favoriete plaats ook slepen-en-
nneerzetten tussen mappen (gebruiker en
project) en submappen (groepen).

U kunt ook naar Favoriete plaatsen zoomen door de naam van de Favoriete plaats te typen in de balk Lokaliseren.
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11.1.5 De kaart decoreren

Decoraties omvatten raster, Titellabel, label Copyright, afbeelding, noordpĳl, schaalbalk en bereiken voor lay-outs.
Ze worden gebruikt om de kaart te ‘decoreren’ door cartografische elementen toe te voegen.

Raster

Raster geeft de mogelĳkheid om een coördinatenraster en annotaties van coördinaten toe te voegen aan het
kaartvenster.

1. Selecteer de menuoptie Beeld ► Decoraties ► Raster… om het dialoogvenster te openen.

Fig. 11.5: Dialoogvenster Raster

2. Selecteer Raster inschakelen en stel de definitie voor het raster in overeenkomstig de geladen lagen in het
kaartvenster:

• Het Type grid: het kan zĳn Lĳn of Markering

• Het geassocieerde Lĳnsymbool of Markeringssymbool dat wordt gebruikt om de markeringen van het
raster weer te geven

• De Interval X en Interval Y tussen de markeringen van het raster, in kaarteenheden
• Een afstand Verspringing X en Verspringing Y voor de markeringen van het raster, vanaf de
linkerbenedenhoek van het kaartvenster, in kaarteenheden

• De parameters interval en verspringing kunnen worden ingesteld, gebaseerd op de:
– Kaartbereiken: maakt een raster met een interval die bĳ benadering 1/5 van de breedte van het
kaartvenster is

– resolutie van de Actieve rasterlaag
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3. Selecteer Annotatie tekenen om de coördinaten van de markeringen van het raster weer te geven en in te
stellen:

• De Annotatie richting, d.i. hoe de labels moeten worden geplaatst, relatief ten opzichte van hun rasterlĳn.
Het kan zĳn:
– Horizontaal of Verticaal voor alle labels
– Horizontaal en Verticaal, d.i. elk label staat parallel aan de rastermarkering waarnaar het verwĳst
– Grens richting, d.i. elk label volgt de grens van het kaartvenster, en staat loodrecht op de
rastermarkering waarnaar het verwĳst

• Het Lettertype annotatie (tekstopmaak, buffer, schaduw…) met de widget Selectie lettertype

• DeAfstand tot kaartvenster, marge tussen annotaties en grenzen van het kaartvenster. Handig bĳvoorbeeld
bĳ het exporteren van het kaartvenster naar een indeling voor een afbeelding of PDF, en vermĳden dat
annotaties op de grenzen van het “papier” staan.

• De Coördinaat precisie
4. Klik op Toepassen om te verifiëren of het eruit ziet zoals u verwachtte, of op OK als u tevreden bent.

Titellabel

Titellabel stelt u in staat uw kaart te decoreren met een Titel.
Een decoratie Titellabel toevoegen:

1. Selecteer de menuoptie Beeld ► Decoraties ► Titellabel… om het dialoogvenster te openen.

Fig. 11.6: Het dialoogvenster Titellabel-decoratie

2. Zorg er voor dat het keuzevak Titellabel inschakelen is geselecteerd
3. Voer de tekst voor de titel in die u op de kaart wilt plaatsen. U kunt het dynamisch maken met de knop Een

expressie invoeren of bewerken….
4. Kies het Lettertype voor het label met behulp van dewidget Selectie lettertypemet volledige toegang tot de opties

van QGIS voor opmaken van tekst. Snel instellen van de kleur voor het lettertype en doorzichtbaarheid door te
klikken op de zwarte pĳl aan de rechterkant van het combinatievak.

5. Selecteer de kleur die moet worden toegepast als de Kleur achtergrondbalk voor de titel
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6. Kies de Plaatsing van het label in het kaartvenster: opties zĳn Linksboven, Centraal boven, Rechtsboven,
Linksonder, Centraal onder, en Rechtsonder.

7. Verfĳn de plaatsing van het item door een horizontale en/of verticale Marge vanaf rand in te stellen. Deze
waarden mogen zĳn in Millimeter of Pixels of ingesteld als Percentage van de breedte of hoogte van het
kaartvenster.

8. Klik op Toepassen om te verifiëren of het eruit ziet zoals u verwachtte, of op OK als u tevreden bent.

Label Copyright

Label Copyright stelt u in staat uw kaart te decoreren met een label Copyright.
Deze decoratie toevoegen:

1. Selecteer de menuoptie Beeld ► Decoraties ► Label Copyright… om het dialoogvenster te openen.

Fig. 11.7: Het dialoogvenster Copyrightlabel-decoratie

2. Zorg er voor dat het keuzevak Copyrightlabel inschakelen is geselecteerd
3. Voer de tekst voor het label Copyright in die u op de kaart wilt plaatsen. U kunt het dynamisch maken met de

knop Een expressie invoeren of bewerken….
4. Kies het Lettertype voor het label met behulp van dewidget Selectie lettertypemet volledige toegang tot de opties

van QGIS voor opmaken van tekst. Snel instellen van de kleur voor het lettertype en doorzichtbaarheid door te
klikken op de zwarte pĳl aan de rechterkant van het combinatievak.

5. Kies de Plaatsing van het label in het kaartvenster: opties zĳn Linksboven, Centraal boven, Rechtsboven,
Linksonder, Centraal onder, en Rechtsonder (standaard voor decoratie Copyright)

6. Verfĳn de plaatsing van het item door een horizontale en/of verticale Marge vanaf rand in te stellen. Deze
waarden mogen zĳn in Millimeter of Pixels of ingesteld als Percentage van de breedte of hoogte van het
kaartvenster.

7. Klik op Toepassen om te verifiëren of het eruit ziet zoals u verwachtte, of op OK als u tevreden bent.

Decoratie Afbeelding

Afbeelding geeft u de mogelĳkheid om een afbeelding (logo, legenda, …) aan het kaartvenster toe te voegen.
Een afbeelding toevoegen

1. Selecteer de menuoptie Beeld ► Decoraties ► Afbeelding… om het dialoogvenster te openen.
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Fig. 11.8: Het dialoogvenster Decoratie afbeelding

2. Zorg er voor dat het keuzevak Afbeelding inschakelen is geselecteerd
3. Selecteer een bitmap (bĳv. png of jpg) of een afbeelding SVG met de knop… Bladeren

4. Als u een parameter hebt gekozen die SVG inschakelt, dan kunt u ook een keur voor Vuling of Lĳn (omtrek)
instellen. Voor afbeeldingen bitmap zĳn de instellingen voor kleuren uitgeschakeld.

5. Stel een Grootte in voor de afbeelding, in mm. De breedte van de geselecteerde afbeelding wordt gebruikt om
het aan te passen naar de ingestelde Grootte.

6. Kies waar u de afbeelding wilt plaatsen in het kaartvenster met het combinatievak Plaatsing. De
standaardpositie is Linksboven.

7. Stel deMarge vanaf randHorizontaal enVerticaal in. Deze waarden kunnen worden ingesteld inMillimeters,
Pixels of als een Percentage van de breedte of hoogte van het kaartvenster.

8. Klik op Toepassen om te verifiëren of het eruit ziet zoals u verwachtte en op OK als u tevreden bent.

Noordpijl

Noordpĳl geeft u de mogelĳkheid om een noordpĳl toe te voegen aan het kaartvenster.
Een noordpĳl toevoegen:

1. Selecteer de menuoptie Beeld ► Decoraties ► Noordpĳl… om het dialoogvenster te openen.
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Fig. 11.9: Dialoogvenster Noordpijl

2. Zorg er voor dat het keuzevak Noordpĳl gebruiken geselecteerd is
3. Wĳzig, optioneel, de kleur en grootte, of kies een aangepaste SVG
4. Wĳzig, optioneel, de hoek of kies Automatisch om QGIS de richting te laten bepalen
5. Kies, optioneel, de plaatsing uit het combinatievak Plaatsing
6. Verfĳn, optioneel, de plaatsing van de pĳl door het instellen van een horizontale en/of verticale Marge vanaf

rand. Deze waarden mogen zĳn inMillimeter of Pixels of ingesteld als Percentage van de breedte of hoogte
van het kaartvenster.

7. Klik op Toepassen om te verifiëren of het eruit ziet zoals u verwachtte en op OK als u tevreden bent.

Schaalbalk

Schaalbalk plaatst een eenvoudige schaalbalk in het kaartvenster. De stĳl en de plaats kan worden aangepast
evenals de labels van de Schaalbalk.
QGIS ondersteunt alleen het tonen van de schaal in dezelfde eenheid als die van de kaart. Dus als de eenheid van de
CRS-en van uw project in meters zĳn, kunt u niet een schaalbalk maken in feet. Zo kunt u ook geen schaalbalk in
meters tonen wanneer de gebruikte kaart als eenheid decimale graden gebruikt.
Een schaalbalk toevoegen:

1. Selecteer de menuoptie Beeld ► Decoraties ► Schaalbalk… om het dialoogvenster te openen.
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Fig. 11.10: Dialoogvenster Schaalbalk

2. Zorg er voor dat het keuzevak Schaalbalk inschakelen is geselecteerd

3. Kies de stĳl in de keuzelĳst Schaalbalkstĳl

4. Selecteer de Schaalbalkkleur door een vulkleur te kiezen (standaard: zwart) en een kleur
voor de omtrek (standaard: wit). De vulkleur en die van de omtrek van de schaalbalk kunnen doorzichtig
worden gemaakt door te klikken op de pĳl naar beneden, rechts van de invoer voor de kleur.

5. Selecteer het lettertype voor de schaalbalk uit de keuzelĳst Lettertype van balk

6. Stel de Grootte van de balk in

7. Optioneel, selecteer Afronden op gehele getallen tĳdens het wĳzigen van kaartgrootte om waarden weer te
geven die gemakkelĳk te lezen zĳn

8. Kies de plaatsing met de keuzelĳst Plaatsing
9. U kunt de plaatsing van het item verfĳnen door een horizontale en/of verticaleMarge vanaf rand in te stellen.

Deze waarden mogen zĳn in Millimeter of Pixels of ingesteld als Percentage van de breedte of hoogte van
het kaartvenster.

10. Klik op Toepassen om te verifiëren of het eruit ziet zoals u verwachtte, of op OK als u tevreden bent.

Bereiken lay-out

Bereiken lay-out voegt de bereiken van de kaartitem(s) in afdruklay-out(s) toe aan het kaartvenster. Indien
ingeschakeld worden bereiken van alle kaartitems in alle afdruklay-outs weergegeven met een licht gestippelde rand,
gelabeld met de naam van de afdruklay-out en het kaartitem. U kunt de stĳl en het labelen van de weergegeven
bereiken van de lay-out beheren. Deze decoratie is nuttig als u de plaatsing van kaartelementen, zoals labels, aanpast
en de feitelĳke zichtbare plaats van afdruklay-outs moet weten.
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Fig. 11.11: Voorbeeld van bereiken van lay-out, weergegeven in een project van QGIS met twee afdruklay-outs. De
afdruklay-out ‘Sights’ bevat twee kaartitems, terwijl de andere lay-out één kaartitem bevat.

Bereik(en) lay-out toevoegen:
1. Selecteer Beeld ► Decoraties ► Bereiken lay-out om het dialoogvenster te openen

Fig. 11.12: Het dialoogvenster Bereiken lay-out

2. Zorg er voor dat het keuzevak Bereiken lay-out weergeven geselecteerd is.
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3. Wĳzig, optioneel, de symbolen en het labelen van de bereiken.
4. Klik op Toepassen om te verifiëren of het eruit ziet zoals u verwachtte en op OK als u tevreden bent.

Tip: Instellingen decoraties
Wanneer u een project van QGIS opslaat, zullen de wĳzigingen, die u hebt gemaakt aan raster, noordpĳl, schaalbalk,
label Copyright en bereiken van lay-out, worden opgeslagen in het projectbestand en worden teruggezet als u het
project een volgende keer opent.

11.1.6 Gereedschappen voor annotatie

Annotaties zĳn een ander type elementen die kunnen worden toegevoegd aan het kaartvenster voor het verschaffen
van aanvullende informatie die niet kan worden weergegeven door de gerenderde lagen. Anders dan labels die
vertrouwen op waarden van attributen die zĳn opgeslagen in vectorlagen, zĳn annotaties onafhankelĳke, opgeslagen
in het projectbestand zelf.
Twee soorten annotaties zĳn beschikbaar in QGIS:

• Object-annotaties: zĳ zĳn in feite geoverwezen objecten van het type tekst, markering, lĳn of polygoon,
opgeslagen in een speciaal type laag, genaamd “annotatielaag”. Zĳ zĳn verbonden met een bepaalde
geografische locatie, wat betekent dat bĳ het verplaatsen van uw kaart, wĳzigen van de schaal of wĳzigen
van de projectie er niet voor zal zorgen dat de annotaties over uw kaart springen. In plaats daarvan zĳn zĳ op
hun plaats vergrendeld op de locatie waar u ze hebt getekend.

• Ballon-annotaties: dit zĳn annotaties van een individu van het type tekst, formulier of afbeelding, geplaatst
in een tekstballon. Zĳ kunnen worden geassocieerd met elke laag voor hun zichtbaarheid, en worden bovenop
het kaartvenster getekend. De grootte is afhankelĳk van de schaal van het kaartvenster, en de positie ervan kan
worden verankerd.

Tip: De kaart opmaken met annotaties
U kunt annotaties met uw kaart afdrukken of exporteren naar verschillende indelingen met:

• gereedschappen voor het exporteren van het kaartvenster, beschikbaar in het menu Project

• afdruklay-out, in welk geval u dient te selecteren Kaartvenster objecten tekenen in de overeenkomende
eigenschappen van items

De Werkbalk Annotaties verschaft een set gereedschappen voor het maken van en interacteren met beide soorten
annotaties.
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Tabel 11.3: De acties van de werkbalk Annotaties
Gereedschap Gebruik Bereik

Nieuwe annotatielaag
Een nieuwe laag maken om annotaties op te slaan Object-

annotaties
Eigenschappen hoofd-annotatielaagInstellingen beheren van de hoofd-annotatielaag

Annotaties aanpassen
Selecteren, verplaatsen, grootte wĳzigen en aanpassen van eigenschappen
voor symbologie van annotaties

Polygoon-annotatie maken
Maak een annotatie als een object polygoon

Lĳn-annotatie maken
Maak een annotatie als een object lĳn

Markering-annotatie maken
Maak een annotatie als een object punt

Tekst-annotatie maken op een punt
Maak een annotatie als een tekstlabel

Tekstannotatie Selecteren en maken van een annotatie met indeling tekst Ballon-
annotatiesHTML-annotatie Selecteren en maken van een annotatie met de inhoud van een HTML-bestand

SVG-annotatie Selecteren en maken van een annotatie die een SVG-bestand weergeeft
Formulier-annotatie Selecteren en maken van een annotatie die attributen van een vectorlaag

weergeeft in een aangepast formulierbestand

Annotatie verplaatsen
Aanpassen van grootte en positie van een element Annotatie

Object-annotaties

Object-annotaties worden opgeslagen in annotatielagen. Anders dan conventionele lagen is een annotatielaag alleen
beschikbaar in het huidige project en kan objecten van verschillende types (tekst, markering, lĳn, polygoon) bevatten.
De laag heeft geen attributen en geen symbologie geassocieerd, maar in plaats daarvan kan elk object worden
gesymboliseerd op een item-per-item basis, via het paneel Laag opmaken.
Twee soorten annotatielagen zĳn beschikbaar in QGIS:

• Een algemene Annotatielaag: u kunt er een maken met het gereedschap Nieuwe annotatielaag. Het is vermeld in
het paneel Lagen, wat het voor u mogelĳk maakt de zichtbaarheid van het object te beheren, het te verplaatsen
naar boven of onder bepaalde lagen in uw kaart, net als elke gewone laag. Dubbelklik op de laag en u heeft
toegang tot zĳn eigenschappen.

• De Hoofd-annotatielaag: Standaard is dit waar annotaties worden opgeslagen als er geen annotatielaag
beschikbaar is in het project of is geselecteerd op het tĳdstip van maken. Deze laag wordt altĳd helemaal
bovenaan uw kaart getekend en u zult hem niet zien vermeld in het paneel Lagen naast de andere lagen in uw
project, wat betekent dat zĳn objecten altĳd zichtbaar zĳn. Het item Eigenschappen hoofd-annotatielaag op de
werkbalk Annotaties helpt u zĳn dialoogvenster Eigenschappen te openen.
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Interactie

De object-annotaties hebben aangewezen gereedschappen voor het maken, afhankelĳk van hun type:

• Polygoon-annotatie maken

• Lĳn-annotatie maken

• Markering-annotatie maken

• Tekst-annotatie maken op een punt

Alle gebruikelĳke sneltoetsen voor QGIS voor het maken van objecten zĳn van toepassing bĳ het maken van
items Annotatie. Een annotatie lĳn of polygoon wordt getekend door met links te klikken voor elk punt, met een
laatste muisklik met rechts om de vorm te voltooien. Snappen kan worden ingeschakeld terwĳl u tekent, u kunt de
gereedschappen voor Geavanceerd digitaliseren gebruiken om punten precies te plaatsen, en zelfs de gereedschappen
voor tekenen schakelen naar de modus Stromen voor volledige vrĳe-hand vormen.
Anders dan gewone lagen hoeft een annotatielaag niet actief te zĳn voordat u zĳn objecten selecteert. Pak

eenvoudigweg het gereedschap Annotaties aanpassen en u zult in staat zĳn te interacteren met elke annotatie van een
object:

• Selectie: klik eenvoudigweg met links op de annotatie
• Verplaatsen: Klik met links op een geselecteerd item Annotatie om te beginnen met het verplaatsen ervan.
Een klik met rechts of drukken op de Esc-toets annuleert het verplaatsen, terwĳl een tweede klik met links
het verplaatsen zal bevestigen. De verplaatsing kan ook worden beheerd met de cursortoetsen:

– Shift+ voor grote verplaatsing
– Alt+key voor verplaatsing met 1 px

• Geometrie aanpassen: voor lĳn- of polygoon-annotatie, klik met links op een punt van de geometrie, verplaats
en klik opnieuw. Dubbelklik op een segment om een nieuw punt toe te voegen.

• Verwĳderen: Drukken op de toetsen Del of Backspace terwĳl een annotatie is geselecteerd zal die
annotatie verwĳderen

• Symbologie object wĳzigen

Symbologie object

Een geselecteerde annotatie zal zĳn eigenschappen voor Symbologie weergeven in het paneel Laag opmaken. U kunt:
• het uiterlĳk aanpassen door gebruikt te maken van de volledige mogelĳkheden voor het symbool of de

tekstindeling (inclusief de tekst zelf), afhankelĳk van het type.
• een Verwĳzingsschaal configureren
• een Z-index instellen
• enkele instellingen van het renderen van de laag aanpassen
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Laageigenschappen

Het dialoogvenster Eigenschappen van een annotatielaag verschaft de volgende tabs:
• Informatie een alleen-lezen dialoogvenster dat een interessante plek is om snel wat overzichtsinformatie en
metadata voor de huidige laag op te pakken.

• Bron: definieert algemene instellingen voor de annotatielaag. U kunt:
– Een Laagnaam instellen die zal worden gebruikt om de laag in het project te identificeren (in het Paneel

Lagen, met expressies, …)
– Het toegewezen Coördinaten ReferentieSysteem (CRS) van de laag weergeven: u kunt het CRS van de laag
wĳzigen door een recent gebruikte te kiezen uit de keuzelĳst of te klikken op de knop CRS selecteren
(bekĳk Keuze Coördinaten ReferentieSysteem). Gebruik dit proces alleen als het op de laag toegepaste
CRS verkeerd is of als er geen werd gespecificeerd.

• Renderen:
– U kunt de schaal Maximum (inclusief) en Minimum (exclusief) instellen, wat een bereik van schalen
definieert waarin de objecten zichtbaar zullen zĳn. Buiten dit bereik is hĳ verborgen. De knop
Op huidige schaal kaartvenster instellen helpt u de schaal van het huidige kaartvenster te gebruiken als grens voor
de zichtbaarheid van het bereik. Bekĳk Schaal zichtbaarheid selecteren voor meer informatie.

– Opaciteit: U kunt met dit gereedschap de onderliggende laag zichtbaar maken in het kaartvenster. Gebruik
de schuifbalk om de transparantie van de geselecteerde vectorlaag aan te passen naar uw behoeften. U
kunt ook een precieze definitie voor het percentage voor de transparantie invullen in het menu naast de
schuifbalk.

– Meng-modus op het niveau Laag toepassen: U kunt met deze gereedschappen speciale effecten op de kaart
toepassen, die eerder alleen bekend waren van grafische programma’s. De pixels van de overliggende en
onderliggende lagen worden vermengd volgens de instellingen zoals beschreven in Meng-modi.

– Toepassen van tekeneffecten op alle objecten van de laag met de knop Tekeneffecten.
Enkele van deze opties zĳn toegankelĳk vanuit de eigenschappen Symbologie van de object annotatie.

Ballon-annotaties

U kunt ballon annotaties toevoegen via het menu Bewerken►Annotatie toevoegen►of vanaf dewerkbalk Annotaties:

• Tekst-annotatie voor aangepaste opgemaakte tekst

• HTML-annotatie om de inhoud van een bestand html te plaatsen

• SVG-annotatie om een symbool SVG toe te voegen

• Formulier-annotatie: nuttig om attributen van een vectorlaag weer te geven in een aangepast bestand ui (zie Fig.
11.13). Dit is soortgelĳk aan de aangepaste formulieren attributen, maar weergegeven in een item Annotatie.
Bekĳk ook deze video https://www.youtube.com/watch?v=0pDBuSbQ02o&feature=youtu.be&t=2m25s van
Tim Sutton voor meer informatie.

• Annotatie verplaatsen om de grootte of positie van het element Annotatie aan te passen (met klikken en slepen)
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Fig. 11.13: Voorbeelden van ballon-annotaties

Selecteer, om een ballon-annotatie toe te voegen, het overeenkomende gereedschap en klik in het kaartvenster.
Een lege ballon wordt toegevoegd. Dubbelklik er op en een dialoogvenster met verschillende opties opent. Dit
dialoogvenster is nagenoeg hetzelfde voor alle typen annotatie:

• Bovenin een bestandsselectie om te vullen met het pad naar een bestand html, svg of ui, afhankelĳk van het
type annotatie. Voor tekst-annotatie kunt u uw bericht in een tekstvak invoeren en het renderen ervan instellen
met de normale gereedschappen voor lettertypen.

• Vaste positie op kaart: indien niet geselecteerd wordt de ballon geplaatst op een positie in het scherm
(in plaats van op de kaart), wat betekent dat het altĳd zal worden weergegeven, ongeacht het bereik van het
kaartvenster.

• Gekoppelde laag: associeert de annotatie met een laag op de kaart en zal zĳ alleen zichtbaar zĳn als die laag
zichtbaar is.

• Kaartmarkering: met symbolen van QGIS, stelt het weer te geven symbool in op de ankerpositie van de ballon
(alleen weergegeven als Vaste positie op de kaart is geselecteerd).

• Randstĳl: stelt de achtergrondkleur voor het frame, transparantie, lĳnkleur of breedte van de ballon in met
symbolen van QGIS.

• Marges voor de inhoud: stelt de interne marges voor het frame van de annotatie in.
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Fig. 11.14: Een dialoogvenster tekst ballon-annotatie

Annotaties kunnen worden geselecteerd als een gereedschap voor annotaties is ingeschakeld. Zĳ kunnen dan worden
verplaatst van de positie op de kaart (door te slepen aan de kaartmarkering) of door alleen de ballon te verplaatsen.
Het gereedschap Annotatie verplaatsen stelt u ook in staat de ballon in het kaartvenster te verplaatsen.
Een annotatie verwĳderen: selecteer het en ofwel druk op de toets Del of Backspace, of dubbelklik er op en druk
op de knop Verwĳderen in het dialoogvenster Eigenschappen.

Notitie: Als u drukt op Ctrl+T terwĳl een gereedschap ballon Annotatie actief is (Annotatie verplaatsen, Tekst-
annotatie, Formulier-annotatie), dan wisselt het item van zichtbaar naar onzichtbaar en andersom.
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11.1.7 Meten

Algemene informatie

QGIS heeft vier manieren voor het meten van geometrieën:

• interactieve meetgereedschappen

• meten in de Veldberekening

• afgeleide metingen in het gereedschap Objecten identificeren
• het vector analysegereedschap: Vector ► Geometrie-gereedschappen ► Attributen voor geometrie toevoegen

Meten werkt binnen geprojecteerde coördinatensystemen (bĳv. UTM) en niet geprojecteerde gegevens. De eerste
drie gereedschappen voor meten gedragen zich gelĳk aan de globale projectinstellingen:

• Anders dan in demeest toepassingen voor GIS is ellipsoïde de standaard voor metrischmeten, met de ellipsoïde
die is gedefinieerd in Project ► Eigenschappen… ► Algemeen. Dat is zo, zowel wanneer geografische als
geprojecteerde coördinatensystemen zĳn gedefinieerd voor het project.

• Indien u het geprojecteerde/planimetrische gebied of afstand wilt berekenen met behulp van Cartesiaanse
rekenkunde, dient de ellipsoïde voor het meten te zĳn ingesteld op “None/Planimetric” (Project ►
Eigenschappen… ► Algemeen). Echter, met een geografisch (d.i. niet geprojecteerd) CRS, gedefinieerd voor
de gegevens en het project, zullen metingen van het gebied en afstand ellipsoïde zĳn.

Echter, noch het gereedschap Objecten identificeren noch Veldberekening zullen uw gegevens, vóór het meten,
transformeren naar het CRS van het project. Indien u dit wilt bereiken dient u het vector analysegereedschap te
gebruiken:Vector►Geometrie-gereedschappen►Attributen voor geometrie toevoegen…. Hier zĳnmetingen standaard
planimetrisch, tenzĳ u voor ellipsoïde meten kiest.

Meet interactief lijnen, gebieden, richting en hoeken

Klik op het pictogram op de werkbalk Attributen om het meten te beginnen. Het pĳltje naar beneden nabĳ het
pictogram schakelt tussen lĳn, gebied, richting of hoek. De in het dialoogvenster standaard gebruikte
eenheid is die welke is ingesteld in het menu Project ► Eigenschappen… ► Algemeen.

Demetingen Lĳnmeten enGebiedmeten kunnenworden uitgevoerd als Cartesiaans of Ellipsoïdischmetingen.

Notitie: Meetgereedschap configureren
Bĳ het meten van lengte of gebied opent klikken op de knop Configuratie aan de onderzĳde van het widget het menu
Extra ► Opties ► Kaartgereedschap, waar u de kleur van het elastiek, de precisie van de metingen en het gedrag van
de eenheid kunt selecteren. U kunt ook de door u bĳ voorkeur gewenste maat- of hoekeenheden kiezen, maar onthoud
dat deze waarden in het huidige project worden overschreven door de selectie die wordt gemaakt in het menu Project
► Eigenschappen… ► Algemeen en de selectie die wordt gemaakt in het widget Meten.

Alle modules voor meten gebruiken de instellingen voor snappen uit de module Digitaliseren (zie gedeelte Tolerantie
voor snappen en zoekradius instellen). Dus, als u nauwkeurig langs een object lĳn wilt meten of rondom een
object polygoon, zet dan eerst voor een laag de tolerantie voor het snappen in. Nu zal bĳ het gebruiken van het
meetgereedschap bĳ elke muisklik (wanneer deze zich binnen ingestelde tolerantie bevindt) naar die laag worden
gesnapt.

Lĳn meten meet afstanden tussen twee opgegeven punten. Het gereedschap stelt u dan in staat punten op de kaart
aan te klikken. Elke lengte van een segment, als ook het totaal, wordt weergegeven in het venster Meten. Klik, om te
stoppen met meten, met de rechtermuisknop. Nu is het mogelĳk al uw lĳnmetingen in één keer te kopiëren naar het
klembord met de knop Alles kopiëren.
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Onthoud dat u de keuzelĳst nabĳ het totaal kunt gebruiken om interactief de maateenheden te wĳzigen tĳdens
het werken met het gereedschap Meten (‘Meters’, ‘Kilometers’, ‘Voet’, ‘Yards’, ‘Mĳlen’, ‘Zeemĳlen’, ‘Centimeters’,
‘Millimeters’, ‘Graden’, ‘Kaarteenheden’). Deze eenheid wordt voor de widget behouden totdat een nieuw project
wordt gemaakt of een ander project wordt geopend.
Het gedeelte Info in het dialoogvenster verklaart hoe berekeningen worden gemaakt, overeenkomstig de beschikbare
instellingen van het CRS.

Fig. 11.15: Afstanden meten

Gebied meten: Gebieden kunnen ook worden gemeten. In het venster Meten verschĳnt de geaccumuleerde grootte
van het gebied. Klik met rechts om te stoppen met meten. Het gedeelte Info is ook beschikbaar, evenals de
mogelĳkheid om te schakelen tussen de verschillende eenheden voor gebieden (‘Vierkante meters’, ‘Vierkante
kilometers’, ‘Vierkante voet’, ‘Vierkante yards’, ‘Vierkante mĳlen’, ‘Hectaren’, ‘Acres’, ‘Vierkante centimeters’,
‘Vierkante millimeters’, ‘Vierkante zeemĳlen’, ‘Vierkante graden’, ‘Kaarteenheden’).

Fig. 11.16: Gebied meten

Richting meten: U kunt ook richtingen opmeten. Demuisaanwĳzer verandert in een kruis. Klik om het eerste segment
te tekenen van de richting die u wilt opmeten, verplaats dan de cursor om het tweede punt te tekenen. De meting wordt
getoond in een pop-up dialoogvenster.
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Fig. 11.17: Richting meten

Hoek meten: U kunt ook hoeken opmeten. De muisaanwĳzer verandert in een kruis. Klik om het eerste segment te
tekenen van de hoek die u wilt opmeten, verplaats dan de cursor om de gewenste hoek te tekenen. De meting wordt
getoond in een pop-up dialoogvenster.

Fig. 11.18: Hoek meten

11.1.8 Aanvullende kaartweergaven instellen

Het is ook mogelĳk aanvullende kaartweergaven te openen waarvan de inhoud zou kunnen afwĳken van de huidige
staat van het paneel Lagen. Ga, om een nieuwe kaartweergave toe te voegen, naar Beeld► Nieuwe kaartweergave.
Een nieuw zwevend widget, dat de rendering van de hoofdkaartweergave nabootst, wordt toegevoegd aan QGIS. U
mag net zoveel kaartweergaven toevoegen als u nodig hebt. Zĳ kunnen zwevendworden gehouden, naast elkaar worden
geplaatst of op elkaar worden gestapeld.
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Fig. 11.19: Meerdere kaartweergaven met verschillende instellingen

Boven het kaartvenster van een aanvullende kaartweergave staat een werkbalk met de volgende mogelĳkheden:

• Volledig zoomen, Zoomen naar selectie en Zoomen naar la(a)g(en) om binnen de weergave te navigeren
• Thema voor weergave instellen om het kaartthema te selecteren dat moet worden weergegeven in de kaartweergave.
Indien ingesteld op (geen), zal de weergave de wĳzigingen in het paneel Lagen volgen.

• Instellingen voor weergave om de kaartweergave te configureren:

– Midden van weergave synchroniseren met hoofdkaart: synchroniseert het midden van de
kaartweergaven zonder de schaal aan te passen. Dit maakt het voor u mogelĳk een stĳl overzichtskaart
of vergrote kaart te hebben die het midden van het hoofdvenster volgt.

– Weergave naar selectie synchroniseren: hetzelfde als Zoom naar selectie
– Schaal

– Rotatie

– Vergroting

– Schaal synchroniserenmet de schaal van de hoofdkaart. Een Schaalfactor kan dan worden toegepast,
wat u in staat stelt een weergave te hebben die bĳv. altĳd 2x de schaal van het hoofdvenster heeft.

– Annotaties weergeven

– Positie van cursor weergeven

– Bereik van hoofdkaart weergeven

– Labels weergeven: maakt het mogelĳk labels te verbergen, ongeacht of zĳ zĳn ingesteld in de
eigenschappen van de weergegeven laag

– CRS voor kaart wĳzigen…

– Weergave hernoemen…
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11.1.9 De kaartweergave exporteren

Kaarten die u maakt kunnen worden opgemaakt en geëxporteerd naar verscheidene indelingen met de geavanceerde
mogelĳkheden van de afdruklay-out of rapport. Het is ook mogelĳk om de huidige rendering direct te exporteren,
zonder een lay-out. Deze snelle “schermafdruk” van de kaartweergave heeft enkele handige mogelĳkheden.
Het kaartvenster met de huidige rendering exporteren:

1. Ga naar Project ► Importeren/Exporteren

2. Selecteer, afhankelĳk van uw indeling voor uitvoer, ofwel

• Kaart als afbeelding exporteren…

• of Kaart als PDF exporteren…

De twee gereedschappen verschaffen u een aantal algemene opties. In het dialoogvenster dat opent:

Fig. 11.20: Dialoogvenster Kaart als afbeelding opslaan

1. Kies het Bereik om te exporteren: het mag het huidige bereik van de weergave zĳn (de standaard), het bereik
van een laag of een aangepast bereik dat in het kaartvenster wordt getekend. Coördinaten van het geselecteerde
gebied worden weergegeven en zĳn handmatig te bewerken.

2. Voer de Schaal van de kaart in of selecteer het uit de vooraf gedefinieerde schalen: wĳzigen van de schaal zal
het te exporteren bereik aanpassen (vanuit het midden).

3. Stel de Resolutie voor de uitvoer in
4. Controleer de Breedte uitvoer enHoogte uitvoer in pixels voor de afbeelding: standaard gebaseerd op de huidige

resolutie en bereik, zĳ kunnen worden aangepast en zullen het kaartbereik aanpassen (vanuit het midden). De
verhoudingen voor de grootte kunnen worden vergrendeld, wat in het bĳzonder handig kan zĳn bĳ het tekenen
van het bereik in het kaartvenster.

5. Actieve decoraties tekenen: in gebruik zĳnde decoraties (schaalbalk, titel, raster, noordpĳl…) worden
geëxporteerd met de kaart

6. Annotaties tekenen om eventuele annotaties te exporteren
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7. Voeg georeferentie informatie toe (ingebed of via world file): afhankelĳk van de indeling voor de uitvoer
zal een world file met dezelfde naam (met de extensie PNGW voor afbeeldingen PNG, JPGW voor afbeeldingen
JPG, …) worden opgeslagen in dezelfde map als uw afbeelding. De indeling PDF bedt de informatie in het
bestand PDF in.

8. Bĳ het exporteren naar PDF zullen meer opties beschikbaar zĳn in het dialoogvensterKaart als PDF opslaan…:

Fig. 11.21: Dialoogvenster Kaart als PDF opslaan

• RDF-metadata exporteren van het document, zoals de titel, auteur, datum, beschrĳving…

• Georuimtelĳke PDF maken (GeoPDF): Maak een PDF-bestand met geoverwĳzingen. U kunt:
– De GeoPDF Indeling kiezen

– informatie over vectorobject opnemen in het bestand GeoPDF: zal alle informatie over geometrie
en attributen uit zichtbare objecten in de kaart opnemen in het uitvoerbestand GeoPDF.

Notitie: Een bestand GeoPDF kan ook worden gebruikt als een databron. Voor meer over ondersteuning
voor GeoPDF in QGIS, bekĳk https://north-road.com/2019/09/03/qgis-3-10-loves-geopdf/.

• Kaart rasteriseren

• Geometrieën vereenvoudigen om de bestandsgrootte te verkleinen: Geometrieën zullen worden
vereenvoudigd bĳ het exporteren van de kaart door punten te verwĳderen die niet opmerkelĳk verschillen
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in de resolutie voor exporteren (bĳv. als de resolutie voor exporteren 300 dpi is, zullen punten die
minder dan 1/600 inch apart liggen worden verwĳderd). Dit kan de grootte en complexiteit van het
exportbestand verkleinen (hele grote bestanden zouden kunnen weigeren te laden in andere toepassingen).

• Tekst exporteren instellen: beheert of tekstlabels worden geëxporteerd als echte tekstobjecten (Tekst
altĳd als tekstobjecten exporteren) of alleen als paden (Tekst altĳd als paden exporteren). Als zĳ worden
geëxporteerd als tekstobjecten, dan kunnen zĳworden bewerkt in externe toepassingen (bĳv. Inkscape) als
normale tekst. MAAR het bĳeffect is dat de kwaliteit van het renderen verminderd, EN er zĳn problemen
met renderen als er bepaalde instellingen voor de tekst, zoals buffers, van kracht zĳn. Dat is de reden
waarom exporteren als paden wordt aanbevolen.

9. Klik op Save om de locatie, naam en indeling voor het bestand te selecteren.
Bĳ het exporteren als afbeelding is het ook mogelĳk om het verwachte resultaat van de bovenstaande
instellingen te Kopiëren naar klembord en de kaart te plakken in een andere toepassing, zoals LibreOffice,
GIMP…

11.2 3D-kaartweergave

Ondersteuning voor 3D-visualisatie wordt aangeboden door de 3D-kaartweergave. U kunt 3D-kaartweergavenmaken,
beheren en openen via het menu Beeld ► 3D-kaartweergeven ►:

1. Door te klikken op Nieuwe 3D-kaartweergave kunt u een nieuwe 3D-kaartweergave maken. Een zwevend
en vast te zetten paneel voor QGIS zal verschĳnen (bekĳk Het dialoogvenster 3D-kaartweergave). Het heeft
hetzelfde bereik als het 2D-hoofdkaartvenster en verschaft een verzameling gereedschappen voor navigatie om
de weergave naar 3D te schakelen.

2. Door te klikken op 3D-kaartweergaven beheren komt u in 3D-kaartweergaven beheren. Hier heeft u de
mogelĳkheid om 3D-kaartweergave te openen, te dupliceren, te verwĳderen en te hernoemen.

3. Als u een of meer 3D-kaartweergaven hebt gemaakt, ziet u ze vermeld in 3D-kaartweergaven. U kunt ze in-
en uitschakelen door erop te klikken. Ze zullen worden opgeslagen bĳ het opslaan van het project, zelfs als ze
uitgeschakeld zĳn.

154 Hoofdstuk 11. Kaarten visualiseren



QGIS Desktop 3.28 User Guide

Fig. 11.22: Het dialoogvenster 3D-kaartweergave

De volgende gereedschappen worden verschaft aan de bovenzĳde van het paneel voor de 3D-kaartweergave:

• Camerabeheer: verplaatst de weergave, dezelfde hoek en richting van de camera behoudend

• Volledig zoomen: past de weergave aan naar het volledige bereik van de laag

• Navigeren op scherm aan-/uitzetten: toont/verbergt de widget voor navigatie (dat is bedoeld om het beheer van de
kaartweergave te vergemakkelĳken)

• Objecten identificeren: geeft informatie over het punt in het terrein of het/de 3D-object(en) waarop geklikt is –
Meer details bĳ Objecten identificeren

• Maatlĳn: meet de horizontale afstand tussen punten

• Animaties: toont/verbergt de widget speler voor animaties

• Als afbeelding opslaan…: exporteert de huidige weergave naar de indeling voor een afbeeldingbestand

• 3D-scene exporteren…: exporteert de huidige weergave als een 3D-scene (bestand .obj), wat het mogelĳk
maakt het na te bewerken in toepassingen zoals Blender… De objecten van terrein en vector worden
geëxporteerd als 3D-objecten. De instellingen voor exporteren overschrĳven de eigenschappen van de laag
of configuratie van de kaartweergave, inclusief:

– Naam scene en doel-map

– Resolutie terrein

– Resolutie textuur terrein
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– Schaal model

– Afgevlakte randen

– Normalen exporteren

– Texturen exporteren

• Thema voor weergave instellen: Stelt u in staat de set lagen, die moet worden weergegeven in de kaartweergave, te
selecteren uit vooraf gedefinieerde kaartthema’s.

• Het menu Opties verschaft sneltoetsen om:
– Voeg visuele effecten toe aan het renderen van 3D, zoals het weergeven van schaduw, eye dome lighting
of ingesloten omgeving weergeven

– Synchroniseren van de weergaven (2D-kaartweergave volgt 3D-camera en/of 3D-camera volgt 2D-
kaartweergave )

– Zichtbare cameragebied weergeven in 2D-kaartweergave

– Configureren van de instellingen van de 3D-kaartweergave

• 3D-kaartweergave vastzetten: schakelen tussen los widget en venster op bovenste niveau

11.2.1 Scenes configureren

De 3D-kaartweergave opent met enkele standaard instellingen die u kunt aanpassen. Klik, om dat te doen, vergroot
het menu Opties aan de bovenzĳde van het 3D-paneel van het kaartvenster en druk op de knop Configureren… om
het venster 3D configuratie te openen.

Fig. 11.23: Dialoogvenster 3D-configuratie

In het venster 3D-configuratie staan verscheidene opties om de 3D-scene fĳn af te stemmen:
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Terrein

• Terrein: Voordat we in de details duiken, is het goed om te weten dat het terrein in een 3D-weergave wordt
weergegeven door een hiërarchie van tegels van het terrein en als de camera zich dichter naar het terrein
verplaatst worden bestaande tegels, die niet voldoende details hebben, vervangen door kleinere tegels meet
meer details. Elke tegel heeft een geometrie van mazen, die zĳn afgeleid van de laag met het hoogteraster en
textuur uit 2D-lagen.

– De hoogte van het terrein Type kan zĳn:
∗ een Vlak terrein

∗ een geladen DEM (rasterlaag)

∗ een Online-service, laden van hoogtetegels geproduceerd door Mapzen tools – meer details op https:
//registry.opendata.aws/terrain-tiles/

∗ een geladen gegevensset Laag met mazen

– Hoogte: Rasterlaag of laag met mazen die moet worden gebruikt voor het maken van het terrein. De
rasterlaag moet een band bevatten die de hoogte weergeeft. Voor een laag met mazen worden de waarden
Z van punten gebruikt.

– Verticale schaal: Schaalfactor voor de verticale as. Verhogen van de schaal zal de hoogte van landvormen
overdrĳven.

– Resolutie tegel: Hoeveel monsters uit de rasterlaag voor het terrein te gebruiken voor elke tegel. Een waarde
van 16px betekent dat de geometrie van elke tegel zal bestaan uit 16x16 hoogtemonsters. Hogere getallen
maken meer gedetailleerde tegels voor het terrein, ten koste van verhoogde complexiteit bĳ het renderen.

– Hoogte ring: Soms kunnen kleine scheurtjes zichtbaar zĳn tussen tegels van het terrein. Verhogen van
deze waarde zal verticale muren (“skirts”) toevoegen rondom tegels van het terrein om de scheurtjes te
verbergen.

– Verschuiving: Verplaatst het terrein naar boven of naar beneden, bĳv. om de hoogte aan te passen, rekening
houdende met het grondniveau of andere objecten in de scene.
Dit kan nuttig zĳn als er verschillen bestaan tussen de hoogte van het terrein en de hoogte van de lagen
in uw scene (bĳv. puntwolken die alleen een verticale hoogte gebruiken). In dit geval kan het handmatig
aanpassen van de terreinhoogte om samen te vallen met de hoogte van objecten in uw scene de ervaring
voor navigatie verbeteren.

• Wanneer een laag met mazen wordt gebruikt als terrein, kunt u de Instellingen driehoeken (weergave
draadmodel, afgevlakte driehoeken, niveau van detail) en de Instellingen voor renderen van kleuren (als
uniforme kleur of op kleurverloop gebaseerd) configureren. Meer details in het gedeelte 3D-eigenschappen
laag met mazen.

• Terreinschaduw: Stelt u in staat te kiezen hoe het terrein zou moeten worden gerenderd:
– Schaduw uitgeschakeld - kleur voor het terrein wordt alleen bepaald vanuit de textuur van de kaart
– Schaduw ingeschakeld - kleur voor het terrein wordt bepaaldmet het Phong’s shading-model, dat rekening
houdt met de textuur van de kaart, de normale vector van het terrein, licht(en) voor de scene en kleuren
Omringen en Spiegelen en Glanzen van het materiaal van het terrein

11.2. 3D-kaartweergave 157

http://s3.amazonaws.com/elevation-tiles-prod/
https://registry.opendata.aws/terrain-tiles/
https://registry.opendata.aws/terrain-tiles/


QGIS Desktop 3.28 User Guide

Lichten

Op de tab Lichten, druk op het menu om toe te voegen
• tot maximaal acht Puntlichten: schĳnt licht in alle richtingen, zoals een bol licht dat een gebied vult. Objecten
dichter bĳ het licht zullen helderder zĳn, en objecten verder weg zullen donkerder zĳn. Een puntlicht heeft een
ingestelde positie (X, Y en Z), een Kleur, een Intensiteit en een Demping

• maximaal vier Richtingslichten: bootst de verlichting na die u zou krĳgen van een reusachtige zaklamp, heel
ver weg van uw objecten, altĳd gecentreerd en dat nooit dooft (bĳv. de zon). Het straalt parallelle lichtstralen
in één enkele richting maar het licht reikt tot in oneindigheid. Een richtingslicht kan worden geroteerd met een
opgegeven Azimut, een Hoogte hebben, een Kleur en een Intensiteit.

Fig. 11.24: Dialoogvenster 3D Lichten configureren

Schaduw

Selecteer Schaduwen weergeven om schaduwen binnen uw scene weer te geven, gegeven:
• een Richtingslicht

• een Maximum afstand schaduw renderen: om renderen van schaduw op objecten te veraf te vermĳden, in het
bĳzonder als de camera langs de horizon kĳkt

• een Schuine schaduw: om effecten van zelf-schaduw te vermĳden dat sommige gebieden donkerder zou kunnen
maken dan andere, vanwege verschillen tussen grootten van kaarten. Hoe lager hoe beter

• een Kaartresolutie schaduw: om schaduwen er scherper uit te laten zien. Het zou kunnen resulteren in mindere
uitvoering als de parameter voor de resolutie te hoog is.
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Camera & skybox

Op deze tab kunt u verschillende parameters beheren, zoals camera, 3D-as, synchronisatie van navigatie en skybox.

Fig. 11.25: Het dialoogvenster 3D camera configuratie

• De groep parameters van Camera overschrĳft enkele standaard camera-instellingen, gemaakt in het
dialoogvenster Extra ► Opties ► 3D.

• Selecteer 3D-as weergeven om het gereedschap voor de 3D-as in te schakelen. Deze groep parameters
smaakt het mogelĳk het type as en de positie ervan in te stellen.

– Met het type Coördinaten ReferentieSysteem zal een loodrechte as worden weergegeven.
– Met het type Kubus zal een 3D-kubus worden weergegeven. De zĳden van de kubus kunnen worden
gebruikt om de cameraweergave te wĳzigen: klik bĳvoorbeeld op de noord-zĳde om de camera te laten
kĳken vanuit het noorrden.

Tip: Klik met rechts op de 3D-as om snel zĳn positie en type, en de cameraweergave in te stellen.

Fig. 11.26: Het contextmenu voor de 3D-as

• De groep parametersNavigatie synchroniseren voegt opties toe om de 2D-kaartweergave te synchroniseren met
de 3D camerapositie of 3D camerapositie met 2D-kaartweergave of bidirectionele synchronisatie. De laatste
optie geeft het zichtbare bereik van de 3D-camera weer op de 2D-kaartweergave.

• Selecteer Skybox weergeven om skybox-renderen in de scene in te schakelen. Het type skybox kan zĳn:
– Panoramische textuur, met een enkel bestand dat zicht verschaft op 360°
– Afzonderlĳke zĳden, met een textuurbestand voor elk van de zes zĳden van een box die de scene bevat

Afbeeldingsbestanden voor textuur mogen bestanden op schĳf zĳn, URL’s op afstand of ingebed in het project
(meer details).
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Geavanceerd

• Resolutie kaarttegel: Breedte en hoogte van de 2D kaartafbeeldingen worden gebruikt als texturen voor de tegels
van het terrein. 256px betekent dat elke tegel zal worden gerenderd naar een afbeelding van 256x256 pixels.
Hogere getallen maken meer gedetailleerde tegels voor het terrein, ten koste van een grotere complexiteit voor
het renderen.

• Max. scherm fout: Bepaalt de drempel voor het verwisselen van tegels voor het terrein door meer gedetailleerde
(en vice versa) - d.i. hoe snel de 3D-kaartweergave een hogere kwaliteit tegels gaat gebruiken. Lagere getallen
betekenen meer details in de scene, ten koste van een verhoogde complexiteit voor het renderen.

• Max. grond fout: De resolutie van de tegels voor het terrein waarop het opdelen van tegels in meer gedetailleerde
zal stoppen (splitsen ervan zal niet op enigerlei wĳze meer detail verschaffen). Deze waarde beperkt de diepte
van de hiërarchie van de tegels: lagere waarden maken de hiërarchie dieper, wat de complexiteit voor het
renderen verhoogt.

• Zoomniveaus: Geeft het aantal zoomniveaus weer (afhankelĳk van de resolutie van de kaarttegels en de max.
grond fout).

• Labels tonen: Schakelt labels voor de kaart in/uit

• Info kaarttegel tonen: Bevatten grenzen en tegelnummers voor de tegels van het terrein (nuttig voor het
oplossen van problemen met het terrein)

• Begrenzingsvakken tonen: Geeft 3D-begrenzingsvakken weer van de tegels van het terrein (nuttig voor het
oplossen van problemen met het terrein)

• Middelpunt camera weergeven

• Middelpunt rotatie camera weergeven

• Lichtbronnen weergeven: geeft een bol weer op de plek van origine van de lichtbronnen, wat het
gemakkelĳker maakt lichtbronnen opnieuw te positioneren of te plaatsen, relatief ten opzichte van de inhoud
van de scene

• Frames per seconde (FPS) weergeven

• Debug overleg weergeven: visuele overleg die enige nuttige informatie voor debuggen en profileren
weergeeft. Dit maakt het in het bĳzonder mogelĳk snel de weergave voor frame en scene te bekĳken.

• Eye Dome Lighting (EDL) weergeven: een effect voor nabewerking dat de perceptie van diepte vergroot.
De diepte van elke pixel (afstand vanaf de camera) wordt vergeleken met de diepte van zĳn buurpixels en
wordt geaccentueerd overeenkomstig het verschil in die diepte, wat de randen beter weergeeft. Beïnvloedt de
gehele scene en kan worden gecombineerd Schermruimte ingesloten omgeving. De volgende parameters kunnen
worden beheerd

– Lichtsterkte: vergroot het contrast, maakt een betere perceptie voor diepte mogelĳk
– Afstand licht: geeft de afstand weer tussen de gebruikte pixels vanaf de pixel van het middelpunt en heeft
het effect van het dikker maken van de randen.

• Schermruimte Ingesloten omgeving weergeven (SSAO): een effect voor nabewerking dat ook de perceptie
van diepte vergroot door het toepassen van een donkerder schaduw voor gebieden die minder zĳn blootgesteld
aan omgevingslicht. Beïnvloedt de gehele scene en kan worden gecombineerd met Eye dome Lighting. De
volgende parameters kunnen worden beheerd:

– Straal: hoe ver we willen reiken om de ingesloten omgeving te berekenen
– Intensiteit: hoe sterk het effect zou moeten zĳn (hogere waarden maken dingen donkerder)
– Drempel insluiting: hoeveel naburige punten moeten worden opgenomen om het effect te laten verschĳnen
(lagere waarden dan 50% zullen de uitvoer donkerder maken, maar mogelĳk een groter bereik aan
insluiting verschaffen)
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Fig. 11.27: Renderen van Puntenwolken in 3D-kaart met Eye Dome Lighting (EDL) en/of Schermruimte ingesloten
omgeving (SSAO)

Vanaf boven, links naar rechts: Geen effect – alleen SSAO – alleen EDL – SSAO en EDL

• Schaduwkaart debuggen: rendert de scene als een rood-zwarte afbeelding vanaf het punt van weergave
van het licht dat wordt gebruikt voor de schaduwen (voor probleemoplossing). De widget is ingesteld met een
proportionele Grootte voor de weergave van de 3D-kaart, en vastgezet in een Hoek.

• Dieptekaart debuggen: rendert de diepte kaart van de scene als een afbeelding waarin pixels dichtbĳ
donkerder zĳn (voor probleemoplossing). De widget is ingesteld met een proportionele Grootte voor de
weergave van de 3D-kaart, en vastgezet in een Hoek.

11.2.2 Navigatie-opties

Verkennen van de kaartweergave in 3D:
• Het terrein kantelen (draaien langs een horizontale as die door het midden van het venster gaat)

– Druk op de gereedschappen Naar boven en Naar beneden

– Druk op Shift en gebruik de toetsen omhoog/omlaag
– Sleep de muis voorwaarts/achterwaarts met de middelste muisknop ingedrukt
– Druk op Shift en sleep de muis voorwaarts/achterwaarts met de linkermuisknop ingedrukt

• Het terrein draaien (langs een verticale as die door het midden van het venster gaat)
– Draai het kompas van de widget Navigatie in de richting om naar te kĳken
– Druk op Shift en gebruik de toetsen links/rechts
– Sleep de muis naar rechts/links met de middelste muisknop ingedrukt
– Druk op Shift en sleep de muis naar rechts/links met de linkermuisknop ingedrukt
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• Wĳzigen van de positie van de camera (en het midden van de weergave), verplaatst rondom in een horizontale
richting

– Slepen met de muis met de linkermuisknop ingedrukt, en de knop Camerabeheer ingeschakeld
– Drukken op de richtingspĳlen van de widget Navigatie
– Gebruiken van de toetsen omhoog/omlaag/links/rechts om de camera respectievelĳk vooruit, achteruit,
rechts en links te verplaatsen

• Wĳzigen van de hoogte van de camera: druk op de toetsen Page Up/Page Down

• Wĳzigen van de oriëntatie van de camera (de camera blĳft op zĳn plaats maar het middelpunt van het zicht
verplaatst zich)

– Drukken op Ctrl en de pĳltoetsen gebruiken om de camera naar boven, beneden, links en rechts te
draaien

– Drukken op Ctrl en de muis slepen met de muisknop ingedrukt
• In- en uitzoomen

– Drukken op de corresponderende gereedschappen Inzoomen en Uitzoomen van de widget Navigatie
– Scrollen met het muiswiel (ingedrukt houden van Ctrl resulteert in fĳnere zoom)
– Slepen met de muis met de rechtermuisknop ingedrukt voor inzoomen (naar beneden slepen) en
uitzoomen (naar boven slepen)

Klik op de knop Volledig uitzoomen aan de bovenzĳde van het paneel van het 3D kaartvenster om de cameraweergave
te herstellen.

11.2.3 Een animatie maken

Een animatie is gebaseerd op een set sleutelframes - cameraposities op bepaalde tĳden. Een animatie maken:

1. Schakel het gereedschap Animaties in, wat de widget voor de speler van animaties zal weergeven

2. Klik op de knop Sleutelframe toevoegen en voer een Tĳd sleutelframe in seconden in. Het combinatievak
Sleutelframe geeft nu de ingestelde tĳd weer.

3. Verplaats, met de gereedschappen voor Navigatie, de camera naar de positie die moet worden gekoppeld aan
de tĳd voor het huidige sleutelframe.

4. Herhaal de vorige stappen om net zoveel sleutelframes toe te voegen (met tĳd en positie) als nodig.

5. Klik op de knop om een voorbeeld te zien van de animatie. QGIS zal scenes makenmet de cameraposities/-
rotaties van de ingestelde tĳden, en ze interpoleren tussen deze sleutelframes. Verscheidene modi voor
Interpolatie voor animaties zĳn beschikbaar (bĳv, lineair, inQuad, outQuad, inCirc… – meer details op
https://doc.qt.io/qt-5/qeasingcurve.html#EasingFunction-typedef).
De animatie kan ook worden bekeken door de schuifbalk voor tĳd te verplaatsen. Selecteren van het keuzevak
Lus zal de animatie herhaald afspelen, terwĳl het klikken op een uitgevoerde animatie stopt.

Klik op Animatieframes exporteren om een reeks afbeeldingen, die de scene weergeven, te maken. Naast de
bestandsnaam Sjabloon en de Map voor uitvoer, kunt u het aantal Frames per seconde, de Breedte uitvoer en Hoogte
uitvoer instellen.
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11.2.4 3D-vectorlagen

Een vectorlaag met waarden voor hoogten kan in 3D-kaartweergave worden weergegeven door 3D-renderer
inschakelen in het gedeelte 3D-weergave van de eigenschappen voor de vectorlaag. Een aantal opties zĳn beschikbaar
voor het beheren van het renderen van de 3D-vectorlaag.

11.3 Weergave Hoogteprofiel

Het paneel Hoogtepofiel is een gereedschap voor het plotten van zĳaanzichten, voor het visualiseren van
hoogtegegevens langs een lĳn. Het ondersteunt vector-, raster-, mazen- en puntenwolklagen. Gegevens mogen van
het type 2D of 3D zĳn.

Ga naar het menu Beeld► Hoogteprofiel om een weergave van het hoogteprofiel toe te voegen. U kunt net zoveel
weergaven voor het hoogteprofiel toevoegen als u wilt, en ze kunnen worden vastgezet, op elkaar worden gestapeld
of zweven.

Fig. 11.28: Dialoogvenster Hoogteprofiel, ingebed onder het kaartvenster
De afbeelding geeft een kustlijn met een stad achter een zeedijk weer. Gebruiken van een grotere tolerantie op de lijn van het

hoogteprofiel geeft meer punten van de puntenwolk weer.

11.3.1 De interface

Aan de bovenzĳde van het paneel Hoogteprofiel, geeft een werkbalk u toegang tot de volgende gereedschappen:

Tabel 11.4: Werkbalk Weergave Hoogteprofiel
Gereedschap Sneltoets Beschrijving

Toon legenda Toont of verbergt de legenda met kaartlagen waarmee men het tekenen van de
profielweergave kan beïnvloeden.

Vervolgt op volgende pagina
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Tabel 11.4 – Vervolgd van vorige pagina
Gereedschap Sneltoets Beschrijving

Opname vanuit lĳn Tekent interactief een lĳn in het kaartvenster om de profielboog weer te geven.

Opname vanuit lĳnobject
Selecteer een bestaand lĳnobject in het kaartvenster en maak een hoogteprofiel
vanuit die lĳn.

Naar links verschuiven Ctrl+Alt+,Stelt u in staat de vastgelegde lĳn langzaam in de kaart naar links te verplaatsen
(bĳv. om de optimale profiellĳn te vinden, gebaseerd op de hoogte).

Naar rechts verschuiven
Ctrl+Alt+.Stelt u in staat de vastgelegde lĳn langzaam in de kaart naar rechts te verplaatsen

(bĳv. om de optimale profiellĳn te vinden, gebaseerd op de hoogte).
Leegmaken Verwĳdert de profiellĳn en de inhoud van het plotgebied van de weergave

Hoogteprofiel
Objecten identificeren Identificeert objecten in het plotgebied via ofwel één enkele klik, of klik-

en-sleep rechthoek. Resultaten worden weergegeven in het standaard paneel
Identificatieresultaten.

Schuiven Spatie Klik en sleep om het plotgebied te verschuiven. Dit kan ook gedaan worden
met de middelste muisknop.

Zoomen X-as Zoomt in/uit langs de horizontale as, de verticale verhouding behoudend
In-/Uitzoomen Ctrl+SpatieKlik of klik-en-sleep een rechthoek over de plot om in te zoomen. Druk op

Alt en klik om in plaats daarvan uit te zoomen.
Volledig uitzoomen Zoomt in de weergave Hoogteprofiel naar het bereik van de vastgezette lĳn
Snappen inschakelen Maakt het mogelĳk te snappen aan de rand of een punt van de objecten in

de plot in de weergave Hoogteprofiel. Handig voor nauwkeurig ophalen van
coördinaten of inmeten van van afstanden.

Afstanden meten Meet horizontale en verticale afstanden
Als PDF exporteren Exporteert plots naar PDF (als hoge kwaliteit vectorobjecten)

Als afbeelding exporteren
Exporteert plots naar verschillende indelingen voor afbeeldingen

Opties Verschaft toegang tot instellingen voor het configureren van de lĳn van het
hoogteprofiel.

Weergave hoogteprofiel vastzetten
Schakelen tussen vastgezette en zwevende status van de weergave

In de linkeronderkant kan een kopie van het paneel Lagen worden weergegeven met de knop Toon legenda. Dit
is echter een onafhankelĳk widget, met zĳn eigen set zichtbare lagen, in een aangepaste volgorde. Het stelt u in staat
het tekenen van de lagen en hun gedrag te beheren van het plotgebied:

• Selecteer het vak naast de naam van de laag om in te stellen of die zoumoeten worden getekend in het plotgebied
• Sleep en zet lagen hoger of lager neer om de tekenvolgorde van de lagen aan te passen
• Stĳl van lagen in de hoogteprofiel weergave aanpassen: dubbelklik op een laag of klik met rechts en selecteer

Eigenschappen… om de tab voor eigenschappen van Hoogte te openen om te configureren. Een overzicht van
de instellingen voor de hoogte wordt als Helptip weergegeven als u met de muis over de laag gaat.

Rechts van de legenda is het plotgebied de belangrĳkste plaats waar u het voorbeeld van het hoogteprofiel van de
ingeschakelde lagen kunt zien. Het is gebaseerd op een graduele raster waarin de horizontale as de lengte van de
profiellĳn weergeeft en de verticale as de Z-hoogte van de gevonden objecten weergeeft. Het maakt het ook mogelĳk
een set interacties, zoals zoomen, schuiven, meten, identificeren van objecten, …, in te stellen met de gereedschappen
aan de bovenzĳde.
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11.3.2 Maken van een hoogteprofiel

U kunt, om een hoogteprofiel te maken:

1. Ga naar het menu Beeld ► Hoogteprofiel. Het paneel Hoogteprofiel opent.
2. Maak de profiellĳn waarlangs het terrein en de objecten moeten worden gerenderd. Selecteer een

tekengereedschap:

• Opname vanuit lĳn: klik met links op het hoofd kaartvenster om punten toe te voegen en klik met rechts
om een lĳn te voltooien die zal dienen als profiellĳn

• or Opname vanuit lĳnobject: klik op een object Lĳn in het kaartvenster om deze als de profiellĳn te
gebruiken. Als er meerdere objecten aanwezig zĳn op het punt waar u klikte, dan zal een popup-menu
verschĳnen dat u in staat stelt daaruit te kiezen.

Alle mogelĳkheden voor het digitaliseren van de lĳn, zoals de opties voor snappen, traceren, technieken voor
digitaliseren of het paneel Geavanceerd digitaliseren zĳn beschikbaar om te gebruiken.
Het plotvenster zou enkele objecten kunnen renderen.

3. De volgende stap is om de eigenschappen voor de hoogte van de lagen die u wilt visualiseren te configureren.

1. Druk op de knop Toon legenda om de legenda met kaartlagen weer te geven.
2. Schakel met de zichtbaarheid van de lagen waarin u bent geïnteresseerd. Dat zĳn de enige die worden

getekend in de weergave van het hoogteprofiel en geselecteerde lagen kunnen verschillen van die in het
paneel Lagen.

3. Dubbelklik op een laagnaam of klik met rechts en selecteer Eigenschappen. De tab Hoogte van de
eigenschappen van de laag opent. Dat is de plaats waar u configureert hoe elk object of terrein zal worden
getekend in de profielweergave. Beschikbare eigenschappen zĳn afhankelĳk van het type laag:
• Raster Eigenschappen hoogte

• Vector Eigenschappen hoogte

• Puntenwolk Eigenschappen hoogte

• Mazen Eigenschappen hoogte

De profielweergave begint met het tekenen van terrein of objecten van actieve lagen die de opgegeven
lĳn van het hoogteprofiel kruisen, zodra er eigenschappen voor hun hoogte zĳn geconfigureerd.

4. In het keuzemenu Opties kunt u de waarde voor Tolerantie instellen. Deze waarde wordt gebruikt om een
zone rondom de hoogteprofiellĳn te maken, zichtbaar in het hoofdkaartvenster. Elk zichtbaar object Punt dat
die buffer overlapt zal worden vastgelegd in het plotvenster.

11.3.3 Interactie met de profielweergaven

Als een lĳn voor een hoogteprofiel is gemaakt, zoomt het plotvenster naar het volledige bereik van het hoogteprofiel.
Op de X-as kunt u de lengte van het profiel zien en op de Y-as het hoogtebereik tussen minimum en maximum
vastgelegde hoogte, beide in kaarteenheden.
Als u de muisaanwĳzer verplaatst in het hoogteprofiel ziet u twee elkaar kruisende stippellĳnen:

• de verticale lĳn geeft de informatie voor de hoogte weer
• de horizontale lĳn geeft de afstand weer vanaf het begin van de lĳn van het hoogteprofiel

Als u de muisaanwĳzer verplaatst in het venster van het hoogteprofiel, ziet u ook een zwarte stip zich verplaatsen
langs de lĳn van het hoogteprofiel in het hoofdkaartvenster. In het midden van de profiellĳn geeft een pĳl zĳn richting
aan.
Voor het hoofdkaartvenster verschaft QGIS middelen om te navigeren in het plotvenster:
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• Schuiven wordt gebruikt om het bereik van het hoogteprofiel te verplaatsen in elke richting die u wilt.
Ingedrukt houden van de toets Spatie tĳdens het verplaatsen van de muis, verschuift ook het bereik van
het plotvenster.

• Zoomen X-as wordt gebruikt om in te zoomen op de horizontale as, waarbĳ de verhouding van de verticale
as (de hoogte) hetzelfde blĳft. Klik met links om de plot langs de X-as uit te rekken, met het aangeklikte punt
als het midden van de as, of sleep een rechthoek om de plot langs de X-as uit te rekken tot de breedte van de
rechthoek. Houdt Alt ingedrukt bĳ het gebruiken van Zoomen X-as om uit te zoomen van die as.

• In-/Uitzoomen wordt gebruikt om op een bepaald punt in te zoomen (met een links klik), of op een bepaald
bereik (slepen van een rechthoek voor het gebied). Houdt Alt ingedrukt bĳ In-/Uitzoomen om in plaats
daarvan uit te zoomen. In combinatie met de Ctrl-toets kunt u geleidelĳker in- of uitzoomen.

• Volledig uitzoomen is het standaard zoomniveau dat in het begin wordt gebruikt en geeft het volledige bereik
van de lĳn van het hoogteprofiel weer, met alle teruggegeven objecten. Gebruik het om het zoomniveau terug
te zetten.

Het is ook mogelĳk te interacteren met de elementen die worden weergegeven in het plotvenster:

• Druk op de knop Snappen inschakelen om nauwkeurig punten vast te leggen, punten of randen van de objecten,
voor een accurate meting of rapporteren van de coördinaten.

• Objecten identificeren wordt gebruikt om objecten te identificeren van de zichtbare lagen in de legenda. U kunt
een rechthoek slepen over verschillende objecten in de profielweergave om ze allemaal te bevragen. Indien
compatibel met de indeling (bĳv. vector, puntenwolk), zullen deze objecten worden geaccentueerd in het
hoofdkaartvenster.

• Meten afstanden: klik of selecteer twee punten in het plotvenster om de horizontale Afstand, de Hoogte en de
Totale afstand tussen hen te rapporteren, in kaarteenheden.

• Naar links verschuiven en Naar rechts verschuiven worden gebruikt om de lĳn van het hoogteprofiel in het
kaartvenster te verschuiven naar links of naar rechts. Het plotvenster zal opnieuw worden getekend, de objecten
en terrein weergevend die de buffer van de profiellĳn overlappen. De lĳn wordt zĳwaarts verplaatst met de
waarde Tolerantie in het menu Opties.

Waarschuwing: Sluiten van een weergave Hoogteprofiel of het project verwĳdert momenteel de weergave uit
het project.

Bekĳk, voor meer details, eens QGIS elevation profile/cross section tool – a deep dive!, een presentatie die is gegeven
door Nyall Dawson.
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12.1 Contextuele help

Wanneer u hulp nodig hebt over een specifiek onderwerp, krĳgt u toegang tot de overeenkomende pagina in de huidige
Gebruikershandleiding via de knop Help, die beschikbaar is in de meeste dialoogvensters — onthoud dat plug-ins die
door derden zĳn gemaakt, kunnen verwĳzen naar speciaal daarvoor gemaakte webpagina’s.

12.2 Panelen

Standaard verschaft QGIS veel panelen om mee te werken. Sommige van deze panelen worden hieronder beschreven
terwĳl andere in verschillende gedeelten van het document zĳn te vinden. Een volledige lĳst van standaard panelen
die door QGIS worden verschaft is beschikbaar via het menu Beeld ► Panelen ► en zĳn vermeld op Panelen.

12.2.1 Paneel Lagen

Het paneel Lagen (ook welkaartlegenda genoemd) vermeldt alle lagen in het project en helpt u hun zichtbaarheid
te beheren en de kaart te vormen. U kunt het paneel weergeven of verbergen door te drukken op Ctrl+1.
Aan de bovenzĳde van het paneel Lagen stelt een werkbalk u in staat om:

• Paneel Laag opmaken openen (F7): in-/uitschakelen van het paneel Laag opmaken.

• Nieuwe groep toevoegen: bekĳk Interactie met groepen en lagen

• Kaartthema’s beheren: beheer voor de zichtbaarheid van lagen en ze schikken in verschillende kaartthema’s.

• filter lagen in de boom van de legenda:
– Legenda op kaartinhoud filteren: alleen de lagen die als zichtbaar zĳn ingesteld en waarvan de objecten
kruisen met het huidige kaartvenster hebben hun stĳl gerenderd in het paneel Lagen. Anders wordt een
generiek symbool NULL toegepast op de laag. Gebaseerd op de symbologie van de laag, is dit een handige
manier om te kunnen identificeren welk soort objecten van welke laag uw gebied bedekken.

– Private lagen weergeven: een handige sneltoets om private lagen in het paneel Lagen weer te geven en
interactie mee uit te voeren, zonder de project-instellingen aan te passen.
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• Legenda filteren met expressie: een expressie toepassen om stĳlen, die geen object hebben dat voldoet aan de
voorwaarde, uit de geselecteerde boom van lagen te verwĳderen. Dit kan bĳvoorbeeld worden gebruikt om
objecten te accentueren die binnen een bepaald gebied/object van een andere laag liggen. U kunt de ingestelde
expressie vanuit het keuzemenu bewerken of de huidige gebruikte expressie leeg maken.

• Alles uitklappen of Alles inklappen, lagen en groepen in het paneel Lagen.

• Laag/Groep verwĳderen momenteel geselecteerde.

Fig. 12.1: Werkbalk Laag in paneel Lagen

Notitie: Gereedschappen om het paneel Lagen te beheren zĳn ook beschikbaar voor kaart- en legenda-items van
afdruklay-outs

Kaartthema’s configureren

De keuzeknop Kaartthema’s beheren verschaft toegang tot handige sneltoetsen om de zichtbaarheid van de lagen te
bewerken in het paneel Lagen:

• Alle lagen tonen

• Alle lagen verbergen

• Geselecteerde lagen tonen

• Geselecteerde lagen verbergen

• Geselecteerde lagen schakelen: wĳzigt de zichtbaarheid van de eerste geselecteerde laag in het paneel, en
past die status toe op de andere geselecteerde lagen. Ook toegankelĳk met de sneltoets Spatiebalk.

• Geselecteerde lagen onafhankelĳk schakelen: wĳzigt de status voor zichtbaarheid van elke geselecteerde laag

• Niet geselecteerde lagen verbergen

Naast het simpel beheren van de zichtbaarheid van lagen, stelt het menu Kaartthema’s beheren u in staatKaartthema’s
te configureren in de legenda en te schakelen van het ene thema naar een ander. Een kaartthema is een
momentopname van de huidige legenda van de kaart die vastlegt:

• de lagen die zĳn ingesteld als zichtbaar in het paneel Lagen
• en voor elke zichtbare laag:

– de verwĳzing naar de op de laag toegepaste stĳl
– de zichtbare klassen van de stĳl, d.i. de op de laag geselecteerde items knoop in het paneel Lagen. Dit is
van toepassing op de symbologieën, anders dan het renderen van het enkele symbool

– de opgevouwen/uitgevouwen status van de kno(o)p(en) en groep(en) van de laag is er in geplaatst
Een kaartthema maken:

1. Selecteer een laag die u wilt weergeven
2. Configureer de eigenschappen voor de laag (symbologie, diagram, labels…) zoals gewoonlĳk
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3. Vergroot het menu Stĳl ► aan de onderzĳde en klik op Toevoegen… om de instellingen op te slaan als een
nieuwe ingebedde stĳl in het project

Notitie: Een kaartthema onthoud niet de huidige details van de eigenschappen: alleen een verwĳzing naar
de naam van de stĳl wordt opgeslagen, dus wanneer u aanpassingen toepast op de laag terwĳl deze stĳl is
ingeschakeld (bĳvoorbeeld het renderen van de symbologie wĳzigt), wordt het kaartthema bĳgewerkt met de
nieuwe informatie.

4. Herhaal de eerdere stappen indien nodig voor de andere lagen
5. Indien van toepassing, groepen of zichtbare laagknopen uit- of inklappen in het paneel Lagen
6. Klik op de knop Kaartthema’s beheren boven in het paneel, en op Thema toevoegen…

7. Voer de naam voor het kaartthema in en klik op OK

Het nieuwe thema wordt vermeld in het onderste gedeelte van het keuzemenu .
U kunt net zoveel kaartthema’s maken als u wilt: wanneer de huidige combinatie in de kaartlegenda (zichtbare lagen,
hun actieve stĳl, de knopen voor de kaartlegenda) niet overeenkomt met de inhoud van een bestaand kaartthema zoals
hierboven gedefinieerd, klik op Thema toevoegen… om een nieuw kaartthema te maken of gebruik Thema vervangen
► om een kaartthema bĳ te werken. U kunt het actieve kaartthema hernoemen met Huidige thema hernoemen… of
gebruik de knop Huidige thema verwĳderen om het te verwĳderen.
Kaartthema’s zĳn nuttig om snel te schakelen tussen verschillende vooraf geconfigureerde combinaties: selecteer
een kaartthema in de lĳst om die combinatie te herstellen. Alle geconfigureerde thema’s zĳn ook toegankelĳk in
de afdruklay-out, wat het voor u mogelĳk maakt een kaartlay-out te maken, gebaseerd op specifieke thema’s en
onafhankelĳk van het huidige gerenderde kaartvenster (bekĳk Lagen met kaartitems).

Overzicht van het contextmenu van het paneel Lagen

Aan de onderzĳde van de werkbalk is de belangrĳkste component van het paneel Lagen het frame dat alle aan het
project toegevoegde lagen vermeld, optioneel gerangschikt in groepen. Een laag met een geselecteerd vak ernaast
geeft zĳn inhoud weer die het bereik van het kaartvenster overlapt, tenzĳ een schaalafhankelĳke zichtbaarheid is
ingesteld. Een laag kan worden geselecteerd en in de legenda naar boven of beneden worden gesleept om de Z-
volgorde te wĳzigen. Z-volgorde betekent dat lagen, die dichter bĳ de bovenzĳde van de legenda worden vermeld,
worden getekend boven lagen die lager in de legenda staan. Ook kan een laag of een groep lagen worden gesleept
naar andere instanties van QGIS.

Notitie: Het gedrag van de Z-volgorde kan worden overschreven door middel van het paneel Laagvolgorde.

Afhankelĳk van het geselecteerde item in het paneel geeft een klik met rechts een aangewezen set opties weer die
hieronder worden weergegeven.

Tabel 12.1: Contextmenu’s van items van het paneel Lagen
Optie Groep Vectorlaag Rasterlaag Laag met mazen Puntenwolklaag

Zoomen naar la(a)g(en)/Groep

Zoom naar selectie

Tonen in overzichtskaart

Aantal objecten tonen

Label weergeven

Laag/groep kopiëren

Laag/groep hernoemen
Vervolgt op volgende pagina
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Tabel 12.1 – Vervolgd van vorige pagina
Optie Groep Vectorlaag Rasterlaag Laag met mazen Puntenwolklaag

Zoom naar eigen resolutie (100%)

Uitrekken naar huidig bereik

SQL-laag bĳwerken…

Virtuele laag bewerken…

Groep toevoegen

Laag dupliceren

Laag/Groep verwĳderen…

Groep verlaten

Verplaats naar bovenste

Naar beneden verplaatsen

Selecteren en ook al zĳn ouders

Geselecteerde groeperen

Attributentabel openen

Bewerken aan/uitzetten

Huidige wĳzigingen ►
Filteren…

Databron wĳzigen…

Databron repareren…

Acties op selecties ► (in modus Bewerken)
► Object dupliceren

► Object dupliceren en digitaliseren

Zichtbaarheidsschaal instellen…

Zoom naar zichtbaarheidsschaal

Laag-CRS ►
Project-CRS van laag overnemen

► Instellen op… (recente CRS-en)
► Laag-CRS instellen…

CRS voor groep instellen…

CRS voor groep WMS-gegevens instellen…

Gemeenschappelĳk uitgesloten groep

Selecteren en ook al zĳn kinderen (Ctrl-klik)

Deselecteren en ook al zĳn kinderen (Ctrl-klik)

Permanent maken

Exporteren ►
► Opslaan als…

► Objecten opslaan als…

► Geselecteerde objecten opslaan als…

► Opslaan als Laag-definitiebestand…
Vervolgt op volgende pagina
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Tabel 12.1 – Vervolgd van vorige pagina
Optie Groep Vectorlaag Rasterlaag Laag met mazen Puntenwolklaag

► Opslaan als QGIS Laagstĳlbestand…

Stĳlen ►
► Stĳl kopiëren

► Stĳl plakken

► Toevoegen…

► Huidige hernoemen…

► Symbool bewerken…

► Symbool kopiëren

► Symbool plakken

Opmerkingen voor laag toevoegen…

Opmerkingen voor laag bewerken…

Opmerkingen voor laag verwĳderen…

Eigenschappen…

Voor vectorlagen van GRASS is Bewerken aan-/uitzetten niet beschikbaar. Bekĳk het gedeelteDigitaliseren en bewerken
van een GRASS vectorlaag voor informatie over het bewerken van vectorlagen van GRASS.

Interactie met groepen en lagen

Lagen in het venster Legenda kunnen in groepen worden ondergebracht. Er zĳn verschillende manieren om dit te
doen:

1. Druk op het pictogram om een nieuwe groep toe te voegen. Typ een naam in voor de groep en druk op
Enter. Klik nu op een bestaande laag en sleep die op de groep.

2. Selecteer meer dan één laag, druk dan op het pictogram . De geselecteerde lagen worden automatisch in
de nieuwe groep ingevoegd.

3. Selecteer enkele lagen, klik met de rechter muisknop in het venster van de legenda en kies Geselecteerde
groeperen. De geselecteerde lagen zullen automatisch aan de nieuwe groep worden toegevoegd.

Een laag uit een groep halen: sleep hem uit de groep of klik er met rechts op en kies Groep verlaten: de laag wordt
verplaatst vanuit de groep en erboven geplaatst. Groepen kunnen ook binnen andere groepen worden genest. Als een
laag in een geneste groep wordt geplaatst zal Groep verlaten de laag uit alle geneste groepen verplaatsen.
Een groep of laag naar de bovenkant van het paneel lagen verplaatsen: ofwel sleep het naar boven, of kies Verplaats
naar bovenste. Als u deze optie gebruikt op een laag die is genest in een groep, wordt de laag verplaatst naar de
bovenste plek in zĳn huidige groep. De optie Naar beneden verplaatsen volgt dezelfde logica om lagen en groepen
naar beneden te verplaatsen.
Het keuzevak voor een groep zal de geselecteerde lagen met één klik weergeven of verbergen. Met Ctrl ingedrukt
zal het keuzevak ook alle lagen in de groep en zĳn subgroepen in- of uitschakelen.
Ctrl-klik op een geselecteerde / niet-geselecteerde laag zal de laag en al zĳn ouders deselecteren / selecteren.
Inschakelen van de optie Gemeenschappelĳk uitgesloten groep betekent dat u er voor kunt zorgen dat slechts één
laag per keer zichtbaar is. Wanneer een laag binnen de groep ingesteld is om zichtbaar te zĳn zullen de andere als
niet zichtbaar worden geschakeld.
Het is mogelĳk om meer dan één laag of groep tegelĳkertĳd te selecteren door de Ctrl -toets vast te houden tĳdens
het klikken op aanvullende lagen. U kunt dan in een keer alles wat u geselecteerd heeft tegelĳkertĳd verplaatsen naar
een nieuwe groep.
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U kunt ook meer dan één laag of groep tegelĳkertĳd verwĳderen door verscheidene items te selecteren met de Ctrl-
toets en dan te drukken op de toetsencombinatie Ctrl+D, alle geselecteerde lagen of groepen verwĳderd worden uit
de lagenlĳst.

Meer informatie over lagen en groepen met pictogram voor indicatie

Onder sommige omstandigheden wĳzigen pictogrammen of opmaak naast de laag of groep in het paneel Lagen om
meer informatie te verschaffen over de laag/groep. Deze elementen zĳn:

• om aan te geven dat de laag in de modus Bewerken staat en dat u de gegevens kunt aanpassen

• om aan te geven dat de bewerkte laag enkele niet opgeslagen wĳzigingen heeft

• om een filter aan te geven dat toegepast is op de laag. Ga met de muiscursor over het pictogram om de
filter-expressie te zien en dubbelklik om de query bĳ te werken

• om lagen te identificeren die vereist zĳn in het project, dus niet te verwĳderen
• om een ingebedde groep of laag te identificeren en het pad naar hun originele projectbestand

• om een laag te identificeren waarvan de gegevensbron niet beschikbaar was bĳ het openen van het
projectbestand (zie Afhandelen defecte bestandspaden). Klik op het pictogram om het pad naar de bron bĳ
te werken of selecteer het item Databron repareren… uit het contextmenu van de laag.

• om u er aan te herinneren dat de laag een tĳdelĳke tekenlaag is en dat de inhoud ervan zal worden genegeerd
als u het project sluit, Klik op het pictogram om de laag op te slaan in een van de door QGIS ondersteunde
vectorindelingen voor GDAL om gegevensverlies te vermĳden en de laag permanent te maken.

• om een laag te identificeren die wordt gebruikt in modus Offline bewerken.

• om een laag te identificeren die geen/onbekend CRS heeft

• voor lagen met coördinaten die zĳn opgeslagen in een Coördinaten ReferentieSysteem dat inherent een
lage nauwkeurigheid heeft (vereist dat de overeenkomende instelling is ingeschakeld)

• om een laag van tĳdbeheer te identificeren die wordt beheerd door een animatie van het kaartvenster

• om aan te geven dat een laag opmerkingen met zich heeft verbonden
• Een uitgegrĳsde naam, als de huidige schaal van het kaartvenster buiten het schaalbereik van de zichtbaarheid
voor de laag ligt (zoals ingesteld in zĳn eigenschappen Renderen). Selecteer de optie in het contextmenu
Zoomen naar zichtbare schaal om de kaart in te zoomen naar de dichtstbĳzĳnde grens voor de schaal van
de zichtbaarheid.

Renderen van lagen beheren door groeperen

Groepen zĳn een manier om lagen te structureren binnen een boom in het project, maar zĳ kunnen ook invloed
hebben over hoe hun componentlagen worden gerenderd, namelĳk als één afgevlakt object bĳ het renderen van de
kaart.
De optie voor een dergelĳk renderen is beschikbaar in het paneel Laag opmaken wanneer ene groep is geselecteerd.

Selecteer, op de tab Symbologie, Lagen renderen als een groep om een set opties in te schakelen om het uiterlĳk
van de kindlagen als één geheel te beheren, in plaats van als individuele lagen:

• Opaciteit: Objecten uit kindlagen die worden bedekt door andere kindlagen blĳven bedekt, en de opaciteit wordt
alleen op de “gehele groep” toegepast.
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Fig. 12.2: Instellen van opaciteit op lagen vs op een groep
De afbeelding aan de linkerkant geeft twee lagen weer die zijn gerenderd met 50% opaciteit (onderliggende objecten zijn

zichtbaar, maar semi-gemaskeerd door het 50% rode object bovenop). De tweede afbeelding geeft het resultaat weer van het
instellen van de opaciteit op de groep (delen van de blauwe onderliggende kindlaag wordt volledig bedekt door de rode laag

bovenop en dan wordt het resultaat gerenderd met 50% opaciteit).

• Meng-modi: Net als met opaciteit resulteert het instellen van eenmeng-modus (zoals vermenigvuldigen, overleg,
…) voor een gehele groep eerst in het afvlakken van objecten van kindlagen, waarbĳ bovenste de onderste
bedekken. Het renderen wordt dan verkregen door de vlakke groep te mengen en de lagen die onder de groep
liggen.

– Als de kindlagen een mengmodus hebben toegewezen gekregen wordt die toegepast vóór het afvlakken,
maar het bereik is beperkt tot het alleen beïnvloeden andere kindlagen uit die groep, en geen andere lagen
die onder de gehele groep liggen.

– Enkele extra opties meng-modi zĳn beschikbaar voor kindlagen in groepen, op hun tab Symbologie
die bewerkingen in de stĳl van “clippen” uitvoeren op andere kindlagen tĳden het renderen. U kunt
bĳvoorbeeld het renderen van de inhoud van de ene laag clippen naar de inhoud van een tweede
“maskeer”-laag.

• Laageffecten: past effecten alleen toe op het afgevlakt renderen van de kindlagen; Dus, bĳvoorbeeld, het effect
van een valschaduw die is toegepast op de groep zou niet zichtbaar zĳn op bedekte kindlagen.

Wanneer een groep is ingesteld op Lagen renderen als een groep, dan zal alleen de groep worden weergegeven in de
lĳst van het paneel Volgorde lagen. Kinderen van de groep zullen in de lĳst voor de volgorde niet zichtbaar zĳn, omdat
hun volgorde wordt bepaald door de plaatsing van de laag van de groep.

Laagstijl bewerken

Op het paneel Lagen heeft u sneltoetsen om het renderen van de laag snel en gemakkelĳk te wĳzigen.
Klik met rechts op een laag en selecteer Stĳlen ► in de lĳst om:

• de huidige beschikbare stĳlen voor de laag te zien. Als u veel stĳlen voor de laag hebt gedefinieerd, kunt u van de
een naar de ander schakelen en zal het renderen van de laag automatisch worden bĳgewerkt in het kaartvenster.

• kopiëren van een deel van of de gehele huidige stĳl en, indien van toepassing, een gekopieerde stĳl uit een
andere laag plakken

• stĳl Huidige hernoemen…

• een nieuwe stĳl Toevoegen (wat in feite een kopie is van de huidige)
• of Verwĳderen huidige stĳl (alleen als meerdere stĳlen beschikbaar zĳn).

Tip: Snel een laagstĳl delen
Kopieer, vanuit het contextmenu, de stĳl van een laag en plak die op een groep of een selectie van lagen: de
stĳl wordt toegepast op alle lagen die van hetzelfde type zĳn (vector, raster, mazen, puntenwolk, …) als de
originele laag en, in het geval van vector, hebben hetzelfde type geometrie (punt, lĳn of polygoon).
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Bĳ het gebruiken van een symbologie die is gebaseerd op klassificatie van objecten (e.g. categorieën, gradueel of
regel-gebaseerd voor vectorlagen of classificatie voor puntenwolken), maakt met rechts klikken op een item in het
paneel Lagen het mogelĳk om de zichtbaarheid van de klassen (en hun objecten) te bewerken en vermĳden om ze
één voor één te moeten (de)selecteren:

• Items schakelen

• Alle items weergeven

• Alle items verbergen

Voor vectorlagen geeft het contextmenu van het item van een klasse ook toegang tot:

• Objecten selecteren: selecteert in de laag alle objecten die overeenkomen met die klasse

• In attributentabel weergeven: opent een attributentabel die is gefilterd op alleen de objecten die
overeenkomen met die klasse

• bĳwerken van de symboolkleur met een Kleurenwiel. Gemakshalve zĳn de recent gebruikte kleuren ook
beschikbaar aan de onderzĳde van het wiel.

• Symbool bewerken…: open het dialoogvenster voor Symbool selecteren om het symbool van het object (symbool,
grootte, kleur…) te wĳzigen.

• Symbool kopiëren

• Symbool plakken

Tip: Dubbelklikken op een blad van het klasseitem opent ook het dialoogvenster Symbool selecteren.

12.2.2 Paneel Laag opmaken

Het paneel Laag opmaken (ook in te schakelen met Ctrl+3) is een snelkoppeling voor enkele mogelĳkheden van
het dialoogvenster Laageigenschappen. Het verschaft een snelle en handige manier om het renderen en het gedrag
van een laag te definiëren, en om de effecten daarvan te visualiseren, zonder het dialoogvenster Laageigenschappen
te moeten openen.
Naast het vermĳden van het blokkerende (of “modale”) dialoogvenster Laageigenschappen, vermĳdt het paneel Laag
opmaken ook het dichtslibben van het scherm met dialoogvensters, en bevat het de meeste functies voor opmaken
(kleur kiezen, eigenschappen effecten, regel bewerken, vervangen van labels…): bĳv., klikken op kleurknoppen in
het paneel Laag opmaken zorgt er voor dat het dialoogvenster Kleur kiezen wordt geopend binnen het paneel Laag
opmaken zelf in plaats van als een zelfstandig dialoogvenster.
Selecteer, vanuit een keuzelĳst met huidige lagen in het paneel Lagen, een item en:

• Stel, afhankelĳk van het actieve item, in:

– Symbologie voor groepen (bekĳk Renderen van lagen beheren door groeperen)

– de eigenschappen Symbologie, Transparantie, en Histogram voor rasterlaag. Deze opties
zĳn dezelfde als in het Dialoogvenster Laageigenschappen.

– de eigenschappen Symbologie, Labels, Masker en 3D-weergave voor vectorlaag in.
Deze opties zĳn dezelfde als in Het dialoogvenster Vectoreigenschappen en kunnen worden uitgebreid met
aangepaste eigenschappen, geïntroduceerd door plug-ins van derde partĳen.

– de eigenschappen Symbologie en 3D-weergave voor lagen met mazen. Deze opties zĳn dezelfde
als in Eigenschappen gegevensset met mazen.
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– Eigenschappen Symbologiey, 3D-weergave en Hoogte voor puntenwolklaag. Deze opties
zĳn hetzelfde als in de Eigenschappen Puntenwolken.

• Beheer de geassocieerde stĳl(en) in de Stĳlmanager (meer details in Aangepaste stĳlen beheren).

• Volg de Geschiedenis van door u toegepaste wĳzigingen op de laagstĳl in het huidige project; u kunt daar
naar elke status terugkeren of die annuleren door het te selecteren in de lĳst en te drukken op Toepassen.

Een andere krachtige mogelĳkheid van dit paneel is het keuzevak Live bĳwerken. Selecteer het om uw wĳzigingen
automatisch direct te renderen in het kaartvenster: U hoeft niet langer op de knop Toepassen te drukken.
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Fig. 12.3: Symbologie voor een laag definiëren vanuit het paneel Laag opmaken
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12.2.3 Paneel Laagvolgorde

Standaard worden lagen, die worden weergegeven in het kaartvenster van QGIS, getekend in de volgorde waarin zĳ
in het paneel Lagen staan: hoe hoger een laag in het paneel staat, des te hoger (en daarom meer zichtbaar) het in de
kaartweergave zal staan.
U kunt een volgorde voor het tekenen definiëren, onafhankelĳk van de volgorde in het paneel Lagen, met het paneel
Laagvolgorde ingeschakeld in hetmenuBeeld►Panelen►ofmetCtrl+9. Selecteer Rendervolgorde controleren
onder in de lĳst met lagen en organiseer de lagen in het paneel zoals u dat wilt. Deze volgorde wordt die welke zal
worden toegepast op het kaartvenster. Bĳvoorbeeld: in Fig. 12.4 kunt u zien dat de objecten airports worden
weergegeven boven de polygoon alaska, ondanks de respectievelĳke plaatsing van die lagen in het paneel Lagen.

Uitschakelen van Rendervolgorde controleren zal het doen terugkeren naar het standaard gedrag.

Fig. 12.4: Een laagvolgorde definiëren onafhankelijk van de legenda

12.2.4 Paneel Overzichtskaart

Het paneel Overzichtskaart (Ctrl+8) geeft een kaart weer met een weergave van het volledige bereik van enkele
van de lagen. De Overzichtskaart wordt gevuld met de lagen die de optie Toon in overzichtskaart uit het menu Laag
of die uit het contextmenu van de laag gebruiken. In de weergave geeft een rode rechthoek het huidige bereik van het
kaartvenster aan, wat u helpt bĳ het snel bepalen van welk gebied van de gehele kaart u momenteel bekĳkt. Als u klikt
en sleept met de rode rechthoek in het frame van de overzichtskaart zal het bereik van het kaartvenster overeenkomstig
worden bĳgewerkt.
Onthoud dat labels niet worden gerenderd in de kaart van de overzichtskaart, zelfs niet als de gebruikte lagen voor de
overzichtskaart zĳn ingesteld voor labelen.
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12.2.5 Paneel Logboekmeldingen

Bĳ het laden of verwerken van sommige bewerkingen kunt u berichten traceren en volgen die op de verschillende
tabs verschĳnen met het paneel Logboekmeldingen. Het kan worden geactiveerd met het meest rechts gelegen
pictogram op de onderste statusbalk.

12.2.6 Paneel Ongedaan maken/Opnieuw

Voor elke laag die wordt bewerkt geeft het paneel Ongedaan maken/Opnieuw (Ctrl+5) de uitgevoerde acties weer,
wat het mogelĳk maakt snel een set acties ongedaan te maken door bovenstaande acties te selecteren. Meer details in
bewerkingen Ongedaan maken en Opnieuw.

12.2.7 Paneel Statistisch overzicht

Het paneel Statistieken (Ctrl+6) verschaft overzichtsinformatie voor een vectorlaag. Dit paneel stelt u in staat te
selecteren:

• de vectorlaag waarvan de statistieken moeten worden berekend: kan worden geselecteerd uit het keuzemenu,
of gesynchroniseerd met de actieve laag in het paneel Lagen met het keuzevak Geselecteerde laag volgen aan
de onderzĳde van de lĳst met statistieken

• het te gebruiken veld of expressie: voor elke laag, het laatste itemwordt onthouden en automatisch berekend
bĳ het opnieuw selecteren van de laag.

• de terug te geven statistieken met behulp van een keuzeknop aan de rechter onderkant van het dialoogvenster.
Afhankelĳk van het type veld (of waarden van de expressie) zĳn de beschikbare statistieken:

Tabel 12.2: Beschikbare statistieken voor elk type veld
Statistieken Tekenreeks Integer Float Datum

Aantal
Aantal (afzonderlĳk)
Aantal (ontbrekende waarde)
Som
Gemiddelde
Standaard afwĳking
Standaard afwĳking voor monster
Minimale waarde
Maximale waarde
Bereik
Minderheid
Meerderheid
Variëteit
Eerste kwartiel
Derde kwartiel
Bereik tussen kwartielen
Minimumlengte
Maximumlengte
Gemiddelde lengte
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Het statistisch overzicht kan worden:

• teruggegeven voor de gehele laag of voor Alleen geselecteerde objecten

• gekopieerd naar het klembord en als een tabel worden geplakt in een andere toepassing

• opnieuw berekend met de knop wanneer de onderliggende gegevensbron wĳzigt (bĳv. nieuwe of
verwĳderde objecten/velden, aanpassingen van attributen)

Fig. 12.5: Statistieken voor een veld weergeven

12.2.8 Paneel Gereedschappen voor debuggen/ontwikkeling

Het paneel Gereedschappen voor debuggen/ontwikkeling (F12) verschaft één enkele plaats voor het afhandelen en
debuggen van acties binnen QGIS. Beschikbare gereedschappen zĳn gerangschikt onder de volgende tabs:

• Netwerklogger

• Querylogger

• Profileren

Notitie: Auteurs van plug-ins kunnen het paneel uitbreiden met aangepaste tabs voor debuggen en ontwikkelen van
hun eigen plug-ins. Dit wordt gedaan met de methode registerDevToolWidgetFactory.
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Netwerklogger

De tab Netwerklogger helpt u verzoeken aan het netwerk vast te leggen en weer te geven, naast een geheel aan
nuttige details, zoals status van verzoek en antwoord, header, fouten, fouten in de configuratie van SSL, time-outs,
status van de cache, etc.
Met zĳn bovenste werkbalk kunt u:

• Log opnemen: wat het loggen zal starten of stoppen.

• Log leegmaken : zal de geschiedenis van het log wissen.

• Log opslaan…: zal eerst een grote waarschuwing weergeven dat het log gevoelige informatie bevat en als
vertrouwelĳk zou moeten worden behandeld en u dan toestaan het log op te slaan.

• Druk op het keuzemenu Instellingen om te selecteren voor Succesvolle verzoeken weergeven, Time-outs
weergeven en Antwoorden weergeven die zĳn geserveerd door de cache.

• Cache uitschakelen: zal de cache uitschakelen zodat elk verzoek moet worden uitgevoerd.

• Verzoeken filteren, gebaseerd op subsets van URL’s of status van verzoek
Door met rechts klikken op een verzoek kunt u:

• URL openen wat de URL in uw standaardbrowser zal openen.
• URL kopiëren

• Als cURL kopiëren om in de terminal te gebruiken.
• Als JSON kopiëren: kopieert de waarden van de boom als een tekenreeks voor JSON naar het klembord, om
gemakkelĳk te plakken in rapporten voor bugs of voor assistentie op afstand.
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Fig. 12.6: Netwerklogger uitvoer voor verzoek GET

Querylogger

De Querylogger is de plaats om de opdrachten voor SQL te loggen die worden verzonden door de
gegevensprovider en de API voor verbindingen naar de achterliggende database, samen met hun tĳd voor uitvoering
zoals die is gemeten door QGIS (d.i. in de cliënt die de opdrachten verzond). Dit kan nuttig zĳn bĳ het onderzoeken
van de uitvoering van een bepaalde laag tĳdens het debuggen of ontwikkelen van een algoritme of plug-in voor QGIS.
Met zĳn bovenste werkbalk kunt u:

• Log opnemen: wat het loggen zal starten of stoppen.

• Log leegmaken : zal de geschiedenis van het log wissen.

• Log opslaan…: zal eerst een grote waarschuwing weergeven dat het log gevoelige informatie bevat en als
vertrouwelĳk zou moeten worden behandeld en u dan toestaan het log op te slaan.

• Query’s filteren, gebaseerd op de subsets van tekenreeksen van de query of details, zoals type provider,
starttĳd, initiator, …

Klik met rechts op een gerapporteerde query, en u kunt:
• SQL kopiëren, opdracht aangeroepen door QGIS op de database
• Als JSON kopiëren: kopieert de waarden van de boom als een tekenreeks voor JSON naar het klembord, om
gemakkelĳk te plakken in rapporten voor bugs of voor assistentie op afstand.
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Fig. 12.7: Querylogger uitvoer

Profileren

De tab Profileren maakt het mogelĳk tĳden te laden voor elke bewerking die is betrokken bĳ acties die zĳn
verzocht door de gebruiker. Afhankelĳk van de context, kunnen deze bewerkingen zĳn het lezen van instellingen,
menu, kaartvenster of maken van 3D-weergaven, oplossen van verwĳzing naar kaartlagen, Favoriete plaatsen of laden
van een lay-out, … Dit helpt bĳ het identificeren van de oorzaken voor trage laadtĳden.
Standaard ondersteunde acties kunnen worden geselecteerd uit het keuzemenu Categorie:

• QGIS Opstarten

• Project laden

Fig. 12.8: Profiler voor opstarten van QGIS
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12.3 Lagen inbedden vanuit externe projecten

Soms zou u sommige lagen in verschillende projecten willen behouden, maar met dezelfde stĳl. U kunt ofwel zelf
een standaardstĳl voor deze lagen maken of ze inbedden vanuit een ander project om tĳd en werk te besparen.
Ingebedde lagen en groepen vanuit een bestaand project heeft enkele voordelen boven stĳl:

• Alle typen lagen (vector of raster, lokaal of online…) kunnen worden toegevoegd
• Ophalen van groepen en lagen, u kunt dezelfde boomstructuur behouden voor de “achtergrond”lagen in uw
verschillende projecten

• Hoewel ingebedde lagen zĳn te bewerken, kunt u hun eigenschappen, zoals symbologie, labels, formulieren
standaard waarden, acties, niet wĳzigen wat zorgt voor consistentie tussen projecten

• Pas de items in het originele project aan en wĳzigingen worden doorgevoerd in alle andere projecten
Wanneer u inhoud van andere projectbestanden wilt inbedden in uw project, selecteer Kaartlagen► Lagen en groepen
inbedden:

1. Klik op de knop… om te zoeken naar een project: u kunt de inhoud van het project zien (bekĳk Fig. 12.9)

2. Houd Ctrl ( of Cmd) ingedrukt en klik op de lagen en groepen die u wilt ophalen
3. Klik op OK

De geselecteerde lagen en groepen worden ingebed in het paneel Lagen en weergegeven in het kaartvenster. Een
pictogram wordt toegevoegd naast hun naam om ze te herkennen en daar overheen gaan met de muis laat een
Helptip zien met het pad naar het originele projectbestand.

Fig. 12.9: Lagen en groepen selecteren om in te bedden

Net als elke andere laag kan een ingebedde laag uit het project worden verwĳderd door met rechts op de laag te
klikken en te klikken op Verwĳderen.

Tip: Rendering van een ingebedde laag wĳzigen
Het is niet mogelĳk de rendering van een ingebedde laag te wĳzigen, tenzĳ u de wĳzigingen maakt in het originele
projectbestand. Echter, met rechts klikken op een laag en selecteren van Dupliceren maakt een laag die alle objecten
bevat en niet afhankelĳk is van het originele project. U kunt dan veilig de gekoppelde laag verwĳderen.
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12.4 Werken met objecten

12.4.1 Objecten selecteren

QGIS verschaft verscheidene gereedschappen om objecten in het kaartvenster te selecteren. Gereedschappen om te
selecteren zĳn beschikbaar in het menu Bewerken ► Selecteren of op de werkbalk Selectie.

Notitie: Gereedschappen om te selecteren werken op de huidige actieve laag.

Handmatig in het kaartvenster selecteren

U kunt een van de volgende gereedschappen gebruiken om één of meer objecten met de muis te selecteren:

• Objecten selecteren per gebied of met een enkele klik

• Objecten met een polygoon selecteren

• Objecten selecteren door er overheen te tekenen

• Objecten met een cirkel selecteren

Notitie: Anders dan Objecten met een polygoon selecteren, stellen deze gereedschappen voor handmatig selecteren u in
staat object(en) in het kaartvenster te selecteren met één enkele klik.

Notitie: Gebruik het gereedschap Objecten met een polygoon selecteren om een bestaand object polygoon (uit elke laag)
te gebruiken om overlappende objecten op de actieve laag te selecteren. Klik met rechts in de polygoon en kies het
in het contextmenu dat een lĳst weergeeft van alle polygonen die het aangeklikte punt bevatten. Alle overlappende
objecten van de actieve laag worden geselecteerd.

Tip: Gebruik het gereedschap Bewerken► Selecteren► Objecten opnieuw selecteren om uw eerdere selectie opnieuw
te selecteren. Heel nuttig als u per ongeluk een selectie hebt gemaakt, en dan ergens anders klikt en uw selectie
leegmaakt.

Ingedrukt houden van Shift of Ctrl, tĳdens het gebruiken van het gereedschap Object(en) selecteren, schakelt
of een object is geselecteerd (d.i. ofwel voegt het aan de huidige selectie toe of verwĳdert het daar uit).
Voor de andere gereedschappen kan ander gedrag worden uitgevoerd door ingedrukt te houden:

• Shift: objecten toevoegen aan de huidige selectie
• Ctrl: objecten verwĳderen uit de huidige selectie
• Ctrl+Shift: kruisen met huidige selectie, d.i. alleen overlappende objecten uit de huidige selectie behouden
• Alt: objecten selecteren die volledig binnen de vorm van de selectie liggen. Gecombineerd met de toetsen
Shift of Ctrl kunt u objecten aan de huidige selectie toevoegen of er uit verwĳderen.
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Automatisch selecteren

De andere gereedschappen voor selecteren, waarvan de meeste beschikbaar zĳn vanuit de Attributentabel, voeren een
selectie uit die is gebaseerd op een attribuut van het object of de status van zĳn selectie (onthoud dat attributentabel en
kaartvenster dezelfde informatie weergeven, dus als u een object selecteert in de attributentabel, zal het ook worden
geselecteerd in het kaartvenster):

• Objecten selecteren met reguliere expressie… stelt de gebruiker in staat objecten te selecteren met een dialoogvenster
voor expressies.

• Objecten selecteren d.m.v. waarde… of door te drukken op F3

• Objecten uit alle lagen deselecteren of druk op Ctrl+Alt+A om alle geselecteerde objecten in alle lagen te
deselecteren

• Objecten deselecteren van huidige actieve laag of druk op Ctrl+Shift+A

• Alle objecten selecteren of druk op Ctrl+A om alle objecten op de huidige laag te selecteren

• Selectie van objecten omdraaien om de selectie van de huidige laag om te draaien

• Selecteren op plaats om objecten te selecteren, gebaseerd op hun ruimtelĳke relatie met andere objecten (op
dezelfde of een andere laag - zie Selecteren op plaats)

Als u bĳvoorbeeld regions wilt zoeken die boroughs zĳn uit regions.shp van de voorbeeldgegevens van QGIS,
kunt u:

1. Het pictogram Objecten selecteren met een expressie gebruiken
2. Vergroot de groep Velden en waarden

3. Dubbelklik op het veld dat u wilt bevragen (“TYPE_2”)
4. Klik op Alle unieke in het paneel dat aan de rechterkant open gaat
5. Dubbelklik, in de lĳst, op ‘Borough’. Schrĳf in het bewerkingsveld Expressie de volgende query:

"TYPE_2" = 'Borough'

6. Klik op Objecten selecteren

Vanuit het dialoogvenster Expressiebouwer kunt u ook Functielĳst ► Recent (Selectie) gebruiken om een selectie te
maken die u al eerder hebt gebruikt. Het dialoogvenster onthoudt de laatste 20 gebruikte expressies. Bekĳk Expressies
voor meer informatie en voorbeelden.

Tip: Uw selectie opslaan in een nieuw bestand
Gebruikers kunnen geselecteerde objecten opslaan in eenTĳdelĳke tekenlaag of eenNieuwe vectorlaagmet behulp
van Bewerken ► Objecten kopiëren en Bewerken ► Plak objecten als in de gewenste indeling.
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Objecten selecteren d.m.v. waarde

Dit gereedschap voor selecteren opent het objectformulier van de laag wat de gebruiker in staat stelt in elk veld te
zoeken, of het zoeken hoofdlettergevoelig moet zĳn en de bewerking die moet worden gebruikt, Het gereedschap
heeft ook automatisch invullen, automatisch vullen van het zoekvak met bestaande waarden.

Fig. 12.10: Objecten met behulp van dialoogvenster Formulier selecteren/filteren

Naast elk veld staat een keuzelĳst met de opties om het zoekgedrag te beheren:

Tabel 12.3: Query operators per type gegevens
Optie zoekveld Tekenreeks Numeriek Datum

Veld uitsluiten bĳ het zoeken
Is gelĳk aan (=)

Niet gelĳk aan ( ̸=)

Groter dan (>)

Kleiner dan (<)

Groter dan of is gelĳk aan (≥)

Kleiner dan of is gelĳk aan (≤)

Tussen (inclusief)

Niet tussen (inclusief)

Bevat

Bevat niet

Ontbreekt (null)

Ontbreekt niet (niet null)

Begint met

Eindigt op

Voor vergelĳkingen van tekenreeksen is het ook mogelĳk om de optie Hoofd-/kleine letters te gebruiken.
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Klik, na het instellen van alle opties voor het zoeken, op Objecten selecteren om de overeenkomende objecten te
selecteren. De opties voor de keuzelĳst zĳn:

• Objecten selecteren

• Voeg toe aan huidige selectie

• Uit huidige selectie verwĳderen

• Huidige selectie filteren

U kunt ook alle opties voor het zoeken opschonen met de knop Formulier herstellen.
Als de voorwaarden eenmaal zĳn ingesteld, kunt u ook ofwel:

• Naar objecten zoomen zonder eerst te hebben geselecteerd
• Flitsmogelĳkheden, de overeenkomende objecten accentueren. Dit is een handige manier om een object
te identificeren zonder selectie of het gereedschap Objecten identificeren te gebruiken. Onthoud dat de
flitsmogelĳkheden niet het bereik van het kaartvenster wĳzigen en het zal alleen zichtbaar zĳn als het object
binnen de grenzen van het huidige kaartvenster valt.

12.4.2 Objecten identificeren

Het gereedschap Objecten identificeren stelt u in staat interactief te zĳn met het kaartvenster en informatie over
objecten te verkrĳgen in een pop-upvenster. Gebruik, om objecten te identificeren:

• Beeld ► Objecten identificeren

• Ctrl+Shift+I (of Cmd+Shift+I),

• pictogram Objecten identificeren op de werkbalk Attributen

Gebruiken van het gereedschap Objecten identificeren

QGIS biedt verscheidene manieren om objecten te identificeren met het gereedschap Objecten identificeren:
• klik met links zal objecten identificeren overeenkomstig demodus voor selectie en hetmasker voor selectie dat
is ingesteld in het paneel Identificatieresultaten

• klik met rechts met Object(en) identificeren als ingestelde modus voor selectie in het paneel
Identificatieresultaten haalt alle gevangen objecten op vanaf alle zichtbare lagen. Dit opent een contextmenu
dat de gebruiker in staat stelt om de objecten meer nauwkeuriger te identificeren of de actie die op die objecten
moet worden uitgevoerd te kiezen.

• klik met rechts met Objecten met een polygoon selecteren als ingestelde modus voor selectie in het
paneel Identificatieresultaten identificeert de objecten die overlappen met de gekozen bestaande polygoon,
overeenkomstig het masker voor selectie dat is ingesteld in het paneel Identificatieresultaten

Tip: De lagen filteren om te bevragen met het gereedschap Objecten identificeren
Deselecteer, onder Service-mogelĳkheden (capabilities) laag in Project► Eigenschappen…► Databronnen, de kolom
Identificeerbaar naast een laag om te voorkomen dat die wordt bevraagd bĳ het gebruiken van het gereedschap
Objecten identificeren in een andere modus danHuidige laag. Dit is een handige manier om alleen gegevens terug te krĳgen
van lagen die voor u van belang zĳn.

Wanneer u op object(en) klikt, dan zal Identificatieresultaten een overzicht geven van de informatie over de/het
geselecteerde object(en). De standaardweergave is een boomweergave waarbĳ het eerste item de naam is van de
laag en de kinderen daarvan zĳn de geïdentificeerde object(en). Elk object wordt beschreven door de naam van een
veld met de waarde daarvan. Dat veld is het veld dat is geselecteerd in Laageigenschappen ► Tonen. Daarna wordt
alle informatie van het object getoond.
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Informatie over objecten

Het dialoogvenster Identificatieresultaten kan worden aangepast om aangepaste velden te tonen, maar het zal
standaard de volgende informatie weergeven:

• De weergavenaam van het object;
• Acties: Acties kunnen worden toegevoegd aan het venster Identificatieresultaten. De actie wordt uitgevoerd
door te klikken op het label van de actie. Standaard wordt slechts één actie toegevoegd, namelĳk het weergeven
van het formulier Object bekijken om te bewerken. U kunt meer acties definiëren in het dialoogvenster
Laageigenschappen (zie Acties).

• Afgeleid: Deze informatie wordt berekend of afgeleid uit andere informatie. Het omvat:
– algemene informatie over de geometrie van het object:

∗ afhankelĳk van het type geometrie, de Cartesiaanse metingen van lengte, omtrek of gebied in de
eenheden van het CRS voor de laag. Voor 3D-lĳnvectors is de Cartesiaanse lĳnlengte beschikbaar.

∗ afhankelĳk van het type geometrie en of een ellipsoïde is ingesteld in het dialoogvenster voor
projecteigenschappen voor Meten, de ellipsoïde waarden voor lengte, omtrek of gebied met de
gespecificeerde eenheden

∗ het aantal delen van de geometrie in het object en het nummer van het aangeklikte deel
∗ het aantal punten in het object

– informatie over coördinaten, met de instellingen de van de projecteigenschappen Coördinaat weergeven:
∗ waarden voor X- en Y-coördinaten van het aangeklikte punt
∗ het nummer van het dichtstbĳgelegen punt ten opzichte van het aangeklikte punt
∗ waarden X- en Y-coördinaten van het dichtstbĳzĳnde punt (en Z/M indien van toepassing)
∗ als u klikt op een gebogen segment wordt de straal van dat gedeelte ook weergegeven.

• Attributen gegevens: Dit is de lĳst met attribuutvelden en de waarden daarvan voor het object waarop werd
geklikt.

• informatie over het gerelateerde kindobject wanneer u een relatie hebt gedefinieerd:
– de naam van de relatie
– het item in het verwĳzingsveld, bĳv. de naam van het gerelateerde kindobject
– Acties: vermeld acties die zĳn gedefinieerd in het dialoogvenster Laag-eigenschappen (zie Acties) en de
standaardactie is Formulier object bekijken.

– Attributen gegevens: Dit is de lĳst met attribuutvelden en de waarden daarvan voor het gerelateerde
kindobject.

Notitie: Op koppelingen in attributen van de objecten kan worden geklikt vanuit het paneel Identificatieresultaten en
zullen openen in uw standaard webbrowser.
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Fig. 12.11: Dialoogvenster Identificatieresultaten

Het dialoogvenster Identificatieresultaten

Aan de bovenkant van het venster staan een handvol gereedschappen:

• Formulier object bekĳken van het huidige object

• Boom uitklappen

• Boom inklappen

• Nieuwe resultaten standaard uitklappen om te definiëren of de informatie van het volgende geïdentificeerde object
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zou moeten worden in- of uitgeklapt

• Resultaat wissen

• Geselecteerde rĳen naar klembord kopiëren

• Geselecteerde HTML antwoord afdrukken

• te gebruiken modus voor selectie om te identificeren objecten op te halen:

– Object(en) identificeren

– Objecten met een polygoon identificeren

– Objecten identificeren door er overheen te tekenen

– Objecten met een cirkel identificeren

Notitie: Bĳ het gebruiken van Objecten met een polygoon identificeren kunt u met rechts klikken op een bestaande
polygoon en die gebruiken om overlappende objecten op een andere laag te identificeren.

Aan de onderzĳde van het venster staan de combinatievakkenModus enWeergave.Modus definieert van welke lagen
objecten zouden moeten worden geïdentificeerd:

• Huidige laag: alleen objecten van de geselecteerde lagen worden geïdentificeerd. Als een groep is geselecteerd,
worden objecten van zĳn zichtbare lagen geïdentificeerd. Als er geen selectie is dan wordt alleen de huidige
laag geïdentificeerd.

• Van bovenaf, stop bĳ eerste: alleen objecten van de bovenste zichtbare laag.
• Van bovenaf: alle objecten uit de zichtbare lagen. De resultaten worden in het paneel weergegeven.
• Laagselectie: opent een contextmenu waar de gebruiker de laag selecteert van waarop de objecten moeten
worden geïdentificeerd, soortgelĳk als een klik met rechts. Alleen de gekozen objecten zullen in het paneel
met resultaten worden weergegeven.

De Weergave kan worden ingesteld als Boom, Tabel of Grafiek. Weergaven ‘Tabel’ en ‘Grafiek’ kunnen alleen
worden ingesteld voor rasterlagen.

Het gereedschap Objecten identificeren stelt u ook in staat om Automatisch formulier openen voor resultaten met
enkele objecten te gebruiken, te vinden onder Instellingen Objecten identificeren. Indien geselecteerd zal, elke keer als één
enkel object is geïdentificeerd, een formulier worden weergeven dat de attributen weergeeft. Dit is een handige manier
om snel de attributen van een object te bewerken.
Andere functies kunnen worden gevonden in het contextmenu van het geïdentificeerde item. Vanuit het contextmenu
kunt u bĳvoorbeeld:

• Het formulier Object bekĳken
• Naar object inzoomen
• Kopieer object: Kopieer alle geometrie en attributen van het object
• Object selecteren aan/uit: Voegt geïdentificeerde object toe aan selectie
• Attribuutwaarde kopiëren: Kopieert alleen de waarde van het attribuut waar u op klikt
• Objectattributen kopiëren: Kopieert de attributen van het object
• Objecten selecteren op waarde attribuut: Selecteer alle objecten op de laag die overeenkomen met het
geselecteerde attribuut

• Wis resultaat: Het scherm Identificatieresultaten wordt leeggemaakt
• Wis accentueren: Verwĳdert objecten die geaccentueerd waren op de kaart
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• Alles accentueren
• Laag accentueren
• Activeer laag: Kies een laag die moet worden geactiveerd
• Laageigenschappen: Opent het menu Laageigenschappen
• Alles uitklappen
• Alles inklappen

12.5 Laageigenschappen opslaan en delen

12.5.1 Aangepaste stijlen beheren

Wanneer een vectorlaag wordt toegevoegd aan het kaartvenster, gebruikt QGIS standaard een willekeurig
symbool/kleur om de objecten daarvan te renderen. U kunt echter een standaard symbool instellen in Project ►
Eigenschappen… ► Standaard stĳlen dat zal worden toegepast op elke nieuw toegevoegde laag, overeenkomstig het
type geometrie.
Maar meestal zult u echter de voorkeur hebben voor een aangepaste en meer complexe stĳl die automatisch of
handmatig kan worden toegepast op de lagen (met minder inspanningen). U kunt dit bereiken met het menu Stĳl
aan de onderzĳde van het dialoogvenster Laageigenschappen. Dit menu verschaft u functies om stĳlen te maken, te
laden en te beheren.
Een stĳl bevat alle informatie die is ingesteld in het dialoogvenster Laageigenschappen om te renderen of voor de
interactie met de laag (inclusief instellingen voor symbologie, labelen, definities voor velden en formulieren, acties,
diagrammen…) voor vectorlagen, of de pixels (band of renderen van de kleur, transparantie, piramiden, histogram
…) voor rasters.

Fig. 12.12: Opties combinatievak Vectorlaagstijl
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Standaard wordt de stĳl, die wordt toegepast op een geladen laag, standaard genoemd. Als u eenmaal de ideale
en toepasselĳke rendering voor uw laag heeft, kunt u die opslaan door te klikken op het combinatievak Stĳl en
kiezen:

• Huidige hernoemen: De actieve stĳl wordt hernoemd en bĳgewerkt naar de huidige opties
• Toevoegen: Een nieuwe stĳl wordt gemaakt met behulp van de huidige opties. Standaard zal die worden
opgeslagen in het projectbestand van QGIS. Zie hieronder om de stĳl in een ander bestand of een database
op te slaan

• Verwĳderen: Verwĳder een niet langer gewenste stĳl, voor het geval u meer dan één stĳl hebt gedefinieerd
voor de laag.

Onder in de keuzelĳst van Stĳl ziet u de ingestelde stĳlen voor de laag en de actieve is geselecteerd.
Onthoud dat elke keer dat u het dialoogvenster Laageigenschappen valideert, de actieve stĳl wordt bĳgewerkt met de
wĳzigingen die u heeft gemaakt.
U mag net zoveel stĳlen maken als u wilt voor een laag, maar er kan er slechts één per keer actief zĳn. Gecombineerd
met Kaartthema’s, biedt dit een snelle en krachtige manier om complexe projecten met een paar lagen te beheren,
zonder de noodzaak om een laag in de legenda van de kaart te dupliceren.

Notitie: Gegeven het feit dat elke keer als u wĳzigingen toepast op de eigenschappen van de laag, wĳzigingen worden
opgeslagen in de actieve stĳl, zorg er altĳd voor dat u de juiste stĳl bewerkt om te vermĳden dat een stĳl wĳzigt die
wordt gebruikt in een kaartthema.

Tip: Stĳlen beheren vanuit het contextmenu van de laag
Klik met rechts op de laag in het paneel Lagen om stĳlen voor een laag te kopiëren, te plakken, toe te voegen of te
hernoemen.

12.5.2 Stijlen opslaan in een bestand of een database

Waar gemaakte stĳlen vanuit het combinatievak Stĳl standaard worden opgeslagen binnen het project en van laag naar
laag worden geplakt binnen het project, is het ook mogelĳk om ze buiten het project op te slaan, zodat zĳ in een ander
project kunnen worden geladen.

Opslaan als tekstbestand

Door te klikken op het menu Stĳl ► Stĳl opslaan, kunt u de stĳl opslaan als een:
• QGIS laagstĳlbestand (.qml)
• SLD-bestand (.sld), alleen beschikbaar voor vectorlagen

Gebruikt bĳ op bestanden gebaseerde laagindelingen (.shp, .tab…), maakt Als standaard opslaan een .qml-
bestand naast de laag (met dezelfde naam). SLD’s kunnen worden geëxporteerd uit elk type renderer – Enkel symbool,
Categorieën, Gradueel of Regel-gebaseerd – maar bĳ het importeren van een SLD, wordt ofwel een Enkel symbool
of Regel-gebaseerde renderer gemaakt. Dit betekent dat stĳlen van Categorieën of Gradueel worden geconverteerd
naar Regel-gebaseerd. Indien u deze renderers wilt behouden, dient u de indeling QML te gebruiken. Aan de andere
kant kan het soms zeer handig zĳn om deze eenvoudige manier te hebben voor het converteren van stĳlen naar regel-
gebaseerd.
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Opslaan in database

Stĳlen voor vectorlagen kunnen ook worden opgeslagen in een database als de gegevensbron voor de laag een provider
voor een database is. Ondersteunde indelingen zĳn PostGIS, GeoPackage, SpatiaLite, MS SQL Server en Oracle. De
laagstĳl wordt opgeslagen in een tabel (genaamd layer_styles) in de database. Klik op het item Stĳl opslaan…
► Opslaan in database en vul het dialoogvenster in om een stĳlnaam te definiëren, een beschrĳving toe te voegen,
een .ui-bestand, indien van toepassing, en selecteer of de stĳl de standaardstĳl zou moeten zĳn.
U kunt verschillende stĳlen voor één enkele tabel opslaan in de database. Elke tabel kan echter maar één standaardstĳl
hebben. Standaardstĳlen kunnen worden opgeslagen in de database van de laag of in qgis.db, een lokale database
van SQLite in de actieve map van het gebruikersprofiel.

Fig. 12.13: Dialoogvenster Stijl in database opslaan

Tip: Bestanden van stĳlen delen tussen databases
U kunt uw stĳl alleen maar opslaan in een database als de laag afkomstig is uit een dergelĳke database. U kunt
databases niet mixen (bĳvoorbeeld laag in Oracle en stĳl in MS SQL Server). Gebruik in plaats daarvan een bestand
met platte tekst als u de stĳl wilt delen tussen databases.

Notitie: U zou problemen tegen kunnen komen bĳ het herstellen van de tabel layer_styles uit een back-up van
een database van PostgreSQL. Volg QGIS tabel layer_style en back-up database om dat te repareren.

Stijl laden

Bĳ het laden van een laag in QGIS, als een standaardstĳl al bestaat voor deze laag, zal QGIS de laag met die stĳl
laden. Ook Stĳl ► Standaard herstellen zoekt naar en laadt dat bestand en vervangt de huidige stĳl van de laag.
Stĳl ► Stĳl laden helpt u bĳ het toepassen van een opgeslagen stĳl op een laag. Waar een stĳl uit een tekstbestand
(.sld of .qml) kan worden toegepast op elke laag, ongeacht de indeling, is het laden van stĳlen die zĳn opgeslagen
in een database alleen mogelĳk als de laag uit dezelfde database komt of als de stĳl is opgeslagen in de lokale database
van QGIS.
Het dialoogvenster Stĳlen database beheren geeft een lĳst weer met gerelateerde stĳlen voor de laag die zĳn gevonden
in de database en alle andere stĳlen die daarin zĳn opgeslagen, met naam en beschrĳving.

Tip: Snel een laagstĳl delen in het project
U kunt ook laagstĳlen delen in een project zonder een bestands- of databasestĳl te importeren: klik met rechts op de
laag in het paneel Lagen en kopieer, uit het combinatievak Stĳlen, de stĳl van een laag en plak die in een groep of een
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selectie van lagen: de stĳl wordt toegepast op alle lagen die van hetzelfde type zĳn (vector vs raster) als de originele
laag en, in het geval van vectorlagen, hetzelfde type geometrie hebben (punt, lĳn of polygoon).

12.5.3 Laag-definitiebestand

Laag-definities kunnen worden opgeslagen als een Laag-definitiebestand (.qlr) met Exporteren ►
Opslaan als Laag-definitiebestand… in het contextmenu van de actieve laag. Een laag-definitiebestand (.qlr) bevat
verwĳzingen naar de gegevensbron van de lagen en hun stĳlen. .qlr-bestanden worden weergegeven in het paneel
Browser en kunnen worden gebruikt om de lagen (met de opgeslagen stĳl) toe te voegen aan het paneel Lagen. U
kunt .qlr-bestanden ook slepen en neerzetten, vanuit de bestandsbeheerder van het systeem, in het kaartvenster.

12.6 Uw gegevens documenteren

In aanvulling op het weergeven en symboliseren van de gegevens in de lagen, stelt QGIS u in staat om te vullen:
• metadata: informatie om mensen te helpen de gegevensset te zoeken en te begrĳpen, hoe zĳ er toegang to
krĳgen en hem kunnen gebruiken… Dit zĳn eigenschappen van de databron en kunnen buiten het project van
QGIS leven.

• opmerkingen: instructies en commentaren met betrekking tot de laag in het huidige project

12.6.1 Metadata

In het dialoogvenster van de laageigenschappen verschaft de tab Metadata u opties om een rapport voor metadata
op uw laag te maken en te bewerken.
Informatie om in te vullen omvat:

• de gegevens Identificeren: basis naamsvermelding van de gegevensset (ouder-ID, identificatie, titel, abstract,
taal…);

• de Categorieën waartoe de gegevens behoren. Naast de ISO-categorieën kunt u aangepaste toevoegen;
• de Sleutelwoorden om de gegevens op te halen en geassocieerde concepten die een op een standaard gebaseerd
woordenboek gebruiken;

• de Toegang tot de gegevensset (licenties, rechten, kosten, en beperkingen);
• het Bereik van de gegevensset, ofwel een ruimtelĳk (CRS, kaartbereik, hoogtes) of tĳdgebonden;
• het Contact voor de eigenaar van de gegevensset;
• de Links naar bĳbehorende bronnen en gerelateerde informatie;
• de Geschiedenis van de gegevensset.

Een overzicht van de ingevulde informatie wordt verschaft op de tab Validatie en helpt u potentiële problemen in
relatie tot het formulier te identificeren. U kunt ze ofwel repareren of ze negeren.
Metadata worden standaard opgeslagen in het projectbestand, het keuzemenu Metadata biedt opties voor het
laden/opslaan van metadata vanuit een bestand .qmd en voor het laden/opslaan van metadata op de locatie
“Standaard”.

194 Hoofdstuk 12. Algemeen gereedschap



QGIS Desktop 3.28 User Guide

Fig. 12.14: Opties laden/opslaan metadata

De locatie “Standaard” gebruikt door Als standaard opslaan en Standaard herstellen wĳzigen, afhankelĳk van de
onderliggende databron en diens configuratie:

• Voor databronnen van PostgreSQL, als de optie voor configuratie Opslaan/laden in de database van metadata
van QGIS-laag toestaan is geselecteerd worden de metadata opgeslagen in een aangewezen tabel in de database.

• Voor databronnen van GeoPackage slaat Als standaard opslaan altĳd de metadata op in de interne tabellen
voor metadata van het GeoPackage.
Als metadata wordt opgeslagen in de interne tabellen van PostgreSQL of GeoPackage worden zĳ beschikbaar
voor zoeken en filteren in de browser en in het paneel Laag metadata zoeken.

• Voor alle andere op bestanden gebaseerde databronnen slaat Als standaard opslaan de metadata op in een
bestand .qmd, naast het bestand.

• In alle andere gevallen slaat Als standaard opslaan de metadata op in een lokale database van .sqlite.

12.6.2 Opmerkingen laag

Opmerkingen voor lagen stellen u in staat de laag te documenteren binnen het huidige project. Zĳ kunnen worden
gebruikt om belangrĳke berichten voor gebruikers van het project op te slaan, zoals “to do”-lĳsten, instructies,
waarschuwingen, …
Selecteer, vanuit het contextmenu van de laag in het paneel Lagen,Opmerkingen laag toevoegen… en vul het geopende
dialoogvenster met de nodige teksten.
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Fig. 12.15: Opmerkingen toevoegen aan een laag

Het dialoogvenster Opmerkingen laag toevoegen verschaft een op HTML gebaseerd, meerregelig tekstvak met een
volledige set gereedschappen voor:

• manipuleren van tekst: knippen, kopiëren, plakken, ongedaan maken, opnieuw
• opmaken van tekens, toegepast op alle delen van de inhoud: grootte lettertype en kleur, vet, cursief,
onderstreept, doorgehaald, achtergrondkleur, URL accentuering

• structureren van alinea’s: lĳsten met opsommingstekens en genummerde lĳsten, inspringen, vooraf
gedefinieerde koppen

• invoegen van bestand, zelfs met slepen en neerzetten
• bewerken met codering voor HTML

Vanuit de keuzelĳst… aan de uiterste rechterkant van de werkbalk, kunt u:
• Alle opmaak verwĳderen

• Opmaak tekens verwĳderen

• Alle inhoud opruimen

In het paneel Lagen wordt aan een laag met een opmerking het pictogram toegewezen, dat, als er overheen wordt
gegaan, de opmerking weergeeft. Klik op het pictogram om de opmerking te bewerken. U kunt ookmet rechts klikken
op de laag en Opmerkingen laag bewerken… of Opmerkingen laag verwĳderen.

Notitie: Opmerkingen zĳn deel van de laagstĳl en kunnen worden opgeslagen in het bestand .qml of .qlr. Zĳ
kunnen ook worden verplaatst van de ene laag naar een andere door de laagstĳl te kopiëren-plakken.

12.7 Waarden opslaan in Variabelen

In QGIS kunt u variabelen gebruiken om nuttige terugkerende waarden op te slaan (bĳv. de titel van het project, of de
volledige naam van de gebruiker) die in expressies kunnen worden gebruikt. Variabelen kunnen worden gedefinieerd
op het globale niveau van de toepassing, op projectniveau, laagniveau, niveau van Grafische modellen maken in
Processing, lay-outniveau, en lay-out-itemniveau. Net als regels voor CSS cascading, kunnen variabelen worden
overschreven - bĳv. een variabele op projectniveau zal variabelen op het niveau van de globale toepassing overschrĳven
die zĳn ingesteldmet dezelfde naam.U kunt deze variabelen gebruiken om tekenreeksen van tekst te bouwen of andere
aangepaste expressies met het teken @ vóór de naam van de variabele. Bĳvoorbeeld in afdruklay-out een label maken
met deze inhoud:
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This map was made using QGIS [% @qgis_version %]. The project file for this
map is: [% @project_path %]

Zal het label renderen zoals hier:

This map was made using QGIS 3.4.4-Madeira. The project file for this map is:
/gis/qgis-user-conference-2019.qgs

Naast de Voorkeuze Alleen-lezen variabelen kunt u uw eigen aangepaste variabelen voor elk van de bovenvermelde
niveaus definiëren. U kunt beheren:

• globale variabelen vanuit het menu Extra ► Opties

• projectvariabelen vanuit het dialoogvenster Projecteigenschappen (zie Projecteigenschappen)
• variabelen voor vectorlagen vanuit het dialoogvenster Laageigenschappen (zie Het dialoogvenster

Vectoreigenschappen);
• model-variabelen vanuit het dialoogvenster Grafische modellen ontwerpen (bekĳk Grafische modellen

ontwerpen);
• variabelen voor lay-out vanuit het paneel Lay-out in afdruklay-out (zie Het paneel Lay-out);
• en variabelen voor items van lay-out vanuit het paneel Item-eigenschappen in afdruklay-out (zie Algemene

opties items Lay-out).
Voor het onderscheiden van bewerkbare variabelen worden waarden en namen van variabelen die Alleen-lezen zĳn
cursief weergegeven. Aan de andere kant worden variabelen op een hoger niveau die worden overschreven door
variabelen van een lager niveau doorgestreept.
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Fig. 12.16: Bewerker voor variabelen op projectniveau

Notitie: U kunt meer informatie over variabelen en enkele voorbeelden vinden in blogposten van Nyall Dawson:
Exploring variables in QGIS 2.12, part 1, part 2 en part 3.

12.8 Authenticatie

QGIS heeft faciliteiten om gegevens voor authenticatie op een beveiligde manier op te slaan/op te halen. Gebruikers
kunnen hun gegevens beveiligd opslaan in configuraties voor authenticatie, die in een draagbare database worden
opgeslagen, kunnen worden toegepast op server- of databaseverbindingen, en waarnaar veilig kan worden verwezen
door hun tokens voor ID in project- of instellingsbestanden. Bekĳk voor meer informatie Authenticatiesysteem.
Een hoofdwachtwoord moet worden ingesteld bĳ het initialiseren van het systeem voor authenticatie en de draagbare
database daarvan.
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12.9 Veel voorkomende widgets

In QGIS zĳn enkele opties waarmee u zeer vaak zult moeten werken. Voor het gemak verschaft QGIS u speciale
widgets die hieronder worden weergegeven.

12.9.1 Kleur selecteren

Het dialoogvenster Kleuren

Het dialoogvenster Kleur selecteren zal verschĳnen als u op het pictogram klikt om een kleur te
kiezen. De mogelĳkheden van dit dialoogvenster zĳn afhankelĳk van de status van het keuzevak voor de parameter
Eigen dialoogvenster voor kleurkeuze gebruiken in het menu Extra ► Opties… ► Algemeen. Indien geselecteerd is het
gebruikte dialoogvenster dat van het gebruikte besturingssysteem waarop QGIS wordt uitgevoerd. Anders wordt de
voor QGIS aangepaste kleurenkiezer gebruikt.
Het dialoogvenster Aangepaste kleur kiezen heeft vier verschillende tabs die u in staat stellen een kleur te kiezen
vanuit Kleurverloop, Kleurenwiel, Kleurenwaaiers of Kleur overnemen. Met de eerste twee tabs kunt u naar alle
mogelĳke kleurcombinaties bladeren en uw keuze op het item toepassen.

Fig. 12.17: Tab Kleurenbalk

Op de tab Kleurenwaaier kunt u kiezen uit een lĳst kleurenpaletten (bekĳk Kleurinstellingen voor details).
Met uitzondering van het palet Recente kleuren kunnen alle paletten worden aangepast met de knoppen
Huidige kleur toevoegen en Geselecteerde kleur verwĳderen aan de onderzĳde van het frame.
De knop… naast het combinatievak van de paletten biedt ook verscheidene opties om:

• kopiëren, plakken, kleuren importeren of exporteren
• kleurpaletten te maken, te importeren of te verwĳderen
• het aangepaste kleurenpalet toe te voegen aan de widget Kleur selecteren met het item Als kleurknoppen

weergeven (zie Fig. 12.19)
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Fig. 12.18: Tab Kleurenwaaiers

Een andere optie is om Kleur overnemen te gebruiken, dat u in staat stelt een monster van een kleur te nemen van
onder uwmuiscursor vanuit een willekeurig deel vanQGIS of zelfs vanuit een andere toepassing: druk op de spatiebalk
terwĳl de tab actief is, plaats de muis boven de gewenste kleur en klik er op of druk opnieuw op de spatiebalk. U
kunt ook op de knop Voorbeeldkleur drukken om Kleur overnemen te activeren.
Welke methode u ook gebruikt, de geselecteerde kleur wordt altĳd beschreven door middel van kleurschuiven voor
HSV- (Hue, Saturation, Value) en waarden RGB (Rood, Groen, Blauw). De kleur is ook te identificeren als een
HTML-notatie.
Aanpassen van een kleur is zo eenvoudig als het klikken op het kleurenwiel of kleurverloop of op een van de
schuifbalken voor de parameters van de kleuren. U kunt dergelĳke parameters aanpassen met het draaivak ernaast of
door met het muiswiel over de overeenkomstige schuifbalk te scrollen. U kunt ook de HTML-notatie voor de kleur
opgeven. Tenslotte is er ook een schuifbalk voor Doorzichtbaarheid om het niveau van transparantie in te stellen.
Het dialoogvenster verschaft ook een visuele vergelĳking tussen deOude kleur (toegepast op het object) en deHuidige

kleur (die geselecteerd wordt). Met slepen en neerzetten of te drukken op de knop Kleur aan kleurenwaaier toevoegen,
kunnen deze kleuren worden opgeslagen in een vak voor gemakkelĳke toegang.

Tip: Snel aanpassen van kleuren
Slepen en neerzetten van een widget Kleur selecteren op een ander om zĳn kleur toe te passen.
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De sneltoets voor keuzelijst Kleur

Klik op de pĳl aan de rechterzĳde van knop voor het kleurenvak om een widget weer te geven
voor het snel selecteren van een kleur. Deze sneltoets biedt toegang tot:

• een kleurenwiel om een kleur uit te kiezen
• een schuifbalk voor alfa om de doorzichtbaarheid van de kleur te wĳzigen
• de eerder ingestelde kleurpaletten in Als kleurknoppen weergeven

• kopieer de huidige kleur en plak die in een ander widget
• kies een kleur ergens vanaf uw computerscherm
• kies een kleur uit het dialoogvenster Kleur selecteren
• slepen-en-neerzetten van een kleur van de ene widget naar een ander om snel te aan te passen

Tip: Scroll het muiswiel over een widget voor het selecteren van kleur om snel de opaciteit van de geassocieerde
kleur aan te passen.

Notitie: Als de widget Kleur is ingesteld op een projectkleur via de eigenschappen Data-bepaalde ‘override’, zĳn de
hierboven vermelde functies voor het wĳzigen van de kleur niet beschikbaar. U moet eerst Kleur ontkoppelen of de
definitie Leegmaken.

Fig. 12.19: Menu Snel kleur kiezen
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De sneltoets voor keuzelijst Kleurverloop

Kleurverlopen zĳn een praktische manier om een set kleuren toe te voegen op een of meerdere objecten. Het maken
ervan wordt beschreven in het gedeelte Een kleurverloop instellen. Net als voor de kleuren opent het drukken op de
knop Kleurverloop het overeenkomende dialoogvenster voor het type kleurverloop, wat u in staat
stelt de eigenschappen ervan te wĳzigen.

Fig. 12.20: Aanpassen van een ColorBrewer kleurverloop

Het keuzemenu aan de rechterkant van de knop geeft snel toegang tot een bredere set kleurverlopen en opties:
• Kleurverloop omdraaien

• Huidig kleurverloop leegmaken om een aan de widget toegewezen kleurverloop ongedaan te maken (alleen
beschikbaar in bepaalde contexten)

• Willekeurige kleuren: alleen beschikbaar in sommige contexten (bĳv. wanneer een kleurverloop wordt
gebruikt voor symbologie van een laag), selecteren van dit itemmaakt en past een kleurverloopmet willekeurige
kleuren toe. Het schakelt ook een item Willekeurige kleuren wisselen in om opnieuw een kleurverloop met
willekeurige kleuren te maken als de huidige niet naar wens is.

• een voorbeeld van het kleurverloop of kleurverlopen catalog: cpt-city gevlagd als Favorieten
in het dialoogvenster Stĳlmanager

• Alle kleurverlopen om toegang te krĳgen tot de database met compatibel kleurverlopen
• Nieuw kleurverloop maken… van een ondersteund type dat kan worden gebruikt in het huidige widget (onthoud
dat dit kleurverloop niet ergens anders beschikbaar zal zĳn, tenzĳ u het opslaat in de bibliotheek)

• Kleurverloop bewerken…, hetzelfde als klikken op de knop van het gehele kleurverloop
• Kleurverloop opslaan… om het huidige kleurverloop met zĳn aanpassingen op te slaan in de stĳlbibliotheek
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Fig. 12.21: Widget Snel kleurverloop selecteren

12.9.2 Widget Symbool

De widget voor selectie van het Symbool is een handige sneltoets wanneer u symbooleigenschappen voor een object
wilt instellen. Klikken op de pĳl van het keuzemenu geeft de volgende opties voor het symbool weer, samen met de
mogelĳkheden voor de widget keuzemenu Kleur:

• Symbool configureren…: hetzelfde als drukken op de widget Symbool selecteren. Het opent een dialoogvenster
om de parameters voor het symbool in te stellen.

• Symbool kopiëren vanuit het huidige item
• Symbool plakken naar het huidige item, versnelt configuratie
• Huidig symbool leegmaken om een aan de widget toegewezen kleurverloop ongedaan te maken (alleen
beschikbaar in bepaalde contexten)

Tip: Scroll het muiswiel over een widget voor een symbool voor markering of lĳnsymbool om snel de grootte van
het geassocieerde symbool aan te passen.

12.9.3 Bestand op afstand of ingebed bestand selecteren

Naast de widget voor het selecteren van bestanden zal de knop … soms een keuzepĳl laten zien. Die is gewoonlĳk
beschikbaar bĳ het gebruiken van:

• een bestand SVG in een symbool of een label
• een rasterafbeelding om symbolen, labels, texturen of decoraties aan te passen

Drukken op de pĳl zal u een menu verschaffen om:
• het bestand te laden vanaf het bestandssysteem: het bestand wordt geïdentificeerd door het bestandspad en
QGIS moet het pad oplossen om de overeenkomende afbeelding te kunnen laten zien
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• het bestand te laden vanaf een URL op afstand: zoals hierboven, de afbeelding zal alleen worden geladen na
succesvol ophalen vanaf de bron op afstand

• het bestand in het item in te bedden: het bestand wordt ingebed in het huidige project, stĳldatabase, of sjabloon
van afdruklay-out. Het bestand wordt dan altĳd gerenderd als deel van het item. Dit is een handige manier om
zelf-bevattende projecten met aangepaste symbolen te maken die eenvoudig kunnen worden gedeeld tussen
verschillende gebruikers en installaties van QGIS.

• het ingebedde bestand uitnemen uit de widget en het opslaan op schĳf.

12.9.4 Schaal zichtbaarheid selecteren

Het selecteren van de schaal voor de zichtbaarheid bevat opties om de schalen te beheren waarop een element zichtbaar
zal worden gemaakt in het kaartvenster. Buiten het gespecificeerde bereik aan schalen worden de elementen niet
weergegeven. Het kan, bĳvoorbeeld, worden toegepast op lagen, labels of diagrammen, vanaf de tab Renderen van
hun eigenschappen.

1. Selecteer het vak Schaalafhankelĳke zichtbaarheid

2. Vul het vak Minimum (exclusief) met de meest uitgezoomde gewenste schaal, typ de waarde of selecteer die
uit de vooraf gedefinieerde schalen

3. en/of vul het vak Maximum (inclusief) met de meest ingezoomde gewenste waarde schaal

De knop Op huidige schaal kaartvenster instellen naast de vakken voor de schalen stelt de schaal van het huidige
kaartvenster in als grens voor het bereik van de zichtbaarheid. Druk op de pĳl naast de knop om toegang te
krĳgen tot schalen van lay-outs en die opnieuw gebruiken om het vak te vullen.

Fig. 12.22: Widget Schaal zichtbaarheid selecteren

12.9.5 Ruimtelijk bereik selecteren

De widget voor selecteren van Bereik is een handige sneltoets wanneer u een ruimtelĳk bereik wilt selecteren om aan
een laag toe te wĳzen of om de uit te voeren acties te beperken. Afhankelĳk van de context, biedt het selectie tussen:

• Huidig laagbereik: bĳv. bĳ exporteren van een laag
• Uit laag berekenen ►: gebruikt het bereik van een laag die in het huidige project is geladen
• Huidige Bereik kaartvenster gebruiken
• In kaartvenster tekenen: een rechthoek waarvan dan de coördinaten worden gebruikt
• Berekenen uit Favoriete plaats: gebruikt het bereik van een opgeslagen Favoriete plaats

• Berekenen uit kaart afdruklay-out: gebruikt het bereik van een afdruklay-out kaart

• Voer de coördinaten in of bewerk ze als xmin, xmax, ymin, ymax
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Fig. 12.23: Widget Bereik selecteren

12.9.6 Lettertype selecteren

De widget voor het selecteren van het Lettertype is een handige sneltoets wanneer u eigenschappen voor lettertypen
wilt instellen voor tekstuele informatie (labels van objecten, labels voor decoraties, tekst voor de legenda van de kaart,
…). Klikken op de pĳl voor het keuzemenu geeft sommige of alle volgende opties weer:

Fig. 12.24: Keuzemenu Lettertype selecteren

• Huidige tekstindeling leegmaken om een aan de widget toegewezen tekstindeling ongedaan te maken (alleen
beschikbaar in bepaalde contexten)

• Lettertype grootte in de geassocieerde eenheid
• Recente lettertypen ► menu met het actieve lettertype aangevinkt (bovenin)
• Opmaak configureren…: hetzelfde als drukken op de widget Lettertype selecteren. Het opent een dialoogvenster
om parameters voor het opmaken van tekst in te stellen. Afhankelĳk van de context kan dat het van het
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besturingssysteem afhankelĳke standaard dialoogvenster Tekst opmaken zĳn of het aangepaste dialoogvenster
van QGISmet geavanceerde opties voor opmaken (doorzichtbaarheid, oriëntatie, buffer, achtergrond, schaduw,
…) zoals beschreven in het gedeelte De tekst van het label opmaken.

• Opmaak kopiëren van de tekst
• Opmaak plakken naar de tekst, versnelt configuratie
• de widget Kleur selecteren om het bewerken van kleuren sneller te maken

Tip: Scroll het muiswiel over een widget voor het selecteren van lettertype om snel de grootte van de geassocieerde
tekst aan te passen.

12.9.7 Eenheid selecteren

Eigenschappen voor de grootte van items (labels, symbolen, elementen van lay-out, …) in QGIS zĳn niet
noodzakelĳkerwĳze gebonden aan ofwel de eenheden voor het project of de eenheden van een bepaalde laag. Voor een
grote set eigenschappen stelt het keuzemenu voor het selecteren van Eenheid u in staat hun waarden aan te passen,
al naar gelang de rendering die u wilt (gebaseerd op schermresolutie, papiergrootte, of het terrein). Beschikbare
eenheden zĳn:

• Millimeters

• Punten

• Pixels

• Inches

• Percentage: staat u toe sommige eigenschappen in te stellen als een percentage van een ander. Dit is
bĳvoorbeeld nuttig voor hetmaken van tekstindelingenwaar de componenten (grootte buffer, straal schaduw…)
netjes worden geschaald als de grootte van de tekst wordt gewĳzigd, in plaats van constante grootte voor
buffer/schaduw te hebben. Dus u hoeft deze groottes niet aan te passen als de grootte van de tekst wĳzigt.

• Meters op schaal: Dit stelt u in staat de grootte altĳd in te stellen op meters, ongeacht wat de onderliggende
kaarteenheden zĳn (zĳ kunnen bĳv. in inches, feet, geografische graden zĳn…). De grootte in meters wordt
berekend, gebaseerd op de huidige instelling van de ellipsoïde voor het project en een projectie van de afstanden
in meters in het midden van het huidige kaartbereik. Voor kaarten in een geprojecteerd coördinatensysteem
wordt dit berekend met geprojecteerde eenheden. Voor kaarten in een geografisch (latitude/longitude)
gebaseerd systeem wordt de grootte in meters benaderd door het berekenen van de grootte in meters met
ellipsoïde berekeningen voor de verticale schaal van de kaart.

• enKaarteenheden: De grootte wordt geschaald overeenkomstig de schaal van de kaartweergave. Gebruik, omdat
dit kan leiden tot te grote of te kleine waarden, de knop naast het item om de grootte te beperken tot een
bereik van waarden, gebaseerd op:

– DeMinimum schaal en deMaximum schaal: De waarde wordt geschaald, gebaseerd op de schaal van de
kaartweergave, totdat u één van deze begrenzingen van de schaal bereikt. Buiten het bereik van de schaal
wordt de waarde van de dichtstbĳzĳnde limiet voor de schaal aangehouden.

– en/of De Minimum grootte en de Maximum grootte in mm: De waarde wordt geschaald, gebaseerd op de
schaal van de kaartweergave totdat het een van deze grenzen bereikt; Dan wordt de grootte van de limiet
aangehouden.
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Fig. 12.25: Dialoogvenster voor aanpassen schaalbereik

12.9.8 Opgemaakte getallen

Opgemaakte getallen maakt het opmaken voor het weergeven van numerieke waarden mogelĳk, met een variëteit
aan verschillende technieken voor opmaak (bĳvoorbeeld wetenschappelĳke notatie, valutawaarden, waarden als
percentage, etc). Een manier voor gebruik is om de tekst van een schaalbalk in een lay-out of vaste tabel in te stellen.

Fig. 12.26: Numerieke waarde opmaken

Verschillende categorieën voor opmaak worden ondersteund. Voor de meeste daarvan kunt u enkele of alle volgende
numerieke opties instellen:

• Scheidingsteken duizendtallen weergeven

• Plusteken weergeven

• Achterliggende nullen weergeven

Maar zĳ kunnen ook hun aangepaste instellingen hebben. Verschafte categorieën zĳn:
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• Algemeen, de standaard categorie: heeft geen instelling en geeft waarden weer zoals ingesteld in de ouderwidget
Eigenschappen of met de globale instellingen.

• Getal

– De waarde kan worden Afgerond tot een zelf gedefinieerd aantal Decimale plaatsen of hun Significante
getallen

– aanpassen van het Scheidingsteken duizendtallen en Decimaal scheidingsteken

• Richting voor een tekstweergave van een richting/graden met:
– Indeling: mogelĳke bereiken van waarden zĳn 0 tot en met 180°, met voorvoegsel O/W,
-180 tot en met +180° en 0 tot en met 360°

– aantal Decimale plaatsen

• Valuta voor een tekstweergave van een valutawaarde.
– Voorvoegsel

– Achtervoegsel

– aantal Decimale plaatsen

• Fractie voor een platte fractionele weergave van een decimale waarde (bĳv. 1/2 in plaats van 0.5)

– Unicode super/subscript gebruiken om weer te geven. Bĳvoorbeeld 1/2 in plaats van 1/2

– Toegewezen Unicode-tekens gebruiken

– het Scheidingsteken duizendtallen aanpassen
• Percentage - voegt % toe aan de waarden, met instellen van:

– aantal Decimale plaatsen

– Schaal om aan te geven of de feitelĳke waarden al percentages weergeven (dan worden zĳ behouden zoals
zĳ zĳn) of fracties (dan worden zĳ geconverteerd)

• Wetenschappelĳk notatie in de vorm 2.56e+03. Het aantal Decimale plaatsen kan worden ingesteld.
Een levend voorbeeld van de instellingen wordt weergegeven in het gedeelte Voorbeeld.

12.9.9 Meng-modi

QGIS biedt verschillende opties voor speciale effecten voor renderen met deze gereedschappen die u eerder mogelĳk
alleen kende vanuit grafische programma’s. Meng-modi kunnen worden toegepast op lagen en objecten, en ook op
items van afdruklay-out:

• Normaal: Dit is de standaard mengmodus die het alfakanaal van de bovenliggende pixel mengt met de pixel
eronder. De kleuren worden niet gemengd.

• Lichter maken: Deze selecteert de maximumwaarden van de pixels van de voor- en achtergrond. Het resultaat
is vaak ruw, grof en kartelig.

• Screen: Lichte pixels van de bronlaag worden getekend over de doellaag, terwĳl dat niet gebeurt met donkere
pixels. Deze modus is geschikt voor het mengen van de textuur van de ene laag met die van een andere laag.
(zoals om schaduwen van heuvels te maken in een andere laag).

• Dodge: Onderliggende pixels feller maken en met meer kleur, gebaseerd op de helderheid van de bovenste
pixel. Heldere pixels bovenop zorgen er voor dat de verzadiging en helderheid van de onderliggende pixels
wordt verhoogd. Dit werkt het beste wanneer de bovenste pixels niet te fel zĳn. Anders wordt het resultaat te
extreem.

• Toevoegen: Telt de waarde van de pixel van de ene laag op bĳ de andere. Wanneer de waarden boven de
maximale waarde (in het geval van RGB) uitkomen, zal wit worden weergegeven. Deze modus is geschikt om
objecten te accentueren.
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• Donkerder maken: Behoudt de laagste waarden van elke component van de pixels van voor- en achtergrond.
Net zoals bĳ de modus Lichter maken, neigen de resultaten naar ruw, grof en gekarteld.

• Vermenigvuldigen: Pixelwaarden van het bovenste item worden vermenigvuldigd met de overeenkomende
waarden van het onderste item. De resultaten zĳn donkerder.

• Branden: Donkere kleuren in de toplaag zorgen ervoor dat onderliggende lagen ook donkerder worden. Branden
kan worden gebruikt om de kleuren van onderliggende lagen bĳ te stellen.

• Overlay: Combineert de mengmodi vermenigvuldigen en screen. Lichtere delen worden lichter en donkere
delen worden donkerder.

• Zacht licht: Lĳkt erg op overlay, maar in plaats van de combinatie vermenigvuldigen/screenwordt de combinatie
branden/dodge gebruikt. Hiervan wordt verwacht het effect na te bootsen van het schĳnen van een zacht licht
op een afbeelding.

• Hard licht: Hard licht lĳkt op de modus overlay. Deze moet ervoor zorgen dat het lĳkt of er een sterk licht
schĳnt op het kaartvenster.

• Verschil: Trekt de waarde van de bovenste pixel van de onderliggende pixel af of omgekeerd, zodat er altĳd een
positieve waarde ontstaat. Het mixen met zwart levert geen wĳziging op, omdat het verschil voor alle kleuren
nul is.

• Aftrekken: Trekt de waarde van de pixel van de ene laag af van de andere. In het geval van negatieve waarden
wordt zwart weergegeven.

Fig. 12.27: Voorbeelden van mengmodi, toegepast op een groen object bovenop een oranje
Van boven naar beneden, van links naar rechts: Normaal – Lichter maken, Screen, Dodge, Toevoegen – Verschil, Aftrekken –

Donkerder maken, Vermenigvuldigen, Branden – Overlay, Zacht licht, Hard licht

Als een laag deel uitmaakt van een groep die lagen rendert als een groep, zĳn aanvullende mengmodi beschikbaar
voor het renderen. Zĳ verschaffen methoden om het renderen van de inhoud van een laag te clippen naar de inhoud
van een tweede “maskeer”laag.

• Gemaskeerd op onder: De uitvoer is de bovenste pixel, waarbĳ de opaciteit is verkleind door die van de onderste
pixel.

• Maskeer onder: De uitvoer is de onderste pixel, waarbĳ de opaciteit is verkleind met die van de bovenste pixel.
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• Gemaskeerd op onder omdraaien: De uitvoer is de bovenste pixel, waarbĳ de opaciteit is verkleind met die van
het omdraaien van de onderste pixel.

• Maskeer onder omdraaien: De uitvoer is de onderste pixel, waarbĳ de opaciteit is verkleind met die van het
omdraaien van de bovenste pixel.

• Kleuren binnen onder: De bovenste pixel wordt gemengd bovenop de onderste pixel, met de opaciteit van de
bovenste pixel verkleind met de opaciteit van de onderste pixel.

• Kleuren onder binnen: De onderste pixel wordt gemengd bovenop de bovenste pixel, met de opaciteit van de
onderste pixel verkleind met de opaciteit van de bovenste pixel.

Fig. 12.28: Voorbeelden van clip mengmodus, toegepast op de bovenste groene laag van een groep
A: Maskeer onder B: Maskeer op onder C: Kleuren onder binnen D: Maskeer onder omdraaien E: Maskeer op onder omdraaien

F: Kleuren binnen onder

12.9.10 Data-bepaalde ‘override’ instellen

Naast vele opties in het dialoogvenster Laageigenschappen of instellingen in afdruklay-out, zult u een pictogram
Data-bepaalde ‘override’ zien. Met expressies gebaseerd op attributen van lagen of instellingen van items, vooraf gebouwde
of aangepaste functies en variabelen, stelt dit gereedschap u in staat om een dynamische waarden voor de betrokken
parameters in te stellen. Indien ingeschakeld wordt de waarde die wordt teruggegeven door dit widget toegepast op
de parameter, ongeacht de normale waarde daarvan (keuzevak, tekstvak, schuifbalk…).

Widget Data-bepaalde ‘override’

Klikken op het pictogram Data-bepaalde ‘override’ geeft de volgende items weer:
• Omschrĳving… die aangeeft of de optie is ingeschakeld, welke invoer verwacht wordt, het geldige type voor
invoer en de huidige definitie, Door met de muis over de widget te gaan komt deze informatie ook tevoorschĳn.

• Gegevens opslaan in het project: een knop die het mogelĳk maakt de eigenschap op te slaan met het mechanisme
Eigenschappen Hulpopslag.

• Veldtype: een item om uit de velden van de laag te selecteren die overeenkomen met het geldige type voor
invoer.

• Kleur: wanneer de widget is gekoppeld aan een eigenschap voor de kleur, geeft dit menu toegang tot de
gedefinieerde kleuren, als deel van het huidige schema projectkleuren.
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• Variabele: een menu om toegang te verkrĳgen tot de beschikbare door de gebruiker gedefinieerde variabelen
• knop Bewerken… om de toe te passen expressie te maken of te bewerken met het dialoogvenster Expressie-

string bouwer. Een herinnering voor de indeling van de verwachte uitvoer wordt in het dialoogvenster gegeven
om u te helpen de expressie correct in te vullen.

• knoppen Plakken en Kopiëren.
• knop Leegmaken om de instellingen te verwĳderen.
• Voor numerieke en eigenschappen voor kleuren, Assistent… om opnieuw op schaal te brengen hoe de gegevens
van het object zullen worden toegepast op de eigenschap (meer details hieronder)

Tip: Rechtsklikken gebruiken om Data-bepaalde ‘override’ te (de)activeren

Wanneer de optie Data-bepaalde ‘override’ juist is ingesteld is het pictogram geel of . Het pictogram is rood
of als het verbroken is.

U kunt een geconfigureerde knop Data-bepaalde ‘override’ in- of uitschakelen door eenvoudigweg op de widget te
klikken met de rechterknop van de muis.

Interface Assistent Data-gedefinieerde ‘override’ gebruiken

Wanneer de knop Data-bepaalde ‘override’ is geassocieerd met een grootte, een rotatie, een doorzichtbaarheid of de
eigenschap van een kleur, heeft het een optie Assistent… die u helpt te wĳzigen hoe de gegevens worden toegepast
voor de parameter voor elk object. De assistent stelt u in staat om:

• De gegevens voor Invoer te definiëren, d.i.:

– Bron: het attribuut dat moet worden weergegeven, door middel van een veld of een expressie

– het bereik aan weer te geven waarden: u kunt handmatig de waarden invoeren of de knop
Waarde bereik uit laag ophalen gebruiken om deze velden automatisch te vullen met de minimum en maximum
waarden, teruggegeven door de expressie Bron die is toegepast op uw gegevens

• Transformatieboog toepassen: standaard worden waarden voor uitvoer (zie hieronder voor instellen)
toegepast op invoerobjecten met een lineaire schaal. U kunt deze logica overschrĳven door de optie voor
transformeren te selecteren, te klikken op de grafiek om breekpunt(en) toe te voegen en de punt(en) te slepen
om een aangepaste verdeling toe te passen.

• Definiëren van de waarden voorUitvoer: de opties variëren, afhankelĳk van de te definiëren parameter. U kunt
globaal instellen:

– voor een instelling van een kleur, het kleurverloop om toe te passen op de waarden en de enkele kleur die
moet worden gebruikt voor waarden NULL

– voor de andere, de minimum en maximum waarden die moeten worden toegepast op de geselecteerde
eigenschap, als ook de waarde voor grootte/hoek/doorzichtbaarheid voor genegeerde of NULL-
bronobjecten

– voor eigenschappen van grootte, de Methode op schaal brengen voor weergave die kan zĳn Bedekking,
Exponentieel, Oppervlakte, Straal of Lineair

– de Exponent om te gebruiken voor het op schaal brengen van de gegevens wanneer deMethode op schaal
brengen van het type exponentieel is of bĳ het aanpassen van de doorzichtbaarheid

Indien compatibel met de eigenschap wordt een live bĳgewerkt voorbeeld weergegeven aan de rechterkant van het
dialoogvenster om u te helpen bĳ het beheren van het op schaal brengen van de waarden.

12.9. Veel voorkomende widgets 211



QGIS Desktop 3.28 User Guide

Fig. 12.29: Op schaal brengen grootte van object, gebaseerd op de waarde van het veld passengers

De waarden die worden weergegeven in de assistent voor variërende grootte hierboven zullen de grootte van ‘Data-
bepaalde ‘override’’ instellen met:

coalesce(scale_exp("passengers", 9, 2000, 1, 10, 0.57), 0)

212 Hoofdstuk 12. Algemeen gereedschap



HOOFDSTUK13

Doe meer met expressies

13.1 Expressies

Gebaseerd op gegevens van lagen en vooraf gedefinieerd of als gebruikergedefinieerde functies biedenExpressies een
krachtige manier om attribuutwaarden, geometrie en variabelen te bewerken om dynamisch de stĳl van de geometrie
te wĳzigen, de inhoud of positie van het label, de waarde voor het diagram, de hoogte van een item voor afdruklay-out,
enkele objecten te selecteren of een virtueel veld te maken, …

Notitie: Een lĳst met standaard functies en variabelen voor het schrĳven van expressies is te vinden op Lĳst van
functies, met gedetailleerde informatie en voorbeelden.

13.1.1 Expressie-string bouwer

Belangrĳkste dialoogvenster om expressies te bouwen, de Expressie string-bouwer is beschikbaar in vele delen van
QGIS en is in het bĳzonder toegankelĳk bĳ:

• klikken op de knop ;

• objecten selecteren met het gereedschap Objecten selecteren met een expressie…;

• attributen bewerken met bĳv. het gereedschap Veldberekening;

• bewerken van parameters voor symbologie, label of item voor afdruklay-out met het gereedschap
Data-bepaalde ‘override’ (zie Data-bepaalde ‘override’ instellen);

• bouwen van een symboollaag Geometrie-generator;
• zelf enige geoprocessing uitvoeren.

Het dialoogvenster Expressie-string bouwer biedt toegang tot de:
• tab Expressie die, dankzĳ een lĳst met vooraf gedefinieerde functies, helpt bĳ het schrĳven en controleren van
de te gebruiken expressie;

• tab Functiebewerker die helpt om de lĳst met functies uit te breiden door aangepaste te maken.
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De interface

De tab Expressie verschaft de belangrĳkste interface voor het schrĳven van expressies met functies, velden van lagen
en waarden. Het bevat de volgende widgets:

Fig. 13.1: De tab Expressie

• Een gebied in de bewerker voor expressies om expressies te typen of te plakken. Automatisch aanvullen is
beschikbaar om het schrĳven van expressies te versnellen:

– Corresponderende variabelen, functienamen en veldnamen voor de invoer van tekst worden hieronder
weergegeven: gebruik de pĳlen Omhoog en Omlaag om door de items te bladeren en druk op Tab om
het in de expressie in te voegen of klik eenvoudigweg op het gewenste item.

– Parameters voor functies worden weergegeven als zĳ worden ingevoerd.
QGIS controleert ook de geldigheid van de expressie en accentueert alle fouten met:

– Onderstrepen: voor onbekende functies, foute of ongeldige argumenten;
– Markering: voor elke andere fout (bĳv. ontbrekende haakjes, onverwacht teken) op één enkele plaats.

Tip: Documenteer uw expressie met opmerkingen
Bĳ het gebruiken van complexe expressies is het een goed gebruik om tekst toe te voegen, ofwel als een
opmerking met meerdere regels, of als een opmerking op de regel zelf, om u te helpen herinneren.

/*
Labels each region with its highest (in altitude) airport(s)
and altitude, eg 'AMBLER : 264m' for the 'Northwest Artic' region
*/
with_variable(
'airport_alti', -- stores the highest altitude of the region
aggregate(

'airports',
'max',
"ELEV", -- the field containing the altitude
-- and limit the airports to the region they are within
filter := within( $geometry, geometry( @parent ) )

),

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)
aggregate( -- finds airports at the same altitude in the region

'airports',
'concatenate',
"NAME",
filter := within( $geometry, geometry( @parent ) )
and "ELEV" = @airport_alti

)
|| ' : ' || @airport_alti || 'm'
-- using || allows regions without airports to be skipped

)

• Boven de bewerker voor expressies helpt een set gereedschappen u:

– Expressiebewerker leegmaken

– Maken en beheren van gebruikersexpressies

• Onder de expressiebewerker vindt u:
– Een set basisoperatoren om u te helpen de expressie te bouwen
– Een indicatie van de verwachte indeling van de uitvoer als u eigenschappen van objecten data-bepaald
– Een “levend” Voorbeeld uitvoer van de expressie (maximaal 60 tekens), standaard geëvalueerd op het
eerste object van de laag. U kunt, om voorbeeld tekst voor de uitvoer die meer dan 60 tekens groot is te
bekĳken, met uw cursor over de tekst gaan om een helptip te laten verschĳnen die het gehele voorbeeld
van de uitvoer bevat. Klik met rechts op de tekst van het voorbeeld van de uitvoer en selecteer Waarde
expressie kopiëren om de tekst van het voorbeeld van de uitvoer om dat naar uw klembord te kopiëren.
U kunt door andere objecten van de laag bladeren en die evalueren met het combinatievak Object (de
waarden worden genomen uit de eigenschap weergavenaam van de laag).
In geval van fouten geeft het dat aan en kunt u toegang krĳgen tot de details met de verschafte hyperlink.

• Een functieselectie geeft de lĳst met functies, variabelen, velden… weer, georganiseerd in groepen. Een
zoekvak is beschikbaar om de lĳst te filteren en snel een bepaalde functie of veld te vinden. Dubbelklikken op
de naam van het item voegt het toe aan de te schrĳven expressie.

• Een paneel Help geeft de help weer voor elk geselecteerd item in de functieselectie.

Tip: Drukken op Ctrl+Click, terwĳl u met de muis over de naam van een functie in een expressie gaat,
zal automatisch de Help daarvoor openen in een dialoogvenster.

Een widget voor waarden van velden dat wordt weergegeven als een veld is geselecteerd in de functieselectie
helpt om attributen van de objecten op te halen.

– Zoeken naar een bepaalde veldwaarde
– De lĳst met waarden Alle unieke of 10 voorbeelden weergeven. Ook beschikbaar door met rechts te
klikken.
Wanneer het veld is verbonden aan een andere laag of een set waarden, d.i. als dewidget Veld van het type
Relatie-verwĳzing,Waarde relatie ofWaardenkaart is, is het mogelĳk om alle waarden van het verbonden
veld te vermelden (vanuit de verbonden laag, tabel of lĳst). Meer nog, u kunt deze lĳst filteren om
Alleen gebruikte waarden weergeven in het huidige veld.

Dubbelklikken op een veldwaarde in de widget voegt het toe aan de expressiebewerker.

Tip: Het rechterpaneel, dat Help voor functies of veldwaarden weergeeft, kan worden samengevouwen
(onzichtbaar) in het dialoogvenster. Druk op de knoppenWaarden weergeven of Help weergeven om het terug
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te krĳgen.

Een expressie schrijven

Expressies van QGIS worden gebruikt om objecten of sets waarden te selecteren. Schrĳven van een expressie in QGIS
moet voldoen aan enkele regels:

1. Het dialoogvenster definieert de context: als u gewend bent aan SQL, zult u waarschĳnlĳk bekend zĳn met
query’s van het type select features from layer where condition of update layer set field = new_value where
condition. Een expressie van QGIS heeft ook al deze informatie nodig, maar het gereedschap dat u gebruikt om
het dialoogvenster Expressie-bouwer te openen verschaft er delen van. Bĳvoorbeeld: uitgaande van een laag
(buildings) met een veld (height):

• klikken op het gereedschap Objecten selecteren met een expressie betekent dat u wilt “select features from
buildings”. De voorwaarde is de enige informatie die u dient op te geven in de widget voor de tekst
van de expressie, bĳv. typ "height" > 20 om gebouwen te selecteren die hoger zĳn dan 20.

• met deze selectie gemaakt, geeft u door te drukken op de knop Veldberekening en te kiezen voor “height”
als Bestaand veld bĳwerken, de opdracht “update buildings set height = ??? where height > 20”. De enige
resterende gedeelten die u in dit geval moet opgeven is de nieuwe waarde, voer bĳv. eenvoudigweg 50 in
het tekstvak van de bewerker voor de expressie in om de hoogte voor de eerder geselecteerde gebouwen
in te stellen.

2. Let op aanhalingstekens: enkele aanhalingstekens geven een letterlĳke waarde terug, dus een tekst die
is geplaatst tussen enkele aanhalingstekens ('145') wordt geïnterpreteerd als een tekenreeks. Dubbele
aanhalingstekens geven u de waarde van die tekst, dus gebruik ze voor velden ("myfield"). Velden kunnen
ook zonder aanhalingstekens worden gebruikt (myfield). Geen aanhalingstekens voor getallen (3.16).

Notitie: Functies nemen normaal gesproken een tekenreeks of veldnaam als argument. Doe:

attribute( @atlas_feature, 'height' ) -- returns the value stored in the
↪→"height" attribute of the current atlas feature

En niet:

attribute( @atlas_feature, "height" ) -- fetches the value of the attribute␣
↪→named "height" (e.g. 100), and use that value as a field

-- from which to return the atlas␣
↪→feature value. Probably wrong as a field named "100" may not exist.

Tip: Benoemde parameters gebruiken om het lezen van de expressie gemakkelĳker te maken
Sommige functies vereisen dat veel parameters moeten worden ingesteld. Het programma voor expressies ondersteunt
het gebruiken van benoemde parameters. Dit betekent dat, in plaats van de cryptische expressie: clamp(1, 2,
9) te schrĳven, u: clamp( min:=1, value:=2, max:=9) kunt gebruiken. Deze wĳziging maakt het ook
mogelĳk argumenten te wisselen, bĳv: clamp( value:=2, max:=9, min:=1). Het gebruiken van benoemde
parameters helpt te verduidelĳken waar de argumenten voor een functie voor een expressie naar verwĳzen, wat nuttig
is als u een expressie later probeert te interpreteren!
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Enkele gebruiksgevallen van expressies

• Vanuit Veldberekening, bereken een veld “pop_density” met behulp van de bestaande velden “total_pop” en
“area_km²”:

"total_pop" / "area_km2"

• Label of categoriseer objecten gebaseerd op hun gebied:

CASE WHEN $area > 10 000 THEN 'Larger' ELSE 'Smaller' END

• Werk het veld “density_level” bĳ met categorieën overeenkomstig de waarden van “pop_density”:

CASE WHEN "pop_density" < 50 THEN 'Low population density'
WHEN "pop_density" >= 50 and "pop_density" < 150 THEN 'Medium population␣

↪→density'
WHEN "pop_density" >= 150 THEN 'High population density'

END

• Pas een stĳl met categorieën toe op alle objecten overeenkomstig het feit of hun gemiddelde huizenprĳs minder
of meer is dan €10.000 per vierkante meter:

"price_m2" > 10000

• Selecteer, met het gereedschap “Objecten selecteren met een expressie…”, alle objecten die gebieden
vertegenwoordigen van “Dicht bevolkt” en waarvan de gemiddelde huizenprĳs hoger is dan €10.000 per
vierkante meter:

"density_level" = 'High population density' and "price_m2" > 10000

De vorige expressie zou ook kunnen worden gebruikt om te definiëren welke objecten te labelen of op de kaart
weer te geven.

• Maak een ander symbool (type) voor de laag, met de geometrie-generator:

point_on_surface( $geometry )

• Gegeven een object punt, maak een gesloten lĳn (met make_line) rondom zĳn geometrie:

make_line(
-- using an array of points placed around the original
array_foreach(

-- list of angles for placing the projected points (every 90°)
array:=generate_series( 0, 360, 90 ),
-- translate the point 20 units in the given direction (angle)
expression:=project( $geometry, distance:=20, azimuth:=radians( @element )␣

↪→)
)

)

• Geef, in een label van afdruklay-out, de naam weer van de objecten “airports” die binnen de lay-out van item
“Kaart 1” liggen:

with_variable( 'extent',
map_get( item_variables( 'Map 1' ), 'map_extent' ),
aggregate( 'airports', 'concatenate', "NAME",

intersects( $geometry, @extent ), ' ,'
)

)
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Expressies opslaan

Door het gebruiken van de knop Huidige expressie aan gebruikersexpressies toevoegen boven het frame van de bewerker voor
de expressie, kunt u belangrĳke expressies, waartoe u snel toegang wilt hebben, opslaan. Deze zĳn beschikbaar
vanuit de groep Gebruikersexpressies in het middelste paneel. Ze worden opgeslagen in het gebruikersprofiel
(bestand <userprofile>/QGIS/QGIS3.ini) en beschikbaar in alle dialoogvensters voor expressies binnen
alle projecten van het huidige gebruikersprofiel.
Een set gereedschappen, beschikbaar boven het frame van de expressiebewerker, helpt u de gebruikersexpressies te
beheren:

• Huidige expressie aan gebruikersexpressies toevoegen: slaat de expressie op in het gebruikersprofiel. Een label en een
helptekst kunnen worden toegevoegd om het gemakkelĳk te identificeren.

• Geselecteerde expressie uit gebruikersexpressies bewerken, als ook hun help en label

• Geselecteerde expressie uit gebruikersexpressies verwĳderen

• Gebruikersexpressies importeren uit een bestand .json in de map voor het actieve gebruikersprofiel

• Gebruikersexpressies exporteren als een bestand .json; alle gebruikersexpressies in het bestand QGIS3.ini van
het gebruikersprofiel worden gedeeld

13.1.2 Functiebewerker

Met de tab Functiebewerker kunt u uw eigen functies schrĳven in de taal Python. Dit verschaft een handige en
comfortabele manier om bepaalde wensen, die niet door vooraf gedefinieerde functies worden verschaft, aan te
pakken.

Fig. 13.2: De tab Functiebewerker

Een nieuwe functie maken:

1. Druk op de knop Nieuw bestand.
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2. Voer een naam in om te gebruiken in het formulier dat opent en druk op OK.
Een nieuw item van de naam die u opgaf, wordt toegevoegd aan het linkerpaneel van de tab Functiebewerker; dit
is een Python-bestand .py gebaseerd op een sjabloonbestand van QGIS en opgeslagen in de map /python/
expressions onder de map van het actieve gebruikersprofiel.

3. Het rechterpaneel geeft de inhoud van het bestand weer: een sjabloon voor een Python-bestand. Werk de code
en zĳn Help bĳ overeenkomstig uw behoeften.

4. Druk op de knop Functies voor laden en opslaan. De functie die u schreef wordt toegevoegd aan de boom
met functies op de tab Expressie, standaard onder de groep Aangepast.

5. Veel plezier met uw functie.
6. Als de functie verbeteringen nodig heeft, schakel naar de tab Functiebewerker, maak de wĳzigingen en druk

opnieuw op de knop Functies voor laden en opslaan om ze beschikbaar te maken in het bestand, en daarmee
op de tab Expressie.

Aangepaste functies voor Python worden opgeslagen onder de map van het gebruikersprofiel, wat betekent dat bĳ elke
keer dat QGIS opstart, het automatisch alle functies zal laden die zĳn gedefinieerd met het huidige gebruikersprofiel.
Onthoud dat nieuwe functies alleen worden opgeslagen in de map /python/expressions en niet in het
projectbestand. Als u een project deelt dat een van uw aangepaste functies gebruikt, moet u ook het bestand .py
in de map /python/expressions delen.
Een aangepaste functie verwĳderen:

1. Schakel naar de tab Functiebewerker

2. Selecteer de functie in de lĳst

3. Druk op de knop Geselecteerde functiebestand verwĳderen. De functie wordt uit de lĳst verwĳderd en het
overeenkomende bestand .py verwĳderd uit de map van het gebruikersprofiel.

Voorbeeld
Hier is een kort voorbeeld voor het maken van uw eigen functie my_sum die werkt met twee waarden.

from qgis.core import *
from qgis.gui import *

@qgsfunction(args='auto', group='Custom')
def my_sum(value1, value2, feature, parent):

"""
Calculates the sum of the two parameters value1 and value2.
<h2>Example usage:</h2>
<ul>

<li>my_sum(5, 8) -> 13</li>
<li>my_sum("field1", "field2") -> 42</li>

</ul>
"""
return value1 + value2

De decoratie @qgsfunction accepteert de volgende argumenten:
• args: het aantal argumenten. Door het gebruiken van het functieargument args='auto' zal het aantal
vereiste functie-argumenten voor de functie worden berekend door het aantal argumenten waarmee de functie
is gedefinieerd in Python (minus 2 - feature, en parent). Met args = -1 wordt elk aantal argumenten
geaccepteerd.

• Het argument group geeft de groep aan waarin de functie zou moeten worden vermeld in het dialoogvenster
Expressie.

• usesgeometry=True als de expressie toegang vereist tot de geometrie van het object. Standaard False.
• handlesnull=True als de expressie aangepaste afhandeling heeft voor waarden NULL. Indien False
(standaard) zal het resultaat altĳd NULL zĳn, zodra enige parameter NULL is.
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• referenced_columns=[lijst]: Een array van namen van attributen die vereist zĳn voor de functie.
Standaard is [QgsFeatureRequest.ALL_ATTRIBUTES].

De functie zelf staat de volgende argumenten toe:
• elk aantal en type parameter dat u wilt doorgeven aan uw functie, ingesteld voor de volgende argumenten.
• feature: het huidige object
• parent: het object QgsExpression
• context: Als er een argument, genaamd context, wordt gevonden op de laatste positie, zal deze variabele
een object QgsExpressionContext bevatten dat toegang geeft tot verschillende aanvullende informatie,
zoals variabelen voor de expressie. Bĳv. context.variable( 'layer_id' )

De vorenstaande voorbeeldfunctie kan dan worden gebruikt in expressies:

Fig. 13.3: Aangepaste functie toegevoegd aan de tab Expressie

Meer informatie over het maken van code voor Python kan worden gevonden in het PyQGIS-Developer-Cookbook.

13.2 Lijst van functies

De functies, operatoren en variabelen, die beschikbaar zĳn in QGIS, zĳn hieronder vermeld, gegroepeerd in
categorieën.

13.2.1 Functies Samenvoegen

Deze groep bevat functies die waarden bĳ elkaar optellen van lagen en velden.
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aggregate

Geeft een samengestelde waarde terug die is berekend met behulp van objecten uit een andere laag.
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Syntaxis aggregate(layer, aggregate, expression, [filter], [concatenator=’’], [order_by])
[] markeert optionele argumenten

Argumenten • layer - een tekenreeks die ofwel een laagnaam of een laag-ID vertegenwoordigt
• aggregate - een tekenreeks die overeenkomt met de te berekenen samenstelling. Geldige
opties zĳn:

– count
– count_distinct
– count_missing
– min
– max
– sum
– mean
– median
– stdev
– stdevsample
– range
– minority
– majority
– q1: eerste kwartiel
– q3: derde kwartiel
– iqr: interkwartiele bereik
– min_length: minimale lengte tekenreeks
– max_length: maximale lengte tekenreeks
– concatenate: tekenreeksen samenvoegen met een teken voor samenvoegen
– concatenate_unique: unieke tekenreeksen samenvoegen met een teken voor
samenvoegen

– collect: een samengestelde meerdelige geometrie maken
– array_agg: een array met samengestelde waarden maken

• expression - subexpressie of veldnaam om samen te stellen
• filter - optionele filterexpressie om de te gebruiken objecten voor het berekenen van de
samenstelling te beperken. Velden en geometrie zĳn van de objecten op de samengevoegde
laag. Toegang tot het bronobject kan worden verkregen met de variabele @parent.

• concatenator - optionele tekenreeks om te gebruiken voor het samenstellen van de
waarden bĳ ‘concatenate’ en ‘concatenate_unique’

• filter - optionele filterexpressie om de te gebruiken objecten voor het berekenen van de
samenstelling te sorteren. Velden en geometrie zĳn van de objecten op de samengevoegde
laag. Standaard zullen de objecten worden teruggegeven in een niet gespecificeerde
volgorde.

Voorbeelden • aggregate(layer:='rail_stations',aggregate:='sum',
expression:="passengers") → som van alle waarden uit het veld passengers
van de laag rail_stations

• aggregate('rail_stations','sum', "passengers"/7)→berekent een
dagelĳks gemiddelde van “passengers” door het veld “passengers” te delen door 7, vóór de
waarden bĳ elkaar op te tellen

• aggregate(layer:='rail_stations',aggregate:='sum',
expression:="passengers",filter:="class">3) → telt alle waarden
van het veld “passengers”, alleen van de objecten waarvan het attribuut “class” groter is
dan 3, bĳ elkaar op

• aggregate(layer:='rail_stations',aggregate:='concatenate',
expression:="name", concatenator:=',') → kommagescheiden lĳst van
het veld name voor alle objecten van de laag rail_stations

• aggregate(layer:='countries', aggregate:='max',
expression:="code", filter:=intersects( $geometry,
geometry(@parent) ) ) → De landcode van een kruisend land van de laag
‘countries’

• aggregate(layer:='rail_stations',aggregate:='sum',
expression:="passengers",filter:=contains(
@atlas_geometry, $geometry ) ) → som van alle waarden uit het
veld passengers van de laag rail_stations in het huidige object van atlas

• aggregate(layer:='rail_stations', aggregate:='collect',
expression:=centroid($geometry), filter:="region_name" =
attribute(@parent,'name') ) → stelt de zwaartepunt geometrieën van de
rail_stations uit de huidige regio in als huidig object
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array_agg

Geeft een array van samengestelde waarden terug uit een veld of expressie.

Syntaxis array_agg(expression, [group_by], [filter], [order_by])
[] markeert optionele argumenten

Argumenten • expression - subexpressie of veld om samen te stellen
• group_by - optionele expressie om te gebruiken omde berekeningen voor de samenstelling
te groeperen

• filter - optionele expressie om te gebruiken om objecten te filteren bĳ het berekenen van
de samenstelling

• filter - optionele filterexpressie om te gebruiken om objecten te sorteren voor het
berekenen van de samenstelling. Standaard zullen de objecten worden teruggegeven in
een niet gespecificeerde volgorde.

Voorbeelden • array_agg("name",group_by:="state") → lĳst van waarden van name,
gegroepeerd op het veld state

collect

Geeft de geometrie met meerdere delen terug uit samengestelde geometrieën uit een expressie

Syntaxis collect(expression, [group_by], [filter])
[] markeert optionele argumenten

Argumenten • expression - geometrie expressie om samen te stellen
• group_by - optionele expressie om te gebruiken omde berekeningen voor de samenstelling
te groeperen

• filter - optionele expressie om te gebruiken om objecten te filteren bĳ het berekenen van
de samenstelling

Voorbeelden • collect( $geometry )→meerdelige geometrie van samengestelde geometrieën
• collect( centroid($geometry), group_by:="region", filter:=
"use" = 'civilian' ) → samengestelde zwaartepunten van de burgerlĳke
objecten, gebaseerd op de waarde van hun region
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concatenate

Geeft alle samengevoegde tekenreeksen terug uit een veld of expressie, verbonden door een scheidingsteken.

Syntaxis concatenate(expression, [group_by], [filter], [concatenator], [order_by])
[] markeert optionele argumenten

Argumenten • expression - subexpressie of veld om samen te stellen
• group_by - optionele expressie om te gebruiken omde berekeningen voor de samenstelling
te groeperen

• filter - optionele expressie om te gebruiken om objecten te filteren bĳ het berekenen van
de samenstelling

• concatenator - optionele tekenreeks om waarden samen te voegen. Standaard leeg.
• filter - optionele filterexpressie om te gebruiken om objecten te sorteren voor het
berekenen van de samenstelling. Standaard zullen de objecten worden teruggegeven in
een niet gespecificeerde volgorde.

Voorbeelden • concatenate("town_name",group_by:="state",concatenator:=',
')→ kommagescheiden lĳst van town_names, gegroepeerd op het veld state

concatenate_unique

Geeft alle unieke tekenreeksen terug uit een veld of expressie, verbonden door een scheidingsteken.

Syntaxis concatenate_unique(expression, [group_by], [filter], [concatenator], [order_by])
[] markeert optionele argumenten

Argumenten • expression - subexpressie of veld om samen te stellen
• group_by - optionele expressie om te gebruiken omde berekeningen voor de samenstelling
te groeperen

• filter - optionele expressie om te gebruiken om objecten te filteren bĳ het berekenen van
de samenstelling

• concatenator - optionele tekenreeks om waarden samen te voegen. Standaard leeg.
• filter - optionele filterexpressie om te gebruiken om objecten te sorteren voor het
berekenen van de samenstelling. Standaard zullen de objecten worden teruggegeven in
een niet gespecificeerde volgorde.

Voorbeelden • concatenate_unique("town_name",group_by:="state",
concatenator:=',') → kommagescheiden lĳst van unieke town_names,
gegroepeerd op het veld state

count

Geeft de telling van het aantal overeenkomende objecten terug.
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Syntaxis count(expression, [group_by], [filter])
[] markeert optionele argumenten

Argumenten • expression - subexpressie of veld om samen te stellen
• group_by - optionele expressie om te gebruiken omde berekeningen voor de samenstelling
te groeperen

• filter - optionele expressie om te gebruiken om objecten te filteren bĳ het berekenen van
de samenstelling

Voorbeelden • count("stations",group_by:="state") → aantal stations, gegroepeerd op
het veld state

count_distinct

Geeft de telling van de afzonderlĳke waarden terug.

Syntaxis count_distinct(expression, [group_by], [filter])
[] markeert optionele argumenten

Argumenten • expression - subexpressie of veld om samen te stellen
• group_by - optionele expressie om te gebruiken omde berekeningen voor de samenstelling
te groeperen

• filter - optionele expressie om te gebruiken om objecten te filteren bĳ het berekenen van
de samenstelling

Voorbeelden • count_distinct("stations",group_by:="state") → aantal
afzonderlĳke stations, gegroepeerd op het veld state

count_missing

Geeft de telling van de ontbrekende (NULL)-waarden terug.

Syntaxis count_missing(expression, [group_by], [filter])
[] markeert optionele argumenten

Argumenten • expression - subexpressie of veld om samen te stellen
• group_by - optionele expressie om te gebruiken omde berekeningen voor de samenstelling
te groeperen

• filter - optionele expressie om te gebruiken om objecten te filteren bĳ het berekenen van
de samenstelling

Voorbeelden • count_missing("stations",group_by:="state") → aantal ontbrekende
of (NULL)-waarden van station, gegroepeerd op het veld state
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iqr

Geeft het berekende bereik voor het interkwartiel terug uit een veld of expressie.

Syntaxis iqr(expression, [group_by], [filter])
[] markeert optionele argumenten

Argumenten • expression - subexpressie of veld om samen te stellen
• group_by - optionele expressie om te gebruiken omde berekeningen voor de samenstelling
te groeperen

• filter - optionele expressie om te gebruiken om objecten te filteren bĳ het berekenen van
de samenstelling

Voorbeelden • iqr("population",group_by:="state") → interkwartiel bereik van de
waarden van population, gegroepeerd op het veld state

majority

Geeft de samengestelde meerderheid van waarden (meest terugkerende waarde) terug uit een veld of expressie.

Syntaxis majority(expression, [group_by], [filter])
[] markeert optionele argumenten

Argumenten • expression - subexpressie of veld om samen te stellen
• group_by - optionele expressie om te gebruiken omde berekeningen voor de samenstelling
te groeperen

• filter - optionele expressie om te gebruiken om objecten te filteren bĳ het berekenen van
de samenstelling

Voorbeelden • majority("class",group_by:="state") → meest voorkomende waarde
voor class, gegroepeerd op het veld state

max_length

Geeft de maximale lengte van tekenreeksen terug uit een veld of expressie.

Syntaxis max_length(expression, [group_by], [filter])
[] markeert optionele argumenten

Argumenten • expression - subexpressie of veld om samen te stellen
• group_by - optionele expressie om te gebruiken omde berekeningen voor de samenstelling
te groeperen

• filter - optionele expressie om te gebruiken om objecten te filteren bĳ het berekenen van
de samenstelling

Voorbeelden • max_length("town_name",group_by:="state") → maximale lengte van
town_name, gegroepeerd op het veld state
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maximum

Geeft de samengestelde maximale waarde terug uit een veld of expressie.

Syntaxis maximum(expression, [group_by], [filter])
[] markeert optionele argumenten

Argumenten • expression - subexpressie of veld om samen te stellen
• group_by - optionele expressie om te gebruiken omde berekeningen voor de samenstelling
te groeperen

• filter - optionele expressie om te gebruiken om objecten te filteren bĳ het berekenen van
de samenstelling

Voorbeelden • maximum("population",group_by:="state") → maximale waarde voor
population, gegroepeerd op het veld state

mean

Geeft de samengestelde gemiddelde waarde terug uit een veld of expressie.

Syntaxis mean(expression, [group_by], [filter])
[] markeert optionele argumenten

Argumenten • expression - subexpressie of veld om samen te stellen
• group_by - optionele expressie om te gebruiken omde berekeningen voor de samenstelling
te groeperen

• filter - optionele expressie om te gebruiken om objecten te filteren bĳ het berekenen van
de samenstelling

Voorbeelden • mean("population",group_by:="state") → gemiddelde waarde voor
population, gegroepeerd op het veld state

median

Geeft de samengestelde waarde mediaan terug uit een veld of expressie.

Syntaxis median(expression, [group_by], [filter])
[] markeert optionele argumenten

Argumenten • expression - subexpressie of veld om samen te stellen
• group_by - optionele expressie om te gebruiken omde berekeningen voor de samenstelling
te groeperen

• filter - optionele expressie om te gebruiken om objecten te filteren bĳ het berekenen van
de samenstelling

Voorbeelden • median("population",group_by:="state") → mediaan van de waarde
population, gegroepeerd op het veld state
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min_length

Geeft de minimale lengte van tekenreeksen terug uit een veld of expressie.

Syntaxis min_length(expression, [group_by], [filter])
[] markeert optionele argumenten

Argumenten • expression - subexpressie of veld om samen te stellen
• group_by - optionele expressie om te gebruiken omde berekeningen voor de samenstelling
te groeperen

• filter - optionele expressie om te gebruiken om objecten te filteren bĳ het berekenen van
de samenstelling

Voorbeelden • min_length("town_name",group_by:="state") → minimale lengte van
town_name, gegroepeerd op het veld state

minimum

Geeft de samengestelde minimale waarde terug uit een veld of expressie.

Syntaxis minimum(expression, [group_by], [filter])
[] markeert optionele argumenten

Argumenten • expression - subexpressie of veld om samen te stellen
• group_by - optionele expressie om te gebruiken omde berekeningen voor de samenstelling
te groeperen

• filter - optionele expressie om te gebruiken om objecten te filteren bĳ het berekenen van
de samenstelling

Voorbeelden • minimum("population",group_by:="state") → minimale waarde voor
population, gegroepeerd op het veld state

minority

Geeft de samengestelde minderheid van waarden (minst terugkerende waarde) terug uit een veld of expressie.

Syntaxis minority(expression, [group_by], [filter])
[] markeert optionele argumenten

Argumenten • expression - subexpressie of veld om samen te stellen
• group_by - optionele expressie om te gebruiken omde berekeningen voor de samenstelling
te groeperen

• filter - optionele expressie om te gebruiken om objecten te filteren bĳ het berekenen van
de samenstelling

Voorbeelden • minority("class",group_by:="state")→minst voorkomendewaarde voor
class, gegroepeerd op het veld state
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q1

Geeft het berekende eerste kwartiel terug uit een veld of expressie.

Syntaxis q1(expression, [group_by], [filter])
[] markeert optionele argumenten

Argumenten • expression - subexpressie of veld om samen te stellen
• group_by - optionele expressie om te gebruiken omde berekeningen voor de samenstelling
te groeperen

• filter - optionele expressie om te gebruiken om objecten te filteren bĳ het berekenen van
de samenstelling

Voorbeelden • q1("population",group_by:="state") → eerste kwartiel van de waarde
population, gegroepeerd op het veld state

q3

Geeft het berekende derde kwartiel terug uit een veld of expressie.

Syntaxis q3(expression, [group_by], [filter])
[] markeert optionele argumenten

Argumenten • expression - subexpressie of veld om samen te stellen
• group_by - optionele expressie om te gebruiken omde berekeningen voor de samenstelling
te groeperen

• filter - optionele expressie om te gebruiken om objecten te filteren bĳ het berekenen van
de samenstelling

Voorbeelden • q3("population",group_by:="state") → derde kwartiel van waarde
population, gegroepeerd op het veld state

range

Geeft het samengestelde bereik van waarden (maximum - minimum) terug uit een veld of expressie.

Syntaxis range(expression, [group_by], [filter])
[] markeert optionele argumenten

Argumenten • expression - subexpressie of veld om samen te stellen
• group_by - optionele expressie om te gebruiken omde berekeningen voor de samenstelling
te groeperen

• filter - optionele expressie om te gebruiken om objecten te filteren bĳ het berekenen van
de samenstelling

Voorbeelden • range("population",group_by:="state") → bereik van waarden van
population, gegroepeerd op het veld state
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relation_aggregate

Geeft een berekende samengestelde waarde terug met behulp van alle overeenkomende kind-objecten uit een laag-
relatie.

Syntaxis relation_aggregate(relation, aggregate, expression, [concatenator=’’], [order_by])
[] markeert optionele argumenten

Argumenten • relation - een tekenreeks die een relatie-ID vertegenwoordigt
• aggregate - een tekenreeks die overeenkomt met de te berekenen samenstelling. Geldige
opties zĳn:

– count
– count_distinct
– count_missing
– min
– max
– sum
– mean
– median
– stdev
– stdevsample
– range
– minority
– majority
– q1: eerste kwartiel
– q3: derde kwartiel
– iqr: interkwartiele bereik
– min_length: minimale lengte tekenreeks
– max_length: maximale lengte tekenreeks
– concatenate: tekenreeksen samenvoegen met een teken voor samenvoegen
– concatenate_unique: unieke tekenreeksen samenvoegen met een teken voor
samenvoegen

– collect: een samengestelde meerdelige geometrie maken
– array_agg: een array met samengestelde waarden maken

• expression - subexpressie of veldnaam om samen te stellen
• concatenator - optionele tekenreeks om te gebruiken voor het samenstellen van de
waarden bĳ ‘concatenate’

• filter - optionele expressie om de te gebruiken objecten voor het berekenen van de
samenstelling te sorteren. Velden en geometrie zĳn van de objecten op de samengevoegde
laag. Standaard zullen de objecten worden teruggegeven in een niet gespecificeerde
volgorde.

Voorbeelden • relation_aggregate(relation:='my_relation',
aggregate:='mean',expression:="passengers") → gemiddelde
waarde van alle overeenkomende kind-objecten met behulp van de relatie ‘my_relation’

• relation_aggregate('my_relation','sum', "passengers"/7) →
som van het veld passengers, gedeeld door 7, voor alle overeenkomende kind-objecten
met behulp van de relatie ‘my_relation’

• relation_aggregate('my_relation','concatenate', "towns",
concatenator:=',') → kommagescheiden lĳst van het veld towns voor alle
overeenkomende kind-objecten met behulp van de relatie ‘my_relation’

• relation_aggregate('my_relation','array_agg', "id") → array
van het veld id van alle overeenkomende kind-objecten met behulp van de relatie
‘my_relation’

Lees verder: Een tot veel- of veel-tot-veel-relaties maken
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stdev

Geeft de samengestelde waarde voor standaardafwĳking terug uit een veld of expressie.

Syntaxis stdev(expression, [group_by], [filter])
[] markeert optionele argumenten

Argumenten • expression - subexpressie of veld om samen te stellen
• group_by - optionele expressie om te gebruiken omde berekeningen voor de samenstelling
te groeperen

• filter - optionele expressie om te gebruiken om objecten te filteren bĳ het berekenen van
de samenstelling

Voorbeelden • stdev("population",group_by:="state") → standaardafwĳking van de
waarde population, gegroepeerd op het veld state

sum

Geeft de samengestelde opgetelde waarde terug uit een veld of expressie.

Syntaxis sum(expression, [group_by], [filter])
[] markeert optionele argumenten

Argumenten • expression - subexpressie of veld om samen te stellen
• group_by - optionele expressie om te gebruiken omde berekeningen voor de samenstelling
te groeperen

• filter - optionele expressie om te gebruiken om objecten te filteren bĳ het berekenen van
de samenstelling

Voorbeelden • sum("population",group_by:="state") → opgetelde waarde van
population, gegroepeerd op het veld state

13.2.2 Functies voor array

Deze groep bevat functies voor expressies voor het maken en manipuleren van arrays (ook wel bekend als de
datastructuur ‘list’). De volgorde van waarden binnen de array is belangrĳk, in tegenstelling tot de gegevensstructuur
van de ‘kaart’ , waar de volgorde van paren sleutels-waarden niet relevant is en waarden worden geïdentificeerd door
hun sleutels.

array

Geeft een array terug die alle waarden bevat die werden doorgegeven als parameter.

Syntaxis array(value1, value2, …)
Argumenten • value - een waarde

Voorbeelden • array(2,10)→ [ 2, 10 ]
• array(2,10)[0]→ 2
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array_all

Geeft TRUE terug als een array alle waarden van een opgegeven array bevat.

Syntaxis array_all(array_a, array_b)
Argumenten • array_a - een array

• array_b - de te doorzoeken array met waarden

Voorbeelden • array_all(array(1,2,3),array(2,3))→ TRUE
• array_all(array(1,2,3),array(1,2,4))→ FALSE

array_append

Geeft een array terug met de opgegeven waarde toegevoegd aan het einde.

Syntaxis array_append(array, value)
Argumenten • array - een array

• value - de toe te voegen waarde

Voorbeelden • array_append(array(1,2,3),4)→ [ 1, 2, 3, 4 ]

array_cat

Geeft een array terug die alle opgegeven arrays samengevoegd bevat.

Syntaxis array_cat(array1, array2, …)
Argumenten • array - een array

Voorbeelden • array_cat(array(1,2),array(2,3))→ [ 1, 2, 2, 3 ]

array_contains

Geeft TRUE terug als een array de opgegeven waarde bevat.

Syntaxis array_contains(array, value)
Argumenten • array - een array

• value - de op te zoeken waarde

Voorbeelden • array_contains(array(1,2,3),2)→ TRUE

232 Hoofdstuk 13. Doe meer met expressies



QGIS Desktop 3.28 User Guide

array_count

Telt het aantal keren dat een bepaalde waarde voorkomt in een array.

Syntaxis array_count(array, value)
Argumenten • array - een array

• value - de te tellen waarde

Voorbeelden • array_count(array('a', 'b', 'c', 'b'), 'b')→ 2

array_distinct

Geeft een array terug die alle afzonderlĳke waarden van de opgegeven array bevat.

Syntaxis array_distinct(array)
Argumenten • array - een array

Voorbeelden • array_distinct(array(1,2,3,2,1))→ [ 1, 2, 3 ]

array_filter

Geeft een array terug met alleen de items waarvoor de expressie naar TRUE evalueert.

Syntaxis array_filter(array, expression, [limit=0])
[] markeert optionele argumenten

Argumenten • array - een array
• expression - een voor elk item te evalueren expressie. De variabele @element zal worden
vervangen door de huidige waarde.

• limit - maximaal aantal terug te geven elementen. Gebruik 0 om alle waarden terug te
geven.

Voorbeelden • array_filter(array(1,2,3),@element < 3)→ [ 1, 2 ]
• array_filter(array(1,2,3),@element < 3, 1)→ [ 1 ]

array_find

Geeft de laagste index terug (0 voor de eerste) van een waarde binnen een array. Geeft -1 terug als de waarde niet
wordt gevonden.
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Syntaxis array_find(array, value)
Argumenten • array - een array

• value - de op te zoeken waarde

Voorbeelden • array_find(array('a', 'b', 'c'), 'b')→ 1
• array_find(array('a', 'b', 'c', 'b'), 'b')→ 1

array_first

Geeft de eerste waarde uit een array terug.

Syntaxis array_first(array)
Argumenten • array - een array

Voorbeelden • array_first(array('a','b','c'))→ ‘a’

array_foreach

Geeft een array terug waar de opgegeven expressie voor elk item is geëvalueerd.

Syntaxis array_foreach(array, expression)
Argumenten • array - een array

• expression - een voor elk item te evalueren expressie. De variabele @element zal worden
vervangen door de huidige waarde.

Voorbeelden • array_foreach(array('a','b','c'),upper(@element)) → [ ‘A’, ‘B’,
‘C’ ]

• array_foreach(array(1,2,3),@element + 10)→ [ 11, 12, 13 ]

array_get

Geeft de n-de waarde terug (0 voor de eerste) of de laatste -n-de waarde (-1 voor de laatste) van een array.

Syntaxis array_get(array, pos)
Argumenten • array - een array

• pos - de op te halen index (0-gebaseerd)

Voorbeelden • array_get(array('a','b','c'),1)→ ‘b’
• array_get(array('a','b','c'),-1)→ ‘c’

Hint: U kunt ook de index operator ([]) gebruiken om een waarde uit een array te verkrĳgen.

234 Hoofdstuk 13. Doe meer met expressies



QGIS Desktop 3.28 User Guide

array_insert

Geeft een array terug met de opgegeven waarde toegevoegd op de opgegeven positie.

Syntaxis array_insert(array, pos, value)
Argumenten • array - een array

• pos - de positie waarop moet worden toegevoegd (0-gebaseerd)
• value - de toe te voegen waarde

Voorbeelden • array_insert(array(1,2,3),1,100)→ [ 1, 100, 2, 3 ]

array_intersect

Geeft TRUE terug als tenminste één element van array1 bestaat in array2.

Syntaxis array_intersect(array1, array2)
Argumenten • array1 - een array

• array2 - een andere array

Voorbeelden • array_intersect(array(1,2,3,4),array(4,0,2,5))→ TRUE

array_last

Geeft de laatste waarde uit een array terug.

Syntaxis array_last(array)
Argumenten • array - een array

Voorbeelden • array_last(array('a','b','c'))→ ‘c’

array_length

Geeft het aantal elementen in een array terug.

Syntaxis array_length(array)
Argumenten • array - een array

Voorbeelden • array_length(array(1,2,3))→ 3
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array_majority

Geeft de meest voorkomende waarden uit een array terug.

Syntaxis array_majority(array, [option=’all’])
[] markeert optionele argumenten

Argumenten • array - een array
• option=’all’ - een tekenreeks die de afhandeling van de teruggegeven waarden
specificeert. Geldige opties zĳn:

– all: Standaard, alle meest voorkomende waarden worden teruggegeven in een array.
– any: Geeft een van de meest voorkomende waarden terug.
– median: Geeft de mediaan van de meest voorkomende waarden terug. Niet-
rekenkundige waarden worden genegeerd.

– real_majority: Geeft de waarde terug die meer voorkomt dan de halve grootte van
de array.

Voorbeelden • array_majority(array(0,1,42,42,43), 'all')→ [ 42 ]
• array_majority(array(0,1,42,42,43,1), 'all')→ [ 42, 1 ]
• array_majority(array(0,1,42,42,43,1), 'any')→ 1 of 42
• array_majority(array(0,1,1,2,2), 'median')→ 1.5
• array_majority(array(0,1,42,42,43), 'real_majority') →
NULL

• array_majority(array(0,1,42,42,43,42), 'real_majority') →
NULL

• array_majority(array(0,1,42,42,43,42,42), 'real_majority')
→ 42

array_max

Geeft de maximumwaarde uit een array terug.

Syntaxis array_max(array)
Argumenten • array - een array

Voorbeelden • array_max(array(0,42,4,2))→ 42

array_mean

Geeft het gemiddelde terug van rekenkundige waarden in een array. Niet-numerieke waarden in de array worden
genegeerd.

Syntaxis array_mean(array)
Argumenten • array - een array

Voorbeelden • array_mean(array(0,1,7,66.6,135.4))→ 42
• array_mean(array(0,84,'a','b','c'))→ 42
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array_median

Geeft de mediaan terug van rekenkundige waarden in een array. Niet-rekenkundige waarden in de array worden
genegeerd.

Syntaxis array_median(array)
Argumenten • array - een array

Voorbeelden • array_median(array(0,1,42,42,43))→ 42
• array_median(array(0,1,2,42,'a','b'))→ 1.5

array_min

Geeft de minimumwaarde uit een array terug.

Syntaxis array_min(array)
Argumenten • array - een array

Voorbeelden • array_min(array(43,42,54))→ 42

array_minority

Geeft de minst voorkomende waarden uit een array terug.

Syntaxis array_minority(array, [option=’all’])
[] markeert optionele argumenten

Argumenten • array - een array
• option=’all’ - een tekenreeks die de afhandeling van de teruggegeven waarden
specificeert. Geldige opties zĳn:

– all: Standaard, alle minst voorkomende waarden worden teruggegeven in een array.
– any: Geeft een van de minst voorkomende waarden terug.
– median: Geeft de mediaan van de minst voorkomende waarden terug. Niet-
rekenkundige waarden worden genegeerd.

– real_minority: Geeft de waarde terug die minder voorkomt dan de halve grootte van
de array.

Voorbeelden • array_minority(array(0,42,42), 'all')→ [ 0 ]
• array_minority(array(0,1,42,42), 'all')→ [ 0, 1 ]
• array_minority(array(0,1,42,42,43,1), 'any')→ 0 of 43
• array_minority(array(1,2,3,3), 'median')→ 1.5
• array_minority(array(0,1,42,42,43), 'real_minority') → [ 42,
43, 0, 1 ]

• array_minority(array(0,1,42,42,43,42), 'real_minority')→ [
42, 43, 0, 1 ]

• array_minority(array(0,1,42,42,43,42,42), 'real_minority')
→ [ 43, 0, 1 ]
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array_prepend

Geeft een array terug met de opgegeven waarde toegevoegd aan het begin.

Syntaxis array_prepend(array, value)
Argumenten • array - een array

• value - de toe te voegen waarde

Voorbeelden • array_prepend(array(1,2,3),0)→ [ 0, 1, 2, 3 ]

array_prioritize

Geeft een array terug die is gesorteerd op de volgorde die is gespecificeerd in een andere array. Waarden die aanwezig
zĳn in de eerste array, maar ontbreken in de tweede array zullen worden toegevoegd aan het einde van het resultaat.

Syntaxis array_prioritize(array, array_prioritize)
Argumenten • array - een array

• array_prioritize - een array met waarden die zĳn gesorteerd op prioriteit

Voorbeelden • array_prioritize(array(1, 8, 2, 5), array(5, 4, 2, 1, 3,
8))→ [ 5, 2, 1, 8 ]

• array_prioritize(array(5, 4, 2, 1, 3, 8), array(1, 8, 6,
5))→ [ 1, 8, 5, 4, 2, 3 ]

array_remove_all

Geeft een array terug waaruit alle items met de opgegeven waarde zĳn verwĳderd.

Syntaxis array_remove_all(array, value)
Argumenten • array - een array

• value - de te verwĳderen waarde

Voorbeelden • array_remove_all(array('a','b','c','b'),'b')→ [ ‘a’, ‘c’ ]

array_remove_at

Geeft een array terug waaruit het item op de opgegeven index is verwĳderd. Ondersteunt positieve (0 voor het eerste
element) en negatieve (de laatste -Ne waarde, -1 voor het laatste element) index.
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Syntaxis array_remove_at(array, pos)
Argumenten • array - een array

• pos - de te verwĳderen positie (0-gebaseerd)

Voorbeelden • array_remove_at(array(1, 2, 3), 1)→ [1, 3 ]
• array_remove_at(array(1, 2, 3), -1)→ [1, 2 ]

array_replace

Geeft een array terug waarin de opgegeven waarde, array, of kaart met waarden is vervangen.
Variant waarde & array
Geeft een array terug waarin de opgegeven waarde of array van waarden is vervangen door een waarde of een array
van waarden.

Syntaxis array_replace(array, before, after)
Argumenten • array - de invoerarray

• before - de te vervangen waarde of array van waarden
• after - de waarde of array van waarden die gebruikt moet worden als vervanging

Voorbeelden • array_replace(array('QGIS','SHOULD','ROCK'),'SHOULD',
'DOES')→ [ ‘QGIS’, ‘DOES’, ‘ROCK’ ]

• array_replace(array(3,2,1),array(1,2,3),array(7,8,9)) → [ 9,
8, 7 ]

• array_replace(array('Q','G','I','S'),array('Q','S'),'-') →
[ ‘-’, ‘G’, ‘I’, ‘-’ ]

Variant kaart
Geeft een array terug waarin de opgegeven kaartsleutels zĳn vervangen door hun gepaarde waarden

Syntaxis array_replace(array, map)
Argumenten • array - de invoerarray

• map - de kaart die de sleutels en waarden bevat

Voorbeelden • array_replace(array('APP', 'SHOULD', 'ROCK'),map('APP',
'QGIS','SHOULD','DOES'))→ [ ‘QGIS’, ‘DOES’, ‘ROCK’ ]
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array_reverse

Geeft een array terug van de opgegeven array met de waarden in omgekeerde volgorde.

Syntaxis array_reverse(array)
Argumenten • array - een array

Voorbeelden • array_reverse(array(2,4,0,10))→ [ 10, 0, 4, 2 ]

array_slice

Geeft een deel van de array terug. Het deel wordt gedefinieerd door de argumenten start_pos en end_pos.

Syntaxis array_slice(array, start_pos, end_pos)
Argumenten • array - een array

• start_pos - de index van de beginpositie van het deel (0-gebaseerd). De index start_pos is
opgenomen in het deel. Wanneer u een negatieve start_pos gebruikt, wordt de index geteld
vanaf het einde van de lĳst (-1-gebaseerd).

• end_pos - de index van de eindpositie van het deel (0-gebaseerd). De index end_pos is
opgenomen in het deel. Wanneer u een negatieve end_pos gebruikt, wordt de index geteld
vanaf het einde van de lĳst (-1-gebaseerd).

Voorbeelden • array_slice(array(1,2,3,4,5),0,3)→ [ 1, 2, 3, 4 ]
• array_slice(array(1,2,3,4,5),0,-1)→ [ 1, 2, 3, 4, 5 ]
• array_slice(array(1,2,3,4,5),-5,-1)→ [ 1, 2, 3, 4, 5 ]
• array_slice(array(1,2,3,4,5),0,0)→ [ 1 ]
• array_slice(array(1,2,3,4,5),-2,-1)→ [ 4, 5 ]
• array_slice(array(1,2,3,4,5),-1,-1)→ [ 5 ]
• array_slice(array('Dufour','Valmiera','Chugiak',
'Brighton'),1,2)→ [ ‘Valmiera’, ‘Chugiak’ ]

• array_slice(array('Dufour','Valmiera','Chugiak',
'Brighton'),-2,-1)→ [ ‘Chugiak’, ‘Brighton’ ]

array_sort

Geeft de opgegeven array terug met gesorteerde elementen.

Syntaxis array_sort(array, [ascending=true])
[] markeert optionele argumenten

Argumenten • array - een array
• ascending - stel deze parameter in op false om de array in aflopende volgorde te sorteren

Voorbeelden • array_sort(array(3,2,1))→ [ 1, 2, 3 ]
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array_sum

Geeft de som terug van rekenkundige waarden in een array. Niet-numerieke waarden in de array worden genegeerd.

Syntaxis array_sum(array)
Argumenten • array - een array

Voorbeelden • array_sum(array(0,1,39.4,1.6,'a'))→ 42.0

array_to_string

Voegt elementen van een array samen tot een tekenreeks, gescheiden door een scheidingsteken en een optionele
tekenreeks gebruikend voor lege waarden.

Syntaxis array_to_string(array, [delimiter=’,’], [empty_value=’’])
[] markeert optionele argumenten

Argumenten • array - de invoerarray
• delimiter - het tekenreeks scheidingsteken dat moet worden gebruikt voor het scheiden
van elementen van de array

• empty_value - de optionele tekenreeks die moet worden gebruikt als vervanging voor lege
(nul lengte) overeenkomsten

Voorbeelden • array_to_string(array('1','2','3'))→ ‘1,2,3’
• array_to_string(array(1,2,3),'-')→ ‘1-2-3’
• array_to_string(array('1','','3'),',','0')→ ‘1,0,3’

generate_series

Maakt een array die een reeks nummers bevat.

Syntaxis generate_series(start, stop, [step=1])
[] markeert optionele argumenten

Argumenten • start - eerste waarde van de reeks
• stop - waarde die de reeks beëindigt als die wordt bereikt
• step - waarde die wordt gebruikt als stap tussen de waarden

Voorbeelden • generate_series(1,5)→ [ 1, 2, 3, 4, 5 ]
• generate_series(5,1,-1)→ [ 5, 4, 3, 2, 1 ]
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geometries_to_array

Splitst een geometrie in eenvoudiger geometrieën in een array.

Syntaxis geometries_to_array(geometry)
Argumenten • geometry - de invoergeometrie

Voorbeelden • geometries_to_array(geom_from_wkt('GeometryCollection
(Polygon ((5 8, 4 1, 3 2, 5 8)),LineString (3 2, 4
2))'))→ an array of a polygon and a line geometries

• geom_to_wkt(geometries_to_array(geom_from_wkt('GeometryCollection
(Polygon ((5 8, 4 1, 3 2, 5 8)),LineString (3 2, 4 2))'))[0])
→ ‘Polygon ((5 8, 4 1, 3 2, 5 8))’

• geometries_to_array(geom_from_wkt('MULTIPOLYGON(((5 5,0 0,
0 10,5 5)),((5 5,10 10,10 0,5 5))')) → an array of two polygon
geometries

regexp_matches

Geeft een array terug van alle opgevangen tekenreeksen die zĳn gevangen door vang-groepen, in de volgorde waarin
de groepen zelf voorkomen in de opgegeven reguliere expressie voor een tekenreeks.

Syntaxis regexp_matches(string, regex, [empty_value=’’])
[] markeert optionele argumenten

Argumenten • string - de tekenreeks waaruit groepen moeten worden gevangen vanuit een reguliere
expressie

• regex - de reguliere expressie die wordt gebruikt voor het vangen van groepen
• empty_value - de optionele tekenreeks die moet worden gebruikt als vervanging voor lege
(nul lengte) overeenkomsten

Voorbeelden • regexp_matches('QGIS=>rocks','(.*)=>(.*)')→ [ ‘QGIS’, ‘rocks’ ]
• regexp_matches('key=>','(.*)=>(.*)','empty value') → [ ‘key’,
‘empty value’ ]

string_to_array

Splitst een tekenreeks in een array met het opgegeven scheidingsteken en de optionele tekenreeks voor lege waarden.

Syntaxis string_to_array(string, [delimiter=’,’], [empty_value=’’])
[] markeert optionele argumenten

Argumenten • string - de tekenreeks voor de invoer
• delimiter - het scheidingsteken voor de tekenreeks, gebruikt om de tekenreeks voor de
invoer te splitsen

• empty_value - de optionele tekenreeks die moet worden gebruikt als vervanging voor lege
(nul lengte) overeenkomsten

Voorbeelden • string_to_array('1,2,3',',')→ [ ‘1’, ‘2’, ‘3’ ]
• string_to_array('1,,3',',','0')→ [ ‘1’, ‘0’, ‘3’ ]

242 Hoofdstuk 13. Doe meer met expressies



QGIS Desktop 3.28 User Guide

13.2.3 Kleurfuncties

Deze groep bevat functies waarmee u kleuren kunt bewerken.

color_cmyk

Geeft een kleur terug in de weergave van een tekenreeks, gebaseerd op de componenten cyan, magenta, yellow en
black

Syntaxis color_cmyk(cyan, magenta, yellow, black)
Argumenten • cyan - component cyaan van de kleur, als een percentage waarde integer tussen 0 tot en

met 100
• magenta - component magenta van de kleur, als een percentage waarde integer tussen 0
tot en met 100

• yellow - component geel van de kleur, als een percentage waarde integer tussen 0 tot en
met 100

• black - component zwart van de kleur, als een percentage waarde integer tussen 0 tot en
met 100

Voorbeelden • color_cmyk(100,50,0,10)→ ‘0,115,230’

color_cmyka

Geeft een kleur terug in de weergave van een tekenreeks, gebaseerd op de componenten cyan, magenta, yellow, black
en alfa (transparantie)

Syntaxis color_cmyka(cyan, magenta, yellow, black, alpha)
Argumenten • cyan - component cyaan van de kleur, als een percentage waarde integer tussen 0 tot en

met 100
• magenta - component magenta van de kleur, als een percentage waarde integer tussen 0
tot en met 100

• yellow - component geel van de kleur, als een percentage waarde integer tussen 0 tot en
met 100

• black - component zwart van de kleur, als een percentage waarde integer tussen 0 tot en
met 100

• alpha - component alfa als een waarde integer tussen 0 (compleet transparant) tot en met
255 (ondoorzichtig).

Voorbeelden • color_cmyka(100,50,0,10,200)→ ‘0,115,230,200’
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color_grayscale_average

Past een filter grĳswaarden toe en geeft een weergave van een tekenreeks terug uit een opgegeven kleur.

Syntaxis color_grayscale_average(color)
Argumenten • color - een tekenreeks voor een kleur

Voorbeelden • color_grayscale_average('255,100,50')→ ‘135,135,135,255’

color_hsl

Geeft een kleur terug in de weergave van een tekenreeks, gebaseerd op de attributen tint, verzadiging en helderheid
ervan.

Syntaxis color_hsl(hue, saturation, lightness)
Argumenten • hue - tint van de kleur, als een waarde integer tussen 0 tot en met 360

• saturation - percentage verzadiging van de kleur, als een waarde integer tussen 0 tot en
met 100

• lightness - percentage helderheid van de kleur, als een waarde integer tussen 0 tot en met
100

Voorbeelden • color_hsl(100,50,70)→ ‘166,217,140’

color_hsla

Geeft een kleur terug in de weergave van een tekenreeks, gebaseerd op de attributen tint, verzadiging, helderheid en
alfa (transparantie)

Syntaxis color_hsla(hue, saturation, lightness, alpha)
Argumenten • hue - tint van de kleur, als een waarde integer tussen 0 tot en met 360

• saturation - percentage verzadiging van de kleur, als een waarde integer tussen 0 tot en
met 100

• lightness - percentage helderheid van de kleur, als een waarde integer tussen 0 tot en met
100

• alpha - component alfa als een waarde integer tussen 0 (compleet transparant) tot en met
255 (ondoorzichtig).

Voorbeelden • color_hsla(100,50,70,200)→ ‘166,217,140,200’
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color_hsv

Geeft een kleur terug in de weergave van een tekenreeks, gebaseerd op de attributen tint, verzadiging en waarde ervan.

Syntaxis color_hsv(hue, saturation, value)
Argumenten • hue - tint van de kleur, als een waarde integer tussen 0 tot en met 360

• saturation - percentage verzadiging van de kleur, als een waarde integer tussen 0 tot en
met 100

• value - percentage waarde van de kleur, als een waarde integer tussen 0 tot en met 100

Voorbeelden • color_hsv(40,100,100)→ ‘255,170,0’

color_hsva

Geeft een kleur terug in de weergave van een tekenreeks, gebaseerd op de attributen tint, verzadiging, waarde en alfa
(transparantie) ervan.

Syntaxis color_hsva(hue, saturation, value, alpha)
Argumenten • hue - tint van de kleur, als een waarde integer tussen 0 tot en met 360

• saturation - percentage verzadiging van de kleur, als een waarde integer tussen 0 tot en
met 100

• value - percentage waarde van de kleur, als een waarde integer tussen 0 tot en met 100
• alpha - component alfa als een waarde integer tussen 0 (compleet transparant) tot en met
255 (ondoorzichtig)

Voorbeelden • color_hsva(40,100,100,200)→ ‘255,170,0,200’

color_mix_rgb

Geeft een tekenreeks terug die een kleur weergeeft die de waarden rood, groen, blauw en alfa van de twee opgegeven
kleuren mengt, gebaseerd op een opgegeven verhouding.

Syntaxis color_mix_rgb(color1, color2, ratio)
Argumenten • color1 - een tekenreeks voor een kleur

• color2 - een tekenreeks voor een kleur
• ratio - een verhouding

Voorbeelden • color_mix_rgb('0,0,0','255,255,255',0.5)→ ‘127,127,127,255’
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color_part

Geeft een specifieke component uit een tekenreeks voor een kleur terug, bĳv, de rode component of alfa-component

Syntaxis color_part(color, component)
Argumenten • color - een tekenreeks voor een kleur

• component - een tekenreeks die correspondeert met de terug te geven kleurcomponent.
Geldige opties zĳn:

– red: RGB rode component (0-255)
– green: RGB groene component (0-255)
– blue: RGB blauwe component (0-255)
– alpha: alfa (transparantie) waarde (0-255)
– hue: HSV tint (0-360)
– saturation: HSV verzadiging (0-100)
– value: HSV waarde (0-100)
– hsl_hue: HSL tint (0-360)
– hsl_saturation: HSL verzadiging (0-100)
– lightness: HSL helderheid (0-100)
– cyan: CMYK cyaan component (0-100)
– magenta: CMYK magenta component (0-100)
– yellow: CMYK gele component (0-100)
– black: CMYK zwarte component (0-100)

Voorbeelden • color_part('200,10,30','green')→ 10

color_rgb

Geeft een kleur terug in de weergave van een tekenreeks, gebaseerd op de componenten rood, groen en blauw.

Syntaxis color_rgb(red, green, blue)
Argumenten • red - rode component als een waarde integer tussen 0 tot en met 255

• green - groene component als een waarde integer tussen 0 tot en met 255
• blue - blauwe component als een waarde integer tussen 0 tot en met 255

Voorbeelden • color_rgb(255,127,0)→ ‘255,127,0’
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color_rgba

Geeft een kleur terug in de weergave van een tekenreeks, gebaseerd op de componenten rood, groen en blauw en alfa
(transparantie).

Syntaxis color_rgba(red, green, blue, alpha)
Argumenten • red - rode component als een waarde integer tussen 0 tot en met 255

• green - groene component als een waarde integer tussen 0 tot en met 255
• blue - blauwe component als een waarde integer tussen 0 tot en met 255
• alpha - component alfa als een waarde integer tussen 0 (compleet transparant) tot en met
255 (ondoorzichtig).

Voorbeelden • color_rgba(255,127,0,200)→ ‘255,127,0,200’

create_ramp

Geeft een balk kleurverloop terug uit een kaart met tekenreeksen voor kleur en stappen.

Syntaxis create_ramp(map, [discrete=false])
[] markeert optionele argumenten

Argumenten • map - een kaart met tekenreeksen voor kleur en stappen
• discrete - stel deze parameter in op true om een balk met afzonderlĳke kleuren te maken

Voorbeelden • ramp_color(create_ramp(map(0,'0,0,0',1,'255,0,0')),1) →
‘255,0,0,255’

darker

Geeft een donkere (of lichtere) kleurenreeks terug

Syntaxis darker(color, factor)
Argumenten • color - een tekenreeks voor een kleur

• factor - een integer die correspondeert met de factor voor het donkerder maken;
– als de factor groter is dan 100 geeft deze functie een donkerder kleur terug (bĳv.,
instellen van de factor op 200 geeft een kleur terug die de helft van de helderheid is);

– als de factor kleiner is dan 100 is de teruggegeven kleur lichter, maar voor dat doel
wordt dan het gebruiken van de functie lighter() aanbevolen;

– als de factor 0 of negatief is, is de teruggegeven waarde niet gespecificeerd.

Voorbeelden • darker('200,10,30', 200)→ ‘100,5,15,255’

Lees verder: lighter
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lighter

Geeft een lichtere (of donkerder) kleurenreeks terug

Syntaxis lighter(color, factor)
Argumenten • color - een tekenreeks voor een kleur

• factor - een integer die correspondeert met de factor voor het lichter maken:
– als de factor groter is dan 100 geeft deze functie een lichtere kleur terug (bĳv.,
instellen van de factor op 150 geeft een kleur terug die 50% helderder is);

– als de factor kleiner is dan 100 is de teruggegeven kleur donkerder, maar voor dat
doel wordt dan het gebruiken van de functie darker() aanbevolen;

– als de factor 0 of negatief is, is de teruggegeven waarde niet gespecificeerd.

Voorbeelden • lighter('200,10,30', 200)→ ‘255,158,168,255’

Lees verder: darker

project_color

Geeft een kleur terug uit het kleurenschema van het project.

Syntaxis project_color(name)
Argumenten • name - de naam van een kleur

Voorbeelden • project_color('Logo color')→ ‘20,140,50’

Lees verder: setting project colors

ramp_color

Geeft een kleur vanuit een kleurenbalk terug in de weergave van een tekenreeks.
Variant Opgeslagen balk
Geeft een kleur vanuit een opgeslagen kleurenbalk terug in de weergave van een tekenreeks.

Syntaxis ramp_color(ramp_name, value)
Argumenten • ramp_name - de naam van de kleurenbalk als een tekenreeks, bĳvoorbeeld ‘Spectral’

• value - de positie op de balk om de kleur te selecteren als een getal real tussen 0 en 1

Voorbeelden • ramp_color('Spectral',0.3)→ ‘253,190,115,255’

Notitie: De beschikbare kleurenbalken variëren tussen installaties van QGIS. Deze functie zou niet het verwachte
resultaat kunnen geven als u uw project verplaatst tussen installaties van QGIS.

Variant Expressie gemaakte balk
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Geeft een tekenreeks terug vanuit een met een expressie gemaakte balk.

Syntaxis ramp_color(ramp, value)
Argumenten • ramp - de kleurenbalk

• value - de positie op de balk om de kleur te selecteren als een getal real tussen 0 en 1

Voorbeelden • ramp_color(create_ramp(map(0,'0,0,0',1,'255,0,0')),1) →
‘255,0,0,255’

Lees verder: Een kleurverloop instellen, De sneltoets voor keuzelĳst Kleurverloop

set_color_part

Stelt een specifieke kleurcomponent in voor een tekenreeks voor een kleur, bĳv, de rode component of alfa-
component.

Syntaxis set_color_part(color, component, value)
Argumenten • color - een tekenreeks voor een kleur

• component - een tekenreeks die correspondeert met de in te stellen kleurcomponent.
Geldige opties zĳn:

– red: RGB rode component (0-255)
– green: RGB groene component (0-255)
– blue: RGB blauwe component (0-255)
– alpha: alfa (transparantie) waarde (0-255)
– hue: HSV tint (0-360)
– saturation: HSV verzadiging (0-100)
– value: HSV waarde (0-100)
– hsl_hue: HSL tint (0-360)
– hsl_saturation: HSL verzadiging (0-100)
– lightness: HSL helderheid (0-100)
– cyan: CMYK cyaan component (0-100)
– magenta: CMYK magenta component (0-100)
– yellow: CMYK gele component (0-100)
– black: CMYK zwarte component (0-100)

• value - nieuwe waarde voor de kleurcomponent, rekening houdende met de bovenstaande
bereiken

Voorbeelden • set_color_part('200,10,30','green',50)→ ‘200,50,30,255’

13.2.4 Functies Voorwaarden

Deze groep bevat functies waarmee controles van voorwaarden kunnen worden opgenomen in een expressie.
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CASE

CASE wordt gebruikt om een reeks voorwaarden te evalueren en een resultaat terug te geven voor de eerste
voorwaarde waaraan wordt voldaan. De voorwaarden worden in een reeks geëvalueerd, en als een voorwaarde waar
is, stopt de evaluatie, en het corresponderende resultaat wordt teruggegeven. Als geen van de voorwaarden waar is,
wordt de waarde van de clausule ELSE teruggegeven. Verder, als er geen clausule ELSE is ingesteld en er niet aan de
voorwaarden wordt voldaan, wordt NULL teruggegeven.
CASE
WHEN voorwaarde THEN resultaat

[ …n ]
[ ELSE resultaat ]
END
[] markeert optionele argumenten

Argumenten • WHEN condition - Een expressie voor een voorwaarde om te evalueren
• THEN result - Als condition evalueert naar True dan wordt result geëvalueerd en
teruggegeven.

• THEN result - Als geen van bovenstaande voorwaarden evalueert naar True dan wordt
result geëvalueerd en teruggegeven.

Voorbeelden • CASE WHEN "name" IS NULL THEN 'None' END → Geeft de tekenreeks
‘None’ terug als het veld “name” NULL is

• CASE WHEN $area > 10000 THEN 'Big property' WHEN $area >
5000 THEN 'Medium property' ELSE 'Small property' END→Geeft
de tekenreeks ‘Big property’ terug als het gebied groter is dan 10000, ‘Medium property’
als het gebied tussen 5000 en 10000 groot is, en ‘Small property’ voor andere

coalesce

Geeft de eerste waarde terug die niet NULL is uit de lĳst van de expressie.
Deze functie mag elk aantal argumenten hebben.

Syntaxis coalesce(expression1, expression2, …)
Argumenten • expression - elke geldige expressie of waarde, ongeacht het type.

Voorbeelden • coalesce(NULL, 2)→ 2
• coalesce(NULL, 2, 3)→ 2
• coalesce(7, NULL, 3*2)→ 7
• coalesce("fieldA", "fallbackField", 'ERROR')→waarde van fieldA
als die niet NULL is, anders de waarde van “fallbackField” of de tekenreeks ‘ERROR’ als
beide NULL zĳn
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if

Test een voorwaarde en geeft een verschillend resultaat terug, afhankelĳk van de controle van de voorwaarde.

Syntaxis if(condition, result_when_true, result_when_false)
Argumenten • condition - de voorwaarde die moet worden gecontroleerd

• result_when_true - het resultaat zal worden teruggegeven als de voorwaarde true is of
een andere waarde die niet converteert naar false.

• result_when_false - het resultaat dat zal worden teruggegeven als de voorwaarde false
is of een andere waarde die converteert naar false, zoals 0 of ‘’. NULL zal ook worden
geconverteerd naar false.

Voorbeelden • if( 1+1=2, 'Yes', 'No' )→ ‘Yes’
• if( 1+1=3, 'Yes', 'No' )→ ‘No’
• if( 5 > 3, 1, 0)→ 1
• if( '', 'It is true (not empty)', 'It is false (empty)' )→
‘It is false (empty)’

• if( ' ', 'It is true (not empty)', 'It is false (empty)' )
→ ‘It is true (not empty)’

• if( 0, 'One', 'Zero' )→ ‘Zero’
• if( 10, 'One', 'Zero' )→ ‘One’

nullif

Geeft een waarde NULL terug als value1 gelĳk is aan value2, anders geeft het value1 terug. Dit kan worden gebruikt
om voorwaardelĳk waarden door NULL te vervangen.

Syntaxis nullif(value1, value2)
Argumenten • value1 - De waarde die zou moeten worden gebruikt of worden vervangen door NULL.

• value2 - De controlewaarde die het vervangen van NULL activeert.

Voorbeelden • nullif('(none)', '(none)')→ NULL
• nullif('text', '(none)')→ ‘text’
• nullif("name", '')→ NULL, als name een lege tekenreeks is (of al NULL), de
waarde van name in elke ander geval.
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regexp_match

Geeft de eerste overeenkomende positie van een reguliere expressie binnen een tekenreeks van Unicode terug, of 0
als de subtekenreeks niet wordt gevonden.

Syntaxis regexp_match(input_string, regex)
Argumenten • input_string - de tekenreeks die moet worden getest tegen de reguliere expressie

• regex - De reguliere expressie die getest moet worden. Tekens backslash moeten dubbel
worden geëscaped (bĳv. “\\s” om overeen te komen met een teken voor witruimte of “\\b”
om overeen te komen met een woordgrens)

Voorbeelden • regexp_match('QGIS ROCKS','\\sROCKS')→ 5
• regexp_match('Budač','udač\\b')→ 2

try

Probeert een expressie en geeft de waarde ervan terug indien zonder fouten. Als de expressie een fout teruggeeft zal
een alternatieve waarde worden teruggegeven, indien opgegeven, anders zal de functie NULL teruggeven.

Syntaxis try(expression, [alternative])
[] markeert optionele argumenten

Argumenten • expression - de expressie die zou moeten worden uitgevoerd
• alternative - het resultaat dat zal worden teruggegeven als de expressie een fout teruggeeft.

Voorbeelden • try( to_int( '1' ), 0 )→ 1
• try( to_int( 'a' ), 0 )→ 0
• try( to_date( 'invalid_date' ) )→ NULL

13.2.5 Functies Conversies

Deze groep bevat functies om een gegevenstype te converteren naar een ander type (bĳv string van/naar integer,
binary van/naar string, string naar date, …).

from_base64

Decodeert een tekenreeks vanuit de codering Base64 naar een binaire waarde.

Syntaxis from_base64(string)
Argumenten • string - de te decoderen tekenreeks

Voorbeelden • from_base64('UUdJUw==')→ ‘QGIS’
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hash

Maakt een hash vanuit een tekenreeks met een opgegeven methode. Één byte (8 bits) wordt weergegeven door twee
hex ‘’getallen’’, dus ‘md4’ (16 bytes) produceert een 16 * 2 = 32 tekens lange teksttekenreeks en ‘keccak_512’ (64
bytes) produceert een 64 * 2 = 128 tekens lange hex-tekenreeks.

Syntaxis hash(string, method)
Argumenten • string - de tekenreeks waaruit de hash moet worden gemaakt

• method - De methode voor het maken van de hash, waaronder ‘md4’, ‘md5’, ‘sha1’,
‘sha224’, ‘sha384’, ‘sha512’, ‘sha3_224’, ‘sha3_256’, ‘sha3_384’, ‘sha3_512’, ‘keccak_224’,
‘keccak_256’, ‘keccak_384’, ‘keccak_512’

Voorbeelden • hash('QGIS', 'md4')→ ‘c0fc71c241cdebb6e888cbac0e2b68eb’
• hash('QGIS', 'md5')→ ‘57470aaa9e22adaefac7f5f342f1c6da’
• hash('QGIS', 'sha1')→ ‘f87cfb2b74cdd5867db913237024e7001e62b114’
• hash('QGIS', 'sha224')→ ‘4093a619ada631c770f44bc643ead18fb393b93d6a6af1861fcfece0’
• hash('QGIS', 'sha256')→ ‘eb045cba7a797aaa06ac58830846e40c8e8c780bc0676d3393605fae50c05309’
• hash('QGIS', 'sha384')→ ‘91c1de038cc3d09fdd512e99f9dd9922efadc39ed21d3922e69a4305cc25506033aee388e554b78714c8734f9cd7e610’
• hash('QGIS', 'sha512')→ ‘c2c092f2ab743bf8edbeb6d028a745f30fc720408465ed369421f0a4e20fa5e27f0c90ad72d3f1d836eaa5d25cd39897d4cf77e19984668ef58da6e3159f18ac’
• hash('QGIS', 'sha3_224')→ ‘467f49a5039e7280d5d42fd433e80d203439e338eaabd701f0d6c17d’
• hash('QGIS', 'sha3_256')→ ‘540f7354b6b8a6e735f2845250f15f4f3ba4f666c55574d9e9354575de0e980f’
• hash('QGIS', 'sha3_384')→ ‘96052da1e77679e9a65f60d7ead961b287977823144786386eb43647b0901fd8516fa6f1b9d243fb3f28775e6dde6107’
• hash('QGIS', 'sha3_512')→ ‘900d079dc69761da113980253aa8ac0414a8bd6d09879a916228f8743707c4758051c98445d6b8945ec854ff90655005e02aceb0a2ffc6a0ebf818745d665349’
• hash('QGIS', 'keccak_224')→ ‘5b0ce6acef8b0a121d4ac4f3eaa8503c799ad4e26a3392d1fb201478’
• hash('QGIS', 'keccak_256')→ ‘991c520aa6815392de24087f61b2ae0fd56abbfeee4a8ca019c1011d327c577e’
• hash('QGIS', 'keccak_384')→ ‘c57a3aed9d856fa04e5eeee9b62b6e027cca81ba574116d3cc1f0d48a1ef9e5886ff463ea8d0fac772ee473bf92f810d’

md5

Maakt een md5-hash uit een tekenreeks.

Syntaxis md5(string)
Argumenten • string - de tekenreeks waaruit de hash moet worden gemaakt

Voorbeelden • md5('QGIS')→ ‘57470aaa9e22adaefac7f5f342f1c6da’

sha256

Maakt een sha256-hash uit een tekenreeks.

Syntaxis sha256(string)
Argumenten • string - de tekenreeks waaruit de hash moet worden gemaakt

Voorbeelden • sha256('QGIS')→ ‘eb045cba7a797aaa06ac58830846e40c8e8c780bc0676d3393605fae50c05309’
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to_base64

Codeert een binaire waarde naar een tekenreeks, met behulp van de codering Base64.

Syntaxis to_base64(value)
Argumenten • value - de te coderen binaire waarde

Voorbeelden • to_base64('QGIS')→ ‘UUdJUw==’

to_date

Converteert een tekenreeks naar een object date. Een optionele tekenreeks voor de indelingmagworden opgegeven om
de tekenreeks te parsen; bekĳk QDate::fromString of de documentatie van de functie format_date voor aanvullende
documentatie over de indeling. Standaard wordt de locale van de huidige gebruiker van QGIS gebruikt.

Syntaxis to_date(string, [format], [language])
[] markeert optionele argumenten

Argumenten • string - tekenreeks die een datumwaarde weergeeft
• format - indeling die moet worden gebruikt om de tekenreeks naar een date te converteren
• language - taal (kleine letters, twee- of drieletterige ISO 639-taalcode) gebruikt om
de tekenreeks naar een date te converteren. Standaard wordt de locale van de huidige
gebruiker van QGIS gebruikt.

Voorbeelden • to_date('2012-05-04')→ 2012-05-04
• to_date('June 29, 2019','MMMM d, yyyy')→ 2019-06-29, als de huidige
locale de naam ‘June’ gebruikt voor de zesde maand, anders treedt er een fout op

• to_date('29 juin, 2019','d MMMM, yyyy','fr')→ 2019-06-29

to_datetime

Converteert een tekenreeks naar een object datetime. Een optionele tekenreeks voor de indeling mag worden
opgegeven om de tekenreeks te parsen; bekĳk QDate::fromString, QTime::fromString of de documentatie van de
functie format_date voor aanvullende documentatie over de indeling. Standaard wordt de locale van de huidige
gebruiker van QGIS gebruikt.
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Syntaxis to_datetime(string, [format], [language])
[] markeert optionele argumenten

Argumenten • string - tekenreeks die een datum-/tĳdwaarde weergeeft
• format - indeling die moet worden gebruikt om de tekenreeks naar een datetime te
converteren

• language - taal (kleine letters, twee- of drieletterige ISO 639-taalcode) gebruikt om de
tekenreeks naar een datetime te converteren. Standaard wordt de locale van de huidige
gebruiker van QGIS gebruikt.

Voorbeelden • to_datetime('2012-05-04 12:50:00')→ 2012-05-04T12:50:00
• to_datetime('June 29, 2019 @ 12:34','MMMM d, yyyy @ HH:mm')
→ 2019-06-29T12:34, als de huidige locale de naam ‘June’ gebruikt voor de zesde maand,
anders treedt er een fout op

• to_datetime('29 juin, 2019 @ 12:34','d MMMM, yyyy @ HH:mm',
'fr')→ 2019-06-29T12:34

to_decimal

Converteert een coördinaat graden, minuten, seconden naar zĳn decimale equivalent.

Syntaxis to_decimal(value)
Argumenten • value - Een tekenreeks graden, minuten, seconden.

Voorbeelden • to_decimal('6°21\'16.445')→ 6.3545680555

to_dm

Converteert een coördinaat naar graden, minuten.

Syntaxis to_dm(coordinate, axis, precision, [formatting=])
[] markeert optionele argumenten

Argumenten • coordinate - Een waarde latitude of longitude.
• axis - De as van het coördinaat. Ofwel ‘x’ of ‘y’.
• precision - Aantal decimalen.
• formatting - Bepaalt het type indeling. Toegestane waarden zĳn NULL (standaard),
‘aligned’ of ‘suffix’.

Voorbeelden
• to_dm(6.1545681, 'x', 3)→ 6°9.274′
• to_dm(6.1545681, 'y', 4, 'aligned')→ 6°09.2741′N
• to_dm(6.1545681, 'y', 4, 'suffix')→ 6°9.2741′N
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to_dms

Converteert een coördinaat naar graden, minuten, seconden.

Syntaxis to_dms(coordinate, axis, precision, [formatting=])
[] markeert optionele argumenten

Argumenten • coordinate - Een waarde latitude of longitude.
• axis - De as van het coördinaat. Ofwel ‘x’ of ‘y’.
• precision - Aantal decimalen.
• formatting - Bepaalt het type indeling. Toegestane waarden zĳn NULL (standaard),
‘aligned’ of ‘suffix’.

Voorbeelden
• to_dms(6.1545681, 'x', 3)→ 6°9′16.445′′
• to_dms(6.1545681, 'y', 4, 'aligned')→ 6°09′16.4452′′N
• to_dms(6.1545681, 'y', 4, 'suffix')→ 6°9′16.4452′′N

to_int

Converteert een tekenreeks naar een getal integer. Niets wordt teruggegeven als een waarde niet kan worden
geconverteerd naar integer (bĳv. ‘123asd’ is ongeldig).

Syntaxis to_int(string)
Argumenten • string - tekenreeks die moet worden geconverteerd naar een getal integer

Voorbeelden • to_int('123')→ 123

to_interval

Converteert een tekenreeks naar een type interval. Kan worden gebruikt om dagen, uren, maanden, etc. uit een datum
te halen.

Syntaxis to_interval(string)
Argumenten • string - een tekenreeks die een interval weergeeft. Toegestane indelingen omvatten {n}

days {n} hours {n} months.

Voorbeelden • to_interval('1 day 2 hours')→ interval: 1.08333 days
• to_interval( '0.5 hours' )→ interval: 30 minutes
• to_datetime('2012-05-05 12:00:00') - to_interval('1 day 2
hours')→ 2012-05-04T10:00:00
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to_real

Converteert een tekenreeks naar een getal real. Niets wordt teruggegeven als een waarde niet kan worden
geconverteerd naar real (bĳv. ‘123.56asd’ is ongeldig). Getallen worden afgerond na het opslaan van wĳzigingen
als de precisie kleiner is dan het resultaat van de conversie.

Syntaxis to_real(string)
Argumenten • string - tekenreeks die moet worden geconverteerd naar een getal real

Voorbeelden • to_real('123.45')→ 123.45

to_string

Converteert een getal naar een tekenreeks.

Syntaxis to_string(number)
Argumenten • number - Waarde integer of real. Het getal dat moet worden geconverteerd naar een

tekenreeks.

Voorbeelden • to_string(123)→ ‘123’

to_time

Converteert een tekenreeks naar een object time. Een optionele tekenreeks voor de indeling mag worden opgegeven
om de tekenreeks te parsen; bekĳk QTime::fromString voor aanvullende documentatie over de indeling.

Syntaxis to_time(string, [format], [language])
[] markeert optionele argumenten

Argumenten • string - tekenreeks die een tĳdwaarde weergeeft
• format - indeling die moet worden gebruikt om de tekenreeks naar een time te converteren
• language - taal (kleine letters, twee- of drieletterige ISO 639-taalcode) gebruikt om de
tekenreeks naar een time te converteren

Voorbeelden • to_time('12:30:01')→ 12:30:01
• to_time('12:34','HH:mm')→ 12:34:00
• to_time('12:34','HH:mm','fr')→ 12:34:00
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13.2.6 Aangepaste functies

Deze groep bevat functies die door de gebruiker zĳn gedefinieerd. Bekĳk Functiebewerker voor meer details.

13.2.7 Datum en tijd functies

Deze groep bevat functies voor het afhandelen van datum en tĳdgegevens. Deze groep deelt ook verscheidene functies
met de groepen Functies Conversies (to_date, to_time, to_datetime, to_interval) en Tekstfuncties (format_date).

Notitie: Datum en datum/tĳd en intervallen opslaan in velden
De mogelĳkheid om waarden date, time en datetime direct op te slaan in velden is afhankelĳk van de provider van
de gegevensbron (bĳv., Shapefiles accepteren de indeling date, maar niet de indelingen datetime of time). Hieronder
volgen enkele suggesties om deze beperking te omzeilen:

• date, datetime en time kunnen worden geconverteerd en opgeslagen in velden type tekst met de functie
format_date().

• Intervallen kunnen worden opgeslagen in velden type integer of decimal na het gebruiken van een van de
functies voor het uitnemen van de datum (bĳv. day() om de interval uitgedrukt te krĳgen in dagen)

age

Geeft het verschil terug tussen twee dates of datetimes.
Het verschil wordt teruggegeven als een Interval en moet worden gebruikt met een van de volgende functies om
bruikbare informatie uit te kunnen nemen:

• year

• month

• week

• day

• hour

• minute

• second

Syntaxis age(datetime1, datetime2)
Argumenten • datetime1 - een tekenreeks, date of datetime die de laatste datum weergeeft

• datetime2 - een tekenreeks, date of datetime die de eerdere datum weergeeft

Voorbeelden • day(age('2012-05-12','2012-05-02'))→ 10
• hour(age('2012-05-12','2012-05-02'))→ 240
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datetime_from_epoch

Geeft een datetime terug waarvan de datum en tĳd het getal in milliseconden, msecs, is die zĳn verstreken sinds
1970-01-01T00:00:00.000, Coordinated Universal Time (Qt.UTC), en geconverteerd naar Qt.LocalTime.

Syntaxis datetime_from_epoch(int)
Argumenten • int - getal (milliseconden)

Voorbeelden • datetime_from_epoch(1483225200000)→ 2017-01-01T00:00:00

day

Neemt de dag uit een datum, of het aantal dagen vanaf een interval.
Variant Date
Neemt de dag uit een date of een datetime.

Syntaxis day(date)
Argumenten • date - een waarde date of datetime

Voorbeelden • day('2012-05-12')→ 12

Variant Interval
Berekent de lengte van een interval in dagen.

Syntaxis day(interval)
Argumenten • interval - waarde interval waarvan het aantal dagen moet worden teruggegeven

Voorbeelden • day(to_interval('3 days'))→ 3
• day(to_interval('3 weeks 2 days'))→ 23
• day(age('2012-01-01','2010-01-01'))→ 730

day_of_week

Geeft de dag van de week terug voor een gespecificeerde date of datetime. De teruggegeven waarde ligt tussen 0 tot
en met 6, waar 0 correspondeert met een zondag en 6 met een zaterdag.

Syntaxis day_of_week(date)
Argumenten • date - waarde date of datetime

Voorbeelden • day_of_week(to_date('2015-09-21'))→ 1
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epoch

Geeft de interval in milliseconden terug tussen de unix epoch en een opgegeven waarde date

Syntaxis epoch(date)
Argumenten • date - een waarde date of datetime

Voorbeelden • epoch(to_date('2017-01-01'))→ 1483203600000

format_date

Maakt een type date of tekenreeks op in een aangepaste indeling voor de tekenreeks. Gebruikt Qt date/time-indeling
tekenreeksen. Bekĳk QDateTime::fromString.
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Syntaxis format_date(datetime, format, [language])
[] markeert optionele argumenten

Argumenten • datetime - waarde date, time of datetime
• format - Tekenreekssjabloon datmoet worden gebruikt voor het indelen van de tekenreeks.

Expressie Uitvoer
d de dag als getal zonder voorloopnul (1 tot en met 31)
dd de dag als getal met voorloopnul (01 tot en met 31)
ddd de verkorte gelokaliseerde naam van de dag (bĳv. ‘maa’ tot en met

‘zon’)
dddd de lange gelokaliseerde naam van de dag (bĳv. ‘maandag’ tot en met

‘zondag’)
M de maand als getal zonder voorloopnul (1-12)
MM de maand als getal met voorloopnul (01-12)
MMM de verkorte gelokaliseerde naam van de maand (bĳv. ‘jan’ tot en met

‘dec’)
MMMM de lange gelokaliseerde naam van de maand (bĳv. ‘januari’ tot en met

‘december’)
yy het jaar als een cĳfer met twee getallen (00-99)
yyyy het jaar als een cĳfer met vier getallen

Deze expressies kunnen worden gebruikt voor het tĳdsgedeelte van de indeling van de
tekenreeks:

Expressie Uitvoer
h het uur als getal zonder voorloopnul (0 tot en met 23 of 1 tot en met

12 met weergave AM/PM)
hh het uur als getal met voorloopnul (00 tot en met 23 of 01 tot en met

12 met weergave AM/PM)
H het uur als getal zonder voorloopnul (0 tot en met 23, zelfs met

weergave AM/PM)
HH het uur als getal met voorloopnul (00 tot en met 23, zelfs met

weergave AM/PM)
m de minuut als getal zonder voorloopnul (0 tot en met 59)
mm de minuut als getal met voorloopnul (00 tot en met 59)
s de seconde als getal zonder voorloopnul (0 tot en met 59)
ss de seconde als getal met voorloopnul (00 tot en met 59)
z de milliseconden zonder achterliggende nullen (0 tot en met 999)
zzz de milliseconden met achterliggende nullen (000 tot en met 999)
AP or A geïnterpreteerd als een tĳd AM/PM. AP moet zĳn ofwel ‘AM’ of

‘PM’.
ap or a geïnterpreteerd als een tĳd AM/PM. apmoet zĳn ofwel ‘am’ of ‘pm’.

• language - taal (kleine letters, twee- of drieletterige ISO 639-taalcode <https:
//en.wikipedia.org/wiki/List_of_ISO_639-1_codes>`_) gebruikt om de date als een
aangepaste tekenreeks op te maken. Standaard wordt de locale van de huidige gebruiker
van QGIS gebruikt.

Voorbeelden • format_date('2012-05-15','dd.MM.yyyy')→ ‘15.05.2012’
• format_date('2012-05-15','d MMMM yyyy','fr')→ ‘15 mai 2012’
• format_date('2012-05-15','dddd') → ‘Tuesday’, als de huidige locale een
Engelse variant is

• format_date('2012-05-15 13:54:20','dd.MM.yy')→ ‘15.05.12’
• format_date('13:54:20','hh:mm AP')→ ‘01:54 PM’
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hour

Neemt het gedeelte uur uit een datetime of time, of het aantal uren vanaf een interval
Variant Time
Neemt het gedeelte uur uit een time of datetime.

Syntaxis hour(datetime)
Argumenten • datetime - een waarde time of datetime

Voorbeelden • hour( to_datetime('2012-07-22 13:24:57') )→ 13

Variant Interval
Berekent de lengte van een interval in uren.

Syntaxis hour(interval)
Argumenten • interval - waarde interval waarvan het aantal uren moet worden teruggegeven

Voorbeelden • hour(to_interval('3 hours'))→ 3
• hour(age('2012-07-22T13:00:00','2012-07-22T10:00:00'))→ 3
• hour(age('2012-01-01','2010-01-01'))→ 17520

make_date

Maakt een waarde date uit getallen voor jaar, maand en dag.

Syntaxis make_date(year, month, day)
Argumenten • year - Getal jaar. Jaren 1 tot en met 99 worden geïnterpreteerd zoals zĳ zĳn. Jaar 0 is

ongeldig.
• month - Getald maand, waar 1=januari
• day - Getal dag, beginnend met 1 voor de eerste dag in de maand

Voorbeelden • make_date(2020,5,4)→ waarde date 2020-05-04

make_datetime

Maakt een waarde datetime uit getallen voor jaar, maand, dag, uur, minuut en seconde.
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Syntaxis make_datetime(year, month, day, hour, minute, second)
Argumenten • year - Getal jaar. Jaren 1 tot en met 99 worden geïnterpreteerd zoals zĳ zĳn. Jaar 0 is

ongeldig.
• month - Getald maand, waar 1=januari
• day - Getal dag, beginnend met 1 voor de eerste dag in de maand
• hour - Getal uur
• minute - Getal minuut
• second - Seconden (fractionele waarden bevatten milliseconden)

Voorbeelden • make_datetime(2020,5,4,13,45,30.5) → waarde datetime 2020-05-04
13:45:30.500

make_interval

Maakt een waarde interval uit waarden jaren, maanden, weken, dagen, uren, minuten en seconden.

Syntaxis make_interval([years=0], [months=0], [weeks=0], [days=0], [hours=0], [minutes=0],
[seconds=0])
[] markeert optionele argumenten

Argumenten • years - Aantal jaren (gaat uit van 365,25 dagen in een jaar).
• months - Aantal maanden (gaat uit van 30 dagen in een maand)
• weeks - Aantal weken
• days - Aantal dagen
• hours - Aantal uren
• minutes - Aantal minuten
• seconds - Aantal seconden

Voorbeelden • make_interval(hours:=3)→ interval: 3 hours
• make_interval(days:=2, hours:=3)→ interval: 2.125 days
• make_interval(minutes:=0.5, seconds:=5)→ interval: 35 seconds

make_time

Maakt een waarde time uit getallen voor uur, minuut en seconde.

Syntaxis make_time(hour, minute, second)
Argumenten • hour - Getal uur

• minute - Getal minuut
• second - Seconden (fractionele waarden bevatten milliseconden)

Voorbeelden • make_time(13,45,30.5)→ waarde time 13:45:30.500
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minute

Neemt het gedeelte minuten uit een datetime of time, of het aantal minuten vanaf een interval.
Variant Time
Neemt het gedeelte minuten uit een time of datetime.

Syntaxis minute(datetime)
Argumenten • datetime - een waarde time of datetime

Voorbeelden • minute( to_datetime('2012-07-22 13:24:57') )→ 24

Variant Interval
Berekent de lengte van een interval in minuten.

Syntaxis minute(interval)
Argumenten • interval - waarde interval waarvan het aantal minuten moet worden teruggegeven

Voorbeelden • minute(to_interval('3 minutes'))→ 3
• minute(age('2012-07-22T00:20:00','2012-07-22T00:00:00')) →
20

• minute(age('2012-01-01','2010-01-01'))→ 1051200

month

Neemt het gedeelte maand uit een date, of het aantal maanden vanaf een interval
Variant Date
Neemt het gedeelte maand uit een date of een datetime.

Syntaxis month(date)
Argumenten • date - een waarde date of datetime

Voorbeelden • month('2012-05-12')→ 05

Variant Interval
Berekent de lengte van een interval in maanden.

Syntaxis month(interval)
Argumenten • interval - waarde interval waarvan het aantal maanden moet worden teruggegeven

Voorbeelden • month(to_interval('3 months'))→ 3
• month(age('2012-01-01','2010-01-01'))→ 4.03333

264 Hoofdstuk 13. Doe meer met expressies



QGIS Desktop 3.28 User Guide

now

Geeft de huidige datum en tĳd terug. De functie is statisch en zal bĳ het evalueren consistente resultaten teruggeven.
De teruggegeven tĳd is de tĳd waarop de expressie werd voorbereid.

Syntaxis now()
Voorbeelden • now()→ 2012-07-22T13:24:57

second

Neemt het gedeelte seconde uit een datetime of time, of het aantal seconden vanaf een interval.
Variant Time
Neemt het gedeelte seconde uit een time of datetime.

Syntaxis second(datetime)
Argumenten • datetime - een waarde time of datetime

Voorbeelden • second( to_datetime('2012-07-22 13:24:57') )→ 57

Variant Interval
Berekent de lengte van een interval in seconden.

Syntaxis second(interval)
Argumenten • interval - waarde interval waarvan het aantal seconden moet worden teruggegeven

Voorbeelden • second(to_interval('3 minutes'))→ 180
• second(age('2012-07-22T00:20:00','2012-07-22T00:00:00')) →
1200

• second(age('2012-01-01','2010-01-01'))→ 63072000

to_date

Converteert een tekenreeks naar een object date. Een optionele tekenreeks voor de indelingmagworden opgegeven om
de tekenreeks te parsen; bekĳk QDate::fromString of de documentatie van de functie format_date voor aanvullende
documentatie over de indeling. Standaard wordt de locale van de huidige gebruiker van QGIS gebruikt.
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Syntaxis to_date(string, [format], [language])
[] markeert optionele argumenten

Argumenten • string - tekenreeks die een datumwaarde weergeeft
• format - indeling die moet worden gebruikt om de tekenreeks naar een date te converteren
• language - taal (kleine letters, twee- of drieletterige ISO 639-taalcode) gebruikt om
de tekenreeks naar een date te converteren. Standaard wordt de locale van de huidige
gebruiker van QGIS gebruikt.

Voorbeelden • to_date('2012-05-04')→ 2012-05-04
• to_date('June 29, 2019','MMMM d, yyyy')→ 2019-06-29, als de huidige
locale de naam ‘June’ gebruikt voor de zesde maand, anders treedt er een fout op

• to_date('29 juin, 2019','d MMMM, yyyy','fr')→ 2019-06-29

to_datetime

Converteert een tekenreeks naar een object datetime. Een optionele tekenreeks voor de indeling mag worden
opgegeven om de tekenreeks te parsen; bekĳk QDate::fromString, QTime::fromString of de documentatie van de
functie format_date voor aanvullende documentatie over de indeling. Standaard wordt de locale van de huidige
gebruiker van QGIS gebruikt.

Syntaxis to_datetime(string, [format], [language])
[] markeert optionele argumenten

Argumenten • string - tekenreeks die een datum-/tĳdwaarde weergeeft
• format - indeling die moet worden gebruikt om de tekenreeks naar een datetime te
converteren

• language - taal (kleine letters, twee- of drieletterige ISO 639-taalcode) gebruikt om de
tekenreeks naar een datetime te converteren. Standaard wordt de locale van de huidige
gebruiker van QGIS gebruikt.

Voorbeelden • to_datetime('2012-05-04 12:50:00')→ 2012-05-04T12:50:00
• to_datetime('June 29, 2019 @ 12:34','MMMM d, yyyy @ HH:mm')
→ 2019-06-29T12:34, als de huidige locale de naam ‘June’ gebruikt voor de zesde maand,
anders treedt er een fout op

• to_datetime('29 juin, 2019 @ 12:34','d MMMM, yyyy @ HH:mm',
'fr')→ 2019-06-29T12:34
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to_interval

Converteert een tekenreeks naar een type interval. Kan worden gebruikt om dagen, uren, maanden, etc. uit een datum
te halen.

Syntaxis to_interval(string)
Argumenten • string - een tekenreeks die een interval weergeeft. Toegestane indelingen omvatten {n}

days {n} hours {n} months.

Voorbeelden • to_interval('1 day 2 hours')→ interval: 1.08333 days
• to_interval( '0.5 hours' )→ interval: 30 minutes
• to_datetime('2012-05-05 12:00:00') - to_interval('1 day 2
hours')→ 2012-05-04T10:00:00

to_time

Converteert een tekenreeks naar een object time. Een optionele tekenreeks voor de indeling mag worden opgegeven
om de tekenreeks te parsen; bekĳk QTime::fromString voor aanvullende documentatie over de indeling.

Syntaxis to_time(string, [format], [language])
[] markeert optionele argumenten

Argumenten • string - tekenreeks die een tĳdwaarde weergeeft
• format - indeling die moet worden gebruikt om de tekenreeks naar een time te converteren
• language - taal (kleine letters, twee- of drieletterige ISO 639-taalcode) gebruikt om de
tekenreeks naar een time te converteren

Voorbeelden • to_time('12:30:01')→ 12:30:01
• to_time('12:34','HH:mm')→ 12:34:00
• to_time('12:34','HH:mm','fr')→ 12:34:00

week

Neemt het weeknummer uit een date, of het aantal weken vanaf een interval
Variant Date
Neemt het weeknummer uit een date of een datetime.

Syntaxis week(date)
Argumenten • date - een waarde date of datetime

Voorbeelden • week('2012-05-12')→ 19

Variant Interval
Berekent de lengte van een interval in weken.
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Syntaxis week(interval)
Argumenten • interval - waarde interval waarvan het aantal maanden moet worden teruggegeven

Voorbeelden • week(to_interval('3 weeks'))→ 3
• week(age('2012-01-01','2010-01-01'))→ 104.285

year

Neemt het deel jaar uit een date, of het aantal jaren vanaf een interval
Variant Date
Neemt het gedeelte jaar uit een date of een datetime.

Syntaxis year(date)
Argumenten • date - een waarde date of datetime

Voorbeelden • year('2012-05-12')→ 2012

Variant Interval
Berekent de lengte van een interval in jaren.

Syntaxis year(interval)
Argumenten • interval - waarde interval waarvan het aantal jaren moet worden teruggegeven

Voorbeelden • year(to_interval('3 years'))→ 3
• year(age('2012-01-01','2010-01-01'))→ 1.9986

Enkele voorbeelden:
Naast deze functies, aftrekken van datums, datum/tĳden of tĳden met behulp van de operator - (minus) zal een
interval teruggeven.
Optellen of aftrekken van een interval bĳ datums, datum/tĳden of tĳden, met behulp van de operatoren + (plus) en
- (minus), zal een datetime teruggeven.

• Haal het aantal dagen op tot de uitgave van QGIS 3.0:

to_date('2017-09-29') - to_date(now())
-- Returns <interval: 203 days>

• Hetzelfde met tĳd:

to_datetime('2017-09-29 12:00:00') - now()
-- Returns <interval: 202.49 days>

• Haal de datum/tĳd op tot 100 dagen vanaf nu:

now() + to_interval('100 days')
-- Returns <datetime: 2017-06-18 01:00:00>
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13.2.8 Velden en waarden

Bevat een lĳst met velden uit de actieve laag, en speciale waarden. De lĳst met velden is inclusief die welke zĳn
opgeslagen in de gegevensset, virtueel en hulp als ook van joins.
Dubbelklik op de naam van een veld om dat toe te voegen aan uw expressie. U kunt ook de naam van het veld typen
(bĳ voorkeur tussen dubbele aanhalingstekens) of het alias daarvan.
Selecteer, om waarden van velden op te halen om in een expressie te gebruiken, het toepasselĳke veld en, in het
weergegeven widget, kies tussen 10 voorbeelden en Alle unieke. Gevraagde waarden worden dan weergegeven en u
kunt het vak Zoeken aan de bovenkant van de lĳst gebruiken om het resultaat te filteren. Toegang tot voorbeeldwaarden
kan ook worden gekregen door met rechts te klikken op een veld.
Een waarde toevoegen aan een expressie die u schrĳft: dubbelklik erop in de lĳst. Als de waarde van het type string
is, moet het tussen enkele aanhalingstekens staan, anders zĳn geen aanhalingstekens nodig.

NULL

Is gelĳk aan waarde NULL.

Syntaxis NULL
Voorbeelden • NULL→ een waarde NULL

Notitie: Gebruik, om te testen op NULL, een expressie IS NULL of IS NOT NULL.

13.2.9 Functies voor bestanden en paden

Deze groep bevat functies waarmee u bestands- en padnamen kunt bewerken.

base_file_name

Geeft de basisnaam terug van het bestand, zonder de map of achtervoegsel voor het bestand (extensie).

Syntaxis base_file_name(path)
Argumenten • path - een bestandspad of een waarde van een kaartlaag. Als een waarde van een kaartlaag

is gespecificeerd dan zal de bestandsbron van de laag worden gebruikt.

Voorbeelden • base_file_name('/home/qgis/data/country_boundaries.shp') →
‘country_boundaries’
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exif

Haalt tags exif op uit een afbeeldingsbestand.

Syntaxis exif(path, [tag])
[] markeert optionele argumenten

Argumenten • path - een bestandspad voor een afbeelding of een waarde van een kaartlaag. Als een
waarde van een kaartlaag is gespecificeerd dan zal de bestandsbron van de laag worden
gebruikt.

• tag - De terug te geven tag. Indien leeg zal een kaart met alle waarden van tags exif worden
teruggegeven.

Voorbeelden • exif('/my/photo.jpg','Exif.Image.Orientation')→ 0

file_exists

Geeft TRUE terug als een bestandspad bestaat.

Syntaxis file_exists(path)
Argumenten • path - een bestandspad of een waarde van een kaartlaag. Als een waarde van een kaartlaag

is gespecificeerd dan zal de bestandsbron van de laag worden gebruikt.

Voorbeelden • file_exists('/home/qgis/data/country_boundaries.shp') →
TRUE

file_name

Geeft de naam terug van een bestand, (inclusief de bestandsextensie), maar zonder de map.

Syntaxis file_name(path)
Argumenten • path - een bestandspad of een waarde van een kaartlaag. Als een waarde van een kaartlaag

is gespecificeerd dan zal de bestandsbron van de laag worden gebruikt.

Voorbeelden • file_name('/home/qgis/data/country_boundaries.shp') →
‘country_boundaries.shp’
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file_path

Geeft de component map terug van een bestandspad. Dit bevat niet de bestandsnaam.

Syntaxis file_path(path)
Argumenten • path - een bestandspad of een waarde van een kaartlaag. Als een waarde van een kaartlaag

is gespecificeerd dan zal de bestandsbron van de laag worden gebruikt.

Voorbeelden • file_path('/home/qgis/data/country_boundaries.shp') →
‘/home/qgis/data’

file_size

Geeft de grootte (in bytes) terug van een bestand.

Syntaxis file_size(path)
Argumenten • path - een bestandspad of een waarde van een kaartlaag. Als een waarde van een kaartlaag

is gespecificeerd dan zal de bestandsbron van de laag worden gebruikt.

Voorbeelden • file_size('/home/qgis/data/country_boundaries.geojson') →
5674

file_suffix

Geeft het achtervoegsel (extensie) terug uit een bestandspad.

Syntaxis file_suffix(path)
Argumenten • path - een bestandspad of een waarde van een kaartlaag. Als een waarde van een kaartlaag

is gespecificeerd dan zal de bestandsbron van de laag worden gebruikt.

Voorbeelden • file_suffix('/home/qgis/data/country_boundaries.shp')→ ‘shp’

is_directory

Geeft TRUE terug als een pad correspondeert met een map.

Syntaxis is_directory(path)
Argumenten • path - een bestandspad of een waarde van een kaartlaag. Als een waarde van een kaartlaag

is gespecificeerd dan zal de bestandsbron van de laag worden gebruikt.

Voorbeelden • is_directory('/home/qgis/data/country_boundaries.shp') →
FALSE

• is_directory('/home/qgis/data/')→ TRUE
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is_file

Geeft TRUE terug als een pad correspondeert met een bestand.

Syntaxis is_file(path)
Argumenten • path - een bestandspad of een waarde van een kaartlaag. Als een waarde van een kaartlaag

is gespecificeerd dan zal de bestandsbron van de laag worden gebruikt.

Voorbeelden • is_file('/home/qgis/data/country_boundaries.shp')→ TRUE
• is_file('/home/qgis/data/')→ FALSE

13.2.10 Formulierfuncties

Deze groep bevat functies die exclusief werken op de context van attribuutformulieren. Bĳvoorbeeld in instellingen
voor veldwidgets.

current_parent_value

Alleen te gebruiken in de context van een ingebed formulier geeft deze functie de huidige niet opgeslagen waarde terug
van een veld in het ouderformulier dat momenteel wordt bewerkt. Dit zal verschillen van de feitelĳke attribuutwaarden
van het ouderobject voor objecten die momenteel worden bewerkt of nog niet zĳn toegevoegd aan een ouderlaag.
Indien gebruikt in een filterexpressie voor een widget waarde-relatie, zou deze functie moeten worden verpakt in een
‘coalesce()’ die het feitelĳke ouderobject kan ophalen uit de laag als het formulier niet wordt gebruikt in een ingebedde
context.

Syntaxis current_parent_value(field_name)
Argumenten • field_name - een veldnaam in het huidige ouderformulier

Voorbeelden • current_parent_value( 'FIELD_NAME' )→De huidige waarde van het veld
‘FIELD_NAME’ in het ouderformulier.

current_value

Geeft de huidige niet opgeslagen waarde terug van een veld in het formulier of tabelrĳ dat momenteel wordt bewerkt.
Dit zal verschillen van de feitelĳke attribuutwaarden van het object voor objecten die momenteel worden bewerkt of
nog niet zĳn toegevoegd aan een laag.

Syntaxis current_value(field_name)
Argumenten • field_name - een veldnaam in het huidige formulier of tabelrĳ

Voorbeelden • current_value( 'FIELD_NAME' ) → De huidige waarde van het veld
‘FIELD_NAME’.
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13.2.11 Functies voor fuzzy overeenkomsten

Deze groep bevat functies voor fuzzy vergelĳkingen tussen waarden.

hamming_distance

Geeft de Hamming-afstand terug voor twee tekenreeksen. Dit komt overeen met het aantal tekens op
corresponderende posities in de tekenreeksen voor de invoer waar de tekens van elkaar verschillen. De tekenreeksen
voor de invoer moeten van dezelfde lengte zĳn, en de vergelĳking is hoofdlettergevoelig.

Syntaxis hamming_distance(string1, string2)
Argumenten • string1 - een tekenreeks

• string2 - een tekenreeks

Voorbeelden • hamming_distance('abc','xec')→ 2
• hamming_distance('abc','ABc')→ 2
• hamming_distance(upper('abc'),upper('ABC'))→ 0
• hamming_distance('abc','abcd')→ NULL

levenshtein

Geeft de Levenshtein-bewerkingsafstand terug voor twee tekenreeksen. Dit komt overeen met het minimale aantal
bewerkingen van tekens (invoegingen, verwĳderingen of vervangingen) vereist om de ene tekenreeks te vervangen
door de andere.
De Levenshtein-afstand is een meting van de overeenkomst tussen twee tekenreeksen. Kleinere afstanden betekenen
dat de tekenreeksen meer overeenkomen, en grotere afstanden gevenmeer verschillende tekenreeksen aan. De afstand
is hoofdlettergevoelig.

Syntaxis levenshtein(string1, string2)
Argumenten • string1 - een tekenreeks

• string2 - een tekenreeks

Voorbeelden • levenshtein('kittens','mitten')→ 2
• levenshtein('Kitten','kitten')→ 1
• levenshtein(upper('Kitten'),upper('kitten'))→ 0

longest_common_substring

Geeft de langste overeenkomende subtekenreeks tussen twee tekenreeksen terug. Deze subtekenreeks is de langste
tekenreeks die een subtekenreeks is van de twee tekenreeksen voor de invoer. De langste overeenkomende
subtekenreeks van “ABABC” en “BABCA” is bĳvoorbeeld “BABC”. De subtekenreeks is hoofdlettergevoelig.
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Syntaxis longest_common_substring(string1, string2)
Argumenten • string1 - een tekenreeks

• string2 - een tekenreeks

Voorbeelden • longest_common_substring('ABABC','BABCA')→ ‘BABC’
• longest_common_substring('abcDeF','abcdef')→ ‘abc’
• longest_common_substring(upper('abcDeF'),upper('abcdex'))
→ ‘ABCDE’

soundex

Geeft de Soundex-weergave van een tekenreeks terug. Soundex is een algoritme voor fonetisch overeenkomen, dus
tekenreeksen met een soortgelĳke klank zouden moeten worden weergegeven door dezelfde code voor Soundex.

Syntaxis soundex(string)
Argumenten • string - een tekenreeks

Voorbeelden • soundex('robert')→ ‘R163’
• soundex('rupert')→ ‘R163’
• soundex('rubin')→ ‘R150’

13.2.12 Algemene functies

Deze groep bevat een algemeen assortiment van functies.

env

Haalt een omgevingsvariabele op en geeft de inhoud daarvan terug als een tekenreeks Als de variabele niet
wordt gevonden, wordt NULL teruggegeven. Dit is handig om systeemspecifieke configuratie, zoals schĳfletters of
voorvoegsels voor paden in te voeren. Definitie van omgevingsvariabelen is afhankelĳk van het besturingssysteem,
neem contact op met uw systeembeheerder, of bekĳk de documentatie voor het besturingssysteem, hoe deze in te
stellen.

Syntaxis env(name)
Argumenten • name - De naam van de omgevingsvariabele die zou moeten worden opgehaald.

Voorbeelden • env( 'LANG' )→ ‘en_US.UTF-8’
• env( 'MY_OWN_PREFIX_VAR' )→ ‘Z:’
• env( 'I_DO_NOT_EXIST' )→ NULL
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eval

Evalueert een expressie die in een tekenreeks wordt doorgegeven. Nuttig om dynamische parameters, die zĳn
doorgegeven als contextvariabelen of velden, uit te breiden.

Syntaxis eval(expression)
Argumenten • expression - een expressie als tekenreeks

Voorbeelden • eval('\'nice\'')→ ‘nice’
• eval(@expression_var) → [wat het resultaat van het evalueren van
@expression_var ook maar mag zĳn…]

eval_template

Evalueert een sjabloon dat in een tekenreeks wordt doorgegeven. Nuttig om dynamische parameters, die zĳn
doorgegeven als contextvariabelen of velden, uit te breiden.

Syntaxis eval_template(template)
Argumenten • template - een tekenreeks voor een sjabloon

Voorbeelden • eval_template('QGIS [% upper(\'rocks\') %]')→ QGIS ROCKS

is_layer_visible

Geeft TRUE terug als een gespecificeerde laag zichtbaar is.

Syntaxis is_layer_visible(layer)
Argumenten • layer - een tekenreeks die ofwel een laagnaam of een laag-ID vertegenwoordigt

Voorbeelden • is_layer_visible('baseraster')→ TRUE

mime_type

Geeft het type mime van de binaire gegevens terug.

Syntaxis mime_type(bytes)
Argumenten • bytes - de binaire gegevens

Voorbeelden • mime_type('<html><body></body></html>')→ text/html
• mime_type(from_base64('R0lGODlhAQABAAAAACH5BAEKAAEALAAAAAABAAEAAAIAOw=='))
→ image/gif
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var

Geeft de opgeslagen waarde uit een gespecificeerde variabele terug.

Syntaxis var(name)
Argumenten • name - de naam van een variabele

Voorbeelden • var('qgis_version')→ ‘2.12’

Lees verder: Lĳst van standaard variabelen

with_variable

Maakt en stelt een variabele in voor de code voor een expressie die zal worden verschaft als derde argument. Dit is
alleen nuttig voor gecompliceerde expressies waar dezelfde berekende waarde moet worden gebruikt op verschillende
plaatsen.

Syntaxis with_variable(name, value, expression)
Argumenten • name - de naam van de in te stellen variabele

• value - de in te stellen waarde
• expression - de expressie waarvoor de variabele beschikbaar moet zĳn

Voorbeelden • with_variable('my_sum', 1 + 2 + 3, @my_sum * 2 + @my_sum *
5)→ 42

13.2.13 Geometrie functies

De groep bevat functies die werken voor geometrie-objecten (bĳv. buffer, transform, $area).
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affine_transform

Geeft de geometrie terug na een affiene transformatie. Berekeningen zĳn in het Ruimtelĳke ReferentieSysteem van
deze geometrie. De bewerkingen worden uitgevoerd in de volgorde schaal, rotatie, vertaling. Als er een Z- of M-
verschuiving is, maar het coördinaat is niet aanwezig in de geometrie, zal die worden toegevoegd.

Syntaxis affine_transform(geometry, delta_x, delta_y, rotation_z, scale_x, scale_y, [delta_z=0],
[delta_m=0], [scale_z=1], [scale_m=1])
[] markeert optionele argumenten

Argumenten • geometry - een geometrie
• delta_x - X-as vertaling
• delta_y - Y-as vertaling
• rotation_z - rotatie rondom Z-as in graden tegen de wĳzers van de klok in
• scale_x - X-as schaalfactor
• scale_y - Y-as schaalfactor
• delta_z - Z-as vertaling
• delta_m - M-as vertaling
• scale_z - Z-as schaalfactor
• scale_m - M-as schaalfactor

Voorbeelden • geom_to_wkt(affine_transform(geom_from_wkt('LINESTRING(1
1, 2 2)'), 2, 2, 0, 1, 1))→ ‘LineString (3 3, 4 4)’

• geom_to_wkt(affine_transform(geom_from_wkt('POLYGON((0 0,
0 3, 2 2, 0 0))'), 0, 0, -90, 1, 2)) → ‘Polygon ((0 0, 6 0, 4 -2,
0 0))’

• geom_to_wkt(affine_transform(geom_from_wkt('POINT(3 1)'),
0, 0, 0, 1, 1, 5, 0))→ ‘PointZ (3 1 5)’

angle_at_vertex

Geeft de hoek bisector hoek (gemiddelde hoek) terug van de geometrie voor een gespecificeerd punt op een geometrie
lĳn. Hoeken zĳn in graden vanaf noord met de klok mee.

Syntaxis angle_at_vertex(geometry, vertex)
Argumenten • geometry - een geometrie lĳn

• vertex - index van het punt, beginnend vanaf 0; als de waarde negatief is, zal de
geselecteerde index voor het punt zĳn totale aantal minus de absolute waarde zĳn

Voorbeelden • angle_at_vertex(geometry:=geom_from_wkt('LineString(0 0,
10 0, 10 10)'),vertex:=1)→ 45.0
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apply_dash_pattern

Past een streepjespatroon toe op een geometrie, wat een MultiLineString-geometrie teruggeeft waarvan de
invoergeometrie gestreept is langs elke lĳn/ring met het gespecificeerde patroon.

Syntaxis apply_dash_pattern(geometry, pattern, [start_rule=no_rule], [end_rule=no_rule],
[adjustment=both], [pattern_offset=0])
[] markeert optionele argumenten

Argumenten • geometry - een geometrie (accepteert (multi)linestrings of (multi)polygonen).
• pattern - streepjespatroon, als een array van getallen die lengten van streepjes en gaten
weergeven. Moet een even aantal elementen bevatten.

• start_rule - optionele regel voor het beperken van het begin van het patroon. Geldige
waarden zĳn ‘no_rule’, ‘full_dash’, ‘half_dash’, ‘full_gap’, ‘half_gap’.

• end_rule - optionele regel voor het beperken van het einde van het patroon. Geldige
waarden zĳn ‘no_rule’, ‘full_dash’, ‘half_dash’, ‘full_gap’, ‘half_gap’.

• adjustment - optionele regel voor het specificeren van welk deel van de patronen moeten
worden aangepast om te zorgen dat de regels van het gewenste patroon passen. Geldige
waarden zĳn ‘both’, ‘dash’, ‘gap’.

• pattern_offset - Optionele afstand die een specifieke afstand specificeert langs het
patroon waar het moet beginnen.

Voorbeelden • geom_to_wkt(apply_dash_pattern(geom_from_wkt('LINESTRING(1
1, 10 1)'), array(3, 1))) → MultiLineString ((1 1, 4 1),(5 1, 8 1),(9 1, 10
1, 10 1))

• geom_to_wkt(apply_dash_pattern(geom_from_wkt('LINESTRING(1
1, 10 1)'), array(3, 1), start_rule:='half_dash')) →
MultiLineString ((1 1, 2.5 1),(3.5 1, 6.5 1),(7.5 1, 10 1, 10 1))

$area

Geeft het gebied van het huidige object terug. Het door deze functie berekende gebied respecteert zowel de instelling
van de ellipsoïde voor het huidige project als de instellingen voor eenheden voor het gebied. Als, bĳvoorbeeld, een
ellipsoïde is ingesteld voor het project, dan zal het berekende gebied ellipsoïde zĳn, en als er geen ellipsoïde is
ingesteld, dan zal het gebied planimetrisch zĳn.

Syntaxis $area
Voorbeelden • $area→ 42

area

Geeft het gebied terug van een geometrie-object polygoon. Berekeningen zĳn altĳd in het ruimtelĳke
referentiesysteem (SRS) van deze geometrie, en de eenheden van het teruggegeven gebied komen overeen met
de eenheden voor het SRS. Dit verschilt van de door de functie $area uitgevoerde berekeningen, die ellipsoïde
berekeningen zal uitvoeren, gebaseerd op de instellingen voor de ellipsoïde van het project en eenheden voor het
gebied.
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Syntaxis area(geometry)
Argumenten • geometry - geometrie-object polygoon

Voorbeelden • area(geom_from_wkt('POLYGON((0 0, 4 0, 4 2, 0 2, 0 0))'))
→ 8.0

azimuth

Geeft de op het noorden gebaseerde azimut terug als de hoek in radialen, met de klok mee gemeten van de verticaal
van point_a naar point_b.

Syntaxis azimuth(point_a, point_b)
Argumenten • point_a - geometrie punt

• point_b - geometrie punt

Voorbeelden • degrees( azimuth( make_point(25, 45), make_point(75, 100)
) )→ 42.273689

• degrees( azimuth( make_point(75, 100), make_point(25,45) )
)→ 222.273689

boundary

Geeft de omsluiting terug van de gecombineerde grens van de geometrie (d.i. de topologische grens van de geometrie).
Een geometrie polygoon zal, bĳvoorbeeld, een grens hebben die bestaat uit de lĳnen voor elke ring in de polygoon.
Sommige typen geometrie hebben geen gedefinieerde grens, bĳv. punten of verzamelingen van geometrieën, en zullen
NULL teruggeven.

Syntaxis boundary(geometry)
Argumenten • geometry - een geometrie

Voorbeelden • geom_to_wkt(boundary(geom_from_wkt('Polygon((1 1, 0 0, -1
1, 1 1))')))→ ‘LineString(1 1,0 0,-1 1,1 1)’

• geom_to_wkt(boundary(geom_from_wkt('LineString(1 1,0 0,-1
1)')))→ ‘MultiPoint ((1 1),(-1 1))’

Lees verder: algoritme Grens
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bounds

Geeft een geometrie terug die het begrenzingsvak van een invoer-geometrie weergeeft. Berekeningen zĳn in het
ruimtelĳke referentiesysteem van deze geometrie.

Syntaxis bounds(geometry)
Argumenten • geometry - een geometrie

Voorbeelden • bounds($geometry)→ begrenzingsvak van de geometrie van het huidige object
• geom_to_wkt(bounds(geom_from_wkt('Polygon((1 1, 0 0, -1 1,
1 1))')))→ ‘Polygon ((-1 0, 1 0, 1 1, -1 1, -1 0))’

Fig. 13.4: Zwarte lijnen geven de begrenzingsvakken van elk object polygoon weer

Lees verder: algoritme Begrenzingsvakken
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bounds_height

Geeft de hoogte van het begrenzingsvak van een geometrie terug. Berekeningen zĳn in het ruimtelĳke
referentiesysteem van deze geometrie.

Syntaxis bounds_height(geometry)
Argumenten • geometry - een geometrie

Voorbeelden • bounds_height($geometry) → height of bounding box of the current feature’s
geometry

• bounds_height(geom_from_wkt('Polygon((1 1, 0 0, -1 1, 1
1))'))→ 1

bounds_width

Geeft de breedte van het begrenzingsvak van een geometrie terug. Berekeningen zĳn in het ruimtelĳke
referentiesysteem van deze geometrie.

Syntaxis bounds_width(geometry)
Argumenten • geometry - een geometrie

Voorbeelden • bounds_width($geometry) → width of bounding box of the current feature’s
geometry

• bounds_width(geom_from_wkt('Polygon((1 1, 0 0, -1 1, 1
1))'))→ 2

buffer

Geeft een geometrie terug die alle punten weergeeft waarvan de afstand vanaf deze geometrie kleiner is dan of gelĳk
is aan afstand. Berekeningen zĳn in het ruimtelĳke referentiesysteem van deze geometrie.

Syntaxis buffer(geometry, distance, [segments=8], [cap=’round’], [join=’round’], [miter_limit=2])
[] markeert optionele argumenten

Argumenten • geometry - een geometrie
• distance - bufferafstand in laageenheden
• segments - aantal te gebruiken segmenten om een kwartcirkel weer te geven als een
afgeronde stĳl voor samenvoegen wordt gebruikt. Een groter aantal resulteert in een
gladdere buffer met meer knopen.

• cap - stĳl voor einde voor buffer. Geldige waarden zĳn ‘round’, ‘flat’ of ‘square’
• join - stĳl voor samenvoegen voor buffer. Geldige waarden zĳn ‘round’, ‘bevel’ of ‘miter’.
• miter_limit - grens voor afstand van miter, te gebruiken als de stĳl voor samenvoegen is
ingesteld op ‘miter’

Voorbeelden • buffer($geometry, 10.5)→ polygoon van de geometrie van het huidige object,
gebufferd op 10.5 eenheden
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Fig. 13.5: Buffer (in geel) van punten, lijn, polygoon met positieve buffer, en polygoon met negatieve buffer

Lees verder: algoritme Buffer

buffer_by_m

Maakt een buffer langs een geometrie lĳn waarbĳ de diameter van de buffer varieert, overeenkomstig de waarden M
van de punten van de lĳn.

Syntaxis buffer_by_m(geometry, [segments=8])
[] markeert optionele argumenten

Argumenten • geometry - invoergeometrie. Moet een geometrie (multi)lĳn zĳn met waarden M.
• segments - aantal segmenten om bogen van een kwartcirkel te benaderen in de buffer.

Voorbeelden • buffer_by_m(geometry:=geom_from_wkt('LINESTRINGM(1 2 0.5, 4
2 0.2)'),segments:=8)→ Een buffer met variabele breedte, beginnend met een
diameter van 0.5 en eindigend met een diameter van 0.2 langs de geometrie lĳn.
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Fig. 13.6: Objecten Lijn bufferen met de M-waarde op de punten

Lees verder: algoritme Variabele breedte buffer (op M-waarde)

centroid

Geeft het geometrische midden van een geometrie terug.

Syntaxis centroid(geometry)
Argumenten • geometry - een geometrie

Voorbeelden • centroid($geometry)→ een geometrie punt

Lees verder: algoritme Zwaartepunten

13.2. Lijst van functies 283



QGIS Desktop 3.28 User Guide

close_line

Geeft een gesloten lĳn voor de lĳn voor invoer terug door het eerste punt toe te voegen aan het einde van de lĳn, als
die nog niet gesloten is. Als de geometrie geen lĳn of multi-lĳn is, dan zal het resultaat NULL zĳn.

Syntaxis close_line(geometry)
Argumenten • geometry - een geometrie lĳn

Voorbeelden • geom_to_wkt(close_line(geom_from_wkt('LINESTRING(0 0, 1 0,
1 1)')))→ ‘LineString (0 0, 1 0, 1 1, 0 0)’

• geom_to_wkt(close_line(geom_from_wkt('LINESTRING(0 0, 1 0,
1 1, 0 0)')))→ ‘LineString (0 0, 1 0, 1 1, 0 0)’

closest_point

Geeft het punt terug op geometry1 dat het dichtst bĳ geometry2 ligt

Syntaxis closest_point(geometry1, geometry2)
Argumenten • geometry1 - geometrie waarop het dichtstbĳzĳnde punt moet worden gezocht

• geometry2 - geometrie waarvan het dichtstbĳzĳnde punt moet worden gevonden

Voorbeelden • geom_to_wkt(closest_point(geom_from_wkt('LINESTRING (20
80, 98 190, 110 180, 50 75 )'),geom_from_wkt('POINT(100
100)')))→ ‘Point(73.0769 115.384)’

collect_geometries

Verzamelt een set geometrieën in een meerdelig object geometrie.
Variant Lĳst met argumenten
Delen van geometrieën worden als afzonderlĳke argumenten gespecificeerd voor de functie.

Syntaxis collect_geometries(geometry1, geometry2, …)
Argumenten • geometry - een geometrie

Voorbeelden • geom_to_wkt(collect_geometries(make_point(1,2),
make_point(3,4), make_point(5,6))) → ‘MultiPoint ((1 2),(3 4),(5
6))’

Variant Array
Delen van geometrieën worden als een array van delen van geometrieën gespecificeerd.
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Syntaxis collect_geometries(array)
Argumenten • array - array van geometrie-objecten

Voorbeelden • geom_to_wkt(collect_geometries(array(make_point(1,2),
make_point(3,4), make_point(5,6)))) → ‘MultiPoint ((1 2),(3 4),(5
6))’

Lees verder: algoritme Geometrieën verzamelen

combine

Geeft de combinatie van twee geometrieën terug.

Syntaxis combine(geometry1, geometry2)
Argumenten • geometry1 - een geometrie

• geometry2 - een geometrie

Voorbeelden • geom_to_wkt( combine( geom_from_wkt( 'LINESTRING(3 3, 4 4,
5 5)' ), geom_from_wkt( 'LINESTRING(3 3, 4 4, 2 1)' ) ) )
→ ‘MULTILINESTRING((4 4, 2 1), (3 3, 4 4), (4 4, 5 5))’

• geom_to_wkt( combine( geom_from_wkt( 'LINESTRING(3 3, 4 4)'
), geom_from_wkt( 'LINESTRING(3 3, 6 6, 2 1)' ) ) ) →
‘LINESTRING(3 3, 4 4, 6 6, 2 1)’

concave_hull

Geeft een mogelĳke bolle polygoon die alle punten in de geometrie bevat
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Syntaxis concave_hull(geometry, target_percent, [allow_holes=False])
[] markeert optionele argumenten

Argumenten • geometry - een geometrie
• target_percent - het percentage gebied dat de oplossing voor de convex hull probeert
te benaderen. Een target_percent van 1 geeft hetzelfde resultaat als de convex hull. Een
target_percent tussen 0 en 0.99 produceert een resultaat dat een kleiner gebied zou moeten
hebben dan de convex hull.

• allow_holes - optioneel argument dat specificeert of gaten zĳn toegestaan in de
uitvoergeometrie. Standaard is FALSE, stel in op TRUE om opnemen van gaten in de
uitvoergeometrie te vermĳden.

Voorbeelden • geom_to_wkt(concave_hull(geom_from_wkt('MULTILINESTRING((106
164,30 112,74 70,82 112,130 94,130 62,122 40,156 32,162
76,172 88),(132 178,134 148,128 136,96 128,132 108,150
130,170 142,174 110,156 96,158 90,158 88),(22 64,66 28,94
38,94 68,114 76,112 30,132 10,168 18,178 34,186 52,184
74,190 100,190 122,182 148,178 170,176 184,156 164,146
178,132 186,92 182,56 158,36 150,62 150,76 128,88 118))'),
0.99)) → ‘Polygon ((30 112, 36 150, 92 182, 132 186, 176 184, 190 122, 190 100,
186 52, 178 34, 168 18, 132 10, 112 30, 66 28, 22 64, 30 112))’

Lees verder: convex_hull

contains

Test of een geometrie een andere bevat. Geeft TRUE terug als, en alleen als, er geen punten van geometry2 in het
exterieur van geometry1 liggen, en tenminste één punt van het interieur van geometry2 in het interieur van geometry1
ligt.

Syntaxis contains(geometry1, geometry2)
Argumenten • geometry1 - een geometrie

• geometry2 - een geometrie

Voorbeelden • contains( geom_from_wkt( 'POLYGON((0 0, 0 1, 1 1, 1 0, 0
0))' ), geom_from_wkt( 'POINT(0.5 0.5 )' ) )→ TRUE

• contains( geom_from_wkt( 'POLYGON((0 0, 0 1, 1 1, 1 0, 0
0))' ), geom_from_wkt( 'LINESTRING(3 3, 4 4, 5 5)' ) ) →
FALSE

Lees verder: overlay_contains
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convex_hull

Geeft de convex hull van een geometrie terug. Dit vertegenwoordigt de minimale convex-geometrie die alle
geometrieën binnen de verzameling omsluit.

Syntaxis convex_hull(geometry)
Argumenten • geometry - een geometrie

Voorbeelden • geom_to_wkt( convex_hull( geom_from_wkt( 'LINESTRING(3 3,
4 4, 4 10)' ) ) )→ ‘POLYGON((3 3, 4 10, 4 4, 3 3))’

Lees verder: concave_hull, algoritme Convex hull (Bolle schil)

crosses

Test of een geometrie kruist met een andere. Geeft TRUE terug als de opgegeven geometrieën enkele, maar niet alle,
punten in het interieur gemeenschappelĳk hebben.

Syntaxis crosses(geometry1, geometry2)
Argumenten • geometry1 - een geometrie

• geometry2 - een geometrie

Voorbeelden • crosses( geom_from_wkt( 'LINESTRING(3 5, 4 4, 5 3)' ),
geom_from_wkt( 'LINESTRING(3 3, 4 4, 5 5)' ) )→ TRUE

• crosses( geom_from_wkt( 'POINT(4 5)' ), geom_from_wkt(
'LINESTRING(3 3, 4 4, 5 5)' ) )→ FALSE

Lees verder: overlay_crosses

densify_by_count

Neemt een geometrie van een polygonen-laag of lĳn-laag en maakt een nieuwe waarin de geometrieën een groter
aantal punten hebben dan de originele.

Syntaxis densify_by_count(geometry, vertices)
Argumenten • geometry - een geometrie (accepteert (multi)linestrings of (multi)polygonen).

• vertices - aantal toe te voegen punten (per segment)

Voorbeelden • geom_to_wkt(densify_by_count(geom_from_wkt('LINESTRING(1
1, 10 1)'), 3))→ LineString (1 1, 3.25 1, 5.5 1, 7.75 1, 10 1)

Lees verder: algoritme Verdichten op aantal
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densify_by_distance

Neemt een geometrie van een polygoon- of lĳnlaag en maakt een nieuwe waarin de geometrieën zĳn verdicht door
aanvullende punten toe te voegen op randen die een maximale afstand hebben ten opzichte van de gespecificeerde
interval voor de afstand.

Syntaxis densify_by_distance(geometry, distance)
Argumenten • geometry - een geometrie (accepteert (multi)linestrings of (multi)polygonen).

• distance - maximale interval afstand tussen punten in de uitvoergeometrie

Voorbeelden • geom_to_wkt(densify_by_distance(geom_from_wkt('LINESTRING(1
1, 10 1)'), 4))→ LineString (1 1, 4 1, 7 1, 10 1)

Lees verder: Verdichten op interval algorithm

difference

Geeft een geometrie terug die dat deel van geometry1 weergeeft dat niet kruist met geometry2.

Syntaxis difference(geometry1, geometry2)
Argumenten • geometry1 - een geometrie

• geometry2 - een geometrie

Voorbeelden • geom_to_wkt( difference( geom_from_wkt( 'LINESTRING(3 3, 4
4, 5 5)' ), geom_from_wkt( 'LINESTRING(3 3, 4 4)' ) ) ) →
‘LINESTRING(4 4, 5 5)’

Lees verder: algoritme Verschil

disjoint

Test of geometrieën elkaar niet ruimtelĳk kruisen. Geeft TRUE terug als de geometrieën geen enkele ruimte met
elkaar delen.

Syntaxis disjoint(geometry1, geometry2)
Argumenten • geometry1 - een geometrie

• geometry2 - een geometrie

Voorbeelden • disjoint( geom_from_wkt( 'POLYGON((0 0, 0 1, 1 1, 1 0, 0
0 ))' ), geom_from_wkt( 'LINESTRING(3 3, 4 4, 5 5)' ) ) →
TRUE

• disjoint( geom_from_wkt( 'LINESTRING(3 3, 4 4, 5 5)' ),
geom_from_wkt( 'POINT(4 4)' ))→ FALSE

Lees verder: overlay_disjoint
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distance

Geeft deminimum afstand (gebaseerd op ruimtelĳke verwĳzing) tussen twee geometrieën in geprojecteerde eenheden
terug.

Syntaxis distance(geometry1, geometry2)
Argumenten • geometry1 - een geometrie

• geometry2 - een geometrie

Voorbeelden • distance( geom_from_wkt( 'POINT(4 4)' ), geom_from_wkt(
'POINT(4 8)' ) )→ 4

distance_to_vertex

Geeft de afstand terug langs de geometrie tot een gespecificeerd punt.

Syntaxis distance_to_vertex(geometry, vertex)
Argumenten • geometry - een geometrie lĳn

• vertex - index van het punt, beginnend vanaf 0; als de waarde negatief is, zal de
geselecteerde index voor het punt zĳn totale aantal minus de absolute waarde zĳn

Voorbeelden • distance_to_vertex(geometry:=geom_from_wkt('LineString(0
0, 10 0, 10 10)'),vertex:=1)→ 10.0

end_point

Geeft de laatste knoop van een geometrie terug.

Syntaxis end_point(geometry)
Argumenten • geometry - object geometrie

Voorbeelden • geom_to_wkt(end_point(geom_from_wkt('LINESTRING(4 0, 4 2,
0 2)')))→ ‘Point (0 2)’

Lees verder: algoritme Specifieke punten uitnemen
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exif_geotag

Maakt een geometrie punt uit de exif geotags van een afbeeldingsbestand.

Syntaxis exif_geotag(path)
Argumenten • path - een bestandspad voor een afbeelding of een waarde van een kaartlaag. Als een

waarde van een kaartlaag is gespecificeerd dan zal de bestandsbron van de laag worden
gebruikt.

Voorbeelden • geom_to_wkt(exif_geotag('/my/photo.jpg'))→ ‘Point (2 4)’

extend

Verlengt het begin en einde van een geometrie lĳn met een gespecificeerde afstand. Lĳnen worden verlengd met
behulp van de richting van het eerste en laatste segment in de lĳn. Voor een multi-lĳn worden alle delen verlengd.
Afstanden zĳn in het ruimtelĳke referentiesysteem van deze geometrie.

Syntaxis extend(geometry, start_distance, end_distance)
Argumenten • geometry - een geometrie (multi)lĳn

• start_distance - afstand waarmee het begin van de lĳn moet worden verlengd
• end_distance - afstand waarmee het einde van de lĳn moet worden verlengd.

Voorbeelden • geom_to_wkt(extend(geom_from_wkt('LineString(0 0, 1 0, 1
1)'),1,2))→ ‘LineString (-1 0, 1 0, 1 3)’

• geom_to_wkt(extend(geom_from_wkt('MultiLineString((0 0, 1
0, 1 1), (2 2, 0 2, 0 5))'),1,2)) → ‘MultiLineString ((-1 0, 1 0, 1
3),(3 2, 0 2, 0 7))’

Lees verder: algoritme Lĳnen verlengen

exterior_ring

Geeft een lĳn terug die de buitenste ring voorstelt van een geometrie polygoon. Als de geometrie geen polygoon is
zal het resultaat NULL zĳn.

Syntaxis exterior_ring(geometry)
Argumenten • geometry - een geometrie polygoon

Voorbeelden • geom_to_wkt(exterior_ring(geom_from_wkt('POLYGON((-1 -1, 4
0, 4 2, 0 2, -1 -1),( 0.1 0.1, 0.1 0.2, 0.2 0.2, 0.2, 0.1,
0.1 0.1))')))→ ‘LineString (-1 -1, 4 0, 4 2, 0 2, -1 -1)’
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extrude

Geeft een uitgetrokken versie terug van de invoergeometrie (Multi-)Curve of (Multi-)Lĳn met een uitbreiding die
wordt gespecificeerd door x en y.

Syntaxis extrude(geometry, x, y)
Argumenten • geometry - een geometrie boog of lĳn

• x - uitbreiding x, numerieke waarde
• y - uitbreiding y, numerieke waarde

Voorbeelden • geom_to_wkt(extrude(geom_from_wkt('LineString(1 2, 3 2, 4
3)'), 1, 2))→ ‘Polygon ((1 2, 3 2, 4 3, 5 5, 4 4, 2 4, 1 2))’

• geom_to_wkt(extrude(geom_from_wkt('MultiLineString((1 2, 3
2), (4 3, 8 3))'), 1, 2))→ ‘MultiPolygon (((1 2, 3 2, 4 4, 2 4, 1 2)),((4 3,
8 3, 9 5, 5 5, 4 3)))’

flip_coordinates

Geeft een kopie terug van de geometrie waarin de X- en Y-coördinaten zĳn verwisseld. Nuttig om geometrieën te
repareren waarvan de waarden voor breedte- en lengtegraad zĳn omgedraaid.

Syntaxis flip_coordinates(geometry)
Argumenten • geometry - een geometrie

Voorbeelden • geom_to_wkt(flip_coordinates(make_point(1, 2)))→ ‘Point (2 1)’
• geom_to_wkt(flip_coordinates(geom_from_wkt('LineString(0
2, 1 0, 1 6)')))→ ‘LineString (2 0, 0 1, 6 1)’

Lees verder: algoritme X- en Y-coördinaten wisselen

force_polygon_ccw

Forceert een geometrie om de conventie te respecteren waar buitenste ringen tegen de wĳzers van de klok in gaan,
binnenste ringen gaan met de wĳzers van de klok mee.

Syntaxis force_polygon_ccw(geometry)
Argumenten • geometry - een geometrie. Elke geometrie die geen polygoon is wordt ongewĳzigd

teruggegeven.

Voorbeelden • geom_to_wkt(force_polygon_ccw(geometry:=geom_from_wkt('Polygon
((-1 -1, 0 2, 4 2, 4 0, -1 -1))')))→ ‘Polygon ((-1 -1, 4 0, 4 2, 0 2, -1
-1))’

Lees verder: force_polygon_cw, force_rhr
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force_polygon_cw

Forceert een geometrie om de conventie te respecteren waar buitenste ringen met de wĳzers van de klok mee gaan,
binnenste ringen tegen de wĳzers van de klok in gaan.

Syntaxis force_polygon_cw(geometry)
Argumenten • geometry - een geometrie. Elke geometrie die geen polygoon is wordt ongewĳzigd

teruggegeven.

Voorbeelden • geom_to_wkt(force_polygon_cw(geometry:=geom_from_wkt('POLYGON((-1
-1, 4 0, 4 2, 0 2, -1 -1))')))→ ‘Polygon ((-1 -1, 0 2, 4 2, 4 0, -1 -1))’

Lees verder: force_polygon_ccw, force_rhr

force_rhr

Forceert een geometrie polygoon om de rechterhandregel te respecteren, waarin het gebied, dat is gebonden aan een
polygoon, aan de rechterkant van de grens ligt. In het bĳzonder, de buitenste ring is georiënteerd in een richting met
de klok mee en de binnenste ringen in een richting tegen de wĳzers van de klok in. Vanwege de inconsistentie in de
definitie van de rechterhandregel in sommige contexten wordt aanbevolen om in plaats daarvan de expliciete functie
force_polygon_cw te gebruiken.

Syntaxis force_rhr(geometry)
Argumenten • geometry - een geometrie. Elke geometrie die geen polygoon is wordt ongewĳzigd

teruggegeven.

Voorbeelden • geom_to_wkt(force_rhr(geometry:=geom_from_wkt('POLYGON((-1
-1, 4 0, 4 2, 0 2, -1 -1))')))→ ‘Polygon ((-1 -1, 0 2, 4 2, 4 0, -1 -1))’

Lees verder: algoritme Rechterhandregel forceren, force_polygon_ccw, force_polygon_cw

geom_from_gml

Geeft een geometrie terug uit een GML-weergave van geometrie.

Syntaxis geom_from_gml(gml)
Argumenten • gml - GML-weergave van een geometrie als een tekenreeks

Voorbeelden • geom_from_gml('<gml:LineString srsName="EPSG:4326"><gml:coordinates>4,
4 5,5 6,6</gml:coordinates></gml:LineString>') → een object
lĳngeometrie
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geom_from_wkb

Geeft een geometrie terug, gemaakt uit een weergave Well-Known Text (WKT).

Syntaxis geom_from_wkb(binary)
Argumenten • binary - weergave inWell-Known Binary (WKB) van een geometrie (als een binaire blob)

Voorbeelden • geom_from_wkb( geom_to_wkb( make_point(4,5) ) )→een geometrie-
object punt

geom_from_wkt

Geeft een geometrie terug, gemaakt uit een weergave Well-Known Text (WKT)-

Syntaxis geom_from_wkt(text)
Argumenten • text - weergave in Well-Known Text (WKT) van een geometrie

Voorbeelden • geom_from_wkt( 'POINT(4 5)' )→ een geometrie-object

geom_to_wkb

Geeft de weergave in Well-Known Binary (WKB) van een geometrie terug.

Syntaxis geom_to_wkb(geometry)
Argumenten • geometry - een geometrie

Voorbeelden • geom_to_wkb( $geometry )→ binaire blob die een geometrie-object bevat

geom_to_wkt

Geeft de weergave in Well-Known Text (WKT) van de geometrie terug zonder de metadata voor het SRID.

Syntaxis geom_to_wkt(geometry, [precision=8])
[] markeert optionele argumenten

Argumenten • geometry - een geometrie
• precision - numerieke precisie

Voorbeelden • geom_to_wkt( make_point(6, 50) )→ ‘POINT(6 50)’
• geom_to_wkt(centroid(geom_from_wkt('Polygon((1 1, 0 0, -1
1, 1 1))')))→ ‘POINT(0 0.66666667)’

• geom_to_wkt(centroid(geom_from_wkt('Polygon((1 1, 0 0, -1
1, 1 1))')), 2)→ ‘POINT(0 0.67)’
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$geometry

Geeft de geometrie terug van het huidige object. Kan worden gebruikt voor het verwerken met andere functies.
WAARSCHUWING:Deze functie is vervallen. Aanbevolen wordt om de vervanging, de variabele@geometry
in plaats daarvan te gebruiken.

Syntaxis $geometry
Voorbeelden • geom_to_wkt( $geometry )→ ‘POINT(6 50)’

geometry

Geeft de geometrie van een object terug.

Syntaxis geometry(feature)
Argumenten • feature - een object

Voorbeelden • `` geometry( $currentfeature )`` → de geometrie van het huidige object. Voorkeur voor
gebruiken van $geometry.

• geom_to_wkt( geometry( get_feature_by_id( 'streets', 1 ) )
)→de geometrie in WKT van het object met de ID 1 op de laag “streets”, bĳv. ‘POINT(6
50)’

• intersects( $geometry, geometry( get_feature( 'streets',
'name', 'Main St.' ) ) ) → TRUE als het huidige object ruimtelĳk kruist
met het benoemde object ‘Main St.’ op de laag “streets”

geometry_n

Geeft een specifieke geometrie terug uit een verzameling geometrieën, of NULL als de invoergeometrie geen
verzameling is. Geeft ook een deel van een meerdelige geometrie terug.

Syntaxis geometry_n(geometry, index)
Argumenten • geometry - verzameling geometrieën

• index - index van de terug te geven geometrie, waar 1 de eerste geometrie in de
verzameling is

Voorbeelden • geom_to_wkt(geometry_n(geom_from_wkt('GEOMETRYCOLLECTION(POINT(0
1), POINT(0 0), POINT(1 0), POINT(1 1))'),3))→ ‘Point (1 0)’
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geometry_type

Geeft een waarde tekenreeks terug die het type van een geometrie beschrĳft (Punt, Lĳn of Polygoon)

Syntaxis geometry_type(geometry)
Argumenten • geometry - een geometrie

Voorbeelden • geometry_type( geom_from_wkt( 'LINESTRING(2 5, 3 6, 4 8)')
)→ ‘Lĳn’

• geometry_type( geom_from_wkt( 'MULTILINESTRING((2 5, 3 6,
4 8), (1 1, 0 0))') )→ ‘Lĳn’

• geometry_type( geom_from_wkt( 'POINT(2 5)') )→ ‘Punt’
• geometry_type( geom_from_wkt( 'POLYGON((-1 -1, 4 0, 4 2, 0
2, -1 -1))') )→ ‘Polygoon’

hausdorff_distance

Geeft de Hausdorff-afstand tussen twee geometrieën terug. Geeft in de basis een meting terug van hoe soortgelĳk of
niet soortgelĳk 2 geometrieën zĳn, met een lagere afstand die meer soortgelĳke geometrieën aangeeft.
De functie mag worden uitgevoerd met een optioneel argument voor de fractiedichtheid. Indien niet gespecificeerd
wordt een benadering van de standaard Hausdorff-afstand gebruikt. Deze benadering is exact of dichtbĳ genoeg voor
een grote subset van nuttige gevallen. Voorbeelden hiervan zĳn:

• berekenen van de afstand tussen lĳnen die ruwweg parallel aan elkaar zĳn, en ruwweg van gelĳke lengte. Dit
komt voor in overeenkomende lineaire netwerken.

• Testen van de soortgelĳkheid van geometrieën.
Als de standaard gegeven benadering voor deze methode niet voldoende is, specificeer dan het argument voor de
fractiedichtheid. Specificeren van dit argument voert een verdichting van segmenten uit voordat de afzonderlĳk
Hausdorff-afstand wordt berekend. De parameter stelt de fractie in waarmee elk segment wordt verdicht. Elk segment
zal worden gesplitst in een aantal subsegmenten van gelĳke lengte, waarvan de fractie van de totale lengte het dichtst
bĳ de opgegeven fractie ligt. Verlagen van de parameter fractiedichtheid zal er voor zorgen dat de teruggegeven afstand
de ware Hausdorff-afstand voor de geometrieën benadert.

Syntaxis hausdorff_distance(geometry1, geometry2, [densify_fraction])
[] markeert optionele argumenten

Argumenten • geometry1 - een geometrie
• geometry2 - een geometrie
• densify_fraction - hoeveelheid frachtiedichtheid

Voorbeelden • hausdorff_distance( geometry1:= geom_from_wkt('LINESTRING
(0 0, 2 1)'),geometry2:=geom_from_wkt('LINESTRING (0 0, 2
0)'))→ 2

• hausdorff_distance( geom_from_wkt('LINESTRING (130 0, 0 0, 0
150)'),geom_from_wkt('LINESTRING (10 10, 10 150, 130 10)'))
→ 14.142135623

• hausdorff_distance( geom_from_wkt('LINESTRING (130 0, 0 0, 0
150)'),geom_from_wkt('LINESTRING (10 10, 10 150, 130 10)'),
0.5)→ 70.0
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inclination

Geeft de hoek terug die wordt gemeten tussen de zenith (0) en de nadir (180) van point_a naar point_b.

Syntaxis inclination(point_a, point_b)
Argumenten • point_a - geometrie punt

• point_b - geometrie punt

Voorbeelden • inclination( make_point( 5, 10, 0 ), make_point( 5, 10, 5
) )→ 0.0

• inclination( make_point( 5, 10, 0 ), make_point( 5, 10, 0
) )→ 90.0

• inclination( make_point( 5, 10, 0 ), make_point( 50, 100,
0 ) )→ 90.0

• inclination( make_point( 5, 10, 0 ), make_point( 5, 10, -5
) )→ 180.0

interior_ring_n

Geeft een specifieke binnenste ring terug uit een geometrie polygoon, of NULL als de invoergeometrie geen polygoon
is.

Syntaxis interior_ring_n(geometry, index)
Argumenten • geometry - geometrie polygoon

• index - index van de terug te geven binnenste ring, waar 1 de eerste binnenste ring is

Voorbeelden • geom_to_wkt(interior_ring_n(geom_from_wkt('POLYGON((-1 -1,
4 0, 4 2, 0 2, -1 -1),(-0.1 -0.1, 0.4 0, 0.4 0.2, 0 0.2,
-0.1 -0.1),(-1 -1, 4 0, 4 2, 0 2, -1 -1))'),1)) → ‘LineString
(-0.1 -0.1, 0.4 0, 0.4 0.2, 0 0.2, -0.1 -0.1))’

intersection

Geeft een geometrie terug die het gedeelde deel weergeeft van twee geometrieën.

Syntaxis intersection(geometry1, geometry2)
Argumenten • geometry1 - een geometrie

• geometry2 - een geometrie

Voorbeelden • geom_to_wkt( intersection( geom_from_wkt( 'LINESTRING(3 3,
4 4, 5 5)' ), geom_from_wkt( 'LINESTRING(3 3, 4 4)' ) ) )
→ ‘LINESTRING(3 3, 4 4)’

• geom_to_wkt( intersection( geom_from_wkt( 'LINESTRING(3 3,
4 4, 5 5)' ), geom_from_wkt( 'MULTIPOINT(3.5 3.5, 4 5)' )
) )→ ‘POINT(3.5 3.5)’

Lees verder: algoritme Kruising
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intersects

Test of een geometrie een andere kruist. Geeft TRUE terug als de geometrieën elkaar ruimtelĳk kruisen (een stukje
ruimte met elkaar delen) en FALSE als zĳ dat niet doen.

Syntaxis intersects(geometry1, geometry2)
Argumenten • geometry1 - een geometrie

• geometry2 - een geometrie

Voorbeelden • intersects( geom_from_wkt( 'POINT(4 4)' ), geom_from_wkt(
'LINESTRING(3 3, 4 4, 5 5)' ) )→ TRUE

• intersects( geom_from_wkt( 'POINT(4 5)' ), geom_from_wkt(
'POINT(5 5)' ) )→ FALSE

Lees verder: overlay_intersects

intersects_bbox

Test of een begrenzingsvak van een geometrie het begrenzingsvak van een andere geometrie overlapt. Geeft TRUE
terug als de geometrieën ruimtelĳk kruisen met het gedefinieerde begrenzingsvak en FALSE als zĳ dat niet doen.

Syntaxis intersects_bbox(geometry1, geometry2)
Argumenten • geometry1 - een geometrie

• geometry2 - een geometrie

Voorbeelden • intersects_bbox( geom_from_wkt( 'POINT(4 5)' ),
geom_from_wkt( 'LINESTRING(3 3, 4 4, 5 5)' ) )→ TRUE

• intersects_bbox( geom_from_wkt( 'POINT(6 5)' ),
geom_from_wkt( 'POLYGON((3 3, 4 4, 5 5, 3 3))' ) ) →
FALSE

is_closed

Geeft TRUE terug als een lĳn gesloten is (begin- en eindpunt zĳn hetzelfde), of FALSE als een lĳn niet gesloten is.
Als de geometrie geen lĳn is, zal het resultaat NULL zĳn.

Syntaxis is_closed(geometry)
Argumenten • geometry - een geometrie lĳn

Voorbeelden • is_closed(geom_from_wkt('LINESTRING(0 0, 1 1, 2 2)')) →
FALSE

• is_closed(geom_from_wkt('LINESTRING(0 0, 1 1, 2 2, 0 0)'))
→ TRUE
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is_empty

Geeft TRUE terug als een geometrie leeg is (zonder coördinaten), FALSE als de geometrie niet leeg is en NULL als
er geen geometrie is. Bekĳk ook is_empty_or_null.

Syntaxis is_empty(geometry)
Argumenten • geometry - een geometrie

Voorbeelden • is_empty(geom_from_wkt('LINESTRING(0 0, 1 1, 2 2)'))→FALSE
• is_empty(geom_from_wkt('LINESTRING EMPTY'))→ TRUE
• is_empty(geom_from_wkt('POINT(7 4)'))→ FALSE
• is_empty(geom_from_wkt('POINT EMPTY'))→ TRUE

Lees verder: is_empty_or_null

is_empty_or_null

Geeft TRUE terug als een geometrie NULL of leeg is (zonder coördinaten), anders FALSE. Deze functie is hetzelfde
als de expressie ‘$geometry IS NULL or is_empty($geometry)’

Syntaxis is_empty_or_null(geometry)
Argumenten • geometry - een geometrie

Voorbeelden • is_empty_or_null(NULL)→ TRUE
• is_empty_or_null(geom_from_wkt('LINESTRING(0 0, 1 1, 2
2)'))→ FALSE

• is_empty_or_null(geom_from_wkt('LINESTRING EMPTY'))→ TRUE
• is_empty_or_null(geom_from_wkt('POINT(7 4)'))→ FALSE
• is_empty_or_null(geom_from_wkt('POINT EMPTY'))→ TRUE

Lees verder: is_empty, NULL

is_multipart

Geeft TRUE terug als de geometrie van het type Multi is.

Syntaxis is_multipart(geometry)
Argumenten • geometry - een geometrie

Voorbeelden • is_multipart(geom_from_wkt('MULTIPOINT ((0 0),(1 1),(2
2))'))→ TRUE

• is_multipart(geom_from_wkt('POINT (0 0)'))→ FALSE

298 Hoofdstuk 13. Doe meer met expressies



QGIS Desktop 3.28 User Guide

is_valid

Geeft TRUE terug als een geometrie geldig is; of het goed gevormd is in 2D, overeenkomstig de regels van OGC.

Syntaxis is_valid(geometry)
Argumenten • geometry - een geometrie

Voorbeelden • is_valid(geom_from_wkt('LINESTRING(0 0, 1 1, 2 2, 0 0)'))
→ TRUE

• is_valid(geom_from_wkt('LINESTRING(0 0)'))→ FALSE

Lees verder: make_valid, Geldigheid controleren algorithm

$length

Geeft de lengte van een lĳn terug. Als u de lengte van een rand van een polygoon nodig hebt, gebruik dan in plaats
hiervan $perimeter. De door deze functie berekende lengte respecteert zowel de instelling van de ellipsoïde voor
het huidige project als de instellingen voor eenheden voor afstanden. Als, bĳvoorbeeld, een ellipsoïde is ingesteld
voor het project, dan zal de berekende lengte ellipsoïde zĳn, en als er geen ellipsoïde is ingesteld, dan zal de lengte
planimetrisch zĳn.

Syntaxis $length
Voorbeelden • $length→ 42.4711

length

Geeft het aantal tekens in een tekenreeks terug of de lengte van een geometrie lĳn.
Variant Tekenreeks
Geeft het aantal tekens in een tekenreeks terug.

Syntaxis length(string)
Argumenten • string - tekenreeks waarvan de lengte moet worden geteld

Voorbeelden • length('hello')→ 5

Variant Geometrie
Geeft de lengte terug van een geometrie-object lĳn. Berekeningen zĳn altĳd planimetrisch in het ruimtelĳke
referentiesysteem (SRS) van deze geometrie, en de eenheden van de teruggegeven lengte komen overeen met de
eenheden voor het SRS. Dit verschilt van de door de functie $length uitgevoerde berekeningen, die ellipsoïde
berekeningen zal uitvoeren, gebaseerd op de instellingen voor de ellipsoïde van het project en eenheden voor
afstanden.
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Syntaxis length(geometry)
Argumenten • geometry - geometrie-object lĳn

Voorbeelden • length(geom_from_wkt('LINESTRING(0 0, 4 0)'))→ 4.0

Lees verder: straight_distance_2d

length3D

Berekent de 3D-lengte van een geometrie-object lĳn. Als de geometrie geen 3D-lĳnobject is, geeft het de 2D-lengte
ervan terug. Berekeningen zĳn altĳd planimetrisch in het ruimtelĳke referentiesysteem (SRS) van deze geometrie, en
de eenheden van de teruggegeven lengte komen overeen met de eenheden voor het SRS. Dit verschilt van de door
de functie $length uitgevoerde berekeningen, die ellipsoïde berekeningen zal uitvoeren, gebaseerd op de instellingen
voor de ellipsoïde van het project en eenheden voor afstanden.

Syntaxis length3D(geometry)
Argumenten • geometry - geometrie-object lĳn

Voorbeelden • length3D(geom_from_wkt('LINESTRINGZ(0 0 0, 3 0 4)'))→ 5.0

line_interpolate_angle

Geeft de hoek terug parallel aan de geometrie op een gespecificeerde afstand langs een geometrie lĳnstring. Hoeken
zĳn in graden vanaf Noord met de klok mee.

Syntaxis line_interpolate_angle(geometry, distance)
Argumenten • geometry - een geometrie lĳn

• distance - afstand langs de lĳn waarop de hoek moet worden geïnterpoleerd

Voorbeelden • line_interpolate_angle(geometry:=geom_from_wkt('LineString(0
0, 10 0)'),distance:=5)→ 90.0

line_interpolate_point

Geeft het geïnterpoleerde punt terug van een gespecificeerde afstand langs een geometrie lĳn.
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Syntaxis line_interpolate_point(geometry, distance)
Argumenten • geometry - een geometrie lĳn

• distance - afstand langs de lĳn waarop moet worden geïnterpoleerd

Voorbeelden • geom_to_wkt(line_interpolate_point(geometry:=geom_from_wkt('LineString(0
0, 8 0)'), distance:=5))→ ‘Punt (5 0)’

• geom_to_wkt(line_interpolate_point(geometry:=geom_from_wkt('LineString(0
0, 1 1, 2 0)'), distance:=2.1))→ ‘Punt (1.48492424 0.51507576)’

• geom_to_wkt(line_interpolate_point(geometry:=geom_from_wkt('LineString(0
0, 1 0)'), distance:=2))→ NULL

Lees verder: algoritme Punt op lĳn interpoleren

line_locate_point

Geeft de afstand langs een lĳnstring terug die overeenkomt met het dichtstbĳzĳnde punt die de lĳnstring komt tot
nabĳ een gespecificeerde geometrie punt.

Syntaxis line_locate_point(geometry, point)
Argumenten • geometry - een geometrie lĳn

• point - geometrie punt waarvan het dichtstbĳzĳnde punt op de lĳn moet worden gevonden

Voorbeelden • line_locate_point(geometry:=geom_from_wkt('LineString(0 0,
10 0)'),point:=geom_from_wkt('Point(5 0)'))→ 5.0

line_merge

Geeft een geometrie LineString ofMultiLineString terug, waar enige verbonden LineStrings van de geometrie voor de
invoer is samengevoegd naar één enkele lĳn. Deze functie zal NULL teruggeven als een geometrie wordt doorgegeven
die geen LineString/MultiLineString is.

Syntaxis line_merge(geometry)
Argumenten • geometry - een geometrie LineString/MultiLineString

Voorbeelden • geom_to_wkt(line_merge(geom_from_wkt('MULTILINESTRING((0
0, 1 1),(1 1, 2 2))')))→ ‘LineString(0 0,1 1,2 2)’

• geom_to_wkt(line_merge(geom_from_wkt('MULTILINESTRING((0
0, 1 1),(11 1, 21 2))')))→ ‘MultiLineString((0 0, 1 1),(11 1, 21 2)’
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line_substring

Geeft het gedeelte van een geometrie lĳn (of boog) terug dat valt tussen de gespecificeerde begin- en eindafstanden
(gemeten vanaf het begin van de lĳn). Waarden Z en M worden lineair geïnterpoleerd vanuit bestaande waarden.

Syntaxis line_substring(geometry, start_distance, end_distance)
Argumenten • geometry - een geometrie lĳn of boog

• start_distance - afstand tot begin subtekenreeks
• end_distance - afstand tot einde substring

Voorbeelden • geom_to_wkt(line_substring(geometry:=geom_from_wkt('LineString(0
0, 10 0)'),start_distance:=2,end_distance:=6)) → ‘LineString (2
0,6 0)’

Lees verder: algoritme Lĳn subdeel

m

Geeft de waarde M (meting) van een geometrie punt terug.

Syntaxis m(geometry)
Argumenten • geometry - een geometrie punt

Voorbeelden • m( geom_from_wkt( 'POINTM(2 5 4)' ) )→ 4

m_max

Geeft de maximale waarde M (measure) van een geometrie terug.

Syntaxis m_max(geometry)
Argumenten • geometry - een geometrie die waarden M bevat

Voorbeelden • m_max( make_point_m( 0,0,1 ) )→ 1
• m_max(make_line( make_point_m( 0,0,1 ), make_point_m( -1,
-1,2 ), make_point_m( -2,-2,0 ) ) )→ 2
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m_min

Geeft de minimale waarde M (measure) van een geometrie terug.

Syntaxis m_min(geometry)
Argumenten • geometry - een geometrie die waarden M bevat

Voorbeelden • m_min( make_point_m( 0,0,1 ) )→ 1
• m_min(make_line( make_point_m( 0,0,1 ), make_point_m( -1,
-1,2 ), make_point_m( -2,-2,0 ) ) )→ 0

main_angle

Geeft de hoek van de lange as terug (met de wĳzers van de klok mee, in graden vanaf Noord) van de georiënteerde
minimale rechthoek voor de begrenzing, die de geometrie volledig bedekt.

Syntaxis main_angle(geometry)
Argumenten • geometry - een geometrie

Voorbeelden • main_angle(geom_from_wkt('Polygon ((321577 129614, 321581
129618, 321585 129615, 321581 129610, 321577 129614))'))→
38.66

make_circle

Maakt een cirkelpolygoon.

Syntaxis make_circle(center, radius, [segments=36])
[] markeert optionele argumenten

Argumenten • center - middelpunt van de cirkel
• radius - straal van de cirkel
• segments - optioneel argument voor segmenteren van de polygoon. Standaard is deze
waarde 36

Voorbeelden • geom_to_wkt(make_circle(make_point(10,10), 5, 4)) → ‘Polygon
((10 15, 15 10, 10 5, 5 10, 10 15))’

• geom_to_wkt(make_circle(make_point(10,10,5), 5, 4)) →
‘PolygonZ ((10 15 5, 15 10 5, 10 5 5, 5 10 5, 10 15 5))’

• geom_to_wkt(make_circle(make_point(10,10,5,30), 5, 4)) →
‘PolygonZM ((10 15 5 30, 15 10 5 30, 10 5 5 30, 5 10 5 30, 10 15 5 30))’
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make_ellipse

Maakt een ellips-polygoon

Syntaxis make_ellipse(center, semi_major_axis, semi_minor_axis, azimuth, [segments=36])
[] markeert optionele argumenten

Argumenten • center - middelpunt van de ellips
• semi_major_axis - semi-hoofdas van de ellips
• semi_minor_axis - semi-hulpas van de ellips
• azimuth - oriëntatie van de ellips
• segments - optioneel argument voor segmenteren van de polygoon. Standaard is deze
waarde 36

Voorbeelden • geom_to_wkt(make_ellipse(make_point(10,10), 5, 2, 90, 4))
→ ‘Polygon ((15 10, 10 8, 5 10, 10 12, 15 10))’

• geom_to_wkt(make_ellipse(make_point(10,10,5), 5, 2, 90, 4))
→ ‘PolygonZ ((15 10 5, 10 8 5, 5 10 5, 10 12 5, 15 10 5))’

• geom_to_wkt(make_ellipse(make_point(10,10,5,30), 5, 2, 90,
4))→ ‘PolygonZM ((15 10 5 30, 10 8 5 30, 5 10 5 30, 10 12 5 30, 15 10 5 30))’

make_line

Maakt een lĳngeometrie uit een serie van puntgeometrieën.
Variant Lĳst met argumenten
Punten van de lĳn worden als afzonderlĳke argumenten gespecificeerd voor de functie.

Syntaxis make_line(point1, point2, …)
Argumenten • point - een geometrie punt (of array met punten)

Voorbeelden • geom_to_wkt(make_line(make_point(2,4),make_point(3,5))) →
‘LineString (2 4, 3 5)’

• geom_to_wkt(make_line(make_point(2,4),make_point(3,5),
make_point(9,7)))→ ‘LineString (2 4, 3 5, 9 7)’

Variant Array
Punten van de lĳn worden als een array van punten gespecificeerd.

Syntaxis make_line(array)
Argumenten • array - array met punten

Voorbeelden • geom_to_wkt(make_line(array(make_point(2,4),make_point(3,
5),make_point(9,7))))→ ‘LineString (2 4, 3 5, 9 7)’
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make_point

Maakt een geometrie punt van X- en Y-waarden (en optioneel waarden Z of M)

Syntaxis make_point(x, y, [z], [m])
[] markeert optionele argumenten

Argumenten • x - X-coördinaat van punt
• y - Y-coördinaat van punt
• z - optioneel Z-coördinaat van punt
• m - optionele waarde M van punt

Voorbeelden • geom_to_wkt(make_point(2,4))→ ‘Point (2 4)’
• geom_to_wkt(make_point(2,4,6))→ ‘PointZ (2 4 6)’
• geom_to_wkt(make_point(2,4,6,8))→ ‘PointZM (2 4 6 8)’

make_point_m

Maakt een geometrie punt uit X- en Y-coördinaten en waarde M.

Syntaxis make_point_m(x, y, m)
Argumenten • x - X-coördinaat van punt

• y - Y-coördinaat van punt
• m - waarde M van punt

Voorbeelden • geom_to_wkt(make_point_m(2,4,6))→ ‘PointM (2 4 6)’

make_polygon

Maakt een geometrie polygoon van een buitenste ring en optioneel een verzameling van geometrieën van binnenste
ringen

Syntaxis make_polygon(outerRing, [innerRing1], [innerRing2], …)
[] markeert optionele argumenten

Argumenten • outerRing - geometrie gesloten lĳn voor de buitenste ring van de polygoon
• innerRing - optionele geometrie gesloten lĳn voor binnenste ring

Voorbeelden • geom_to_wkt(make_polygon(geom_from_wkt('LINESTRING( 0 0, 0
1, 1 1, 1 0, 0 0 )')))→ ‘Polygon ((0 0, 0 1, 1 1, 1 0, 0 0))’

• geom_to_wkt(make_polygon(geom_from_wkt('LINESTRING( 0 0, 0
1, 1 1, 1 0, 0 0 )'),geom_from_wkt('LINESTRING( 0.
1 0.1, 0.1 0.2, 0.2 0.2, 0.2 0.1, 0.1 0.1 )'),
geom_from_wkt('LINESTRING( 0.8 0.8, 0.8 0.9, 0.9 0.9, 0.9
0.8, 0.8 0.8 )')))→ ‘Polygon ((0 0, 0 1, 1 1, 1 0, 0 0),(0.1 0.1, 0.1 0.2, 0.2 0.2,
0.2 0.1, 0.1 0.1),(0.8 0.8, 0.8 0.9, 0.9 0.9, 0.9 0.8, 0.8 0.8))’
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make_rectangle_3points

Maakt een rechthoek uit 3 punten.

Syntaxis make_rectangle_3points(point1, point2, point3, [option=0])
[] markeert optionele argumenten

Argumenten • point1 - Eerste punt.
• point2 - Tweede punt.
• point3 - Derde punt.
• option - Een optioneel argument om de rechthoek te construeren. Standaard is dezewaarde
0.Waardemag 0 (afstand) of 1 (geprojecteerd) zĳn. Optie afstand: Tweede afstand is gelĳk
aan de afstand tussen het 2e en 3e punt. Optie geprojecteerd: Tweede afstand is gelĳk aan
de afstand van de loodrechte projectie van het 3e punt op het segment of het verlengde
daarvan.

Voorbeelden • geom_to_wkt(make_rectangle_3points(make_point(0, 0),
make_point(0,5), make_point(5, 5), 0)) → ‘Polygon ((0 0, 0 5,
5 5, 5 0, 0 0))’

• geom_to_wkt(make_rectangle_3points(make_point(0, 0),
make_point(0,5), make_point(5, 3), 1)) → ‘Polygon ((0 0, 0 5,
5 5, 5 0, 0 0))’

make_regular_polygon

Maakt een normale polygoon.

Syntaxis make_regular_polygon(center, radius, number_sides, [circle=0])
[] markeert optionele argumenten

Argumenten • center - middelpunt van de normale polygoon
• radius - tweede punt. Het eerste als de normale polygoon wordt ingeschreven. Het
middelpunt van de eerste zĳde als de normale polygoon wordt omschreven.

• number_sides - Aantal zĳden/randen van de normale polygoon
• circle - Optioneel argument om de normale polygoon te construeren. Standaard is deze
waarde 0. Waarde mag zĳn 0 (ingeschreven) of 1 (omschreven)

Voorbeelden • geom_to_wkt(make_regular_polygon(make_point(0,0),
make_point(0,5), 5)) → ‘Polygon ((0 5, 4.76 1.55, 2.94 -4.05, -2.94 -
4.05, -4.76 1.55, 0 5))’

• geom_to_wkt(make_regular_polygon(make_point(0,0),
project(make_point(0,0), 4.0451, radians(36)), 5)) →
‘Polygon ((0 5, 4.76 1.55, 2.94 -4.05, -2.94 -4.05, -4.76 1.55, 0 5))’
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make_square

Maakt een vierkant uit een diagonaal.

Syntaxis make_square(point1, point2)
Argumenten • point1 - Eerste punt van de diagonaal

• point2 - Laatste punt van de diagonaal

Voorbeelden • geom_to_wkt(make_square( make_point(0,0), make_point(5,
5)))→ ‘Polygon ((0 0, -0 5, 5 5, 5 0, 0 0))’

• geom_to_wkt(make_square( make_point(5,0), make_point(5,
5)))→ ‘Polygon ((5 0, 2.5 2.5, 5 5, 7.5 2.5, 5 0))’

make_triangle

Maakt een driehoekige polygoon.

Syntaxis make_triangle(point1, point2, point3)
Argumenten • point1 - eerste punt van de driehoek

• point2 - tweede punt van de driehoek
• point3 - derde punt van de driehoek

Voorbeelden • geom_to_wkt(make_triangle(make_point(0,0), make_point(5,
5), make_point(0,10)))→ ‘Triangle ((0 0, 5 5, 0 10, 0 0))’

• geom_to_wkt(boundary(make_triangle(make_point(0,0),
make_point(5,5), make_point(0,10)))) → ‘LineString (0 0, 5 5, 0
10, 0 0)’

make_valid

Geeft een geldige geometrie terug of een lege geometrie als de geometrie niet geldig gemaakt kon worden.
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Syntaxis make_valid(geometry, [method=structure], [keep_collapsed=false])
[] markeert optionele argumenten

Argumenten • geometry - een geometrie
• method - algoritme repareren. Ofwel ‘structure’ of ‘linework’. De optie ‘linework’
combineert alle ringen naar een set verbonden lĳnen en neemt dan de geldige polygonen
uit dat netwerk uit. De methode ‘structure’ maakt eerst alle ringen geldig en voegt dan
schillen samen en trekt gaten af van de schillen om een geldig resultaat te maken. Gaat
ervan uit dat gaten en schillen correct zĳn gecategoriseerd.

• keep_collapsed - indien ingesteld op TRUE, dan zullen componenten die zĳn ingeklapt
naar een lagere dimensionaliteit worden behouden. Bĳvoorbeeld een ring die is ingeklapt
naar een lĳn, of een lĳn die is ingeklapt naar een punt.

Voorbeelden • geom_to_wkt(make_valid(geom_from_wkt('POLYGON((3 2, 4 1, 5
8, 3 2, 4 2))')))→ ‘Polygoon ((3 2, 5 8, 4 1, 3 2))’

• geom_to_wkt(make_valid(geom_from_wkt('POLYGON((3 2, 4 1, 5
8, 3 2, 4 2))'), 'linework'))→ ‘GeometryCollection (Polygon ((5 8, 4 1,
3 2, 5 8)),LineString (3 2, 4 2))’

• geom_to_wkt(make_valid(geom_from_wkt('POLYGON((3 2, 4 1, 5
8))'), method:='linework'))→ ‘Polygon ((3 2, 4 1, 5 8, 3 2))’

• make_valid(geom_from_wkt('LINESTRING(0 0)'))→Een lege geometrie

Lees verder: is_valid, Geometrieën repareren algorithm

minimal_circle

Geeft de minimale omsluitende cirkel van een geometrie terug. Dit vertegenwoordigt de minimale cirkel die alle
geometrieën binnen de verzameling omsluit.

Syntaxis minimal_circle(geometry, [segments=36])
[] markeert optionele argumenten

Argumenten • geometry - een geometrie
• segments - optioneel argument voor segmenteren van de polygoon. Standaard is deze
waarde 36

Voorbeelden • geom_to_wkt( minimal_circle( geom_from_wkt( 'LINESTRING(0
5, 0 -5, 2 1)' ), 4 ) )→ ‘Polygon ((0 5, 5 -0, -0 -5, -5 0, 0 5))’

• geom_to_wkt( minimal_circle( geom_from_wkt( 'MULTIPOINT(1
2, 3 4, 3 2)' ), 4 ) )→ ‘Polygon ((3 4, 3 2, 1 2, 1 4, 3 4))’

Lees verder: algoritme Minimale omsluitende cirkels
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nodes_to_points

Geeft een geometrie multipunt terug, bestaande uit elke knoop in de invoergeometrie.

Syntaxis nodes_to_points(geometry, [ignore_closing_nodes=false])
[] markeert optionele argumenten

Argumenten • geometry - object geometrie
• ignore_closing_nodes - optioneel argument dat specificeert of duplicaat-knopen, die
lĳnen of ringen van polygonen sluiten, ook moeten worden opgenomen. Standaard is
false, stel in op true om te vermĳden dat deze duplicaat-knopen worden opgenomen in
de verzameling voor de uitvoer.

Voorbeelden • geom_to_wkt(nodes_to_points(geom_from_wkt('LINESTRING(0 0,
1 1, 2 2)')))→ ‘MultiPoint ((0 0),(1 1),(2 2))’

• geom_to_wkt(nodes_to_points(geom_from_wkt('POLYGON((-1 -1,
4 0, 4 2, 0 2, -1 -1))'),true))→ ‘MultiPoint ((-1 -1),(4 0),(4 2),(0 2))’

Lees verder: algoritme Punten uitnemen

num_geometries

Geeft het aantal geometrieën terug uit een verzameling geometrieën, of het aantal delen in een meerdelige geometrie.
De functie geeft NULL terug als de invoergeometrie geen verzameling is.

Syntaxis num_geometries(geometry)
Argumenten • geometry - verzameling geometrie of meerdelige geometrie

Voorbeelden • num_geometries(geom_from_wkt('GEOMETRYCOLLECTION(POINT(0
1), POINT(0 0), POINT(1 0), POINT(1 1))'))→ 4

• num_geometries(geom_from_wkt('MULTIPOINT((0 1), (0 0), (1
0))'))→ 3

num_interior_rings

Geeft het aantal binnenste ringen terug uit een polygoon of verzameling van geometrie, of NULL als de
invoergeometrie geen polygoon of verzameling van geometrie is.

Syntaxis num_interior_rings(geometry)
Argumenten • geometry - invoergeometrie

Voorbeelden • num_interior_rings(geom_from_wkt('POLYGON((-1 -1, 4 0, 4 2,
0 2, -1 -1),(-0.1 -0.1, 0.4 0, 0.4 0.2, 0 0.2, -0.1 -0.1))'))
→ 1
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num_points

Geeft het aantal punten in een geometrie terug.

Syntaxis num_points(geometry)
Argumenten • geometry - een geometrie

Voorbeelden • num_points($geometry)→ aantal punten in de geometrie van het huidige object

num_rings

Geeft het aantal ringen (inclusief buitenste ringen) terug uit een polygoon of verzameling van geometrie, of NULL
als de invoergeometrie geen polygoon of verzameling is.

Syntaxis num_rings(geometry)
Argumenten • geometry - invoergeometrie

Voorbeelden • num_rings(geom_from_wkt('POLYGON((-1 -1, 4 0, 4 2, 0 2, -1
-1),(-0.1 -0.1, 0.4 0, 0.4 0.2, 0 0.2, -0.1 -0.1))'))→ 2

offset_curve

Geeft een geometrie terug die wordt gevormd door de verspringing van een geometrie lĳn naar de kant. Afstanden
zĳn in het ruimtelĳke referentiesysteem van deze geometrie.

Syntaxis offset_curve(geometry, distance, [segments=8], [join=1], [miter_limit=2.0])
[] markeert optionele argumenten

Argumenten • geometry - een geometrie (multi)lĳn
• distance - afstand voor de verschuiving. Positieve waarden zullen links van de lĳn worden
gebufferd, negatieve waarden aan de rechterkant

• segments - aantal te gebruiken segmenten om een kwartcirkel weer te geven als een
afgeronde stĳl voor samenvoegen wordt gebruikt. Een groter aantal resulteert in een
gladdere lĳn met meer knopen.

• join - stĳl voor samenvoegen van hoeken, waar 1 = rond, 2 = verstek en 3 = afgeschuind
• miter_limit - limiet voor de verhouding van het verstek, gebruikt voor zeer scherpe hoeken
(alleen bĳ het gebruiken van samenvoegingen in verstek)

Voorbeelden • offset_curve($geometry, 10.5) → verschuiving van de lĳn naar links met
10.5 eenheden

• offset_curve($geometry, -10.5)→ verschuiving van de lĳn naar rechts met
10.5 eenheden

• offset_curve($geometry, 10.5, segments:=16, join:=1) → lĳn
verschoven naar links met 10,5 eenheden, meer segmenten gebruikend wat resulteert in
een gladdere boog

• offset_curve($geometry, 10.5, join:=3) → lĳn verschoven naar links
met 10,5 eenheden, met een schuine samenvoeging

310 Hoofdstuk 13. Doe meer met expressies



QGIS Desktop 3.28 User Guide

Lees verder: algoritme Verspringing lĳnen

order_parts

Sorteert de delen van een MultiGeometrie op opgegeven criteria

Syntaxis order_parts(geometry, orderby, [ascending=true])
[] markeert optionele argumenten

Argumenten • geometry - een geometrie van het type multi
• orderby - een tekenreeks voor een expressie die de criteria voor de volgorde definieert
• ascending - Booleaanse waarde, True voor oplopend, False voor aflopend

Voorbeelden • geom_to_wkt(order_parts(geom_from_wkt('MultiPolygon (((1
1, 5 1, 5 5, 1 5, 1 1)),((1 1, 9 1, 9 9, 1 9, 1 1)))'),
'area($geometry)', False))→ ‘MultiPolygon (((1 1, 9 1, 9 9, 1 9, 1 1)),((1 1,
5 1, 5 5, 1 5, 1 1)))’

• geom_to_wkt(order_parts(geom_from_wkt('LineString(1 2, 3 2,
4 3)'), '1', True))→ ‘LineString(1 2, 3 2, 4 3)’

oriented_bbox

Geeft een geometrie terug die het minimale georiënteerde begrenzingsvak van een invoergeometrie weergeeft.

Syntaxis oriented_bbox(geometry)
Argumenten • geometry - een geometrie

Voorbeelden • geom_to_wkt( oriented_bbox( geom_from_wkt( 'MULTIPOINT(1 2,
3 4, 3 2)' ) ) )→ ‘Polygon ((3 2, 3 4, 1 4, 1 2, 3 2))’

Lees verder: algoritme Georiënteerd minimum begrenzingsvak

overlaps

Test of een geometrie een andere overlapt. Geeft TRUE terug als de geometrieën ruimte delen, van dezelfde dimensie
zĳn, maar niet volledig door elkaar worden omvat.

Syntaxis overlaps(geometry1, geometry2)
Argumenten • geometry1 - een geometrie

• geometry2 - een geometrie

Voorbeelden • overlaps( geom_from_wkt( 'LINESTRING(3 5, 4 4, 5 5, 5 3)'
), geom_from_wkt( 'LINESTRING(3 3, 4 4, 5 5)' ) )→ TRUE

• overlaps( geom_from_wkt( 'LINESTRING(0 0, 1 1)' ),
geom_from_wkt( 'LINESTRING(3 3, 4 4, 5 5)' ) )→ FALSE
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overlay_contains

Geeft terug of het huidige object ruimtelĳk minstens één object uit een doellaag bevat, of een array van op een
expressie gebaseerde resultaten voor de objecten in de doellaag die zĳn opgenomen in het huidige object.
Lees meer over het onderliggende predikaat van GEOS “Contains”, zoals beschreven in de functie voor PostGIS
ST_Contains.

Syntaxis overlay_contains(layer, [expression], [filter], [limit], [cache=false])
[] markeert optionele argumenten

Argumenten • layer - de laag waarvan de overleg wordt gecontroleerd
• expression - een optionele expressie die moet worden geëvalueerd met de objecten van
de doellaag. Indien niet ingesteld zal de functie slechts een Booleaanse waarde teruggeven
die aangeeft of er tenminste één overeenkomst is.

• filter - een optionele expressie om de te controleren doelobjecten te filteren. Indien niet
ingesteld zullen alle objecten worden gecontroleerd.

• limit - een optioneel geheel getal (integer) om het aantal overeenkomende objecten te
beperken. Indien niet ingesteld zullen alle overeenkomende objecten worden teruggegeven.

• cache - stel dit in op true om een lokale ruimtelĳke index te bouwen (dit is meestal niet
gewenst, tenzĳ u werkt met een bĳzonder trage gegevensprovider)

Voorbeelden • overlay_contains('regions') → TRUE als het huidige object ruimtelĳk een
region bevat

• overlay_contains('regions', filter:= population > 10000)→
TRUE als het huidige object ruimtelĳk een region bevat met een population die groter is
dan 10000

• overlay_contains('regions', name) → een array van namen, voor de
regions die zĳn opgenomen in het huidige object

• array_to_string(overlay_contains('regions', name)) → een
tekenreeks als een kommagescheiden lĳst van namen, voor de regions die zĳn opgenomen
in het huidige object

• array_sort(overlay_contains(layer:='regions',
expression:="name", filter:= population > 10000)) → een
gesorteerde array van namen, voor de regions die zĳn opgenomen in het huidige object en
met een population die groter is dan 10000

• overlay_contains(layer:='regions', expression:=
geom_to_wkt($geometry), limit:=2) → een array van geometrieën
(in WKT), voor maximaal twee regions die zĳn opgenomen in het huidige object

Lees verder: contains, array bewerken, algoritme Selecteren op plaats

overlay_crosses

Geeft terug of het huidige object ruimtelĳk kruist met minstens één object uit een doellaag, of een array van op een
expressie gebaseerde resultaten voor de objecten in de doellaag die worden gekruist door het huidige object.
Lees meer over het onderliggende predikaat van GEOS “Crosses”, zoals beschreven in de functie voor PostGIS
ST_Crosses.
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Syntaxis overlay_crosses(layer, [expression], [filter], [limit], [cache=false])
[] markeert optionele argumenten

Argumenten • layer - de laag waarvan de overleg wordt gecontroleerd
• expression - een optionele expressie die moet worden geëvalueerd met de objecten van
de doellaag. Indien niet ingesteld zal de functie slechts een Booleaanse waarde teruggeven
die aangeeft of er tenminste één overeenkomst is.

• filter - een optionele expressie om de te controleren doelobjecten te filteren. Indien niet
ingesteld zullen alle objecten worden gecontroleerd.

• limit - een optioneel geheel getal (integer) om het aantal overeenkomende objecten te
beperken. Indien niet ingesteld zullen alle overeenkomende objecten worden teruggegeven.

• cache - stel dit in op true om een lokale ruimtelĳke index te bouwen (dit is meestal niet
gewenst, tenzĳ u werkt met een bĳzonder trage gegevensprovider)

Voorbeelden • overlay_crosses('regions')→ TRUE als het huidige object ruimtelĳk kruist
met een region

• overlay_crosses('regions', filter:= population > 10000) →
TRUE als het huidige object ruimtelĳk kruist met een region met een population die groter
is dan 10000

• overlay_crosses('regions', name)→ een array van namen, voor de regions
die worden gekruist door het huidige object

• array_to_string(overlay_crosses('regions', name)) → een
tekenreeks als een kommagescheiden lĳst van namen, voor de regions die worden gekruist
door het huidige object

• array_sort(overlay_crosses(layer:='regions',
expression:="name", filter:= population > 10000)) → een
gesorteerde array van namen, voor de regions die worden gekruist door het huidige object
en met een population die groter is dan 10000

• overlay_crosses(layer:='regions', expression:=
geom_to_wkt($geometry), limit:=2) → een array van geometrieën
(in WKT), voor maximaal twee regions die worden gekruist door het huidige object

Lees verder: crosses, array bewerken, algoritme Selecteren op plaats

overlay_disjoint

Geeft terug of het huidige object ruimtelĳk is losgekoppeld van alle objecten uit een doellaag bevat, of een array van
op een expressie gebaseerde resultaten voor de objecten in de doellaag die zĳn losgekoppeld van het huidige object.
Lees meer over het onderliggende predikaat van GEOS “Disjoint”, zoals beschreven in de functie voor PostGIS
ST_Disjoint.
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Syntaxis overlay_disjoint(layer, [expression], [filter], [limit], [cache=false])
[] markeert optionele argumenten

Argumenten • layer - de laag waarvan de overleg wordt gecontroleerd
• expression - een optionele expressie die moet worden geëvalueerd met de objecten van
de doellaag. Indien niet ingesteld zal de functie slechts een Booleaanse waarde teruggeven
die aangeeft of er tenminste één overeenkomst is.

• filter - een optionele expressie om de te controleren doelobjecten te filteren. Indien niet
ingesteld zullen alle objecten worden gecontroleerd.

• limit - een optioneel geheel getal (integer) om het aantal overeenkomende objecten te
beperken. Indien niet ingesteld zullen alle overeenkomende objecten worden teruggegeven.

• cache - stel dit in op true om een lokale ruimtelĳke index te bouwen (dit is meestal niet
gewenst, tenzĳ u werkt met een bĳzonder trage gegevensprovider)

Voorbeelden • overlay_disjoint('regions') → TRUE als het huidige object ruimtelĳk is
losgekoppeld van alle regions

• overlay_disjoint('regions', filter:= population > 10000)→
TRUE als het huidige object ruimtelĳk is losgekoppeld van alle regions met een population
die groter is dan 10000

• overlay_disjoint('regions', name) → een array van namen, voor de
regions die ruimtelĳk zĳn losgekoppeld van het huidige object

• array_to_string(overlay_disjoint('regions', name)) → een
tekenreeks als een kommagescheiden lĳst van namen, voor de regions die ruimtelĳk zĳn
losgekoppeld van het huidige object

• array_sort(overlay_disjoint(layer:='regions',
expression:="name", filter:= population > 10000)) → een
gesorteerde array van namen, voor de regions die ruimtelĳk zĳn losgekoppeld van het
huidige object en met een population die groter is dan 10000

• overlay_disjoint(layer:='regions', expression:=
geom_to_wkt($geometry), limit:=2) → een array van geometrieën
(in WKT), voor maximaal twee regions die ruimtelĳk zĳn losgekoppeld van het huidige
object

Lees verder: disjoint, array bewerken, algoritme Selecteren op plaats

overlay_equals

Geeft terug of het huidige object ruimtelĳk gelĳk is aan minstens één object uit een doellaag, of een array van op een
expressie gebaseerde resultaten voor de objecten in de doellaag die ruimtelĳk gelĳk zĳn aan het huidige object.
Lees meer over het onderliggende predikaat van GEOS “Equals”, zoals beschreven in de functie voor PostGIS
ST_Equals.
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Syntaxis overlay_equals(layer, [expression], [filter], [limit], [cache=false])
[] markeert optionele argumenten

Argumenten • layer - de laag waarvan de overleg wordt gecontroleerd
• expression - een optionele expressie die moet worden geëvalueerd met de objecten van
de doellaag. Indien niet ingesteld zal de functie slechts een Booleaanse waarde teruggeven
die aangeeft of er tenminste één overeenkomst is.

• filter - een optionele expressie om de te controleren doelobjecten te filteren. Indien niet
ingesteld zullen alle objecten worden gecontroleerd.

• limit - een optioneel geheel getal (integer) om het aantal overeenkomende objecten te
beperken. Indien niet ingesteld zullen alle overeenkomende objecten worden teruggegeven.

• cache - stel dit in op true om een lokale ruimtelĳke index te bouwen (dit is meestal niet
gewenst, tenzĳ u werkt met een bĳzonder trage gegevensprovider)

Voorbeelden • overlay_equals('regions')→ TRUE als het huidige object ruimtelĳk gelĳk is
aan een region

• overlay_equals('regions', filter:= population > 10000) →
TRUE als het huidige object ruimtelĳk gelĳk is aan een region met een population die
groter is dan 10000

• overlay_equals('regions', name)→ een array van namen, voor de regions
die ruimtelĳk gelĳk zĳn aan het huidige object

• array_to_string(overlay_equals('regions', name)) → een
tekenreeks als een kommagescheiden lĳst van namen, voor de regions die ruimtelĳk gelĳk
zĳn aan het huidige object

• array_sort(overlay_equals(layer:='regions',
expression:="name", filter:= population > 10000)) → een
gesorteerde array van namen, voor de regions die ruimtelĳk gelĳk zĳn aan het huidige
object en met een population die groter is dan 10000

• overlay_equals(layer:='regions', expression:=
geom_to_wkt($geometry), limit:=2) → een array van geometrieën
(in WKT), voor maximaal twee regions die ruimtelĳk gelĳk zĳn aan het huidige object

Lees verder: array bewerken, algoritme Selecteren op plaats

overlay_intersects

Geeft terug of het huidige object ruimtelĳk minstens één object uit een doellaag kruist, of een array van op een
expressie gebaseerde resultaten voor de objecten in de doellaag die het huidige object kruist.
Lees meer over het onderliggende predikaat van GEOS “Intersects”, zoals beschreven in de functie voor PostGIS
ST_Intersects.
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Syntaxis overlay_intersects(layer, [expression], [filter], [limit], [cache=false], [min_overlap],
[min_inscribed_circle_radius], [return_details], [sort_by_intersection_size])
[] markeert optionele argumenten

Argumenten • layer - de laag waarvan de overleg wordt gecontroleerd
• expression - een optionele expressie die moet worden geëvalueerd met de objecten van
de doellaag. Indien niet ingesteld zal de functie slechts een Booleaanse waarde teruggeven
die aangeeft of er tenminste één overeenkomst is.

• filter - een optionele expressie om de te controleren doelobjecten te filteren. Indien niet
ingesteld zullen alle objecten worden gecontroleerd.

• limit - een optioneel geheel getal (integer) om het aantal overeenkomende objecten te
beperken. Indien niet ingesteld zullen alle overeenkomende objecten worden teruggegeven.

• cache - stel dit in op true om een lokale ruimtelĳke index te bouwen (dit is meestal niet
gewenst, tenzĳ u werkt met een bĳzonder trage gegevensprovider)

• min_overlap - definieert een optioneel filter voor uitsluiting:
– voor polygonen, een minimum gebied in vierkante eenheden van het huidige object
voor de kruising. Als de resultaten van de kruising resulteert in meerdere polygonen
zal de kruising worden teruggegeven als tenminste één van de polygonen een gebied
heeft dat groter of gelĳk is aan de waarde.

– voor lĳnen, een minimum gebied in eenheden van het huidige object. Als de
resultaten van de kruising resulteert in meerdere lĳnen zal de kruising worden
teruggegeven als tenminste één van de polygonen een lengte heeft die groter of gelĳk
is aan de waarde.

• min_inscribed_circle_radius - definieert een optioneel filter voor uitsluiting (alleen
voor polygonen): minimum straal in eenheden voor het huidige object voor de maximale
ingesloten cirkel van de kruising. Als de resultaten van de kruising resulteert in meerdere
polygonen zal de kruising worden teruggegeven als tenminste één van de polygonen een
straal voor de maximale ingesloten cirkel heeft die groter of gelĳk is aan de waarde.
Lees meer over het onderliggende predikaat van GEOS, zoals beschreven in de functie
voor PostGIS ST_MaximumInscribedCircle.
Dit argument vereist GEOS >= 3.9.

• return_details - Stel dit in op TRUE om een lĳst kaarten terug te geven die (sleutel
namen tussen aanhalingstekens) het object ‘id’, de expressie ‘result’ en de waarde ‘overlap’
bevatten. De ‘straal’ van de maximale ingesloten cirkel wordt ook teruggegeven als de
doellaag een polygoon is. Alleen geldig indien gebruikt met de parameter expression

• sort_by_intersection_size - alleen geldig indien gebruikt met een expressie, stel dit in op
‘des’ om de resultaten weer te geven in de volgorde van de waarde overlap in aflopende
volgorde of stel het in op ‘asc’ voor oplopende volgorde.

Voorbeelden • overlay_intersects('regions') → TRUE als het huidige object ruimtelĳk
een region kruist

• overlay_intersects('regions', filter:= population > 10000)
→ TRUE als het huidige object ruimtelĳk een region kruist met een population die groter
is dan 10000

• overlay_intersects('regions', name) → een array van namen, voor de
regions gekruist door het huidige object

• array_to_string(overlay_intersects('regions', name)) → een
tekenreeks als een kommagescheiden lĳst van namen, voor de regions gekruist door het
huidige object

• array_sort(overlay_intersects(layer:='regions',
expression:="name", filter:= population > 10000)) → een
gesorteerde array van namen, voor de regions gekruist door het huidige object en met een
population die groter is dan 10000

• overlay_intersects(layer:='regions', expression:=
geom_to_wkt($geometry), limit:=2) → een array van geometrieën
(in WKT), voor maximaal twee regions gekruist door het huidige object

• overlay_intersects(layer:='regions', min_overlap:=0.54) →
TRUE als het huidige object ruimtelĳk een region kruist en het gebied van de kruising
(of tenminste één van de delen in het geval van multipolygonen) is groter of gelĳk aan
0.54

• overlay_intersects(layer:='regions', min_inscribed_circle_radius:=0.
54)→TRUE als het huidige object ruimtelĳk een region kruist en demaximale ingesloten
cirkel van het gebied van de kruising (of tenminste één van de delen in het geval van
multipolygonen) is groter of gelĳk aan 0.54

• overlay_intersects(layer:='regions', expression:=
geom_to_wkt($geometry), return_details:=true) → een array
van kaarten die ‘id’, ‘result’, ‘overlap’ en ‘radius’ bevatten

• overlay_intersects(layer:='regions', expression:=
geom_to_wkt($geometry), sort_by_intersection_size:='des')
→ een array van geometrieën (in WKT) op volgorde van de waarde overlap in aflopende
volgorde
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Lees verder: intersects, array bewerken, algoritme Selecteren op plaats

overlay_nearest

Geeft terug of het huidige object binnen een bepaalde afstand object(en) heeft uit een doellaag, of een array van
op een expressie gebaseerde resultaten voor de objecten in de doellaag binnen een bepaalde afstand van het huidige
object.
Opmerking: Deze functie kan erg traag zĳn en veel geheugen gebruiken voor grote lagen.

Syntaxis overlay_nearest(layer, [expression], [filter], [limit=1], [max_distance], [cache=false])
[] markeert optionele argumenten

Argumenten • layer - de doellaag
• expression - een optionele expressie die moet worden geëvalueerd met de objecten van
de doellaag. Indien niet ingesteld zal de functie slechts een Booleaanse waarde teruggeven
die aangeeft of er tenminste één overeenkomst is.

• filter - een optionele expressie om de te controleren doelobjecten te filteren. Indien niet
ingesteld zullen alle objecten worden gebruikt.

• limit - een optioneel geheel getal (integer) om het aantal overeenkomende objecten te
beperken. Indien niet ingesteld zal alleen het dichtstbĳzĳnde object worden teruggegeven.
Indien ingesteld op -1, geeft het alle overeenkomende objecten terug.

• max_distance - een optionele afstand om het zoeken naar overeenkomende objecten te
beperken. Indien niet ingesteld zullen alle objecten van de doellaag worden gebruikt.

• cache - stel dit in op true om een lokale ruimtelĳke index te bouwen (dit is meestal niet
gewenst, tenzĳ u werkt met een bĳzonder trage gegevensprovider)

Voorbeelden • overlay_nearest('airports') → TRUE als de laag “airports” minstens één
object heeft

• overlay_nearest('airports', max_distance:= 5000)→TRUE als er
een vliegveld is binnen een afstand van 5000 kaarteenheden vanaf het huidige object

• overlay_nearest('airports', name) → de naam van het dichtstbĳzĳnde
vliegveld tot het huidige object, als een array

• array_to_string(overlay_nearest('airports', name))→ de naam
van het dichtstbĳzĳnde vliegveld tot het huidige object, als een tekenreeks

• overlay_nearest(layer:='airports', expression:= name,
max_distance:= 5000) → de naam van het dichtstbĳzĳnde vliegveld binnen een
afstand van 5000 kaarteenheden vanaf het huidige object, als een array

• overlay_nearest(layer:='airports', expression:="name",
filter:= "Use"='Civilian', limit:=3)→ een array van namen, voor ten
hoogste drie dichtstbĳzĳnde burgerlĳke vliegvelden, gesorteerd op afstand

• overlay_nearest(layer:='airports', expression:="name",
limit:= -1, max_distance:= 5000) → een array van namen, voor alle
vliegvelden binnen een afstand van 5000 kaarteenheden vanaf het huidige object,
gesorteerd op afstand

Lees verder: array bewerken, algoritme Koppel attributen op dichtstbĳzĳnde
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overlay_touches

Geeft terug of het huidige object ruimtelĳk één object uit een doellaag raakt, of een array van op een expressie
gebaseerde resultaten voor de objecten in de doellaag die worden geraakt door het huidige object.
Lees meer over het onderliggende predikaat van GEOS “Touches”, zoals beschreven in de functie voor PostGIS
ST_Touches.

Syntaxis overlay_touches(layer, [expression], [filter], [limit], [cache=false])
[] markeert optionele argumenten

Argumenten • layer - de laag waarvan de overleg wordt gecontroleerd
• expression - een optionele expressie die moet worden geëvalueerd met de objecten van
de doellaag. Indien niet ingesteld zal de functie slechts een Booleaanse waarde teruggeven
die aangeeft of er tenminste één overeenkomst is.

• filter - een optionele expressie om de te controleren doelobjecten te filteren. Indien niet
ingesteld zullen alle objecten worden gecontroleerd.

• limit - een optioneel geheel getal (integer) om het aantal overeenkomende objecten te
beperken. Indien niet ingesteld zullen alle overeenkomende objecten worden teruggegeven.

• cache - stel dit in op true om een lokale ruimtelĳke index te bouwen (dit is meestal niet
gewenst, tenzĳ u werkt met een bĳzonder trage gegevensprovider)

Voorbeelden • overlay_touches('regions') → TRUE als het huidige object ruimtelĳk een
region raakt

• overlay_touches('regions', filter:= population > 10000) →
TRUE als het huidige object ruimtelĳk een region raakt met een population die groter is
dan 10000

• overlay_touches('regions', name)→ een array van namen, voor de regions
die worden geraakt door het huidige object

• string_to_array(overlay_touches('regions', name)) → een
tekenreeks als een kommagescheiden lĳst van namen, voor de regions die worden geraakt
door het huidige object

• array_sort(overlay_touches(layer:='regions',
expression:="name", filter:= population > 10000)) → een
gesorteerde array van namen, voor de regions die worden geraakt door het huidige object
en met een population die groter is dan 10000

• overlay_touches(layer:='regions', expression:=
geom_to_wkt($geometry), limit:=2) → een array van geometrieën
(in WKT), voor maximaal twee regions die worden geraakt door het huidige object

Lees verder: touches, array bewerken, algoritme Selecteren op plaats

overlay_within

Geeft terug of het huidige object ruimtelĳk binnen minstens één object uit een doellaag ligt, of een array van op een
expressie gebaseerde resultaten voor de objecten in de doellaag die het huidige object bevatten.
Lees meer over het onderliggende predikaat van GEOS “Within”, zoals beschreven in de functie voor PostGIS
ST_Within.
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Syntaxis overlay_within(layer, [expression], [filter], [limit], [cache=false])
[] markeert optionele argumenten

Argumenten • layer - de laag waarvan de overleg wordt gecontroleerd
• expression - een optionele expressie die moet worden geëvalueerd met de objecten van
de doellaag. Indien niet ingesteld zal de functie slechts een Booleaanse waarde teruggeven
die aangeeft of er tenminste één overeenkomst is.

• filter - een optionele expressie om de te controleren doelobjecten te filteren. Indien niet
ingesteld zullen alle objecten worden gecontroleerd.

• limit - een optioneel geheel getal (integer) om het aantal overeenkomende objecten te
beperken. Indien niet ingesteld zullen alle overeenkomende objecten worden teruggegeven.

• cache - stel dit in op true om een lokale ruimtelĳke index te bouwen (dit is meestal niet
gewenst, tenzĳ u werkt met een bĳzonder trage gegevensprovider)

Voorbeelden • overlay_within('regions') → TRUE als het huidige object ruimtelĳk in een
region ligt

• overlay_within('regions', filter:= population > 10000) →
TRUE als het huidige object ruimtelĳk in een region ligt met een population die groter is
dan 10000

• overlay_within('regions', name)→ een array van namen, voor de regions
die het huidige object bevatten

• array_to_string(overlay_within('regions', name)) → een
tekenreeks als een kommagescheiden lĳst van namen, voor de regions die het huidige
object bevatten

• array_sort(overlay_within(layer:='regions',
expression:="name", filter:= population > 10000)) → een
gesorteerde array van namen, voor de regions die het huidige object bevatten en met een
population die groter is dan 10000

• overlay_within(layer:='regions', expression:=
geom_to_wkt($geometry), limit:=2) → een array van geometrieën
(in WKT), voor maximaal twee regions die het huidige object bevatten

Lees verder: within, array bewerken, algoritme Selecteren op plaats

$perimeter

Geeft de lengte van de perimeter van het huidige object terug. De door deze functie berekende perimeter respecteert
zowel de instelling van de ellipsoïde voor het huidige project als de instellingen voor eenheden voor afstand. Als,
bĳvoorbeeld, een ellipsoïde is ingesteld voor het project, dan zal de berekende perimeter ellipsoïde zĳn, en als er
geen ellipsoïde is ingesteld, dan zal de perimeter planimetrisch zĳn.

Syntaxis $perimeter
Voorbeelden • $perimeter→ 42
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perimeter

Geeft de perimeter terug van een geometrie-object polygoon. Berekeningen zĳn altĳd planimetrisch in het ruimtelĳke
referentiesysteem (SRS) van deze geometrie, en de eenheden van de teruggegeven perimeter komen overeen met de
eenheden voor het SRS. Dit verschilt van de door de functie $perimeter uitgevoerde berekeningen, die ellipsoïde
berekeningen zal uitvoeren, gebaseerd op de instellingen voor de ellipsoïde van het project en eenheden voor de
afstanden.

Syntaxis perimeter(geometry)
Argumenten • geometry - geometrie-object polygoon

Voorbeelden • perimeter(geom_from_wkt('POLYGON((0 0, 4 0, 4 2, 0 2, 0
0))'))→ 12.0

point_n

Geeft een specifieke knoop van een geometrie terug.

Syntaxis point_n(geometry, index)
Argumenten • geometry - object geometrie

• index - index van terug te geven knoop, waar 1 de eerste knoop is; als de waarde negatief
is, zal de geselecteerde index voor het punt zĳn totale aantal minus de absolute waarde zĳn

Voorbeelden • geom_to_wkt(point_n(geom_from_wkt('POLYGON((0 0, 4 0, 4 2,
0 2, 0 0))'),2))→ ‘Point (4 0)’

Lees verder: algoritme Specifieke punten uitnemen

point_on_surface

Geeft een punt terug dat gegarandeerd is gelegen op het oppervlak van een geometrie.

Syntaxis point_on_surface(geometry)
Argumenten • geometry - een geometrie

Voorbeelden • point_on_surface($geometry)→ een geometrie punt

Lees verder: algoritme Punt op oppervlak

320 Hoofdstuk 13. Doe meer met expressies



QGIS Desktop 3.28 User Guide

pole_of_inaccessibility

Berekent de geschatte Pool van Ontoegankelĳkheid voor een oppervlak, wat het meest veraf gelegen interne punt
is vanaf de grens van het oppervlak. Deze functie gebruikt het algoritme ‘polylabel’ (Vladimir Agafonkin, 2016),
wat een iteratieve benadering is die gegarandeerd het ware punt van de Pool van Ontoegankelĳkheid vind binnen een
gespecificeerde tolerantie. Meer preciezere tolerantie vereist meer doorlopen en zullen langer duren om te berekenen.

Syntaxis pole_of_inaccessibility(geometry, tolerance)
Argumenten • geometry - een geometrie

• tolerance - maximale afstand tussen het teruggegeven punt en de locatie van de ware pool

Voorbeelden • geom_to_wkt(pole_of_inaccessibility( geom_from_wkt('POLYGON((0
1, 0 9, 3 10, 3 3, 10 3, 10 1, 0 1))'), 0.1))→ ‘Point(1.546875
2.546875)’

Lees verder: algoritme Pool van ontoegankelĳkheid

project

Geeft een geprojecteerd punt terug vanaf een beginpunt met een afstand, richting (azimut) en een hoogte in radialen.

Syntaxis project(point, distance, azimuth, [elevation])
[] markeert optionele argumenten

Argumenten • point - beginpunt
• distance - te projecteren afstand
• azimuth - azimut in radialen, met de wĳzers van de klok mee, waar 0 overeenkomt met
noord

• elevation - hoek van de helling in radialen

Voorbeelden • geom_to_wkt(project(make_point(1, 2), 3, radians(270))) →
‘Point(-2, 2)’

Lees verder: algoritme Punten projecteren (Cartesiaans)

relate

Test de weergave Dimensional Extended 9 Intersection Model (DE-9IM) van de relatie tussen twee geometrieën.
Variant Relatie
Geeft de weergave Dimensional Extended 9 Intersection Model (DE-9IM) van de relatie tussen twee geometrieën
weer.

Syntaxis relate(geometry, geometry)
Argumenten • geometry - een geometrie

• geometry - een geometrie

Voorbeelden • relate( geom_from_wkt( 'LINESTRING(40 40,120 120)' ),
geom_from_wkt( 'LINESTRING(40 40,60 120)' ) )→ ‘FF1F00102’
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Variant Overeenkomst patroon
Test of de relatie DE-9IM tussen twee geometrieën overeenkomt met een gespecificeerd patroon.

Syntaxis relate(geometry, geometry, pattern)
Argumenten • geometry - een geometrie

• geometry - een geometrie
• pattern - het patroon voor DE-9IM dat overeen moet komen

Voorbeelden • relate( geom_from_wkt( 'LINESTRING(40 40,120 120)' ),
geom_from_wkt( 'LINESTRING(40 40,60 120)' ), '**1F001**'
)→ TRUE

reverse

Draait de richting van een lĳn om door de volgorde van zĳn punten om te draaien.

Syntaxis reverse(geometry)
Argumenten • geometry - een geometrie

Voorbeelden • geom_to_wkt(reverse(geom_from_wkt('LINESTRING(0 0, 1 1, 2
2)')))→ ‘LINESTRING(2 2, 1 1, 0 0)’

Lees verder: algoritme Omgekeerde lĳnrichting

rotate

Geeft de geroteerde versie van een geometrie terug. Berekeningen zĳn in het ruimtelĳke referentiesysteem van deze
geometrie.

Syntaxis rotate(geometry, rotation, [center=NULL], [per_part=false])
[] markeert optionele argumenten

Argumenten • geometry - een geometrie
• rotation - rotatie in graden met de wĳzers van de klok mee
• center - middelpunt van de rotatie. Indien niet gespecificeerd wordt het midden van het
begrenzingsvak van de geometrie gebruikt

• per_part - rotatie per deel toepassen. Indien TRUE, dan zal de rotatie worden toegepast
rondom het midden van het begrenzingsvak van elk deel als de invoergeometrie meerdelig
is en een expliciet punt voor de rotatie niet is gespecificeerd.

Voorbeelden • rotate($geometry, 45, make_point(4, 5)) → geometrie 45 graden
geroteerd, met de wĳzers van de klok mee, rond het punt (4, 5)

• rotate($geometry, 45)→ geometrie 45 graden geroteerd, met de wĳzers van de
klok mee, rond het middelpunt van zĳn begrenzingsvak
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Fig. 13.7: Objecten roteren

roundness

Berekent hoe dichtbĳ de vorm van een polygoon is bĳ een cirkel. De functie geeft TRUE terug als de vorm van de
polygoon een perfecte cirkel is en 0 als hĳ volledig vlak is.

Syntaxis roundness(geometry)
Argumenten • geometry - een polygoon

Voorbeelden • round(roundness(geom_from_wkt('POLYGON(( 0 0, 0 1, 1 1, 1
0, 0 0))')), 3)→ 0.785

• round(roundness(geom_from_wkt('POLYGON(( 0 0, 0 0.1, 1 0.1,
1 0, 0 0))')), 3)→ 0.260

Lees verder: algoritme Rondheid
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scale

Geeft een geschaalde versie van een geometrie terug. Berekeningen zĳn in het ruimtelĳke referentiesysteem van deze
geometrie.

Syntaxis scale(geometry, x_scale, y_scale, [center])
[] markeert optionele argumenten

Argumenten • geometry - een geometrie
• x_scale - schaalfactor X-as
• y_scale - schaalfactor Y-as
• center - middelpunt van het op schaal brengen. Indien niet gespecificeerd wordt het
midden van het begrenzingsvak van de geometrie gebruikt

Voorbeelden • scale($geometry, 2, 0.5, make_point(4, 5)) → geometrie tweemaal
horizontaal geschaald en verticaal gehalveerd, rond het punt (4, 5)

• scale($geometry, 2, 0.5, make_point(4, 5)) → geometrie tweemaal
horizontaal geschaald en verticaal gehalveerd, rond hetmiddelpunt van zĳn begrenzingsvak

segments_to_lines

Geeft een geometrie multilĳn terug, bestaande uit een lĳn voor elk segment in de invoergeometrie.

Syntaxis segments_to_lines(geometry)
Argumenten • geometry - object geometrie

Voorbeelden • geom_to_wkt(segments_to_lines(geom_from_wkt('LINESTRING(0
0, 1 1, 2 2)')))→ ‘MultiLineString ((0 0, 1 1),(1 1, 2 2))’

Lees verder: algoritme Lĳnen uitvergroten

shared_paths

Geeft een verzameling terug die paden bevat die worden gedeeld door de twee invoergeometrieën. Die welke in
dezelfde richting gaan staan in het eerste element van de verzameling, die welke in tegengestelde richting gaan staan
in het tweede element. De paden zelf worden gegeven in de richting van de eerste geometrie.
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Syntaxis shared_paths(geometry1, geometry2)
Argumenten • geometry1 - een geometrie LineString/MultiLineString

• geometry2 - een geometrie LineString/MultiLineString

Voorbeelden • geom_to_wkt(shared_paths(geom_from_wkt('MULTILINESTRING((26
125,26 200,126 200,126 125,26 125),(51 150,101 150,76 175,51
150)))'),geom_from_wkt('LINESTRING(151 100,126 156.25,126
125,90 161, 76 175)'))) → ‘GeometrieVerzameling (MultiLineString ((126
156.25, 126 125),(101 150, 90 161),(90 161, 76 175)),MultiLineString EMPTY)’

• geom_to_wkt(shared_paths(geom_from_wkt('LINESTRING(76
175,90 161,126 125,126 156.25,151 100)'),
geom_from_wkt('MULTILINESTRING((26 125,26 200,126 200,
126 125,26 125),(51 150,101 150,76 175,51 150))')))
→ ‘GeometrieVerzameling (MultiLineString EMPTY,MultiLineString ((76 175, 90
161),(90 161, 101 150),(126 125, 126 156.25)))’

shortest_line

Geeft de kortste lĳn terug die geometry1 en geometry2 met elkaar verbindt. De resulterende lĳn zal beginnen op
geometry1 en eindigen op geometry2.

Syntaxis shortest_line(geometry1, geometry2)
Argumenten • geometry1 - geometrie waar vandaan de kortste lĳn moet worden gezocht

• geometry2 - geometrie waarnaar de kortste lĳn moet worden gevonden

Voorbeelden • geom_to_wkt(shortest_line(geom_from_wkt('LINESTRING (20
80, 98 190, 110 180, 50 75 )'),geom_from_wkt('POINT(100
100)')))→ ‘LineString(73.0769 115.384, 100 100)’

simplify

Vereenvoudigt een geometrie door knopen te verwĳderen vanaf een afstand die is gebaseerd op een drempelwaarde
(d.i, het algoritme Douglas Peucker). Het algoritme behoudt grote afwĳkingen in geometrieën en verkleint het aantal
punten op nagenoeg rechte segmenten.

Syntaxis simplify(geometry, tolerance)
Argumenten • geometry - een geometrie

• tolerance - maximale afwĳking van rechte segmenten voor de te verwĳderen punten

Voorbeelden • geom_to_wkt(simplify(geometry:=geom_from_wkt('LineString(0
0, 5 0.1, 10 0)'),tolerance:=5))→ ‘LineString(0 0, 10 0)’

Lees verder: algoritme Vereenvoudigen
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simplify_vw

Vereenvoudigt een geometrie door knopen te verwĳderen op een op een gebied gebaseerde drempelwaarde (d.i, het
algoritme Visvalingam-Whyatt). Het algoritme verwĳdert punten die kleine gebieden vormen in geometrieën, bĳv.
kleine uitsteeksels of nagenoeg rechte segmenten.

Syntaxis simplify_vw(geometry, tolerance)
Argumenten • geometry - een geometrie

• tolerance - een meting van het maximale gebied dat door een knoop wordt gemaakt voor
de te verwĳderen knoop

Voorbeelden • geom_to_wkt(simplify_vw(geometry:=geom_from_wkt('LineString(0
0, 5 0, 5.01 10, 5.02 0, 10 0)'),tolerance:=5))→ ‘LineString(0
0, 10 0)’

Lees verder: algoritme Vereenvoudigen

single_sided_buffer

Geeft een geometrie terug die wordt gevormd door slechts één zĳde van een geometrie lĳn te bufferen. Afstanden
zĳn in het ruimtelĳke referentiesysteem van deze geometrie.

Syntaxis single_sided_buffer(geometry, distance, [segments=8], [join=1], [miter_limit=2.0])
[] markeert optionele argumenten

Argumenten • geometry - een geometrie (multi)lĳn
• distance - bufferafstand. Positieve waarden zullen links van de lĳnen worden gebufferd,
negatieve waarden aan de rechterkant

• segments - aantal te gebruiken segmenten om een kwartcirkel weer te geven als een
afgeronde stĳl voor samenvoegen wordt gebruikt. Een groter aantal resulteert in een
gladdere buffer met meer knopen.

• join - stĳl voor samenvoegen van hoeken, waar 1 = rond, 2 = verstek en 3 = afgeschuind
• miter_limit - limiet voor de verhouding van het verstek, gebruikt voor zeer scherpe hoeken
(alleen bĳ het gebruiken van samenvoegingen in verstek)

Voorbeelden • single_sided_buffer($geometry, 10.5) → lĳn, gebufferd aan de
linkerkant met 10.5 eenheden

• single_sided_buffer($geometry, -10.5) → lĳn, gebufferd aan de
rechterkant met 10.5 eenheden

• single_sided_buffer($geometry, 10.5, segments:=16, join:=1)
→ lĳn gebufferd naar links met 10,5 eenheden, meer segmenten gebruikend wat resulteert
in een gladdere buffer

• single_sided_buffer($geometry, 10.5, join:=3) → lĳn gebufferd
naar links met 10,5 eenheden, met een schuine samenvoeging

Lees verder: algoritme Enkelzĳdige buffer
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sinuosity

Geeft de bochtigheidscoëfficiënt van een boog terug, wat de verhouding is tussen de lengte van de boog ten opzichte
van de rechte (2D) afstand tussen zĳn eindpunten.

Syntaxis sinuosity(geometry)
Argumenten • geometry - Invoer boog (circularstring, linestring)

Voorbeelden • round(sinuosity(geom_from_wkt('LINESTRING(2 0, 2 2, 3 2, 3
3)')), 3)→ 1.265

• sinuosity(geom_from_wkt('LINESTRING( 3 1, 5 1)'))→ 1.0

smooth

Maakt een geometrie gladder door het toevoegen van extra knopen die hoeken in de geometrie afronden. Als
invoergeometrieën waarden Z of M bevatten, zullen deze ook gladder worden gemaakt en de uitvoergeometrie zal
dezelfde dimensie behouden als de invoergeometrie.

Syntaxis smooth(geometry, [iterations=1], [offset=0.25], [min_length=-1], [max_angle=180])
[] markeert optionele argumenten

Argumenten • geometry - een geometrie
• iterations - aantal doorlopen om gladder te maken die moet worden toegepast. Hogere
getallen resulteren in gladdere, maar meer complexe geometrieën.

• offset - waarde tussen 0 en 0.5 die beheert hoe “nauw” de afgevlakte geometrieën de
originele geometrieën volgen. Kleinere waarden resulteren in nauwer glad maken, grotere
waarden resulteren in losser glad maken.

• min_length - minimale lengte van segmenten waarop gladder maken moet worden
toegepast. Deze parameter kan worden gebruikt om het plaatsen van teveel aanvullende
knopen in kortere segmenten van de geometrie te vermĳden.

• max_angle - maximale hoek voor de knoopwaarop gladdermakenmoet worden toegepast
(0-180). Door de maximale hoek te verlagen kunnen opzettelĳke scherpe hoeken in de
geometrie worden behouden. Een waarde van, bĳvoorbeeld, 80 graden zal rechte hoeken
in de geometrie behouden.

Voorbeelden • geom_to_wkt(smooth(geometry:=geom_from_wkt('LineString(0
0, 5 0, 5 5)'),iterations:=1,offset:=0.2,min_length:=-1,
max_angle:=180))→ ‘LineString (0 0, 4 0, 5 1, 5 5)’

Lees verder: algoritme Glad maken
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square_wave

Construeert vierkante/rechthoekige golven rondom de grens van een geometrie.

Syntaxis square_wave(geometry, wavelength, amplitude, [strict=False])
[] markeert optionele argumenten

Argumenten • geometry - een geometrie
• wavelength - lengte golf van vierkante vorm golf
• amplitude - grootte van vierkante vorm golf
• strict - Standaard wordt het argument wavelength behandeld als een “maximum
wavelength”, waar de feitelĳk golflengte dynamisch zal worden aangepast, zodat een
exact aantal vierkante golven wordt gemaakt langs de grenzen van de geometrie. Als het
argument strict is ingesteld op true dan zal de golflengte exact worden gebruikt, en een
onvolledig patroon kan worden gebruikt voor de uiteindelĳke vorm van de golf.

Voorbeelden • square_wave(geom_from_wkt('LineString(0 0, 10 0)'), 3, 1)
→ Vierkante golven met golflengte 3 en grootte 1 langs de lĳn

square_wave_randomized

Construeert willekeurige vierkante/rechthoekige golven rondom de grens van een geometrie.

Syntaxis square_wave_randomized(geometry, min_wavelength, max_wavelength, min_amplitude,
max_amplitude, [seed=0])
[] markeert optionele argumenten

Argumenten • geometry - een geometrie
• min_wavelength - minimum golflengte van de golven
• max_wavelength - maximum golflengte van de golven
• min_amplitude - minimum grootte van de golven
• max_amplitude - maximum grootte van de golven
• seed - specificeert een willekeurig zaad voor het maken van golven. Als zaad 0 is, dan zal
een volledig willekeurige set golven worden gemaakt.

Voorbeelden • square_wave_randomized(geom_from_wkt('LineString(0 0, 10
0)'), 2, 3, 0.1, 0.2) → Vierkante golven met willekeurige grootte met
golflengten tussen 2 en 3 en groottes tussen 0.1 en 0.2 langs de lĳn

start_point

Geeft de eerste knoop van een geometrie terug.

Syntaxis start_point(geometry)
Argumenten • geometry - object geometrie

Voorbeelden • geom_to_wkt(start_point(geom_from_wkt('LINESTRING(4 0, 4 2,
0 2)')))→ ‘Point (4 0)’
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Lees verder: algoritme Specifieke punten uitnemen

straight_distance_2d

Geeft de directe/euclidische afstand terug tussen het eerste en laatste punt van een geometrie. De geometrie moet een
boog zĳn (circularstring, linestring).

Syntaxis straight_distance_2d(geometry)
Argumenten • geometry - De geometrie.

Voorbeelden • straight_distance_2d(geom_from_wkt('LINESTRING(1 0, 1 1)'))
→ 1

• round(straight_distance_2d(geom_from_wkt('LINESTRING(1 4,
3 5, 5 0)')), 3)→ 5.657

Lees verder: length

sym_difference

Geeft een geometrie terug die het gedeelde deel weergeeft van twee geometrieën die elkaar niet kruisen.

Syntaxis sym_difference(geometry1, geometry2)
Argumenten • geometry1 - een geometrie

• geometry2 - een geometrie

Voorbeelden • geom_to_wkt( sym_difference( geom_from_wkt( 'LINESTRING(3
3, 4 4, 5 5)' ), geom_from_wkt( 'LINESTRING(3 3, 8 8)' ) )
)→ ‘LINESTRING(5 5, 8 8)’

Lees verder: algoritme Symmetrisch verschil

tapered_buffer

Maakt een buffer langs een geometrie lĳn waarbĳ de diameter van de buffer gelĳkmatig varieert over de lengte van
de lĳn.

Syntaxis tapered_buffer(geometry, start_width, end_width, [segments=8])
[] markeert optionele argumenten

Argumenten • geometry - invoergeometrie. Moet een geometrie (multi)lĳn zĳn.
• start_width - breedte van de buffer aan het begin van de lĳn,
• end_width - breedte van de buffer aan het einde van de lĳn.
• segments - aantal segmenten om bogen van een kwartcirkel te benaderen in de buffer.

Voorbeelden • tapered_buffer(geometry:=geom_from_wkt('LINESTRING(1 2,
4 2)'),start_width:=1,end_width:=2,segments:=8) → Een taps
toelopende buffer, beginnend met een diameter van 0.5 en eindigend met een diameter
van 0.2 langs de geometrie lĳn.
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Fig. 13.8: Taps toelopende buffer op objecten Lijn

Lees verder: algoritme Taps toelopende buffers

touches

Test of een geometrie een andere raakt. Geeft TRUE terug als de geometrieën tenminste één gemeenschappelĳk punt
hebben, maar hun interieurs niet kruisen.

Syntaxis touches(geometry1, geometry2)
Argumenten • geometry1 - een geometrie

• geometry2 - een geometrie

Voorbeelden • touches( geom_from_wkt( 'LINESTRING(5 3, 4 4)' ),
geom_from_wkt( 'LINESTRING(3 3, 4 4, 5 5)' ) )→ TRUE

• touches( geom_from_wkt( 'POINT(4 4)' ), geom_from_wkt(
'POINT(5 5)' ) )→ FALSE

Lees verder: overlay_touches
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transform

Geeft de getransformeerde geometrie terug van het bron-CRS naar het doel-CRS.

Syntaxis transform(geometry, source_auth_id, dest_auth_id)
Argumenten • geometry - een geometrie

• source_auth_id - het ID van het bron-CRS
• dest_auth_id - het ID van het doel-CRS

Voorbeelden • geom_to_wkt( transform( make_point(488995.53240249,
7104473.38600835), 'EPSG:2154', 'EPSG:4326' ) ) → ‘POINT(0
51)’

Lees verder: algoritme Laag opnieuw projecteren

translate

Geeft een vertaalde versie van een geometrie terug. Berekeningen zĳn in het ruimtelĳke referentiesysteem van deze
geometrie.

Syntaxis translate(geometry, dx, dy)
Argumenten • geometry - een geometrie

• dx - delta X
• dy - delta Y

Voorbeelden • translate($geometry, 5, 10) → een geometrie van hetzelfde type als de
originele
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Fig. 13.9: Objecten vertalen

Lees verder: algoritme Transleren

triangular_wave

Construeert driehoekige golven rondom de grens van een geometrie.

Syntaxis triangular_wave(geometry, wavelength, amplitude, [strict=False])
[] markeert optionele argumenten

Argumenten • geometry - een geometrie
• wavelength - lengte golf van driehoekige vorm golf
• amplitude - grootte van driehoekige vorm golf
• strict - Standaard wordt het argument wavelength behandeld als een “maximum
wavelength”, waar de feitelĳk golflengte dynamisch zal worden aangepast, zodat een exact
aantal driehoekige golven wordt gemaakt langs de grenzen van de geometrie. Als het
argument strict is ingesteld op true dan zal de golflengte exact worden gebruikt, en een
onvolledig patroon kan worden gebruikt voor de uiteindelĳke vorm van de golf.

Voorbeelden • triangular_wave(geom_from_wkt('LineString(0 0, 10 0)'), 3,
1)→ Driehoekige golven met golflengte 3 en grootte 1 langs de lĳn
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triangular_wave_randomized

Construeert willekeurige driehoekige golven rondom de grens van een geometrie.

Syntaxis triangular_wave_randomized(geometry, min_wavelength, max_wavelength, min_amplitude,
max_amplitude, [seed=0])
[] markeert optionele argumenten

Argumenten • geometry - een geometrie
• min_wavelength - minimum golflengte van de golven
• max_wavelength - maximum golflengte van de golven
• min_amplitude - minimum grootte van de golven
• max_amplitude - maximum grootte van de golven
• seed - specificeert een willekeurig zaad voor het maken van golven. Als zaad 0 is, dan zal
een volledig willekeurige set golven worden gemaakt.

Voorbeelden • `triangular_wave_randomized(geom_from_wkt('LineString(0 0,
10 0)'), 2, 3, 0.1, 0.2)→ Driehoekige golven met willekeurige grootte met
golflengten tussen 2 en 3 en groottes tussen 0.1 en 0.2 langs de lĳn

union

Geeft een geometrie terug die de verenigde verzameling van punten weergeeft van de geometrieën.

Syntaxis union(geometry1, geometry2)
Argumenten • geometry1 - een geometrie

• geometry2 - een geometrie

Voorbeelden • geom_to_wkt( union( make_point(4, 4), make_point(5, 5) ) )
→ ‘MULTIPOINT(4 4, 5 5)’

wave

Construeert afgeronde (sinus-achtige) golven rondom de grens van een geometrie.

Syntaxis wave(geometry, wavelength, amplitude, [strict=False])
[] markeert optionele argumenten

Argumenten • geometry - een geometrie
• wavelength - lengte golf van sinus-achtige vorm golf
• amplitude - grootte van sinus-achtige vorm golf
• strict - Standaard wordt het argument wavelength behandeld als een “maximum
wavelength”, waar de feitelĳk golflengte dynamisch zal worden aangepast, zodat een exact
aantal golven wordt gemaakt langs de grenzen van de geometrie. Als het argument strict is
ingesteld op true dan zal de golflengte exact worden gebruikt, en een onvolledig patroon
kan worden gebruikt voor de uiteindelĳke vorm van de golf.

Voorbeelden • wave(geom_from_wkt('LineString(0 0, 10 0)'), 3, 1) → Sinus-
achtige golven met golflengte 3 en grootte 1 langs de lĳn
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wave_randomized

Construeert willekeurige gebogen (sinus-achtige) golven rondom de grens van een geometrie.

Syntaxis wave_randomized(geometry, min_wavelength, max_wavelength, min_amplitude,
max_amplitude, [seed=0])
[] markeert optionele argumenten

Argumenten • geometry - een geometrie
• min_wavelength - minimum golflengte van de golven
• max_wavelength - maximum golflengte van de golven
• min_amplitude - minimum grootte van de golven
• max_amplitude - maximum grootte van de golven
• seed - specificeert een willekeurig zaad voor het maken van golven. Als zaad 0 is, dan zal
een volledig willekeurige set golven worden gemaakt.

Voorbeelden • wave_randomized(geom_from_wkt('LineString(0 0, 10 0)'), 2,
3, 0.1, 0.2)→ Gebogen golven met willekeurige grootte met golflengten tussen 2
en 3 en groottes tussen 0.1 en 0.2 langs de lĳn

wedge_buffer

Geeft een wigvormige buffer terug, afkomstig uit een geometrie punt.

Syntaxis wedge_buffer(center, azimuth, width, outer_radius, [inner_radius=0.0])
[] markeert optionele argumenten

Argumenten • center - middelpunt (origine) van de buffer. Moet een geometrie punt zĳn.
• azimuth - hoek (in graden) voor waar het midden van de wig naartoe moet wĳzen.
• width - breedte buffer (in graden). Onthoud dat de wig zich zal uitstrekken tot de helft
van de breedte van de hoek aan elke zĳde van de richting van de azimut.

• outer_radius - buitenste straal voor de buffers
• inner_radius - optionele binnenste straal voor de buffers

Voorbeelden • wedge_buffer(center:=geom_from_wkt('POINT(1 2)'),
azimuth:=90,width:=180,outer_radius:=1) → Een wigvormige buffer,
gecentreerd op het punt (1,2), gaande in oostelĳk richting, met een breedte van 180
graden en een buitenste straal van 1.

Lees verder: algoritmeWigvormige buffers maken

within

Test of een geometrie in een andere ligt. Geeft TRUE terug als geometry1 volledig binnen geometry2 ligt.
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Syntaxis within(geometry1, geometry2)
Argumenten • geometry1 - een geometrie

• geometry2 - een geometrie

Voorbeelden • within( geom_from_wkt( 'POINT( 0.5 0.5)' ), geom_from_wkt(
'POLYGON((0 0, 0 1, 1 1, 1 0, 0 0))' ) )→ TRUE

• within( geom_from_wkt( 'POINT( 5 5 )' ), geom_from_wkt(
'POLYGON((0 0, 0 1, 1 1, 1 0, 0 0 ))' ) )→ FALSE

Lees verder: overlay_within

$x

Geeft de X-coördinaat van het huidige geometrie punt terug. Als het object een object multipunt is, dan zal de X-
coördinaat van het eerste punt worden teruggegeven.

Syntaxis $x
Voorbeelden • $x→ 42

x

Geeft de X-coördinaat van een geometrie punt terug, of de X-coördinaat van het zwaartepunt van een geometrie
niet-punt.

Syntaxis x(geometry)
Argumenten • geometry - een geometrie

Voorbeelden • x( geom_from_wkt( 'POINT(2 5)' ) )→ 2
• x( $geometry )→ X-coördinaat van het zwaartepunt van het huidige object

$x_at

Haalt een X-coördinaat op van de geometrie van het huidige object.

Syntaxis $x_at(i)
Argumenten • i - index van een punt van een lĳn (indices beginnen met 0; negatieve waarden zĳn van

toepassing vanaf de laatste index, beginnend met -1)

Voorbeelden • $x_at(1)→ 5
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x_max

Geeft de maximumX-coördinaat van een geometrie terug. Berekeningen zĳn in het ruimtelĳke referentiesysteem van
deze geometrie.

Syntaxis x_max(geometry)
Argumenten • geometry - een geometrie

Voorbeelden • x_max( geom_from_wkt( 'LINESTRING(2 5, 3 6, 4 8)') )→ 4

x_min

Geeft de minimum X-coördinaat van een geometrie terug. Berekeningen zĳn in het ruimtelĳke referentiesysteem van
deze geometrie.

Syntaxis x_min(geometry)
Argumenten • geometry - een geometrie

Voorbeelden • x_min( geom_from_wkt( 'LINESTRING(2 5, 3 6, 4 8)') )→ 2

$y

Geeft de Y-coördinaat van het huidige geometrie punt terug. Als het object een object multipunt is, dan zal de Y-
coördinaat van het eerste punt worden teruggegeven.

Syntaxis $y
Voorbeelden • $y→ 42

y

Geeft de Y-coördinaat van een geometrie punt terug, of de Y-coördinaat van het zwaartepunt van een geometrie
niet-punt.

Syntaxis y(geometry)
Argumenten • geometry - een geometrie

Voorbeelden • y( geom_from_wkt( 'POINT(2 5)' ) )→ 5
• y( $geometry )→ Y-coördinaat van het zwaartepunt van het huidige object
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$y_at

Haalt een Y-coördinaat op van de geometrie van het huidige object.

Syntaxis $y_at(i)
Argumenten • i - index van een punt van een lĳn (indices beginnen met 0; negatieve waarden zĳn van

toepassing vanaf de laatste index, beginnend met -1)

Voorbeelden • $y_at(1)→ 2

y_max

Geeft de maximumY-coördinaat van een geometrie terug. Berekeningen zĳn in het ruimtelĳke referentiesysteem van
deze geometrie.

Syntaxis y_max(geometry)
Argumenten • geometry - een geometrie

Voorbeelden • y_max( geom_from_wkt( 'LINESTRING(2 5, 3 6, 4 8)') )→ 8

y_min

Geeft de minimum Y-coördinaat van een geometrie terug. Berekeningen zĳn in het ruimtelĳke referentiesysteem van
deze geometrie.

Syntaxis y_min(geometry)
Argumenten • geometry - een geometrie

Voorbeelden • y_min( geom_from_wkt( 'LINESTRING(2 5, 3 6, 4 8)') )→ 5

$z

Geeft de Z-waarde van het huidige object punt terug als het 3D is. Als het object een object multipunt is, dan zal de
Z-waarde van het eerste punt worden teruggegeven.

Syntaxis $z
Voorbeelden • $z→ 123
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z

Geeft de Z-coördinaat van een geometrie punt terug, of NULL als de geometrie geen waarde Z heeft.

Syntaxis z(geometry)
Argumenten • geometry - een geometrie punt

Voorbeelden • z( geom_from_wkt( 'POINTZ(2 5 7)' ) )→ 7

z_max

Geeft de maximum Z-coördinaat van een geometrie terug, of NULL als de geometrie geen waarde Z heeft.

Syntaxis z_max(geometry)
Argumenten • geometry - een geometrie met een Z-coördinaat

Voorbeelden • z_max( geom_from_wkt( 'POINT ( 0 0 1 )' ) )→ 1
• z_max( geom_from_wkt( 'MULTIPOINT ( 0 0 1 , 1 1 3 )' ) )→ 3
• z_max( make_line( make_point( 0,0,0 ), make_point( -1,-1,-2
) ) )→ 0

• z_max( geom_from_wkt( 'LINESTRING( 0 0 0, 1 0 2, 1 1 -1 )'
) )→ 2

• z_max( geom_from_wkt( 'POINT ( 0 0 )' ) )→ NULL

z_min

Geeft de minimum Z-coördinaat van een geometrie terug, of NULL als de geometrie geen waarde Z heeft.

Syntaxis z_min(geometry)
Argumenten • geometry - een geometrie met een Z-coördinaat

Voorbeelden • z_min( geom_from_wkt( 'POINT ( 0 0 1 )' ) )→ 1
• z_min( geom_from_wkt( 'MULTIPOINT ( 0 0 1 , 1 1 3 )' ) )→ 1
• z_min( make_line( make_point( 0,0,0 ), make_point( -1,-1,-2
) ) )→ -2

• z_min( geom_from_wkt( 'LINESTRING( 0 0 0, 1 0 2, 1 1 -1 )'
) )→ -1

• z_min( geom_from_wkt( 'POINT ( 0 0 )' ) )→ NULL
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13.2.14 Functies voor lay-out

Deze groep bevat functies waarmee u eigenschappen voor items van lay-out kunt bewerken.

item_variables

Geeft een kaart van variabelen terug uit een item van lay-out binnen deze afdruklay-out.

Syntaxis item_variables(id)
Argumenten • id - ID van het item van afdruklay-out

Voorbeelden • map_get( item_variables('Map 0'), 'map_scale') → schaal van het
item ‘Map 0’ in de huidige afdruyklay-out

Lees verder: Lĳst van standaard variabelen

map_credits

Geeft een lĳst tekenreeksen met naamsvermelding (gebruiksrechten) terug voor de lagen die worden weergegeven in
een lay-outitem Kaart.

Syntaxis map_credits(id, [include_layer_names=false], [layer_name_separator=’: ‘])
[] markeert optionele argumenten

Argumenten • id - kaartitem ID
• include_layer_names - Stel in op true om de laagnamen op te nemen vóór hun
tekenreeksen met naamsvermelding

• layer_name_separator - Tekenreeks om in te voegen tussen laagnamen en hun
tekenreeksen voor naamsvermelding, als include_layer_names is ingesteld op true

Voorbeelden • array_to_string( map_credits( 'Main Map' ) )→ kommagescheiden
lĳst met naamsvermeldingen voor de lagen die worden weergegeven in het lay-outitem
‘Main Map’, bĳv. ‘CC-BY-NC, CC-BY-SA’

• array_to_string( map_credits( 'Main Map',
include_layer_names := true, layer_name_separator :=
': ' ) ) → kommagescheiden lĳst met laagnamen en hun naamsvermeldingen voor
de lagen die worden weergegeven in het lay-outitem ‘Main Map’,, bĳv. ‘Spoorwegen:
CC-BY-NC, Basiskaart: CC-BY-SA’

Deze functie vereist dat de Access metadata properties van de lagen zĳn gevuld.
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13.2.15 Lagen

Deze groep bevat een lĳst van de beschikbare lagen in het huidige project en, voor elke laag, hun velden (opgeslagen
in de gegevensset, virtueel of die van de hulpopslag, als ook van samenvoegingen). De velden kunnen op dezelfde
manier worden bewerkt als vermeld in Velden en waarden, behalve dat een dubbelklik de naam als een tekenreeks
zal toevoegen (enkele aanhalingstekens) voor de expressie in plaats van als een opgegeven verwĳzing naar een veld
dat zĳ niet behoren tot de actieve laag. Dit biedt een handige manier om expressies te schrĳven die verwĳzen naar
andere lagen, zoals bĳ het uitvoeren van query’s samenvoegen, attributen of ruimtelĳk.
Het verschaft ook enkele handige functies om lagen te bewerken.

decode_uri

Neemt een laag en decodeert de URI van de onderliggende gegevensprovider. Beschikbare informatie is afhankelĳk
van de gegevensprovider.

Syntaxis decode_uri(layer, [part])
[] markeert optionele argumenten

Argumenten • layer - De laag waarvan de URI moet worden gedecodeerd.
• part - Het terug te geven gedeelte van de URI. Indien niet gespecificeerd zal een kaart
met alle URI-gedeelten worden teruggegeven.

Voorbeelden • decode_uri(@layer) → {‘layerId’: ‘0’, ‘layerName’: ‘’, ‘path’:
‘/home/qgis/shapefile.shp’}

• decode_uri(@layer) → {‘layerId’: NULL, ‘layerName’: ‘layer’, ‘path’:
‘/home/qgis/geopackage.gpkg’}

• decode_uri(@layer, 'path')→ ‘C:\my_data\qgis\shape.shp’

layer_property

Geeft een overeenkomende laageigenschap of waarde voor metadata terug.
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Syntaxis layer_property(layer, property)
Argumenten • layer - een tekenreeks die ofwel een laagnaam of een laag-ID vertegenwoordigt

• property - een tekenreeks die correspondeert met de terug te geven eigenschap. Geldige
opties zĳn:

– name: naam van de laag
– id: laag-ID
– title: tekenreeks voor de titel van de metadata
– abstract: tekenreeks voor abstract van de metadata
– keywords: sleutelwoorden voor metadata
– data_url: URL voor metadata
– attribution: tekenreeks voor de toekenning van de metadata
– attribution_url: URL voor de toekenning van de metadata
– source: laagbron
– min_scale: minimale schaal voor weergave van de laag
– max_scale: maximale schaal voor weergave van de laag
– is_editable: als de laag in modus Bewerken staat
– crs: laag-CRS
– crs_definition: volledige definitie van laag-CRS
– crs_description: beschrĳving laag-CRS
– extent: bereik van de laag (als een geometrie-object)
– distance_units: eenheden voor afstanden op de laag
– type: type laag, bĳv. Vector of Raster
– storage_type: indeling voor opslaan (alleen voor vectorlagen)
– geometry_type: type geometrie type, bĳv. Punt (alleen vectorlagen)
– feature_count: geschatte aantal objecten voor de laag (alleen vectorlagen)
– path: Bestandspad naar de databron van de laag. Alleen beschikbaar voor op
bestanden gebaseerde lagen.

Voorbeelden • layer_property('streets','title')→ ‘Basemap Streets’
• layer_property('airports','feature_count')→ 120
• layer_property('landsat','crs')→ ‘EPSG:4326’

Lees verder: vector, raster en mesh laageigenschappen

13.2.16 Functies Kaartobjecten

Deze groep bevat functies voor expressies voor het creëren en bewerken van gegevensstructuren ‘map’ (ook wel bekend
als het datatype dictionary, paren sleutel-waarde of associatieve arrays). Anders dan de gegevensstructuur lĳst waar
de volgorde van de waarden van belang is, is de volgorde van de paren sleutel-waarde in het kaartobject niet relevant
en worden waarden geïdentificeerd met hun sleutels.

from_json

Laadt een als JSON opgemaakte tekenreeks.

Syntaxis from_json(string)
Argumenten • string - tekenreeks JSON

Voorbeelden • from_json('{"qgis":"rocks"}')→ { ‘qgis’: ‘rocks’ }
• from_json('[1,2,3]')→ [1,2,3]
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hstore_to_map

Maakt een kaart uit een als hstore opgemaakte tekenreeks.

Syntaxis hstore_to_map(string)
Argumenten • string - de tekenreeks voor de invoer

Voorbeelden • hstore_to_map('qgis=>rocks')→ { ‘qgis’: ‘rocks’ }

map

Geeft een kaart terug die alle sleutels en waarden bevat die als parameters voor het paar werden doorgegeven.

Syntaxis map(key1, value1, key2, value2, …)
Argumenten • key - een sleutel (tekenreeks)

• value - een waarde

Voorbeelden • map('1','one','2', 'two')→ { ‘1’: ‘one’, ‘2’: ‘two’ }
• map('1','one','2', 'two')['1']→ ‘one’

map_akeys

Geeft alle sleutels van een kaart terug als een array.

Syntaxis map_akeys(map)
Argumenten • map - een kaart

Voorbeelden • map_akeys(map('1','one','2','two'))→ [ ‘1’, ‘2’ ]

map_avals

Geeft alle waarden van een kaart terug als een array.

Syntaxis map_avals(map)
Argumenten • map - een kaart

Voorbeelden • map_avals(map('1','one','2','two'))→ [ ‘one’, ‘two’ ]
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map_concat

Geeft een kaart terug die alle items van de opgegeven kaarten bevat. Als twee kaarten dezelfde sleutel bevatten, wordt
de waarde van de tweede kaart genomen.

Syntaxis map_concat(map1, map2, …)
Argumenten • map - een kaart

Voorbeelden • map_concat(map('1','one', '2','overridden'),map('2','two',
'3','three'))→ { ‘1’: ‘one’, ‘2’: ‘two’, ‘3’: ‘three’ }

map_delete

Geeft een kaart terug waaruit de opgegeven sleutel en de bĳbehorende waarde zĳn verwĳderd.

Syntaxis map_delete(map, key)
Argumenten • map - een kaart

• key - de te verwĳderen sleutel

Voorbeelden • map_delete(map('1','one','2','two'),'2')→ { ‘1’: ‘one’ }

map_exist

Geeft TRUE terug als de opgegeven sleutel bestaat in de kaart.

Syntaxis map_exist(map, key)
Argumenten • map - een kaart

• key - de sleutel die moet worden gezocht

Voorbeelden • map_exist(map('1','one','2','two'),'3')→ FALSE

map_get

Geeft de waarde van een kaart terug, opgegeven als zĳn sleutel. Geeft NULL terug als de sleutel niet bestaat.

Syntaxis map_get(map, key)
Argumenten • map - een kaart

• key - de sleutel die moet worden gezocht

Voorbeelden • map_get(map('1','one','2','two'),'2')→ ‘two’
• map_get( item_variables('Map 0'), 'map_scale') → schaal van het
item ‘Map 0’ (als die bestaat) in de huidige afdruklay-out
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Hint: U kunt ook de index operator ([]) gebruiken om een waarde uit een kaart te verkrĳgen.

map_insert

Geeft een kaart terug met een toegevoegde sleutel/waarde. Als de sleutel al bestaat wordt de waarde daarvan
overschreven.

Syntaxis map_insert(map, key, value)
Argumenten • map - een kaart

• key - de toe te voegen sleutel
• value - de toe te voegen waarde

Voorbeelden • map_insert(map('1','one'),'3','three')→ { ‘1’: ‘one’, ‘3’: ‘three’ }
• map_insert(map('1','one','2','overridden'),'2','two') → {
‘1’: ‘one’, ‘2’: ‘two’ }

map_prefix_keys

Geeft een kaart terug waarin alle sleutels worden voorafgegaan door een opgegeven tekenreeks.

Syntaxis map_prefix_keys(map, prefix)
Argumenten • map - een kaart

• prefix - een tekenreeks

Voorbeelden • map_prefix_keys(map('1','one','2','two'), 'prefix-') → {
‘prefix-1’: ‘one’, ‘prefix-2’: ‘two’ }

map_to_hstore

Voeg kaartelementen samen tot een als hstore opgemaakte tekenreeks.

Syntaxis map_to_hstore(map)
Argumenten • map - de kaart voor de invoer

Voorbeelden • map_to_hstore(map('qgis','rocks'))→ ‘“qgis”=>”rocks”’
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to_json

Maak een als JSON opgemaakte tekenreeks uit een kaart, een array of een andere waarde.

Syntaxis to_json(value)
Argumenten • value - De waarde voor de invoer

Voorbeelden • to_json(map('qgis','rocks'))→ {“qgis”:”rocks”}
• to_json(array(1,2,3))→ [1,2,3]

url_encode

Geeft een URL-gecodeerde tekenreeks terug uit een kaart. Transformeert alle tekens naar hun correct gecodeerde
vorm een volledig conforme tekenreeks voor de query producerend.
Onthoud dat het plusteken ‘+’ niet wordt geconverteerd.

Syntaxis url_encode(map)
Argumenten • map - een kaart.

Voorbeelden • url_encode(map('a&+b', 'a and plus b', 'a=b', 'a equals b'))
→ ‘a%26+b=a%20and%20plus%20b&a%3Db=a%20equals%20b’

13.2.17 Wiskundige functies

Deze groep bevat wiskundige functies (bĳv. vierkantswortel, sin en cos).

abs

Geeft de absolute waarde van een getal terug.

Syntaxis abs(value)
Argumenten • value - een getal

Voorbeelden • abs(-2)→ 2
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acos

Geeft de inverse cosinus van een waarde in radialen terug.

Syntaxis acos(value)
Argumenten • value - cosinus van een hoek in radialen

Voorbeelden • acos(0.5)→ 1.0471975511966

asin

Geeft de inverse sinus van een waarde in radialen terug.

Syntaxis asin(value)
Argumenten • value - sinus van een hoek in radialen

Voorbeelden • asin(1.0)→ 1.5707963267949

atan

Geeft de inverse tangens van een waarde in radialen terug.

Syntaxis atan(value)
Argumenten • value - tangens van een hoek in radialen

Voorbeelden • atan(0.5)→ 0.463647609000806

atan2

Geeft de inverse tangens van dy/dx terug door de twee tekens van de twee argumenten te gebruiken om het kwadrant
van het resultaat te bepalen

Syntaxis atan2(dy, dx)
Argumenten • dy - verschil Y-coördinaat

• dx - verschil X-coördinaat

Voorbeelden • atan2(1.0, 1.732)→ 0.523611477769969
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ceil

Rondt een getal naar boven af.

Syntaxis ceil(value)
Argumenten • value - een getal

Voorbeelden • ceil(4.9)→ 5
• ceil(-4.9)→ -4

clamp

Beperkt een invoerwaarde tot een gespecificeerd bereik.

Syntaxis clamp(minimum, input, maximum)
Argumenten • minimum - de kleinste waarde voor invoer die is toegestaan.

• input - een waarde die zal worden beperkt tot het bereik dat wordt gespecificeerd door
minimum en maximum

• maximum - de grootste waarde voor invoer die is toegestaan.

Voorbeelden • clamp(1,5,10)→ 5
input ligt tussen 1 en 10 en wordt dus ongewĳzigd teruggegeven

• clamp(1,0,10)→ 1
input is kleiner dan de minimum waarde van 1, dus geeft de functie 1 terug

• clamp(1,11,10)→ 10
input is groter dan de maximum waarde van 10, dus geeft de functie 10 terug

cos

Geeft de cosinus van een hoek terug.

Syntaxis cos(angle)
Argumenten • angle - hoek in radialen

Voorbeelden • cos(1.571)→ 0.000796326710733263
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degrees

Converteert van radialen naar graden.

Syntaxis degrees(radians)
Argumenten • radians - numerieke waarde

Voorbeelden • degrees(3.14159)→ 180
• degrees(1)→ 57.2958

exp

Geeft de exponentieel van een waarde terug.

Syntaxis exp(value)
Argumenten • value - getal waarvan de exponentieel moet worden teruggegeven

Voorbeelden • exp(1.0)→ 2.71828182845905

floor

Rondt een getal naar beneden af.

Syntaxis floor(value)
Argumenten • value - een getal

Voorbeelden • floor(4.9)→ 4
• floor(-4.9)→ -5

ln

Geeft de natuurlĳke logaritme van een waarde terug.

Syntaxis ln(value)
Argumenten • value - numerieke waarde

Voorbeelden • ln(1)→ 0
• ln(2.7182818284590452354)→ 1
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log

Geeft de waarde van de logaritme van de opgegeven waarde en basis terug.

Syntaxis log(base, value)
Argumenten • base - elkpositief getal

• value - elk positief getal

Voorbeelden • log(2, 32)→ 5
• log(0.5, 32)→ -5

log10

Geeft de waarde van de logaritme basis 10 van de opgegeven expressie terug.

Syntaxis log10(value)
Argumenten • value - elk positief getal

Voorbeelden • log10(1)→ 0
• log10(100)→ 2

max

Geeft de grootste waarde uit een verzameling waarden terug.

Syntaxis max(value1, value2, …)
Argumenten • value - een getal

Voorbeelden • max(2,10.2,5.5)→ 10.2
• max(20.5,NULL,6.2)→ 20.5

min

Geeft de kleinste waarde uit een verzameling waarden terug.

Syntaxis min(value1, value2, …)
Argumenten • value - een getal

Voorbeelden • min(20.5,10,6.2)→ 6.2
• min(2,-10.3,NULL)→ -10.3
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pi

Geeft de waarde Pi terug voor berekeningen.

Syntaxis pi()
Voorbeelden • pi()→ 3.14159265358979

radians

Converteert van graden naar radialen.

Syntaxis radians(degrees)
Argumenten • degrees - numerieke waarde

Voorbeelden • radians(180)→ 3.14159
• radians(57.2958)→ 1

rand

Geeft een willekeurig geheel getal terug binnen het bereik dat is gespecificeerd door de argumenten minimum en
maximum (inclusief). Als zaad wordt opgegeven zal het teruggegeven altĳd hetzelfde zĳn, afhankelĳk van het zaad.

Syntaxis rand(min, max, [seed=NULL])
[] markeert optionele argumenten

Argumenten • min - een integer (geheel getal) dat het gewenste kleinst mogelĳke willekeurige getal
weergeeft

• max - een integer (geheel getal) dat het gewenste grootst mogelĳke willekeurige getal
weergeeft

• seed - elke waarde die als zaad moet worden gebruikt

Voorbeelden • rand(1, 10)→ 8

randf

Geeft een willekeurig getal float terug binnen het bereik dat is gespecificeerd door de argumenten minimum en
maximum (inclusief). Als zaad wordt opgegeven zal het teruggegeven altĳd hetzelfde zĳn, afhankelĳk van het zaad.

Syntaxis randf([min=0.0], [max=1.0], [seed=NULL])
[] markeert optionele argumenten

Argumenten • min - een getal float dat het gewenste kleinst mogelĳke willekeurige getal weergeeft
• max - een getal float dat het gewenste grootst mogelĳke willekeurige getal weergeeft
• seed - elke waarde die als zaad moet worden gebruikt

Voorbeelden • randf(1, 10)→ 4.59258286403147
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round

Rondt een getal af naar het aantal plaatsen achter de komma.

Syntaxis round(value, [places=0])
[] markeert optionele argumenten

Argumenten • value - decimale getal dat moet worden afgerond
• places - Optionele integer die het aantal plaatsen achter de komma weergeeft voor het
afronden van decimalen. Mag negatief zĳn.

Voorbeelden • round(1234.567, 2)→ 1234.57
• round(1234.567)→ 1235
• round(1234.567, -1)→ 1230

scale_exp

Transformeert een opgegeven waarde uit een invoerdomein naar een uitvoerbereik met behulp van een exponentiële
boog. Deze functie kan worden gebruikt om het gemakkelĳker te maken waarden in of uit het gespecificeerde
uitvoerbereik te plaatsen.

Syntaxis scale_exp(value, domain_min, domain_max, range_min, range_max, exponent)
Argumenten • value - Een waarde in het invoerdomein. De functie zal een overeenkomende geschaalde

waarde in het uitvoerbereik teruggeven.
• domain_min - Specificeert de minimum waarde in het invoerdomein, de kleinste waarde
die de invoerwaarde zou mogen hebben.

• domain_max - Specificeert de maximumwaarde in het invoerdomein, de grootste waarde
die de invoerwaarde zou mogen hebben.

• range_min - Specificeert de minimum waarde in het uitvoerbereik, de kleinste waarde
die door de functie zou mogen worden uitgevoerd.

• range_min - Specificeert de maximum waarde in het uitvoerbereik, de grootste waarde
die door de functie zou mogen worden uitgevoerd.

• exponent - Een positieve waarde (groter dan 0), die de manier bepaalt waarop
invoerwaarden in kaart worden gebracht in het uitvoerbereik. Grote exponenten zullen r
voor zorgen dat de uitvoerwaarden ‘gemakkelĳk instromen’, langzaam beginnend voordat
zĳ accelereren als de invoerwaarden het maximum van het domein bereiken. Kleinere
exponenten (kleiner dan 1) zullen er voor zorgen dat uitvoerwaarden ‘gemakkelĳk
uitstromen’, waarbĳ het in kaart brengen snel begint maar vertraagt als het het maximum
van het domein nadert.

Voorbeelden • scale_exp(5,0,10,0,100,2)→ 25
gemakkelĳk instromend, met een exponent 2

• scale_exp(3,0,10,0,100,0.5)→ 54.772
gemakkelĳk uitstromend, met een exponent 0.5
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scale_linear

Transformeert een opgegeven waarde uit een invoerdomein naar een uitvoerbereik met behulp van lineaire
interpolatie.

Syntaxis scale_linear(value, domain_min, domain_max, range_min, range_max)
Argumenten • value - Een waarde in het invoerdomein. De functie zal een overeenkomende geschaalde

waarde in het uitvoerbereik teruggeven.
• domain_min - Specificeert de minimum waarde in het invoerdomein, de kleinste waarde
die de invoerwaarde zou mogen hebben.

• domain_max - Specificeert de maximumwaarde in het invoerdomein, de grootste waarde
die de invoerwaarde zou mogen hebben.

• range_min - Specificeert de minimum waarde in het uitvoerbereik, de kleinste waarde
die door de functie zou mogen worden uitgevoerd.

• range_min - Specificeert de maximum waarde in het uitvoerbereik, de grootste waarde
die door de functie zou mogen worden uitgevoerd.

Voorbeelden • scale_linear(5,0,10,0,100)→ 50
• scale_linear(0.2,0,1,0,360)→ 72
op schaal brengen van een waarde tussen 0 en 1 naar een hoek tussen 0 en 360

• scale_linear(1500,1000,10000,9,20)→ 9.6111111
op schaal brengen van een populatie die varieert tussen 1000 en 10000 naar een grootte
van het lettertype tussen 9 en 20

sin

Geeft de sinus van een hoek terug.

Syntaxis sin(angle)
Argumenten • angle - hoek in radialen

Voorbeelden • sin(1.571)→ 0.999999682931835

sqrt

Geeft de vierkantswortel van een waarde terug.

Syntaxis sqrt(value)
Argumenten • value - een getal

Voorbeelden • sqrt(9)→ 3
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tan

Geeft de tangens van een hoek terug.

Syntaxis tan(angle)
Argumenten • angle - hoek in radialen

Voorbeelden • tan(1.0)→ 1.5574077246549

13.2.18 Functies voor mazen

Deze groep bevat functies die aan mazen gerelateerde waarden kunnen berekenen of teruggeven.

$face_area

Geeft het gebied van het huidige zĳde van mazen terug. Het door deze functie berekende gebied respecteert zowel
de instelling van de ellipsoïde voor het huidige project als de instellingen voor eenheden voor het gebied. Als,
bĳvoorbeeld, een ellipsoïde is ingesteld voor het project, dan zal het berekende gebied ellipsoïde zĳn, en als er geen
ellipsoïde is ingesteld, dan zal het gebied planimetrisch zĳn.

Syntaxis $face_area
Voorbeelden • $face_area→ 42

$face_index

Geeft de index van de huidige zĳde van mazen.

Syntaxis $face_index
Voorbeelden • $face_index→ 4581

$vertex_as_point

Geeft het huidige punt als een geometrie punt terug.

Syntaxis $vertex_as_point
Voorbeelden • geom_to_wkt( $vertex_as_point )→ ‘POINT(800 1500 41)’
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$vertex_index

Geeft de index van het huidige punt van mazen terug.

Syntaxis $vertex_index
Voorbeelden • $vertex_index→ 9874

$vertex_x

Geeft de X-coördinaat van het huidige punt van mazen terug.

Syntaxis $vertex_x
Voorbeelden • $vertex_x→ 42.12

$vertex_y

Geeft de Y-coördinaat van het huidige punt van mazen terug.

Syntaxis $vertex_y
Voorbeelden • $vertex_y→ 12.24

$vertex_z

Geeft de Z-waarde van het huidige punt van mazen terug.

Syntaxis $vertex_z
Voorbeelden • $vertex_z→ 42

13.2.19 Operatoren

Deze groep bevat operatoren (bĳv. +, -, *). Onthoud dat voor de meeste wiskundige functies hieronder, als één van
de invoeren NULL is, het resultaat NULL is.

%

Restant van de deling. Neemt het teken van de deler.
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Syntaxis a % b
Argumenten • a - waarde

• b - waarde

Voorbeelden • 9 % 2→ 1
• 9 % -2→ 1
• -9 % 2→ -1
• 5 % NULL→ NULL

*

Vermenigvuldigen van twee waarden

Syntaxis a * b
Argumenten • a - waarde

• b - waarde

Voorbeelden • 5 * 4→ 20
• 5 * NULL→ NULL

+

Optellen van twee waarden, Als één van de waarden NULL is, zal het resultaat NULL zĳn.

Syntaxis a + b
Argumenten • a - waarde

• b - waarde

Voorbeelden • 5 + 4→ 9
• 5 + NULL→ NULL
• 'QGIS ' + 'ROCKS'→ ‘QGIS ROCKS’
• to_datetime('2020-08-01 12:00:00') + '1 day 2 hours'→ 2020-
08-02T14:00:00

Lees verder: concat, ||
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-

Aftrekken van twee waarden, Als één van de waarden NULL is, zal het resultaat NULL zĳn.

Syntaxis a - b
Argumenten • a - waarde

• b - waarde

Voorbeelden • 5 - 4→ 1
• 5 - NULL→ NULL
• to_datetime('2012-05-05 12:00:00') - to_interval('1 day 2
hours')→ 2012-05-04T10:00:00

/

Delen van twee waarden

Syntaxis a / b
Argumenten • a - waarde

• b - waarde

Voorbeelden • 5 / 4→ 1.25
• 5 / NULL→ NULL

<

Vergelĳkt twee waarden en evalueert naar 1 als de waarde links kleiner is dan de waarde rechts.

Syntaxis a < b
Argumenten • a - waarde

• b - waarde

Voorbeelden • 5 < 4→ FALSE
• 5 < 5→ FALSE
• 4 < 5→ TRUE
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<=

Vergelĳkt twee waarden en evalueert naar 1 als de waarde links kleiner is dan of gelĳk is aan de waarde rechts.

Syntaxis a <= b
Argumenten • a - waarde

• b - waarde

Voorbeelden • 5 <= 4→ FALSE
• 5 <= 5→ TRUE
• 4 <= 5→ TRUE

<>

Vergelĳkt twee waarden en evalueert naar 1 als zĳ niet gelĳk zĳn.

Syntaxis a <> b
Argumenten • a - waarde

• b - waarde

Voorbeelden • 5 <> 4→ TRUE
• 4 <> 4→ FALSE
• 5 <> NULL→ NULL
• NULL <> NULL→ NULL

=

Vergelĳkt twee waarden en evalueert naar 1 als zĳ gelĳk zĳn.

Syntaxis a = b
Argumenten • a - waarde

• b - waarde

Voorbeelden • 5 = 4→ FALSE
• 4 = 4→ TRUE
• 5 = NULL→ NULL
• NULL = NULL→ NULL
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>

Vergelĳkt twee waarden en evalueert naar 1 als de waarde links groter is dan de waarde rechts.

Syntaxis a > b
Argumenten • a - waarde

• b - waarde

Voorbeelden • 5 > 4→ TRUE
• 5 > 5→ FALSE
• 4 > 5→ FALSE

>=

Vergelĳkt twee waarden en evalueert naar 1 als de waarde links groter is dan of gelĳk is aan de waarde rechts.

Syntaxis a >= b
Argumenten • a - waarde

• b - waarde

Voorbeelden • 5 >= 4→ TRUE
• 5 >= 5→ TRUE
• 4 >= 5→ FALSE

AND

Geeft TRUE terug als voorwaarden a en b waar zĳn.

Syntaxis a AND b
Argumenten • a - voorwaarde

• b - voorwaarde

Voorbeelden • TRUE AND TRUE→ TRUE
• TRUE AND FALSE→ FALSE
• 4 = 2+2 AND 1 = 1→ TRUE
• 4 = 2+2 AND 1 = 2→ FALSE
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BETWEEN

Geeft TRUE terug als de waarde binnen het gespecificeerde bereik ligt. Het bereik wordt beschouwd inclusief de
begrenzingen. Voor het testen van uitsluiting kan NOT BETWEEN worden gebruikt.

Syntaxis value BETWEEN lower_bound AND higher_bound
Argumenten • value - de te verwachten waarde om te vergelĳkenmet een bereik. Hetmag een tekenreeks,

een getal of een datum zĳn.
• lower_bound AND higher_bound - grenzen van bereik

Voorbeelden • 'B' BETWEEN 'A' AND 'C'→ TRUE
• 2 BETWEEN 1 AND 3→ TRUE
• 2 BETWEEN 2 AND 3→ TRUE
• 'B' BETWEEN 'a' AND 'c'→ FALSE
• lower('B') BETWEEN 'a' AND 'b'→ TRUE

Notitie: value BETWEEN lower_bound AND higher_bound is hetzelfde als “value >= lower_bound AND value <=
higher_bound”.

Lees verder: NOT BETWEEN

ILIKE

Geeft TRUE terug als de eerste parameter, niet hoofdlettergevoelig, overeenkomt met het opgegeven patroon. LIKE
kan worden gebruikt in plaats van ILIKE om de overeenkomst hoofdlettergevoelig te maken. Werkt ook met getallen.

Syntaxis string/number ILIKE pattern
Argumenten • string/number - tekenreeks die moet worden gezocht

• pattern - te vinden patroon, u kunt ‘%’ als een jokerteken gebruiken, ‘_’ als één enkel teken
en ‘\\’ om deze speciale teken te escapen.

Voorbeelden • 'A' ILIKE 'A'→ TRUE
• 'A' ILIKE 'a'→ TRUE
• 'A' ILIKE 'B'→ FALSE
• 'ABC' ILIKE 'b'→ FALSE
• 'ABC' ILIKE 'B'→ FALSE
• 'ABC' ILIKE '_b_'→ TRUE
• 'ABC' ILIKE '_B_'→ TRUE
• 'ABCD' ILIKE '_b_'→ FALSE
• 'ABCD' ILIKE '_B_'→ FALSE
• 'ABCD' ILIKE '_b%'→ TRUE
• 'ABCD' ILIKE '_B%'→ TRUE
• 'ABCD' ILIKE '%b%'→ TRUE
• 'ABCD' ILIKE '%B%'→ TRUE
• 'ABCD%' ILIKE 'abcd\\%'→ TRUE
• 'ABCD' ILIKE '%B\\%'→ FALSE
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IN

Geeft TRUE terug als de waarde is gevonden in een lĳst met waarden.

Syntaxis a IN b
Argumenten • a - waarde

• b - lĳst met waarden

Voorbeelden • 'A' IN ('A','B')→ TRUE
• 'A' IN ('C','B')→ FALSE

IS

Geeft TRUE terug als a hetzelfde is als b.

Syntaxis a IS b
Argumenten • a - elke waarde

• b - elke waarde

Voorbeelden • 'A' IS 'A'→ TRUE
• 'A' IS 'a'→ FALSE
• 4 IS 4→ TRUE
• 4 IS 2+2→ TRUE
• 4 IS 2→ FALSE
• $geometry IS NULL→ 0, als uw geometrie niet NULL is

IS NOT

Geeft TRUE terug als a niet hetzelfde is als b.

Syntaxis a IS NOT b
Argumenten • a - waarde

• b - waarde

Voorbeelden • 'a' IS NOT 'b'→ TRUE
• 'a' IS NOT 'a'→ FALSE
• 4 IS NOT 2+2→ FALSE
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LIKE

Geeft TRUE terug als de eerste parameter overeenkomt met het opgegeven patroon. Werkt ook met getallen.

Syntaxis string/number LIKE pattern
Argumenten • string/number - waarde

• pattern - patroon waarmee de waarde moet worden vergeleken, u kunt ‘%’ als een
jokerteken gebruiken, ‘_’ als één enkel teken en ‘\\’ om deze speciale teken te escapen.

Voorbeelden • 'A' LIKE 'A'→ TRUE
• 'A' LIKE 'a'→ FALSE
• 'A' LIKE 'B'→ FALSE
• 'ABC' LIKE 'B'→ FALSE
• 'ABC' LIKE '_B_'→ TRUE
• 'ABCD' LIKE '_B_'→ FALSE
• 'ABCD' LIKE '_B%'→ TRUE
• 'ABCD' LIKE '%B%'→ TRUE
• '1%' LIKE '1\\%'→ TRUE
• '1_' LIKE '1\\%'→ FALSE

NOT

Draait een voorwaarde om.

Syntaxis NOT a
Argumenten • a - voorwaarde

Voorbeelden • NOT 1→ FALSE
• NOT 0→ TRUE

NOT BETWEEN

Geeft TRUE terug als de waarde niet binnen het gespecificeerde bereik ligt. Het bereik wordt beschouwd inclusief
de begrenzingen.

Syntaxis value NOT BETWEEN lower_bound AND higher_bound
Argumenten • value - de te verwachten waarde om te vergelĳkenmet een bereik. Hetmag een tekenreeks,

een getal of een datum zĳn.
• lower_bound AND higher_bound - grenzen van bereik

Voorbeelden • 'B' NOT BETWEEN 'A' AND 'C'→ FALSE
• 1.0 NOT BETWEEN 1.1 AND 1.2→ TRUE
• 2 NOT BETWEEN 2 AND 3→ FALSE
• 'B' NOT BETWEEN 'a' AND 'c'→ TRUE
• lower('B') NOT BETWEEN 'a' AND 'b'→ FALSE
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Notitie: value NOT BETWEEN lower_bound AND higher_bound is hetzelfde als “value < lower_bound OR value >
higher_bound”.

Lees verder: BETWEEN

OR

Geeft TRUE terug als voorwaarde a of b waar is.

Syntaxis a OR b
Argumenten • a - voorwaarde

• b - voorwaarde

Voorbeelden • 4 = 2+2 OR 1 = 1→ TRUE
• 4 = 2+2 OR 1 = 2→ TRUE
• 4 = 2 OR 1 = 2→ FALSE

[]

Index-operator. Geeft een element terug uit een array of kaartwaarde.

Syntaxis [index]
Argumenten • index - array-index of waarde sleutel kaart

Voorbeelden • array(1,2,3)[0]→ 1
• array(1,2,3)[2]→ 3
• array(1,2,3)[-1]→ 3
• map('a',1,'b',2)['a']→ 1
• map('a',1,'b',2)['b']→ 2

Lees verder: array_get, map_get

^

Macht van twee waarden.

Syntaxis a ^ b
Argumenten • a - waarde

• b - waarde

Voorbeelden • 5 ^ 4→ 625
• 5 ^ NULL→ NULL
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||

Voegt twee waarden samen tot een tekenreeks.
Als één van de waarden NULL is, zal het resultaat NULL zĳn. Bekĳk de functie CONCAT voor ander gedrag.

Syntaxis a || b
Argumenten • a - waarde

• b - waarde

Voorbeelden • 'Hier' || ' en ' || 'daar'→ ‘Hier en daar’
• 'Nothing' || NULL→ NULL
• 'Dia: ' || "Diameter"→ ‘Dia: 25’
• 1 || 2→ ‘12’

Lees verder: concat, +

~

Voert een reguliere expressie voor overeenkomsten uit op een waarde tekenreeks. Tekens backslash moeten dubbel
worden geëscaped (bĳv. “\\s” om overeen te komen met een teken voor witruimte).

Syntaxis string ~ regex
Argumenten • string - Een waarde tekenreeks

• regex - Een reguliere expressie. Backslashes moeten worden geëscapet, bĳv. \\d.

Voorbeelden • 'hello' ~ 'll'→ TRUE
• 'hello' ~ '^ll'→ FALSE
• 'hello' ~ 'llo$'→ TRUE
• 'abc123' ~ '\\d+'→ TRUE

Lees verder: regexp_match

13.2.20 Functies voor Processing

Deze groep bevat functies die werken op algoritmes van Processing.

• parameter
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parameter

Geeft de waarde van een parameter voor de invoer voor een algoritme van Processing terug.

Syntaxis parameter(name)
Argumenten • name - naam van de corresponderende parameter voor de invoer

Voorbeelden • parameter('BUFFER_SIZE')→ 5.6

13.2.21 Functies voor rasters

Deze groep bevat functies voor bewerkingen van rasterlagen.

• raster_statistic

• raster_value

raster_statistic

Geeft statistieken uit een rasterlaag terug.

Syntaxis raster_statistic(layer, band, property)
Argumenten • layer - een tekenreeks die ofwel een laagnaam of een laag-ID vertegenwoordigt

• band - integer die het bandnummer van de rasterlaag weergeeft, beginnend met 1
• property - een tekenreeks die correspondeert met de terug te geven eigenschap. Geldige
opties zĳn:

– min: minimum waarde
– max: maximum waarde
– avg: gemiddelde (gemiddeld) waarde
– stdev: standaardafwĳking van waarden
– range: bereik van waarden (max - min)
– sum: som van alle waarden uit het raster

Voorbeelden • raster_statistic('lc',1,'avg') → Gemniddelde waarde uit band 1 van
rasterlaag ‘lc’

• raster_statistic('ac2010',3,'min') → Minimum waarde uit band 3 van
rasterlaag ‘ac2010’
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raster_value

Geeft de rasterwaarde terug voor het opgegeven punt.

Syntaxis raster_value(layer, band, point)
Argumenten • layer - de naam of ID van een rasterlaag

• band - het bandnummer waaruit de waarde moet worden genomen.
• point - geometrie punt (voor meerdelige geometrieën die meer dan één deel hebben zal
een waarde NULL worden teruggegeven)

Voorbeelden • raster_value('dem', 1, make_point(1,1))→ 25

13.2.22 Functies Records en attributen

Deze groep bevat functies voor het bewerken van unieke record-ID’s.

attribute

Geeft een attribuut uit een object terug.
Variant 1
Geeft de waarde van een attribuut van het huidige object terug.

Syntaxis attribute(attribute_name)
Argumenten • attribute_name - naam van het terug te geven attribuut

Voorbeelden • attribute( 'name' )→ waarde die is opgeslagen in het attribuut ‘name’ voor het
huidige object

Variant 2
Maakt het mogelĳk het doelobject en de naam van het attribuut te specificeren.

Syntaxis attribute(feature, attribute_name)
Argumenten • feature - een object

• attribute_name - naam van het terug te geven attribuut

Voorbeelden • attribute( @atlas_feature, 'name' ) → waarde die is opgeslagen in het
attribuut ‘name’ voor het huidige object van atlas
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attributes

Geeft een kaart terug van alle attributen van een object, met veldnamen als sleutels voor de kaart.
Variant 1
Geeft een kaart van alle attributen van het huidige object terug.

Syntaxis attributes()
Voorbeelden • attributes()['name']→waarde die is opgeslagen in het attribuut ‘name’ voor het

huidige object

Variant 2
Maakt het mogelĳk het doelobject te specificeren.

Syntaxis attributes(feature)
Argumenten • feature - een object

Voorbeelden • attributes( @atlas_feature )['name']→waarde die is opgeslagen in het
attribuut ‘name’ voor het huidige object van atlas

Lees verder: Functies Kaartobjecten

$currentfeature

Geeft het huidige object terug dat wordt geëvalueerd. Dit kan wordnegebruikt met de functie ‘attribute’ om waarden
attributen te evalueren van het huidige object.WAARSCHUWING: Deze functie is vervallen. Aanbevolen wordt
de vervanging, de variabele @feature, in plaats daarvan te gebruiken.

Syntaxis $currentfeature
Voorbeelden • attribute( $currentfeature, 'name' )→waarde die is opgeslagen in het

attribuut ‘name’ voor het huidige object

display_expression

Geeft de weergave-expressie terug voor een opgegeven object op een laag. De expressie wordt standaard geëvalueerd.
Kan worden gebruikt met nul, een of meer argumenten, bekĳk de details hieronder.
Geen parameters
Indien aangeroepen zonder parameters, zal de functie de weergave-expressie van het huidige object op de huidige
laag evalueren.

Syntaxis display_expression()
Voorbeelden • display_expression() → De weergave-expressie van het huidige object op de

huidige laag.
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Ëén parameter ‘feature’
Indien aangeroepen met een parameter ‘feature’ zal de functie de weergave-expressie van het gespecificeerde object
op de huidige laag evalueren.

Syntaxis display_expression(feature)
Argumenten • feature - Het object dat zou moeten worden geëvalueerd.

Voorbeelden • display_expression(@atlas_feature) → De weergave-expressie van het
huidige object van atlas.

Parameters voor laag en object
Indien aangeroepen met een parameter voor zowel de laag als een object zal de functie het gespecificeerde object op
de gespecificeerde laag evalueren.

Syntaxis display_expression(layer, feature, [evaluate=true])
[] markeert optionele argumenten

Argumenten • layer - De laag (of diens ID of naam)
• feature - Het object dat zou moeten worden geëvalueerd.
• evaluate - Of de expressie moet worden geëvalueerd. Indien false zal de expressie worden
teruggegeven als alleen een letterlĳke tekenreeks (die potentieel later zou kunnen worden
geëvalueerd met de functie ‘eval’).

Voorbeelden • display_expression( 'streets', get_feature_by_id('streets',
1))→ De weergave-expressie van het object met de ID 1 op de laag ‘streets’.

• display_expression('a_layer_id', $currentfeature, 'False')
→ De weergave-expressie van het huidige object niet geëvalueerd.

get_feature

Geeft het eerste object uit een laag terug dat voldoet aan een bepaalde opgegeven waarde voor een attribuut.
Variant enkele waarde
Naast de laag-ID worden een enkele kolom en waarde gespecificeerd.

Syntaxis get_feature(layer, attribute, value)
Argumenten • layer - laagnaam of ID

• attribute - naam van het te gebruiken attribuut voor d eovereenkomst
• value - waarde van het attribuut die overeen moet komen

Voorbeelden • get_feature('streets','name','main st')→ feeste gevonden object op
de laag “streets” met de waarde “main st” in het veld “name”

Variant kaart
Naast de laag-ID wordt een kaart, die de kolommen (sleutel) en hun respectievelĳk waarde bevatten, gebruikt.
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Syntaxis get_feature(layer, attribute)
Argumenten • layer - laagnaam of ID

• attribute - Kaart die de te gebruiken paren kolom en waarde bevat

Voorbeelden • get_feature('streets','name','main st')→ eerste gevonden object op
de laag “streets” met de waarde “main st” in het veld “name” en waarde “4” in het veld
“lane_num”

get_feature_by_id

Geeft het object met een ID op een laag terug.

Syntaxis get_feature_by_id(layer, feature_id)
Argumenten • layer - laag, laagnaam of laag-ID

• feature_id - het ID van het object dat zou moeten worden teruggegeven

Voorbeelden • get_feature_by_id('streets', 1) → het object met de ID 1 op de laag
“streets”

Lees verder: $id

$id

Geeft de object-ID terug van de huidige rĳ. WAARSCHUWING: Deze functie is vervallen. Aanbevolen wordt
om de vervanging, de variabele @id, in plaats daarvan te gebruiken.

Syntaxis $id
Voorbeelden • $id→ 42

is_selected

Geeft TRUE terug als een object is geselecteerd. Kan worden gebruikt met nul, een of twee argumenten, bekĳk de
details hieronder.
Geen parameters
Indien aangeroepen zonder parameters, zal de functie TRUE teruggeven als het huidige object op de huidige laag is
geselecteerd.

Syntaxis is_selected()
Voorbeelden • is_selected()→ TRUE als het huidige object op de huidige laag is geselecteerd.

Ëén parameter ‘feature’
Indien aangeroepen met alleen een parameter ‘feature’ zal de functie TRUE teruggeven als het gespecificeerde object
op de huidige laag is geselecteerd.
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Syntaxis is_selected(feature)
Argumenten • feature - Het object dat zou moeten worden gecontroleerd of het geselecteerd is.

Voorbeelden • is_selected(@atlas_feature) → TRUE als het huidige object van atlas is
geselecteerd.

• is_selected(get_feature('streets', 'name', 'Main St.')))
→ TRUE als het unieke benoemde object “Main St.” op de actieve laag “streets” is
geselecteerd.

• is_selected(get_feature_by_id('streets', 1)) → TRUE als het
object met de ID 1 op de actieve laag “streets” is geselecteerd.

Twee parameters
Als de functie wordt aangeroepen met zowel een laag als een object zal de functie TRUE teruggeven als het
gespecificeerde object op de gespecificeerde laag is geselecteerd.

Syntaxis is_selected(layer, feature)
Argumenten • layer - De laag (zĳn ID of naam) waarop de selectie zal worden gecontroleerd.

• feature - Het object dat zou moeten worden gecontroleerd of het geselecteerd is.

Voorbeelden • is_selected( 'streets', get_feature('streets', 'name',
"street_name"))→ TRUE als de huidige straat van het gebouw is geselecteerd (er
van uitgaande dat de laag met gebouwen een veld, genaamd ‘street_name’, heeft en de laag
‘streets’ een veld, genaamd ‘name’, met unieke waarden heeft).

• is_selected( 'streets', get_feature_by_id('streets', 1))→
TRUE als het object met de ID 1 op de laag “streets” is geselecteerd.

maptip

Geeft de kaarttip terug voor een opgegeven object op een laag. De expressie wordt standaard geëvalueerd. Kan worden
gebruikt met nul, een of meer argumenten, bekĳk de details hieronder.
Geen parameters
Indien aangeroepen zonder parameters, zal de functie de kaarttip van het huidige object op de huidige laag evalueren.

Syntaxis maptip()
Voorbeelden • maptip()→ De kaarttip van het huidige object op de huidige laag.

Ëén parameter ‘feature’
Indien aangeroepen met een parameter ‘feature’ zal de functie de weergave-expressie van het gespecificeerde object
op de huidige laag evalueren.

Syntaxis maptip(feature)
Argumenten • feature - Het object dat zou moeten worden geëvalueerd.

Voorbeelden • maptip(@atlas_feature)→ De kaarttip van het huidige object van atlas.
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Parameters voor laag en object
Indien aangeroepen met een parameter voor zowel de laag als een object zal de functie het gespecificeerde object op
de gespecificeerde laag evalueren.

Syntaxis maptip(layer, feature, [evaluate=true])
[] markeert optionele argumenten

Argumenten • layer - De laag (of diens ID of naam)
• feature - Het object dat zou moeten worden geëvalueerd.
• evaluate - Of de expressie moet worden geëvalueerd. Indien false zal de expressie worden
teruggegeven als alleen een letterlĳke tekenreeks (die potentieel later zou kunnen worden
geëvalueerd met de functie ‘eval_template’).

Voorbeelden • maptip('streets', get_feature_by_id('streets', 1)) → De
kaarttip van het object met de ID 1 op de laag ‘streets’.

• maptip('a_layer_id', $currentfeature, 'False')→De kaarttip van
het huidige object niet geëvalueerd.

num_selected

Geeft het aantal geselecteerde objecten op een opgegeven laag terug. Werkt standaard op de laag waarop de expressie
wordt geëvalueerd.

Syntaxis num_selected([layer=current layer])
[] markeert optionele argumenten

Argumenten • layer - De laag (of zĳn ID of naam) waarvan gecontroleerd moet worden of die is
geselecteerd.

Voorbeelden • num_selected()→ Het aantal geselecteerde objecten op de huidige laag.
• num_selected('streets') → Het aantal geselecteerde objecten op de laag
‘streets’

represent_attributes

Geeft een kaart terug met de namen van de attributen als sleutels en de geconfigureerde weergaven voor waarden
als waarden. De weergegeven waarde voor de attributen is afhankelĳk van het geconfigureerde type widget voor elk
attribuut. Mag worden gebruikt met nul, een of meer argumenten, kĳk hieronder voor de details.
Geen parameters
Indien aangeroepen zonder parameters, zal de functie de weergave van de attributen van het huidige object op de
huidige laag teruggeven.

Syntaxis represent_attributes()
Voorbeelden • represent_attributes() → De weergave van de attributen voor het huidige

object.

Ëén parameter ‘feature’
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Indien aangeroepen met alleen een parameter ‘feature’ zal de functie de weergave van de attributen van het
gespecificeerde object op de huidige laag teruggeven.

Syntaxis represent_attributes(feature)
Argumenten • feature - Het object dat zou moeten worden geëvalueerd.

Voorbeelden • represent_attributes(@atlas_feature)→De weergave van de attributen
voor het gespecificeerde object van de huidige laag.

Parameters voor laag en object
Indien aangeroepen met de parameters ‘layer’ en ‘feature’ zal de functie de weergave van de attributen van het
gespecificeerde object op de gespecificeerde laag teruggeven.

Syntaxis represent_attributes(layer, feature)
Argumenten • layer - De laag (of zĳn ID of naam).

• feature - Het object dat zou moeten worden geëvalueerd.

Voorbeelden • represent_attributes(@atlas_layer, @atlas_feature) → De
weergave van de attributen voor het gespecificeerde object van de gespecificeerde laag.

Lees verder: represent_value

represent_value

Geeft de geconfigureerde waarde voor weergave terug voor een veldwaarde. Het is afhankelĳk van het
geconfigureerde type widget. Dit is vaak nuttig met de widgets ‘Waardenkaart’.

Syntaxis represent_value(value, [fieldName])
[] markeert optionele argumenten

Argumenten • value - De waarde die zou moeten worden opgelost. Meestal een veld.
• fieldName - De veldnaam waarvoor de configuratie van de widget zou moeten worden
geladen.

Voorbeelden • represent_value("field_with_value_map") → Omschrĳving voor
waarde

• represent_value('static value', 'field_name') → Omschrĳving
voor statische waarde

Lees verder: typen widget, represent_attributes
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sqlite_fetch_and_increment

Beheren van automatisch verhogende waarden in databases van SQLite.
Standaardwaarden voor SQLite kunnen alleen worden toegepast met invoegen en niet vooraf worden opgehaald.
Dit maakt het onmogelĳk om een automatisch verhogende primaire sleutel op te halen via AUTO_INCREMENT
voordat de rĳ in de database wordt gemaakt. Opmerking terzĳde: met PostgreSQL werkt dit via de optie evaluate
default values.
Bĳ het toevoegen van nieuwe objecten met relaties, is het echt fĳn om in staat te zĳn om reeds kinderen toe te voegen
voor een ouder, terwĳl het ouder-formulier nog steeds geopend is, maar het ouder-object nog niet is ingediend.
Deze functie kan worden gebruikt om, teneinde deze beperking te omzeilen, reeksen waarden te beheren in een
afzonderlĳke tabel met op SQL gebaseerde indelingen, zoals gpkg.
De tabel met de reeks zal worden gefilterd op een ID voor de reeks (filter_attribute en filter_value) en de huidige
waarde van het id_field zal worden verhoogd met 1 en de verhoogde waarde wordt teruggegeven.
Als aanvullende kolommen waarden vereisen die zĳn gespecificeerd, kan de kaart default_values voor dit doel worden
gebruikt.
Opmerking
Deze functie past de doel-SQLitetabel aan. Het is bedoeld om te gebruiken met configuraties voor standaardwaarde
voor attributen.
Wanneer de parameter voor de database een laag is en de laag staat in de modus Transactie, zal de waarde slechts
eenmaal worden opgehaald gedurende de levenscyclus van een transactie en gecachet en verhoogd. Dit maakt het niet
veilig om parallel vanuit verschillende processen te werken met dezelfde database.

Syntaxis sqlite_fetch_and_increment(database, table, id_field, filter_attribute, filter_value,
[default_values])
[] markeert optionele argumenten

Argumenten • database - Pad naar het bestand van SQLite of laag van Geopackage
• table - Naam van de tabel die de reeksen beheert
• id_field - Naam van het veld dat de huidige waarde bevat
• filter_attribute - Naam van het veld dat een unieke identificatie voor deze reeks bevat.
Moet een index UNIQUE hebben.

• filter_value - Naam van de te gebruiken reeks.
• default_values - Kaart met aanvullende standaardwaarden voor aanvullende kolommen
in de tabel. De waarden moeten zĳn omsloten door aanhalingstekens. Functies zĳn
toegestaan.

Voorbeelden • sqlite_fetch_and_increment(@layer, 'sequence_table',
'last_unique_id', 'sequence_id', 'global',
map('last_change', 'date(''now'')', 'user', '''' ||
@user_account_name || ''''))→ 0

• sqlite_fetch_and_increment(layer_property(@layer, 'path'),
'sequence_table', 'last_unique_id', 'sequence_id',
'global', map('last_change', 'date(''now'')', 'user',
'''' || @user_account_name || ''''))→ 0

Lees verder: Eigenschappen Databronnen, Een tot veel- of veel-tot-veel-relaties maken
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uuid

Maakt een Universally Unique Identifier (UUID) voor elke rĳ met de methode Qt QUuid::createUuid.

Syntaxis uuid([format=’WithBraces’])
[] markeert optionele argumenten

Argumenten • format - De indeling, omdat de UUID zal worden opgemaakt. ‘WithBraces’,
‘WithoutBraces’ of ‘Id128’.

Voorbeelden • uuid()→ ‘{0bd2f60f-f157-4a6d-96af-d4ba4cb366a1}’
• uuid('WithoutBraces')→ ‘0bd2f60f-f157-4a6d-96af-d4ba4cb366a1’
• uuid('Id128')→ ‘0bd2f60ff1574a6d96afd4ba4cb366a1’

13.2.23 Relaties

Deze groep bevat de lĳst met relaties die beschikbaar zĳn in het huidige project, met hun beschrĳvingen. Het verschaft
een snelle toegang tot de ID van de relatie voor het schrĳven van een expressie (met bĳv. de functie relation_aggregate)
of het aanpassen van een formulier.

13.2.24 Tekstfuncties

Deze groep bevat functies die werken op tekst (bĳv. vervangen, omzetten naar hoofdletters).

ascii

Geeft de code voor Unicode terug dat is geassocieerd met het eerste teken uit een tekenreeks.

Syntaxis ascii(string)
Argumenten • string - de naar Unicode te decoderen tekenreeks

Voorbeelden • ascii('Q')→ 81

char

Geeft het teken terug dat is geassocieerd met een code voor Unicode.

Syntaxis char(code)
Argumenten • code - een getal voor Unicode

Voorbeelden • char(81)→ ‘Q’
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concat

Voegt verscheidene tekenreeksen samen tot een. Waarden NULL worden geconverteerd naar lege tekenreeksen.
Andere waarden (zoals getallen) worden geconverteerd naar tekenreeksen.

Syntaxis concat(string1, string2, …)
Argumenten • string - een waarde tekenreeks

Voorbeelden • concat('sun', 'set')→ ‘sunset’
• concat('a','b','c','d','e')→ ‘abcde’
• concat('Anno ', 1984)→ ‘Anno 1984’
• concat('The Wall', NULL)→ ‘The Wall’

Over het samenvoegen van velden
U kunt ook tekenreeksen of veldwaarden samenvoegen met ofwel de operatoren || of +, met enkele speciale
karakteristieken:

• De operator + betekent ook het optellen van de expressie, dus als u een integer deel hebt (veld of numerieke
waarde), kan dit gevoelig zĳn voor fouten en kunt u beter de andere gebruiken:

'My feature id is: ' + "gid" => triggers an error as gid returns an integer

• Wanneer een van de argumenten een waarde NULL is, zullen || of + een waarde NULL teruggeven. U zou
misschien de functie concat willen gebruiken om de andere argumenten, ongeacht de waarde NULL, terug
te geven:

'My feature id is: ' + NULL ==> NULL
'My feature id is: ' || NULL => NULL
concat('My feature id is: ', NULL) => 'My feature id is: '

Lees verder: ||, +

format

Maakt een tekenreeks op met behulp van de opgegeven argumenten.

Syntaxis format(string, arg1, arg2, …)
Argumenten • string - Een tekenreeks met de plaatsvervangers %1, %2, etc., voor de argumenten.

Plaatsvervangers mogen worden herhaald. De laagste genummerde plaatsvervanger zal
worden vervangen door arg1, de volgende door arg2, etc.

• arg - elk type. Elk aantal argumenten.

Voorbeelden • format('Dit %1 een %2','is', 'test')→ ‘Dit is een test’
• format('This is %2','a bit unexpected but 2 is lowest number
in string','normal')→ ‘This is a bit unexpected but 2 is lowest number in string’
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format_date

Maakt een type date of tekenreeks op in een aangepaste indeling voor de tekenreeks. Gebruikt Qt date/time-indeling
tekenreeksen. Bekĳk QDateTime::fromString.
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Syntaxis format_date(datetime, format, [language])
[] markeert optionele argumenten

Argumenten • datetime - waarde date, time of datetime
• format - Tekenreekssjabloon datmoet worden gebruikt voor het indelen van de tekenreeks.

Expressie Uitvoer
d de dag als getal zonder voorloopnul (1 tot en met 31)
dd de dag als getal met voorloopnul (01 tot en met 31)
ddd de verkorte gelokaliseerde naam van de dag (bĳv. ‘maa’ tot en met

‘zon’)
dddd de lange gelokaliseerde naam van de dag (bĳv. ‘maandag’ tot en met

‘zondag’)
M de maand als getal zonder voorloopnul (1-12)
MM de maand als getal met voorloopnul (01-12)
MMM de verkorte gelokaliseerde naam van de maand (bĳv. ‘jan’ tot en met

‘dec’)
MMMM de lange gelokaliseerde naam van de maand (bĳv. ‘januari’ tot en met

‘december’)
yy het jaar als een cĳfer met twee getallen (00-99)
yyyy het jaar als een cĳfer met vier getallen

Deze expressies kunnen worden gebruikt voor het tĳdsgedeelte van de indeling van de
tekenreeks:

Expressie Uitvoer
h het uur als getal zonder voorloopnul (0 tot en met 23 of 1 tot en met

12 met weergave AM/PM)
hh het uur als getal met voorloopnul (00 tot en met 23 of 01 tot en met

12 met weergave AM/PM)
H het uur als getal zonder voorloopnul (0 tot en met 23, zelfs met

weergave AM/PM)
HH het uur als getal met voorloopnul (00 tot en met 23, zelfs met

weergave AM/PM)
m de minuut als getal zonder voorloopnul (0 tot en met 59)
mm de minuut als getal met voorloopnul (00 tot en met 59)
s de seconde als getal zonder voorloopnul (0 tot en met 59)
ss de seconde als getal met voorloopnul (00 tot en met 59)
z de milliseconden zonder achterliggende nullen (0 tot en met 999)
zzz de milliseconden met achterliggende nullen (000 tot en met 999)
AP or A geïnterpreteerd als een tĳd AM/PM. AP moet zĳn ofwel ‘AM’ of

‘PM’.
ap or a geïnterpreteerd als een tĳd AM/PM. apmoet zĳn ofwel ‘am’ of ‘pm’.

• language - taal (kleine letters, twee- of drieletterige ISO 639-taalcode <https:
//en.wikipedia.org/wiki/List_of_ISO_639-1_codes>`_) gebruikt om de date als een
aangepaste tekenreeks op te maken. Standaard wordt de locale van de huidige gebruiker
van QGIS gebruikt.

Voorbeelden • format_date('2012-05-15','dd.MM.yyyy')→ ‘15.05.2012’
• format_date('2012-05-15','d MMMM yyyy','fr')→ ‘15 mai 2012’
• format_date('2012-05-15','dddd') → ‘Tuesday’, als de huidige locale een
Engelse variant is

• format_date('2012-05-15 13:54:20','dd.MM.yy')→ ‘15.05.12’
• format_date('13:54:20','hh:mm AP')→ ‘01:54 PM’
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format_number

Geeft een getal terug dat is opgemaakt met het scheidingsteken voor duizendtallen van de locale. Standaard wordt
de locale van de huidige gebruiker van QGIS gebruikt. Breekt ook het aantal decimale plaatsen af tot het aantal
opgegeven plaatsen.

Syntaxis format_number(number, [places=0], [language], [omit_group_separators=false],
[trim_trailing_zeroes=false])
[] markeert optionele argumenten

Argumenten • number - getal dat moet worden opgemaakt
• places - integer die het aantal plaatsen achter de komma weergeeft voor het afbreken van
de tekenreeks.

• language - taal (kleine letters, twee- of drieletterige ISO 639-taalcode <https://
en.wikipedia.org/wiki/List_of_ISO_639-1_codes>`_) gebruikt om het getal als een
tekenreeks op te maken. Standaard wordt de locale van de huidige gebruiker van QGIS
gebruikt.

• omit_group_separators - indien ingesteld op TRUE dan zullen scheidingstekens voor
groepen niet worden opgenomen in de tekenreeks

• trim_trailing_zeroes - indien ingesteld op TRUE dan zullen achterliggende nullen, die
volgen op de decimale punt, worden weggelaten uit de tekenreeks

Voorbeelden • format_number(10000000.332,2)→ ‘10,000,000.33’ als bĳv. de huidige locale
een Engelse variant is

• format_number(10000000.332,2,'fr')→ ‘10 000 000,33’

left

Geeft een subtekenreeks terug die de n meest links gelegen tekens van de tekenreeks bevat.

Syntaxis left(string, length)
Argumenten • string - een tekenreeks

• length - integer. Het aantal tekens, vanaf links, van de tekenreeks die moeten worden
teruggegeven.

Voorbeelden • left('Hello World',5)→ ‘Hello’

length

Geeft het aantal tekens in een tekenreeks terug of de lengte van een geometrie lĳn.
Variant Tekenreeks
Geeft het aantal tekens in een tekenreeks terug.

Syntaxis length(string)
Argumenten • string - tekenreeks waarvan de lengte moet worden geteld

Voorbeelden • length('hello')→ 5
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Variant Geometrie
Geeft de lengte terug van een geometrie-object lĳn. Berekeningen zĳn altĳd planimetrisch in het ruimtelĳke
referentiesysteem (SRS) van deze geometrie, en de eenheden van de teruggegeven lengte komen overeen met de
eenheden voor het SRS. Dit verschilt van de door de functie $length uitgevoerde berekeningen, die ellipsoïde
berekeningen zal uitvoeren, gebaseerd op de instellingen voor de ellipsoïde van het project en eenheden voor
afstanden.

Syntaxis length(geometry)
Argumenten • geometry - geometrie-object lĳn

Voorbeelden • length(geom_from_wkt('LINESTRING(0 0, 4 0)'))→ 4.0

lower

Converteert een tekenreeks naar kleine letters.

Syntaxis lower(string)
Argumenten • string - de naar kleine letters te converteren tekenreeks

Voorbeelden • lower('HELLO World')→ ‘hello world’

lpad

Geeft een tekenreeks terug van de opgegeven breedte die vanaf links is uitgevuld met een vulteken. Als de doelbreedte
smaller is dan de lengte van de tekenreeks, wordt de tekenreeks afgebroken.

Syntaxis lpad(string, width, fill)
Argumenten • string - tekenreeks die moet worden uitgevuld

• width - lengte van de nieuwe tekenreeks
• fill - teken waarmee de resterende ruimte moet worden uitgevuld

Voorbeelden • lpad('Hello', 10, 'x')→ ‘xxxxxHello’
• lpad('Hello', 3, 'x')→ ‘Hel’

regexp_match

Geeft de eerste overeenkomende positie van een reguliere expressie binnen een tekenreeks van Unicode terug, of 0
als de subtekenreeks niet wordt gevonden.
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Syntaxis regexp_match(input_string, regex)
Argumenten • input_string - de tekenreeks die moet worden getest tegen de reguliere expressie

• regex - De reguliere expressie die getest moet worden. Tekens backslash moeten dubbel
worden geëscaped (bĳv. “\\s” om overeen te komen met een teken voor witruimte of “\\b”
om overeen te komen met een woordgrens)

Voorbeelden • regexp_match('QGIS ROCKS','\\sROCKS')→ 5
• regexp_match('Budač','udač\\b')→ 2

regexp_replace

Geeft een tekenreeks terug waarin de opgegeven reguliere expressie is vervangen.

Syntaxis regexp_replace(input_string, regex, replacement)
Argumenten • input_string - de tekenreeks waarin de overeenkomsten moeten worden vervangen

• regex - De reguliere expressie die vervangen moet worden. Tekens backslash moeten
dubbel worden geëscaped (bĳv. “\\s” om overeen te komen met een teken voor witruimte).

• replacement - De tekenreeks die alle overeenkomsten van de opgegeven reguliere
expressie zal vervangen. Vanggroepen kunnen in de tekenreeks voor vervangen worden
ingevoegd met \\1, \\2, etc.

Voorbeelden • regexp_replace('QGIS SHOULD ROCK','\\sSHOULD\\s',' DOES ')
→ ‘QGIS DOES ROCK’

• regexp_replace('ABC123','\\d+','')→ ‘ABC’
• regexp_replace('mijn naam is Jan','(.*) is (.*)','\\2 is
\\1')→ ‘Jan is mĳn naam’

regexp_substr

Geeft het gedeelte van een tekenreeks terug dat overeenkomt met een opgegeven reguliere expressie.

Syntaxis regexp_substr(input_string, regex)
Argumenten • input_string - de tekenreeks waarin de overeenkomsten moeten worden gevonden

• regex - De reguliere expressie die getest moet worden. Tekens backslash moeten dubbel
worden geëscaped (bĳv. “\\s” om overeen te komen met een teken voor witruimte).

Voorbeelden • regexp_substr('abc123','(\\d+)')→ ‘123’
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replace

Geeft een tekenreeks terug waarin de opgegeven tekenreeks, array, of kaart met tekenreeksen is vervangen.
Variant tekenreeks & array
Geeft een tekenreeks terug waarin de opgegeven tekenreeks of array van tekenreeksen is vervangen door een
tekenreeks of een array van tekenreeksen.

Syntaxis replace(string, before, after)
Argumenten • string - de tekenreeks voor de invoer

• before - de te vervangen tekenreeks of array van tekenreeksen
• after - de tekenreeks of array van tekenreeksen die gebruikt moet worden als vervanging

Voorbeelden • replace('QGIS SHOULD ROCK','SHOULD','DOES') → ‘QGIS DOES
ROCK’

• replace('QGIS ABC',array('A','B','C'),array('X','Y','Z'))
→ ‘QGIS XYZ’

• replace('QGIS',array('Q','S'),'')→ ‘GI’

Variant kaart
Geeft een tekenreeks terug waarin de opgegeven sleutels voor de kaart zĳn vervangen door hun gepaarde waarden.
Langere kaartsleutels worden eerst geëvalueerd.

Syntaxis replace(string, map)
Argumenten • string - de tekenreeks voor de invoer

• map - de kaart die de sleutels en waarden bevat

Voorbeelden • replace('APP SHOULD ROCK',map('APP','QGIS','SHOULD',
'DOES'))→ ‘QGIS DOES ROCK’

• replace('forty two',map('for','4','two','2','forty two',
'42'))→ ‘42’

right

Geeft een subtekenreeks terug die de n meest rechts gelegen tekens van de tekenreeks bevat.

Syntaxis right(string, length)
Argumenten • string - een tekenreeks

• length - integer. Het aantal tekens, vanaf rechts, van de tekenreeks die moeten worden
teruggegeven.

Voorbeelden • right('Hello World',5)→ ‘World’
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rpad

Geeft een tekenreeks terug van de opgegeven breedte die vanaf rechts is uitgevuld met een vulteken. Als de
doelbreedte smaller is dan de lengte van de tekenreeks, wordt de tekenreeks afgebroken.

Syntaxis rpad(string, width, fill)
Argumenten • string - tekenreeks die moet worden uitgevuld

• width - lengte van de nieuwe tekenreeks
• fill - teken waarmee de resterende ruimte moet worden uitgevuld

Voorbeelden • rpad('Hello', 10, 'x')→ ‘Helloxxxxx’
• rpad('Hello', 3, 'x')→ ‘Hel’

strpos

Geeft de eerste overeenkomende positie van een subtekenreeks binnen een andere tekenreeks terug, of 0 als de
subtekenreeks niet wordt gevonden.

Syntaxis strpos(haystack, needle)
Argumenten • haystack - tekenreeks waarin moet worden gezocht

• needle - tekenreeks waarnaar moet worden gezocht

Voorbeelden • strpos('HELLO WORLD','WORLD')→ 7
• strpos('HELLO WORLD','GOODBYE')→ 0

substr

Geeft een deel van een tekenreeks terug.

Syntaxis substr(string, start, [length])
[] markeert optionele argumenten

Argumenten • string - de volledige tekenreeks voor de invoer
• start - integer die de beginpositie weergeeft vanaf waar moet worden uitgenomen,
beginnend met 1; als start negatief is, zal de teruggegeven tekenreeks beginnen aan het
einde van de tekenreeks minus de waarde van start

• length - integer die de lengte van de terug te geven tekenreeks weergeeft; als length negatief
is, zal de teruggegeven tekenreeks de opgegeven lengte van tekens weglaten vanaf het einde
van de tekenreeks

Voorbeelden • substr('HELLO WORLD',3,5)→ ‘LLO W’
• substr('HELLO WORLD',6)→ ‘ WORLD’
• substr('HELLO WORLD',-5)→ ‘WORLD’
• substr('HELLO',3,-1)→ ‘LL’
• substr('HELLO WORLD',-5,2)→ ‘WO’
• substr('HELLO WORLD',-5,-1)→ ‘WORL’
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title

Converteert alle woorden van een tekenreeks naar titels (alle woorden in kleine letters met hoofdletter aan het begin).

Syntaxis title(string)
Argumenten • string - de naar titels te converteren tekenreeks

Voorbeelden • title('hello WOrld')→ ‘Hello World’

to_string

Converteert een getal naar een tekenreeks.

Syntaxis to_string(number)
Argumenten • number - Waarde integer of real. Het getal dat moet worden geconverteerd naar een

tekenreeks.

Voorbeelden • to_string(123)→ ‘123’

trim

Verwĳdert alle voor- en achterliggende witruimte (spaties, tabs, etc) uit een tekenreeks.

Syntaxis trim(string)
Argumenten • string - tekenreeks die moet worden getrimd

Voorbeelden • trim(' hello world ')→ ‘hello world’

upper

Converteert een tekenreeks naar hoofdletters.

Syntaxis upper(string)
Argumenten • string - de naar hoofdletters te converteren tekenreeks

Voorbeelden • upper('hello WOrld')→ ‘HELLO WORLD’
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wordwrap

Geeft een tekenreeks terug, verpakt in een maximum/minimum aantal tekens.

Syntaxis wordwrap(string, wrap_length, [delimiter_string])
[] markeert optionele argumenten

Argumenten • string - de te verpakken tekenreeks
• wrap_length - een integer. Als wrap_length positief is dan geeft het getal het ideale
maximale aantal te verpakken tekens weer; indien negatief, geeft het getal het minimale
aantal te verpakken tekens weer.

• delimiter_string - Optionele tekenreeks als scheidingsteken om naar een nieuwe regel te
verpakken.

Voorbeelden • wordwrap('UNIVERSITY OF QGIS',13)→ ‘UNIVERSITY OF<br>QGIS’
• wordwrap('UNIVERSITY OF QGIS',-3)→ ‘UNIVERSITY<br>OF QGIS’

13.2.25 Gebruikersexpressies

Deze groep bevat de expressies die zĳn opgeslagen als gebruikersexpressies.

13.2.26 Variabelen

Deze groep bevat dynamische variabelen gerelateerd aan de toepassing, het projectbestand en andere instellingen. De
beschikbaarheid van variabelen is afhankelĳk van de context:

• in het dialoogvenster Objecten selecteren met een expressie

• in het dialoogvenster Veldberekening

• in het dialoogvenster Laageigenschappen
• uit de afdruklay-out

Deze variabelen zouden, om te kunnen worden gebruikt in een expressie, moeten worden voorafgegaan door het teken
@ (bĳv. @row_number).

Variabele Omschrijving
algorithm_id De unieke ID van een algoritme
animation_end_time Einde van de tĳdsperiode van Tĳdbeheer voor de gehele animatie (als een waarde

datetime)
animation_interval Duur van de tĳdsperiode van Tĳdbeheer voor de gehele animatie (als een waarde

interval)
animation_start_time Begin van de tĳdsperiode van Tĳdbeheer voor de gehele animatie (als een waarde

datetime)
atlas_feature Het huidige object in atlas (als object object)
atlas_featureid Het huidige atlas object-ID
atlas_featurenumber Het huidige nummer voor het object van atlas in de lay-out
atlas_filename De huidige bestandsnaam voor atlas
atlas_geometry De geometrie voor het huidige atlas-object
atlas_layerid De huidige ID voor de bedekkingslaag van atlas
atlas_layername De naam van de huidige bedekkingslaag van atlas
atlas_pagename De huidige paginanaam voor atlas
atlas_totalfeatures Het totale aantal objecten in de atlas

Vervolgt op volgende pagina

13.2. Lijst van functies 383



QGIS Desktop 3.28 User Guide

Tabel 13.1 – Vervolgd van vorige pagina
Variabele Omschrijving
canvas_cursor_point De laatste cursorpositie in het kaartvenster in de geografische coördinaten van het

project
cluster_color De kleur van symbolen binnen een cluster, of NULL als symbolen gemixte kleuren

hebben
cluster_size Het aantal opgenomen symbolen binnen een cluster
current_feature Het object dat momenteel wordt bewerkt in het attributenformulier of n de tabelrĳ
current_geometry De geometrie van het object dat momenteel wordt bewerkt in het

attributenformulier of in de tabelrĳ
current_parent_feature geeft het object terug dat momenteel wordt bewerkt in het ouderformulier. Alleen

te gebruiken in de context van een ingebed formulier.
current_parent_geometry geeft de geometrie van het object terug dat momenteel wordt bewerkt in het

ouderformulier. Alleen te gebruiken in de context van een ingebed formulier.
form_mode Waar het formulier voor gebruikt wordt, zoals AddFeatureMode, SingleEditMode,

MultiEditMode, SearchMode, AggregateSearchMode of IdentifyMode als
tekenreeks.

feature NEW in 3.28 Geeft het huidige object weer dat wordt geëvalueerd. Dit kan worden gebruikt met
de functie ‘attribute’ om waarden van attributen van het huidige object te evalueren.

frame_duration Duur voor Tĳdbeheer van elk frame voor de animatie (als een waarde interval)
frame_number Huidige framenummer gedurende terugspelen van de animatie
frame_rate Aantal frames per seconde gedurende terugspelen van de animatie
fullextent_maxx Maximumwaarde X uit volledig bereik kaartvenster (inclusief alle lagen)
fullextent_maxy Maximumwaarde Y uit volledig bereik kaartvenster (inclusief alle lagen)
fullextent_minx Minimumwaarde X uit volledig bereik kaartvenster (inclusief alle lagen)
fullextent_miny Minimumwaarde Y uit volledig bereik kaartvenster (inclusief alle lagen)
geometry NEW in 3.28 De geometrie van het huidige object dat wordt geëvalueerd
geometry_part_count Het aantal delen in de geometrie van het gerenderde object
geometry_part_num Het huidige nummer van het deel van de geometrie voor het object dat wordt

gerenderd
geometry_point_count Het aantal punten in het gerenderde deel van een geometrie
geometry_point_num Het nummer van het huidige punt in het gerenderde deel van een geometrie
geometry_ring_num Ringnummer voor huidige geometrie van het object dat momenteel wordt gerenderd

(alleen voor objecten polygoon). De buitenste ring heeft de waarde 0.
grid_axis De huidige as voor het annotatieraster (bĳv, ‘x’ voor longitude, ‘y’ voor latitude).
grid_number De huidige waarde annotatieraster
id NEW in 3.28 De ID van het huidige object dat wordt geëvalueerd
item_id Het huidige gebruikers-ID van item afdruklay-out (niet noodzakelĳkerwĳze uniek)
item_uuid Het unieke ID van item afdruklay-out
layer De huidige laag
layer_crs De ID van de autoriteit van het coördinaten referentiesysteem van de huidige laag
layer_id Het ID van de huidige laag
layer_ids De ID’s van alle kaartlagen in het huidige project, als een lĳst
layer_name De naam van de huidige laag
layers Alle kaartlagen in het huidige project, als een lĳst
layout_dpi De resolutie van de lay-out (DPI)
layout_name De naam van de lay-out
layout_numpages Het aantal pagina’s in de lay-out
layout_page Het paginanummer van het huidige item in de lay-out
layout_pageheight De actieve paginahoogte in de lay-out (in mm voor standaard papiergrootten, of

eender welke eenheid werd gebruikt voor aangepaste papiergrootte)
layout_pageoffsets Array van Y-coördinaten voor de bovenzĳde van elke pagina. Maakt het mogelĳk

items dynamisch te plaatsen op pagina’s in een context waarin paginagroottes
kunnen wĳzigen

layout_pagewidth De actieve paginabreedte in de lay-out (in mm voor standaard papiergrootten, of
eender welke eenheid werd gebruikt voor aangepaste papiergrootte)

legend_column_count Het aantal kolommen in de legenda
Vervolgt op volgende pagina
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Tabel 13.1 – Vervolgd van vorige pagina
Variabele Omschrijving
legend_filter_by_map Geeft aan of de inhoud van de legenda is gefilterd op de kaart
legend_filter_out_atlas Geeft aan of de Atlas is uitgefilterd van de legenda
legend_split_layers Geeft aan of lagen in de legenda kunnen worden gesplitst
legend_title De titel van de legenda
legend_wrap_string Het/de teken(s) die zĳn gebruikt om de tekst van de legenda te verpakken
map_crs De naam van het coördinaten referentiesysteem van de huidige kaart
map_crs_acronym Het acroniem van het coördinaten referentiesysteem van de huidige kaart
map_crs_definition De volledige definitie van het coördinaten referentiesysteem van de huidige kaart
map_crs_description De naam van het coördinaten referentiesysteem van de huidige kaart
map_crs_ellipsoid Het acroniem van de ellipsoïde van het coördinaten referentiesysteem van de

huidige kaart
map_crs_proj4 De definitie voor Proj4 van het coördinaten referentiesysteem van de huidige kaart
map_crs_projection De beschrĳvende naam van projectie-methode die wordt gebruikt door het

Coördinaten ReferentieSysteem van de kaart (bĳv. ‘Albers Equal Area’)
map_crs_wkt De definitie voor WKT van het coördinaten referentiesysteem van de huidige kaart
map_end_time Het einde van de tĳdsperiode van Tĳdbeheer voor de kaart (als een waarde

datetime)
map_extent De geometrie die het huidige bereik van de kaart weergeeft
map_extent_center Het puntobject in het midden van het kaartvenster
map_extent_height De huidige hoogte van de kaart
map_extent_width De huidige breedte van de kaart
map_id Het ID van het huidige doel op de kaart. Dit zal ‘canvas’ zĳn voor renderers van het

kaartvenster, en het item-ID voor renderers van de afdruklay-out
map_interval De duur van de tĳdsperiode van Tĳdbeheer voor de kaart (als een waarde interval)
map_layer_ids De lĳst met ID’s van op de kaart zichtbare lagen
map_layers De lĳst van op de kaart zichtbare lagen
map_rotation De huidige rotatie van de kaart
map_scale De huidige schaal van de kaart
map_start_time Het begin van de tĳdsperiode van Tĳdbeheer voor de kaart (als een waarde

datetime)
map_units De maateenheden voor de kaart
model_path Het volledige pad (inclusief bestandsnaam) van het huidige model (of pad van het

project als het model is ingebed in een project).
model_folder Map die het huidige model bevat (of map van het project als het model is ingebed

in een project).
model_name Naam van het huidige model
model_group Groep voor het huidige model
notification_message Inhoud van het notificatiebericht dat is verzonden door de provider (alleen

beschikbaar voor acties die worden geactiveerd door notificaties van de provider).
parent Verwĳst naar het huidige object in de ouderlaag, toegang verschaffend tot de

attributen en geometrie bĳ het filteren met een functie samenvoegen
project_abstract De abstract van project, afkomstig uit de metadata van het project
project_area_units De eenheid voor gebied voor het huidige project, gebruikt voor het berekenen van

gebieden van geometrieën
project_author De auteur van het project, afkomstig uit de metadata van het project
project_basename De basisnaam van de bestandsnaam van het huidige project (zonder pad en extensie)
project_creation_date De aanmaakdatum van het project, afkomstig uit de metadata van het project
project_crs Het coördinaten referentiesysteem van het project
project_crs_arconym Het acroniem van het coördinaten referentiesysteem van het project
project_crs_definition De volledige definitie van het coördinaten referentiesysteem van het project
project_crs_description De beschrĳving van het coördinaten referentiesysteem van het project
project_crs_ellipsoid De ellipsoïde van het coördinaten referentiesysteem van het project
project_crs_proj4 De weergave in Proj4 van het coördinaten referentiesysteem van het project
project_crs_wkt De weergave in WKT (well known text) van het coördinaten referentiesysteem van

het project
Vervolgt op volgende pagina
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Tabel 13.1 – Vervolgd van vorige pagina
Variabele Omschrijving
project_distance_units De eenheid voor afstand voor het huidige project, gebruikt voor het berekenen van

lengten van geometrieën en afstanden
project_ellipsoid De naam van de ellipsoïde voor het huidige project, gebruikt voor het berekenen

van geodetische gebieden of lengten van geometrieën
project_filename De bestandsnaam van het huidige project
project_folder De map voor het huidige project
project_home Het pad naar de map voor het huidige project
project_identifier De identificatie van het project, afkomstig uit de metadata van het project
project_keywords De sleutelwoorden van het project, afkomstig uit de metadata van het project
project_last_saved Datum/tĳd van wanneer project voor het laatst werd opgeslagen.
project_path Het volledige pad (inclusief bestandsnaam) van het huidige project
project_title De titel van het huidige project
project_units De eenheden van het CRS van het project
qgis_locale De huidige taal van QGIS
qgis_os_name De naam van het huidige besturingssysteem, bĳv ‘Windows’, ‘Linux’ of ‘OSX’
qgis_platform Het platform voor QGIS, bĳv. ‘desktop’ of ‘server’
qgis_release_name De naam van de huidige uitgave voor QGIS
qgis_short_version De verkorte tekenreeks voor de huidige versie van QGIS
qgis_version De tekenreeks voor de huidige versie van QGIS
qgis_version_no Het huidige versienummer voor QGIS
row_number Slaat het nummer van de huidige rĳ op
snapping_results Geeft toegang tot de resultaten voor snappen bĳ digitaliseren van een object (alleen

beschikbaar in Object toevoegen)
scale_value De huidige waarde voor afstand van de schaalbalk
selected_file_path Geselecteerde bestandspad uit de widget Bestandsselectie bĳ het uploaden van een

bestand met een extern opslagsysteem
symbol_angle De hoek van symbool dat is gebruikt om het object te renderen (alleen geldig voor

markeringssymbolen)
symbol_color De kleur van het symbool dat is gebruikt om het object te renderen
symbol_count Het aantal objecten, weergegeven door het symbool (in de Legenda van lay-out)
symbol_id Het interne ID van het symbool (in de Legenda van de lay-out)
symbol_label Het label voor het symbool (ofwel een door de gebruiker gedefinieerd label of het

standaard, automatisch gemaakte, label - in de Legenda van de lay-out)
symbol_layer_count Totaal aantal symboollagen in het symbool
symbol_layer_index Huidige index voor de symboollaag
symbol_marker_column Kolomnummer voor markering (alleen geldig voor vullingen van puntpatroon).
symbol_marker_row Rĳnummer voor markering (alleen geldig voor vullingen van puntpatroon).
user_account_name De accountnaam van de gebruiker voor het huidige besturingssysteem
user_full_name De gebruikersnaam van de huidige gebruiker voor het besturingssysteem
value De huidige waarde
vector_tile_zoom Exacte vectortegel zoomniveau van de kaart die wordt gerenderd (afgeleid van de

huidige schaal van de kaart). Normaal gesproken in interval [0, 20]. Anders dan
@zoom_level, is deze variabele een waarde floating point die kan worden gebruikt
om waarden te interpoleren tussen twee integere zoomniveaus.

with_variable Maakt instellen van een variabele mogelĳk om te gebruiken in een expressie om
herhaaldelĳk herberekenen van dezelfde waarde te vermĳden

zoom_level Vectortegel zoomniveau van de kaart die wordt gerenderd (afgeleid van de huidige
schaal van de huidige kaart). Normaal gesproken in interval [0, 20].

Enkele voorbeelden:
• Geef het X-coördinaat van het midden van een kaartitem in een lay-out terug:

x( map_get( item_variables( 'map1'), 'map_extent_center' ) )

• Geef, voor elk object op de huidige laag, het aantal overlappende objecten airports terug:
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aggregate( layer:='airport', aggregate:='count', expression:="code",
filter:=intersects( $geometry, geometry( @parent ) ) )

• Haal het object_ID op van het eerste gesnapte punt van een lĳn:

with_variable(
'first_snapped_point',
array_first( @snapping_results ),
attribute(

get_feature_by_id(
map_get( @first_snapped_point, 'layer' ),
map_get( @first_snapped_point, 'feature_id' )

),
'object_id'

)
)

13.2.27 Functies Recent

Deze groep bevat recent gebruikte functies. Afhankelĳk van de context van zĳn gebruik (object selecteren,
veldberekening, algemeen), worden recent toegepaste expressies toegevoegd aan de corresponderende lĳst (tot
maximaal tien expressies), gesorteerd van de meest tot de minst recente. Dit maakt het gemakkelĳker om snel eerder
gebruikte expressies terug te vinden.
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HOOFDSTUK14

De Stijlbibliotheek

14.1 De Stijlmanager

14.1.1 Het dialoogvenster Stijlmanager

De Stĳlmanager is de plaats waar u algemene items voor stĳl kunt beheren enmaken. Dit zĳn symbolen, kleurverlopen,
tekstindelingen of instellingen voor labels die kunnen worden gebruikt om objecten, lagen of afdruklay-outs te
symboliseren. Ze worden opgeslagen in de database symbology-style.db onder het actieve gebruikersprofiel
en gedeeld met alle projectbestanden die met dat profiel worden geopend. Items voor stĳl kunnen ook met anderen
worden gedeeld dankzĳ de mogelĳkheden voor exporteren/importeren van het dialoogvenster Stĳlmanager.
U kunt dat modeless dialoogvenster openen, ofwel:

• vanuit het menu Extra ► Stĳlmanager…

• met de knop Stĳlmanager vanaf de werkbalk Project

• of met de knop Stĳlmanager uit een vectormenu Laageigenschappen ► (bĳ het configureren van een symbool
of opmaken van een tekst).
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Fig. 14.1: De Stijlmanager

Items voor stijl beheren

Het dialoogvenster Stĳlmanager geeft in het midden een frame weer met daarin voorbeelden van items, georganiseerd
op tabs:

• Alles voor een complete collectie van punt-, lineaire en oppervlaktesymbolen en instellingen voor labels, als
ook voorafgedefinieerde kleruverlopen en tekstindelingen;

• Markering alleen voor puntsymbolen;

• Lĳn alleen voor lineaire symbolen;

• Vulling alleen voor oppervlaktesymbolen;

• Kleurverloop;
• Tekst opmaken om opmaak van tekst te beheren, die het lettertype, kleur, buffers, schaduwen, en
achtergronden voor tekst opslaan (d.i. alle delen voor opmaak van instellingen voor de labels, die bĳvoorbeeld
kunnen worden gebruikt in lay-outs);

• Instellingen label om instellingen voor labels te beheren, die de opmaak voor de teksten omvatten en enkele
specifieke instellingen voor lagen, zoals plaatsing van labels, prioriteit, tekstballonnen, renderen…

• Legenda modelvormen om aangepste modelvormen voor de legenda te beheren, waaronder gepmetrieën
Markering, Lĳn en Vulling.

• 3D-symbolen om symbolen met 3D-eigenschappen (extrusie, schaduwen, hoogte, …) te configureren voor
de objecten die moeten worden gerenderd in een 3D-kaartweergave

U kunt de Stĳlen schikken in Pictogramweergave of in Lĳstweergave aan de rechter onderkant. In beide
weergave geeft de helptip een grotere versie van de stĳl. De schuifbalk voor de miniaturen aan de linkerkant van
de pictogrammen helpt u de feitelĳk grootte van de miniaturen in het dialoogvenster aan te passen, voor een beter
voorbeeld van de symbolen!
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Voor elke familie van items kunt u de elementen beheren in verschillende categorieën, vermeld in het paneel aan de
linkerkant:

• Favorieten: standaard weergegeven bĳ het configureren van een item, het geeft een uit te breiden set met items
weer;

• Alles: vermeld alle beschikbare items voor het actieve type;
• Tags: geeft een lĳst weer met labels die u kunt gebruiken om de items te identificeren. Een item mag meer dan
een keer worden getagd. Selecteer een tag in de lĳst en de tabs worden bĳgewerkt, om alleen de items weer te
geven die daartoe behoren. Gebruik, om een nieuwe tag te maken, die u later kunt toevoegen aan een set items,
de knop Tag toevoegen… of selecteer Aan tag toevoegen… uit het contextmenu van een tag;

• Slimme groepen: een slimme groep haalt dynamisch zĳn symbolen op, overeenkomstig ingestelde
voorwaarden (zie bĳv, Fig. 14.2). Klik op de knop Slimme groep toevoegen… om slimme groepen te maken.
Het vak in het dialoogvenster stelt u in staat een expressie in te voeren om de te selecteren items te filteren
(heeft een bepaalde tag, heeft een tekenreeks in zĳn naam, etc.). Elk symbool, kleurverloop, tekstindeling of
instelling voor label dat voldoet aan de ingevoerde voorwaarde(n) wordt automatisch toegevoegd aan de slimme
groep.

Fig. 14.2: Een Slimme groep maken

Tags en slimme groepen sluiten elkaar niet uit: het zĳn eenvoudigweg twee verschillende manieren om uw
stĳlelementen te beheren. Anders dan de slimme groepen, die automatisch hun daartoe behorende items ophalen
gebaseerd op de voorwaarden voor de invoer, worden tags gevuld door de gebruiker. U kunt, om een van deze
categorieën te bewerken, ofwel:

• de items selecteren, met rechts klikken en kiezen Aan tag toevoegen ► en dan de naam van de tag selecteren
of een nieuwe tag maken;

• de tag selecteren en drukken op Groep aanpassen…► Geselecteerde tag aan symbolen koppelen. Een keuzevak
verschĳnt naast elk item om u te helpen het te selecteren of te deselecteren. Wanneer de selectie is voltooid,
druk op Groep aanpassen… ► Taggen voltooien.

• de slimme groep selecteren, druk op Groep aanpassen… ► Slimme groep bewerken… en configureer een
nieuwe set voorwaarden in het dialoogvenster Slimme groep bewerken. Deze optie is ook beschikbaar in het
contextmenu van de slimme groep.

Klik, om een tag of een slimme groep te verwĳderen, er met rechts op en selecteer de knop Verwĳderen. Onthoud
dat dit niet de items verwĳdert die zĳn gegroepeerd in de categorie.
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Een item toevoegen, bewerken of verwijderen

Zoals eerder gezien worden stĳlelementen onder verschillende tabs weergegeven, waarvan de inhoud afhankelĳk is
van de actieve categorie (tag, slimme groep, Favorieten…). Wanneer een tab is ingeschakeld kunt u:

• Nieuwe items toevoegen: druk op de knop Item toevoegen en configureer het item, daarbĳ de beschrĳving voor
het bouwen van symbolen, kleurverlopen of tekstindelingen en label volgend.

• Een bestaand item aanpassen: selecteer een item en druk op de knop Item bewerken en configureer zoals
hierboven vermeld.

• Bestaande items verwĳderen: om een element te verwĳderen dat u niet langer nodig hebt, selecteer het en klik
op Item verwĳderen (ook beschikbaar door met rechts te klikken). Het item zal uit de lokale database worden
verwĳderd.

Onthoud dat de tab Alles toegang verschaft tot deze opties voor elk type item.
Door met rechts te klikken boven een selectie van items kunt u:

• Aan Favorieten toevoegen;
• Uit Favorieten verwĳderen;
• Aan tag toevoegen ► en de toepasselĳke tag selecteren of een nieuwe maken om te gebruiken; de huidige
toegewezen tags worden gecontroleerd;

• Tags leegmaken: symbolen losmaken van elke tag;
• Item(s) verwĳderen;
• Item bewerken: van toepassing voor het item waarboven u met rechts klikt;
• Item kopiëren;
• Item plakken…: plakken naar een van de categorieën van de Stĳlmanager of ergens anders in QGIS (symbool
of kleurknoppen)

• Geselecteerde symbo(o)len als PNG exporteren… (alleen beschikbaar met symbolen);
• Geselecteerde symbo(o)len als SVG exporteren… (alleen beschikbaar met symbolen);

Items voor stijl delen

Het gereedschap Importeren/Exporteren, aan de linkeronderkant van het dialoogvenster Stĳlmanager, biedt opties
om gemakkelĳk symbolen, kleurverlopen, tekstindelingen en instellingen voor labels te delenmet anderen. Deze opties
zĳn ook beschikbaar door met rechts te klikken boven de items.

Items exporteren

U kunt een set items naar een .XML-bestand exporteren:

1. Vergroot het keuzemenu Importeren/Exporteren en selecteer Item(s) exporteren…

2. Kies de items die u wilt opnemen. Selecteren kan worden gedaan met de muis of door een eerder ingestelde
tag of groep te gebruiken

3. Druk op Exporteren indien gereed. U zult worden gevraagd om de bestemming van het opgeslagen bestand aan
te geven. De indeling XML maakt één enkel bestand dat alle geselecteerde items bevat. Dit bestand kan dan
worden geïmporteerd in de stĳlbibliotheek van een andere gebruiker.
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Fig. 14.3: Items voor stijl exporteren

Als symbolen zĳn geselecteerd, kunt u ze ook exporteren naar .PNG of .SVG. Exporteren naar .PNG of .SVG
(beide niet beschikbaar voor andere typen items voor stĳl) maakt een bestand voor elk geselecteerd symbool in een
opgegeven map. De map SVG kan worden toegevoegd aan de SVG-paden in het menu Extra► Opties► Systeem van
een andere gebruiker, wat hem directe toegang geeft tot al deze symbolen.

Items importeren

U kunt uw stĳlbibliotheek uitbreiden door nieuwe items te importeren:

1. Vergroot het keuzemenu Importeren/Exporteren en selecteer Item(s) importeren… aan de
linkeronderkant van het dialoogvenster.

2. Geef, in het nieuwe dialoogvenster, de bron van de items voor stĳl aan (het mag een .xml-bestand zĳn op de
schĳf of een URL).

3. Stel Aan favorieten toevoegen in of niet voor de te importeren items.

4. Selecteer Ingebedde tags niet importeren om het importeren van tags, die zĳn geassocieerd aan de te
importeren items, te vermĳden.

5. Geef de naam op van eventuele Aanvullende tag(s) om toe te passen op de nieuwe items.
6. Selecteer uit het voorbeeld de symbolen die u wilt toevoegen aan uw bibliotheek.
7. En druk op Importeren.
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Fig. 14.4: Items voor stijl importeren

Het paneel Browser gebruiken

Het is ook mogelĳk items voor stĳl direct te importeren in de stĳldatabase van het actieve gebruikersprofiel vanuit
het paneel Browser:

1. Selecteer het stĳlbestand .xml in de browser
2. Sleep het naar het kaartvenster en zet het neer of klik met rechts en selecteer Stĳl importeren…

3. Vul het dialoogvenster Item(s) importeren volgens Items importeren

4. Druk op Importeren en de geselecteerde items voor stĳl worden toegevoegd aan de stĳldatabase
Dubbelklikken op het stĳlbestand in de browser opent het dialoogvenster Stĳlmanager dat de items in het bestand
weergeeft. U kunt ze selecteren en drukken op Naar standaard stĳl kopiëren… om ze te importeren in de actieve
stĳldatabase. Tags kunnen aan items worden toegewezen. Ook beschikbaar via met rechts klikken, opdracht Stĳl
openen….

Fig. 14.5: Openen van een bestand met items voor stijl

Het dialoogvenster staat ook toe om enkele symbolen als bestanden .PNG of .SVG te exporteren.
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De online opslagplaats gebruiken

Het project QGIS onderhoudt een opslagplaats met een collectie stĳlen die worden gedeeld door gebruikers van QGIS.
Deze is beschikbaar op https://plugins.qgis.org/styles en er kan toegang worden verkregen vanuit het dialoogvenster
StĳlManager, door te drukken op de knop Door online stĳlen bladeren aan de onderzĳde.
Vanuit die opslagplaats kunt u:

1. Bladeren en zoeken naar stĳlitems, gebaseerd op hun type of naam
2. Het stĳlbestand downloaden en het uitpakken
3. Het op .xml gebaseerde bestand laden in uw stĳldatabase in QGIS, met behulp van de hiervoor vermelde

methoden voor importeren.

14.1.2 Een kleurverloop instellen

De tab Kleurverloop in het dialoogvenster Stĳlmanager helpt u voorbeelden te bekĳken van verschillende
kleurverlopen, gebaseerd op de categorie die is geselecteerd in het linkerpaneel.

Activeer, om een aangepast kleurverloop te maken, de tab Kleurverloop en klik op de knop Item toevoegen. De knop
onthult een keuzemenu om het type kleurverloop te kiezen:

• Kleurverloop: gegeven een begin- en eindkleur, maak een kleurverloop dat Doorgaand of Afzonderlĳk kan
zĳn. Door te dubbelklikken op het voorbeeld van het kleurverloop kunt u net zoveel tussenliggende kleuren
toevoegen als u wilt. Door te klikken op de indicatie voor de kleurstop en onder Stop kleurverloop kunt u:

– zĳn Relatieve positie aanpassen vanuit het begin van het kleurverloop. Ook is het mogelĳk de indicatie
te slepen met de muis, of door te drukken op de pĳltjestoetsen (combineer met Shift-toets voor een
grotere verplaatsing)

– het te gebruiken kleurmodel specificeren bĳ het interpoleren van kleuren: het kan zĳn RGB, HSL of HSV.
In sommige omstandigheden kan deze optie helpen verzadigde middentonen te vermĳden, wat resulteert
in visueel meer prettige kleurverlopen.

– de richting instellen waarin de interpolatie de component Tint zou moeten volgen of een kleurspecificatie
voor HSL of HSV. Het kan zĳn Met de klok mee of Tegen de klok in.

– de eigenschappen voor kleur instellen
– de kleurstop verwĳderen door te drukken op Stop verwĳderen of DEL

De groep Plot verschaft een andere grafische manier om het kleurverloop te ontwerpen, wĳzigen van de positie
of de opaciteit en componenten HSL voor de kleurstoppen.
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Fig. 14.6: Voorbeeld van aangepast gradiënt kleurverloop met meerdere stops

Hint: Slepen en neerzetten van een kleur op het voorbeeld van het kleurverloop voegt een nieuwe kleurstop
toe.

• Voorkeuzen kleuren: maakt het mogelĳk een kleurverloop te maken dat bestaat uit een door de gebruiker
geselecteerde lĳst met kleuren;

• Willekeurig: maakt een willekeurige set kleuren, gebaseerd op een bereik van waarden voor Kleurnuance,
Saturatie,Waarde en Doorzichtbaarheid en een aantal kleuren (Klassen);

• Catalogus: ColorBrewer: een set vooraf gedefinieerde afzonderlĳke kleurovergangen, waarvan u het aantal
kleuren in het kleurverloop kunt aanpassen;

• of Catalogus: cpt-city: een toegang tot een hele catalogus met kleurovergangen om lokaal te Opslaan als
standaard gradiënt. De optie cpt-city opent een nieuw dialoogvenster met honderden thema’s ‘out of the box’.
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Fig. 14.7: Dialoogvenster cpt-city met honderden kleurverlopen

14.1.3 Een Legenda modelvorm maken

Activeer, om een nieuwe Legenda modelvorm te maken, de tab Legenda modelvormen en klik op de knop
Item toevoegen. De knop onthult een keuzelĳst om het type geometrie te kiezen:

• Markering Legenda modelvorm…: om te gebruiken met geometrieën punt.
• Lĳn Legenda modelvorm…: om te gebruiken met geometrieën lĳn.
• Vulling Legenda modelvorm…: om te gebruiken met geometrieën polygoon.

Alle drie opties zullen hetzelfde dialoogvenster weergeven.
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Fig. 14.8: Een nieuwe Legenda modelvorm maken

Alleen het type vorm en de weergegeven Legenda modelvormen zullen verschillen, afhankelĳk van het gekozen type
geometrie. De volgende opties zullen beschikbaar zĳn:

• Vorm: definieer de vorm van de Legenda modelvorm als een WKT=tekenreeks. Enkele en meerdelige
geometrieën mogen worden gebruikt, maar niet GeometryCollection.

• Verhoudingen aspect behouden

• Pictogramweergave of Lĳstweergave van de beschiibare Legenda modelvormen, gefilterd op tags.
Als de nieuwe vorm is gedefinieerd kunt u Legenda modelvorm opslaan… of drukken op OK, wat beide zal leiden tot
hetzelfde dialoogvenster.
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Fig. 14.9: Een nieuwe Legenda modelvorm opslaan

Hier dient u een naam te kiezen, tags om de vorm te beschrĳven en of het moet worden toegevoegd aan Favorieten.
Als u drukt op Opslaan… wordt de modelvorm toegevoegd aan de lĳst en u wordt teruggeleid naar het dialoogvenster
Nieuwe Legenda modelvorm om nieuwe vormen te kunnen blĳven maken.

14.2 Symbool selecteren

Symbool selecteren is het belangrĳkste dialoogvenster om een symbool te ontwerpen. U kunt symbolen voor
markeringen, lĳn of vulling maken of bewerken.
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Fig. 14.10: Een symbool Lijn ontwerpen

Twee belangrĳke componenten structureren het dialoogvenster Symbool selecteren:
• de boom met symbolen, die symboollagen weergeeft die achteraf zĳn gecombineerd om een nieuw globaal
symbool vorm te geven

• en instellingen om de geselecteerde symboollaag in de boom te configureren.

14.2.1 De boom voor de symboollagen

Een symbool kan bestaan uit verscheidene Symboollagen. De boom van de symboollagen geeft het overzicht weer
van deze symboollagen, die achteraf worden gecombineerd om een nieuw globaal symbool vorm te geven. Daarnaast
wordt een dynamische weergave van het symbool bĳgewerkt, zodra eigenschappen van het symbool wĳzigen.
Afhankelĳk van het geselecteerde niveau, in items van de boom van de symboollagen, zĳn verschillende
gereedschappen beschikbaar gemaakt om u te helpen de boom te beheren:

• een nieuwe symboollaag toevoegen: u mag net zoveel symbolen stapelen als u wilt

• de geselecteerde symboollaag verwĳderen

• kleuren van de symboollaag vergrendelen: een vergrendelde kleur blĳft ongewĳzigd als de gebruiker de
kleur wĳzigt op het globale (of bovenste) niveau van het symbool
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• een (groep van) symboolla(a)g(en) dupliceren
• de symboollaag naar boven of beneden verplaatsen

14.2.2 Een symbool configureren

In QGIS wordt het configureren van een symbool uitgevoerd in twee stappen: het symbool en dan de symboollaag.

Het symbool

Op het bovenste niveau van de boom, het is afhankelĳk van de geometrie van de laag en kan zĳn van het type
Markering, Lĳn ofVulling. Elk symbool kan één op meer symbolen (inclusief van elk ander type) of symboollagen
inbedden.
U kunt enkele parameters instellen die van toepassing zĳn op het globale symbool:

• Eenheid: dit kan zĳn Millimeters, Punten, Pixels, Meters op schaal, Kaarteenheden of Inches (bekĳk
Eenheid selecteren voor meer details)

• Doorzichtbaarheid

• Kleur: wanneer deze parameter wordt gewĳzigd door de gebruiker, wordt de waarde ervan doorgeëchood naar
alle niet vergrendelde kleuren van subsymbolen

• Grootte en Rotatie voor markeringssymbolen
• Breedte voor lĳnsymbolen

Tip: Gebruik de eigenschappen Grootte (voor markeringssymbolen) of Breedte (voor lĳnsymbolen) op het
niveau van het symbool om de grootte van al zĳn ingebedde dimensies van symboollagen proportioneel te
wĳzigen.

Notitie: De knop Data-bepaalde ‘override’ naast de parameters Breedte, Grootte of Rotatie is inactief bĳ het
instellen van het symbool vanuit het dialoogvenster Stĳlmanager. Wanneer het symbool wordt verbonden aan
een kaartlaag, helpt deze knop u bĳ het maken van proportionele of multivariatie analyse rendering.

• Een voorbeeld van de symbolenbibliotheek: Symbolen van hetzelfde type worden weergegeven en kunnen, met
de bewerkbare keuzelĳst er net boven, worden gefilterd met vrĳe-vorm-tekst of op categorieën. U kunt de lĳst
met symbolen ook bĳwerken met de knop Stĳlmanager en het dialoogvenster voor eponiemen openen. Daar
kunt u elk van de mogelĳkheden gebruiken die worden weergegeven in het gedeelte De Stĳlmanager.
De symbolen worden weergegeven, ofwel:

– in een lĳst met pictogrammen (met miniatuur, naam en geassocieerde tags) met de knop Lĳstweergave

onder het frame;

– of als een voorbeeld van het pictogram met de knop Pictogramweergave.
• Druk op de knop Symbool opslaan om het bewerkte symbool toe te voegen aan de symbolenbibliotheek.

• Met de optie Geavanceerd kunt u:
– voor symbolen Lĳn en Vulling, Objecten naar kaartbereik clippen.
– voor symbolen Vulling Oriëntatie voor Rechterhand-regel forceren: maakt het mogelĳk te forceren dat
gerenderde symbolen voor vulling de standaard “rechterhand-regel” volgen voor oriëntatie van ringen
(d.i. polygonen waarvan de ring voor het exterieur met de regels van de klok meegaat, en de ringen voor
het interieur allemaal tegen de wĳzers van de klok in gaan).
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Het repareren van de oriëntatie wordt alleen tĳdens het renderen toegepast, en de originele geometrie
van het object wordt niet gewĳzigd. Dit maakt het maken van symbolen voor vulling met een consistent
uiterlĳkmogelĳk, ongeacht het renderen van de gegevensset en de oriëntatie van de ringen van individuele
objecten.

– Afhankelĳk van de symbologie van de laag waarop een symbool wordt toegepast, zĳn aanvullende
instellingen beschikbaar in het menu Geavanceerd:
∗ Symboollagen… om de volgorde van het renderen van de symbolen te definiëren
∗ Data-bepaalde grootte Legenda

∗ Overeenkomst met opgeslagen symbolen… en Overeenkomst met symbolen uit bestand… om
automatisch symbolen aan klassen toe te wĳzen

De symboollaag

Op een lager niveau van de boom kunt u de symboollagen aanpassen. De beschikbare typen symboollaag zĳn
afhankelĳk van het bovenste type symbool. U kunt tekeneffecten toepassen op de symboollaag om het renderen
ervan te verbeteren.
Omdat het beschrĳven van alle opties van alle typen symboollagen niet mogelĳk is, worden hieronder alleen bepaalde
en significante vermeld.

Algemene parameters

Enkele algemene opties en widgets zĳn beschikbaar om een symboollaag te bouwen, ongeacht het subtypeMarkering,
Lĳn of Vulling:

• de widget Kleur selecteren om het bewerken van kleuren makkelĳk te maken
• Eenheid: dit kan zĳn Millimeters, Punten, Pixels, Meters op schaal, Kaarteenheden of Inches (bekĳk

Eenheid selecteren voor meer details)

• de widget Data-bepaalde ‘override’ bĳ bĳna alle opties, wat de mogelĳkheden voor het aanpassen van elk symbool
uitbreidt (bekĳk Data-bepaalde ‘override’ instellen voor meer informatie)

• de optie Symboollaag inschakelen beheert de zichtbaarheid van de symboollaag. Uitgeschakelde
symboollagen worden niet getekend bĳ het renderen van het symbool, maar worden opgeslagen in het symbool.
Het kunnen verbergen van symboollagen is handig bĳ het zoeken naar het beste ontwerp van uw symbool,
omdat u er geen hoeft te verwĳderen bĳ het testen. De data-bepaalde ‘override’ maakt het dan mogelĳk
om verschillende symboollagen te verbergen of weer te geven, gebaseerd op expressies (met behulp van
bĳvoorbeeld attributen van objecten).

• de knop Tekeneffecten voor renderen van effecten.

Notitie: Hoewel de beschrĳving hieronder er van uitgaat dat het type symboollaag is gebonden aan de geometrie
van het object, onthoud dat u symboollagen in elkaar kunt inbedden. In dat geval zou de parameter voor het onderste
niveau van de symboollaag (plaatsing, verschuiving…) kunnen worden gebonden aan het symbool op het bovenste
niveau, en niet aan de geometrie van het object zelf.
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Markeringssymbolen

Toepasselĳk voor geometrieobjecten punt hebben markeringssymbolen verscheidene Symboollaagtypen:
• Standaard symbool (standaard)

Fig. 14.11: Een standaard markeringssymbool ontwerpen

Het enkele markering symboollaagtype heeft de volgende eigenschappen:
– Grootte in verscheidene ondersteunde eenheden
– Vulkleur

– Lĳnkleur, Lĳnstĳl uit een vooraf gedefinieerde lĳst en Lĳndikte

– Verbindingsstĳl: het kan zĳn Hoekig, Puntig of Rond
– Eindstĳl: het kan zĳn Vierkant, Plat of Rond
– Rotatie
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– Verspringing in X- en Y- richtingen van het object
– Ankerpunt: definiëren van het kwadrantpunt op het symbool om te dienen als plaats van origine. Dit is
het punt waar Verspringing op wordt toegepast.

• Ellips-markering: een standaard markeringssymboollaag, met aan te passen breedte en hoogte
• Gevulde markering: soortgelĳk aan de standaard markeringssymboollaag, met de uitzondering dat het een

subsymbool voor vulling gebruikt om de markering te renderen. Dit maakt het mogelĳk alle bestaande stĳlen
van QGIS voor vulling (en dikte) voor het renderen van markeringen te gebruiken, bĳv. vulling kleurverloop
of shapeburst.

• Lettertype-markering: soortgelĳk aan de standaard markeringssymboollaag, met de uitzondering dat het
geïnstalleerde lettertypen gebruikt om de markering te renderen. De aanvullende eigenschappen ervan zĳn:

– Lettertype

– Stĳl lettertype

– Teken(s), de tekst om weer te geven als symbool. Zĳ kunnen worden getypt of geselecteerd uit de widget
met verzamelde tekens van het lettertype en u kunt ze live als Voorbeeld zien met de geselecteerde
instellingen.

• Geometrie-generator (bekĳk De Geometrie-generator)
• Masker: zĳn sub-symbool definieert een vorm masker waarvan de eigenschap kleur zal worden genegeerd en
alleen doorzichtbaarheid zal worden gebruikt. Dit is nuttig als het markeringssymbool overlapt met labels of
andere symbolen waarvan kleuren dicht bĳ elkaar liggen, wat het moeilĳker te ontcĳferen maakt. Meer details
in Eigenschappen Maskers.

• Markering rasterafbeelding: gebruik een afbeelding (PNG, JPG, BMP …) als markeringssymbool. De
afbeelding kan een bestand op schĳf zĳn, een URL op afstand, ingebed in de stĳldatabase (meer details) of het
kan zĳn gecodeerd als een tekenreeks van base64. Breedte en hoogte van de afbeelding kunnen onafhankelĳk
worden ingesteld of door Verhoudingen aspect vastzetten. De grootte kan worden ingesteld met een van de algemene
eenheden of als een percentage van de originele grootte van de afbeelding (geschaald op de breedte).

• Markering vectorveld (bekĳk De markering Vectorveld)
• SVG-markering: verschaft u afbeeldingen uit uw paden voor SVG (ingesteld in het menu Extra ► Opties…
► Systeem) om als markeringssymbool te renderen. Breedte en hoogte van het symbool kunnen onafhankelĳk
worden ingesteld of met Verhoudingen aspect vastzetten. De kleuren en lĳnen van elk SVG-bestand kunnen ook
worden aangepast. De afbeelding mag een bestand op schĳf zĳn, een URL op afstand, ingebed in de
stĳldatabase (meer details) of het kan zĳn gecodeerd als een tekenreeks van base64.
Het symbool kan ook worden ingesteld met Dynamische parameters SVG. Bekĳk het gedeelte SVG met
parameters om een SVG-symbool te voorzien van parameters.

Notitie: Vereisten voor versie van SVG
QGIS rendert SVG-bestanden die het SVG Tiny 1.2 profiel volgen, bedoeld voor het implementeren op een
bereik aan apparaten, van mobiele telefoons en PDA’s tot en met laptop- en desktopcomputers, en dus bevat
het een subset van de mogelĳkheden die zĳn opgenomen in SVG 1.1 Full, naast de nieuwe mogelĳkheden om
de mogelĳkheden van SVG uit te breiden.
Sommige mogelĳkheden, die niet zĳn opgenomen in deze specificaties, zouden misschien niet correct worden
gerenderd in QGIS.
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Symbolen Lijn

Toepasselĳk voor geometrieobjecten lĳn hebben lĳnsymbolen de volgende typen symboollagen:
• Doorgetrokken lĳn (standaard)

Fig. 14.12: Een symbool Doorgetrokken lijn ontwerpen

Het symboollaagtype Doorgetrokken lĳn heeft veel dezelfde eigenschappen als het standaard
markeringssymbool, en, in aanvulling daarop:

– Gebruik aangepast lĳnpatroon: overschrĳft de instelling Lĳnstĳl door een aangepast streepje. U zou de
lengte van opvolgende streepjes en witruimte moeten definiëren om het model te vormen, in de gekozen
eenheid. De totale lengte van het patroon wordt weergegeven aan de onderzĳde van het dialoogvenster.

– Verschuiving patroon: de plaatsing van de streepjes/gaten in de lĳn kunnen worden aangepast, zodat zĳ
op betere posities kunnen worden geplaatst om rekening te houden met hoeken in de lĳn (kan potentieel
ook worden gebruikt om aanliggende grenzen van het streepjespatroon) “uit te lĳnen”

– Streepjespatroon uitlĳnen op lĳnlengte: de lengte van het streepjespatroon zal worden aangepast, zodat
de lĳn zal eindigen met een volledig element streepje, in plaats van met een gat.
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– Streepjespatroon op scherpe hoeken aanpassen: pas de plaatsing van het streepjespatroon dynamisch
aan, zodat scherpe hoeken worden weergegeven door een volledig element streepje dat in en uit de scherpe
hoek komt. Afhankelĳk van Streepjespatroon uitlĳnen op lĳnlengte.

– Lĳnen afbreken vanaf Start en/of Einde: maakt het mogelĳk voor het renderen van de lĳn om de eerste x
mm en de laatste y mm te verwĳderen van de feitelĳke lĳn bĳ het tekenen van die lĳn. Het ondersteunt
een bereik aan eenheden, inclusief een percentage van de totale lengte van de lĳn, en kan worden data-
bepaald voor extra beheer. De afstand voor start/einde kan bĳvoorbeeld worden gebruikt bĳ het maken
van complexe symbolen waar een lĳnlaag het markeringssymbool dat is geplaatst aan het begin of einde
van de lĳn niet zou moeten overlappen.

• Pĳl: tekent lĳnen als gebogen (of niet) pĳlen met een enkele of dubbele kop met te configureren (en data te
bepalen):

– Type pĳlkop

– Type pĳl

– Breedte pĳl

– Breedte pĳl aan begin

– Lengte kop

– Dikte kop

– Verspringing

Het is mogelĳk om te kiezen voor Gebogen pĳlen (het object Lĳn moet minstens drie punten hebben) en
Pĳl op elk segment herhalen. Het gebruikt ook een symbool voor de vulling, zoals kleurverlopen of shapeburst
om het lichaam van de pĳl te renderen. Gecombineerd met de geometrie-generator helpt dit type laagsymbool
u om stroomkaarten weer te geven.

• Geometrie-generator (bekĳk De Geometrie-generator)
• Geïnterpoleerde lĳn: maakt het mogelĳk een lĳn te renderen waarvan Lĳndikte en/of Kleur constant kunnen
zĳn (gegeven de parameters Vaste breedte en Enkele kleur ) of variëren langs de geometrie. Bĳ het variëren zĳn
de noodzakelĳke invoer:

– Startwaarde en Eindwaarde: Waarden die zullen worden gebruikt voor interpoleren aan de uiteinden van
de geometrie van de objecten. Zĳ mogen vaste waarden zĳn, attributen van objecten of gebaseerd op een
expressie.

– Min. waarde en Max. waarde: Waarden waartussen het interpoleren zal worden uitgevoerd. Druk op de
knop Vernieuwen om ze automatisch te vullen, gebaseerd op de minimum en maximum waarden voor
start/einde die zĳn toegepast op de laag.

– Alleen beschikbaar voor de optie Lĳn:
∗ Min. breedte en Max. breedte: definiëren het bereik van de variërende breedte. Min. breedte is
toegewezen aan de Min. waarde en Max. breedte aan de Max. waarde. Een eenheid kan worden
toegewezen.

∗ Absolute waarde gebruiken: alleen absolute waarden gebruiken voor interpoleren (negatieve
waarden worden gebruikt als positieve).

∗ Buiten het bereik negeren: standaard, als het bereik [startwaarde - eindwaarde] van
een object niet is opgenomen in het bereik [min. waarde - max. waarde], worden de
delen van de geometrie van het object die buiten het bereik liggen gerenderd met de minimale of
maximale breedte. Selecteer deze optie om ze helemaal niet te redeneren.

– Voor variërende kleuren kunt u elk van de methoden voor interpolatie van classificeren van kleurverloop
gebruiken
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Fig. 14.13: Voorbeelden van geïnterpoleerde lijnen

• Symbolenlĳn: herhaalt een markeringssymbool over de lengte van een lĳn.
– De Plaatsing markering kan worden ingesteld met een instelling voor een regelmatige interval (beginnend
bĳ het eerste punt) en/of de eigenschap van de geometrie lĳn (op eerste of laatste punt, binnenste punten,
het centrale punt van de lĳn of van elk segment, of op elk punt van een boog).

– Als plaatsing op het eerste of laatste punt is ingeschakeld, zal de optie Plaatsen op uiteinde van elk deel
er voor zorgen dat de markeringen ook renderen op het eerste of laatste punt voor elk deel van meerdelige
geometrieën.

– Verspringen volgens lĳn: de plaatsing van de markeringen kan ook een verschuiving langs de lĳn worden
gegeven, in de ref:eenheid <unit_selector> van uw keuze (millimeters, punten, kaarteenheden, meters op
schaal, percentage, …):
∗ Een positieve waarde verschuift de symbolen voor de markering in de richting van de lĳn (met
plaatsingen Op eerste punt en Met interval) en achterwaarts (met plaatsing Op laatste punt).

∗ Een negatieve waarde op een niet gesloten lĳn zal niet resulteren in een verschuiving (voor plaatsingen
Op eerste punt en Op laatste punt) of achterwaartse verschuiving van de symbolen (vanaf het laatste
punt).

∗ Met een gesloten ring behandelt QGIS de verschuiving als doorlopend langs de ring (voorwaarts of
achterwaarts). Bĳv. instellen van de verschuiving op 150% (resp. -10% of -110%) resulteert erin dat
de verschuiving wordt behandeld als 50% (resp. 90%) van de lengte van de gesloten ring.

– De optie Markering draaien zodat die de lĳnrichting volgt stelt in of elk markeringssymbool zou
moeten worden georiënteerd, relatief ten opzichte van de richting van de lĳn of niet.
Omdat een lĳn vaak een opeenvolging is van segmenten van verschillende richtingen, wordt het draaien
van de markering berekend door het middelen van een gespecificeerde afstand langs de lĳn. Instellen
van, bĳvoorbeeld, de eigenschap Gemiddelde hoek over op 4mm betekent dat de twee punten langs de
lĳn, die 2mm vóór en achter de plaatsing van het symbool liggen, worden gebruikt om de hoek voor de
lĳn te berekenen voor dat markeringssymbool. Dit heeft het effect van glad maken (of verwĳderen) van
enkele kleine lokale afwĳkingen van de algehele richting van de lĳn, wat resulteert in veel nettere visuele
oriëntaties van de symbolen van de markeringslĳn.

– Lĳn verspringing: de markeringssymbolen kunnen ook worden verschoven van het object lĳn.
• Gestreepte lĳn: herhaalt een lĳnsegment (een streep) over de lengte van een lĳnsymbool, met een lĳn
subsymbool dat wordt gebruikt voor het renderen van elk individueel segment. Met andere woorden, een
gestreepte lĳn lĳkt op een markeringslĳn waarin markeringssymbolen zĳn vervangen door segmenten. Als
zodanig hebben de gestreepte lĳnen dezelfde eigenschappen als symbolen voor markeringslĳnen, naast:

– Lengte van streepjes

– Rotatie van streepjes
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Fig. 14.14: Voorbeeld van gestreepte lijnen

• Rasterlĳn: rendert en herhaalt een rasterafbeelding die de vorm van de lengte van een object lĳn volgt. De
Lĳndikte, Verspringing, Verbindingsstĳl, Eindstĳl en Opaciteit kunnen worden aangepast.

Fig. 14.15: Voorbeelden van rasterlijnen

• Lineburst: rendert een kleurverloop langs de breedte van een lĳn. U kunt kiezen tussen Twee kleuren of
Kleurverloop en de Lĳndikte, Verspringing, Verbindingsstĳl, Eindstĳl kunnen worden aangepast.
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Fig. 14.16: Voorbeelden van lineburstlijnen

Standaard vulling

Toepasselĳk voor geometrieobjecten polygoon hebben standaard vullingen ook verscheidene symboollaagtypen:
• Standaard vulling (standaard): vult een polygoon met een uniforme kleur
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Fig. 14.17: Een symbool Standaard vulling ontwerpen

• Zwaartepuntvulling: plaatst een markeringssymbool op het zwaartepunt van het zichtbare object. De positie
van de markering mag niet het echte zwaartepunt van het object zĳn, omdat de berekening rekening houdt met
de polygo(o)n(en) die zĳn geclipt tot het zichtbare gebied in het kaartvenster voor renderen en gaten negeert.
Gebruik het symbool geometrie-generator als u het exacte zwaartepunt wilt.
U kunt:

– Plaatsen van markeringen binnen polygonen forceren

– Markeringen tekenen op elk deel van een object met meerdere delen of plaats het punt alleen op zĳn grootste
deel

– geef de markeringssymbo(o)l(en) in zĳn geheel of gedeeltelĳk weer, behoud delen die de geometrie van
het huidige object overlappen (Markeringen clippen naar grenzen polygoon) of het gedeelte geometrie van
het symbool behoort tot (Markeringen alleen clippen naar huidige deel van polygoon)

• Geometrie-generator (bekĳk De Geometrie-generator)
• Geleidelĳke vulling: gebruikt een radiaal, lineair of conisch kleurverloop, gebaseerd op ofwel eenvoudige
tweekleurige kleurverlopen of een vooraf gedefinieerd kleurverloop om polygonen te vullen. Het kleurverloop
kan worden gedraaid en toegepast op basis van één enkel object of over het gehele kaartbereik. Ook kunnen
begin- en eindpunten worden ingesteld via coördinaten of met het zwaartepunt (van object of kaart). Een data-
bepaalde verschuiving lan worden gedefinieerd.

• Lĳnpatroonvulling: vult de polygoon met een gearceerd patroon van lĳnsymboollagen. U kunt instellen:
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– Uitlĳning: definieert hoe het patroon is gepositioneerd, relatief ten opzichte van de/het object(en):
∗ Patroon uitlĳnen op objecten: lĳnen worden gerenderd in elk object
∗ Patroon uitlĳnen op kaartbereik: een patroon wordt gerenderd over het gehele kaartbereik, wat het
mogelĳk maakt lĳnen netjes uit te lĳnen in objecten

– Rotatie: van de lĳnen, tegen de wĳzers van de klok in
– Tussenruimte: afstand tussen opeenvolgende lĳnen
– Verspringing: afstand van de lĳnen vanaf de grens van het object
– Clippen: maakt het mogelĳk te beheren hoe lĳnen in de vulling zouden moeten worden geclipt naar de
vorm van de polygoon. Opties zĳn:
∗ Alleen clippen tĳden renderen: lĳnen worden gemaakt die het gehele begrenzingsvak van het object
bedekken en dan geclipt bĳ het tekenen. Uiteinden van de lĳn (begin en einde) zullen niet zichtbaar
zĳn.

∗ Lĳnen clippen vóór renderen: lĳnen worden geclipt naar de exacte vorm van de polygoon
voorafgaande aan het renderen. Uiteinden van de lĳn (inclusief eindstĳlen, objecten voor start/einde
vanmarkeringslĳnen,…) zullen zichtbaar zĳn, en zouden soms tot buiten de polygoon kunnen reiken
(afhankelĳk van de instellingen voor de symbolen van de lĳn).

∗ Niet clippen: er wordt helemaal niet geclipt - lĳnen zullen het gehele begrenzingsvak van het object
bedekken

• Puntpatroonvulling: vult de polygoon met een rasterpatroon van markeringssymbolen. U kunt instellen:
– Uitlĳning: definieert hoe het patroon is gepositioneerd, relatief ten opzichte van de/het object(en):

∗ Patroon uitlĳnen op objecten: markeringslĳnen worden gerenderd in elk object
∗ Patroon uitlĳnen op kaartbereik: een patroon wordt gerenderd over het gehele kaartbereik, wat het
mogelĳk maakt markeringen netjes uit te lĳnen in objecten

Fig. 14.18: Uitlijnen van puntpatroon op object (links) en op kaartbereik (rechts)

– Afstand: afstanden Horizontaal en Verticaal tussen opeenvolgende markeringen
– Verplaatsing: een verschuiving Horizontaal (resp. Verticaal) van de uitlĳning tussen opeenvolgende
markeringen in een kolom (resp. in een rĳ)

– Verspringing: afstanden Horizontaal en Verticaal vanaf de grens van het object
– Clippen: maakt het mogelĳk te beheren hoe markeringen in de vulling zouden moeten worden geclipt
naar de vorm van de polygoon. Opties zĳn:
∗ Naar vorm clippen: markeringen worden geclipt zodat alleen de gedeelten binnen de polygoon
zichtbaar zĳn
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∗ Middelpunt in vorm markeren: alleen markeringen waar het middelpunt van de markering binnen de
polygoon valt worden getekend, maar deze markeringen worden niet buiten de polygoon geclipt

∗ Binnen vorm volledig markeren: alleen markeringen die volledig binnen de polygoon liggen worden
weergegeven

∗ Niet clippen: elke markering die enigszins kruist met de polygoon zal volledig worden gerenderd
(strikt gesproken is het “kruist met het begrenzingsvak van de markering”)

Fig. 14.19: Markeringen in vulling clippen - Van links naar rechts: Naar vorm clippen, Middelpunt in vormmarkeren,
Binnen vorm volledig markeren, Niet clippen

– Rotatie van het gehele patroon, met de wĳzers van de klok mee
– De instelling van de groep Willekeurig patroon maakt het mogelĳk elk punt in de vulling van een
puntpatroon willekeurig wordt verschoven tot de gespecificeerde maximale afstand Horizontaal of
Verticaal. U kunt de maximale verschuiving specificeren in elke ondersteunde eenheid, zoals millimeters,
punten, kaarteenheden, of zelfs een “percentage” (waar percentage relatief is ten opzichte van de breedte
of hoogte van het patroon).
U kunt een optioneel willekeurig aantal zaad instellen om te vermĳden dat de patronen van de symbolen
“rondspringen” bĳ het vernieuwen van de kaart. Data-bepaalde instellingen worden ook ondersteund.

Notitie: Het belangrĳkste verschil tussen Willekeurig patroon en het symbooltype willekeurige vulling
markeringen is dat de willekeurige verschuiving met een puntpatroon de quasi-“normale” plaatsing van
markeringen mogelĳk maakt – omdat de punten in het patroon effectief worden beperkt tot een raster, dit
maakt het mogelĳk semi-willekeurige vullingen te maken die geen lege gebieden hebben of overlappende
markeringen. (Tegengesteld aan de willekeurige vulling voor markeringen die altĳd punten volledig
willekeurig plaatst… wat soms resulteert in visuele clusters van punten of ongewenste lege gebieden).

• Vulling willekeurige markering: vult de polygoon met een markeringssymbool geplaatst op willekeurige
locaties binnen de grenzen van de polygoon. U kunt instellen:

– Methode voor tellen: of het aantal te renderen markeringssymbolen moet worden beschouwd als een
absoluut aantal of moet worden gebaseerd op dichtheid

– Aantal punten: het aantal te renderen markeringssymbolen,
– een optioneel willekeurig aantal zaad, om consistente plaatsing te geven
– Dichtheidsgebied: in het geval van op dichtheid gebaseerde methode voor tellen, zorgt ervoor dat de
dichtheid van markeringen hetzelfde blĳft op verschillende schaal- / zoomniveaus van markeringen als
kaarten worden vernieuwd (maakt ook willekeurige plaatsing mogelĳk om netjes te werken met QGIS
Server en op tegel gebaseerd renderen)

– Markeringen clippen op grens polygoon: of markeringen die worden gerenderd nabĳ de randen van
polygonen tot de grenzen van de polygoon zouden moeten worden geclipt of niet
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• Rasterafbeeldingvulling: vult de polygoon met tegels uit een rasterafbeelding (PNG JPG, BMP …). De
afbeelding mag een bestand op schĳf zĳn, een URL op afstand of een ingebed bestand, gecodeerd als een
tekenreeks (meer details). Opties omvatten (data-bepaalde) opaciteit, breedte afbeelding, modus Coördinaat
(object of kaartvenster), rotatie en verspringing. De breedte van de afbeelding kan worden ingesteld met elk
van de algemene eenheden of een percentage van de originele grootte.

• SVG-vulling: vult de polygoon met SVG-markeringen van een bepaalde grootte (Textuur breedte).
• Shapeburst-vulling: buffert een vulling van een kleurverloop, waar een kleurverloop wordt getekend vanaf
de grens van een polygoon naar het midden van de polygoon. Parameters die kunnen worden geconfigureerd
omvatten afstand vanaf de grens die moet worden geschaduwd, gebruiken van kleurverlopen of eenvoudige
tweekleurige verlopen, optioneel vervagen van de vulling en verschuivingen.

• Rand: Pĳl: gebruikt een lĳn pĳl symbool-laag om de rand van de polygoon weer te geven. De instellingen voor
de p[ĳl van de rand zĳn hetzelfde als die voor pĳl-lĳnsymbolen.

• Rand: Gestreepte lĳn: gebruikt een streepjes-lĳnsymbool-laag om de rand van de polygoon (Ringen) weer te
geven, wat kan zĳn alleen de binnenste ringen, alleen de buitenste ring of alle ringen). De andere instellingen
voor de Rand: Gestreepte lĳn zĳn hetzelfde als voor de gestreepte lĳnsymbolen.

• Rand: Markeringslĳn: gebruikt een markerings-lĳnsymbool-laag om de rand van de polygoon (Ringen) weer
te geven, wat kan zĳn alleen de binnenste ringen, alleen de buitenste ring of alle ringen). De andere instellingen
voor de Rand: Markeringslĳn zĳn hetzelfde als voor de markerings-lĳnsymbolen.

• Rand: Doorgetrokken lĳn: gebruikt een doorgetrokken-lĳnsymbool-laag om de rand van de polygoon (Ringen)
weer te geven, wat kan zĳn alleen de binnenste ringen, alleen de buitenste ring of alle ringen). De optie Teken
lĳn alleen binnen polygonen geeft de randen van de polygoon binnen de polygoon weer en kan nuttig zĳn om
aanliggende randen van polygonen helder weer te geven. De andere instellingen voor de Rand: Doorgetrokken
lĳn zĳn hetzelfde als voor de doorgetrokken-lĳnsymbolen.

Notitie: Als het type geometrie polygoon is, kunt u er voor kiezen om het automatisch clippen van lĳnen/polygonen
tot het kaartbereik uit te schakelen. In sommige gevallen resulteert dit clippen tot ongewenste symbologie (bĳv.
vullingen centroïde waarbĳ de centroïde altĳd het feitelĳke zwaartepunt van het object moet zĳn).

SVG met parameters

U heeft de mogelĳkheid om de kleuren te wĳzigen van een SVG-markering. U moet dan de plaatsvervangers
param(fill) voor de vulkleur, param(outline) voor de lĳnkleur en param(outline-width) voor
lĳndikte toevoegen. Deze plaatsvervangers kunnen optioneel worden gevolgd door een standaardwaarde, bĳv.:

<svg width="100%" height="100%">
<rect fill="param(fill) #ff0000" stroke="param(outline) #00ff00" stroke-width=
↪→"param(outline-width) 10" width="100" height="100">
</rect>
</svg>

Meer in het algemeen, SVG kan vrĳelĳk worden voorzien van parameters met param(param_name). Deze
parameter kan ofwel worden gebruikt als een attribuutwaarde of tekst voor een knoop:

<g stroke-width=".265" text-anchor="middle" alignment-baseline="param(align)">
<text x="98" y="147.5" font-size="6px">param(text1)</text>
<text x="98" y="156.3" font-size="4.5px">param(text2)</text>

</g>

De parameters kunnen dan worden gedefinieerd als expressies in de tabel Dynamische parameters SVG.
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Fig. 14.20: Tabel Dynamische parameters SVG

De Geometrie-generator

Beschikbaar voor alle typen symbolen, de geometrie-generator symboollaag maakt het mogelĳk de syntaxis voor
expressies te gebruiken om direct een geometrie te maken gedurende het proces van renderen. De resulterende
geometrie hoeft niet overeen te komenmet het origineleType geometrie en umag verscheidene verschillend aangepaste
symboollagen op elkaar leggen.
Een eigenschap Eenheden kan worden ingesteld: wanneer het geometrie-generatorsymbool niet wordt toegepast op
een laag (bĳv. het wordt gebruikt op een lay-out-item), dit geeft meer controle over de gemaakte uitvoer.
Enkele voorbeelden:

-- render the centroid of a feature
centroid( $geometry )

-- visually overlap features within a 100 map units distance from a point
-- feature, i.e generate a 100m buffer around the point
buffer( $geometry, 100 )

-- Given polygon layer1( id1, layer2_id, ...) and layer2( id2, fieldn...)
-- render layer1 with a line joining centroids of both where layer2_id = id2
make_line( centroid( $geometry ),

centroid( geometry( get_feature( 'layer2', 'id2', attribute(
$currentfeature, 'layer2_id') ) )

)

-- Create a nice radial effect of points surrounding the central feature
-- point when used as a MultiPoint geometry generator
collect_geometries(

array_foreach(
generate_series( 0, 330, 30 ),

project( $geometry, .2, radians( @element ) )
)

)
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De markering Vectorveld

DeMarkering vectorveld wordt gebruikt om gegevens uit vectorvelden weer te geven, zoals vervorming van de aarde,
getĳdenstromen, enzovoort. Het geeft de vectors weer als lĳnen (bĳ voorkeur pĳlen) die worden geschaald en in
richting geplaatst, overeenkomstig geselecteerde attributen van gegevenspunten. Het kan alleen worden gebruikt om
puntgegevens te renderen; lĳn en polygoonlagen worden bĳ deze symbologie niet getekend.
Het vectorveld wordt gedefinieerd door attributen in de gegevens, die het veld kunnen weergeven als:

• Cartesiaanse componenten (X- en Y-componenten van het veld)
• of polaire coördinaten: in dit geval definiëren attributen Lengte en Hoek. De hoek kan worden gemeten
ofwel met de wĳzers van de klok mee vanuit het noorden, of tegen de wĳzers van de klok in vanuit het oosten,
en mogen in radialen of graden zĳn.

• of als gegevens Alleen hoogte, die een verticale pĳl weergeven, geschaald met behulp van een attribuut van de
gegevens. Dit is bĳvoorbeeld toepasbaar voor het weergeven van de verticale component van vervorming.

De grootte van het veld kan omhoog of omlaag worden geschaald tot een toepasselĳke grootte voor het bekĳken van
het veld.

14.3 Een label instellen

Labels zĳn tekstinformatie die u kunt weergeven op vectorobjecten. Zĳ voegen details toe die u niet
noodzakelĳkerwĳze zou kunnen weergeven met symbolen. Twee typen tekst-gerelateerde items zĳn beschikbaar in
QGIS:

• Tekstindeling: definieert het uiterlĳk van de tekst, inclusief lettertype, grootte, kleuren, schaduw, achtergrond,
buffer, …
Zĳ kunnen worden gebruikt om tekst te renderen over de kaart (titel lay-out/kaart, decoraties, schaalbalk, …),
gewoonlĳk met de widget lettertype.
Een item Tekstindeling maken:

1. Open het dialoogvenster Stĳlmanager

2. De tab Tekstindeling activeren

Fig. 14.21: Tekst opmaken in het dialoogvenster Stijlmanager
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3. Druk op de knop Item toevoegen. Het dialoogvenster Instellingen tekst opent om te configureren. Zoals
gewoonlĳk zĳn deze eigenschappen data te bepalen.

• Instellingen label: breidt de instellingen voor tekstindeling uit met eigenschappen die zĳn gerelateerd aan de
locatie of de interactie met andere teksten of objecten (tekstballonnen, plaatsing, overleg, zichtbaarheid schaal,
masker …).
Zĳ kunnen worden gebruikt om slim labelen voor vectorlagen te configureren via de tab Labels van het
dialoogvenster vector Laag-eigenschappen of het paneel Laag opmaken of door de knop Laag-label opties op
de werkbalk Label.
Een item Instellingen label maken:

1. Open het dialoogvenster Stĳlmanager

2. Activeer de tab Instellingen label.

Fig. 14.22: Instellingen label in het dialoogvenster Stijlmanager

3. Druk op het menu Item toevoegen en selecteer het item dat overeenkomt met het type geometrie van de
objecten die u wilt labelen.

Het dialoogvenster Instellingen label opent met de volgende eigenschappen. Zoals gewoonlĳk zĳn deze
eigenschappen data te bepalen.

14.3.1 De tekst van het label opmaken

Of u nu een item Tekstindeling of Labelinstellingen configureert, u zult de volgende opties krĳgen aangeboden:

Tab Eigenschappen Tekstindeling Labelinstellingen

Tekst

Opmaak

Buffer

Masker

Achtergrond
Vervolgt op volgende pagina
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Tabel 14.1 – Vervolgd van vorige pagina
Tab Eigenschappen Tekstindeling Labelinstellingen

Schaduw

Tekstballon

Plaatsing

Renderen

Tab Tekst

Fig. 14.23: Instellingen label - tab Tekst

Op de tab Tekst kunt u instellen:
• het Lettertype, vanuit een van de beschikbare op uw machine
• de Stĳl: naast de algemene stĳlen van het lettertype kunt u instellen of de tekst zou moeten worden onderstreept
of doorgehaald

• de Grootte in een ondersteunde eenheid

• de Kleur
• de Doorzichtbaarheid
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• enHTML-opmaak toestaan: De optie voor opmaak vanHTML schakelt het correct renderen van enkele HTML-
tags in om het label aan te passen. De ondersteunde tags voor HTML zĳn:

– Kleur, toepasbaar voor tekst, onderstrepen, doorhalen en overstrepen
– Eigenschappen lettertype (familie lettertype, grootte lettertype, vet en cursief)

Voor het gebruiken van de opmaak in HTML dient u de code voor HTML op te geven in het veldWaarde. De
expressie wordt geparset en elke ondersteunde tag voor HTML overschrĳft zĳn overeenkomstige instelling in
de eigenschappen voor labels. Zĳ combineren ook primamet andere eigenschappen voor achtergrond, schaduw,
buffer… van labels.
Hieronder een voorbeeld van op HTML gebaseerde expressie en rendering (past verschillende kleuren en
onderstrepen toe op hetzelfde label):

format(
'<span style="color:blue">%1</span> ( <span style="color:red"><u>%2 ft</u></

↪→span> )',
title( lower( "Name" ) ),
round($length)

)

Fig. 14.24: Labelen met opmaak voor HTML ingeschakeld

Aan de onderzĳde van de tab geeft een widget een te filteren lĳst weer van compatibele items die zĳn opgeslagen in
uw database van de Stĳlmanager. Dit stelt u in staat gemakkelĳk de huidige tekstindeling of instelling label, gebaseerd
op een bestaande, te configureren en ook om een nieuw item op te slaan in de stĳldatabase: Druk op de knop Indeling
opslaan… of Instellingen opslaan… en geef een naam en tag(s) op.

Notitie: Bĳ het configureren van een item Instellingen label, zĳn items tekstindeling ook beschikbaar in dit widget.
Selecteer er een om snel de huidige teksteigenschappen van het label te overschrĳven. Op dezelfde wĳze kunt u van
daaruit een tekstindeling maken/overschrĳven.
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Tab Opmaak

Fig. 14.25: Instellingen label - tab Opmaak

Op de tab Opmaak kunt u:
• De optie Hoofd- of kleine letters gebruiken om de stĳl voor hoofdletters van de tekst te wĳzigen. U heeft de
mogelĳkheden om de tekst te renderen als:

– Geen veranderingen

– Alles in hoofdletters

– Alles in kleine letters

– Elk woord begint met een hoofdletter: past de eerste letter van elk woord aan naar een hoofdletter, en
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schakelt de andere letters naar kleine letters als de originele tekst één enkel type hoofd- of kleine letters
gebruikt. In gevallen van gemixte hoofd- en kleine letters in de tekst, blĳven de andere letters ongewĳzigd.

– Eerste letter forceren als hoofdletter: past de eerste letter van elk woord aan naar een hoofdletter en laat
de andere letters in de tekst ongewĳzigd.

• Onder Tussenruimte, wĳzig de tussenruimte tussen woorden en tussen individuele letters.
• Stretch ratio: maakt het mogelĳk tekst horizontaal uit te rekken of te verkleinen met een factor. Handig voor
het aanpassen van de breedte van de lettertypen om een beetje extra tekst in labels te krĳgen.

• Kerning inschakelen voor het lettertype van de tekst
• Instellen van de Oriëntatie tekst die Horizontaal of Verticaal kan zĳn. Het kan ook Op rotatie gebaseerd zĳn bĳ
het instellen van een label (bĳv. om lĳnobjecten in de modus voor plaatsing parallel juist te labelen).

• De optie Meng-modus gebruiken om te bepalen hoe uw labels zullen mixen met de kaartobjecten onder hen
(meer details op Meng-modi).

• De optie Vervangingen voor tekst van labels toepassen stelt u in staat een lĳst met teksten te specificeren om
teksten in labels van objecten te vervangen (bĳv. afkortingen voor typen straten). Vervangende teksten worden
gebruikt bĳ het weergeven van labels op de kaart. Gebruikers kunnen ook lĳsten met vervangingen exporteren
en importeren om hergebruik en delen gemakkelĳker te maken.

• Meerdere tekstregels configureren:
– Een teken instellen, dat een regeleinde in de tekst zal forceren, met de optie Afbrekingsteken
– Een ideale regelgrootte instellen, om te gebruiken met automatisch doorlopen, met de optie Regels door

laten lopen. De grootte kan ofwel de Maximum regellengte of de Minimum regellengte weergeven.
– Bepaal de Tekstregel hoogte: waarden kunnen worden ingesteld in Millimeters, Punten, Pixels, Percentage
of Inches. Als de hoogte voor de tekstregel is ingesteld op Percentage is dat het percentage van de
standaard afstand voor de tekstregel voor dat lettertype. Gewoonlĳk 1,2 tot en met 1,5 maal de grootte
van de tekst.

– Opmaken van de Uitlĳning: typische beschikbare waarden zĳn Links, Rechts, Uitvullen en Centreren.
Bĳ het instellen van eigenschappen voor labels van punten kan de uitlĳning van de tekst ook zĳn Plaatsing
van label volgen. In dat geval zal de uitlĳning afhangen van de uiteindelĳke plaatsing van het label, relatief
ten opzichte van het punt. Bĳv. als het label links van het punt is geplaatst, dan zal het label rechts uitgelĳnd
zĳn, terwĳl, als het aan de rechterkant is geplaatst, het links uitgelĳnd zal zĳn.

Notitie: De opmaak Meerdere lĳnen wordt nog niet ondersteund door op bogen gebaseerde plaatsing van
labels. De opties zullen dan worden gedeactiveerd.

• Voor lĳnlabels kunt u opnemen Richtingssymbool lĳn om te helpen bĳ het bepalen van de richtingen van lĳnen,
met te gebruiken symbolen die Links of Rechts aangeven. Zĳ werken in het bĳzonder goed als zĳ worden
gebruikt met de opties voor de plaatsing Gebogen of Parallel van de tab Plaatsing. Er zĳn opties om de positie
van de symbolen in te stellen, en voor Omgekeerde richting.

• Gebruik de optie Opgemaakte getallen om numerieke teksten op te maken. U kunt het aantal Decimale

plaatsen instellen. Standaard zullen 3 decimale plaatsen worden gebruikt. Gebruik Plusteken weergeven als
u het plusteken voor positieve getallen wilt laten zien.
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Tab Buffer

Fig. 14.26: Instellingen label - tab Buffer

Activeer, om een buffer rondom het label te maken, het keuzevak Teken tekstbuffer op de tab Buffer. Dan
kunt u:

• De Grootte van de buffer instellen in een ondersteunde eenheid

• De Kleur van de buffer selecteren

• Vulkleur buffer: De buffer wordt vergroot vanuit de omtrek van het label, dus, als de optie is geactiveerd,
wordt het interieur van het label gevuld. Dit kan relevant zĳn bĳ het gebruiken van gedeeltelĳk transparante
labels of met niet-normale meng-modi, die het mogelĳk zullen maken achter de tekst van het label te kĳken.
Deselecteren van de optie (terwĳl volledig transparante labels worden gebruikt) zal het u mogelĳk maken
tekstlabels met omtrek te maken.

• Definiëren van de Doorzichtbaarheid van de buffer
• Een Pen verbindingsstĳl toe te passen: het kan zĳn Rond, Hoekig of Puntig
• De optieMeng-modus gebruiken om te bepalen hoe uw buffers voor de labels zullenmixenmet de componenten
van de kaart onder hen (meer details op Meng-modi).

• Selecteer Tekeneffecten om geavanceerde tekeneffecten toe te voegen voor het verbeteren van de
leesbaarheid van de tekst, bĳv. via Buitenste gloed en Vervagen.
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Tab Achtergrond

De tab Achtergrond stelt u in staat een vorm te configureren die achter elk label staat. Activeer, om een
achtergrond toe te voegen, het keuzevak Teken achtergrond en selecteer het type Vorm. Dat kan zĳn:

• een regelmatige vorm, zoals Rechthoek, Vierkant, Cirkel of Ellips, met de volledige eigenschappen van een
vulsymbool

• een symbool SVG uit een bestand, een URL of ingebed in het project of stĳldatabase (meer details)
• of een Markeringssymbool dat u kunt maken of selecteren uit de symboolbibliotheek.

Fig. 14.27: Instellingen label - tab Achtergrond

Afhankelĳk van de geselecteerde vorm, dient u enkele van de volgende eigenschappen te configureren:
• De Lettergrootte van het frame, wat kan zĳn:

– Vast: dezelfde grootte gebruiken voor alle labels, ongeacht de grootte van de tekst
– of een Buffer over het begrenzingsvak van de tekst

• De Grootte van het frame in de richtingen X en Y, in een ondersteunde eenheid

• Een Rotatie van de achtergrond, tussenMet label synchroiniseren, Op afstand van label en Vast. De laatste twee
vereisen een hoek in graden.

• Een Verspringing X,Y om het item Achtergrond te verschuiven in de richtingen X en/of Y
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• Een Radius X,Y om de hoeken van de vorm van de achtergrond af te ronden (alleen van toepassing voor
rechthoekige en vierkante vormen)

• Een Doorzichtbaarheid van de achtergrond
• Een Meng-modus om de achtergrond te mixen met de andere items bĳ het renderen (zie Meng-modi).
• Voor symbolen SVG kunt u zĳn standaard eigenschappen gebruiken (Laad symbool parameters) of een
aangepaste Vulkleur, Lĳnkleur en Lĳndikte width instellen.

• Tekeneffecten om geavanceerde tekeneffecten toe te voegen voor het verbeteren van de leesbaarheid
van de tekst, bĳv. via Buitenste gloed en Vervagen.

Tab Schaduw

Fig. 14.28: Instellingen label - tab Schaduw

Schakel, om een schaduw aan de tekst toe te voegen, naar de tab Schaduw en activeer Teken valschaduw.
Dan kunt u:

• Geef het item aan dat moet worden gebruikt om de schaduw te maken met Eronder tekenen. Het kan zĳn de
Laagste label component of een bepaalde component, zoals de Tekst zelf, de Buffer of de Achtergrond.

• De Verspringing van de schaduw instellen vanaf het item dat moet worden voorzien van schaduw, d.i.:
– De hoek: met de wĳzers van de klok mee, het is afhankelĳk van de onderliggende oriëntatie van het item
– De afstand van de verschuiving vanaf het item dat moet worden voorzien van schaduw
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– De eenheden van de verschuiving

Als u het keuzevak Gebruik globale schaduw selecteert, dan is het nulpunt van de hoek altĳd gericht op het
noorden en is die niet afhankelĳk van de oriëntatie van het item van het label.

• Beïnvloed het uiterlĳk van de schaduw met de Straal van vervaging. Hoe hoger het getal, des te zachter de
schaduwen, in de eenheden van uw keuze.

• Definiëren van de Doorzichtbaarheid van de schaduw
• Schaal de grootte van de schaduw opnieuw met de factor Schaal
• Kies de Kleur van de schaduw
• De optie Meng-modus gebruiken om te bepalen hoe uw schaduw voor de labels zullen mixen met de
componenten van de kaart onder hen (meer details op Meng-modi).

14.3.2 Interactie met labels configureren

Anders dan de instellingen voor tekstindeling zoals hierbovenweergegeven, kunt u ook instellen hoe labels interacteren
met elkaar of met de objecten.

Tab Masker

De tab Masker stelt u in staat een maskergebied rondom de labels te definiëren. Deze mogelĳkheid is bĳzonder
nuttig wanneer u overlappende symbolen en labels hebt met soortgelĳke kleuren en u de labels zichtbaar wilt maken.

Fig. 14.29: Instellingen Labels - tab Masker (met het tekstvoorbeeld dat een groene achtergrond weergeeft die laat
weten dat een andere laag is uitgesloten)

Maskerende effecten op labels maken:

1. Activeer het keuzevak Masker inschakelen op de tab .
2. Dan kunt u instellen:
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• de Grootte van het masker in ondersteunde eenheden

• de Doorzichtbaarheid van het gebied van het masker rondom het label
• een Pen verbindingsstĳl

• effecten tekenen met het keuzevak Tekeneffecten.

3. Selecteer deze maskervorm als een bron voor het masker op de tab Masker van de eigenschappen van de
overlappende laag (zie Eigenschappen Maskers).

Tab Tekstballonnen

Een veel voorkomende methode bĳ het plaatsen van labels op een drukke kaart is om tekstballonnen te gebruiken
- labels, die zĳn geplaatst buiten (of verplaatst van) hun geassocieerde object, worden geïdentificeerd met een
dynamische lĳn die het label en het object verbindt. Als een van de twee uiteinden (ofwel het label of het object)
wordt verplaatst, wordt de vorm van de verbinding opnieuw berekend.

Fig. 14.30: Labels met verschillende instellingen voor tekstballonnen

Schakel, om een schaduw aan de tekst toe te voegen, naar de tab Tekstballonnen en activeer Tekstballonnen
tekenen. Dan kunt u:

1. De Stĳl van de verbinding selecteren, één van:
• Doorgetrokken lĳnen: een rechte lĳn, het kortste pad
• Manhattan-lĳnen: een onder 90° gebroken lĳn
• Gebogen lĳnen: een gebogen lĳn
• Ballonnen: een tekstballon omringt het label en wĳst naar het object. Het kan afgeronde hoeken hebben.

2. Voor een op een lĳn gebaseerde tekstballon:
1. De Lĳnstĳl selecteren met volledige mogelĳkheden van een symbool lĳn inclusief laageffecten, en data-

bepaalde instellingen
2. Indien gebogen definieert u ook:

• het percentage van Boog van de verbindingslĳn
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• en zĳn Oriëntatie: beginnend vanuit het label naar het object, het kan zĳn Met de klok mee of Tegen
de klok in, of Automatisch (die een optimale oriëntatie voor elk label bepaalt)

3. De Minimumlengte instellen voor lĳnen van tekstballonnen

4. Selecteer of Lĳnen naar alle delen van objecten vanuit het label van het object getekend moeten
worden

5. Een Ankerpunt label instellen: beheert waar de verbindingslĳn aan zou meten sluiten op de tekst van het
label. Beschikbare opties zĳn:
• Dichtstbĳzĳnde punt

• Zwaartepunt

• Vaste positie aan de rand (Linksboven, Boven midden, Rechtsboven, Midden links, Midden rechts,
Linksonder, Beneden midden en Rechtsonder).

6. De optie Verschuiven vanuit gebied van label instellen: beheert de afstand vanaf het ankerpunt van het
label (waar de lĳn van de tekstballon eindigt). Dit vermĳdt het tekenen van lĳnen recht tegen de tekst.

3. Voor een tekstballon moet u instellen:
• de Vullingsstĳl met volledige mogelĳkheden van een symbool vulling inclusief laageffecten, en data-
bepaalde instellingen

• de Radius hoek van de tekstballon
• de Breedte wig: hoe groot de verbinding tussen de tekstballon en de aanwĳzer voor het object zou moeten
zĳn

• de Marges rondom de tekst van het label
4. De optie Verschuiving van object instellen: beheert de afstand vanaf het object (of zĳn ankerpunt, indien een

polygoon) waar lĳnen van tekstballonnen eindigen. Dit vermĳdt bĳvoorbeeld het tekenen van lĳnen recht tegen
de randen van objecten.

5. Het Ankerpunt object instellen voor het (polygoon) object (het eindpunt van de verbindingslĳn). Beschikbare
opties:

• Pool van ontoegankelĳkheid

• Punt op exterieur

• Punt op oppervlak

• Zwaartepunt

6. De Meng-modus instellen: beheert het mengen van de tekstballon.
Onder de groep Data-bepaalde plaatsing kunnen coördinaten van de punten Oorsprong (aan de kant van het label)
en/ofr Doel (aan de kant van het object) van de tekstballon worden beheerd. Tekstballonnen kunnen ook handmatig
worden beheerd met het gereedschap Label, diagram of tekstballon verplaatsen op de werkbalk Labelen. De begin- en
eindpunten van elke tekstballon kunnen op deze manier worden verplaatst. De knopen zouden moeten worden
geaccentueerd als de cursor in de buurt is. Indien nodig kan de Shift-toets ingedrukt worden gehouden bĳ het
verplaatsen. Dat zal het punt snappen op een manier dat de hoek tussen de twee punten van de tekstballon wordt
vergroot met 15 graden.
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Tab Plaatsing

Kies de tab Plaatsing voor het configureren van plaatsing van het label en prioriteit voor het labelen. Onthoud
dat de opties voor de plaatsing verschillen, overeenkomstig het type vectorlaag, namelĳk punt, lĳn of polygoon, en
worden beïnvloed door de globale instelling van PAL.

Plaatsing voor puntlagen

Beschikbare modi voor plaatsen van puntlabels zĳn:
• Cartografisch: puntlabels worden gemaakt met een betere visuele relatie met het puntobject, door regels voor
ideale cartografische plaatsing te volgen. Labels kunnen worden geplaatst:

– op een ingestelde Afstand in ondersteunde eenheden, ofwel vanaf het object punt zelf of vanaf de grenzen
van het gebruikte symbool om het object weer te geven (ingesteld in Verspringing afstand van). De
laatste optie is speciaal nuttig als de grootte van het symbool niet vast is ingesteld, als het bĳvoorbeeld is
ingesteld door een data-bepaalde grootte of bĳ het gebruiken van verschillende symbolen in een renderer
Categorieën.

– door een Prioriteit positie te volgen die kan worden aangepast of worden ingesteld voor een individueel
object met een data-bepaalde lĳst met geprioriteerde posities. Dit maakt het ook mogelĳk dat slechts
bepaalde plaatsingen worden gebruikt, dus bĳvoorbeeld voor kustobjecten kunt u voorkomen dat labels
op het land worden geplaatst.
Standaard worden modi voor cartografisch plaatsen geprioriteerd in de volgende volgorde (volgens de
richtlĳnen van Krygier and Wood (2011) en andere cartografische leerboeken):
1. rechtsboven
2. linksboven
3. rechtsonder
4. linksonder
5. midden rechts
6. midden links
7. boven, ietwat rechts
8. onder, ietwat links.

• Rondom punt: labels worden geplaatst in een cirkel met een gelĳke straal (ingesteld in Afstand) rondom het
object. De prioriteit voor de plaatsing is met de klok mee vanaf “rechtsboven”. De positie kan worden beperkt
met de data-bepaalde optie Kwadrant.

• Op afstand van punt: labels worden geplaatst op een afstand Verschuiving X,Y van het object punt, in
verscheidene eenheden, of met voorkeur boven het object. U kunt een data-bepaald Kwadrant gebruiken om
de plaatsing te beperken en u kunt een Rotatie toewĳzen aan het label.

Plaatsing voor lijnlagen

Modi voor labels voor lĳnlagen omvatten:
• Parallel: tekent het label parallel aan een algemene lĳn die het object weergeeft, met voorkeur voor plaatsing
op rechtere delen van de lĳn. U kunt definiëren:

– Toegestane posities: Boven lĳn, Op lĳn, Onder lĳn en Positieafhankelĳke oriëntatie van lĳn (plaatst het label
aan de linker- of rechterkant van de lĳn). Het is mogelĳk om verscheidene opties in één keer te selecteren.
In dat geval zal QGIS zoeken naar de optimale positie voor het label.

– Afstand tussen het label en de lĳn
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• Gebogen: tekent het label zodat het de buiging van het object lĳn volgt. In aanvulling op de beschikbare
parameters van de modus Parallel, kunt u de Maximale hoek tussen tekens die bocht volgen instellen, ofwel
binnen of buiten.

• Horizontaal: tekent labels horizontaal langs de lengte van het object lĳn.

Fig. 14.31: Voorbeelden plaatsing van labels voor lijnen

Naast de modi voor plaatsing kunt u instellen:
• Labels herhalen Afstand om het label meerdere keren over de lengte van het object weer te geven. De afstand
mag zĳn in Millimeters, Punten, Pixels, Meters op schaal, Kaarteenheden en Inches.

• EenDoorlopen labels Afstand (niet beschikbaar voor modus Horizontaal): specificeert de maximaal toegestane
afstand die aan label aan het einde mag doorlopen (of beginnen) vanaf objecten lĳn. Verhogen van deze waarde
kan het weergeven van labels voor kortere objecten lĳn mogelĳk maken.

• Label verankeren: beheert de plaatsing van de labels langs het object lĳn waartoe zĳ behoren. Klik op
Instellingen … om te kiezen:

– de positie langs de lĳn (als verhouding) waar dichtbĳ labels zullen worden geplaatst. Het mag data-bepaald
zĳn en mogelĳke waarden zĳn:

∗ Midden van lĳn

∗ Begin van lĳn

∗ Einde van lĳn

∗ or Aangepast….
– Clippen: Bepaalt hoe het plaatsen van een label op een lĳn wordt berekend. Standaard wordt alleen het
zichtbare bereik van de lĳn gebruikt, maar het gehele bereik kan worden gebruikt om meer consistente
resultaten te verkrĳgen.

– Tekstanker: beheert welk deel van de tekst (begin, midden of einde) zal worden uitgelĳnd met het
ankerpunt. Gebruiken van verankering Automatisch betekent dat:
∗ Voor labels die worden verankerd aan het begin van de regel (0-25%), zal de plaatsing van het anker
aan het begin van de labeltekst zĳn

∗ Voor labels die worden verankerd aan het einde van de regel (75-100%), zal de plaatsing van het
anker aan het einde van de labeltekst zĳn

∗ Voor labels die worden verankerd aan het midden van de regel (25-75%), zal de plaatsing van het
anker in hetmidden van de labeltekst zĳn

– Gedrag plaatsing: gebruik Hint voor voorkeursplaatsing om het labelanker alleen te beschouwen als een
hint voor het plaatsen van het label. Door Strikt te kiezen worden labels exact op het labelanker geplaatst.
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Plaatsing voor polygoonlagen

U kunt kiezen uit een van de volgende opties voor het plaatsen van labels van polygonen:

Fig. 14.32: Voorbeelden plaatsing van labels voor polygonen

• Rondom zwaartepunt: labels worden geplaatst boven het zwaartepunt van het object of op een vaste afstand
Verschuiving X,Y (in ondersteunde eenheden) vanaf het zwaartepunt. Het zwaartepunt voor de verwĳzing kan
worden bepaald op basis van het gedeelte van de polygoon dat is gerenderd in het kaartvenster (zichtbare
polygoon) of de gehele polygoon, het is niet belang of u het kunt zien. U kunt ook:

– forceren dat het zwaartepunt in hun polygoon ligt
– het label in een specifiek kwadrant plaatsen
– een rotatie toewĳzen
– Plaatsen labels buiten polygonen toestaan als het niet mogelĳk is om ze binnen de polygoon te plaatsen.
Dankzĳ data-bepaalde eigenschappen maakt dit het mogelĳk om ofwel labels buiten, voorkomen dat
labels buiten, of labels buiten forceren te gebruiken op een object-per-object basis.

• Rondom zwaartepunt: plaatst het label op een vooraf ingestelde afstand vanaf het zwaartepunt, met een voorkeur
voor plaatsing direct boven het zwaartepunt. U kunt opnieuw definiëren of het zwaartepunt een van de zichtbare
polygoon of de gehele polygoon is, en of het zwaartepunt binnen de polygoon moet worden geforceerd.

• Horizontaal: plaatst op de beste positie een horizontaal label in de polygoon. De voorkeursplaatsing is verder
van de randen van de polygoon. Het is mogelĳk om Plaatsen labels buiten polygonen toestaan te selecteren.

• Vrĳ (gehoekt): plaatst op de beste positie een geroteerd label in de polygoon. De rotatie respecteert de oriëntatie
van de polygoon en de voorkeursplaatsing is verder van de randen van de polygoon. Het is mogelĳk om Plaatsen
labels buiten polygonen toestaan te selecteren.

• Omtrek gebruiken: tekent het label parallel aan een algemene lĳn die de grens van de polygoon weergeeft, met
voorkeur voor plaatsing op rechtere delen van de omtrek. U kunt definiëren:

– Toegestane posities: Boven lĳn, Op lĳn, Onder lĳn en Positieafhankelĳke oriëntatie van lĳn (plaatst het label
aan de linker- of rechterkant van de grens van de polygoon). Het is mogelĳk om verscheidene opties in
één keer te selecteren. In dat geval zal QGIS zoeken naar de optimale positie voor het label.

– Afstand tussen het label en de omtrek van de polygoon
– Labels herhalen Afstand om het label meerdere keren over de lengte van de omtrek weer te geven.
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• Perimeter (gebogen) gebruiken: tekent het label zodat het de buiging van de grens van de polygoon volgt.In
aanvulling op de beschikbare parameters van de modus Omtrek gebruiken, kunt u de Maximale hoek tussen
tekens die bocht volgen instellen, ofwel binnen of buiten.

• Buiten polygonen: plaatst labels altĳd buiten de polygonen, op een ingestelde Afstand

Algemene instellingen voor plaatsing

Sommige instellingen voor het plaatsen van labels zĳn beschikbaar voor alle typen geometrie voor lagen:

Geometrie-generator

Het gedeelte Geometrie-generator stelt een gebruiker in staat om de onderliggende geometrie, gebruikt om het label
te plaatsen en te renderen, te wĳzigen met expressies. Dit kan nuttig zĳn om verplaatsing van de geometrie dynamisch
uit te voeren of om het te converteren naar een andere geometrie (type).
Om de geometrie-generator te gebruiken:

1. Selecteer de optie Geometrie-generator

2. Voer de expressie in die de geometrie moet maken om op te vertrouwen
3. Indien relevant, selecteer het type geometrie voor de uitvoer van de expressie: de op de geometrie van het

label gebaseerde instellingen, zoals plaatsing of renderen worden bĳgewerkt om overeen te komen met de
mogelĳkheden voor de nieuwe geometrie.

Enkele gebruiksgevallen omvatten:
• Gebruik een geometrie die is opgeslagen in een ander veld “label_position”
• Gebruik de gemaakte geometrie uit de symbologie ook voor labelen
• Gebruik de variabele @map_scale om afstanden /grootten te berekenen die onafhankelĳk zĳn van het
zoomniveau.

• Gecombineerd met de modus voor plaatsing Gebogen, maakt een cirkelvormig label rondom een object punt:

exterior_ring(make_circle($geometry, 20))

• Voeg een label toe aan het begin en het einde van een object lĳn:

collect_geometries( start_point($geometry), end_point($geometry) )

• Vertrouw op een gladde lĳn voor een rivier om meer ruimte te krĳgen voor het plaatsen van labels:

smooth( $geometry, iterations:=30, offset:=0.25, min_length:=10 )

Data-bepaald

De groep Gegevens gedefinieerd verschaft direct beheer over het plaatsen van labels, op een object-per-object basis.
Het rekent op hun attributen of een in te stellen expressie:

• de X- en Y -coördinaten
• de uitlĳning van tekst boven de hierboven ingestelde aangepaste positie:

– Horizontaal: het kan zĳn Links,Midden of Rechts
– de tekst Verticaal: het kan zĳn Onder, Basis, Half, Cap of Boven
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• de Rotatie voor de tekst. Verschillende eenheden kunnen worden gedefinieerd voor de rotatie bĳ labelen (bĳv.
graden, minuten van de boog, draaiingen). Selecteer het item Behoud data rotatie waarden als u de
waarde voor de rotatie in het geassocieerde veld wilt houden en pas het toe op het label, of het label is vastgezet
of niet. Indien niet geselecteerd, wordt bĳ het losmaken de rotatie voor het label hersteld en de waarde ervan
leeggemaakt in de attributentabel.

Notitie: Data-bepaalde rotatie met objecten polygoon wordt momenteel alleen ondersteund met de modus
voor plaatsing Rondom zwaartepunt.

Notitie: Expressies kunnen niet worden gebruikt in combinatie met de kaartgereedschappen voor labels (d.i. de
gereedschappen Label roteren en Label verplaatsen) om plaatsing van labels data te bepalen. De widget zal worden
hersteld naar het overeenkomende veld voor hulpopslag.

Prioriteit

In het gedeelte Prioriteit kunt u de prioriteit voor elk label definiëren, d.i. als er verschillende kandidaatdiagrammen
of -labels voor dezelfde locatie zĳn, zal het item met de hogere prioriteit worden weergegeven en de andere zullen
worden weggelaten.
De prioriteit wordt ook gebruikt om te evalueren of een label zou kunnen worden weggelaten vanwege een groter
gewicht van een object Obstakel.

Obstakels

In sommige contexten (bĳv. labels met hoge dichtheid, overlappende objecten…), zou het plaatsen van labels kunnen
resulteren in labels die worden geplaatst over niet-gerelateerde objecten.
Een obstakel is een object waarover QGIS probeert het plaatsen van labels of diagrammen van andere objecten te
vermĳden. Dit kan worden beheerd in het gedeelte Obstakels:

1. Activeer de optie Objecten optreden als obstakels om te bepalen dat objecten van de laag zouden moeten
optreden als obstakels voor enig label of diagram (inclusief items van andere objecten op dezelfde laag).
In plaats van de gehele laag kunt u een subset van objecten selecteren om als obstakels te gebruiken, met het
besturingselement Data-bepaalde ‘override’ naast de optie.

2. Gebruik de knop Instellingen om het gewicht van het obstakel aan te passen.
• Voor elk potentieel object obstakel kunt u een Gewicht obstakel toewĳzen: elk label of diagram, waarvan
de prioriteit voor de plaatsing groter is dan deze waarde, kan er overheen geplaatst worden. Labels of
diagrammen met een lagere rang zullen worden weggelaten als geen andere plaatsing mogelĳk is.
Dit gewicht mag ook data-bepaald zĳn, zodat, op dezelfde laag, het voor bepaalde objecten meer
waarschĳnlĳker is dat zĳ worden bedekt dan voor andere.

• Voor lagen polygoon kunt u het soort obstakel kiezen dat het object zou kunnen zĳn:
– Over het interieur van het object: vermĳd het plaatsen van labels over het interieur van de polygoon
(voorkeur voor plaatsen van labels totaal buiten of slechts heel weinig binnen de polygoon)

– of Over de begrenzing van het object: vermĳdt plaatsen van labels over de begrenzing van
de polygoon (voorkeur voor plaatsen van labels buiten of volledig binnen de polygoon). Dit kan
bĳvoorbeeld erg nuttig zĳn voor lagen waar objecten een geheel gebied (administratieve eenheden,
categorische bedekkingen, …) bedekken. In dit geval is het onmogelĳk om het plaatsen van labels
binnen deze objecten te vermĳden, en zou het veel beter zĳn om het over de grenzen tussen objecten
te plaatsen te vermĳden.
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Tab Renderen

Op de tab Renderen kunt u afstemmen wanneer de labels moeten worden gerenderd en hun interactie met andere
labels en objecten.

Label opties

Onder Label opties:
• Vindt u de schaalafhankelĳke en de Pixelgrootte instellingen voor de zichtbaarheid.
• De Label Z-index bepaalt de volgorde waarin labels worden gerenderd, als ook in relatie met andere labels van
objecten in de laag (met expressie data-bepaalde ‘override’), als ook met labels van andere lagen. Labels met
een hogere Z-index worden gerenderd bovenop labels (vanuit elke laag) met een lagere Z-index.
Aanvullend is de logica aangepast, zodat wanneer twee labels overeenkomende Z-indexen hebben, dan:

– als zĳ van dezelfde laag zĳn, wordt het kleinere label getekend bovenop het grotere label
– als zĳ van verschillende lagen zĳn, zullen de labels worden getekend in dezelfde volgorde als waarin de
lagen zelf worden getekend (d.i. met respect voor de volgorde die is ingesteld in de legenda van de kaart).

Notitie: Deze instelling zorgt er niet voor dat labels worden getekend onder objecten van andere lagen, het
beheerst slechts de volgorde waarin labels worden getekend bovenop objecten van alle lagen.

• Slechte plaatsing van terugvallen toestaan: Standaard probeert QGIS labels te renderen op hun beste plaatsing,
volgens uw instellingen. Selecteer deze modus om toe te staan dat objecten terugvallen op opties voor minder
beste plaatsing als er geen andere keuze is, bĳv. wanneer een lĳn te kort is om een gebogen labeltekst op te
laten passen, dan zou het label horizontaal mogen worden geplaatst net boven het middelpunt van het object.

• Met data-bepaalde expressies in Label tonen en Toon altĳd kunt u fĳn afstemmen welke labels zouden moeten
worden gerenderd.

• Toestaan van Labels tonen die ondersteboven staan: alternatieven zĳn nooit, wanneer rotatie is gegeven of
altĳd.

• De groep Overlappende labels stelt u in staat te beheren of overlappende labels zĳn toegestaan voor objecten
in de laag en hoe elk van hen zou moeten worden afgehandeld:

– Nooit overlappen: nooit overlappende labels voor de laag plaatsen, zelfs niet als dat betekent dat enkele
labels zullen ontbreken

– Overlappen toestaan indien vereist: als het label niet anders kan worden geplaatst, teken dan een
overlappend label. Deze modus zal er voor zorgen dat het label wordt verplaatst naar een minder ideale
plaatsing, indien mogelĳk, bĳv. het label verder verplaatsen van het midden van een lĳn of polygoon,
ALS het doen daarvan overlappende labels zal vermĳden. Maar als er geen andere posities mogelĳk zĳn,
teken dan een overlappend label.

– Overlappen zonder straf toestaan: Het maakt helemaal niet uit of het label andere labels of obstakels
overlapt, dat mag en de beste plaatsing (bĳvoorbeeld meest centrale plaatsing) zou altĳd moeten worden
gebruikt, zelfs als een alternatieve verdere plaatsing mogelĳk is die overlappen volledig vermĳdt.

Mogelĳk maken van zowel overlappende labels als opties voor terugvallen van plaatsing zullen er voor zorgen
dat alle objecten in de laag worden gelabeld… niet noodzakelĳkerwĳze met hun beste renderen!
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Opties object

Onder Opties object:
• Kunt u kiezen voor Elk deel van een samengesteld object labelen en Stel het maximale aantal te labelen objecten

in op.
• Zowel lagen lĳn als polygoon bieden de optie om een minimale grootte in te stellen voor de te labelen objecten,
met Onderdruk labelen van objecten kleiner dan.

• Voor objecten polygoon kunt u ook de weer te geven labels filteren, afhankelĳk van het feit of zĳ volledig
binnen hun object passen of niet.

• Voor objecten lĳn kunt u kiezen voor Aan elkaar verbonden lĳnen samenvoegen om labelduplicaten te
voorkomen, rendert een nogal luchtige kaart in samenwerking met de opties Afstand of Herhaal op de tab
Plaatsing.

14.4 3D-symbolen maken

De Stĳlmanager helpt u 3D-symbolen maken en opslaan voor elk type geometrie om te renderen in de 3D-
kaartweergave.

Net als met de andere items, schakel naar de tab 3D-symbolen en vergroot het knopmenu om te maken:
• 3D puntsymbool

• 3D lĳnsymbool

• 3D polygoonsymbool
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14.4.1 Puntlagen

Fig. 14.33: Eigenschappen van een 3D puntsymbool

• U kunt verschillende typen 3D Vormen definiëren om te gebruiken voor puntsymbolen. Zĳ worden
voornamelĳk gedefinieerd door hun dimensies waarvan de eenheid verwĳst naar het CRS van het project.
Beschikbare typen zĳn:

– Bol gedefinieerd door een Straal

– Cilinder gedefinieerd door een Straal en Lengte

– Kubus gedefinieerd door een Grootte

– Kegel gedefinieerd door een Bovenste straal, een Onderste straal en een Lengte

– Vlak gedefinieerd door een Grootte

– Torus gedefinieerd door een Straal en een Kleine straal

– 3D-model, gebruikt een 3D-modelbestand: ondersteunde indelingen bevatten wavefront .obj, .glTF
en .fbx. Modellen kunnen alleen een bestand op schĳf zĳn, een URL op afstand URL of ingebed
in het project. Door de gemeenschap gemaakte modellen worden gedeeld op de QGIS Hub op https:
//plugins.qgis.org/wavefronts.

– Aanplakbord, gedefinieerd door de Hoogte aanplakbord en het Symbool aanplakbord (gewoonlĳk
gebaseerd op een markeringssymbool). Het symbool zal een stabiele grootte hebben. Handig voor het
visualiseren van 3D puntenwolken vormen.

• De Hoogte klemmen kan worden ingesteld op Absoluut, Relatief of Terrein. De instelling Absoluut kan
ookworden gebruikt als de waarden voor de hoogte van de 3D-vectors worden opgegeven als absolute metingen
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vanaf 0. Relatief en Terrein voegen opgegeven waarden voor hoogte toe aan de onderliggende hoogte van het
terrein.

• De eigenschappen voor schaduw kunnen worden gedefinieerd.
• In het frame Transformaties kunt u affiene transformatie toepassen op het symbool:

– Vertaling om objecten te verplaatsen langs de X-, Y- en Z-as.
– Schaal om de grootte van 3D-vormen te wĳzigen
– Rotatie rondom de X-, Y- en Z-as.

14.4.2 Lijnlagen

Fig. 14.34: Eigenschappen van een 3D lijnsymbool

• Onder de instellingen Breedte en Hoogte kunt u Vervormen definiëren voor de vectorlĳnen. Als de lĳnen geen
waarden Z hebben, kunt u de 3D-volumes definiëren met deze instelling.

• Met Hoogte klemmen definieert u de positie van de 3D-lĳnen relatief ten opzichte van het onderliggende
oppervlak van het terrein, als u raster hoogtegegevens of andere 3D-vectoren hebt opgenomen.

• Hoogte binden definieert hoe het object wordt geklemd aan het terrein. Ofwel elk Punt van het object zal aan
het terrein worden geklemd of dit zal worden gedaan door de Centroïde.

• Het is mogelĳk om te Renderen als eenvoudige 3D-lĳnen.
• De eigenschappen voor schaduw kunnen worden gedefinieerd.
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14.4.3 Polygoonlagen

Fig. 14.35: Eigenschappen van een 3D polygoonsymbool

• Net als voor de andere kan Hoogte worden gedefinieerd in CRS-eenheden. U kunt ook de knop gebruiken
om de waarde te overschrĳven door een aangepaste expressie, een variabele of een item van de attributentabel

• Opnieuw is Vervormen mogelĳk voor ontbrekende waarden Z. Ook voor het vervormen kunt u de knop
gebruiken om de waarden van de vectorlaag te gebruiken en verschillende resultaten voor elke polygoon te
hebben:
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Fig. 14.36: Data-bepaald vervormen

• Hoogte klemmen en Hoogte binden kunnen worden gedefinieerd zoals hierboven is uitgelegd.
• De Modus Verzamelen om toe te passen op het symbool; het kan zĳn:

– Niet verzamelen: dit kan helpen om kennelĳk ontbrekende oppervlakte, als gegevens van
polygonZ/multipatch geen consistente volgorde van punten hebben (bĳv. allemaal met de wĳzers
van de klok mee of tegen de wĳzers van de klok in), te vermĳden

– Voorzĳde

– of Achterzĳde
• De Gerenderde gevel bepaalt de weer te geven zĳden. Mogelĳke waarden zĳn Geen gevels, Muren, Daken, of

Muren en daken

• Achterzĳden toevoegen: voor elke driehoek, maakt zowel voor- als achterzĳde met correcte normalen -
ten koste van een verhoogd aantal gegevens voor punten. Deze optie kan worden gebruikt om problemen met
schaduw op te lossen (bĳv. vanwege gegevens met inconsistente volgorde van punten).

• Normalen inverteren (experimenteel): kan nuttig zĳn voor het repareren van volgorde met de wĳzers van de
klok mee/tegen de wĳzers van de klok in van punten op zĳden

• De eigenschappen voor schaduw kunnen worden gedefinieerd.

• Weergeven van de Randen van de symbolen kan worden ingeschakeld en een Breedte en Klur. worden
toegewezen

Hint: Combinatie voor beste renderen van 3D-gegevens
Modus Verzamelen, Achterzĳden toevoegen en Normalen inverteren zĳn allemaal bedoeld om het uiterlĳk
van 3D-gegevens te repareren als ze er niet goed uitzien. Gewoonlĳk bĳ het laden van gegevens is
het het beste om eerste te proberen Modus Verzamelen=achterzijde en Achterzijden
toevoegen=uitgeschakeld - het is het meest efficiënte. Als het renderen er niet correct uitziet, probeer
Achterzijde toevoegen=ingeschakeld en houd Modus Verzamelen=Niet verzamelen.
Andere combinaties zĳn meer geavanceerd en alleen nuttig in sommige scenario’s, gebaseerd op hoe gemengd de
gegevensset voor de invoer is.
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14.4.4 Schaduw aanbrengen op de textuur

Schaduw helpt u 3D-details van objecten te onthullen die anders verborgen zouden blĳven vanwege de belichting
van de scene. Ultiem gezien, is het een eenvoudiger materiaal om mee te werken, omdat u zich geen zorgen hoeft te
maken over het instellen van de toepasselĳke belichting voor de scene om objecten te kunnen visualiseren.
Verscheidene technieken voor schaduw worden in QGIS gebruikt en hun beschikbaarheid is afhankelĳk van het type
geometrie van het symbool:

• Realistisch (Phong): beschrĳft de manier waarop een oppervlak licht reflecteert als een combinatie van de
Verspreiden reflectie van ruwe oppervlakkenmet de Spiegelen reflectie van glimmende oppervlakken (Glanzen).
Het omvat ook een optie Omringen om rekening te houden met de kleine hoeveelheid licht dat over de gehele
scene wordt verspreid. Gebruik de schuifbalk Opaciteit om semi-transparente objecten in 3D te renderen. Lees
meer op https://en.wikipedia.org/wiki/Phong_reflection_model#Description

• Realistisch met textuur (Phong): hetzelfde als de Realistisch (Phong), behalve dat een afbeelding wordt gebruikt
als Diffuse textuur. De afbeelding mag een bestand op schĳf zĳn, een URL op afstand of ingebed in het project.
DeTextuur schaal enTextuur rotatie zĳn vereist. Gebruik de schuifbalkOpaciteit om semi-transparente objecten
in 3D te renderen.

• CAD (Gooch): deze techniek maakt het mogelĳk alleen schaduw te laten verschĳnen in middentonen, zodat
lĳnen van randen en accenten visueel prominent blĳven. Naast de opties Verspreiden, Spiegelen, Glanzen, dient
u een kleur Warm (voor oppervlak dat in de richting van het licht ligt) en een kleur Koel (voor die welke de
andere kant opkĳken) op te geven. Ookworden de relatieve bĳdragen aan de kleurenWarm enKoel aan de kleur
Verspreiden beheerd door de respectievelĳke eigenschappen Alfa en Beta. Bekĳk ook https://en.wikipedia.org/
wiki/Gooch_shading

• Ingebedde texturen met 3D-model-vorm

14.4.5 Voorbeeld toepassing

Omdoor de instellingen te gaan zoals die hierboven zĳn uitgelegd kunt u een kĳkje nemen op https://app.merginmaps.
com/projects/saber/luxembourg/tree.
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Databronnen beheren

15.1 Gegevens openen

Als deel van een Open Source Software ecosysteem is QGIS gebouwd met verschillende bibliotheken die,
gecombineerd met zĳn eigen providers, mogelĳkheden bieden tot het lezen en vaak ook schrĳven in veel indelingen:

• Indelingen voor vectorgegevens omvatten onder meer GeoPackage, GML, GeoJSON, GPX, KML, Comma
Separated Values, ESRI indelingen (Shapefile, Geodatabase…), MapInfo en MicroStation bestandsindelingen,
AutoCADDWG/DXF, GRASS en nog veel meer…Lees de complete lĳst met ondersteunde vectorindelingen.

• Indelingen voor rastergegevens omvatten onder meer GeoTIFF, JPEG, ASCII Gridded XYZ, MBTiles, R of
Idrisi rasters, GDAL Virtual, SRTM, Sentinel Data, ERDAS IMAGINE, ArcInfo Binary Grid, ArcInfo ASCII
Grid, en nog veel meer… Lees de complete lĳst met ondersteunde rasterindelingen.

• Indelingen voor databases omvatten PostgreSQL/PostGIS, SQLite/SpatiaLite, Oracle, MS SQL Server, SAP
HANA, MySQL…

• Webkaart- en gegevensservices (WM(T)S, WFS, WCS, CSW, XYZ-tegels, ArcGIS services, …) worden ook
afgehandeld door providers van QGIS. Bekĳk Werken met protocollen van OGC / ISO voor meer informatie
over enkele hiervan.

• U kunt ondersteunde bestanden lezen vanuit archiefmappen en eigen indelingen van QGIS gebruiken, zoals
QML-bestanden (QML - De QGIS indeling voor stĳlbestand) en virtuele en geheugenlagen.

Meer dan 80 vector- en 140 rasterindelingen worden ondersteund door GDAL en eigen providers van QGIS.

Notitie: Niet alle vermelde indelingen zouden kunnenwerken inQGIS, om verschillende redenen. Sommige vereisen,
bĳvoorbeeld, externe merkgebonden bibliotheken, of de installatie van GDAL/OGR voor uw besturingssysteem zou
niet gebouwd hoeven te zĳn om de indeling, die u wilt gebruiken, te ondersteunen. Voer, om de lĳst met beschikbare
indelingen te bekĳken, de opdrachten voor de opdrachtregel ogrinfo --formats (voor vectors) en gdalinfo
--formats (voor rasters) uit, of selecteer het menu Extra ► Opties ► GDAL in QGIS.

In QGIS, afhankelĳk van de gegevensindeling, staan verschillende gereedschappen om een gegevensset te openen,
voornamelĳk beschikbaar in het menu Kaartlagen ► Laag toevoegen ► of vanaf de werkbalk Kaartlagen beheren
(ingeschakeld via het menu Beeld ►Werkbalken). Al deze gereedschappen verwĳzen naar een uniek dialoogvenster,
het dialoogvensterDatabronnen beheren, dat u kunt openen met de knop Databronnen beheren openen, beschikbaar op de
werkbalk Databronnen beheren, of door te drukken op Ctrl+L. Het dialoogvenster Databronnen beheren Fig. 15.1
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biedt een geünificeerde interface om gegevens, gebaseerd op bestanden, te openen, als ook databases of webservices
die worden ondersteund door QGIS.

Fig. 15.1: QGIS dialoogvenster Databronnen beheren

Naast dit belangrĳkste toegangspunt, heeft u ook de plug-in DB Manager die geavanceerde mogelĳkheden biedt
om verbonden databases te analyseren en te bewerken. Meer informatie over mogelĳkheden van DB Manager is te
vinden in Plug-in DB Manager.
Er zĳn nog veel meer andere gereedschappen, eigen of plug-ins van derde partĳen, die u helpen bĳ het openen van
verscheidene indelingen voor gegevens.
Dit hoofdstuk zal alleen de gereedschappen beschrĳven die standaard worden verschaft in QGIS voor het laden
van gegevens. Het zal zich voornamelĳk focussen op het dialoogvenster Databronnen beheren, maar meer dan het
beschrĳven van elke tab, zal het ook de gereedschappen verkennen, gebaseerd op de gegevensprovider of de specifieke
bĳzonderheden van de indeling.
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15.1.1 Het paneel Browser

De Browser is één van de vele manieren om snel een eenvoudig uw gegevens aan projecten toe te voegen. Het is
beschikbaar als:

• een tab Databronnen beheren, ingeschakeld door te drukken op de knop Databronnen beheren openen (Ctrl+L);

• als een paneel van QGIS dat u kunt openen vanuit het menu Beeld ► Panelen (of Settings ► Panels) of
door te drukken op Ctrl+2.

In beide gevallen helpt de Browser u te navigeren in uw bestandssysteem en geogegevens te beheren, ongeacht het
type laag (raster, vector, tabel), of de indeling van de gegevensbron (platte of gecomprimeerde bestanden, databases,
webservices).

De interface verkennen

Boven in het paneel Browser vindt u enkele knoppen die u helpen bĳ:

• Geselecteerde lagen toevoegen: u kunt ook gegevens toevoegen aan het kaartvenster door Geselecteerde lagen
toevoegen uit het contextmenu van de laag;

• Bĳwerken van de boom van de browser;

• Filter browser om te zoeken naar specifieke gegevens. Voer een zoekwoord of jokerteken in en de browser
zal de boom filteren om alleen de paden te laten zien die overeenkomen met databasetabellen, bestandsnamen
of mappen – andere gegevens of mappen worden niet meer weergegeven. Bekĳk het voorbeeld van Browser
Panel(2) in Fig. 15.2. De vergelĳking mag hoofdlettergevoelig zĳn of niet. Het kan ook worden ingesteld op:

– Normaal: geef items weer die de zoektekst bevatten
– Jokerteken(s): stem de zoekactie fĳn af met de tekens ? en/of * om de positie van de zoektekst te
specificeren

– Reguliere expressie

• Alles inklappen de gehele boom;

• Widget Eigenschappen in-/uitschakelen: indien ingeschakeld wordt een nieuw widget toegevoegd aan de onderzĳde
van het paneel, dat, indien van toepassing, metadata voor het geselecteerde item weergeeft.

De items in het paneel Browser zĳn hiërarchisch georganiseerd, en er zĳn verscheidene items op het bovenste niveau:
1. Favorieten waar u snelkoppelingen kunt plaatsen naar vaak gebruikte locaties
2. Favoriete plaatsenwaar u vaak gebruikte kaartbereiken kunt opslaan (zie Favoriete plaatsen maken van bereiken

op de kaart)
3. Thuis voor project: voor snelle toegang tot de map waarin de (meeste) gegevens die gerelateerd zĳn aan uw

project zĳn opgeslagen. De standaardwaarde is de map waar uw projectbestand is opgeslagen.
4. Home-map in het bestandssysteem en de bronmap van het bestandssysteem.
5. Verbonden lokale of netwerkschĳven
6. Daarna komen er een aantal container / typen database en serviceprotocollen, afhankelĳk van uw platform en

onderliggende bibliotheken:

• GeoPackage

• SpatiaLite

• PostgreSQL
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• SAP HANA

• MS SQL Server

• Oracle

• WMS/WMTS

• Vectortegels

• XYZ-tegels

• WCS

• WFS/OGC API-Features

• ArcGIS REST Server

• GeoNode

Interactie met de items van de Browser

De browser ondersteunt slepen-en-neerzetten in de browser, vanuit de browser naar het kaartvenster en paneel Lagen,
en vanuit het paneel Lagen naar containers van lagen (bĳv. GeoPackage) in de browser.
Items van het projectbestand in de browser kunnen worden opengeklapt, wat de volledige boom van de laag weergeeft
(inclusief groepen), die zĳn opgenomen in dat project. Items voor het project worden op dezelfde manier behandelt
als elk ander item in de browser, dus kunnen zĳ binnen de browser worden gesleept en neergezet (bĳvoorbeeld om
een item laag te kopiëren naar een bestand van Geopackage) of worden toegevoegd aan het huidige project met
slepen-en-neerzetten of dubbelklikken.
Het contextmenu voor een element in het paneel Browser wordt geopend door er met rechts op te klikken.
Voor items van de map voor het bestandssysteem biedt het contextmenu het volgende:

• Nieuw ► om in het geselecteerde item te maken een:
– Map…

– GeoPackage…

– ShapeFile…

• Als Favoriet toevoegen: favoriete mappen kunnen op elk moment worden hernoemd (Favoriet hernoemen…) of
verwĳderd (Favoriet verwĳderen).

• Verbergen in browser: verborgen mappen kunnen weer naar zichtbaar worden geschakeld met de instelling
Extra ► Opties ► Databronnen ► Paden verbergen in paneel van browser

• Deze map snel scannen

• Map openen

• In Terminal openen

• Eigenschappen…

• Mapeigenschappen…

Voor bladitems die kunnen optreden als lagen in het project, zal het contextmenu ondersteunende items hebben.
Bĳvoorbeeld voor niet-database, niet op service gebaseerde vector-, raster- en gegevensbronnen met mazen:

• Laag exporteren ► Naar bestand…

• Laag aan project toevoegen

• Laageigenschappen
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• Beheren ► Hernoemen “<name of file>”… of Verwĳderen”<name of file>”…

• Weergeven in bestanden

• Bestandseigenschappen

In het item Laageigenschappen zult u vinden (soortgelĳk aan dat wat u zult vinden in de vector en raster
laageigenschappen als de lagen eenmaal zĳn toegevoegd aan het project):

• Metadata voor de laag. Groepen voormetadata: Informatie van provider (indienmogelĳk, Pad zal een hyperlink
naar de bron zĳn), Identificatie, Bereik, Toegang,Velden (voor vectorlagen), Banden (voor rasterlagen), Contact,
Links (voor vectorlagen), Verwĳzingen (voor rasterlagen), Geschiedenis.

• Een paneel Voorbeeld
• De attributentabel voor vectorbronnen (in het paneel Attributen).

De Browser gebruiken om een laag aan het project toe te voegen:
1. Schakel de Browser in zoals hierboven beschreven. Een boom voor de browser met uw bestandssysteem,

databases en webservices wordt weergegeven. U zoumisschienmoeten verbindenmet databases en webservices
voordat zĳ zichtbaar zĳn (zie betreffende gedeelten).

2. Zoek de laag op in de lĳst.
3. Gebruik het contextmenu, dubbelklik op de naam ervan of sleep en zet het neer in het kaartvenster. Uw laag

wordt nu toegevoegd aan het paneel Lagen en kan worden bekeken in het kaartvenster.

Tip: Een project van QGIS direct openen vanuit de browser
U kunt ook direct een project van QGIS openen vanuit het paneel Browser door te dubbelklikken op de naam
of door het te slepen en neer te zetten in het kaartvenster.

Als een bestand eenmaal is geladen, kunt u daar in zoomen met de gereedschappen voor kaartnavigatie. Open, om de
stĳl van een laag te wĳzigen, het dialoogvenster Laageigenschappen door te dubbelklikken op de naam van de laag of
met rechts te klikken op de naam in de legenda en Eigenschappen te kiezen in het contextmenu. Bekĳk het gedeelte
Eigenschappen Symbologie voor meer informatie over het instellen van symbologie voor vectorlagen.
Met rechts klikken op een item in de boom van de Browser helpt u om:

• voor een bestand of een tabel, de metadata ervan weer te geven of het te openen in uw project. Tabellen kunnen
zelfs worden hernoemd, verwĳderd of afgebroken.

• voor een map, een bladwĳzer te maken in uw Favorieten of het te verbergen in de boom van de Browser.
Verborgen mappen kunnen worden beheerd vanaf de tab Extra ► Opties ► Databronnen.

• uw Favoriete plaatsen te beheren: Favoriete plaatsen kunnen worden gemaakt, geëxporteerd en geïmporteerd
als XML-bestanden.

• een verbinding naar een database of een webservice te maken.
• een schema te vernieuwen, te hernoemen of te verwĳderen.

U kunt ook bestanden importeren in databases of tabellen kopiëren van het/de ene schema/database naar een ander
met eenvoudig slepen-en-neerzetten. Er is een tweede paneel Browser beschikbaar om lang scrollen bĳ het slepen
te vermĳden. Selecteer eenvoudigweg het bestand en plaats het met slepen-en-neerzetten van het ene paneel in het
andere.
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Fig. 15.2: Panelen QGIS Browser naast elkaar

Tip: Lagen aan QGIS toevoegen door ze eenvoudigweg te slepen en neer te zetten vanuit de bestandsbrowser
van uw besturingssysteem
U kunt ook bestand(en) toevoegen aan het project door ze te slepen en neer te zetten vanuit de bestandsbrowser van
uw besturingssysteem naar het paneel Lagen of het kaartvenster.

15.1.2 De DB Manager

De plug-in DB Manager is een ander gereedschap voor het integreren en beheren van indelingen voor ruimtelĳke
databases, ondersteunt doorQGIS (PostGIS, SpatiaLite, GeoPackage, Oracle Spatial,MS SQLServer, virtuele lagen).
Het kan worden geactiveerd vanuit het menu Plug-ins ► Plug-ins beheren en installeren….

De plug-in DB Manager verschaft verscheidene mogelĳkheden:
• verbinden met databases en hun structuur en inhoud weergeven
• voorbeelden van tabellen van databases
• lagen toevoegen aan het kaartvenster, ofwel door te dubbelklikken of met slepen-en-neerzetten.
• lagen aan een database toevoegen vanuit de QGIS Browser of vanuit een andere database
• SQL-query’s maken en hun uitvoer toevoegen aan het kaartvenster
• virtuele lagen maken

Meer informatie over mogelĳkheden van DB Manager is te vinden in Plug-in DB Manager.
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Fig. 15.3: Dialoogvenster DB Manager

15.1.3 Provider-gebaseerde gereedschappen voor laden

Naast het paneel Browser en de DB Manager, de belangrĳkste door QGIS verschafte gereedschappen om lagen toe
te voegen, zult u ook gereedschappen vinden die specifiek voor gegevensproviders zĳn.

Notitie: Sommige externe plug-ins verschaffen ook gereedschappen om bestanden met specifieke indelingen te
openen in QGIS.

Een laag uit een bestand laden

Een laag uit een bestand laden:

1. Open de tab voor het type laag in het dialoogvenster Databronnen beheren, d.i. klik op de knop
Databronnen beheren openen (of druk op Ctrl+L) en schakel de tab voor het doel in of:

• voor vectorgegevens (zoals GML, ESRI Shapefile, Mapinfo- en DXF-lagen): druk op Ctrl+Shift+V,
selecteer de menuoptie Kaartlagen► Laag toevoegen► Vectorlaag toevoegen of klik op de knop op
de werkbalk Vectorlaag toevoegen.
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Fig. 15.4: Dialoogvenster Vectorlaag toevoegen

• voor rastergegevens (zoals GeoTiff, MBTiles, GRIdded Binaire en DWG-lagen): druk op
Ctrl+Shift+R, selecteer de menuoptie Kaartlagen► Laag toevoegen► Rasterlaag toevoegen of
klik op de knop op de werkbalk Rasterlaag toevoegen.

Fig. 15.5: Dialoogvenster Rasterlaag toevoegen

2. Selecteer het Type bron Bestand

3. Klik op de knop… Bladeren

4. Navigeer in het bestandssysteem en laadt een ondersteunde gegevensbron. Meer dan één laag kan tegelĳkertĳd
worden geladen door de Ctrl-toets ingedrukt te houden en te klikken op meerdere items in het dialoogvenster
of door de Shift-toets ingedrukt te houden om een bereik aan items te selecteren door te klikken op het
eerste en laatste item in het bereik. Alleen indelingen die goed zĳn getest zullen in het filter voor de indelingen
verschĳnen. Andere indelingen kunnen worden geladen door Alle bestanden te selecteren (het bovenste
item in het keuzemenu).

5. Druk op Openen om het geselecteerde bestand te laden in het dialoogvenster Databronnen beheren
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Fig. 15.6: Een Shapefile laden met opties voor openen

6. Druk op Toevoegen om het bestand in QGIS te laden en het weer te geven in het kaartvenster. Fig. 15.7 geeft
QGIS weer na het laden van het bestand alaska.shp.
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Fig. 15.7: QGIS met het geladen shapefile van Alaska

Notitie: Voor het laden van vector- en rasterbestanden biedt het stuurprogramma van GDAL de mogelĳkheid voor
het definiëren van acties om te openen. Deze zullen worden weergegeven als een bestand wordt geselecteerd. Opties
worden in detail beschreven op https://gdal.org/drivers/vector/, https://gdal.org/drivers/raster en als een bestand
is geselecteerd in QGIS, zal een tekst met hyperlink direct leiden naar de documentatie van het geselecteerde
bestandstype.

Notitie: Omdat sommige indelingen, zoals MapInfo (bĳv. .tab) of Autocad (.dxf) het mixen van verschillende
typen geometrie in één enkel bestand toestaan, opent het laden van dergelĳke gegevenssets een dialoogvenster om de
te gebruiken geometrieën te selecteren, teneinde één geometrie per laag te hebben.

De tabs Vectorlaag toevoegen en Rasterlaag toevoegen staan het laden van lagen toe vanuit andere typen bron danBestand:
• U kunt specifieke vectorindelingen, zoals ArcInfo Binary Coverage, UK. National Transfer
Format, laden als ook de indeling voor ruwe TIGER van het US Census Bureau of OpenfileGDB.
U selecteert, om dat te doen, Map als Type bron. In dit geval kan een map worden geselecteerd in het
dialoogvenster, na het drukken op… Bladeren.

• Met het Type bron Database kunt u een bestaande databaseverbinding selecteren of er een maken
voor het geselecteerde type database. Enkele mogelĳke typen databases zĳn ODBC, Esri Personal
Geodatabase, MS SQL Server, als ook PostgreSQL of MySQL.
Drukken op de knop Nieuw opent het dialoogvenster Nieuwe OGR-databaseverbinding maken, waarvan de
parameters tussen die staan welke u kunt vinden in Een opgeslagen verbinding maken. Drukken op Openen laat
u selecteren uit de beschikbare tabellen, bĳvoorbeeld van met PostGIS ingeschakelde databases.

• Het Type bron Protocol: HTTP(S), cloud, etc. opent gegevens die lokaal zĳn opgeslagen op het netwerk,
ofwel publiek toegankelĳk of in private mandjes of commerciële services voor opslag in de cloud. Ondersteunde
typen protocol zĳn:

– HTTP/HTTPS/FTP, met een URI en, indien vereist, een authenticatie.
– Opslag in de cloud, zoals AWS S3, Google Cloud Storage, Microsoft Azure Blob,
Alibaba OSS Cloud, Open Stack Swift Storage. U dient Mandje of container en de
Sleutel voor object in te vullen.

– service die OGC ondersteunt WFS 3 (nog steeds experimenteel), gebruikt indeling GeoJSON of
GEOJSON - Newline Delimited of gebaseerd op database CouchDB. Een URI is vereist, met
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optionele authenticatie.
– Voor alle typen vectorbronnen is het mogelĳk om de Codering te definiëren of de instelling Automatisch
► te gebruiken.

Laden van een laag met mazen

Een laag met mazen is een ongestructureerd raster, gewoonlĳk met tĳdelĳke en andere componenten. De ruimtelĳke
component bevat een collectie punten, randen en zĳden in ruimte 2D of 3D. Meer informatie over lagen met mazen
opWerken met gegevens met mazen.
Een laag met mazen toevoegen aan QGIS:

1. Open het dialoogvenster Databronnen beheren, ofwel door het te selecteren in het menu Kaartlagen ► of te
klikken op de knop Databronnen beheren openen.

2. Schakel naar de tab Mazen in het linkerpaneel
3. Druk op de knop… Bladeren om het bestand te selecteren. Verscheidene indelingen worden ondersteund.
4. Selecteer het bestand en druk op Toevoegen. De laag zal worden toegevoegdmet de eigen rendering voor mazen.
5. Als het geselecteerde bestand veel lagen met mazen bevat, dan zult u worden gevraagd, met een dialoogvenster,

om de te laden sublagen te kiezen. Maak uw selectie en druk op OK en de lagen worden geladen met de eigen
rendering voor mazen. Het is ook mogelĳk om ze in een groep te laden.

Fig. 15.8: Tab Mazen in Databronnen beheren

Een tekstgescheiden bestand importeren

Tekengescheiden tekstbestanden (bĳv. .txt, .csv, .dat, .wkt) kunnen worden geladen met de hierboven
beschreven gereedschappen. Op deze manier zullen zĳ verschĳnen als eenvoudige tabellen. Soms kunnen
tekengescheiden tekstbestanden coördinaten / geometrieën bevatten die u zou willen visualiseren. Dat is waar

Tekstgescheiden-laag toevoegen voor is ontworpen.

1. Klik op het pictogram Databronnen beheren openen om het dialoogvenster Databronnen beheren te openen

2. Schakel naar de tab Tekengescheiden tekst

3. Selecteer het te importeren gescheiden tekstbestand (bĳv. qgis_sample_data/csv/elevp.csv) door
te klikken op de knop… Bladeren.

4. In het veld Laagnaam, geef de te gebruiken naam op voor de laag in het project (bĳv. Hoogte).
5. Configureer de instellingen zoals die voor uw gegevensset en behoeften nodig zĳn, zoals hieronder uitgelegd.
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Fig. 15.9: Dialoogvenster Maak een laag uit een tekstgescheiden bestand

Bestandsindeling

Als het bestand eenmaal is geselecteerd, probeert QGIS het bestand te parsen met het meest recent gebruikte
scheidingsteken, dat velden en rĳen identificeert. Het is belangrĳk om het juiste scheidingsteken te selecteren, om
QGIS zodanig in te schakelen dat het bestand op de juiste wĳze wordt geparset. U kunt een scheidingsteken selecteren
door te kiezen tussen:

• CSV (komma gescheiden waarden) om het teken komma te gebruiken.

• Reguliere expressie tekstscheider en voer tekst in in het veld Expressie. Gebruik bĳvoorbeeld \t om het
scheidingsteken naar tab te wĳzigen (dit wordt in reguliere expressies gebruikt voor het teken tab).

• Zelfgekozen tekstscheiders, kiezen uit enkele vooraf gedefinieerde scheidingstekens, zoals komma,
spatie, tab, puntkomma, … .

Records en velden

Enkele andere handige opties kunnen worden gebruikt voor het herkennen van gegevens:
• Aantal kopregels die overgeslagen kunnen worden: handig wanneer u de eerste regels in het bestand wilt
vermĳden bĳ het importeren, ofwel omdat het blanco regels zIjn, of met een andere opmaak.

• De eerste regel bevat veldnamen: waarden in de eerste regel worden gebruikt als veldnamen, anders gebruikt
QGIS de veldnamen field_1, field_2…

• Veldtypen detecteren: automatisch het type veld herkennen. Indien niet geselecteerd worden alle attributen
behandeld als tekstvelden.

• Decimaal scheidingsteken is de komma: u kunt forceren dat een komma het decimale scheidingsteken is.
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• Spaties voor/na velden verwĳderen: stelt u in staat spaties voor en achter de tekst van de velden te
verwĳderen.

• Sla lege velden over.
• Aangepaste Booleaanse letterlĳken: stelt u in staat een aangepast stel tekenreeksen toe te voegen die zullen
worden gedetecteerd als Booleaanse waarden.

Veldtype detecteren

QGIS probeert automatisch veldtypen te detecteren (tenzĳ Veldtypen detecteren niet is geselecteerd) door de
inhoud van een optionele bĳgevoegd CSVT-bestand te onderzoeken (bekĳk: GeoCSV specification) en door het
gehele bestand te scannen om er voor te zorgen dat alle waarden feitelĳk kunnen worden geconverteerd zonder fouten,
het veldtype waarop wordt teruggevallen is text.
Het gedetecteerde veldtype verschĳnt onder de veldnaam in de voorbeeldtabel met gegevens en kan handmatig worden
gewĳzigd indien nodig.
En de volgende veldtypen worden ondersteund:

• Boolean hoofdletterongevoelige koppels van letterlĳken die worden geïnterpreteerd als Booleaanse waarden
zĳn 1/0, true/false, t/f, yes/no

• Geheel getal (integer)

• Geheel getal (integer - 64 bit)

• Decimaal getal: double-precisie zwevende punt-getal
• Datum

• Tijd

• Datum en tijd

• Tekst

Geometrie definitie

Als het bestand eenmaal is geparst, stel Geometrie definitie in op

• Punt coördinaten en geef de X-veld, Y-veld, Z-veld (voor 3-dimensionale gegevens) en M-veld (voor
de dimensie maat) op als de laag van het type geometrie punt is en dergelĳke velden bevat. Activeer het
keuzevak DMS-coördinaten als de coördinaten zĳn gedefinieerd als graden/minuten/seconden. Verschaf
het van toepassing zĳnde Geometrie CRS met de widget CRS selecteren.

• Well known text (WKT) optie als de ruimtelĳke informatie wordt weergegeven als WKT: selecteer het
Geometrie-veld dat de geometrie WKT bevat en kies het van toepassing zĳnde Type geometrie of laat QGIS
dat automatisch detecteren. Geef het van toepassing zĳnde Geometrie CRS op met de widget CRS selecteren.

• Als het bestand geen ruimtelĳke gegevens bevat, activeer dan Geen geometrieën (alleen attributentabel) en
het zal worden geladen als een gewone tabel.
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Laag-instellingen

Aanvullend kunt u inschakelen:

• Ruimtelĳke index gebruiken om de uitvoering van het weergeven en ruimtelĳk selecteren van objecten te
verbeteren.

• Gebruik een subset index om het uitvoeren van subsetfilters te verbeteren (indien gedefinieerd in de
laageigenschappen).

• Bestand in de gaten houden om de wĳzigingen aan het bestand door andere toepassingen terwĳl QGIS wordt
uitgevoerd bĳ te houden.

Aan het einde, klik op Toevoegen om de laag aan de kaart toe te voegen. In ons voorbeeld wordt een puntenlaag,
genaamd Hoogte, toegevoegd aan het project en gedraagt zich als elke andere laag in QGIS. Deze laag is het resultaat
van een query op het bronbestand .csv (deswege, eraan gekoppeld) en zou moeten worden opgeslagen om een
ruimtelĳke laag op schĳf te krĳgen.

Voorbeeldgegevens

Als u de eigenschappen voor het parsen instelt, wordt de voorbeeldweergave bĳgewerkt, met inachtneming van de
toegepaste instellingen.
In de tabel met Voorbeeldgegevens is het mogelĳk om de automatisch bepaalde veldtypen te wĳzigen.

Een DXF- of DWG-bestand importeren

DXF- en DWG-bestanden kunnen aan QGIS worden toegevoegd door ze eenvoudigweg te slepen-en-neerzetten vanuit
het paneel Browser. U zult worden gevraagd de sublagen te selecteren die u aan het project zou willen toevoegen.
Lagen worden toegevoegd met willekeurige eigenschappen voor de stĳl.

Notitie: Voor DXF-bestanden die verschillende typen geometrie bevatten (punt, lĳn en/of polygoon), zal de naam
van de lagen worden gemaakt als <bestandsnaam.dxf> entiteiten <geometry type>.

Wanneer u de bestandsstructuur van DXF/DWG en de symbologie ervan in QGIS wilt behouden, wilt u waarschĳnlĳk
het toegewezen gereedschap Project► Importeren/Exporteren► Lagen importeren vanuit DWG/DXF… gebruiken dat
u in staat stelt:

1. elementen uit het bestand van de tekening in een database van GeoPackage te importeren.
2. geïmporteerde elementen toe te voegen aan het project.

In het dialoogvenster DWG/DXF importeren om de inhoud van het bestand met de tekening te importeren:
1. Voer de locatie van het Doelpakket in, d.i. het nieuwe bestand van GeoPackage dat de gegevens zal bevatten.

Als een bestaand bestand wordt opgegeven, zal dat worden overschreven.
2. Specificeer het coördinaten referentiesysteem van de gegevens in het bestand van de tekening.

3. Selecteer Verwĳzingen naar blokken uitbreiden om de blokken in het bestand van de tekening als normale
elementen te importeren.

4. Selecteer Bogen gebruiken om de geïmporteerde lagen te promoveren naar een type geometrie boog.
5. Gebruik de knop Importeren om het te gebruiken bestand DWG/DXF te selecteren (één per Geopackage).

De database van GeoPackage zal automatisch worden gevuld met de inhoud van het bestand van de tekening.
Afhankelĳk van de grootte van het bestand kan dit enige tĳd duren.

Nadat de .dwg- of .dxf-gegevens zĳn geïmporteerd in de database van GeoPackage wordt het frame in de onderste
helft van het dialoogvenster gevuld met de lĳst met lagen van het geïmporteerde bestand. Daar kunt u selecteren welke
lagen toe te voegen aan het project van QGIS:
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1. Stel, bovenin, een Groepsnaam in om de tekeningbestanden in het project te groeperen.
2. Selecteer weer te geven lagen: Elke geselecteerde laag wordt toegevoegd aan een ad hoc-groep die vectorlagen

bevat voor de punt, lĳn, label en gebiedsobjecten van de laag met de tekening. De stĳl van de lagen zal lĳken
op hoe zĳ eruit zagen in *CAD.

3. Kies of de laag zichtbaar zou moeten zĳn bĳ openen.

4. Selecteren van de optie Lagen samenvoegen plaatst alle lagen in één enkele groep.
5. Druk op OK om de lagen in QGIS te openen.

Fig. 15.10: Dialoogvenster voor het importeren van bestanden DWG/DXF

OpenStreetMap vectors importeren

Het project OpenStreetMap is populair, omdat in veel landen geen vrĳe ruimtelĳke gegevens, zoals digitale
wegenkaarten, beschikbaar zĳn. Het doel van het project OSM is om een vrĳ bewerkbare kaart van de wereld te
maken uit gegevens van GPS, luchtfotografie en lokale kennis. QGIS verschaft ondersteuning voor gegevens van
OSM om dit doel te ondersteunen.
Met het paneel Browser kunt u een bestand .osm laden in het kaartvenster, in welk geval u een dialoogvenster zult
krĳgen om sublagen te selecteren, gebaseerd op het type geometrie. De geladen lagen zullen alle gegevens bevatten
van dat type geometrie in het bestand .osm, en zal de gegevensstructuur van het bestand osm behouden.
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SpatiaLite-lagen

De eerste keer dat u gegevens laadt vanuit een database van SpatiaLite begint met:

• klikken op de knop van de werkbalk SpatiaLite-laag toevoegen

• selecteren van de optie SpatiaLite-laag toevoegen… uit het menu Kaartlagen ► Laag toevoegen

• of door te typen Ctrl+Shift+L
Dit zal een venster openen dat u in staat zal stellen om ofwel te verbinden met een database van SpatiaLite, die al
bekend is bĳ QGIS (die u kiest uit het keuzemenu) of om een nieuwe verbinding naar een nieuwe database te maken.
Klik, om een nieuwe verbinding te definiëren, op Nieuw en gebruik de bestandsbrowser om naar uw database van
SpatiaLite, wat een bestand is met de extensie .sqlite, te verwĳzen.
QGIS ondersteunt ook het bewerken van gegevens via te bewerken Views in SpatiaLite.

GPS

Er bestaan heel veel verschillende bestandsindelingen voor het opslaan van GPS-gegevens. De indeling die QGIS
gebruikt wordt GPX (GPS eXchange-indeling) genoemd, wat een standaardindeling voor uitwisseling is dat een
willekeurig aantal waypoints, routes en tracks in hetzelfde bestand kan bevatten.
Gebruik de knop… Bladeren om het GPX-bestand te selecteren, gebruik dan de keuzevakken om de typen objecten te
selecteren die u wilt laden vanuit dat GPX-bestand. Elk type object zal in een afzonderlĳke laag worden geladen.
Meer over het manipuleren van gegevens voor GPS inWerken met GPS-gegevens.

Fig. 15.11: Dialoogvenster GPS-gegevens laden

GRASS

Werken met vectorgegevens van GRASS wordt beschreven in het gedeelte Integratie van GRASS GIS.
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Database gerelateerde gereedschappen

Een opgeslagen verbinding maken

Voor het lezen en schrĳven van tabellen vanuit een indeling voor een database die QGIS ondersteunt, moet u een
verbinding maken naar die database. Hoewel paneel Browser in QGIS de eenvoudigste en aanbevolen manier is om
te verbinden met en voor het gebruiken van databases, verschaft QGIS andere gereedschappen om met elk ervan te
verbinden en hun tabellen te laden:

• PostGIS-laag toevoegen… of door te typen Ctrl+Shift+D

• MS SQL Server-laag toevoegen

• Oracle Spatial-laag toevoegen… of door te typen Ctrl+Shift+O

• SAP HANA Spatial-laag toevoegen… of door te typen Ctrl+Shift+G
Deze gereedschappen zĳn toegankelĳk vanuit ofwel de werkbalk Lagen beheren en het menu Kaartlagen ► Laag
toevoegen ►. Verbinden met een database van SpatiaLite wordt beschreven in SpatiaLite-lagen.

Tip: Verbinding naar database maken vanuit het QGIS paneel Browser
Selecteren van de corresponderende indeling voor de database in de boom van Browser, klik met rechts en kiezen
van Nieuwe verbinding zal u brengen naar het dialoogvenster Databaseverbinding.

De meeste dialoogvensters voor het maken van een verbinding volgen een algemene basis, die, als een voorbeeld,
hieronder zal worden beschrevenmet behulp van het gereedschap voor de database van PostgreSQL. Voor aanvullende
instellingen, specifiek voor andere providers, vindt u corresponderende beschrĳvingen op:

• Verbinden met MS SQL Server;
• Verbinden met Oracle Spatial;
• Verbinden met SAP HANA.

De eerste keer dat u een gegevensbron van PostGIS gebruikt, moet u een verbinding maken naar een database die
de gegevens bevat. Begin door te klikken op de toepasselĳke knop zoals hierboven weergegeven, dat opent een
dialoogvenster PostGIS-tabel(len) toevoegen (zie Fig. 15.14). Klik op de knop Nieuw om het dialoogvenster Nieuwe
PostGIS-verbinding maken weer te geven om toegang te krĳgen tot het beheer van de verbinding.

15.1. Gegevens openen 455



QGIS Desktop 3.28 User Guide

Fig. 15.12: Dialoogvenster Nieuwe PostGIS-verbinding maken
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De voor een verbindingmet PostGIS vereiste parameters worden hieronder uitgelegd. Voor de andere typen databases,
bekĳk hun verschillen op Bĳzondere vereisten voor verbindingen.

• Naam: Een naam voor deze verbinding. Het mag hetzelfde zĳn als Database.
• Service: Parameter Service om als alternatief te worden gebruikt voor hostnaam/poort (en potentieel
database). Dit kan worden gedefinieerd in pg_service.conf. Bekĳk het gedeelte PostgreSQL service
verbindingsbestand voor meer details.

• Host: Naam van de host voor de database. Dit moet een terug te vinden naam zĳn, zoals die gebruikt wordt
voor een TCP/IP-verbinding, of hoe de host te pingen. Als de database op dezelfde computer staat als QGIS,
voer hier dan localhost in.

• Poort: Poortnummer waar de server van de database van PostgreSQL naar luistert. De standaardpoort voor
PostGIS is 5432.

• Database: Naam van de database.
• SSL mode: instellen encryptie voor SSL. De volgende opties zĳn beschikbaar:

– Voorkeur (de standaard): Ik heb niets met encryptie, maar ik neem de lasten van encryptie op de koop
toe, als de server het ondersteunt.

– Vereist: Ik wil dat mĳn gegevens versleuteld worden, en ik accepteer de lasten. Ik vertrouw erop dat het
netwerk er altĳd voor zal zorgen dat ik wordt verbonden met de server die ik wil.

– Verifiëren CA: Ik wil dat mĳn gegevens versleuteld worden, en ik accepteer de lasten. Ik wil zeker weten
dat ik ben verbonden met een server die ik vertrouw.

– Volledig verifiëren: Ik wil dat mĳn gegevens worden versleuteld, en ik accepteer de lasten. Ik wil zeker
weten dat ik wordt verbonden met een server die ik vertrouw en dat het die is welke ik specificeer.

– Toestaan: Ik heb niets met beveiliging, maar ik neem de lasten van encryptie op de koop toe, als de server
daar op staat.

– Uitschakelen: Ik heb niets met beveiliging en ik wil niet de lasten van encryptie dragen.
• Authenticatie, Basis.

– Gebruikersnaam: Gebruikersnaam die gebruikt is om in te loggen in de database.
– Wachtwoord: Wachtwoord dat gebruikt is met Gebruikersnaam om te verbinden met de database.

U kunt een of beide parameters Gebruikersnaam en Wachtwoord opslaan, in welk geval zĳ standaard
zullen worden gebruikt, elke keer als u met deze database moet verbinden. Indien niet opgeslagen, zult u worden
gevraagd de inloggegevens op te geven om voor volgende sessies in QGIS te verbinden met de database. De
parameters voor de verbinding die u hebt ingevoerd worden opgeslagen in een tĳdelĳke interne cache en
teruggegeven wanneer een gebruikersnaam/wachtwoord voor dezelfde database wordt gevraagd, totdat u de
huidige sessie van QGIS beëindigt.

Waarschuwing: QGIS Gebruikersinstellingen en beveiliging
Het op de tab Authenticatie opslaan van Gebruikersnaam en Wachtwoord zal niet beveiligde
inloggegevens behouden in de configuratie van de verbinding. Deze inloggegevens zullen zichtbaar zĳn
als u, bĳvoorbeeld, het projectbestand deelt met iemand. Daarom wordt geadviseerd om uw inloggegevens
in plaats daarvan op te slaan in een configuratie voor Authenticatie (tab Configuraties - Bekĳk ook
Authenticatiesysteem voor meer details) of in een verbindingsbestand voor de service (bekĳk bĳvoorbeeld
PostgreSQL service verbindingsbestand).

• Authenticatie, Configuraties. Kies een configuratie voor de authenticatie. U kunt configuraties toevoegen met
de knop . Keuzen zĳn:

– Basis authenticatie
– PKI PKCS#12-authenticatie

15.1. Gegevens openen 457



QGIS Desktop 3.28 User Guide

– PKI-paden authenticatie
– PKI opgeslagen identiteitscertificaat

Optioneel, afhankelĳk van het type database, kunnen de volgende keuzevakken worden geactiveerd:

• Toon alleen lagen in de kaartlagen registers

• Niet het type geometrie bepalen voor onbeperkte kolommen (GEOMETRY)

• Alleen in het ‘publieke’-schema kĳken

• Ook tabellen zonder geometrie tonen

• Gebruik ’estimated table statistics’

• Opslaan/laden van projecten van QGIS in de database toestaan - meer details hier

• Opslaan/laden van metadata van lagen van QGIS in de database toestaan - meer details hier

Tip: Geschatte metadata voor tabel gebruiken om bewerkingen te versnellen
Bĳ het initialiseren van lagen, zouden verscheidene query’s nodig kunnen zĳn om de karakteristieken van de
geometrieën, die zĳn opgeslagen in de tabel van de database, vast te stellen. Als de optie Gebruik geschatte
tabelstatistieken is geselecteerd, bekĳken deze query’s slechts een monster van de rĳen en gebruiken de
tabelstatistieken, in plaats van de gehele tabel. Dit kan bewerkingen op grote gegevenssets aanzienlĳk versnellen,
maar zou kunnen resulteren in onjuiste karakterisatie van lagen (bĳv. de telling van objecten van gefilterde lagen zou
niet nauwkeurig kunnen worden bepaald) en zou zelfs vreemd gedrag kunnen veroorzaken, als kolommen, die geacht
worden uniek te zĳn, dat feitelĳk niet zĳn.

Als alle parameters en opties eenmaal zĳn ingesteld, kunt u de verbinding testen door te klikken op de knopVerbinding
testen of toepassen door te klikken op de knop OK. Vanuit PostGIS-laag toevoegen, klik nu op Verbinden, en het
dialoogvenster wordt gevuld met tabellen uit de geselecteerde database (zoals weergegeven in Fig. 15.14).

Bijzondere vereisten voor verbindingen

Vanwege de bĳzonderheden van de typen database zĳn de verschafte opties niet hetzelfde. Databasespecifieke opties
worden hieronder beschreven.

PostgreSQL service verbindingsbestand

Het service verbindingsbestand maakt het mogelĳk dat in PostgreSQL parameters voor een verbinding worden
geassocieerd met één enkele naam van een service. Die naam van een service kan dan worden gespecificeerd door
een cliënt en de geassocieerde instellingen zullen worden gebruikt.
Het is genaamd .pg_service.conf op systemen van *nix (GNU/Linux, macOS etc.) en pg_service.conf
op Windows.
Het servicebestand kan er zo uitzien:

[water_service]
host=192.168.0.45
port=5433
dbname=gisdb
user=paul
password=paulspass

[wastewater_service]
host=dbserver.com

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)
dbname=water
user=waterpass

Notitie: Er staan twee services in het bovenstaande voorbeeld:water_service en wastewater_service. U
kunt deze gebruiken om te verbinden vanuit QGIS, pgAdmin, etc. door alleen de naam van de service te specificeren
waarmee u wilt verbinden (zonder de omsluitende haakjes). Als u de service wilt gebruiken met psql moet u iets
doen zoals export PGSERVICE=water_service voordat u uw opdrachten voor psql doet.
U vindt alle parameters voor PostgreSQL hier

Notitie: Wanneer u de wachtwoorden niet op wilt slaan in het servicebestand, kunt u de optie .pg_pass gebruiken.

Op besturingssystemen van *nix (GNU/Linux, macOS etc.) kunt u het bestand .pg_service.conf opslaan in de
thuismap van de gebruiker en cliënten van PostgreSQL zullen zich daar automatisch van bewust zĳn. Als bĳvoorbeeld
de ingelogde gebruiker web is, zou .pg_service.conf worden opgeslagen in de map /home/web/ om direct
te kunnen werken (zonder enige andere omgevingsvariabelen te specificeren).
U kunt de locatie van het servicebestand specificeren door een omgevingsvariabele PGSERVICEFILE te maken
(bĳv. voer de opdracht export PGSERVICEFILE=/home/web/.pg_service.conf uit onder uw *nix
besturingssysteem om de variabele PGSERVICEFILE tĳdelĳk in te stellen)
U kunt het servicebestand ook systeembreed beschikbaar maken (alle gebruikers), ofwel door het bestand
.pg_service.conf te plaatsen in pg_config --sysconfdir of door de omgevingsvariabele
PGSYSCONFDIR toe te voegen om de map te specificeren die het servicebestand bevat. Als servicedefinities met
dezelfde naam bestaan in het bestand van de gebruiker en van het systeem, heeft dat van de gebruiker voorrang.

Waarschuwing: Er zĳn enkele valkuilen onder Windows:
• Het servicebestand zoumoeten worden opgeslagen als pg_service.conf en niet als .pg_service.
conf.

• Het servicebestand zou moeten worden opgeslagen in de indeling voor Unix om te kunnen werken. Eén
manier om dat te doen is door het te openen in Notepad++ en dan Bewerken -> Formaat -> UNIX-indeling
-> Bestand opslaan.

• U kunt omgevingsvariabelen op verscheidene manieren toevoegen; een geteste, waarvan bekend is
dat het betrouwbaar is, is Configuratiescherm ► Systeem en beveiliging ► Systeem ► Geavanceerde
systeeminstellingen ► Omgevingsvariabelen toevoegen van PGSERVICEFILE aan het pad - bĳv. C:\
Users\John\pg_service.conf

• Na het toevoegen van een omgevingsvariabele zou u mogelĳk uw computer opnieuw moeten opstarten.

Verbinden met Oracle Spatial

De ruimtelĳke objecten in Oracle Spatial helpen gebruikers bĳ het beheren van geografische en locatie-gegevens in
een eigen type binnen een database van Oracle. In aanvulling op enkele opties in Een opgeslagen verbinding maken,
stelt het dialoogvenster voor:

• Database SID of SERVICE_NAME van de Oracle instantie;
• Poort: Poortnummer waar de server van de database van Oracle naar luistert. De standaard poort is 1521;
• Opties: Specifieke opties voor verbindingen van Oracle (bĳv. OCI_ATTR_PREFETCH_ROWS,
OCI_ATTR_PREFETCH_MEMORY). De indeling van de tekenreeks voor de optie is een door puntkomma’s
gescheiden lĳst van namen van opties of paren van optie=waarde;

• Werkruimte: De werkruimte waarnaar moet worden geschakeld;
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• Schema: Schema waarin de gegevens zĳn opgeslagen
Optioneel kunt u de volgende keuzevakken selecteren:

• Kĳk alleen in de tabel Metadata: dit beperkt de weergegeven tabellen tot die welke aanwezig zĳn in de
weergave all_sdo_geom_metadata. Dit kan de initiële weergave van ruimtelĳke tabellen aanzienlĳk
versnellen.

• Alleen zoeken naar tabellen van de gebruiker: bĳ het zoeken naar ruimtelĳke tabellen, beperk het zoeken
tot alleen die tabellen waar de gebruiker eigenaar van is.

• Ook tabellen zonder geometrie tonen: geeft aan dat ook tabellen zonder geometrie standaard in de lĳst
getoond zouden moeten worden.

• Gebruik geschatte tabelstatistieken voor de laag metadata: wanneer een laag wordt aangemaakt wordt er ook
verschillende metadata aangemaakt voor de tabel in Oracle. Deze bevat informatie als het bĳhouden van het
aantal regels, het type geometrie en het bereik van alle geometrieën in de tabel. Het bĳhouden van dezemetadata
is tĳdrovend als de tabellen veel records bevatten. Door deze optie te activeren, worden de volgende snelle
bewerkingen voor demetadata uitgevoerd: Het aantal regels wordt bepaald vanuitall_tables.num_rows.
De bereiken van elke tabel worden altĳd bepaald met de functie SDO_TUNE.EXTENTS_OF, zelfs wanneer
er een laagfilter wordt gebruikt. Het bepalen van het type geometrie wordt bepaald uit de eerste 100 niet null
regels in de tabel.

• Alleen aanwezige typen geometrie: toon alleen bestaande typen geometrie en biedt niet aan om andere toe
te voegen.

• Aanvullende attributen geometrie opnemen

Tip: Oracle Spatial-lagen
Normaal gesproken wordt een ruimtelĳke laag in ORACLE gedefinieerd door een item in de tabel
USER_SDO_METADATA.
Het wordt aanbevolen dat uw tabellen een primaire sleutel hebben, om er voor te zorgen dat de gereedschappen voor
selecteren correct werken.

Verbinden met MS SQL Server

In aanvulling op enkele opties in Een opgeslagen verbinding maken, stelt het dialoogvenster voor het maken van een
nieuwe verbinding voor MS SQL Server u voor om een Provider/DSN-naam in te vullen. U kunt ook aanwezige
databases weergeven.

Verbinden met SAP HANA

Notitie: U hebt de SAP HANA Client nodig om te kunnen verbinden met een database van SAP HANA. U kunt
de SAP HANA Client voor uw platform downloaden van de SAP Development Tools website.
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Fig. 15.13: Dialoogvenster Nieuwe SAP HANA-verbinding maken
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De volgende parameters kunnen worden ingevoerd:
• Naam: Een naam voor deze verbinding.
• Stuurbestand (driver) : De naam van het stuurprogramma van HANA ODBC. Het is HDBODBC als u
64-bit QGIS gebruikt, HDBODBC32 als u 32-bit QGIS gebruikt. De van toepassing zĳnde naam van het
stuurprogramma wordt automatisch ingevoerd.

• Driver : Voer de naam in waaronder de SAP HANA ODBC-driver is geregistreerd in /etc/
odbcinst.ini of het volledige pad naar de SAP HANA ODBC-driver. Het installatieprogramma
voor de SAP HANA Client zal standaard de ODBC-driverinstalleren naar /usr/sap/hdbclient/
libodbcHDB.so.

• Host: De naam van de host van de database.
• Identificatie: Identificeert de instantie waarmee moet worden verbonden op de host. Dit kan zĳn Nummer

instantie of Nummer poort. Nummers van instanties bestaan uit twee getallen, poortnummers zĳn in het bereik
van 1 tot en met 65,535.

• Modus: Specificeert de modus waarin de SAP HANA-instantie wordt uitgevoerd. Met deze instelling wordt
alleen rekening gehouden als Identificatie is ingesteld opNummer instantie. Als de databasemeerdere containers
host, kunt u ofwel verbinden met een huurder met de naam die is opgegeven bĳ Gepachte database of u kunt
verbinden met de systeemdatabase.

• Schema: Deze parameter is optioneel. Als een naam voor een schema wordt opgegeven, zal QGIS alleen zoeken
naar gegevens in dat schema. Als dit veld leeg wordt gelaten, zal QGIS naar gegevens zoeken in alle schema’s.

• Authenticatie ► Basis.
– Gebruikersnaam: Gebruikersnaam die gebruikt wordt om te verbinden met de database.
– Wachtwoord: Wachtwoord dat gebruikt wordt om te verbinden met de database.

• SSL-instellingen

– Encryptie TLS/SSL inschakelen: Schakelt encryptie TLS 1.1 - TLS1.2 in. De server zal de hoogst
beschikbare kiezen.

– Provider: Specificeert de provider voor de cryptografische bibliotheek, gebruikt voor SSL-communicatie.
sapcrypto zou moeten werken op alle platformen, openssl zou moeten werken op , mscrypto zou
moeten werken op en commoncrypto vereist dat CommonCryptoLib is geïnstalleerd.

– SSL-certificaat valideren: Indien geselecteerd zal het SSL-certificaat worden gevalideerd met de
truststore die is opgegeven in het Truststore-bestand met publieke sleutel.

– Hostnaam overschrĳven in certificaat: Specificeert de hostnaam die wordt gebruikt om de identiteit van
de server te verifiëren. De hier gespecificeerde hostnaam verifieert de identiteit van de server in plaats
van de hostnaam waarmee de verbinding werd gemaakt. Als u * specificeert als de hostnaam, dan wordt
de hostnaam van de server niet gevalideerd. Andere jokertekens zĳn niet toegestaan.

– Bestand sleutelopslag met private sleutel: Momenteel genegeerd. Deze parameter zou het in de toekomst
mogelĳk moeten maken te authenticeren via certificaat in plaats van via gebruikersnaam en wachtwoord.

– Bestand vertrouwde sleutelopslag met publieke sleutel: Specificeert het pad naar een bestand voor
vertrouwde opslag dat de publieke certificaten van de server bevat voor het gebruiken met OpenSSL.
Gewoonlĳk bevat de vertrouwde opslag het broncertificaat of het certificaat van de autoriteit voor
certificaten die de publieke certificaten voor de server heeft ondertekend. Als u de cryptografische
bibliotheek CommonCryptoLib of msCrypto gebruikt, laat deze eigenschap dan leeg.

• Alleen zoeken naar tabellen van de gebruiker: Indien geselecteerd zoekt QGIS alleen naar tabellen en
weergaven waarvan de gebruiker, die is verbonden met de database, eigenaar is.

• Ook tabellen zonder geometrie tonen: Indien geselecteerd zoekt QGIS ook naar tabellen en weergaven die
geen ruimtelĳke kolom bevatten.
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Tip: Verbinden met SAP HANA Cloud
Wanneer u wilt verbinden met een instantie van SAP HANA Cloud, moet u gewoonlĳk het Nummer poort instellen
op 443 en Encryptie TLS/SSL inschakelen selecteren.

Het laden van laag uit een database

Als u eenmaal één of meer verbindingen naar een database hebt gedefinieerd (zie het gedeelte Een opgeslagen
verbinding maken), kunt u er lagenmee laden. Natuurlĳk vereist dat dat gegevens beschikbaar zĳn. Bekĳk het gedeelte
Importeren van gegevens in PostgreSQL voor een bespreking over het importeren van gegevens in een database van
PostgreSQL.
U kunt de volgende stappen uitvoeren om een laag te laden uit een database:

1. Open het dialoogvenster “Databasetabel(len) toevoegen <database>” (zie Een opgeslagen verbinding maken).
2. Kies de verbinding vanuit de keuzelĳst en druk op Verbinden.

3. Selecteer of deselecteer het keuzevak Ook tabellen zonder geometrie tonen

4. Optioneel, gebruik enkele Zoekopties om de lĳst met tabellen te verkleinen tot die welke overeenkomen
met uw zoekactie. U kunt deze optie ook instellen voordat u op de knop Verbinden drukt, wat het ophalen uit
de database versnelt.

5. Zoek naar de laag/lagen die u wilt toevoegen in de lĳst van beschikbare lagen.
6. Selecteer het door er op te klikken. U kunt meerdere lagen selecteren door de Shift- of Ctrl-toets ingedrukt

te houden tĳdens het klikken.
7. Gebruik, indien van toepassing, de knop Filter instellen (of dubbelklik op de laag) om het dialoogvenster

Querybouwer te openen (bekĳk het gedeelte Querybouwer) en definieer welke objecten uit de geselecteerde
laag moeten worden geladen. De expressie voor het filter verschĳnt in de kolom sql. Deze beperking kan
worden verwĳderd of bewerkt in het frame Laageigenschappen ► Algemeen ► Provider objectfilter.

8. Het keuzevak in de kolom Op ID selecteren, dat standaard is geactiveerd, haalt de object-ID’s op zonder
de attributen en versnelt over het algemeen het laden van gegevens.

9. Klik op de knop Toevoegen om de laag toe te voegen aan het kaartvenster.
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Fig. 15.14: Dialoogvenster PostGIS-tabel(len) toevoegen

Tip: Het paneel Browser gebruiken om het laden van tabel(len) van databases te versnellen
Toevoegen van databasetabellen vanuit Databronnen beheren kan soms tĳdverslindend zĳn, omdat QGIS statistieken
en eigenschappen vooraf ophaalt (bĳv. type geometrie en veld, CRS, aantal objecten) voor elke tabel. Om dit te
vermĳden is het beter, als de verbinding is ingesteld, om het paneel Browser of Databronnen beheren te gebruiken om
de tabellen van de database met slepen-en-neerzetten naar het kaartvenster te brengen.

15.1.4 Het paneel Metadata voor laag zoeken

Het paneel Metadata voor laag zoeken stelt u in staat door de metadata van lagen te bladeren van geregistreerde
providers van metadata en dat toe te voegen aan het project.
De lĳst kan worden gefilterd op tekst, op huidig project en op bereik kaartvenster.
De bronnen voor de metadata zĳn geïmplementeerd door een systeem voor providers van metadata voor lagen dat
kan worden uitgebreid met plug-ins.
QGIS verschaft van nature de providers voor metadata van lagen die metadata ophalen van de verbindingen die het
opslaan van metadata toestaan (voor meer details metadata opslaan naar de database).
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Fig. 15.15: Metadata voor laag zoeken

15.1.5 QGIS aangepaste indelingen

QGIS stelt twee aangepaste indelingen voor:
• Tĳdelĳke tekenlaag: een geheugenlaag die is gebonden aan het project (zie Een nieuwe tĳdelĳke tekenlaagmaken
voor meer informatie)

• Virtuele lagen: een laag die resulteert vanuit een query op andere laag/lagen (zie Virtuele lagen maken voor
meer informatie)

15.1.6 QLR - QGIS Laag-definitiebestand

Laagdefinities kunnen worden opgeslagen als een Laag-definitiebestand (QLR - .qlr) met behulp van Exporteren
► Opslaan als Laag-definitiebestand… in het contextmenu van de laag.
De indeling QLR maakt het mogelĳk om “complete” QGIS-lagen te delen met andere gebruikers van QGIS. QLR-
bestanden bevatten koppelingen naar de gegevensbronnen en alle benodigde QGIS stĳlinformatie om de laag op te
kunnen maken.
QLR-bestanden worden in het paneel Browser weergegeven en kunnen worden gebruikt om lagen toe te voegen (met
hun opgeslagen stĳlen) aan het paneel Lagen. U kunt ook QLR-bestanden slepen en neerzetten vanuit de systeem
bestandsbeheerder in het kaartvenster.
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15.1.7 Verbinden met webservices

MetQGIS kunt u toegang verkrĳgen tot verschillende typen webservices van OGC (WM(T)S,WFS(-T),WCS, CSW,
…). Dankzĳ QGIS Server kunt u dergelĳke services ook publiceren. QGIS-Server-manual bevat beschrĳvingen van
deze mogelĳkheden.

Vector tegelservices gebruiken

Vectortegel-services kunnen worden toegevoegd via de tab Vectortegel van het dialoogvenster Databronnen
beheren of het contextmenu van het item Vector Tiles in het paneel Browser. Services kunnen ofwel een Nieuwe
algemene verbinding… of een Nieuwe ArcGIS Vectortegel serviceverbinding… zĳn.
U stelt een service in door toe te voegen:

• een Naam

• de URL: van het type http://example.com/{z}/{x}/{y}.pbf voor algemene services en
http://example.com/arcgis/rest/services/Layer/VectorTileServer voor op
ArcGIS gebaseerde services. De service moet tegels verschaffen in de indeling .pbf.

• het Min. zoomniveau en het Max. zoomniveau. Vectortegels hebben een piramide-structuur. Door deze
opties te gebruiken heeft u de mogelĳkheid om individueel lagen uit de piramide van tegels te maken. Deze
lagen zullen dan worden gebruikt om de vectortegel in QGIS te renderen.
Voor projecties in Mercator (gebruikt door OpenStreetMap Vector Tiles) Geeft zoomniveau 0 de gehele wereld
weer op een schaal van 1:500.000.000. Zoomniveau 14 vertegenwoordigt de schaal 1:35.000.

• een URL stĳl: een URL naar een MapBox GL JSON stĳlconfiguratie. Indien opgegeven dan zal die stĳl
elke keer worden toegepast als de lagen van de verbinding worden toegevoegd aan QGIS. In het geval van
serviceverbindingen van de ArcGis vectortegel, overschrĳft de URL de configuratie voor de standaard stĳl in
de configuratie van de server.

• de configuratie voor de authenticatie indien nodig
• een Verwĳzing

Fig. 15.16 geeft het dialoogvenster weer met de configuratie voor de MapTiler planet Vector Tiles service.
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Fig. 15.16: Vector Tiles - configuratie Maptiler Planet

Configuraties kunnen worden opgeslagen naar een bestand .XML (Opslaan) via het item Vectortegel in het
dialoogvenster Databronnen beheren of het contextmenu daarvan in het paneel Browser. Op dezelfde wĳze kunnen
zĳ vanuit een bestand worden toegevoegd (Laden).
Als eenmaal een verbinding naar een service voor vectortegels is ingesteld, is het mogelĳk om:

• Bewerken van de instellingen voor de verbinding van de vectortegels
• Verwĳderen van de verbinding
• Vanuit het paneel Browser, klik met rechts boven het item en u kunt ook:

– Laag aan project toevoegen: een dubbelklik voegt de laag ook toe
– Bekĳk de Laageigenschapopen… en krĳg toegang tot metadata en een voorbeeld van de gegevens die
door de service worden verschaft. Meer instellingen zĳn beschikbaar als de laag in het project is geladen.

XYZ Tile-services gebruiken

XYZ-tegelservices kunnen worden toegevoegd via de tab XYZ van het dialoogvenster Databronnen beheren of
het contextmenu van het item XYZ Tiles in het paneel Browser. Druk op Nieuw (respectievelĳk Nieuwe verbinding)
en geef op:

• een Naam

• de URL

• de configuratie voor de authenticatie indien nodig
• het Min. zoomniveau en Max. zoomniveau

15.1. Gegevens openen 467



QGIS Desktop 3.28 User Guide

• een Verwĳzing

• de Resolutie tegel: mogelĳke waarden zĳn Onbekend (niet op schaal gebracht), Standaard (256x256 / 96DPI)
en Hoog (512x512 / 192DPI)

• Interpretatie: converteert WMTS/XYZ raster gegevenssets naar een rasterlaag van het type enkele band float
volgens een vooraf gedefinieerd schema voor de codering. Ondersteunde schema’s zĳn Standaard (er wordt
geen conversie uitgevoerd), MapTiler Terrein RGB en Terrarium Terrein RGB. De geselecteerde converter
zal de RGB bronwaarden vertalen naar waarden float voor elke pixel. Eenmaal geladen zal de laag worden
weergegeven als een enkelband, zwevende punt getal rasterlaag, klaar voor het opmaken met de gewone
:ref:`raster renderers ` voor QGIS.

Standaard verschaft QGIS enkele standaard en klaar om te gebruiken XYZ Tiles-services:

• Mapzen Global Terrain, wat onmiddellĳke toegang toestaat voor globale DEM-bron voor de projecten.
Meer details en bronnen op https://registry.opendata.aws/terrain-tiles/

• OpenStreetMap voor toegang tot de 2D-kaart van de wereld. Fig. 15.17 geeft het dialoogvenster weer met
de configuratie van de OpenStreetMap XYZ Tile-service.

Fig. 15.17: XYZ Tiles - OpenStreetMap configuratie

Configuraties kunnen worden opgeslagen naar een bestand .XML (Opslaan) via het item XYZ in het dialoogvenster
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Databronnen beheren of het contextmenu daarvan in het paneel Browser. Op dezelfde wĳze kunnen zĳ vanuit een
bestand worden toegevoegd (Laden).
Het XML-bestand voor OpenStreetMap ziet er zo uit:

<!DOCTYPE connections>
<qgsXYZTilesConnections version="1.0">

<xyztiles url="https://tile.openstreetmap.org/{z}/{x}/{y}.png"
zmin="0" zmax="19" tilePixelRatio="0" password="" name="OpenStreetMap"
username="" authcfg="" referer=""/>

</qgsXYZTilesConnections>

Als eenmaal een verbinding naar een service voor XYZ-tegels is ingesteld, is het mogelĳk om:
• Bewerken van de instellingen voor de verbinding van de XYZ-tegels
• Verwĳderen van de verbinding
• Vanuit het paneel Browser, klik met rechts boven het item en u kunt ook:

– Laag exporteren… ► Naar bestand, het opslaan als een raster

– Laag aan project toevoegen: een dubbelklik voegt de laag ook toe
– Bekĳk de Laageigenschapopen… en krĳg toegang tot metadata en een voorbeeld van de gegevens die
door de service worden verschaft. Meer instellingen zĳn beschikbaar als de laag in het project is geladen.

Voorbeelden van XYZ Tile-services:
• OpenStreetMap Monochrome: URL: http://tiles.wmflabs.org/bw-mapnik/{z}/{x}/{y}.
png, Min. Zoom Level: 0, Max. Zoom Level: 19.

• Google Maps: URL: https://mt1.google.com/vt/lyrs=m&x={x}&y={y}&z={z},Min. Zoom
Level: 0, Max. Zoom Level: 19.

• OpenWeather Map Temperature: URL: http://tile.openweathermap.org/map/temp_new/
{z}/{x}/{y}.png?appid={api_key} Min. Zoom Level: 0, Max. Zoom Level: 19.

ArcGIS REST-servers gebruiken

ArcGIS REST-servers kunnen worden toegevoegd via de tab ArcGIS REST-server van het dialoogvenster
Databronnen beheren of het contextmenu van het item ArcGIS REST-server in het paneel Browser. Druk op Nieuw
(respectievelĳk Nieuwe verbinding) en geef op:

• een Naam

• de URL

• een Eindpunt URL gemeenschap

• een Eindpunt URL inhoud

• de configuratie voor de authenticatie indien nodig
• een Verwĳzing

Notitie: Verbindingen vanArcGIS Feature Service die hun corresponderende eindpunt-URL’s voor het Portal hebben
ingesteld kunnen worden verkend via groepen inhoud in het paneel Browser.
Als een verbinding de eindpunten voor het Portal heeft ingesteld, dan zal het uitbreiden van de verbinding in de
Browser een map “Groepen” en “Services” weergeven, in plaats van de volledige lĳst met services die gewoonlĳk
wordt weergegeven. Uitbreiden van de map Groepen zal een lĳst met alle groepen voor inhoud weergeven waarvan
de gebruiker lid is, elk daarvan kan worden uitgebreid om de items voor de service weer te geven die tot die groep
behoren.
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Configuraties kunnen worden opgeslagen naar een bestand .XML (Opslaan) via het item ArcGIS REST-server in het
dialoogvenster Databronnen beheren of het contextmenu daarvan in het paneel Browser. Op dezelfde wĳze kunnen
zĳ vanuit een bestand worden toegevoegd (Laden).
Als eenmaal een verbinding naar een ArcGIS REST-server is ingesteld, is het mogelĳk om:

• Bewerken van de instellingen voor de verbinding van ArcGIS REST-server
• Verwĳderen van de verbinding
• Bĳwerken van de verbinding
• een filter gebruiken voor de beschikbare lagen

• kiezen uit een lĳst met beschikbare lagenmet de optie voor Alleen objecten bevragen die het huidige zichtbare
bereik overlappen

• Vanuit het paneel Browser, klik met rechts boven het item en u kunt:
– Bĳwerken

– Verbinding bewerken…

– Verbinding verwĳderen…

– Info service bekĳken wat de standaard webbrowser zal openen en de Service Info zal weergeven.
• Klik met rechts op het item van de laag en u kunt ook:

– Info service bekĳken wat de standaard webbrowser zal openen en de Service Info zal weergeven.
– Laag exporteren… ► Naar bestand…

– Laag aan project toevoegen: een dubbelklik voegt de laag ook toe
– Bekĳk de Laageigenschapopen… en krĳg toegang tot metadata en een voorbeeld van de gegevens die
door de service worden verschaft. Meer instellingen zĳn beschikbaar als de laag in het project is geladen.

15.2 Lagen maken

Lagen kunnen op veel manieren worden gemaakt, inclusief:
• lege lagen vanuit niets
• lagen uit bestaande lagen
• lagen vanaf het klembord
• lagen als resultaat van een SQL-achtige query, gebaseerd op één of meerdere lagen (virtuele lagen)

QGIS verschaft ook gereedschappen om vanuit/naar verschillende indelingen te importeren/exporteren.

15.2.1 Nieuwe vectorlagen maken

QGIS stelt u in staat nieuwe lagen te maken in verschillende indelingen. Het verschaft gereedschappen voor het maken
van GeoPackage, Shapefile, SpatiaLite, GPX-indeling en Tĳdelĳke tekenlagen (alias geheugenlagen). Maken van een
nieuwe laag voor GRASS wordt ondersteund in de plug-in GRASS.
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Een nieuwe laag voor GeoPackage maken

Druk, om een nieuwe laag voor GeoPackage te maken, op de knop Nieuwe laag voor GeoPackage… in het menu
Kaartlagen ► Laag maken ► of vanaf de werkbalk Databronnen beheren toolbar. Het dialoogvenster Nieuwe laag
voor GeoPackage zal worden weergegeven, zoals getoond in Fig. 15.18.

Fig. 15.18: Dialoogvenster Nieuwe laag voor GeoPackage maken

1. De eerste stap is om de locatie van het databasebestand aan te geven. Dit kan worden gedaan door te drukken
op de knop … rechts van het veld Database en een bestaand bestand voor GeoPackage te selecteren of een
nieuw te maken. QGIS zal automatisch de juiste extensie toevoegen aan de naam die u opgeeft.

2. Geef de nieuwe laag / tabel een naam (Tabelnaam)
3. Definieer hetType geometrie. Indien geen laag zonder geometrie kunt u specificeren of het Z- dimensie opnemen

en/of M-waarden opnemen moet gebruiken.

4. Specificeer het coördinaten referentiesysteem met de knop .
Velden toevoegen aan de laag die u maakt:

1. Voer de Naam van het veld in
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2. Selecteer het Type gegevens. Ondersteunde types zĳn Tekst-data, Geheel getal (zowel integer als integer64),
Decimaal getal, Datum en Datum & tĳd, Binair (BLOB) en Boolean.

3. Voer de Maximumlengte voor waarden in, afhankelĳk van de geselecteerde indeling van de gegevens.

4. Klik op de knop Aan lĳst met velden toevoegen

5. Voer de stappen hierboven opnieuw uit voor elk veld dat u wilt toevoegen
6. Als u eenmaal tevreden bent met de attributen, klik dan op OK. QGIS zal de nieuwe laag aan de legenda

toevoegen, en u kunt het bewerken zoals beschreven in het gedeelte Het digitaliseren van een bestaande
kaartlaag.

Standaard maakt QGIS, bĳ het maken van een laag voor GeoPackage, een Kolom voor ID van object, genaamd fid,
die optreedt als de primaire sleutel voor de laag. De naam kan worden gewĳzigd. Het veld voor de geometrie, indien
beschikbaar, is genaamd geometry, en u kunt kiezen voor Een ruimtelĳke index maken. Deze opties zĳn te vinden
onder de Geavanceerde opties, samen met de Identificatie laag (korte door mensen te lezen naam van de laag) en de
Beschrĳving laag.
Verder beheer van lagen van GeoPackage kan worden gedaan met de DB Manager.

Nieuwe Shapefile-laag maken

Druk, om een nieuwe laag voor de indeling ESRI Shapefile te maken, op de knop Nieuwe Shapefile-laag… in het
menu Kaartlagen ► Laag maken ► of op de werkbalk Databronnen beheren. Het dialoogvenster Nieuwe Shapefile-
laag zal worden weergegeven, zoals getoond in Fig. 15.19.

1. Geef een pad en bestandsnaam opmet de knop… naast Bestandsnaam. QGIS zal automatisch de juiste extensie
toevoegen aan de naam die u opgeeft.

2. Geef vervolgens de Bestandscodering aan van de gegevens
3. Kies het Type geometrie voor de laag: Geen geometrie (resulterend in een bestand in de indeling .DBF), punt,

multipunt, lĳn of polygoon
4. Specificeer of de geometrie aanvullende dimensies:Geen, Z (+M-waarden) ofM-waarden zoumoeten hebben

5. Specificeer het coördinaten referentiesysteem met de knop .
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Fig. 15.19: Dialoogvenster Nieuwe Shapefile-laag maken

Velden toevoegen aan de laag die u maakt:
1. Voer de Naam van het veld in
2. Selecteer het Type gegevens. Alleen de attributen Decimaal getal, Geheel getal, Tekst-data en Datum worden

ondersteund.
3. Voer de Lengte en Precisie in, afhankelĳk van de geselecteerde indeling voor de gegevens.

4. Klik op de knop Aan lĳst met velden toevoegen

5. Voer de stappen hierboven opnieuw uit voor elk veld dat u wilt toevoegen
6. Als u eenmaal tevreden bent met de attributen, klik dan op OK. QGIS zal de nieuwe laag aan de legenda

toevoegen, en u kunt het bewerken zoals beschreven in het gedeelte Het digitaliseren van een bestaande
kaartlaag.

Standaard wordt eerst een kolom id, integer, toegevoegd, maar die kan worden verwĳderd.

Het maken van een nieuwe SpatiaLite-laag

Druk, om een nieuwe laag voor SpatiaLite te maken, op de knop Nieuwe SpatiaLite-laag… in het menuKaartlagen
► Laag maken ► of op de werkbalk Databronnen beheren. Het dialoogvenster Nieuwe SpatiaLite-laag zal worden
weergegeven, zoals getoond in Fig. 15.20.

15.2. Lagen maken 473



QGIS Desktop 3.28 User Guide

Fig. 15.20: Dialoogvenster Nieuwe SpatiaLite-laag maken

1. De eerste stap is om de locatie van het databasebestand aan te geven. Dit kan worden gedaan door te drukken
op de knop … rechts van het veld Database en selecteer een bestaand bestand voor SpatiaLite of maak een
nieuw. QGIS zal automatisch de juiste extensie toevoegen aan de naam die u opgeeft.

2. Geef een naam (Laagnaam) op voor de nieuwe laag
3. Definieer hetType geometrie. Indien geen laag zonder geometrie kunt u specificeren of het Z- dimensie opnemen

en/of M-waarden opnemen moet gebruiken.

4. Specificeer het coördinaten referentiesysteem met de knop .
Velden toevoegen aan de laag die u maakt:

1. Voer de Naam van het veld in
2. Selecteer hetType gegevens. Ondersteunde types zĳnTekst-data,Geheel getal,Decimaal getal,Datum enDatum

& tĳd.

3. Klik op de knop Aan lĳst met velden toevoegen

4. Voer de stappen hierboven opnieuw uit voor elk veld dat u wilt toevoegen
5. Als u eenmaal tevreden bent met de attributen, klik dan op OK. QGIS zal de nieuwe laag aan de legenda

toevoegen, en u kunt het bewerken zoals beschreven in het gedeelte Het digitaliseren van een bestaande
kaartlaag.

Indien gewenst kunt u Maak een automatisch ophogend primair sleutelveld aan selecteren in het gedeelte
Geavanceerde opties. U kunt ook de Geometriekolom hernoemen (standaard geometry).

474 Hoofdstuk 15. Databronnen beheren



QGIS Desktop 3.28 User Guide

Verder beheer van lagen van SpatiaLite kan worden gedaan met de DB Manager.

Een nieuwe laag met mazen maken

Druk, om een nieuwe laag met mazen te maken, op de knop Nieuwe Laag met mazen… in het menu Kaartlagen►
Laag maken ► of vanaf de werkbalk Databronnen beheren. Het dialoogvenster Nieuwe Laag met mazen zal worden
weergegeven zoals getoond in Fig. 15.21.

Fig. 15.21: Dialoogvenster voor maken van nieuwe Laag met mazen

1. De eerste stap is om de locatie van het bestand met de mazen aan te geven. Dit kan worden gedaan door te
drukken op de knop… rechts van het veld Bestandsnaam en selecteer een bestaand bestand met mazen of een
nieuw te maken.

2. Geef een naam op (Laagnaam), d.i. de naam waarmee de laag wordt weergegeven in het paneel Lagen
3. Selecteer de Bestandsindeling: momenteel ondersteunde bestandsindelingen voor mazen zĳn 2DM Mesh

File (*.2dm), Selafin File (*.slf) en UGRID (*.nc).
4. Geef het Coördinaten ReferentieSysteem aan dat moet worden toegewezen aan de gegevensset
5. Bovenstaande stappen zullen een lege laag maken waarin u nadien punten kunt digitaliseren en groepen van

gegevenssets kunt toevoegen. Het is echter ook mogelĳk de laag te initialiseren met een bestaande laag met
mazen, d.i. de nieuwe laag vullen met punten of zĳden vanuit de andere. Om dat te doen:

1. Selecteer Mazen initialiseren met
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2. en selecteer ofwel Mazen uit het huidige project of Mazen uit bestand. Informatie over het geselecteerde
bestand met mazen wordt ter controle weergegeven.

Merk op dat alleen het frame van de laag met mazen wordt overgebracht naar de nieuwe laag; hun gegevenssets
worden niet gekopieerd.

Een nieuwe GPX-laag maken

Een nieuw GPX-bestand maken:

1. Selecteer Laag maken ► Nieuwe GPX-laag… uit het menu Kaartlagen.
2. Kies, in het dialoogvenster, waar het nieuwe bestand moet worden opgeslagen, geef het een naam en druk op

Opslaan.
3. Drie nieuwe lagen zĳn toegevoegd aan het paneel Lagen.

• een puntenlaag om locaties te digitaliseren (waypoints) met velden voor het opslaan van de naam,
hoogte, opmerking, omschrĳving, bron, URL en naam van de URL

• een lĳnenlaag om reeksen van locaties die samen een geplande route vormen te digitaliseren (routes)
met velden voor het opslaan van de naam, symbool, nummer, opmerking, omschrĳving, bron, URL en
naam van de URL

• en een lĳnenlaag om de verplaatsing van de ontvanger in tĳd vast te leggen (tracks) met velden voor
het opslaan van de naam, symbool, nummer, opmerking, omschrĳving, bron, URL en naam van de URL.

4. U kunt nu elk daarvan bewerken, zoals beschreven in het gedeelteHet digitaliseren van een bestaande kaartlaag.

Een nieuwe tijdelijke tekenlaag maken

Tĳdelĳke tekenlagen zĳn in-geheugenlagen, wat betekent dat zĳ niet worden opgeslagen op schĳf en zullen worden
verwĳderd als QGIS wordt afgesloten. Zĳ kunnen handig zĳn voor het opslaan van objecten die u tĳdelĳk nodig hebt
of als tussenliggende lagen gedurende bewerkingen voor geoprocessing.

Kies, om een nieuwe Tĳdelĳke tekenlaag te maken, het item Nieuwe tĳdelĳke tekenlaag… in het menu Kaartlagen
► Laag maken► of op de werkbalk Databronnen beheren. Het dialoogvenster Nieuwe tĳdelĳke tekenlaag zal worden
weergegeven, zoals getoond in Fig. 15.22. Dan:

1. Geef de Laagnaam op
2. Selecteer het type Geometrie. Hier kunt u maken een:

• Geen geometrie type laag, aangeboden als eenvoudige tabel,
• Punt of MultiPunt laag,
• Lijn/CompoundCurve of MultiLijn/MultiCurve laag,
• Polygoon/CurvePolygon of MultiPolygoon/MultiSurface laag.

3. Specificeer, voor typen geometrie, de dimensies van de gegevensset: selecteer of het Z-dimensie opnemen en/of
M-waarden opnemen moet gebruiken

4. Specificeer het coördinaten referentiesysteem met de knop .
5. Voeg velden toe aan de laag. Onthoud dat, anders dan vele indelingen, tĳdelĳke lagen gemaakt kunnen worden

zonder velden. Deze stap is dus optioneel.
1. Voer de Naam van het veld in
2. Selecteer het Type gegevens. Tekst-data, Geheel getal, Decimaal getal, Boolean, Datum, Tĳd, Datum &

tĳd en Binair (BLOB) worden ondersteund.
3. Voer de Lengte en Precisie in, afhankelĳk van de geselecteerde indeling voor de gegevens.
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4. Klik op de knop Aan lĳst met velden toevoegen

5. Herhaal de stappen hierboven voor elk veld dat u wilt toevoegen
6. Als u eenmaal tevreden bent met de instellingen, klik dan op OK. QGIS zal de nieuwe laag aan het paneel

Lagen toevoegen, en u kunt het bewerken zoals beschreven in het gedeelte Het digitaliseren van een bestaande
kaartlaag.

Fig. 15.22: Dialoogvenster Nieuwe tijdelijke tekenlaag maken

U kunt ook vooraf gevulde tĳdelĳke tekenlagen maken met bĳv. het klembord (zie Nieuwe lagen maken vanaf het
klembord) of als een resultaat van een algoritme van Processing.

Tip: Een geheugenlaag permanent opslaan op schĳf
U kunt, om gegevensverlies te voorkomen bĳ het sluiten van een project met tĳdelĳke tekenlagen, deze lagen opslaan
naar elke indeling voor vector die wordt ondersteund door QGIS:

• klikken op het pictogram naast de laag;
• selecteren van het item Permanent maken in het contextmenu van de laag;
• met het item Exporteren ► uit het contextmenu of het menu Kaartlagen ► Opslaan als….

Elk van deze opdrachten opent het dialoogvenster Vectorlaag opslaan als, zoals beschreven in het gedeelte Nieuwe
lagen uit een bestaande laag maken, en het opgeslagen bestand vervangt het tĳdelĳke in het paneel Lagen.
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15.2.2 Nieuwe lagen uit een bestaande laag maken

Zowel raster- als vectorlagen kunnen worden opgeslagen in verschillende indelingen en/of opnieuw worden
geprojecteerd in een ander coördinaten referentiesysteem (CRS) met het menu Kaartlagen ► Opslaan als… of door
met rechts te klikken op de laag in het paneel Lagen en te selecteren:

• Exporteren ► Opslaan als… voor rasterlagen
• Exporteren ► Objecten opslaan als… of Exporteren ► Geselecteerde objecten opslaan als… voor vectorlagen.
• Sleep de laag uit de boommet lagen naar het item PostGIS in het paneel Browser en zet hem daar neer. Onthoud
dat u een verbinding naar PostGIS moet hebben in het paneel Browser.

Algemene parameters

Het dialoogvenster Opslaan als… geeft verscheidene parameters weer om het gedrag te wĳzigen bĳ het opslaan van
de laag. Onderdeel van de algemene parameters voor raster en vector zĳn:

• Bestandsnaam: de locatie van het bestand op de schĳf. Het mag verwĳzen naar de uitvoerlaag of naar
een container die de laag opslaat (bĳvoorbeeld database-achtige indelingen zoals GeoPackage, SpatiaLite of
OpenDocument-werkbladen).

• CRS: kan worden gewĳzigd om de gegevens opnieuw te projecteren
• Bereik: beperkt het bereik van de invoer dat zal worden geëxporteerd met de widget Bereik selecteren

• Voeg opgeslagen bestand toe aan de kaart: om de nieuwe laag toe te voegen aan het kaartvenster
Sommige parameters zĳn echter specifiek voor raster- en vectorindelingen:

Rasterspecifieke parameters

Afhankelĳk van de indeling voor het exporteren, zouden enkele van deze opties wel of niet beschikbaar kunnen zĳn:
• Modus uitvoer (kan zĳn ruwe gegevens of gerenderde afbeelding)
• Indeling: exporteert naar elke rasterindeling waar GDAL naar toe kan schrĳven, zoals GeoTiff, GeoPackage,
MBTiles, Geospatial PDF, SAGA GIS Binary Grid, Intergraph Raster, ESRI .hdr Labelled…

• Resolutie

• Opties voor aanmaken: gebruik geavanceerde opties (bestandscompressie, blokgrootten, kleurbepaling…) bĳ
het maken van bestanden, ofwel uit de vooraf gedefinieerde profielen voor maken gerelateerd aan de indeling
voor uitvoer of door elke parameter in te stellen.

• Piramiden maken

• VRT-tegels in het geval u koos voor VRT maken

• Waarden Geen gegevens
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Fig. 15.23: Als nieuwe rasterlaag opslaan

Vectorspecifieke parameters

Afhankelĳk van de indeling voor het exporteren, zouden enkele van deze opties beschikbaar kunnen zĳn:
• Indeling: exporteert naar elke vectorindeling waar GDAL naar toe kan schrĳven, zoals GeoPackage, GML,
ESRI Shapefile, AutoCAD DXF, ESRI FileGDB, Mapinfo TAB of MIF, SpatiaLite, CSV, KML, ODS, …

• Laagnaam: beschikbaar als Bestandsnaam verwĳst naar een container-achtige indeling, dit item geeft de
uitvoerlaag weer.

• Codering

• Alleen geselecteerde objecten opslaan

• Te exporteren veld en hun opties voor exporteren selecteren: verschaft manieren om velden te exporteren met
aangepaste namen en instellingen voor widget formulier:

– Selecteer rĳen in de kolom Naam om velden te kiezen die moeten worden behouden in de uitvoerlaag,
of druk op de knoppen Alles selecteren of Alles deselecteren

– Schakel met het keuzevak Aliassen gebruiken voor geëxporteerde naam om de kolom Naam exporteren
te vullen met het corresponderende alias van het veld of te herstellen naar de originele veldnaam.
Dubbelklikken op een cel zal ook de naam bewerken.

– Afhankelĳk van het feit of aangepaste widgets voor attribuutformulieren in gebruik zĳn, kunt u
Alle geselecteerde ruwe veldwaarden vervangen door weergegeven waarden. Bĳv. als een widget
waardenkaart is toegepast op een veld, zal de uitvoerlaag de beschreven waarden bevatten in plaats
van de originele waarden. Het vervangen ka ook worden gedaan op een veld-per-veld basis basis, in de
kolom Vervangen door weergegeven waarden.
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• Metadata laag vasthouden: zorgt ervoor dat enige metadata voor de laag die aanwezig is in de bronlaag zal
worden gekopieerd en opgeslagen:

– in de nieuw gemaakte laag, als de uitvoer in de indeling GeoPackage is
– als een bestand .qmd naast de uitvoerlaag, voor andere indelingen. Onthoud dat op bestand gebaseerde
indelingen die meer dan één gegevensset ondersteunen (bĳv. SpatiaLite, DXF, …) onbedoeld gedrag
kunnen vertonen.

• Exporteren van symbologie: kan voornamelĳk worden gebruikt voor exporteren naar DXF en voor alle
bestandsindelingen die objectstĳlen voor OGR beheren (zie opmerking hieronder) zoals DXF, KML, tab-
bestandsindelingen:

– Geen symbologie: standaard stĳl van de toepassing die de gegevens leest
– Objectsymbologie: stĳl opslaan met OGR objectstĳlen (zie opmerking hieronder)
– Symboollaagsymbologie: opslaan met OGR objectstĳlen (zie opmerking hieronder) maar exporteer
dezelfde geometrie meerdere keren als er meerdere symbologie symboollagen worden gebruikt

– Een waarde Schaal kan worden toegepast op de laatste opties

Notitie: OGR Feature Styles zĳn een manier om stĳl direct op te slaan in de gegevens als een verborgen attribuut.
Alleen sommige indelingen kunnen dit soort informatie afhandelen. KML-, DXF- en TAB-bestandsindelingen zĳn
dergelĳke indelingen. Voor meer geavanceerde details, kunt u het document specificatie OGR Feature Styles lezen.

• Geometrie: u kunt de mogelĳkheden voor de geometrie van de uitvoerlaag configureren
– Type geometrie: behoudt de originele geometrie van de objecten indien ingesteld opAutomatisch, anders
verwĳdert het die of overschrĳft het met elk type. U kunt een lege geometriekolom toevoegen aan een
attributentabel en de geometriekoom van een ruimtelĳke laag verwĳderen.

– Multi-type forceren: forceer het maken van multi-geometrie-objecten op de laag.
– Z-dimensie opnemen in geometrieën.

Tip: Overschrĳven van het type geometrie van de laag maakt het mogelĳk om dingen te doen zoals het opslaan van
een tabel zonder geometrie (bĳv. .csv-bestand) in een shapefile MET elk type geometrie (punt, lĳn, polygoon),
zodat geometrieën dan handmatig kunnen worden toegevoegd aan rĳen met het gereedschap Deel toevoegen .

• Databron opties, Laagopties of Aangepaste opties die u in staat stellen gevorderde parameters te configureren,
afhankelĳk van de indeling voor de uitvoer. Sommige worden beschreven in Gegevensindelingen en velden
verkennen, maar voor de volledige details, bekĳk de GDAL documentatie voor het stuurprogramma.
Elke bestandsindeling heeft zĳn eigen aangepaste parameters, bĳv. bekĳk voor de indeling GeoJSON de
documentatie op GDAL GeoJSON.
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Fig. 15.24: Als nieuwe vectorlaag opslaan

Bĳ het opslaan van een vectorlaag in een reeds bestaand bestand, afhankelĳk van de mogelĳkheden van de indeling
voor de uitvoer (Geopackage, SpatiaLite, FileGDB…), kan de gebruiker beslissen om:

• het gehele bestand te overschrĳven
• alleen de doellaag te overschrĳven (de laagnaam is aan te passen)
• objecten toe te voegen aan de bestaande doellaag
• objecten toe te voegen, nieuwe velden toe te voegen indien die er zĳn.

Voor indelingen zoals ESRI Shapefile, MapInfo .tab is het toevoegen van objecten ook beschikbaar.
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15.2.3 Nieuwe DXF-bestanden maken

Naast het dialoogvenster Opslaan als… dat opties verschaft voor het exporteren van één enkele laag naar een andere
indeling, inclusief *.DXF, verschaft QGIS een ander gereedschap om meerdere lagen te exporteren naar één enkele
laag DXF. Het is toegankelĳk via het menu Project ► Importeren/Exporteren ► Exporteer project naar DXF….
In het dialoogvenster DXF export:

1. Geef het doelbestand op.
2. Kies de modus voor Symbologie en de schaal (bekĳk de opmerkingOGR Feature Styles), indien van toepassing.
3. Selecteer de Codering voor de gegevens.
4. Selecteer het toe te passen CRS: de geselecteerde lagen zullen opnieuw worden geprojecteerd naar het

opgegeven CRS.
5. Selecteer de in de DXF-bestanden op te nemen lagen, ofwel door ze te selecteren in de widget Tabel of door ze

automatisch te kiezen uit een bestaand kaartthema. De knoppen Alles selecteren en Alles deselecteren kunnen
helpen om snel de te exporteren gegevens in te stellen.
Voor elke laag kunt u kiezen of alle objecten naar één enkele DXF-laag moeten worden geëxporteerd of
vertrouwen op een veld waarvan de waarden worden gebruikt om de objecten te verdelen in lagen voor de
uitvoer in DXF.

Optioneel kunt u ook kiezen om:

• Titel van laag gebruiken als naam indien ingesteld in plaats van de laagnaam zelf;

• Exporteer objecten die overlappen met het huidige kaartbereik;

• 2D-uitvoer forceren (bĳv. om breedte polylĳn te ondersteunen);

• Labels als elementen MTEXT exporteren of als elementen TEXT.

Fig. 15.25: Dialoogvenster Exporteer project naar DXF
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15.2.4 Nieuwe lagen maken vanaf het klembord

Objecten die op het klembord staan kunnen worden geplakt in een nieuwe laag. maak de laag eerst bewerkbaar om
dit te kunnen doen. Selecteer enkele objecten, kopieer ze naar het klembord en plak ze dan in de nieuwe laag met
behulp van Bewerken ► Objecten plakken als ► en kies:

• Nieuwe vectorlaag…: het dialoogvensterVectorlaag opslaan als… verschĳnt (zieNieuwe lagen uit een bestaande
laag maken voor parameters)

• of Tĳdelĳke tekenlaag…: u dient een naam op te geven voor de laag
Een nieuwe laag, gevuld met de geselecteerde objecten en hun attributen, wordt gemaakt (en toegevoegd aan het
kaartvenster).

Notitie: Lagen maken vanaf het klembord is mogelĳk met geselecteerde objecten en gekopieerd binnen QGIS, als
ook vanuit andere toepassingen, zolang als hun geometrieën maar zĳn gedefinieerd met well-known text (WKT).

15.2.5 Virtuele lagen maken

Een virtuele laag is een speciaal soort vectorlaag. Het stelt u in staat een laag te definiëren als resultaat van een SQL-
query die elk aantal andere vectorlagen kan bevatten die QGIS in staat is te openen. Virtuele lagen dragen zelf geen
gegevens en kunnen worden gezien als views.
Open, om een virtuele laag te maken, het dialoogvenster voor het maken van een virtuele laag door:

• het item Virtuele laag toevoegen/bewerken te kiezen in het menu Kaartlagen ► Laag toevoegen ►;

• de tab Virtuele laag in het dialoogvenster Databronnen beheren in te schakelen;
• of de boom in het dialoogvenster DB Manager te gebruiken.

Het dialoogvenster stelt u in staat een Laagnaam en een SQL-Query te specificeren. De query mag de naam (of ID)
van bestaande vectorlagen als tabellen gebruiken, als ook hun veldnamen als kolommen.
Indien u bĳvoorbeeld een laag heeft die is genaamdairports, kunt u een nieuwe virtuele laagmaken die is genaamd
public_airports met een SQL-query als:

SELECT *
FROM airports
WHERE USE = "Civilian/Public"

De query voor SQL zal worden uitgevoerd, ongeacht de onderliggende provider van de laag airports, zelfs als
deze provider niet direct query’s voor SQL ondersteunt.
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Fig. 15.26: Dialoogvenster Virtuele laag maken

Koppelingen en complexe query’s kunnen ook eenvoudigweg worden gemaakt, bĳvoorbeeld om de informatie van
airports en country samen te voegen.

SELECT airports.*, country.population
FROM airports
JOIN country
ON airports.country = country.name

Notitie: Het is ook mogelĳk virtuele lagen te maken met het venster SQL van Plug-in DB Manager.

Lagen inbedden om in query’s te gebruiken

Naast de beschikbare vectorlagen in het kaartvenster, kan de gebruiker ook lagen toevoegen aan de lĳst met Ingebedde
lagen, die in query’s kan worden gebruikt zonder de noodzaak om ze te hebben weergegeven in het kaartvenster of
het paneel Lagen.
Klik, om een laag in te bedden, op Toevoegen en geef de Lokale naam, Provider, Codering en het pad naar de Bron
op.
De knop Importerenmaakt het mogelĳk lagen vanuit het kaartvenster toe te voegen aan de lĳst Ingebedde lagen. Deze
lagen kunnen dan uit het paneel Lagen worden verwĳderd, zonder bestaande query’s te beschadigen.
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Ondersteunde taal voor query

Het onderliggende programma gebruikt SQLite en SpatiaLite voor bewerkingen.
Dat betekent dat u alles voor SQL kunt gebruiken dat uw lokale installatie van SQLite begrĳpt.
Functies uit SQLite en ruimtelĳke functies uit SpatiaLite kunnen ook worden gebruikt voor een query voor een
virtuele laag. Maken van bĳvoorbeeld een puntenlaag uit een laag met alleen attributen kan worden gedaan met een
query soortgelĳk aan:

SELECT id, MakePoint(x, y, 4326) as geometry
FROM coordinates

Functies van expressies van QGIS kunnen ook worden gebruikt in een query voor een virtuele laag.
Gebruik de naam geometry om te verwĳzen naar de geometriekolom van een laag.
Tegengesteld aan een pure SQL-query, moeten alle velden van een query voor een virtuele laag een naam hebben.
Vergeet niet het sleutelwoord as te gebruiken om uw kolommen een naam te geven als zĳ het resultaat zĳn van een
berekening of de aanroep van een functie.

Problemen bij de uitvoering

Met standaard parameters zal het programma voor virtuele lagen zĳn best doen om het type van de verschillende
kolommen van de query te bepalen, inclusief het type van de geometriekolom, als die aanwezig is.
Dit wordt gedaan door introspectie van de query waar mogelĳk of door de eerste rĳ van de query op te halen (LIMIT
1) als een laatste redmiddel. Ophalen van de eerste rĳ van het resultaat om uiteindelĳk de laag te maken zou ongewenst
kunnen zĳn om redenen van uitvoering.
Het dialoogvenster voor het maken van de parameters:

• Unieke kolom voor identificatie: specificeert een veld van de query dat unieke waarden integer weergeeft, die
QGIS kan gebruiken als identificatie voor rĳen. Standaard wordt een automatisch verhogende waarde integer
gebruikt. Definiëren van een unieke kolom voor identificatie versnelt het selecteren van rĳen op ID.

• Geen geometrie: forceert de virtuele laag om elk veld voor geometrie te negeren. De resulterende laag is een
laag met alleen attributen.

• Geometrie Geometriekolom: specificeert de naam van de geometriekolom.
• Geometrie Type: specificeert het type geometrie.
• Geometrie CRS: specificeert het coördinaten referentiesysteem voor de virtuele laag.

Speciale opmerkingen

Het programma voor de virtuele laag probeert het type te bepalen voor elke kolom van de query. Als dat mislukt
wordt de eerste rĳ van de query opgehaald om typen kolommen te bepalen.
Het type van een bepaalde kolom kan direct in de query worden gespecificeerd met behulp van enkele speciale
opmerkingen.
De syntaxis is de volgende: /*:type*/. Het moet worden geplaatst net na de naam van een kolom. typemag zĳn
int voor integers, real voor floating point-getallen of text.
Bĳvoorbeeld:

SELECT id+1 as nid /*:int*/
FROM table

Het type en coördinaten referentiesysteem van de geometriekolom kan ook worden ingesteld dankzĳ speciale
opmerkingen met de volgende syntaxis /*:gtype:srid*/ waar gtype het type geometrie is (point,
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linestring, polygon, multipoint, multilinestring of multipolygon) en srid een integer die
de code voor EPSG van een coördinaten referentiesysteem weergeeft.

Indexen gebruiken

Bĳ het bevragen van een laag door middel van een virtuele laag, worden de indices van de bronlaag op de volgende
manieren gebruikt:

• als een predicaat = wordt gebruikt in de kolom voor de primaire sleutel van de laag, zal de onderliggende
gegevensprovider worden gevraagd naar een bepaalde ID (FilterFid)

• voor elk ander predicaat (>, <=, !=, etc.) of op een kolom zonder primaire sleutel zal een verzoek dat is
opgebouwd uit een expressie worden gebruikt om de onderliggende gegevensprovider te bevragen. Dat betekent
dat indexen, als zĳ bestaan, kunnen worden gebruikt voor databaseproviders.

Er bestaat een specifieke syntaxis om ruimtelĳke predicaten in verzoeken af te handelen en het gebruiken van een
ruimtelĳke index te activeren: er bestaat voor elke virtuele laag een verborgen kolom, genaamd _search_frame_.
Deze kolom mag voor gelĳkheid worden vergeleken met een begrenzingsvak. Voorbeeld:

SELECT *
FROM vtab
WHERE _search_frame_=BuildMbr(-2.10,49.38,-1.3,49.99,4326)

Ruimtelĳke binaire gezegdes als ST_Intersects worden significant versneld als zĳ samen worden gebruikt met
deze syntaxis voor ruimtelĳke indexen.

15.3 Gegevensindelingen en velden verkennen

15.3.1 Rastergegevens

GIS rastergegevens zĳn matrices van afzonderlĳke cellen die objecten / fenomenen weergeven op, boven of onder het
oppervlak van de aarde. Elke cel in het raster heeft dezelfde grootte, en cellen zĳn gewoonlĳk rechthoekig (in QGIS
zullen zĳ altĳd rechthoekig zĳn). Normale raster gegevenssets bevatten gegevens van remote sensing, zoals luchtfoto’s
of satellietafbeeldingen en gemodelleerde gegevens, zoals hoogte of temperatuur.
Anders dan vectorgegevens, hebben rastergegevens gewoonlĳk geen geassocieerd databaserecord voor elke cel. Zĳ
zĳn voorzien van geocoderingen op pixelresolutie en de X/Y-coördinaat van een hoekpixel van de rasterlaag. Dit stelt
QGIS in staat de gegevens correct in het kaartvenster te plaatsen.
De indeling GeoPackage is handig voor het opslaan van rastergegevens bĳ het werken met QGIS. De populaire en
krachtige indeling GeoTiff is een goed alternatief.
QGIS maakt gebruik van informatie over geo-verwĳzingen in het rasterbestand zelf (bĳvoorbeeld GeoTiff) of in een
geassocieerd world file om de rastergegevens correct weer te geven.

15.3.2 Vectorgegevens

Veel mogelĳkheden en gereedschappen die beschikbaar zĳn in QGIS werken hetzelfde, ongeacht de bron voor
de vectorgegevens. Echter, vanwege de verschillen in specificaties van indelingen (GeoPackage, ESRI Shapefile,
MapInfo en MicroStation bestandsindelingen, AutoCAD DXF, PostGIS, SpatiaLite, Oracle Spatial, MSSQL Spatial,
SAP HANA Spatial databases, en nog veel meer), zou QGIS sommige van hun eigenschappen verschillend af kunnen
handelen. Ondersteuning wordt verschaft door de ``GDAL vector drivers <https://gdal.org/drivers/vector/index.
html>`_. Dit gedeelte beschrĳft hoe te werken met deze specifieken.

Notitie: QGIS ondersteunt objecttypen (multi)punt, (multi)lĳn, (multi)polygoon, CircularString, CompoundCurve,
CurvePolygon, MultiCurve, MultiSurface, alle optioneel met Z- en/of M-waarden.
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U zou ook moeten onthouden dat sommige stuurprogramma’s enkele van deze objecttypen niet ondersteunen: zoals
objecttype CircularString, CompoundCurve, CurvePolygon, MultiCurve, MultiSurface. QGIS zal ze converteren.

GeoPackage

De indeling GeoPackage (GPKG) is platform-onafhankelĳk, en is geïmplementeerd als een container voor een
database van SQLite, en kan worden gebruikt om zowel vector- als rastergegevens op te slaan. De indeling werd
gedefinieerd door het Open Geospatial Consortium (OGC), en werd gepubliceerd in 2014.
GeoPackage kan worden gebruikt om het volgende op te slaan in een database van SQLite:

• vector-objecten
• tegel-matrixsets van afbeeldingen en raster-kaarten
• attributen (niet ruimtelĳke gegevens)
• extensies

Sinds QGIS versie 3.8 kan GeoPackage ook projecten van QGIS opslaan. Lagen van GeoPackage mogen velden voor
JSON hebben.
GeoPackage is de standaardindeling voor vectorgegevens in QGIS.

ESRI Shapefile-indeling

De indeling ESRI Shapefile is nog steeds een van de meest gebruikte vector bestandsindelingen, zelfs terwĳl het
enkele beperkingen heeft, vergeleken met andere bestandsindelingen, zoals GeoPackage en SpatiaLite.
Een gegevensset met een indeling ESRI Shapefile bestaat feitelĳk uit meerdere bestanden. De volgende drie zĳn
vereist:

1. .shp bestand dat de geometrieën van de objecten bevat
2. .dbf bestand dat de attribuutwaarden bevat in de indeling voor dBase
3. .shx het indexbestand

Een gegevensset met de indeling ESRI Shapefile kan ook een bestand bevatten met de bestandsextensie .prj, het
projectiebestand dat informatie over het coördinatensysteem bevat. Alhoewel een projectiebestand erg handig is, is
het niet noodzakelĳk. Een gegevensset Shapefile kan daarnaast nog meer bestanden bevatten. Voor verdere details,
bekĳk de technische specificaties van ESRI op technical specification.
GDAL heeft ondersteuning voor lezen-schrĳven voor gecomprimeerde indeling ESRI Shapefile (shz en shp.zip).
Verbeteren van de uitvoering voor gegevenssets in de indeling ESRI Shapefile
U kunt een ruimtelĳke index maken om de uitvoering van het tekenen van gegevenssets met de indeling ESRI
Shapefile te verbeteren. Een ruimtelĳke index zal er voor zorgen dat u sneller kunt in- en uitzoomen en het beeld kunt
verschuiven. Ruimtelĳke indexen die gebruikt worden door QGIS hebben de extensie .qix na de bestandsnaam.
Gebruik de volgende stappen om de index te maken:

1. Laad een gegevensset in de indeling ESRI Shapefile (zie Het paneel Browser)
2. Open het dialoogvenster Laageigenschappen door in de legenda te dubbelklikken op de naam van de laag of

door met rechts te klikken en Eigenschappen… te selecteren in het contextmenu
3. Klik, op de tab Bron, op de knop Ruimtelĳke index maken

Problemen bĳ het laden van een bestand .prj
Als u een gegevensset in de indeling ESRI Shapefile met een bestand .prj laadt en QGIS is niet in staat het
coördinaten referentiesysteem uit dat bestand te lezen, moet u de juiste projectie handmatig definiëren op de tab
Laageigenschappen► Bron van de laag door te klikken op de knop CRS selecteren. Dit omdat bestanden .prj vaak
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niet de volledige parameters verschaffen zoals die worden gebruikt in QGIS en zĳn vermeld in het dialoogvenster
CRS.
Als u met QGIS een nieuwe gegevensset in de indeling ESRI Shapefile maakt worden, om dezelfde reden, twee
verschillende projectiebestanden gemaakt: een bestand .prj met beperkte parameters voor projectie, compatibel
met software voor ESRI, en een bestand .qpj, dat alle parameters van het CRS verschaft. Iedere keer wanneer
QGIS een bestand .qpj vindt, zal dat worden gebruikt in plaats van het bestand .prj.

Tekstgescheiden bestanden

Tekengescheiden tekstbestanden komen veel voor en worden breed gebruikt vanwege hun simpliciteit en leesbaarheid
– gegevens kunnen worden bekeken en bewerkt in een normale tekstbewerker. Een tekengescheiden tekstbestand is
gegevens in kolommen, gescheiden door een gedefinieerd teken en rĳen gescheiden door regeleinden. De eerste rĳ
bevat normaal gesproken de namen van de kolommen. Een veel voorkomend type tekengescheiden tekstbestand is een
CSV (Comma Separated Values = kommagescheiden waarden), met kolommen die zĳn gescheiden door komma’s.
Tekengescheiden tekstbestanden kunnen ook positionele informatie bevatten (zie Informatie over geometrie opslaan
in tekengescheiden tekstbestanden).
QGIS stelt u in staat een tekengescheiden tekstbestand te laden als een gewone laag of als een gewone tabel (zie Het
paneel Browser of Een tekstgescheiden bestand importeren). Controleer eerst of het bestand voldoet aan de volgende
vereisten:

1. Het bestand moet een gescheiden kopregel met veldnamen hebben. Dit moet de eerste regel in het tekstbestand
zĳn (idealiter de eerste rĳ in het tekstbestand).

2. Als geometrie zou moeten zĳn ingeschakeld, moet het bestand veld(en) bevatten die de geometrie definiëren.
Deze veld(en) mogen elke naam hebben.

3. De velden voor X- en Y-coördinaten (als de geometrie wordt gedefinieerd door coördinaten) moeten zĳn
gespecificeerd als getallen. Het coördinatensysteem is niet belangrĳk.

4. Als u een CSV-bestand hebt met kolommen die geen tekenreeks zĳn, mag u een begeleidend bestand CSVT
hebben (bekĳk het gedeelte CSVT-bestand gebruiken voor beheren van de opmaak van velden).

Het gegevensbestand met hoogtepunten elevp.csv in de voorbeeld gegevensset in QGIS, (bekĳk het gedeelte
Voorbeeldgegevens downloaden), is een voorbeeld van een geldig tekstbestand:

X;Y;ELEV
-300120;7689960;13
-654360;7562040;52
1640;7512840;3
[...]

Enkele opmerkingen met betrekking tot het tekstbestand:
1. Het voorbeeld tekstbestand gebruikt ; (puntkomma) als scheidingsteken (elk teken mag worden gebruikt om

de velden te scheiden).
2. De eerst rĳ is de kopregel. Deze bevat de velden X, Y en ELEV.
3. Er worden geen aanhalingstekens (") gebruikt om tekstvelden te scheiden
4. De X-coördinaten zĳn opgenomen in het veld X
5. De Y-coördinaten zĳn opgenomen in het veld Y
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Informatie over geometrie opslaan in tekengescheiden tekstbestanden

Gescheiden tekstbestanden kunnen informatie over geometrie bevatten in twee belangrĳke vormen:
• Als coördinaten in afzonderlĳke kolommen (bĳv. Xkol, Ykol… ), voor gegevens van geometrie punt;
• Als weergave wel bekende tekst (WKT) van geometrie in één enkele kolom, voor elk type geometrie.

Objecten met gebogen geometrieën (CircularString, CurvePolygon en CompoundCurve) worden ondersteund. Hier
zĳn enkele voorbeelden van typen geometrie in een tekengescheiden tekstbestand met geometrieën gecodeerd als
WKT:

Label;WKT_geom
LineString;LINESTRING(10.0 20.0, 11.0 21.0, 13.0 25.5)
CircularString;CIRCULARSTRING(268 415,227 505,227 406)
CurvePolygon;CURVEPOLYGON(CIRCULARSTRING(1 3, 3 5, 4 7, 7 3, 1 3))
CompoundCurve;COMPOUNDCURVE((5 3, 5 13), CIRCULARSTRING(5 13, 7 15,

9 13), (9 13, 9 3), CIRCULARSTRING(9 3, 7 1, 5 3))

Tekengescheiden tekstbestanden ondersteunen ook waarden Z en M in geometrieën:

LINESTRINGZ(10.0 20.0 30.0, 11.0 21.0 31.0, 11.0 22.0 30.0)

CSVT-bestand gebruiken voor beheren van de opmaak van velden

Bĳ het laden van CSV-bestanden gaat het stuurprogramma van GDAL er van uit dat alle velden tekenreeksen (d.i.
tekst) is, tenzĳ anders is aangegeven. U kunt een bestand CSVT maken om GDAL (en QGIS) het type gegevens in
de verschillende kolommen door te geven:

Type Naam Voorbeeld
Geheel getal Integer 4
Boolean Integer(Boolean) true
Decimaal getal Real 3.456
Datum Date (YYYY-MM-DD) 2016-07-28
Tĳd Time (HH:MM:SS+nn) 18:33:12+00
Datum & Tĳd DateTime (YYYY-MM-DD HH:MM:SS+nn) 2016-07-28 18:33:12+00
CoordX CoordX 8.8249
CoordY CoordY 47.2274
Punt(X) Punt(X) 8.8249
Punt(Y) Punt(Y) 47.2274
WKT WKT POINT(15 20)

Het CSVT-bestand is een ÉÉNREGELIG platte tekstbestand met de gegevenstypes tussen aanhalingstekens en
gescheiden door komma’s, bĳv.:

"Integer","Real","String"

U mag zelfs de breedte en precisie van elke kolom specificeren, bĳv.:

"Integer(6)","Real(5.5)","String(22)"

Dit bestand dient te worden opgeslagen in dezelfde map als het .csv-bestand, met dezelfde naam, maar met de
extensie .csvt.
U vindt meer informatie op GDAL CSV Driver.

Tip: Veldtypen detecteren
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In plaats van een CSVT-bestand te gebruiken om de gegevenstypen door te geven, verschaft QGIS de mogelĳkheid
om automatisch de veldtypen te detecteren en om de veronderstelde gegevenstypen te wĳzigen.

PostGIS-lagen

Lagen voor PostGIS worden opgeslagen in een database van PostgreSQL. De voordelen van PostGIS zĳn
mogelĳkheden voor ruimtelĳk indexeren, filteren en bevragen. Door PostGIS te gebruiken werken functies voor
vectors, zoals selecteren en identificeren nauwkeuriger dan dat zĳ dat doen met lagen van GDAL in QGIS.

Tip: PostGIS-lagen
Normaal gesproken wordt een laag voor PostGIS geïdentificeerd door een item in de tabel geometry_columns. QGIS
kan lagen laden die geen item in de tabel geometry_columns hebben. Dit omvat zowel tabellen als views. Bekĳk uw
handleiding voor PostgreSQL voor informatie over het maken van views.

Dit gedeelte bevat enkele details over hoe QGIS toegang heeft tot lagen van PostgreSQL. Meestal zou QGIS u een
lĳst met tabellen van de database moeten verschaffen die kunnen worden geladen, en het zal ze op verzoek laden.
Wanneer u echter problemen hebt bĳ het laden van een tabel van PostgreSQL in QGIS, zou de informatie hieronder
u misschien kunnen helpen berichten van QGIS te begrĳpen en u aanwĳzingen kunnen geven voor het aanpassen van
de definitie van de tabel of view in PostgreSQL om QGIS toe te staan het te laden.

Notitie: Een database van PostgreSQL kan ook projecten van QGIS opslaan.

Primaire sleutel

QGIS vereist dat tabellen van PostgreSQL een uniek sleutelveld bevatten voor de te laden laag. In QGIS, moet deze
tabel van het type int4 zĳn, een integer (geheel getal) met een grootte van 4 bytes. Als een alternatief kan het veld
CTID gebruikt worden als sleutelveld. Wanneer in een tabel een van deze velden ontbreekt zal in plaats daarvan het
veld OID worden gebruikt. De uitvoering zal verbeteren door een index te definiëren op het sleutelveld. (onthoud dat
sleutelvelden automatisch een index krĳgen in PostgreSQL).
QGIS biedt een keuzevak Selecteren op ID die standaard wordt geactiveerd. Deze optie haalt de ID’s op zonder de
attributen, wat in de meeste gevallen veel sneller is.

Weergave

Wanneer de PostgreSQL-laag een weergave betreft, bestaan dezelfde vereisten, maar weergaven hebben geen
sleutelvelden of velden met regels die ervoor zorgen dat deze uniek zĳn. Er moet eerst een sleutelveld (van het type
integer) in het dialoogvenster van QGIS gedefinieerd zĳn voordat de weergave geladen kan worden. Wanneer er niet
een daarvoor geschikte kolom bestaat in de weergave zal de laag niet geladen worden in QGIS. Wanneer dat gebeurd
kunt u dat oplossen door de weergave te veranderen zodat deze een geschikte kolom bevat (een type integer en ofwel
een primaire sleutel of met een unieke beperking, bĳ voorkeur geïndexeerd).
Net als voor een tabel is standaard een keuzevak Select at id geactiveerd (zie boven voor de betekenis van het
keuzevak). Het kan zin hebben deze optie uit te schakelen als u hele uitgebreide weergaven gebruikt.

Notitie: PostgreSQL foreign table
PostgreSQL foreign tables worden niet expliciet ondersteund door de provider PostgreSQL en zal worden afgehandeld
als een view.
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QGIS tabel layer_style en back-up database

Als u een back-up van uw database van PostGIS wilt maken met de opdrachten pg_dump en pg_restore, en
daarna mislukt het herstellen van de standaard laagstĳlen, zoals die werden opgeslagen door QGIS, dient u de optie
XML in te stellen op DOCUMENT vóór de opdracht restore.

1. Maak een GEWONE back-up van de tbabel ``layer_style`
2. Open het bestand in een tekstbewerker
3. Wĳzig de regel SET xmloption = content; naar SET XML OPTION DOCUMENT;

4. Sla het bestand op
5. Gebruik psql om de tabel terug te plaatsen in de nieuwe database

Filteren aan de kant van de database

QGIS maakt het mogelĳk objecten al te filteren aan de kant van de server. Selecteer Extra ► Opties ► Databronnen

► Expressies aan de zĳde van de server uitvoeren indien mogelĳk om dat te doen. Alleen ondersteunde expressies
zullen naar de database worden verzonden. Expressies die niet ondersteunde operatoren of functies gebruiken zullen
netjes terugvallen naar lokale evaluatie.

Ondersteuning van gegevenstypen van PostgreSQL

Typen gegevens die worden ondersteund door de provider PostgreSQL omvatten: integer, float, boolean, binary object,
varchar, geometry, timestamp, array, hstore en json.

Importeren van gegevens in PostgreSQL

Gegevens kunnen worden geïmporteerd in PostgreSQL/PostGIS met behulp van verscheidene programma’s,
waaronder de plug-in DB Manager en de programma’s voor de opdrachtregel shp2pgsql en ogr2ogr.

DB Manager

QGIS heeft standaard ook de plug-in DB Manager. Deze kan gebruikt worden om gegevens te laden en het
ondersteunt ook schema’s. Bekĳk het gedeelte Plug-in DB Manager voor meer informatie.

shp2pgsql

PostGIS bevat een programma, genaamd shp2pgsql, dat kan worden gebruikt om gegevenssets in de indeling
Shapefile te importeren in een voor PostGIS-ingeschakelde database. Gebruik bĳvoorbeeld de volgende opdracht
om een gegevensset in de indeling Shapefile, genaamd lakes.shp, te importeren in een database van PostgreSQL,
genaamd gis_data,

shp2pgsql -s 2964 lakes.shp lakes_new | psql gis_data

Dit maakt een nieuwe laag, genaamd lakes_new, in de database gis_data. De nieuwe laag zal de spatial
reference identifier (SRID) 2964 hebben. Bekĳk het gedeelte Werken met projecties voor meer informatie over
ruimtelĳke referentiesystemen en projecties.

Tip: Exporteren van gegevens uit PostGIS
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Er is ook een programma voor het exporteren van gegevenssets uit PostGIS naar de indeling van Shapefile: pgsql2shp.
Het wordt meegeleverd met uw distributie van PostGIS.

ogr2ogr

In aanvulling op shp2pgsql en DB Manager, is er nog een ander gereedschap voor het invoeren van geografische
gegevens in PostGIS: ogr2ogr. Het maakt deel uit van uw installatie voor GDAL.
Doe het volgende om een gegevensset in de indeling Shapefile te importeren in PostGIS:

ogr2ogr -f "PostgreSQL" PG:"dbname=postgis host=myhost.de user=postgres
password=topsecret" alaska.shp

Dit zal de gegevensset in de indeling Shapefile alaska.shp importeren in de database van PostGIS postgismet de
gebruiker postgres met het wachtwoord topsecret op de hostserver myhost.de.
Onthoud dat GDAL moet zĳn gebouwd met PostgreSQL om PostGIS te ondersteunen. U kunt dit verifiëren door te
typen (in ):

ogrinfo --formats | grep -i post

Als u de voorkeur hebt om de opdracht COPY van PostgreSQL te gebruiken in plaats van de standaard methode
INSERT INTO, kunt u de volgende omgevingsvariabele exporteren (tenminste beschikbaar op en ):

export PG_USE_COPY=YES

ogr2ogr maakt geen ruimtelĳke indexen, zoals shp2pgsl wel doet. U moet ze achteraf handmatig maken, met
de normale opdracht voor SQL CREATE INDEX, als een extra stap (zoals beschreven in het volgende gedeelte
Verbeteren van de uitvoering).

Verbeteren van de uitvoering

Ophalen van objecten uit een database van PostgreSQL kan veel tĳd vergen, speciaal over een netwerk. U kunt de
uitvoering van het tekenen van lagen van PostgreSQL verbeteren door er voor te zorgen dat een ruimtelĳke index
voor PostGIS bestaat voor elke laag in de database. PostGIS ondersteunt het maken van een index GiST (Generalized
Search Tree) om ruimtelĳk zoeken te versnellen (informatie voor de index GiST is genomen uit de beschikbare
documentatie voor PostGIS op https://postgis.net).

Tip: U kunt DBManager gebruiken om een index voor uw laag te maken. U zou eerst de laag moeten selecteren en
klikken op Tabel ► Tabel bewerken, ga naar de tab Indexen en klik op Ruimtelĳke index toevoegen.

De syntaxis voor het maken van een index GiST is:

CREATE INDEX [indexname] ON [tablename]
USING GIST ( [geometryfield] GIST_GEOMETRY_OPS );

Onthoud dat, voor grote tabellen, het maken van de index heel lang kan duren. Als de index eenmaal is gemaakt,
zou u een VACUUM ANALYZE moeten uitvoeren. Bekĳk de documentatie voor PostGIS (POSTGIS-PROJECT in
Verwĳzingen naar literatuur en web) voor meer informatie.
Het volgende voorbeeld maakt een index GiST:

gsherman@madison:~/current$ psql gis_data
Welcome to psql 8.3.0, the PostgreSQL interactive terminal.

Type: \copyright for distribution terms

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)
\h for help with SQL commands
\? for help with psql commands
\g or terminate with semicolon to execute query
\q to quit

gis_data=# CREATE INDEX sidx_alaska_lakes ON alaska_lakes
gis_data-# USING GIST (the_geom GIST_GEOMETRY_OPS);
CREATE INDEX
gis_data=# VACUUM ANALYZE alaska_lakes;
VACUUM
gis_data=# \q
gsherman@madison:~/current$

SpatiaLite-lagen

Als u een vectorlaag wilt opslaan in de indeling SpatiaLite, kunt u dat doen door de instructies te volgen op Nieuwe
lagen uit een bestaande laag maken. U selecteert SpatiaLite als Indeling en voert zowel Bestandsnaam als
Laagnaam in.
U kunt ook SQLite als indeling selecteren en dan SPATIALITE=YES toevoegen in het veld Aangepaste opties
► Databron. Dit vertelt GDAL om een database voor SpatiaLite te maken. Zie ook https://gdal.org/drivers/vector/
sqlite.html.
QGIS ondersteunt ook bewerkbare views in SpatiaLite. Voor gegevensbeheer in SpatiaLite kunt u ook de bronplug-in
DB Manager gebruiken.
Als u een nieuwe SpatiaLite laag wilt maken, ga naar het gedeelte Het maken van een nieuwe SpatiaLite-laag.

GeoJSON-specifieke parameters

Bĳ lagen exporteren naar GeoJSON, zĳn er enkele specifieke Laagopties beschikbaar. Deze opties komen uit GDAL,
dat verantwoordelĳk is vor het schrĳven van het bestand:

• COORDINATE_PRECISION het maximum aantal getallen na het decimale scheidingsteken om coördinaten te
schrĳven. Standaard is dit 15 (opmerking: voor coördinaten in Lat Lon wordt 6 als voldoende beschouwd).
Deze worden ingekort wanneer gevolgd door nullen.

• RFC7946 standaard zal GeoJSON 2008 worden gebruikt. Indien ingesteld op YES, zal de bĳgewerkte
standaard RFC 7946 worden gebruikt. Standaard is NO (dus GeoJSON 2008). Bekĳk https://gdal.org/
drivers/vector/geojson.html#rfc-7946-write-support voor de belangrĳkste verschillen. Kort gezegd is alleen
EPSG:4326 toegestaan, andere CRSen zullen worden getransformeerd, polygonen zullen worden geschreven
zodat zĳ de rechterhand-regel voor oriëntatie volgen, waarden van een array “bbox” zĳn [west, south, east,
north], niet [minx, miny, maxx, maxy]. Sommige namen van leden voor extensies zĳn verboden in objecten
FeatureCollection, Feature en Geometry, de standaard precisie voor coördinaten is 7 decimale vĳfers

• WRITE_BBOX ingesteld op YES om het begrenzingsvak van de geometrieën, op het niveau van het object en
de objectcollectie, te bevatten

Naast GeoJSON is er ook een optie om te exporteren naar “GeoJSON - Newline Delimited” (zie https://gdal.org/
drivers/vector/geojsonseq.html). In plaats van een FeatureCollection met Features kunt u slechts één type stromen
(waarschĳnlĳk alleen Features), sequentieel gescheiden door nieuwe regels.
GeoJSON - Newline Delimited heeft ook enkele specifieke Laagopties beschikbaar:

• COORDINATE_PRECISION zie boven (hetzelfde als voor GeoJSON)
• RS of records moeten worden begonnen met het teken RS=0x1E. Het verschil is hoe de objecten worden
gescheiden: alleen door een teken newline (LF) (Newline Delimited JSON, geojsonl) of door er ook een teken
voor scheiding van records (RS) voor te zetten (geeft GeoJSON Text Sequences, geojsons). Standaard op NO.
Bestanden krĳgen de extensie .json, als de extensie niet wordt opgegeven.
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SAP HANA ruimtelijke lagen

Dit gedeelte bevat enkele details over hoe QGIS toegang heeft tot lagen van SAP HANA. Meestal zou QGIS u
eenvoudigweg een lĳst met tabellen en weergaven van de database verschaffen die kunnen worden geladen, en het zal
ze op verzoek laden. Wanneer u echter problemen hebt bĳ het laden van een tabel van SAP HANA in QGIS, zou de
informatie hieronder u misschien kunnen helpen de bron van de oorzaak te begrĳpen en assisteren bĳ het oplossen
van het probleem.

Informatie over objecten

Indien u alle mogelĳkheden van QGIS wilt gebruiken voor het bewerken van objecten, moet QGIS in staat zĳn om
zonder twĳfel elk object in de laag uniek kunnen identificeren. Intern gebruikt QGIS een 64-bit signed integer om
objecten te identificeren, waarbĳ het negatieve bereik is gereserveerd voor speciale doelen.
Daarom vereist de provider SAP HANA een unieke sleutel die kan worden gekoppeld aan een positieve 64-bit integer
om de mogelĳkheden voor het bewerken van objecten van QGIS volledig te ondersteunen. Als het niet mogelĳk is
een dergelĳke koppeling te maken, zou u nog steeds de objecten kunnen bekĳken, maar bewerken zou niet hoeven
werken.

Tabellen toevoegen

Bĳ het toevoegen van een tabel als een laag, gebruikt de provider SAP HANA de primair sleutel van de tabel om
die te koppelen aan een unieke object-ID. Daarom moet u, om volledig ondersteuning voor bewerken te hebben. een
primaire sleutel in de definitie van uw tabel hebben.
De provider SAP HANA ondersteunt multi-kolom primaire sleutels, maar als u de beste uitvoering wilt bereiken, zou
uw primaire sleutel één enkele kolom zĳn van het type INTEGER.

Weergaven toevoegen

Bĳ het toevoegen van een weergave als een laag, kan de provider SAP HANA niet automatisch kolommen
identificeren die op unieke wĳze een object identificeren. Verder zĳn sommige weergaven alleen-lezen en kunnen
niet worden bewerkt.
Voor volledige ondersteuning voor bewerken moet de weergave bĳ te werken zĳn (controleer de kolom
IS_READ_ONLY in systeemweergave SYS.VIEWS voor de betreffende view) en u moet handmatig QGIS één of
meer kolommen verschaffen die een object identificeren. De kolommen kunnen worden opgegeven met Kaartlagen
► Laag toevoegen ► SAP HANA Spatial-laag tevoegen en dan de kolommen te selecteren in de kolom Object-id .
Voor de beste uitvoering zou de waarde van Object-id één enkele kolom INTEGER moeten zĳn.

15.3.3 Lagen die de 180° lengtegraad overschrijden

Veel GIS-pakketten verpakken lagen met een geografisch referentiesysteem (lat/lon) dat de lĳn van 180-graden
longitude kruist niet (https://postgis.net/docs/ST_Shift_Longitude.html). Als resultaat, wanneer we een dergelĳke
laag in QGIS openen, zouden we twee wĳd verspreide locaties zien, die vlak naast elkaar zouden verschĳnen. In
Fig. 15.27, zou het kleine puntje aan de uiterste linkerkant van het kaartvenster (Chatham Islands) binnen het raster
moeten liggen, rechts van de hoofdeilanden van Nieuw-Zeeland.
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Fig. 15.27: Kaarten maken voor lat/lon die de 180° lengtegraad overschrijden

Oplossen in PostGIS

Een tĳdelĳke oplossing is om de waarden van longitude te transformeren met PostGIS en de functie
ST_ShiftLongitude. Deze functie leest elk punt in elke component van elk object in een geometrie, en verschuift de
coördinaat van de longitude van -180…0° naar 180…360° en vice versa indien zĳ in dit bereik liggen. Deze functie
is symmetrisch, dus het resultaat is een 0…360° weergave van gegevens voor -180…180° data en een weergave van
-180…180° van gegevens voor 0…360°.

Fig. 15.28: Het overschrijden van de 180° lengtegraad met het toepassen van de functie ST_ShiftLongitude

1. Importeer gegevens in PostGIS (Importeren van gegevens in PostgreSQL), bĳvoorbeeld door gebruik te maken
van de plug-in DB Manager.

2. Gebruik de interface voor de opdrachtregel van PostGIS om de volgende opdracht op te geven:

-- In this example, "TABLE" is the actual name of your PostGIS table
update TABLE set geom=ST_ShiftLongitude(geom);

3. Als alles goed ging, zou u nu een bevestiging moeten ontvangen van het aantal objecten die bĳgewerkt zĳn.
Daarna kan deze tabel geladen worden en ziet u het verschil (Figure_vector_crossing_map).
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Werken met vectorgegevens

16.1 Het dialoogvenster Vectoreigenschappen

Het dialoogvenster Laageigenschappen voor een vectorlaag verschaft algemene instellingen om het uiterlĳk van
objecten van de kaart op de laag te beheren (symbologie, labels, diagrammen), interactie met demuis (acties, kaarttips,
ontwerpen van formulieren). Het verschaft ook informatie over de laag.
Toegang tot het dialoogvenster Laag-eigenschappen:

• In het paneel Lagen, dubbelklik op de laag of klik met rechts en selecteer Eigenschappen… uit het contextmenu;
• Ga naar menu Kaartlagen ► Laageigenschappen… als de laag is geselecteerd.

Het vector dialoogvenster Laageigenschappen verschaft de volgende gedeelten:

Informatie Bron Symbologie[1]

Labels[1] Maskers[1] 3D-weergave[1]

Diagrammen Velden Formulier Attributen

Koppelingen Hulpopslag Acties

Tonen Rendering Tĳdbeheer

Variabelen Hoogte Metadata

Afhankelĳkheden Legenda QGIS Server

Digitaliseren tabs Externe plug-ins[2]

[1] Ook beschikbaar in het paneel Laag opmaken
[2] Externe plug-ins die u installeert kunnen optioneel tabs toevoegen aan dit dialoogvenster. Deze worden niet
weergegeven in dit document. Bekĳk hun documentatie.

Tip: Volledige of gedeeltelĳke eigenschappen van de laagstĳlen delen
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Het menu Stĳl aan de onderzĳde van het dialoogvenster stelt u in staat deze of delen van deze eigenschappen te
importeren of te exporteren uit/naar verschillende doelen (bestand, klembord, database). Bekĳk Aangepaste stĳlen
beheren.

Notitie: Omdat eigenschappen (symbologie, label, acties, standaardwaarden, formulieren…) van ingebedde lagen
(zie Lagen inbedden vanuit externe projecten) uit het originele projectbestand worden opgehaald en om wĳzigingen
die dit gedrag zouden kunnen beschadigen te vermĳden, is het dialoogvenster Laageigenschappen voor deze lagen
niet beschikbaar gemaakt.

16.1.1 Eigenschappen Informatie

De tab Informatie is alleen-lezen en is een interessante plek om snel wat overzichtsinformatie en metadata voor
de huidige laag op te pakken. Verschafte informatie is:

• algemeen, zoals naam in het project, pad van de bron, lĳst met aanvullende bestanden, laatste tĳd en grootte
van opslaan, de gebruikte provider

• gebaseerd op de provider van de laag: indeling van opslag, type geometrie, codering databron, bereik, aantal
objecten…

• het Coördinaten ReferentieSysteem: naam, eenheden, methode, nauwkeurigheid, verwĳzing (d.i. of het statisch
of dynamisch is)

• opgehaald uit de gevulde metadata: toegang, bereiken, links, contacten, geschiedenis…
• en gerelateerd aan zĳn geometrie (ruimtelĳk bereik, CRS…) of zĳn attributen (aantal velden, karakteristieken
van elk…).

16.1.2 Eigenschappen Bron

Gebruik deze tab om algemene instellingen voor de vectorlaag te definiëren.
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Fig. 16.1: Tab Bron in dialoogvenster Laageigenschappen

Instellingen

• Stel een Laagnaam in die anders is dan de bestandsnaam van de laag die zal worden gebruikt om de laag in het
project te identificeren (in het Paneel Lagen, met expressies, in de legenda van de afdruklay-out, …)

• Selecteer, afhankelĳk van de indeling van de gegevens, de Tekencodering databron als die niet correct door
QGIS wordt gedetecteerd.

Coördinaten ReferentieSysteem en geometrie

• Geeft het Coördinaten ReferentieSysteem (CRS) van de laag weer. U kunt het CRS van de laag wĳzigen door
een recent gebruikte te kiezen uit de keuzelĳst of te klikken op de knop CRS selecteren (bekĳk Keuze
Coördinaten ReferentieSysteem). Gebruik dit proces alleen als het op de laag toegepaste CRS verkeerd is of
als er geen werd gespecificeerd. Als u uw gegevens opnieuw wilt projecteren, gebruik dan een algoritme voor
opnieuw projecteren uit Processing of Sla het op als een nieuwe laag.

• Ruimtelĳke index maken (alleen voor door OGR ondersteunde indelingen).
• Bereiken vernieuwen informatie voor een laag.
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Querybouwer

Het dialoogvenster Querybouwer is toegankelĳk met de knop voor het eponiem aan de onderzĳde van de tab Bron in
het dialoogvenster Laag-eigenschappen, in de groep Provider objectfilter.
De Querybouwer verschaft een interface die u de mogelĳkheid geeft om een subset van de objecten in de laag te
definiëren met behulp van een SQL-achtige clausule WHERE en het resultaat te tonen in het hoofdscherm. Zolang
de query actief is zĳn alleen de resultaten die overeenkomen met het resultaat ervan beschikbaar in het project.
U kunt één of meer laagattributen gebruiken om het filter in de Querybouwer te definiëren. Gebruiken van meer
dan één attribuut wordt weergegeven in Fig. 16.2. In het voorbeeld combineert het filter de attributen

• toa (DateTime-veld: cast("toa" as character) > '2017-05-17' and cast("toa" as
character) < '2019-12-24T18:00:00'),

• name (String-veld: "name" > 'S') en
• FID (Integer-veld: FID > 10)

met behulp van de operatoren AND, OR en NOT en haakjes. Deze syntaxis (inclusief de indeling DateTime voor het
veld toa) werken voor gegevenssets van GeoPackage.
Het filter is gemaakt op het niveau van de gegevensprovider (OGR, PostgreSQL, MS SQL Server…). Dus is de
syntaxis afhankelĳk van de gegevensprovider (DateTime wordt bĳvoorbeeld niet ondersteund voor de indeling ESRI
Shapefile). De volledige expressie:

cast("toa" as character) > '2017-05-17' AND
cast("toa" as character) < '2019-12-24T18:00:00' AND
NOT ("name" > 'S' OR FID > 10)

U kunt het dialoogvenster Querybouwer ook openen met de optie Filteren… uit het menu Kaartlagen of het
contextmenu van de laag. De gedeelten Velden, Waarden en Operatoren in het dialoogvenster helpen u de SQL-
achtige query te construeren die wordt weergegeven in het vak Provider-specifieke filter-expressie.
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Fig. 16.2: Querybouwer

De lĳst Velden bevat alle velden van de laag. Dubbelklik op de naam in de lĳst van veldnamen om een veld met
attributen toe te voegen aan het invoergedeelte van de clausule SQL WHERE of typ het direct in het vak voor de
SQL.
Het frame Waarden vermeldt alle waarden van het momenteel geselecteerde veld. Klik op de knop Alles om alle
unieke waarden van een veld te vermelden. Klik op de knop Voorbeeld om in plaats daarvan de eerste 25 unieke
waarden van de kolom te zien. Dubbelklik op een naam in de lĳst Waarden om een waarde toe te voegen aan het
veld voor de clausule SQL WHERE. U kunt het zoekvak aan de bovenzĳde van het frame Waarden gebruiken om
gemakkelĳk naar waarden voor attributen in de lĳst te zoeken en te bladeren.
Het gedeelte Operatoren bevat alle operatoren die gebruikt kunnen worden. Druk op de bĳbehorende knop om een
operator toe te voegen aan het vak voor de clausule SQL WHERE. Beschikbaar zĳn relationele operatoren ( = , > ,
…), de tekstvergelĳkingsoperator (LIKE) en logische operatoren (AND, OR, …).
De knop Test helpt u uw query te controleren en een bericht weer te geven met het aantal objecten dat aan de huidige
query voldoet. Gebruik de knop Leegmaken om de SQL-query te verwĳderen en de laag terug te brengen naar zĳn
originele staat (d.i. volledig alle objecten laden).
Wanneer een filter wordt toegepast behandelt QGIS de resulterende subset als was het de gehele laag. Als u
bĳvoorbeeld het filter hierboven toepaste op ‘Borough’ ("TYPE_2" = 'Borough'), kunt u Anchorage niet
weergeven, bevragen, opslaan of bewerken, omdat het een ‘Municipality’ is en daarom geen deel uitmaakt van de
subset.

Tip: Gefilterde lagen worden aangegeven in het paneel Lagen

In het paneel Lagen wordt een gefilterde laag vermeld met een pictogram Filter ernaast om de gebruikte query aan
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te geven als de muis over de knop gaat. Dubbelklikken op het pictogram opent het dialoogvenster Querybouwer om
te bewerken.

16.1.3 Eigenschappen Symbologie

De tab Symbologie geeft toegang tot een uitgebreid gereedschap voor renderen en toevoegen van symbologie aan
uw vectorgegevens. U kunt gereedschappen gebruiken die veel voorkomend zĳn voor vectorgegevens als ook speciale
gereedschappen voor digitaliseren die speciaal werden ontworpen voor de verschillende soorten vectorgegevens. Alle
typen delen echter dezelfde structuur van het dialoogvenster: in het bovenste gedeelte staat een widget dat u helpt bĳ
het voorbereiden van de classificatie en het te gebruiken symbool voor objecten en onderin de widget Renderen van
lagen.

Tip: Snel tussen verschillende weergaven van lagen schakelen
Met het menu Stĳl ► Toevoegen onderin het dialoogvenster Laageigenschappen kunt u net zoveel stĳlen opslaan als
u nodig hebt. Een stĳl is de combinatie van alle eigenschappen van een laag (zoals symbologie, labels, diagram,
formulier met velden, acties…). Dan kunt u eenvoudigweg schakelen tussen de stĳlen in het contextmenu van de laag
in het paneel Lagen om automatisch verschillende weergaven van uw gegevens te krĳgen.

Tip: Vectorsymbologie exporteren
U heeft de optie om vectorsymbologie vanuit QGIS te exporteren naar Google *.kml-, *.dxf- en MapInfo *.tab-
bestanden. Open eenvoudigweg het contextmenu van de laag en klik op Opslaan als ► om de naam van het
uitvoerbestand te specificeren en de indeling ervan. Gebruik, in het dialoogvenster, het menu Symbologie exporteren
om de symbologie ofwel op te slaan als Objectsymbologie ► of als Symbologie symboollaag ►. Als u symboollagen
heeft gebruikt wordt aanbevolen om de tweede instelling te gebruiken.

Objecten renderen

De renderer is verantwoordelĳk voor het tekenen van een object tezamen met het juiste symbool. Ongeacht het type
geometrie van de laag zĳn er vier algemene typen renderers: Enkel symbool, Categorieën, Gradueel en Op regel
gebaseerd. Voor puntlagen zĳn renderers voor verplaatsing van punten, cluster van punten en heatmap beschikbaar,
terwĳl polygonenlagen ook kunnen worden gerenderd met de samengevoegde objecten, geïnverteerde polygonen en
2.5D-renderers.
Er is geen renderer voor doorlopende kleuren aangezien deze in feite een speciale variant van de renderer Gradueel
is. De renderers Gradueel en Categorieën kunnen worden gemaakt door een combinatie van een symbool en een
kleurverloop te specificeren - zĳ zullen de kleuren voor de symbolen toepasselĳk weergeven. Voor elk gegevenstype
(punten, lĳnen en polygonen) zĳn typen vector symboollaag beschikbaar. Afhankelĳk van de gekozen renderer geeft
het dialoogvenster verschillende aanvullende gedeelten.

Notitie: Wanneer u het type renderer wĳzigt bĳ het instellen van een stĳl voor een vectorlaag zullen de instellingen
die u voor het symbool maakte worden behouden. Onthoud dat deze procedure slechts werkt voor één wĳziging.
Indien u het type renderer blĳft wĳzigen zullen de instellingen voor het symbool verloren gaan.
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Renderer Enkel symbool

De renderer Enkel symbool wordt gebruikt om alle objecten van de laag te renderen met behulp van één enkel
gebruikergedefinieerd symbool. Bekĳk Symbool selecteren voor meer informatie over weergave van symbolen.

Fig. 16.3: Eigenschappen van Enkel symbool lijn

Renderer Geen symbolen

De renderer Geen symbolen is een speciaal geval van gebruik van de renderer Enkel symbool dat dezelfde
rendering toepast op alle objecten. Met deze renderer zal geen symbool worden getekend voor objecten, maar labels,
diagrammen en andere delen zonder symbool zullen nog steeds worden getoond.
Selecties kunnen nog steeds worden gemaakt in de laag in het kaartvenster en geselecteerde objecten zullen worden
gerenderd met een standaardsymbool. Objecten die worden bewerkt zullen ook worden weergegeven.
Dit is bedoeld als een handige sneltoets voor lagen waarin u alleen de labels of diagrammen weer wilt geven, en
voorkomt dat symbolen moeten worden gerenderd met volledig transparante vulling/rand om dit te bereiken.

Renderer Categorieën

De renderer Categorieën wordt gebruikt om objecten van een laag te renderen met een door de gebruiker
gedefinieerd symbool, waarvan de ligging de afzonderlĳke waarden van een veld of een expressie reflecteert.
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Fig. 16.4: Categorieën - opties voor symbologie

Symbologie Categorieën gebruiken voor een laag:
1. Selecteer deWaarde voor het classificeren: het mag een bestaand veld zĳn of een expressie die u kunt typen in

het vak of kunt bouwen met de geassocieerde knop . Expressies gebruiken voor categoriseren vermĳdt de
noodzaak voor het maken van een veld voor alleen symbologiedoeleinden (bĳv. als uw criteria voor classificeren
zĳn afgeleid van één of meer attributen).
De expressie die wordt gebruikt voor het classificeren van objecten mag van elk type zĳn; bĳv. het kan:

• een vergelĳking zĳn. In dit geval geeft QGIS waarden 1 (True) en 0 (False) terug. Enkele voorbeelden:

myfield >= 100
$id = @atlas_featureid
myfield % 2 = 0
within( $geometry, @atlas_geometry )

• verschillende velden combineren:

concat( field_1, ' ', field_2 )

• een berekening op velden zĳn:

myfield % 2
year( myfield )
field_1 + field_2
substr( field_1, -3 )

• worden gebruikt om lineaire waarden te transformeren naar afzonderlĳke klassen, bĳv.:

CASE WHEN x > 1000 THEN 'Big' ELSE 'Small' END

• verscheidene afzonderlĳke waarden combineren tot één enkele categorie, bĳv.:

CASE
WHEN building IN ('residence', 'mobile home') THEN 'residential'
WHEN building IN ('commercial', 'industrial') THEN 'Commercial and␣
↪→Industrial'
END
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Tip: Hoewel u elk soort expressie kunt gebruiken om objecten in categorieën te plaatsen, kan het voor sommige
complexe expressies eenvoudiger zĳn om Regel-gebaseerd renderen te gebruiken.

2. Configureer het Symbool, dat zal worden gebruikt als basissymbool voor alle klassen;
3. Geef het Kleurverloop aan, d.i. het bereik van kleuren waaruit de kleur, die wordt toegepast op elk symbool,

wordt geselecteerd.

Naast de algemene opties van de widget Kleurverloop, kunt u een Willekeurig kleurverloop toepassen op
de categorieën. U kunt klikken op het item Willekeurig kleurverloop wisselen om opnieuw een nieuwe set
willekeurige kleuren te maken, als u niet tevreden bent.

4. Klik dan op de knop Classificeren om klassen te maken uit de afzonderlĳke waarden van het opgegeven veld
of expressie.

5. Toepassen van de wĳzigingen als Live bĳwerken niet in gebruik is en elk object in het kaartvenster zal worden
gerenderd met het symbool van zĳn klasse.
Standaard voegt QGIS een klasse alle andere waarden toe aan de lĳst. Hoewel leeg in het begin wordt deze
klasse gebruikt als een standaardklasse voor elk object dat niet valt in een van de andere klassen (bĳv. als u
objecten maakt met nieuwe waarden voor het veld voor classificeren / de expressie).

Meer aanpassingen kunnen worden gemaakt aan de standaardclassificatie:

• U kunt nieuwe categorieën Toevoegen, geselecteerde categorieën Verwĳderen of Alles verwĳderen.
• Een klasse kan worden uitgeschakeld door het keuzevak aan de linkerkant van de naam van de klasse te
deselecteren; de corresponderende objecten worden op de kaart verborgen.

• De rĳen slepen-en-neerzetten om de volgorde van de klassen te wĳzigen
• Dubbelklik op een item om het symbool, de waarde of de legenda van een klasse te wĳzigen.

Klikken met rechts boven geselecteerd(e) item(s) geeft een contextmenu weer voor:
• Symbool kopiëren en Symbool plakken, een handige manier om de weergave van een item op andere toe te
passen

• Kleur wĳzigen… van de geselecteerde symbolen
• Doorzicht wĳzigen… van de geselecteerde symbolen
• Uitvoereenheid wĳzigen… van de/het geselecteerde symbo(o)l(en)
• Grootte wĳzigen… van de geselecteerde symbolen
• Grootte wĳzigen… van de/het geselecteerde puntsymbo(o)l(en)
• Hoek wĳzigen… van de/het geselecteerde puntsymbo(o)l(en)
• Categorieën samenvoegen: Groepeert meerdere geselecteerde categorieën naar één enkele. Dit maakt het
eenvoudiger opmaken van lagen met een groot aantal categorieën mogelĳk, waar het mogelĳk zou kunnen zĳn
een aantal afzonderlĳke categorieën te groeperen naar een kleinere en beter beheersbaarder set van categorieën,
die van toepassing zĳn voor meerdere waarden.

Tip: Omdat het behouden symbool voor de samengevoegde categorieën dat van de bovenste geselecteerde
categorie in de lĳst is, wilt u misschien de categorie, waarvan u het symbool opnieuw wilt gebruiken, voor het
samenvoegen verplaatsen naar de bovenste positie.

• Categorieën losmaken die eerder werden samengevoegd
De gemaakte klassen verschĳnen ook in een boom-hiërarchie in het paneel Lagen. Dubbelklik op een item in de
legenda van de kaart om het toegewezen symbool te bewerken. Klik met rechts en u zult nog wat meer opties krĳgen.
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Het menu Geavanceerd geeft toegang tot opties om het classificeren te versnellen of het renderen van de symbolen
fĳn af te stemmen:

• Overeenkomst met opgeslagen symbolen: Gebruiken van de symbolenbibliotheek wĳst aan elke categorie een
symbool toe, waarvan de naam de waarde van de classificatie van de categorie weergeeft

• Overeenkomst met symbolen uit bestand…: Gegeven een bestand met symbolen, wĳst aan elke categorie een
symbool toe, waarvan de naam de waarde van de classificatie van de categorie weregeeft

• Symboollagen… om de volgorde van het renderen van de symbolen te definiëren.

Renderer Gradueel

De renderer Gradueelwordt gebruikt om alle objecten in een laag te renderen,met behulp van één enkel gebruiker-
gedefinieerd symbool waarvan de kleur of grootte de aanwĳzing van een geselecteerd attribuut van het object aan een
klasse weergeeft.
Net als de renderer Categorieën stelt de renderer Gradueel u in staat om rotatie en schaal voor de grootte uit
gespecificeerde kolommen te definiëren.
Ook, analoog aan de renderer Categorieën, stelt het u in staat om te selecteren:

• DeWaarde voor het classificeren: het mag een bestaand veld zĳn of een expressie die u kunt typen in het vak of
kunt bouwen met de geassocieerde knop . Expressies gebruiken voor gradueren vermĳdt de noodzaak voor
het maken van een veld voor alleen symbologiedoeleinden (bĳv. als uw criteria voor classificeren zĳn afgeleid
van één of meer attributen).

• Het symbool (met het dialoogvenster Symbool selecteren )
• De indeling van de legenda en de precisie
• De te gebruiken methode voor het wĳzigen van het symbool: kleur of grootte
• De kleuren (met behulp van het lĳstvak Kleurenbalk) als de methode voor de kleur is geselecteerd
• De grootte (met behulp van het domein grootte en de eenheid daarvan)

Dan kunt u de tab Histogram gebruiken die een interactief histogram van de waarden uit het toegewezen veld of
expressie weergeeft. Afbrekingen van klassen kunnen met behulp van de widget Histogram worden verplaatst of
toegevoegd.

Notitie: U kunt een paneel Statistisch overzicht gebruiken om meer informatie te krĳgen over uw vectorlaag. Bekĳk
Paneel Statistisch overzicht.

Terug op de tab Klassen kunt u het aantal klassen specificeren en ook de modi voor het classificeren van objecten
binnen de klassen (met behulp van de lĳst Modus). De beschikbare modi zĳn:

• Gelĳk aantal (Kwantiel): elke klasse heeft hetzelfde aantal elementen in zich (het idee van een doosdiagram).
• Gelĳke interval: elke klasse zal dezelfde grootte hebben (bĳv. waarden van 1 tot en met 16 en vier klassen,
elke klasse zal een grootte van vier hebben).

• Logaritmische schaal: geschikt voor gegevens met een breed bereik aan waarden. Smalle klassen voor lage
waarden en brede klassen voor grote waarden (bĳv. voor decimale getallen met bereik [0..100] en twee klassen,
zal de eerste klasse zĳn van 0 tot en met 10 en de tweede klasse van 10 tot en met 100).

• Natuurlĳke grenzen (Jenks): de variantie binnen elke klasse is geminimaliseerd, terwĳl de variantie tussen de
klassen gemaximaliseerd is.

• Mooie grenzen: berekent een reeks van ongeveer n+1 gelĳk geplaatste nette waarden die het bereik bedekken
van de waarden in x. De waarden worden zo gekozen dat zĳ 1, 2 of 5 keer een macht van 10 zĳn. (gebaseerd
op pretty uit de statistische omgeving R https://www.rdocumentation.org/packages/base/topics/pretty)

• Standaardafwĳking: klassen worden afhankelĳk van de standaardafwĳking van de waarden opgebouwd.
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De lĳst in het middelste deel van de tab Symbologie somt de klassen op met hun bereik, labels en symbolen die voor
het renderen worden gebruikt.
Klik op de knop Classificeren om klassen te maken met behulp van de gekozen modus. Elke klasse kan worden
uitgeschakeld door het keuzevak aan de linkerkant van de naam van de klasse te deselecteren.
Dubbelklik eenvoudigweg op het item dat u wilt wĳzigen om het symbool, waarde en/of label van de klasse te wĳzigen.
Klikken met rechts boven geselecteerd(e) item(s) geeft een contextmenu weer voor:

• Symbool kopiëren en Symbool plakken, een handige manier om de weergave van een item op andere toe te
passen

• Kleur wĳzigen… van de geselecteerde symbolen
• Doorzicht wĳzigen… van de geselecteerde symbolen
• Uitvoereenheid wĳzigen… van de/het geselecteerde symbo(o)l(en)
• Grootte wĳzigen… van de geselecteerde symbolen
• Grootte wĳzigen… van de/het geselecteerde puntsymbo(o)l(en)
• Hoek wĳzigen… van de/het geselecteerde puntsymbo(o)l(en)

Het voorbeeld in Fig. 16.5 geeft het dialoogvenster voor Gradueel renderen weer voor de laag major_rivers van de
voorbeeld gegevensset van QGIS.

Fig. 16.5: Gradueel - opties voor symbologie

De gemaakte klassen verschĳnen ook in een boom-hiërarchie in het paneel Lagen. Dubbelklik op een item in de
legenda van de kaart om het toegewezen symbool te bewerken. Klik met rechts en u zult nog wat meer opties krĳgen.
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Proportionele symbool en multivariatie analyse

Proportionele symbool en multivariatie analyse zĳn geen beschikbare typen voor renderen uit de keuzelĳst voor
renderen van Symbologie. Echter, met de opties data-bepaalde ‘override’ toegepast voor een van de eerdere opties
voor renderen, stelt QGIS u in staat uw punt- en lĳngegevens in een dergelĳke weergave weer te geven.
Een proportioneel symbool maken
Een proportionele rendering toepassen:

1. Pas op de laag eerst de renderer Enkel symbool toe.
2. Stel dan het symbool in om toe te passen op de objecten.

3. Selecteer het item van het bovenste niveau van de boom met symbolen, en gebruik de knop
Data-bepaalde ‘override’ naast de opties Grootte voor puntlaag) of Breedte (voor lĳnlaag).

4. Selecteer een veld of voer een expressie in, en QGIS zal voor elk object de waarde voor de uitvoer toepassen
op de eigenschap en het symbool proportioneel op grootte brengen in het kaartvenster.

Als het nodig is, gebruik dan de optie Assistent Grootte… van het menu om enige transformatie
(exponentieel, Flannery…) toe te passen op het opnieuw schalen van het symbool (bekĳk Interface Assistent
Data-gedefinieerde ‘override’ gebruiken voor meer details).

U kunt er voor kiezen om de proportionele symbolen weer te geven in het paneel Lagen en de items voor legenda van
afdruklay-out: vouw de keuzelĳst Geavanceerd aan de onderzĳde van het dialoogvenster van de tab Symbologie uit
en selecteer Data-bepaalde grootte legenda… om de items voor de legenda te configureren (bekĳk Data-bepaalde
grootte legenda voor details).
Multivariate analyse instellen
Renderen als multivariate analyse helpt u de relatie te evalueren tussen twee of meer variabelen, bĳv. één kan worden
weergegeven door een kleurenbalk terwĳl de andere wordt weergegeven door een grootte.
De eenvoudigste manier om multivariate analyse te maken in QGIS is om:

1. Eerst een rendering Categorieën of Gradueel toe te passen op een laag, met hetzelfde type symbool voor alle
klassen.

2. Dan, een proportionele symbologie op de klassen toe te passen:
1. Klik op de knop Wĳzigen boven het frame voor classificeren: u krĳgt het dialoogvenster Symbool

selecteren.

2. Breng de grootte of breedte van de symboollaag opnieuw op schaal met de widget data-bepaalde
‘override’ zoals hierboven.

Net als het proportionele symbool, wordt het aan de grootte gerelateerde symbool toegevoegd aan de boom van lagen,
boven op de symboolklassen Categorieën of Gradueel met de mogelĳkheid data-bepaalde grootte legenda. En beide
weergaven zĳn ook beschikbaar in het item Legenda van afdruklay-out.
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Fig. 16.6: Voorbeeld multivariatie met geschaalde grootte Legenda

Renderer Regel-gebaseerd

Regels zĳn expressies voor QGIS die worden gebruikt om objecten te kunnen onderscheiden overeenkomstig hun
attributen of eigenschappen om specifieke instellingen op hen toe te passen. Regels mogen worden genest, en objecten
behoren tot een klasse als zĳ behoren tot alle bovenliggende geneste niveaus.

De renderer Regel-gebaseerd is daarom ontworpen om alle objecten van een laag te renderen, met behulp van
symbolen waarvan het aspect de toewĳzing van een geselecteerd object aan een fĳnmazige klasse reflecteert.
Een regel maken:

1. Activeer een bestaande rĳ door erop te dubbelklikken (standaard voegt QGIS een symbool zonder regel toe als
de modus Renderen is ingeschakeld) of klik op de knop Huidige regel bewerken of Regel toevoegen.

2. In het dialoogvenster Regel bewerken dat opent, kunt u een label definiëren om u te helpen elke regel te
identificeren. Dit is het label dat zal worden weergegeven in het paneel Lagen en ook in de legenda van
afdruklay-out.

3. Voer handmatig een expressie in in het tekstvak naast de optie Filter, of druk op de knop ernaast, om
het dialoogvenster voor de Expressie-string bouwer te openen.

4. Gebruik de verschafte functies en attributen van de laag om een expressie te bouwen om de objecten te filteren
die u zou willen ophalen. Druk op de knop Test om het resultaat van de query te controleren.

5. U kunt een langer label invoeren om de beschrĳving van de regel te voltooien.

6. U kunt de optie Schaal waarden gebruiken om schalen in te stellen waarop de regel zou moeten worden
toegepast.

7. Configureer tenslotte het te gebruiken symbool voor deze objecten.
8. En druk op OK.

Een nieuwe regel die de regel samenvat wordt toegevoegd aan het dialoogvenster Laageigenschappen. U kunt net
zoveel regels maken als nodig is door de voorgaande stappen te volgen of een bestaande regel te kopiëren en te
plakken. Slepen-en-neerzetten van de regels bovenop elkaar om ze te nesten en de objecten van de bovenste objecten
te verfĳnen in subklassen.
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De renderer Regel-gebaseerd kan worden gecombineerd met de renderers Categorieën of Gradueel. Door het
selecteren van een regel kunt u de objecten daarvan organiseren in subklassen met het keuzemenuGeselecteerde regels
verfĳnen. Verfĳnde klassen verschĳnen als sub-items van de regel, in een boom-hiërarchie en, net als hun ouder, kunt
u de symbologie en de regel voor elke klasse instellen. Automatisch verfĳnen van regels kan worden gebaseerd op:

• schalen: gegeven een lĳst met schalen, maakt deze optie een set klassen waarvoor de verschillende gebruiker-
gedefinieerde schaalbereiken van toepassing zĳn. Elke nieuw op schaal gebaseerde klasse kan zĳn eigen
symbologie en expressie voor definitie hebben. Dit kan bĳvoorbeeld een handige manier zĳn om dezelfde
objecten weer te geven met verschillende symbolen op verschillende schalen, of alleen een set objecten
weergeven, afhankelĳk van de schaal (bĳv. lokale vliegvelden op een grote schaal vs internationale vliegvelden
op een kleine schaal).

• categorieën: past een renderer Categorieën toe op de objecten die vallen in de geselecteerde regel.
• of bereiken: past een renderer Gradueel toe op de objecten die vallen in de geselecteerde regel.

Verfĳnde klassen verschĳnen als subitems van de regel, in een boom-hiërarchie en, net als hierboven, kunt u de
symbologie voor elke klasse instellen Symbolen van de geneste regels zĳn op elkaar gestapeld, dus wees voorzichtig
bĳ het kiezen ervan. Het is ook mogelĳk om Symbool te deselecteren in het dialoogvensterHuidige regel bewerken
om renderen van een bepaald symbool in de stapel te vermĳden.
In het dialoogvenster Regel bewerken kunt u het schrĳven van al die regels vermĳden door gebruik te maken van
de optie Anders om alle objecten te vangen die niet voldoen aan een van de andere regels op hetzelfde niveau.
Dit kan ook worden bereikt door Else te schrĳven in de kolom Regel van het dialoogvenster Laageigenschappen ►
Symbologie ► Regel-gebaseerd.
Klikken met rechts boven geselecteerd(e) item(s) geeft een contextmenu weer voor:

• Kopiëren en Plakken, een handige manier om nieuwe item(s) te maken, gebaseerd op bestaande item(s)
• Symbool kopiëren en Symbool plakken, een handige manier om de weergave van een item op andere toe te
passen

• Kleur wĳzigen… van de geselecteerde symbolen
• Doorzicht wĳzigen… van de geselecteerde symbolen
• Uitvoereenheid wĳzigen… van de/het geselecteerde symbo(o)l(en)
• Grootte wĳzigen… van de geselecteerde symbolen
• Grootte wĳzigen… van de/het geselecteerde puntsymbo(o)l(en)
• Hoek wĳzigen… van de/het geselecteerde puntsymbo(o)l(en)
• Huidige regel verfĳnen: opent een submenu dat het mogelĳk maakt de huidige regel te verfĳnen met schalen,
categorieën of bereiken. Hetzelfde als het selecteren van het corresponderende menu aan de onderzĳde van
het dialoogvenster.

Deselecteren van een rĳ in het dialoogvenster van de renderer Regel-gebaseerd verbergt de objecten van die specifieke
regel en de geneste in het kaartvenster.
De gemaakte klassen verschĳnen ook in een boom-hiërarchie in het paneel Lagen. Dubbelklik op een item in de
legenda van de kaart om het toegewezen symbool te bewerken. Klik met rechts en u zult nog wat meer opties krĳgen.
Het voorbeeld in Fig. 16.7 toont het dialoogvenster van een Regel-gebaseerde renderer voor de laag rivers van de
voorbeeld gegevensset van QGIS.
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Fig. 16.7: Opties voor Regel-gebaseerde symbologie

Renderer Verplaatsing punt

De renderer Verplaatsing punt neemt de objecten punt die liggen binnen een opgegeven tolerantie voor de afstand
van elkaar en plaatst hun symbolen rondom hun zwaartepunt, verschillende methoden voor plaatsing volgend. Dit kan
een handige manier zĳn om alle objecten van een puntenlaag te visualiseren, zelfs als ze dezelfde locatie hebben (bĳv.
voorzieningen in een gebouw).
U moet, om een renderer Verplaatsing punt te configureren:

1. Het Midden symbool instellen: hoe het virtuele punt in het midden eruit zal zien
2. Het type Renderer selecteren: hoe u objecten in de laag wil classificeren (enkel, gecategoriseerd, op regel-

gebaseerd…)
3. Drukken op de knop Instellingen renderer… om de symbologie van de punten te configureren overeenkomstig

de geselecteerde renderer
4. De tolerantieAfstand opgeven waarbinnen objecten dichtbĳ worden geacht te overlappen en dan verplaatst over

hetzelfde virtuele punt. Ondersteunt de algemene eenheden voor symbolen.
5. De Methode plaatsing configureren:

• Ring: plaatst alle objecten op een cirkel waarvan de straal afhankelĳk is van het aantal weer te geven
objecten.

• Concentrische ringen: gebruikt een set concentrische cirkels om de objecten weer te geven.
• Raster: maakt een regelmatig raster met een puntsymbool op elke kruising.

6. Verplaatste symbolen worden geplaatst op de Verplaatsingslĳnen. Waar de minimale afstand van de
verplaatsingslĳnen afhankelĳk is van de renderer van het puntsymbool kunt u nog steeds enkele van hun
instellingen aanpassen, zoals de Lĳndikte, Lĳnkleur en Grootte aanpassen (bĳv. om meer afstand tussen de
gerenderde punten toe te voegen).

7. De opties van de groep Labels gebruiken om labelen van de punten uit te voeren: de labels worden geplaatst
nabĳ het verplaatste symbool, en niet op de echte positie van het object.
1. Selecteer het Attribuut van label: een veld van de laag om te gebruiken voor labelen
2. Geef de eigenschappen en grootte van het Label lettertype aan
3. Kies een Labelkleur

4. Stel een Factor labelafstand in: voor elk object punt, verschuift het label vanaf het midden van het symbool
proportioneel naar de diagonale grootte van het symbpol.
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5. Schakel Schaalafhankelĳk labelen in als u alleen labels wilt weergeven in schalen die groter zĳn dan
een opgegeven Minimale schaal kaart.

Fig. 16.8: Dialoogvenster Verplaatsing punt

Notitie: De renderer Verplaatsing punt verandert niet de geometrie van de objecten, wat betekent dat de punten niet
van hun positie worden verplaatst. Zĳ zĳn nog steeds geplaatst op hun initiële plaats. Wĳzigingen zĳn alleen visueel,
voor het doel renderen. Gebruik in plaats daarvan het algoritme van Processing Punten verplaatsen als u verplaatste
objecten wilt maken.

Renderer Cluster punten

Anders dan de renderer Verplaatsing punt die de plaatsing van overgelegde of nabĳe punten opblaast, groepeert

de renderer Cluster punten nabĳe punten naar één enkel gerenderd markeringssymbool. Punten die vallen binnen
een bepaalde afstand van elkaar worden samengevoegd tot één enkel symbool. Bĳ elkaar voegen van punten is
gebaseerd op de dichtstbĳzĳnde gevormde groep, in plaats van ze gewoon toe te wĳzen aan de eerste groep binnen
de zoekafstand.
Vanuit het hoofddialoogvenster kunt u:

1. Het symbool instellen om de clusterpunten weer te geven in Symbool voor cluster; de standaard rendering
geeft het aantal samengevoegde objecten weer door de variabele @cluster_size op de symboollaag
Lettertypemarkering.
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2. Het type Renderer selecteren, d.i. hoe u objecten in de laag wilt classificeren (enkel, gecategoriseerd, op regel-
gebaseerd…)

3. Zoals gewoonlĳk op de knop Instellingen renderer… drukken om de symbologie van de objecten te
configureren. Onthoud dat deze symbologie alleen zichtbaar is voor objecten die niet geclusterd zĳn, anders
wordt het Symbool voor cluster toegepast. Ook, als alle objecten punt in een cluster behoren tot dezelfde
klasse voor renderen, en dus dezelfde kleur zou worden toegepast, die kleur wordt weergegeven in de variabele
@cluster_color`` van de cluster.

4. De maximale Afstand opgeven die in acht moet worden genomen voor het clusteren van objecten. Ondersteunt
de algemene eenheden voor symbolen.

Fig. 16.9: Dialoogvenster Cluster punten

Notitie: De renderer Cluster punten verandert niet de geometrie van de objecten, wat betekent dat de punten niet
van hun positie worden verplaatst. Zĳ zĳn nog steeds geplaatst op hun initiële plaats. Wĳzigingen zĳn alleen visueel,
voor het doel renderen. Gebruik in plaats daarvan de algoritmes van Processing Clusteren K-gemiddelde of DBSCAN
clusteren als u op clusters gebaseerde objecten wilt maken.

Renderer Samengevoegde objecten

De renderer Samengevoegde objecten maakt het mogelĳk gebieds- en lĳnobjecten “op te lossen” tot één enkel
object, voorafgaande aan het renderen om er voor te zorgen dat complexe symbolen of overlappende objecten worden
weergegeven door een uniform en doorlopend cartografisch symbool.

Renderer Geïnverteerde polygonen

De renderer Geïnverteerde polygonen stelt de gebruiker in staat een symbool te definiëren om het gebied buiten de
polygonen op de laag te vullen. Zoals hierboven kunt u subrenderers selecteren, namelĳk Enkel symbool, Gradueel,
Categorieën, Regel-gebaseerd of de 2.5D renderer.
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Fig. 16.10: Dialoogvenster Geïnverteerde polygonen

Renderer Heatmap

Met de renderer Heatmap kunt u live dynamische heatmaps maken voor (multi)puntlagen. U kunt de radius voor
de heatmap specificeren in millimeters, punten, pixels, kaarteenheden of inches, een kleurenbalk kiezen voor de stĳl
van de heatmap en een schuifbalk gebruiken voor het selecteren van een verhouding tussen snelheid van renderen en
kwaliteit. U kunt ook een grens voor de maximale waarde definiëren en een gewicht aan punten geven met behulp van
een veld of een expressie. Wanneer een object wordt toegevoegd of verwĳderd werkt de renderer voor de heatmap
de stĳl voor de heatmap automatisch bĳ.

Fig. 16.11: Dialoogvenster Heatmap

514 Hoofdstuk 16. Werken met vectorgegevens



QGIS Desktop 3.28 User Guide

2.5D-renderer

Met behulp van de renderer 2.5D is het mogelĳk om een 2.5D-effect op de objecten van uw lagen toe te passen.
U begint door een waarde Hoogte te kiezen (in kaarteenheden). Daarvoor kunt u een vaste waarde gebruiken, één of
meer velden uit uw laag, of een expressie. U dient ook een Hoek (in graden) te kiezen om de positie van het kĳken
opnieuw te bepalen (0° betekent West, groeiend tegen de klok in). Gebruik gevorderde opties voor configuratie om
de Kleur dak en Kleur muur in te stellen. Indien u zonneschĳn zou willen simuleren op de wanden van de objecten,
zorg er dan voor om het keuzevak voor de optie Muren voorzien van schaduw, gebaseerd op aspect te selecteren.
U kunt ook een schaduw simuleren door een Kleur en Grootte (in kaarteenheden) in te stellen.

Fig. 16.12: dialoogvenster 2.5D

Tip: 2.5D-effect gebruiken met andere renderers
Als u eenmaal het instellen van de basisstĳl hebt voltooid voor de renderer 2.5D, kunt u deze converteren naar een
andere renderer (Enkel, Categorieën, Gradueel). De 2.5D-effecten zullen worden behouden en alle andere specifieke
opties voor de renderer zullen beschikbaar zĳn om ze fĳn af te stemmen (op deze manier kunt u bĳvoorbeeld
gecategoriseerde symbolen met een keurige 2.5D-weergave krĳgen of enige extra opmaak toe te voegen aan uw
2.5D-symbolen). U moet misschien Symboollagen ( Geavanceerd ► Symboollagen…) inschakelen om er voor te
zorgen dat de schaduw en de “building” zelf niet interfereren met andere objecten in de nabĳheid. De 2.5D-waarden
voor hoogte en hoek worden opgeslagen in de variabelen van de laag, dus u kunt ze later nog bewerken op de tab
Variabelen van het dialoogvenster Laageigenschappen.
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Renderer Ingebedde symbolen

De renderer Ingebedde symbolen maakt het mogelĳk om de ‘eigen’ symbologie van een verschafte databron weer te
geven. Dit is meestal het geval met gegevenssets van KML en TAB die een vooraf gedefinieerde symbologie hebben.

Renderen van lagen

Vanaf de tab Symbologie kunt u ook enkele opties instellen die altĳd acteren op alle objecten van de laag:

• Doorzichtbaarheid : U kunt hiermee onderliggende lagen zichtbaar maken in het
kaartvenster. Gebruik de schuifbalk om de transparantie van de geselecteerde vectorlaag aan te passen naar uw
behoeften. U kunt ook een precieze definitie voor het percentage voor de transparantie invullen in het menu
naast de schuifbalk.

• Meng-modus op de niveaus Laag en Object: Met dit gereedschap kunt u speciale effecten op de kaart toepassen,
die eerder alleen bekend waren van grafische programma’s. De pixels van de overliggende en onderliggende
lagen worden vermengd volgens de instellingen zoals beschreven in Meng-modi.

• Toepassen van tekeneffecten op alle objecten van de laag met de knop Tekeneffecten.
• Volgorde van renderen van objecten beheren stelt u in staat, met behulp van attributen van objecten, de Z-
volgorde te definiëren waarin zĳ zullen worden gerenderd. Activeer het keuzevak en klik op de knop
ernaast. U krĳgt dan het dialoogvenster Volgorde definiëren waarin u:
1. Een veld kunt kiezen of een expressie kunt bouwen om op de objecten van de laag toe te passen.
2. In kunt stellen in welke volgorde de opgehaalde objecten zouden moeten worden gesorteerd, d.i. als u de

volgorde Oplopend kiest, zullen de objecten met een lagere waarde onder die met een hogere waarde
staan.

3. Kunt definiëren dat als objecten de waarde NULL teruggeven ze moeten worden gerenderd, als: eerste
(beneden) of laatste (boven).

4. Bovenstaande stappen net zo vaak herhalen als het aantal regels dat u wilt gebruiken.
De eerste regel wordt toegepast op alle objecten in de laag, in de Z-volgorde overeenkomstig de door hen
teruggegeven waarde. Dan, voor elke groep objecten met dezelfde waarde (inclusief die met de waarde NULL)
en dus hetzelfde niveau Z, wordt de volgende regel toegepast om de items te sorteren. Enzovoort…

Fig. 16.13: Opties voor renderen van de laag

Andere instellingen

Symboollagen

Voor renderers die gestapelde symboollagen toestaan (alleen Heatmap doet dat niet) is er een optie om de volgorde
van renderen van elke symboollaag te beheren.
Voor de meeste renderers krĳgt u toegang tot de optie Symboollagen door te klikken op de knop Geavanceerd onder
de opgeslagen lĳst met symbolen en te kiezen voor Symboollagen. Voor de Renderer Regel-gebaseerd is de optie direct
beschikbaar via de knop Symboollagen, terwĳl het voor de renderer Renderer Verplaatsing punt dezelfde knop is in
het dialoogvenster Instellingen ‘renderer’.
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Selecteer Symboollagen tonen om de symboollagen te actieveren. Elke rĳ zal worden weergegeven als een klein
voorbeeld van het gecombineerde symbool, het label ervan en de individuele symboollaag opgedeeld in kolommen
met een getal ernaast. De nummers vertegenwoordigen het niveau van volgorde van renderen waarin de symboollaag
zal worden getekend. Lagere waarden worden eerst getekend, blĳven onderop, terwĳl hogere waarden later worden
getekend, bovenop de andere.

Fig. 16.14: Dialoogvensters Symboollagen

Notitie: Als symboollagen zĳn uitgeschakeld, zullen volledige symbolen worden getekend overeenkomstig hun
respectievelĳke volgorde als object. Overlappende symbolen zullen eenvoudigweg worden verborgen door andere
eronder. Daarnaast zullen soortgelĳke symbolen niet met elkaar worden “samengevoegd”.

Fig. 16.15: Geactiveerde symboollagen (A) en uitgeschakelde (B) verschil
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Data-bepaalde grootte legenda

Wanneer een laag is gerenderd met de proportioneel symbool of de multivariate rendering of wanneer een diagram
met geschaalde grootte is toegepast op de laag, kunt u toestaan dat de geschaalde symbolen worden weergegeven in
zowel het paneel Lagen als de legenda van afdruklay-out.
Selecteer de eponiem-optie in de knop Geavanceerd onder de lĳst met opgeslagen symbolen om het dialoogvenster
Data-bepaalde grootte Legenda in te schakelen om symbologie te renderen. Voor diagrammen is de optie beschikbaar
op de tab Legenda. Het dialoogvenster verschaft de volgende opties om:

• het type legenda te selecteren: Legenda niet ingeschakeld, Afzonderlĳke items legenda en
Samengevouwen legenda. Voor de laatste optie kunt u selecteren of de items moeten worden uitgelĳnd Onder
of Centreren;

• het te gebruiken symbool voor weergave in de legenda te bekĳken;
• de titel in de legenda invoeren;
• de grootte van de te gebruiken klassen wĳzigen: standaard verschaft QGIS u een legenda met vĳf klassen
(gebaseerd op natuurlĳke nette grenzen), maar u kunt uw eigen classificatie toepassen met de optie
Handmatige grootte klassen. Gebruik de knoppen en om uw aangepaste waarden en labels voor de
klassen in te stellen.

• Voor ingeklapte legenda’s, is het mogelĳk om:
– Symbolen uitlĳnen in het midden of onderaan
– het horizontale leidende Lĳnsymbool configureren van het symbool naar de corresponderende tekst in de
legenda.

Een voorbeeld van de legenda wordt weergegeven in het rechterpaneel van het dialoogvenster en bĳgewerkt als u de
parameters instelt.

Fig. 16.16: Grootte geschaalde legenda instellen

Notitie: Momenteel kan data-bepaalde grootte legenda voor symbologie van de laag alleen worden toegepast op een
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puntlaag met symbologie Enkel symbool, Categorieën of Gradueel.

Tekeneffecten

Voor het verbeteren van het renderen van lagen en om het gebruiken van andere software voor het uiteindelĳke
renderen van kaarten te vermĳden (of tenminste te verminderen), verschaft QGIS een andere krachtige functionaliteit:
de opties Tekeneffecten die tekeneffecten toevoegen voor het aanpassen van de visualisatie van vectorlagen.
De optie is beschikbaar in het dialoogvenster Laageigenschappen ► Symbologie, onder de groep Renderen van lagen
(die wordt toegepast op de gehele laag) of in eigenschappen van symboollagen (wordt toegepast op de overeenkomende
objecten). U mag de beide gebruikswĳzen combineren.

Tekeneffecten kunnen worden geactiveerd door de optie Tekeneffecten te selecteren en te klikken op de knop
Effecten aanpassen. Dat zal het dialoogvenster Eigenschappen effecten openen (zie Fig. 16.17). De volgende typen effecten,
met opties om ze aan te passen, zĳn beschikbaar:

• Bron: Tekent de originele stĳl van het object overeenkomstig de configuratie van de eigenschappen van de
laag. De Doorzichtbaarheid van de stĳl ervan kan worden aangepast als ook de Meng-modus en Tekenmodus.
Dit zĳn algemene eigenschappen voor alle typen effecten.

Fig. 16.17: Tekeneffecten: dialoogvenster Bron

• Vervagen: Voegt het effect van vervagen toe aan de vectorlaag. De opties die men kan wĳzigen zĳn het Type
vervagen (Stapel vervagen (snel) of Gaussiaans vervagen (kwaliteit)) en de Sterkte vervagen.
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Fig. 16.18: Tekeneffecten: dialoogvenster Vervagen

• Kleuren: Dit effect kan worden gebruikt om een versie van de stĳl te maken met één enkele tint. De basis zal
altĳd een versie in grĳstinten van het symbool zĳn en u kunt:

– De Grĳstinten gebruiken om te selecteren hoe gemaakt moet worden: opties zĳn ‘Lichtsterkte van’,
‘Helderheid van’, ‘Gemiddelde van’ en ‘Uit’.

– Als Kleuren is geselecteerd, zal het mogelĳk zĳn een andere kleur te mengen en te kiezen hoe sterk
die zou moeten zĳn.

– De niveaus van Helderheid, Contrast en Saturatie van het resulterende symbool te beheren.
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Fig. 16.19: Tekeneffecten: dialoogvenster Kleuren

• Valschaduw: Gebruiken van dit effect voegt een schaduw toe aan het object, wat er uitziet als het toevoegen van
een extra dimensie. Dit effect kan worden aangepast door de graden en afstand van de Verspringing te wĳzigen,
te bepalen waar de schaduw naartoe moet verschuiven en de nabĳheid van het bronobject. Valschaduw heeft
ook de optie om de straal van vervagen, de transparantie en de kleur van het effect te wĳzigen.

Fig. 16.20: Tekeneffecten: dialoogvenster Valschaduw
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• Binnenschaduw: Dit effect is soortgelĳk aan het effect Valschaduw, maar het voegt ook het schaduweffect
toe aan de binnenkant van de randen van het object. De beschikbare opties voor het aanpassen zĳn dezelfde
als voor het effect Valschaduw.

Fig. 16.21: Tekeneffecten: dialoogvenster Binnenschaduw

• Binnenste gloed: Voegt het effect van een gloed toe aan de binnenkant van het object. Dit effect kan worden
aangepast door de Verdeling (breedte) van de gloed, of de Straal van vervaging. De laatste specificeert de
nabĳheid vanaf de rand van het object waar u wilt dat de vervaging wordt toegepast. Aanvullend zĳn er opties
om de kleur van de gloed aan te passen met één Enkele kleur of een Kleurverloop.

Fig. 16.22: Tekeneffecten: dialoogvenster Binnenste gloed
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• Buitenste gloed: Dit effect is soortgelĳk aan het effect Binnenste gloed, maar het voegt ook het schaduweffect
toe aan de buitenkant van de randen van het object. De beschikbare opties voor het aanpassen zĳn dezelfde als
voor het effect Binnenste gloed.

Fig. 16.23: Tekeneffecten: dialoogvenster Buitenste gloed

• Transformeren: Voegt de mogelĳkheid tot het transformeren van de vorm van het symbool toe. De eerste
beschikbare opties voor aanpassen zĳn Horizontaal reflecteren en Verticaal reflecteren, die in feite een reflectie
maken op de horizontale en/of verticale assen. De andere opties zĳn:

– X,Y schuin trekken: Trekt het object schuin langs de X- en/of Y-as.
– X,Y op schaal brengen: Vergroot of verkleint het object langs de X- en/of Y-as met het opgegeven
percentage.

– Rotatie: Draait het object langs zĳn middelpunt.
– en X, Y vertalen wĳzigt de positie van het item, gebaseerd op een opgegeven afstand voor de X- en/of
Y-as.
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Fig. 16.24: Tekeneffecten: dialoogvenster Transformeren

Eén of meer typen tekeneffecten kunnen tegelĳkertĳd gebruikt worden. U kunt een effect (de)activeren met zĳn
keuzevak in de lĳst met effecten. U kunt het geselecteerde type effect wĳzigen door de optie Type effect te
gebruiken. U kunt de volgorde van de effecten wĳzigen met behulp van de knoppen Naar boven en Naar beneden

en ook effecten toevoegen/verwĳderen met de knoppen Nieuw effect toevoegen en Effect verwĳderen.
Er zĳn enkele algemene opties beschikbaar voor alle typen tekeneffecten. De opties Doorzichtbaarheid en Meng-
modus werken soortgelĳk aan die welke zĳn beschreven in Renderen van lagen en kunnen worden gebruikt voor alle
tekeneffecten, met uitzondering van die van Transformeren.

Er is ook een optie Tekenmodus beschikbaar voor elk effect, en u kunt er voor kiezen om het symbool te
renderen en/of aan te passen door enkele regels te volgen:

• Effecten renderen van boven naar beneden.
• Modus Alleen renderen betekent dat het effect zichtbaar zal zĳn.
• Modus Alleen aanpassen betekent dat het effect niet zichtbaar zal zĳn, maar de wĳzigingen die het toepast
zullen worden doorgegeven aan het volgende effect (het er direct onder).

• De modus Renderen en aanpassen zal het effect zichtbaar maken en eventuele wĳzigingen doorgeven aan het
volgende effect. Als het effect boven in de lĳst met effecten staat of als het effect er direct boven niet in de
modus Aanpassen staat, dan zal het het originele bronsymbool uit de eigenschappen van de laag gebruiken
(soortgelĳk aan de bron).

16.1.4 Labeleigenschappen

De eigenschappen Labels verschaffen u alle benodigde en van toepassing zĳnde mogelĳkheden voor het slim
labelen voor vectorlagen. Dit dialoogvenster is ook toegankelĳk via het paneel Laag opmaken, of door de knop
Laag-label opties op de werkbalk Labels te gebruiken.
De eerste stap is om de methode voor labelen te kiezen vanuit de keuzelĳst. Beschikbare methoden zĳn:

• Geen labels: de standaardwaarde, geeft geen labels op de laag weer
• Enkele labels: Geeft labels weer op de kaart met behulp van één attribuut of een expressie
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• Regel-gebaseerd labelen

• en Blokkeren: maakt het mogelĳk een laag slechts in te stellen als een obstakel voor labels van andere lagen
zonder labels van zichzelf te renderen.

Voor de volgende stappen nemen we aan dat u de optie Enkele labels selecteert, wat het volgende dialoogvenster
opent.

Fig. 16.25: Instellingen Laag labelen - Enkele labels

Aan de bovenzĳde van het dialoogvenster is een keuzelĳst Waarde ingeschakeld. U kunt een attributenkolom
selecteren om te gebruiken voor het labelen. Standaard wordt het veld weergave gebruikt. Klik op als u labels wilt
definiëren, gebaseerd op expressies - Zie Labels definiëren die zĳn gebaseerd op expressies.

Notitie: Labels met hun opmaak kunnen worden weergegeven als items in de legenda’s, indien ingeschakeld op de
tab Legenda.

Hieronder worden opties weergegeven om de labels aan te passen, op verschillende tabs:
• Tekst

• Opmaak

• Buffer

• Masker

• Achtergrond
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• Schaduw

• Tekstballonnen

• Plaatsing

• Renderen

Een beschrĳving van hoe elke eigenschap in te stellen wordt weergegeven op Een label instellen.

Instellen van de automatische plaatsing

U kunt de automatische instellingen voor plaatsing gebruiken om een project-niveau en geautomatiseerd
gedrag voor de labels te configureren. In de rechterbovenhoek van de tab Labels, klik op de knop
Automatische instellingen voor plaatsing (van toepassing op alle lagen), dat een dialoogvenster opent met de volgende opties:

Fig. 16.26: Instellingen voor automatische plaatsing

• Aantal kandidaten: berekent en wĳst aan objecten lĳn en polygoon het aantal mogelĳk plaatsingen voor labels
toe, gebaseerd op hun grootte. Hoe langer of breder een object is, des te meer kandidaten het heeft, en de labels
ervan kunnen beter worden geplaatst, zonder risico op botsingen.

• Tekst renderen: stelt de standaardwaarde in voor widgets voor renderen van labels bĳ exporteren van een
kaartvenster of een lay-out naar PDF of SVG. Als Labels altĳd als tekst renderen is geselecteerd dan kunnen
labels worden bewerkt in externe teopassingen (bĳv. Inkscape) als normale tekst. MAAR het bĳeffect is
dat de kwaliteit van het renderen verminderd, en dat er problemen met renderen zĳn wanneer er bepaalde
instellingen voor de tekst, zoals buffers, van kracht zĳn. Dat is de reden waarom Labels altĳd als paden renderen
(aanbevolen), wat labels exporteert als omtrekken, wordt aanbevolen.

• Afgebroken labels aan rand van kaart toestaan: beheert of van labels, die gedeeltelĳk buiten het kaartbereik
vallen, het toegestane bereik zou moeten worden gerenderd. Indien geselecteerd zullen deze labels worden
weergegeven (wanneer er geen manier is om ze volledig binnen het zichtbare gebied te plaatsen). Indien niet
geselecteerd dan zullen gedeeltelĳk zichtbare labels worden overgeslagen. Onthoud dat deze instelling geen
effect heeft op de weergave van labels in het lay-out kaartitem.

• Alle labels voor alle lagen weergeven (d.i. inclusief conflicterende objecten). Onthoud dat deze instelling ook
per laag kan worden ingesteld (zie Tab Renderen)
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• Niet geplaatste labels weergeven: maakt het mogelĳk om te bepalen of belangrĳke labels ontbreken in de
kaarten (bĳv. vanwege overlappingen of andere beperkingen). Zĳ worden weergegeven in een aan te passen
kleur.

• Kandidaten weergeven (om te debuggen): beheert of vakken op de kaart zouden moeten worden getekend
die alle kandidaten weergeven die zĳn gemaakt voor het plaatsen van labels. Zoals het label al zegt is het alleen
nuttig voor debuggen en het testen van de effecten die verschillende instellingen voor labelen hebben. Dit zou
handig kunnen zĳn voor beter handmatig plaatsen met gereedschappen van de werkbalk Label.

• Versie voor labelen van project: QGIS ondersteunt twee verschillende versies voor automatisch plaatsen van
labels:

– Versie 1: het oude systeem (gebruikt door QGIS versies 3.10 en eerder, en bĳ het openen in QGIS 3.12 of
later van projecten die zĳn gemaakt in die eerdere versies). Versie 1 behandelt prioriteiten voor labels en
obstakels alleen als “ruwe richtlĳnen”, en het is mogelĳk dat in deze versie een label met lage prioriteit zal
worden geplaatst boven een obstakel met hoge prioriteit. Daarom kan het moeilĳk zĳn om de gewenste
resultaten voor labelen te verkrĳgen bĳ het gebruiken van deze versie en wordt die dus alleen aanbevolen
voor compatibiliteit met oudere projecten.

– Versie 2 (aanbevolen): dit is het standaardsysteem in nieuwe projecten die zĳn gemaakt in QGIS 3.12 of
later. In versie 2 is de logica, die dicteert wanneer het labels is toegestaan om obstakels te overlappen,
opnieuw bewerkt. De nieuwere logica verbiedt labels om obstakels te overlappen die een groter gewicht
voor obstakels hebben, vergeleken met de prioriteit van de labels. Als resultaat hiervan heeft deze versie
veel beter te voorspellen en gemakkelĳker te begrĳpen resultaten voor labelen.

Regel-gebaseerd labelen

Met Regel-gebaseerd labelen kunnen meerdere configuraties voor labels worden gedefinieerd en selectief worden
toegepast op basis van filters van expressies, zoals in Regel-gebaseerd renderen.
Een regel maken:

1. Selecteer de optie Regel-gebaseerd labelen in de hoofdkeuzelĳst van de tab Labels

2. Klik op de knop Regel toevoegen aan de onderzĳde van het dialoogvenster.
3. Vul het nieuwe dialoogvenster met:

• Omschrĳving: een tekst die wordt gebruikt om de regel te identificeren op de tab Labels en als een item
voor de labellegenda in de legenda van de afdruklay-out

• Filter: een expressie om de objecten te selecteren waarop de instellingen voor het label van toepassing
zĳn

• Als er al regels zĳn ingesteld kan de optie Anders worden gebruikt om alle objecten te selecteren die niet
voldoen aan een van de regels in dezelfde groep.

4. U kunt een schaalbereik instellen waarin de regel voor het abel zou moeten worden toegepast.
5. De beschikbare opties onder het groepsvak Labels zĳn de normale instellingen voor labels. Configureer ze en

druk op OK.
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Fig. 16.27: Instellingen regels
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Een overzicht van de bestaande regels wordt weergegeven in het hoofddialoogvenster (bekĳk Fig. 16.28). U kunt
meerdere regels toevoegen, de volgorde wĳzigen of ze dakpansgewĳze leggen met slepen en neerzetten. U kunt ze
ook verwĳderen met de knop of ze bewerken met de knop of een dubeblklik.

Fig. 16.28: Paneel Regel-gebaseerd labelen

Labels definiëren die zijn gebaseerd op expressies

Of u nu kiest voor het type enkel of op regel gebaseerd labelen, QGIS staat toe om objecten te labelen met expressies.

Er van uitgaande dat u de methode Enkele labels gebruikt, klik op de knop nabĳ de keuzelĳstWaarde op de tab
Labels van het dialoogvenster Laageigenschappen.

In Fig. 16.29 ziet u een voorbeeld van een expressie om de laag met bomen in Alaska te labelen met type boom
en gebied, gebaseerd op het veld ‘VEGDESC’, enige beschrĳvende tekst, en de functie $area in combinatie met
format_number() om het er netter uit te laten zien.

Fig. 16.29: Expressies gebruiken voor labelen

Labelen gebaseerd op expressie is eenvoudig om mee te werken. Waar u rekening mee moet houden is:
• U moet misschien alle elementen (tekenreeksen, velden en functies) combineren met een functie voor het
samenvoegen van tekenreeksen, zoals concat, + of ||. Onthoud dat in sommige situaties (als null of
numerieke waarden zĳn betrokken) niet al deze gereedschappen aan uw wensen zullen voldoen.
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• Tekenreeksen zouden moeten worden omsloten door ‘enkele aanhalingstekens’.
• Velden moeten worden omsloten door “dubbele aanhalingstekens” of zonder enig aanhalingsteken.

Laten we eens naar enkele voorbeelden kĳken:
1. Labels, gebaseerd op twee velden ‘name’ en ‘place’, met een komma als scheidingsteken:

"name" || ', ' || "place"

Geeft terug:

John Smith, Paris

2. Labels, gebaseerd op twee velden ‘name’ en ‘place’, met andere teksten:

'My name is ' + "name" + 'and I live in ' + "place"
'My name is ' || "name" || 'and I live in ' || "place"
concat('My name is ', name, ' and I live in ', "place")

Geeft terug:

My name is John Smith and I live in Paris

3. Labels, gebaseerd op twee velden ‘name’ en ‘place’, met andere teksten en gecombineerde functies
samenvoegen:

concat('My name is ', name, ' and I live in ' || place)

Geeft terug:

My name is John Smith and I live in Paris

Of, als het veld ‘place’ NULL is, geeft terug:

My name is John Smith

4. Labels met meerdere regels, gebaseerd op twee velden ‘name’ en ‘place’, met een beschrĳvende tekst:

concat('My name is ', "name", '\n' , 'I live in ' , "place")

Geeft terug:

My name is John Smith
I live in Paris

5. Label, gebaseerd op een veld en de functie $area, om de naam van de plaats weer te geven en de afgeronde
grootte van het gebied in een geconverteerde eenheid:

'The area of ' || "place" || ' has a size of '
|| round($area/10000) || ' ha'

Geeft terug:

The area of Paris has a size of 10500 ha

6. Maak een voorwaarde CASE ELSE. Als de waarde van de bevolking in het veld population is <= 50000 is het
een kleine stad, anders is het een stad:

concat('This place is a ',
CASE WHEN "population" <= 50000 THEN 'town' ELSE 'city' END)

Geeft terug:
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This place is a town

7. Geef de naam voor de steden weer en geen label voor de andere objecten (bekĳk het voorbeeld hierboven voor
de context van “city”):

CASE WHEN "population" > 50000 THEN "NAME" END

Geeft terug:

Paris

Zoals u kunt zien in de expressiebouwer heeft u honderden functies beschikbaar om eenvoudige en zeer complexe
expressies te maken om uw gegevens in QGIS te labelen. Bekĳk het hoofdstuk Expressies voor meer informatie en
voorbeelden over expressies.

Data gedefinieerd labelen gebruiken

Met de functie Data-bepaalde ‘override’ worden de functies voor de labels overschreven door items uit de attributentabel
of expressies die daarop zĳn gebaseerd. Deze mogelĳkheid kan worden gebruikt om waarden in te stellen voor de
meeste hierboven vermelde opties voor labelen.
Laten we, als voorbeeld, de QGIS voorbeeld gegevens voor Alaska gebruiken om de laag airports te labelen met
hun naam, gebaseerd op hun militaire USE, d.i. of het vliegveld toegankelĳk is voor:

• militairen, en het dan weergeven in een grĳze kleur, grootte 8;
• anderen, en het dan weergeven in een blauwe kleur, grootte 10.

Om dit te doen, nadat u het labelen hebt ingeschakeld op het veld NAME van de laag (bekĳk Een label instellen):
1. Activeer de tab Tekst.

2. Klik op het pictogram naast de eigenschap Grootte.
3. Selecteer Bewerken… en typ:

CASE
WHEN "USE" like '%Military%' THEN 8 -- because compatible values are

↪→'Military'
-- and 'Joint Military/Civilian'

ELSE 10
END

4. Druk op OK om het door te voeren. Het dialoogvenster sluit en de knop wordt wat betekent dat een
regel wordt uitgevoerd.

5. Klik dan op de knop naast de eigenschap Kleur, typ de expressie hieronder en voer die door:

CASE
WHEN "USE" like '%Military%' THEN '150, 150, 150'
ELSE '0, 0, 255'

END

Op dezelfde manier kunt u elke andere eigenschap van het label opmaken zoals u dat wilt. Bekĳk meer details in
de beschrĳving van de widget Data-bepaalde ‘override’ en het bewerken ervan in het gedeelte Data-bepaalde ‘override’
instellen.
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Fig. 16.30: Labels van vliegvelden zijn opgemaakt gebaseerd op hun attributen

Tip: Gebruik de Data-bepaalde ‘override’ om elk deel van samengestelde objecten te labelen
Er is een optie om het labelen voor meerdelige objecten onafhankelĳk in te stellen van uw eigenschappen voor labels.
Kies Renderen, Opties object, ga naar de knop Data-bepaalde ‘override’ naast het keuzevak Elk deel van
een samengesteld object labelen en definieer de labels zoals beschreven in Data-bepaalde ‘override’ instellen.

De werkbalk Label

De werkbalk Label verschaft enkele gereedschappen om labels te bewerken (inclusief hun eigenschappen voor

tekstballon) of diagram:

Fig. 16.31: De werkbalk Label

• Vastgezette labels, diagrammen en tekstballonnen accentueren. Als de vectorlaag van het item is te bewerken, dan is de kleur
van het accentueren groen, anders blauw.

• Schakel weergave van niet geplaatste labels: Maakt het mogelĳk om te bepalen of belangrĳke labels ontbreken in de
kaarten (bĳv. vanwege overlappingen of andere beperkingen). Zĳ worden weergegeven in een aan te passen
kleur (bekĳk Instellen van de automatische plaatsing)..
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• Labels en diagrammen vastzetten/losmaken. Door te klikken op of een gebied te slepen zet u overgelegde items vast. Als
u klikt of sleept met een gebied met de Shift-toets ingedrukt, worden de items losgemaakt. Tenslotte kunt u
ook klikken of slepen met een gebied met de Ctrl-toets ingedrukt om hun status van vastzetten/losmaken te
schakelen.

• Labels en diagrammen tonen/verbergen. Als u klikt op de items, of klikt en een gebied sleept met de Shift-toets
ingedrukt, worden ze verborgen. Wanneer een item is verborgen, hoeft u slechts op het object te klikken om
de zichtbaarheid te herstellen. Als u een gebied sleept zullen alle items in het gebied worden hersteld.

• Verplaats een label, diagram of tekstballon: klik om het item te selecteren en klik om het naar de gewenste plaats
te verplaatsen. De nieuwe coördinaten worden opgeslagen in hulpvelden. Selecteren van het item met dit
gereedschap en drukken op de toets Delete zal de opgeslagen waarde voor de positie verwĳderen.

• Roteer een label. Klik om het label te selecteren en klik opnieuw om de gewenste rotatie toe te passen. Op
dezelfde wĳze wordt de nieuwe hoek opgeslagen in een hulpveld. Selecteren van een label met dit gereedschap
en drukken op de toets Delete zal de waarde voor het roteren van dit label verwĳderen.

• Label-eigenschappen wĳzigen. Het opent een dialoogvenster om de geklikte eigenschappen van het label te wĳzigen;
dat kan het label zelf zĳn, zĳn coördinaten, hoek, lettertype, grootte, uitlĳnen van meerdere regels…, zolang
als deze eigenschap maar is verbonden met een veld. Hier kunt u de optie instellen voor Elk deel van een
object labelen.

Waarschuwing: Gereedschappen voor label overschrĳven huidige veldwaarden
Het gebruiken van de werkbalk Label om het labelen aan te passen schrĳft in feite de nieuwe waarde voor de
eigenschap naar het toegewezen veld. Wees daarom voorzichtig om niet per ongeluk gegevens te vervangen die u
later misschien nog nodig hebt!

Notitie: Het mechanisme Eigenschappen Hulpopslag kan worden gebruikt om het labelen aan te passen (positie,
enzovoort) zonder de onderliggende gegevensbron aan te passen.

De labels aanpassen vanuit het kaartvenster

Gecombineerd met de werkbalk Label, helpt de instelling Data-bepaalde ‘override’ u labels te manipuleren in het
kaartvenster (verplaatsen, bewerken, roteren). We beschrĳven nu een voorbeeld met de functie Data-bepaalde
‘override’ voor de functie Verplaats een label, diagram of tekstballon (bekĳk Fig. 16.32).

1. Importeer lakes.shp uit de voorbeeld gegevensset van QGIS.

2. Dubbelklik op de laag om de Laageigenschappen te openen. Klik op Labels en Plaatsing. Selecteer Op
afstand van centroïde.

3. Ga naar de items Data bepaald. Klik op het pictogram om te bepalen welk veld gebruikt moet worden
voor Coördinaat. Kies xlabel voor X en ylabel voor Y. De pictogrammen worden nu geel geaccentueerd.

Fig. 16.32: Labelen van polygoon vectorlagen met data-bepaalde ‘override’s
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4. Zoom in op een meer.

5. Stel het bewerken van de laag in met behulp van de knop Bewerken aan/uitzetten.

6. Ga naar de werkbalk Label en klik op het pictogram . Nu kunt u het label handmatig naar een andere positie
verplaatsen (zie Fig. 16.33). De nieuwe positie van het label wordt opgeslagen in de kolommen xlabel en
ylabel van de attributentabel.

7. Het is ook mogelĳk een lĳn toe te voegen die de meren verbindt met hun verplaatste label met behulp van:
• de eigenschap Tekstballon van het label
• of de geometriegenerator symboollaag met de expressie hieronder:

make_line( centroid( $geometry ), make_point( "xlabel", "ylabel" ) )

Fig. 16.33: Verplaatste labels

Notitie: Het mechanisme Eigenschappen Hulpopslag kan met data-bepaalde eigenschappen worden gebruikt zonder
een te bewerken gegevensbron te heben.
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16.1.5 Eigenschappen diagrammen

De tab Diagrammen stelt u in staat diagrammen in een vectorlaag te plaatsen (zie Fig. 16.34).
De huidige bron-implementatie voor diagrammen verschaft ondersteuning voor:

• Geen diagrammen: de standaardwaarde waarbĳ geen diagrammen worden weergegeven over de objecten;

• Taartdiagram, een cirkelvormige statistische grafiek opgedeeld in stukken om de numerieke verhouding
weer te geven. De lengte van de boog van elk stuk is proportioneel aan de hoeveelheid die het weergeeft;

• Tekstdiagram, een horizontaal gedeelde cirkel waarin de statistische waarden worden weergegeven;

• Histogram, balken in verschillende kleuren voor elk attribuut, naast elkaar uitgelĳnd

• Kolommen, Gestapelde kolommen van verschillende kleuren voor elk attribuut, verticaal of horizontaal
bovenop elkaar

In de rechterbovenhoek van de tab Diagrammen verschaft de knop
Automatische instelling voor plaatsing (van toepassing op alle lagen) manieren om de plaatsing van labels voor het diagram in het
kaartvenster te beheren.

Tip: Snel tussen typen diagram schakelen
Gegeven het feit dat instellingen nagenoeg algemeen zĳn voor de verschillende typen diagram, kunt u, bĳ het
ontwerpen van uw diagram, eenvoudig het type diagram wisselen en controleren welke beter toe te passen voor
uw gegevens, zonder enig verlies.

Voor elk type diagram zĳn de eigenschappen verdeeld over verscheidene tabs:
• Attributen

• Rendering

• Grootte

• Plaatsing

• Opties

• Legenda

Attributen

Attributen definieert welke variabelen moeten worden weergegeven in het diagram. Gebruik de knop Item toevoegen

om de gewenste velden te selecteren voor het paneel ‘Toegekende attributen’. Gegenereerde attributen met Expressies
kunnen ook worden gebruikt.
U kunt, om te sorteren hoe attributen worden weergegeven, elke rĳ naar boven of beneden verplaatsen met klikken
en slepen. U kunt ook het label in de kolom ‘Legenda’ wĳzigen of de kleur van het attribuut door te dubbelklikken
op het item.
Dit label is de standaardtekst die wordt weergegeven in de legenda van afdruklay-out of de boom met lagen.
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Fig. 16.34: Diagrammen - tab Attributen

Renderen

Rendering definieert hoe het diagram er uitziet. Het verschaft algemene instellingen die geen invloed hebben op de
statistische waarden zoals:

• de transparantie van de grafiek, de omtrek, breedte en kleur ervan;
• afhankelĳk van het type diagram:

– voor histogram en kolommen, de breedte van de balk en de afstand tussen de balken. U wilt misschien
de afstand voor kolommen instellen op 0. Meer nog, het Symbool aslĳn kan zichtbaar worden gemaakt in
het kaartvenster en worden aangepast met Eigenschappen lĳnsymbool.

– voor tekstdiagramworden de kleur van de achtergrond van de cirkel en het lettertype gebruikt voor teksten;
– voor taartdiagrammen, de Beginhoek van het eerste stuk en zĳn Richting (met de klok mee of niet).

• het gebruiken van tekeneffecten op de grafieken.
Op deze tab kunt u ook de zichtbaarheid van het diagram beheren en fĳn afstemmen met verschillende opties:

• Diagram Z-index: beheert hoe diagrammen boven elkaar en boven labels worden getekend. Een diagram met
een hogere index wordt getekend boven diagrammen en labels;

• Alle diagrammen tonen: geeft alle diagrammen weer, zelfs als zĳ elkaar overlappen;
• Diagram weergeven: staat toe dat alleen specifieke diagrammen worden gerenderd;
• Toon altĳd: selecteert specifieke diagrammen om altĳd te renderen, zelfs als zĳ andere diagrammen of labels
overlappen;

• instellen van de Schaalafhankelĳke zichtbaarheid;
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Fig. 16.35: Diagrammen - tab Rendering

Grootte

Grootte is de hoofdtab om in te stellen hoe de geselecteerde statistieken worden weergegeven. De eenheid voor grootte
van het diagram mag ‘Millimeters’, ‘Punten’, Pixels, ‘Kaarteenheden’ of ‘Inches’ zĳn. U kunt gebruiken :

• Vaste grootte, een unieke grootte om de grafiek van alle objecten weer te geven (niet beschikbaar voor
histogram)

• of Geschaalde grootte, gebaseerd op een expressie met behulp van attributen van de laag:
1. Selecteer, in Attribuut, een veld of bouw een expressie
2. Klik op Vind om deMaximale waarde terug te geven van het attribuut of voer een aangepaste waarde in

de widget in.
3. Voor histogram en kolommen, voer een waarde Lengte balk in, gebruikt om deMaximale waarde van de

attributen weer te geven. Voor elk object zal de lengte van de balk dan lineair op schaal worden gebracht
om deze overeenkomst te behouden.

4. Voor taart- en tekstdiagram, voer een waarde Grootte in, gebruikt om de Maximale waarde van de
attributen weer te geven. Voor elk object zal het cirkelgebied of de diameter dan lineair op schaal worden
gebracht om deze overeenkomst te behouden (vanaf 0). Een Minimale grootte kan echter ook worden
ingesteld voor kleine diagrammen.
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Fig. 16.36: Diagrammen - tab Grootte

Plaatsing

Plaatsing definieert de positie van het diagram.Afhankelĳk van het type geometrie voor de laag biedt het verschillende
opties voor de plaatsing (meer details op Plaatsing):

• Rondom punt of Boven punt voor geometrie punt. De eerste variabele vereist een straal om te volgen.
• Rondom lĳn of Boven lĳn voor geometrie lĳn. Net als bĳ een puntobject vereist de eerste variabele een afstand
om te respecteren en de gebruiker kan de plaatsing van het diagram specificeren, relatief aan het object (‘boven’,
‘op’ en/of ‘onder’ de lĳn). Het is mogelĳk om verscheidene opties in één keer te selecteren. In dat geval zal
QGIS zoeken naar de optimale positie voor het diagram. Onthoud dat u hier ook de oriëntatie van de lĳn kunt
gebruiken voor de positie van het diagram.

• Rondom zwaartepunt (met een ingestelde afstand), Boven zwaartepunt, Omtrek gebruiken en ergens Binnen
polygoon zĳn de opties voor objecten polygoon.

De groep Coördinaten verschaft direct beheer over het plaatsen van diagrammen, op een object-per-object basis,
gebruik makend van hun attributen of een expressie om de X- en Y-coördinaat in te stellen. De informatie mag ook
worden ingevuld met het gereedschap Labels en diagrammen verplaatsen.
In het gedeelte Prioriteit kunt u de prioriteit voor elk diagram definiëren, d.i. als er verschillende kandidaatlabels of
-diagrammen voor dezelfde locatie zĳn, zal het item met de hogere prioriteit worden weergegeven en de andere zullen
worden weggelaten.
Voorkomen dat diagrammen en labels objecten bedekken: definieert objecten om als obstakels te gebruiken, d.i. QGIS
zal proberen geen diagrammen of labels over deze objecten te plaatsen. De prioriteit zal worden gebruikt om te
evalueren of een diagram zou kunnen worden weggelaten vanwege een object met een hoger gewicht als obstakel.
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Fig. 16.37: Dialoogvenster Vectoreigenschappen met Diagrammen, tab Plaatsing

Opties

De tab Opties heeft alleen instellingen voor histogram en kolommen. U kunt er voor kiezen of de Kolom-oriëntatie
zou moeten zĳn Omhoog, Naar beneden, Rechts en Links, voor horizontale en verticale diagrammen.

Legenda

Op de tab Legenda kunt u kiezen welke items van het diagram moeten worden weergegeven in het paneel Lagen, en
in de legenda van de afdruklay-out, naast de symbologie van de laag:

• selecteer Legenda-items voor attributen van diagram weergeven om weer te geven in de eigenschappen Kleur
en Legenda van de Legenda, zoals eerder toegewezen op de tab Attributen;

• en, als een geschaalde grootte wordt gebruikt voor de diagrammen, druk op de knop Items voor legenda voor
grootte diagram… om de ligging van de symbolen voor de diagrammen in de legenda’s te configureren. Dit
opent het dialoogvensterData-bepaalde grootte legendawaarvan de opties worden beschreven inData-bepaalde
grootte legenda.

Indien ingesteld zĳn de items van de legenda (attributen met kleur en grootte diagram) van het diagram ook
beschikbaar in de legenda van afdruklay-out, naast de symbologie van de laag.

16.1.6 Eigenschappen Maskers

De tabMaskers helpt u de huidige laagsymbolen van de overlegmet andere symboollagen of labels te configureren,
vanuit elke laag. Dit is bedoeld om de leesbaarheid van symbolen en labels, waarvan de kleuren dicht bĳ elkaar liggen
en die moeilĳk te ontcĳferen zouden kunnen zĳn bĳ overlappen, te verbeteren; het voegt een aangepast en transparant
masker toe rondom de items om delen van de symboollagen van de huidige laag “te verbergen”.
U moet eerst, om maskers op de actieve laag toe te kunnen passen, in het project inschakelen ofwel Gemaskeerde
symboollagen of Labels Masker. Selecteer dan op de tab Maskers:

• deGemaskeerde symboollagen: vermeldt in een boomstructuur alle symboollagen van de huidige laag. Daar kunt
u het item voor de symboollaag selecteren dat u transparant zou willen “uitsnĳden” wanneer zĳ de geselecteerde
bronnen van het masker overlappen
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• de Bronnen masker: vermeldt alle maskers voor labels en gemaskeerde symboollagen die zĳn gedefinieerd in
het project. Selecteer de items die het masker over de geselecteerde gemaskeerde symboollagen zouden moeten
maken

Fig. 16.38: Laag-eigenschappen - tab Maskers

16.1.7 Eigenschappen 3D-weergave

De tab 3D-weergave verschaft instellingen voor vectorlagen die zouden moeten worden weergegeven in het
gereedschap 3D-kaartweergave.
Een laag weergeven in 3D, selecteer uit het combinatievak aan de bovenzĳde van de tab, ofwel:

• Enkel symbool: objecten worden gerenderd met een algemeen 3D-symbool waarvan de eigenschappen data-
bepaald kunnen zĳn of niet. Lees details in een 3D-symbool instellen voor elk type geometrie van de laag.

• Regel-gebaseerd: meerdere configuraties voor symbolen kunnen worden gedefinieerd en selectief worden
toegepast, gebaseerd op expressiefilters en schaalbereik. Meer details over hoe in Regel-gebaseerd renderen.
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Fig. 16.39: 3D-eigenschappen van een puntenlaag

Let op: Voorkeur voor de tab Hoogte voor instellingen voor symbolen voor hoogte en terrein
Eigenschappen voor hoogte en aan hoogte gerelateerd (Hoogte vastzetten, Binding hoogte, Uitstrekken of Hoogte)
in de tab 3D weergave erven hun standaard waarden van de Eigenschappen voor hoogte van de laag en zouden bĳ
voorkeur moeten worden ingesteld op de tab Hoogte.

Voor een betere uitvoering worden gegevens vanuit vectorlagen geladen op de achtergrond, met multithreading, en
gerenderd in tegels waarvan de grootte kan worden beheerd in het gedeelte Renderen van lagen van de tab:

• Aantal zoomniveaus: bepaalt hoe diep de quadtree zal zĳn. Bĳvoorbeeld: één zoomniveau betekent dat er één
enkele tegel voor de gehele laag zal zĳn. Drie zoomniveaus betekent dat er 16 tegels zullen zĳn op het bladniveau
(elk extra zoomniveau vermenigvuldigt dat met 4). De standaard is 3 en het maximum is 8.

• Begrenzingsvakken van tegels weergeven: in het bĳzonder nuttig als er problemen zĳn met tegels die niet
worden weergegeven terwĳl dat wel zou moeten.
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16.1.8 Eigenschappen Velden

De tab Velden verschaft informatie over velden, gerelateerd aan de laag, en helpt u ze te organiseren.

De laag kan bewerkbaar worden gemaakt met Bewerken aan/uitzetten. Op dit moment kunt u de structuur aanpassen

met de knoppen Nieuw veld en Veld verwidjeren.
U kunt ook velden hernoemen door te dubbelklikken op de naam van het veld. Dit wordt alleen ondersteund voor
gegevensproviders zoals PostgreSQL, Oracle, geheugenlaag en enkele lagen van GDAL, afhankelĳk van de versie van
GDAL.
Indien ingesteld in de onderliggende gegevensbron of in de formuliereigenschappen, wordt het alias van het veld ook
weergegeven. Een alias is een voor mensen te lezen veldnaam die u in het objectformulier of de attributentabel kunt
gebruiken. Aliassen worden opgeslagen in het projectbestand.
Anders dan de velden die zĳn opgenomen in de gegevensset, vermeldt de tab Velden, inclusief virtuele velden en
Hulpopslag, ook velden uit eventuele samengevoegde lagen. Afhankelĳk van de origine van het veld, wordt een andere
achtergrond erop toegepast.
Voor elk vermeld veld, vermeld het dialoogvenster ook alleen-lezen karakteristieken, zoals het Type, Type naam,
Lengte en Precisie`.
Afhankelĳk van de gegevensprovider kunt u een opmerking koppelen aan een veld, bĳvoorbeeld bĳ het maken ervan.
Deze informatie wordt opgehaald en weergegeven in de kolom Opmerking en wordt later weergegeven als u met de
muis over het veldlabel gaat in een objectformulier.
In de kolom Configuratie kunt u instellen hoe het veld zich zou moeten gedragen onder bepaalde omstandigheden:

• Niet te doorzoeken: selecteer deze optie als u niet wilt dat dit veld wordt bevraagd door de zoek
Locatiebalk

• Niet weergeven via WMS: selecteer deze optie als u dit veld niet wilt weergeven als de laag wordt
geserveerd als WMS vanuit QGIS server

• Niet weergeven via WFS: selecteer deze optie als u dit veld niet wilt weergeven als de laag wordt
geserveerd als WFS vanuit QGIS server

Fig. 16.40: Tab Veldeigenschappen
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16.1.9 Eigenschappen Formulier attributen

De tab Formulier attributen helpt u het formulier in te stellen dat wordt weergegeven bĳ het maken van nieuwe
objecten of het bevragen van bestaande. U kunt definiëren:

• het uiterlĳk en gedrag van elk veld in het objectformulier of de attributentabel (label, widget, beperkingen…);
• de structuur van het formulier (aangepast of automatisch gemaakt):
• extra logica in Python om interactie met het formulier of de widgets voor de velden af te handelen.

Aan de rechterbovenzĳde van het dialoogvenster kunt u instellen of het formulier standaard moet worden geopend
bĳ het maken van nieuwe objecten. Dit kan worden geconfigureerd per laag of globaal met de optie Voorkom tonen
van attributenformulier na intekenen object in het menu Extra ► Opties ► Digitaliseren.

Een formulier voor uw gegevens aanpassen

Standaard, als u klikt op een object met het gereedschap Objecten identificeren of de attributentabel schakelt naar de
modus Formulierweergave, geeft QGIS een formulier weermet vooraf gedefinieerde widgets (meestal waardenvakken
en tekstvakken — elk veld wordt weergegeven op een toegewezen rĳ door zĳn label naast de widget). Als relaties op
de laag zĳn ingesteld, worden velden, uit de lagen waarnaar verwezen wordt, weergegeven in een ingebed frame aan
de onderzĳde van het formulier, met dezelfde basisstructuur.
Deze rendering is het resultaat van de standaardwaarde Automatisch genereren van de instelling Attribuutlay-
out bewerker op de tab Laageigenschappen► Formulier attributen. Deze eigenschap bevat drie verschillende waarden:

• Automatisch genereren: behoudt de basisstructuur van “één rĳ - één veld” voor het formulier, maar
staat aanpassen toe van elk corresponderend widget.

• Ontwerper Slepen en neerzetten: anders dan aanpassen van de widgets, kan de structuur van het
formulier meer complex worden gemaakt, bĳv. met widgets die zĳn ingebed in groepen en tabs.

• Geef een UI-bestand op: maakt het mogelĳk een bestand van Qt Designer te gebruiken, en dus een
potentieel meer complex en volledig uitgerust sjabloon, als objectformulier.

Het automatisch gemaakte formulier

Als de optie Automatisch genereren is ingeschakeld geeft het paneel Beschikbare widgets de lĳst met velden
weer (van de laag en zĳn relaties) die in het formulier zouden worden weergegeven. Selecteer een veld en u kunt het
uiterlĳk en het gedrag ervan configureren in het rechterpaneel:

• aangepaste labels en geautomatiseerde controles aan het veld toevoegen;
• instellen om een bepaald widget te gebruiken.

De ontwerper Slepen en neerzetten

De ontwerper Slepen en neerzetten stelt u in staat een formulier te maken met verscheidene containers (tabs of
groepen) om de attribuutvelden te presenteren of andere widgets die niet direct zĳn gekoppeld aan een bepaald veld
(zoals de HTML/QML-widgets of de acties gedefinieerd voor de laag), zoals bĳvoorbeeld weergegeven in Fig. 16.41.
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Fig. 16.41: Resultaat ingebouwd formulier met tabs en benoemde groepen

1. Kies Ontwerper Slepen en neerzetten uit het combinatievak Attribuutlay-outbewerker selecteren.
Dit schakelt het paneel Lay-out formulier in naast het paneel Beschikbare widgets, gevuld met bestaande velden.
Het geselecteerde veld geeft zĳn eigenschappen weer in een derde paneel.

2. Selecteer velden die u niet wilt gebruiken in uw paneel Formulier lay-out en druk op de knop om ze te
verwĳderen. U kunt ook de selectie schakelen met de knop Selectie omdraaien.

3. Sleep en zet velden neer vanuit het eerste paneel naar het paneel Formulier lay-out om ze opnieuw toe te voegen.
Hetzelfde veld mag meerdere keren worden toegevoegd.

4. Sleep velden en zet ze neer in het paneel Lay-out formulier om de volgorde van de positie aan te passen.
5. Voeg containers (tab- of groepsframes) om velden, die tot dezelfde categorie behoren, met elkaar te associëren

en het formulier beter te structureren.

1. De eerste stap is om het pictogram Nieuwe tab of groep toevoegen aan Formulier lay-out te gebruiken. Velden en
andere groepen zullen daarin worden weergegeven.

2. Stel dan de eigenschappen voor de container in, d.i.:
• het Label: de titel die moet worden gebruikt voor de container
• het Type container: het kan een tab of een groepsvak in container (een groep binnen een tab of een
andere groep) zĳn

• en het aantal kolommen waarover de ingebedde velden zouden moeten worden verdeeld
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Fig. 16.42: Dialoogvenster om containers te maken met de Attribuutlay-outbewerker

Deze, en andere eigenschappen kunnen later worden bĳgewerkt door het item te selecteren, en, uit het
derde paneel:
• het label van de container te verbergen of weer te geven
• de container te hernoemen
• het aantal kolommen in te stellen
• een expressie in te voeren om de zichtbaarheid van de container te beheren. De expressie zal
opnieuw worden geëvalueerd, elke keer als waarden in het formulier wĳzigen, en de tab of groepsvak
overeenkomstig weergeven/verbergen

• Weergeven als groepsvak: converteert een tab naar een groepsvak op het hoogste niveau en vice
versa

• Stel, in het geval van een groepsvak, in of het, bĳ het openen van het formulier, Ingeklapt zou moeten
wordenweergegeven voor alle objecten of alleen voor die welke voldoen aan een expressie (Inklappen
beheren door expressie).

• configureer het uiterlĳk voor de Stĳl van de container, met aangepaste Achtergrondkleur, kleur voor
het label en eigenschappen voor het lettertype

3. U kunt net zoveel containers maken en inbedden als u wilt door opnieuw te drukken op het pictogram
Nieuwe tab of groep toevoegen aan Formulier lay-out.

6. De volgende stap is om de relevante velden toe te wĳzen aan elke container, door eenvoudigweg te slepen en
neer te zetten. Groepsvakken en tabs kunnen ook op dezelfde manier worden verplaatst.

7. De widget aanpassen voor de gebruikte velden
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8. In het geval dat de laag is opgenomen in een één-tot-veel relatie, sleep en zet de naam van de relatie neer vanuit
het paneel Beschikbare widgets naar het paneel Formulier lay-out. Het geassocieerde attributenformulier voor
de laag zal worden ingebed op de gekozen plaats in het formulier van de huidige laag. Net als voor de andere
items, selecteer het label van de relatie om enkele eigenschappen te configureren:

• het label van de relatie te verbergen of weer te geven
• de knop om te koppelen weer te geven
• de knop om te ontkoppelen weer te geven

9. In het geval dat voor de laag één of meer acties zĳn ingeschakeld voor het bereik Laag of Object, zullen de
acties zĳn vermeld onderActies en u kunt ze slepen en neerzetten, net alsmet de andere velden. De geassocieerde
actie zal worden ingebed op de gekozen plaats in het huidige formulier voor de laag.

10. Pas het formulier verder aan door een of meer widgets toe te voegen vanuit Andere widgets (bekĳk Andere
widgets)

11. Het dialoogvenster Laageigenschappen toe te passen

12. Open een attributenformulier van een object (bĳv. met het gereedschap Objecten identificeren) en het zou het
nieuwe formulier moeten weergeven.

Andere widgets

De Ontwerper Slepen en neerzetten biedt een aantal widgets die niet zĳn verbonden met een bepaald veld. Zĳ kunnen
worden gebruikt om het uiterlĳk van het formulier te verbeteren of om dynamisch berekende waarden weer te geven.

• HTML-widget: bed een pagina voor HTML in, de bron van de HTML mag het resultaat van dynamisch
berekende expressies bevatten.

• QML-widget: bed een pagina voor QML in, de bron van de QML mag het resultaat van dynamisch berekende
expressies bevatten.

Aangepast UI-bestand gebruiken

De optie ‘Geef een UI-bestand op’ stelt u in staat veel complexere dialoogvensters te gebruiken die zĳn gemaakt met de
Qt-Designer. Het gebruik van een UI-bestand geeft veel meer vrĳheid om een dialoogvenster te maken. Onthoud dat,
om de grafische objecten (tekstvak, combinatievak…) te kunnen koppelen aan de velden van de laag, u ze dezelfde
naam dient te geven.
Gebruik UI voor bewerken om het pad te definiëren van het te gebruiken bestand.
UI-bestanden mogen ook worden gehost op een server op afstand. In dat geval moet u de URL van het formulier
invullen in plaats van het bestandspad in UI voor bewerken.
U kunt enkele voorbeelden vinden in de les Een nieuw formulier maken van de QGIS-training-manual-
index-reference. Voor meer gevorderde informatie, bekĳk https://woostuff.wordpress.com/2011/09/05/
qgis-tips-custom-feature-forms-with-python-logic/.

Uw formulier verbeteren met aangepaste functies

Formulieren van QGIS mogen een Python-functie hebben die wordt aangeroepen als het dialoogvenster wordt
geopend. Gebruik deze functie om extra logica aan uw dialoogvensters toe te voegen. De code voor het formulier
kan op drie verschillende manieren gespecificeerd worden:

• laden uit de omgeving: een functie gebruiken, bĳvoorbeeld in een startup.py of vanuit een
geïnstalleerde plug-in

• laden uit een extern bestand: een bestandskiezer stelt u in staat een bestand voor Python te
selecteren uit uw bestandssysteem of een URL in te voeren voor een bestand op afstand.
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• laden met in-regelige code: een bewerker voor Python zal verschĳnen waar u direct de te gebruiken
functie kunt typen

In alle gevallen moet u de naam invoeren van de functie die moet worden aangeroepen (open in het voorbeeld
hieronder).
Een voorbeeld is (in module MyForms.py):

def open(dialog,layer,feature):
geom = feature.geometry()
control = dialog.findChild(QWidget,"My line edit")

Verwĳs als volgt naar de Python-functie Init: open

Het gedrag van velden configureren

Het hoofdgedeelte van de tab Formulier attributen helpt u het te gebruiken type widget instellen om waarden van het
veld in te vullen of weer te geven, in de attributentabel of het objectformulier: u kunt definiëren doe de gebruiker
werkt met elk veld en de waarden of bereik van waarden die aan elk zouden kunnen worden toegevoegd.

Fig. 16.43: Dialoogvenster om een widget voor bewerken te kiezen voor een attribuutveld
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Algemene instellingen

Ongeacht het op het veld toegepaste type widget zĳn er enkele algemene eigenschappen die u in kunt stellen om te
beheren of en hoe een veld kan worden bewerkt.

Widget weergeven

Alleen beschikbaar voor de modus Ontwerper Slepen en neerzetten, helpt deze groep u het uiterlĳk te configureren
van de widget die is toegewezen aan het veld:

• Label weergeven: geeft aan of de veldnaam moet worden weergegeven in het formulier
• Kleur label overschrĳven: past een specifieke kleur toe op het label van het veld
• Lettertype label overschrĳven: past specifieke eigenschappen van het lettertype (vet, cursief, onderstrepen,
doorhalen, of familie lettertype) toe op het label van het veld

Algemene opties

• Alias: een door mensen te lezen naam om te gebruiken voor velden. Het alias zal worden weergegeven in
het objectformulier, de attributentabel, of in het paneel Identificatieresultaten. Het kan ook worden gebruikt
als vervanging voor de veldnaam in de Expressiebouwer, wat het begrĳpen en beoordelen van expressies
gemakkelĳker maakt. Aliassen worden opgeslagen in het projectbestand.

• Opmerking: geeft de opmerking voor het veld weer, zoals weergegeven op de tab Velden, in een status Alleen-
lezen. Deze informatie wordt weergegeven als Helptip bĳ het over het veldlabel gaan in een formulier van het
object.

• Aanpasbaar: deselecteer deze optie om het veld in te stellen als Alleen-lezen (niet handmatig aan te passen)
als de laag in modus Bewerken staat. Onthoud dat deze instelling niet een door de provider ingestelde beperking
voor bewerken overschrĳft.

• Laatst ingevoerde waarde gebruiken: onthoudt de laatste ingevoerde waarde die is ingevoerd in dit veld en
gebruikt het als standaard voor het volgende object dat wordt bewerkt in de laag.

• Labels bovenaan: plaatst de veldnaam boven of naast de widget in het objectformulier.

Standaard waarden

• Standaardwaarde: voor nieuwe objecten, vult standaard automatisch het veld met een vooraf gedefinieerde
waarde of een die op een expressie is gebaseerd. U kunt bĳvoorbeeld:

– $x, $length, $area gebruiken om automatisch een veld te vullen met de X-coördinaat, lengte, gebied
of andere geometrische informatie van een object bĳ het maken ervan;

– een veld met 1 verhogen voor elk nieuw object met maximum("field")+1;
– de datetime van het maken van het object opslaan met now();
– variabelen in expressies gebruiken, wat het gemakkelĳker maakt om bĳvoorbeeld de naam van
de gebruiker in te vullen (@user_full_name), het volledige pad naar het projectbestand
(@project_path), …

Een voorbeeld van de resulterende standaardwaarde wordt weergegeven aan de onderzĳde van de widget.

Notitie: De optie Standaardwaarde is zich niet bewust van de waarden in enig ander veld van het te
maken object, dus is het niet mogelĳk een expressie te gebruiken die enkele van deze waarden combineert, d.i.
gebruiken van een expressie als concat(field1, field2) zou niet kunnen werken.
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• Standaardwaarde toepassen bĳ bĳwerken: elke keer als het attribuut of de geometrie van het object wordt
gewĳzigd, wordt de waarde opnieuw berekend. Dit zou handig kunnen zĳn om waarden op te slaan zoals de
laatste gebruiker die wĳzigingen in de gegevens maakt, laatste keer dat het werd gewĳzigd…

Beperkingen

U kunt de in het veld in te voegen waarde beperken. Deze beperking mag zĳn:

• Niet null: eist van de gebruiker om een waarde in te vullen

• Uniek: garandeert dat de ingevoerde waarde voor het gehele veld uniek zal zĳn;
• gebaseerd op een aangepaste expressie: bĳv. not regexp_match(col0,'A-Za-z') zal er voor zorgen
dat de waarde van het veld col0 alleen alfabetische letters mag hebben. Een korte beschrĳving kan worden
toegevoegd om u te helpen de beperking te onthouden.

Elke keer als een waarde wordt toegevoegd aan of bewerkt in een veld, wordt het doorgegeven aan de bestaande
beperkingen en:

• als het voldoet aan alle vereisten, wordt een groen vinkje weergegeven naast het veld in het formulier;
• als het niet voldoet aan alle vereisten, dan wordt het veld geel of oranje gekleurd weergegeven en een
overeenkomend kruis wordt weergegeven naast de widget. U kunt over het kruis gaan met de muis om er
achter te komen welke beperkingen zĳn toegepast op het veld en de waarde te repareren:

– Een geel kruis verschĳnt als de beperking waaraan niet voldaan wordt er een is die niet geforceerd kan
worden afgedwongen (zachte beperking) en het belet u niet om de wĳzigingen met de “verkeerde”
waarden op te slaan;

– Een oranje kruis kan niet worden genegeerd en staat u dus niet toe de wĳzigingen op te slaan, totdat
zĳ voldoen aan de beperkingen. Het verschĳnt als de optie Beperking voor expressie forceren is
geselecteerd (harde beperking).

Widgets bewerken

Gebaseerd op het type veld bepaalt QGIS automatisch en wĳst er een standaardtype widget toe. U kunt dan de widget
vervangen door elk widget dat compatibel is met dat veldtype. De beschikbare widgets zĳn:

• Keuzevak: Geeft een keuzevak weer waarvan de status definieert welke waarde moet worden ingevoerd.
• Classificatie: Alleen beschikbaar als een symbologie Categorieën is toegepast op de laag, geeft een
combinatievak weer met de waarden van de klassen.

• Kleur: Geeft een widget Kleur weer dat het mogelĳk maakt een kleur te selecteren, de waarde van de kleur
wordt opgeslagen als een HTML-notatie in de attributentabel.

• Datum/Tĳd: Geeft een regelveld weer dat een widget van een kalender kan openen om een datum, een tĳd
of beide in te voeren. Het type kolom moet tekst zĳn. U kunt een aangepaste indeling kiezen, een kalender op
laten komen, etc.

• Enumeratie: Opent een combinatievak met vooraf gedefinieerde waarden die zĳn opgehaald uit de database.
Dit wordt momenteel alleen ondersteund voor de provider PostgreSQL voor velden van het type enum.

• Bĳlage: Gebruikt een dialoogvenster “Bestand openen” om het bestandspad op te slaan in een relatieve of
absolute modus. Het kan worden gebruikt om een hyperlink weer te geven (naar het pad van het document),
een afbeelding of en webpagina. De gebruiker kan ook een extern opslagsysteem configureren om bronnen op
te halen/op te slaan.

• Verborgen: Een verborgen attribuut is niet zichtbaar. De gebruiker kan de inhoud ervan niet zien.
• Sleutel/waarde: Geeft een tabel met twee kolommen weer om sets van paren van sleutels en waarden op te
slaan binnen één enkel veld. Dit wordt momenteel alleen ondersteund voor de provider PostgreSQL voor velden
van het type hstore.
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• JSON-weergave: Geeft gegevens voor JSON weer in een syntaxis accentuerende tekstbewerker of in een
boomweergave. Dit widget is momenteel alleen-lezen. Verschillende opties zĳn beschikbaar om de manier
waarop de gegevens worden weergegeven te wĳzigen. ‘Standaard weergave’ specificeert of de widget zou
moeten verschĳnen in de modus Tekst of Boom. ‘JSON opmaken’ heeft drie opties die alleen zĳn gerelateerd
aan de weergave Boom:

– Inspringen: Geeft gegevens weer in een voor mensen leesbare vorm met nieuwe regels en vier tekens
spatie voor inspringen.

– Compact: Geeft gegevens weer in éénregelige grote, geoptimaliseerde tekenreeks zonder nieuwe regels
of spaties.

– Uitgeschakeld: Geeft gegevens weer zoals die zĳn verschaft door de provider.
• Lĳst: Geeft een tabel met één enkele kolom weer om verschillende waarden toe te voegen aan één enkel veld.
Dit wordt momenteel alleen ondersteund voor de provider PostgreSQL voor velden van het type array.

• Bereik: Maakt het mogelĳk numerieke waarden in te stellen binnen een specifiek bereik. het hulpmiddel voor
bewerking kan een schuifbalk of een draaiknop zĳn

• Relatieverwĳzing: Dit is de standaard widget die is toegewezen aan het verwĳzingsveld (d.i. de vreemde
sleutel in de kind-laag) wanneer een relatie is ingesteld. Het verschaft directe toegang tot het formulier met
ouder-objecten dat op zĳn beurt de lĳst en het formulier bevat van al zĳn kinderen.

• Tekst bewerken (standaard): Dit opent een tekstveld waarin u meerdere regels tekst kunt ingeven. Als u voor
meerdere regels kiest, kunt u ook HTML-inhoud kiezen.

• Unieke waarden: U kunt één van de al in de attributentabel gebruikte waarden kiezen. Als ‘Aanpasbaar’ is
geactiveerd wordt een hulpmiddel voor bewerken getoond met ondersteuning voor automatisch aanvullen,
anders wordt een combinatievak gebruikt.

• UUID-generator: Genereert een veld alleen-lezen UUID (Universele Unieke IDentificatie), indien leeg.
• Aanwezige waarden: Een combinatievak met vooraf gedefinieerde items. De waarde is opgeslagen in het
attribuut, de omschrĳving wordt weergegeven in het combinatievak. U kunt waarden handmatig definiëren of
laden vanuit een laag of een CSV-bestand.

• Waarde relatie: Biedt waarden uit een gerelateerde tabel in een combinatievak. U kunt laag, kolom voor sleutel
en kolom voor waarde selecteren. Verscheidene opties zĳn beschikbaar om het standaardgedrag te wĳzigen:
Null-waarden toestaan, volgorde op waarde, meerdere selecties toestaan en automatisch aanvullen gebruiken.
De formulieren zullen ofwel een keuzelĳst of een veld voor tekst bewerken weergeven als het keuzevak voor
automatisch aanvullen is ingeschakeld.
Als een laag, die is opgeslagen in PostgreSQL, GeoPackage of SpatiaLite, is geconfigureerd om een widget
Waarde relatie te gebruiken, maar de laag is nog niet geladen in het project, zal QGIS automatisch zoeken naar
de laag in dezelfde database/verbinding.

Tip: Relatieve pad in widget Bĳlage
Indien het pad dat is geselecteerd met de bestandsbrowser is geplaatst in dezelfde map als het projectbestand .qgs
of lager, worden paden geconverteerd naar relatieve paden. Dit verhoogt de portabiliteit van een project .qgs met
aangehechte informatie voor multimedia.
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16.1.10 Eigenschappen van koppelingen

De tab Koppelingen stelt u in staat objecten van de huidige laag (genaamd Doellaag) te associëren met
objecten uit een andere geladen vectorlaag (of tabel). De koppeling is gebaseerd op een attribuut dat door de lagen
wordt gedeeld. De lagen mogen zonder geometrie zĳn (tabellen) of wel, maar hun attribuut voor het koppelen zou
van hetzelfde type moeten zĳn.
Een koppeling maken:

1. Klik op de knop Nieuwe koppeling maken. Het dialoogvenster Vectorkoppeling toevoegen verschĳnt.
2. Selecteer de Koppellaag waarmee u de doelvectorlaag wilt verbinden
3. Specificeer het Koppelveld en het Doelveld, dat voorkomt in zowel de koppellaag als de doellaag
4. Druk op OK en een overzicht van de geselecteerde parameters wordt toegevoegd aan het paneel Koppelingen.
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Fig. 16.44: Een attributentabel koppelen aan een bestaande vectorlaag

De stappen hierboven zullen een koppeling maken waar ALLE attributen, van het eerste overeenkomende object in
de koppellaag, worden toegevoegd aan het object van de doellaag. QGIS verschaft meer opties om de koppeling aan
te passen:

• Koppellaag in virtueel geheugen ‘cachen’ : stelt u in staat waarden in het geheugen te cachen (zonder
geometrieën) uit de gekoppelde laag om opzoekacties te versnellen.

• Index voor attributen aanmaken op het koppelveld

• Dynamisch formulier: helpt om de koppelvelden direct te synchroniseren, overeenkomstig hetDoelveld. Op
deze manier worden ook beperkingen voor de koppelvelden ook correct bĳgewerkt. Onthoud dat het standaard
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is uitgeschakeld, omdat het heel tĳdrovend kan zĳn als u heel veel objecten hebt of ontelbare koppelingen.
• Als de doellaag bewerkbaar is, dan zullen enkele pictogrammen worden weergegeven in de attributentabel naast
velden, om te informeren over hun status:

– : de koppellaag is niet geconfigureerd om te worden bewerkt. Als u in staat wilt zĳn om gekoppelde
objecten uit de attributentabel van het doel te bewerken, dan moet u de optie Bewerkbare
samengevoegde laag selecteren.

– : de koppellaag is wel geconfigureerd om te worden bewerkt, maar de huidige status is Alleen-lezen.

– : de koppellaag is te bewerken, maar het mechanismen voor synchroniseren zĳn niet geactiveerd. Als
u automatisch een object wilt toevoegen in de koppellaag als een object in de doellaag wordt gemaakt,
dan moet u de optie Bĳwerken bĳ bewerken selecteren. Symmetrisch, de optie Stapel verwĳderen
moet worden geactiveerd als u automatisch gekoppelde objecten wilt verwĳderen.

• Gekoppelde velden: in plaats van het toevoegen van alle velden uit de gekoppelde laag, kunt u een subset
specificeren.

• Voorvoegsel voor naam aangepast veld voor gekoppelde velden, om botsingen tussen namen van velden te
vermĳden

QGIS heeft momenteel ondersteuning voor het koppelen van niet-ruimtelĳke tabelindelingen, ondersteund door
GDAL (bĳv. CSV, DBF en Excel), tekengescheiden tekst en de provider PostgreSQL.

16.1.11 Eigenschappen Hulpopslag

De normale manier om opmaak en labelen aan te passen is door data-bepaalde eigenschappen te gebruiken, zoals
beschreven in Data-bepaalde ‘override’ instellen. Dat zou echter niet mogelĳk kunnen zĳn als de onderliggende
gegevens Alleen-lezen zĳn. Meer nog zou het configureren van deze data-bepaalde eigenschappen veel tĳd kunnen
vergen of niet gewenst zĳn! Als u bĳvoorbeeld volledig de kaartgereedschappen wilt gebruiken die staan op De
werkbalk Label, dan dient u meer dan 20 velden toe te voegen en te configureren in uw originele gegevensbron (X-
en Y-posities, rotatiehoek, opmaak lettertype, kleur enzovoort).
Het mechanisme Hulpopslag verschaft de oplossing voor deze beperkingen en vervelende configuraties. Hulpvelden
zĳn een omweg om automatisch deze data-bepaalde eigenschappen (labels, diagram, symbologie…) te beheren en op
te slaan in een database voor SQLite, dankzĳ bewerkbare koppelingen. Dit stelt u in staat eigenschappen op te slaan
voor lagen die niet bewerkbaar zĳn.
Een tab is beschikbaar in het dialoogvenster voor vector-eigenschappen om de Hulpopslag te beheren:
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Fig. 16.45: Tab Hulpopslag

Labelen

Overwegende dat de gegevensbron kan worden aangepast dankzĳ data-bepaalde eigenschappen zonder bewerkbaar
te zĳn, zĳn de gereedschappen voor labelen, zoals beschreven in De werkbalk Label, altĳd beschikbaar zodra labelen
wordt geactiveerd.
In feite heeft het systeem voor hulpopslag een hulplaag nodig om deze eigenschappen op te slaan in een database van
SQLite (bekĳk Database Hulpopslag). Het proces van maken wordt uitgevoerd als u de eerste keer klikt op de kaart
terwĳl een gereedschap voor labelen van de kaart momenteel is geactiveerd. Dan wordt een venster weergegeven dat
u in staat stelt de te gebruiken primaire sleutel te selecteren voor het koppelen (om er voor te zorgen dat objecten
uniek geïdentificeerd worden):

Fig. 16.46: Dialoogvenster Hulplaag maken

Zodra een hulplaag is geconfigureerd voor de huidige gegevensbron, kunt u de informatie ervan ophalen op de tab:
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Fig. 16.47: Sleutel hulplaag

De hulplaag heeft nu deze karakteristieken:
• de primaire sleutel is ID,
• er zĳn 0 objecten die een hulpveld gebruiken,
• er zĳn 0 hulpvelden.

Nu de hulplaag is gemaakt kunt u de labels van de laag bewerken. Klik op een label terwĳl het gereedschap
Label wĳzigen is geactiveerd, dan kunt u eigenschappen voor opmaak bĳwerken zoals de grootten, kleuren, enzovoort.
De corresponderende data-bepaalde eigenschappen worden gemaakt en kunnen worden opgehaald:
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Fig. 16.48: Hulpvelden

Zoals u kunt zien in de afbeelding hierboven zĳn 21 velden automatisch gemaakt en geconfigureerd voor labelen.
Bĳvoorbeeld het type voor hulpveld FontStyle is een String en is genaamd labeling_fontstyle in de
onderliggende database van SQLite. Er is ook 1 object dat momenteel deze hulpvelden gebruikt.

Merk op dat het pictogram wordt weergegeven op de tab Labels, wat aangeeft dat de opties voor data-bepaalde
‘override’ correct zĳn ingesteld:
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Fig. 16.49: Data-bepaalde eigenschappen automatisch gemaakt

Anders is er nog een andere manier om een hulpveld te maken voor een specifieke eigenschap, dankzĳ de knop
data-bepaalde ‘override’. Door te klikken op Gegevens opslaan in het project wordt automatisch een hulpveld gemaakt voor
het veld Doorzichtbaarheid. Als u op deze knop klikt en de hulplaag nog niet is gemaakt, zal eerst een venster Fig.
16.46 worden weergegeven om de primaire sleutel te kiezen voor het koppelen.

Symbologie

Net zoals de hierboven beschreven methode voor het aanpassen van labels, kunnen hulpvelden ook worden gebruikt
om symbolen en diagrammen op te maken. Klik, om dat te doen, op Data-bepaalde ‘override’ en selecteer Gegevens
opslaan in het project voor een specifieke eigenschap. Bĳvoorbeeld het veld Vulkleur:
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Fig. 16.50: Menu Data-bepaalde eigenschappen voor symbool

Er zĳn verschillende attributen voor elk symbool (bĳv. opmaak vulling, vulkleur, randkleur, etc. …), dus elk hulpveld
dat een attribuut vertegenwoordigt vereist een unieke naam om conflicten te voorkomen. Na het selecteren van
Gegevens opslaan in het project, opent een venster en geeft het Type veld weer en vraagt u een unieke naam in te
voeren voor het hulpveld. Bĳvoorbeeld bĳ het maken van een hulpveld Vulkleur opent het volgende venster:

Fig. 16.51: Naam van het hulpveld voor een symbool

Eenmaal gemaakt kan het hulpveld worden opgehaald vanaf de tab Hulpopslag:
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Fig. 16.52: Hulpveld symbool

Attributentabel en widgets

Hulpvelden kunnen worden bewerkt met de attributentabel. Echter, niet alle hulpvelden zĳn initieel zichtbaar in de
attributentabel.
Hulpvelden die attributen weergeven van de symbologie, labelen, uiterlĳk of diagrammen van een laag zullen
automatisch in de attributentabel verschĳnen. De uitzondering zĳn attributen die aangepast kunnen worden met de
werkbalk Label die standaard zĳn verborgen. Hulpvelden die een Kleur weergeven hebben standaard een widget
Kleur ingesteld, anders hebben hulpvelden standaard een widget Tekst bewerken.
Hulpvelden die attributen weergeven die kunnen worden aangepast met de werkbalk Label zĳn standaard
Verborgen in de attributentabel. Open de tab Formulier attributen en wĳzig de waarde van een hulpveld Widget
Type van Verborgen naar een andere relevante waarde om een veld zichtbaar te maken. Wĳzig bĳvoorbeeld
auxiliary_storage_labeling_size naarTekst bewerken of wĳzig auxiliary_storage_labeling_color naar de widget
Kleur. Deze velden zullen nu zichtbaar zĳn in de attributentabel.
Hulpvelden in de attributentabel zullen er uitzien zoals in de volgende afbeelding:
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Fig. 16.53: Formulier met hulpvelden

Beheer

Het menu Hulplaag stelt u in staat de hulpvelden te beheren:
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Fig. 16.54: Beheer hulplaag

Het eerste itemMaken is in dit geval uitgeschakeld omdat de hulplaag al is gemaakt. Maar in het geval van een verse
start kunt u deze actie gebruiken om een hulplaag te maken. Zoals uitgelegd in Labelen is dan een primaire sleutel
nodig.
De actie Leegmaken stelt u in staat alle hulpvelden te behouden maar de inhoud ervan te verwĳderen. Op deze manier
zal het aantal objecten dat deze velden zal gebruiken terugvallen naar 0.
De actie Verwĳderen verwĳdert de hulplaag volledig. Met andere woorden: de corresponderende tabel wordt uit de
onderliggende database van SQLite verwĳderd en aanpassingen aan eigenschappen gaan verloren.
Tenslotte maakt de actie Exporteren het mogelĳk de hulplaag op te slaan als een nieuwe vectorlaag. Onthoud dat
geometrieën niet worden opgeslagen in hulpopslag. In dit geval worden geometrieën echter ook geëxporteerd vanuit
de originele gegevensbron.
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Database Hulpopslag

Wanneer u uw project opslaat in de indeling .qgs, wordt de database van SQLite, die wordt gebruikt voor de
hulpopslag, opgeslagen op dezelfde plaats, maar met de extensie .qgd.
Voor het gemak kan in plaats daarvan een archief worden gebruikt, dankzĳ de indeling .qgz. In dit geval worden
zowel de bestanden .qgd als .qgs ingebed in het archief.

16.1.12 Acties

QGIS geeft de mogelĳkheid om een actie te starten waarbĳ gebruik wordt gemaakt van attribuutwaarden. U
kunt meerdere acties per vectorlaag aanmaken waarmee u bĳvoorbeeld een ander programma kunt aanroepen waarbĳ
u attribuutwaarden als argumenten meegeeft.

Fig. 16.55: Overzicht dialoogvenster Acties met enkele voorbeeldacties

Acties zĳn erg handig wanneer u regelmatig een extern programma wilt uitvoeren of een webpagina wilt bekĳken die
is gebaseerd op een of meer waarden in uw vectorlaag. Zĳ zĳn van verschillende typen die als volgt gebruikt kunnen
worden:

• Acties Algemeen, macOS,Windows en Unix starten een extern proces.
• De actie Python voert een expressie voor Python uit.
• Acties Algemeen en Python zĳn overal zichtbaar.
• De acties macOS, Windows en Unix zĳn alleen zichtbaar op die specifieke besturingssystemen (u kunt bĳv.
drie acties “Bewerken” maken om een bewerkingsprogramma te openen, maar de gebruikers kunnen alleen de
actie “Bewerken” voor hun platform zien en uitvoeren om het bewerkingsprogramma uit te voeren).

• URL openen: Gebruikt een HTTP-verzoek GET om een opgegeven URL te openen.
• URL indienen (urlencoded of JSON): Hetzelfde als de actie URL openen maar gebruikt een HTTP-
verzoek POST. Gegevens worden gepost naar een URL, met “application/x-www-form-urlencoded” of
“application/json” als de body een geldige JSON is.
Een voorbeeld van een aanroep van een actie zou kunnen zĳn:

http://localhost:8000?/[% url_encode(map('file', 'index.php')) %]

• URL indienen (multipart): Hetzelfde als de actie URL openen maar gebruikt een HTTP-verzoek POST.
Gegevens worden gepost naar een URL, met “multipart/form-data”.
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Er zĳn verscheidene voorbeelden opgenomen in het dialoogvenster. U kunt deze laden door te klikken op Standaard
acties maken. Dubbelklik op een rĳ om een van de voorbeelden te bewerken. Eén voorbeeld is een zoekactie gebaseerd
op een waarde van een attribuut. Dit concept is gebruikt in volgende bespreking.

In attributentabel weergeven maakt het voor u mogelĳk de op geselecteerde objecten gerichte acties in
de attributentabel weer te geven, ofwel als Combinatievak of als Afzonderlĳke knoppen (bekĳk De kolommen
configureren).

Acties definiëren

Open, om een actie voor een attribuut te definiëren, het vectordialoogvenster Laageigenschappen en klik op de tab
Acties. Klik, op de tab Acties, op Een nieuwe actie toevoegen om het dialoogvenster Actie bewerken te openen.
Selecteer het Type voor de actie en geef een beschrĳvende naam voor de actie. De actie zelf moet de naam van de
toepassing bevatten die moet worden uitgevoerd als de actie wordt gestart. U kunt één of meer waarden van veldenmet
attributen als argumenten toevoegen voor de toepassing. Wanneer de actie wordt gestart, zal elke set tekens die begint
met een %, gevolgd door de naam van een veld, worden vervangen door de waarde van dat veld. De speciale tekens %%
zullen worden vervangen door de waarde van het veld dat werd geselecteerd uit de resultaten van de identificatie of de
attributentabel (zie Acties gebruiken). Dubbele aanhalingstekens kunnen worden gebruikt om tekst te groeperen naar
één enkel argument voor het programma, script of de opdracht. Dubbele aanhalingstekens zullen worden genegeerd
indien zĳ worden voorafgegaan door een backslash.
De Bereiken actie maken het voor u mogelĳk te definiëren waar de actie beschikbaar zou moeten zĳn. U heeft de
volgende keuzes:

1. Veld: actie is beschikbaar bĳ met rechts klikken in de cel in de attributentabel, in het objectformulier en in de
standaard actieknop van de hoofdwerkbalk.

2. Object: actie is beschikbaar bĳ met rechts klikken in de cel in de attributentabel.
3. Kaartvenster: actie is beschikbaar in de hoofd actieknop op de werkbalk.
4. Formulier: actie is alleen beschikbaar in een formulier van een object dat is ontworpen in de modus slepen en

neerzetten.
5. Laag: actie is beschikbaar in de actieknop op de werkbalk Attributentabel. Onthoud dat dit type actie de gehele

laag betreft en niet alleen de enkele objecten.
Wanneer u veldnamen gebruikt waarvan de naam een deel vormt van een andere veldnaam (bĳv. col1 en col10)
zou u dat moeten aangeven door rechte haken om de veldnaam (en het % teken) te plaatsen (bĳv. [\%col10]).
Dit voorkomt dat het veld %col10 wordt gelezen als veld %col1met daarachter de tekst 0. De rechte haken zullen
door QGIS worden verwĳderd bĳ het vervangen door de veldwaarde. Als u echter wilt dat het te vervangen veld wordt
omgeven door rechte haken, gebruik dan een tweede paar, bĳvoorbeeld: [[\%col10]].
Met behulp van het gereedschap Objecten identificeren kunt u het dialoogvenster Identificatieresultaten openen. Dit
heeft een deel (Afgeleid) dat informatie bevat die relevant is voor dit type vectorlaag. Toegang tot de waarden in dit
item kan worden verkregen op een soortgelĳke wĳze als tot andere velden door de naam van het afgeleide veld vooraf
te laten gaan door (Afgeleid).. Een puntenlaag heeft bĳvoorbeeld de afgeleide velden X en Y en de waarden van
die velden kunnen in een actie worden gebruikt als %(Afgeleid).X en %(Afgeleid).Y. De afgeleide waarden
zĳn alleen beschikbaar vanuit het dialoogvenster Identificatieresultaten niet uit het dialoogvenster Attributentabel.
Twee voorbeeldacties worden hieronder weergegeven:

• konqueror https://www.google.com/search?q=%nam

• konqueror https://www.google.com/search?q=%%

In het eerste voorbeeld wordt de webbrowser Konqueror gestart en een URL ingegeven als argument. Er wordt een
zoekactie via Google uitgevoerd op de waarde van het veld nam van onze vectorlaag. Let er op dat de toepassing wel
in het pad staat, anders moet u ook het volledige pad ingeven. We zouden het eerste voorbeeld kunnen herschrĳven
als: /opt/kde3/bin/konqueror https://www.google.com/search?q=\%nam om zeker te zĳn.
Dit zal er voor zorgen dat de toepassing Konqueror zal worden uitgevoerd wanneer de actie wordt gestart.
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Het tweede voorbeeld gebruikt de notatie %% , die niet afhankelĳk is van een bepaald veld voor zĳn waarde.Wanneer
de actie wordt gestart, zal %% worden vervangen door de waarde van het geselecteerde veld in Identificatieresultaten
of de Attributentabel.

Acties gebruiken

QGIS biedt vele manieren om acties uit te voeren die u op een laag hebt ingeschakeld. Afhankelĳk van hun instellingen
zĳn zĳ beschikbaar:

• in het keuzemenu van de knop Object-actie uitvoeren op de werkbalk Attributen of het dialoogvenster
Attributentabel;

• bĳ met rechts klikken op een object met het gereedschap Objecten identificeren (bekĳk Objecten identificeren
voor meer informatie);

• vanuit het paneel Identificatieresultaten onder het gedeelte Acties;
• als items van een kolom Acties in het dialoogvenster Attributentabel.

Wanneer u een actie start die de notatie %% gebruikt, selecteer dan eerst het veld, dat u wilt meegeven als argument, in
het venster Identificatieresultaten of het dialoogvensterAttributentabel, zodat dewaarde van dat veld wordtmeegegeven
aan de actie.
Hier volgt nog een voorbeeld dat gegevens uit een vectorlaag haalt en die met behulp van bash en de opdracht echo
naar een bestand schrĳft (dit werkt dus alleen onder en misschien ook onder ). De betrokken laag heeft velden
met de soortnaam taxon_name, de breedtegraad lat en de lengtegraad long. We zouden een ruimtelĳke selectie
willen maken van locaties en de veldwaarden voor de geselecteerde records willen exporteren naar een tekstbestand
(in geel weergegeven in het kaartvenster van QGIS). Hier volgt de actie om dat te bereiken:

bash -c "echo \"%taxon_name %lat %long\" >> /tmp/species_localities.txt"

Na het selecteren van een aantal objecten en het aanroepen van de actie ziet de inhoud van het uitvoerbestand er
ongeveer zo uit:

Acacia mearnsii -34.0800000000 150.0800000000
Acacia mearnsii -34.9000000000 150.1200000000
Acacia mearnsii -35.2200000000 149.9300000000
Acacia mearnsii -32.2700000000 150.4100000000

Als oefening kunnen we een actie maken voor de laag lakes waarbĳ we gegevens opzoeken met Google. Eerst
moeten we bepalen wat de URL is waarmee we met een zoekterm kunnen zoeken. Dat doen we door naar Google te
gaan en een simpele zoekopdracht uit te voeren en vervolgens uit de adresregel van de webbrowser de gebruikte URL
over te nemen. Met deze kleine inspanning zien we dat de indeling van de URL is: https://www.google.com/search?
q=QGIS, waarbĳ in dit geval QGIS de zoekterm is. Gewapend met deze kennis kunnen we doorgaan:

1. Eerst moet de laag lakes zĳn geladen.
2. Open het dialoogvenster Laageigenschappen door in de legenda te dubbelklikken op de laag of door met rechts

te klikken en Eigenschappen te selecteren uit het pop-upmenu.
3. Klik op de tab Acties.

4. Klik op Een nieuwe actie toevoegen.
5. Sluit het type actie URL openen,
6. Geef een naam voor de actie bĳvoorbeeld Google Search.
7. Aanvullend kunt u een Verkorte naam of zelfs een Pictogram toevoegen.
8. Kies het Bereik. BekĳkActies definiëren voor meer informatie. Laat voor dit voorbeeld de standaardinstellingen

staan.
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9. Voeg, voor de actie, de URL in voor een zoekactie met Google, maar zonder de zoekterm: https://www.
google.com/search?q=

10. De tekst in het veld Actie zou er nu als volgt uit moeten zien:

https://www.google.com/search?q=

11. Klik op de keuzelĳst die veldnamen voor de vectorlaag lakes bevat. Deze keuzelĳst staat links van de knop
Toevoegen.

12. Selecteer NAMES in de keuzelĳst en klik op Toevoegen.
13. De tekst van uw actie ziet er nu als volgt uit:

https://www.google.com/search?q=[%NAMES%]

14. Klik op de knop OK om de actie te voltooien en de actie toe te voegen.

Fig. 16.56: Overzicht dialoogvenster Acties bewerken met de voorbeeldacties

Dit voltooit de actie, en die is klaar voor gebruik.
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Sluit het dialoogvenster Laageigenschappen. Zorg er voor dat de laag lakes geselecteerd is in de legenda en start de
functie Objecten identificeren. Na het selecteren van een meer zie je dat de actie beschikbaar is in het resultaat:

Fig. 16.57: Selecteer een object en kies een actie

Wanneer we op de actie klikken, zal deze uw standaard browser opstarten en navigeren naar de URL https://www.
google.com/search?q=Tustumena. Het is ook mogelĳk om nog meer attribuutvelden aan de zoekterm toe te voegen
Daartoe kunt u aan het einde van de tekst van de actie een ‘+’ toevoegen, een ander veld te selecteren en te klikken
op Toevoegen. Voor dit voorbeeld is er echter geen veld beschikbaar dat zin zou hebben om op te zoeken.
U kunt meerdere acties voor een laag definiëren en elk daarvan zal worden weergegeven in het dialoogvenster
Identificatieresultaten.
U kunt ook acties activeren vanuit de attributentabel door een rĳ te selecteren en met rechts te klikken en dan de actie
te kiezen uit het pop-upmenu.
U kunt allerlei toepassingen voor acties bedenken. Als u bĳvoorbeeld een puntenlaag heeft die locaties van afbeelding
of foto’s bevat met een bestandsnaam, zou u een actie kunnen maken om een viewer te starten om de afbeelding weer
te geven. U zou ook acties kunnen gebruiken op web-gebaseerde rapporten voor een attribuutveld of combinatie van
velden te starten, die u op dezelfde specificeert als we met ons zoekvoorbeeld voor Google hebben gedaan.
We kunnen ook meer complexe acties maken, bĳvoorbeeld door gebruik te maken van acties van Python.
Normaal gebruiken we, als we een actie maken om een bestand met een externe toepassing te openen, absolute
paden of eventueel relatieve paden. In het tweede geval is het pad relatief ten opzichte van de locatie van de externe
toepassing. Maar wat wanneer we een relatief pad moeten gebruiken, relatief ten opzichte van de geselecteerde laag
(een op een bestand gebaseerde laag, zoals een Shapefile of een SpatiaLite)? De volgende code geeft een mogelĳke
oplossing:

command = "firefox"
imagerelpath = "images_test/test_image.jpg"
layer = qgis.utils.iface.activeLayer()
import os.path
layerpath = layer.source() if layer.providerType() == 'ogr'

else (qgis.core.QgsDataSourceURI(layer.source()).database()
if layer.providerType() == 'spatialite' else None)

path = os.path.dirname(str(layerpath))

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)
image = os.path.join(path,imagerelpath)
import subprocess
subprocess.Popen( [command, image ] )

We moeten eenvoudigweg onthouden dat de actie van het type Python is en de variabelen command en imagerelpath
moeten worden gewĳzigd om aan onze behoeften te voldoen.
Maar wat als het relatieve pad relatief moet zĳn ten opzichte van het (opgeslagen) projectbestand? De code van de
Python-actie zou dan zĳn:

command = "firefox"
imagerelpath = "images_test/test_image.jpg"
projectpath = qgis.core.QgsProject.instance().fileName()
import os.path
path = os.path.dirname(str(projectpath)) if projectpath != '' else None
image = os.path.join(path, imagerelpath)
import subprocess
subprocess.Popen( [command, image ] )

Een ander voorbeeld van een Python-actie is die welke ons in staat stelt nieuwe lagen toe te voegen aan het project.
Bĳvoorbeeld: de volgende voorbeelden zullen respectievelĳk een vector- en een rasterlaag aan het project toevoegen.
De namen van de bestanden die toegevoegd zullen worden, evenals de namen die gegeven worden aan de lagen, zĳn
reeds geladen gegevens (filename en layername zĳn kolomnamen van de attributentabel van de vectorlaag waarmee
de actie werd gemaakt.

qgis.utils.iface.addVectorLayer('/yourpath/[% "filename" %].shp',
'[% "layername" %]', 'ogr')

Het wordt, om een rasterbestand toe te voegen (in dit voorbeeld een TIF-afbeelding):

qgis.utils.iface.addRasterLayer('/yourpath/[% "filename" %].tif',
'[% "layername" %]')

16.1.13 Tonen

De tab Tonen helpt u velden te configureren om te gebruiken bĳ het identificeren van objecten:
• De Naam: gebaseerd op een veld of een expressie. Dit is:

– het weergegeven label boven de informatie over het object in de resultaten van het gereedschap Objecten
identificeren;

– het veld dat wordt gebruikt in de werkbalk Lokaliseren bĳ het zoeken naar objecten op alle lagen
– de identificatie voor het object in de formulierweergave van de attributentabel
– de identificatie voor het object wanneer de kaart of lay-out wordt geëxporteerd naar een gelaagde indeling
voor uitvoer, zoals GeoPDF

– de informatie voor de kaarttip, d.i. het bericht dat wordt weergegeven in het kaartvenster als met de muis
over een object op de actieve laag wordt gegaan terwĳl het pictogram Kaarttips weergeven is ingedrukt.
Van toepassing als geen HTML-kaarttip is ingesteld.

• De HTML-kaarttip is specifiek gemaakt voor de kaarttips: het is een meer complexe en volledige HTML-tekst
die een mix is van velden, expressies en HTML-tags (meerregelig, lettertypen, afbeeldingen, hyperlink…).
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Fig. 16.58: HTML-code voor tip op kaart

Selecteer, om Kaarttips te activeren, de menuoptie Beeld ► Kaarttips weergeven of klik op het pictogram
Kaarttips weergeven op de werkbalk Attributen. Kaarttips is een doorlopende mogelĳkheid voor sessies, wat betekent dat
als het eenmaal is ingeschakeld dat zo blĳft en wordt toegepast op elke laag in elk project, zelfs in toekomstige sessies
van QGIS, totdat het wordt uitgeschakeld.

Fig. 16.59: Tip voor kaart gemaakt met HTML-code
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16.1.14 Rendering

Fig. 16.60: Dialoogvenster Laageigenschappen

Schaalafhankelijke zichtbaarheid

U kunt de schaalMaximum (inclusief) enMinimum (exclusief) instellen, wat een bereik van schalen definieert waarin
de objecten zichtbaar zullen zĳn. Buiten dit bereik is hĳ verborgen. De knop Op huidige schaal kaartvenster instellen helpt
u de schaal van het huidige kaartvenster te gebruiken als grens voor de zichtbaarheid van het bereik. Bekĳk Schaal
zichtbaarheid selecteren voor meer informatie.

Notitie: U kunt het schaalafhankelĳk renderen ook activeren op een laag vanuit het paneel Lagen. Klik met rechts
op de laag en selecteer in het contextmenu, Zichtbaarheidsschaal laag instellen.

Geometrie vereenvoudigen

QGIS biedt ondersteuning voor directe generalisatie voor het object. Dit kan de tĳd voor het renderen verbeteren
bĳ het tekenen van vele complexe objecten op kleine schalen. Deze mogelĳkheid kan in de instellingen voor de
laag worden in- of uitgeschakeld met behulp van de optie Vereenvoudig geometrie. Er is ook een nieuwe globale
instelling die generalisatie standaard inschakelt voor nieuw toegevoegde lagen (bekĳk globale vereenvoudiging voor
meer informatie).

Notitie: Objectgeneralisatie kan in sommige gevallen artefacten in uw gerenderde uitvoer veroorzaken. Dit kunnen
versplinteringen zĳn tussen polygonen en niet nauwkeurig renderen bĳ het gebruiken van op verplaatsing gebaseerde
symboollagen.
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Bĳ het renderen van extreem gedetailleerde lagen (bĳv. polygoonlagen met een zeer groot aantal knopen), kan
dit zorgen voor extreem grote export naar de indelingen PDF/SVG in afdruklay-out omdat alle knopen worden
opgenomen in het geëxporteerde bestand. Dit kan er ook voor zorgen dat het resulterende bestand erg langzaam
wordt om mee te werken/te openen in andere programma’s.

Selecteren van Laag forceren om te renderen als een raster forceert deze lagen om te worden gerasterd zodat de
geëxporteerde bestanden niet alle knopen behoeven te bevatten die zĳn opgenomen in deze lagen en het renderen
wordt daardoor sneller.
U kunt dit ook doen door afdruklay-out te dwingen om als een raster te exporteren, maar dat is een alles-of-niets
oplossing, gegeven het feit dat het rasteren wordt toegepast op alle lagen.
Laag bĳwerken met interval (seconden): een tĳd instellen om individuele lagen automatisch te vernieuwen op een
overeenkomende interval. Bĳwerken van het kaartvenster wordt uitgesteld om veelvuldig vernieuwen te vermĳden
indien meer dan één laag een interval heeft ingesteld voor automatisch bĳwerken.
Afhankelĳk van de gegevensprovider (bĳv. PostgreSQL), kunnen notificaties worden verzonden naar QGIS als
wĳzigingen worden toegepast op de gegevensbron, buiten QGIS. Gebruik de optie Laag vernieuwen na notificeren
om bĳwerken af te dwingen. U kunt ook het vernieuwen van de laag beperken tot een specifiek bericht, ingesteld in
het tekstvak Alleen als het bericht is.

Vaste verwijzingsschaal

Indien ingesteld geeft de verwĳzingsschaal de schaal voor de kaart aan waarop grootten van symbologie en labelen die
op papier gebaseerde eenheden gebruiken (zoals millimeters of punten) zich baseren. De grootten zullen op schaal
worden gebracht. elke keer als de kaart op een andere schaal wordt bekeken.
Bĳvoorbeeld een lĳnlaagmet een 2mmbrede lĳn en een ingestelde verwĳzingsschaal van 1:2000 zal worden gerenderd
met 4mm brede lĳnen als de kaart wordt bekeken op de schaal 1:1000.

16.1.15 Eigenschappen Tijdbeheer

De tab Tĳdbeheer verschaft opties om het renderen van de laag in de tĳd te beheren. Dergelĳk dynamisch renderen
vereist dat de Navigatie voor Tĳdbeheer is ingeschakeld in het kaartvenster.
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Fig. 16.61: Dialoogvenster Eigenschappen Tijdbeheer vectorlaag

Selecteer de optie Dynamisch Tĳdbeheer om het renderen met Tĳdbeheer voor de laag te configureren.
Afhankelĳk van de structuur van uw gegevensset, wilt u misschien een van de meegeleverde opties voor Configuratie
gebruiken:

• Vaste tĳdsperiode: alle objecten worden gerenderd als het tĳdframe in het kaartvenster het opgegeven bereik
tussen Startdatum en Einddatum overlapt.

• Enkel veld met datum/tĳd: objecten worden gerenderd als hun waarde van het Veld valt binnen het tĳdframe in
het kaartvenster. Een Duur gebeurtenis kan worden ingesteld. Door de optie Objecten over tĳd accumuleren te
selecteren zullen alle objecten, die voorkomen vóór of in het tĳdbereik van de kaart, blĳven worden gerenderd.
De Duur gebeurtenis wordt dus genegeerd.

• Afzonderlĳke velden voor start en einde Datum/Tĳd: objecten worden gerenderd als het bereik dat wordt
gespecificeerd door de waarden van hun Veld Start en Einde veld de tĳdsperiode van het kaartvenster
overlappen.

• Afzonderlĳke velden voor start en Duur gebeurtenis: objecten worden gerenderd als het bereik dat wordt
gespecificeerd door de waarden van hunVeld Start enVeld Duur gebeurtenis de tĳdsperiode van het kaartvenster
overlappen.

• Start en einde Datum/Tĳd uit expressies: objecten worden gerenderd als de tĳdsperiode, die wordt gespecificeerd
door de velden Expressie Start en Expressie Einde, die van Tĳdbeheer in het kaartvenster overlapt.

• Alleen laag opnieuw tekenen: de laag wordt opnieuw getekend bĳ elke nieuw frame voor de animatie, maar er
wordt geen op tĳd gebaseerd filteren toegepast op de objecten. Het is nuttig als de laag waarden van expressies
gebruikt, die zĳn gebaseerd op tĳd, voor instellingen van renderen (bĳv. data-bepaalde symbologie).

Het is ook mogelĳk de Limieten voor de tĳdsperiode van de objecten in te stellen als:
• Inclusief Start, exclusief Einde

• Inclusief Start, inclusief Einde
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16.1.16 Variabelen

De tab Variabelen vermeldt alle variabelen die beschikbaar zĳn op het niveau van de laag (inclusief alle globale
en projectvariabelen).

Het stelt de gebruiker ook in staat om variabelen op het niveau van de laag te beheren. Klik op de knop om
een nieuwe aangepaste variabele op het niveau van de laag toe te voegen. Selecteer op dezelfde wĳze een aangepaste
variabele op het niveau van de laag en klik op de knop om hem te verwĳderen.
Meer informatie over het gebruiken van variabelen in het gedeelteWaarden opslaan in Variabelen.

16.1.17 Eigenschappen hoogte

De tab Hoogte verschaft opties om de eigenschappen voor hoogte van de laag te beheren in een 3D-kaartweergave
en het uiterlĳk in de diagrammen van het profiel. Specifiek kunt u instellen:

Fig. 16.62: Dialoogvenster Eigenschappen Hoogte vectorlaag

• Hoogte vastzetten: definieert hoe en of de hoogte van de objecten zou moeten:
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– Vastgemaakt aan terrein: neemt de hoogte direct uit de hoogte van het terrein en negeert bestaande
waarden Z in de objecten. Een data-bepaalde waarde voor Verschuiving vanaf het terrein kan ook worden
ingevuld.

– Relatief aan terrein: bestaande waarden Z in de objecten worden toegevoegd aan de hoogte van het terrein.
Een factor Schaal, gevolgd door een data-bepaalde Verschuiving, kan worden gebruikt om de hoogte aan
te passen. Deze optie is niet beschikbaar voor lagen met 2D-geometrie.

– Absoluut: negeert de hoogte van het terrein en neemt voor de hoogte de waarden Z direct uit de objecten.
Een Schaal`factor,, gevolgd door een data-bepaalde :guilabel:`Verschuiving kan worden gebruikt om de
hoogte aan te passen. Voor lagen met 2D geometrie (zonder waarden Z), kan in plaats daarvan een
Basishoogte worden ingesteld.

• Uitstrekken inschakelen: u kunt een Hoogte instellen om te beheren hoe objecten zich verticaal uitstrekken
boven hun basis. Dit is handig om aan te geven dat lagen met 2D geometrie, bĳv. een laag met polygoon
voetafdruk van een gebouw, in feite 3D objecten weergeeft.

• Hoogte binden: alleen relevant bĳ het combineren van een Hoogte vastzetten vertrouwend op het terrein met een
lĳnen- of polygonenlaag, deze optie beheert hoe de hoogte van objecten is ingesteld, relatief aan de hoogte van
het terrein. Het terrein kan worden bemonsterd:

– op het Zwaartepunt van het object, waarbĳ de hoogte van het zwaartepunt wordt toegevoegd aan de
waarde Z van elk punt

– op elk individueel Punt voordat het wordt toegevoegd aan de waarde Z van het punt
• Uiterlĳk diagram profiel: beheert hoe objecten worden gerenderd bĳ het tekenen van een diagram voor een
profiel. Twee belangrĳke modi voor Interpretatie zĳn beschikbaar:

– als Individuele objecten: monstert afzonderlĳke posities waar de kruisende profiellĳn kruist met de
vectorobjecten. Die kruising kan worden weergegeven als punt, lĳn of oppervlak, afhankelĳk van het
type laag en of uitstrekken is toegepast.

Door Symbologie laag respecteren te selecteren, zullen objecten worden gerenderd op het diagram
van het profiel met hun corresponderende opmaak voor de laag (wat het mogelĳk maakt om bĳv.
gecategoriseerde klassen zichtbaar te maken op het diagram voor het profiel). Als het type symbool
voor het profiel niet overeenkomt met de typen symbool van de renderer van de laag, zal alleen de kleur
van de renderer worden toegepast op het symbool voor het profiel.
Afhankelĳk van de instellingen van de laag kunnen symbolen voor het profiel worden weergegeven met
een aangepaste opmaak, met:
∗ Stĳl markering: voor niet-uitgestrekte objecten punt en lĳn, en voor niet-uitgestrekte objecten
polygoon die worden geraakt door de lĳn van het profiel

∗ Lĳnstĳl: voor uitgestrekte objecten punt en lĳn, en voor niet-uitgestrekte objecten polygoon die
worden gekruist door de lĳn van het profiel

∗ Vullingstĳl: voor uitgestrekte objecten polygoon
– als Doorlopend oppervlak (bĳv. Contouren): het diagram van de hoogte zal worden gerenderd als een
oppervlak in plaats van afzonderlĳke objecten door de gemonsterde resultaten voor de hoogte in een
doorlopende lĳn samen te voegen. Dit kan de visualisatie verbeteren en is ontworpen voor vectorlagen
die een doorlopend oppervlak voor hoogte weergeven, bĳv. contourlĳnen of in kaart gebrachte punten
voor hoogte. De Stĳl van de lĳn kan worden ingesteld als:
∗ een profiel Lĳn met een toegepaste lĳnstĳl
∗ een oppervlak met Vullen onder en een corresponderende Vullingstĳl

Meer nog, u kunt Markeringen weergeven op bemonsterde punten selecteren om ze zichtbaar te maken
op de lĳn voor interpretatie en ze een Stĳl markering toe te wĳzen.
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16.1.18 Metadata

De tab Metadata verschaft u opties om een rapport met metadata voor uw laag te maken en te bewerken. Bekĳk
Metadata voor meer informatie.

16.1.19 Afhankelijkheden

De tab Afhankelĳkheden maakt het mogelĳk afhankelĳkheden voor gegevens te declareren tussen lagen. Een
afhankelĳkheid voor gegevens treedt op bĳ bewerken van gegevens in een laag, niet door direct aanpassen door de
gebruiker kan gegevens van andere lagen bewerken. Dit is bĳvoorbeeld het geval als de geometrie van een laag wordt
bĳgewerkt door een trigger van de database, of een aangepast script van PyQGIS, na het aanpassen van de geometrie
van een andere laag.
Op de tabAfhankelĳkheden kunt u lagen selecteren die extern de gegevens op de huidige laag zouden kunnen wĳzigen.
Correct gespecificeerde afhankelĳke lagen stellen QGIS in staat om caches voor deze laag ongeldig te verklaren als
de afhankelĳke lagen worden gewĳzigd.

16.1.20 Legenda

De tab Legenda verschaft u geavanceerde instellingen voor het paneel Lagen en/of de legenda voor afdruklay-out.
Deze opties omvatten:

• Afhankelĳk van de op de laag toegepaste symbologie, zou u kunnen eindigen met verscheidene items in de
legenda, niet noodzakelĳkerwĳze leesbaar/nuttig om weer te geven. De Plaatsvervangende afbeelding legenda
helpt u een afbeelding selecteren voor vervanging daarvan, weergegeven zowel in het paneel Lagen als in de
legenda van de afdruklay-out.

• Labellegenda weergeven: Geeft overzichten van de verschillende instellingen voor labels als items in de
legenda’s. De labelstĳl wordt als voorbeeld gegeven, naast de omschrĳving.

• Tekst op symbolen: In sommige gevallen kan het nuttig zĳn om extra informatie aan de symbolen in de
Legenda toe te voegen. Met dit frame kunt u een symbool dat wordt gebruikt in de symbologie voor de laag
voorzien van een tekst die over het symbool wordt weergegeven, in zowel het paneel Lagen als de legenda
van afdruklay-out. Deze teksten worden gemaakt door elke tekst in te typen naast het symbool in de widget
tabel of door de tabel te vullen met de knop Labels instellen vanuit expressie. Het uiterlĳk van de tekst wordt
afgehandeld door de widgets Lettertype en Kleur van de knop Tekst opmaken.

Fig. 16.63: Instellen van tekst op symbolen (links) en het renderen ervan in het paneel Lagen (rechts)
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• Een lĳst met widgets die u in de boom van lagen in het paneel Lagen kunt inbedden. Het idee erachter is om
een manier te hebben om snel toegang te krĳgen tot acties die vaak op de laag worden gebruikt (instellen van
de transparantie, filteren, selectie, stĳl of andere dingen…).
Standaard verschaft QGIS de widget voor transparantie, maar dit kan worden uitgebreid door plug-ins die hun
eigen widgets registreren en aangepaste acties toewĳzen aan de lagen die zĳ beheren.

16.1.21 QGIS Server

De tab QGIS Server bestaat uit de gedeelten Omschrĳving, Naamsvermelding, URL metadata, en Legenda URL.
Vanuit het gedeelte Omschrĳving kunt u de Korte naam wĳzigen die wordt gebruikt als verwĳzing naar de laag in
verzoeken (lees services_basics_short_name om meer te leren over korte namen). U kunt ook een Titel en Abstract
toevoegen voor de laag of die bewerken, of hier een Sleutelwoordenlĳst definiëren. Deze sleutelwoordenlĳst kan
worden gebruikt in een catalogus voor metadata. Als u een titel wilt gebruiken uit een XML-metadatabestand, moet
u een link invoeren in het veld URL gegevens.
Gebruik Naamsvermelding om gegevens van attributen uit een catalogus met XML-metadata te halen.
In URL metadata kunt u de algemene paden naar de XML catalogus voor metadata toevoegen. Deze informatie zal
worden opgeslagen in het QGIS projectbestand voor opvolgende sessies en zal worden gebruikt voor QGIS Server.
In het gedeelte Legenda URL kunt u de URL opgeven van een afbeelding voor de legenda in het veld URL. U kunt
het keuzemenu Indeling gebruiken om de van toepassing zĳnde indeling van de afbeelding toe te passen. Momenteel
worden de indelingen voor afbeeldingen png, jpg en jpeg ondersteund.

Fig. 16.64: Tab QGIS Server in dialoogvenster Laageigenschappen

Lees de QGIS-Server-manual om meer te leren over QGIS Server.
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16.1.22 Digitaliseren

De tab Digitaliseren geeft toegang tot opties die helpen bĳ het bewaken van de kwaliteit van gedigitaliseerde
geometrieën.

Fig. 16.65: Tab Digitaliseren in dialoogvenster Laageigenschappen

Automatisch repareren

Opties in het gedeelte Automatisch repareren zullen de punten van een geometrie die wordt toegevoegd of gewĳzigd
direct beïnvloeden. Als de optie Duplicaatknopen verwĳderen is geselecteerd, zullen tweede opeenvolgende
punten, die exact dezelfde coördinaten hebben, worden verwĳderd. Als de Precisie voor geometrie is ingesteld, zullen
alle punten worden afgerond naar het dichtstbĳzĳnde veelvoud van de geconfigureerde precisie voor de geometrie.
Het afronden vindt plaats in het coördinaten referentiesysteem voor de laag. waarden Z en M worden niet afgerond.
Met veel kaartgereedschappen kan een raster worden weergegeven in het kaartvenster bĳ het digitaliseren.

Fig. 16.66: Verplaatsen van het bovenste punt snapt alle punten aan het raster
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Controles voor geometrie

In het gedeelteControles voor geometrie kunnen aanvullende validaties op een per-geometrie basis worden geactiveerd.
Onmiddellĳk na enige aanpassing aan een geometrie wordt het mislukken van deze controles gerapporteerd aan de
gebruiker in het paneel Valideren geometrie. Zo lang als een controle mislukt, is het niet mogelĳk de laag op te slaan.
De controle Is geldig controleert op basiscontroles voor geldigheid, zoals zelf kruisend op geometrieën.

Controles topologie

In het gedeelte Controles topologie kunnen aanvullende controles voor valideren van topologie worden geactiveerd.
Controles voor topologie zullen worden uitgevoerd wanneer de gebruiker de laag opslaat Fouten in de topologie zullen
worden gerapporteerd in het paneel Valideren geometrie. Zo lang als er fouten bĳ het valideren aanwezig zĳn, kan
de laag niet worden opgeslagen. Controles voor topologie worden uitgevoerd in het gebied van het begrenzingsvak
van de aangepaste objecten. Omdat andere objecten in hetzelfde gebied aanwezig kunnen zĳn, worden topologische
fouten met betrekking tot deze objecten ook gerapporteerd als fouten die in de huidige sessie van bewerken werden
geïntroduceerd.

Optie Controles topologie Illustratie

De controle Gap zal controleren op gaten tussen naburige
polygonen.

De controle Overlap zal controleren op overlappingen tussen
naburige polygonen.

De controle Missing vertex zal controleren op gedeelde
grenzen van naburige polygonen waar één grens een punt mist
dat wel aanwezig is op de andere.
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Uitzonderingen controle Gaten

Soms is het gewenst om gaten binnen een gebied in een polygoonlaag te hebben dat anders volledig zou worden bedekt
door polygonen. Een laag voor landgebruik zou bĳvoorbeeld te accepteren gaten voor meren mogen hebben. Het is
mogelĳk gebieden te definiëren die zullen worden genegeerd bĳ de controle van gaten. Omdat gaten binnen deze
gebieden zĳn toegestaan, zullen we naar ze verwĳzen als gebieden Toegestane gaten.
In de opties voor de controles van gaten onder Toegestane gaten, kan een Laag met toegestane lagen worden
geconfigureerd.
Elke keer als de controle voor gaten wordt uitgevoerd, worden gaten die worden bedekt door één of meer polygonen
in de Laag met toegestane gaten niet gerapporteerd als topologiefouten.
Het is ook mogelĳk een aanvullende Buffer te configureren. Deze buffer wordt toegepast op elke polygoon op de
Laag met toegestane gaten. Dit maakt het mogelĳk de testen minder ontvankelĳk te maken voor kleine wĳzigingen in
de omtrekken aan de grenzen of gaten.
Als Toegestane gaten zĳn ingeschakeld, is een aanvullende knop (Toegestaan gat toevoegen) voor gedetecteerde fouten
met gaten beschikbaar in het venster voor validatie van de geometrie, waar gaten worden gerapporteerd tĳdens het
digitaliseren. Als op de knop Toegestaan gat toevoegen wordt gedrukt, zal een nieuwe polygoon met de geometrie
van het gedetecteerde gat worden ingevoegd in de Laag met toegestane gaten. Dit maakt het mogelĳk gaten snel als
toegestaan te vlaggen.

Paneel Valideren geometrie

Het paneel Valideren geometrie wordt geactiveerd als een van de hierboven vermelde controles een fout vindt. Het
dialoogvenster verschaft u een lĳst met fouten en hun beschrĳving, en u kunt door de lĳst bladeren met de pĳlen op
het toetsenbord of de toegewezen pĳlen.
U zult alle problemen moeten oplossen voordat u bewerkingen aan de laag kunt opslaan. Om dat te doen:

1. Selecteer een fout en dan is het mogelĳk om:

• Zoomen naar object(en)

• Zoom naar probleem

2. Kies de gebruikelĳke gereedschappen voor digitaliseren om het probleem te repareren.

16.2 Werken met de attributentabel

De attributentabel geeft informatie over de objecten van een geselecteerde laag weer. Elke regel in de tabel geeft één
object (met of zonder geometrie) weer en elke kolom bevat een bepaald stukje informatie over het object. Objecten
in de tabel kunnen worden opgezocht, geselecteerd, verplaatst of zelfs bewerkt.

16.2.1 Voorwoord: Ruimtelijke en niet ruimtelijke tabellen

QGIS stelt u in staat ruimtelĳke en niet-ruimtelĳke lagen te laden. Dit omvat momenteel ook tabellen die worden
ondersteund door GDAL en gescheiden tekst, als ook de providers PostgreSQL, MS SQL Server, SpatiaLite en
Oracle. Alle geladen lagen worden vermeld in het paneel Lagen. Of een laag ruimtelĳk ingeschakeld is of niet bepaalt
of u interactie kunt uitvoeren op de kaart.
Niet ruimtelĳke tabellen kunnen gebladerd worden en ze kunnen worden bewerkt met de tabelweergave voor de
attributen. Verder kunnen zĳ worden gebruikt voor het opzoeken van velden. Als voorbeeld kunt u kolommen van
een niet ruimtelĳke tabel gebruiken om waarden voor attributen te definiëren of een bereik van toegestane waarden
die mogen worden toegevoegd aan een specifieke vectorlaag tĳdens het digitaliseren. Bekĳk de widget voor bewerken
in Eigenschappen Formulier attributen wat nader voor meer informatie.
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16.2.2 Introductie van de interface van de Attributentabel

Activeer, om de attributentabel voor een vectorlaag te openen, de laag door deze te selecteren in het Paneel Lagen.
Open dan de attributentabel vanuit het menu Kaartlagen, kies Attributentabel openen. Het is ook mogelĳk door
met de rechter muisknop op een laag in de legenda te klikken en Attributentabel openen te kiezen uit het
contextmenu of door te klikken op de knop Attributentabel openen op de werkbalk Attributen. Als u liever met
sneltoetsen werkt: F6 zal de attributentabel openen. Shift+F6 zal de attributentabel openen, maar gefilterd tot de
geselecteerde objecten en Ctrl+F6 zal de attributentabel openen, maar gefilterd tot de zichtbare objecten.
Dit zal een nieuw venster openen dat de attributen voor de objecten van de laag weergeeft (figure_attributes_table).
Overeenkomstig de instelling in het menu Extra ► Opties ► Databronnen, zal de attributentabel openen in
een vastgezet venster of een normaal venster. Het totale aantal objecten op de laag en het aantal momenteel
geselecteerde/gefilterde objecten wordt weergegeven in de titel van de attributentabel en ook of de laag ruimtelĳk
beperkt is.

Fig. 16.67: Attributentabel voor de laag regions

De knoppen boven in het venster van de attributentabel bieden de volgende functionaliteiten:

Tabel 16.1: Beschikbare gereedschappen
Pictogram Label Doel Standaard snelkoppeling

Bewerken aan/uitzetten Schakel functionaliteiten voor Bewerken in Ctrl+E

Schakelen naar modus Meervoudige bewerkingen Meerdere velden van veel objecten bĳwerken

Bewerkingen opslaan Huidige aanpassingen opslaan

De tabel opnieuw laden

Object toevoegen Object zonder geometrie toevoegen

Geselecteerde objecten verwĳderen Geselecteerde objecten op de laag verwĳderen
Vervolgt op volgende pagina
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Tabel 16.1 – Vervolgd van vorige pagina
Pictogram Label Doel Standaard snelkoppeling

Geselecteerde objecten naar klembord knippen Ctrl+X

Geselecteerde objecten naar klembord kopiëren Ctrl+C

Objecten vanaf klembord plakken Nieuwe objecten vanuit gekopieerde invoegen Ctrl+V

Objecten selecteren m.b.v. reguliere expressie

Alles selecteren Alle objecten op de laag selecteren Ctrl+A

Selectie omdraaien De huidige selectie van de laag omdraaien Ctrl+R

Alles deselecteren Alle objecten op de huidige laag deselecteren Ctrl+Shift+A

Objecten filteren/selecteren met behulp van formulier Ctrl+F

Geselecteerde naar boven verplaatsen Geselecteerde rĳen naar boven in de tabel verplaatsen

Kaart naar de geselecteerde rĳen verschuiven Ctrl+P

Kaart naar de geselecteerde rĳen zoomen Ctrl+J

Nieuw veld Nieuw veld aan de gegevensbron toevoegen Ctrl+W

Veld verwĳderen Een veld uit de gegevensbron verwĳderen

Kolommen schikken Velden in de attributentabel weergeven/verbergen

Veldberekening openen Veld voor veel objecten in een rĳ bĳwerken Ctrl+I

Voorwaardelĳke opmaak Opmaak voor de tabel inschakelen

Attributentabel vast zetten Maakt het mogelĳk de attributentabel vast te zetten/los te maken

Acties Vermeldt de aan de laag gerelateerde acties

Notitie: Afhankelĳk van de indeling van de gegevens en de bibliotheek van GDAL die is gebouwd met uw versie
van QGIS, zouden sommige gereedschappen niet beschikbaar kunnen zĳn.

Onder deze knoppen staat de werkbalk Veldberekening (alleen ingeschakeld in demodus Bewerken), die het mogelĳk
maakt berekeningen snel toe te passen op ofwel alle of de geselecteerde attributen in de tabel. Deze werkbalk gebruikt
dezelfde expressies als Veldberekening (zie Attribuutwaarden bewerken).
De attributentabel ondersteunt scrollen met Shift+muiswiel in de attributentabel om te schakelen naar een
horizontale scrollactie in plaats van verticaal.

Tabelweergave vs Formulierweergave

QGIS verschaft twee weergaven om eenvoudig gegevens in de attributentabel te bewerken:

• De Tabelweergave geeft waarden van meerdere objecten weer in een tabulaire modus, elke rĳ geeft een object
weer en elke kolom een veld. Een klik met rechts op de kolomkop stelt u in staat de weergave van de tabel te
configureren terwĳl een klik met rechts op een cel interactie met het object verschaft.

• De Formulierweergave geeft identificaties voor objectenweer in een eerste paneel en geeft alleen de attributen van
de aangeklikte identificatie weer in het tweede paneel. Er is een keuzemenu aan de bovenzĳde van het eerste
paneel waar de “identificatie” kan worden gespecificeerd met een attribuut (Voorbeeld kolom) of een Expressie.
Het keuzemenu bevat ook de laatste 10 expressies om die opnieuw te kunnen gebruiken. Formulierweergave
gebruikt de configuratie van de velden van de laag (bekĳk Eigenschappen Formulier attributen).
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U kunt door de identificaties van de objecten bladeren met de pĳlen aan de onderzĳde van het eerste paneel.
De attributen van de objecten worden in het tweede paneel bĳgewerkt terwĳl u daar naartoe gaat. Het is ook
mogelĳk om het actieve object in het kaartvenster te identificeren of te verplaatsen door op een van de knoppen
aan de onderzĳde te drukken:

– Huidige object op de kaart aacentueren indien zichtbaar in het kaartvenster

– Automatisch verschuiven naar huidige object

– Automatisch zoomen naar huidige object

U kunt van de ene naar de andere modus schakelen door te klikken op het corresponderende pictogram aan de
rechteronderzĳde van het dialoogvenster.
U kunt ook de modus Standaard weergave specificeren voor het openen van de attributentabel in het menu Extra ►
Opties ► Gegevensbronnen. Het kan de ‘Laatste weergave onthouden’, ‘Tabelweergave’ of ‘Formulierweergave’ zĳn.

Fig. 16.68: Attributentabel in tabelweergave (boven) vs formulierweergave (onder)
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De kolommen configureren

Klikmet rechts op een kolomkop in de Tabelweergave om toegang te krĳgen tot gereedschappen die u helpen beheren:
• de kolomgrootte

• de zichtbaarheid en volgorde van kolommen

• de sorteervolgorde van de gegevens

Breedte kolommen wijzigen

De breedte van kolommen kan worden ingesteld met een klik met rechts op de kolomkop en ofwel te selecteren:
• Breedte instellen… om de gewenste waarde in te voeren. Standaard wordt in de widget de huidige waarde
weergegeven

• Alle kolombreedten instellen… op dezelfde waarde
• of Autom. grootte om te wĳzigen naar de best passende grootte voor de kolom.
• Automatische grootte alle kolommen

Een grootte van een kolom kan ook worden gewĳzigd door de begrenzing aan de rechterkant van de kop te slepen. De
nieuwe grootte van de kolom wordt voor de laag behouden, en hersteld bĳ het opnieuw openen van de attributentabel.

Kolommen verbergen en beheren en acties inschakelen

Door met rechts te klikken op een kolomkop, kunt u kiezen voor Kolom verbergen in de attributentabel (in modus
“Tabelweergave”). Voor meer geavanceerd beheer, druk op de knop Kolommen beheren… op de werkbalk van het
dialoogvenster of kies Kolommen beheren… in het contextmenu van een kolomkop. In het nieuwe dialoogvenster
kunt u:

• kolommen selecteren/deselecteren die u wilt weergeven of verbergen: een verborgen kolom zal verdwĳnen uit
elke instantie van het dialoogvenster van de attributentabel totdat hĳ actief wordt hersteld.

• items slepen en neerzetten om de volgorde van de kolommen in de attributentabel te wĳzigen. Onthoud dat
deze wĳziging slechts is bestemd voor het renderen van de tabel en niet de veldvolgorde in de gegevensbron
van de laag wĳzigt

• een nieuwe virtuele kolom Acties toevoegen die in elke rĳ een keuzemenu of knoppenlĳst met ingeschakelde
acties weergeeft. Bekĳk Acties voor meer informatie over acties.

Kolommen sorteren

De tabel kan worden gesorteerd op elke kolom, door te klikken op de kolomkop. Een kleine pĳl geeft de
sorteervolgorde aan (naar beneden wĳzend betekent aflopende waarden vanaf de bovenste rĳ naar beneden, naar
boven wĳzend betekent oplopende waarden vanaf de bovenste rĳ naar beneden). U kunt er ook voor kiezen de rĳen
te sorterenmet de optie Sorteren… van het contextmenu van de kolomkop en een expressie schrĳven. Om bĳvoorbeeld
de rĳen te sorteren op meerdere kolommen kunt u schrĳven concat(col0, col1).

In formulierweergave kan de ID van de objecten worden gesorteerd met behulp van de optie Op expressie voor
weergave sorteren.

Tip: Sorteren gebaseerd op kolommen van verschillende typen
Een attributentabel proberen te sorteren op kolommen van tekenreeksen of numerieke typen zou kunnen leiden tot
onverwachte resultaten omdat de expressie concat("USE", "ID") waarden als tekenreeksen teruggeeft (d.i,
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'Borough105' < 'Borough6'). U kunt daar omheen werken door bĳv. concat("USE", lpad("ID",
3, 0)) te gebruiken, dat 'Borough105' > 'Borough006' teruggeeft.

Opmaken van tabelcellen met voorwaarden

Instellingen voor voorwaardelĳke opmaak kunnen worden gebruikt om objecten in de attributentabel, waarop u een
bĳzonder focus wilt zetten, te accentueren met behulp van aangepaste voorwaarden op de object:

• geometrie (bĳv. identificeren van meerdelige objecten, zeer kleine gebieden of in een gedefinieerd
kaartbereik…);

• of veldwaarde (bĳv. waarden vergelĳken met een drempel, lege cellen identificeren…).

U kunt het paneel Voorwaardelĳke opmaak inschakelen door te klikken op aan de rechterbovenkant van het
venster Attributen in de tabelweergave (niet beschikbaar in de formulierweergave).
Het nieuwe paneel stelt de gebruiker in staat om nieuwe regels toe te voegen voor de opmaak van het renderen van
het Veld of de Volledige rĳ. Toevoegen van een nieuwe regel opent een formulier om te definiëren:

• de naam van de regel;
• een voorwaarde met behulp van een van de functies van Expressie-string bouwer;
• de opmaak: die kan worden gekozen uit een lĳst met vooraf gedefinieerde opmaak of gemaakt worden,
gebaseerd op eigenschappen zoals:

– achtergrond- en tekstkleuren;
– gebruik van pictogram;
– vet, cursief onderstreept, of doorgehaald;
– lettertype.

16.2. Werken met de attributentabel 583



QGIS Desktop 3.28 User Guide

Fig. 16.69: Voorwaardelijke opmaak van een attributentabel

16.2.3 Werken met objecten in een attributentabel

Objecten selecteren

In tabelweergave geeft elke regel in de attributentabel de attributen van een uniek object in de laag weer. Selecteren van
een rĳ selecteert het object en soortgelĳk, selecteren van een object in het kaartvenster (in het geval van een laag met
ingeschakelde geometrie) selecteert de rĳ in de attributentabel. Als de set geselecteerde objecten in het kaartvenster
(of attributentabel) wordt gewĳzigd, dan wordt die selectie ook overeenkomstig bĳgewerkt in de attributentabel (of
het kaartvenster).
Rĳen kunnen worden geselecteerd door te klikken op het rĳnummer aan de linkerkant. Meerdere rĳen kunnen
worden geselecteerd met de Ctrl-toets ingedrukt gehouden. EenOpvolgende selectie kan worden gemaakt door de
Shift-toets in te drukken en een rĳnummer aan de linkerkant. Alle rĳen tussen de rĳ waarin zich de cursor bevindt
en de aangeklikte rĳ worden geselecteerd. Het veranderen van de cursorpositie, door in een andere cel van de tabel
te klikken, zal de selectie niet aanpassen. Het wĳzigen van de selectie in het kaartvenster, zal niet de cursorpositie in
de attributentabel wĳzigen.
In de formulierweergave van de attributentabel worden objecten standaard geïdentificeerd in het linkerpaneel aan de
hand van hun weergegeven veld (zie Tonen). Deze identificatie kan worden vervangenmet behulp van de keuzelĳst aan
de bovenzĳde van het paneel, ofwel door een bestaand veld te kiezen of door een aangepaste expressie te gebruiken.
U kunt er ook voor kiezen de lĳst met objecten te sorteren vanuit de keuzelĳst.
Klik op een waarde in het linkerpaneel om de attributen van het object in het rechter weer te geven. U dient binnen
het vierkant aan de linkerkant van de identificatie te klikken om een object te selecteren. Standaard zal het symbool
geel kleuren. Net zoals in de tabelweergave kunt u meervoudig selecteren van objecten uitvoeren met behulp van de
reeds eerder weergegeven combinaties voor het toetsenbord.
Naast het selecteren van objecten met de muis, kunt u automatische selecties uitvoeren, gebaseerd op de attributen van
het object met behulp van de beschikbare gereedschappen in de werkbalk van de attributentabel, zoals (zie gedeelte
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Automatisch selecteren en volgende voor meer informatie en gebruiksgevallen):

• Objecten selecteren m.b.v. een reguliere expressie

• Objecten selecteren d.m.v. waarde…

• Objecten deselecteren van huidige actieve laag

• Alle objecten selecteren

• Selectie van objecten omdraaien

Het is ook mogelĳk objecten te selecteren met behulp van Objecten filteren en selecteren met formulieren.

Objecten filteren

Als u eenmaal objecten hebt geselecteerd in de attributentabel, wilt u misschien alleen die records in de tabel
weergeven. Dat kan eenvoudig worden gedaan met behulp van het item Geselecteerde objecten weergeven uit de
keuzelĳst aan de linkeronderzĳde van het dialoogvenster Attributentabel. Deze lĳst biedt de volgende filters:

• Alle objecten tonen

• Geselecteerde objecten tonen - hetzelfde als het gebruiken van Attributentabel openen (Geselecteerde
objecten) vanuit het menu Kaartlagen of deWerkbalk Attributen of te drukken op Shift+F6

• Op kaart zichtbare objecten tonen - hetzelfde als het gebruiken van Attributentabel openen (Zichtbare
objecten) vanuit het menu Kaartlagen of deWerkbalk Attributen of te drukken op Ctrl+F6

• Bewerkte en nieuwe objecten tonen - hetzelfde als het gebruiken van Attributentabel openen (Bewerkte en
nieuwe objecten) vanuit het menu Kaartlagen of deWerkbalk Attributen

• Veldfilter - stelt de gebruiker in staat te filteren op basis van een waarde van een veld: kies een kolom
uit een lĳst, typ of selecteer een waarde en druk op Enter om te filteren. Daarna worden alleen de
objecten die overeenkomen met de expressie num_field = value of string_field ilike

'%value%'weergegeven in de attributentabel. U kunt Case sensitive selecteren ommindermogelĳkheden
in teksttekenreeksen toe te staan.

• Geavanceerd filter (Expressie) - Opent het dialoogvenster voor de Expressie-string bouwer. Daarin kunt u
complexe expressies maken waaraan rĳen van de tabel moeten voldoen. U kunt, bĳvoorbeeld, de tabel filteren
met behulp van meer dan één veld. Indien toegepast verschĳnt de expressie van het filter aan de onderzĳde van
het formulier.

• Opgeslagen filterexpressies ►: een sneltoets naar opgeslagen expressies frequent gebruikt voor het filteren van
uw attributentabel.

Het is ook mogelĳk objecten te filteren met formulieren.

Notitie: Filteren van records uit de attributentabel filtert niet de objecten uit de laag weg; zĳ worden eenvoudigweg
tĳdelĳk verborgen in de tabel en er kan toegang tot verkregen worden vanuit het kaartvenster of door het filter te
verwĳderen. Voor filters die wel objecten van de laag verbergen, gebruik de Querybouwer.

Tip: Gegevensbron bĳwerken door te filteren met Op kaart zichtbare objecten tonen

Indien om redenen van uitvoering objecten die worden weergegeven in de attributentabel ruimtelĳk zĳn beperkt tot het
kaartvenster bĳ het openen (zie Instellingen voor databronnen voor een how-to), zal selecteren van Op kaart zichtbare
objecten tonen op een nieuw kaartbereik de ruimtelĳke beperking bĳwerken.
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Filterexpressies opslaan

Expressies die u gebruikt voor het filteren van de attributentabel kunnen worden opgeslagen voor toekomstig
gebruik. Bĳ het gebruiken van de items Veldfilter of Geavanceerd filter (expressie) wordt de gebruikte expressie
weergegeven in een widget Tekst aan de onderzĳde van het dialoogvenster van de attributentabel. Druk op
Expressie opslaan met tekst als naam naast het vak om de expressie in het project op te slaan. Drukken op het keuzemenu naast
de knop maakt het mogelĳk de expressie op te slaan met een aangepaste naam (Expressie opslaan als…). Wanneer
een opgeslagen expressie wordt weergegeven, wordt de knop geactiveerd en het keuzemenu daarvan stelt u in
staat om Expressie bewerken en een naam te geven, of Opgeslagen expressie verwĳderen.
Opgeslagen filterexpressies worden opgeslagen in het project en zĳn beschikbaar via het menu Opgeslagen
filterexpressies van de attributentabel. Ze zĳn anders dan de gebruikersexpressies, die worden gedeeld door alle
projecten van het actieve gebruikersprofiel.

Objecten filteren en selecteren met formulieren

Klikken op Objecten met behulp van formulier filteren/selecteren of drukken op Ctrl+F in het dialoogvenster van de
attributentabel zal dat schakelen naar de formulierweergave en elk widget vervangen door zĳn variant om te zoeken.
Vanaf dit punt is de functionaliteit van dit gereedschap soortgelĳk aan die welke werd beschreven inObjecten selecteren
d.m.v. waarde, waar u beschrĳvingen kunt vinden van alle operatoren en modi voor selecteren.

Fig. 16.70: Attributentabel gefilterd door het filterformulier

Bĳ het selecteren / filteren van objecten in de attributentabel is er een knop Objecten filteren die het mogelĳk maakt
filters te definiëren en te verfĳnen. Gebruiken ervan activeert de optie Geavanceerd filter (Expressie) en geeft de
overeenkomende expressie voor het filteren weer in een bewerkbaar tekstwidget aan de onderzĳde van het formulier.
Indien er al gefilterde objecten zĳn, kunt u het filter verfĳnen met behulp van de keuzelĳst naast de knop Objecten
filteren. De opties zĳn:

• Filteren binnen (“AND”)

• Filter uitbreiden (“OR”)

Selecteer, om het filter op te heffen, ofwel de optie Alle objecten tonen uit de keuzelĳst aan de linkeronderzĳde, of
maak de expressie leeg en klik op Toepassen of druk op Enter.
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16.2.4 Acties op objecten gebruiken

Gebruikers hebben verscheidene mogelĳkheden om objecten te bewerken met het contextmenu, zoals:
• Alles selecteren (Ctrl+A) alle objecten selecteren;
• De inhoud van een cel naar het klembord te kopiëren met Celinhoud kopiëren;
• Naar object inzoomen zonder het eerst te hebben geselecteerd;
• Naar object verplaatsen zonder het eerst te hebben geselecteerd;
• Flitsmogelĳkheid, om het in het kaartvenster te accentueren;
• Formulier openen: Het schakelt de attributentabel naar formulierweergave met de focus op het aangeklikte
object.

Fig. 16.71: Knop Celinhoud kopiëren

Indien u gegevens van attributen wilt gebruiken in externe programma’s (zoals Excel, LibreOffice, QGIS of een eigen
webtoepassing), selecteer één of meer rĳ(en) en gebruik de knop Geselecteerde rĳen naar klembord kopiëren of druk op
Ctrl+C.
In het menu Extra ► Opties ► Databronnen kunt u uit de keuzelĳst de opmaak definiëren die moet worden geplakt
met Objecten kopiëren als:

• Platte tekst, geen geometrie,
• Platte tekst, WKT-geometrie,
• GeoJSON

U kunt ook een lĳst met acties weergeven in dit contextmenu. Dit wordt ingeschakeld op de tab Laageigenschappen
► Acties. Bekĳk Acties voor meer informatie over acties.
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Geselecteerde objecten als nieuwe laag opslaan

De geselecteerde objecten kunnen worden opgeslagen in alle door OGR ondersteunde vectorindelingen en ook worden
omgezet naar een ander Coördinaten ReferentieSysteem (CRS). In het contextmenu van de laag uit het paneel Lagen,
klik op Exporteren► Geselecteerde objecten opslaan als… om vervolgens een naam voor het uitvoer gegevensbestand
op te geven, de gewenste indeling en het CRS (zie het gedeelte Nieuwe lagen uit een bestaande laag maken). U zult
zien dat het keuzevak Alleen geselecteerde objecten opslaan is geselecteerd. Het is ook mogelĳk om opties voor
het maken van GDAL op te geven in het dialoogvenster.

16.2.5 Attribuutwaarden bewerken

Bewerken van waarden van attributen kan worden gedaan door:
• het direct typen van de nieuwe waarde in de cel, zowel in de tabel als in de formulierweergave. Wĳzigingen
worden daarom per cel uitgevoerd, object na object;

• met Veldberekening: bĳwerken van een rĳ van een veld dat al kan bestaan of dat kan worden gemaakt, maar
voor meerdere objecten. Het kan worden gebruikt om virtuele velden te maken;

• met de werkbalk Snelle veldberekening: hetzelfde als hierboven maar alleen voor bestaande velden;
• of met de modus Meervoudige bewerkingen: meerdere velden voor meerdere objecten bĳwerken in een rĳ.

Veldberekening gebruiken

De knop Veldberekening in de attributentabel geeft de mogelĳkheid om berekeningen uit te voeren van bestaande
waarden van attributen of gedefinieerde functies, bĳvoorbeeld om de lengte of oppervlakte van objecten geometrie
te berekenen. De resultaten kunnen worden gebruikt om een bestaand veld bĳ te werken of worden geschreven naar
een nieuw veld (dat een virtueel veld mag zĳn).
Veldberekening is beschikbaar op elke laag die bewerken ondersteunt. Wanneer u op het pictogram Veldberekening
klikt opent het dialoogvenster (zie Fig. 16.72). Als de laag niet in de modus Bewerken staat, wordt een waarschuwing
weergegeven en het gebruiken van Veldberekening zal er voor zorgen dat de laag in de modus Bewerken wordt gezet
vóórdat de berekening wordt uitgevoerd.
Gebaseerd op het dialoogvenster Expressie-string bouwer, biedt het dialoogvenster Veldberekening een volledige
interface om een expressie te definiëren en die toe te passen op een bestaand of nieuw gemaakt veld. U moet eerst,
om Veldberekening te kunnen gebruiken, selecteren:

1. berekening toepassen op de gehele laag of alleen op de geselecteerde objecten
2. een nieuw veld voor de berekening maken of een bestaand veld bĳwerken.
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Fig. 16.72: Veldberekening

Als u er voor kiest een nieuw veld toe te voegen, dient een veldnaam, een veldtype (geheel getal, decimaal getal,
datum of tekst) en, indien nodig, de totale veldlengte en de precisie te worden opgegeven. Als u bĳvoorbeeld voor
een veldlengte van 10 en een precisie van 3 kiest, betekent dit dat u ruimte heeft voor 7 tekens voor de punt, en 3
tekens voor het decimale gedeelte.
Een kort voorbeeld illustreert het gebruik van Veldberekening bĳ het gebruiken van de tab Expressie. We willen de
lengte van de laag railroads van de voorbeeld dataset van QGIS berekenen in km:

1. Laad het shapefile railroads.shp in QGIS en selecteer Attributentabel openen.

2. Klik op Bewerken aan/uitzetten en open het dialoogvenster Veldberekening.

3. Selecteer het keuzevak Nieuw veld aanmaken om berekeningen op te slaan in het nieuwe veld.
4. Stel Naam voor veld in op length_km
5. Selecteer Decimaal getal (real) als Type voor veld
6. Stel de Lengte van veld voor uitvoer in op 10 en de Precisie op 3
7. Dubbelklik op $length in de groep Geometrie om de lengte van de geometrie toe te voegen in het

expressievak van Veldberekening (u zult een begin zien van een voorbeeld van de uitvoer, tot maximaal 60
tekens, onder het vak voor de expressie die real-time wordt bĳgewerkt als de expressie wordt samengesteld).

8. Voltooi de expressie compleet door “/1000” in te typen in het vak voor de expressie van de berekening en druk
op OK.

9. U zult nu een nieuw veld length_km in de attributentabel terugvinden.

16.2. Werken met de attributentabel 589



QGIS Desktop 3.28 User Guide

Een virtueel veld maken

Een virtueel veld is een veld dat is gebaseerd op een direct berekende expressie, wat betekent dat zĳn waarde
automatisch wordt bĳgewerkt zodra een onderliggende parameter wĳzigt. De expressie wordt één keer ingesteld; u
hoeft het veld niet langer elke keer opnieuw te berekenen als de onderliggende waarde wĳzigt. U zou, bĳvoorbeeld, een
virtueel veld willen gebruiken als u gebieden wilt laten evalueren bĳ het digitaliseren van objecten of om automatisch
een duur te laten berekenen tussen datums die zouden kunnen wĳzigen (bĳv. bĳ het gebruiken van de functie now()).

Notitie: Virtuele velden gebruiken
• Virtuele velden staan niet permanent in de attributen van de laag, wat betekent dat zĳ alleen worden opgeslagen
en beschikbaar zĳn in het projectbestand waarin zĳ zĳn gemaakt.

• Een veld kan allen virtueel worden ingesteld bĳ het maken. Virtuele velden zĳn gemarkeerd met een paarse
achtergrond op de tab Velden van het dialoogvenster Laageigenschappen om ze te kunnen onderscheiden van
normale fysieke of samengestelde velden. Hun expressie kan later worden bewerkt door te drukken op de knop
Expressie in de kolom Opmerking. Een venster voor het bewerken van de expressie zal worden geopend om
de expressie van het virtuele veld aan te kunnen passen.

De werkbalk Snelle veldberekening gebruiken

Waar Veldberekening altĳd beschikbaar is, is de werkbalk Snelle veldberekening, boven in de attributentabel, alleen
zichtbaar als de laag in de modus Bewerken staat. Dankzĳ het programma voor de expressie, biedt het snelle toegang
voor het bewerken van een reeds bestaand veld:

1. Selecteer het bĳ te werken veld in de keuzelĳst.
2. Vul het tekstvak met een waarde, een expressie die u direct schrĳft of bouwt met de knop voor de expressie

3. Klik op de knop Alles bĳwerken, Geselecteerde bĳwerken of Gefilterde bĳwerken, overeenkomstig uw wensen.

Fig. 16.73: De werkbalk Snelle veldberekening
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Meerdere velden bewerken

Anders dan met de vorige gereedschappen, staat de modus Meervoudige bewerkingen toe dat meerdere attributen
van verschillende objecten tegelĳkertĳd worden bewerkt. Wanneer de laag is geschakeld naar de modus Bewerken,
zĳn mogelĳkheden voor Meervoudige bewerkingen toegankelĳk:

• met de knop Schakelen naar modus Meervoudige bewerkingen vanaf de werkbalk binnen het dialoogvenster
Attributentabel;

• of door het selecteren van het menu Bewerken ► Attributen van geselecteerde objecten aanpassen.

Notitie: Anders dan het gereedschap vanuit de attributentabel zal drukken op de optie Bewerken ► Attributen van
geselecteerde objecten aanpassen u een modaal dialoogvenster verschaffen om wĳzigingen aan de attributen in te
vullen. Daarom is het selecteren van objecten vereist vóór het uitvoeren.

Om meerdere velden in één rĳ te bewerken:
1. Selecteer de objecten die u wilt bewerken.

2. Klik, op de werkbalk van de Attributentabel, op de knop . Dit zal het dialoogvenster naar de
formulierweergave schakelen. Selecteren van objecten zou ook in deze stap gedaan kunnen worden.

3. Aan de rechterkant van de attributentabel worden velden (en waarden) van geselecteerde objecten weergegeven.
Nieuwe widgets verschĳnen naast elk veld, wat het mogelĳk maakt de huidige status voor Meervoudige
bewerkingen weer te geven:

• Het veld bevat verschillende waarden voor de geselecteerde objecten. Het wordt leeg weergegeven
en elk object behoudt zĳn originele waarde. U kunt de waarde van het veld herstellen uit de keuzelĳst van
de widget.

• Alle geselecteerde objecten hebben dezelfde waarde voor dit veld en de weergegeven waarde in het
formulier zal worden behouden.

• Het veld is bewerkt en de ingevoerde waarde zal worden toegepast op alle geselecteerde objecten.
Er verschĳnt een bericht aan de bovenzĳde van het dialoogvenster dat u zal vragen uw wĳziging toe te
passen of te herstellen.

Klikken op een van deze widgets stelt u in staat ofwel de huidige waarde voor het veld in te stellen of de originele
waarde te herstellen, wat betekent dat u wĳzigingen kunt terugdraaien op een veld-na-veld-basis.
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Fig. 16.74: Velden van meerdere objecten bewerken

4. Maak de wĳzigingen in de velden die u wilt.
5. Klik opWĳzigingen toepassen in het bericht bovenaan of enig ander object in het linkerpaneel.

Wĳzigingen zullen worden toegepast op alle geselecteerde objecten. Indien er geen object is geselecteerd wordt de
gehele tabel met uw wĳzigingen bĳgewerkt. Aanpassingen worden gemaakt als één enkele opdracht tot bewerken.
Het drukken op Ongedaan maken zal dus de wĳzigingen aan de attributen voor alle objecten in één keer terugdraaien.

Notitie: Modus Meervoudige bewerkingen is alleen beschikbaar voor automatisch gegenereerde en formulieren
van Slepen en neerzetten (zie Een formulier voor uw gegevens aanpassen); het wordt niet ondersteund in aangepaste
formulieren voor de UI.

16.2.6 Een tot veel- of veel-tot-veel-relaties maken

Relaties zĳn een techniek die veel gebruikt wordt in databases. Het concept is dat objecten (rĳen) van verschillende
lagen (tabellen) aan elkaar kunnen behoren.

1-N-relaties introduceren

Als voorbeeld heeft u een laag met alle regio’s van Alaska (polygoon) die verschillende attributen verschaft over de
naam ervan en het type regio en een unieke ID (die dient als primaire sleutel).
Dan krĳgt u een andere laag met punten of tabel met informatie over vliegvelden die in de regio’s liggen en u wilt
ook deze bĳhouden. Als u ze wilt toevoegen aan de laag van de regio’s, dient u een één tot veel-relatie te maken met
behulp van secundaire sleutels, omdat er meerdere vliegvelden in de meeste regio’s liggen.
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Fig. 16.75: Regio Alaska met vliegvelden

Lagen in 1-N-relaties

QGIS maakt geen verschil tussen een tabel en een vectorlaag. In feite is een vectorlaag een tabel met een geometrie.
Dus kunt u uw laag tabel als een vectorlaag toevoegen. U kunt, om de 1-N-relatie te demonstreren, het shapefile
regions laden en de csv-tabel airports dat een veld voor een secundaire sleutel (fk_region) voor de laag
regions heeft. Dit betekent dat elk vliegveld tot precies één regio behoort terwĳl elke regio een onbepaald aantal
vliegvelden kan hebben (een typische een tot veel-relatie).

Vreemde sleutels in 1-N-relaties

In aanvulling op de reeds bestaande attributen in de attributentabel van de vliegvelden heeft u nog een ander veld
fk_region nodig dat optreedt als een secundaire sleutel (als u een database heeft, wilt u er waarschĳnlĳk een
voorwaarde aan verbinden).
Dit veld fk_region zal altĳd een ID van een regio bevatten. Het kan worden gezien als een verwĳzing naar de regio
waartoe het behoort. En u kunt een aangepaste vorm voor bewerken ontwerpen enQGIS zorgt dan voor de instellingen.
Het werkt voor verschillende providers (dus u kunt het ook gebruiken met Shapefile- en csv-bestanden) en alles wat
u hoeft te doen is QGIS de relaties tussen uw tabellen te vertellen.

1-N-relaties definiëren

Het eerste dat gaan we doen is om QGIS in kennis te stellen van de relaties tussen de lagen. Dit wordt gedaan in
Project ► Eigenschappen…. Open de tab Relaties en klik op Relatie toevoegen.

• Naam zal worden gebruikt als de titel. Het zou een door mensen te lezen tekenreeks moeten zĳn, die beschrĳft
waar de relatie voor wordt gebruikt. We zullen het in dit geval eenvoudigweg vliegveld_relatie noemen.

• Referentielaag (Ouder), ook wel beschouwd als de ouderlaag, is die waarnaar de primaire sleutel verwĳst,
dus hier is het de laag regions. U moet de primaire sleutel voor de referentielaag definiëren, dus is het ID.

• Referentielaag (Kind), ook wel beschouwd als de kindlaag, is die met het veld voor de vreemde sleutel erop.
In ons geval is dit de laag airports. Voor deze laag dient u een verwĳzingsveld toe te voegen dat naar de
andere laag verwĳst, dus is dit fk_region.

Notitie: Soms heeft u meer dan één enkel veld nodig om objecten op een laag uniek te kunnen identificeren.
Maken van een relatie met een dergelĳke laag vereist een samengestelde sleutel, d.i. meer dan één enkel
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paar van overeenkomende velden. Gebruik de knop Nieuw veldpaar toevoegen als deel van een samengestelde sleutel om net
zoveel paren toe te voegen als nodig is.

• ID zal worden gebruikt voor interne doeleinden en moet uniek zĳn. U zou mogelĳk aangepaste formulieren
moeten maken. Als u het leeg laat zal er een voor u worden gegenereerd maar u kunt er zelf een toewĳzen om
er een te krĳgen die voor u eenvoudiger is.

• Sterkte relatie stelt de sterkte in van de relatie tussen de ouder- en kindlaag. Het standaard type Associatie
betekent dat de ouderlaag eenvoudig is gekoppeld aan de kindlaag, terwĳl het type Compositie u in staat stelt ook
de kindobjecten te dupliceren bĳ het dupliceren van die van de ouderlaag en bĳ het verwĳderen van een object
ook de kinderen worden verwĳderd, resulterend in trapsgewĳze over alle niveaus (wat betekent dat kinderen
van kinderen van… ook worden verwĳderd).

Fig. 16.76: Toevoegen van een relatie tussen de lagen regions en airports

Op de tab Relaties kunt u ook drukken op de knop Relaties ontdekken om de beschikbare relaties van de geladen
lagen op te halen. Dit is mogelĳk voor lagen die zĳn opgeslagen in gegevensproviders zoals PostgreSQL of SpatiaLite.
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Formulieren voor 1-N-relaties

Nu QGIS van de relatie weet zal het worden gebruikt om de formulieren te verbeteren die het genereert. Als we
de standaardmethode voor het formulier niet wĳzigden (automatisch gegenereerd) zal het eenvoudigweg een nieuw
widget in ons formulier maken. Dus laten we de laag regions selecteren in de legenda en het gereedschap Objecten
identificeren gebruiken. Afhankelĳk van uw instellingen zou het formulier direct kunnen openen of u moet het kiezen
om het openen in het dialoogvenster Identificatieresultaten onder Acties.

Fig. 16.77: Dialoogvenster Identificatieresultaten regions met relatie naar vliegvelden

Zoals u kunt zien worden de vliegvelden die tot deze bepaalde regio zĳn toegewezen weergegeven in een tabel. En er
zĳn ook enkele knoppen beschikbaar. Laten we die even kort bekĳken:

• De knop is voor het aan of uitzetten van het bewerken. Onthoud dat het de modus Bewerken voor de laag
airports schakelt, hoewel we in het objectformulier van een object uit de laag regions staan. Maar de tabel geeft
objecten weer uit de laag airports.

• De knop is voor het opslaan van alle bewerkingen in de kindlaag (airport).

• De knop laat u de geometrie van het vliegveld digitaliseren in het kaartvenster en wĳst het nieuwe
object standaard toe aan de huidige region. Merk op dat het pictogram zal wĳzigen, overeenkomstig het type
geometrie.

• De knop voegt een nieuw record in de attributentabel van de laag airports in en wĳst het nieuwe object
standaard toe aan de huidige region. De geometrie kan later worden getekend met het gereedschap voor
digitaliseren Deel toevoegen.

• De knop maakt het voor u mogelĳk om één of meer kindobjecten te kopiëren en te plakken in de kindlaag.
Ze kunnen later worden toegewezen aan een ander ouderobject of hun attributen kunnen worden aangepast.

• De knop verwĳdert het/de geselecteerde vliegveld(en) permanent.
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• Het symbool opent een nieuw dialoogvenster waar u een bestaand vliegveld kunt selecteren dat dan zal
worden toegewezen aan de huidige region. Dit zou handig kunnen zĳn als u het vliegveld per ongeluk in de
verkeerde region maakte.

• Het symbool ontkoppelt het/de geselecteerde vliegveld(en) van de huidige region, hen effectief laten staan
als niet toegewezen (de vreemde sleutel wordt ingesteld op NULL).

• Met de knop kunt u op de kaart inzoomen op de geselecteerde kindobjecten.

• De twee knoppen en aan de rechterkant schakelen tussen de tabel- en formulierweergave van de
gerelateerde kind-objecten.

Als u de Ontwerper Slepen en neerzetten gebruikt voor het object regions, kunt u selecteren welke gereedschappen
beschikbaar zĳn. U kunt zelfs beslissen of een nieuw formulier moet worden geopend wanneer een nieuw object wordt
toegevoegd met de optie Formulier verbergen bĳ toevoegen object. Onthoud dat deze optie impliceert dat attributen
niet Null een geldige waarde moeten hebben om correct te werken.

Fig. 16.78: Ontwerper Slepen en neerzetten voor het configureren van gereedschappen voor relaties regions-airports

In het bovenstaande voorbeeld heeft de verwĳzingslaag geometrieën (en is het niet slechts een alfanumerieke tabel),
dus zullen de bovenvermelde stappen een item maken in de attributentabel van de laag dat geen overeenkomend
geometrisch object heeft. De geometrie toevoegen:

1. Kies Attributentabel openen voor de referentielaag.
2. Selecteer het record dat eerder werd toegevoegd in het objectformulier van de verwĳzingslaag.

3. Gebruik het gereedschap voor digitaliseren Deel toevoegen om een geometrie te verbinden met het
geselecteerde record van de attributentabel.

Als u werkt met de tabel Airports is de widget Relatie-verwĳzing automatisch ingesteld voor het veld fk_region
(dat werd gebruikt om de relatie te maken), bekĳk widget Relatie-verwĳzing.

In het formulier Airports zult u de knop zien aan de rechterkant van het veld fk_region: als u op de knop klikt
zal het formulier van de laag Regions worden geopend. Dit widget stelt u in staat eenvoudig en snel de formulieren
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van de gekoppelde ouderobjecten te openen.

Fig. 16.79: Dialoogvenster Identificatieresultaten Airports met relatie naar Regions

De widget Relatie-verwĳzing heeft ook een optie om het formulier van de ouderlaag in te bedden in de kindlaag. Het is
beschikbaar in het menu Eigenschappen► Formulier attributen van de laag Airports: selecteer het veld fk_region
en selecteer de optie Ingebed formulier weergeven.
Als u nu kĳkt naar het dialoogvenster van het object, zult u zien dat het formulier van de regio nu is ingebed in het
formulier van de vliegvelden en zelfs een combinatievak zal hebben, wat u in staat stelt het huidige vliegveld aan een
andere regio toe te wĳzen.

Meer nog, als u schakelt met de modus Bewerken van de laag airports, heeft het veld fk_region ook een functie
automatisch aanvullen: tĳdens het typen zult u alle waarden zien van het veld id van de laag regions. Hier is het
mogelĳk een polygoon te digitaliseren voor de laag regions met de knop als u kiest voor de knop Toevoegen
nieuwe objecten toestaan in het menu Eigenschappen ► Formulier attributen van de laag airports.
De kindlaag kan ook worden gebruikt in het gereedschap Objecten selecteren d.m.v. waarde om objecten van de
ouderlaag te selecteren, gebaseerd op attributen van hun kinderen.
In Fig. 16.80 zĳn alle regio’s, waarvan de gemiddelde hoogte van de vliegvelden groter is dan 500 meter boven
zeeniveau, geselecteerd.
U zult merken dat veel verschillende functies voor samenvoegen in het formulier beschikbaar zĳn.
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Fig. 16.80: Ouderobjecten selecteren met waarden van hun kind

Introduceren van relaties veel-tot-veel (N-M)

N-M-relaties zĳn veel-tot-veel-relaties tussen twee tabellen. Bĳvoorbeeld voor de lagen airports en airlines:
een vliegveld ontvangt verscheidene luchtvaartmaatschappĳen en een luchtvaartmaatschappĳ vliegt naar verscheidene
vliegvelden.
Deze code voor SQL maakt de drie tabellen die we nodig hebben voor een relatie N-M in schema voor
PostgreSQL/PostGIS, genaamd locations. U kunt de code uitvoeren met Database ► DB Manager… voor PostGIS
of met externe programma’s als pgAdmin. De tabel airports slaat de laag airports op en de tabel airlines slaat de
laag airlines op. In beide tabellen worden voor helderheid enkele velden gebruikt. Het moeilĳke gedeelte is de
tabel airports_airlines. We dienen er voor te zorgen dat die alle airlines voor alle airports vermeld (of vice
versa). Dit soort tabel staat bekend als een draaitabel. De voorwaarden in deze tabel forceren dat een airport alleen
kan worden geassocieerd met een airline als beide al in hun lagen bestaan.

CREATE SCHEMA locations;

CREATE TABLE locations.airports
(

id serial NOT NULL,
geom geometry(Point, 4326) NOT NULL,
airport_name text NOT NULL,
CONSTRAINT airports_pkey PRIMARY KEY (id)

);

CREATE INDEX airports_geom_idx ON locations.airports USING gist (geom);

CREATE TABLE locations.airlines
(

id serial NOT NULL,
geom geometry(Point, 4326) NOT NULL,
airline_name text NOT NULL,
CONSTRAINT airlines_pkey PRIMARY KEY (id)

);

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)

CREATE INDEX airlines_geom_idx ON locations.airlines USING gist (geom);

CREATE TABLE locations.airports_airlines
(

id serial NOT NULL,
airport_fk integer NOT NULL,
airline_fk integer NOT NULL,
CONSTRAINT airports_airlines_pkey PRIMARY KEY (id),
CONSTRAINT airports_airlines_airport_fk_fkey FOREIGN KEY (airport_fk)

REFERENCES locations.airports (id)
ON DELETE CASCADE
ON UPDATE CASCADE
DEFERRABLE INITIALLY DEFERRED,

CONSTRAINT airports_airlines_airline_fk_fkey FOREIGN KEY (airline_fk)
REFERENCES locations.airlines (id)
ON DELETE CASCADE
ON UPDATE CASCADE
DEFERRABLE INITIALLY DEFERRED

);

In plaats van PostgreSQL kunt u ook GeoPackage gebruiken. In dit geval kunnen de drie tabellen handmatig worden
gemaakt met Database ► DB Manager…. In GeoPackage zĳn geen schema’s, dus het voorvoegsel locations is niet
nodig.
Voorwaarden voor secundaire sleutels in de tabelairports_airlines kunnen niet worden gemaakt metTabel►
Tabel maken… of Tabel► Tabel bewerken… dus zouden zĳ moeten worden gemaakt metDatabase► SQL-venster….
GeoPackage ondersteunt geen argumenten ADD CONSTRAINT, dus de tabel airports_airlines zou in twee
stappen moeten worden gemaakt:

1. Maak de tabel met alleen het veld ID met Tabel ► Tabel maken…

2. Met Database ► SQL-venster…, typ en voer deze code voor SQL uit:

ALTER TABLE airports_airlines
ADD COLUMN airport_fk INTEGER
REFERENCES airports (id)
ON DELETE CASCADE
ON UPDATE CASCADE
DEFERRABLE INITIALLY DEFERRED;

ALTER TABLE airports_airlines
ADD COLUMN airline_fk INTEGER
REFERENCES airlines (id)
ON DELETE CASCADE
ON UPDATE CASCADE
DEFERRABLE INITIALLY DEFERRED;

Dan, in QGIS, zou u twee een-tot-veel relaties moeten instellen zoals hierboven uitgelegd:
• een relatie tussen de tabel airlines en de draaitabel;
• en een tweede tussen de tabel airports en de draaitabel.

Een gemakkelĳker manier om dit te doen (alleen voor PostgreSQL) is met Relaties ontdekken in Project ►
Eigenschappen► Relaties. QGIS zal automatisch alle relaties in uw database lezen en u hoeft alleen de twee te kiezen
die u nodig hebt. Vergeet niet eerst de drie tabellen in het project van QGIS in te lezen.
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Fig. 16.81: Relaties en automatisch ontdekken

In het geval u een airport of een airline wilt verwĳderen, zal QGIS het/de geassocieerde record(s) in de
tabel airports_airlines niet verwĳderen. Deze taak zal door de database worden uitgevoerd als we de juiste
voorwaarden specificeren bĳ het maken van de draaitabel, zoals in het huidige voorbeeld.

Notitie: N-M-relatie combineren met automatische transactie groep
U zou de modus voor transacties in moeten schakelen in Eigenschappen ► Databronnen ► bĳ het werken met een
dergelĳke context. QGIS zou in staat moeten zĳn rĳ(en) in alle tabellen (airlines, airports en de draaitabel) toe te
voegen en bĳ te werken.

Tenslotte moeten we de juiste kardinaliteit selecteren in Laageigenschappen ► Attributen formulier voor de lagen
airports en airlines. Voor de eerste zouden we de optie airlines (id) kiezen en voor de tweede de optie
airports (id).

Fig. 16.82: Kardinaliteit relatie instellen

Nu kunt u een airport aan een airline koppelen (of een airline aan een airport) met Kindobject toevoegen of
Bestaand kindobject koppelen in de subformulieren. Een record zal automatisch worden ingevoegd in de tabel
airports_airlines.

600 Hoofdstuk 16. Werken met vectorgegevens



QGIS Desktop 3.28 User Guide

Fig. 16.83: N-M-relaties tussen airports en airlines

Notitie: Kardinaliteit Veel-tot één-relatie gebruiken
Soms is het verbergen van de draaitabel in een N-M-relatie niet gewenst. Voornamelĳk omdat er attributen in de
relatie kunnen staan die alleen waarden hebben als er een relatie is. Als uw tabellen lagen zĳn (een veld geometrie
hebben) zou het interessant kunnen zĳn om de optieOp kaart identificeren (Laageigenschappen► Formulier attributen
► Beschikbare widgets ► Velden) te activeren voor de velden met secundaire sleutels in de draaitabel.

Notitie: Primaire sleutel draaitabel
Vermĳd het gebruiken van meerdere velden voor de primaire sleutel in een draaitabel. QGIS gaat uit van één
enkele sleutel, dus een voorwaarde als constraint airports_airlines_pkey primary key
(airport_fk, airline_fk) zal niet werken.
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Polymorfische-relaties introduceren

Polymorfische relaties zĳn een speciaal geval van 1-N-relaties, waar één enkele verwĳzings- (document)laag de
objecten bevat voor meerdere lagen waarnaar verwezen wordt. Dit verschilt van normale relaties die een verschillende
verwĳzingslaag vereisen voor elke laag waarnaar verwezen wordt. Één enkele verwĳzings- (document)laag kan
worden verkregen door een aanvullende kolom layer_field toe te voegen in de verwĳzings- (document)laag
die informatie opslaat om de laag waarnaar verwezen wordt te identificeren. In zĳn meest eenvoudige vorm zal de
verwĳzings- (document)laag eenvoudigweg de laagnaam, van de laag waarnaar verwezen wordt, in dit veld invoegen.
Ommeer precies te zĳn, een polymorfische relatie is een set van normale relaties die dezelfde verwĳzingslaag hebben,
maar hebben de laag waarnaar verwezen wordt dynamisch gedefinieerd. De polymorfische instelling van de laag wordt
opgelost door een expressie te gebruiken die overeen moet komen met enkele eigenschappen van de laag waarnaar
verwezen wordt, zoals de naam van de tabel, laag-ID, laagnaam.
Stel u voor dat we naar het park gaan en foto’s willen nemen van verschillende soorten plants en animals die
we daar zien. Elke plant of dier heeft meerdere foto’s aan zich verbonden, dus als we de normale 1:N-relaties zouden
gebruiken om de foto’s op te slaan, zouden we twee afzonderlĳke tabellen nodig hebben, animal_images en
plant_images. Dit zou misschien geen probleem zĳn voor 2 tabellen, maar stel u voor dat we afzonderlĳke foto’s
willen maken van paddenstoelen, vogels etc.
Polymorfische relaties lossen dit probleem op omdat alle objecten waarnaar verwezen wordt zĳn opgeslagen in
dezelfde tabel documents. Voor elk object wordt de laag waarnaar verwezen wordt opgeslagen in het veld
referenced_layer en het verwezen object-ID in het veld referenced_fk.

Polymorfische-relaties definiëren

Eerst moeten we QGIS laten weten van de polymorfische relaties tussen de lagen. Dat wordt gedaan in Project ►
Eigenschappen…. Open de tab Relaties en klik op de kleine pĳl die naar beneden wĳst naast de knop Relatie
toevoegen, zodat u de optie Polymorfische relatie toevoegen kunt selecteren in het nieuw verschenen keuzemenu.
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Fig. 16.84: Toevoegen van een polymorfische relatie door een laag documents als verwijzing en animals en
plants als lagen waarnaar verwezen wordt.

• ID zal worden gebruikt voor interne doeleinden en moet uniek zĳn. U zou mogelĳk aangepaste formulieren
moeten maken. Als u het leeg laat zal er een voor u worden gegenereerd maar u kunt er zelf een toewĳzen om
er een te krĳgen die voor u eenvoudiger is.

• Referentielaag (Kind), ook wel beschouwd als de kindlaag, is die met het veld voor de vreemde sleutel erop.
In ons geval is dit de laag documents. Voor deze laag dient u een verwĳzingsveld toe te voegen dat naar de
andere laag verwĳst, dus is dit referenced_fk.

Notitie: Soms heeft u meer dan één enkel veld nodig om objecten op een laag uniek te kunnen identificeren.
Maken van een relatie met een dergelĳke laag vereist een samengestelde sleutel, d.i. meer dan één enkel
paar van overeenkomende velden. Gebruik de knop Nieuw veldpaar toevoegen als deel van een samengestelde sleutel om net
zoveel paren toe te voegen als nodig is.

• Veld laag is het veld in de verwĳzingstabel dat het resultaat van de expressie voor de geëvalueerde laag opslaat,
wat de verwĳzingstabel is waartoe dit object behoort. In ons voorbeeld zou dit het veld referenced_layer
zĳn.

• Expressie veld laag evalueert naar een unieke identificatie van de laag. Dit mag zĳn de laagnaam
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@layer_name, de laag-ID @layer_id, de naam van de tabel van de laag decode_uri(@layer,
'table') of elk ander ding dat een laag uniek kan identificeren.

• Sterkte relatie stelt de sterkte in van de gemaakte relaties tussen de ouder- en kindlaag. Het standaard type
Associatie betekent dat de ouderlaag eenvoudig is gekoppeld aan de kindlaag, terwĳl het type Compositie u in
staat stelt ook de kindobjecten te dupliceren bĳ het dupliceren van die van de ouderlaag en bĳ het verwĳderen
van een object ook de kinderen worden verwĳderd, resulterend in trapsgewĳze over alle niveaus (wat betekent
dat kinderen van kinderen van… ook worden verwĳderd).

• Verwezen lagen ook wel beschouwd als ouderlagen, zĳn die waar de primaire sleutel naartoe wĳst, dus hier
zouden dat de lagen plants en animals zĳn. U moet de primaire sleutel definiëren van de verwezen lagen
vanuit de keuzelĳst, dus is het fid. Onthoud dat de definitie van een geldige primaire sleutel vereist dat alle
verwezen lagen een veld hebben met die naam. Als er niet zo’n veld is, kunt u geen polymorfische relatie
opslaan.

Eenmaal toegevoegd kan de polymorfische relatie worden bewerkt via het menu-item Polymorfische relatie bewerken.

Fig. 16.85: Voorbeeld van de nieuw gemaakte polymorfische relatie en zijn kind-relaties voor animals en plants.

Het voorbeeld hierboven gebruikt het volgende databaseschema:

CREATE SCHEMA park;

CREATE TABLE park.animals
(

fid serial NOT NULL,
geom geometry(Point, 4326) NOT NULL,
animal_species text NOT NULL,
CONSTRAINT animals_pkey PRIMARY KEY (fid)

);

CREATE INDEX animals_geom_idx ON park.animals USING gist (geom);

CREATE TABLE park.plants
(

fid serial NOT NULL,
geom geometry(Point, 4326) NOT NULL,
plant_species text NOT NULL,
CONSTRAINT plants_pkey PRIMARY KEY (fid)

);

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)

CREATE INDEX plants_geom_idx ON park.plants USING gist (geom);

CREATE TABLE park.documents
(

fid serial NOT NULL,
referenced_layer text NOT NULL,
referenced_fk integer NOT NULL,
image_filename text NOT NULL,
CONSTRAINT documents_pkey PRIMARY KEY (fid)

);

16.2.7 Een externe bron opslaan en ophalen

Een veld kan als doel een bron hebben die is opgeslagen op een extern opslagsysteem. Formulier attributen kunnen
worden geconfigureerd zodat zĳ acteren als een cliënt voor een extern opslagsysteem om deze bronnen op te slaan en
op te halen, op aanvraag van de gebruiker, direct vanuit de formulieren.

Een externe opslag configureren

Voor het instellen van een externe opslag, moet u het eerst configureren vanuit de vector eigenschappen Formulier
attributen en de widget Bĳlage selecteren.

Fig. 16.86: Bewerken van een WebDAV externe opslag voor een bepaald veld

In de widget Bĳlage moet u eerst het Type opslag selecteren:
• Bestaand bestand selecteren: De doel-URL die al bestaat. Wanneer u een bron selecteert, wordt geen bewerking
voor opslaan uitgevoerd, het attribuut wordt eenvoudigweg bĳgewerkt met de URL.

• Eenvoudig kopiëren: Slaat een kopie van de bron op een bestemming op een bestandsschĳf op (wat een lokaal
of een gedeeld netwerk-systeem zou kunnen zĳn) en het attribuut wordt bĳgewerkt met het te kopiëren pad.

• WebDAV-opslag: De bron wordt gepusht naar een HTTP-server die het protocol WebDAV ondersteunt en het
attribuut wordt bĳgewerkt met de URL daarvan. Nextcloud, Pydio of andere software voor het hosten van
bestanden ondersteunen dit protocol.
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Dan moet u de parameter URL opslaan instellen, die de te gebruiken URL verschaft als een nieuwe bron moet
worden opgeslagen. Het is mogelĳk om een expressie in te stellen met dewidget Data-bepaalde override om specifieke
waarden te krĳgen, overeenkomstig attributen van de objecten.
De variabele @selected_file_path zou in die expressie kunnen worden gebruikt en het absolute bestandspad
weergeven van het door de gebruiker geselecteerde bestand (met bestandsselectie of slepen-en-neerzetten).

Notitie: Bĳ het gebruiken van deWebDAV externe opslag, als de URL eindigt op een “/”, wordt het beschouwd als
een map en zal de geselecteerde bestandsnaam worden toegevoegd om de uiteindelĳke URL te verkrĳgen.

Als het externe opslagsysteem dat nodig heeft, is het mogelĳk een authenticatie te configureren.

Een externe opslag gebruiken

Eenmaal geconfigureerd kunt u een lokaal bestand selecteren met de knop … bĳ het bewerken van een attribuut
van een object. Afhankelĳk van het geconfigureerde type opslag, zal het bestand worden opgeslagen op het externe
opslagsysteem (behalve wanneer Bestaand bestand selecteren werd geselecteerd) en het veld zal worden bĳgewerkt
met de nieuwe URL van de bron.

Fig. 16.87: Een bestand opslaan op een WebDAV externe opslag

Notitie: De gebruiker kan hetzelfde resultaat ook bereiken als hĳ een bestand sleept en neerzet in de widget Bĳlage.

Gebruik de knop Annuleren om het proces van opslaan af te breken. Het is mogelĳk om een viewer te
configureren met een Geïntegreerde documentviewer zodat de bron automatisch zal worden opgehaald vanaf het
externe opslagsysteem en wordt weergegeven direct onder de URL. Het bovenstaande pictogram geeft aan dat de
bron niet kan worden opgehaald van het externe opslagsysteem. In dat geval zouden meer details kunnen verschĳnen
in het Paneel Logboekmeldingen.
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16.3 Bewerken

QGIS heeft diverse mogelĳkheden voor het bewerken van vectorlagen en tabellen van OGR, SpatiaLite, PostGIS,
MS SQL Server en Oracle Spatial en tabellen. Zĳ mogen van het type 2D of 3D zĳn.

Notitie: De procedure voor het bewerken van GRASS vectorlagen is anders - zie Digitaliseren en bewerken van een
GRASS vectorlaag voor details.

Let op: Tegelĳk bewerken
QGIS houdt niet bĳ of iemand anders hetzelfde object bewerkt, terwĳl u dat ook doet. De laatste persoon, die de
bewerkingen opslaat, wint.

Tip: Bewerkingen valideren
Doorlopend valideren kan worden geactiveerd op een basis per laag op de tab Laag-eigenschappen ► Digitaliseren.
Meer op Digitaliseren.

16.3.1 Tolerantie voor snappen en zoekradius instellen

Onder het menu Extra ► Opties… ► Digitaliseren verschaft QGIS een aantal parameters om het standaard gedrag
voor gereedschappen om te bewerken te configureren. Meere informatie op Instellingen voor digitaliseren.
Voor optimaal en nauwkeurig bewerken van geometrieën van vectorlagen moeten we een toepasselĳke waarde
instellen voor de tolerantie voor snappen en de zoekradius voor punten van objecten. De groep Snapping verschaft
gerelateerde opties, namelĳk de afhandeling van de tolerantie voor snappen en de zoekradius.

• Tolerantie voor snappen: Wanneer u een nieuw punt toevoegt of een bestaand verplaatst is de tolerantie voor
snappen de afstand die QGIS gebruikt om te zoeken naar het dichtstbĳzĳnde punt of segment waaraan u
probeert te verbinden. Indien niet binnen de tolerantie voor snappen zal QGIS het punt daar laten waar u
de muisknop loslaat, in plaats van het te snappen aan een bestaand punt of segment.
De instellingen voor de tolerantie beïnvloeden alle gereedschappen die werken met snappen en worden
standaard toegepast op nieuwe lagen en projecten. Het kan echter worden overschreven op laag-niveau (bekĳk
Opties voor snappen en digitaliseren).

• Zoekradius: Zoekradius voor hoekpuntaanpassingen is de afstand die QGIS gebruikt om te zoeken naar het
te selecteren punt als u op de kaart klikt. Als u niet binnen de zoekradius bent, zal QGIS geen punt vinden en
selecteren om te bewerken.

Afstand voor snappen en zoekradius worden ingesteld in kaarteenheden of pixels. U zou misschien iets
moeten experimenteren om ze juist ingesteld te krĳgen. Als u een tolerantie instelt die te groot is, zou QGIS het aan
een verkeerd punt kunnen snappen, speciaal als u al met een groot aantal punten op korte afstand van elkaar werkt.
Hoe kleiner de zoekradius, hoe moeilĳker het zal worden om te raken wat u wilt verplaatsen.
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16.3.2 Opties voor snappen en digitaliseren

Globale instellingen voor snappen en digitaliseren (modus Snappen, waarde voor tolerantie, en eenheden…) kunnen
worden overschreven in het project vanuit het menu Project ► Opties voor snappen… menu. In de Opties voor
snappen en digitaliseren kunt u ook enkele andere eigenschappen configureren (snappen in lagen, begrenzing schaal,
topologie…) DeWerkbalk Snappen geeft toegang tot de meeste van deze mogelĳkheden.

Standaard is snappen in een project uitgeschakeld totdat u drukt op de knop Snappen inschakelen of drukt op S. De
modus Snappen, waarde voor tolerantie, en eenheden kunnen ook met deze werkbalk worden geconfigureerd.

Eigenschappen voor snappen

Er zĳn drie opties om de la(a)g(en) te selecteren om aan te snappen:
• Alle lagen: snel instellen voor alle zichtbare lagen in het project, zodat de aanwĳzer snapt aan alle punten en/of
segmenten. In de meeste gevallen is het voldoende om deze modus voor snappen te gebruiken, maar wees
voorzichtig bĳ het te gebruiken voor projecten met veel vectorlagen, omdat het de uitvoering kan beïnvloeden.

• Actieve laag: alleen de actieve laag wordt gebruikt, een handige manier om te zorgen voor topologische
consistentie binnen de laag die bewerkt word.

• Gevorderde configuratie: stelt u in staat modus Snappen, tolerantie en eenheden, overlappingen en schalen voor
snappen in te schakelen en aan te passen op een per-laag basis (bekĳk Fig. 16.88). Als u een laagmoet bewerken
en zĳn punten aan een ander snapt, zorg er dan voor dat de doellaag is geselecteerd en vergroot de tolerantie
voor snappen naar een hogere waarde. Snappen zal niet gebeuren in een laag die niet is geselecteerd in het
dialoogvenster van de Opties voor snappen.

Voor de modus Snappen kunt u kiezen tussen Hoekpunt, Segment, Gebied, Centroïde, Midden van
segmenten en Lijn-eindpunten.
QGIS zal verschillende pictogrammen voor snappen weergeven, afhankelĳk van het soort snappen:

Tabel 16.2: Pictogrammen voor snappen

Snappen aan een punt: pictogram
vak

Snappen aan een segment:
pictogram zandloper

Snappen aan een kruising:
pictogram kruis

Onthoud dat het mogelĳk is om de kleur van deze pictogrammen te wĳzigen in het gedeelte Digitaliseren van de
globale instellingen.
De waarden voor tolerantie kunnen ofwel worden ingesteld in de kaarteenheden van het project of in pixels.
Het voordeel van het kiezen vanpixels is dat het het snappen constant houdt op verschillende kaartschalen. 10 tot en
met 12 pixels is normaal gesproken een goede waarde, maar het is afhankelĳk van de DPI van uw scherm. Gebruiken
van kaarteenheden maakt het mogelĳk de tolerantie te relateren aan echte afstanden op de grond. Bĳvoorbeeld als
u een minimum afstand hebt tussen elementen, kan deze optie nuttig zĳn om er voor te zorgen dat u geen punten
toevoegt die te dicht op elkaar staan.
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Fig. 16.88: Opties voor snappen (modus Gevorderde configuratie)

Notitie: Standaard kunnen alleen zichtbare objecten (de objecten waarvan de stĳl wordt weergegeven, met
uitzondering van lagen waarvoor de symbologie is “Geen symbolen”), worden gesnapt. U kunt het snappen voor
onzichtbare objecten inschakelen door te selecteren Snappen aan niet-zichtbare objecten inschakelen op de tab
Extra ► Opties ► Digitaliseren.

Tip: Snappen standaard inschakelen
U kunt instellen dat snappen standaard is ingeschakeld voor alle nieuwe projecten op de tab Extra ► Opties ►
Digitaliseren. U kunt ook de standaardmodus voor snappen instellen, de waarde voor tolerantie en de eenheden,
die aanwezig zĳn in het dialoogvenster Opties voor snappen.

Snappen op snijpunten aanzetten

Een andere beschikbare optie is om Snappen op snĳpunten te gebruiken, wat de mogelĳkheid geeft te ‘snappen’
aan snĳpunten van geometrieën op voor snappen ingeschakelde lagen, zelfs wanneer er geen punt aanwezig is op de
snĳpunten.

Snappen beperken tot een schaalbereik

In sommige gevallen kan snappen heel traag worden. Dit wordt vaak veroorzaakt door de hoeveelheid objecten in
sommige lagen die een zware index vereisen om te berekenen en te onderhouden. Er zĳn enkele parameters die
snappen alleen inschakelen als de kaartweergave binnen een relevant schaalbereik is. Dit maakt het mogelĳk alleen
de kostbare berekening van de index uit te voeren, gerelateerd aan snappen op een schaal waar tekenen relevant is.
Beperken van de schaal voor snappen wordt geconfigureerd in Project►Opties voor snappen…. Beperken van snappen
is alleen beschikbaar in modus Gevorderde configuratie.
Voor snappen beperken tot een schaalbereik hebt u drie modi beschikbaar:

• Uitgeschakeld: Snappen is ingeschakeld, ongeacht de huidige schaal van de kaart. Dit is de standaardmodus.
• Globaal: Snappen is beperkt en alleen ingeschakeld als de huidige schaal van de kaart tussen een globale
minimum- en een globale maximumwaarde is. Bĳ het selecteren van deze modus komen twee widgets
beschikbaar om het bereik van schalen te configureren waarvoor snappen ingeschakeld wordt.

• Per laag: De beperking voor het schaalbereik voor snappen wordt voor elke laag gedefinieerd. Bĳ het selecteren
van deze modus komen twee kolommen beschikbaar om de minimum en maximum schalen voor elke laag te
configureren.

Onthoud dat de minimum en maximum schalen de conventie van QGIS volgen: minimumschaal is de meest
“uitgezoomde” schaal, terwĳl maximumschaal de meest “ingezoomde” is. Een minimum of maximum schaal die
is ingesteld op “0” of “niet ingesteld” wordt gezien als zonder beperking.
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Zelf-snappen

De optie Zelf-snappen stelt u in staat te snappen aan de geometrie die wordt bewerkt. Gecombineerd met het paneel
Geavanceerd digitaliseren, verschaft dit een handige manier om nieuwe randen te digitaliseren, relatief ten opzichte
van eerder randen of punten. Zelf-snappen kan ongeldige geometrieën veroorzaken, gebruik het voorzichtig.

Snappen aan aangepast raster

Een afstand voor snappen kan ook worden aangepast op een per-laag basis op de tab Digitaliseren van het
dialoogvenster Laageigenschappen. Door de afstand Geometrie precisie in te stellen schakelt u een gestippeld raster
in dat zichtbaar is in het kaartvenster op een coherente schaal voor weergave. Snappen kan dan worden uitgevoerd
op de stippen van het raster: een toegevoegde of aangepaste geometrie zal al zĳn punten automatisch hebben gesnapt
aan de dichtstbĳzĳnde knoop van het raster. Meer informatie op Digitaliseren.

16.3.3 Topologische bewerkingen

In aanvulling op deze opties voor snappen, stellen het dialoogvenster Opties voor snappen… (Project ► Opties voor
snappen) en de werkbalk Snappen u in staat enkele andere topologische functionaliteiten in / uit te schakelen.

Topologisch bewerken aanzetten

De knop Topologisch bewerken helpt bĳ het werken en onderhouden van objecten met gedeelde grenzen. Met deze
optie ingeschakeld, zal QGIS gedeelde grenzen ‘detecteren’. Wanneer u gedeelde punten/segmenten verplaatst, zal
QGIS ze ook verplaatsen in de geometrieën van de naburige objecten.
Topologisch bewerken werkt met objecten uit verschillende lagen, zo lang als de lagen zichtbaar zĳn en in modus
Bewerken staan.
Op een laag met waarden Z of M zal topologisch bewerken de waarde Z of M van het punt interpoleren, gebaseerd
op de waarde van de rand die wordt gebruikt voor de verbinding.

Overlappingen beheren

Overlappingen voorkomen dat u nieuwe objecten kunt tekenen die bestaande overlappen in de geselecteerde laag, wat
digitaliseren van aanliggende polygonen versnelt. Het kan worden beheerd door het gereedschap Overlappen. Drie
modi zĳn beschikbaar:

1. Overlappen toestaan (standaard)

2. Overlappen vermĳden op actieve laag: voorkomt overlappen door andere objecten op de bewerkte laag.
Digitaliseer de nieuwe geometrieën zodat zĳ hun buren overlappen en QGIS zal de overlappende delen van de
nieuwe geometrieën afsnĳden en ze snappen aan de grens van de bestaande objecten. Het voordeel is dat u niet
de gemeenschappelĳke punten op de grens hoeft te digitaliseren.

3. Gevorderde configuratie volgen: maakt het mogelĳk de instelling voor overlappen op een per-laag basis
kan worden ingesteld in de weergavemodus Gevorderde configuratie.

Notitie: Als de nieuwe geometrie totaal wordt bedekt door bestaande, wordt het opgeschoond en zal QGIS een
foutmelding weergeven.
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Waarschuwing: Gebruik de optie Overlapping voorkomen met zorg
Omdat deze optie nieuwe overlappende geometrieën van elke polygoonlaag zal afsnĳden, kunt u onverwachte
geometrieën krĳgen, als u vergeet ze niet te selecteren als u ze niet langer nodig hebt.

Automatisch traceren

Gewoonlĳk dient u, bĳ het gebruiken van gereedschappen voor het vastzetten van objecten (object toevoegen, deel
toevoegen, ring toevoegen, vervormen en splitsen), op elk punt van het object te klikken. Met de modus Automatisch
traceren kunt u het proces van digitaliseren versnellen omdat u niet langer handmatig alle punten hoeft te plaatsen bĳ
het digitaliseren:

1. Schakel het gereedschap Traceren (op de werkbalk Snappen) in, door te drukken op het pictogram of op de
toets T.

2. Snap aan een punt of segment van een object waarlangs u wilt traceren.
3. Verplaats de muis over een ander punt of segment waaraan u zou willen snappen en, in plaats van de normale

rechte lĳn, het elastiek van het digitaliseren geeft een pad weer van het laatste punt waaraan u snapte tot de
huidige positie. Het gereedschap werkt ook met gebogen geometrieën.
QGIS gebruikt in feite de topologie van de onderliggende objecten om het kortste pad te bouwen naar de
twee punten. Traceren vereist dat snappen is geactiveerd in lagen waarop getraceerd kan worden om het pad
te bouwen. U zou ook kunnen snappen aan een bestaand punt of segment tĳdens het digitaliseren en er voor
zorgen dat de twee knopen topologisch aan elkaar te verbinden zĳn door bestaande objecten te volgen, anders
is QGIS niet in staat om ze te verbinden en traceert dus een enkele rechte lĳn.

4. Klik en QGIS plaatst de tussenliggende punten, die het weergegeven pad volgen.

Vouw het pictogram Traceren inschakelen uit en stel de optie Verschuiving in om een pad te digitaliseren, parallel aan
de objecten, in plaats van hen te traceren. Een positieve waarde verschuift de nieuw getekende naar de linkerkant van
de richting van traceren en een negatieve waarde doet het tegenovergestelde.

Notitie: Kaartschaal of instellingen voor snappen aanpassen voor optimaal traceren
Als er teveel objecten in de kaartweergave staan, wordt traceren uitgeschakeld om het voorbereiden van potentieel
lange structuren voor traceren en enorme belasting van het geheugen te vermĳden. Na inzoomen of uitschakelen van
enkele lagen wordt traceren weer ingeschakeld.

Notitie: Voegt geen topologische punten toe
Dit gereedschap voegt geen punten toe aan bestaande geometrieën polygoon, zelfs niet als Topologisch bewerken is
ingeschakeld. Als precisie voor de geometrie is geactiveerd op de bewerkte laag, zou de resulterende geometrie niet
exact een bestaande geometrie hoeven te volgen.

Tip: Automatisch traceren snel in- of uitschakelen door te drukken op de toets T
Door te drukken op de toets T kan traceren altĳd worden ingeschakeld / uitgeschakeld (zelfs tĳdens het digitaliseren
van een object), zo is het mogelĳk delen van het object te digitaliseren met traceren ingeschakeld en andere delen met
traceren uitgeschakeld. Gereedschappen gedragen zich als gewoonlĳk als traceren is uitgeschakeld.

Tip: Traceren converteren naar gebogen geometrieën
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Door Extra ► Opties ► Digitaliseren ► Traceren te gebruiken kunt u gebogen geometrieën maken tĳdens het
digitaliseren. Zie opties voor digitaliseren options.

16.3.4 Het digitaliseren van een bestaande kaartlaag

Standaard laadt QGIS lagen als alleen-lezen. Dit is een veiligheidsmaatregel die voorkomt dat u een laag gaat wĳzigen
als u per ongeluk uitschiet met de muis. U kunt er echter voor kiezen elke laag te wĳzigen, zolang de provider
van de gegevens dat ondersteunt (zie Gegevensindelingen en velden verkennen), en wanneer u, op bestandsniveau,
schrĳfrechten hebt voor die bestanden (d.i. als de bestanden niet alleen-lezen zĳn).

Tip: Rechten voor bewerken beperken op lagen in een project
Vanuit de tabel Project ► Eigenschappen… ► Databronnen ► Service-mogelĳkheden laag kunt u er voor kiezen elke
laag alleen-lezen te maken, ongeacht eventuele toestemming van de provider. Dit kan, in een omgeving met meerdere
gebruikers, een handige manier zĳn om te voorkomen dat niet geautoriseerde gebruikers per ongeluk lagen bewerken
(bĳv. Shapefile), daarbĳ potentieel gegevens kunnen beschadigen. Onthoud dat deze instelling alleen van toepassing
is binnen het huidige project.

In het algemeen zĳn gereedschappen voor het bewerken van vectorlagen verdeeld over een werkbalk Digitaliseren en
eenwerkbalkGeavanceerd digitaliseren, beschreven in het gedeelteGeavanceerd digitaliseren. U kunt beide selecteren
en deselecteren onder Beeld ►Werkbalken ►.
Met het gebruiken van de basisgereedschappen voor digitaliseren kunt u de volgende functies uitvoeren:

Tabel 16.3: Basis werkbalk voor Bewerken van vectorlaag
GereedschapDoel GereedschapDoel

Toegang tot opslaan, terugdraaien of
annuleren van wĳzigingen tegelĳkertĳd in
alle of geselecteerde lagen

Status voor bewerken van geselecteerde
la(a)g(en) in of uit schakelen, gebaseerd op
de status van de actieve laag

Bewerkingen opslaan naar de actieve laag

Digitaliseren met rechte segmenten Digitaliseren met gebogen lĳnen

Vrĳe hand digitaliseren inschakelen Polygoon met normale vorm digitaliseren

Nieuw record toevoegen Object punt toevoegen

Object lĳn toevoegen Object polygoon toevoegen

Gereedschap Punten (Alle lagen) Gereedschap Punten (Huidige laag)

Puntenbewerker
weregeven

Stel in of het paneel Puntenbewerker
automatisch zou moeten openen

De attributen van alle geselecteerde objecten
tegelĳkertĳd aanpassen

Geselecteerde objecten op de actieve laag
verwĳderen

Objecten van de actieve laag knippen

Geselecteerde objecten op de actieve laag
kopiëren

Objecten op de actieve laag plakken

Wĳzigingen op de actieve laag ongedaan
maken

Wĳzigingen op de actieve laag opnieuw
uitvoeren

Onthoud dat bĳ het gebruiken van een van de gereedschappen voor Digitaliseren, u nog steeds kunt zoomen of
verschuiven in het kaartvenster zonder de focus van het gereedschap te verliezen.
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Alle sessies voor bewerken beginnen door de optie Bewerken aan-/uitzetten te kiezen, te vinden in het contextmenu van
een bepaalde laag, vanuit het dialoogvenster van de attributentabel, de werkbalk Digitaliseren of het menu Laag.
Als de laag eenmaal in de modus Bewerken staat, zullen aanvullende gereedschappen op de werkbalk Bewerken
beschikbaar komen en markeringen zullen verschĳnen op de punten van alle objecten, tenzĳ de optie Markeringen
alleen gebruiken voor geselecteerde objecten onder het menu Extra ► Opties… ► Digitaliseren is geselecteerd.

Tip: Regelmatig opslaan

Vergeet niet om de knop Wĳzigingen laag opslaan regelmatig te gebruiken. Deze zal ook controleren of u uw gegevens
nog naar de gegevensbron kunt schrĳven.

Technieken voor bewerken geometrie

Wanneer een tekengreeedschap voor een geometrie (voornamelĳk die welke toevoegen, splitsen, objecten opnieuw
vormen) is ingeschakeld voor een op lĳn of polygoon gebaseerde laag, kunt u de techniek selecteren voor het toevoegen
van nieuwe punten:

• Het gereedschap Digitaliseren met segment: tekent recht segment waarvan de begin- en eindpunten worden
gedefinieerd door klikken met links.

• Het gereedschap Digitaliseren met boog: tekent een gebogen lĳn, gebaseerd op drie opeenvolgende punten,
gedefinieerd door klikken met links (begin, punt langs de boog, einde). Als het type geometrie geen bogen
ondersteund, dan zullen opeenvolgende kleinere segmenten worden gebruikt om het uiterlĳk van de boog te
benaderen.

• Het gereedschap Stroom digitaliseren: tekent lĳnen in modus Vrĳe hand, d.i. knopen worden toegevoegd die
de verplaatsing van de cursor in het kaartvenster volgen en een Tolerantie stromen. De tolerantie voor stromen
definieert de afstand tussen opeenvolgende punten. Momenteel is de enige ondersteunde eenheid pixels (px).
In deze modus zĳn alleen de klik voor het begin en de klik met rechts voor het einde noodzakelĳk.

• Het gereedschap Vorm digitaliseren: activeert gereedschappen op de werkbalk Regelmatige vorm digitaliseren
om een polygoon met een regelmatige vorm te tekenen.

De geselecteerde techniek wordt behouden bĳ het schakelen tussen de gereedschappen voor digitaliseren. U kunt elk
van de eerste drie methoden combineren bĳ het tekenen van dezelfde geometrie.

Objecten toevoegen

Afhankelĳk van het type laag kunt u de pictogrammen Record toevoegen, Object punt toevoegen, Object lĳn toevoegen

of Object polygoon toevoegen op de werkbalk gebruiken om nieuwe objecten aan de huidige laag toe te voegen.

Klik, om een object zonder geometrie toe te voegen, op de knop Object toevoegen en u kunt attributen invoeren in
het objectformulier dat opent.
U moet eerst de geometrie digitaliseren en dan de attributen ervan invoeren om objecten te maken met de
ingeschakelde ruimtelĳke gereedschappen. Digitaliseren van de geometrie:

1. (Optioneel omdat het de standaard is) Selecteer de methode voor tekenen Digitaliseren met segment van een
geometrie

2. Klik met links op het kaartgebied om het eerste punt van uw nieuwe object te maken. Voor objecten punt zou
dit genoeg moeten zĳn en, indien gewenst, het objectformulier moeten activeren om de attributen in te vullen.
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3. Voor geometrieën lĳn of polygoon, blĳfmet links klikken voor elk aanvullend punt dat u wilt vastleggen. U kunt
vertrouwen op de opties snappen aan objecten, de snappen-aan-raster of het paneel Geavanceerd digitaliseren
voor het nauwkeurig plaatsen van elk punt.
Naast het tekenen van rechte segmenten tussen knopen die u een voor een klikt, kunnen lĳnen en polygonen
worden:

• automatisch getraceerd, het digitaliseren versnellend. Dit zal opeenvolgende rechte lĳnen maken tussen
de punten die u plaatst, bestaande objecten volgend.

• vrĳe-hand gedigitaliseerd, druk op R of activeer Stroom digitaliseren.

• getekend als boog, druk op Ctrl+Shift+G of activeer Digitaliseren met boog.

Notitie: Tĳdens het digitaliseren van geometrieën lĳn of polygoon kunt u heen en weer schakelen tussen de
methoden voor het tekenen van geometrieën, wat het voor u mogelĳk maakt objecten te tekenen met gemixte
rechte, vrĳ-hand en gebogen delen.

4. Druk op de toets Delete of Backspace om de laatste kno(o)p(en) te verwĳderen die u misschien foutief
toevoegde.

5. Wanneer u voldoende punten hebt toegevoegd, klik dan met rechts ergens in het kaartvenster om te bevestigen
dat u gereed bent met het invoeren van de geometrie van dat object.

Tip: Het elastiek voor digitaliseren aanpassen
Bĳ het vastleggen van polygonen kan het, standaard rode, elastiek onderliggende objecten verbergen op plaatsen
waar u een punt zou willen vastleggen. Dit kan worden opgelost door een instelling van een lagere lichtdichtheid
(of alfa-kanaal) voor de Kleur vulling van het elastiek in het menu Extra ► Opties ► Digitaliseren. U kunt ook
het gebruiken van het elastiek vermĳden door te selecteren Elastiek niet bĳwerken gedurende bewerken van
knoop.

6. Voor objecten lĳn zal het drukken op Shift + klik met rechts de lĳn automatisch sluiten.
7. Het venster Attributen zal verschĳnen, wat het u mogelĳk maakt de informatie voor het nieuwe object in te

voeren. Fig. 16.89 geeft het instellen van attributen weer voor een denkbeeldige nieuwe rivier. Echter, in het
menu Digitaliseren onder het menu Extra ► Opties, kunt u ook:

• Voorkom tonen van attributenformulier na intekenen object om het openen van het formulier te
vermĳden;

• of Laatst ingevoerde attribuutwaarden gebruiken om velden automatisch te laten vullen bĳ het openen
van het formulier en alleen gewĳzigde waarden in te hoeven vullen.

Fig. 16.89: Dialoogvenster Attribuutwaarden invoeren na digitaliseren van een nieuw vectorobject
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Gereedschap Punten

QGIS verschaft twee gereedschappen voor interactie met punten van vectorobjecten:

• Gereedschap Punten (Huidige laag): alleen overlegde objecten op de actieve laag (in het paneel Lagen) worden
beïnvloed

• Gereedscxhap Punten (Alle lagen): elk overgelegd object op alle bewerkbare lagen wordt beïnvloed. Dit stelt u in
staat objecten te bewerken zonder de actieve laag te schakelen of meerdere lagen in één keer te bewerken (bĳv.
landen en hun grenzen van regio’s)

Voor elke bewerkbare vectorlaag verschaffen de Gereedschappen Punten mogelĳkheden voor het manipuleren van
punten van het object, soortgelĳk aan CAD-programma’s. Het is mogelĳk om meerdere punten in één keer te
selecteren en ze te verplaatsen, toe te voegen of helemaal te verwĳderen. De Gereedschappen Punten ondersteunen
ook de mogelĳkheid voor topologisch bewerken. Ze zĳn persistent in hun selectie, dus wanneer een bewerking is
gedaan, blĳft de selectie actief voor dit object en dit gereedschap.

Het is belangrĳk om de eigenschap Extra ► Opties ► Digitaliseren ► Zoekradius voor hoekaanpassingen:
op een waarde groter dan 0 te zetten. Anders zal QGIS u niet kunnen vertellen welk punt bewerkt wordt en zal een
waarschuwing weergeven.

Tip: Knooppunt markeringen
QGIS ondersteunt verschillende soorten markeringen voor punten: ‘Semi-transparante cirkel’, ‘Kruis’ en ‘Geen’. Kies,
om de stĳl voor markeren te wĳzigen, Opties in het menu Extra, klik op de tab Digitaliseren en selecteer het van
toepassing zĳnde item.

Standaard bewerkingen

Met een laag in de modus Bewerken, begin met het activeren van het Gereedschap Punten. Rode cirkels zullen
verschĳnen als u over punten gaat.

• Punten selecteren: U kunt punten selecteren door:
– Door er één voor één op te klikken terwĳl u de Shift-toets ingedrukt houd
– Te klikken en een rechthoek te slepen die de doelpunten omsluit
– Een polygoon tekenen die de doelpunten omsluit: Houd de Alt-toets ingedrukt en klik met het
Gereedschap Punten om te beginnen met het digitaliseren van een polygoon. Elke volgende klik voegt
een nieuw punt toe aan de elastiek-polygoon. Backspace of Delete verwĳdert het laatst toegevoegde
elastiek-punt. Esc annuleert de modus Selecteren voor de polygoon, als ook het backspacen/verwĳderen
van alle elastiek-punten doet. Klikken met rechts voltooit het digitaliseren van de polygoon en selecteert
alle punten binnen de elastiek-polygoon.

Wanneer een punt is geselecteerd, wĳzigt zĳn kleur naar blauw. Houd, om meer punten aan de huidige selectie
toe te voegen, de Shift-toets ingedrukt terwĳl u doorgaat zoals hierboven vermeld. Houd de Ctrl-toets
ingedrukt om punten uit de selectie te verwĳderen.

Tip: Selecteren van object bindt Gereedschap Punten
Punten kunnen worden geselecteerd vanuit verschillende objecten (of lagen). Als u zoekt naar punten van een
specifiek object op een drukke plaats, selecteer dan eerst dat object. Teken dan de rechthoek of polygoon voor
het selecteren met het Gereedschap Punten rondom de punten: alleen de punten van het geselecteerde object
worden geselecteerd.
Dit is ook het geval wanneer u het object weergeeft in het paneel Punten bewerker.
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• Modus Batch punten selecteren: De modus Batch punten selecteren kan worden geactiveerd door te drukken
op Shift+R. Selecteer een eerste knoop met één enkele klik, en ga dan zonder te klikken over een andere
knoop. Dit zal dynamisch alle tussenliggende knopen selecteren met het kortste pad (voor polygonen).

Fig. 16.90: Batch punten selecteren met Shift+R

Drukken opCtrl zal de selectie omdraaien en het langste pad langs de grens van het object selecteren. Beëindig
het selecteren van punten met een tweede klik, of druk op Esc om de modus Batch op te heffen.

• Punten toevoegen: Houd Shift ingedrukt en dubbelklik op de plaats van het om een punt toe te voegen aan
een geometrie lĳn of polygoon.
Wanneer u over een segment gaat verschĳnt een virtuele nieuwe knoop in het midden. Klik er op, verplaats
de cursor naar een nieuwe locatie en klik opnieuw om een nieuw punt toe te voegen. Voor lĳnen wordt een
virtuele knoop ook voorgesteld aan beide uiteinden: klik er op, maak volgende klikken en voltooi met en klik
met rechts; dit maakt het mogelĳk een bestaande lĳn uit te breiden.

Fig. 16.91: Virtuele knopen voor toevoegen van punten

• Punten verwĳderen: Selecteer de punten en klik op de toets Delete. Verwĳderen van alle punten van een
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object maakt, indien compatibel met een gegevensbron, een object zonder geometrie. Onthoud dat dit niet het
gehele object verwĳdert, alleen het gedeelte geometrie. Gebruik het gereedschap Geselecteerde object verwĳderen

om een volledig object te verwĳderen.
• Punten verplaatsen: Selecteer alle punten die u wilt verplaatsen, klik op een geselecteerd punt of rand, en
klik op de gewenste nieuwe locatie. U kunt de mogelĳkheden voor snappen aan object gebruiken en het Paneel
Geavanceerd digitaliseren beperkingen voor afstand, hoeken, exacte locatie X en Y vóór de tweede klik. Alle
geselecteerde punten zullen worden vertaald.
Echter, als de optie snappen-aan-raster is ingeschakeld, worden geselecteerde punten gesnapt aan de
dichtstbĳzĳnde kruising van het raster naar hun vertaalde positie. Niet geselecteerde punten worden ook
verplaatst naar hun dichtstbĳzĳnde kruising van het raster. Er is geen eenvoudige vertaling.

Fig. 16.92: Verplaatsen van het bovenste punt snapt alle punten aan het raster

• Aanliggende segmenten naar/van boog converteren: Selecteer het middelste punt van het segment dat u wilt
converteren, druk op de toets met de letter O. Als het punt in een boog lag zal de boog worden geconverteerd
naar rechte lĳnen. Als het punt tussen twee rechte lĳnen lag, zullen ze worden geconverteerd naar een boog.
Een eerste of laatste punt van een lĳn kan niet worden geconverteerd naar een middelste punt op de boog. De
laag moet compatibel zĳn met het type geometrie boog.

Fig. 16.93: Schakelen van boog naar rechte lijnen met de letter O

Elke wĳziging die wordt gemaakt met het Gereedschap Punten wordt als een afzonderlĳk item opgeslagen in
het dialoogvenster Ongedaan maken. Onthoud dat alle bewerkingen topologisch bewerken ondersteunen als dit is
ingeschakeld. Directe projectie wordt ook ondersteund.
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Het paneel Puntenbewerker

Door het inschakelen van een gereedschap voor punten opent u ook het paneel Puntenbewerker. Rechtsklikken op
een object vult het paneel met de lĳst van alle punten van het object met hun coördinaten X, Y (Z, M indien van
toepassing) en R (voor de straal, in het geval van een cirkelvormige geometrie). Het object wordt ook exclusief voor
bewerken ingesteld, wat betekent dat het bewerken van enig ander object uitgeschakeld is:

• Selecteren van een rĳ in de tabel selecteert het overeenkomende punt in het kaartvenster, en vice versa.
• Klikken of slepen over het kaartvenster zal alleen punten en segmenten van dat object selecteren of verplaatsen
• Wĳzig een coördinaat in de tabel en de positie van het punt wordt bĳgewerkt. Dit is een handige manier om
coördinaten Z of waarden M te bewerken voor punten.

• U kunt ook meerdere rĳen tegelĳk selecteren en ze allemaal verwĳderen.
• Nieuw punten kunnen alleen worden toegevoegd aan het verbonden object

Als u niet wilt dat het paneel Puntenbewerker onmiddellĳk wordt weergegeven elke keer dat u interacteert met
gereedschappen voor punten (en potentieel ander panelen verbergt of de plaatsing van panelen verstoort), deselecteer
het item Auto openen tabel in het menu Opties aan de bovenzĳde van het paneel. U kunt dan ook het paneel sluiten.
U zou, om het paneel opnieuw te openen, met rechts moeten klikken op een paneel of werkbalk en het selecteren in
de lĳst of klikken op het item Puntenbewerker weergeven op de werkbalk Digitaliseren.

Fig. 16.94: Paneel Punten bewerker dat geselecteerde punten weergeeft

Regels voor toewijzen van coördinaat Z of waarde M

Digitaliseren van 3D vectorobjecten of objecten met waarde M verschilt niet zoveel van (X,Y) 2D-lagen.
Gereedschappen en opties die worden beschreven in dit hoofdstuk zĳn nog steeds beschikbaar en helpen u bĳ het
plaatsen van het punt in een vlakke omgeving. Dan dient u de toewĳzing van het coördinaat Z (of waarde M ) af te
handelen:

• Standaard zal QGIS aan nieuwe punten de Standaard waarde Z (respectievelĳk Standaard waarde M)
toewĳzen, ingesteld op de tab Extra ► Opties ► Digitaliseren. Als het paneel Geavanceerd digitaliseren in
gebruik is, dan wordt de waarde genomen uit de widget Z (respectievelĳk M) daarvan.

• Bĳ het snappen aan een punt zullen nieuwe of verplaatste punten de waarde Z of M van de gesnapte punten
overnemen.
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• Bĳ het snappen aan een segment terwĳl Topologisch bewerken is ingeschakeld, dan wordt de nieuwe waarde
Z of M van het punt geïnterpoleerd langs het segment.

• Als de widget Z (respectievelĳkM) van het paneel Geavanceerd digitaliseren is vergrendeld, dan wordt de
waarde daarvan toegepast op het punt, voorrang nemend over enige waarde Z of M van een gesnapt punt of
segment.

U kunt, om waarden Z of M van een bestaand object te bewerken, het paneel Puntenbewerker gebruiken. Voor het
maken van aangepaste waarden Z of M zou u willen vertrouwen op het paneel Geavanceerd digitaliseren.

Objecten knippen, kopiëren en plakken

Geselecteerde objecten kunnen geknipt, gekopieerd en geplakt worden tussen lagen in hetzelfde project van QGIS,
maar dan moeten de doellagen ook eerst ingesteld zĳn om te bewerken met Bewerken aan/uitzetten.

Tip: Polygoon naar lĳn transformeren en vice versa met behulp van kopiëren/plakken
Kopieer een object lĳn en plak dat in een polygoonlaag: QGIS plakt in de doellaag een polygoon waarvan de
rand correspondeert met de dichtstbĳzĳnde geometrie van het lĳnobject. Dit is een snelle manier om verschillende
geometrieën te maken uit dezelfde gegevens.

Objecten kunnen ook als tekst geplakt worden in externe toepassingen. De objecten worden daarbĳ weergegeven in de
indeling CSV, waarbĳ de waarden van de geometrie zĳn opgeslagen in indeling van OGC, Well-Known Text (WKT).
WKT- en GeoJSON-objecten van buiten QGIS kunnen ook worden geplakt in een laag in QGIS.
Wanneer komt de functionaliteit kopiëren en plakken van pas? Wel, u kunt meerdere lagen tegelĳk bewerken en
objecten tussen lagen kopiëren en plakken. Waarom zouden we dit willen doen? Stel dat we moeten werken met een
nieuwe laag, maar slechts een of twee meren nodig hebben, niet de 5.000 op onze laag big_lakes. We kunnen
een nieuwe laag maken en daarmee kopiëren/plakken gebruiken om de benodigde meren erop te zetten.
Als voorbeeld zullen we enkele lagen van de laag met meren kopiëren naar een nieuwe laag:

1. Laad de laag van waaruit u objecten wilt kopiëren (de bronlaag)
2. Laad of maak de laag aan waar u naartoe wilt kopiëren (de doellaag)
3. Zet het bewerken aan voor de doellaag
4. Maak de bronlaag de actieve laag door deze te selecteren in de legenda

5. Gebruik het gereedschap Objecten selecteren per gebied of met één enkele klik om de object(en) op de bronlaag te
selecteren

6. Klik op het gereedschap Objecten kopiëren

7. Maak nu de doellaag de actieve laag door er op te klikken in de legenda

8. Klik op het gereedschap Objecten plakken

9. Zet bewerken voor de laag uit en sla de wĳzigingen op
Wat gebeurt er wanneer de attribuutvelden inhoudelĳk niet overeenkomen (veldnamen en typen zĳn niet hetzelfde)?
QGIS zal dan alleen die velden kopiëren die inhoudelĳk overeenkomen en de rest negeren. Als het u niet uitmaakt of
de attributen naar de doellaag worden gekopieerd, maakt het niet uit hoe de velden en gegevenstypen zĳn ontworpen.
Als u zeker wilt weten dat alles - het object en de attributen daarvan - gekopieerd worden, zorg er dan voor dat de
schema’s overeen komen.

Notitie: Behoud van eigenschappen geplakte objecten
Als uw bron- en doellaag dezelfde projectie gebruiken, zullen de geplakte objecten een identieke geometrie hebben
als op de bronlaag. Wanneer echter de doellaag een andere projectie gebruikt, dan kan QGIS niet garanderen dat
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de geometrie identiek is. Dit komt eenvoudigweg omdat er kleine afrondingsverschillen zullen optreden bĳ het
converteren tussen projecties.

Tip: Tekenreeks van attribuut naar een ander kopiëren
Indien u een nieuwe kolom hebt gemaakt in uw attributentabel van het type ‘string’ en u wilt daarin waarden plakken
vanuit een andere kolom met attributen die een grotere lengte hebben, zal de grootte van de kolom worden uitgebreid
tot dezelfde grootte. Dat is omdat het stuurprogramma voor het GDAL Shapefile de velden voor string en integer
automatisch weet te vergroten om dynamisch aan te passen tot de lengte van de gegevens die moeten worden
ingevoerd.

Geselecteerde objecten verwijderen

Als we een volledig object (attribuut en geometrie) willen verwĳderen, kunnen we dat doen door eerst de geometrie
te selecteren met het normale gereedschap Object(en) selecteren. Selecteren kan ook worden uitgevoerd vanuit de
attributentabel. Als u de selectie eenmaal hebt ingesteld, druk dan op de toets Delete of Backspace of gebruik
het gereedschap Geselecteerde object verwĳderen om de objecten te verwĳderen. Meerdere geselecteerde objecten kunnen
in één keer worden verwĳderd.

Het gereedschap Objecten knippen op de werkbalkDigitaliseren kan ook worden gebruikt om objecten te verwĳderen.
Dit verwĳdert effectief de objecten uit de laag, maar plaatst ze ook tĳdelĳk in het “ruimtelĳke klembord”. We kunnen
dus het object knippen om het te verwĳderen. We kunnen dan het gereedschap Objecten plakken gebruiken om het
terug te plaatsen, wat ons de mogelĳkheid Ongedaan maken geeft voor 1 niveau. Knippen, kopiëren en plakken werkt
op de momenteel geselecteerde objecten, wat betekent dat we er meer dan één per keer kunnen bewerken.

Ongedaan maken en Opnieuw

De gereedschappen Ongedaan maken en Opnieuw geven u de mogelĳkheid om bewerkingen op vectorlagen
ongedaan te maken of nogmaals uit te voeren. Er is ook een vast te zetten widget dat alle bewerkingen in de
geschiedenis van Ongedaan maken/Opnieuw weergeeft (zie Fig. 16.95). Dit widget is standaard niet zichtbaar maar
u kunt dit zichtbaar maken door met de rechtermuisknop op de werkbalk te klikken en vervolgens het keuzevak
Ongedaan maken/Opnieuw te selecteren. De mogelĳkheid Ongedaan maken/ Opnieuw is echter actief, ook als de
widget niet zichtbaar is.

Fig. 16.95: Ongedaan maken en Opnieuw gedigitaliseerde stappen

Als Ongedaan maken wordt gebruikt of op Ctrl+Z (of Cmd+Z) wordt gedrukt, zal de status van alle objecten en
attributen worden teruggebracht naar die van vóór de laatste bewerking.Wĳzigingen anders dan normale bewerkingen
van vectoren (bĳvoorbeeld gemaakt door een plug-in) zouden al dan niet kunnen ongedaan worden gemaakt,
afhankelĳk van hoe de wĳzigingen werden uitgevoerd.

620 Hoofdstuk 16. Werken met vectorgegevens



QGIS Desktop 3.28 User Guide

Met het paneel Ongedaan maken/Opnieuw kunt u door te klikken op een bewerking in de lĳst direct naar de situatie
terugspringen van voor de bewerking.

Bewerkte lagen opslaan

Als een laag te bewerken is, zullen de wĳzigingen in het geheugen van QGIS zĳn opgeslagen. Deze zĳn dan nog
niet onmiddellĳk doorgevoerd/opgeslagen in de gegevensbron of op schĳf. Als u tĳdens het bewerken de wĳzigingen
tussendoor wilt opslaan maar door wilt gaan met bewerken zonder de modus Bewerken te verlaten, kunt u op de knop

Wĳzigingen laag opslaan klikken. Als u modus Bewerken uitzet met Bewerken aan/uitzetten (of QGIS wilt afsluiten), dan
zult u worden gevraagd of uw aanpassingen wilt opslaan of negeren.
Als de wĳzigingen niet opgeslagen kunnen worden (bĳv. geen schĳfruimte meer beschikbaar of de attributen hebben
waarden die buiten het bereik liggen), dan blĳven de wĳzigingen nog bewaard in het geheugen van QGIS. U kunt dan
nog wĳzigingen aanbrengen en het opnieuw proberen.

Tip: Integriteit van gegevens
Het is altĳd een goed idee om een back-up te maken van uw gegevens voordat u begint met het wĳzigen ervan.
Alhoewel de auteurs van QGIS veel aandacht hebben gegeven aan het behouden van de integriteit van de gegevens,
worden er geen garanties gegeven.

Meerdere lagen in één keer opslaan

Deze functionaliteit geeft de mogelĳkheid om meerdere lagen te digitaliseren. Kies Opslaan voor geselecteerde

laag/lagen om alle wĳzigingen op te slaan die u in meerdere lagen hebt gemaakt. Het is ook mogelĳk om met
Terugdraaien voor geselecteerde laag/lagen alle wĳzigingen voor alle geselecteerde lagen in één keer terug te draaien.
Als u wilt stoppen met het bewerken van de geselecteerde lagen is Afbreken voor geselecteerde laag/lagen een
eenvoudige manier.
Dezelfde functionaliteit is beschikbaar voor het bewerken van alle lagen.

Tip: Transactiegroep gebruiken om wĳzigingen in meerdere lagen in één keer te bewerken, op te slaan of
terug te draaien
Activeer, bĳ het werken met lagen vanuit dezelfde database van PostgreSQL, de optie Automatisch transactiegroepen
maken waar mogelĳk in Project ► Eigenschappen… ► Databronnen om hun gedrag te synchroniseren (de modus
Bewerken aan- of uitzetten, tegelĳkertĳd opslaan of terugdraaien van wĳzigingen).
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16.3.5 Geavanceerd digitaliseren

Tabel 16.4: Werkbalk voor Geavanceerd bewerken voor vectorlaag
Pictogram Doel Pictogram Doel

Gereedschap Geavanceerd digitaliseren
inschakelen

Object(en) verplaatsen Object(en) kopiëren en
verplaatsen

Object(en) roteren Object vereenvoudigen

Object op schaal brengen

Ring toevoegen Deel toevoegen

Ring vullen Richting omdraaien

Ring verwĳderen Deel verwĳderen

Verspring curve Object vervormen

Delen splitsen Kaartobjecten splitsen

Attributen van geselecteerde objecten
samenvoegen

Geselecteerde objecten
samenvoegen

Puntsymbolen roteren Verschuiving puntsymbolen

Object verkleinen of vergroten

Object(en) verplaatsen

Het gereedschap Object(en) verplaatsen stelt u in staat bestaande objecten te verplaatsen:
1. Selecteer het/de te verplaatsen object(en).
2. Klik in het kaartvenster om het punt van origine aan te geven voor de verplaatsing; u kunt vertrouwen op de

mogelĳkheden voor snappen om een nauwkeurig punt te bepalen.
U kunt ook voordeel trekken uit de beperkingen Geavanceerd digitaliseren om nauwkeurig de coördinaten van
het punt van origine in te stellen. In dat geval:

1. Klik eerst op de knop om het paneel in te schakelen.
2. Typ X en voer de corresponderende waarde in voor het punt van origine dat u wilt gebruiken. Druk dan

op de knop naast de optie om de waarde vast te zetten.
3. Doe hetzelfde voor het Y- coördinaat.
4. Klik in het kaartvenster en uw punt van origine is geplaatst op de aangegeven coördinaten.

3. Verplaats over het kaartvenster om het bestemmingspunt van de verplaatsing aan te geven, nog steeds de
modus Snappen gebruikend of, zoals hierboven, gebruik het paneel Geavanceerd digitaliseren wat u aanvullende
beperkingen voor plaatsing afstand en hoek verschaft om het eindpunt van de verplaatsing te plaatsen.

4. Klik in het kaartvenster: alle objecten worden verplaatst naar de nieuwe locatie.

Op dezelfde wĳze kunt u een vertaalde kopie maken van de object(en) met het gereedschap
Object(en) kopiëren en verplaatsen.
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Notitie: Als er geen object is geselecteerd als u de eerste keer klikt in het kaartvenster met een van de gereedschappen
Object(en) verplaatsen of Object(en) kopiëren en verplaatsen, dan wordt alleen het object onder de muiscursor
beïnvloedt door de actie. Dus: als u meerdere objecten wilt verplaatsen dient u ze eerst te selecteren.

Object(en) roteren

Gebruik het gereedschap Object draaien om één of meerdere objecten in het kaartvenster te roteren:

1. Druk op het pictogram Object draaien

2. Klik dan op het object om het te draaien. Het zwaartepunt van het object wordt genomen als draaipunt, een
voorbeeld van het gedraaide object wordt weergegeven en een widget opent dat de huidige hoek voor Rotatie
weergeeft.

3. Klik in het kaartvenster als u tevreden bent met de nieuwe plaatsing of voer handmatig de hoek voor het draaien
in in het tekstvak. U kunt ook het vak Snappen aan ° gebruiken om de waarden voor het draaien te beperken.

4. Als u verschillende objecten tegelĳkertĳd wilt draaien, zouden zĳ eerst geselecteerd moeten worden, en de
rotatie wordt standaard uitgevoerd over het zwaartepunt van hun gecombineerde geometrieën.

U kunt ook een ankerpunt definiëren dat anders is dan het standaard zwaartepunt van het object: druk op de Ctrl-
toets, klik in het kaartvenster en dat punt zal worden gebruikt als het nieuwe draaipunt.
Indien u Shift ingedrukt houdt vóór het klikken op de kaart, wordt het roteren uitgevoerd in stappen van 45 graden,
die later kunnen worden aangepast in de widget voor invoer door de gebruiker.

Druk op de toets ESC of klik op het pictogram Object draaien om het roteren van objecten te beëindigen.

Object op schaal brengen

Het gereedschap Object op schaal brengen is soortgelĳk aan de mogelĳkheid Object roteren. In plaats van het uitvoeren
van een rotatie van geselecteerde objecten, brengt het hun geometrie opnieuw op schaal. De wĳziging wordt uitgevoerd
in relatie tot het ankerpunt en de verhouding voor de schaal kan handmatig worden gespecificeerd in de widget die
verschĳnt in de bovenhoek van het kaartvenster.

Object vereenvoudigen

Het gereedschap Object vereenvoudigen stelt u in staat interactief de vorm van een geometrie lĳn of polygoon te wĳzigen
door het aantal punten van een object te reduceren of te verdichten, zolang als de geometrie geldig blĳft:

1. Selecteer het gereedschap Object vereenvoudigen.
2. Klik op het object of sleep een rechthoek over de objecten.
3. Een dialoogvenster verschĳnt waar u de toe te passen Methode kunt definiëren, d.i. of u wilt:

• de geometrie vereenvoudigen, wat betekent minder punten dan het origineel. Beschikbare methoden zĳn
Vereenvoudigen op afstand, Vereenvoudigen op snappen aan raster of
Vereenvoudigen op gebied (Visvalingam). U dient dan de waarde van Tolerantie in
Laageenheden, Pixels of kaarteenheden, om te gebruiken voor het vereenvoudigen, aan te
geven. Hoe hoger de tolerantie des te meer punten kunnen worden verwĳerd.

• of de geometrieën te verdichten met nieuwe punten met de optie Afgevlakt: voor elk bestaand punt
worden twee punten geplaatst op het segment waartoe het behoort, op een afstand Verspringing die het
percentage van de lengte van het segment aangeeft. U kunt ook het aantal Doorlopen instellen waarmee
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de verwerking zou moeten worden verwerkt: hoe meer doorlopen, des te meer punten en hoe vlakker het
object wordt.

De door u gebruikte instellingen zullen worden opgeslagen bĳ het verlaten van een project of een sessie van
bewerken. U kunt dus, de volgende keer dat u een object vereenvoudigt, teruggaan naar dezelfde parameters.

4. Een overzicht van de aanpassingen die uitgevoerd gaan worden wordt aan de onderzĳde van het dialoogvenster
weergegeven en vermeld het aantal objecten en punten (voor en na de bewerking en de verhouding die het
vertegenwoordigt). Ook wordt, in het kaartvenster, de verwachte geometrie weergegeven over de bestaande,
met de kleur van het elastiek.

5. Wanneer de verwachte geometrie voldoet aan uw wensen, klik dan op OK om de aanpassing toe te passen.
Anders kunt u, om de bewerking te annuleren, ofwel drukken op Annuleren of met rechts klikken in het
kaartvenster.

Notitie: Anders dan de optie voor vereenvoudigen van een object in het menu Extra►Opties►Rendering, wat slechts
de geometrie vereenvoudigt voor het renderen, past het gereedschap Object vereenvoudigen permanent de geometrie
van het object in de gegevensbron aan.

Deel toevoegen

U kunt met Deel toevoegen aan een geselecteerd object een object multipunt, multilĳn of multipolygoon genereren.
Het nieuwe onderdeel moet buiten de bestaande worden gedigitaliseerd wat de eerder geselecteerde zou moeten zĳn.

Deel toevoegen kan ook worden gebruikt om een geometrie toe te voegen aan een object zonder geometrie. Selecteer
eerst het object in de attributentabel en digitaliseer de nieuwe geometrie met het gereedschap Deel toevoegen.

Deel verwijderen

Met Deel verwĳderen kunt u delen verwĳderen van multi-geometrie objecten (bĳv. om polygonen uit een object
multi-polygoon te verwĳderen). Dit gereedschap werkt voor alle multi-geometrie objecten voor punten, lĳnen en
polygonen. Verder kan het worden gebruikt om de geometrische component van een object te verwĳderen. Klik
eenvoudigweg in het doeldeel om een deel te verwĳderen.

Ring toevoegen

U kunt ringpolygonen maken met behulp van het pictogram Ring toevoegen. Dit betekent dat het, binnen een
bestaand gebied, mogelĳk is meerdere polygonen toe te voegen die fungeren als een ‘gat’, dus het gebied tussen
de buitenste polygoon en de binnenste polygonen blĳft over als ringpolygoon.

Ring vullen

Het gereedschap Ring vullen helpt u een object polygoon te maken dat geheel binnen een ander valt, zonder
overlappend gebied; dat betekent dat het nieuwe object een gat bedekt binnen het bestaande. Een dergelĳk object
maken:

1. Selecteer het gereedschap Ring vullen.
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2. Teken een nieuwe polygoon over het bestaande object: QGIS voegt een ring toe aan de geometrie ervan (alsof

u het gereedschap Ring toevoegen gebruikte) en maakt een nieuw object waarvan de geometrie overeenkomt
met de ring (alsof u die traceerde over de interne grenzen met het gereedschap Object polygoon toevoegen).

3. Of, als alternatief, als de ring al bestaat in het object, plaats de muis over de ring en klik met links met Shift
ingedrukt: een nieuw object dat het gat vult wordt op die plaats getekend.
Het formulier Object-attributen van het nieuwe object opent, gevuld met waarden van het “ouder”-object en/of
veldbeperkingen.

Ring verwijderen

Met Ring verwĳderen kunt u ringen binnen een bestaande polygoon verwĳderen, door te klikken in het gat. Dit
gereedschap werkt alleen met objecten polygoon en multi-polygonen. Het zal ook niets veranderen wanneer het wordt
gebruikt op de buitenste ring van de polygoon.

Object vervormen

U kunt objecten lĳn en polygoon opnieuw vorm geven met behulp van het gereedschap Object vervormen op de
werkbalk. Voor lĳnen vervangt het het lĳndeel van de eerste tot de laatste kruising met de originele lĳn.

Fig. 16.96: Lijn vervormen

Tip: Geometrieën Lĳnen uitbreiden met gereedschap Objecten vervormen

Gebruik het gereedschap Object vervormen om bestaande geometrieën Lĳn te verlengen: snap aan het eerste of laatste
punt van de lĳn en teken een nieuwe. Valideer en de geometrie van het object wordt de combinatie van de twee lĳnen.

Voor polygonen zal het de grenzen van de polygoon opnieuw vormgeven. De lĳn van het gereedschap moet, om dit te
laten werken, de grens van de polygoon tenminste twee keer kruisen. Klik, om de lĳn te tekenen, op het kaartvenster
om punten toe te voegen. Klik met rechts om te stoppen. Net als met de lĳnen wordt alleen het segment tussen de
eerste en laatste kruising in aanmerking genomen. De opnieuw vormgegeven segmenten van de lĳn die binnen de
polygoon liggen zullen worden verkleind, terwĳl die welke er buiten liggen zullen worden verlengd.
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Fig. 16.97: Polygoon vervormen

Bĳ polygonen kan vervormen soms leiden tot ongewenste resultaten. Het is vooral handig om kleinere lĳnstukken
van een polygoon aan te passen, en niet om grote wĳzigingen uit te voeren. Het vervormen van lĳnen is ook niet
toegestaan om meerdere polygoonringen te doorsnĳden, aangezien dit een ongeldige polygoon oplevert.

Notitie: Het gereedschap Objecten vervormen kan het startpunt van een polygoon of een gesloten lĳn wĳzigen. Dus
het punt dat twee keer voorkomt kan een ander punt zĳn. Dit zal geen probleem zĳn voor de meeste applicaties, maar
hier dient wel rekening mee worden gehouden.

Verspring curve

Het gereedschap Verspring curve maakt parallelle lĳnen en polygonen voor lĳnlagen. De functie werkt voor de laag
die bewerkt wordt (de geometrieën worden gewĳzigd) of op achtergrondlagen (in welk geval het kopieën maakt van
de lĳnen / ringen en ze toevoegt aan de laag die bewerkt wordt). Het is dus ideaal geschikt voor het maken van op
afstand-lĳnlagen. Het dialoogvenster Gebruikersinvoer verschĳnt en geeft de afstand voor de verplaatsing weer.

U moet eerst naar de modus Bewerken en het gereedschap Verspring curve activeren om een lĳnlaag te kunnen
verschuiven. Klik daarna op een object om het te kunnen verplaatsen. Verplaats de muis en klik waar u het neer
wilt zetten of voer de gewenste afstand in het widget voor invoer door de gebruiker in. Ingedrukt houden van Ctrl
gedurende de 2e klik zal een kopie van de verschuiving maken. Uw wĳzigingen kunnen dan worden opgeslagen met
het gereedschap Wĳzigingen laag opslaan.
QGIS dialoogvenster Opties (tab Digitaliseren dan gedeelte Lĳnverspring-gereedschap ) stelt u in staat enkele
parameters, zoals Verbindingsstĳl, Segmenten per kwadrant, Maximale puntlengte bĳ hoekpunten, te
configureren.
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Lijn omdraaien

Wĳzigen van de richting van een geometrie lĳn kan nuttig zĳn voor cartografische doeleinden of bĳ het voorbereiden
van netwerkanalyses.
Richting van een lĳn omdraaien:

1. Activeer het gereedschap voor het omdraaien van de lĳn door te klikken op Lĳn omdraaien.
2. Klik op de lĳn. De richting van de lĳn is omgedraaid.

Kaartobjecten splitsen

Gebruik het gereedschap Objecten splitsen om een object in twee of meer afzonderlĳke objecten te splitsen, d.i. elke
geometrie correspondeert met een nieuwe rĳ in de attributentabel.
Lĳn- of polygoonobjecten splitsen:

1. Selecteer het gereedschap Objecten splitsen.
2. Teken een lĳn over het/de object(en) die u wilt splitsen. Als een selectie actief is zullen alleen de

geselecteerde objecten worden gesplitst. Indien ingesteld worden standaardwaarden of clausules toegepast op
de corresponderende velden, en andere attributen van het ouderobject worden standaard gekopieerd naar de
nieuwe objecten.

3. U kunt dan op de normale wĳze attributen van een resulterend object aanpassen.

Tip: Een object polylĳn splitsen in nieuwe objecten met één klik

Met het gereedschap Objecten splitsen snap en klik op een bestaand punt of een object polylĳn om dat object in twee
nieuwe objecten te splitsen.

Delen splitsen

In QGIS is het nu mogelĳk om de delen van een meerdelige object te splitsen zodat het aantal delen wordt vergroot.

Teken gewoon een lĳn over het deel dat u wilt splitsen met behulp van het pictogram Objecten splitsen.

Tip: Een polylĳn splitsen in nieuwe delen met één klik

Met het gereedschap Objecten splitsen snap en klik op een bestaand punt of een object polylĳn om het object in twee
nieuwe polylĳnen, die tot hetzelfde object behoren, te splitsen.

Geselecteerde objecten samenvoegen

Het gereedschap Geselecteerde objecten samenvoegen stelt u in staat een nieuw object te maken door bestaande samen
te voegen. Een nieuw object door bestaande samen te voegen zal hun geometrieën samenvoegen tot één nieuw. Als
objecten geen gemeenschappelĳke grenzen hebben zal een object multipolygoon/multilĳn/multipunt worden gemaakt.

1. Selecteer eerst de objecten die u wilt combineren.

2. Druk dan op de knop Geselecteerde objecten samenvoegen.
3. In het nieuwe dialoogvenster geeft de regel Samenvoegen aan de onderzĳde van de tabel de attributen van het

resulterende object weer. U kunt elk van deze waarden wĳzigen, ofwel door:
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• handmatig de waarde in de corresponderende cel te vervangen;
• een rĳ in de tabel te selecteren en te drukken opGebruik attributen van geselecteerde object om de waarden
van dat initiële object te gebruiken;

• drukken op Attributen gebruiken van het object met het grootste gebied om de attributen van het langste
object lĳn, de grootste polygoon, of de multipunten met de meste delen te gebruiken;

• door te drukken op Alle velden overslaan om lege attributen te gebruiken;
• uitbreiden van het keuzemenu aan de bovenzĳde van de tabel, selecteer en van bovenstaande opties om
alleen op het corresponderende veld toe te passen. Daar kunt u ook kiezen om de attributen van de initiële
objecten samen te voegen (Minimum, Maximum, Mediaan, Som, Aantal, Samenvoeging… afhankelĳk
van het type veld. bekĳk Paneel Statistisch overzicht voor de volledige lĳst met functies).

Notitie: Als de laag standaardwaarden of clausules aanwezig heeft in velden zullen die worden gebruikt als
initiële waarden voor het samengevoegde object.

4. Druk opOK om de aanpassingen toe te passen. Één enkel (multi)object wordt op de laag gemaakt, dat de eerder
geselecteerde vervangt.

Samenvoegen attribuutwaarden van geselecteerde objecten

Het gereedschap Attributen van geselecteerde objecten samenvoegen stelt u in staat dezelfde attributen toe te passen op objecten
zonder de grenzen samen te voegen. Het dialoogvenster is hetzelfde als dat van het gereedschap Geselecteerde
objecten samenvoegen met uitzondering van het feit dat anders dan met dat gereedschap, geselecteerde
objecten met hun geometrie worden behouden terwĳl sommige van hun attributen identiek worden gemaakt.

Puntsymbolen roteren

Puntsymbolen roteren stelt u in staat het draaien van puntsymbolen in het kaartvenster individueel te wĳzigen.
1. Eerst moet u het veld aangeven waar de waarde voor rotatie moet worden opgeslagen. Dit wordt gedaan door

een veld toe te wĳzen aan de data-bepaalde eigenschap rotatie van het symbool:
1. Blader, in het dialoogvenster Laageigenschappen ► Symbologie, naar het dialoogvenster voor het

bewerken van het symbool.

2. Klik op de widget Data-bepaalde ‘override’ naast de optie Rotatie van het bovenste niveauMarkering
(bĳ voorkeur) van de symboollagen.

3. Kies een veld in het combinatievak Veldtype. Waarden van dat veld worden dus gebruikt om het symbool
van het object overeenkomstig te draaien.
U kunt ook het item Gegevens opslaan in het project selecteren om een veld hulpopslag te maken om de waarde
voor rotatie te beheren.

Notitie: Zorg er voor dat hetzelfde veld aan alle symboollagen is toegewezen
Instellen van het data-bepaalde veld voor roteren op het bovenste niveau van de boom van symbolen zorgt er
automatisch voor dat het wordt doorgegeven aan alle symboollagen, een vereiste om grafisch roteren van een
symbool met het gereedschap Puntsymbolen roteren te kunnen uitvoeren. Inderdaad, als een symboollaag niet
hetzelfde veld heeft toegewezen aan de eigenschap voor roteren, zal het gereedschap niet werken.

628 Hoofdstuk 16. Werken met vectorgegevens



QGIS Desktop 3.28 User Guide

Fig. 16.98: Een puntsymbool roteren

2. Klik dan op een punt in het kaartvenster met het gereedschap Puntsymbolen roteren

3. Verplaats de muis in het kaartvenster. Een rode pĳl met de waarde van de rotatie zal worden gevisualiseerd
(zie Fig. 16.98). Wanneer u de toets Ctrl ingedrukt houdt tĳdens het verplaatsen, zal het roteren gebeuren in
stappen van 15 graden.

4. Wanneer u de verwachte waarde voor de hoek ziet, klik opnieuw. Het symbool wordt gerenderd met deze
nieuwe rotatie en het daaraan verbonden veld wordt overeenkomstig bĳgewerkt.
U kunt met rechts klikken om het roteren van het symbool af te breken.

Verschuiving puntsymbolen

Puntsymbolen verschuiven stelt u in staat om interactief de gerenderde positie van puntsymbolen in het kaartvenster te

wĳzigen. Dit gereedschap gedraagt zich zoals het gereedschap Puntsymbolen roteren met uitzondering van het feit dat
het vereist dat u een veld verbindt met de data-bepaalde eigenschap Verschuiving (X,Y) van elke laag van het symbool.
Het veld zal dan worden gevuld met de coördinaten voor de verschuiving voor de objecten waarvan het symbool is
verplaatst in het kaartvenster.

1. Koppel een veld aan de data-bepaalde widget van de eigenschap Verschuiving (X,Y) van het symbool. Als het
symbool is gemaakt met veel lagen, zou u het veld aan elk daarvan willen toewĳzen

2. Selecteer het gereedschap Puntsymbolen verschuiven

3. Klik op een puntsymbool
4. Verplaats naar een nieuwe locatie
5. Klik opnieuw. Het symbool wordt verplaats naar de nieuwe plek. Waarden voor de verschuiving vanaf de

originele positie worden opgeslagen in het gekoppelde veld.
U kunt met rechts klikken om het verschuiven van het symbool af te breken.

Notitie: Het gereedschap Puntsymbolen verschuiven verplaatst niet het punt zelf; u zou de gereedschappen
gereedschap Punten (Huidige laag) of Object(en) verplaatsen voor dat doel moeten gebruiken.

16.3. Bewerken 629



QGIS Desktop 3.28 User Guide

Object verkleinen/vergroten

Het gereedschap Verkleinen/Vergroten stelt u in staat lengtes van segmenten, van een geometrie (multi)lĳn of
(multi)polygoon, te verkleinen of te vergroten om samen te vallen met een geselecteerd segment (de snĳlĳn). Dit
resulteert in een aangepaste geometrie met een punt dat is gesnapt aan het doelsegment of het verlengde daarvam.
Depending on how the selected geometries are placed in relation to each other, the tool will either:

• Verkleinen: verwĳdert delen van het lĳnsegment of de grens van de polygoon, voorbĳ de snĳlĳn
• Vergroten: breidt de grenzen van de polygoon of lĳnsegmenten uit zodat zĳ kunnen snappen aan de snĳlĳn.

Bestaande geometrieën verkleinen of vergroten:
1. Schakel de toepasselĳke instellingen voor snappen in voor segmenten op de betrokken la(a)g(en

2. Selecteer het gereedschap Verkleinen/Vergroten

3. Klik op het doel-segment, d.i. het segment waarop u een ander segment wilt vergroten of verkleinen. Het zal
worden geaccentueerd.

4. Verplaats naar het segment dat u wilt verkleinen of vergroten. Het hoeft niet het laatst segment van de geometrie
te zĳn, maar moet op de actieve laag liggen.

5. Ga over het segment en QGIS geeft een voorbeeld weer van hoe de geometrie van het object eruit zou komen
te zien. Indien OK, klik op het segment. In het geval van verkleinen moet u het deel selecteren dat u verkleind
zou moeten worden.

6. Als beide segmenten in 3D zĳn, voert het gereedschap een interpolatie uit op het segment van de limiet om de
waarde Z te verkrĳgen.

Let op: Let op de aangepaste geometrie tĳdens het gebruiken van het gereedschap Verkleinen/Vergroten.
Afhankelĳk van de invoer kan het ongeldige geometrieën maken, wat potentieel resulteert in het niet kunnen
opslaan van de laag.

16.3.6 Vorm digitaliseren

De werkbalk Regelmatige vorm digitaliseren is gesynchroniseerd met de Vorm digitaliseren methode voor het tekenen
van een geometrie die u kunt selecteren op de werkbalk Geavanceerd digitaliseren. Het biedt een set gereedschappen
om lĳnen of polygonen te tekenen met ene regelmatige vorm.

Cirkel-tekenreeks per straal

De knop Cirkel-tekenreeks per straal maakt het mogelĳk objecten lĳn of polygoon met een cirkelvormige geometrie toe
te voegen, gegeven de twee knopen op de boog en een straal:

1. Klik tweemaal met links om de twee punten op de geometrie te plaatsen.
2. Een widget Straal in de rechterbovenhoek van het kaartvenster geeft de huidige straal weer (corresponderend

met de afstand tussen de punten). Bewerk dat veld naar de waarde die u wilt gebruiken.
3. Een overzicht van de bogen die overeenkomen met deze beperkingen wordt weergegeven bĳ het verplaatsen

van de muis. Klik met rechts om te valideren als de verwachte boog wordt weergegeven.
4. Voeg een nieuw punt toe om een andere boog vorm te geven.

Notitie: Gebogen geometrieën worden als zodanig alleen opgeslagen in compatibele gegevensproviders
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Hoewel QGIS het mogelĳk maakt gebogen geometrieën te digitaliseren binnen elke bewerkbare gegevensindeling,
dient u een gegevensprovider (bĳv. PostGIS, geheugenlaag, GML of WFS) te gebruiken die gebogen vormen
ondersteunt om objecten als gebogen op te kunnen slaan, anders maakt QGIS segmenten van de cirkelvormige bogen.

Cirkels tekenen

Er is een set gereedschap voor het tekenen van cirkels. De gereedschappen worden hieronder beschreven.
Cirkels worden geconverteerd naar circulaire tekenreeksen. Daarom, zoals uitgelegd in Cirkel-tekenreeks per straal,
indien toegestaan door de gegevensprovider, zal het worden opgeslagen als een gebogen geometrie, Indien niet, dan
zal QGIS segmenten maken van de circulaire bogen.

• Cirkel uit 2 punten: De twee punten definiëren de diameter en de oriëntatie van de cirkel. (Klik met links, klik
met rechts)

• Cirkel uit 3 punten: Tekent een cirkel uit drie bekende punten op de cirkel. (Klik met links, klik met links, klik
met rechts)

• Cirkel vanuit middelpunt en een punt: Tekent een cirkel met een opgegeven middelpunt en een punt op de cirkel (Klik
met links, klik met rechts). Indien gebruikt met het Het paneel Geavanceerd digitaliseren kan dit gereedschap
een gereedschap “Cirkel uit middelpunt en straal toevoegen” worden door het instellen en vastzetten van een
waarde Afstand na de eerste klik.

• Cirkel uit 3 tangens: Tekent een cirkel die tangentiaal is naar drie segmenten. Onthoud dat u Snappen naar
segmenten moet activeren (Bekĳk Tolerantie voor snappen en zoekradius instellen). Klik op een segment om
een tangens toe te voegen. Als twee tangens parallel zĳn, worden de coördinaten van de klik op de eerste
parallelle tangens gebruikt om de positie van de cirkel te bepalen. Als drie tangens parallel zĳn wordt een
foutbericht weergegeven en de invoer wordt leeggemaakt. (Klik met links, klik met links, klik met rechts)

• Cirkel uit 2 tangens en een punt: Soortgelĳk aan cirkel vanuit 3 tangens, behalve dat u twee tangens moet selecteren,
een straal moet invoeren en het gewenste middelpunt moet selecteren.

Ellipsen tekenen

Er is een set gereedschap voor het tekenen van ellipsen. De gereedschappen worden hieronder beschreven.
Ellipsen kunnen niet worden geconverteerd naar cirkeltekenreeksen, zĳ zullen dus altĳd worden gesegmenteerd.

• Ellips uit middelpunt en twee punten: Tekent een ellips met een opgegeven middelpunt, hoofdas en hulpas. (Klik met
links, klik met links en klik met rechts)

• Ellips uit middelpunt en een punt: Tekent een ellips in een begrenzingsvak met het middelpunt en een hoek. (Klik
met links, klik met rechts)

• Ellips uit bereik: Tekent een ellips in een begrenzingsvak met twee tegenoverliggende hoeken. (Klik met links,
klik met rechts)

• Ellips uit foci: Tekent een ellips uit 2 punten voor foci en een punt op de ellips. (Klik met links, klik met
rechts)
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Rechthoeken tekenen

Er is een set gereedschap voor het tekenen van rechthoeken. De gereedschappen worden hieronder beschreven.

• Rechthoek toevoegen uit middelpunt en een punt: Tekent een rechthoek in een begrenzingsvak met het middelpunt en
een hoek. (Klik met links, klik met rechts)

• Rechthoek toevoegen uit bereik: Tekent een rechthoek in een begrenzingsvak met twee tegenoverliggende hoeken.
(Klik met links, klik met rechts)

• Rechthoek uit 3 punten (afstand): Tekent een georiënteerde rechthoek uit drie punten. Het eerste en tweede punt
bepalen de lengte en de hoek van de eerste zĳde. Het derde punt bepaalt de lengte van de andere zĳde. Men
kan Het paneel Geavanceerd digitaliseren gebruiken om de lengte van de randen in te stellen. (Klik met links,
klik met links, klik met rechts)

• Rechthoek uit 3 punten (geprojecteerd): Hetzelfde als het voorgaande gereedschap, maar de lengte van de tweede zĳde
wordt berekend uit de projectie van het derde punt op de eerste zĳde. (Klik met links, klik met links, klik met
rechts)

Fig. 16.99: Rechthoek tekenen uit 3 punten met afstand (rechts) en geprojecteerd (links)

Normale polygonen tekenen

Er is een set gereedschap voor het tekenen van gewone polygonen. De gereedschappen worden hieronder beschreven.
Klik met links om het eerste punt te plaatsen. Een dialoogvenster verschĳnt waar u het aantal zĳden van de polygoon
kunt instellen. Klik met rechts om de normale polygoon te voltooien.

• Gewone polygoon toevoegen uit twee punten: Tekent een normale polygoon waarbĳ de twee punten de lengte en hoek
van de eerste zĳde bepalen.

• Gewone polygoon toevoegen uit middelpunt en een punt: Tekent een normale polygoon vanuit het opgegeven middelpunt.
Het tweede punt bepaalt de hoek en afstand tot het midden van een zĳde.

• Gewone polygoon toevoegen uit middelpunt en een hoek: Hetzelfde als het voorgaande gereedschap maar het tweede punt
bepaalt de hoek en afstand tot een punt.
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16.3.7 Het paneel Geavanceerd digitaliseren

Bĳ het vastleggen, opnieuw vormgeven of splitsen van nieuwe of bestaande geometrieën heeft u ook de mogelĳkheid
om het paneel Geavanceerd digitaliseren te gebruiken. U kunt lĳnen exact parallel of loodrecht onder een specifieke
hoek digitaliseren of lĳnen onder specifieke hoeken vastzetten. Verder kunt u een precieze definitie voor uw nieuwe
geometrie maken, door het invoeren van coördinaten X en Y en ook Z voor 3D-objecten, of waarden M.

Fig. 16.100: Het paneel Geavanceerd digitaliseren

Het paneel Geavanceerd digitaliseren kan worden geopend ofwel met een klik met rechts op de werkbalk, vanuit het
menu Beeld ► Panelen of door te drukken op Ctrl+4. Als het paneel eenmaal zichtbaar is, klik dan op de knop

gereedschap Geavanceerd digitaliseren inschakelen om de set gereedschappen in te schakelen.

Notitie: De gereedschappen zĳn niet ingeschakeld als de kaartweergave in geografische coördinaten is.

Het doel van het gereedschap Geavanceerd digitaliseren is om coördinaten, lengten, en hoeken vast te zetten bĳ het
verplaatsen van de muis gedurende het digitaliseren in het kaartvenster.
U kunt ook beperkingen met relatieve of absolute verwĳzingen maken. Relatieve verwĳzing betekent dat de volgende
beperkende waarden voor het punt relatief zullen zĳn ten opzichte van het vorige punt of segment.

De werkbalk

Aan de bovenzĳde van het Paneel Digitaliseren, vindt u de volgende knoppen:

• Gereedschap Geavanceerd digitaliseren inschakelen

• Constructie-modus: maakt het mogelĳk de posities van de klikken vast te leggen en opnieuw te gebruiken als
verwĳzingspunten om relatieve waarden afstand, hoek, X, Y, Z of M vast te leggen. Meer details op Modus
Constructie.

• Parallel om een lĳn parallel aan een bestaande te tekenen (meer op Parallelle en loodrechte lĳnen)

• Loodrecht om een lĳn loodrecht op een bestaande te tekenen (meer op Parallelle en loodrechte lĳnen)

• Snappen naar algemene hoeken: wanneer u de cursor verplaatst, geeft dat een virtuele lĳn weer waaraan u kunt
snappen om het volgende punt toe te voegen. De lĳn voor snappen wordt gedefinieerd door het laatste
toegevoegde punt en een (absolute of relatieve naar het eerdere segment) hoek vanuit een voorkeuzelĳst (met
stappen van 5°, 10°, 15°, 18°, 22.5°, 30°, 45° of 90°). Kies Niet snappen naar veel voorkomende hoeken om
deze mogelĳkheid uit te schakelen.

• Zwevend schakelen: geeft een live voorbeeld van de coördinaten, direct naast de cursor, wat snel digitaliseren
mogelĳk maakt. Toegang tot de waarden is te verkrĳgen via de sneltoetsen van het paneel, bewerken en
Vergrendeld na validatie (drukken op Enter).
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• Gereedschappen voor constructie verschaft een aantal opties die de plaatsing van punten beperken, gebaseerd op
geëxtrapoleerde coördinaten van bestaande elementen:

– Uitbreiding lĳn: ga met de muis over een segment en u krĳgt een paars gestippelde lĳn die het segment
verlengt in het kaartvenster. U kunt het punt snappen overal op deze virtuele lĳn.

– X/Y-punt: ga met de muis over een punt en u krĳgt een paars gestippelde lĳn langs zĳn coördinaat X
of Y, in het kaartvenster. U kunt het punt snappen overal op deze virtuele lĳn. Het is zelfs mogelĳk om
over twee verschillende punten te gaan met de muis, virtuele lĳnen voor coördinaten maken voor beide,
en snappen aan hun kruising.

Onder de werkbalk zult u een aantal tekstvakken zien waarvan de waarde standaard de positie of verplaatsing in het
kaartvenster weergeeft. Bewerken van deze waarden helpt u de positie van de items die u bewerkt te beperken:

• d voor de afstand vanaf een verwĳzingspositie, gewoonlĳk het laatste bewerkte punt
• a voor de hoek (absoluut of relatief) vanaf een verwĳzingspositie, gewoonlĳk het laatste bewerkte punt
• x voor de coördinaat X van de aanwĳzer
• y voor de coördinaat Y van de aanwĳzer
• z voor de standaard waarde Z of het coördinaat Z van het punt of segment onder de aanwĳzer
• m voor de standaard waarde M of het coördinaat M van het punt of segment onder de aanwĳzer

Snelkoppelingen toetsenbord

Er zĳn een aantal snelkoppelingen voor het toetsenbord beschikbaar om de snelheid, bĳ het gebruiken van het paneel
Geavanceerd digitaliseren, te verhogen:

Tabel 16.5: Sneltoetsen voor het toetsenbord voor de gereedschappen van
het paneel Geavanceerd digitaliseren

Toets Eenvoudig Ctrl+ of Alt+ Shift+

D Afstand instellen Afstand vastzetten

A Hoek instellen Hoek vastzetten Relatieve hoek naar laatste segment schakelen
X X-coördinaat instellen X-coördinaat vastzetten Relatieve X naar laatste punt schakelen
Y Y-coördinaat instellen Y-coördinaat vastzetten Relatieve Y naar laatste punt schakelen
Z Z-coördinaat instellen Z-coördinaat vastzetten Relatieve Z naar laatste punt schakelen
M M-waarde instellen M-waarde vastzetten Relatieve M naar laatste punt schakelen
C Naar modus Constructie schakelen
P Tussen modi loodrecht en parallel schakelen

Notitie: Opties voor de Z-coördinaat en waarden M zĳn alleen beschikbaar als zĳ compatibel zĳn met de dimensie
van de geometrie van de laag.
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Digitaliseren met absolute verwijzing

Bĳ het tekenen van een geheel nieuwe geometrie is het bĳzonder handig om demogelĳkheid te hebben om te beginnen
met het digitaliseren van punten op opgegeven coördinaten.

Bĳvoorbeeld voor het toevoegen van een nieuw object aan een polygonenlaag, klik op de knop . U kunt de exacte
coördinaten invoeren voor waar u wilt beginnen met het bewerken van het object, d.i.:

1. Klik op het tekstvak X (of gebruik de sneltoets voor het toetsenbord X).

2. Typ de waarde voor de X-coördinaat die u wilt en druk op Enter of klik op de knop rechts daarvan om
de muis vast te zetten op de X-as van het kaartvenster.

3. Klik op het tekstvak Y (of gebruik de sneltoets voor het toetsenbord Y).

4. Typ de waarde voor de Y-coördinaat die u wilt en druk op Enter of klik op de knop rechts daarvan om
de muis vast te zetten op de Y-as van het kaartvenster.

5. Als de laag een coördinaat Z of waarden M heeft, wordt de corresponderende widget Z of M ingeschakeld en
geeft zĳn standaard waarde weer, zoals ingesteld op de tab Extra ► Opties ► Digitaliseren.
1. Klik op het tekstvak z of m (of gebruik de sneltoets voor het toetsenbord Z of M).

2. Typ de waarde die u wilt voor de coördinaat en druk op Enter of klik op de knop rechts daarvan
om de waarde vast te zetten in de widget.

Notitie: Lees Regels voor toewĳzen van coördinaat Z of waarde M voor details over hoe coördinaat Z en
waarden M automatisch worden bepaald uit bestaande objecten.

6. Twee blauwe gestippelde lĳnen en een groen kruis identificeren de exact coördinaten die u hebt ingevoerd.
Klik in het kaartvenster om een punt op de positie van het groene kruis toe te voegen.

Fig. 16.101: Begin met tekenen op de opgegeven coördinaten

7. U kunt doorgaan zoals hierboven, een nieuwe set coördinaten toevoegen voor het volgende punt, of schakelen
naar een andere modus voor digitaliseren (bĳv. segment, boog of stroom).

8. Als u een segment van een bepaalde lengte wilt tekenen:
1. Klik in het tekstvak d (afstand) (sneltoets toetsenbord D)
2. Typ de waarde voor de afstand (in kaarteenheden)
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3. Druk op Enter of klik op de knop aan de rechterkant om de muis vast te zetten in het kaartvenster
op de lengte van het segment. In het kaartvenster wordt het laatste punt omsloten door een cirkel waarvan
de straal de waarde is die is ingevoerd in het vak voor de afstand. Een kruis op de cirkel geeft de positie
van het volgende punt aan als u klikt.

Fig. 16.102: Segment met vaste lengte

9. U kunt ook de positie van het punt beperken, door het instellen van de hoek van het segment. Zoals eerder
beschreven:
1. Klik in het tekstvak a (hoek) (sneltoets toetsenbord A)
2. Typ de waarde voor de hoek (in graden)

3. Druk op Enter of klik op de knop aan de rechterkant om het vast te zetten. Een lĳn die door het
laatste punt gaat, en roteert gebaseerd op de ingevoerde hoek, verschĳnt in het kaartvenster en een kruis
erop geeft de positie van het volgende punt weer als u klikt.

Fig. 16.103: Segment met vaste hoek

Hint: Drukken op Ctrl+<key> of Alt+<key> zet automatisch de eigenschap voor het doel vast en plaats zĳn
waarde in modus Bewerken. Pas het aan, druk op Enter en u bent klaar. Gecombineerd met Zwevend schakelen kan
dit een echte besparing van tĳd zĳn, met digitaliseren met het toetsenbord.
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Digitaliseren met relatieve verwijzing

In plaats van absolute waarden of hoeken of coördinaten te gebruiken, kunt u ook waarden gebruiken die relatief zĳn
ten opzichte van het laatste gedigitaliseerde punt of segment.

Voor hoeken kunt u klikken op de knop links van het tekstvak a (of druk op Shift+A) om relatieve hoeken
naar het vorige segment te schakelen. Met die optie ingeschakeld worden hoeken gemeten tussen het laatste segment
en de aanwĳzer van de muis.

Voor coördinaten, klik op de knoppen aan de linkerkant van de tekstvakken x, y, z of m (of druk op
Shift+<key>) om relatieve coördinaten te schakelen naar het eerder punt. Met deze opties aan, zal het meten
van coördinaten er van uitgaan dat het laatste punt het origine is van de ingestelde coördinaten.

Doorlopend vastzetten

Zowel bĳ digitaliseren met absolute of relatieve verwĳzing, kunnen beperkingen voor hoek, afstand, X, Y, Z en
M doorlopend worden vastgezet door te klikken op de knoppen Doorlopende … vastzetten. Gebruiken van
doorlopend vastzetten stelt u in staat verscheidene punten met dezelfde beperkingen te digitaliseren.

Parallelle en loodrechte lijnen

Alle hierboven beschreven gereedschappen kunnen worden gecombineerd met de gereedschappen Loodrecht en
Parallel. Deze twee gereedschappen maken het mogelĳk segmenten perfect loodrecht of parallel te tekenen ten

opzichte van een ander segment. Het doelsegment kan een andere laag zĳn, een ander object op de laag of het object
dat wordt gedigitaliseerd (vereist de optie Zelf-snappen).
Een loodrecht segment tekenen:

1. Voeg eerst een van de punten van het segment toe.

2. Klik op het pictogram Loodrecht (sneltoets toetsenbord P) om het te activeren.
3. Klik op het segment waarvan u wilt dat het er loodrecht op komt.
4. Een virtuele gestippelde lĳn, loodrecht op het segment door het vorige punt, verschĳnt. De eigenschap voor de

hoek wordt vastgezet, wat het volgende punt op die lĳn beperkt en een kruis geeft de geprojecteerde positie
van de cursor op de lĳn weer. Klik om het nieuwe punt te plaatsen.

Fig. 16.104: Loodrecht digitaliseren
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Voor het tekenen van een parallel segment zĳn de stappen hetzelfde, behalve dat u moet klikken op het pictogram
Parallel (sneltoets toetsenbord P tweemaal).

Fig. 16.105: Parallel digitaliseren

Deze twee gereedschappen zoeken eenvoudigweg de juiste hoek voor loodrecht en de hoek voor parallel en zetten
deze parameter vast gedurende het bewerken door u. Maak de parameter voor de hoek los om het gebruik te annuleren
in het midden van het proces.

Modus Constructie

Ukunt de constructie-modus in- en uitschakelen door te klikken op het pictogram Constructie-modus ofmet de sneltoets
voor het toetsenbord C. Klikken in het kaartvenster, terwĳl u in Constructie-modus bent, zal geen nieuwe punten
toevoegen, maar zal de posities van de klikken vastleggen zodat u ze kunt gebruiken als verwĳzingspunten om dan
de relatieve waarden voor afstand, hoek of X, Y, Z, M vast te leggen.
Als voorbeeld kan de modus Constructie worden gebruikt om enkele punten te tekenen op een exacte afstand van een
bestaand punt.
Met een bestaand punt in het kaartvenster en de modus Snappen correct geactiveerd, kunt u eenvoudige andere punten
tekenen op opgegeven afstanden en hoeken van daaruit. In aanvulling op de knop moet u ook de constructie-modus

activeren door te klikken op het pictogram Constructie-modus of met de C sneltoets voor het toetsenbord.
Klik naast het punt van waaruit u de afstand wilt berekenen en klik op het vak D (sneltoets d) typ de gewenste afstand
in en druk op Enter om de positie van de muis in het kaartvenster vast te zetten:
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Fig. 16.106: Afstand vanaf punt

Druk, vóór het toevoegen van het nieuwe punt, op C om de modus Constructie te verlaten. Klik nu op het kaartvenster
en het punt zal op de ingevoerde afstand worden geplaatst.
U kunt ook de beperking voor de hoek gebruiken om, als voorbeeld, een ander punt te maken op dezelfde afstand
van het originele, maar onder een bepaalde hoek vanuit het nieuw toegevoegde punt. Klik op het pictogram
Constructie-modus of met de C sneltoets voor het toetsenbord om naar de Constructie-modus te gaan. Klik op het recent
toegevoegde punt, en dan op het andere om een richtingssegment in te stellen. Klik dan in het tekstvak d (sneltoets
D) typ de gewenste afstand en druk op Enter. Klik in het tekstvak a (sneltoets A) typ de hoek die u wilt en druk op
Enter. De positie van de muis zal worden vastgezet voor zowel afstand als hoek.

Fig. 16.107: Afstand en hoeken vanaf punten

Druk, vóór het toevoegen van het nieuwe punt, op C om de modus Constructie te verlaten. Klik nu op het kaartvenster
en het punt zal op de ingevoerde afstand en onder de ingevoerde hoek worden geplaatst. Door het proces te herhalen
kunnen verscheidene punten worden toegevoegd.
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Fig. 16.108: Punten op opgegeven afstand en hoek

16.3.8 De Processing Op-de-plaats aanpassen

Het menu Processing verschaft toegang tot een grote set gereedschappen om nieuwe objecten te analyseren en te
maken, gebaseerd op de eigenschappen van invoerobjecten of hun relaties met andere objecten (op dezelfde laag of
niet). Waar het normale gedrag is om nieuwe lagen als uitvoer te maken, staan sommige algoritmes ook aanpassingen
toe aan de invoerlaag. Dat is een handige manier om het aanpassen van meerdere objecten te automatiseren met
geavanceerde en complexe bewerkingen.
Objecten Op-de-plaats bewerken:

1. Selecteer de te bewerken laag in het paneel Lagen.
2. Selecteer de betreffende objecten. U kunt deze stap overslaan, in welk geval de aanpassingen zullen worden

toegepast op de gehele laag.

3. Druk op de knop Objecten op hun plaats bewerken boven in de Toolbox van Processing. De lĳst met algoritmes
wordt gefilterd en geeft alleen die weer, welke compatibel zĳn met op-de-plaats aanpassingen, d.i.:

• Zĳ werken op de bron van het object en niet op het niveau van de laag.
• Zĳ wĳzigen de structuur van de lagen niet, bĳv. velden toevoegen of verwĳderen.
• Zĳ wĳzigen niet het type geometrie, bĳv. van lĳn- naar puntlaag.
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Fig. 16.109: Algoritmes van Processing: alle (links) vs polygoon op-de-plaats bewerken (rechts)

4. Zoek het algoritme dat u wilt uitvoeren en dubbelklik er op.

Notitie: Als het algoritme geen aanvullende door de gebruiker ingestelde parameters nodig heeft (exclusief de
normale parameters voor de invoer- en uitvoerlaag), dan wordt het algoritme onmiddellĳk uitgevoerd, zonder
dat een dialoogvenster tevoorschĳn komt.

1. Als andere parameters dan de normale parameters voor de invoer- en uitvoerlaag nodig zĳn, wordt het
dialoogvenster van het algoritme weergegeven. Vul de vereiste informatie in.

2. Klik op Geselecteerde objecten aanpassen of op Alle objecten aanpassen, afhankelĳk van het feit of er een
actieve selectie is.

Wĳzigingen worden op de laag toegepast en in de buffer voor bewerken geplaatst: de laag wordt inderdaad
geschakeld naar de modus Bewerken met niet opgeslagen wĳzigingen zoals aangegeven door het pictogram
naast de naam van de laag.

5. Druk, zoals gewoonlĳk, op Wĳzigingen laag opslaan om de wĳzigingen door te voeren op de laag. U kunt ook
drukken op Ongedaan maken om alle wĳzigingen terug te draaien.
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Werken met rastergegevens

17.1 Dialoogvenster Laageigenschappen

Dubbelklik op de naam van een rasterlaag in de legenda of selecteer de laag en gebruik de rechtermuisknop en kies
Eigenschappen uit het contextmenu om de eigenschappen van een rasterlaag te bekĳken en in te stellen. Dit zal het
dialoogvenster Laageigenschappen voor de rasterlaag openen.
Het dialoogvenster bevat verschillende tabbladen:

Informatie Bron Symbologie[1]

Transparantie[1] Histogram[1] Renderen

Tĳdbeheer Hoogte Piramiden

Metadata Legenda QGIS Server
Externe plug-ins[2] tabs

[1] Ook beschikbaar in het paneel Laag opmaken
[2] Externe plug-ins die u installeert kunnen optioneel tabs toevoegen aan dit dialoogvenster. Deze worden niet
weergegeven in dit document. Bekĳk hun documentatie.

Tip: Live bĳwerken renderen
Het Paneel Laag opmaken verschaft u enkele algemene mogelĳkheden van het dialoogvenster Laageigenschappen en
is een goed modeless widget dat u kunt gebruiken om de configuratie van de stĳlen van de laag te versnellen en uw
wĳzigingen te bekĳken in het kaartvenster.

Notitie: Omdat eigenschappen (symbologie, label, acties, standaardwaarden, formulieren…) van ingebedde lagen
(zie Lagen inbedden vanuit externe projecten) uit het originele projectbestand worden opgehaald en om wĳzigingen
die dit gedrag zouden kunnen beschadigen te vermĳden, is het dialoogvenster Laageigenschappen voor deze lagen
niet beschikbaar gemaakt.
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17.1.1 Eigenschappen Informatie

De tab Informatie is alleen-lezen en is een interessante plek om snel wat overzichtsinformatie en metadata voor
de huidige laag op te pakken. Verschafte informatie is:

• algemeen, zoals naam in het project, pad van de bron, lĳst met aanvullende bestanden, laatste tĳd en grootte
van opslaan, de gebruikte provider

• gebaseerd op de provider van de laag: bereik, breedte en hoogte, type gegevens, stuurprogramma GDAL,
statistieken van banden

• het Coördinaten ReferentieSysteem: naam, eenheden, methode, nauwkeurigheid, verwĳzing (d.i. of het statisch
of dynamisch is)

• gelezen uit laageigenschappen: type gegevens, bereik, breedte/hoogte, compressie, pixelgrootte, statistieken van
banden, aantal kolommen, rĳen en waarden Geen gegevens van het raster…

• opgehaald uit de gevulde metadata: toegang, bereiken, links, contacten, geschiedenis…

17.1.2 Eigenschappen Bron

De tab Bron geeft basisinformatie weer over het geselecteerde raster, inclusief:
• de Laagnaam om weer te geven in het paneel Lagen;
• het Coördinaten ReferentieSysteem: Geeft het Coördinaten ReferentieSysteem (CRS) van de laag weer. U kunt
het CRS van de laag wĳzigen door een recent gebruikte te kiezen uit de keuzelĳst of te klikken op de knop

CRS selecteren (bekĳk Keuze Coördinaten ReferentieSysteem). Gebruik dit proces alleen als het op de laag
toegepaste CRS verkeerd is of als er geen werd gespecificeerd. Als u uw gegevens opnieuw wilt projecteren,
gebruik dan een algoritme voor opnieuw projecteren uit Processing of Sla het op als een nieuwe gegevensset.

Fig. 17.1: Raster Laageigenschappen - dialoogvenster Bron
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17.1.3 Eigenschappen Symbologie

De tab voor symbologie voor het raster bestaat uit drie gedeelten:
• Rendering van banden waar u het te gebruiken type renderer kunt beheren
• Renderen van lagen om effecten toe te passen op gerenderde gegevens
• Resamplen methoden om renderen op de kaart te optimaliseren

Enkelbands renderen

QGIS biedt vele verschillende Rendertypes. De keuze van de renderer is afhankelĳk van het type gegevens en de
informatie die u wilt accentueren.

1. Multiband kleur - als het bestand bestaat uit verscheidene banden (bĳv. een satellietafbeeldingmet verscheidene
banden).

2. Gepaletteerde/Unieke waarden - voor bestanden met één enkele band, die een geïndexeerd palet bevatten (bĳv.
een digitale topografische kaart) of voor paletten voor algemeen gebruik voor het renderen van rasterlagen.

3. Enkelbands grĳs - (één band van) de afbeelding zal grĳs worden gerenderd. QGIS zal deze renderer kiezen als
het bestand geen multiband is of niet is gepaletteerd (bĳv. een geschaduwde reliëfkaart).

4. Enkelbands pseudokleur - deze renderer kan worden gebruikt voor bestanden met een doorlopend palet of
kleurenkaart (bĳv. een hoogtekaart).

5. Schaduw voor heuvels - Maakt schaduw voor heuvels uit een band.
6. Contouren - Maakt direct contouren voor een bron rasterband.

Multiband kleur

Met de kleurenrenderer voor multiband zullen drie geselecteerde banden uit de afbeelding worden gebruikt als de
rode, groene of blauwe component van de kleurenafbeelding. QGIS haalt automatisch waardenMin enMax op voor
elke band van het raster en schaalt de kleuring overeenkomstig. U kunt de bereiken van waarden beheren in het
gedeelte Instellingen min- / max-waarden.
Een methode voor Contrastverbetering kan worden toegepast voor de waarden: ‘Geen verbetering’, ‘Stretch tot
MinMax’, ‘Stretch en clip tot MinMax’ of ‘Clip naar MinMax’.

Notitie: Contrastverbetering
Bĳ het toevoegen van rasters van GRASS zal de optie Contrastverbetering altĳd automatisch worden ingesteld op
Stretch tot MinMax, zelfs als dit is ingesteld op een andere waarde in de algemene opties van QGIS.
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Fig. 17.2: Raster symbologie - Multiband kleur renderen

Tip: Het bekĳken van een enkel- of multiband raster
Als u slechts één enkele band wilt bekĳken van een multiband-afbeelding (bĳvoorbeeld Rood), zou u misschien
denken dat u de banden Groen en Blauw zou moeten instellen op Niet bepaald. Maar de voorkeursmanier om dit te
doen is om het type afbeelding in te stellen op Enkelbands grĳs, en dan Rood te selecteren als de te gebruiken Grĳze
band.

Gepaletteerde/Unieke waarden

Dit is de standaardoptie voor renderen voor enkelbands-bestanden die een kleurtabel bevatten, waar een bepaalde
kleur is toegewezen aan elke pixelwaarde. In dat geval wordt het palet automatisch gerenderd.
Het kan worden gebruikt voor alle soorten rasterbanden, waarbĳ een kleur aan elke unieke rasterwaarde wordt
toegewezen.
Als u een kleur wilt wĳzigen, dubbelklik eenvoudigweg op de kleur en het dialoogvenster Kleur selecteren verschĳnt.
Het is ook mogelĳk labels toe te wĳzen aan de kleuren. Het label zal dan in de legenda van de rasterlaag verschĳnen.
Met rechts klikken op geselecteerde rĳen in de kleurentabel geeft een contextmenu weer om:

• Kleur wĳzigen… voor de selectie
• Transparantie wĳzigen… voor de selectie
• Label wĳzigen… voor de selectie
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Fig. 17.3: Raster symbologie - Gepaletteerd/Unieke waarden renderen

Het keuzemenu, dat opent bĳ het klikken op de knop … (Geavanceerde opties) onder de kleurenkaart rechts, biedt het
laden van een kleurenkaart (Kleurenkaart laden uit bestand…) en exporteren ervan (Kleurenkaart naar bestand
exporteren…), en het laden van klassen (Klassen uit laag laden).

Enkelbands grijs

Deze renderer stelt u in staat een laag te renderen met slechts één band met een Kleurovergang: ‘Zwart naar wit’
of ‘Wit naar zwart’. U kunt het bereik van waarden om te kleuren wĳzigen (Min en Max) in de Instellingen min- /
max-waarden.
Een methode voor Contrastverbetering kan worden toegepast voor de waarden: ‘Geen verbetering’, ‘Stretch tot
MinMax’, ‘Stretch en clip tot MinMax’ of ‘Clip naar MinMax’.
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Fig. 17.4: Raster symbologie - Enkelband grijs renderen

Pixels krĳgen een kleur toegewezen, gebaseerd op de geselecteerde kleurovergang en de legenda van de laag (in het
paneel Lagen en het lay-out item Legenda) wordt weergegeven met een doorlopend kleurverloop. Druk op Instellingen
legenda… als u de instellingen wilt aanpassen. Meer details op Legenda van raster aanpassen.

Enkelbands pseudokleur

Dit is een optie voor het renderen van bestanden met één band die een doorlopend palet bevatten. U kunt ook
kleurenkaarten maken voor een band van een multiband-raster.

Fig. 17.5: Raster symbologie - Enkelband pseudokleur renderen
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Door een Band van de laag en eenwaardenbereik te gebruiken, kunt u nu interpoleren en een weergavekleur toewĳzen
aan pixels binnen klassen. Meer op Classificatie kleurverloop schaduw.
Pixels krĳgen een kleur toegewezen, gebaseerd op het geselecteerde kleurverloop en de legenda van de laag (in het
paneel Lagen en het lay-out item Legenda) wordt weergegeven met een doorlopend kleurverloop. Druk op Instellingen
legenda… als u de instellingen wilt aanpassen, of gebruik een legenda met afzonderlĳke klassen (en kleuren). Meer
details op Legenda van raster aanpassen.

Schaduw voor heuvels

Een band van de rasterlaag renderen met schaduw voor heuvels.

Fig. 17.6: Raster symbologie - Schaduw voor heuvels renderen

Opties:
• Band: De te gebruiken rasterband.
• Altitude: De hoek van de hoogte van de lichtbron (standaard is 45°).
• Azimut: De azimut van de lichtbron (standaard is 315°).
• Factor Z: Schaalfactor voor de waarden van de rasterband (standaard is 1).

• Multidirectioneel: Specificeer of multidirectionele schaduw voor heuvels moet worden gebruikt (standaard
is uit).

Contouren

Deze renderer tekent contourlĳnen die direct worden berekend uit de bron rasterband.
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Fig. 17.7: Raster Symbologie - Renderer Contouren

Opties:
• Invoerband: de te gebruiken rasterband.
• Interval contour: de afstand tussen twee opeenvolgende contourlĳnen
• Symbool contour: het symbool om toe te passen op de gemeenschappelĳke contourlĳnen.
• Index interval contour: de afstand tussen twee opeenvolgende index-contouren, dat zĳn de lĳnen die op een
duidelĳke manier worden weergegeven om ze gemakkelĳker te kunnen identificeren, gewoonlĳk iets dikker
afgedrukt dan andere contourlĳnen en over het algemeen gelabeld met een waarde langs zĳn loop.

• Index symbool contour: het symbool om toe te passen op de index-contourlĳnen
• Invoer neerschalen: Geeft aan met hoeveel de renderer het verzoek zal afschalen naar de gegevensprovider.
(standaard is 4.0.
Als u bĳvoorbeeld contourlĳnen maakt op een invoer rasterblok met dezelfde grootte als het blok voor het
uitvoerraster, zouden de gemaakte lĳnen teveel detail bevatten. Deze detaillering kan worden verkleind door
de factor “neerschalen”, die een lagere resolutie vraagt voor het bronraster. Voor een rasterblok van 1000x500
met neerschalen 10, zal de renderer een raster van 100x50 vragen van de provider. Hoger neerschalen maakt
contourlĳnen meer eenvoudiger (ten koste van het verliezen van enig detail).
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Instellen van de minimale en maximale waarden

Standaard rapporteert QGIS de waarden Min en Max van de band(en) van het raster. Een aantal hele lage en/of hele
hoge waarden kunnen een negatieve invloed hebben op het renderen van het raster. Het frame Instellingen min- /
max-waarden helpt u het renderen te beheren.

Fig. 17.8: Raster symbologie - Instellingen min-/max-waarden

Beschikbare opties zĳn:

• Door gebruiker gedefinieerd: De standaardwaarden Min en Max van de band(en) kunnen worden
overschreven

• Cumulatieve telling deel: verwĳdert uitschieters. Het standaardbereik van waarden is 2% tot en met 98%,
maar het kan handmatig worden aangepast.

• Min / max: Gebruikt het gehele bereik van waarden in de band van de afbeelding.

• Gemiddelde +/- standaard afwĳking x: Maakt een kleurentabel die alleen waarden in overweging neemt
binnen de standaardafwĳking of binnen meerdere standaardafwĳkingen. Dit is nuttig wanneer u één of twee
cellen hebt met abnormaal hoge waarden in een rasterlaag, die een negatieve invloed hebben op het renderen
van het raster.

Berekeningen van de waarden min en max die voor de banden worden gemaakt zĳn gebaseerd op:
• Bereik statistieken: dat kan zĳn Gehele raster, Huidige kaartvenster of Bĳgewerkte kaartvenster. Bĳgewerkte

kaartvenster betekent dat waarden min/max die zĳn gebruikt voor het renderen zullen wĳzigen met het bereik
van het kaartvenster (dynamisch uitgerekt).

• Nauwkeurigheid, die kan zĳn Schatten (sneller) of Actueel (langzamer).

Notitie: Voor sommige instellingen dient u misschien te drukken op de knop Toepassen van het dialoogvenster
Laageigenschappen om de feitelĳke waarden voor de waarden Min en Max in de widgets weer te kunnen geven.
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Classificatie kleurverloop schaduw

Deze methode kan worden gebruikt om een scalaire gegevensset (raster of contouren van mazen) te classificeren en
weer te geven, gebaseerd op hun waarden. Gegeven een kleurverloop en een aantal klassen maakt het tussenliggende
items voor de kleurenkaart voor de grenzen van de klassen. Elke kleur wordt gemaakt met en waarde die is
geïnterpoleerd uit een waardebereik en overeenkomstig de modus van classificeren. De elementen van de scalaire
gegevensset krĳgen dan hun kleur toegewezen, gebaseerd op hun klasse.

Fig. 17.9: Classificeren van een gegevensset met en kleurverloop schaduw

1. De waarden Min en Max moeten worden gedefinieerd en worden gebruikt om de grenzen van de klassen te
interpoleren. Standaard detecteert QGIS ze uit de gegevensset, maar zĳ kunnen worden aangepast.

2. Het item Interpolatie definieert hoe scalaire elementen hun kleur krĳgen toegewezen:
• Afzonderlĳk (een symbool <= verschĳnt in de kop van de kolom Waarde): De kleur wordt genomen uit
het dichtstbĳzĳnde item van de kleurenkaart met een gelĳke of hogere waarde

• Lineair: De kleur wordt lineair geïnterpoleerd uit de items van de kleurenkaart boven en onder de
pixelwaarde, wat betekent dat elke waarde van de gegevensset correspondeert met een unieke kleur

• Exact (een symbool = verschĳnt in de kop van de kolom Waarde): Alleen op pixels met een waarde die
gelĳk is aan een item van de kleurenkaart wordt een kleur toegepast; andere worden niet gerenderd.

3. DewidgetKleurverloop helpt u het aan de gegevensset toe te wĳzen kleurverloop te selecteren. Zoals gewoonlĳk
met dit widget, kunt u een nieuwe maken en bewerken of het huidige geselecteerde opslaan. De naam van het
kleurverloop zal worden opgeslagen in de configuratie.

4. Het Label voor achtervoegsel eenheid voegt een label toe na de waarde in de legenda, en de Precisie label beheert
het aantal decimalen dat moet worden weergegeven.

5. De classificatie Modus helpt u te definiëren hoe waarden over de klassen worden verdeeld:
• Gelĳke interval: Met het opgegeven aantal Klassen worden grenzen van waarden gedefinieerd, zodat de
klassen allemaal dezelfde grootte hebben.
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• Doorgaand: Aantal en kleur van de klassen worden opgehaald uit de stappen van het kleurverloop;
grenswaarden worden ingesteld naar aanleiding van de verdeling van de stops in het kleurverloop.

• Kwantielen: Met het aantal Klassen worden grenswaarden gedefinieerd, zodat de klassen hetzelfde aantal
elementen hebben. Niet beschikbaar voor lagen met mazen.

6. U kunt dan Classificeren of de klassen aanpassen:

• De knop Voeg handmatig waarden in voegt een waarde aan de tabel toe.

• De knop Geselecteerde rĳ(en) verwĳderen verwĳdert geselecteerde waarden uit de tabel.
• Dubbelklikken in de kolomWaarde laat u de waarde van de klasse aanpassen.
• Dubbelklikken in de kolom Kleur opent het dialoogvenster Kleur selecteren, waar u een kleur kunt
selecteren om toe te passen op die waarde.

• Dubbelklikken in de kolom Label om het label van de klasse aan te passen, maar deze waarde zal niet
worden weergegeven als u het gereedschap Objecten identificeren gebruikt.

• Met rechts klikken op geselecteerde rĳen in de kleurentabel geeft een contextmenu weer om Kleur
wĳzigen… en Opaciteit wĳzigen…. voor de selectie.

U kunt de knoppen Kleurenkaart uit bestand laden of Kleurenkaart naar bestand exporteren gebruiken om een bestaande
kleurentabel te laden of om de kleurentabel op te slaan voor later gebruik.

7. Met lineaire Interpolatie kunt u ook configureren:

• Clip buiten bereik van waarden: Standaard wĳst de methode Lineair de kleur van de eerste klasse
(respectievelĳk de laatste klasse) toe aan waarden in de gegevensset die kleiner zĳn dan de ingestelde
waarde Min (respectievelĳk groter dan het ingestelde Max). Selecteer deze instelling als u deze waarden
niet wilt renderen.

• Instellingen Legenda voor het weergeven in het paneel Lagen en het lay-out item Legenda. Meer details
op Legenda van raster aanpassen.

Legenda van raster aanpassen

Bĳ het toepassen van een kleurverloop op een raster of een laag met mazen wilt u misschien een legenda weergeven
die de classificatie weergeeft. Standaard geeft QGIS een doorlopend kleurverloop met waarden min en max in het
paneel Lagen en het lay-out item Legenda. Dit kan worden aangepast met de knop Instellingen legenda in de widget
voor classificeren.
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Fig. 17.10: Legenda van raster wijzigen

In dit dialoogvenster kunt u Doorlopende legenda gebruiken selecteren: indien niet geselecteerd geeft de legenda
afzonderlĳke kleuren weer, corresponderend met de verschillende toegepaste klassen. Deze optie is niet beschikbaar
voor symbologie van rasters enkelbands grĳs.
Selecteren van Doorlopende legenda gebruiken maakt het voor u mogelĳk om zowel de labels als de eigenschappen
voor de opmaak van de legenda te configureren.
Labels

• Voeg een Voorvoegsel en een Achtervoegsel toe aan de labels
• Aanpassen van de waarden Minimum en Maximum die worden weergegeven in de legenda
• Aanpassen van de Getalindeling

• Aanpassen van de Tekstindeling die wordt gebruikt in de legenda van de afdruklay-out.
Lay-out

• Beheer de Oriëntatie van het kleurverloop van de legenda; het kan zĳn Verticaal of Horizontaal
• Beheer de Richting van de waarden, afhankelĳk van de oriëntatie:

– Indien verticaal kunt u hetMaximum bovenaan of hetMinimum bovenaan weergeven
– Indien horizontaal kunt u hetMaximum rechts of hetMinimum rechts weergeven

Renderen van lagen

Voor het type symbologie dat is toegepast op de band(en van de laag kunt u speciale effecten voor renderen bereiken
voor het/de gehele rasterbestand(en):

• Gebruik een van de Meng-modi (bekĳk Meng-modi)
• Aangepaste Helderheid, Saturatie, Gamma en Contrast voor kleuren instellen.

• Met Draai kleuren om wordt de laag gerenderd met tegenovergestelde kleuren. Bĳvoorbeeld handig om
out-of-the box OpenStreetMap-tegels te schakelen naar donkere modus.

• De laag schakelen naar optie Grĳstinten, ofwel ‘Lichtsterkte van’, ‘Helderheid van’ of ‘Gemiddelde van’.
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• Inkleuren en pas de Sterkte van Kleurnuance aan in de kleurentabel
Druk op Terug naar beginwaarden om elke aangepaste wĳziging voor het renderen van lagen te verwĳderen.

Fig. 17.11: Raster symbologie - Instellingen voor Renderen van lagen en Hersamplen

Hersamplen

De optie Hersamplen heeft effect als u op een afbeelding in- en uitzoomt. Modi voor Hersamplen kunnen het
uiterlĳk van de kaart optimaliseren. Ze berekenen een nieuwe matrix voor grĳze waarden middels een geometrische
transformatie.
Bĳ het toepassen van de methode ‘Nearest neighbour’ kan de kaart een gepixelde structuur krĳgen bĳ het inzoomen.
Dit uiterlĳk kan worden verbeterd door de methoden ‘Bilineair’ of ‘Kubisch’ te gebruiken, die er voor zorgen dat
scherpe randen worden vertroebeld. Het effect is een vlakkere afbeelding. Deze methode kan bĳvoorbeeld worden
toegepast op digitale topografische rasterkaarten.

Vroeg hersamplen: maakt het mogelĳk het renderen van de raster te berekenen op het niveau van de provider
waarbĳ de resolutie van de bron bekend is, en zorgt voor een beter renderen bĳ inzoomen met aangepaste opmaak
voor QGIS. Echt handig voor tegelrasters die worden geladen met een interpretatie methode.

17.1.4 Eigenschappen voor transparantie

QGIS verschaft mogelĳkheden om het niveau voor transparantie voor een rasterlaag in te stellen.
Gebruik de schuifbalk Globale opaciteit om in te stellen tot welk bereik de onderliggende lagen (indien gekozen)
zichtbaar zou moeten zĳn door de huidige rasterlaag. Dit is bĳzonder nuttig als u rasterlagen overlegt (bĳv. een
reliëfkaart met schaduwen die wordt overgelegd met een geclassificeerde rasterkaart). Dit zal de kaart er meer
driedimensionaal uit laten zien. De opaciteit van het raster mag data-bepaald zĳn, en variëren, bĳv. afhankelĳk van
de zichtbaarheid van een andere laag, door variabelen van Tĳdbeheer, op verschillende pagina’s van een atlas, …
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Fig. 17.12: Transparantie raster

Met Waarde voor ‘geen data’ rapporteert QGIS de originele bronwaarde Geen gegevens (indien gedefinieerd) die
u kunt beschouwen zoals die is in het renderen. Aanvullend kunt u een rasterwaarde invullen die zou moeten worden
behandeld als een Extra waarde ‘geen data’. Het selecteren van een kleur voor Geen gegevens weergeven alsmaakt het
voor u mogelĳk een aangepaste kleur toe te passen op pixels Geen gegevens, in plaats van het standaard transparant
renderen.
Een nog meer flexibele manier om de transparantie aan te passen is beschikbaar in het gedeelte Aangepaste opties
voor transparantie:

• Gebruik Transparantieband om transparantie voor een gehele band toe te passen.
• Geef een lĳst van pixels op om transparantie te maken met het corresponderende niveau van transparantie:

1. Klik op Voeg handmatig waarden toe. Een nieuwe rĳ zal worden toegevoegd aan de pixellĳst voor
Transparantie.

2. Voer de waarden Rood, Groen en Blauw voor de pixel in en pas het toe te passen Percentage
transparantie aan.

3. Als alternatief kunt u de pixelwaarden direct ophalen uit het raster met de knop
Waarden uit weergave toevoegen. Voer dan de waarde voor de transparantie in.

4. Herhaal de stappen om meer waarden met een aangepaste transparantie te wĳzigen.
5. Druk op de knop Toepassen en controleer het resultaat op de kaart.

Het is eenvoudig om een aangepaste transparantie op te zetten, maar dit is aardig wat werk. De knop
Naar bestand exporteren geeft dan ook de mogelĳkheid om de pixellĳst voor Transparantie op te slaan naar een
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bestand. De knop Uit bestand importeren laadt de lĳst van de transparantie weer en past die toe op de huidige
rasterlaag.

17.1.5 Eigenschappen Histogram

De tab Histogram stelt u in staat om de verdeling van de waarden in uw raster te bekĳken. Het histogram wordt
gemaakt als als u drukt op de knop Histogram berekenen. Alle bestaande banden zullen samen worden weergegeven.
U kunt het histogram opslaan als een afbeelding met de knop .
Aan de onderzĳde van het histogram kunt u een rasterband uit het keuzemenu selecteren en deMin/max stĳl instellen

er voor instellen. Het keuzemenu Voorkeuren/Acties geeft u gevorderde opties om het histogram aan te passen:

• Met de optie Zichtbaarheid kunt u histogrammen weergeven voor individuele banden. U dient de optie
Toon geselecteerde band te selecteren.

• DeMin/Max-opties stellen u in staat te kiezen voor ‘Altĳd min/max-symbolen tonen’, ‘Naar min/max zoomen’
en ‘Update stĳl naar min/max’.

• De optie Acties stelt u in staat ‘Terug naar beginwaarden’ te gaan of ‘Histogram herberekenen’ nadat u de
waarden min of max van de band(en) hebt gewĳzigd.
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Fig. 17.13: Raster Histogram

17.1.6 Eigenschappen Renderen

Op de tab Renderen is het mogelĳk om:
• Schaalafhankelĳke zichtbaarheid in te stellen voor de laag: U kunt de schaalMaximum (inclusief) enMinimum

(exclusief) instellen, wat een bereik van schalen definieert waarin de laag zichtbaar zal zĳn. Buiten dit bereik
is hĳ verborgen. De knop Op huidige schaal kaartvenster instellen helpt u de schaal van het huidige kaartvenster te
gebruiken als grens voor de zichtbaarheid van het bereik. Bekĳk Schaal zichtbaarheid selecteren voor meer
informatie.

Notitie: U kunt het schaalafhankelĳk renderen ook activeren op een laag vanuit het paneel Lagen. Klik met
rechts op de laag en selecteer in het contextmenu, Zichtbaarheidsschaal laag instellen.

• Laag bĳwerken met interval (seconden): een tĳd instellen om individuele lagen automatisch te vernieuwen.
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Bĳwerken van het kaartvenster wordt uitgesteld om veelvuldig vernieuwen te vermĳden indien meer dan één
laag een interval heeft ingesteld voor automatisch bĳwerken.

Fig. 17.14: Raster Eigenschappen Renderen

17.1.7 Eigenschappen Tijdbeheer

De tab Tĳdbeheer verschaft opties om het renderen van de laag in de tĳd te beheren. Dergelĳk dynamisch renderen
vereist dat de Navigatie voor Tĳdbeheer is ingeschakeld in het kaartvenster.
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Fig. 17.15: Raster Eigenschappen Tijdbeheer

Selecteer de optie Dynamisch Tĳdbeheer en stel in of het opnieuw tekenen van de laag zou moeten zĳn:
• Automatisch: het renderen wordt beheerd door de onderliggende gegevensprovider als die het behandelen van
gegevens met Tĳdbeheer ondersteunt. Dit kan bĳvoorbeeld worden gebruikt met WMS-T-lagen of PostGIS-
rasters.

• Vast tĳdbereik: geeft de rasterlaag alleen weer als de tĳd voor de animatie binnen het bereik van Startdatum en
Einddatum ligt

• Alleen laag opnieuw tekenen: de laag wordt opnieuw getekend bĳ elke nieuw frame voor de animatie. Het is
nuttig als de laag waarden van expressies gebruikt, die zĳn gebaseerd op tĳd, voor instellingen van renderen
(bĳv. data-bepaalde opaciteit voor de renderer, om in of uit te vervagen op een rasterlaag).

17.1.8 Eigenschappen Hoogte

De tab Hoogte verschaft opties om de eigenschappen voor hoogte van de laag te beheren in een 3D-kaartweergave
en het uiterlĳk in de diagrammen van het profiel. Specifiek kunt u instellen:

660 Hoofdstuk 17. Werken met rastergegevens



QGIS Desktop 3.28 User Guide

Fig. 17.16: Eigenschappen rasterhoogte

• Geeft oppervlakte hoogte weer: of de rasterlaag een oppervlak voor hoogte weergeeft (bĳv. DEM) en de
pixelwaarden zouden moeten worden geïnterpreteerd als hoogtes. Selecteer deze optie als u een raster in een
weergave van het hoogteprofiel wilt weergeven. U zult de Band moeten invullen om waarden op te halen en
kunt een Schaal-factor toepassen en een Verschuiving.

• Uiterlĳk diagram profiel: beheert het renderen Stĳl die de hoogte van de raster zal gebruiken bĳ het tekenen
van een diagram van het profiel. Het kan worden ingesteld als:

– een profiel Lĳn met een toegepaste lĳnstĳl
– een oppervlak met Vullen onder en een corresponderende stĳl voor vulling

17.1.9 Eigenschappen Piramiden

Rasterlagen met hoge resolutie zouden traag kunnen navigeren in QGIS. Door kopieën van de gegevens te maken
met lagere resoluties (piramiden), kan de uitvoering aanzienlĳk worden verbeterd, omdat QGIS de meest geschikte
te gebruiken resolutie selecteert, afhankelĳk van het zoomniveau.
U moet schrĳfrechten hebben voor de map waarin de originele rastergegevens zĳn opgeslagen om piramiden te
bouwen.
Selecteer, vanuit de lĳst Resoluties, resoluties waarop u niveaus van piramiden wilt maken door er op te klikken.
Indien u ‘Intern (indien mogelĳk)’ kiest uit het keuzemenu Overzichtsindeling, probeert QGIS intern piramiden te
bouwen.

Notitie: Onthoud dat het bouwen van piramiden het originele gegevensbestand zou kunnen wĳzigen, en als zĳ
eenmaal zĳn gemaakt, kunnen zĳ niet worden verwĳderd. Als u een versie ‘zonder piramiden’ wilt behouden, maak
dan een back-upkopie, voorafgaand aan het bouwen van de piramiden.

Indien u kiest voor Extern en Extern (Erdas Imagine) zullen de piramiden worden gemaakt in een bestand naast
het originele raster met dezelfde naam en de extensie .ovr.
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Verscheidene Hersampling methode kunnen voor het berekenen van piramiden worden gebruikt:
• ‘Dichtstbĳzĳnde buur’
• Gemiddelde
• Gauss
• Kubisch
• Kubische spline
• Laczos
• Modus
• Geen

Klik tenslotte op Piramiden bouwen om het proces te starten.

Fig. 17.17: Raster Piramiden

17.1.10 Eigenschappen Metadata

De tab Metadata verschaft u opties om een rapport met metadata voor uw laag te maken en te bewerken. Bekĳk
Metadata voor meer informatie.
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Fig. 17.18: Raster Metadata

17.1.11 Eigenschappen Legenda

De tab Legenda verschaft u geavanceerde instellingen voor het paneel Lagen en/of de legenda voor afdruklay-out.
Deze opties omvatten:

• Afhankelĳk van de op de laag toegepaste symbologie, zou u kunnen eindigen met verscheidene items in de
legenda, niet noodzakelĳkerwĳze leesbaar/nuttig om weer te geven. De Plaatsvervangende afbeelding legenda
helpt u een afbeelding selecteren voor vervanging daarvan, weergegeven zowel in het paneel Lagen als in de
legenda van de afdruklay-out.

• Ingebedde widgets in legenda verschaft u een lĳst met widgets die u in de boom van lagen in het paneel
Lagen kunt inbedden. Het idee erachter is om een manier te hebben om snel toegang te krĳgen tot acties die
vaak op de laag worden gebruikt (instellen van de transparantie, filteren, selectie, stĳl of andere dingen…).
Standaard verschaft QGIS de widget voor transparantie, maar dit kan worden uitgebreid door plug-ins die hun
eigen widgets registreren en aangepaste acties toewĳzen aan de lagen die zĳ beheren.
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Fig. 17.19: Raster Legenda

17.1.12 Eigenschappen QGIS Server

De tab QGIS Server helpt u instellingen configureren van de gegevens indien gepubliceerd door QGIS Server. De
configuratie betreft:

• Omschrĳving: verschaft informatie om de gegevens te beschrĳven, zoals Korte naam, Titel, Samenvatting,
een Sleutelwoordenlĳst, en Gegevens URL waarvan het Type mag zĳn text/html, text/plain of
application/pdf.

• Naamsvermelding: een Titel en URL om te identificeren wie de gegevens verschaft
• Metadata URL: een lĳst van URL voor de metadata die kan zĳn van het Type FGDC of TC211, en in Indeling
text/plain of text/xml

• Legenda URL: een URL voor de legenda, in ofwel Indeling image/png of image/jpeg

Notitie: Wanneer de rasterlaag die u wilt publiceren al wordt verschaft door een webservice, zĳn verdere
eigenschappen beschikbaar om in te stellen.
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Fig. 17.20: QGIS Server in Laageigenschappen

17.2 Rasteranalyse

17.2.1 Rasterberekeningen

Rasterberekeningen, in het menu Raster, stelt u in staat berekeningen uit te voeren op basis van bestaande raster
pixelwaarden (zie Fig. 17.21). De resultaten worden weggeschreven naar een nieuw raster, in een indeling die wordt
ondersteund door GDAL.
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Fig. 17.21: Rasterberekeningen

De lĳst Rasterbanden bevat alle geladen rasterlagen die kunnen worden gebruikt. Dubbelklik, om een raster aan het
expressieveld van Rasterberekeningen toe te voegen, op de naam in de lĳst Velden. U kunt de operatoren gebruiken
om expressies voor berekeningen te construeren, of u kunt ze eenvoudigweg in het vak typen.
In het gedeelte Resultaatlaag moet u een uitvoerlaag definiëren. U kunt:

• Direct raster maken in plaats van de laag naar schĳf te schrĳven:
– Indien niet geselecteerd wordt de uitvoer opgeslagen op schĳf als een nieuw gewoon bestand. Een pad
voor Uitvoerlaag en een Indeling uitvoer zĳn vereist.

– Indien geselecteerd wordt een virtuele rasterlaag, d.i. een rasterlaag die wordt gedefinieerd door zĳn URI
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en waarvan de pixels direct worden berekend, gemaakt. Het is geen nieuw bestand op schĳf; de virtuele
laag is nog steeds verbonden met de rasters die zĳn gebruikt voor de berekeningen, wat betekent dat het
verwĳderen of verplaatsen van deze rasters het zouden verbreken. Een Laagnaam kan worden opgegeven,
anders wordt de expressie voor de berekening als zodanig gebruikt. Verwĳderen van de virtuele laag uit
het project verwĳdert het, en het kan persistent als bestand worden gemaakt door het contextmenu van
de laag Exporteren ► Opslaan als… te gebruiken.

• Definieer het Ruimtelĳk bereik van de berekening, gebaseerd op een bereik van een invoer rasterlaag, of op
aangepaste coördinaten X,Y

• Stel de Resolutie voor de laag in met kolom- en rĳnummer. Als de invoerlaag een andere resolutie heeft, zullen
de waarden worden geresampled met het algoritme Nearest neighbor.

• Met het keuzevak Voeg resultaat toe aan project,zal de resultaatlaag automatisch worden toegevoegd aan
het gebied van de Legenda en kan worden gevisualiseerd. Standaard geselecteerd voor virtuele rasters.

Het gedeelte Operatoren bevat alle beschikbare operatoren. Klik, om een operator toe te voegen aan het expressievak
van Rasterberekeningen, op de toepasselĳk knop. Rekenkundige berekeningen (+, -, *, … ) en trigonometrische
functies (sin, cos, tan, … ) zĳn beschikbaar. Voorwaardelĳke expressies (=, !=, <, >=, … ) geven ofwel 0 voor
false of 1 voor true terug, en kunnen daarom worden gebruikt met andere operatoren en functies.

Hint: Bekĳk ook het algoritme Raster calculator.

Voorbeelden

Hoogtewaarden van meter naar voet omzetten
Voor het omzetten van een hoogteraster van meters naar voet kunt u de omrekeningsfactor 3.28 gebruiken. De
expressie is:

"elevation@1" * 3.28

Een uitknipmasker gebruiken
Wanneer u van een hoogterasterkaart dat deel wilt uitknippen dat boven 0 meter hoogte ligt – kunt u de volgende
expressie gebruiken om in één keer een uitknipmasker te maken en het resultaat weg te schrĳven naar een nieuwe
rasterkaart.

("elevation@1" >= 0) * "elevation@1"

Met andere woorden: voor elke cel met een waarde groter dan of gelĳk aan 0 evalueert de voorwaardelĳke expressie
tot 1, wat de originele waarde behoudt door die te vermenigvuldigen met 1. Anders evalueert de voorwaardelĳke
expressie tot 0, wat de rasterwaarde instelt op 0. Dit maakt direct het uitknipmasker.
Een raster classificeren
Als u een raster wilt classificeren – bĳvoorbeeld in twee hoogteklassen, kunt u de volgende expressie gebruiken om,
in één stap, een raster te maken met twee waarden 1 en 2.

("elevation@1" < 50) * 1 + ("elevation@1" >= 50) * 2

Met andere woorden: voor elke cel kleiner dan 50 wordt zĳn waarde ingesteld op 1. Voor elke cel groter dan of gelĳk
aan 50 wordt de waarde ingesteld op 2.
Of u kunt de operator IF gebruiken.

if ( elevation@1 < 50 , 1 , 2 )
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17.2.2 Raster uitlijnen

Dit gereedschap is in staat om meerdere rasters als invoer te gebruiken en ze perfect uit te lĳnen, wat betekent:
• opnieuw projecteren naar hetzelfde CRS,
• opnieuw samplen naar dezelfde celgrootte en verschuiving in het raster,
• een interessegebied te clippen,
• waarden, indien nodig, opnieuw op schaal brengen.

Alle rasters zullen worden opgeslagen in andere bestanden.

Open eerst de gereedschappen via Raster ► Rasters uitlĳnen… en klik op de knop Nieuw raster toevoegen om een
bestaand raster in QGIS te selecteren. Selecteer een uitvoerbestand om het raster na het uitlĳnen op te slaan, de
methode voor opnieuw samplen en of de gereedschappenWaarden opnieuw schalen naar celgroottemoeten uitvoeren.
De methode voor resamplen kan zĳn (zie Fig. 17.22):

• Nearest Neighbor
• Bilineair (2x2 kernel)
• Kubisch (4x4 kernel): Kubische convolutie benadering
• Kubisch B-Spline (4x4 kernel): Kubische B-Spline benadering
• Lanczos (6x6 kernel): Lanczos windowed sinc interpolatie
• Gemiddelde: berekent het gemiddelde van alle bĳdragende niet-NODATA pixels
• Modus: selecteert de waarde die het meest voorkomt van alle monsterpunten
• Maximum,Minimum,Mediaan, Eerste kwartiel (Q1) of Derde kwartiel (Q3) van alle bĳdragende niet-
NODATA pixels

Fig. 17.22: Opties voor resamplen van raster selecteren

In het hoofddialoogvenster Raster uitlĳnen kunt u nog steeds Bestandsinstellingen bewerken of Bestaand bestand verwĳderen

uit de lĳst met rasterlagen. U kunt ook een of meer andere opties kiezen (zie Fig. 17.23):
• De Referentielaag selecteren,
• Naar een nieuw CRS transformeren,
• Een andere Celgrootte instellen,
• Een andere Ruitennetverspringing instellen,
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• Tot bereik clippen: kan gebruikergedefinieerd zĳn of gebonden aan een laag of aan het kaartvenster
• Uitvoergrootte

• Uitgelĳnde rasters toevoegen aan kaartvenster.

Fig. 17.23: Raster uitlijnen

17.3 Georeferencer

De Georeferencer is een programma voor het genereren van wereldbestanden voor lagen. Het stelt u in staat om
rasters of vectors te laten verwĳzen naar geografische of geprojecteerde coördinatensystemen door het maken van
een nieuwe GeoTiff of door een wereldbestand toe te voegen aan de bestaande afbeelding. De basis benadering voor
geoverwĳzingen in een laag is door er punten op te lokaliseren waarvoor u accurate coördinaten kunt bepalen.
Mogelĳkheden
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Pictogram Doel Pictogram Doel

Raster openen Vector openen

Geoverwĳzingen starten

GDAL-script genereren GCP-punten laden

GCP-punten opslaan als Instellingen voor transformatie

Punt toevoegen Punt verwĳderen

GCP-punt verplaatsen Schuiven

Inzoomen Uitzoomen

Zoomen naar laag Zoomen naar laatste

Zoomen naar volgende Georeferencer linken aan QGIS

QGIS linken aan Georeferencer Volledige histogram stretch

Lokale histogram stretch

Tabel Georeferencer: Gereedschap voor Georeferencer

17.3.1 Normale procedure

Omdat X- en Y-coördinaten (DMS (dd mm ss.ss), DD (dd.dd) of geprojecteerde coördinaten (mmmm.mm)), die
overeenkomen met het geselecteerde punt in de afbeelding, bekend zĳn, kunnen twee alternatieve procedures worden
gebruikt:

• Het raster zelf verschaft soms kruisingen van coördinaten die zĳn “geschreven” op de afbeelding. In dat geval
kunt u de coördinaten handmatig invoeren.

• Lagen gebruiken die al zĳn voorzien van geoverwĳzingen. Dit kunnen ófwel vector- of rastergegevens zĳn die
dezelfde objecten/mogelĳkheden bevatten die u op de afbeelding hebt die u wilt voorzien van geoverwĳzingen
en met de door u gewenste projectie voor uw afbeelding. In dat geval kunt u de coördinaten invoeren door te
klikken op de geladen gegevensset voor de verwĳzingen die is geladen in het kaartvenster van QGIS.

De normale procedure voor geoverwĳzingen in een afbeelding omvat het selecteren vanmeerdere punten op het raster,
hun coördinaten specificeren en het kiezen van een relevant type transformatie. Gebaseerd op de parameters voor de
invoer en de gegevens, zal Georeferencer de parameters voor het wereldbestand berekenen. Hoe meer coördinaten u
opgeeft, hoe beter het resultaat zal zĳn.

De eerste stap is om QGIS te starten en klik dan op Kaartlagen ► Georeferencer, dat verschĳnt in de menubalk
van QGIS. Het dialoogvenster van Georeferencer verschĳnt, zoals weergegeven in Fig. 17.24.
Voor dit voorbeeld gebruiken we een topografieblad van South Dakota van SDGS. Het kan later samen met de
gegevens uit het bestand spearfish60 in de locatie van GRASS worden gevisualiseerd. U kunt het topografieblad
hier downloaden: https://grass.osgeo.org/sampledata/spearfish_toposheet.tar.gz.

670 Hoofdstuk 17. Werken met rastergegevens

https://grass.osgeo.org/sampledata/spearfish_toposheet.tar.gz


QGIS Desktop 3.28 User Guide

Fig. 17.24: Dialoogvenster Georeferencer

Grond ControlePunten (GCP’s) invoeren

1. We moeten een rasterafbeelding laden met behulp van de knop om te beginnen met geoverwĳzingen
voor een rasterafbeelding zonder geoverwĳzingen. Het raster zal worden weergegeven in het hoofd-
bewerkingsgebied van het dialoogvenster. Als de rasterafbeelding eenmaal is geladen kunnen we beginnen
met de punten voor de verwĳzingen.

2. Met de knop Punt toevoegen punten toevoegen aan het hoofdwerkgebied en hun coördinaten invoeren (bekĳk
afbeelding Fig. 17.25). Voor deze procedure heeft u de volgende opties:

• Klik op een punt in de rasterafbeelding en voer de X- en Y-coördinaten handmatig in, naast het CRS
voor het punt.

• Klik op een punt in de rasterafbeelding en kies de knop Van kaartvenster om de X- en Y-coördinaten toe
te voegen met hulp van een kaart met geoverwĳzingen die al is geopend in het kaartvenster van QGIS.
Het CRS zal automatisch worden ingesteld.

3. Ga door met het invoeren van punten. U zou minstens vier punten moeten hebben en hoe meer coördinaten
u kunt opgeven, hoe beter het resultaat zal zĳn. Er zĳn aanvullende gereedschappen om naar het
bewerkingsgebied te zoomen en te verschuiven, om een relevante verzameling GCP-punten te lokaliseren.

4. Met het gereedschap kunt u de GCP’s verplaatsen, zowel in het kaartvenster als in het venster voor de
geo-verwĳzingen, indien u ze moet corrigeren.
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Fig. 17.25: Punten toevoegen aan de rasterafbeelding

De punten die worden toegevoegd aan de kaart zullen worden opgeslagen in een afzonderlĳk tekstbestand
([filename].points) gewoonlĳk samen met de rasterafbeelding. Dit stelt ons in staat om later Georeferencer
opnieuw te openen en nieuwe punten toe te voegen of bestaande te verwĳderen om het resultaat te optimaliseren. Het
bestand points bevat waarden in de vorm: kaartX, kaartY, pixelX, pixelY. U kunt de knoppen
GCP-punten laden en GCP-punten opslaan als gebruiken om de bestanden te beheren.

Definiëren van de instellingen voor de transformatie

Nadat u uwGCP’s heeft toegevoegd aan de rasterafbeelding dient u de instellingen voor de transformatie te definiëren
voor het proces van de geoverwĳzingen.

Fig. 17.26: Definiëren van de instellingen voor de transformatie van geoverwijzingen
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Beschikbare algoritmes voor transformaties

Een aantal algoritmes voor transformatie zĳn beschikbaar, afhankelĳk van de kwaliteit van de ingevoerde gegevens,
de soort en de hoeveelheid geometrische vervorming die u toe wilt staan in het uiteindelĳke resultaat, en het aantal
grondcontrolepunten (GCP’s).
Momenteel zĳn de volgende Transformatie types beschikbaar:

• Het algoritme Lineair wordt gebruikt om een world file te maken en is afwĳkend van de andere algoritmes,
omdat het actueel niet de rasterpixels transformeert. Het staat positioneren (vertalen) van de afbeelding en
uniform op schaal brengen toe, maar geen draaien of andere transformaties. Het is het meest geschikte
als uw afbeelding een goede kwaliteit rasterkaart is, in een bekend CRS, maar slechts de informatie voor
geoverwĳzingen mist. Tenminste 2 GCP’s zĳn nodig.

• De transformatieHelmert staat ook draaien toe. Het is in het bĳzonder nuttig als uw raster een goede kwaliteit
lokale kaart of ortho-gerectificeerde luchtfoto is, maar niet niet is uitgelĳnd op de rasterrichting in uw CRS.
Tenminste 2 GCP’s zĳn nodig.

• Het algoritme Polynomial 1 staat een meer algemene affiene transformatie toe, in het bĳzonder ook uniform
scheef trekken. Rechte lĳnen blĳven recht (d.i. collineaire punten blĳven collineair) en parallelle lĳnen blĳven
parallel. Dit is in het bĳzonder nuttig bĳ het geoverwĳzen van cartogrammen met gegevens, die geplot (of
verzamelde gegevens) zĳn met verschillende grootten voor grondpixels in verschillende richtingen. Tenminste
3 GCP’s zĳn vereist.

• De algoritmes Polynomial 2-3 gebruiken meer algemene 2e- of 3e-graads polynomialen in plaats van
slechts affiene transformatie. Dit maakt het voor hen mogelĳk rekening te houden met de buiging of andere
systematische vervorming van de afbeelding, bĳvoorbeeld gefotografeerde kaarten met gebogen randen.
Tenminste 6 (respectievelĳk 10) GCP’s zĳn vereist. Hoeken en lokale schaal worden niet behouden of uniform
worden behandeld in de gehele afbeelding. In het bĳzonder zouden rechte lĳnen gebogen kunnen worden en
er zouden significante vervormingen kunnen worden geïntroduceerd aan de randen of ver weg van GCPs die
voortkomen uit het te ver extrapoleren van gegevens-passende polynomialen.

• Het algoritme Projective generaliseert Polynomial 1 op een andere manier, wat het voor transformaties
mogelĳk maakt een centrale projectie weer te geven tussen 2 niet-parallelle vlakken, de afbeelding en het
kaartvenster. Rechte lĳnen blĳven recht, maar het parallel zĳn wordt niet behouden en de schaal van de
afbeelding varieert consistent met de wĳziging in het perspectief. Dit type transformatie is in het bĳzonder
nuttig voor geoverwĳzingen in gehoekte afbeeldingen (in plaats van vlakke scans) van goed kwaliteit kaarten,
of oblique luchtfoto’s. Een minimaal aantal van 4 GCP’s is vereist.

• Tenslotte “rubber sheets” het algoritme Thin Plate Spline (TPS) het raster met meerdere lokale polynomialen
om overeen te komen met de gespecificeerde GCP’s, met minimale verbuiging van het overall oppervlak.
Gebieden die verwĳderd liggen van GCP’s zullen in de uitvoer worden verplaatst om het overeenkomen met de
GCP’s mogelĳk te maken, maar zullen op andere wĳze lokaal minimaal worden vervormd. TPS is meest nuttig
voor beschadigde ,vervormde, geoverwĳzingen, of op andere wĳzige enigszins onnauwkeurige kaarten of slecht
ge-orthorectificeerde luchtfoto’s. Het is ook nuttig voor geoverwĳzingen bĳ benadering en impliciet opnieuw
projecteren van kaarten met onbekend type projectie of parameters, maar waar een regelmatig raster of dichte
set van ad-hoc GCP’s kan worden gematcht met een verwĳzingslaag. Het vereist technisch een minimum van
10 GCP’s, maar gewoonlĳk meer om met succes te worden toegepast.

In alle algoritmes, behalve TPS, zullen, als meer dan het minimale aantal GCP’s zĳn gespecificeerd, parameters
worden toegepast zodat de overall fout voor residuen wordt geminimaliseerd. Dit is nuttig om de impact van het
registreren van fouten te minimaliseren, d.i. lichte onnauwkeurigheden in klikken op punten of getypte coördinaten,
of andere kleine lokale vervormingen in de afbeelding. Afwezigheid van andere GCP’s om te compenseren, zouden
zulke fouten of vervormingen zich kunnen vertalen naar significante vervormingen, in het bĳzonder nabĳ de randen
van de afbeelding met geoverwĳzingen. Echter, als meer dan het minimale aantal GCP’s wordt gespecificeerd, zullen
zĳ in de uitvoer slechts bĳ benadering overeenkomen. In tegenstelling daaraan zal TPS precies overeenkomen met
alle gespecificeerde GCP’s, maar zou significante vervormingen kunnen introduceren tussen nabĳgelegen GCP’s met
fouten in de registratie.
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Definiëren van de methode Hersamplen

Het type hersamplen dat u kiest, zal waarschĳnlĳk afhankelĳk zĳn van uw invoergegevens en het uiteindelĳke doel van
de oefening. Als u de statistieken van de afbeelding niet wilt wĳzigen (ander dan als geïmpliceerd door niet-uniforme
geometrisch op schaal brengen bĳ het gebruiken van andere dan de transformaties Linear, Helmert, of Polynomial 1),
zult u willen kiezen voor ‘Dichtstbĳzĳnde buur’. In tegenstelling daaraan zal een ‘Cubische hersample’ waarschĳnlĳk
een visueel gladder resultaat geven.
Het is mogelĳk om te kiezen uit vĳf verschillende methoden voor resample:

1. Dichtstbĳzĳnde buur
2. Lineair
3. Kubisch
4. Kubische spline
5. Lanczos

De instellingen voor transformatie definiëren

Er zĳn verscheidene opties die moeten worden gedefinieerd voor het uitvoerraster voor geoverwĳzingen.

• Het keuzevak Wereldbestand aanmaken is alleen beschikbaar als u besluit het lineaire transformatie-type te
gebruiken, omdat dit betekent dat de rasterafbeelding niet echt zal worden getransformeerd. In dat geval wordt
het veld Uitvoerbestand niet geactiveerd, omdat alleen een nieuw wereldbestand zal worden gemaakt.

• Voor alle andere typen transformatie dient u een Uitvoer rasterbestand te definiëren. Standaard zal een nieuw
bestand ([filename]_modified) worden gemaakt in dezelfde map als waar de originele rasterafbeelding in staat.

• Als een volgende stap dient u een Doel SRS (Ruimtelĳk Referentie Systeem) voor de rasterafbeelding met
geoverwĳzingen te definiëren (zieWerken met projecties).

• Als u wilt kunt u een PDF-kaart maken en ook PDF-rapportage maken. Het rapport bevat informatie over
de gebruikte parameters voor de transformaties, een afbeelding van de restanten en een lĳst met alle GCP’s en
hun RMS-fouten.

• Verder kunt u het keuzevak Doelresolutie instellen activeren en de pixelresolutie voor de uitgevoerde
rasterafbeelding definiëren. Standaard is de horizontale en verticale resolutie 1.

• Het keuzevak Gebruik 0 voor transparantie indien nodig kan worden geselecteerd als pixels met de waarde
0 transparant moeten worden gevisualiseerd. In ons voorbeeld topografieblad zouden alle witte gebieden
transparant zĳn.

• Tenslotte laadt Na afloop in QGIS laden de uitvoer rasterafbeelding automatisch in het kaartvenster van
QGIS als de transformatie is voltooid.

Rastereigenschappen weergeven en aanpassen

Klikken op de optie Rastereigenschappen in het menu Extra opent het dialoogvenster Laageigenschappen van de laag
waarin u de geoverwĳzingen wilt plaatsen.
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De georeferencer configureren

• U kunt definiëren of u GCP-coördinaten wilt weergeven en/of ID’s.
• Als laatste kunnen eenheden voor de restanten, pixels en kaarteenheden, worden gekozen.
• Voor het PDF-rapport kunnen een linker- en rechtermarge worden gedefinieerd en u kunt ook de grootte van
het papier instellen voor de PDF-kaart.

• Tenslotte kunt u selecteren Georeferencer-venster ‘docked’ weergeven.

De transformatie uitvoeren

Nadat alle GCP’s zĳn verzameld en alle instellingen voor transformatie zĳn gedefinieerd, druk dan eenvoudigweg op
de knop Georeferencer starten om de nieuwe rasterafbeelding met geoverwĳzingen te maken.
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Werken met gegevens met mazen

18.1 Wat zijn mazen?

Een laag met mazen is een ongestructureerd raster, gewoonlĳk met tĳd- en andere componenten. De ruimtelĳke
component bevat een collectie punten, randen en zĳden in ruimte 2D of 3D:

• punten - XY(Z)-punten (in het coördinaten referentiesysteem van de laag)
• randen - verbonden paren punten
• zĳden - een zĳde is een set hoeken die een gesloten vorm vormen - gewoonlĳk een driehoek of een vierhoek
(quad), zelden polygonen met meerdere punten

Uitgaande van bovenstaande kunnen lagen met mazen dus verschillende typen structuur hebben:
• 1D-mazen: bestaan uit punten en randen. Een rand verbindt twee punten en kan gegevens (scalairen of vectoren)
aan zich hebben toegewezen. Het netwerk van 1D-mazen kan bĳvoorbeeld worden gebruikt voor het modelleren
van een stedelĳk drainagesysteem.

• 2D-mazen: bestaan uit zĳden met driehoeken, regelmatige of ongestructureerde vierkanten.
• 3D-gelaagde mazen: bestaan uit meerdere gestapelde 2D ongestructureerde mazen die elk zĳn uitgetrokken in
de verticale richting (niveaus) door middel van een verticale coördinaat. De punten en zĳden hebben dezelfde
topologie op elk verticaal niveau. De definitie van de mazen (uittrekking van verticaal niveau) zou in het
algemeen kunnen wĳzigen in tĳd. De gegevens worden gewoonlĳk gedefinieerd in volumecentra of door enige
parametrische functie.
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Fig. 18.1: Verschillende typen mazen

Mazen verschaffen informatie over de ruimtelĳke structuur. In aanvulling daarop kunnen de mazen gegevenssets
(groepen) hebben die een waarde toewĳzen aan elk punt. Bĳvoorbeeld driehoekige mazen hebben met genummerde
punten, zoals weergegeven in de afbeelding hieronder:

Fig. 18.2: Driehoekig raster met genummerde punten

Elk punt kan verschillende gegevenssets opslaan (gewoonlĳk meerdere kwantiteiten), en deze gegevenssets kunnen
ook een tĳdelĳk dimensie hebben. Één enkel bestand kan dus meerdere gegevenssets bevatten.
De volgende tabel geeft een idee over welke informatie kan worden opgeslagen in gegevenssets met mazen.
Tabelkolommen geven indices weer van punten van mazen, elke rĳ staat voor één gegevensset. Gegevenssets kunnen
verschillende gegevenstypen hebben. In dit geval slaat het de windsnelheid op 10 m op op bepaalde tĳden (t1, t2, t3).
Op soortgelĳke wĳze kan de gegevensset van mazen ook vectorwaarden opslaan voor elk punt. Bĳvoorbeeld een
vector voor de windrichting op de opgegeven tĳdstippen:
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Tabel 18.1: Voorbeeld van gegevensset met mazen
10 meter wind 1 2 3 …
10 meter snelheid op tĳd=t1 17251 24918 32858 …
10 meter snelheid op tĳd=t2 19168 23001 36418 …
10 meter snelheid op tĳd=t3 21085 30668 17251 …
… … … … …
10 m windrichting tĳd=t1 [20,2] [20,3] [20,4.5] …
10 m windrichting tĳd=t2 [21,3] [21,4] [21,5.5] …
10 m windrichting tĳd=t3 [22,4] [22,5] [22,6.5] …
… … … … …

We kunnen de gegevens visualiseren door kleuren aan waarden toe te wĳzen (soortgelĳk als hoe dat wordt gedaan met
Enkelbands pseudokleur renderen van rasters) en gegevens interpoleren tussen punten overeenkomstig de topologie
van de mazen. Het komt vaak voor dat sommige kwantiteiten 2D-vectors zĳn, in plaats van dat zĳ eenvoudige
scalaire waarden zĳn (bĳv. windrichting). Voor dergelĳke kwantiteiten is het wenselĳk om pĳlen weer te geven die
de richtingen aangeven.

Fig. 18.3: Mogelijke visualisatie van gegevens met mazen

18.2 Ondersteunde indelingen

QGIS verkrĳgt toegang tot de gegevens van mazen met de MDAL drivers, en ondersteunt vanuit zichzelf een variëteit
aan indelingen. Of QGIS een laag met mazen kan bewerken is afhankelĳk van de indeling en het structuurtype van
de mazen.

Gebruik de tab Mazen in het dialoogvenster Databronnen beheren om een gegevensset met mazen in QGIS te
laden. Lees Laden van een laag met mazen voor meer details.
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18.3 Eigenschappen gegevensset met mazen

Het dialoogvenster Laageigenschappen voor een laag met mazen verschaft algemene instellingen om de groepen van
gegevenssets van de laag te beheren en het renderen ervan (actieve groepen van de gegevensset, symbologie, 2D en
3D renderen). Het verschaft ook informatie over de laag.
Toegang tot het dialoogvenster Laag-eigenschappen:

• In het paneel Lagen, dubbelklik op de laag of klik met rechts en selecteer Eigenschappen… uit het contextmenu;
• Ga naar menu Kaartlagen ► Laageigenschappen… als de laag is geselecteerd.

Het dialoogvenster voor mazen Laageigenschappen verschaft de volgende gedeelten:

Tabel 18.2: Tabs van de eigenschappen van laag met mazen

Informatie Bron Symbologie[1]

3D-weergave[1] Tĳdbeheer Hoogte

Renderen Metadata

[1] Ook beschikbaar in het paneel Laag opmaken

Notitie: Demeeste eigenschappen van een laagmetmazen kunnen worden opgeslagen naar of geladen uit een bestand
.qml met het menu Stĳl aan de onderzĳde van het dialoogvenster. Meer details in Aangepaste stĳlen beheren.

18.3.1 Eigenschappen Informatie

Fig. 18.4: Laag met mazen eigenschappen Informatie
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De tab Informatie is alleen-lezen en is een interessante plek om snel wat overzichtsinformatie en metadata over
de huidige laag op te pakken. Verschafte informatie is:

• algemeen, zoals naam in het project, pad van de bron, lĳst met aanvullende bestanden, laatste tĳd en grootte
van opslaan, de gebruikte provider

• gebaseerd op de provider van de laag: bereik, punt, zĳde, aantal randen en/of groepen gegevensset
• het Coördinaten ReferentieSysteem: naam, eenheden, methode, nauwkeurigheid, verwĳzing (d.i. of het statisch
of dynamisch is)

• opgehaald uit de gevulde metadata: toegang, bereiken, links, contacten, geschiedenis…

18.3.2 Eigenschappen Bron

De tab Bron geeft basisinformatie weer over de geselecteerde laag met mazen, inclusief:

Fig. 18.5: Laag met mazen eigenschappen Bron

• de laagnaam om weer te geven in het paneel Lagen
• instellen van het Coördinaten ReferentieSysteem: Geeft het toegewezen Coördinaten ReferentieSysteem (CRS)
van de laag weer. U kunt het CRS van de laag wĳzigen door een recent gebruikte te kiezen uit de keuzelĳst
of te klikken op de knop CRS selecteren (bekĳk Keuze Coördinaten ReferentieSysteem). Gebruik dit proces
alleen als het op de laag toegepaste CRS verkeerd is of als er geen werd gespecificeerd.

• Het frame Beschikbare gegevenssets vermeldt alle groepen gegevenssets (en subgroepen) in de laag met mazen,
met hun type en omschrĳving in een boomweergave. Zowel gewone gegevenssets (d.i. hun gegevens zĳn
opgeslagen in het bestand) en virtuele gegevenssets (die direct worden berekend) worden vermeld.

– Gebruik de knop Extra gegevensset aan mazen toevoegen om meer groepen aan de huidige laag met
mazen toe te voegen.
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– Alles inklappen en Alles uitklappen van de boom van de gegevensset, in het geval van ingebedde
groepen

– Als u slechts geïnteresseerd bent in enkele gegevenssets kunt u de andere deselecteren en ze onbeschikbaar
maken in het project

– Dubbelklik op een naam en u kunt de gegevensset hernoemen.

– Herstellen naar standaarden: selecteert alle groepen en hernoemt ze terug naar hun originele naam
in de provider.

– Klik met rechts op een virtuele groep gegevensset en u kunt:
∗ Groep gegevensset verwĳderen uit het project
∗ Groep gegevensset opslaan als… een bestand op schĳf, naar elke ondersteunde indeling. Het nieuwe
bestand blĳft toegewezen aan de huidige laag met mazen in het project.

• Selecteren van de groep Behandelen als statische gegevensset maakt het mogelĳk de eigenschappen voor
navigatie Tĳdbeheer voor de kaart te negeren bĳ het renderen van de laag met mazen. Voor elke actieve groep

gegevensset (zoals geselecteerd in Symbologie ► tab Gegevenssets), kunt u:
– instellen op Geen: de groep gegevensset wordt helemaal niet weergegeven
– Gegevensset weergeven: bĳv. voor de gegevensset “bed elevation” die geen tĳdsindeling heeft
– een bepaalde datum/tĳd uitnemen: de gegevensset die overeenkomt met de opgegeven tĳd wordt
gerenderd en blĳft vast tĳdens navigeren op de kaart.

18.3.3 Eigenschappen Symbologie

Klik op de knop Symbologie om het dialoogvenster te activeren. Eigenschappen voor Symbologie zĳn verdeeld
over verschillende tabs:

• Gegevenssets

• Contouren

• Vectoren

• Renderen

• Methode voor middelen van gestapelde mazen

Gegevenssets

De tab Gegevenssets is de belangrĳkste plaats om te beheren en in te stellen welke gegevenssets zullen worden
gebruikt voor de laag. Het geeft de volgende items weer:

• Groepen beschikbaar in de gegevensset met mazen, en of zĳ verschaffen:

– scalaire gegevensset

– of vector gegevensset: standaard heeft elke vector gegevensset een scalaire gegevensset die zĳn
automatisch gemaakte omvang weergeeft.

Klik op het pictogram naast de naam van de gegevensset om de groep en het type gegevens, dat moet worden
weergegeven, te selecteren.

• Metadata voor groep(en) van geselecteerde gegevensset, met details over:
– het type mazen: randen of zĳden
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– het type gegevens: punten, randen, zĳden of volume
– of het van het type vector is of niet
– de originele naam in de laag met mazen
– de eenheid, indien van toepassing

• Meng-modus beschikbaar voor de geselecteerde gegevenssets.

Fig. 18.6: Laag met mazen Gegevenssets

U kunt symbologie toepassen op de geselecteerde vector- en/of scalaire groep met de volgende tabs.

Symbologie Contouren

Notitie: De tab Contouren kan alleen worden geactiveerd als een scalaire gegevensset is geselecteerd op de tab
Gegevenssets.

Op de tab Contouren kunt u bekĳken en wĳzigen de huidige opties voor visualisatie van contouren voor de
geselecteerde groep, zoals hieronder weergegeven in Fig. 18.7:
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Fig. 18.7: Contouren opmaken in een laag met mazen

• Voor 1D-mazen, stel de Lĳndikte van de randen in. Dit kan een vaste grootte zĳn voor de gehele gegevensset,
of variëren langs de geometrie (meer details bĳ de renderer geïnterpoleerde lĳn)

• Gebruik de schuifbalk of draaiknop om de Opaciteit van de huidige groep in te stellen, indien van het type
2D-mazen.

• Voer het bereik aan waarden in die u wilt laten weergeven voor de huidige groep: gebruik Laden om de
minimum en maximum waarden van de huidige groep op te halen of voer aangepaste waarden in als u enkele
wilt uitsluiten.

• Voor 2D/3D-mazen, selecteer de Hersampling methode om de waarden van de omliggende punten te
interpoleren naar de zĳden (of vanuit de omliggende zĳden naar de punten) met de methode Gemiddelde buur.
Afhankelĳk van of de gegevensset is gedefinieerd op de punten (respectievelĳk op de zĳden), stelt QGIS deze
instelling standaard in op de methode Geen (respectievelĳk Gemiddelde buur) om de waarden op punten te
gebruiken en het standaard renderen glad te houden.

• Classificeer de gegevensset met de classificatie voor het Kleurverloop.
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Symbologie Vectors

Notitie: De tab Vectoren kan alleen worden geactiveerd als een vector gegevensset is geselecteerd op de tab
Gegevenssets.

Op de tab Vectoren kunt u bekĳken enwĳzigen de huidige opties voor visualisatie van vectoren voor de geselecteerde
groep, zoals hieronder weergegeven in Fig. 18.8:

Fig. 18.8: Vectoren opmaken in een laag met mazen met pijlen

Een vector gegevensset met mazen kan worden opgemaakt met verscheidene typen Symbologie:
• Pĳlen: vectoren worden weergegeven met pĳlen op dezelfde plaats als waar zĳ zĳn gedefinieerd in de ruwe
gegevensset (d.i. op de knopen of het midden van elementen) of op een gebruiker-gedefinieerd raster (waardoor
zĳ evenredig worden verdeeld). De lengte van de pĳl is proportioneel ten opzichte van de omvang van de pĳl,
zoals gedefinieerd in de ruwe gegevens, maar kan met verscheidene methoden op schaal worden gebracht.

• Stroomlĳnen: vectoren worden weergegeven met stroomlĳnen die beginnen vanuit het beginpunt. De
beginpunten mogen beginnen vanuit de punten van de mazen, vanuit een gebruikers-raster of willekeurig.

• Sporen: een nettere animatie van de stroomlĳnen, het soort effect dat u krĳgt wanneer u willekeurig zand in
het water strooit en kĳkt waar de zandkorrels naartoe vloeien.

Beschikbare eigenschappen zĳn afhankelĳk van de geselecteerde symbologie, zoals weergegeven in de volgende tabel.
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Tabel 18.3: Beschikbaarheid en betekenis van de eigenschappen voor
symbologie van vectors

Label Beschrijving en
eigenschappen

Pijl Stroomlijnen Sporen

Lĳndikte Breedte van de
weergave van de
vector

Kleurmethode • een Enkele
kleur
toegewezen
aan alle
vectoren

• of een
variabele
kleur,
gebaseerd op
de omvang
van vectoren,
met een
Kleurverloop
schaduw

Op omvang filteren Alleen vectoren
waarvan de
lengte voor de
geselecteerde
gegevensset vallen
binnen het bereik
Min en Max worden
weergegeven

Weergeven op raster
gebruiker

Plaatst de vector op
een raster met een
aangepaste Afstand
X en Afstand Y en
interpoleert hun
lengte, gebaseerd
op buren

Opties voor uiteinde Lengte en Breedte
van de pĳlkop, als
een percentage van
de lengte van de
schacht

Lengte pĳl •
Gedefinieerd
door Min
en Max: U
specificeert
de minimum
en maximum
lengte voor
de pĳlen,
QGIS zal
hun grootte
interpoleren,
gebaseerd
op de
onderliggende
omvang van
de vectoren

• Op grootte
schalen:
pĳllengte is
proportioneel
aan de
grootte van
hun vector

• Vast: alle
vectoren
worden
weergegeven
met dezelfde
lengte

Methode voor begin
stroomlĳnen • Op

mazen/raster:
vertrouwt op
het raster
van de
gebruiker om
de vectoren
weer te geven

• Willekeurig:
plaatsing van
vectoren
wordt
willekeurig
gedaan met
inachtneming
van een
bepaalde
dichtheid

Aantal deeltjes De hoeveelheid
“zand” die u in de
visualisatie wilt
gooien

Max. staartlengte De tĳd waarin
de deeltjes zich
verspreiden
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Renderen

Op de tab Renderen biedt QGIS mogelĳkheden voor het weergeven en aanpassen van de structuur van mazen.
Lĳndikte en Lĳnkleur kunnen ook worden ingesteld om weer te geven:

• de randen voor 1D-mazen
• Voor 2D-mazen:

– Normale mazen renderen: geeft originele zĳden en randen van de laag weer
– Driehoekige mazen renderen: voegt meer randen toe en geeft de zĳden als driehoeken weer

Fig. 18.9: 2D-mazen renderen

Methode voor middelen van gestapelde mazen

3D-gelaagde mazen bestaan uit meerdere gestapelde 2D ongestructureerde mazen, elk uitgetrokken in de verticale
richting (niveaus) door middel van een verticale coördinaat. De punten en zĳden hebben dezelfde topologie op elk
verticaal niveau.Waarden worden gewoonlĳk opgeslagen in de volumes die regelmatig zĳn gestapeld over de basis 2D-
mazen. Om ze te visualiseren in een 2D-kaartvenster moet u waarden op de volumes (3D) converteren naar waarden
op zĳden (2D) die in de laag met mazen kunnen worden weergegeven. De Methode voor middelen van gestapelde mazen

verschaft verschillende methoden voor middelen/interpoleren om dit af t handelen.
U kunt de methode selecteren om de 2D-gegevenssets af te leiden en corresponderende parameters (index niveau,
waarden diepte of hoogte). Voor elke methode wordt een voorbeeld voor het toepassen weergegeven in het
dialoogvenster, maar u kunt meer over de methoden lezen op https://fvwiki.tuflow.com/index.php?title=Depth_
Averaging_Results.
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18.3.4 Eigenschappen 3D-weergave

Lagen met mazen kunnen worden gebruikt als terrein in een 3D-kaartweergave, gebaseerd op de waarden Z van hun

punten. Op de tab voor eigenschappen van 3D-weergave is het ook mogelĳk om de gegevensset van de laag
met mazen in dezelfde 3D-weergave te renderen Daarvoor kan de verticale component van de punten gelĳk worden
gesteld met de waarden van de gegevensset (bĳvoorbeeld niveau van wateroppervlak) en de textuur van de mazen kan
worden ingesteld om andere waarden van de gegevensset te renderen met kleurschaduw (bĳvoorbeeld snelheid).

Fig. 18.10: Eigenschappen 3D gegevensset met mazen

Selecteer 3D-renderer inschakelen en u kunt de volgende eigenschappen bewerken:
• Onder Instellingen voor driehoeken

– Afgevlakte driehoeken: Hoeken tussen opeenvolgende driehoeken worden afgevlakt voor beter renderen
in 3D

– Draadmodel weergeven waarvan u de Lĳndikte en Keur kunt instellen
– Waarde van detail: Beheert hoe vereenvoudigd de te renderen laag met mazen zou moeten zĳn. Aan
de uiterste rechterzĳde, is het de basis mazen, en hoe meer u naar links gaat, hoe meer de laag wordt
vereenvoudigd en wordt gerenderd met minder details. Deze optie is alleen beschikbaar als de optie
Mazen vereenvoudigen op de tab Renderen is geactiveerd.

• Verticale instellingen om het gedrag van de verticale component te beheren
van punten van gerenderde driehoeken

– Groep gegevensset voor verticale waarde: de groep van de gegevensset die zal worden gebruikt voor de
verticale component van de mazen
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– Waarde gegevensset relatief ten opzichte van de waarde Z van punten: of de waarden van de gegevensset
moeten worden beschouwd als absolute coördinaat Z of relatief ten opzichte van eigen waarde Z van de
punten

– Verticale schaal: de schaalfactor om toe te passen op de waarden Z van de gegevensset
• Instellingen voor renderen van kleuren met een Weergave-stĳl die kan worden gebaseerd op het kleurverloop
schaduw ingesteld in Symbologie Contouren (2D contour kleurverloop schaduw) of als een Enkele kleurmet een
geassocieerde Kleur mazen

• Pĳlen weergeven: geeft pĳlen weer op gegevensset laag met mazen 3D-entiteit, gebaseerd op dezelfde vector
groep gegevensset, gebruikt in de vector 2D-renderen. Zĳ worden weergegeven met de 2D kleurinstelling. Het
is ook mogelĳk de Tussenruimte pĳlen te definiëren en, of het van eenVaste grootte of op schaal is gebracht naar
zĳn omvang. Deze instelling voor tussenruimte definieert ook de maximum grootte van pĳlen omdat pĳlen niet
kunnen overlappen.

18.3.5 Eigenschappen Renderen

Fig. 18.11: Mazen eigenschappen renderen

Onder het groepsvak Scaalafhankelĳke zichtbaarheid, kunt u de schaal Maximum (inclusief) en Minimum (exclusief)
instellen, wat een bereik van schalen definieert waarin elementen van mazen zichtbaar zullen zĳn. Buiten dit bereik is
hĳ verborgen. De knop Op huidige schaal kaartvenster instellen helpt u de schaal van het huidige kaartvenster te gebruiken
als grens voor de zichtbaarheid van het bereik. Bekĳk Schaal zichtbaarheid selecteren voor meer informatie.

Notitie: U kunt het schaalafhankelĳk renderen ook activeren op een laag vanuit het paneel Lagen. Klik met rechts
op de laag en selecteer in het contextmenu, Zichtbaarheidsschaal laag instellen.

Omdat lagen met mazen miljoenen zĳden kunnen hebben, kan het renderen daarvan soms heel traag zĳn, speciaal
wanneer alle zĳden worden weergegeven in de weergave hoewel zĳ te klein zĳn om te worden weergegeven. U
kunt, om het renderen te versnellen, de laag met mazen vereenvoudigen, wat er in resulteert dat één of meer mazen
verschillende niveaus van detail weergeven en selecteren op welk niveau u QGIS zou willen de laag met mazen te
renderen. Onthoud dat de vereenvoudigde laag met mazen alleen driehoekige mazen bevat.

Op de tab Renderen, selecteer Mazen vereenvoudigen en stel in:
• een Verkleiningsfactor: Beheert het maken van opeenvolgende niveaus van vereenvoudigde mazen. Als
bĳvoorbeeld de basislaag met mazen 5 miljoen zĳden heeft, en de verkleiningsfactor is 10, zal de eerste
vereenvoudigde laag met mazen ongeveer 500.000 zĳden hebben, de tweede 50.000 zĳden, de derde 5000,…
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Omdat een hogere verkleiningsfactor snel leidt tot eenvoudiger mazen (d.i. met driehoeken van een grotere
omvang), produceert het ook minder niveaus van detail.

• Minimale grootte driehoek: de gemiddelde grootte (in pixels) van de driehoeken die toegestaan is om te worden
weergegeven. Als de gemiddelde grootte van de mazen minder is dan deze waarde, wordt het renderen van
mazen met een lager niveau van details geactiveerd.

18.3.6 Eigenschappen Tijdbeheer

De tab Tĳdbeheer verschaft opties om het renderen van de laag in de tĳd te beheren. Het maakt het mogelĳk
dynamisch tĳdwaarden van de ingeschakelde groepen van gegevenssets weer te geven. Dergelĳk dynamisch renderen
vereist dat de Navigatie voor Tĳdbeheer is ingeschakeld in het kaartvenster.

Fig. 18.12: Laag met mazen eigenschappen Tijdbeheer

Instellingen Tĳdbeheer voor laag
• Verwĳzingstĳd van de groep van de gegevensset, als een absolute datum/tĳd. Standaard parst QGIS de bronlaag
en geeft de eerste geldige verwĳzingstĳd in de groep van de gegevensset in de laag terug. Indien niet beschikbaar
zal de waarde worden ingesteld door de tĳdsperiode van het project of terugvallen op de huidige datum. De
Starttĳd en Eindtĳd waarmee rekening moet worden gehouden worden dan berekend op basis van de stap van
het interne tĳdstempel van de gegevensset.
Het is mogelĳk een aangepaste Verwĳzingstĳd (en dan de tĳdperiode) in te stellen, en de wĳzigingen terug te
draaien met de knop Opnieuw laden vanaf provider. Met Verwĳzingstĳd altĳd nemen uit databron geselecteerd
zorgt u ervoor dat de eigenschappen voor de tĳd worden bĳgewerkt vanuit het bestand, elke keer als de laag
opnieuw wordt geladen of het project opnieuw wordt geopend.

• Gegevensset overeenkomende methode: bepaalt de op een bepaalde tĳd weer te geven gegevensset. Opties zĳn
Zoek dichtstbĳzĳnde gegevensset vóór gevraagde tĳd of Zoek dichtstbĳzĳnde gegevensset vanaf gevraagde tĳd (na
of voor).

Tĳdinstelingen provider
• Tĳdseenheid uitgenomen vanuit de ruwe gegevens, of gebruiker-gedefinieerd. Dit kan worden gebruikt om de
snelheid van de laag met mazen uit te lĳnen met andere lagen in het project gedurende navigeren door de tĳd
van de kaart. Ondersteunde eenheden zĳn Seconden, Minuten, Uren en Dagen.
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18.3.7 Eigenschappen hoogte

De tab Hoogte verschaft opties om de eigenschappen voor hoogte van de laag te beheren in een 3D-kaartweergave
en het uiterlĳk in de diagrammen van het profiel. Specifiek kunt u instellen:

Fig. 18.13: Eigenschappen hoogte mazen

• Hoogte oppervlak: hoe de laag met mazen punten met waarden Z zou moeten interpreteren als hoogte voor het
terrein. U kunt een factor voor Schaal en een Verschuiving toewĳzen.

• Uiterlĳk diagram profiel: beheert het renderen Stĳl die de hoogte van de mazen zal gebruiken bĳ het tekenen
van een diagram van het profiel. Het kan worden ingesteld als:

– een profiel Lĳn met een toegepaste lĳnstĳl
– een oppervlak met Vullen onder en een corresponderende stĳl voor vulling

18.3.8 Eigenschappen Metadata

De tab Metadata verschaft u opties om een rapport met metadata voor uw laag te maken en te bewerken. Bekĳk
Metadata voor meer informatie.

18.4 Een laag met mazen bewerken

QGIS maakt het mogelĳk een laag met mazen te maken vanuit niets of gebaseerd op een bestaande. U kunt de
geometrieën van de nieuwe laag maken/aanpassen waaraan u later gegevenssets kunt toewĳzen. Het is ook mogelĳk
een bestaande laag met mazen te bewerken. Om dat het bewerken een alleen-frames-laag vereist, zult u worden
gevraagd om eerst enige geassocieerde gegevensset te verwĳderen (zorg er voor dat u hem nog steeds beschikbaar
hebt als zĳ nog steeds noodzakelĳk zĳn) of een kopie te maken van de laag (alleen geometrieën).

Notitie: QGIS staat niet toe dat randen op lagen met mazen worden gedigitaliseerd. Alleen punten en zĳden zĳn
elementen van mazen die kunnen worden gemaakt. Ook kunnen niet alle ondersteunde indelingen voor mazen worden
bewerkt in QGIS (bekĳk permissions).
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18.4.1 Overzicht van de gereedschappen voor het digitaliseren van mazen

De volgende gereedschappen zĳn beschikbaar voor interactie met of bewerken van een element van een basis laag
met mazen.

Tabel 18.4: Gereedschappen voor digitaliseren van mazen
Label Doel Locatie

Huidige bewerkingen Toegang tot opslaan, terugdraaien of annuleren vanwĳzigingen
tegelĳkertĳd in alle of geselecteerde lagen

Werkbalk
Digitaliseren

Bewerken aan/uitzetten In-/Uitschakelen laag naar modus Bewerken Werkbalk
Digitaliseren

Bewerkingen opslaan Wĳzigingen op de laag opslaan Werkbalk
Digitaliseren

Ongedaan maken Laatste wĳziging(en) ongedaan maken - Ctrl+Z Werkbalk
Digitaliseren

Opnieuw Laatste actie voor ongedaan maken opnieuw uitvoeren -
Ctrl+Shift+Z

Werkbalk
Digitaliseren

Gereedschap Geavanceerd digitaliseren inschakelen
In-/Uitschakelen van het paneel Geavanceerd digitaliseren Werkbalk

Geavanceerd
digitaliseren

Zĳden en punten opnieuw indexeren
Maak de index opnieuw en hernummer de elementen van de
mazen voor optimalisatie

Menu Mazen

Elementen van mazen digitaliseren
Punten en zĳden selecteren/maken Digitaliseren mazen

werkbalk

Elementen van mazen met een polygoon selecteren
Punten en zĳden selecteren die worden overlapt door een
getekende polygoon

Digitaliseren mazen
werkbalk

Elementen van mazen met een expressie selecteren
Punten en zĳden selecteren m.b.v. reguliere expressie Digitaliseren mazen

werkbalk

Coördinaten van punten transformeren
Coördinaten van een selectie van punten aanpassen Digitaliseren mazen

werkbalk

Forceren op geselecteerde geometrieën
Zĳden splitsen en Z-waarde beperken met een lineaire
geometrie

Digitaliseren mazen
werkbalk

18.4.2 Verkennen van de logica voor het toewijzen van de Z-waarde

Wanneer een laag met mazen in modus Bewerken wordt gezet, opent een widget Z-waarde punt aan de
rechterbovenkant van het kaartvenster. Standaard correspondeert de waarde ervan met de Standaardwaarde Z
ingesteld op de tab Extra► Opties ► Digitaliseren. Wanneer er geselecteerde punten zĳn, geeft het widget de
gemiddelde Z-waarde van d geselecteerde punten weer.
Gedurende het bewerken wordt de Z-waarde punt toegewezen aan nieuwe punten. Het is ook mogelĳk een aangepaste
waarde in te stellen: bewerk de widget, druk op Enter en u zult de standaardwaarde overschrĳven en gebruik maken
van deze nieuwe waarde in het proces Digitaliseren. Klik op het pictogram in de widget om de waarde te herstellen
naar de standaardwaarde van Opties.
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Regels voor tewijzen

Bĳ hetmaken van een nieuw punt, kan de definitie van de Z-waarde ervan variëren, afhankelĳk van actieve selectie
in de laag met mazen en de locatie ervan. De volgende tabel laat de verschillende combinaties zien.

Tabel 18.5: Matrix voor toewĳzen van Z-waarde voor nieuwe punten
Vector maken Zijn er geselecteerde

punten in de laag met
mazen?

Bron van toegewezen waarde Toegewezen Z-
waarde

“Vrĳ” punt, niet
verbonden met
enige
zĳde of rande van
een zĳde

Nee Z-waarde punt Standaard of
gebruikergedefinieerd

paneel Geavanceerd digitaliseren (als
widget z in de vastgezette Vastgezet

status staat)

widget z indien in
status Vastgezet

Ja Z-waarde punt Gemiddelde van
de geselecteerde
punten

Punt op een rand — Laag met mazen Geïnterpoleerd
vanuit de punten
van de rand

Punt op een zĳde — Laag met mazen Geïnterpoleerd
vanuit de punten
van de zĳde

Punt gesnapt
aan een 2D-
vectorobject

— Z-waarde punt Standaard of
gebruikergedefinieerd

Punt gesnapt
aan een 3D-
vectorobject

— Vectorlaag Punt

Punt gesnapt
aan een 3D-
vectorsegmentt

— Vectorlaag Geïnterpoleerd
langs het
vectorsegment

Notitie: De widget Z-waarde punt wordt gedeactiveerd als het paneel Geavanceerd digitaliseren is ingeschakeld en
er geen element van mazen is geselecteerd. De widget z van het laatste bepaalt dan de toewĳzing van de Z-waarde.

Z-waarde van bestaande punten aanpassen

De meest eenvoudige manier, om de Z-waarde van punten aan het passen, is:
1. Selecteer één of meerdere punten. Het widget Z-waarde punt zal de gemiddelde hoogte van de selectie

weergeven.
2. Wĳzig de waarde in de widget.
3. Druk op Enter. De ingevoerde waarde wordt toegewezen aan de punten en wordt de standaardwaarde voor

de volgende punten.
Een andere manier om de Z-waarde van een punt te wĳzigen is om het te verplaatsen en het te snappen aan een
object van een vectorlaag met de mogelĳkheid voor een Z-waarde. Indien meer dan één punt is geselecteerd, kan de
Z-waarde niet worden gewĳzigd op deze manier.
Het dialoogvenster Punten van mazen transformeren verschaft ook mogelĳkheden om de Z-waarde van een selectie
van punten aan te passen (samen met hun coördinaten X of Y).
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18.4.3 Elementen van mazen selecteren

Gebruiken van Elementen van mazen digitaliseren

Activeer het gereedschap Elementen van mazen digitaliseren. Ga over een element en het wordt geaccentueerd, wat u in
staat stelt het te selecteren.

• Klik op een punt en het is geslecteerd.
• Klik op het kleine vierkant in het midden van een zĳde of een rand en het wordt geselecteerd. Verbonden
knopen worden ook geselecteerd. Omgekeerd selecteert het selecteren van alle punten van een rand of een
zĳde ook dat element.

• Sleep een vierkant om overlappende elementen te selecteren (een geselecteerde zĳde komt met al zĳn punten).
Druk op Alt-toets als u alleen volledig opgenomen elementen wilt selecteren.

• Druk op de Shift-toets tĳdens het selecteren om elementen aan een selectie toe te voegen.
• Druk, om een element uit de selectie te verwĳderen, op de Ctrl-toets en selecteer het opnieuw. Een
gedeselecteerde zĳde zal ook al zĳn punten hebben gedeselecteerd.

Gebruiken van Elementen van mazen met een polygoon selecteren

Activeer het gereedschap Elementen van mazen met een polygoon selecteren en:
• Teken een polygoon (klik met links om een punt toe te voegen, Backspace om het laatste punt ongedaan
te maken, Esc om de polygoon te verlaten en klik met rechts om die te valideren) over de geometrieën met
mazen. Alle gedeeltelĳk overlappende punten en zĳden zullen worden geselecteerd. Druk op de Alt -toets
tĳdens het tekenen als u alleen volledig opgenomen elementen wilt selecteren.

• Klik met rechts op de geometrie van een object van een vectorlaag, selecteer het in de lĳst die tevoorschĳn
komt en alle gedeeltelĳk overlappende punten en zĳden van de laag met mazen zullen worden geselecteerd.
Gebruik Alt tĳdens het tekenen om alleen volledig opgenomen elementen te selecteren.

• Druk op de Shift-toets tĳdens het selecteren om elementen aan een selectie toe te voegen.
• Druk, om een element uit de selectie te verwĳderen, op Ctrl tĳdens het tekenen over de polygoon voor de
selectie.

Gebruiken van Elementen van mazen met een expressie selecteren

Een ander gereedschap voor het selecteren van elementen van mazen is Elementen van mazen met een expressie selecteren.
Indien op gedrukt zal het gereedschap het mazen dialoogvenster Expressie selecteren openen van waaruit u kunt:

1. De methode voor de selectie selecteren:
• Selecteren op punten:past de ingevoerde expressie toe op punten, en geeft overeenkomende en hun
eventuele geassocieerde randen/zĳden terug

• Selecteren op zĳden:past de ingevoerde expressie toe op zĳden, en geeft overeenkomende en hun eventuele
geassocieerde randen/punten terug

2. Schrĳf de expressie voor de selectie. Afhankelĳk van de geselecteerde methode, zullen beschikbare functies
in de groep Mazen overeenkomstig worden gefilterd.

3. Voer de query uit door in te stellen hoe de selectie zich zou moeten gedragen en te drukken op:

• Selecteren: vervangt elke bestaande selectie in de laag

• Toevoegen aan huidige selectie
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• Verwĳderen uit huidige selectie

18.4.4 Elementen van mazen aanpassen

Punten toevoegen

Punten toevoegen aan een laag met mazen:

1. Druk op de knop Elementen van mazen digitaliseren.
2. Een widget Z-waarde punt verschĳnt rechtsboven in het kaartvenster. Stel deze waarde in op de Z-coördinaat

die u wilt toewĳzen aan de opeenvolgende punten
3. Dubbelklik dan:

• buiten een zĳde: voegt een “vrĳ punt” toe dat een punt is dat niet is gekoppeld aan enige zĳde. Dit punt
wordt weergegeven als een rode punt als de laag in de modus Bewerken staat.

• op de rand van bestaande zĳde(n): voegt een punt toe op de rand, splitst de elkaar rakende zĳde(n) in
driehoeken die zĳn verbonden met het nieuwe punt

• binnen een zĳde: splitst de zĳde in driehoeken waarvan de randen de omliggende punten verbinden met
het nieuwe punt.

Zijden toevoegen

Zĳden toevoegen aan een laag met mazen:

1. Druk op de knop Elementen van mazen digitaliseren.
2. Een widget Z-waarde punt verschĳnt rechtsboven in het kaartvenster. Stel deze waarde in op de Z-coördinaat

die u wilt toewĳzen aan de opeenvolgende punten.
3. Ga met de muis over een punt en klik op de kleine driehoek die ernaast verschĳnt.
4. Verplaats de cursor naar de volgende positie voor een punt; u kunt snappen aan bestaande punten of

dubbelklikken om een nieuw toe te voegen.
5. Ga door zoals hierboven om net zoveel punten aan de zĳde toe te voegen als u wilt. Druk op de knop

Backspace om het laatste punt ongedaan te maken.
6. Tĳdens het verplaatsen van de muis wordt een elastiek weergegeven dat de vorm van de zĳde weergeeft. Als het

groen wordt weergegeven dan is de verwachte zĳde geldig en kunt u met rechts klikken om hem toe te voegen
aan de laag met mazen. Als het rood is, is de zĳde niet geldig (bĳv. omdat die zichzelf snĳdt, een bestaande
zĳde of punt overlapt, maakt een gat, …) en kan niet worden toegevoegd. Umoet eerst enkele punten ongedaan
maken en de geometrie repareren.

7. Druk op Esc om het digitaliseren van de zĳde af te breken.
8. Klik met rechts om de zĳde te valideren.
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Fig. 18.14: Voorbeelden van ongeldige mazen

Elementen van mazen verwijderen

1. De doelelementen selecteren

2. Schakel het gereedschap Elementen van mazen digitaliseren in.
3. Klik met rechts en selecteer.

• Geselecteerde punten verwĳderen en gat(en) vullen of drukken op Ctrl+Del: verwĳdert punten en
gekoppelde zĳden en vult het/de gat(en) door te trianguleren vanaf de naburige punten

• Geselecteerde punten verwĳderen zonder gat(en) vullen of drukken op Ctrl+Shift+Del: verwĳdert
punten en gekoppelde zĳden en vult het/de gat(en) niet

• Geselecteerde zĳden(n) verwĳderen of drukken op Shift+Del: verwĳdert zĳden, maar behoud de
punten

Deze opties zĳn ook toegankelĳk vanuit het contextmenu wanneer u over één enkel item gaat zonder te selecteren.
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Elementen van mazen verplaatsen

Punten en zĳden verplaatsen in laag met mazen:
1. De doelelementen selecteren

2. Schakel het gereedschap Elementen van mazen digitaliseren in.
3. Klik, om te beginnen met het verplaatsen van het element, op een punt of het zwaartepunt van een zĳde/rand
4. Verplaats de cursor naar de doellocatie (snappen aan vectorobjecten wordt ondersteund).
5. Als de nieuwe locatie geen ongeldige laag met mazen genereert, verschĳnen de verplaatste elementen in het

groen. Klik opnieuw om ze op deze locatie los te laten. Zĳden waarvan alle punten zĳn geselecteerd worden
vertaald, hun buren worden opnieuw overeenkomstig vorm gegeven.

Punten van mazen transformeren

Het gereedschap Coördinaten van punten transformeren geeft een meer geavanceerde manier om punten te verplaatsen, door
het bewerken van hun X-, Y- en/of Z-coördinaten, met expressies.

1. Selecteer de punten waarvan u de coördinaten wilt bewerken

2. Druk op Coördinaten van punten transformeren. Een dialoogvenster opent met een vermelding van het aantal
geselecteerde punten. U kunt nog steeds punten aan de selectie toevoegen of daaruit verwĳderen.

3. Afhankelĳk van de eigenschappen die u wilt aanpassen, moet u X-coördinaat, Y-coördinaat en/of Z-waarde
selecteren.

4. Voer dan de doelpositie in het vak in, ofwel als een numerieke waarde of als een expressie (met het
dialoovenster Expressie)

5. Met de knop Coördinaten van het geselecteerde punt importeren ingedrukt, worden de vakken X, Y en Z automatisch
gevuld met hun coördinaten wanneer één enkel punt is geselecteerd. Een handige en snelle manier om punten
individueel aan te passen.

6. Druk op Voorbeeld transformatie om de nieuwe locatie van het punt te simuleren en een voorbeeld te zien van
de mazen met de transformatie.

• Als het voorbeeld groen is, is de getransformeerde laag met mazen geldig en kunt u de transformatie
toepassen.

• Als het voorbeeld rood is, is de getransformeerde laag met mazen ongeldig en kunt u de transformatie
niet toepassen, totdat het is gecorrigeerd.

7. Druk op Transformatie toepassen om de geselecteerde coördinaten voor de set met punten aan te passen.

Geometrie van mazen opnieuw vormen

Het contextmenu

1. Schakel Elementen van mazen digitaliseren in
2. Selecteer item(s) van mazen, of niet
3. Door over een element van mazen te gaan wordt het geaccentueerd.
4. Klik met rechts en u kunt:

• de item(s) verplaatsen

• Geselecteerde zĳde(n) splitsen) (Huidige zĳde splitsen): splitst de zĳde waar u overheen gaat of elke
geselecteerde quadzĳden in twee driehoeken
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• Delaunay-triangulatie met geselecteerde punten: bouwt driehoekige zĳden met behulp van geselecteerde
vrĳe punten.

• Geselecteerde zĳde(n) verfĳnen (Huidige zĳde verfĳnen): splitst de zĳde in vier zĳden, gebaseerd op punten
die zĳn toegevoegd aan het midden van elke rand (een driehoek resulteert in driehoeken, een quad in
quads). Trianguleert ook aanliggende zĳden die zĳn verbonden met de nieuwe punten.

De markeringen voor randen

Als Elementen van mazen digitaliseren actief is en u gaat over een rand, wordt de rand geaccentueerd en is het mogelĳk
om daarmee interactief te werken. Afhankelĳk van de context zouden de volgende markeringen beschikbaar kunnen
zĳn:

• een vierkant, in het midden van de rand: klik erop om de eindpunten te selecteren.
• een kruis als de twee zĳden aan beide zĳden kunnen worden samengevoegd: klik erop om de rand te
verwĳderen en de zĳden samen te voegen.

• een cirkel als de rand tussen twee driehoeken staat: Klik erop om de rand om te draaien, d.i. hem verbinden
in plaats van aan de twee andere “vrĳe” punten van de zĳden.

Het gereedschap Forceren op geselecteerde geometrieën

Het gereedschap Forceren op geselecteerde geometrieën verschaft geavanceerde manieren om breuklĳnen toe te passen met
lĳn-geometrie. Een breuklĳn zal de mazen forceren om randen langs de lĳn te hebben. Onthoud dat de breuklĳn
niet als persistent zal worden beschouwd als de bewerking eenmaal is uitgevoerd; resulterende randen zullen niet
langer als beperkingen optreden en kunnen worden aangepast, net als elke andere rand. Dit kan worden gebruikt om
bĳvoorbeeld om lokaal een laag met mazen aan te passen met nauwkeurige lĳnen, zoals rivieroevers of grenzen of
wegbermen.

1. Schakel het gereedschap Forceren op geselecteerde geometrieën in
2. Geef de geometrie aan die moet worden gebruikt als “forcerende lĳn”; het mag zĳn:

• uitgekozen vanuit een object lĳn of polygoon in het kaartvenster: klik met rechts op het vectorobject en
selecteer het uit de lĳst in het contextmenu.

• een virtuele lĳn die is getekend over het frame met mazen: klik met links om punten toe te voegen, klik
met rechts om te valideren. De Z-waarde van de punten wordt ingesteld door de widget Z-waarde punt
of de widget z als het paneel Geavanceerd digitaliseren is ingeschakeld. Als de lĳn is gesnapt aan een punt
van de mazen of een punt of segment van een 3D-vectorobject, zal het nieuwe punt de Z-waarde van het
gesnapte element aannemen.

Zĳden van mazen die de geometrie lĳn of de grenzen van de polygoon overlappen zullen worden beïnvloed op
een manier die afhankelĳk is van de opties die u in kunt stellen vanuit het keuzemenu van het gereedschap
Forceren op geselecteerde geometrieën:

• Nieuw punt op kruisen randen toevoegen: met deze optie wordt een nieuw punt toegevoegd, elke keer als de
forcerende lĳn een rand kruist. Deze optie leidt tot het splitsen langs de lĳn bĳ elke tegengekomen zĳde.
Zonder deze optie worden tegengekomen zĳden verwĳderd en vervangen door zĳden die komen uit een
triangulatie met slechts de bestaande punten plus de punten van de forcerende lĳnen (nieuwe punten worden
ook toegevoegd op de grensrand die de forcerende lĳnen kruist).
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Fig. 18.15: Mazen forceren met een geometrie lijn - Resultaten zonder (midden) en met (rechts) nieuwe punten op
kruisingen van randen

• Z-waarde interpoleren vanuit: stelt in hoe de Z-waarde van de nieuwe punten wordt bewerkt. Het mag zĳn:
– de Mazen zelf: de Z-waarde van de nieuwe punten wordt geïnterpoleerd uit punten van de zĳde waarop
zĳ vallen

– of de Forcerende lĳn: als de lĳn wordt gedefinieerd door een 3D-vectorobject of een getekende lĳn, dan
wordt de Z-waarde voor de nieuwe punten afgeleid van de geometrie daarvan. In het geval van een 2D-
lĳnobject is de Z-waarde voor de nieuwe punten de Z-waarde punt.

• Tolerantie: wanneer een bestaand punt van mazen dichter bĳ de lĳn staat dan de waarde van de tolerantie, maak
geen nieuw punt op de lĳn, maar gebruik in plaats daarvan het bestaande punt. De waarde kan worden ingesteld
in Meters op schaal of in Schaaleenheden (meer details op Eenheid selecteren).

18.4.5 Herindexeren van lagen met mazen

Gedurende het bewerken, en om bewerkingen voor ongedaan maken/opnieuw snel uit te kunnen voeren, behoudt
QGIS lege plekken voor verwĳderde elementen, wat kan leiden tot groeiend gebruik van het geheugen en inefficiënte
structuur van mazen. Het gereedschap Mazen ► Zĳden en punten herindexeren is ontworpen om deze gaten
te verwĳderen en de indices van zĳden en punten opnieuw te nummeren, zodat ze doorlopen en enigszins redelĳk
geordend zĳn. Dit optimaliseert de relatie tussen zĳden en punten en vergroot de efficiëntie van berekeningen.

Notitie: Het gereedschap Zĳden en punten herindexeren slaat de laag op en maakt de stapels voor
ongedaan/maken/opnieuw leeg, wat terugdraaien onmogelĳk maakt.
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18.5 Mazen berekenen

Het gereedschapMazen berekenen uit het bovenste menuMazen stelt u in staat rekenkundige en logische berekeningen
uit te voeren op bestaande groepen gegevenssets om een nieuwe groep gegevensset te maken (bekĳk Fig. 18.16).

Fig. 18.16: Mazen berekenen

De lĳst Gegevenssets bevat alle groepen gegevenssets in de actieve laag met mazen. Dubbelklik, om een groep
gegevensset in een expressie te gebruiken, op de naam in de lĳst en het zal worden toegevoegd aan het veldUitdrukking
voor mazen berekenen. U kunt dan de operatoren gebruiken om, expressies voor berekeningen te construeren, of u
kunt ze eenvoudigweg in het vak typen.
De Resultaatlaag helpt u eigenschappen voor de uitvoerlaag te configureren:

• Direct groep voor gegevensset maken in plaats van de laag naar schĳf te schrĳven:
– Indien niet geselecteerd wordt de uitvoer opgeslagen op schĳf als een nieuw gewoon bestand. Een pad
voor Uitvoerbestand en een Indeling uitvoer zĳn vereist.

– Indien geselecteerd zal een nieuwe groep voor de gegevensset worden toegevoegd aan de laag met mazen.
Waarden van de groep voor de gegevensset worden niet in het geheugen opgeslagen, maar elke gegevensset
wordt berekend als die nodig is in de formule die is ingevoerd in Mazen berekenen. Die virtuele groep
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voor de gegevensset wordt met het project opgeslagen, en indien nodig, kan hĳ worden verwĳderd of
permanent worden gemaakt in het bestand vanaf de tab Bron in de Laageigenschappen.

In beide gevallen zou u een Groepsnaam moeten opgeven voor de uitvoer groep voor de gegevensset.
• Het Ruimtelĳk bereik waarmee rekening moet worden gehouden voor berekenen mag zĳn:

– een Aangepast bereikt, handmatig gevuld met de coördinaten voor X min, X max, Y min en Y max, of
uitgenomen uit een bestaande groep voor de gegevensset (selecteer hem in de lĳst en druk opGeselecteerd
laagbereik gebruiken om de bovengenoemde velden voor coördinaten te vullen)

– gedefinieerd door een polygonenlaag (Maskeerlaag) van het project: de geometrie van de objecten
polygoon worden gebruikt om de gegevenssets van de laag met mazen te clippen

• De Tĳdperiodewaarmee rekeningmoet worden gehouden voor gegevenssets kan worden ingesteldmet de opties
Starttĳd en Eindtĳd, geselecteerd uit de bestaande tĳdstappen van de groepen voor gegevenssets. Ze kunnen
ook worden gevuld met de knop Alle geselecteerde tĳden van de gegevensset gebruiken om de gehele periode te
nemen.

Het gedeelte Operatoren bevat alle beschikbare operatoren. Klik, om een operator toe te voegen aan het expressievak
van Mazen berekenen, op de toepasselĳke knop. Rekenkundige berekeningen (+, -, *, … ) en statistische functies
(min, max, sum (aggr), average (aggr), … ) zĳn beschikbaar. Voorwaardelĳke expressies (=, !=, <, >=,
IF, AND, NOT, … ) geven ofwel 0 voor false of 1 voor true terug, en kunnen daarom worden gebruikt met andere
operatoren en functies. De waarde NODATA mag ook in de expressies worden gebruikt.
De widget Uitdrukking voor mazen berekenen geeft de expressie weer en laat u die bewerken om uit te voeren.
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Werken met vectortegels

19.1 Wat zijn vectortegels?

Vectortegels zĳn pakketten van geografische gegevens, verpakt in vooraf gedefinieerde ruwweg vierkant gevormde
“tegels” om te transporteren over het web. Zĳ combineren vooraf gedefinieerde rasterkaarttegels en vectorkaarttegels.
De server voor vectortegels geeft gegevens van vectorkaarten terug, die zĳn geclipt naar de begrenzingen van elke
tegel, in plaats van een vooraf gerenderde kaartafbeelding. De geclipte tegels geven de zoomniveaus weer van de
service voor de vectortegels, afgeleid van een piramide-achtige benadering. Door gebruik te maken van deze structuur,
wordt de overdracht van de gegevens verkleind in vergelĳking tot niet getegelde vectorkaarten. Alleen gegevens binnen
de huidige kaartweergave, en op het huidige zoomniveau, dienen te worden overgedragen. Ook, vergeleken met een
getegelde rasterkaart, wordt de overdracht van de gegevens enorm gereduceerd, omdat vectorgegevens gewoonlĳk
veel kleiner zĳn dan een gerenderde bitmap. Vectortegels hebben geen informatie voor opmaak aan zich toegewezen,
zodat QGIS een cartografische stĳl moet toepassen om de gegevens te kunnen weergeven.
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Fig. 19.1: Piramidestructuur van vectortegels met zoomniveaus

19.2 Ondersteunde indelingen

Er is ondersteuning voor vectortegels door:
• bronnen op afstand (HTTP/S) - met sjabloon XYZ - type=xyz&url=http://example.com/{z}/
{x}/{y}.pbf

• lokale bestanden - met sjabloon XYZ - bĳv. type=xyz&url=file:///pad/naar/tegels/{z}/
{x}/{y}.pbf

• lokale database MBTiles - bĳv. type=mbtiles&url=file:///pad/naar/bestand.mbtiles

Gebruik de tab Vectortegel in het dialoogvenster Databronnen beheren om een gegevensset met vectortegels in
QGIS te laden. Lees Vector tegelservices gebruiken voor meer details.
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19.3 Eigenschappen vectortegels gegevensset

19.3.1 Eigenschappen Informatie

De tab Informatie is alleen-lezen en is een interessante plek om snel wat overzichtsinformatie en metadata voor de
huidige laag op te pakken. Verschafte informatie is:

• gebaseerd op de provider van de laag: naam, URI, type bron en pad, aantal zoomniveaus
• het Coördinaten ReferentieSysteem: naam, eenheden, methode, nauwkeurigheid, verwĳzing (d.i. of het statisch
of dynamisch is)

• opgehaald uit de gevulde metadata: toegang, bereiken, links, contacten, geschiedenis…

19.3.2 Eigenschappen Symbologie en Label

Fig. 19.2: Symbologie voor vectortegellaag

Omdat vectortegels bestaan uit geometrieën punt, lĳn en polygoon, zĳn de respectievelĳke symbolen beschikbaar. U
moet, om een cartografische stĳl toe te passen, een Stĳl URL gebruiken bĳ het maken van de Verbinding vectortegels.

De symbologie zal onmiddellĳk worden weergegeven op de tab Symbologie nadat op de knop OK is geklikt.
U kunt, om uw eigen cartografische stĳl te definiëren, een set regels maken voor objecten en stĳl en label toepassen.
In Fig. 19.2 hebben we stĳl en labelen ingesteld voor de OpenStreetMap landuse-laag. De instellingen zĳn hier
gemaakt voor de klasse suburb. Voor betere zichtbaarheid zĳn de meeste regels niet geselecteerd.
Aan de onderzĳde wordt deHuidige zoomweergegeven. Selecteer de optieAlleen zichtbare regels om de lĳst met regels
te filteren tot alleen die welke zichtbaar zĳn op het opgegeven zoomniveau. Dit maakt het eenvoudiger te werken met
complexe opmaak voor vectors en om regels die problemen geven te lokaliseren. Stĳl en labelen kan afhankelĳk zĳn
van het zoomniveau.
Er is ook de optie om stĳlen te importeren. Deze stĳlen kunnen worden verschaft als:

• QML-bestanden (QML - De QGIS indeling voor stĳlbestand)
• MapBox GL Json stĳl configuratiebestanden
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19.3.3 Eigenschappen Metadata

De tab Metadata verschaft u opties om een rapport met metadata voor uw laag te maken en te bewerken. Bekĳk
Metadata voor meer informatie.
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Werken met puntenwolken

20.1 Introductie voor puntenwolken

Wat is een puntenwolk?
Een puntenwolk is een drie-dimensionale afbeelding van een ruimte die is opgemaakt door heel veel individuele
gegevenspunten (meer dan biljoenen, zelfs triljoenen). Elk van de punten heeft een X, Y en Z-coördinaat.
Afhankelĳk van de methode van vastleggen hebben puntenwolken gewoonlĳk ook aanvullende attributen die komen
uit het vastleggen, zoals kleurwaarden of intensiteit. Deze attributen kunnen worden gebruikt, bĳvoorbeeld, om
puntenwolken in verschillende kleuren weer te geven. In QGIS kan een puntenwolk worden gebruikt om een drie-
dimensionale afbeelding van het landschap (of een andere ruimte) te maken.
Ondersteunde indelingen
QGIS ondersteunt de indelingen voor gegevens Entwine Point Tile (EPT) en LAS/LAZ. QGIS slaat, bĳ het werken
met puntenwolken, de gegevens altĳd op in EPT. EPT is een indeling voor opslag die bestaat uit verschillende
bestanden, opgeslagen in een gedeelde map. EPT gebruikt indexeren om snelle toegang tot de gegevens mogelĳk
te maken. Voor meer informatie over de indeling EPT, bekĳk Entwine homepage
Als de gegevens in de indelingen LAS of LAZ staan, zal QGIS ze converteren naar EPT wanneer ze voor de eerste
keer worden geladen. Afhankelĳk van de grootte van het bestand zou dit enige tĳd kunnen vergen. In dit proces
wordt een submap gemaakt in de map waar het bestand LAS/LAZ is geplaatst, overeenkomstig het schema ept_
+ name_LAS/LAZ_file. Als een dergelĳke map al bestaat, laadt QGIS het EPT onmiddellĳk (wat leidt tot een
verkorte tĳd voor het laden).
Goed om te weten
In QGIS is het (nog) niet mogelĳk om puntenwolken te bewerken. Als u uw puntenwolk wilt bewerken kunt u
CloudCompare gebruiken, een open bron programma voor het bewerken van puntenwolken. Ook de Point Data
Abstraction Library (PDAL - soortgelĳk aan GDAL) biedt u opties om puntenwolken te bewerken (PDAL is alleen
voor de opdrachtregel).
Vanwege het grote aantal gegevenspunten is het niet mogelĳk om een attributentabel van puntenwolken weer te geven
in QGIS. Echter, het gereedschap Objecten identificeren ondersteunt puntenwolken, dus kunt u alle attributen
weergeven, zelfs van één enkel gegevenspunt.
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20.2 Eigenschappen Puntenwolken

Het dialoogvenster Laageigenschappen voor een laag met een puntenwolk biedt algemene instellingen voor de laag
en het renderen ervan. Het verschaft ook informatie over de laag.
Toegang tot het dialoogvenster Laag-eigenschappen:

• In het paneel Lagen, dubbelklik op de laag of klik met rechts en selecteer Eigenschappen… uit het contextmenu;
• Ga naar menu Kaartlagen ► Laageigenschappen… als de laag is geselecteerd.

Het puntenwolk dialoogvenster Laageigenschappen verschaft de volgende gedeelten:

Informatie Bron Symbologie[1]

3D-weergave[1] Renderen Hoogte[1]

Metadata Statistieken

[1] Ook beschikbaar in het paneel Laag opmaken

Notitie: De meeste eigenschappen van een puntenwolk laag kan worden opgeslagen naar of geladen uit een
bestand .qml met het menu Stĳl aan de onderzĳde van het dialoogvenster voor de eigenschappen. Meer details
in Laageigenschappen opslaan en delen

20.2.1 Eigenschappen Informatie

De tab Informatie is alleen-lezen en is een interessante plek om snel wat overzichtsinformatie en metadata over
de huidige laag op te pakken. Verschafte informatie is:

• Algemeen, zoals naam in het project, pad van de bron, laatste tĳd en grootte van opslaan, de gebruikte provider
• Gebaseerd op de provider van de laag: bereik en aantal punten
• Het Coördinaten ReferentieSysteem: naam, eenheden,methode, nauwkeurigheid, verwĳzing (d.i. of het statisch
of dynamisch is)

• Metadata geleverd door de provider: datum van maken, versie, indeling gegevens, schaal X/Y/Z, …

• Gekozen vanaf de tab Metadata (waar zĳ kunnen worden bewerkt): toegang, bereiken, links, contacten,
geschiedenis…
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Fig. 20.1: Puntenwolk tab Informatie

20.2.2 Eigenschappen Bron

Op de tab Bron kunt u basisinformatie over de puntenwolk laag bekĳken en bewerken:
• Instellingen: Stel een Laagnaam in die anders is dan de bestandsnaam van de laag die zal worden gebruikt om
de laag in het project te identificeren (in het Paneel Lagen, met expressies, in de legenda van de afdruklay-out,
…)

• Toegewezen Coördinaten ReferentieSysteem (CRS): Hier kunt u het aan de laag toegewezen Coördinaten
ReferentieSysteem wĳzigen. door een recent gebruikte te selecteren uit de keuzelĳst of te klikken op de knop

CRS selecteren (bekĳk Keuze Coördinaten ReferentieSysteem). Gebruik dit proces alleen als het op de laag
toegepaste CRS verkeerd is of als er geen werd gespecificeerd.
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Fig. 20.2: Puntenwolk tab Bron

20.2.3 Eigenschappen Symbologie

Op de tab Symbologie worden de instellingen voor het renderen van de puntenwolk. In het bovenste gedeelte
zĳn de instellingen voor de verschillende renderers voor de objecten te vinden. In het onderste gedeelte zĳn er delen
waarmee algemene instellingen voor de gehele laag kunnen worden gemaakt en die voorrang hebben boven renderers
voor objecten.

Typen renderer voor objecten

Er zĳn verschillende opties voor het renderen van puntenwolken die kunnen worden geselecteerd met het keuzemenu
aan de bovenzĳde van de tab Symbologie (zie Fig. 20.3):

• Alleen bereik: Alleen een begrenzingsvak van het bereik van de gegevens wordt weergegeven; handig voor
een overzicht van het bereik van de gegevens. Zoals gewoonlĳk helpt de widget Symbool u de eigenschappen
te configureren (kleur, dikte, opaciteit, sub-lagen, …) die u wilt voor het vak.

• Attributen per kleurverloop: De gegevens worden getekend met een kleurverloop. Bekĳk Renderer
Attributen per kleurverloop

• RGB: Teken de gegevens met waarden voor de kleuren rood, groen en blauw. Bekĳk Renderer RGB

• Classificatie: De gegevens worden getekend met verschillende kleuren voor verschillende klassen. Bekĳk
Renderer Classificatie

Wanneer een puntenwolk wordt geladen volgt QGIS logica om de beste renderer te selecteren:
• als de gegevensset informatie over kleuren bevat (attributen rood, groen, blauw), zal de renderer RGB worden
gebruikt

• anders als de gegevensset een attribuut Classificatie bevat, zal de renderer Classificatie worden gebruikt
• anders valt het terug op renderen dat is gebaseerd op het attribuut Z

Als u de attributen van de puntenwolk niet weet verschaft de tab Statistieken een goed overzicht van welke
attributen zĳn opgenomen in de puntenwolk en in welke bereiken de waarden zĳn geplaatst.
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Fig. 20.3: Puntenwolk tab Symbologie

Renderer Attributen per kleurverloop

Met Attributen per kleurverloop, kunnen de gegevens worden weergegeven op numerieke waarden met behulp
van een kleurverloop. Zulke numerieke waarden kunnen, bĳvoorbeeld, een bestaand attribuut Intensity of de waarde
Z zĳn. Afhankelĳk van een minimum en een maximum waarde, worden de andere waarden over het kleurverloop
verspreid via interpolatie. De afzonderlĳke waarden en hun toewĳzing aan een bepaalde kleur worden “kleurenkaart”
genoemd en worden in de tabel weergegeven. Er zĳn verschillende opties voor instellingen, die onder de afbeelding
beschreven worden.
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Fig. 20.4: Puntenwolk tab Symbologie: Attributen per kleurverloop

• Min enMax definiëren het bereik dat wordt toegepast op het kleurverloop: de waardeMin geeft het linker einde,
de waarde Max het rechter einde van het kleurverloop weer, de waarden daartussen worden geïnterpoleerd.
Standaard detecteert QGIS minimum en maximum uit het geselecteerde attribuut, maar zĳ kunnen worden
aangepast. Als u de waarden eenmaal hebt gewĳzigd, kunt u de standaard herstellen door te klikken op de
knop Laden.

• Het item Interpolatie definieert hoe waarden hun kleur krĳgen toegewezen:
– Afzonderlĳk (een symbool <= verschĳnt in de kop van de kolom Waarde): De kleur wordt genomen uit
het dichtstbĳzĳnde item van de kleurenkaart met een gelĳke of hogere waarde

– Lineair: De kleur wordt lineair geïnterpoleerd uit de items van de kleurenkaart boven en onder de
pixelwaarde, wat betekent dat elke waarde van de gegevensset correspondeert met een unieke kleur

– Exact (een symbool = verschĳnt in de kop van de kolom Waarde): Alleen op pixels met een waarde die
gelĳk is aan een item van de kleurenkaart wordt een kleur toegepast; andere worden niet gerenderd.

• DewidgetKleurverloop helpt u het aan de gegevensset toe te wĳzen kleurverloop te selecteren. Zoals gewoonlĳk
met dit widget, kunt u een nieuwe maken en bewerken of het huidige geselecteerde opslaan.

• Het Label voor achtervoegsel eenheid voegt een label toe na de waarde in de legenda, en de Precisie label beheert
het aantal decimalen dat moet worden weergegeven.

De classificatie Modus helpt u te definiëren hoe waarden over de klassen worden verdeeld:
• Doorgaand: Aantal en kleur van de klassen worden opgehaald uit de stappen van het kleurverloop;
grenswaarden worden ingesteld naar aanleiding van de verdeling van de stops in het kleurverloop (u kunt meer
informatie over stops vinden in Een kleurverloop instellen)..

• Gelĳke interval: het aantal klassen wordt ingesteld door het veld Klassen; grenzen van waarden worden
gedefinieerd, zodat de klassen allemaal dezelfde grootte hebben.

De klassen worden automatisch bepaald en weergegeven in de tabel met kleuren. Maar u kunt deze klassen ook
handmatig bewerken:

• Dubbelklikken op eenWaarde in de tabel: laat u de waarde van de klasse aanpassen.
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• Dubbelklikken in de kolom Kleur opent de widget Kleur selecteren, waar u een kleur kunt selecteren om toe te
passen op die waarde

• Dubbelklikken in de kolom Label laat u het label van de klasse aanpassen
• Met rechts klikken op geselecteerde rĳen in de kleurentabel geeft een contextmenu weer om Kleur wĳzigen…
en Opaciteit wĳzigen… voor de selectie.

Onder de tabel staan de opties om de standaard klassen te herstellen met Classificeren of om handmatig waarden
Toe te voegen of geselecteerde waarden te Verwĳderen uit de tabel.

Omdat een aangepaste kleurenkaart zeer complex kan zĳn is er ook de optie om een bestaande kleurenkaart te
Laden of voor het Opslaan om in andere lagen te gebruiken (als een bestand txt).
Als u Lineair hebt geselecteerd voor Interpolatie kunt u ook configureren:

• Clip buiten bereik van waarden Standaard wĳst de methode Lineair de kleur van de eerste klasse
(respectievelĳk de laatste klasse) toe aan waarden in de gegevensset die kleiner zĳn dan de ingestelde waarde
Min (respectievelĳk groter dan het ingestelde Max). Selecteer deze instelling als u deze waarden niet wilt
renderen.

• Instellingen Legenda voor het weergeven in het paneel Lagen en in het lay-out item Legenda. Aanpassen werkt
hetzelfde als voor een rasterlaag (Vind meer details op Legenda van raster aanpassen).

Renderer RGB

Met de renderer RGB zullen drie geselecteerde attributen uit de puntenwolk worden gebruikt als de rode, groene
en blauwe component. Als de attributen overeenkomstig worden benoemd, selecteert QGIS ze automatisch en haalt
de waarden Min en Max voor elke band op en brengt de kleur overeenkomstig op schaal. Het is echter ook mogelĳk
de waarden handmatig aan te passen.
Een methode voor Contrastverbetering kan worden toegepast voor de waarden: Geen verbetering, Stretch tot MinMax,
Stretch e clip tot MinMax en Clip naar MinMax

Notitie: Het gereedschap Contrastverbetering is nog steeds in ontwikkeling. Als u er problemen mee hebt, zou u de
standaard instelling Stretch tot MinMax moeten gebruiken.

Fig. 20.5: De puntenwolk renderer RGB
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Renderer Classificatie

Met de renderer Classificatie wordt de puntenwolk weergegeven met een verschil in kleur op basis van een
attribuut. Elk type attribuut mag worden gebruikt (numeriek, tekenreeks, …). Gegevens van puntenwolken bevatten
vaak een veld genaamd Classificatie. Dat bevat doorgaans gegevens die automatisch kunnen worden bepaald
door nabewerken, bĳv. over vegetatie. Met Attribuut kunt u het veld selecteren uit de attributentabel dat zal worden
gebruikt voor de classificatie. Standaard gebruikt QGIS de definities van de specificatie van LAS (bekĳk de tabel
‘ASPRS Standard Point Classes’ in de PDF op ASPRS homepage). De gegevens kunnen echter afwĳken van dit
schema; in geval van twĳfel, zult u naar de definities moeten vragen aan degene of het instituut waar u de gegevens
van hebt ontvangen.

Fig. 20.6: De puntenwolk renderer Classificatie

In de tabel worden alle gebruikte waarden weergegeven met de corresponderende kleur en legenda. Aan het begin van
elke rĳ staat een keuzevak ; als dat niet is geselecteerd wordt deze waarde niet langer weergegeven op de kaart.
Met een dubbelklik in de tabel kunnen de Kleur, de Waarde en de Legenda worden aangepast (voor de kleur opent
de widget Kleur selecteren).
Onder de tabel staan knoppen waarmee u de standaard klassen, gemaakt door QGIS, kunt wĳzigen:

• Met de knopClassificeren kunnen de gegevens automatischworden geclassificeerd: alle waarden die voorkomen
in de attributen en nog niet in de tabel staan worden toegevoegd

• Met Toevoegen en Verwĳderen kunnen waarden handmatig worden toegevoegd of verwĳderd
• Alles verwĳderen verwĳdert alle waarden uit de tabel

Hint: In het paneel Lagen kunt u met rechts klikken op een item van een klasse van een laag om snel de zichtbaarheid
van de overeenkomende objecten te configureren.
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Puntsymbool

Onder Puntsymbool, kunnen de grootte en eenheid (bĳv. millimeters, pixels, inches) waarmee elk gegevenspunt wordt
weergegeven worden ingesteld. Ofwel Cirkel of Vierkant kan worden geselecteerd als de stĳl voor de punten.

Renderen van lagen

In het gedeelte Renderen van lagen heeft u de volgende opties om het renderen van de laag aan te passen:
• Tekenvolgorde: maakt het mogelĳk te beheren of de volgorde van renderen voor puntenwolken op 2D-
kaartvenster zou moeten bepaald op het waarde Z. Het is mogelĳk te renderen :

– in de volgorde Standaard waar de punten mee zĳn opgeslagen in de laag,
– met Van beneden naar boven (punten met een grotere waarde Z bedekken lagere punten, wat het uiterlĳk
van een echte ortho-foto geeft),

– of met Van boven naar beneden waarmee de scene verschĳnt als wordt hĳ van onder bekeken.
• Maximum fout: Puntenwolken bevatten gewoonlĳk meer punten dan nodig zĳn voor het weergeven. Met deze
optie stelt u in hoe dicht of schraal de weergave van de puntenwolk zal zĳn (dit kan ook worden begrepen als
‘maximale toegestane gat tussen punten’). Als u een hoog getal invoert (bĳv. 5 mm), zullen er zichtbare gaten
tussen de punten zĳn. Lage waarde (bĳv. 0.1 mm) zou het renderen van een onnodig aantal punten kunnen
forceren, wat het renderen trager maakt (verschillende eenheden kunnen worden geselecteerd).

• Opaciteit: U kunt hiermee onderliggende lagen zichtbaar maken in het kaartvenster. Gebruik de schuifbalk om
de transparantie van de geselecteerde vectorlaag aan te passen naar uw behoeften. U kunt ook een precieze
definitie voor het percentage voor de transparantie invullen in het menu naast de schuifbalk.

• Meng-modus: Met dit gereedschap kunt u speciale effecten op de kaart toepassen. De pixels van de overliggende
en onderliggende lagen worden vermengd volgens de instellingen zoals beschreven in Meng-modi.

• Eye dome lighting: dit past effecten voor schaduw toe op het kaartvenster voor het beter renderen van de diepte.
Kwaliteit van het renderen is afhankelĳk van de eigenschap tekenvolgorde; de tekenvolgorde Standaard zou
sub-optimale resultaten kunnen geven. De volgende parameters kunnen worden beheerd:

– Sterkte: vergroot het contrast, maakt een betere perceptie voor diepte mogelĳk
– Afstand: geeft de afstand weer tussen de gebruikte pixels vanaf de pixel van het middelpunt en heeft het
effect van het dikker maken van de randen.

20.2.4 Eigenschappen 3D-weergave

Op de tab 3D-weergave kunt u de instellingen maken voor het renderen van de puntenwolk in 3D-kaarten.

Modi 3D renderen

De volgende opties kunnen worden geselecteerd uit het keuzemenu aan de bovenzĳde van de tab:
• Niet renderen: Gegevens worden niet weergegeven
• 2D-symbologie volgen: Synchroniseert objecten bĳ het renderen in 3D met symbologie die is toegewezen voor

2D

• Enkele kleur: Alle punten worden weergegeven in dezelfde kleur ongeacht hun attributen

• Attributen per kleurverloop: Interpoleert een opgegeven attribuut over een kleurverloop en wĳst de objecten
hun overeenkomende kleur toe. Bekĳk Renderer Attributen per kleurverloop

• RGB: Gebruik verschillende attributen van de objecten om de kleurcomponenten Rood, Groen en Blauw
in te stellen om ze toe te kunnen wĳzen. Bekĳk Renderer RGB.
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• Classificatie: Differentieert punten op hun kleur op basis van een attribuut Bekĳk Renderer Classificatie.

Fig. 20.7: De puntenwolk tab 3D-weergave met de renderer Classificatie

3D-puntsymbool

In het onderste gedeelte van de tab 3D-weergave vindt u het gedeelte Puntsymbool. Hier kunt u voor de gehele
laag algemene instellingen maken die hetzelfde zĳn voor alle renderers. Er zĳn de volgende opties:

• Grootte punt: De grootte (in pixels) waarmee elk gegevenspunt wordt weergegeven kan worden ingesteld
• Max. schermruimte fout: Met deze optie stelt u in hoe dicht of schraal de weergave van de puntenwolk zal zĳn
(in pixels). Als u een groot getal instelt (bĳv. 10), zullen er zichtbare gaten tussen de punten zĳn; lage waarde
(bĳv. 0) zou renderen van een onnodig aantal punten kunnen forceren, wat het renderen trager maakt (u kunt
meer details vinden in Symbologie Maximum fout).

• Budget punt: U kunt het maximale aantal te renderen punten instellen om lang renderen te vermĳden
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• Selecteer Renderen als oppervlakte (Trianguleren) om de laag van de puntenwolk in de 3D-weergave
te renderen met een gevuld oppervlak, verkregen uit triangulatie. U kunt de dimensies van de berekende
driehoeken beheren:

– Driehoeken overslaan die langer zĳn dan een drempelwaarde: stelt het horizontale vlak in, de
maximale lengte van een zĳde van de driehoeken om rekening mee te houden

– Driehoeken overslaan die groter zĳn dan een drempelwaarde: stelt het verticale vlak in, de maximale
hoogte van een zĳde van de driehoeken om rekening mee te houden

• Begrenzingsvakken tonen: Speciaal nuttig bĳ debuggen, geeft de begrenzingsvakken van knopen weer in
hiërarchie

20.2.5 Rendering

Onder het groepsvak Schaalafhankelĳke zichtbaarheid, kunt u de schaalMaximum (inclusief) enMinimum (exclusief)
instellen, wat een bereik van schalen definieert waarin objecten zichtbaar zullen zĳn. Buiten dit bereik is hĳ verborgen.
De knop Op huidige schaal kaartvenster instellen helpt u de schaal van het huidige kaartvenster te gebruiken als grens voor
de zichtbaarheid van het bereik. Bekĳk Schaal zichtbaarheid selecteren voor meer informatie.

Notitie: U kunt het schaalafhankelĳk renderen ook activeren op een laag vanuit het paneel Lagen. Klik met rechts
op de laag en selecteer in het contextmenu, Zichtbaarheidsschaal laag instellen.

Fig. 20.8: De puntenwolk tab Renderen

20.2.6 Eigenschappen hoogte

Op de tab Hoogte kunt u correcties instellen voor de waarden Z van de gegevens. Dit zou nodig kunnen zĳn om
de hoogte van de gegeven in 3D-kaarten aan te passen en het uiterlĳk in de diagrammen van het profiel. Er zĳn twee
opties voor de instelling:

• Onder de groep Hoogte:
– U kunt een Schaal instellen: Als 10 hier wordt ingevoerd zal een punt, dat een waarde Z = 5 heeft, worden
weergegeven op een hoogte van 50.

– Een Verschuiving naar het niveau Z kan worden ingevoerd. Dit is nuttig om verschillende databronnen,
ten opzichte van elkaar, in hoogte overeen te laten komen. Standaard wordt de laagste waarde Z die is
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opgenomen in de gegevens als deze waarde gebruikt. Deze waarde kan ook worden hersteld met de knop
Vernieuwen aan het einde van de regel.

• Under Nauwkeurigheid diagram profiel, de Maximum fout helpt u beheren hoe dicht of schaarser bĳ elkaar
de punten zullen worden gerenderd in het hoogteprofiel. Grotere waarden resulteren in een sneller maken met
minder opgenomen punten.

• Onder Uiterlĳk diagram profiel kunt u de weergave van de punten beheren:
– Grootte punt: de grootte waarmee de punten gerenderd moeten worden, in ondersteunde eenheden
(millimeters, kaarteenheden, pixels, …)

– Stĳl: of de punten als Cirkel of Vierkant moeten worden gerenderd
– Pas één enkele Kleur toe op alle zichtbare punten in de weergave van het profiel

– Selecteer Kleur laag respecteren om in plaats daarvan de punten weer te geven met de in hun 2D
symbology toegewezen kleur

– Opaciteit bĳ afstand effect van boog toepassen verklein de opaciteit van punten die verder weg liggen
van boog van het profiel

Fig. 20.9: De puntenwolk tab Hoogte

20.2.7 Metadata

De tab Metadata verschaft u opties om een rapport met metadata voor uw laag te maken en te bewerken. Bekĳk
Metadata voor meer informatie.
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20.2.8 Eigenschappen Statistieken

Op de tab Statistieken kunt u een overzicht krĳgen van de attributen van uw puntenwolk en hun verdeling.
Aan de bovenzĳde vindt u het gedeelte Statistieken attribuut. Hier worden alle attributen die zĳn opgenomen
in de puntenwolk vermeld, als ook enkele van hun statistische waarden: Minimum, Maximum, Gemiddelde,
Standaardafwĳking

Als er een attribuut Classificatie is, dan is er een andere tabel in het onderste gedeelte. Hier worden alle waarden die
zĳn opgenomen in de attributen vermeld, als ook hun absolute Aantal en relatieve overvloed%.

Fig. 20.10: De puntenwolk tab Statistieken
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De kaarten opmaken

Met afdruklay-outs en rapporten kunt u kaarten en atlassen maken, en ze afdrukken of opslaan als afbeelding, PDF-
of SVG-bestanden.

21.1 Overzicht van de afdruklay-out

De afdruklay-out verschaft een groeiend aantal mogelĳkheden voor lay-out en afdrukken. Het stelt u in staat elementen
toe te voegen zoals het kaartvenster van QGIS, tekstlabels, afbeeldingen, legenda’s, schaalbalken, basisvormen, pĳlen,
attributentabellen en HTML-objecten. U kunt elk element wĳzigen van grootte, groeperen, uitlĳnen, roteren en de
positie bepalen en hun eigenschappen aanpassen om uw lay-out te maken. De lay-out kan worden afgedrukt of
geëxporteerd naar indelingen voor afbeeldingen, PostScript, PDF of naar SVG. U kunt de lay-out opslaan als een
sjabloon en het opnieuw laden in een andere sessie. Tenslotte kunnen verscheidene kaarten worden gemaakt die zĳn
gebaseerd op een sjabloon met behulp van de atlas-generator.

21.1.1 Voorbeeldsessie voor beginners

Vóórdat u begint te werken met de afdruklay-out dient u enkele raster- of vectorlagen te laden in het kaartvenster
van QGIS en hun eigenschappen aan te passen om te voldoen aan uw eigen wensen. Nadat alles volgens uw wensen
is gerenderd en gesymboliseerd, klik op het pictogram Nieuwe afdruklay-out op de werkbalk Project of kies Project ►

Nieuwe afdruklay-out. U zult naar een nieuwe titel worden gevraagd voor de nieuwe afdruklay-out.
Volg de volgende instructies om te demonstreren hoe een kaart te maken.

1. Selecteer, aan de linkerkant, de knop voor de werkbalk Kaart toevoegen en teken een rechthoek in het
kaartvenster, ondertussen de linkermuisknop ingedrukt houdend. Binnen de getekende rechthoek verschĳnt
de kaartweergave van QGIS in het kaartvenster.

2. Selecteer de knop voor de werkbalk Schaalbalk toevoegen en plaats het item met de linkermuisknop op het
kaartvenster van afdruklay-out. Een schaalbalk zal aan het kaartvenster worden toegevoegd

3. Selecteer de knop voor de werkbalk Legenda toevoegen en teken, met de linkermuisknop ingedrukt, een
rechthoek in het kaartvenster. Binnen de getekende rechthoek zal de legenda worden getekend.
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4. Selecteer het pictogram Item selecteren/verplaatsen om de kaart op het kaartvenster te selecteren en die enigszins
te verplaatsen.

5. Terwĳl de kaart nog steeds geselecteerd is kunt u ook de grootte van het kaartitem wĳzigen. Klik, terwĳl u de
linkermuisknop ingedrukt houdt, in een kleine witte rechthoek in een van de hoeken van het kaartitem en sleep
die naar een nieuwe locatie om de grootte te wĳzigen.

6. Klik op het paneel Item-eigenschappen van het linker onderste paneel en zoek naar de instelling voor de
oriëntatie. Wĳzig de waarde van de instelling Rotatie naar ‘15.00°’. U zou de oriëntatie van het kaartitem
moeten zien wĳzigen.

7. Nu kunt u uw afdruklay-out afdrukken of exporteren naar indelingen voor afbeeldingen, PDF of naar SVG
met de gereedschappen voor exporteren in het menu Lay-out.

8. Tenslotte kunt u uw afdruklay-out opslaan in het projectbestand met de knop Project opslaan.
U kunt meerdere items toevoegen aan de afdruklay-out. Het is ook mogelĳk om meer dan één kaartweergave of
legenda of schaalbalk in het kaartvenster van afdruklay-out te hebben, op één of verscheidene pagina’s. Elk item
heeft zĳn eigen eigenschappen en, in het geval van de kaart, zĳn eigen bereik. Als u een item uit het kaartvenster van
afdruklay-out wilt verwĳderen kunt u dat doen met de toetsen Delete of Backspace.

21.1.2 Lay-out beheren

Lay-out beheren is het hoofdvenster om de afdruklay-outs in het project te beheren. Het geeft u een overzicht van de
bestaande afdruklay-outs en rapporten in het project en biedt gereedschappen om:

• zoeken naar een lay-out;
• nieuwe afdruklay-outs of rapporten vanaf nul toe te voegen, vanuit sjabloon of een bestaande te dupliceren;
• elk van hen te hernoemen of te verwĳderen;
• ze in het project te openen.

Het dialoogvenster Lay-out beheren openen:

• vanuit het dialoogvenster van QGIS, selecteer het menu Project ► Lay-out beheren… of klik op de knop
Lay-out beheren weergeven op de werkbalk Project;

• vanuit een dialoogvenster in een afdruklay-out of rapport, selecteer het menu Lay-out► Lay-out beheren… of
klik op de knop Lay-out beheren op de werkbalk Lay-out;

Fig. 21.1: Lay-out beheren
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Lay-out beheren vermeldt in zĳn bovenste gedeelte alle beschikbare afdruklay-outs of rapporten in het project met
de gereedschappen om:

• de selectie weer te geven: u kunt meerdere rapporten en/of afdruklay-outs selecteren en ze met één klik openen.
Dubbelklikken op een naam opent het;

• de geselecteerde lay-out of rapport te dupliceren (alleen beschikbaar als slechts één item is geselecteerd): het
maakt een nieuw dialoogvenster met de geselecteerde als sjabloon. U zult worden gevraagd om een nieuwe titel
voor de nieuwe lay-out te kiezen;

• het rapport of de lay-out te hernoemen (ook slechts beschikbaar als één item is geselecteerd): u zult worden
gevraagd om een nieuwe titel voor de nieuwe lay-out te kiezen.

• de lay-out te verwĳderen: de geselecteerde afdruklay-out(s) zullen uit het project worden verwĳderd.
In het onderste gedeelte is het mogelĳk nieuwe afdruklay-outs of rapporten vanaf nul of vanuit een sjabloon te
maken. Standaard zal QGIS zoeken naar sjablonen in het gebruikersprofiel en de sjabloonmappen voor de toepassing
(toegankelĳk met de twee knoppen aan de onderzĳde van het frame), maar ook in elke map die is vermeld in Pad(en)
om te zoeken naar extra sjablonen voor afdrukken in Extra ► Opties ► Lay-outs. Gevonden sjablonen worden in het
combinatievak vermeld. Selecteer een item en druk op de knop Maken om een nieuw rapport of afdruklay-out te
maken.
U kunt ook sjablonen voor lay-outs gebruiken uit een aangewezen map; selecteer in dat geval Specifiek in de keuzelĳst
voor sjablonen, blader naar de sjabloon en druk op Maken.

Tip: Op sjablonen gebaseerde afdruklay-outs maken vanuit het paneel Browser
Sleep en zet een bestand .qpt voor een sjabloon van een afdruklay-out vanuit een bestandsbeheerder in het
kaartvenster of dubbelklikken erop in het paneel Browser maakt een nieuwe afdruklay-out uit de sjabloon.

21.1.3 Menu’s, gereedschappen en panelen van de afdruklay-out

Openen van de afdruklay-out verschaft u een blanco kaartvenster dat het papieren oppervlakte vertegenwoordigt
wanneer u de optie Afdrukken gebruikt. Initieel vindt u aan de linkerkant naast het kaartvenster knoppen om items
toe te voegen aan de lay-out: het huidige kaartvenster van QGIS, tekstlabels, afbeeldingen, legenda’s, schaalbalken,
basisvormen, pĳlen, attributentabellen en HTML-objecten. Op deze werkbalk vindt u ook knoppen om te navigeren,
in te zoomen op een gebied en het beeld van de lay-out te verschuiven en ook knoppen om een item voor de lay-out
te selecteren en de inhoud van het kaartitem te verplaatsen.
Fig. 21.2 toont de initiële weergave van de afdruklay-out vóórdat daaraan elementen zĳn toegevoegd.

21.1. Overzicht van de afdruklay-out 723



QGIS Desktop 3.28 User Guide

Fig. 21.2: Afdruklay-out

Rechts naast het kaartvenster vindt u twee panelen. Het bovenste bevat de panelen Items en Geschiedenis Ongedaan
maken en het onderste bevat de panelen Lay-out, Item-eigenschappen en Atlas-generatie.

• Het paneel Items verschaft een lĳst van alle items voor afdruklay-out die zĳn toegevoegd aan het kaartvenster
en manieren om daar globaal mee te werken (bekĳk Het paneel Items voor meer informatie).

• Het paneel Geschiedenis Ongedaan maken geeft de geschiedenis weer van alle wĳzigingen die zĳn toegepast
op de lay-out. Met een muisklik is het mogelĳk om heen en weer stappen in de lay-out ongedaan te maken of
opnieuw te doen tot een bepaalde status.

• Het paneel Lay-out stelt u in staat algemene parameters in te stellen om op de lay-out toe te passen bĳ het
exporteren of bĳ het werken ermee (bekĳk Het paneel Lay-out voor meer details);

• Het paneel Item-eigenschappen geeft de eigenschappen weer voor het geselecteerde item. Klik op het pictogram
Item selecteren/verplaatsen om een item te selecteren (bĳv., legenda, schaalbalk of label) in het kaartvenster. Klik

dan op het paneel Item-eigenschappen en pas de instelling voor het geselecteerde item aan (bekĳk Lay-out items
voor gedetailleerde informatie over elke instelling voor het item).

• Het paneel Atlas stelt u in staat een atlas te maken voor de huidige afdruklay-out en geeft toegang tot de
parameters daarvan (bekĳk Een atlas genereren voor gedetailleerde informatie over het gebruiken van Atlas
genereren).

In het onderste gedeelte van het venster van afdruklay-out vindt u een statusbalk met daarin de positie van de muis,
huidige paginanummer, een combinatievak voor het instellen van het niveau van zoomen, het aantal geselecteerde
items indien van toepassing en, in geval van Atlas genereren, het aantal objecten.
In het bovenste gedeelte van het venster van afdruklay-out vindt u menu’s en andere werkbalken. Alle gereedschappen
voor afdruklay-out zĳn beschikbaar in menu’s en als pictogrammen op een werkbalk.
De werkbalken en panelen kunnen in- en uitgeschakeld worden met de rechtermuisknop boven een werkbalk of via
Beeld ►Werkbalken ► of Beeld ► Panelen ►.
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Menu’s en gereedschappen

Menu Lay-out

Het menu Lay-out verschaft acties om de lay-out te beheren:
• Het projectbestand direct vanuit het venster van de afdruklay-out opslaan.

• Een nieuwe, blanco afdruklay-out te maken met Nieuwe lay-out….

• Lay-out dupliceren… : Maak een nieuwe afdruklay-out door de huidige te kopiëren.

• De huidige afdruklay-out te verwĳderen met Lay-out verwĳderen….

• Lay-out beheren… te openen.
• Lay-outs ► : Een bestaande afdruklay-out te openen.

Als de lay-out eenmaal is ontworpen kunt u met Als sjabloon opslaan en Items uit sjabloon toevoegen de
huidige status van een sessie van afdruklay-out opslaan als een .qpt-sjabloonbestand en items ervan opnieuw laden
in een andere sessie/afdruklay-out.
In het menu Lay-out zĳn ook krachtige manieren aanwezig om geografische informatie, geproduceerd met QGIS,
te delen die kan worden opgenomen in rapporten of gepubliceerd. Deze gereedschappen zĳn Als afbeelding

exporteren…, Als PDF exporteren…, Als SVG exporteren… en Afdrukken….
Hieronder staat een lĳst van alle beschikbare gereedschappen in dit menu met enige handige informatie.

Gereedschap Sneltoets Werkbalk Verwijzing

Project opslaan Ctrl+S Lay-out Introductie van projecten van QGIS

Nieuwe lay-out Ctrl+N Lay-out Lay-out beheren

Lay-out dupliceren Lay-out Lay-out beheren

Lay-out verwĳderen

Lay-out beheren… Lay-out Lay-out beheren
Lay-outs ►
Eigenschappen Lay-out… Het paneel Lay-out
Lay-out hernoemen…

Pagina’s toevoegen… Lay-out Werken met de pagina-eigenschappen

Items uit sjabloon toevoegen Lay-out Een item voor lay-out maken

Als sjabloon opslaan… Lay-out Lay-out beheren

Als afbeelding exporteren… Lay-out Als afbeelding exporteren

Als SVG exporteren… Lay-out Exporteren naar SVG

Als PDF exporteren… Lay-out Als PDF exporteren
Pagina-instellingen… Ctrl+Shift+P

Afdrukken… Ctrl+P Lay-out Een uitvoer maken
Sluiten Ctrl+Q
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Menu Bewerken

Het menu Bewerken biedt gereedschappen om items voor afdruklay-out te bewerken. Het bevat veelvoorkomende
acties zoals gereedschappen om te selecteren, Kopiëren/Knippen/Plakken en functionaliteit Ongedaan
maken/Opnieuw (bekĳk Paneel Geschiedenis Ongedaan maken: acties Ongedaan maken en Opnieuw) voor de
items in de lay-out.
Bĳ het gebruiken van de actie Plakken zullen de items worden geplakt overeenkomstig de huidige positie van de muis.
Gebruiken van de actie Bewerken ► In plaats plakken of drukken op Ctrl+Shift+V zal de items in de huidige
pagina plakken, op dezelfde plaats als waar zĳ op de initiële pagina stonden. Dit zorgt er voor dat items op dezelfde
plek worden gekopieerd/geplakt, van pagina naar pagina.
Hieronder staat een lĳst van alle beschikbare gereedschappen in dit menu met enige handige informatie.

Tabel 21.1: Beschikbare gereedschappen
Gereedschap Sneltoets Werkbalk Verwijzing

Ongedaan maken (laatste
wĳziging)

Ctrl+Z Lay-out Paneel Geschiedenis Ongedaan maken:
acties Ongedaan maken en Opnieuw

Opnieuw (laatste ongedaan
gemaakte wĳziging)

Ctrl+Y Lay-out Paneel Geschiedenis Ongedaan maken:
acties Ongedaan maken en Opnieuw

Verwĳderen Del

Knippen Ctrl+X

Kopiëren Ctrl+C

Plakken Ctrl+V
In plaats plakken Ctrl+Shift+V

Alles selecteren Ctrl+A

Alles deselecteren Ctrl+Shift+A

Selectie omdraaien
Selecteer volgende item Ctrl+Alt+[
Selecteer vorige item Ctrl+Alt+]

Lay-out verschuiven P Toolbox

In-/Uitzoomen Z Toolbox

Item selecteren/verplaatsen V Toolbox Werken met items voor lay-out

Inhoud verschuiven C Toolbox Het kaartitem

Item Knopen bewerken Toolbox De op knopen gebaseerde vormen

Menu Beeld

Het menu Beeld geeft toegang tot gereedschappen voor navigatie en helpt bĳ het configureren van het algemene
gedrag van de afdruklay-out. Naast de algemene gereedschappen voor zoomen, kunt u:

• Scherm verversen (als u merkt dat het scherm zich niet in een consistente status bevind);
• een raster inschakelen waaraan u items kunt snappen bĳ het verplaatsen of maken ervan. Instellen van het raster
wordt gedaan in Instellingen ► Opties voor lay-out… of in het paneel Lay-out;

• hulplĳnen inschakelen waaraan u items kunt snappen bĳ het verplaatsen of maken ervan. Hulplĳnen zĳn rode
lĳnen waarop u kunt klikken in de liniaal (boven of aan de linkerkant van de lay-out) en ze slepen en neerzetten
op de gewenste locatie;
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• Slimme hulplĳnen gebruiken: gebruikt andere items voor lay-out als hulplĳnen om dynamisch aan te snappen
als u een item verplaatst of de vorm ervan wĳzigt;

• Hulplĳnen verwĳderen om alle huidige hulplĳnen te verwĳderen;
• Begrenzingsvakken tonen rondom de items om uw selectie beter te kunnen identificeren;
• Linialen tonen rondom de lay-out;
• Pagina’s weergeven of pagina’s instellen op transparant. Vaak wordt afdruklay-out gebruikt voor het maken
van lay-outs die niet moeten worden afgedrukt, bĳv. om op te nemen in presentaties of andere documenten,
en is het gewenst om de lay-out te exporteren met een volledig transparante achtergrond. Soms wordt er naar
verwezen als naar een “oneindig kaartvenster” in andere programma’s voor bewerken.

In de afdruklay-out kunt u het niveau van zoomen ookwĳzigenmet hetmuiswiel of de schuifbalk en het combinatievak
in de statusbalk. Als u moet schakelen naar de modus Schuiven, terwĳl u werkt in het gebied van de lay-out, kunt u
de Spatiebalk of het muiswiel ingedrukt houden. Met Ctrl+spatiebalk kunt u tĳdelĳk overschakelen naar
de modus Inzoomen en met Ctrl+Alt+spatiebalk naar de modus Uitzoomen.
Panelen enwerkbalken kunnenworden ingeschakeld in hetmenuBeeld►.Voor hetmaximaliseren van de beschikbare
ruimte om te kunnen werken met lay-out kunt u de optie Beeld ► Zichtbaarheid paneel aan/uit selecteren of
drukken op Ctrl+Tab; alle panelen worden verborgen en alleen eerder zichtbare panelen worden hersteld bĳ het
deselecteren.
Het is ook mogelĳk om naar een modus Volledig scherm te schakelen om meer ruimte te hebben om te werken door
te drukken op F11 of Beeld ► Volledig scherm schakelen te gebruiken.
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Gereedschap Sneltoets Werkbalk Verwijzing

Bĳwerken F5 Navigatie
Voorbeeld ►

Inzoomen Ctrl++ Navigatie

Uitzoomen Ctrl+- Navigatie

Zoomen naar 100% Ctrl+1 Navigatie

Volledig zoomen Ctrl+0 Navigatie
Zoom naar breedte

Grid tonen Ctrl+' Hulplĳnen en raster

Aan grid snappen Ctrl+Shift+' Hulplĳnen en raster

Hulplĳnen tonen Ctrl+; Hulplĳnen en raster

Aan hulplĳnen snappen Ctrl+Shift+; Hulplĳnen en raster

Slimme hulplĳnen Ctrl+Alt+;
Hulplĳnen beheren… Het paneel Hulplĳnen

Hulplĳnen verwĳderen Het paneel Hulplĳnen

Linialen tonen Ctrl+R

Begrenzingsvakken toenen Ctrl+Shift+B

Pagina’s weergeven
Werkbalken ► Panelen en werkbalken

Panelen ► Panelen en werkbalken

Volledig scherm schakelen F11 Beeld

Zichtbaarheid paneel aan/uit Ctrl+Tab Beeld

Menu Items

Het menu Items helpt u bĳ het configureren van de positie van de items in de lay-out en de onderlinge relaties (bekĳk
Werken met items voor lay-out).
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Gereedschap Sneltoets Werkbalk Verwijzing

Groeperen Ctrl+G Acties Items groeperen

Groeperen ongedaan maken Ctrl+Shift+G Acties Items groeperen

Omhoog Ctrl+] Acties Uitlĳning en verdeling

Omlaag Ctrl+[ Acties Uitlĳning en verdeling

Naar voorgrond Ctrl+Shift+] Acties Uitlĳning en verdeling

Naar achtergrond Ctrl+Shift+[ Acties Uitlĳning en verdeling

Geselecteerde items vastzetten Ctrl+L Acties Items vastzetten

Alles losmaken Ctrl+Shift+L Acties Items vastzetten
Items uitlĳnen ► Acties Uitlĳning en verdeling
Items verdelen ► Acties Items verplaatsen en grootte wĳzigen
Grootte aanpassen ► Acties Items verplaatsen en grootte wĳzigen

Menu Items toevoegen

Dit zĳn gereedschappen om items voor lay-out te maken. Elk ervan wordt gedetailleerd beschreven in het hoofdstuk
Lay-out items.

Gereedschap Werkbalk Verwijzing

Kaart toevoegen Toolbox Het kaartitem

3D-kaart toevoegen Toolbox Het 3D-kaartitem

Afbeelding toevoegen Toolbox Het item Afbeelding

Label toevoegen Toolbox Het item Label
Dynamische tekst toevoegen ► Het item Label

Legenda toevoegen Toolbox Het item Legenda

Schaalbalk toevoegen Toolbox Het item Schaalbalk

Noordpĳl toevoegen Toolbox Het item Noordpĳl

Vorm toevoegen ► Toolbox Het item regelmatige vorm

► Rechthoek toevoegen Toolbox Het item regelmatige vorm

► Ellipse toevoegen Toolbox Het item regelmatige vorm

► Driehoek toevoegen Toolbox Het item regelmatige vorm

Markering toevoegen Toolbox Het item Markering

Pĳl toevoegen Toolbox Het item Pĳl

Item Knoop toevoegen ► Toolbox De op knopen gebaseerde vormen

► Polygoon toevoegen Toolbox De op knopen gebaseerde vormen

► Polylĳn toevoegen Toolbox De op knopen gebaseerde vormen

HTML toevoegen Toolbox Het item HTML-frame

Attributentabel toevoegen Toolbox Het item attributentabel

Vaste tabel toevoegen Toolbox Het item Vaste tabel

21.1. Overzicht van de afdruklay-out 729



QGIS Desktop 3.28 User Guide

Menu Atlas

Gereedschap Sneltoets Werkbalk Verwijzing

Voorbeeld Atlas Ctrl+ALt+/ Atlas Voorbeeld en maken van een atlas

Eerste object Ctrl+< Atlas Voorbeeld en maken van een atlas

Vorige object Ctrl+, Atlas Voorbeeld en maken van een atlas

Volgende object Ctrl+. Atlas Voorbeeld en maken van een atlas

Laatste object Ctrl+> Atlas Voorbeeld en maken van een atlas

Atlas afdrukken… Atlas Voorbeeld en maken van een atlas

Atlas als afbeeldingen exporteren… Atlas Voorbeeld en maken van een atlas

Atlas als SVG exporteren… Atlas Voorbeeld en maken van een atlas

Atlas als PDF exporteren… Atlas Voorbeeld en maken van een atlas

Instellingen voor Atlas Atlas Een atlas genereren

Menu Instellingen

Het menu Instellingen ► Opties voor lay-out… is een sneltoets naar het menu Extra ► Opties ► Lay-outs van het
hoofdvenster van QGIS. Hier kunt u enkele opties instellen die als standaard zullen worden gebruikt voor een nieuwe
afdruklay-out:

• Standaard lay-outs laat u het standaard te gebruiken lettertype specificeren;
• Met Ruitennetweergave kunt u de stĳl voor het raster en de kleur daarvan instellen. Er zĳn drie typen raster:
Stippels, Doorgetrokken lĳnen en Kruisjes;

• Standaarden voor raster en hulplĳnen definieert afstand, verschuiving en tolerantie van het raster (bekĳk
Hulplĳnen en raster voor meer details);.

• Paden voor lay-outs: om een lĳst van aangepaste paden te beheren om te zoeken naar sjablonen voor afdruklay-
outs.

Contextmenu’s

Afhankelĳk van waar u met rechts klikt in het dialoogvenster van afdruklay-out, opent u een contextmenu met
verschillende mogelĳkheden:

• Klik met rechts op de menubalk of een andere werkbalk en u krĳgt een lĳst met panelen en werkbalken voor
lay-outs die u, met één klik, kunt in- of uitschakelen.

• Klik met rechts boven een liniaal en u kunt Hulplĳnen tonen, Aan hulplĳnen snappen, Hulplĳnen
beheren… het paneel Hulplĳnen openen of Hulplĳnen verwĳderen. Het is ook mogelĳk om de linialen te
verbergen.

• Klik met rechts in het kaartvenster van afdruklay-out en:
– U zult in staat zĳn voor recente wĳzigingen Ongedaan maken en Opnieuw te gebruiken, of een gekopieerd
item te Plakken (alleen beschikbaar als geen item is geselecteerd).

– Als u klikt boven een pagina heeft u aanvullende toegang tot het huidige paneel Pagina-eigenschappen of
Pagina verwĳderen.

– Als u klikt op een geselecteerd item dan kunt u het knippen of kopiëren en ook het paneel Item-
eigenschappen openen.
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– Indien er meer dan één item is geselecteerd, dan kunt u ze ofwel groeperen en/of het groeperen opheffen
als er tenminste al één groep in de selectie aanwezig is.

• Met rechts klikken in een tekstvak of widget met waarden of een paneel van lay-out verschaft opties om te
bewerken om de inhoud aan te passen.

Het paneel Lay-out

In het paneel Lay-out kunt u de globale instellingen van uw afdruklay-out definiëren.

Fig. 21.3: Instellingen voor Lay-out in de afdruklay-out
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Algemene instellingen

In een afdruklay-out kunt u meer dan één kaartitem gebruiken. De Verwĳzingskaart geeft het kaartitem weer dat
moet worden gebruikt als de hoofdkaart van de lay-out. Het is toegewezen zolang er een kaartitem in de lay-out staat.
De lay-out zal deze kaart gebruiken voor elk van zĳn eigenschappen en variabelen die eenheden of schaal berekenen.
Dat omvat ook het exporteren van de afdruklay-out naar indelingen met geoverwĳzingen.
Meer nog, nieuwe items voor de lay-out, zoals schaalbalk, legenda of noordpĳl hebben standaard hun instellingen
(oriëntatie, weergegeven lagen, schaal, …) verbonden met het kaartitem waar zĳ op getekend zĳn, en vallen terug op
de verwĳzingskaart als er geen overlappende kaart is.

Hulplijnen en raster

U kunt enkele markeringen voor verwĳzingen op het papier plaatsen om u te helpen om nauwkeurig enkele items te
plaatsen. Deze markeringen kunnen zĳn:

• eenvoudige horizontale of verticale lĳnen (genaamd Hulplĳnen) geplaatst op de positie die u wilt (bekĳk Het
paneel Hulplĳnen voor het maken van hulplĳnen).

• of normaal raster: een netwerk van horizontale en verticale lĳnen weergegeven over de lay-out.
Instellingen zoals Rasterafstand of Ruitennetverspringing kunnen ook in deze groep worden aangepast als ook
de Tolerantie voor ‘snappen’ om voor items te gebruiken. De tolerantie is de maximale afstand waaronder de
muisaanwĳzer wordt ge’snapt’ aan een raster of hulplĳn bĳ het verplaatsen, wĳzigen van de grootte of het maken
van een item.
Of rasters of hulplĳnen moeten worden weergegeven wordt ingesteld in het menu Beeld. Daar kunt u ook beslissen of
zĳ moeten worden gebruikt om items van afdruklay-out te “snappen”. Wanneer zowel een rasterlĳn als een hulplĳn
binnen de tolerantie van een punt liggen zullen de hulplĳnen altĳd voorgaan - omdat zĳ handmatig zĳn ingesteld
(daarom wordt aangenomen dat zĳ expliciet zĳn geplaatst op bĳzonder gewenste locaties om te ‘snappen’ en dat zĳ
zouden moeten worden geselecteerd boven het algemene raster).

Notitie: In het menu Instellingen► Opties voor lay-out kunt u ook de parameters voor het raster en hulplĳnen, zoals
hierboven vermeld, instellen. Deze opties zullen echter slechts als standaarden voor nieuwe afdruklay-outs worden
toegepast.

Instellingen voor exporteren

U kunt een resolutie definiëren die moet worden gebruikt voor alle geëxporteerde kaarten Export resolutie. Deze
instelling kan echter elke keer worden overschreven wanneer u een kaart exporteert.
Vanwege enkele geavanceerde opties voor renderen (mengmodus, effecten…), zou een item voor lay-out misschien
moeten worden gerasteriseerd om correct te kunnen worden geëxporteerd. QGIS zal het individueel rasteriseren
zonder elk ander te forceren om ook te worden gerasteriseerd. Dit maakt het mogelĳk bĳ het afdrukken of opslaan
naar PostScript of PDF om items zoveel mogelĳk als vectors te behouden, bĳv. een kaartitem met doorzichtbaarheid
voor de laag zal labels, schaalbalk etc. niet forceren om ook te worden gerasteriseerd. U kunt echter:

• alle items forceren om te worden gerasteriseerd door het keuzevak Als raster afdrukken te selecteren;
• of de tegengestelde optie gebruiken,d. i. Altĳd als vectoren exporteren, om de export te forceren de items te
behouden als vectoren indien geëxporteerd naar een compatibel indeling. Onthoud dat in sommige gevallen dit
er toe zou kunnen leiden dat de uitvoer er anders uitziet dan de lay-out.

Waar de indeling het mogelĳkmaakt (bĳv, .TIF, .PDF) resultaten van een afdruklay-out standaard naar een bestand
met geoverwĳzingen te exporteren (gebaseerd op het item Verwĳzingskaart in de groep Algemene instellingen). Voor
andere indelingen vereist uitvoer naar geoverwĳzingen u om een world file te maken door World file opslaan te
selecteren. Het world file wordt gemaakt naast de geëxporteerde kaart(en), heeft de naam van de pagina-uitvoer met
het item voor de verwĳzingskaart en bevat informatie om het gemakkelĳk van geoverwĳzingen te voorzien.
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Lay-out aanpassen naar inhoud

Met het gereedschapGrootte pagina aanpassen in deze groep, kunt u een unieke lay-out voor de paginamakenwaarvan
het bereik de huidige inhoud van de afdruklay-out bedekt (met enkele optionele marges rondom de bĳgesneden
grenzen).
Onthoud dat dit gedrag anders is dan dat van de optie Bĳsnĳden naar inhoud in die zin dat alle items worden geplaatst
op een echte en unieke pagina ter vervanging van alle bestaande pagina’s.

Variabelen

Variabelen vermeldt alle variabelen die beschikbaar zĳn op het niveau van de lay-out (inclusief alle globale en
projectvariabelen).

Het stelt de gebruiker ook in staat om variabelen op het niveau van de lay-out te beheren. Klik op de knop om een
nieuwe aangepaste variabele op het niveau van de lay-out toe te voegen. Selecteer op dezelfde wĳze een aangepaste
variabele op het niveau van de lay-out en klik op de knop om hem te verwĳderen.
Meer informatie over het gebruiken van variabelen in het gedeelte Algemeen gereedschap.

Fig. 21.4: Variabelen bewerken in de afdruklay-out
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Werken met de pagina-eigenschappen

Een lay-out kan worden samengesteld uit verschillende pagina’s. Een eerste pagina kan, bĳvoorbeeld, een kaartvenster
weergeven en een tweede pagina kan de attributentabel, die is geassocieerd met een laag, weergeven, terwĳl een derde
een HTML-object weergeeft dat is gekoppeld aan de website van uw organisatie. Of u kunt veel typen items toevoegen
op elke pagina.

Een nieuwe pagina toevoegen

Verder kan een lay-out worden gemaakt met pagina’s in verschillende grootten en/of oriëntatie. Selecteer het

gereedschap Pagina’s toevoegen… in het menu Lay-out of werkbalk Lay-out om een pagina toe te voegen. Het
dialoogvenster Pagina’s toevoegen opent en u zult worden gevraagd om in te vullen:

• het aantal toe te voegen pagina’s;
• de positie van de pagina(‘s): voor of na een bepaalde pagina of aan het einde van de afdruklay-out;
• De Grootte pagina: het zou een vooraf opgemaakte pagina kunnen zĳn (A4, B0, Legal, Letter, ANSI A,
Arch A en hun afgeleiden, als ook een type resolutie, zoals 1920x1080 of 1024x768) met geassocieerde
Oriëntatie (Staand of Liggend).
De grootte van de pagina kan ook een aangepaste indeling hebben; In dat geval dient u de Breedte enHoogte
in te vullen (met vastgezette verhoudingen indien nodig) en selecteer de te gebruiken eenheid uit mm, cm, px,
pt, in, ft… Converteren van ingevoerde waarden wordt automatisch toegepast bĳ het omschakelen van de
ene eenheid naar de andere.

Fig. 21.5: Een nieuwe pagina in de afdruklay-out maken

Pagina-eigenschappen bijwerken

Elke pagina kan later worden aangepast met het paneel Pagina Item-eigenschappen. Klikmet links op een leeg gedeelte
van de pagina of klik met rechts op een pagina en selecteer Pagina-eigenschappen… om toegang te verkrĳgen tot de
eigenschappen van een pagina. Het paneel Item-eigenschappen opent, met instellingen zoals:

• het hierboven beschreven frame Grootte pagina. U kunt elke eigenschap aanpassen met de opties voor data-
bepaalde ‘override’ (bekĳk Knoppen Data-bepaalde ‘override’ verkennen met atlas voor een gebruiksgeval);

• het keuzevak Pagina uitsluiten voor exporteren om te beheren of de huidige pagina met zĳn inhoud zou
moeten worden opgenomen in de uitvoer van de lay-out;

• de Achtergrond van de huidige pagina met de kleur of symbool die u wilt.
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Fig. 21.6: Dialoogvenster Pagina-eigenschappen

Het paneel Hulplijnen

Hulplĳnen zĳn verticale of horizontale lĳnverwĳzingen, die u op een pagina van de lay-out kunt plaatsen, om u te
helpen bĳ het plaatsen van items, bĳ het maken, verplaatsen of aanpassen van de grootte ervan. Voor hulplĳnen
moeten, om actief te kunnen zĳn, de opties Beeld ► Hulplĳnen tonen en Beeld ► Aan hulplĳnen snappen zĳn
geselecteerd. Er zĳn twee verschillende methoden om een hulplĳn te maken:

• Als de optie Beeld ► Linialen tonen is ingesteld, sleep dan een liniaal in het gebied van de pagina en laat, op
de gewenste positie, de muisknop los.

• gebruik, voor meer precisie, het paneel Hulplĳnen uit Beeld ► Toolbox ► of door Hulplĳnen beheren… te
selecteren uit het contextmenu van de pagina.

Fig. 21.7: Het paneel Hulplijnen

Het paneel Hulplĳnen maakt het mogelĳk snaplĳnen te maken op specifieke locaties:
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1. Selecteer de Pagina waaraan u de hulplĳnen wilt toevoegen

2. Klik op de knop Nieuwe hulplĳn toevoegen en voer de coördinaten in voor de horizontale of verticale lĳn. De bron
is de linkerbovenhoek. Hiervoor zĳn verschillende eenheden beschikbaar.
Het paneel staat ook het aanpassen toe van bestaande hulplĳnen naar exacte coördinaten: dubbelklik en vervang
de waarde.

3. Het paneel Hulplĳnen vermeldt alleen de items voor de huidige pagina. Het staat het maken en verwĳderen van
hulplĳnen alleen toe op de huidige pagina. U kunt echter de knop Op alle pagina’s toepassen gebruiken om de
configuratie van de huidige pagina door te voeren op de andere pagina’s in de lay-out.

4. Selecteer, om een hulplĳn te verwĳderen, die en druk op de knop Geselecteerde hulplĳn verwĳderen. Gebruik Alle
hulplĳnen verwĳderen om alle hulplĳnen van de huidige pagina te verwĳderen.

Tip: Snappen aan bestaande items van lay-out
Anders dan met hulplĳnen en rasters kunt u bestaande items gebruiken als verwĳzingen om aan te snappen bĳ
verplaatsen, aanpassen of maken van nieuwe items; dit worden slimme hulplĳnen genoemd en die vereisen dat
de optie Beeld► Slimme hulplĳnen is geselecteerd. Elke keer als de muisaanwĳzer dicht bĳ de grens van een item is,
verschĳnt een kruis om te kunnen snappen.

Het paneel Items

Het paneel Items biedt enkele opties om selecteren en zichtbaarheid van items te beheren. Alle items die zĳn
toegevoegd aan het kaartvenster van afdruklay-out (inclusief gegroepeerde items) worden in een lĳst weergegeven
en selecteren van een item selecteert de overeenkomende rĳ in de lĳst, als ook dat het selecteren van een rĳ het
overeenkomende item in het kaartvenster van afdruklay-out selecteert. Dit is dus een handige manier om een item,
dat is geplaatst achter een ander item, te selecteren. Onthoud dat de geselecteerde rĳ vet wordt weergegeven.
Voor elk geselecteerd item kunt u :

• het zichtbaar maken of niet;

• de positie ervan vastzetten of losmaken;
• de positie Z ervan sorteren. U kunt elk item in de lĳst naar boven of beneden verplaatsen met een klik en slepen.
Het bovenste item in de lĳst zal naar de voorgrond in het kaartvenster van afdruklay-out worden gebracht.
Standaard wordt een nieuw gemaakt item op de voorgrond geplaatst.

• het ID van het item wĳzigen door te dubbelklikken op de tekst;
• klik met rechts op een item en kopieer of verwĳder het of open zĳn paneel Eigenschappen.

Als u eenmaal de juiste positie heeft gevonden voor een item, kunt u het vastzetten door in het vak te klikken in de
kolom . Vastgezette items zĳn niet te selecteren in het kaartvenster. Vastgezette items kunnen worden losgemaakt
door het item te selecteren in het paneel Items en het keuzevak te deselecteren, of u kunt de pictogrammen op de
werkbalk gebruiken.
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Paneel Geschiedenis Ongedaan maken: acties Ongedaan maken en Opnieuw

Gedurende het proces van het opmaken is het mogelĳk wĳzigingen terug te draaien en weer opnieuw uit te voeren.
Dit kan worden gedaan met behulp van de gereedschappen die beschikbaar zĳn in het menu Bewerken, de werkbalk
Lay-out of het contextmenu, elke keer als u met rechts klikt in het gebied van de afdruklay-out:

• Laatste wĳziging terugdraaien

• Laatste wĳziging opnieuw

Dit kan ook worden gedaan met een muisklik in het paneel Geschiedenis Ongedaan maken (zie Fig. 21.8). Het paneel
Geschiedenis Ongedaan maken vermeldt de laatste acties die zĳn uitgevoerd binnen de afdruklay-out. Selecteer het
punt dat u ongedaan wilt maken en als u eenmaal uw nieuwe actie hebt uitgevoerd zullen alle acties, na die welke
geselecteerd werd, worden verwĳderd.

Fig. 21.8: Geschiedenis Ongedaan maken in de afdruklay-out

21.2 Lay-out items

21.2.1 Algemene opties items Lay-out

QGIS verschaft een groot aantal items om een kaart op te maken. Ze kunnen zĳn van het type kaart, legenda,
schaalbalk, afbeelding, tabel, noordpĳl… Ze delen echter enkele algemene opties en gedrag dat hieronder wordt
uitgelegd.

Een item voor lay-out maken

Items kunnen worden gemaakt met verschillende gereedschappen, ofwel vanaf niets of gebaseerd op bestaande items.
Een item voor lay-out maken vanaf niets:

1. Selecteer het overeenkomende gereedschap ofwel uit het menu Item toevoegen of de werkbalk Toolbox.
2. Dan:

• Klik op de pagina en vul de grootte en informatie voor de plaatsing in in het dialoogvenster Nieuw item
eigenschappen dat opent (voor details, bekĳk Positie en grootte);
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Fig. 21.9: Dialoogvenster Nieuw item Eigenschappen

• Of klik-en-sleep om de initiële grootte en plaatsing van het item te definiëren. U kunt vertrouwen op
snappen aan rasters en hulplĳnen voor een betere positie.

Notitie: Omdat ze bĳzondere vormen kunnen hebben werken de methoden met één klik, noch klikken-en-slepen
voor het tekenen van items knoop en pĳl; u dient te klikken en elke knoop van het item te plaatsen. Bekĳk De op
knopen gebaseerde vormen voor meer details.

U kunt ook:

1. Een bestaand item selecteren met de knop Item selecteren/verplaatsen op de werkbalk Toolbox

2. Het contextmenu of de gereedschappen van het menu Bewerken gebruiken om het item te kopiëren/knippen
en het op de muispositie plakken als een nieuw item.
U kunt ook de opdracht In plaats plakken (Ctrl+Shift+V) gebruiken om een item te dupliceren van de ene
pagina naar een andere en het op de nieuwe pagina plakken op dezelfde coördinaten als het origineel.

Meer nog, u kunt items maken met een sjabloon voor afdruklay-out (voor details, bekĳk Lay-out beheren) met de
opdracht Lay-out ► Items uit sjabloon toevoegen….

Tip: Items voor lay-out toevoegen met de bestandsverkenner
Vanuit uw bestandsverkenner of met het paneel Browser slepen-en-neerzetten van een sjabloon voor een afdruk-
lay-out (bestand .qpt) op een dialoogvenster voor een afdruklay-out en QGIS voegt automatisch alle items uit dat
sjabloon toe aan de lay-out.

Werken met items voor lay-out

Elk item in de afdruklay-out kan worden verplaatst en op grootte worden gebracht om een perfecte lay-out te maken.

Voor beide bewerkingen is de eerste stap om het gereedschap Item selecteren/verplaatsen en te klikken op het item.

U kunt meerdere items kiezen met de knop Item selecteren/verplaatsen: klik en sleep over de items of houdt de toets
Shift ingedrukt en klik op alle items die u nodig heeft. Klik erop met ingedrukte Shift-toets om een item te
deselecteren.
Elke keer als er een selectie is wordt het aantal items weergegeven op de statusbalk. In het menu Bewerken vindt u
acties om alle items te selecteren, alle selecties op te heffen, de huidige selectie om te keren en meer…
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Items verplaatsen en grootte wijzigen

Tenzĳ de optie Beeld ► Begrenzingsvakken weergeven niet is geselecteerd zal een geselecteerd item vierkantjes
rondom zĳn randen weergeven ; verplaatsen van een daarvan met de muis zal de grootte van het item in de
overeenkomende richting wĳzigen. Ingedrukt houden van de Shift-toets tĳdens het wĳzigen van de grootte zal
de verhoudingen behouden. Ingedrukt houden van de Alt-toets zal de grootte wĳzigen vanuit het midden van het
item.
Selecteer, om een item voor de lay-out te verplaatsen, het met de muis en verplaatst het met ingedrukte
linkermuisknop. Als u de verplaatsing wilt beperken tot de horizontale of verticale as, houd dan de Shift-toets
op het toetsenbord ingedrukt tĳden het verplaatsen van de muis. U kunt ook een geselecteerd item verplaatsen met
de pijltoetsen op het toetsenbord; als de verplaatsing te langzaam gaat, kunt u die versnellen door Shift
ingedrukt te houden. Als u een betere precisie nodig hebt, gebruik dan de eigenschappen Positie en grootte, of snappen
aan rasters/hulplĳnen zoals hierboven uitgelegd voor het maken van items.
Wĳzigen van de grootten of verplaatsen van verscheidene items in één keer gaat op dezelfde manier als voor een enkel
item. QGIS verschaft echter enkele gevorderde gereedschappen om automatisch de grootte van een selectie items te
wĳzigen door verschillende regels te volgen:

• de hoogte van elk item komt overeen met het grootste of het kleinste geselecteerde item;

• de breedte van elk item komt overeen met het breedste of het smalste geselecteerde item;

• grootten van items wĳzigen naar vierkanten: elk item wordt vergroot om een vierkant te vormen.
Op dezelfde wĳze zĳn gereedschappen beschikbaar om de positie van meerdere items te beheren door ze gelĳkmatig
te verdelen:

• randen (links, rechts, boven of onder) van items;
• midden van items horizontaal of verticaal;
• ruimte tussen items horizontaal of verticaal.

Items groeperen

Groeperen van items stelt u in staat een set items te bewerken zoals één enkel: u kunt eenvoudig grootte wĳzigen,
verplaatsen, verwĳderen, kopiëren van de items als één geheel.

Selecteer, om een groep items te maken, er meer dan één en druk op de knop Groeperen in het menu Beeld of
de werkbalk Acties of vanuit het menu met rechts klikken. Een rĳ genaamd Groep is toegevoegd aan aan het paneel
Items en kan worden vastgezet of verborgen, net als elk ander object van het paneel Items. Gegroepeerde items zĳn
niet individueel te selecteren in het kaartvenster; gebruik het paneel Items om direct te selecteren en toegang te
krĳgen tot het paneel Item-eigenschappen.

Items vastzetten

Als u eenmaal de juiste positie voor een item heeft gevonden, kunt u het vastzetten met de knop Geselecteerde
items vastzetten in het menu Items of op de werkbalk Acties of door in het vak te klikken naast het item op het paneel
Items. Vastgezette items zĳn niet te selecteren in het kaartvenster.
Vastgezette items kunnen worden losgemaakt door het item te selecteren op het paneel Items en het keuzevak te
deselecteren, of u kunt de pictogrammen op de werkbalk gebruiken.
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Uitlijning en verdeling

De visuele hiërarchie verhogen of verlagen van items staan in het keuzemenu Geselecteerde items verhogen. Kies een
item uit het kaartvenster van de afdruklay-out en selecteer de overeenkomende functionaliteit om het geselecteerde
item te verhogen of te verlagen vergeleken met de andere items. Deze volgorde wordt weergegeven in het paneel
Items. U kunt ook objecten verhogen of verlagen op het paneel Items door een label van een object aan te klikken en
te verslepen in deze lĳst.

Fig. 21.10: Hulplijnen voor uitlijnen in de afdruklay-out

Er zĳn verscheidene opties voor uitlĳning beschikbaar binnen het menu Geselecteerde items uitlĳnen (zie Fig. 21.10). U
selecteert eerst enkele items en klikt dan op één van de pictogrammen voor uitlĳning.

• Links uitlĳnen of Rechts uitlĳnen;

• Bovenkant uitlĳnen of Onderkant uitlĳnen;

• Midden uitlĳnen horizontaal of Midden verticaal uitlĳnen.
Alle geselecteerde items zullen dan worden uitgelĳnd op hun gemeenschappelĳk begrenzingsvak. Bĳ het verplaatsen
van items in het kaartvenster verschĳnen hulplĳnen voor uitlĳnen als randen, midden of hoeken worden uitgelĳnd.
Een andere manier om het plaatsen van items voor de lay-out is door de ruimte ertussen aan te passen op de pagina
van de lay-out. Dit kan worden gedaan door de items te selecteren en te drukken op keuzemenu Linkerranden
verdelen om:

• Linkerranden verdelen of Rechterranden verdelen voor gelĳkmatige afstanden tussen items

• Bovenranden verdelen of Onderranden verdelen voorgelĳkmatige afstanden tussen items

• Vanaf het horizontale midden verdelen of Vanaf het verticale midden verdelen voor gelĳkmatige
afstanden tussen items
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• Voeg gelĳkmatige ruimte toe tussen items: Horizontaal op gelĳke afstanden verdelen of Verticaal op
gelĳke afstanden verdelen

Items Algemene eigenschappen

Items van afdruklay-out hebben een verzameling algemene eigenschappen die u vindt aan de onderzĳde van het
paneel Item-eigenschappen: Positie en grootte, Rotatie, Frame, Achtergrond, Item ID, Variabelen en Rendering (Zie
Fig. 21.11).

Fig. 21.11: Algemene groepen Item-eigenschappen

Notitie: Het pictogram Data bepaalde ‘override’ naast de meeste opties betekent dat u die eigenschap kunt associëren
met een laag, attributen van objecten, geometrie of met enig andere eigenschap van lay-outitems met expressies of
variabelen. Deze zĳn in het bĳzonder handig bĳ het genereren van een atlas (Bekĳk voor meer informatie Knoppen
Data-bepaalde ‘override’ verkennen met atlas).

• De groep Positie en grootte laat u de grootte en de positie definiëren van het frame dat het item bevat (zie Positie
en grootte voor meer informatie).

• De Rotatie stelt de rotatie van het item in (in graden).
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• Het Frame toont of verbergt het frame rondom het item. Gebruik de widgets Randkleur, Dikte en
Verbindingsstĳl om deze eigenschappen aan te passen.

• Gebruik het menu Achtergrondkleur voor het instellen van een achtergrondkleur. Klik op de knop [Kleur…]
om een dialoogvenster weer te geven waar u een kleur of een aangepaste instelling kunt kiezen. Transparantie
kan worden aangepast door de instellingen voor het veld Alfa te wĳzigen.

• Gebruik Item ID om een relatie te maken naar andere items van afdruklay-out. Dit wordt gebruikt met de server
van QGIS en andere potentiële webcliënten. U kunt een ID instellen voor een item (bĳvoorbeeld een kaart en
een label), en dan kan de webcliënt gegevens verzenden om een eigenschap in te stellen (bĳv. tekst voor een
label) voor dat specifieke item. De opdracht GetProjectSettings zal de items en ID’s vermelden die beschikbaar
zĳn in een lay-out.

• Modus Rendering helpt u in te stellen of en hoe het item moet worden weergegeven: u kunt, bĳvoorbeeld,
Meng-modus toepassen, de doorzichtbaarheid van het item aanpassen of Item uitsluiten voor exporteren.

Positie en grootte

Uitbreiden van demogelĳkheden van het dialoogvensterNieuw Item eigenschappenmet data-bepaaldemogelĳkheden,
deze groep stelt u in staat de items nauwkeurig te plaatsen.

Fig. 21.12: Positie en grootte

• het feitelĳke nummer van de pagina waar het item op geplaatst moet worden;
• het verwĳzingspunt van het item;
• de coördinaten X en Y van het Referentiepunt van het item op de geselecteerde pagina. De verhouding tussen
deze waarden kan worden vergrendeld door te klikken op de knop . Wĳzigen van een waarde met de widget

of met het gereedschap Item selecteren/verplaatsen zal in beide zichtbaar zĳn;
• de Breedte en Hoogte van het begrenzingsvak van het item. Net als met coördinaten kan de verhouding tussen
breedte en hoogte worden vergrendeld.

Modus Rendering

QGIS staat nu geavanceerde rendering toe voor items van afdruklay-out net zoals voor vector- en rasterlagen.
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Fig. 21.13: Modus Rendering

• Meng-modus: U kunt met dit gereedschap speciale effecten bereiken die anders mogelĳk pas konden worden
bereikt met grafische programma’s. De pixels van uw bovenliggende en onderliggende items worden gemengd,
overeenkomstig de ingestelde modus (bekĳk Meng-modi voor een beschrĳving van elk effect).

• Transparantie : U kunt met dit gereedschap het onderliggende item in afdruklay-out
zichtbaar maken. Gebruik de schuifbalk om de zichtbaarheid van uw item aan uw behoeften aan te passen.
U kunt ook een precieze definitie van het percentage zichtbaarheid instellen in het menu naast de schuifbalk.

• Item uitsluiten voor exporteren: U kunt besluiten om een item onzichtbaar te maken in alle acties voor
exporteren. Na het activeren van het keuzevak, zal het item niet worden opgenomen in PDF’s, afdrukken etc..

Variabelen

Variabelen vermeldt alle beschikbare variabelen op het niveau van het item voor afdruklay-out (inclusief alle globale,
project en lay-out variabelen). Kaartitems bevatten ook variabelen voor Kaartinstellingen die eenvoudige toegang
verlenen tot waarden zoals het schaalbereik van de kaart, enzovoort.

In Variabelen is het ook mogelĳk om variabelen op het niveau van het item te beheren. Klik op de knop om een
nieuwe aangepaste variabele toe te voegen. Selecteer op dezelfde wĳze een aangepaste variabele uit de lĳst en klik
op de knop om hem te verwĳderen.
Meer informatie over het gebruiken van variabelen in het gedeelteWaarden opslaan in Variabelen.

21.2.2 Het kaartitem

Het kaartitem is het belangrĳkste frame dat de door u ontworpen kaart weergeeft in het kaartvenster. Gebruik het
gereedschap Kaart toevoegen, gevolgd door instructies voor maken van items om een nieuw kaartitem toe te voegen
dat u later op dezelfde wĳze kunt bewerken als is besproken inWerken met items voor lay-out.
Standaard geeft een nieuw kaartitem de huidige status van het kaartvenstermet zĳn bereik en zichtbare lagen weer. U
kunt het aanpassenmet zĳn paneel Item-eigenschappen. Naast de algemene eigenschappen, heeft dit object de volgende
functionaliteiten:
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Fig. 21.14: Paneel Kaart Item-eigenschappen

De werkbalk

Het paneel Item-eigenschappen voor het kaartitem heeft een ingebedde werkbalk met de volgende functionaliteiten:

• Voorbeeld kaart bĳwerken

• Kaartbereik instellen op bereik van kaartvenster

• Huidig kaartbereik in kaartvenster weergeven

• Schaal van kaart instellen op schaal van kaartvenster

• Kaartvenster op huidige schaal kaartvenster instellen

• Favoriete plaatsen: stel het bereik van het kaartitem in om overeen te komen met een bestaande Favoriete plaats

• Kaartbereik interactief bewerken: interactief verschuiven en zoomen in het kaartitem
• Instellingen voor labelen: beheert het gedrag van het label van het object (plaatsing, zichtbaarheid…) in het bereik
van het kaartitem op de lay-out:

– een Marge vanaf randen kaart instellen, een data-bepaalde afstand vanaf de randen van het kaartitem
waarin geen label zou moeten worden weergegeven

– Afgebroken labels aan rand van kaart toestaan: beheert of van labels, die gedeeltelĳk buiten het
kaartitem vallen, het toegestane bereik zou moeten worden gerenderd. Indien geselecteerd zullen deze
labels worden weergegeven (wanneer er geen manier is om ze volledig binnen het zichtbare gebied te
plaatsen). Indien niet geselecteerd dan zullen gedeeltelĳk zichtbare labels worden overgeslagen.
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– Items voor blokkeren van labels: toestaan dat andere items van de lay-out (zoals schaalbalken, noordpĳlen,
overzichtskaarten, etc) worden gemarkeerd als blokkering voor de kaartlabels op het actieve kaartitem.
Dit voorkomt dat een kaartlabel wordt geplaatst onder deze items - wat er voor zorgt dat het mechanisme
voor labels een alternatieve plaatsing voor deze labels probeert of ze helemaal negeert.
Als een Marge vanaf randen kaart is ingesteld, worden de kaartlabels niet dichterbĳ geplaatst dan de
gespecificeerde afstand vanaf de geselecteerde items voor de lay-out.

– Niet geplaatste labels weergeven: kan worden gebruikt om te bepalen welke labels ontbreken in de kaart
van de lay-out (bĳv. vanwege conflicten met andere kaartlabels of vanwege onvoldoende ruimte om het
label te plaatsen) door ze te accentueren in een vooraf gedefinieerde kleur.

• Instellingen clippen: stelt u in staat het kaartitem te clippen naar het object van de atlas en naar items Vorm en
Polygoon:

– Clippen naar atlas object: u kunt bepalen dat het kaartitem van de lay-out automatisch zal worden
geclipt tot het huidige object van atlas.
Er zĳn verschillende modi voor clippen beschikbaar:
∗ Alleen clippen tĳdens renderen: past een op schilderen gebaseerde clip toe, zodat delen van
vectorobjecten, die zich buiten het object van atlas bevinden, onzichtbaar worden

∗ Object clippen vóór renderen: past de clip toe voor het renderen van de objecten, dus randen van
objecten, die gedeeltelĳk buiten het object van atlas vallen, zullen nog steeds zichtbaar zĳn op de
grens van het object van atlas

∗ Kruisende objecten ongewĳzigd renderen: rendert alle objecten die kruisen met het huidige object van
atlas, maar zonder hun geometrie te clippen.

U kunt Labels binnen atlas object forceren. Als u niet wilt Alle lagen clippen naar het atlas object,
kunt u de optie Geselecteerde lagen clippen gebruiken.

– Naar item clippen: het is mogelĳk om de vorm van het kaartitem te wĳzigen door een item Vorm
of Polygoon te gebruiken uit de afdruklay-out. Wanneer u deze optie inschakelt zal de kaart automatisch
worden geclipt naar de geselecteerde vorm in het combinatievak. Nogmaals, de hierboven vermelde modi
voor clippen zĳn beschikbaar en labels kunnen worden geforceerd om alleen binnen de geclipte vorm te
worden weergegeven.

Fig. 21.15: Een lay-outkaartitem clippen naar vormen
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Algemene eigenschappen

In de groep Algemene eigenschappen (zie Fig. 21.14) van het paneel Item-eigenschappen zĳn de beschikbare opties:
• De knopVoorbeeld kaart bĳwerken om het renderen van het kaartitem te verversen als de weergave van de kaart
is aangepast in het kaartvenster. Onthoud dat de meeste keren het vernieuwen van het kaartitem automatisch
wordt geactiveerd door de wĳzigingen;

• De Schaal om handmatig de schaal voor het kaartitem in te stellen;
• De Kaartrotatie stelt u in staat het kaartitem te draaien met de wĳzers van de klok mee in graden. De rotatie
van het kaartvenster kan hier worden geïmiteerd;

• De CRS stelt u in staat de inhoud van het kaartitem weer te geven in elk CRS. De standaard is Project-CRS
gebruiken;

• Kaartvenster objecten tekenen laat u annotaties, die zĳn geplaatst in het hoofdkaartvenster, weergeven in de
afdruklay-out.

Lagen

Standaard wordt het uiterlĳk van het kaartitem gesynchroniseerd met het renderen van het kaartvenster, wat betekent
dat het schakelen met de zichtbaarheid van de lagen of het aanpassen van hun stĳl in het paneel Lagen automatisch
wordt toegepast op het kaartitem. Omdat, net als met alle andere items, u zou kunnen willen meerdere kaartitems toe
te voegen aan een afdruklay-out, is er een noodzaak om deze synchronisatie te verbreken om het mogelĳk te maken
verschillende gebieden, combinaties van lagen weer te geven, op verschillende schalen… De groep eigenschappen
Lagen (zie Fig. 21.16) helpt u dat te doen.

Fig. 21.16: Kaart groep Lagen

Als u wilt dat het kaartitem consistent wordt gehouden met een bestaand kaartthema, selecteer dan Kaartthema
volgen en selecteer het gewenste thema in de keuzelĳst. Elke wĳziging die wordt gemaakt in de voorkeuze in het
hoofdvenster van QGIS (met de functie Thema vervangen) zal ook worden weergegeven in het kaartitem. In dit geval
zal de optie Stĳlen voor lagen vergrendelen worden uitgeschakeld omdat Voorkeuze zichtbaarheid volgen ook de stĳl
(symbologie, label, diagram) van de lagen in de voorkeuze voor zichtbaarheid bĳwerkt.

Selecteer, om lagen die worden weergegeven in het kaartvenster vast te zetten, Lagen vergrendelen. Als deze optie
is geselecteerd zullen wĳzigingen voor de zichtbaarheid van de lagen in het hoofdvenster van QGIS het kaartitem
van lay-out niet meer beïnvloeden. Niettegenstaande dat worden stĳl en labels van een vastgezette laag nog steeds
vernieuwd, overeenkomstig het hoofdvenster van QGIS. U kunt dit voorkomen door Stĳlen voor lagen vergrendelen
te gebruiken.
In plaats van het huidige kaartvenster te gebruiken, kunt u ook de lagen van het kaartitem vastzetten op die van een
bestaand kaartthema: selecteer een kaartthema uit de keuzelĳst van de knop Lagenlĳst instellen uit een kaartthema, en het
keuzevak Lagen vergrendelen is geactiveerd. De set zichtbare lagen in het kaartthema wordt vanaf nu gebruikt
voor het kaartitem, totdat u een ander kaartthema selecteert of de optie Lagen vergrendelen deselecteert. U zou
dan misschien de weergave moeten verversen met de knop Scherm vernieuwen van de werkbalk Navigatie of de knop
Voorbeeld kaart verversen zoals hierboven weergegeven.
Onthoud dat, anders dan met de optie Kaartthema volgen, als de optie Lagen vergrendelen is ingeschakeld en ingesteld
op een thema, de lagen van het kaartitem niet worden bĳgewerkt als het thema wordt gewĳzigd (met de optie Thema
vervangen) in het hoofdvenster van QGIS.
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Vergrendelde lagen in het kaartitem kunnen ook data-bepaald worden, met het pictogram naast de optie. Indien
gebruikt overschrĳft dit de gekozen selectie in de keuzelĳst. U dient een lĳst met lagen op te geven, gescheiden door
een teken |. Het volgende voorbeeld zet het kaartitem vast om alleen de lagen layer 1 en layer 2 te gebruiken:

concat ('layer 1', '|', 'layer 2')

Bereiken

De groep Bereiken van het paneel van het kaartitem verschaft de volgende functionaliteiten (zie Fig. 21.17):

Fig. 21.17: groep Bereiken kaart

Het gedeelte Bereiken geeft de X- en Y-coördinaten weer van het gebied dat wordt getoond in het kaartitem. Elk van
deze waarden kan handmatig worden vervangen, wat het weergegeven gebied in het kaartvenster aanpast en/of grootte
van het kaartitem. Het bereik kan ook worden aangepast met gereedschappen aan de bovenzĳde van het paneel, zoals:

• Kaartbereik instellen op bereik van kaartvenster

• Schaal van kaart instellen op schaal van kaartvenster

U kunt ook het bereik van een kaartitem wĳzigen met het gereedschap Inhoud item verschuiven: klik-en-sleep in het
kaartitem om de huidige weergave daarvan aan te passen, dezelfde schaal daarbĳ behoudend. Met het gereedschap

ingeschakeld, gebruik het muiswiel om in of uit te zoomen, de schaal van de weergegeven kaart aanpassend.
Combineer de verschuiving met het indrukken van de Ctrl-toets ingedrukt om een kleinere zoom te krĳgen.

Tijdbereik

De groep Tĳdbereik van de eigenschappen van het paneel Kaartitem verschaft de opties om het renderen van lagen in
het kaartitem te beheren, gebaseerd op een tĳdsperiode. Alleen lagen waarvan de eigenschappen voor tĳd overlappen
met de tĳdsperiode die is ingesteld met de tĳdsperiode die wordt ingesteld door de datums Begin en Einde die worden
weergegeven in het kaartitem.
De geassocieerde data-bepaalde widgets helpen bĳ het dynamisch maken van het tĳdbereik, en staan de uitvoer van
door tĳd beheerde atlassen toe, d.i. geautomatiseerde kaarten met een vast ruimtelĳk bereiken waarvan de inhoud
varieert, gebaseerd op tĳd. Bĳvoorbeeld bĳ het gebruiken van een CSV-bestand als een bedekkingslaag met een
begin- en eindpaar van velden en een aantal rĳen die tĳdsperioden weergeven, schakel zowel de tĳdsperiode als het
beheren door atlas in de eigenschappen van het kaartitem in en druk op Atlas exporteren.
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Beheerd door atlas

De groep eigenschappen Beheerd door atlas is alleen beschikbaar als een atlas actief is in de afdruklay-out.
Selecteer deze optie als u wilt dat het kaartitem wordt beheerd door de atlas; bĳ het doorlopen van de bedekkingslaag
wordt het bereik van het kaartitem verschoven/gezoomd naar het object van de atlas, waarbĳ:

• Marges rondom objecten: zoomt naar het object met de beste schaal, behoudt rondom elk een marge die
een percentage van de breedte en hoogte van het kaartitem vertegenwoordigt. De marge mag hetzelfde zĳn
voor alle objecten of variabel ingesteld, bĳv. afhankelĳk van de schaal van de kaart;

• Vooraf gedefinieerde schaal (best passend): zoomt naar het object met de voor het project vooraf
gedefinieerde schaal waar het object van de atlas het beste past;

• Vaste schaal: objecten van atlas worden verschoven van de een naar de ander, behouden dezelfde schaal
van het kaartitem. Ideaal bĳ het werken met objecten van dezelfde grootte (bĳv. een raster) of mogelĳkheid
om verschillen in grootte tussen objecten van atlas te accentueren.

Rasters

Met rasters kunt u, over uw kaart, informatie toevoegen relatief tot zĳn bereik of coördinaten, ofwel in de projectie
van het kaartitem of een ander. De groepRasters verschaft de mogelĳkheid om verschillende rasters aan een kaartitem
toe te voegen.

• Met de knoppen en kunt u een geselecteerd raster toevoegen of verwĳderen;

• met de knoppen en kunt u een raster in de lĳst naar boven of beneden verplaatsen, het daarmee
bovenop een ander of onder een ander te plaatsen, over het kaartitem.

Dubbelklik op het toegevoegde raster om het een andere naam te geven.

Fig. 21.18: Dialoogvenster Kaartraster

Selecteer, om een raster aan te passen, het en druk op de knop Raster aanpassen… om het paneel Eigenschappen
kaartraster te openen en toegang te krĳgen tot de opties om het te configureren.

Uiterlijk

In het paneel Eigenschappen kaartraster, selecteer Raster ingeschakeld om het raster op het kaartitem weer te
geven.
U kunt, als te gebruiken type raster, specificeren:

• Doorgetrokken: geeft een lĳn weer over het frame van het raster. De Lĳnstĳl kan worden aangepast met widgets
voor het kiezen van kleur en symbool;

• Kruis: geeft segment weer op de kruising van de rasterlĳnen waarvoor u de Lĳnstĳl en de Kruisdikte kunt
instellen;
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• Markeringen: geeft alleen aan te passen markeringssymbolen weer op de kruisingen van de rasterlĳnen;
• of Alleen frame en annotaties.

Naast het type raster kunt u definiëren:
• het CRS van het raster. Indien niet gewĳzigd zal het het kaart-CRS volgen. De knop Wĳzigen laat u een
ander CRS instellen. Eenmaal ingesteld kan het worden teruggezet naar de standaard door een willekeurige
groepskop te selecteren (bĳv. Geografisch CoördinatenSysteem) onder Vooraf gedefinieerde Coördinaten
ReferentieSystemen in het dialoogvenster Keuze Coördinaten ReferentieSysteem.

• het te gebruiken type Interval voor de verwĳzingen van het raster. Beschikbare opties zĳn Kaarteenheid,
Breedte segment passend maken, Millimeter of Centimeter:

– kiezen van Breedte segment passen maken zal dynamisch de interval voor het raster selecteren,
gebaseerd op het kaartbereik, tot een “prettige” interval. Indien geselecteerd kunnen de Minimum en
Maximum voor de intervallen worden ingesteld.

– de andere opties stellen u in staat de afstand tussen twee opeenvolgende rasterverwĳzingen in de richtingen
X en Y in te stellen.

• de Verspringing vanaf de randen van het kaartitem, in de richting X en/of Y
• en de Meng-modus van het raster (zie Meng-modi) indien compatibel.

Fig. 21.19: Dialoogvenster Uiterlijk

Rasterframe

Er zĳn verschillende opties om het frame op te maken dat de kaart bevat. De volgende opties zĳn beschikbaar:
Geen frame, Zebra, Zebra (nautisch), Interieurtikken, Exterieurtikken, Interieur-
en exterieurtikken, Lijnrand en Lijnrand (nautisch).
Indien compatibel, is het mogelĳk de Frame grootte in te stellen, een Marge frame, de Frame lĳndiktes met
geassocieerde kleur en de Frame vulkleuren.
Met het gebruiken van de waarden Alleen breedtegraad weergeven en Alleen lengtegraad
weergeven in het gedeelte voor indeling kunt u voorkomen dat een mix van latitude/Y- en longitude/X-coördinaten
aan elke zĳde wordt weergegeven, bĳ het werken met geroteerde kaarten of opnieuw geprojecteerde rasters. U kunt
er ook voor kiezen om elke zĳde van het frame van het raster zichtbaar te laten zĳn, of niet.
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Fig. 21.20: Dialoogvenster Frame raster

Coördinaten

Het keuzevak Coördinaten tekenen stelt u in staat coördinaten toe te voegen aan het kaartframe. U kunt kiezen
uit de indeling annotatie numeriek, de opties reiken van decimaal tot graden, minuten en seconden, met of zonder
achtervoegsel, uitgelĳnd of niet en een aangepaste indeling met het dialoogvenster voor expressie.
U kunt er voor kiezen welke annotatie weer te geven. De opties zĳn: Alles weergeven, Alleen breedtegraad weergeven,
Alleen lengtegraad weergeven, of Uitgeschakeld. Dit is nuttig als de kaart is gedraaid. De annotatie kan worden
getekend binnen of buiten het kaartframe. De richting van de annotatie kan worden gedefinieerd als horizontaal,
verticaal stĳgend of verticaal dalend.
Tenslotte kunt u het lettertype, kleur van het lettertype afstand vanaf het kaartframe en de precisie van de getekende
coördinaten van de annotatie definiëren.
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Fig. 21.21: Dialoogvenster Raster - Coördinaten tekenen

Overzichtskaarten

Soms wilt u meer dan één kaart in de afdruklay-out hebben en een bepaald gebied van één kaartitem op een ander
zou willen bekĳken. Dat zou bĳvoorbeeld kaartlezers helpen het gebied te identificeren in relatie met zĳn grotere
geografische context, weergegeven in de tweede kaart.
De groep Overzichtskaarten van het paneel Kaart helpt u de koppeling te maken tussen twee verschillende
kaartbereiken en verschaft de volgende functionaliteiten:
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Fig. 21.22: Kaart groep Overzichtskaarten

Selecteer, om een overzichtskaart te maken, het kaartitem waarop u het bereik van het andere kaartitem wilt
weergeven en vergroot de optie Overzichtskaarten in het paneel Item-eigenschappen. Druk dan op de knop om
een overzichtskaart toe te voegen.
Initieel is deze overzichtskaart genaamd ‘Overzichtskaart 1’ (zie Fig. 21.22). U kunt:

• Het met een dubbelklik hernoemen

• Met de knoppen en kunt u overzichtskaarten toevoegen of verwĳderen

• Met de knoppen en kunt u een overzichtskaart op en neer in de lĳst verplaatsen, het boven of onder
andere overzichtskaarten in het kaartitem plaatsen (als zĳ dezelfde gestapelde positie hebben).

Selecteer dan het item Overzichtskaart in de lĳst en selecteer Overzichtskaart “<name_overview>” tekenen om het
tekenen van de overzichtskaart op het geselecteerde kaartframe in te schakelen. U kunt het aanpassen met:

• Het Kaartframe selecteert het kaartitem waarvan de bereiken zullen worden weergegeven in het huidige
kaartitem.

• De Randstĳl gebruikt de eigenschappen van symbool om het frame voor de overzichtskaart te renderen.
• De Meng-modus stelt u in staat verschillende meng-modi voor transparantie in te stellen.

• Inverteren overzichtskaart maakt een masker rondom de bereiken, indien geactiveerd: de kaartbereiken
waarnaar verwezen wordt, worden helder weergegeven, terwĳl de rest van het kaartitem wordt vertroebeld
door de vulkleur van het frame (als een vulkleur wordt gebruikt).

• Centreer in overzichtskaart verschuift de inhoud van het kaartitem, zodat het frame van de overzichtskaart
wordt weergegeven in het midden van de kaart. U kunt slechts één overzichtskaart gebruiken voor centreren,
als u meerdere overzichtskaarten hebt.

• De Positie beheert exact waar in de stapel met lagen voor het kaartitem de overzichtskaart zal worden geplaatst,
bĳv. toestaan dat een bereik voor een overzichtskaart wordt getekend onder enkele lagen met objecten, zoals
wegen, bĳ het tekenen boven andere lagen voor de achtergrond. Beschikbare opties zĳn:

– Onder kaart

– Onder laag en Boven laag: plaats het frame voor de overzichtskaart respectievelĳk onder en boven de
geometrieën van een laag. De laag wordt geselecteerd in de optie Laag stapelen.
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– Onder kaartlabels: gegeven dat labels altĳd worden gerenderd bovenop alle geometrieën van objecten in
een kaartitem, plaatst het frame voor de overzichtskaart bovenop alle geometrieën en onder eventuele
labels.

– Boven kaartlabels: plaatst het frame voor de overzichtskaart bovenop alle geometrieën en eventuele labels
in het kaartitem.

21.2.3 Het 3D-kaartitem

Het 3D-kaartitem wordt gebruikt om een 3D kaartweergave weer te geven. Gebruik de knop 3D-kaart toevoegen,
en volg de instructies voor maken van items om een nieuw 3D-kaartitem toe te voegen dat u later kunt bewerken op
dezelfde manier zoals is gedemonstreerd inWerken met items voor lay-out.
Standaard is een nieuw 3D-kaartitem leeg. U kunt de eigenschappen van de 3D-weergave instellen en die aanpassen
in het paneel Item-eigenschappen. In aanvulling op de algemene eigenschappen heeft deze mogelĳkheid de volgende
functionaliteiten (Fig. 21.23):

Fig. 21.23: Eigenschappen 3D-kaartitem

Instellingen scene

Druk op Instellingen vanuit een 3D-weergave kopiëren… om de weer te geven 3D-kaartweergave te kiezen.
De 3D-kaartweergave wordt gerenderd met zĳn huidige configuratie (lagen, terrein, lichten, camerapositie en
hoek…).
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Camerastandpunt

• Centrum X stelt de X-coördinaat in voor het punt waarop de camera is gericht
• Centrum Y stelt de Y-coördinaat in voor het punt waarop de camera is gericht
• Centrum Z stelt de Z-coördinaat in voor het punt waarop de camera is gericht
• Afstand stelt de afstand in van het midden van de camera tot het punt waarop de camera is gericht
• Tekenbreedte stelt de rotatie van de camera rondom de X-as in (verticale rotatie). Waarden tussen 0 tot en met
360 (graden). 0°: terrein bekeken recht van boven; 90°: horizontaal (van de zĳkant); 180°: recht van onderen;
270°: horizontaal, ondersteboven; 360°: recht van boven.

• Kop stelt de rotatie van de camera rondom de Y-as in (horizontale rotatie - 0 tot en met 360 graden). 0°/360°:
noord; 90°: west; 180°: zuid; 270°: oost.

Het keuzemenu Vanuit een 3D-weergave instellen… laat u de items vullen met de parameters van een 3D-weergave.

21.2.4 Het item Label

Het item Label is een gereedschap dat helpt bĳ het decoreren van uw kaart met teksten die zouden kunnen helpen hem
beter te begrĳpen; het kan de titel, auteur, gegevensbron of enige andere informatie zĳn. U kunt een label toevoegen
met het gereedschap Label toevoegen door de instructies voor het maken van items te volgen en het op dezelfde
manier te bewerken als is besproken inWerken met items voor lay-out.
Standaard verschaft het item Label een standaard tekst die u kunt aanpassen met behulp van zĳn paneel Item-
eigenschappen. Naast de algemene eigenschappen voor items, heeft dit object de volgende functionaliteiten (zie Fig.
21.24):
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Fig. 21.24: Paneel Label Item-eigenschappen
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Algemene eigenschappen

De groep Algemene eigenschappen is de plaats om de tekst van het label op te geven. De tekst kan statisch, dynamisch
met expressie-functies en variabelen zĳn, en/of opgemaakt met HTML. Dynamische delen van een label moeten
worden omsloten door [% en %] om als zodanig geïnterpreteerd en geëvalueerd te kunnen worden.

• U kunt, om expressies in labels te gebruiken, klikken op de knop Een expressie invoegen of bewerken…, schrĳf
uw formule zoals gewoonlĳk en als het dialoogvenster wordt toegepast, voegt QGIS automatisch de omsluitende
tekens toe.

Hint: Klikken op de knop Een expressie invoegen of bewerken… als geen selectie is gemaakt in het tekstvak
zal de nieuwe expressie toevoegen aan de bestaande tekst. Wanneer u een bestaande expressie wilt aanpassen,
moet u eerst het betreffende deel selecteren.

Omdat kaarten gewoonlĳk zĳn gevuld met enige veel voorkomende tekstinformatie (datum, auteur, titel,
paginanummer, …), verschaft QGIS een directe toegang tot de overeenkomende expressies of variabelen:
druk op de knop Dynamische tekst om ze te selecteren en in te voegen in uw label.

Tip: Het bovenste menu Item toevoegen ► Dynamische tekst toevoegen ► kan worden gebruikt om een nieuw
item label te maken dat is gevuld met de geselecteerde vooraf gedefinieerde expressie.

Het is mogelĳk om van een dynamisch label een statisch te maken: druk op het keuzepĳltje naast de knop Een
expressie invoegen of bewerken… en selecteer Naar statische tekst converteren. Alle dynamische delen van de
inhoud van het label zullen worden geëvalueerd en vervangen door hun huidige waarden. U kunt dan handmatig
de resulterende tekst bewerken als dat nodig is.

• Labels kunnen worden geïnterpreteerd als HTML-code: selecteer Renderen als HTML. U kunt nu HTML-
tags of stĳlen invoegen, URL, een aan te klikken afbeelding die linkt naar een webpagina, of iets complexer…

De volgende code combineert het renderen als HTMLmet expressies, voor een geavanceerd labelen en zal Fig. 21.25
uitvoeren:

<html>
<head>
<style>

/* Define some custom styles, with attribute-based size */
name {color:red; font-size: [% ID %]px; font-family: Verdana; text-shadow:␣

↪→grey 1px 0 10px;}
use {color:blue;}

</style>
</head>

<body>
<!-- Information to display -->
<u>Feature Information</u>
<ul style="list-style-type:disc">

<li>Feature Id: [% ID %]</li>
<li>Airport: <name>[% NAME %]</name></li>
<li>Main use: <use>[% USE %]</use></li>

</ul>
Last check: [% concat( format_date( "control_date", 'yyyy-MM-dd'), ' by <b><i>',

↪→ @user_full_name, '</i></b>' ) %]

<!-- Insert an image -->
<p align=center><img src="path/to/logos/qgis-logo-made-with-color.svg" alt=

↪→"QGIS icon" style="width:80px;height:50px;"</p>
</body>

</html>
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Fig. 21.25: Niveau van een label opwaarderen met opmaak in HTML

Uiterlijk

• Definieer lettertype en stĳl van de tekst door te klikken op de knop Lettertype. In het menu Label lettertype
kunt u enkele opties gebruiken voor Labeltekst opmaken.

• U kunt de verschillende horizontale en verticale marges specificeren in mm. Dat is de marge vanaf de rand van
het item van afdruklay-out. Het label kan worden geplaatst buiten de begrenzingen van het label, bĳv. om items
label uit te lĳnen met andere items. In dat geval dient u negatieve waarden voor de marge te gebruiken.

• Gebruiken van uitlĳning is een andere manier om uw label te plaatsen. Het kan zĳn:
– Links, Centreren, Rechts of Uitvullen voor Horizontale uitlĳning

– en Boven, Centraal midden, Onder voor Verticale uitlĳning.

Expressies verkennen in een item Label

Hieronder staan enkele voorbeelden van expressies die u kunt gebruiken om het label te vullen met interessante
informatie - onthoud dat de code, of ten minste het berekende gedeelte, zou moeten zĳn omsloten door [% en %] in
de groep Algemene eigenschappen:

• Een titel weergeven met de huidige waarde van “field1” van het huidige object van Atlas:

'This is the map for ' || "field1"

of, zoals geschreven in het gedeelte Algemene eigenschappen:

This is the map for [% "field1" %]

• Paginanummering toevoegen voor verwerkte objecten van Atlas (bĳv, Pagina 1/10):

concat( 'Page ', @atlas_featurenumber, '/', @atlas_totalfeatures )

• Geef de naam terug van de airports van het huidige object region van atlas, gebaseerd op hun
gemeenschappelĳke attributen:

aggregate( layer := 'airports',
aggregate := 'concatenate',
expression := "NAME",
filter := fk_regionId = attribute( @atlas_feature, 'ID' ),
concatenator := ', '

)

Of, indien een attributenrelatie is ingesteld:

relation_aggregate( relation := 'airports_in_region_relation',
aggregate := 'concatenate',
expression := "NAME",

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)
concatenator := ', '

)

• Geef de naam terug van de airports van het huidige object region van atlas, gebaseerd op hun ruimtelĳke relatie:

aggregate( layer := 'airports',
aggregate := 'concatenate',
expression := "NAME",
filter := contains( geometry( @parent ), $geometry ),
concatenator := ', '

)

OF:

array_to_string( array:= overlay_contains( layer := 'airports',
expression := "NAME" ),

delimiter:= ', '
)

• Geef de laagste X-coördinaat terug van het bereik van het item Kaart 1:

x_min( map_get( item_variables( 'Map 1' ), 'map_extent' ) )

• Haal de namen op van de lagen in de huidige lay-out van het item Kaart 1, en maak die op met één naam
per regel:

array_to_string(
array_foreach(
map_get( item_variables( 'Map 1' ), 'map_layers' ), -- retrieve the layers␣

↪→list
layer_property( @element, 'name' ) -- retrieve each layer name

),
'\n' -- converts the list to string separated by breaklines
)

• De lĳst van lagen met hun tekenreeksen voor licentie weergeven (gebruiksrechten) in een item voor lay-out
Kaart 1. U moet eerst de eigenschappen van de laag Toegang metadata vullen.

array_to_string( map_credits( 'Map 1', true ) )

21.2.5 Het item Legenda

Het item Legenda is een vak of tabel dat de op de kaart gebruikte symbolen uitlegt. Een item Legenda is dan gebonden
aan een kaartitem. U kunt een item Legenda toevoegen met het gereedschap Legenda toevoegen door instructies
voor het maken van items te volgen en het op dezelfde manier te bewerken als is besproken inWerken met items voor
lay-out.
Standaard geeft het item Legenda alle beschikbare lagen weer en kan worden verfĳnd met zĳn paneel Item-
eigenschappen. Naast de algemene eigenschappen voor items, heeft dit object de volgende functionaliteiten (zie Fig.
21.26):

758 Hoofdstuk 21. De kaarten opmaken



QGIS Desktop 3.28 User Guide

Fig. 21.26: Paneel Legenda Item-eigenschappen

Algemene eigenschappen

De groep Algemene eigenschappen van het paneel Item-eigenschappen van de legenda verschaft de volgende
functionaliteiten (zie Fig. 21.27):

Fig. 21.27: Legenda groep Algemene eigenschappen

In Algemene eigenschappen kunt u:
• De Titel van de legenda wĳzigen. Die kan dynamisch worden gemaakt met de instelling data-bepaalde

‘override’ , bĳvoorbeeld nuttig bĳ het maken van een atlas;
• Kiezen naar welk item kaart de huidige legenda zal verwĳzen. Standaard wordt de kaart gekozen waarover het
item is getekend. Indien geen dan valt het terug op de verwĳzingskaart.

Notitie: Variabelen van het gekoppelde kaartitem (@map_id, @map_scale, @map_extent…) zĳn ook
bereikbaar vanuit data-bepaalde eigenschappen van de legenda.

• De tekst van de legenda laten afbreken op een opgegeven teken: elke keer als het teken verschĳnt, wordt het
vervangen door een regeleinde;

• De plaatsing van symbolen en tekst in de legenda instellen: de Schikking kan zĳn Symbolen links of Symbolen
rechts. De standaardwaarde is afhankelĳk van de gebruikte locale (gebaseerd op van-rechts-naar-links of niet).
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• Aanpassen naar inhoud gebruiken om te beheren of de grootte van een legenda automatisch zou moeten
worden aangepast om zĳn inhoud te laten passen of niet. Indien niet geselecteerd, dan zal de grootte nooit
worden aangepast en in plaats daarvan blĳven op de grootte zoals de gebruiker die heeft ingesteld. Alle inhoud,
die niet binnen de grootte past, wordt afgebroken.

Items voor legenda

De groep Items voor Legenda van het paneel Item-eigenschappen verschaft de volgende functionaliteiten (zie Fig.
21.28):

Fig. 21.28: Legenda groep Items voor Legenda

• De legenda zal automatisch worden bĳgewerkt als Automatisch bĳwerken is geselecteerd. Wanneer
Automatisch bĳwerken niet is geselecteerd, dan zal dit u meer beheer over de items van de legenda geven.
Alle pictogrammen onder de lĳst met items voor de legenda zullen worden geactiveerd.

• Het venster met items van de legenda vermeld alle items van de legenda en stelt u in staat de volgorde van de
items te wĳzigen, lagen te groeperen, items in de lĳst te verwĳderen en opnieuw op te nemen, laagnamen en
symbologie te bewerken en een filter toe te voegen.

– De volgorde van de items kan worden gewĳzigd met de knoppen en of met de functionaliteit
‘slepen en neerzetten’. De volgorde kan niet worden gewĳzigd voor afbeeldingen van een WMS-legenda.

– Gebruik de knop om een groep voor de legenda toe te voegen.

– Gebruik de knop om nieuwe lagen toe te voegen en de knop om groepen, lagen of klassen voor
symbolen te verwĳderen.

– De knop wordt gebruikt om de laag- , groepsnaam of titel te bewerken. U dient eerst het item van
de legenda te selecteren. Dubbelklikken op het item opent het tekstvak om het te hernoemen.

– De knop gebruikt expressies om elk symboollabel van de geselecteerde laag aan te passen (zie Data-
bepalen van de labels voor de legenda)

– De knop voegt een telling van de objecten voor elke klasse van de vectorlaag toe.
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– Legenda op expressie filteren helpt u filteren welke items van de legenda zullen worden weergegeven, d.i.
met behulp van een laag die verschillende items voor de legenda (bĳv. uit een op regel gebaseerde of
gecategoriseerde symbologie) heeft, kunt u een Booleaanse expressie specificeren om stĳlen, die geen
object hebben dat voldoet aan de voorwaarde, uit de boom van de legenda te verwĳderen. Onthoud dat
ondanks dat de objecten wel worden behouden en worden weergegeven in het kaartitem van Afdruklay-
out.

Waar het standaard gedrag van het item legenda is om de boom van het paneel Lagen na te bootsen, door
dezelfde groepen, lagen en klassen symbologie weer te geven, biedt een klik met rechts u opties om de naam
van de laag te verbergen of te laten zien als groep of subgroep. In het geval u enkele wĳzigingen aan een laag
hebt gemaakt, kunt u die terugdraaien door te kiezen voor Herstellen naar standaarden in het contextmenu van
het item Legenda.
Na het wĳzigen van de symbologie in het hoofdvenster van QGIS kunt u klikken op Alles bĳwerken om de
wĳzigingen toe te passen in het element Legenda van de afdruklay-out.

• Met het keuzevak Alleen items tonen die binnen de gekoppelde kaart liggen, worden alleen de items voor de
legenda, die zichtbaar zĳn in de gekoppelde kaart, vermeld in de legenda. Dit gereedschap blĳft beschikbaar
als Automatisch bĳwerken actief is

• Bĳ het genereren van een atlas met polygoonobjecten kunt u items voor de legenda die buiten het huidige
atlasobject liggen uitfilteren. Selecteer, om dat te doen, de optie Alleen items tonen die binnen het huidige
atlasobject liggen.

Data-bepalen van de labels voor de legenda

stelt u in staat expressies toe te voegen aan elk label van een symbool van een opgegeven laag. Nieuwe variabelen
(@symbol_label, @symbol_id en @symbol_count) helpen u bĳ het werken met het item Legenda.
Als voorbeeld: gegeven een laag regions, die is gecategoriseerd op zĳn veld type, kunt u aan elke klasse in de
legenda zĳn aantal objecten en totale gebied toevoegen, bĳv. Borough (3) - 850ha:

1. Selecteer het item van de laag in de boom van de legenda

2. Druk op de knop , wat het dialoogvenster Expressie-string bouwer opent
3. Voer de volgende expressie in (er van uitgaande dat de symboollabels niet zĳn bewerkt):

format( '%1 (%2) - %3ha',
@symbol_label,
@symbol_count,
round( aggregate(@layer, 'sum', $area, filter:= "type"=@symbol_label)/

↪→10000 )
)

4. Klik op OK
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Items van legenda aanpassen

Items van de legenda kunnen ook individueel worden aangepast in de Legenda item-igenschappen. Maar dit aanpassen
kan alleen worden uitgevoerd als Automatisch bĳwerken is uitgeschakeld.

Dubbelklikken op een item of drukken op Geselecteerde item-eigenschappen bewerken maakt verder aanpassen mogelĳk.
Label

Voor alle typen items is het mogelĳk de tekst van het label aan te passen door er in te typen of door expressie in te
voegen met de knop Een expressie invoegen of bewerken. Expressies kunnen ook direct overal in het label van het
item worden toegevoegd met de notatie [% expressie %].
Kolommen

De Item-eigenschappen legenda stellen u ook in staat het gedrag voor het splitsen van kolommen te beheren door
het splitsen van de kolommen geforceerd te laten gebeuren na een specifiek item of alle symbolen van een laag.
Automatisch splitsen van een laag en zĳn kinderen kan ook worden toegestaan of geblokkeerd op een basis per laag
in dit widget.
Modelvorm
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Voor items met een symbool maakt de Itemeigenschap legenda het mogelĳk om de maximale hoogte en breedte te
specificeren die een symbool mag innemen.
Voor vectorsymbolen kunt u een aangepaste vorm specificeren voor het symbool. De vormen worden gewoonlĳk
gedefinieerd door een expressie om de geometrie in een eenvoudig vlak weer te geven, maar deze symbolen kunnen
ook worden opgeslagen in de Stĳlmanager en later worden geïmporteerd. Het standaard symbool voor elk type
geometrie kan ook worden beheerd via de Stĳlmanager.
Aangepast symbool

Een aangepast symbool kan ook worden gespecificeerd voor vectorsymbolen. Dit kan nuttig zĳn om het renderen van
een specifiek symbool aan te passen, het in de legende te verbeteren of een onafhankelĳk symbool van zĳn waren
voorbeeldsymbool te hebben. Dit aangepaste symbool zal het symbool in de legenda overschrĳven, maar zal rekening
houden met de voor het symbool gspecificeerde Modelvorm.

Lettertypen

De groep Lettertypen van het paneel Item-eigenschappen verschaft de volgende functionaliteiten:

Fig. 21.29: Legenda eigenschappen lettertypen

• U kunt het lettertype van de titel van de legenda, groep, subgroep en item (object) in het item Legenda wĳzigen
met de widget lettertype selecteren
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• Voor elk van deze niveaus kunt u de Uitlĳning van de tekst instellen: het kan zĳn Links (standaard voor locales
gebaseerd op van-rechts-naar-links), Centreren of Rechts (standaard voor locales gebaseerd op van-links-naar-
rechts).

• U kunt de Kleur van de labels instellen met de widget kleur selecteren. De geselecteerde kleur zal worden
toegepast op alle items voor lettertypen in de legenda.

Kolommen

Onder de groep Kolommen van het paneel Item-eigenschappen van de legenda, kunnen items van de legenda worden
geschikt in verscheidene kolommen:

• Stel het aantal kolommen in in het veld Aantal. Deze waarde kan dynamisch worden gemaakt, bĳv.
volgen van objecten van de atlas, inhoud van de legenda, de grootte van het frame…

• Gelĳke kolombreedtes stelt in hoe kolommen van legenda’s zouden moeten worden aangepast.

• De optie Kaartlagen splitsen stelt u in staat een legenda voor een gecategoriseerde of een graduele laag op
te delen in kolommen.

Fig. 21.30: Legenda instellingen kolommen

Symbool

De groep Symbool van het paneel Item-eigenschappen van de legenda configureert de grootte van symbolen die worden
weergegeven naast de labels van de legenda. U kunt:

• De Symboolbreedte en Symboolhoogte instellen
• Instellen van demarkeringen’Min symboolgrootte enMax symboolgrootte:0.00mm betekent dat er geen waarde
is ingesteld.

• Lĳn voor rastersymbolen tekenen: dit voegt een omtrek toe aan het symbool dat de kleur van de band van
de rasterlaag weergeeft; u kunt zowel de Lĳnkleur als de Dikte instellen.
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Fig. 21.31: Symbool van legenda configureren

WMS LegendGraphic

Het gedeelteWMS LegendGraphic van het paneel Item-eigenschappen verschaft de volgende functionaliteiten (bekĳk
Fig. 21.28):

Fig. 21.32: WMS LegendGraphic

Wanneer u een WMS-laag heeft toegevoegd en u voegt een item Legenda voor de Afdruklay-out toe, zal een verzoek
worden verzonden aan de server vanWMS om een legenda voorWMS te verschaffen, Deze legenda zal alleen worden
weergegeven als de server vanWMS de mogelĳkheid GetLegendGraphic bezit. De inhoud van de legenda voorWMS
zal worden verschaft als een rasterafbeelding.
WMS LegendGraphic wordt gebruikt om in staat te zĳn de Legenda breedte en de Legenda hoogte van de
rasterafbeelding van de WMS-legenda aan te passen.
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Afstanden

Het gedeelte Tussenruimte stelt u in staat de tussenruimte aan te passen binnen de legenda. Tussenruimte kan enorm
helpen bĳ het groeperen van items in de legenda en hun relatie.
Tussenruimte rondom en voor titel, groepen, subgroepen, symbolen, labels, vakken, kolommen en lĳnen kan via dit
dialoogvenster worden aangepast.

21.2.6 Het item Schaalbalk

Schaalbalken verschaffen een visuele indicatie van de grootte van objecten, en afstand tussen objecten, op het
kaartitem. Een item Schaalbalk vereist een kaartitem. Gebruik het gereedschap Schaalbalk toevoegen, gevolgd
door instructies voor het maken van items, om een nieuw item Schaalbalk toe te voegen en het later op dezelfde manier
te bewerken als is besproken inWerken met items voor lay-out.
Standaard geeft een nieuw item Schaalbalk de schaal weer van het kaartitem waar het op getekend is. Als er geen
kaartitem onder ligt, wordt de verwĳzingskaart gebruikt. U kunt die aanpassen in het paneel Item-eigenschappen.
Anders dan de algemene eigenschappen voor items, heeft deze mogelĳkheid de volgende functionaliteiten (zie Fig.
21.33):
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Fig. 21.33: Paneel Schaalbalk Item-eigenschappen

Algemene eigenschappen

De groep Algemene eigenschappen van het paneel Item-eigenschappen van de schaalbalk verschaft de volgende
functionaliteiten (zie Fig. 21.34):

Fig. 21.34: Schaalbalk groep Algemene eigenschappen

1. Kies als eerste de kaart waar de schaalbalk aan verbonden zal worden
2. Kies dan de stĳl van de schaalbalk. Beschikbare stĳlen zĳn:

• Stĳlen Enkele rechthoek en Dubbele rechthoek, die een of twee lĳnen met wisselende kleurvakken
bevatten;

• Midden, Boven of Onder schaalstreepjes;
• Staplĳn stĳl die een weergave als een staplĳn tekent voor de schaalbalk
• Holle stĳl die een enkel vak tekent met verschillende kleuren voor de segmenten, met horizontale lĳnen
door verschillende segmenten

• Numeriek, waar de verhoudingen van de schaal worden afgedrukt (bĳv. 1:50000).
3. Stel eigenschappen in zoals toepasselĳk is
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Eenheden

De groep Eenheden van het paneel Item-eigenschappen van de schaalbalk verschaft de functionaliteiten om de
eenheden voor weergave in te stellen en enige opmaak voor tekst (zie Fig. 21.35):

Fig. 21.35: Schaalbalk groep Eenheden

• Selecteer de eenheden die u wilt gebruiken voor Schaalbalk eenheden. Er zĳn veel mogelĳke keuzen:
Kaarteenheden (de standaard), Meters, Voet, Mĳlen of Zeemĳlen… en enkele afgeleiden. Converteren
van eenheden wordt automatisch afgehandeld.

• De Vermenigvuldigingsfactor eenheid label specificeert hoeveel eenheden van de schaalbalk per gelabelde
eenheid. Bĳv. als uw eenheden voor de schaalbalk zĳn ingesteld op “meters”, zal een vermenigvuldigingsfactor
van 1000 resulteren in labels voor de schaalbalk in “kilometers”.

• Het veld Label voor eenheden definieert de tekst die wordt gebruikt voor labels van de eenheden van de
schaalbalk, bĳv m of km. Dit zou moeten overeenkomen om de vermenigvuldigingsfactor van hierboven te
reflecteren.

• Druk op Aanpassen naast Getalindeling om beheer te verkrĳgen over alle eigenschappen voor opmaak van
de getallen in de schaalbalk, inclusief scheidingstekens duizendtallen, decimale plaatsen, wetenschappelĳke
notatie, etc. (zie Opgemaakte getallen voor meer details). Zeer nuttig in het geval van het maken van kaarten
voor publiek buiten de huidige locale van QGIS, of wanneer u de stĳl zou willen laten variëren van de
locale standaarden (bĳv. scheidingstekens duizendtallen toevoegen als de standaard voor de locale is om ze
te verbergen).

Segmenten

De groep Segmenten van het paneel Item-eigenschappen van de schaalbalk verschaft de functionaliteiten om het aantal
en de grootte van segmenten en subverdelingen te configureren (zie Fig. 21.36):

Fig. 21.36: Schaalbalk groep Segmenten

• U kunt het aantal Segmenten definiëren dat zal worden getekend aan de linker- en rechterkant van de 0 van de
schaalbalk.
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– aantal subverdelingen van een uniek segment aan de Linker kant
– aantal segmenten aan de Rechter kant

• U kunt de breedte van een segment instellen of een bereik voor de totale lengte van de schaalbalk:
– Stel in hoe lang een segment moet zĳn, in eenheden van uw schaalbalk (Vaste breedte)
– Of de grootte in de schaalbalk beperken in mmmet de optie Breedte segment passend maken. In het laatste
geval wordt de schaalbalk, elke keer als de kaart wordt gewĳzigd, aangepast in grootte (en wordt het label
bĳgewerkt) om te passen binnen het ingestelde bereik.

• Hoogte wordt gebruikt om de hoogte van de balk te definiëren.
• Subverdeling rechter segmenten wordt gebruikt om het aantal gedeelten te definiëren die segmenten aan de
rechterkant mogen hebben (voor de stĳlen van de schaalbalk Schaalstreepjes onder, Schaalstreepjes midden en
Schaalstreepjes boven) .

• Subverdelingen hoogte wordt gebruikt om de hoogte van het segment subverdeling te definiëren.

Tonen

De groep Tonen van het paneel Item-eigenschappen verschaft de volgende functionaliteiten:

Fig. 21.37: Schaalbalk groep Tonen

U kunt definiëren hoe de schaalbalk zal worden weergegeven in zĳn frame.
• Marges vak : ruimte tussen de tekst en de randen van het frame
• Labelmarge : afstand tussen tekst en de getekende schaalbalk
• Label verticale plaatsing: het kan staan boven of onder het segment van de schaalkbalk
• Label horizontale plaatsing: wat zou worden gecentreerd aan de rand of het midden van het segment Schaalbalk
• Primaire vulling en Secundaire vulling voor het tekenen van de schaalbalk gebruiken eigenschappen voor

symbolen voor vulling (kleur, doorzichtbaarheid, patronen, effecten…) — voor de stĳlen Enkele rechthoek,
Dubbele rechthoek en Hol

• Lĳnstĳl voor het tekenen van de schaalbalk gebruikt eigenschappen voor lĳnsymbolen (kleur, dikte, koppeling,
eindstĳl, patronen, effecten…) — voor alle stĳlen, behalve de stĳl Numeriek
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• Verdelingsstĳl en Subverdelingsstĳl respectievelĳk voor segmenten voor verdeling en subverdeling in de
stĳlen Schaalstreepjes boven, Schaalstreepjes midden en Schaalstreepjes onder voor de schaalbalk gebruiken
eigenschappen voor lĳnsymbolen (kleur, dikte, koppeling, eindstĳl, patronen, effecten…)

• Uitlĳning plaatst tekst links, midden of rechts van het frame (alleen voor de stĳl Numeriek van de schaalbalk)
• Lettertype om de eigenschappen (grootte, lettertype, kleur, letterafstand, schaduw, achtergrond…) van het label
voor de schaalbalk in te stellen.

Omdat de meeste van de eigenschappen voor weergave van de schaalbalk afhankelĳk zĳn van symbolen waarvan de
eigenschappen data-bepaald kunnen worden, is het mogelĳk data-bepaalde schaalbalken te renderen.
Voorbeeld: De volgende code, toegepast op de eigenschap Vet van de labels voor de schaalbalk, zal getallen vet
weergeven wanneer zĳ een veelvoud van 500 zĳn:

-- returns True (or 1) if the value displayed on the bar
-- is a multiple of 500

@scale_value % 500 = 0

21.2.7 De items Tabel

U kunt items Tabel gebruiken om uw kaart te decoreren en uit te leggen:
• Attributentabel: geeft een subset weer van de attributen van een laag, gebaseerd op vooraf gedefinieerde regels
• Vaste tabel: voegt een handmatige teksttabel in waarin informatie, onafhankelĳk van de lagen, kan worden
opgenomen.

Het item attributentabel

Elke laag in het project kan zĳn attributen hebben weergegeven in de afdruklay-out. Gebruik het gereedschap
Attributentabel toevoegen, zoals vermeld in instructies voor het maken van items, om een nieuw item Tabel toe te
voegen dat u later op dezelfde manier kunt bewerken zoals besproken inWerken met items voor lay-out.
Standaard laadt een nieuw item attributentabel eerst rĳen van de eerste (alfabetisch gesorteerd) laag, met alle velden.
U kunt echter de tabel aanpassen met het paneel Item-eigenschappen. Naast de algemene eigenschappen voor items,
heeft dit object de volgende functionaliteiten (zie Fig. 21.38):

Fig. 21.38: Paneel Attributentabel Item-eigenschappen
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Algemene eigenschappen

De groep Algemene eigenschappen van een attributentabel verschaft de volgende functionaliteiten (zie Fig. 21.39):

Fig. 21.39: Attributentabel groep Algemene eigenschappen

• Voor Bron kunt u standaard alleen Laagobjecten selecteren, wat u in staat stelt een Laag te kiezen uit de in
het project geladen vectorlagen.

De knop data-bepaalde ‘override’ nabĳ de lagenlĳst stelt u in staat de laag, die is gebruikt om de tabel te vullen,
dynamisch te wĳzigen, bĳv. u zou de attributentabel met verschillende attributen van lagen kunnen vullen
per pagina voor Atlas. Onthoud dat de gebruikte tabelstructuur (Fig. 21.42), die is van de laag die wordt
weergegeven in de keuzelĳst Laag, en dat die intact wordt gelaten, wat betekent dat het instellen van een
gegevensgedefinieerde tabel op een laag met verschillende veld(en) zal resulteren in lege kolom(men) in de
tabel.

In het geval dat u de optie Genereer een atlas in het paneel Atlas (zie Een atlas genereren) hebt geactiveerd,
zĳn er twee aanvullende Bron mogelĳk:

– Huidig atlasobject (zie Fig. 21.40): u zult geen optie zien om de laag te kunnen kiezen, en het tabelitem
zal slechts één rĳ weergeven met de attributen van het huidige object in de bedekkingslaag van de atlas.

– en Relatie kinderen (zie Fig. 21.41): een optie met de namen van de relaties zal worden weergegeven.
Deze mogelĳkheid kan alleen worden gebruikt als u een relatie heeft gedefinieerd die uw bedekkingslaag
voor de atlas als ouder gebruikt en de tabel zal de kind-rĳen weergeven van het huidige object van de
bedekkingslaag voor de atlas.

• De knop Tabelgegevens verversen kan worden gebruikt om de tabel te vernieuwen wanneer de feitelĳke inhoud
van de tabel is gewĳzigd.

Fig. 21.40: Attributentabel Algemene eigenschappen voor ‘Huidig atlas-object’

Fig. 21.41: Attributentabel Algemene eigenschappen voor ‘Relatie kinderen’
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• De knop Attributen… start het dialoogvenster Attributen selecteren (zie Fig. 21.42), dat kan worden gebruikt
om de zichtbare inhoud van de tabel te wĳzigen. Het bovenste gedeelte van het venster geeft de weer te geven
lĳst met attributen weer en het onderste gedeelte helpt u om de gegevens te sorteren.

Fig. 21.42: Dialoogvenster Attributentabel Selecteer attributen

In het gedeelte Kolommen kunt u:
– attributen naar boven of naar beneden verplaatsen in de lĳst, door de rĳen te selecteren en dan de knoppen

en om de rĳen te verschuiven. Meerdere rĳen kunnen in één keer worden geselecteerd en
verplaatst.

– een attribuut toevoegen met de knop . Dit zal een lege regel aan het einde van de tabel toevoegen
waar u een veld kunt selecteren voor de waarde van het attribuut of u kunt een attribuut maken met een
reguliere expressie.

– Verwĳder een attribuut met de knop . Meerdere rĳen kunnen in één keer worden geselecteerd en
verwĳderd.

– de attributentabel terug herstellen naar zĳn standaardstatus met de knop Terug naar beginwaarden.
– de tabel leegmaken met de knop Leegmaken. Dit is nuttig als u een grote tabel heeft, maar slechts een
klein aantal attributen wilt weergeven. In plaats van handmatig elke rĳ te verwĳderen, zou het sneller
kunnen zĳn om de tabel leeg te maken en de benodigde rĳen toe te voegen.

– celkoppen wĳzigen door de aangepaste tekst toe te voegen aan de kolom Kop.
– cellen uitlĳnen beheren met de kolom Uitlĳning, die de positie van de teksten binnen de tabelcel dicteert.
– celbreedte handmatig beheren door aangepaste waarden toe te voegen aan de kolom Breedte.

In het gedeelte Sorteren kunt u:

– Voeg een attribuut toe om de tabel op te sorteren: druk op de knop en een nieuwe lege rĳ wordt
toegevoegd. Voeg een veld of een expressie in de kolom Attribuut in en stel de Sorteervolgorde in op
Oplopend of Aflopend.
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– Selecteer een regel in de lĳst en gebruik de knoppen en om de prioriteit voor het sorteren op
het niveau van het attribuut te wĳzigen. Selecteren van een cel in de kolom Sorteervolgorde helpt u de
sorteervolgorde van een veld van een attribuut te wĳzigen.

– Gebruik de knop om een attribuut uit de lĳst van de sorteervolgorde te verwĳderen.

Objecten filteren

De groep Objecten filteren van de attributentabel verschaft de volgende functionaliteiten (zie Fig. 21.43):

Fig. 21.43: Attributentabel groep Objecten filteren

U kunt:
• Het Maximaal aantal rĳen, dat moet worden weergegeven, definiëren.

• Activeren Duplicaat-rĳen uit tabel verwĳderen om alleen unieke records weer te geven.

• Activeer Alleen objecten zichtbaar op kaart tonen en selecteer de overeenkomende Gekoppelde kaart
waarvan alleen attributen van objecten die zichtbaar zĳn op de geselecteerde kaart zullen worden weergegeven.

• Activeren van Alleen objecten die object atlas kruisen tonen is alleen beschikbaar als Genereer een atlas is
geactiveerd. Indien geactiveerd zal het een tabel weergeven met alleen de objecten die kruisen met het huidige
object van de atlas.

• Activeer Filterenmet en verschaf een filter door die in de invoerregel te typen of door een reguliere expressie
te gebruiken met behulp van de verschafte knop . Een aantal voorbeelden van argumenten om te filteren
die u kunt gebruiken wanneer u de laag Airports uit de voorbeeld gegevensset heeft geladen:

– ELEV > 500

– NAME = 'ANIAK'

– NAME NOT LIKE 'AN%

– regexp_match( attribute( $currentfeature, 'USE' ) , '[i]')

De laatste reguliere expressie zal alleen de vliegvelden opnemen die de letter ‘i’ in het attribuutveld ‘USE’
hebben.
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Uiterlijk

De groep Uiterlĳk van de attributentabel verschaft de volgende functionaliteiten (zie Fig. 21.44):

Fig. 21.44: Attributentabel groep Uiterlijk

• Klik op Lege rĳen tonen zal de attributentabel vullen met lege cellen. Deze optie kan ook worden gebruikt
om aanvullende lege cellen te maken wanneer u een resultaat wilt weergeven!

• Met Celmarges kunt u de marge rondom de tekst in elke cel van de tabel definiëren.
• Met Kop weergeven kunt u één optie uit een lĳst selecteren, ‘Op eerste frame’, ‘Op alle frames’ standaardoptie,
of ‘Geen kop’.

• De optie Lege tabel beheert wat zal worden weergegeven als de selectie van het resultaat leeg is.
– Alleen koppen tekenen, zal alleen de kop tekenen, tenzĳ u ‘Geen kop’ heeft gekozen voorKop weergeven.

– Gehele tabel verbergen, zal alleen de achtergrond van de tabel tekenen. U kunt Geen achtergrond
tekenen als frame leeg is activeren in Frames om de tabel volledig te verbergen.

– Ingesteld bericht tonen, zal de kop tekenen en voegt een cel toe die zich uitstrekt over alle kolommen en
geeft een bericht weer als ‘Geen resultaten’ die kan worden opgegeven in de optieWeer te geven bericht

• De optie Weer te geven bericht tonen wordt alleen geactiveerd wanneer u Ingesteld bericht tonen voor Lege
tabel heeft geselecteerd. Het opgegeven bericht zal worden weergegeven in de eerste rĳ van de tabel, als het
resultaat een lege tabel is.

• Met Achtergrondkleur kunt u de achtergrondkleur van de tabel instellen met de widget Kleur kiezen. De optie
Geavanceerd aanpassen helpt u om verschillende achtergrondkleuren te definiëren voor elke cel (zie Fig. 21.45)
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Fig. 21.45: Dialoogvenster Attributentabel Geavanceerd Achtergrondkleur

• Kleuren voorwaardelĳke stĳlen toepassen op laag: de voorwaardelĳke opmaak van de tabel, die aanwezig is
in de laag, wordt toegepast op de lay-out attributentabel (achtergrondkleur, familie lettertype en eigenschappen
zoals vet, cursief, onderstrepen, kleur, …). Regels voor voorwaardelĳke opmaak hebben voorrang boven
andere instellingen voor opmaak van tabellen voor lay-out, ze zullen bĳvoorbeeld andere instellingen voor
de achtergrondkleur voor cellen overschrĳven, zoals wisselende kleuren voor rĳen.

• Met de optie Tekstterugloop aan kunt u een teken definiëren waarbĳ de celinhoud naar een nieuwe regel gaat
als het teken wordt tegengekomen

• Met Vergrote tekst definieert u het gedrag als de ingestelde breedte voor een kolom kleiner is dan de lengte van
de inhoud. Het kan Tekst door laten lopen of Tekst afbreken zĳn.

Notitie: Meer eigenschappen van het item attributentabel worden beschreven in het gedeelte Algemene
functionaliteiten voor tabellen.

Het item Vaste tabel

Aanvullende informatie over de kaart kan handmatig worden ingevoegd door te kiezen voor Vaste tabel toevoegen,
en de instructies voor het maken van items te volgen, om een nieuw item Tabel toe te voegen dat u later op dezelfde
manier kunt bewerken zoals besproken inWerken met items voor lay-out.
Standaard verschĳnt een lege tabel met twee geminimaliseerde kolommen en rĳen in de lay-out van de kaart. U kunt
het aanpassen met zĳn paneel Item-eigenschappen. Naast de algemene eigenschappen, heeft dit object de volgende
functionaliteiten:
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Algemene eigenschappen

Fig. 21.46: Paneel Vaste tabel Item-eigenschappen met tabelontwerper

In Algemene eigenschappen kunt u werken met de Tabelontwerper door te klikken op Tabel bewerken…:
• U kunt in de tabel klikken en handmatig tekst invoegen.
• Met de menu’s aan de bovenzĳde is het mogelĳk om:

– Inhoud vanaf klembord importeren door te gaan naar Bestand (het overschrĳft de aanwezige invoer).
– werken met functies voor selecteren van rĳen en kolommen door te gaan naar Bewerken.

– Rĳen invoegen, Kolommen invoegen, Rĳen verwĳderen, Kolommen verwĳderen als ook de optie om
Koprĳ opnemen.

• U kunt werken met het gedeelte Celinhoud aan de rechterkant en:
– De indeling voor de tekst voor geselecteerde cellen definiëren in Opmaak

∗ door te klikken op de aanwezig knop Expressie en een reguliere expressie gebruiken voor de
invoer van de cel

∗ door Tekstindeling te kiezen

∗ met Als getal opmaken (verscheidene indelingen zĳn beschikbaar)
∗ door de Horizontale uitlĳning en de Verticale uitlĳning te definiëren
∗ door een Achtergrondkleur te kiezen
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– Definieer de Celgrootte with Rĳhoogte en Kolombreedte.

Uiterlijk

De groep Uiterlĳk van de vaste tabel verschaft de volgende functionaliteiten:

• Klik op Lege rĳen weergeven om de attributentabel te vullen met lege cellen.
• Met Celmarges kunt u de marge rondom de tekst in elke cel van de tabel definiëren.
• Met Kop weergeven kunt u één optie uit een lĳst selecteren, ‘Op eerste frame’, ‘Op alle frames’ standaardoptie,
of ‘Geen kop’.

• Met Achtergrondkleur kunt u de achtergrondkleur van de tabel instellen met de widget Kleur kiezen. De optie
Geavanceerd aanpassen helpt u om verschillende achtergrondkleuren te definiëren voor elke cel.

• Met Vergrote tekst definieert u het gedrag als de ingestelde breedte voor een kolom kleiner is dan de lengte van
de inhoud. Het kan Tekst door laten lopen of Tekst afbreken zĳn.

Notitie: Meer eigenschappen van het item vaste tabel worden beschreven in het gedeelte Algemene functionaliteiten
voor tabellen.

Algemene functionaliteiten voor tabellen

Raster tonen

De groep Raster tonen van de items Tabel verschaft de volgende functionaliteiten (zie Fig. 21.47):

Fig. 21.47: Attributentabel groep Raster tonen

• Activeer Raster tonen wanneer u het raster wilt weergeven, de omtrekken van de cellen van de tabel. U kunt
ook kiezen voor ofwel Horizontale lĳnen tekenen of Verticale lĳnen tekenen of beide.

• Met Lĳndikte kunt u de dikte van de lĳnen, die in het raster worden gebruikt, instellen.
• De Kleur van het raster kan worden ingesteld met het widget Kleur kiezen.

Opmaak lettertypen en tekst

De groep Opmaak lettertypen en tekst van de items Tabel verschaft de volgende functionaliteiten (zie Fig. 21.48):
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Fig. 21.48: Attributentabel groep Opmaak lettertypen en tekst

• U kunt eigenschappen Lettertype voor Tabelkop en Tabelinhoud definiëren, met de widget voor gevorderde
tekstinstellingen (met buffer, schaduw, tekeneffecten, transparantie, achtergrond, kleur, …). Onthoud dat deze
wĳzigingen niet de cellen beïnvloeden die een aangepast lettertype hebben toegewezen gekregen, ofwel vanuit
het gedeelte Uiterlĳk of het dialoogvenster Tabelontwerp. Alleen cellen met de standaard rendering worden
overschreven.

• Voor Tabelkop kunt u aanvullend de Uitlĳning instellen op Uitlijnen kolom volgen of deze instelling
overschrĳven door te kiezen voor Links, Centreren of Rechts. De uitlĳning van de kolom wordt
ingesteld met het dialoogvenster Attributen selecteren (zie Fig. 21.42).

Frames

De groep Frames van de items Tabel verschaft de volgende functionaliteiten (zie Fig. 21.49):

Fig. 21.49: Attributentabel groep Frames

• Met Modus Formaat wĳzigen kunt u selecteren hoe de inhoud van de attributentabel moet worden gerenderd:
– Bestaande frames gebruiken geeft het resultaat alleen weer in het eerste frame en toegevoegde
frames.

– Verlengen met de volgende pagina zal net zoveel frames (en corresponderende pagina’s)
maken als nodig is om de volledige selectie uit de attributentabel weer te geven. Elk frame kan over de
lay-out worden verplaatst. Als u de grootte van een frame aanpast, zal de tabel worden opgedeeld tussen
de andere frames. Het laatste frame zal worden verkleind om de tabel daar in te laten passen.

– Herhalen tot voltooid zal net zoveel pagina’s maken als de optie Verlengen met de volgende
pagina, met het verschil dat alle frames dezelfde grootte hebben.

• Gebruik de knop Frame toevoegen om een ander frame met dezelfde grootte als het geselecteerde frame toe te
voegen. Het resultaat van de tabel dat niet past binnen het eerste frame zal worden voortgezet in het volgende
frame wanneer u de modus Formaat wĳzigen Bestaande frames gebruiken gebruikt.

• Activeren van Pagina niet exporteren als frame leeg is voorkomt dat de pagina wordt geëxporteerd als het
tabelframe geen inhoud heeft. Dit betekent dat alle andere items van de lay-out, kaarten, schaalbalken, legenda’s
etc. niet zichtbaar zullen zĳn in het resultaat.

• Activeren van Geen achtergrond tekenen als frame leeg is voorkomt dat de achtergrond wordt getekend als
het tabelframe geen inhoud heeft.
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21.2.8 De items Markering, Afbeelding en Noordpijl

• Het item Afbeelding

– Algemene eigenschappen

– Grootte en plaatsing

– Afbeelding draaien

• Het item Noordpĳl

• Het item Markering

Naast de kaart- of legenda-items in de afdruklay-out wilt u misschien uw creatie decoreren met afbeeldingen of
annotaties. QGIS verschaft verschillende gereedschappen om dat te doen:

• het item Afbeelding: decoreert de lay-out met een afbeeldingsraster of SVG-bestand (bĳv. logo’s, afbeeldingen,
noordpĳlen, …)

• het item Noordpĳl: een item Afbeelding met een vooraf gedefinieerde afbeelding van een noordpĳl
• het item markering: decoreert de lay-out met QGIS vector-symbolen. Het kan worden gebruikt ommarkeringen
ov er een kaartitem te plaatsen of voor het maken van geavanceerde aangepaste legenda’s.

Het item Afbeelding

U kunt een afbeelding toevoegen door het uit uw bestandsbeheerder in het kaartvenster te slepen, het direct in de
lay-out te plakken met Ctrl+V of Bewerken ► Plakken en door Afbeelding toevoegen, daarbĳ de instructies voor het
maken van items te volgen. Dan kunt u het bewerken zoals uitgelegd inWerken met items voor lay-out.

Bĳ het gebruiken van Afbeelding toevoegen, zal het item Afbeelding een leeg frame zĳn dat u kunt aanpassen met zĳn
paneel Item-eigenschappen. Naast de algemene eigenschappen, heeft dit object de volgende functionaliteiten:
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Algemene eigenschappen

Fig. 21.50: Afbeelding paneel Item-eigenschappen

Het item Afbeelding ondersteunt twee typen afbeeldingen:
• Rasterafbeelding: een widget voor selecteren van bestanden kan worden gebruikt om de gegevens op te halen.
Gebruik de knop… Bladeren om een bestand op uw computer te selecteren of voer het pad direct in het tekstveld
in. U mag zelfs een URL op afstand opgeven die naar een afbeelding verwĳst. De geassocieerde afbeelding
kan ook worden ingebed in de lay-out.

Gebruik de knop Data-bepaalde ‘override’ om de bron voor de afbeelding in te stellen vanuit een attribuut van
een object of met behulp van een reguliere expressie.

• SVG-afbeelding: gebruikt standaard de SVG-bibliotheken die zĳn verschaft in Extra ► Opties ► Systeem ►
SVG-paden. U mag echter elk ander bestand gebruiken, en het selecteren van het bestand volgt dezelfde regels
als die voor de rasterafbeelding. De parameters voor de SVG kunnen ook dynamisch worden ingesteld.
De met QGIS meegeleverde (standaard) .SVG-bestanden zĳn aan te passen, wat betekent dat u eenvoudig
andere Vulkleur, Lĳnkleur (inclusief doorzicht) en Lĳndikte kunt toepassen in plaats van het origineel, met hun
overeenkomende object in de groep SVG-parameters. Deze eigenschappen kunnen ook worden data-bepaald.
Wanneer u een .SVG-bestand toevoegt dat deze eigenschappen niet inschakelt, dient u misschien de volgende
tags toe te voegen aan het bestand om ondersteuning toe te voegen voor bĳv. transparantie:

– fill-opacity=”param(fill-opacity)”

– stroke-opacity=”param(outline-opacity)”

Meer details op SVG met parameters.

Notitie: Slepen en neerzetten van een afbeeldingsbestand (raster of SVG) op de pagina van de lay-out zal een item
Afbeelding voor de lay-out maken met overeenkomstige instellingen.
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Grootte en plaatsing

Fig. 21.51: Lay-out eigenschappen Afbeelding grootte en plaatsing

Met de optie Modus Formaat aanpassen kunt u instellen hoe de afbeelding wordt weergegeven wanneer het frame
wordt gewĳzigd:

• In-/Uitzoomen: vergroot/verkleint de afbeelding ten opzichte van het frame met behoud van de
verhoudingen in de afbeelding;

• Stretch: strekt de afbeelding om die te laten passen in het frame
• Clip: gebruik deze modus alleen voor rasterafbeeldingen, het stelt de grootte van de afbeelding in op de
originele grootte van de afbeelding zonder op schaal te brengen en het frame wordt gebruikt om de afbeelding
af te knippen. Dus alleen het gedeelte van de afbeelding binnen het frame zal zichtbaar zĳn.

• Inzoomen en kaartformaat aanpassen: vergroot de afbeelding zodat die in het frame past, wĳzigt
dan de grootte van het frame, zodat de dimensies van de resulterende afbeelding erin passen.

• Kaartgrootte aanpassen naar afbeelding: stelt de grootte van het frame in om overeen te
komen met de originele grootte van de afbeelding (zonder op schaal te brengen)

Afhankelĳk van de geselecteerde Modus Formaat wĳzigen, zouden de opties Plaatsing en Afbeelding draaien
uitgeschakeld kunnen zĳn. Plaatsing laat u de positie van de afbeelding binnen zĳn frame selecteren
(boven/midden/beneden en links/midden/rechts).

Afbeelding draaien

Afbeeldingen kunnen worden gedraaid met het veld Afbeelding draaien. Activeren van het keuzevak Met kaart
synchroniseren synchroniseert het draaien van de afbeelding met de rotatie die wordt toegepast op het geselecteerde
kaartitem. Dit is een handige mogelĳkheid om elke afbeelding zich te laten gedragen als een noordpĳl. Het Uitlĳnen
Noord kan zĳn:

• Raster Noord: de richting van een rasterlĳn die parallel ligt aan de centrale meridiaan van het nationale/lokale
raster

• Ware Noorden: richting van een meridiaan van longitude.
U kunt ook een afwĳking Verspringing toepassen op het draaien van de afbeelding.
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Fig. 21.52: Lay-out eigenschappen Afbeelding draaien

Het item Noordpijl

U kunt een afbeelding toevoegen met de knop Noordpĳl toevoegen, zoals vermeld in instructies voor het maken van
items en het op dezelfde manier bewerken als is weergegeven inWerken met items voor lay-out.
Omdat Noordpĳlen afbeeldingen zĳn heeft het item Noordpĳl dezelfde eigenschappen als het item Afbeelding. De
belangrĳkste verschillen zĳn:

• Een standaard noordpĳl wordt gebruikt bĳ het toevoegen van het item, in plaats van een blanco frame
• Het item Noordpĳl wordt standaard gesynchroniseerd met een kaartitem: de eigenschap Met kaart

synchroniseren van de kaart waarop het item Noordpĳl wordt getekend. Indien geen valt het terug op de
verwĳzingskaart.

Notitie: Veel van de noordpĳlen hebben geen ‘N’ toegevoegd in de Noordpĳl. Dit is met opzet gedaan, omdat er
talen zĳn die niet een ‘N’ voor Noord gebruiken.

Fig. 21.53: Beschikbare Noordpijlen in de meegeleverde bibliotheek voor SVG
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Het item Markering

Selecteer, om een item Markering toe te voegen, de knop Markering toevoegen, en klik op de pagina. Een standaard
markeringssymbool punt wordt toegevoegd. Dan kunt u het bewerken, zoals uitgelegd in Werken met items voor lay-
out. Maar onthoud dat, in tegenstelling tot de meeste andere items, u de grootte van het item wĳzigt wetende dat de
grootte ervan wordt beheerd door de ingebedde symbooleigenschappen.
Het item Markering kan worden aangepast met zĳn paneel Item-eigenschappen. Anders dan de algemene
eigenschappen voor items kunt u ook:

• het Symbool aanpassen, vertrouwend op alle widget-mogelĳkheden van het symbool
• het draaien van het item Markering synchroniseren met die van de kaart (bekĳk Afbeelding draaien), acterend
als een noordpĳl. De rotatie van de kaart wordt toegevoegd aan elk bestaand niveau voor draaien van het
markeringssymbool (dus bĳv. als u de markering driehoek 90° moet draaien om het recht naar boven te laten
wĳzen, zal het nog steeds goed werken in de modus Noordpĳl!)

Fig. 21.54: De aangepaste eigenschappen voor het item Markering

21.2.9 Het item HTML-frame

Het is mogelĳk een frame toe te voegen dat de inhoud van een website weergeeft of zelfs uw eigen pagina met HTML
maken en opmaken en die weergeven! U kunt een afbeelding toevoegen met HTML toevoegen gevolgd door
instructies voor het maken van items en het op dezelfde manier bewerken als werd besproken inWerken met items voor
lay-out. Onthoud dat de schaal van de HTML wordt beheerd door de exportresolutie van de lay-out op het moment
dat het HTML-frame wordt gemaakt.
Het item HTML kan worden aangepast met zĳn paneel Item-eigenschappen. Naast de algemene eigenschappen voor
items, heeft dit object de volgende functionaliteiten (zie Fig. 21.55):
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Fig. 21.55: HTML Frame, the Item Properties Panel

HTML-bron

De groepHTML-bron van het paneel Item-eigenschappen van het HTML-frame verschaft de volgende functionaliteiten
(zie Fig. 21.56):

Fig. 21.56: HTML frame, the HTML Source properties

• In URL kunt u de URL invoeren van een webpagina die u heeft gekopieerd vanuit uw internetbrowser of
een HTML-bestand selecteren met behulp van de knop … Bladeren. Er is ook de optie om de knop
Data bepaalde ‘override’ te gebruiken, om een URL op te geven van een attribuutveld vanuit een tabel of met behulp
van een reguliere expressie.

• In Bron kunt u in het tekstvak tekst invoeren met enkele HTML-tags of een volledige HTML-pagina opgeven.
• De knop Een expressie invoeren of bewerken… kan worden gebruikt om een expressie zoals
[%Year($now)%] toe te voegen aan het tekstvak Bron om het huidige jaar weer te geven. Deze
knop wordt alleen geactiveerd als de keuzeknop Bron is geselecteerd. Klik, na het invoeren van de expressie,
ergens in het tekstvak vóór het HTML-frame te vernieuwen, anders zal de expressie verloren gaan.

• Activeer Evalueren van QGIS-expressies in HTML-bron om het resultaat te zien van de expressie die u heeft
opgenomen, anders zult u in plaats daarvan de expressie zien.

• Gebruik de knop Bĳwerken HTML om de HTML-frame(s) te vernieuwen en het resultaat van wĳzigingen te
bekĳken.
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Frames

De groep Frames van het paneel Item-eigenschappen van het HTML-frame verschaft de volgende functionaliteiten
(zie Fig. 21.57):

Fig. 21.57: HTML-frame, eigenschappen van Frames

• Met Modus Formaat wĳzigen kunt u selecteren hoe de HTML-inhoud moet worden gerenderd:
– Bestaande frames gebruiken geeft het resultaat alleen weer in het eerste frame en toegevoegde
frames.

– Verleng tot aan de volgende pagina zal net zoveel frames (en corresponderende pagina’s)
maken als nodig is om de hoogte van de webpagina te renderen. Elk frame kan over de lay-out worden
verplaatst. Als u de grootte van een frame aanpast, zal de webpagina worden opgedeeld tussen de andere
frames. Het laatste frame zal worden verkleind om de webpagina te laten passen.

– Herhaal op elke pagina zal de linker bovenkant van de webpagina herhalen op elke pagina, in
frames van dezelfde grootte.

– Herhalen tot voltooid zal net zoveel pagina’s maken als de optie Verlengen met de
volgende pagina, met het verschil dat alle frames dezelfde grootte hebben.

• Gebruik de knop Frame toevoegen om een ander frame met dezelfde grootte als het geselecteerde frame toe
te voegen. Als de HTML-pagina niet past binnen het eerste frame zal het worden voortgezet in het volgende
frame wanneer u Modus Formaat wĳzigen of Bestaande frames gebruiken gebruikt.

• Activeren van Pagina niet exporteren als frame leeg is voorkomt dat de kaartlay-out wordt geëxporteerd
als het frame geen HTML-inhoud heeft. Dit betekent dat alle andere items van afdruklay-out, kaarten,
schaalbalken, legenda’s etc. niet zichtbaar zullen zĳn in het resultaat.

• Activeren van Geen achtergrond tekenen als frame leeg is voorkomt dat het HTML-frame wordt getekend
als het frame geen inhoud heeft.

Slimme pagina-overgangen en Stijlbestand van gebruiker gebruiken

De dialoogvensters Slimme pagina-overgangen gebruiken en Stĳlbestand van gebruiker van het paneel Item-
eigenschappen van het HTML-frame verschaft de volgende functionaliteiten (zie Fig. 21.58):

Fig. 21.58: HTML-frame, eigenschappen Slimme pagina-overgangen gebruiken en Stijlbestand van gebruiker

21.2. Lay-out items 785



QGIS Desktop 3.28 User Guide

• Activeer Slimme pagina-overgangen gebruiken om te voorkomen dat de inhoud van het HTML-frame
halverwege een regel tekst wordt afgebroken zodat die netjes en gladjes doorloopt in het volgende frame.

• Stel de toegestane Maximum afstand in bĳ het berekenen van de plaats waar pagina-overgangen in de HTML
moeten komen. Deze afstand is de toegestane maximale hoeveelheid lege ruimte aan de onderzĳde van een
frame na het berekenen van de optimale locatie voor afbreken. Instellen van een lagere waarde zal resulteren in
een betere keuze voor de locatie van het afbreken van de pagina, maar meer verloren ruimte aan de onderzĳde
van de frames. Dit wordt alleen gebruikt als Slimme pagina-overgangen gebruiken is geactiveerd.

• Activeer Stĳlbestand van gebruiker om HTML-stĳlen toe te passen die vaak worden verschaft in Cascading
Style Sheets. Een voorbeeld van code voor stĳl wordt hieronder verschaft om de kleur van de tag voor de kop
<h1> in te stellen op groen en het lettertype en de grootte van tekst in alinea-tags <p>.

h1 {color: #00ff00;
}
p {font-family: "Times New Roman", Times, serif;

font-size: 20px;
}

• Gebruik de knop Bĳwerken HTML om het resultaat van de instellingen voor het stĳlbestand te bekĳken.

21.2.10 De items Vorm

QGIS verschaft een aantal gereedschappen om regelmatige of meer complexe vormen te tekenen in de afdruklay-out.

Notitie: Anders dan voor andere items kunt u niet het frame of de achtergrondkleur van het begrenzingsvak van de
vorm opmaken (standaard ingesteld op transparant).

Het item regelmatige vorm

Het item Vorm is een gereedschap dat helpt om uw kaart te decoreren met regelmatige vormen zoals driehoek,
rechthoek, ellips… U kunt een regelmatige vorm toevoegen met het gereedschap Vorm toevoegen dat u toegang geeft
tot de bĳzondere gereedschappen zoals Rechthoek toevoegen, Ellips toevoegen en Driehoek toevoegen. Als u eenmaal
het toepasselĳke gereedschap hebt geselecteerd, kunt u het item tekenen door de instructies voor het maken van items
te volgen. net als andere items voor lay-out kunnen regelmatige vormen op dezelfde manier worden bewerkt als is
weergegeven inWerken met items voor lay-out.

Notitie: Wanneer u ook de toets Shift ingedrukt houdt bĳ het tekenen van de basisvorm met de methode Klikken
en neerzetten, kunt u een perfect vierkant, perfecte cirkel of perfecte driehoek maken.

Het item Vorm kan worden aangepast met zĳn paneel Item-eigenschappen. Naast de algemene eigenschappen voor
items, heeft dit object de volgende functionaliteiten (zie Fig. 21.59):
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Fig. 21.59: Paneel Vorm Item-eigenschappen

De groep Algemene eigenschappen geeft het weer en stelt u in staat te schakelen tussen het type van het item Vorm
(Ellips, Rechthoek of Driehoek) binnen het opgegeven frame.
U kunt de stĳl van de vorm instellen met het geavanceerde symbool en het keuzewidget Kleur…
Voor de vorm Rechthoek kunt u de waarde van Radius hoek in verschillende eenheden instellen om afgeronde hoeken
te maken.

De op knopen gebaseerde vormen

Waar het gereedschap Vorm toevoegen een manier verschaft om een eenvoudig en vooraf gedefinieerd
geometrisch item te maken, helpt het gereedschap Item Knoop toevoegen u een aangepast een meer geavanceerd
geometrisch item te maken. Voor polylĳnen of polygonen kunt u net zoveel lĳnen of zĳkanten tekenen als u wilt en
knopen van de items kunnen onafhankelĳk en direct worden bewerkt met het gereedschap Item Knopen bewerken.
Het item zelf kan worden bewerkt zoals is weergegeven inWerken met items voor lay-out.
Een op knopen gebaseerde vorm toevoegen:

1. Klik op het pictogram Item Knoop toevoegen

2. Selecteer ofwel het gereedschap Polygoon toevoegen of Polylĳn toevoegen

3. Klik daarna doorlopend met links om knopen aan uw huidige vorm toe te voegen. Als u de toets Shift
ingedrukt houd tĳdens het tekenen van een segment, wordt dat beperkt om een richting te volgen van een
veelvoud van 45°.

4. Klik, als u gereed bent, met rechts om de vorm te voltooien.
U kunt het uiterlĳk van de vorm aanpassen in het paneel Item-eigenschappen.
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Fig. 21.60: Vorm paneel Polygoon Item-eigenschappen

In de groep Algemene eigenschappen, kunt u de stĳl van de vorm instellen met het geavanceerde symbool en
keuzewidget Kleur…
Voor items Polylĳn kunt u ook parameters opgeven voor de Lĳnmarkeringen d.i. toevoegen:

• begin- en/of eindmarkeringen met opties:
– Geen: tekent een eenvoudige polylĳn.
– Pĳl: voegt een normale driehoekige pĳlpunt toe die u kunt aanpassen.
– SVG markering: gebruikt een bestand SVG als pĳlpunt voor het item.

• aanpassen van de pĳlpunt:
– Lĳnkleur pĳl: stelt de lĳnkleur van de pĳlpunt in.
– Kleur vulling pĳl: stelt de vulkleur van de pĳlpunt in.
– Lĳndikte pĳl: stelt de lĳndikte van de pĳlpunt in.
– Pĳlpunt-breedte: stelt de grootte van de pĳlpunt in.

SVG-afbeeldingen worden automatisch gedraaid met de lĳn. Kleuren voor lĳn en vulling van vooraf gedefinieerde
SVG-afbeeldingen van QGIS kunnen worden gewĳzigd met de overeenkomstige opties. Aangepaste SVG-
afbeeldingen zouden enkele tags kunnen vereisen conform deze instructie.
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Fig. 21.61: Vorm paneel Polylijn Item-eigenschappen

Het item Pijl

Het gereedschap Pĳl toevoegen is een sneltoets om standaard een polylĳn met pĳluiteinden te maken en dus heeft
het dezelfde eigenschappen en gedrag als een item knoop voor polylĳn.
Het item Pĳl kan in feite worden gebruikt om een eenvoudige pĳl toe te voegen, die bĳvoorbeeld kan worden gebruikt
om de relatie aan te duiden tussen twee andere items van lay-out. Voor het maken van een noordpĳl zou echter eerst
het image item moeten worden overwogen, omdat dat toegang geeft tot een set noordpĳlen in de indeling .SVG, die
u kunt synchroniseren met een kaartitem, zodat dat automatisch meedraait.
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Een geometrie van een item Knoop bewerken

Een specifiek gereedschap wordt verschaft om op knopen gebaseerde vormen te kunnen bewerken met
Item Knopen bewerken. In deze modus kunt u een knoop selecteren door erop te klikken (een markering wordt op de
geselecteerde knoop weergegeven). Een geselecteerde knoop kan worden verplaatst, ofwel door hem te slepen of door
de pĳltoetsen te gebruiken.Meer nog, in dezemodus, kunt u knopen toevoegen aan een bestaande vorm: dubbelklik op
een segment en een knoop wordt toegevoegd op de plaats waar u klikte. Tenslotte kunt u de momenteel geselecteerde
knoop verwĳderen door op de toets Del te drukken.

21.3 Een uitvoer maken

Fig. 21.62 geeft een voorbeeld weer van een afdruklay-out, inclusief alle typen lay-outitems beschreven in het vorige
gedeelte.

Fig. 21.62: Afdruklay-out met toegevoegde kaartweergave, legenda, afbeelding, schaalbalk, coördinaten, tekst en
HTML-frame

Vanuit het menu Lay-out of de werkbalk kunt u de afdruklay-out uitvoeren naar verschillende bestandsindelingen, en
is het mogelĳk om de resolutie (afdrukkwaliteit) en papiergrootte aan te passen:

• Het pictogram Lay-out afdrukken stelt u in staat de lay-out af te drukken naar een verbonden printer of een
bestand voor PostScript, afhankelĳk van de geïnstalleerde stuurprogramma’s voor de printer.

• Het pictogram Als afbeelding exporteren exporteert de afdruklay-out naar indelingen voor afbeeldingen, zoals
PNG, BMP, TIF, JPG, en nog veel meer…

• Het pictogram Als SVG exporteren slaat het kaartvenster van afdruklay-out op als een SVG (Scalable Vector
Graphic).

• Het pictogram Als PDF exporteren slaat de gedefinieerde afdruklay-out direct op als een bestand PDF (Portable
Document Format).

790 Hoofdstuk 21. De kaarten opmaken



QGIS Desktop 3.28 User Guide

21.3.1 Instellingen voor exporteren

Iedere keer wanneer u een afdruklay-out exporteert, is er een selectie van instellingen voor de export die QGIS moet
controleren om de meest toepasselĳke uitvoer te geven. Deze configuraties zĳn:

• De Instellingen voor exporteren van het paneel Lay-out, zoals Export resolutie, Als raster afdrukken Altĳd als
vectoren exporteren ofWorld file opslaan

• Pagina uitsluiten voor exporteren in het paneel Pagina-eigenschappen
• Item uitsluiten voor exporteren in het paneel Item-eigenschappen

Meer nog, een aantal vooraf gedefinieerde controles worden automatisch toegepast op de lay-out.Momenteel bevatten
deze controles testen of de schaalbalk correct is gekoppeld aan kaartitems, en of overzichtsitems van de kaart ook
correct zĳn gekoppeld aan een kaart. Als de controles mislukken wordt u een nette waarschuwing getoond die u in
kennis stelt van het probleem.

21.3.2 Als afbeelding exporteren

Een lay-out als een afbeelding exporteren:

1. Klik op het pictogram Als afbeelding exporteren

2. Selecteer de indeling voor de afbeelding, de map en bestandsnaam (bĳv. myill.png) om te gebruiken. Als
de lay-out meer dan één pagina bevat, zal elke pagina worden geëxporteerd naar een bestand met de opgegeven
bestandsnaam en daaraan toegevoegd het paginanummer (bĳv. myill_2.png).

3. In het volgende dialoogvenster (Opties voor exporteren afbeelding):
• U kunt de Export resolutie van de afdruklay-out en de dimensies voor de geëxporteerde pagina (zoals
ingesteld in het paneel Lay-out) overschrĳven.

• Renderen van de afbeelding kan ook worden verbeterd met de optie Antialiasing inschakelen.
• Als u uw lay-out wilt exporteren als een afbeeldingmet geoverwĳzingen (bĳv. ommet andere projecten
te delen), selecteer dan de optie World file aanmaken, en een ESRI World Filemet dezelfde naam als
de geëxporteerde afbeelding, maar een andere extensie (.tfw voor TIFF, .pnw voor PNG, jgw voor
JPEG, …), zal bĳ het exporteren worden gemaakt. Deze optie kan ook standaard worden geselecteerd in
het paneel Lay-out.

Notitie: Voor uitvoer met meerdere pagina’s zal alleen de pagina, die de verwĳzingskaart bevat, een
world file krĳgen (er van uitgaande dat de optieWorld file aanmaken is geselecteerd).

• Door het selecteren van de optie Bĳsnĳden naar inhoud zullen de door de afdruklay-out uitgevoerde
afbeeldingen het minimale gebied bevatten dat alle items omsluit (kaart, legenda, schaalbalk, vormen,
label, afbeelding…) van elke pagina van de lay-out.
– Als de lay-out één enkele pagina omvat, dan zal de grootte van de uitvoer worden aangepast voor
ALLES op de lay-out. De pagina kan dan worden verkleind of vergroot tot alle items, afhankelĳk
van hun positie (op, boven, onder, links of rechts van de pagina).

– In het geval van een lay-out met meerdere pagina’s zal de grootte van elke pagina worden aangepast
zodat de items in het gebied ervan (linker- en rechterkant voor alle pagina’s, plus bovenkant voor
de eerste pagina en onderkant voor de laatste pagina). Elke in grootte aangepaste pagina wordt
geëxporteerd als een afzonderlĳk bestand.

Het dialoogvenster Bĳsnĳden naar inhoud stelt u ook in staat marges rond de bĳgesneden grenzen toe te
voegen.

21.3. Een uitvoer maken 791



QGIS Desktop 3.28 User Guide

Fig. 21.63: Opties voor exporteren afbeeldingen, uitvoer is op grootte van de inhoud van de items gebracht

Tip: Gebruik indelingen voor afbeeldingen die transparantie ondersteunen als items zich uitstrekken tot
buiten de inhoud van het papier
Items voor lay-out zouden buiten het bereik van het papier kunnen worden geplaatst. Bĳ het exporteren met de
optie Bĳsnĳden naar inhoud zou de resulterende afbeelding zich daarom kunnen uitstrekken tot buiten het bereik
van het papier. Omdat de achtergrond buiten het bereik van het papier transparant zal zĳn, zal voor indelingen voor
afbeeldingen die transparantie niet ondersteunen (bĳv. BMP en JPG) de transparante achtergrond worden gerenderd
als volledig zwart, wat de afbeelding “corrumpeert”. Gebruik in dergelĳke gevallen transparantie-compatibele
indelingen (bĳv. TIFF en PNG).

Notitie: Indien ondersteund door de indeling (bĳv. PNG) en de onderliggende bibliotheek van Qt, zou de
geëxporteerde afbeelding metadata van het project (auteur, titel, datum, beschrĳving…) kunnen bevatten.

21.3.3 Exporteren naar SVG

Een lay-out als SVG exporteren:

1. Klik op het pictogram Als SVG exporteren

2. Vul het pad en de bestandsnaam in (gebruikt als basis voor alle bestanden in geval van een compositie met
meerdere pagina’s, net als bĳ exporteren naar afbeelding)

3. In het volgende dialoogvenster SVG export opties kunt u de standaard instellingen voor exporteren voor de lay-out
overschrĳven of nieuwe configureren:

• Lagen als groepen SVG exporteren: geëxporteerde items worden gegroepeerd in lagen, waarvan de
namen overeenkomen met de laagnamen van QGIS, wat het veel gemakkelĳker maakt de inhoud van het
document te begrĳpen.

• Altĳd als vectoren exporteren: sommige opties voor renderen vereisen dat items worden gerasteriseerd
voor beter renderen. Selecteer deze optie om de objecten te behouden als vectoren met het risico dat het
uiterlĳk van het uitvoerbestand niet overeen zou hoeven te komen met het voorbeeld van de afdruklay-out
(voor meer details, bekĳk Instellingen voor exporteren).
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• RDF-metadata exporteren van het document, zoals de titel, auteur, datum, beschrĳving…

• Geometrieën vereenvoudigen om de bestandsgrootte te verkleinen: dit vermĳdt het exporteren van
ALLE punten van geometrieën, wat zou kunnen resulteren in een waanzinnig complex en groot
exportbestand, dat niet in andere toepassingen geladen zou kunnen worden. Geometrieën zullen worden
vereenvoudigd bĳ het exporteren van de lay-out door punten te verwĳderen die niet opmerkelĳk
verschillen in de resolutie voor exporteren (bĳv. als de resolutie voor exporteren 300 dpi is, zullen
punten die minder dan 1/600 inch apart liggen worden verwĳderd).

• Tekst exporteren instellen: beheert of tekstlabels worden geëxporteerd als echte tekstobjecten (Tekst
altĳd als tekstobjecten exporteren) of alleen als paden (Tekst altĳd als paden exporteren). Als zĳ worden
geëxporteerd als tekstobjecten, dan kunnen zĳworden bewerkt in externe toepassingen (bĳv. Inkscape) als
normale tekst. MAAR het bĳeffect is dat de kwaliteit van het renderen verminderd, EN er zĳn problemen
met renderen als er bepaalde instellingen voor de tekst, zoals buffers, van kracht zĳn. Dat is de reden
waarom exporteren als paden wordt aanbevolen.

• Toepassen van de optie Bĳsnĳden naar inhoud

• Uitschakelen getegelde rasterlagen export: Bĳ het exporteren van bestanden gebruikt QGIS een
ingebouwde rendering voor tegels van rasterlagen die geheugen bespaart. Soms zorgt dit voor zichtbare
“naden” in de rasters voor gemaakte bestanden. Selecteren van deze optie zal dat oplossen, ten koste van
een hoger gebruik van geheugen tĳdens het exporteren.

Fig. 21.64: SVG export opties

Notitie: Momenteel is de uitvoer naar SVG heel basaal. Dit is geen probleem van QGIS, maar een probleem met de
onderliggende bibliotheek van Qt. Hopelĳk zal dit in toekomstige versies zĳn opgelost.
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21.3.4 Als PDF exporteren

Een lay-out als PDF exporteren:

1. Klik op het pictogram Als PDF exporteren

2. Vul het pad en de bestandsnaam in: anders dan voor exporteren als afbeelding en SVG, worden alle pagina’s
in de lay-out geëxporteerd naar één enkel PDF-bestand.

3. In het volgende dialoogvensterOpties voor exporteren naar PDF kunt u de standaard instellingen voor exporteren
voor de lay-out overschrĳven of nieuwe configureren:

• Altĳd als vectoren exporteren: sommige opties voor renderen vereisen dat items worden gerasteriseerd
voor beter renderen. Selecteer deze optie om de objecten te behouden als vectoren met het risico dat het
uiterlĳk van het uitvoerbestand niet overeen zou hoeven te komen met het voorbeeld van de afdruklay-out
(voor meer details, bekĳk Instellingen voor exporteren).

• Informatie geoverwĳzing toepassen: alleen beschikbaar als de verwĳzingskaart, waaruit de informatie
wordt opgehaald, op de eerste pagina staat.

• RDF-metadata exporteren van het document, zoals de titel, auteur, datum, beschrĳving…
• Tekst exporteren instellen: beheert of tekstlabels worden geëxporteerd als echte tekstobjecten (Tekst

altĳd als tekstobjecten exporteren) of alleen als paden (Tekst altĳd als paden exporteren). Als zĳ worden
geëxporteerd als tekstobjecten, dan kunnen zĳworden bewerkt in externe toepassingen (bĳv. Inkscape) als
normale tekst. MAAR het bĳeffect is dat de kwaliteit van het renderen verminderd, EN er zĳn problemen
met renderen als er bepaalde instellingen voor de tekst, zoals buffers, van kracht zĳn. Dat is de reden
waarom exporteren als paden wordt aanbevolen.

• Beheer de PDF Afbeeldingscompressie met:
– Met verlies (JPEG), wat de standaardmodus voor compressie is
– of Zonder verlies, wat in de meeste gevallen grotere bestanden maakt, maar veel meer geschikt is
voor afgedrukte uitvoer of voor post-productie in externe programma’s (vereist Qt 5.13 of later).

• Georuimtelĳke PDF maken (GeoPDF): Maakt een PDF-bestand met geoverwĳzingen.

• Uitschakelen getegelde rasterlagen export: Bĳ het exporteren van bestanden gebruikt QGIS een op
tegels gebaseerd renderen van rasterlagen die geheugen bespaart. Soms zorgt dit voor zichtbare “naden”
in de rasters voor gemaakte bestanden. Selecteren van die optie zal dat oplossen, ten koste van een hoger
gebruik van geheugen tĳdens het exporteren.

• Geometrieën vereenvoudigen om de bestandsgrootte te verkleinen: Geometrieën zullen worden
vereenvoudigd bĳ het exporteren van de lay-out door punten te verwĳderen die niet opmerkelĳk
verschillen in de resolutie voor exporteren (bĳv. als de resolutie voor exporteren 300 dpi is, zullen
punten dieminder dan1/600 inch apart liggen worden verwĳderd). Dit kan de grootte en complexiteit
van het exportbestand verkleinen (hele grote bestanden zouden kunnen weigeren te laden in andere
toepassingen).
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Fig. 21.65: Opties voor exporteren naar PDF

Notitie: Exporteren van GeoPDF wordt ondersteund en een aantal GeoPDF-specifieke opties zĳn beschikbaar:
• Indeling (indeling GeoPDF - er zĳn enkele varianties van GeoPDF),
• Meerdere kaartthema’s opnemen (specificeer de op te nemen kaartthema’s),
• Informatie over vectorobject opnemen (kies de lagen en groepeer ze in logische PDF-groepen).

Notitie: Exporteren van een afdruklay-out naar indelingen die geoverwĳzingen ondersteunen (bĳv. PDF en TIFF)
maken standaard een uitvoer met geoverwĳzingen.

21.3.5 Een atlas genereren

Functies voor atlas stellen u in staat kaartboeken te maken op een geautomatiseerde manier. Atlas gebruikt de objecten
van een tabel of vectorlaag (Bedekkingslaag) om een uitvoer voor elk object te maken (atlas-object) in de tabel / laag.
Het meest voorkomend gebruik is om een kaartitem te zoomen naar het huidige object voor atlas. Andere gevallen
voor gebruik omvatten:

• een kaartitem dat, voor een andere laag, alleen objecten laat zien die hetzelfde attribuut delen als het object
voor atlas of binnen de geometrie ervan liggen.

• een label of item HTML waarvan de tekst wordt vervangen als over objecten wordt gegaan
• een tabelitem dat attributen weergeeft van geassocieerde objecten ouder of kind van het huidige object voor
atlas…

Voor elk object wordt de uitvoer verwerkt voor alle pagina’s en de items ervan, overeenkomstig hun instellingen voor
exporteren.

Tip: Variabelen gebruiken voor meer flexibiliteit
QGIS verschaft een groot paneel met functies en variabelen, inclusief aan atlas gerelateerde, die u kunt gebruiken
om de items voor lay-out te bewerken, maar ook de symbologie van de lagen, overeenkomstig de status van atlas.
Combineren van deze objecten geeft u veel flexibiliteit en helpt u gemakkelĳk geavanceerde kaarten te maken.

21.3. Een uitvoer maken 795



QGIS Desktop 3.28 User Guide

Bekĳk het paneel Atlas om het maken van een atlas in te schakelen en toegang te krĳgen tot parameters voor de atlas.
Dit paneel bevat het volgende (zie Fig. 21.66):

Fig. 21.66: Paneel Atlas

• Genereer een atlas schakelt het maken van een atlas in of uit.
• Configuratie

– Een combinatievak Bedekkingslaag dat u in staat stelt de tabel of vectorlaag te kiezen die de
objecten bevat waar doorheen gelopen moet worden.

– Een optionele Verborgen bedekkingslaag die, indien geselecteerd, de bedekkingslaag zal verbergen
(maar niet de andere lagen) gedurende het maken.

– Een optioneel combinatievak Paginanaam om de naam voor de objectpagina(‘s) te specificeren. U kunt
een veld van de bedekkingslaag selecteren of een expressie instellen. Als deze optie leeg is, zal QGIS een
intern ID gebruiken, overeenkomstig het filter en/of de op de laag toegepaste sorteervolgorde.

– Een optioneel tekstvak Filter met dat u in staat stelt een expressie in te stellen voor het filteren van
objecten van de bedekkingslaag. Als de expressie niet leeg is, zullen alleen objecten, die evalueren naar
True, worden verwerkt.

– Een optioneel Sorteren op dat u in staat stelt objecten van de bedekkingslaag (en de uitvoer) te
sorteren, door een veld van de bedekkingslaag of een expressie te gebruiken. De volgorde van sorteren
(ofwel oplopend of aflopend) wordt ingesteld door de knop met twee statussen Sorteerrichting, die een
pĳl omhoog of omlaag weergeeft.

• Uitvoer - dit is waar de uitvoer van de atlas kan worden geconfigureerd:
– Een tekstvak Expressie Uitvoer bestandsnaam dat wordt gebruikt om een bestandsnaam te maken voor
elk object atlas. Het is gebaseerd op expressies. Is alleen van betekenis voor het renderen van meerdere
bestanden.

– Een Exporteren naar enkel bestand indien mogelĳk dat u in staat stelt het maken van één enkel bestand
te forceren, als dat mogelĳk is met de gekozen indeling voor de uitvoer (bĳvoorbeeld PDF). Als dit veld
is geselecteerd, is de waarde van het veld Expressie Uitvoer bestandsnaam zonder betekenis.

– Een keuzelĳst Indeling voor exporteren afbeelding om de indeling voor de uitvoer te selecteren bĳ het
gebruiken van de knop Atlas als afbeeldingen exporteren….
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Kaart beheren door atlas

Het meest voorkomende gebruik van atlas is met het kaartitem, zoomend naar het huidige object van atlas, omdat
het doorlopen over de bedekkingslaag gaat. Dit gedrag wordt ingesteld in de groep eigenschappen van het kaartitem
Beheerd door atlas. Bekĳk Beheerd door atlas voor verschillende instellingen die u op het kaartitem kunt toepassen.

Labels aanpassen met een expressie

Aanpassen van labels naar het object waar de atlas overheen loopt, is mogelĳk door expressies op te nemen. Zorg er
voor dat u het gedeelte van de expressie (inclusief functies, velden of variabelen) plaatst tussen [% en %] (bekĳk Het
item Label voor meer details).
Bĳvoorbeeld voor een stadslaag met velden CITY_NAME en ZIPCODE, zou u dit kunnen invoegen:

The area of [% concat( upper(CITY_NAME), ',', ZIPCODE, ' is ',
format_number($area/1000000, 2) ) %] km2

of, een andere combinatie:

The area of [% upper(CITY_NAME)%],[%ZIPCODE%] is
[%format_number($area/1000000,2) %] km2

De informatie [% concat( upper(CITY_NAME), ',', ZIPCODE, ' is ',
format_number($area/1000000, 2) ) %] is een expressie die in het label wordt gebruikt. Beide
expressies zouden resulteren in het volgende type label in de gemaakte atlas:

The area of PARIS,75001 is 1.94 km2

Knoppen Data-bepaalde ‘override’ verkennen met atlas

Er zĳn verscheidene plaatsen waar u een knop Data-bepaalde ‘override’ kunt gebruiken om de geselecteerde instelling
te overschrĳven. Dit is in het bĳzonder nuttig bĳ het maken van atlas. Bekĳk Data-bepaalde ‘override’ instellen voor
meer details over dit widget.
Voor de volgende voorbeelden wordt de laag Regions van de voorbeeld gegevensset van QGIS gebruikt en
geselecteerd als Bedekkingslaag voor het maken van een atlas. We gaan er van uit dat het een lay-out met één enkele
pagina is, die een kaartitem en een item Label bevat.
Als de hoogte (noord-zuid) van het bereik van een region groter is dan zĳn breedte (oost-west), zou u de richting
Portret moeten gebruiken in plaats van Landschap om het gebruik van het papier te optimaliseren. Met een knop
Data-bepaalde ‘override’ kunt u de richting van het papier dynamisch instellen.
Klik met rechts op de pagina en selecteer Pagina-eigenschappen om het paneel te openen. We willen de oriëntatie
dynamisch instellen, met behulp van een expressie die afhankelĳk is van de geometrie van de region, dus druk op de
knop van het veld Oriëntatie, selecteer Bewerken… om het dialoogvenster Expressie-string bouwer te openen en
voer de volgende expressie in:

CASE WHEN bounds_width(@atlas_geometry) > bounds_height(@atlas_geometry)
THEN 'Landscape' ELSE 'Portrait' END

Als u nu het voorbeeld van de atlas bekĳkt, oriënteert het papier zichzelf automatisch, maar plaatsing van de items zou
niet ideaal kunnen zĳn. Voor elke Region dient u ook de locatie van de items voor de lay-out opnieuw te positioneren.
Voor het kaartitem kunt u de knop gebruiken van zĳn eigenschap Breedte, om die dynamisch in te stellen met de
volgende expressie:

@layout_pagewidth - 20
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Gebruik op dezelfde wĳze de knop van de eigenschapHoogte om de volgende expressie op te geven om de grootte
van het kaartitem te beperken:

@layout_pageheight - 20

Stel het Referentiepunt in op de radioknop linksboven en voer 10 in voor de posities X en Y, om er voor te zorgen dat
het kaartitem blĳft gecentreerd op de pagina.
Latenwe een titel boven de kaart toevoegen in hetmidden van de pagina. Selecteer het itemLabel en stel de horizontale
uitlĳning in op Centreren. Verplaats vervolgens het label naar de juiste positie, kies de middelste knop als het
Referentiepunt, en geef de volgende expressie op voor het veld X:

@layout_pagewidth / 2

Voor alle andere items voor de lay-out kunt u op een soortgelĳke manier de positie instellen, zodat zĳ correct zĳn
gepositioneerd voor zowel Portret als Landschap. U kunt nog meer aanpassingen uitvoeren, zoals het aanpassen van
de titel met attributen van het object (zie bĳvoorbeeld Labels aanpassen met een expressie), afbeeldingen wĳzigen, op
grootte brengen van het aantal kolommen voor de legenda overeenkomstig de oriëntatie van de pagina, …
De hier verschafte informatie is een bĳgewerkte versie van het excellente blog (in het Engels en Portugees) over de
opties Data-bepaalde ‘override’ Multiple_format_map_series_using_QGIS_2.6 .
Een ander voorbeeld van het gebruiken van de knoppen voor Data-bepaalde override is het gebruiken van een
dynamische afbeelding. Voor de volgende voorbeelden gebruiken we een laag van Geopackage die een veld BLOB
bevat, genaamd logomet het veldtype binary (zie Een nieuwe laag voor GeoPackage maken). Voor elk object is een
andere afbeelding gedefinieerd, zodat de atlas daar doorheen kan gaan zoals beschreven in Voorbeeld en maken van
een atlas. Alles wat u hoeft te doen is een afbeelding toe te voegen in de afdruklay-out en naar de Item-eigenschappen
daarvan te gaan in de context van de atlas. Daar vindt u een knop Data-bepaalde override in het gedeelte Bron
afbeelding van de Algemene instellingen.

Kies, in het volgende venster, Bewerken zodat de Expressie string-bouwer opent. In het gedeelte Velden en waarden
vindt u het veld BLOB dat werd gedefinieerd in de laag van Geopackage. Dubbelklik op de veldnaam logo en klik
op OK.
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De atlas gaat door de items in het veld BLOB, vooropgesteld dat u de laag van Geopackage koos als Bedekkingslaag
(meer instructies zĳn te vinden in Voorbeeld en maken van een atlas).
Dit zĳn slechts twee voorbeelden van hoe u enkele gevorderde instellingen kunt gebruiken met atlas.

Voorbeeld en maken van een atlas

Fig. 21.67: Werkbalk Voorbeeld atlas

Als de instellingen voor de atlas eenmaal zĳn geconfigureerd, en items voor de lay-out (kaart, tabel, afbeelding…) er
aan zĳn gekoppeld, kunt u een voorbeeld van alle pagina’s maken door te kiezen Atlas ► Voorbeeld Atlas of door te
klikken op het pictogram Voorbeeld Atlas. U kunt dan de pĳlen gebruiken om door alle objecten te navigeren:

• Eerste object

• Vorige object

• Volgende object

• Laatste object

Ukunt ook het combinatievak gebruiken om een specifiek object te selecteren en te bekĳken. Het combinatievak geeft
namen voor de objecten van atlas weer, overeenkomstig de ingestelde expressie in de optie voor atlas Paginanaam.
Net als eenvoudige composities, kan een atlas worden gemaakt op verschillende manieren (zie Een uitvoer maken
voor meer informatie - door eenvoudigweg gereedschappen te gebruiken uit het menu Atlas of werkbalk, in plaats
van het menu Lay-out.
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Dit betekent dat u uw lay-outs direct kunt afdrukken met Atlas ► Afdrukken Atlas. U kunt ook een PDF maken met
Atlas ► Atlas als PDF exporteren: U zult worden gevraagd naar een map om alle gegenereerde PDF-bestanden op
te slaan (behalve als Exporteren naar enkel bestand indien mogelĳk is geselecteerd). In dat geval zal u worden
gevraagd een bestandsnaam in te voeren.
Met de gereedschappen Atlas► Atlas als afbeeldingen exporteren… of Atlas► Atlas als SVG exporteren…, zult u ook
worden gevraagd een map te selecteren. Elke pagina van elk object van de compositie van atlas wordt geëxporteerd
naar de indeling voor het afbeeldingsbestand zoals ingesteld in het paneel Atlas of naar SVG.

Notitie: Met een uitvoer met meerdere pagina’s gedraagt een atlas zich als een lay-out, met dien verstande dat alleen
de pagina die de Algemene instellingen bevat, een world file zal krĳgen (voor elk uitgevoerd object).

Tip: Een specifiek object van atlas afdrukken
Als u slechts één object van de lay-out van de atlas wilt afdrukken of exporteren, start dan het voorbeeld, selecteer
het gewenste object in de keuzelĳst en klik op Lay-out ► Afdrukken (of Exporteren… naar enige ondersteunde
bestandsindeling).

Projectgedefinieerde relaties gebruiken voor maken van Atlas

Voor gebruikers met kennis van HTML en Javascript is het mogelĳk te werken op objecten van GeoJSON en
projectgedefinieerde relaties uit het project van QGIS te gebruiken. Het verschil tussen deze benadering, en het
gebruiken van direct in HTML ingevoerde expressies is, dat het u een volledig ongestructureerd object GeoJSON
geeft om mee te werken. Dit betekent dat u bestaande bibliotheken en functies voor Javascript kunt gebruiken die
werken op weergaven van objecten voor GeoJSON.
De volgende code bevat alle gerelateerde kindobjecten uit de gedefinieerde relatie. Met de functie van JavaScript
setFeature stelt het u in staat flexibele HTML te maken die relaties weergeeft in elke indeling die u wilt
(lĳsten, tabellen, etc). In het codevoorbeeld maken we een dynamische lĳst met opsommingen van de gerelateerde
kindobjecten.

// Declare the two HTML div elements we will use for the parent feature id
// and information about the children
<div id="parent"></div>
<div id="my_children"></div>

<script type="text/javascript">
function setFeature(feature)
{

// Show the parent feature's identifier (using its "ID" field)
document.getElementById('parent').innerHTML = feature.properties.ID;
//clear the existing relation contents
document.getElementById('my_children').innerHTML = '';
feature.properties.my_relation.forEach(function(child_feature) {
// for each related child feature, create a list element
// with the feature's name (using its "NAME" field)
var node = document.createElement("li");
node.appendChild(document.createTextNode(child_feature.NAME));
document.getElementById('my_children').appendChild(node);

});
}

</script>

Gedurende het maken van de atlas wordt er een doorloop uitgevoerd over de bedekkingslaag die de ouder-objecten
bevat. Op elke pagina zult u een lĳst met opsommingstekens zien van de gerelateerde kind-objecten die de identificatie
van de ouder volgen.
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21.4 Een rapport maken

Dit gedeelte helpt u een rapport in te stellen in QGIS.

21.4.1 Wat is het?

Per definitie is een GIS-rapport een document dat informatie bevat die is georganiseerd op een vertellende manier
en kaarten, tekst afbeeldingen, tabellen etc. bevat. Een rapport kan worden voorbereid op ad hoc basis, periodiek,
terugkerend, regelmatig, of indien vereist. Rapporten kunnen verwĳzen naar specifieke perioden, gebeurtenissen,
incidenten, onderwerpen of locaties.
In QGIS is een Rapport een uitbreiding van een Lay-out.
Rapporten stellen gebruikers in staat hun projecten voor GIS uit te voeren op een eenvoudige, snelle en gestructureerde
manier.
Een rapport kan worden gemaakt met Project ► Nieuw rapport of in Project ► Lay-out beheren.

Notitie: De kaarten in rapporten van QGIS gedragen zich op dezelfde manier als kaarten in afdruklay-outs en
atlassen. We zullen ons concentreren op de specifieken van rapporten voor QGIS. Voor details voor het afhandelen
van kaarten, bekĳk het gedeelte over afdruklay-outs en atlassen.

21.4.2 Beginnen

In het dialoogvenster Lay-out beheren kan een rapport worden gemaakt met Nieuw uit sjabloon door de keuze-optie
Leeg rapport te selecteren en te drukken op de knop Maken….
Voor dit voorbeeld gebruiken we enkele administratieve grenzen, bevolkte plaatsen, havens en vliegvelden uit de
gegevensset van Natural Earth (1:10M).
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Met de opdracht Project ► Nieuw rapport maken we een nieuw blanco rapport. Initieel is er niet veel om naar te
kĳken – het dialoogvenster dat wordt weergegeven ziet er bĳna net zo uit als de ontwerper voor afdruklay-outs, met
uitzondering van het nieuwe paneel Rapport beheren aan de linkerkant:

21.4.3 Werkruimte lay-out Rapport

Rapporten van QGIS kunnen bestaan uit meerdere, geneste gedeelten. In ons nieuwe blanco rapport hebben we
initieel alleen het hoofdgedeelte van het rapport. De enige aanwezige opties voor dit gedeelte van het rapport zĳn Kop
rapport opnemen of Voettekst rapport opnemen. Als we deze opties inschakelen, zal een kop worden opgenomen in de
allereerste pagina(‘s) (individuele gedeelten van rapporten kunnen uit meerdere pagina’s bestaan indien gewenst) in
het rapport, en de voettekst zal op de laatste pagina(‘s) staan. Schakel de kop in (Kop rapport opnemen), en druk dan
op de knop Bewerken ernaast:

802 Hoofdstuk 21. De kaarten opmaken



QGIS Desktop 3.28 User Guide

Als resultaat gebeuren er een aantal dingen. Ten eerste wordt nu een potlood voor bewerken weergegeven naast
Rapport in Rapport beheren, wat aangeeft dat dat gedeelte van het rapport momenteel wordt bewerkt in de ontwerper.
We zien ook dat een nieuwe blanco pagina wordt weergegeven in de ontwerper zelf, met de kleine titel Kop
rapport. De pagina heeft standaard de oriëntatie liggend, maar dat (en andere eigenschappen van de pagina) kunnen
worden gewĳzigd door met rechts te klikken op de pagina en Pagina-eigenschappen te kiezen. Dit zal de tab Item-
eigenschappen voor de pagina openen, en kunnen Grootte, Breedte, Hoogte, en meer worden gespecificeerd voor de
pagina.
In rapporten van QGIS is elke component van het rapport opgemaakt uit individuele lay-outs. Zĳ kunnen worden
gemaakt en aangepast met exact dezelfde gereedschappen als die, welke beschikbaar zĳn voor standaard afdruklay-
outs – dus u kunt elke gewenste combinatie van labels, afbeeldingen, kaarten, tabellen, etc. gebruiken. Laten we
enkele items toevoegen aan de kop van ons rapport om het te demonstreren:
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We zullen ook een eenvoudige voettekst voor het rapport maken, door de optieVoettekst rapport opnemen te selecteren
en te drukken op Bewerken.

Laten we, voordat we verder gaan, dit rapport exporteren en zien wat we krĳgen. Exporteren wordt gedaan vanuit
het menu Rapport – in dit geval selecteren we Rapport als PDF exporteren om het gehele rapport te renderen als een
PDF-bestand. Hier is het niet-zo-indrukwekkende resultaat – een PDF met twee pagina’s, bestaande uit onze kop- en
voettekst:
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Laten we de dingen eens wat interessanter maken. Door te drukken op de knop Gedeelte toevoegen in Rapport beheren,
krĳgen we de keuze om nieuwe gedeelten toe te voegen aan ons rapport.
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Er zĳn twee opties: Statisch lay-outgedeelte en Gedeelte Veld groeperen.
Het Statisch lay-outgedeelte toevoegen is een enkele, statische tekstlay-out. Dit kan worden gebruikt om statische lay-
outs halverwege een rapport in te bedden.
Het Gedeelte Veld groeperen herhaalt zĳn blok lay-out voor elk object in een laag. De objecten worden gesorteerd op
het geselecteerde object voor groeperen (met een optie voor oplopend/aflopend sorteren). Als een Gedeelte Veld
groeperen kind-gedeelten heeft (bĳv. een ander Gedeelte Veld groeperen met een ander veld) dan zullen alleen
objecten met een unieke waarde voor het groepsobject worden doorlopen. Dit maakt geneste rapporten mogelĳk.
Voor nu zullen we een Gedeelte Veld groeperen toevoegen aan ons rapport. Op zĳn meest basale niveau kunt u aan
een Gedeelte Veld groeperen denken als het equivalent van een afdruk als atlas: u selecteert een laag om doorheen te
lopen en het rapport zal een gedeelte invoegen voor elk gevonden object. Selecteren van het nieuwe gedeelte :Gedeelte
Veld groeperen onthult een aantal nieuwe gerelateerde instellingen:
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In dit geval hebben we Veld groeperen zo ingesteld dat we over alle staten in de laag Admin Level 1 lopen,
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gebruikmakend van de waarden uit het veld adm1name. Dezelfde opties voor kop en voettekst zĳn aanwezig, samen
met een nieuwe optie om een bloktekst voor dit gedeelte op te nemen. We zullen dat doen en de bloktekst bewerken:

Onze bloktekst bestaat nu uit een kaart en een label dat de naam van de staat weergeeft. We selecteerden, om de naam
van de staat op te nemen, Item toevoegen► Label toevoegen en data-bepaalden de tekst onderAlgemene eigenschappen
met de hulp van Een expressie invoeren of bewerken….
Het resultaat was de volgende expressie (name is de naam van het attribuut in de laag Admin Level 1 die de naam van
de staat bevat):

[% "name" %]

De kaart is ingesteld om het huidige object van het rapport te volgen (ingeschakeld door Beheerd door Rapport te
selecteren – net als een kaartitem in een atlas het huidige object van de atlas zal volgen als Beheerd door atlas is
geselecteerd):
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Als we door zouden gaan en ons rapport nu zouden exporteren, zouden we iets zoals dit krĳgen:
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Fig. 21.68: De kop van het rapport, een pagina voor elke staat, en de voettekst van het rapport.

Dus min of meer een atlas, maar met een pagina voor de kop en de voettekst.
Laten we de dingen nog wat interessanter maken door een subgedeelte aan onze groep Staat toe te voegen. We doen
dit door eerst de groep van het veld Admin Level 1 te selecteren in Rapport beheren, en dan te drukken op de knop

Gedeelte toevoegen en dan een nieuw Gedeelte Veld groeperen toe te voegen:

810 Hoofdstuk 21. De kaarten opmaken



QGIS Desktop 3.28 User Guide

Als eenGedeelte Veld groeperen door zĳn objecten gaat, zullen de objecten worden gefilterd, zodat de attributen van de
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objecten overeenkomen met die uit zĳn veld van de ouder-groep (in dit geval adm1name). Hier gaat het subgedeelte
dat we hebben toegevoegd door een laag Populated Places, inclusief een gedeelte bloktekst voor elke plaats die het
tegenkomt. De magie hier is dat de laag Populated Places een attribuut heeft met dezelfde naam als het definiërende
veld uit de ouderlaag, adm1name, dat elke plaats tagt met de staat waarin het is gelegen (als u geluk hebt zĳn uw
gegevens al op deze wĳze gestructureerd – indien niet, voer dan het algoritme voor Processing Join Attributes by
Location uit en maak uw eigen veld). Wanneer we dit rapport exporteren, zal QGIS de eerste staat uit de laag Admin
Level 1 pakken en dan doorlopen over alle Populated Places met een overeenkomende waarde voor adm1name. Dit
is wat we krĳgen:

Hier hebben we een basis bloktekst voor de groep Populated Places gemaakt, inclusief een kaart van de plaats en
een tabel van enkele attributen van de plaats. Ons rapport heeft nu dus een kop voor het rapport, een pagina voor
de eerste staat, gevolgd door een pagina voor elke bevolkte plaats in die staat, dan de rest van de staten met hun
bevolkte plaatsen, en tenslotte de voettekst voor het rapport. Als we nog een kop voor de groep Populated Places
zouden opnemen, zou die worden opgenomen net voor de vermeldingen van de bevolkte plaatsen voor elke staat,
zoals weergegeven in de afbeelding hieronder:
Op dezelfde wĳze zou een voettekst voor de groep Populated Places worden ingevoegd nadat de laatste plaats voor
elke staat is opgenomen.
In aanvulling op geneste subgedeelten, kunnen subgedeelten in een rapport ook achter elkaar worden opgenomen.
Als we een tweede subgedeelte toevoegen aan de groep Admin Level 1 voor Airports, dan (als de laag Airports een
attribuut adm1name heeft dat het kan koppelen aan de oudergroep) zou ons rapport eerst ALLE bevolkte plaatsen
vermelden voor elke staat, gevolgd door de vliegvelden in die staat, voordat wordt doorgegaan naar de volgende staat.
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Het sleutelpunt hier is dat onze groep Airports een subgedeelte is van de groep Admin Level 1 – niet van de groep
Populated Places.
In dat geval zou ons rapport zĳn gestructureerd zoals dit (onthoud dat ook vlaggen van de staat zĳn opgenomen - de
procedure voor het op deze manier toevoegen van objectspecifieke afbeeldingen wordt hieronder beschreven):
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Afbeeldingen opnemen in een rapport

Afbeeldingen kunnen bĳzonder nuttig zĳn in rapporten, en QGIS staat afbeeldingen toe in zowel de statische als de
dynamische delen van een rapport. Afbeeldingen worden op dezelfdemanier toegevoegd als voor standaard afdruklay-
outs, en voor de statische delen van het rapport (en statische afbeeldingen in dynamische delen) is er niet meer dan
dat.
Maar als u illustraties wilt die op maat gemaakt zĳn voor de objecten in het rapport, moet uw laag een attribuut hebben
dat kan worden gebruikt om de op te nemen afbeelding te definiëren.
QGIS is afhankelĳk van absolute bestandsnamen voor afbeeldingen in rapporten.
Voor dynamische afbeeldingen voegt u eerst een afbeelding toe aan de bloktekst van die groep, zoals gewoonlĳk.
In de Item-eigenschappen van de afbeelding, stelt u de Bron afbeelding in met de knop Data-bepaalde ‘override’, en
selecteer ofwel een attribuut dat het absolute pad bevat van de afbeeldingen of Bewerken… (om een expressie in te
voeren die het absolute pad voor de afbeelding maakt).
Hieronder staat een voorbeeldexpressie die het samenvoegen van tekenreeksen gebruikt om het absolute pad
naar de afbeelding te specificeren, met de map waar het projectbestand is geplaatst (@project_path) en een
attribuut (adm1name) van waaruit de bestandsnaam wordt gemaakt (in dit geval door de tekenreeks in het attribuut
adm1name om te zetten naar hoofdletters en ‘_flag.png’ toe te voegen):

concat(@project_folder, '/naturalearth/pictures/' ,
upper("adm1name"), '_flag.png')

Dit betekent dat de afbeeldingen zĳn geplaatst in de submap naturalearth/pictures van de map met het
projectbestand.

Accentueren van het huidige object van het rapport op een kaart

In het bovenstaande rapport worden de objecten in het rapport benadrukt in de kaarten met accentueren (state) en
cirkels (populated places). Umoet, om de objecten in het rapport te benadrukken in de kaarten (los van ze te plaatsen in
het midden van de kaarten), de stĳl data-bepalen met een vergelĳking tussen zĳn @id en de @atlas_featureid,
net als voor atlassen.
Als u bĳvoorbeeld een dikkere lĳn / grens zou willen hebben voor het object in het rapport dan voor de andere
objecten, kunt u de lĳndikte data-bepalen:

if($id=@atlas_featureid, 2.0, 0.1)

Het object van het rapport zal een 2 eenheden brede polygoonomtrek krĳgen, terwĳl alle andere objecten een 0.1
eenheden brede lĳn zullen krĳgen. Het is ook mogelĳk de kleur data te bepalen (niet-transparant donker magenta
voor het object van het rapport en semi-transparant lichtgrĳs voor de andere objecten):

if($id=@atlas_featureid, '#FF880088', '#88CCCCCC')
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Meer groepen op niveau 1

Combineren van geneste en opeenvolgende gedeelten, samen met koppen en voetteksten voor gedeelten, geeft
bĳzonder veel flexibiliteit. Bĳvoorbeeld in het onderstaande rapport voegen we een ander groepsveld toe als kind
van het hoofdrapport voor de laag Ports. Nu, na het vermelden van de staten, samen met hun bevolkte plaatsen en
vliegvelden, zullen we een overzichtslĳst krĳgen van alle havens in de regio:

Dit geeft voor het laatste deel van de export ons rapport het volgende:
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21.4.4 Instellingen voor exporteren

Wanneer u een rapport exporteert (Rapport ► Rapport als afbeelding exporteren… / SVG… / PDF…), zult u worden
gevraagd naar een bestandsnaam, en dan krĳgt u de gelegenheid om de instellingen voor het exporteren fĳn af te
stemmen om de meest toepasselĳke uitvoer te krĳgen.
Zoals u ziet zĳn rapporten in QGIS bĳzonder krachtig en flexibel!

Notitie: De huidige informatie werd aangepast vanuit een blog van North Road, Exploring Reports in QGIS 3.0 -
the Ultimate Guide!
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Werken met protocollen van OGC / ISO

Het Open Geospatial Consortium (OGC) is een internationale organisatie met, wereldwĳd, leden in meer dan
300 commerciële, overheids-, non-profit- en research-organisaties. De leden ervan ontwikkelen en implementeren
standaarden voor geo-ruimtelĳke inhoud en diensten, het verwerken van GIS-gegevens en uitwisseling.
Beschrĳven van een basis gegevensmodel voor geografische objecten, een groeiend aantal specificaties zĳn ontwikkeld
door OGC om te voldoen aan specifieke behoeften voor interoperabele locatie- en georuimtelĳke technologie,
inclusief GIS. Meer informatie kan worden gevonden op https://www.ogc.org/.
Belangrĳke specificaties voor OGC die worden ondersteund door QGIS zĳn:

• WMS—Web Map Service (WMS/WMTS-cliënt)
• WMTS—Web Map Tile Service (WMS/WMTS-cliënt)
• WFS—Web Feature Service (WFS- en WFS-T-cliënt)
• WFS-T—Web Feature Service - Transactional (WFS- en WFS-T-cliënt)
• WCS—Web Coverage Service (WCS-cliënt)
• WPS—Web Processing Service
• CSW—Catalog Service voor het Web
• SFS— Simple Features for SQL (PostGIS-lagen)
• GML—Geography Markup Language

OGC-diensten worden steeds meer gebruikt om georuimtelĳke gegevens uit te wisselen tussen verschillende
implementaties van GIS en gegevensopslag. QGIS kan als een cliënt bovenvermelde specificaties afhandelen, door
SFS te zĳn (door ondersteuning van de gegevensprovider PostgreSQL / PostGIS, zie het gedeelte PostGIS-lagen).
U kunt uw kaarten en gegevens ook delen via de protocollen WMS, WMTS, WFS, WFS-T en WCS met een
geïnstalleerde webserver met QGIS Server, UMN MapServer of GeoServer.
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22.1 WMS/WMTS-cliënt

22.1.1 Overzicht ondersteuning voor WMS

QGIS kan momenteel dienen als een WMS-cliënt die servers met WMS 1.1, 1.1.1 en 1.3 begrĳpt. In het bĳzonder
is het getest met publiek toegankelĳke servers, zoals DEMIS.
Een WMS-server acteert op verzoeken van de cliënt (bĳv. QGIS) voor een rasterkaart met een opgegeven bereik,
set van lagen, stĳl voor symbologie en transparantie. De WMS-server consulteert dan zĳn lokale gegevensbronnen,
rasteriseert de kaart en stuurt het terug naar de cliënt in de indeling van een raster. Voor QGIS zou deze indeling
gewoonlĳk JPEG of PNG zĳn.
WMS is in het algemeen een REST (Representational State Transfer)-service in plaats van een volledige webservice.
Als zodanig kunt u in feite de URL’s gebruiken die worden gegenereerd door QGIS en die gebruiken in een
webbrowser om dezelfde afbeeldingen op te halen als die welke QGIS intern gebruikt. Dit kan handig zĳn bĳ het
oplossen van problemen, omdat er verschillende merken WMS-server op de markt zĳn en zĳ allemaal hun eigen
integratie van de WMS-standaard hebben.
WMS-lagen kunnen vrĳ eenvoudig worden toegevoegd, zolang u de URL maar weet om toegang te krĳgen tot de
server van WMS, u een verbinding met services hebt naar die server en de server HTTP begrĳpt als het mechanisme
voor transport van de gegevens.
Aanvullend zal QGIS uw antwoorden van WMS opslaan in een cache (bĳv. afbeeldingen) voor 24u zolang het
verzoek GetCapabilities niet wordt geactiveerd. Het verzoek GetCapabilities wordt elke keer geactiveerd als de knop
Verbinden in het dialoogvensterWMTS wordt gebruikt om de capabilities van de WMS server op te halen. Dit is een
automatische mogelĳkheid die is bedoeld om de tĳd voor het laden te optimaliseren. Als een project wordt opgeslagen
met laag van WMS, worden de corresponderende tegels van WMS geladen vanuit de cache, de volgende keer dat het
project wordt geopend, zolang zĳ niet ouder zĳn dan 24 uur.

22.1.2 Overzicht van ondersteuning voor WMTS

QGIS kan ook optreden als een WMTS-cliënt. WMTS is een OGC-standaard voor het distribueren van tegelsets van
georuimtelĳke gegevens. Dit is een snellere en meer efficiënte manier voor het distribueren van gegevens dan WMS
omdat met WMTS de tegelsets vooraf worden gegenereerd en de cliënt alleen de verzending van de tegels verzoekt,
niet hun productie. Een verzoek aan WMS omvat gewoonlĳk zowel het genereren als het verzenden van de gegevens.
Een zeer bekend voorbeeld van een niet-OGC-standaard voor het bekĳken van getegelde georuimtelĳke gegevens is
Google Maps.
De tegelsets van WMTS worden geproduceerd op verschillende schaalniveaus om de gegevens op een breed bereik
aan schalen tot waar de gebruiker ze zou kunnen willen weergeven en worden beschikbaar gesteld aan de GIS-cliënt
om ze te bevragen.
Dit diagram illustreert het concept van tegelsets:

Fig. 22.1: Concept van tegelsets voor WMTS
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De twee typen interfaces voor WMTS die QGIS ondersteunt zĳn die via Key-Value-Pairs (KVP) en RESTful. Deze
twee interfaces verschillen van elkaar en u moet ze voor QGIS verschillend specificeren.

1. Een gebruiker van QGIS moet, om toegang te krĳgen tot een WMTS KVP-service, de interface voor
WMS/WMTS openen en de volgende tekenreeks toevoegen aan de URL van de WMTS-tegelservice:

"?SERVICE=WMTS&REQUEST=GetCapabilities"

Een voorbeeld van dit type adres is:

https://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?service=WMTS&
↪→request=GetCapabilities

Voor het testen van de laag topo2 in dit WMTS werkt het aardig. Toevoegen van deze tekenreeks geeft aan dat
een WMTS-webservice moet worden gebruikt in plaats van een WMS-service.

2. De service RESTful WMTS heeft een andere vorm, een rechttoe rechtaan URL. De door OGC aanbevolen
indeling is:

{WMTSBaseURL}/1.0.0/WMTSCapabilities.xml

Deze indeling helpt u te herkennen dat het een adres voor RESTful is. Een RESTful WMTS is in QGIS
toegankelĳk door eenvoudigweg het adres toe te voegen aan de instelling van de WMS in het veld URL van
het formulier. Een voorbeeld van dit type adres voor een Oostenrĳkse basiskaart is:

https://maps.wien.gv.at/basemap/1.0.0/WMTSCapabilities.xml

Notitie: U kunt nog steeds enkele oudere services vinden, genaamd WMS-C. Deze services komen vrĳwel overeen
met WMTS (d.i. hetzelfde doel maar werken iets anders). U kunt ze op dezelfde wĳze beheren als u met WMTS-
services doet. Voeg gewoon ?tiled=true toe aan het einde van de URL. Zie https://wiki.osgeo.org/wiki/Tile_Map_
Service_Specification voor meer informatie over deze specificatie.
Wanneer u WMTS leest, mag u ook WMS-C denken.

22.1.3 Selecteren van servers voor WMS/WMTS

De eerste keer dat u de mogelĳkheid WMS/WMTS in QGIS gebruikt, zĳn er geen servers gedefinieerd.
U moet dan verbindingen maken naar de server die u wilt gebruiken:

1. Ga naar de tab WMS/WMTS van het dialoogvenster Databronnen beheren, of door:

• te klikken op de knop Databronnen beheren openen (of door te drukken op Ctrl+L) en te schakelen naar
de tab

• te klikken op de knop WMS/WMTS-laag toevoegen op de werkbalk Lagen beheren

• of door te selecteren het menu Kaartlagen ► Laag toevoegen ► WMS/WMTS-laag toevoegen…

2. Klik op Nieuw op de tab Lagen. Het dialoogvenster Nieuwe WMS/WMTS-verbinding maken… verschĳnt.

Tip: Met rechts klikken op het item WMS/WMTS in het paneel Browser en selecteren van Nieuwe
verbinding… opent ook het dialoogvenster Nieuwe WMS/WMTS-verbinding maken….

3. Voer dan de parameters in om te verbinden met de door u gewenste WMS-server, zoals hieronder vermeld:
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Fig. 22.2: Een verbinding maken naar een WMS-server

• Naam: Een naam voor de verbinding. Deze naam zal worden gebruikt in de keuzelĳst Serververbindingen
zodat u hem kunt onderscheiden van andere WMS-servers.

• URL: URL van de server die de gegevens verschaft. Dit moet een herkenbare hostnaam zĳn – dezelfde
indeling als wanneer u een telnet-verbinding wilt openen of een host pingt. d.i. alleen de basis-URL. U
zou, bĳvoorbeeld, geen fragmenten zoals request=GetCapabilities of version=1.0.0 in
uw URL moeten hebben.

• Authenticatie (optioneel): gebruiken van een opgeslagen configuratie of een basisauthenticatie met
Gebruikersnaam enWachtwoord.

Waarschuwing: Invoeren van Gebruikersnaam en Wachtwoord op de tab Authenticatie zal het
opslaan van niet beveiligde inloggegevens behouden in de configuratie van de verbinding. Deze
inloggegevens zullen zichtbaar zĳn als u, bĳvoorbeeld, het projectbestand deelt met iemand.
Daarom wordt geadviseerd om uw inloggegevens in plaats daarvan op te slaan in een configuratie
voor Authenticatie (tab Configuraties). Bekĳk ook Authenticatiesysteem voor meer details.

• HTTP Verwĳzing

• DPI-modus: Beschikbare opties zĳn alles, uit, QGIS, UMN en GeoServer
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• GetMap/GetTile/GetLegendGraphic URI uit de capabilities negeren: indien geselecteerd, gebruik de
opgegeven URI uit het veld URL hierboven.

• GetFeatureInfo URI uit de capabilities negeren: indien geselecteerd, gebruik de opgegeven URI uit het
veld URL hierboven.

• As-oriëntatie (WMS 1.3/WMTS) negeren

• Bereiken van gerapporteerde laag negeren: omdat het bereik dat wordt gerapporteerd door rasterlagen
kleiner kan zĳn dan het feitelĳke gebied dat kan worden gerenderd (met name voor WMS-servers met
symbologie dat meer ruimte inneemt dan het gegevensbereik), selecteer deze optie om het afbreken van
rasterlagen tot hun gerapporteerde bereik, wat zou resulteren im afgebroken symbolen aan de randen van
deze lagen, te vermĳden.

• As-oriëntatie omdraaien

• Gelikte pixmap-transformatie

4. Klik op OK

Als de nieuwe verbinding voor de WMS/WMTS-server eenmaal is gemaakt, zal die worden behouden voor
toekomstige sessies in QGIS.
Als u een proxyserver moet opzetten om in staat te zĳn WMS-services vanaf het internet te ontvangen, kunt u uw
proxyserver toevoegen in de opties. Kies Extra ► Opties en klik op de tab Netwerk. Daar kunt u uw instellingen voor
de proxy toevoegen en ze inschakelen door Gebruik een proxy voor internettoegang te selecteren. Zorg er voor dat
u het juiste type proxy selecteert uit de keuzelĳst Proxy type .

22.1.4 Laden van lagen WMS/WMTS

Als u eenmaal met succes uw parameters hebt ingevuld, kunt u de knop Verbinden gebruiken om de objecten van
de geselecteerde server op te halen. Dit is inclusief de codering voor de afbeelding, lagen, stĳlen voor lagen en
projecties. Omdat dit een bewerking op het netwerk is, is de snelheid van het antwoord afhankelĳk van de kwaliteit
van uw netwerkverbinding naar deWMS-server. Gedurende het downloaden van gegevens van deWMS-server wordt
de voortgang van dat proces gevisualiseerd in de linkerbenedenhoek van het hoofdvenster van QGIS.
Uw scherm zou er nu een beetje uit moeten zien zoals Fig. 22.3, wat het antwoord laat zien dat wordt verschaft door
een WMS-server.
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Fig. 22.3: Dialoogvenster voor het toevoegen van een WMS-server, met filter op zijn beschikbare lagen

Het bovenste gedeelte van de tab Lagen van het dialoogvenster geeft een boomstructuur weer die groepen van lagen
kan bevatten met ingebedde lagen met hun geassocieerde afbeeldingsstĳle(en), geserveerd door de server. Elk item
kan worden geïdentificeerd door:

• een ID

• een Naam

• een Titel

• en een Samenvatting.

De lĳst kan worden gefilterd met de widget in de rechterbovenhoek.
Codering van afbeelding
Het gedeelte Afbeeldingsformaat vermeld de indelingen die zowel door de cliënt als de server worden ondersteund.
Kies er een, afhankelĳk van de vereisten voor de nauwkeurigheid van uw afbeelding.

Tip: Codering van afbeelding
U zult vrĳwel altĳd merken dat een WMS-server u de keuze biedt tussen de JPEG- of PNG-codering voor
afbeeldingen. JPEG is een indeling voor compressie met verlies van gegevens, waar PNG de ruwe rastergegevens
zorgeloos reproduceert.
Gebruik JPEG als u verwacht dat de gegevens van WMS van oorsprong fotografisch zĳn en/of u geen bezwaar heeft
tegen verlies van enige kwaliteit in de afbeelding. Dit nadeel reduceert gewoonlĳk met de factor vĳf de vereisten voor
gegevensoverdracht ten opzichte van PNG.
Gebruik PNG als u precieze weergaven van de originele gegevens wilt en u geen bezwaar heeft tegen de verhoogde
vereisten voor gegevensoverdracht.

Opties
Het gebied Opties van het dialoogvenster verschaft manieren om de WMS-verzoeken te configureren. U kunt
definiëren:
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• Tile-grootte als u de grootte van de tegels wilt instellen (bĳv. 256x256) om het WMS-verzoek op te splitsen in
meerdere verzoeken.

• Stapgrootte gevraagd: als u het effect van het afsnĳden van labels aan de randen van de tegels wilt verminderen,
maakt het vergroten van de stapgrootte grotere verzoeken, minder tegels enminder randen. De standaardwaarde
is 2000.

• Het Maximale aantal GetFeatureInfo resultaten vanaf de server
• Elke WMS-laag kan worden weergegeven in meerdere CRS-en, afhankelĳk van de mogelĳkheden van de
WMS-server. Als u een WMS selecteert uit de lĳst, verschĳnt een veld met de standaard projectie die is
verschaft door de webserver. Druk op de widget CRS selecteren om de standaard projectie van de WMS
te vervangen door een andere CRS, ondersteund door de WMS-server.
Een dialoogvenster, soortgelĳk als weergegeven in Fig. 10.3 zal verschĳnen. Het belangrĳkste verschil met
de WMS-versie van het dialoogvenster is dat alleen die CRS-en zullen worden weergegeven die worden
ondersteund door de WMS-server.

• Tenslotte kunt u Contextuele WMS-legenda gebruiken activeren als de WMS-server die mogelĳkheid
ondersteunt. Dan zal alleen de relevante legenda voor uw huidige kaartweergave worden weergegeven en zal
dus geen items voor de legenda bevatten voor items die u niet kunt zien in de huidige kaart.

Aan de onderzĳde van het dialoogvenster geeft een tekstveld Laagnaam de Titel van het geselecteerde item weer. U
kunt de naam wĳzigen naar wat u wilt. Deze naam zal in het paneel Lagen verschĳnen nadat u op de knop Toevoegen
hebt geklikt en de la(a)g(en) zĳn geladen in QGIS.
U kunt verscheidene lagen in één keer selecteren, maar slechts één stĳl voor een afbeelding per laag. Wanneer
verscheidene lagen zĳn geselecteerd, zullen zĳ op de WMS-server worden gecombineerd en in één keer naar QGIS
worden verzonden, als één enkele laag. De standaardnaam is een door slashes (/ ) gescheiden lĳst van hun originele
titels. U kunt er echter voor kiezen voor Als afzonderlĳke lagen laden.
Volgorde lagen
De tab Laagvolgorde vermeldt de geselecteerde beschikbare lagen uit de huidige verbinding met de WMS-server.
WMS-lagen die zĳn gerenderd door een server worden gestapeld in de volgorde die is vermeld in de tab Lagen, van
boven naar beneden in de lĳst. Als u de volgorde van stapelen wilt wĳzigen, kunt u de knoppen Omhoog en Naar
beneden van de tab Laagvolgorde gebruiken.
Transparantie
De instelling Globale transparantie uit de Laageigenschappen is hard gecodeerd om altĳd aan te staan, indien
beschikbaar.

22.1.5 Tegelsets

Bĳ het gebruiken van services van WMTS (gecachte WMS) kunt u bladeren op de tab Tilesets die is doorgegeven
door de server. Aanvullende informatie zoals tegelgrootte, indelingen en ondersteund CRS zĳn in deze tabel vermeld.

# example of WMTS service

https://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?service=WMTS&
↪→request=GetCapabilities

Bĳ het selecteren van een laag om te laden is het ook mogelĳk om een Methode voor interpretatie toe te passen, wat
het converteert naar een rasterlaag van het type enkelbands float, klaar om te worden opgemaakt met de normale
renderers voor raster van QGIS.
In combinatie met deze mogelĳkheid kunt u de schuif voor de schaal van de tegel gebruiken door te selecteren Beeld

► Panelen of Extra ► Panelen en dan te kiezen paneel Tile-schaal. Dat geeft u de beschikbare schalen vanaf de
tileserver met een leuke schuifbalk daarin.
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22.1.6 Gebruiken van het gereedschap Objecten identificeren

Als u eenmaal een WMS-server hebt toegevoegd en als een laag van een WMS-server is te bevragen, dan kunt u
het gereedschap Objecten identificeren gebruiken om een pixel in het kaartvenster te selecteren. Een query naar de
WMS-server wordt verstuurd voor elke gemaakte selectie. De resultaten van de bevraging worden teruggegeven in
platte tekst. De opmaak van die tekst is afhankelĳk van de gebruikte WMS-server.
Selecteren indeling
Indien meerdere indelingen voor uitvoer worden ondersteund door de server, wordt een combinatievak met die
ondersteunde indelingen automatisch toegevoegd aan het dialoogvenster Identificatieresultaten en de geselecteerde
indeling kan voor de laag worden opgeslagen in project.
Ondersteuning indeling GML

Het gereedschap Objecten identificeren ondersteunt antwoorden vanWMS-server (GetFeatureInfo) in de indelingGML
(het wordt in de QGIS GUI in deze context Object genoemd). Als de indeling “Object” wordt ondersteund door de
server en geselecteerd, zĳn de resultaten van het gereedschapObjecten identificeren vectorobjecten, als uit een gewone
vectorlaag. Wanneer één enkel object is geselecteerd in de boom, wordt het geaccentueerd in de kaart en kan het naar
het klembord worden gekopieerd en geplakt op een andere vectorlaag. Bekĳk de voorbeeld instelling van de UMN
Mapserver hieronder voor ondersteuning van GetFeatureInfo in de indeling GML.

# in layer METADATA add which fields should be included and define geometry␣
↪→(example):

"gml_include_items" "all"
"ows_geometries" "mygeom"
"ows_mygeom_type" "polygon"

# Then there are two possibilities/formats available, see a) and b):

# a) basic (output is generated by Mapserver and does not contain XSD)
# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "application/vnd.ogc.gml,text/html"

# b) using OGR (output is generated by OGR, it is sent as multipart and contains␣
↪→XSD)
# in MAP define OUTPUTFORMAT (example):
OUTPUTFORMAT

NAME "OGRGML"
MIMETYPE "ogr/gml"
DRIVER "OGR/GML"
FORMATOPTION "FORM=multipart"

END

# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "OGRGML,text/html"

22.1.7 Eigenschappen bekijken

Wanneer u een WMS-server hebt toegevoegd kunt u de eigenschappen ervan bekĳken door met rechts te klikken
in de legenda en te selecteren Laageigenschappen. De WMS/WMTS laageigenschappen lĳken heel veel op die
eigenschappen van een rasterlaag, dus u vindt een gedetailleerde beschrĳving in Dialoogvenster Laageigenschappen.
Er zĳn echter enkele verschillen die hieronder besproken worden.
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Eigenschappen Informatie

Tab Metadata
De tab Metadata geeft een grote hoeveelheid informatie weer over de WMS-server, over het algemeen verzameld
door het argument capabilities dat werd teruggegeven door die server. Vele definities kunnen worden verzameld door
de WMS-standaarden te lezen (zie OPEN-GEOSPATIAL-CONSORTIUM in Verwĳzingen naar literatuur en web),
maar hier zĳn een aantal handige definities:

• Servereigenschappen
– WMS Versie—De door de server ondersteunde versie van WMS.
– Indelingen voor afbeeldingen— De lĳst van MIME-types waarmee de server kan antwoorden bĳ het
tekenen van de kaart. QGIS ondersteunt alle indelingen waarmee de onderliggende bibliotheken van Qt
werden gebouwd, wat over het algemeen tenminste image/png en image/jpeg zĳn.

– Indelingen voor identificeren—De lĳst van MIME-types waarin de server kan antwoorden wanneer u
het gereedschap Objecten identificeren gebruikt. Momenteel ondersteunt, QGIS het type text-plain.

• Laageigenschappen
– Geselecteerd—Of deze laag al dan niet geselecteerd was toen de server ervan werd toegevoegd aan dit
project.

– Zichtbaar — Of deze laag al dan niet is geselecteerd als zichtbaar in de legenda (nog niet gebruikt in
deze versie van QGIS).

– Kan identificeren — Of deze laag al dan niet resultaten zal teruggeven als het gereedschap Objecten
identificeren er op zal worden gebruikt.

– Kan transparant zĳn — Of de laag al dan niet kan worden gerenderd met transparantie. Deze versie
van QGIS zal altĳd transparantie gebruiken als dit Yes is en de codering voor de afbeelding transparantie
ondersteunt.

– Kan inzoomen — Of op deze laag al dan niet kan worden ingezoomd door de server. Deze versie van
QGIS neemt aan datWMS-lagen dit hebben ingesteld opJa. Afwĳkende lagen zouden vreemd gerenderd
kunnen worden.

– Telling doorzenden—WMS-servers kunnen als een proxy optreden voor andere WMS-servers om de
rastergegevens voor een laag te verkrĳgen. Dit item geeft weer hoe vaak het verzoek voor deze laag werd
doorgezonden aan collega WMS-servers voor een resultaat.

– Vaste breedte, vaste hoogte—Of deze laag al dan niet vaste dimensies voor de bronpixels heeft. Deze
versie van QGIS neemt aan dat alle WMS-lagen dit hebben ingesteld op niets. Afwĳkende lagen zouden
vreemd gerenderd kunnen worden.

– WGS 84-begrenzing — De begrenzing van de laag, in coördinaten voor WGS 84. Sommige WMS-
servers stellen dit niet juist in (bĳv. worden in plaats daarvan coördinaten voor UTM gebruikt). Als
dit het geval is dan zou de initiële weergave van deze laag kunnen worden gerenderd met een zeer
‘uitgezoomd’ uiterlĳk door QGIS. De webbeheerder van WMS zou over deze fout moeten worden
geïnformeerd, wat zĳ zouden kunnen kennen als de WMS XML-elementen LatLonBoundingBox,
EX_GeographicBoundingBox of de CRS:84 BoundingBox.

– Beschikbaar in CRS — De projecties waarin deze laag kan worden gerenderd door de WMS-server.
Deze worden vermeld in de eigen indeling van WMS.

– Beschikbaar in stĳl — De stĳlen voor de afbeelding waarin deze laag kan worden gerenderd door de
WMS-server.
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Eigenschappen Tijdbeheer

Raster eigenschappen Tĳdbeheer (genaamdDynamisch Tĳdbeheer) kan worden ingesteld voor lagenWMS enWMTS.
Standaard, wanneer een dimensie tĳd is ingeschakeld in de laag voor WMS of WMTS wordt toegevoegd aan
het project, wordt dat aangegeven in het paneel Lagen met het pictogram Tĳdbeheer laag ` ernaast. De :guilabel:`Tĳdbeheer-
eigenschappen zĳn standaard in de modus voor tĳdbeheer Automatisch, wat betekent dat de laag standaard de huidige
tĳdsperiode van Tĳdbeheer zal volgen.
U kunt er dan voor kiezen een specifieke statische tĳd voor de laag weer te geven door Dynamisch tĳdbeheer te
deselecteren en een optie te kiezen onder Statische tĳdsperiode WMS-T :

• Standaard server

• Vooraf gedefinieerde datum voor een server die gegevens weergeeft voor niet aaneengesloten tĳdsperioden of
Vooraf gedefinieerd bereik voor een server die een periode van beschikbare datums weergeeft. In het laatste
geval zĳn een Startdatum en Einddatum noodzakelĳk. Hun verwachte opmaak kan worden afgeleid van de
optie Verwĳzingstĳd (zie hieronder). afhankelĳk van het feit of de provider gegevens voor een aaneensluitende
periode heeft of niet

• Tĳdsperiode project volgen zoals gedefinieerd in het dialoogvenster voor de eigenschappen van het project

Fig. 22.4: Eigenschappen Tijdbeheer voor een WMTS-laag

Ongeacht het gebruikte tĳdbeheer zĳn er enkeleWMS-T instellingen om te helpen de correcte gegevens voor tĳdbeheer
weer te geven:

• Modus Tĳdschuif die kan zĳn
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– gehele tĳdsperiode gebruiken

– Overeenkomen met begin van bereik

– Overeenkomen met einde van bereik

– Dichtstbĳzĳnde overeenkomst met begin van bereik

– Dichtstbĳzĳnde overeenkomst met einde van bereik

• Tĳd-componenten negeren (alleen datums gebruiken): Indien geselecteerd zullen de tĳdcomponenten van query’s
in Tĳdbeheer worden genegeerd en alleen de datum-component zal worden gebruikt bĳ verzoeken aan de
server.

U kunt ook Specifieke WMS-T verwĳzingstĳd gebruiken, gekozen uit de tĳden die zĳn gerapporteerd in de
capabilities van de laag. Handig voor servers die een niet aaneensluitende set van datum/tĳd instanties weergeven
(in plaats van een bereik aan datums).

Eigenschappen QGIS Server

In aanvulling op de eigenschappen van de rasterlaag, zal publiceren van een WMS/WMTS-laag met QGIS Server de
volgende opties weergeven:

• WMS afdruklaag: Maakt het mogelĳk een alternatieve WMS-laag in te stellen die zou moeten wordne gebruikt
voor afdrukken (in het antwoord GetProjectSettings). Handig voor WMTS-lagen die over het algemeen niet
geschikt zĳn om af te drukken.

• WMS/WMTS URI databron publiceren: Staat een webcliënt toe om de gegevens van WMS/WMTS direct
op te halen

• Aanbieden als achtergrondlaag
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Fig. 22.5: Eigenschappen QGIS Server voor een WMTS-laag

22.1.8 Afbeelding van WMS-legenda weergeven in inhoudsopgave en
afdruklay-out

De QGIS WMS-gegevensprovider is in staat om een afbeelding van de legenda weer te geven in de inhoudsopgave
van de lĳst met lagen en in de afdruklay-out van de kaart. De legenda voor WMS zal alleen worden weergegeven als
de WMS-server de mogelĳkheid GetLegendGraphic heeft en de laag getCapability heeft gespecificeerd in de URL,
dus moet u aanvullend een opmaak voor de laag selecteren.
Als een legendGraphic beschikbaar is, wordt die weergegeven onder de laag. Hĳ is klein en u moet er op klikken om
hem te openen in zĳn echte afmetingen (wegens de architectonische beperking in QgsLegendInterface). Klikken op
de legenda van de lagen zal een kader openen met de legenda in zĳn volledige resolutie.
In de afdruklay-out zal de legenda worden geïntegreerd in zĳn originele (gedownloade) afmeting. Resolutie van de
afbeelding van de legenda kan worden ingesteld in de Item-eigenschappen onder Legenda -> WMS LegendGraphic
om overeen te komen met uw wensen voor afdrukken.
De legenda zal contextuele informatie weergeven gebaseerd op uw huidige schaal. De legenda voor WMS zal alleen
worden weergegeven als de WMS-server de mogelĳkheid GetLegendGraphic heeft en de laag getCapability heeft
gespecificeerd in de URL, dus moet u aanvullend een opmaak voor de laag selecteren.
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22.2 WCS-cliënt

EenWeb Coverage Service (WCS) verschaft toegang tot rastergegevens in vormen die handig zĳn voor cliëntzĳde
renderen, als invoer voor wetenschappelĳke modellen en voor andere cliënten. De WCS kan worden vergeleken
met WFS en WMS. Waar WMS en WFS service uitvoeren, staat WCS-cliënten toe gedeelten van de op de server
opgeslagen informatie te kiezen, gebaseerd op ruimtelĳke beperkingen en andere criteria voor bevragingen.
QGIS heeft een eigen WCS-provider en ondersteunt zowel versie 1.0 als 1.1 (die significant van elkaar verschillen),
maar heeft momenteel een voorkeur voor 1.0, omdat 1.1 nog vele problemen heeft (d.i. elke server implementeert
het op een andere manier met verschillende eigenaardigheden).
De eigen WCS-provider behandelt alle netwerkverzoeken en gebruikt alle standaard netwerkinstellingen van QGIS
(proxy in het bĳzonder). Het is ook mogelĳk modus Cache te selecteren (‘always cache’, ‘prefer cache’, ‘prefer
network’, ‘always network’), en de provider ondersteunt ook het selecteren van de tĳdpositie, indien een tĳdelĳk
domein wordt aangeboden door de server.

Waarschuwing: Invoeren van Gebruikersnaam en Wachtwoord op de tab Authenticatie zal het opslaan
van niet beveiligde inloggegevens behouden in de configuratie van de verbinding. Deze inloggegevens zullen
zichtbaar zĳn als u, bĳvoorbeeld, het projectbestand deelt met iemand. Daarom wordt geadviseerd om uw
inloggegevens in plaats daarvan op te slaan in een configuratie voor Authenticatie (tab Configuraties). Bekĳk ook
Authenticatiesysteem voor meer details.

22.3 WFS- en WFS-T-cliënt

In QGIS gedraagt een WFS-laag zich nagenoeg hetzelfde als elke andere vectorlaag. U kunt objecten identificeren en
selecteren en de attributentabel bekĳken. QGIS ondersteunt WFS 1.0.0, 1.1.0, 2.0 en OGC API - Features (OAPIF),
inclusief bewerken (via WFS-T). QGIS ondersteunt ook downloaden op de achtergrond en progressief renderen,
op-schĳf cachen van gedownloade objecten en automatisch detecteren van de versie.
In het algemeen is het toevoegen van eenWFS-laag nagenoeg hetzelfde als de procedure die werd gebruikt metWMS.
Er zĳn geen standaardservers gedefinieerd, dus dient u uw eigen toe te voegen. U kunt zoeken naar WFS-servers met
de plug-in MetaSearch of uw favoriete zoekmachine voor het web. Er zĳn een aantal lĳsten met publieke URL’s,
sommige daarvan worden onderhouden, andere niet.
Laden van een WFS-laag
Als een voorbeeld gebruiken we de WFS server Gateway Geomatics en geven een laag weer.

https://demo.gatewaygeomatics.com/cgi-bin/wfs_gateway?REQUEST=GetCapabilities&
↪→VERSION=1.0.0&SERVICE=WFS

Maak eerst een verbinding naar de WFS server om in staat te kunnen zĳn een WFS-laag te laden.

1. Open het dialoogvenster Databronnen beheren door te drukken op de knop Databronnen beheren openen

2. Schakel naar de tab WFS/OGC API-Features

3. Klik op Nieuw… om het dialoogvenster Nieuwe WFS-verbinding maken te openen
4. Voer Gateway Geomatics in als naam
5. Voer de URL in (zie boven)
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Fig. 22.6: Een verbinding maken naar een server van WFS

Notitie: In het geval van een OGC API - Features (OAPIF), zou de op te geven URL de thuispagina moeten
zĳn, d.i. de hoofdpagina vanaf waar het mogelĳk is om naar alle beschikbare service eindpunten te navigeren.

6. In het dialoogvenster voor instellingen van WFS kunt u:
• De versie van WFS van de server aangeven. Indien onbekend, druk dan op de knop Detecteren om hem
automatisch op te halen.

• Het Max. aantal objecten te definiëren dat moet worden opgehaald in één enkel verzoek GetFetFeature.
Indien leeg wordt er geen limiet ingesteld.

• En afhankelĳk van de versie van WFS geven we aan om:
– Bladeren door objecten inschakelen en het maximale aantal op te halen objecten specificeren met

Grootte pagina. Als geen limiet wordt gedefinieerd, dan wordt de standaard van de server toegepast.
– Forceren van Oriëntatie van as negeren (WFS 1.1/WFS 2.0)

– As-oriëntatie omdraaien.
– GML2-codering gebruiken voor transacties.

Waarschuwing: Invoeren van Gebruikersnaam enWachtwoord op de tab Authenticatie zal het opslaan
van niet beveiligde inloggegevens behouden in de configuratie van de verbinding. Deze inloggegevens
zullen zichtbaar zĳn als u, bĳvoorbeeld, het projectbestand deelt met iemand. Daarom wordt geadviseerd
om uw inloggegevens in plaats daarvan op te slaan in een configuratie voor Authenticatie (tab Configuraties).
Bekĳk ook Authenticatiesysteem voor meer details.
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7. Druk op OK om de verbinding te maken.
Onthoud dat instellingen voor een proxy, die u kan hebben ingesteld in uw voorkeuren, ook worden herkend.
Nu zĳn we klaar om WFS-lagen te laden met bovenstaande verbinding.

1. Kies ‘Gateway Geomatics’ uit de keuzelĳst Serververbindingen.
2. Klik op Verbinden

3. Selecteer de laag Parks uit de lĳst
4. U kunt ook kiezen om:

• Gebruik titel als laagnaam selecteren wat de titel van de laag, zoals die is gedefinieerd op de server,
weergeeft in het paneel Lagen in plaats van zĳn Naam

• Alleen objecten bevragen die het huidige zichtbare bereik overlappen

• Wĳzigen… het CRS van de laag naar een ander door de service ondersteunde
• of bouw een query om bepaalde objecten te specificeren die moeten worden opgehaald vanaf de service:
dubbelklik op de rĳ van de laag om het dialoogvenster SQL-querybouwer te openen. Dat dialoogvenster
verschaft widgets om een geavanceerde query voor SQL te schrĳven, daarbĳ uitgaande van de beschikbare
tabellen en kolommen van de service, met sorteren en filteren en een grote hoeveelheid functies van SQL,
ruimtelĳke predicaten en operatoren.
De query die u bouwt, zal na validatie verschĳnen in de kolom SQL in de tabelWFS / OGC API - Features,

en de gefilterde laag zal het pictogram ernaast weergeven in het paneel Lagen. Het is dus mogelĳk
om op elk moment de query aan te passen.

5. Klik op Toevoegen om de laag aan de kaart toe te voegen.
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Fig. 22.7: Een laag voor WFS toevoegen

De voortgang van de download is linksonder in de hoek van het hoofdvenster van QGIS zichtbaar. Wanneer de laag
klaar is met laden, kunt u enkele objecten identificeren en selecteren en kan de attributentabel worden bekeken.
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Werken met GPS-gegevens

23.1 Introduceren van gegevens van GNSS/GPS

23.1.1 Wat is GPS?

GPS, het Global Positioning System is een op satellieten gebaseerd systeem dat iedereen met een GPS-ontvanger
toestaat om hun exacte positie te vinden, overal op de wereld. GPSwordt gebruikt als hulp bĳ navigatie, bĳvoorbeeld in
vliegtuigen, in boten en door hikers. De GPS-ontvanger gebruikt de signalen van de satellieten om zĳn breedtegraad,
lengtegraad en (soms) hoogte te berekenen. De meeste ontvangers hebben ook de mogelĳkheid om op te slaan:

• locaties (bekend als waypoints)
• reeksen locaties die een geplande route vormen
• en een track-log van de verplaatsing van de ontvanger in de tĳd.

Waypoints, routes en tracks zĳn de drie basis typen objecten in GPS-gegevens. QGIS geeft waypoints weer in
puntlagen, waar routes en tracks wordne weergegeven in lagen linestring.

Notitie: QGIS ondersteunt ook ontvangers voor GNSS. Maar in deze documentatie blĳven we de term GPS
gebruiken.

23.1.2 Typen GPS-apparaten definiëren

Er zĳn heel veel verschillende typen GPS-apparaten. QGIS staat u toe uw eigen type apparaat te definiëren en
parameters voor het gebruik in te stellen op de tab Extra ► Opties ► GPS ► GPSBabel. Lees voor meer details
GPSBabel.
Als u eenmaal een nieuw type apparaat heeft gemaakt, zal het worden vermeld in de lĳsten met apparaten voor de
gereedschappen Download en Upload.
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23.1.3 GPS-gegevens overdragen of laden

Er bestaan heel veel verschillende bestandsindelingen voor het opslaan van GPS-gegevens. De indeling die QGIS
gebruikt wordt GPX (GPS eXchange-indeling) genoemd, wat een standaardindeling voor uitwisseling is dat een
willekeurig aantal waypoints, routes en tracks in hetzelfde bestand kan bevatten.
Een GPX-bestand laden:

1. Open de tab GPS in het dialoogvenster Databronnen beheren, d.i.:

• Klik op de knop Databronnen beheren openen op de werkbalk (of druk op Ctrl+L) en te schakelen naar de
doeltab

• Of selecteer Kaartlagen ► Laag toevoegen ► GPX-laag toevoegen…

2. Gebruik de knop… Bladeren naast de optie GPX-gegevensset om het GPX-bestand te selecteren.
3. Gebruik de keuzevakken om de Object typen te selecteren die u wilt laden vanuit het bestand. Elk objecttype

(Waypoints, Tracks of Routes) zal worden geladen in een afzonderlĳke laag.

Fig. 23.1: Dialoogvenster GPS-gegevens laden

U heeft, omdat QGIS GPX-bestanden gebruikt, een manier nodig om andere bestandsindelingen voor GPS te
converteren naar GPX. Dit kan voor veel indelingen worden gedaan met het gratis programma GPSBabel. Dit
programma kan ook GPS-gegevens overdragen tussen uw computer en een GPS-apparaat. QGIS gebruikt GPSBabel
om deze dingen te doen, en verschaft u handige algoritmes voor Processing, beschikbaar onder de groep GPS.

Notitie: GPS-apparaten stellen u in staat uw gegevens op te slaan in verschillende coördinatensystemen. Zorg er
voor, bĳ het downloaden van een GPX-bestand (vanaf uw GPS-apparaat of vanaf een website) om het dan te laden
in QGIS, dat de gegevens in het GPX-bestand zĳn opgeslagen in de indeling WGS 84 (latitude/longitude). QGIS
verwacht dit en het is de officiële specificatie voor GPX. Zie GPX 1.1 Schema Documentation.

23.2 GPS-informatie

Umoet Beeld► Panelen GPS-informatie selecteren of op Ctrl+0 drukken om het live volgen van GPS in QGIS
te activeren. U zult een nieuw vastgezet venster aan de linkerkant van het kaartvenster krĳgen.
Er zĳn drie mogelĳke schermen in dit venster van GPS-informatie:

• Positie: GPS-positie coördinaten en een interface voor het handmatig invoeren van punten en objecten

• Signaal: GPS signaalsterkte van satellietverbindingen
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• Opties: GPS scherm Opties (zie Fig. 23.4)
Met een aangesloten GPS-ontvanger (moet worden ondersteund door uw besturingssysteem) verbindt een eenvoudige
klik op Verbinden de GPS met QGIS. Een tweede klik (nu op Verbinding verbreken) verbreekt de verbinding van de
GPS-ontvanger met uw computer. Voor GNU/Linux is ondersteuning voor gpsd geïntegreerd om de verbinding te
ondersteunen met de meeste GPS-ontvangers. Daarom moet u eerst gpsd correct configureren om QGIS daarmee te
kunnen verbinden.
Met de knop Recenter zal de kaart naar de huidige GPS-positie springen.

Waarschuwing: Als u uw positie op het kaartvenster wilt opnemen, dient u eerst een nieuwe vectorlaag te maken
en die overschakelen naar de bewerkbare status om uw spoor op te kunnen nemen.

Wanneer een GPS-apparaat is verbonden en de gebruiker verplaatst de cursor over het kaartvenster, zal een livebericht
op de statusbalk de afstand en richting weergeven van de cursor naar de GPS-positie. Met instellingen voor het project
voor afstand en richting wordt in deze weergave rekening gehouden.

Tip: Touchscreen-apparaten
Op een touchscreen-apparaat, gebruik een tik en houd vast gebeurtenis om het livebericht voor de statusbalk te
activeren.

23.2.1 Positie en aanvullende attributen

Als de GPS signalen van satellieten ontvangt, zult u uw positie zien in breedtegraad, lengtegraad en hoogte,
tezamen met aanvullende attributen.
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Fig. 23.2: GPS-informatie en aanvullende attributen

23.2.2 GPS signaalsterkte

Hier ziet u de signaalsterkte van de satellieten waarvan u signalen ontvangt.

Fig. 23.3: GPS -informatie signaalsterkte
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23.2.3 GPS-opties

Fig. 23.4: GPS-informatie venster Opties
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Hier kunt u specificeren:
• Verbinding

– In geval van problemen met verbindingen kunt u schakelen tussen:

∗ Automatisch detecteren

∗ Serieel apparaat (opnieuw laden vereist als met een nieuw GPS-apparaat wordt verbonden)

∗ gpsd (selecteren van de host, poort en apparaat waarmee uw GPS is verbonden)
– Een klik op Verbinden initieert opnieuw de verbinding naar de GPS-ontvanger.

• Digitaliseren

– U kunt Bewaar toegevoegd object automatisch activeren wanneer u in de modus Bewerken bent. Of u
kunt activeren Voeg automatisch punten toe aan het kaartvenster met een bepaalde breedte en kleur.

– De Richting berekenen vanuit reisrichting kan worden gebruikt als het apparaat foutieve metingen voor
richting rapporteert en het zal de GPS-richting berekenen op basis van de twee eerder opgenomen locaties.

• Cursor u kunt een schuifbalk gebruiken om de positiecursor in het kaartvenster te
verkleinen en te vergroten.

• Filteren: U kunt ook de parameters Interval voor ophalen (seconden) en Drempel afstand (meters) instellen om
de cursor steeds actief te houden wanneer de ontvanger in een statische conditie staat.

• Kaart centreren en rotatie

– Activeren van Kaart hercentreren stelt u in staat om te bepalen op welke manier het kaartvenster
zal worden bĳgewerkt. Dit bevat ‘altĳd’, ‘wanneer buiten’, als u uw opgenomen coördinaten begint te
verplaatsen tot buiten het kaartvenster, of ‘nooit’ om het kaartbereik te behouden.

– Activeren van Kaart roteren om overeen te komen met de GPS-richting zal automatisch het kaartvenster
draaien zodat het in dezelfde richting is georiënteerd als de GPS-richting.

• Activeren van Lĳn voor richting weergeven zal een lĳn weergeven vanaf de GPS-locatie, wĳzend in de richting
van het huidige pad voor de GPS.

• Tenslotte kunt u Logbestand activeren en een pad en bestand definiëren waar logberichten over het volgen
van GPS worden gelogd.

Als u handmatig een object wilt instellen, moet u teruggaan naar Positie en klikken op Object toevoegen of Voeg
trackpunt toe.

23.2.4 Verbinden met een Bluetooth GPS voor live volgen

Met QGIS kunt u verbinden met een Bluetooth GPS voor het verzamelen van gegevens in het veld. U heeft een
apparaat voor GPS Bluetooth en een ontvanger voor Bluetooth op uw computer nodig om deze taak uit te kunnen
voeren.
Als eerste moet u uw GPS-apparaat laten herkennen en paren aan de computer. Schakel de GPS in, ga naar het
pictogram Bluetooth in uw systeemvak en zoek naar een Nieuw apparaat.
Zorg er voor, aan de rechterkant van het masker voor selecteren van een apparaat, dat alle apparaten zĳn geselecteerd,
zodat uw GPS-eenheid waarschĳnlĳk tussen de beschikbare wordt weergegeven. In de volgende stap zou een seriële
verbindingsservice beschikbaar moeten zĳn, selecteer die en klik op de knop Configureren.
Onthoudt het nummer van de COM-poort die is toegewezen aan de GPS-verbinding, zoals dat als resultaat wordt
weergegeven door de eigenschappen van Bluetooth.
Verzorg, nadat de GPS is herkend, het paren van de verbinding. De activatiecode is gewoonlĳk 0000.
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Open nu het paneel GPS-informatie en schakel over naar het venster GPS opties. Selecteer de aan de GPS
verbinding toegewezen COM-poort en klik op Verbinden. Na enige tĳd zou een cursor uw positie moeten aangeven.
Als QGIS geen gegevens van GPS kan ontvangen, zou u uw GPS-apparaat opnieuw moeten inschakelen, 5-10
seconden wachten en dan opnieuw moeten proberen te verbinden. Normaal gesproken werkt deze oplossing. Als
u opnieuw een verbindingsfout ontvangt, zorg er dan voor dat er geen andere Bluetooth-ontvanger in de buurt is, die
gepaard is met dezelfde GPS-eenheid.

23.2.5 GPSMAP 60cs gebruiken

MS Windows

De gemakkelĳkste manier om het werkend te maken is om een middleware-programma te gebruiken (freeware, niet
open), genaamd GPSGate.
Start het programma, zorg dat het scant naar GPS-apparaten (werkt voor zowel USB als die van BT) en klik dan
in QGIS eenvoudigweg op Verbinden in het paneel GPS-informatie met behulp van de modus Automatisch
detecteren.

Ubuntu/Mint GNU/Linux

Net als voor Windows is de eenvoudigste manier om een server in het midden te gebruiken, in dit geval GPSD, dus

sudo apt install gpsd

Laad dan de kernelmodule garmin_gps

sudo modprobe garmin_gps

En verbind dan de eenheid. Controleer dan met dmesg het actuele apparaat dat wordt gebruikt door de eenheid,
bĳvoorbeeld /dev/ttyUSB0. Nu kunt u gpsd starten

gpsd /dev/ttyUSB0

En verbind tenslotte met het QGIS gereedschap GPS-informatie.

23.2.6 BTGP-38KM gegevenslogger gebruiken (alleen Bluetooth)

Het gebruiken van GPSD (onder Linux) of GPSGate (onder Windows) vereist geen inspanningen.

23.2.7 BlueMax GPS-4044 gegevenslogger gebruiken (zowel BT als USB)

MS Windows

GPS-informatie werkt voor zowel de modus USB als modus BT door GPSGate te gebruiken, of zelfs zonder, gebruik
eenvoudigweg de modus Automatisch detecteren, of wĳs aan het gereedschap de juiste poort toe.
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Ubuntu/Mint GNU/Linux

Voor USB
GPS-informatie werkt met zowel GPSD

gpsd /dev/ttyACM3

of zonder, door het QGIS gereedschap GPS-informatie rechtstreeks te verbinden met het apparaat (bĳvoorbeeld
/dev/ttyACM3).
Voor Bluetooth
GPS-informatie werkt met zowel GPSD

gpsd /dev/rfcomm0

of zonder, door het QGIS gereedschap GPS-informatie rechtstreeks te verbinden met het apparaat (bĳvoorbeeld
/dev/rfcomm0).
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Authenticatiesysteem

24.1 Overzicht authenticatiesysteem

Fig. 24.1: Anatomie van het authenticatiesysteem

24.1.1 Authenticatie-database

Het nieuwe authenticatiesysteem slaat configuraties voor authenticatie standaard op in een databasebestand van
SQLite, <profile directory>/qgis-auth.db.
Deze authenticatie-database kan worden verplaatst tussen installaties van QGIS zonder andere huidige instellingen van
de gebruikers voor QGIS te beïnvloeden, omdat hĳ volledig afgezonderd is van de normale instellingen voor QGIS.
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Een ID voor configuratie (een willekeurige 7-tekens lange alfanumerieke tekenreeks) wordt gegenereerd bĳ het initieel
opslaan van een configuratie in de database. Die vertegenwoordigt de configuratie, waarbĳ het wordt toegestaan de
ID op te slaan in platte tekst componenten van de toepassing, (zoals project-, plug-in, of instellingsbestanden) zonder
de daarmee geassocieerde gegevens prĳs te geven.

Notitie: De bovenliggende map van de qgis-auth.db kan worden ingesteld met behulp van de volgende
omgevingsvariabele, QGIS_AUTH_DB_DIR_PATH, of worden ingesteld op de opdrachtregel bĳ het opstarten met
behulp van de optie --authdbdirectory.

24.1.2 Hoofdwachtwoord

Een gebruiker moet een hoofdwachtwoord definiëren om gevoelige informatie in de database op te slaan of er toegang
tot te verkrĳgen. Een nieuw hoofdwachtwoord wordt verzocht en geverifieerd bĳ het initieel opslaan van versleutelde
informatie in de database. Wanneer toegang wordt gezocht tot gevoelige informatie wordt de gebruiker gevraagd het
hoofdwachtwoord in te voeren. Het wachtwoord wordt opgeslagen voor de rest van die sessie (totdat de toepassing
wordt afgesloten), tenzĳ de gebruiker handmatig een actie kiest om de opgeslagen waarde te verwĳderen. Sommige
instances van het gebruik van het authenticatiesysteem vereisen geen invoer van het hoofdwachtwoord, zoals bĳ het
kiezen van een bestaande configuratie voor authenticatie, of het toepassen van een configuratie op een configuratie
voor een server (zoals bĳ het toevoegen van een WMS-laag).
U kunt er voor kiezen het wachtwoord op te slaan in de Wallet/Keyring van uw computer.

Fig. 24.2: Nieuw hoofdwachtwoord invoeren

Notitie: Een pad naar een bestand dat het hoofdwachtwoord bevat kan worden ingesteld met behulp van de volgende
omgevingsvariabele, QGIS_AUTH_PASSWORD_FILE.
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Hoofdwachtwoord beheren

Eenmaal ingesteld kan het hoofdwachtwoord worden hersteld; het huidige hoofdwachtwoord is voorafgaand aan het
herstellen nodig. Gedurende dit proces bestaat er een optie om een volledige back-up van de huidige database te
genereren.

Fig. 24.3: Hoofdwachtwoord opnieuw instellen

Als de gebruiker het hoofdwachtwoord vergeet, bestaat er geen manier om het terug te vinden of te overschrĳven. Er
bestaat ook geen manier om versleutelde informatie terug te halen zonder het hoofdwachtwoord te kennen.
Als een gebruiker zĳn bestaande hoofdwachtwoord drie keer foutief invoert, zal een dialoogvenster aanbieden om de
database te wissen.

Fig. 24.4: Na drie ongeldige pogingen wordt naar het wachtwoord gevraagd

24.1.3 Configuraties voor authenticatie

U kunt configuraties voor authenticatie beheren vanuit Configuraties op de tab Authenticatie van het dialoogvenster
QGIS Opties (Extra ► Opties).
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Fig. 24.5: Configuraties bewerken

Gebruik de knop om een nieuwe configuratie toe te voegen, de knop om configuraties te verwĳderen, en de
knop om bestaande aan te passen.
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Fig. 24.6: Configuraties vanuit de bewerker voor Configuraties toevoegen

Hetzelfde type bewerkingen voor het beheren van configuraties voor authenticatie (Toevoegen, Bewerken en
Verwĳderen) kan ook worden uitgevoerd bĳ het configureren van een bepaalde serviceverbinding, zoals het
configureren van een serviceverbinding voor OWS. Daarvoor zĳn er binnen de configuratieselectie actieknoppen
voor het volledig beheren van configuraties die kunnen worden gevonden in de authenticatie-database. In dat geval
is er geen noodzaak om te gaan naar de Configuraties op de tab Authenticatie van Opties van QGIS, tenzĳ u meer
uitgebreid beheer van de configuraties wilt uitvoeren.

Fig. 24.7: DialoogvensterWMS-verbinding dat de knoppen voor configuratie voor authenticatieToevoegen,Bewerken,
en Verwijderen weergeeft
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Bĳ het maken of bewerken van een configuratie voor authenticatie, is de info die wordt vereist een naam, een
authenticatiemethode en elke andere info die nodig is voor de authenticatiemethode (vind meer over de beschikbare
typen authenticatie in Authenticatiemethoden).

24.1.4 Authenticatiemethoden

Beschikbare authenticaties worden verschaft door plug-ins voor C++ op nagenoeg dezelfde manier als dat plug-ins
voor gegevensproviders worden ondersteund door QGIS. De methode van authenticatie die kan worden geselecteerd
is relatief aan de toegang die wordt verleend voor de bron/provider, bĳv. HTTP(S) of database, en of er ondersteuning
is in zowel de code voor QGIS als een plug-in. Daarom zouden sommige plug-ins voor authenticatiemethoden niet
overal toegepast kunnen worden waar een selectie voor een configuratie voor authenticatie wordt weergegeven. Een
lĳst van beschikbare plug-ins voor authenticatiemethoden en hun compatibele bron/providers kan worden bereikt via
Extra ► Opties en, op de tab Authenticatie, klik op de knop Geïnstalleerde plug-ins.

Fig. 24.8: Lijst met beschikbare plug-ins voor methoden

Plug-ins kunnen worden gemaakt voor nieuwe authenticatiemethoden die geen QGIS nodig hebben om opnieuw
te worden gecompileerd. Omdat de ondersteuning voor plug-ins momenteel alleen C++ is, dient QGIS opnieuw te
worden opgestart om de nieuw geïnstalleerde plug-in beschikbaar te maken voor de gebruiker. Zorg er voor dat
uw plug-in is gecompileerd voor dezelfde doelversie van QGIS als u van plan bent om hem toe te voegen aan een
bestaande doelinstallatie.

Fig. 24.9: Configuraties voor basis HTTP-authenticatie
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Fig. 24.10: Configuraties authenticatie voor tokens van ESRI
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Fig. 24.11: Configuraties voor authenticatie voor OAuth2
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Fig. 24.12: Configuraties voor authenticatie PKI-paden

Fig. 24.13: Configuraties voor authenticatie PKI PKCS#12 bestandspaden

Fig. 24.14: Opgeslagen identiteit configuraties voor authenticatie

Notitie: De Bron-URL is momenteel een niet geïmplementeerde mogelĳkheid die er uiteindelĳk toe moet leiden dat
een bepaalde configuratie automatisch wordt gekozen bĳ het verbinden met bronnen op een opgegeven URL.
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24.1.5 Gereedschappen voor hoofdwachtwoord en configuratie voor
authenticatie

In het menu Opties (Extra ► Opties) op de tab Authenticatie, staan verschillende acties voor gereedschappen om de
authenticatiedatabase en de configuraties te beheren:

Fig. 24.15: menu Gereedschappen

• Hoofdwachtwoord invoeren: opent het dialoogvenster voor het invoeren van het hoofdwachtwoord,
onafhankelĳk van een opdracht voor de database voor authenticatie

• Hoofdwachtwoord uit cache verwĳderen: verwĳdert het hoofdwachtwoord als dat is ingesteld
• Hoofdwachtwoord opnieuw instellen: opent een dialoogvenster om het hoofdwachtwoord te wĳzigen (het
huidige hoofdwachtwoord moet bekend zĳn) en optioneel een back-up te maken van de huidige database

• Cache voor toegang netwerk authenticatie leegmaken: leegt de cache voor authenticatie van alle
verbindingen

• Automatisch cache voor toegang netwerk authenticatie bĳ fouten in SSL leegmaken: de cache voor de
verbinding slaat alle gegevens voor authenticatie voor verbindingen op, ook als de verbinding mislukt. Wanneer
u configuraties voor authenticatie of autoriteiten voor certificaten wĳzigt zou u de cache voor authenticatie leeg
moeten maken of QGIS opnieuw moeten starten. Als deze optie is geselecteerd zal de cache voor authenticatie
automatisch leeg worden gemaakt, elke keer als er een SSL-fout optreedt en u er voor kiest de verbinding af
te breken

• Hoofdwachtwoord integreren met uwWallet/Keyring: voegt het hoofdwachtwoord toe aan uw persoonlĳke
Wallet/Keyring

• Het hoofdwachtwoord opslaan/bĳwerken in uw Wallet/Keyring: werkt het gewĳzigde hoofdwachtwoord
bĳ in uw Wallet/Keyring

• Verwĳder het hoofdwachtwoord uit uw Wallet/Keyring: verwĳdert het hoofdwachtwoord uit uw
Wallet/Keyring

• Log voor hulp bĳ debuggen van wachtwoord inschakelen: schakelt een gereedschap voor debuggen in dat
alle informatie van het loggen zal bevatten van de methoden voor authenticatie

• Gecachete configuraties voor authenticatie verwĳderen: leegt de interne cache voor opzoeken van
configuraties gebruikt om netwerkverbindingen te versnellen. Dit schoont niet de beheerscache van het
bronnetwerk van QGIS op, die opnieuw starten van QGIS vereist.
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• Alle configuraties voor authenticatie verwĳderen: schoont de database van alle records voor configuratie,
zonder andere opgeslagen records te verwĳderen.

• Authenticatiedatabase wissen: maakt een taak aan voor een volledige back-up van de huidige database en een
volledige herbouw van de tabelstructuur van de database. De acties worden later gepland om er voor te zorgen
dat andere bewerkingen, zoals het laden van een project, de bewerking niet onderbreken of fouten veroorzaken
door een tĳdelĳk ontbrekende database.

Fig. 24.16: Verificatiemenu Database wissen

24.1.6 Configuratie voor authenticatie gebruiken

Gewoonlĳk wordt een configuratie voor authenticatie geselecteerd in een dialoogvenster voor configuratie van een
netwerkservice (zoals WMS). Echter, het widget voor selectie van de configuratie kan overal worden ingebed waar
authenticatie nodig is of in niet-bron functionaliteit, zoals in derde-partĳ PyQGIS of plug-ins voor C++.
Bĳ het gebruiken van de selectiemogelĳkheid wordt Geen authenticatie weergegeven in het besturingselement van
het pop-upmenu als niets is geselecteerd, wanneer er geen configuraties zĳn om uit te kiezen, of wanneer een eerder
toegewezen configuratie niet kan worden gevonden in de database. De velden Type en ID zĳn alleen-lezen en geven
respectievelĳk een beschrĳving van de authenticatiemethode en de ID van de configuratie.

Fig. 24.17: Selectie voor configuratie voor authenticatie zonder authenticatie

Fig. 24.18: Selectie voor configuratie voor authenticatie met geselecteerde configuratie
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24.1.7 Python-bindingen

Alle klassen en publieke functies hebben sip-bindingen, uitgezonderd QgsAuthCrypto, omdat beheer van het
hashen van het hoofdwachtwoord en encryptie van de authenticatiedatabase zouden moeten worden afgehandeld via
de hoofdtoepassing en niet via Python. Bekĳk Overwegingen voor beveiliging met betrekking tot toegang tot Python.

24.2 Werkstromen voor authenticatie van gebruikers

Fig. 24.19: Algemene werkstroom voor gerbuikers

24.2.1 HTTP(S)-authenticatie

Een van de meest voorkomende verbindingen naar bronnen is via HTTP(S), bĳv. servers voor webkaarten, en plug-ins
voor methoden van authenticatie werken vaak met deze typen verbindingen. Plug-ins voor methoden hebben toegang
tot het object HTTP request en kunnen zowel het request als de kopteksten daarvan manipuleren. Dit maakt vele
vormen van authenticatie op basis van internet mogelĳk. Wanneer wordt verbonden via HTTP(S) met behulp van
de standaardmethode authenticatie gebruikersnaam/wachtwoord zal bĳ het verbinden authenticatie HTTP BASIC
worden geprobeerd.
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Fig. 24.20: Een WMS-verbinding voor HTTP BASIC configureren

24.2.2 Database authenticatie

Verbindingen naar databasebronnen worden over het algemeen opgeslagen als paren sleutels=waarde, die
gebruikersnamen en (optioneel) wachtwoorden laten zien, indien geen configuratie voor authenticatie wordt gebruikt.
Bĳ het configureren met het systeem voor authenticatie, zal de sleutel=waarde een abstracte weergave zĳn van
de inloggegevens, bĳv. authfg=81t21b9.
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Fig. 24.21: Configureren van een verbinding Postgres SSL-met-PKI

24.2.3 PKI-authenticatie

Bĳ het configureren van componenten van PKI in het systeem van authenticatie moet u de optie hebben om
componenten te importeren in de database of te verwĳzen naar opgeslagen bestanden voor componenten op uw
bestandssysteem. Het laatste zou nuttig zĳn als dergelĳke componenten regelmatig wĳzigen, of als de componenten
zullen worden vervangen door een systeembeheerder. In elk geval zult u een wachtwoord moeten opslaan dat nodig
is om toegang te krĳgen tot private sleutels binnen de database.
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Fig. 24.22: Werkstroom voor configuratie PKI

Alle componenten voor PKI kunnen in afzonderlĳke bewerkers worden beheerd binnen Certificaten beheren, waar
toegang toe kan worden verkregen via de tab Authenticatie in QGIS, dialoogvenster Opties (Extra ► Opties) door te
klikken op de knop Certificaten beheren.
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Fig. 24.23: Certificaten beheren openen

In Certificaten beheren, staan bewerkers voor Identiteiten, Servers en Autoriteiten. Elk hiervan is opgenomen in
zĳn eigen tab, en ze worden hieronder beschreven in de volgorde waarin zĳ worden tegengekomen in de kaart voor
de werkstroom hierboven. De volgorde van de tabs is relatief aan frequent gebruikte bewerkers als u eenmaal gewend
bent aan de werkstroom.

Notitie: Het is niet noodzakelĳk om in het dialoogvenster Opties op de knop OK te drukken voor het opslaan van
de wĳzigingen, omdat alle bewerkingen aan het systeem voor authenticatie direct naar de database voor authenticatie
worden geschreven. Dit wĳkt af van andere instellingen in het dialoogvenster Opties.

Autoriteiten

U kunt beschikbare Certificaat Autoriteiten (CA’s) beheren op de tab Autoriteiten in Certificaten beheren op de
tab Authenticatie van het dialoogvenster Opties van QGIS.
Zoals weergegeven in de kaart voor de werkstroom hierboven is de eerste stap om een bestand van CA’s te importeren
of naar te verwĳzen. Deze stap is optioneel en zou niet nodig hoeven te zĳn als uw vertrouwde ketens voor PKI hun
origine vinden in bron-CA’s die al zĳn geïnstalleerd op uw besturingssysteem (OS), zoals een certificaat van een
commerciële verkoper van certificaten. Indien uw authenticerende bron-CA niet in de door het besturingssysteem
vertrouwde bron-CA’s staat, zal het geïmporteerd moeten worden of een verwĳzing moeten krĳgen naar het pad van
het bestandssysteem. (Neem contact op met uw systeembeheerder als u niet zeker bent.)
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Fig. 24.24: Bewerker voor autoriteiten

Standaard zĳn de bron-CA’s van uw besturingssysteem beschikbaar; echter, hun instellingen voor vertrouwen worden
niet geërfd. U zou de instellingen van het beleid voor het vertrouwen van certificaten opnieuw moeten bekĳken, in
het bĳzonder als het beleid van de bron-CA’s van uw besturingssysteem is aangepast. Elk certificaat dat is verlopen
zal worden ingesteld op niet te vertrouwen en zal niet worden gebruikt in verbindingen naar een beveiligde server,
tenzĳ u specifiek het beleid voor vertrouwen overschrĳft. Selecteer het en klik op Informatie over certificaat weergeven om
de door QGIS te ontdekken te vertrouwen keten voor een certificaat te bekĳken.
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Fig. 24.25: Dialoogvenster Informatie over certificaat

U kunt Vertrouwensbeleid voor elk geselecteerd certificaat binnen de keten bewerken. Elke wĳziging in het
beleid voor vertrouwen voor een geselecteerd certificaat zal niet in de database worden opgeslagen, tenzĳ op de knop

Wĳziging van certificaat vertrouwensbeleid in database opslaan is geklikt per geselecteerd certificaat. Sluiten van het dialoogvenster
zal de wĳzigingen in het beleid niet doorvoeren.

Fig. 24.26: De wijzigingen van vertrouwensbeleid opslaan

U kunt de gefilterde CA’s bekĳken, zowel tussenliggende als broncertificaten, die zullen worden vertrouwd voor
beveiligde verbindingen of het standaard beleid voor vertrouwen wĳzigen door te klikken op de knop Opties.

Waarschuwing: Wĳzigen van het standaardbeleid voor vertrouwen zou kunnen resulteren in problemen met
beveiligde verbindingen.
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Fig. 24.27: Menu Opties voor autoriteiten

U kunt CA’s importeren of een pad voor het bestandssysteem opslaan naar een bestand dat meerdere CA’s bevat,
of individuele CA’s importeren. De standaardindeling PEM voor bestanden die meerdere keten certificaten voor
meerdere CA’s bevatten heeft het broncertificaat onder in het bestand staan en alle opvolgende ondertekende
kindcertificaten daarboven, naar het begin van het bestand.
Het dialoogvenster voor het importeren van certificaten van CA’s zal alle CA-certificaten in het bestand vinden,
ongeacht de volgorde, en ook de optie bieden om certificaten te importeren die als ongeldig worden beschouwd (voor
het geval u hun beleid voor vertrouwen wilt overschrĳven). U kunt het beleid voor vertrouwen overschrĳven bĳ het
importeren, of dat later doen met de bewerker voor Autoriteiten.

Fig. 24.28: Dialoogvenster Certificaten importeren

Notitie: Indien u informatie over het certificaat plakt in het veld PEM-tekst, onthoud dan dat versleutelde certificaten
niet worden ondersteund.

Identiteiten

U kunt de beschikbare bundels met identiteiten voor cliënten beheren vanaf de tab Identiteiten in Certificaten beheren
op de tab Authenticatie van het dialoogvenster Opties van QGIS. Een identiteit is wat u authenticeert voor een
PKI-ingeschakelde service en bestaat gewoonlĳk uit een certificaat voor een cliënt en een persoonlĳke sleutel, ofwel
als afzonderlĳke bestanden of gecombineerd in één enkel “gebundeld” bestand. De bundel of persoonlĳke sleutel is
vaak beveiligd met een wachtwoord.
Als u eenmaal enkele Certificaat Autoriteiten (CA’s) hebt geïmporteerd kunt u optioneel enige identiteitsbundels in
de database voor authenticatie importeren. Als u de identiteiten niet wilt opslaan, kunt u naar de paden voor het
bestandssysteem voor hun componenten verwĳzen met een individuele configuratie voor authenticatie.

24.2. Werkstromen voor authenticatie van gebruikers 863



QGIS Desktop 3.28 User Guide

Fig. 24.29: Bewerker Identiteiten

Bĳ het importeren van een identiteitsbundel, mag die beveiligd zĳnmet een wachtwoord of niet beveiligd, en mag CA-
certificaten bevatten die een keten van vertrouwen vormen. Vertrouwde ketencertificaten zullen hier niet geïmporteerd
worden; zĳ kunnen afzonderlĳk worden toegevoegd onder de tab Autoriteiten.
Bĳ het importeren zullen het certificaat van de bundel en de persoonlĳke sleutel worden opgeslagen in de database,
met de opslag van de sleutel versleuteld met behulp van het hoofdwachtwoord van QGIS. Volgend gebruik van de
opgeslagen bundel uit de database zal alleen het invoeren van het hoofdwachtwoord vergen.
Persoonlĳke identiteitsbundels, bestaande uit PEM/DER (.pem/.der) en PKCS#12 (.p12/.pfx) componenten, worden
ondersteund. Als een sleutel of bundel met een wachtwoord is beveiligd, zal het wachtwoord nodig zĳn om,
voorafgaande aan het importeren, de component te valideren. Idem, als het certificaat van de cliënt in de bundel
ongeldig is (bĳvoorbeeld omdat de geldigheidsdatum nog niet is begonnen of is verlopen) kan de bundel niet worden
geïmporteerd.

Fig. 24.30: PEM/DER identiteit importeren
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Fig. 24.31: PKCS#12 identiteit importeren

24.2.4 Probleemlagen afhandelen

Af en toe komt het voor dat de ID voor de configuratie voor de authenticatie, die werd opgeslagen in een
projectbestand, niet langer geldig is, mogelĳk omdat de huidige database voor authenticatie anders is dan toen het
project voor het laatst werd opgeslagen, of vanwege het niet overeenkomen van de inloggegevens. In dergelĳke gevallen
zal het dialoogvenster Probleemlagen afhandelen worden weergegeven bĳ het opstarten van QGIS.

Fig. 24.32: Probleemlagen met authenticatie afhandelen

Als een gegevensbron wordt gevonden met daaraan een ID voor een configuratie voor authenticatie geassocieerd,
zult u in staat zĳn het te bewerken. Door dat te doen zal automatisch de tekenreeks van de gegevensbron worden
bewerkt, nagenoeg op dezelfde manier als het openen van het projectbestand in een tekstverwerker en de tekenreeks
te bewerken.
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Fig. 24.33: Probleemlagen ID voor configuratie van authenticatie bewerken

24.2.5 Configuratie voor authenticatie ID wijzigen

Af en toe zult u het ID voor de configuratie van authenticatie die is geassocieerd met toegang tot een bron moeten
wĳzigen. Er zĳn gevallen wanneer dit nuttig is:

• Bron voor ID configuratie van authenticatie is niet langer geldig: Dit kan voorkomen als u gewisseld
bent van database voor authenticatie en een nieuwe configuratie voor de ID moet uitlĳnen voor de ID die al
geassocieerd is met een bron.

• Gedeelde projectbestanden: Als u van plan bent projecten te delen met andere gebruikers, bĳv. via een server
met gedeelde bestanden, kunt u een tekenreeks met 7 tekens vooraf definiëren (die a-z en/of 0-9 bevat) die is
geassocieerd met de bron. Daarna wĳzigen individuele gebruikers de ID van een configuratie van authenticatie
die specifiek is voor hun inloggegevens. Als het project wordt geopend, wordt de ID gevonden in de database
voor authenticatie, maar de inloggegevens verschillen per gebruiker.

Fig. 24.34: Een ID voor configuratie voor authenticatie wijzigen (niet vastgezet geel tekstveld)
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Waarschuwing: Wĳzigen van de ID voor configuratie van authenticatie wordt beschouwd als een geavanceerde
bewerking en zou alleen moeten worden uitgevoerd als de volledige kennis aanwezig is voor het waarom het nodig
is. Dat is waarom er een knop voor vastzetten is waarop moet worden geklikt, om het tekstveld van de ID los te
maken, voorafgaande aan het bewerken van de ID.

24.2.6 QGIS Server ondersteuning

Bĳ het gebruiken van een projectbestand, met lagen die configuraties voor authenticatie hebben, als basis voor een
kaart in QGIS Server, zĳn er een aantal aanvullende stappen voor instellen noodzakelĳk voor QGIS om de bronnen
te laden:

• Database voor authenticatie moet beschikbaar zĳn
• Hoofdwachtwoord voor database voor authenticatie moet beschikbaar zĳn

Bĳ het instantiëren van het systeem voor authenticatie zal Server het bestand qgis-auth.db in het actieve
gebruikersprofiel, of de map die is gedefinieerd in de omgevingsvariabele QGIS_AUTH_DB_DIR_PATH, maken
of gebruiken. Het kan zĳn dat de gebruiker van Server geen map HOME heeft, in welk geval, de omgevingsvariabele
wordt gebruikt om een map te definiëren waar de gebruiker lees/schrĳf-rechten heeft en die niet is gelegen in de
vanaf het web toegankelĳke mappen.
Schrĳf, om het hoofdwachtwoord door te kunnen geven aan Server, het in de eerste regel van een bestand op het
pad van het bestandssysteem dat is te lezen door de gebruiker van de processen van Server en wordt gedefinieerd
met behulp van de omgevingsvariabele QGIS_AUTH_PASSWORD_FILE. Zorg er voor het bestand te beperken tot
alleen te lezen door de gebruiker van de processen van Server en sla het bestand niet op in mappen die toegankelĳk
zĳn vanaf het web.

Notitie: De variabele QGIS_AUTH_PASSWORD_FILE wordt direct uit de omgeving van Server verwĳderd nadat
toegang is verleend

24.2.7 SSL server uitzonderingen

Fig. 24.35: SSL server uitzondering

U kunt de configuraties en uitzonderingen van SSL-server beheren vanaf de tab Servers in het gedeelteAuthenticatie
van het dialoogvenster Opties in QGIS.
Soms, tĳdens het verbinden met een SSL-server, zĳn er fouten met de SSL “handshake” of het certificaat van de
server. U kunt deze fouten negeren of een configuratie voor een SSL-server maken als uitzondering. Dit is soortgelĳk
aan hoe webbrowsers u toestaan fouten van SSL te overschrĳven, maar met een meer fĳner beheer.
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Waarschuwing: U zou geen configuratie voor een SSL-server moeten maken, tenzĳ u de volledige kennis heeft
van de gehele instelling van SSL tussen de server en de cliënt. Rapporteer in plaats daarvan het probleem bĳ de
beheerder van de server.

Notitie: Sommige instellingen van PKI gebruiken een volledige andere keten van vertrouwen van CA’s dan de keten
die wordt gebruikt om het certificaat van de SSL-server te valideren. Onder dergelĳke omstandigheden zal niet elke
gemaakte configuratie voor de verbindende server noodzakelĳkerwĳze een probleemmet de validatie van de identiteit
van uw cliënt oplossen, en alleen de uitgever van de identiteit van uw cliënt of de beheerder van de server kunnen het
probleem oplossen.

U kunt vooraf een configuratie voor een SSL-server configureren door te klikken op de knop . Als alternatief
kunt u een configuratie toevoegen als een SSL-fout optreedt gedurende een verbinding en u wordt geconfronteerd
met een dialoogvenster SSL Error (waar de fout tĳdelĳk kan worden genegeerd of kan worden opgeslagen naar de
database en genegeerd):

Fig. 24.36: Handmatig configuratie toevoegen
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Fig. 24.37: Configuratie gedurende SSL-fout toevoegen

Als een SSL-configuratie eenmaal is opgeslagen in de database, kan die worden bewerkt of verwĳderd.

Fig. 24.38: Bestaande configuratie SSL
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Fig. 24.39: Een bestaande SSL-configuratie bewerken

Als u vooraf een SSL-configuratie wilt configureren en het dialoogvenster voor importeren werkt niet voor de
verbinding van uw server, kunt u handmatig een verbinding activeren via de Python Console door de volgende
code uit te voeren (vervang https://bugreports.qt-project.org door de URL van uw server):

from qgis.PyQt.QtNetwork import QNetworkRequest
from qgis.PyQt.QtCore import QUrl
from qgis.core import QgsNetworkAccessManager

req = QNetworkRequest(QUrl('https://bugreports.qt-project.org'))
reply = QgsNetworkAccessManager.instance().get(req)

Dit zal een dialoogvenster voor SSL-fouten openen als er een fout optreedt, waar u er voor kunt kiezen de configuratie
op te slaan naar de database.

24.3 Overwegingen voor beveiliging

Als het hoofdwachtwoord eenmaal is ingevoerd, is de API geopend om toegang te verkrĳgen voor de configuraties
voor authenticatie in de database voor authenticatie, soort gelĳk aan de manier waarop Firefox werkt. Echter, in de
initiële implementatie, is geen muur tegen toegang door PyQGIS gedefinieerd. Dit kan leiden tot problemen als een
gebruiker een schadelĳke plug-in of zelfstandige toepassing voor PyQGIS downloadt/installeert, die toegang verkrĳgt
tot gegevens voor authenticatie.
De snelle oplossing voor de initiële uitgave van deze mogelĳkheid is om gewoonweg niet de meeste bindingen voor
PyQGIS voor het systeem van authenticatie op te nemen.
Een andere eenvoudige, maar niet robuuste, reparatie is om een combinatievak toe te voegen in Extra ► Opties ►
Authenticatie (standaard “nooit”):

"Allow Python access to authentication system"
Choices: [ confirm once per session | always confirm | always allow | never]

Een dergelĳke instelling voor een optie zou moeten worden opgeslagen op een locatie die niet toegankelĳk is voor
Python, bĳv. de database voor authenticatie, en moeten zĳn versleuteld met het hoofdwachtwoord.

• Een andere optie zou kunnen zĳn na te gaan welke plug-ins de gebruikers specifiek heeft
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• toegestaan om toegang te verkrĳgen tot het systeem voor authenticatie, hoewel het gevaarlĳk kan zĳn om te
bepalen welke plug-in in feite de aanroep doet.

• Testen van plug-ins in een zandbak, mogelĳkerwĳze in hun eigen virtuele omgevingen, zou hacken via ‘cross-
plugin’ van configuraties voor authenticatie vanuit een andere plug-in die wel is geautoriseerd kunnen reduceren.
Dit zou zou ook de communicatie tussen plug-ins kunnen beperken, maar misschien alleen tussen plug-ins van
derde partĳen.

• Een andere goede oplossing is om gecodeerde certificaten uit te geven aan betrouwbare auteurs van plug-ins.
Daarna het certificaat te valideren bĳ het laden van de plug-in. Indien nodig zou de gebruiker ook direct een
beleid voor niet vertrouwd kunnen instellen voor het certificaat dat is geassocieerd met de plug-in met behulp
van bestaande dialoogvensters voor het beheren van certificaten.

• Als alternatief, toegang tot gevoelige gegevens in het systeem voor authenticatie vanuit Python
• kan nooit worden toegestaan, en alleen het gebruiken van bronwidgets van QGIS, of het dupliceren van
integraties voor het systeem van authenticatie, zou de plug-in toestaan om te werken met bronnen die een
configuratie voor authenticatie hebben, terwĳl het hoofdwachtwoord en de configuratie voor authenticatie
worden geladen in het gebied van de hoofdtoepassing.

Dezelfde beveiligingsoverwegingen bestaan voor plug-ins van C++, hoewel het moeilĳker zal zĳn om toegang te
beperken, omdat er geen binding voor functies is die eenvoudigweg kan worden verwĳderd, zoals met Python.

24.3.1 Beperkingen

De verwarrende problemen voor licensering en exporteren die zĳn geassocieerd met OpenSSL zĳn van toepassing.
Om Qt te kunnen laten werken met certificaten van SSL, heeft het toegang nodig tot de bibliotheken van OpenSSL.
Afhankelĳk van hoe Qt werd gecompileerd, is de standaard om dynamisch te koppelen naar de bibliotheken van
OpenSSL tĳdens run-time (om beperkingen voor exporteren te vermĳden).
QCA volgt een soortgelĳke tactiek, waarbĳ koppelen naar QCA geen beperkingen ophaalt, omdat de plug-in qca-
ossl (OpenSSL) gedurende run-time wordt geladen. De plug-in qca-ossl is direct gekoppeld aan de bibliotheken van
OpenSSL. Verpakkers zouden degenen moeten zĳn die er voor zorgen dat aan de beperkingen voor koppelen naar
OpenSSL wordt voldaan, als zĳ de plug-in distribueren. Misschien. Ik weet het echt niet. Ik ben geen jurist.
Het systeem voor authenticatie schakelt zichzelf veiligheidshalve uit indien qca-ossl niet wordt gevonden
gedurende run-time.
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Integratie van GRASS GIS

Integreren van GRASS verschaft toegang tot databases van GRASS GIS en functionaliteiten (zie GRASS-PROJECT
in Verwĳzingen naar literatuur en web). De integratie bestaat uit twee delen: provider en plug-in. De provider maakt
het mogelĳk GRASS vector- en rasterlagen door te bladeren, te beheren en te visualiseren. De plug-in kan worden
gebruikt om nieuwe locaties en mapsets voor GRASS te maken, GRASS regio te wĳzigen,vectorlagen te maken en te
bewerken en gegevens in GRASS 2-D en 3-D te analyseren met meer dan 400 modules voor GRASS. In dit gedeelte
zullen we de functionaliteiten van de provider en de plug-in behandelen en enkele voorbeelden geven van het beheren
van en werken met gegevens van GRASS.
De provider ondersteunt de versies van GRASS 6 en 7, de plug-in ondersteunt GRASS 6 en 7 (vanaf QGIS 2.12). De
distributie van QGIS kan ofwel de provider/plug-in voor GRASS 6 of GRASS 7 bevatten of beide versies tegelĳkertĳd
(binaries hebben andere bestandsnamen). In runtime kan echter slechts één versie van de provider/plug-in worden
geladen.

25.1 Demo gegevensset

Als voorbeeld zullen we de voorbeeld gegevensset van Alaska voor QGIS gebruiken (zie gedeelte Voorbeeldgegevens
downloaden). Het bevat een klein voorbeeld van een GRASS LOCATION met drie vectorlagen en
één raster hoogtekaart. Maak een nieuwe map genaamd grassdata, download de gegevensset ‘Alaska’
qgis_sample_data.zip voor QGIS vanaf https://qgis.org/downloads/data/ en pak het bestand uit in
grassdata.
Meer voorbeelden voor LOCATION's van GRASS zĳn beschikbaar op de website van GRASS op https://grass.
osgeo.org/download/data/.
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25.2 GRASS raster- en vectorlagen laden

Als de provider is geladen in QGIS, wordt het item voor de locatie met het pictogram voor GRASS toegevoegd in
de boom van de browser onder elk item van de map dat een locatie voor GRASS bevat. Ga naar de map grassdata
en vergroot de locatie alaska en de mapset demo.
U kunt raster- en vectorlagen voor GRASS net als elke andere laag openen vanuit de browser door te dubbelklikken
op een laagitem of door het te slepen en neer te zetten in het kaartvenster of de legenda.

Tip: GRASS–Laden van gegevens
Als u het item voor de locatie van GRASS niet ziet, verifieer dan in Help ► Info ► Providers of de GRASS vector
provider is geladen.

25.3 Importeren van gegevens in een GRASS LOCATION via
slepen en neerzetten

Dit gedeelte geeft een voorbeeld van hoe gegevens voor raster en vector te importeren in een mapset van GRASS.
1. Navigeer in de browser van QGIS naar de mapset waarin u gegevens wilt importeren.
2. Zoek in de browser van QGIS naar een laag die u wilt importeren in GRASS, onthoud dat u een andere instantie

van de browser (Paneel Browser (2)) kunt openen als de brongegevens te ver van de mapset in de boom staan.
3. Sleep een laag en zet die in de doel-mapset. Het importeren kan enige tĳd vergen voor grote lagen, u zult een

geanimeerd pictogram zien vóór het item van de nieuwe laag totdat de import is voltooid.
Waar rastergegevens in een ander CRS staan, kunnen zĳ opnieuw worden geprojecteerd met behulp van een
transformatieApproximate (fast) of Exact (precise). Als een koppeling naar het bronraster wordt gemaakt (met behulp
van r.external ), de brongegevens in hetzelfde CRS staan en de indeling bekend is bĳ GDAL, zal het CRS van
de brongegevens worden gebruikt. U kunt deze opties instellen op de tab Browser in GRASS Opties.
Als een bronraster meerdere banden heeft, wordt een nieuwe kaart voor GRASS gemaakt voor elke laag met het

achtervoegsel .<band nummer> en een pictogram voor een groep van alle mappen. Externe rasters hebben een

afwĳkend pictogram .

25.4 Gegevens voor GRASS beheren in QGIS Browser

• Kaarten kopiëren: Kaarten voor GRASS kunnen tussen mapsets op dezelfde locatie worden gekopieerd met
behulp van slepen en neerzetten.

• Kaarten verwĳderen: Klik met rechts op een kaart voor GRASS en selecteer Delete uit het contextmenu.
• Kaarten hernoemen: Klik met rechts op een kaart voor GRASS en selecteer Rename uit het contextmenu.
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25.5 GRASS Opties

Opties voor GRASS kunnen worden ingesteld in het dialoogvenster GRASS Options, dat kan worden geopend door
met rechts te klikken op het item voor de locatie of mapset in de browser en dan te kiezen GRASS Options.

25.6 De plug-in GRASS starten

Umoet de plug-in GRASS selecteren en ladenmet Plug-ins beheren en installeren om de functionaliteiten van GRASS
te kunnen gebruiken in QGIS. Ga daarom naar het menu Plug-ins ► Plug-ins beheren en installeren…, selecteer

GRASS en klik op OK.
De volgende belangrĳkste mogelĳkheden worden verschaft in het menu GRASS (Plug-ins► GRASS) als u de plug-in
GRASS start:

• Mapset openen

• Nieuwe Mapset

• Mapset sluiten

• GRASS-gereedschap openen

• Huidige GRASS-regio weergeven

• GRASS opties

25.7 GRASS mapset openen

Een mapset voor GRASS moet zĳn geopend om toegang te krĳgen tot de gereedschappen van GRASS in de plug-in
(de gereedschappen zĳn uitgeschakeld als er geen mapset is geopend). U kunt een mapset vanuit de browser openen:
klik met rechts op het item van de mapset en kies dan Mapset openen uit het contextmenu.

25.8 GRASS LOCATION en MAPSET

Gegevens voor GRASS worden opgeslagen in een map waarnaar wordt verwezen als GISDBASE. Deze map, vaak
grassdata genaamd, moet worden gemaakt vóórdat u met de plug-in GRASS gaat werken in QGIS. Binnen
deze map zĳn de GIS-gegevens van GRASS georganiseerd in projecten die zĳn opgeslagen in submappen, genaamd
LOCATION's. Elke LOCATION wordt gedefinieerd door zĳn coördinatensysteem, kaartprojectie en geografische
grenzen. Elke LOCATION kan verscheidene MAPSET's (submappen van LOCATION) hebben, die worden gebruikt
om het project op te delen in verschillende onderwerpen of subregio’s, of als werkruimte voor individuele teamleden
(zie Neteler & Mitasova 2008 in Verwĳzingen naar literatuur en web). Over het algemeen moet u, om vector- en
rasterlagen met modules van GRASS te analyseren, ze importeren in een GRASS LOCATION. (Dit is niet helemaal
waar – met de modules voor GRASS r.external en v.external kunt u koppelingen maken die alleen-lezen
zĳn naar externe gegevenssets, die door GDAL/OGR ondersteund worden, zonder ze te importeren. Dit is echter niet
de normale manier voor beginners om te werken met GRASS, en daarom zal deze functionaliteit hier niet worden
beschreven.)
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Fig. 25.1: Gegevens voor GRASS op de LOCATION alaska

25.9 Importeren van gegevens in een GRASS LOCATION

Bekĳk het gedeelte Importeren van gegevens in een GRASS LOCATION via slepen en neerzetten om uit te vinden hoe
gegevens eenvoudig kunnen worden geïmporteerd door te slepen en neer te zetten in de browser.
Dit gedeelte geeft een voorbeeld van hoe raster- en vectorgegevens te importeren in de ‘alaska’ GRASS LOCATION
verschaft door de gegevensset ‘Alaska’ van QGIS. Daarom gebruiken we de rasterkaart voor landbedekking
landcover.img en het vector GML-bestand lakes.gml uit de gegevensset ‘Alaska’ van QGIS (zie
Voorbeeldgegevens downloaden).

1. Start QGIS en zorg er voor dat de plug-in GRASS is geladen.

2. Klik, op de werkbalk van GRASS, op het pictogram Mapset openen om de assistent MAPSET te laten zien.
3. Selecteer als database van GRASS de map grassdata in de gegevensset Alaska van QGIS, als LOCATION

‘alaska’, als MAPSET ‘demo’ en klik op OK.

4. Klik nu op het pictogram GRASS–gereedschap openen. Het dialoogvenster van de Toolbox van GRASS (zie
gedeelte De Toolbox voor GRASS) verschĳnt.

5. Klik op de module r.in.gdal op de tab Modulen Boom om de rasterkaart landcover.img te
importeren. Deze module voor GRASS stelt u in staat GDAL-ondersteunde rasterbestanden te importeren
in een LOCATION van GRASS. Het dialoogvenster voor de module r.in.gdal verschĳnt.

6. Blader naar demapraster in de gegevensset ‘Alaska’ van QGIS en selecteer het bestandlandcover.img.
7. Definieer, als naam voor het uitvoer rasterbestand, landcover_grass en klik op Uitvoeren. Op de tab

Output ziet u de momenteel uitgevoerde opdracht voor GRASS r.in.gdal -o input=/pad/naar/
landcover.img output=landcover_grass.

8. Klik, wanneer het zegt Met succes voltooid, op Uitvoer bekĳken. De rasterlaag landcover_grass is nu
geïmporteerd in GRASS en zal worden gevisualiseerd in het kaartvenster van QGIS.

9. Klik op de module v.in.ogr op de tab Modulen Boom om het vector GML-bestand lakes.gml te
importeren. Deze module voor GRASS stelt u in staat OGR-ondersteunde vectorbestanden te importeren in
een LOCATION van GRASS. Het dialoogvenster voor de module v.in.ogr verschĳnt.

10. Blader naar de map gml in de gegevensset ‘Alaska’ van QGIS en selecteer het bestand lakes.gml als OGR-
bestand.

11. Definieer, als naam voor het uitvoer vectorbestand, lakes_grass en klik op Uitvoeren. U hoeft zich in dit
voorbeeld geen zorgen te maken over de andere opties. Op de tab Output ziet u de momenteel uitgevoerde
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opdracht van GRASS v.in.ogr -o dsn=/pad/naar/lakes.gml output=lakes\_grass.
12. Klik, wanneer het zegt Met succes voltooid, op Uitvoer bekĳken. De vectorlaag lakes_grass is nu

geïmporteerd in GRASS en zal worden gevisualiseerd in het kaartvenster van QGIS.

25.9.1 Maken van een nieuwe GRASS LOCATION

Als voorbeeld is hier het voorbeeld GRASS LOCATION alaska, wat is geprojecteerd in de projectie Albers Equal
Area met behulp van feet als eenheid. Dit voorbeeld GRASS LOCATION alaska zal worden gebruikt voor alle
voorbeelden en oefeningen in de volgende aan GRASS gerelateerde gedeelten. Het is nuttig om de gegevensset naar
uw computer te downloaden en te installeren (zie Voorbeeldgegevens downloaden).

1. Start QGIS en zorg er voor dat de plug-in GRASS is geladen.
2. Visualiseer het shapefile alaska.shp (zie gedeelte Een laag uit een bestand laden) uit de gegevensset Alaska

van QGIS (zie Voorbeeldgegevens downloaden).

3. Klik, op de werkbalk van GRASS, op het pictogram Nieuwe mapset om de assistent MAPSET te laten
verschĳnen.

4. Selecteer een bestaande GRASS-database (GISDBASE) map grassdata, of maak een nieuwe LOCATION
met behulp van een bestandsbeheerder op uw computer. Klik dan op Next.

5. We kunnen deze assistent gebruiken om een nieuwe MAPSET binnen een bestaande LOCATION te maken (zie
het gedeelte Toevoegen van een nieuwe MAPSET) of om een geheel nieuwe LOCATION te maken. Selecteer

Nieuwe locatie maken (zie Fig. 25.2).
6. Voer een naam in voor de LOCATION – wĳ gebruikten ‘alaska’ – en klik op Next.

7. Definieer de projectie door te klikken op de optieknop Projectie om de lĳst met projecties in te schakelen.
8. We gebruiken de projectie Albers Equal Area Alaska (feet). Omdat wĳ weten dat die wordt weergegeven door

de EPSG ID 2964, voeren we die in het zoekvak in. (Opmerking: Als u dit proces wilt herhalen voor een andere
LOCATION en projectie en vergeten bent het EPSG ID te onthouden, klik op het pictogram CRS Status in
de rechterbenedenhoek van de statusbalk (zie gedeelteWerken met projecties)).

9. In Filter, voer 2964 in om de projectie te selecteren.
10. Klik op Next.
11. We moeten de grenzen voor de LOCATION in de richtingen Noord, Zuid, Oost en West invoeren, om de

standaardregio te definiëren. Hier klikken we eenvoudigweg op de knop Gebruik huidige QGIS -bereik, om het
bereik van de geladen laag alaska.shp als bereik voor de standaard regio in GRASS toe te passen.

12. Klik op Next.
13. We moeten ook een MAPSET definiëren binnen onze nieuwe LOCATION (dit is nodig bĳ het maken van een

nieuwe LOCATION). U mag het de naam geven die u wilt - wĳ gebruikten ‘demo’. GRASS maakt automatisch
een speciale MAPSET, genaamd PERMANENT, ontworpen om de brongegevens voor het project op te slaan,
het standaard ruimtelĳke bereik en de definities van het coördinatensysteem (zie Neteler & Mitasova 2008 in
Verwĳzingen naar literatuur en web).

14. Controleer de samenvatting om te zien of die juist is en klik op Finish.
15. De nieuwe LOCATION, ‘alaska’, en de twee MAPSETs, ‘demo’ en ‘PERMANENT’, zĳn gemaakt. De

momenteel geopende werkset is ‘demo’, zoals u heeft gedefinieerd.
16. Merk op dat enkele gereedschappen op de werkbalk vanGRASS, die uitgeschakeld waren, nu zĳn ingeschakeld.
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Fig. 25.2: Een nieuwe GRASS LOCATION of een nieuwe MAPSET in QGIS maken

Als dat veel stappen lĳken te zĳn, het is eigenlĳk niet zo slecht en een hele snelle manier om een LOCATION te
maken. De LOCATION ‘alaska’ is nu gereed voor het importeren van gegevens (zie gedeelte Importeren van gegevens
in een GRASS LOCATION). U kunt ook de reeds bestaande vector- en rastergegevens gebruiken uit het voorbeeld van
GRASS LOCATION ‘alaska’, opgenomen in de gegevensset ‘Alaska’ van QGIS Voorbeeldgegevens downloaden, en
doorgaan naar het gedeelte Het GRASS vectorgegevensmodel.

25.9.2 Toevoegen van een nieuwe MAPSET

Een gebruiker heeft alleen schrĳfrechten voor een MAPSET van GRASS die hĳ of zĳ zelf heeft gemaakt. Dit betekent
dat, naast toegang tot uw eigen MAPSET, u mappen in MAPSET's van andere gebruikers kunt lezen (en zĳ kunnen
die van u lezen), maar u kunt alleen mappen aanpassen of verwĳderen vanuit uw eigen MAPSET.
Alle MAPSET's bevatten een bestand WIND dat de huidige waarden voor coördinaten voor de grenzen opslaat en
de huidige geselecteerd rasterresolutie (zie Neteler & Mitasova 2008 in Verwĳzingen naar literatuur en web, en het
gedeelte Het GRASS–gereedschap regio).

1. Start QGIS en zorg er voor dat de plug-in GRASS is geladen.

2. Klik, op de werkbalk van GRASS, op het pictogram Nieuwe mapset om de assistent MAPSET te laten
verschĳnen.

3. Selecteer de GRASS database (GISDBASE)-map grassdatamet de LOCATION ‘alaska’, waar we nog een
MAPSET zullen toevoegen, genaamd ‘test’.

4. Klik op Next.
5. We kunnen deze assistent gebruiken om een nieuwe MAPSET binnen een bestaande LOCATION te maken of

om een geheel nieuwe LOCATION te maken. Klik op de optieknop Selecteer een locatie (zie Fig. 25.2) en
klik op Next.

6. Voer de naamtest in voor de nieuweMAPSET. Onder in de assistent ziet u een lĳst van bestaandeMAPSET's
en corresponderende eigenaren.

7. Klik op Next, controleer de samenvatting om te zien of die juist is en klik op Finish.
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25.10 Het GRASS vectorgegevensmodel

Het is belangrĳk om het GRASS vectorgegevensmodel te begrĳpen, voorafgaande aan het digitaliseren. In het
algemeen gebruikt GRASS een topologisch vectormodel. Dit betekent dat gebieden niet worden weergegeven als
gesloten polygonen, maar door één of meer grenzen. Een grens tussen twee aaneengesloten gebieden wordt slechts
één keer gedigitaliseerd, en het wordt gedeeld door beide gebieden. Grenzen moeten zĳn verbonden en zonder gaten
zĳn gesloten. Een gebied wordt geïdentificeerd (en gelabeld) door het zwaartepunt van het gebied.
Naast grenzen en zwaartepunten kan een vectorkaart ook punten en lĳnen bevatten. Al deze elementen voor geometrie
kunnen worden gemixt in één vector en zullen worden weergegeven in verschillende, zogenaamde ‘lagen’, binnen
één vectorkaart van GRASS. Dus in GRASS, is een laag geen vector- of rasterkaart, maar een niveau binnen een
vectorlaag. Het is belangrĳk om dit verschil zorgvuldig te onderscheiden. (Hoewel het mogelĳk is om elementen
voor geometrie te mixen, het is ongebruikelĳk en, zelfs in GRASS, alleen gebruikt in speciale gevallen, zoals vector
netwerkanalyses. Normaal gesproken zou u de voorkeur hebben voor het opslaan van verschillende elementen voor
geometrie in verschillende lagen.)
Het is mogelĳk om verscheidene ‘lagen’ op te slaan in één vector-gegevensset. Bĳvoorbeeld: velden, bossen en meren
kunnen worden opgeslagen in één vector. Een aansluitend bos en meer kunnen dezelfde grens delen, maar zĳ hebben
afzonderlĳk attributentabellen. Het is ook mogelĳk attributen te verbinden aan grenzen. Een voorbeeld zou kunnen
zĳn het geval waar de grens tussen een meer en een bos een weg is, dus kan het een verschillende attributentabel
hebben.
De ‘laag’ van het object wordt gedefinieerd door de ‘laag’ binnen GRASS. ‘Laag’ is het getal dat definieert of er meer
dan één laag binnen de gegevensset is (bĳv. als de geometrie bos of meer is). Momenteel mag het alleen een getal
zĳn. In de toekomst zal GRASS ook namen als velden in de gebruikersinterface ondersteunen.
Attributen kunnen binnen de LOCATION van GRASS worden opgeslagen als dBase, SQLite3 of in externe
databasetabellen, bĳvoorbeeld PostgreSQL, MySQL, Oracle, etc.
Attributen in databasetabellen worden aan elementen van geometrie gekoppeld door middel van een waarde
‘categorie’.
‘Category’ (sleutel, ID) is een integer die is verbonden met geometrie-primitieven, en het wordt gebruikt als de
koppeling naar één sleutelkolom in de databasetabel.

Tip: Het GRASS vectorgegevensmodel leren
De beste manier om het vectormodel van GRASS en de mogelĳkheden daarvan te leren is om één van de vele
handleidingen voor GRASS te downloaden waar het vectormodel dieper wordt beschreven. Zie https://grass.osgeo.
org/learn/manuals/ voor meer informatie, boeken en handleidingen in verschillende talen.

25.11 Maken van een nieuwe GRASS vectorlaag

Selecteer een van de volgende items uit het contextmenu van de mapset in de browser om een nieuwe vectorlaag voor
GRASS te maken:

• Nieuwe puntlaag
• Nieuwe lĳnlaag
• Nieuwe polygoonlaag

en voer een naam in in het dialoogvenster. Een nieuwe vectorkaart zal worden gemaakt en de laag zal worden
toegevoegd aan het kaartvenster en bewerken gestart. Selecteren van het type laag beperkt niet de typen geometrie
die kunnen worden gedigitaliseerd in de vectorkaart. In GRASS is het mogelĳk alle soorten typen geometrie (punt,
lĳn en polygoon) in één vectorkaart te organiseren. Het type wordt alleen gebruikt om de laag toe te voegen aan het
kaartvenster, omdat QGIS vereist dat een laag een specifiek type moet hebben.
Het is ook mogelĳk lagen toe te voegen aan bestaande vectorkaarten door een van de items te selecteren die hierboven
zĳn beschreven in het contextmenu van de bestaande vectorkaart.
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In GRASS is het mogelĳk alle soorten typen geometrie (punt, lĳn en gebied) te beheren in één laag, omdat GRASS
een topologisch vectormodel gebruikt, dus hoeft u niet het type geometrie te selecteren bĳ het maken van een
nieuwe vector in GRASS. Dit verschilt van het maken van een shapefile met QGIS omdat shapefiles het vectormodel
Eenvoudig object gebruiken (zie gedeelte Nieuwe vectorlagen maken).

25.12 Digitaliseren en bewerken van een GRASS vectorlaag

Vectorlagen van GRASS kunnen worden gedigitaliseerd met behulp van de standaardgereedschappen voor
digitaliseren van QGIS. Er zĳn echter enige bĳzonderheden die u zou moeten weten, vanwege

• GRASS topologisch model versus QGIS eenvoudige object
• complexiteit van het model van GRASS

– meerdere lagen in enkele kaarten
– meerdere typen geometrie in enkele kaarten
– delen van geometrie door meerdere objecten vanuit meerdere lagen

De bĳzonderheden worden besproken in de volgende gedeelten.
Opslaan, wĳzigingen verwerpen, ongedaan maken, opnieuw

Waarschuwing: Alle wĳzigingen die tĳdens het bewerken worden gemaakt, worden onmiddellĳk weggeschreven
naar de vectorkaart en gerelateerde attributentabellen.

Wĳzigingen worden weggeschreven na elke bewerking, het is echter mogelĳk wĳzigingen ongedaan te
maken/opnieuw te doen of te verwerpen bĳ het afsluiten van het bewerken. Als ongedaan maken of wĳzigingen
verwerpen zĳn gebruikt, wordt de originele status opnieuwweggeschreven naar de vectorkaart en de attributentabellen.
Er zĳn twee belangrĳke redenen voor dit gedrag:

• Het zit in de genen van GRASS vectors vanuit de overtuiging dat de gebruiker weet wat hĳ doet en dat het
beter is om de gegevens opgeslagen te hebben als het werk plotseling wordt onderbroken (bĳvoorbeeld uitval
van electriciteit)

• Noodzakelĳk voor het effectief bewerken van topologische gegevens is gevisualiseerde informatie over
topologische juistheid, zoals wanneer informatie alleen kan worden verkregen van een GRASS vectorkaart
als wĳzigingen naar de kaart zĳn weggeschreven.

Werkbalk
De ‘werkbalk Digitaliseren’ heeft enkele specifieke gereedschappen wanneer een laag van GRASS wordt bewerkt:

Pictogram Gereedschap Doel

Nieuw punt Nieuw punt digitaliseren

Nieuwe lĳn Nieuwe lĳn digitaliseren

Nieuwe grens Nieuwe grens digitaliseren

Nieuw zwaartepunt Nieuw zwaartepunt digitaliseren (label bestaand gebied)

Nieuwe gesloten grens Nieuwe gesloten grens digitaliseren

Tabel GRASS Digitaliseren: GRASS Gereedschap Digitaliseren

Tip: Digitaliseren van polygonen in GRASS
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Wanneer u een polygoon wilt maken in GRASS, digitaliseert u eerst de grens van de polygoon. Dan voegt u een
zwaartepunt (labelpunt) in de gesloten begrenzing in. De reden hiervoor is dat een topologisch vectormodel de
informatie voor het attribuut van een polygoon altĳd koppelt aan het zwaartepunt en niet aan de grens.

Categorie
Categorie, vaak cat genaamd, is een soort ID. De naam komt uit de tĳd dat GRASS vectors slechts één enkel attribuut
hadden “category”. Categorie wordt gebruikt als een koppeling tussen geometrie en attributen. Eén enkele geometrie
kan meerdere categorieën hebben en dus meerdere objecten in verschillende lagen weergeven. Momenteel is het
mogelĳk slechts één categorie per laag toe te wĳzen met behulp van de gereedschappen voor bewerken van QGIS.
Nieuwe objecten krĳgen automatisch een nieuwe unieke categorie toegewezen, behalve begrenzingen. Begrenzingen
vormen gewoonlĳk alleen gebieden en geven geen lineaire objecten weer, het is echter mogelĳk om attributen voor
een begrenzing later te definiëren, bĳvoorbeeld op een andere laag.
Nieuwe categorieën worden altĳd alleen gemaakt in de momenteel bewerkte laag.
Het is niet mogelĳk meerdere categorieën toe te wĳzen aan geometrie met behulp van bewerken van QGIS, dergelĳke
gegevens worden juist weergegeven als meerdere objecten, en individuele objecten, zelfs uit verschillende lagen,
kunnen worden verwĳderd.
Attributen
Alleen attributen van de momenteel bewerkte laag kunnen worden gewĳzigd. Als de vectorkaart meer lagen bevat,
zullen de objecten van alle andere lagen alle attributen hebben ingesteld op ‘<not editable (layer #)>’ om u te
waarschuwen dat een dergelĳk attribuut niet te bewerken is. De reden hiervoor is, dat andere lagen verschillende
sets velden zouden kunnen hebben, en gewoonlĳk ook hebben, terwĳl QGIS slechts één vaste set velden per laag
ondersteunt.
Als een geometrie primitief geen toegewezen categorie heeft, wordt automatisch een nieuwe unieke categorie
toegewezen en wordt een nieuw record in de attributentabel gemaakt wanneer een attribuut van die geometrie wordt
gewĳzigd.

Tip: Als u een bulk update van attributen in de tabel wilt doen, bĳvoorbeeld met behulp van ‘Veldberekening’
(Veldberekening gebruiken), en er zĳn objecten zonder categorie die u niet wilt bĳwerken (gewoonlĳk grenzen), kunt
u die er uit filteren door ‘Advanced Filter’ in te stellen op cat is not null.

Stĳl bewerken
De topologische symbologie is essentieel voor effectief bewerken van topologische gegevens. Wanneer het bewerken
begint, wordt een speciale renderer ‘GRASS Edit’ automatisch op de laag ingesteld en de originele renderer wordt
hersteld als het bewerken wordt afgesloten. De stĳl kan worden aangepast in de Laageigenschappen op de tab ‘Stĳl’.
De stĳl kan ook worden opgeslagen in het projectbestand of in een afzonderlĳk bestand zoals elke andere stĳl. Als
u de stĳl aanpast, wĳzig dan niet de naam, omdat die wordt gebruikt om de stĳl te herstellen als het bewerken weer
opnieuw wordt gestart.

Tip: Sla het projectbestand niet op wanneer de laag niet wordt bewerkt, de laag zou worden opgeslagen met ‘Stĳl
bewerken’ wat geen betekenis heeft als de laag niet wordt bewerkt.

De stĳl is gebaseerd op topologische informatie die tĳdelĳk aan de attributentabel wordt toegevoegd als het veld
‘topo_symbol’. Het veld wordt automatisch verwĳderd als het bewerken wordt afgesloten.

Tip: Verwĳder niet het veld ‘topo_symbol’ uit de attributentabel, dat zou objecten onzichtbaar maken omdat de
renderer is gebaseerd op die kolom.

Snappen
Hoekpunten van verbonden grenzen moeten exact dezelfde coördinaten hebben om een gebied te vormen. Dit kan
alleen worden bereikt met behulp van het gereedschap Snappen als het kaartvenster en vectorkaart hetzelfde CRS
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hebben. Anders kunnen, vanwege de conversie van kaartcoördinaten naar kaart en terug, de coördinaten enigszins
anders worden vanwege de fout in de weergave en transformaties van CRS.

Tip: CRS van lagen ook gebruiken bĳ bewerken van kaartvenster.

Beperkingen
Gelĳktĳdig bewerken van meerdere lagen in dezelfde vector op hetzelfde moment wordt niet ondersteund. Dat
komt vooral door de onmogelĳkheid van het afhandelen van meerdere stapels Ongedaan maken voor één enkele
gegevensbron.

Op Linux en macOS kan slechts één laag voor GRASS op enig moment worden bewerkt. Dit is vanwege een
bug in GRASS die niet toestaat om besturingsprogramma’s voor databases te sluiten in willekeurige volgorde. Dit
wordt opgelost met ontwikkelaars van GRASS.

Tip: GRASS Rechten voor bewerken
U moet de eigenaar zĳn van de MAPSET van GRASS die u wilt bewerken. Het is onmogelĳk om gegevenslagen te
bewerken in een MAPSET die niet van u is, zelfs niet als u schrĳfrechten heeft.

25.13 Het GRASS–gereedschap regio

De definitie van een regio (instellen van een ruimtelĳk werkvenster) in GRASS is belangrĳk voor het werken met
rasterlagen. Vectoranalyses zĳn standaard niet beperkt tot definities van gedefinieerde regio´s. Maar alle nieuwe
gemaakte rasters zullen de ruimtelĳke extensie en resolutie van de huidige gedefinieerde regio in GRASS hebben,
ongeacht hun originele extensie en resolutie. De huidige regio van GRASS is opgeslagen in het bestand$LOCATION/
$MAPSET/WIND, en het definieert de grenzen voor Noord, Zuid, Oost en West, aantal kolommen en rĳen,
horizontale en verticale ruimtelĳke resolutie.
Het is mogelĳk de visualisatie van de regio van GRASS in het kaartvenster van QGIS in of uit te schakelen met behulp
van de knop Huidige GRASS-regio tonen.
De regio kan worden aangepast op de tab ‘Regio’ in de vastgezette widget ‘GRASS-gereedschap’. Typ de nieuwe
grenzen voor de regio in en de resolutie, en klik op Apply. Als u klikt op Selecteer het bereik door te slepen over het
kaartvenster kunt u interactief een nieuwe regio kiezen met uwmuis op het kaartvenster van QGIS door een rechthoek
te slepen.
De module voor GRASS g.region verschaft nog veel meer parameters om een toepasselĳk bereik voor een regio
en resolutie voor uw rasteranalyses te definiëren. U kunt deze parameters gebruiken met de Toolbox voor GRASS,
beschreven in het gedeelte De Toolbox voor GRASS.

25.14 De Toolbox voor GRASS

Het vak GRASS-gereedschap openen verschaft functionaliteiten voor modules van GRASS om met gegevens binnen een
geselecteerde LOCATION en MAPSET voor GRASS te werken. U dient een LOCATION en MAPSET te openen
waarvoor u schrĳfrechten heeft toegekend gekregen (gewoonlĳk toegekend als u de MAPSET zelf maakte) om de
Toolbox voor GRASS te kunnen gebruiken. Dit is nodig omdat nieuwe raster- of vectorlagen die worden gemaakt
gedurende analyses moeten worden weggeschreven naar de momenteel geselecteerde LOCATION en MAPSET.
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Fig. 25.3: GRASS Toolbox en Modulenboom

25.14.1 Werken met modules van GRASS

De GRASS-shell binnen de Toolbox voor GRASS verschaft toegang tot bĳna alle (meer dan 300) modules voor
GRASS in een interface voor de opdrachtregel. Ongeveer 200 van de beschikbare modules en functionaliteiten voor
GRASS zĳn ook voorzien van grafische dialoogvensters binnen de Toolbox van de plug-in GRASS om een meer
gebruikersvriendelĳker werkomgeving te bieden.
Een volledige lĳst van modules voor GRASS, die beschikbaar zĳn in de grafische Toolbox in QGIS versie 3.28, is
beschikbaar in de wiki van GRASS op https://grasswiki.osgeo.org/wiki/GRASS-QGIS_relevant_module_list.
Het is ook mogelĳk de inhoud van de Toolbox van GRASS aan te passen. Deze procedure wordt beschreven in het
gedeelte Aanpassen van de Toolbox van GRASS.
Zoals weergegeven in Fig. 25.3 kunt u naar de toepasselĳke module voor GRASS zoeken met behulp van de
thematisch gegroepeerde Modulenboom of de te doorzoeken tab Modules.
Door te klikken op een grafisch pictogram voor een module zal een nieuwe tab worden toegevoegd aan het
dialoogvenster van de Toolbox, die drie nieuwe sub-tabs verschaft: Opties, Output en Handleiding.
Opties
De tabOpties verschaft een vereenvoudigd dialoogvenster voor de module waar u gewoonlĳk een raster- of vectorlaag,
die is gevisualiseerd in het kaartvenster van QGIS, kunt selecteren en meer module-specifieke parameters kunt
invullen om de module uit te voeren.
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Fig. 25.4: GRASS Toolbox Module-opties

De verschafte parameters voor de module zĳn vaak niet compleet om het dialoogvenster eenvoudig te houden. Als u
meer parameters en vlaggen voor de module wilt gebruiken, dient u de GRASS-shell te starten en de module uit te
voeren op de opdrachtregel.
Een nieuwe mogelĳkheid sinds QGIS 1.8 is de ondersteuning voor een knop Geavanceerde opties tonen onder het
vereenvoudigde dialoogvenster voor de module op de tab Opties. Op dit moment is het alleen toegevoegd aan de
module v.in.ascii als gebruiksvoorbeeld, maar het zal waarschĳnlĳk deel gaan uitmaken van de meeste of alle
modules in de Toolbox voor GRASS in toekomstige versies van QGIS. Dit stelt u in staat de volledige opties voor de
module voor GRASS te gebruiken zonder dat u hoeft over te schakelen naar de GRASS-shell.
Output
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Fig. 25.5: GRASS Toolbox Module-uitvoer

De tab Output verschaft informatie over de uitvoerstatus van de module. Wanneer u klikt op de knop Uitvoeren,
schakelt de module naar de tab Output en ziet u informatie over het analyseproces. Als alles goed werkt ziet u
uiteindelĳk een bericht Met succes voltooid.
Handleiding
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Fig. 25.6: GRASS Toolbox Module Handleiding

De tab Handleiding geeft de HTML Help-pagina van de module voor GRASS weer. U kunt die gebruiken om te
controleren op meer parameters en vlaggen voor de module of om een beter inzicht te krĳgen over het doel van de
module. Aan het einde van elke paginamet de handleiding van demodule zult u verder koppelingen zien naar deMain
index, de Thematische index en de Full index. Deze koppelingen verschaffen dezelfde informatie als
de module g.manual.

Tip: Resultaten onmidellĳk weergeven
Als u uw resultaten van de berekeningen direct wilt weergeven in uw kaartvenster, kunt u de knop ‘Uitvoer bekĳken’
onder op de tab van de module gebruiken.
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25.14.2 GRASS voorbeelden van modules

De volgende voorbeelden zullen de kracht van enkele van de modules van GRASS demonstreren.

Contourlijnen maken

Het eerste voorbeeld maakt een vector contourenkaart uit een hoogteraster (DEM). Hier wordt aangenomen dat u de
LOCATIONAlaska heeft ingesteld zoals uitgelegd in het gedeelte Importeren van gegevens in een GRASS LOCATION.

• Open eerst de locatie door te klikken op de knop Mapset openen en de locatie Alaska te kiezen.

• Open nu de Toolbox met de knop GRASS-gereedschap openen.
• In de lĳst met categorieën gereedschap, dubbelklik op Raster► Surface management►Generate vector contour

lines.
• Nu zal een enkele klik op het gereedschap r.contour het dialoogvenster voor het gereedschap openen zoals
boven uitgelegd (zieWerken met modules van GRASS).

• Voer, in het vak Name of input raster map, gtopo30 in.

• Typ in het vak Increment between Contour levels de waarde 100. (Dit zal contourlĳnen maken met een
interval van 100 meter.)

• Typ in het vak Name for output vector map de naam ctour_100.
• Klik op Uitvoeren om het proces te beginnen. Wacht even totdat het bericht Met succes voltooid
verschĳnt in het uitvoervenster. Klik dan op Uitvoer bekĳken en Sluiten.

Omdat dit een grote regio is zal het even duren voordat alles wordt weergegeven. Nadat het renderen is voltooid, kunt u
het venster Laageigenschappen openen om de lĳnkleur te wĳzigen zodat de contouren duidelĳk over het hoogteraster
te zien zĳn, zoals in Het dialoogvenster Vectoreigenschappen.
Zoom vervolgens in op een klein bergachtig gebied in het midden van Alaska. Bĳ het veel inzoomen zult u opmerken
dat de contouren scherpe hoeken hebben. GRASS biedt het gereedschap v.generalize om vectorkaarten lichtjes
te wĳzigen met behoud van hun overall-vorm. Het gereedschap gebruikt verscheidene verschillende algoritmes met
verschillende doeleinden. Sommig algoritmes (d.i., Douglas Peuker en Vertex Reduction) vereenvoudigen de lĳn door
enkele punten te verwĳderen. De resulterende vector zal sneller laden. Dit proces is nuttig als u een vector met veel
detail heeft, maar u maakt een kaart op zeer kleine schaal, dus detail is niet nodig.

Tip: Het gereedschap Vereenvoudigen
Onthoud dat QGIS een gereedschap Vector► Geometrie-gereedschappen► Geometrieën vereenvoudigen► heeft dat
net zo werkt als het GRASS v.generalize Douglas-Peuker algoritme.

Echter, het doel van dit voorbeeld is anders. De contourlĳnen die zĳn gemaakt door r.contour hebben scherpe
hoeken die gladder zouden moeten. Tussen de algoritmes voor v.generalize staat Chaiken’s, wat precies dat doet (ook
Hermite-splines). Onthoud dat deze algoritmes aanvullende hoeken kunnen toevoegen aan de vector, waardoor het
nog langzamer is te laden.

• Open de Toolbox voor GRASS en dubbelklik op categorieën Vector ► Develop map ► Generalization, klik
dan op de module v.generalize om het venster Opties daarvan te openen.

• Controleer of de vectorlaag ‘ctour_100’ verschĳnt in het vak Name of input vector.
• Kies Chaiken’s Algorithm uit de lĳst met algoritmes. Laat alle andere opties op hun standaard staan en scroll
naar beneden naar de laatste rĳ om in het veld Name for output vector map ‘ctour_100_smooth’ in te vullen en
klik op Uitvoeren.

• Het proces duurt enige tĳd. Als eenmaal Met succes voltooid verschĳnt in het uitvoervenster, klik dan
op Uitvoer bekĳken en dan op Sluiten.
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• U zou de kleur van de vectorlaag kunnen wĳzigen om die duidelĳk weer te geven tegen de achtergrond van het
raster en om contrast te krĳgen met de originele contourlĳnen. Het zal u opvallen dat de nieuwe contourlĳnen
gladdere hoeken hebben dan de originele terwĳl zĳ nog voldoen aan de originele overall-vorm.

Fig. 25.7: GRASS module v.generalize om een vectorkaart gladder te maken

Tip: Ander gebruik voor r.contour
De hierboven beschreven procedure kan in equivalente andere situaties worden gebruikt. Als u een rasterkaart
heeft met gegevens over neerslag, bĳvoorbeeld, dan kan dezelfde methode worden gebruikt om een vectorkaart met
isohyetale (constante neerslag) lĳnen te maken.

Een 3D heuvels met schaduw-effect maken

Verscheidene methoden worden gebruikt om hoogtelagen weer te geven en een 3D-effect aan kaarten te geven. Het
gebruiken van contourlĳnen, zoals hierboven weergegeven, is een populaire methode die vaak gekozen wordt om
topografische kaarten te produceren. Een andere manier om een 3D-effect weer te geven is door schaduw op heuvels.
Het effect van schaduw op heuvels wordt gemaakt vanuit een DEM (hoogte)raster door eerst de helling en aspect van
elke cel te berekenen, dan de positie van de zon in de lucht te simuleren en een waarde van reflectie te geven aan elke
cel. U krĳgt dus lichte hellingen in de zon; de hellingen die uit de zon liggen (in de schaduw) worden donkerder.

• Begin dit voorbeeld met het laden van het hoogteraster gtopo30. Start de Toolbox voor GRASS en onder de
categorie Raster, dubbelklik om Spatial analysis ► Terrain analysis te openen.

• Klik dan op r.shaded.relief om de module te openen.

• Wĳzig azimuth angle van 270 naar 315.
• Voer gtopo30_shade in voor het nieuwe raster met schaduw voor de heuvels en klik op Uitvoeren.
• Wanneer het proces voltooid is, voeg dan het raster met schaduw voor de heuvels toe aan de kaart. U zou die
nu moeten zien weergegeven in grĳswaarden.

• Verplaats de kaart met schaduw op de heuvels naar onder de kaartgtopo30 in de inhoudsopgave, open dan het
venster Eigenschappen van gtopo30, schakel naar de tab Transparantie en stel het niveau voor transparantie
in op ongeveer 25% om zowel de schaduw op de heuvels als de kleuren van gtopo30 samen te zien.

U zou nu de hoogte gtopo30 moeten hebben met zĳn kleurenkaart en transparante instelling weergegeven boven
de kaart van de heuvels met schaduw in grĳswaarden. Schakel, om de visuele effecten van de schaduw op de hevels
te zien, de kaart gtopo30_shade uit en schakel die dan weer in.
Gebruiken van de GRASS-shell
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De plug-in GRASS in QGIS is ontworpen voor gebruikers voor wie GRASS nieuw is en die niet bekend zĳn met alle
modules en opties. Daarom geven sommige modules in de Toolbox niet alle beschikbare opties weer, en sommige
modules verschĳnen in het geheel niet. De GRASS-shell (of console) geeft de gebruiker toegang tot deze aanvullende
modules van GRASS die niet in de boom van Toolbox verschĳnen en ook tot enkele aanvullende opties voor de
modules die in de Toolbox staan met de eenvoudigste standaardparameters. Dit voorbeeld demonstreert het gebruiken
van een aanvullende optie in de module r.shaded.relief die hierboven werd weergegeven.

Fig. 25.8: De GRASS-shell, r.shaded.relief module

De module r.shaded.reliefmag een parameter zmult hebben, die de waarden voor hoogte relatief vermenigvuldigt
ten opzichte van de eenheden van de XY-coördinaten zodat het effect van schaduw op de heuvels nog meer
geprononceerd is.

• Laad het hoogteraster gtopo30 zoals hierboven en start dan de Toolbox voor GRASS en klik op de
GRASS-shell. Typ, in het venster van de shell, de opdracht r.shaded.relief map=gtopo30
shade=gtopo30_shade2 azimuth=315 zmult=3 en druk op Enter.

• Schakel, nadat het proces is voltooid, over naar de tab Browser en dubbelklik op het nieuwe raster
gtopo30_shade2 om het weer te geven in QGIS.

• Zoals hierboven uitgelegd, verplaats het raster met het schaduw-reliëf tot onder het raster gtopo30 in de
inhoudsopgave en controleer de transparantie van de gekleurde laag gtopo30. U zou moeten zien dat het
3D-effect sterker naar voren komt vergeleken met de eerste kaart met schaduw-reliëf.
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Fig. 25.9: Weergeven van reliëf met schaduw, gemaakt met de module van GRASS r.shaded.relief

Rasterstatistieken in een vectorkaart

Het volgende voorbeeld laat zien hoe een module van GRASS rastergegevens kan aggregeren en kolommen voor
statistieken voor elke polygoon in een vectorkaart kan toevoegen.

• Gebruik opnieuw de gegevens voor Alaska, bekĳk Importeren van gegevens in een GRASS LOCATION om het
shapefiles/trees.shp te importeren in GRASS.

• Nu is een tussenstap vereist: zwaartepunten moeten worden toegevoegd aan de geïmporteerde kaart trees om
het een volledige gebiedsvector voor GRASS te maken (inclusief beide grenzen en zwaartepunten).

• Kies, vanuit de Toolbox, Vector ► Develop map ► Manage features en open de module v.centroids.
• Voer als output vector map in ‘forest_areas’ en voer de module uit.
• Laad vervolgens de laag forest_areas en visualiseer de karakteristieken - naaldbos (evergreen), loofbos
(deciduous) of gemengd (mixed) - in verschillende kleuren. Selecteer in het venster van de laag Eigenschappen,
de tab Symbologie en selecteer uit Legenda type ‘Unieke waarde’ en vervolgens het Classificatie veld
‘VEGDESC’. (Bekĳk voor de uitleg over de tab Symbologie Eigenschappen Symbologie in het gedeelte vector.)

• Vervolgens, open de Toolbox voor GRASS opnieuw en open Vector ► Vector update by other maps.
• Klik op de module v.rast.stats. Voer gtopo30 en forest_areas in.
• Er is slechts één aanvullende parameter nodig: Voer column prefix elev in en klik op Uitvoeren. Dit is een
qua berekeningen zware bewerking die geruime tĳd zal vergen (waarschĳnlĳk meer dan twee uur).

• Tenslotte, open de attributentabel van forest_areas en verifieer dat verschillende nieuwe kolommen zĳn
toegevoegd, inclusief elev_min, elev_max, elev_mean, etc., voor elk polygoon bos.

25.14.3 Aanpassen van de Toolbox van GRASS

Nagenoeg alle modules voor GRASS kunnen worden toegevoegd aan de Toolbox voor GRASS. Een XML-interface
wordt verschaft voor het parsen van de vrĳ eenvoudige XML-bestanden die het uiterlĳk en parameters van de module
binnen de Toolbox configureren.
Een voorbeeld XML-bestand voor het maken van de module v.buffer (v.buffer.qgm) ziet er uit zoals dit:

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE qgisgrassmodule SYSTEM "http://mrcc.com/qgisgrassmodule.dtd">

<qgisgrassmodule label="Vector buffer" module="v.buffer">

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)
<option key="input" typeoption="type" layeroption="layer" />
<option key="buffer"/>
<option key="output" />

</qgisgrassmodule>

De parser leest deze definitie en maakt een nieuwe tab binnen de Toolbox wanneer u de module selecteert. Een meer
gedetailleerde beschrĳving voor het toevoegen van nieuwe modules, wĳzigen van een groep van een module, etc., is
te vinden op https://qgis.org/nl/site/getinvolved/development/addinggrasstools.html.
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HOOFDSTUK26

QGIS framework Processing

26.1 Introductie

Dit hoofdstuk introduceert het QGIS framework voor Processing, een omgeving voor geo-processing die kan worden
gebruikt om eigen en algoritmes van derde partĳen aan te roepen vanuit QGIS, wat uw taken voor ruimtelĳke analyses
meer productief en eenvoudig uit te voeren maakt.
Als een Bronplug-in, Processing is standaard geïnstalleerd, maar u moet het wel activeren:

1. Ga naar Plug-ins ► Plug-ins beheren en installeren…

2. Klik op de tab Geïnstalleerd aan de linkerkant.

3. Selecteer het vak naast het item Processing

4. Sluit het dialoogvenster.
Een menu Processing is nu beschikbaar in de bovenste menubalk. Van daaruit kunt u de belangrĳkste
componenten van dit framewerk bereiken.

In de volgende gedeelten zullen we bekĳken hoe de grafische elementen van dit framework gebruikt kunnen worden
en het meeste uit elk van hen te halen.
Er zĳn vier basiselementen in de GUI van het framework, die worden gebruikt om algoritmes voor verschillende
doeleinden uit te voeren. Kiezen van het ene gereedschap of het andere is afhankelĳk van het soort analyse dat
moet worden uitgevoerd en de bĳzondere karakteristieken van elke gebruiker en project. Alle algoritmes (met
uitzondering van de interface Batch processing, die, zoals we zullen zien, wordt aangeroepen vanuit de Toolbox of
het dialoogvenster voor het uitvoeren van een algoritme) kunnen worden bereikt vanuit het menuitem Processing (U
zult meer items zien. De resterende worden niet gebruikt om algoritmes uit te voeren en zullen later in dit hoofdstuk
worden besproken).

• De Toolbox: Het hoofdelement van de GUI, het wordt gebruikt om één enkel algoritme uit te voeren of een
batch-proces gebaseerd op dat algoritme.
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Fig. 26.1: Processing - Toolbox

• Grafische modellen ontwerpen: Verscheidene algoritmes kunnen grafisch worden gecombineerdmet behulp van
Grafische modellen ontwerpen om een werkstroom te definiëren, één enkel proces maken dat verschillende
subprocessen omvat.
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Fig. 26.2: Processing - Grafische modellen bouwen

• Het beheren vanGeschiedenis: Alle uitgevoerde acties met behulp van een van de hiervoor genoemde elementen
worden opgeslagen in een bestand voor geschiedenis en kunnen later eenvoudig worden gereproduceerd met
behulp van Geschiedenis.

Fig. 26.3: Processing - Geschiedenis

• De interface voor Batch-processing: Deze interface stelt u in staat batch-processen uit te voeren en het uitvoeren
van één enkel algoritme om meerdere gegevenssets te automatiseren.
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Fig. 26.4: Processing - Interface voor verwerken in batch

In de volgende gedeelten zullen we tot in detail elk van deze elementen nader bekĳken.

26.2 Configureren van het framework Processing

Het menu Processing in Opties (Extra► Opties ► tab Processing) stelt u in staat te configureren hoe algoritmes
werken. Parameters voor configuratie zĳn gestructureerd in afzonderlĳke blokken die u kunt selecteren aan de
linkerkant van het dialoogvenster.

26.2.1 Algemeen

Het blok Algemeen bevat de standaard instellingen om te beheren hoe het dialoogvenster voor algoritmes, als ook
de parameters voor in- en uitvoer, zich zouden moeten gedragen. Sommige instellingen kunnen, voor individuele
parameters, echter worden overschreven bĳ het uitvoeren van het algoritme.

• Standaard uitvoer rasterlaagextensie is standaard tif
• Standaard uitvoer vectorlaagextensie is standaard gpkg
• Ongeldige objecten filteren bĳ het uitvoeren van een algoritme:

– Niet filteren (betere uitvoering): alle objecten (met geldige en ongeldige geometrieën) worden verwerkt,
maar het resultaat zou misleidend kunnen zĳn, afhankelĳk van hoe de ongeldigheid van de geometrie de
bewerkingen beïnvloedt

– Objecten met ongeldige geometrieën overslaan (negeren), wat betekent dat alleen een subset van uw
gegevensset (de objecten met een geldige geometrie) zullen worden verwerkt

– Uitvoering van algoritme als een geometrie ongeldig is stoppen: u zult de ongeldige geometrieën moeten
opsporen en repareren als u wilt dat het algoritme de gehele laag verwerkt. Algoritmes zoals Geldigheid
controleren of Geometrieën repareren kunnen helpen dit te bereiken.

De instelling Ongeldige objecten filteren kan worden overschreven op een per-invoer basis, bĳ het uitvoeren van
het algoritme.

• Dialoogvenster open houden na uitvoeren van een algoritme. Als een algoritme eenmaal de uitvoering heeft
voltooid en de uitvoerlagen zĳn geladen in het project van QGIS, zal het dialoogvenster Algoritme worden
gesloten. Als u het geopend wilt houden (om het algoritme opnieuw uit te voeren, maar met andere parameters,
of om de uitvoer, die is weggeschreven naar de tab Log, beter te controleren), selecteer dan deze optie.

• Max threads

896 Hoofdstuk 26. QGIS framework Processing



QGIS Desktop 3.28 User Guide

• Map voor uitvoer voor niet-tĳdelĳke uitvoer: Als geen pad voor de map wordt opgegeven voor de uitvoer van
uitvoeringen van Processing, is dit de folder waarin zĳ zullen worden bewaard. Standaard is processing/
outputs onder de map van het actieve gebruikersprofiel.

• Tĳdelĳk pad voor map overschrĳven: Tĳdelĳke uitvoer wordt standaard opgeslagen in de map tmp op de
machine. Deze optie helpt u een andere plaats voor de opslag in te stellen.

• Vóór-uitvoering script enNa-uitvoering script. Deze parameters verwĳzen naar de bestanden die scripts bevatten
die zĳn geschreven met behulp van de functionaliteit Scripten in Processing, uitgelegd in het gedeelte dat het
scripten en de console behandelt.

• Voorkeur uitvoer bestandsnaam voor laagnamen. De naam van elke resulterende laag die wordt gemaakt door
een algoritme wordt gedefinieerd door het algoritme zelf. In sommige gevallen zou een vaste naam kunnen
worden gebruikt, wat betekent dat dezelfde naam voor de uitvoer wordt gebruikt, ongeacht welke laag voor de
invoer wordt gebruikt. In andere gevallen zou de naam afhankelĳk kunnen zĳn van de naam van de invoerlaag
of enkele van de parameters die worden gebruikt om het algoritme uit te voeren. Als dit keuzevak is geselecteerd
zal in plaats daarvan de naam uit de naam voor het uitvoerbestand worden genomen. Onthoud dat, wanneer de
uitvoer wordt opgeslagen naar een tĳdelĳk bestand, de bestandsnaam van dit tĳdelĳke bestand gewoonlĳk een
lange en betekenisloze is, bedoeld om botsingen met reeds bestaande bestandsnamen te vermĳden.

• Naam groep resultaten. Als u wilt dat alle lagen met resultaten van Processing worden verkregen in een groep
in het paneel Lagen, stel dan een naam voor de groep in voor deze parameter. De groep mag al bestaan of
niet. QGIS zal alle uitvoerlagen toevoegen aan een dergelĳke groep. Standaard is deze parameter leeg, dus
alle uitvoerlagen worden toegevoegd op verschillende plaatsen in het paneel Lagen, afhankelĳk van het item
dat actief is bĳ het uitvoeren van een algoritme. Onthoud dat uitvoerlagen alleen in het paneel Lagen worden
geladen als Uitvoerbestand openen na uitvoeren van algoritme is geselecteerd in het dialoogvenster van het
algoritme.

• Algoritmes met bekende problemen weergeven: Standaard vermĳdt QGIS het weergeven van defecte algoritmes
(over het algemeen van derde-partĳ providers). Indien geselecteerd zullen zĳ beschikbaar zĳn in de Toolbox
van Processing, met een waarschuwingspictogram en een helptip die uitlegt dat zĳ problemen hebben. Gebruik
ze op uw eigen risico.

• Aantal uitvoervectorlagen weergeven. Deze optie is standaard uit gezet, omdat het berekenen van het aantal
objecten enige tĳd kan vergen in bepaalde indelingen.

• CRS-definitie van laag in selectievakken weergeven

• Helptip weergeven indien er providers zĳn uitgeschakeld

• Stĳl voor lĳnlagen, Stĳl voor puntlagen, Stĳl voor polygoonlagen en Stĳl voor rasterlagen worden gebruikt voor
het instellen van de standaard stĳl voor renderen voor uitvoerlagen (dat is, lagen die worden gemaakt door
algoritmes van Processing). Maak eenvoudigweg de stĳl die u wilt met behulp van QGIS, sla die op naar een
bestand en voer dan het pad naar dat bestand in de instellingen in, zodat de algoritmes het kunnen gebruiken.
Wanneer een laag wordt geladen door Processing en toegevoegd aan het kaartvenster van QGIS, zal die worden
gerenderd in die stĳl.
Stĳlen voor weergave kunnen individueel worden geconfigureerd voor elk algoritme en elk van diens uitvoeren.
Klik eenvoudigweg met rechts op de naam van het algoritme in de Toolbox en selecteerWeergave-stĳlen voor
uitvoer bewerken. U zult een dialoogvenster zien zoals hieronder wordt weergegeven.

Fig. 26.5: Weergave-stijlen
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Selecteer het stĳlbestand (.qml) dat u wilt toepassen voor elke uitvoer en druk op OK.
• Waarschuwen vóór uitvoeren als parameter CRS niet overeenkomt: Standaard projecteren de eigen algoritmes
van QGIS (d.i. die welke zĳn vermeld onder de groep Menu’s ► QGIS (native C++)) de invoerlagen
transparant opnieuw naar het CRS van de eerste vóór het uitvoeren. Selecteer deze optie om een notificatie uit
andere gereedschappen die opnieuw projecteren niet ondersteunen, als de CRS-en voor de invoer niet identiek
zĳn. Derde partĳ-providers worden niet betrokken.

26.2.2 Menu’s

Het blok Menu’s beheert of een algoritme, script of model (ingebouwd of verschaft door plug-ins) beschikbaar
zou moeten worden gemaakt via een toegewezen menu of werkbalk (naast de Toolbox van Processing). Voor elk item
van elke provider, kunt u:

• Knop toevoegen aan werkbalk, wat het beschikbaar maakt op de werkbalk Processing algoritmes

• een Pictogram toewĳzen aan het algoritme
• een Menupad instellen: het algoritme zal dan beschikbaar zĳn via een bestaand of aangepast menu, bĳv.
Vect&or/MyTopAlgorithms

Herstart QGIS om de instellingen toe te passen. Op elk moment kunnen uw wĳzigingen worden teruggezet met Terug
naar standaardinstellingen.

26.2.3 Modellen en scripts

In de blokken Modellen en Scripts kunt u een standaardmap instellen om op te slaan en respectievelĳk uw
modellen en scripts te zoeken.

26.2.4 Providers

U zult ook een blok vinden voor Providers van algoritmes. Dit is de plek waar geïnstalleerde providers hun
instellingen weergeven. Ingebouwde providers, bĳvoorbeeld, bevatten een item Activeren dat u kunt gebruiken om
hun algoritmes al dan niet te laten verschĳnen in de Toolbox. Sommige providers van algoritmes hebben hun eigen
items voor configuratie, dat zal worden uitgelegd bĳ het behandelen van bepaalde providers van algoritmes.

26.3 De Toolbox

De Processing Toolbox is het hoofdelement van de GUI van Processing en die u waarschĳnlĳk het meeste gaat
gebruiken in uw dagelĳkse werk. Het geeft de lĳst met alle beschikbare algoritmesweer, gegroepeerd in verschillende
blokken, genaamd Providers, en aangepastemodellen en scripts die u kunt toevoegen om de set gereedschappen uit
te breiden. Daarom is de Toolbox het toegangspunt om ze uit te voeren, ofwel als een enkel proces of als een batch-
proces dat verschillende uitvoeringen van hetzelfde algoritme betreft op verschillende sets voor de invoer.
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Fig. 26.6: Processing - Toolbox

Providers kunnen worden ge(de)activeerd in het dialoogvenster voor instellingen van Processing. Standaard zĳn alleen
providers die niet afhankelĳk zĳn van toepassingen van derde partĳen (dat is, die alleen elementen van QGIS nodig
hebben om te worden uitgevoerd) actief. Algoritmes die externe toepassingen nodig hebben zouden een aanvullende
configuratie nodig kunnen hebben. Configureren van providers wordt in een later hoofdstuk van deze handleiding
uitgelegd.
In het bovenste gedeelte van het dialogvenster Toolbox, vindt u ook een set gereedschappen:

• werken met Modellen: Nieuw model maken…, Bestaand model openen… enModel toevoegen aan Toolbox…;

• werken met Scripts: Nieuw script maken…, Nieuw script uit sjabloon maken…, Bestaand script openen… en
Script toevoegen aan Toolbox…;

• openen van het paneel Geschiedenis;

• openen van het paneel Resultaten bekĳken;

• schakelen van de Toolbox naar modus Objecten op hun plaats bewerken met de knop
Objecten op hun plaats bewerken: alleen de algoritmes die geschikt zĳn om te worden uitgevoerd op de actieve
laag zonder een nieuwe laag uit te voeren worden weergegeven;

• openen van het dialoogvenster Opties.

Onder deze werkbalk staat een Zoek…-vak om u te helpen de gereedschappen die u nodig heeft eenvoudig te
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vinden. U kunt een woord of een frase in dat tekstvak invoeren. Onthoud dat, terwĳl u typt, het aantal algoritmes in de
Toolbox wordt gereduceerd tot net die welke in hun namen of sleutelwoorden de tekst bevatten die u heeft ingevoerd.

Notitie: Bovenin de lĳst met algoritmes worden de meest recent gebruikte gereedschappen weergegeven; handig als
u er een opnieuw dient uit te voeren.

Fig. 26.7: Processing - Toolbox geeft de resultaten weer

Dubbelklik eenvoudigweg op de naam in de Toolbox om een gereedschap uit te voeren.
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26.3.1 Het dialoogvenster Algoritme

Als u eenmaal hebt geklikt op de naam van het algoritme dat u wilt uitvoeren, zal een dialoogvenster, zoals dat in
de Fig. 26.8 hieronder, worden weergegeven (in dit geval correspondeert het dialoogvenster met het algoritme van
Centroids).

Fig. 26.8: Dialoogvenster algoritme - Parameters

Het dialoogvenster geeft twee tabs weer (Parameters en Log) in het linkerdeel, de beschrĳving van het algoritme
rechts, en een set knoppen aan de onderkant.

Typen parameters

De tab Parameters wordt gebruikt om de waarden voor de invoer in te stellen waarmee het algoritme moet worden
uitgevoerd. Het geeft een lĳst weer met waarden voor de invoer en parameters voor de configuratie die moeten worden
ingesteld. Het heeft natuurlĳk een andere inhoud, afhankelĳk van de vereisten van het uit te voeren algoritme, en wordt
automatisch gemaakt, gebaseerd op deze vereisten.
Hoewel het aantal en type parameters afhankelĳk is van de karakteristieken van het algoritme, is de structuur voor
alle ongeveer hetzelfde. De parameters in de tabel kunnen van een van de volgende types zĳn.

• Een vectorlaag te selecteren uit een lĳst van beschikbare vectorlagen (momenteel geopend) in QGIS. U kunt
ook niet geladen lagen gebruiken: druk op de knop… van de widget aan de rechterkant en selecteer:

– Bestand selecteren…: selecteert het bestand op schĳf met de bestandsverkenner van het besturingssysteem
– Bladeren naar laag…: opent het paneel Browser dat het mogelĳk maakt de lagen direct te selecteren uit
databronnen (PostgreSQL, SQL Server, Oracle,…), webservices (WFS, AFS,…) of bestanden op schĳf.

Fig. 26.9: Widget voor invoer vector

Notitie: Standaard zal de widget van de laag het CRS weergeven met zĳn naam. Als u deze aanvullende
informatie niet wilt zien, kunt u die functionaliteit in het dialoogvenster met instellingen voor Processing
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uitschakelen, door de optie Algemeen ► CRS-definitie van laag in selectievakken weergeven niet te selecteren.

De vector invoerwidget heeft ook de volgende mogelĳkheden:

– een knop Doorloop : Indien ingeschakeld zal het algoritme iteratief worden uitgevoerd op elk van
zĳn objecten, in plaats van slechts één keer voor de gehele laag, wat net zoveel uitvoeren maakt als dat het
algoritme wordt uitgevoerd. Dit maakt het mogelĳk het proces te automatiseren als alle objecten op een
laag afzonderlĳk moeten worden verwerkt. Als het algoritme verschillende vectors voor de invoer bevat
die u kunt doorlopen, zal het doorlopen alleen worden verwerkt op de eerste ingeschakelde parameter, in
de volgorde waarin de parameters zĳn gedeclareerd in het algoritme.

– knop Geavanceerde opties om instellingen aan te passen om te gebruiken met die specifieke parameter.
Deze instellingen omvatten:
∗ Ongeldige objecten filteren: staat de standaard methode, voor afhandelen van objecten met ongeldige
geometrieën, toe om te worden overschreven

∗ Verwerkte objecten beperken: optionele begrenzing voor het aantal objecten dat vanuit de bron moet
worden verwerkt

– Het is ook mogelĳk de uitvoering van het algoritme op de vectorlaag te beperken met zĳn keuze Alleen
geselecteerde objecten.

• Een tabel om te selecteren uit een lĳst met alle beschikbare in QGIS. Niet-ruimtelĳke tabellen worden net als
vectorlagen in QGIS geladen en gebruikt dezelfde widget.

• Een rasterlaag om te selecteren uit een lĳst van alle beschikbare rasterlagen in QGIS. De selectie bevat ook
een knop … aan de rechterkant om u bestandsnamen te laten selecteren die lagen weergeven die momenteel
niet geladen zĳn in QGIS.

Fig. 26.10: Raster invoerwidget

• Een optie, om te kiezen uit een selectielĳst met mogelĳke opties.
• Een numerieke waarde, die moet worden ingevoerd in een draaivak. In sommige contexten (als de parameter
van toepassing is op het niveau van het object en niet dat van de laag), zult u een knop Data-bepaalde ‘override’

er naast vinden, die u in staat stelt de expressiebouwer te openen en een rekenkundige expressie in te voeren
om variabele waarden voor de parameter te maken. Sommige nuttige variabelen die zĳn gerelateerd aan in
QGIS geladen gegevens kunnen aan uw expressie worden toegevoegd, dus kunt u een waarde selecteren die is
afgeleid van één van deze variabelen, zoals de grootte van een cel van een laag of de meest noordelĳk gelegen
coördinaat van een andere.
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Fig. 26.11: Op expressie gebaseerde invoer

• Een bereik, met waarden min en max die moeten worden ingevoerd in twee tekstvakken.
• Een tekst-tekenreeks, om te worden ingevoerd in een tekstvak.
• Een veld, om te kiezen uit de attributentabel van een vectorlaag of één enkele tabel, geselecteerd in een andere
parameter.

• Een coördinaten referentiesysteem. U kunt het selecteren uit de meest recent gebruikte uit de keuzelĳst of uit
het dialoogvensterKeuze Coördinaten ReferentieSysteem dat verschĳnt als u klikt op de knop aan de rechterkant.

• Een bereik, een tekstvak dat een rechthoek definieert met zĳn hoekcoördinaten in de indeling xmin,
xmax, ymin, ymax. Druk op de knop Op huidig bereik kaartvenster instellen om het bereik van het kaartvenster
te gebruiken. Klikken op de pĳl aan de rechterkant van de selectie voor de waarde laat een pop-upmenu
verschĳnen dat u opties geeft om:

– Uit laag berekenen►: vult het tekstvak met de coördinaten van het begrenzingsvak van een uit de geladen
lagen te selecteren laag

– Uit lay-out laag berekenen►: vult het tekstvak met de coördinaten van een kaartitem, geselecteerd in een
lay-out in het huidige project

– Uit Favoriete plaats berekenen►: vult het tekstvakmet de coördinaten van een opgeslagen Favoriete plaats

– Bereik huidig kaartvenster gebruiken

– In kaartvenster tekenen: het venster Parameters zal zichzelf verbergen, zodat u kunt klikken en slepen
in het kaartvenster. Als u de geselecteerde rechthoek heeft gedefinieerd zal het dialoogvenster opnieuw
verschĳnen en de waarden bevatten in het tekstvak voor het bereik.
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Fig. 26.12: Bereikselectie

• Een lĳst met elementen (raster- of vectorlagen, tabellen, velden) om uit te kiezen. Klik op de knop … links
van de optie om een dialoogvenster zoals het volgende te zien. Meervoudig selecteren is toegestaan en als
het dialoogvenster wordt gesloten, wordt het aantal geselecteerde items weergegeven in de widget Tekstvak
parameter.

Fig. 26.13: Meervoudige selecties

• Een kleine tabel om te worden bewerkt door de gebruiker. Deze worden gebruikt om parameters te definiëren
zoals tabellen voor opzoeken of samengevouwde kernen, naast andere.
Klik op de knop aan de rechterkant om de tabel te zien en de waarden ervan te bewerken.
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Fig. 26.14: Vaste tabel

Afhankelĳk van het algoritme kan het aantal rĳen, al dan niet, worden aangepast met de knoppen aan de
rechterkant van het venster.

Notitie: Sommige algoritmes vereisen veel parameters om te kunnen worden uitgevoerd, bĳv. in de Raster calculator
moet u handmatig de celgrootte, het bereik en het CRS specificeren. U kunt het handmatig kiezen van alle parameters
vermĳden als het algoritme de parameter Verwijzingslaag heeft. Met die parameter kunt u de verwĳzingslaag
kiezen en alle eigenschappen daarvan (celgrootte, bereik, CRS) zullen worden gebruikt.

Loggen van de uitvoering

Naast de tab Parameters is er ook een andere tab, genaamd Log (zie Fig. 26.15 hieronder). Informatie die wordt
verschaft door het algoritme gedurende de uitvoering ervan wordt in deze tab weggeschreven en stelt u in staat
de uitvoering te volgen en in de gaten te houden en meer details te verkrĳgen over het algoritme als het wordt
uitgevoerd. Informatie over het uitvoeren van het algoritme wordt ook uitgevoerd in het Beeld ► Panelen ► paneel
Logboekmeldingen.
Onthoud dat niet alle algoritmes informatie naar de tab Log wegschrĳven, en veel ervan zouden geluidloos kunnen
worden uitgevoerd, zonder enige uitvoer te produceren anders dan de uitvoerbestanden. Controleer in dat geval het
paneel Logboekmeldingen.

26.3. De Toolbox 905



QGIS Desktop 3.28 User Guide

Fig. 26.15: Dialoogvenster algoritme - Log

Aan de onderzĳde van de tab Log vindt u de knoppen voor Log opslaan naar bestand, Log

naar klembord kopiëren en Log leegmaken. Deze zĳn in het bĳzonder handig als u het keuzevak
Dialoogvenster open houden na uitvoeren van een algoritme in het gedeelte Algemeen
van de opties van Processing hebt geselecteerd.

Andere gereedschappen

Aan de rechterkant van het dialoogvenster ziet u een korte beschrĳving van het algoritme, wat u zal helpen het doel
ervan te begrĳpen en de basisideeën erachter. Als een dergelĳke beschrĳving niet beschikbaar is zal het paneel met
de beschrĳving niet worden weergegeven.
Voor een meer gedetailleerd Help-bestand, dat een beschrĳving zou kunnen bevatten van alle parameters die het
gebruikt, of voorbeelden, vindt u een knop Help aan de onderzĳde van het dialoogvenster die u brengt naar de
Processing providers en algoritmes of naar de documentatie van de provider (voor enkele providers van derde-partĳen).
Het menu Geavanceerd ► verschaft functies om de configuratie, die is gedefinieerd in het dialoogvenster, opnieuw
te gebruiken zonder het algoritme uit te voeren:

• Als opdracht voor Python kopiëren: maakt het gemakkelĳk om het equivalent van de opdracht van PyQGIS te
kopiëren om het gereedschap uit te voeren met de parameters die zĳn gedefinieerd in het dialoogvenster.

• Als opdracht voor qgis_process kopiëren: maakt het maken van een opdracht voor qgis_process , inclusief zĳn
instellingen voor de omgeving, zoals eenheden voor afstanden, eenheden voor gebied, ellipsoïde, en enkele
moeilĳkere waarden voor parameters zoals uitvoer naar GeoPackage met specifieke lagen, gemakkelĳker.

• Als JSON kopiëren: alle instellingen voor de opdracht worden gekopieerd naar de indeling JSON, klaar om te
worden gebruikt door qgis_process. Dit is een handige manier om de verwachte indeling van de opdrachten
te bekĳken, zelfs voor complexe parameters (zoals parameters voor TIN interpolatie). U kunt ze gemakkelĳk
opslaan en ze later terugplaatsen door de waarden te plakken.

• Instellingen plakken in de indeling JSON
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De knop Uitvoeren als een Batch proces… activeert de modus In batch verwerken wat het mogelĳk maakt meerdere
instanties van het algoritme te configureren en uit te voeren met een variëteit aan parameters. Een knop Als enkel
proces uitvoeren… helpt u terug te schakelen vanuit de modus Batch.
Wanneer de uitvoering van een algoritme is voltooid (ofwel met succes of niet), wordt een nieuwe knop Parameters
wĳzigen weergegeven, zolang de tab Log actief is.

Een opmerking over projecties

Uitvoering van algoritmes van Processing worden altĳd uitgevoerd in het coördinaten referentiesysteem (CRS) van de
invoerlaag. Vanwege de directe mogelĳkheden voor opnieuw projecteren van QGIS, hoewel twee lagen elkaar lĳken
te overlappen en overeenkomen, hoeft dat niet waar te zĳn als hun originele coördinaten werden gebruikt zonder ze
opnieuw te projecteren in een algemeen coördinatensysteem. Altĳd wanneer u meer dan één laag als invoer gebruikt
voor een QGIS eigen algoritme, vector of raster, zullen de lagen allemaal opnieuw worden geprojecteerd om overeen
te komen met het coördinaten referentiesysteem van de eerste invoerlaag.
Dat is echter minder waar voor de meeste externe toepassingen waarvan algoritmes worden weergegeven in
het framework Processing omdat die ervan uitgaan dat alle lagen reeds in een overeenkomend coördinaten
referentiesysteem staan en klaar zĳn om te worden geanalyseerd.
Standaard zal het dialoogvenster Parameters een beschrĳving weergeven van het CRS van elke laag, tezamen met
de naam ervan, wat het eenvoudig maakt lagen te selecteren die hetzelfde CRS delen om te worden gebruikt als
invoerlagen. Als u deze aanvullende informatie niet wilt zien, kunt u die functionaliteit in het dialoogvenster Opties
uitschakelen, door de optie CRS-definitie van laag in selectievakken weergeven niet te selecteren.
Wanneer u probeert een algoritme uit te voeren met twee of meer lagen als invoer, waarvan de CRS-en niet
overeenkomen, zal een dialoogvenster met een waarschuwing worden weergegeven. Dat komt door de optie
Waarschuwen vóór uitvoeren als de parameter CRS niet overeen komt.
U kunt nog steeds het algoritme uitvoeren, maar weet dat dat in de meeste gevallen verkeerde resultaten zal
produceren, zoals lege lagen, omdat de invoerlagen elkaar niet overlappen.

Tip: Algoritmes voor Processing gebruiken om tussentĳds opnieuw te projecteren
Wanneer een algoritme niet met succes uitgevoerd kan worden op meerdere invoerlagen vanwege niet-
overeenkomende CRS-en, gebruik dan het interne algoritme van QGIS, zoals Laag opnieuw projecteren, om opnieuw
projecteren van de lagen naar hetzelfde CRS uit te voeren vóór het uitvoeren van het algoritme dat deze uitvoer
gebruikt.

26.3.2 Gegevensobjecten gegenereerd door algoritmes

Gegevensobjecten gegenereerd door een algoritme kunnen van één van de volgende typen zĳn:
• Een rasterlaag
• Een vectorlaag
• Een tabel
• Een HTML-bestand (gebruikt voor tekst en grafische uitvoer)

Deze worden allemaal opgeslagen op schĳf en de tabel met parameters zal een tekstvak bevatten dat overeenkomt
met elk van deze uitvoeren, waar u het kanaal voor uitvoer kunt typen om het op te slaan. Een kanaal voor uitvoer
bevat de informatie die nodig is om de resulterende object ergens op te kunnen slaan. In het meest normale geval,
zult u het opslaan naar een bestand, maar in het geval van vectorlagen en wanneer zĳ worden gegenereerd door eigen
algoritmes (algoritmes die geen externe toepassingen gebruiken) kunt u ook opslaan naar een database van PostGIS,
GeoPackage of SpatiaLite, of naar een geheugenlaag.
Klik, om een kanaal voor uitvoer te selecteren, eenvoudigweg op de knop aan de rechterkant van het tekstvak, en u
zult een klein contextmenu met de beschikbare opties zien.
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In de meeste gevallen zult u willen selecteren dat u wilt opslaan naar een bestand. Als u die optie selecteert, zult u
in een dialoogvenster Opslaan als worden gevraagd naar het gewenste pad om het bestand op te slaan. Ondersteunde
bestandsextensies worden in de selectie voor de bestandsindeling in het dialoogvenster weergegeven, afhankelĳk van
het soort uitvoer en het algoritme.
De indeling van de uitvoer wordt gedefinieerd door de extensie van de bestandsnaam. De ondersteunde indelingen
zĳn afhankelĳk van wat door het algoritme zelf wordt ondersteund. Selecteer eenvoudigweg de corresponderende
bestandsextensie (of voeg die toe, als u in plaats daarvan het bestandspad direct intypt) om een indeling te selecteren.
Als de extensie van het bestandspad dat u invoerde niet overeenkomt met een van de ondersteunde indelingen, zal
een standaard extensie worden toegevoegd aan het bestandspad, en de bestandsindeling die correspondeert met die
extensie zal worden gebruikt om de laag of de tabel op te slaan. Standaard extensies zĳn: .dbf voor tabellen, .tif
voor rasterlagen en .gpkg voor vectorlagen. Deze kunnen worden aangepast in het dialoogvenster Opties, door één
van de door QGIS ondersteunde indelingen te selecteren.
Als u geen bestandsnaam invoert in het tekstvak voor de uitvoer (of de overeenkomende optie in het contextmenu
selecteert) zal het resultaat worden opgeslagen als een tĳdelĳk bestand in de corresponderende standaard
bestandsindeling en het zal worden verwĳderd als u QGIS afsluit (wees u daarvan bewust als u uw project opslaat en
het tĳdelĳke lagen bevat).
U kunt een standaardmap instellen voor gegevensobjecten van uitvoer. Ga naar het dialoogvenster Opties (u kunt het
openen vanuit het menu Extra► Opties► Processing), en in de groep Algemeen vindt u een parameter genaamdMap
voor uitvoer. Deze map voor uitvoer wordt gebruikt als het standaardpad in het geval dat u slechts een bestandsnaam
typt, zonder pad (d.i. mynbestand.shp) bĳ het uitvoeren van een algoritme.
Bĳ het uitvoeren van een algoritme dat een vectorlaag in iteratieve modus gebruikt, wordt het ingevoerde bestandspad
gebruikt als het basispad voor alle gegenereerde bestanden, die worden benoemd met behulp van de basisnaam en
de toevoeging van een getal dat de index van de iteratie vertegenwoordigt. De bestandsextensie (en indeling) wordt
gebruikt voor alle op die manier gegenereerde bestanden.
Apart van rasterlagen en tabellen, genereren algoritmes ook afbeeldingen en tekst als HTML-bestanden. Deze
resultaten worden weergegeven aan het einde van de uitvoering van het algoritme in een nieuw dialoogvenster. Dit
dialoogvenster zal de resultaten behouden die door een algoritme zĳn geproduceerd gedurende de huidige sessie, en
kan op elk moment worden weergegeven via het menu Processing► Resultaten bekĳken in het hoofdmenu van QGIS.
Sommige externe toepassingen zouden bestanden (zonder bepaalde beperkingen voor de extensie) als uitvoer kunnen
hebben, maar zĳ behoren niet tot de hierboven vermelde categorieën. Deze bestanden voor uitvoer zullen niet worden
verwerkt door QGIS (geopend of opgenomen in het huidige project van QGIS), omdat zĳ meestal niet corresponderen
met bestandsindelingen of elementen die worden ondersteund doorQGIS. Dit is, bĳvoorbeeld, het gevalmet bestanden
van LAS, gebruikt voor de gegevens van LiDAR. De bestanden worden gemaakt maar u zult niets zien in uw nieuwe
werksessie van QGIS.
Voor alle andere typen van uitvoer zult u een tekstvak vinden dat u kunt gebruiken om het algoritme te vertellen
om het bestand te laden als het eenmaal is gegenereerd door het algoritme of niet. Standaard worden alle bestanden
geopend.
Optionele uitvoeren worden ondersteund. Dat is, alle uitvoeren worden gemaakt. Echter, u kunt het corresponderende
tekstvak deselecteren als u niet geïnteresseerd bent in een bepaalde uitvoer, wat er in essentie voor zorgt dat het zich
gedraagt als een optionele uitvoer (met andere woorden: de laag wordt toch gemaakt, maar als u het tekstvak leeg
laat, zal die worden opgeslagen in een tĳdelĳk bestand en worden verwĳderd als u QGIS afsluit).

26.4 Beheren van de geschiedenis

26.4.1 De geschiedenis van Processing

Elke keer als u een algoritme uitvoert, wordt informatie over het proces opgeslagen in het beheer van de geschiedenis.
De datum en tĳd van het uitvoeren worden opgeslagen, als ook de gebruikte parameters, wat het gemakkelĳker maakt
al het werk dat is ontwikkeld met het framewerk Processing te volgen en te beheren, en het te reproduceren.
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Fig. 26.16: Geschiedenis

Procesinformatie wordt opgeslagen als een uitdrukking voor de opdrachtregel, zelfs als het algoritme werd gestart
vanuit de Toolbox. Dit maakt het handig voor degenen die leren hoe zĳ de interface voor de opdrachtregel moeten
gebruiken, omdat zĳ een algoritme kunnen aanroepen met behulp van de Toolbox en dan het beheren van de
geschiedenis kunnen raadplegen om te zien hoe het zou kunnen worden aangeroepen vanaf de opdrachtregel.
Klik met rechts op een rĳ en u zou moeten kunnen:

• Als opdracht voor Python kopiëren: maakt het mogelĳk om het equivalent van de opdracht van PyQGIS te
kopiëren en uit te voeren in het dialoogvenster. Hetzelfde als de code die is weergegeven onder de lĳst met
opdrachten.

• Als opdracht voor qgis_process kopiëren: maakt het maken van een opdracht voor qgis_process , inclusief zĳn
instellingen voor de omgeving, zoals eenheden voor afstanden, eenheden voor gebied, ellipsoïde, en enkele
moeilĳkere waarden voor parameters zoals uitvoer naar GeoPackage met specifieke lagen, gemakkelĳker.

• Als JSON kopiëren: alle instellingen voor de opdracht worden gekopieerd naar de indeling JSON, klaar om te
worden gebruikt door qgis_process. Dit is een handige manier om de verwachte indeling van de opdrachten
te bekĳken, zelfs voor complexe parameters (zoals parameters voor TIN interpolatie). U kunt ze gemakkelĳk
opslaan en ze later terugplaatsen door de waarden te plakken in het dialoogvenster van een algoritme.

• Test maken… met het betrokken algoritme en parameters, de instructies volgend van Processing README
file.

Apart van het bladeren door de items in het register, kunt u het proces ook opnieuw uitvoeren door simpelweg te
dubbelklikken op het item. Het dialoogvenster voor het algoritme opent dan met reeds ingestelde parameters en u
kunt elk van deze wĳzigen om aan uw behoefte te voldoen en het algoritme opnieuw uitvoeren.
Het dialoogvenster Geschiedenis verschaft ook een handige manier om bĳ te dragen aan de consolidatie van de
infrastructuur voor het testen van QGIS Processing algoritmes en scripts.
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26.4.2 Het log van de verwerking

Het dialoogvenster Geschiedenis bevat alleen de aanroepen voor uitvoering, maar niet de door het algoritme
geproduceerde informatie bĳ het uitvoeren. Die informatie wordt weggeschreven naar het log van QGIS (Beeld ►
Panelen ► Logboekmeldingen).
Algoritmes van derde partĳen worden gewoonlĳk uitgevoerd door hun interfaces voor de opdrachtregel te gebruiken,
die met de gebruiker communiceren via de console. Hoewel die console niet wordt weergegeven, wordt gewoonlĳk
een volledig dump ervan weggeschreven naar het log, elke keer als u een van deze algoritmes uitvoert. Om vervuiling
van het log met die informatie te voorkomen, kunt u het voor elke provider uitschakelen in dialoogvenster Opties.
Sommige algoritmes, zelfs als zĳ een resultaat kunnen produceren met de opgegeven invoerdata, voeren opmerkingen
of aanvullende informatie toe aan het log, wanneer zĳ potentiële problemen met de gegevens detecteren, om u te
waarschuwen. Zorg er voor dat u deze berichten in het log controleert als u onverwachte resultaten ondervindt.

26.5 Grafische modellen ontwerpen

Grafische modellen ontwerpen stelt u in staat complexe modellen te maken met behulp van een eenvoudige en
gemakkelĳk te gebruiken interface. Bĳ het werken met een GIS staan de meeste bewerkingen voor analyses niet
op zichzelf, maar maken deel uit van een reeks bewerkingen. Met Grafische modellen ontwerpen kan die keten van
bewerkingen worden verpakt in één enkel proces, wat het handiger maakt het later als één enkel proces uit te voeren
op een andere verzameling invoer. Het maakt niet uit hoeveel stappen en verschillende algoritmes er bĳ betrokken
zĳn, een model wordt uitgevoerd als één enkel algoritme, en bespaart tĳd en inspanning.
Grafische modellen bouwen kan worden geopend vanuit het menu Processing (Processing ► Grafische modellen
ontwerpen).
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26.5.1 De interface van Grafische modellen ontwerpen

Fig. 26.17: Grafische modellen ontwerpen

In zĳn hoofdgedeelte heeft de modelontwerper een werkvenster waar de structuur van het model en de werkstroom
die het weergeeft kunnen worden geconstrueerd.
Aan de bovenzĳde van het dialoogvenster geven verschillende menu’s en de werkbalk Navigatie toegang tot een
variëteit aan gereedschap[en.
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Menu Model

Label Sneltoets Werkbalk
Navigatie

Beschrijving

Model valideren Controleert of de in het model gebruikte algoritmes en
invoer bestaan. Handig voor het uitgeven van het model.

Model uitvoeren… F5 Voert het model uit
Invoer model opnieuw
sorteren…

Stelt de volgorde in waarin invoer wordt weergegeven
aan de gebruiker in het dialoogvenster voor het
algoritme.

Model openen… Ctrl+O Opent een bestand .model3 om te bewerken of uit te
voeren

Model opslaan Ctrl+S Slaat het model op schĳf op als een bestand .model3

Model opslaan als… Ctrl+Shift+S Slaat het model op schĳf op als een nieuw bestand .
model3

Model opslaan in
project

Bedt het modelbestand in het projectbestand in, wat het
beschikbaar maakt bĳ het delen van het projectbestand.

Model Help
bewerken…

Een interface om het model, de algoritmes, de
parameters en uitvoer, als ook de auteur en versie te
documenteren

Exporteren ►

► Als afbeelding
exporteren…

Slaat het grafische ontwerp van het model op naar
een indeling voor een afbeelding (voor illustratie-
doeleinden)

► Als PDF
exporteren…

Slaat het grafische ontwerp van het model op naar een
indeling voor PDF (voor illustratie-doeleinden)

► Als SVG
exporteren…

Slaat het grafische ontwerp van het model op naar een
indeling voor SVG (voor illustratie-doeleinden)

► Als scriptalgoritme
exporteren…

Maakt een scriptbestand voor Python, inclusief de
instructies voor het model
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Menu Bewerken

Label Sneltoets Werkbalk
Navigatie

Beschrijving

Alles selecteren Ctrl+A Selecteert alle componenten van het model in de
ontwerper

Geselecteerde
componenten aan raster
snappen

snapt en lĳnt de elementen uit aan een raster

Opnieuw Ctrl+Y Draai de laatste geannuleerde actie terug. Bekĳk ook het
paneel Ongedaan maken/Opnieuw.

Ongedaan maken Ctrl+Z Annuleer de laatste wĳziging. Bekĳk ook het paneel
Ongedaan maken/Opnieuw.

Knippen Ctrl+X Knipt een selectie componenten uit het model.

Kopiëren Ctrl+C Kopieert een selectie componenten uit het model.

Plakken Ctrl+V Plakt een geknipte of gekopieerde selectie componenten
uit een model naar een ander of in hetzelfde model.
De geselecteerde componenten behouden hun originele
eigenschappen en opmerkingen.

Geselecteerde
componenten verwĳderen

Del Verwĳdert een component uit het model.

Groepsvak toevoegen Voegt een vak toe aan de achtergrond van gerelateerde
componenten om ze visueel te groeperen. In het
bĳzonder nuttig in grote modellen om de werkstroom
helder te houden.

Menu Beeld

Label Sneltoets Werkbalk
Navigatie

Beschrijving

Zoom naar ► Zoomt naar het bereik van het geselecteerde groepsvak

Inzoomen Ctrl++

Uitzoomen Ctrl+-

Zoomen naar 100% Ctrl+1

Volledig zoomen Ctrl+0 Geeft alle componenten weer in het huidige venster van
de ontwerper

Opmerkingen
weergeven

Geeft opmerkingen weer die zĳn geassocieerd met elk
algoritme of invoer in Grafische modellen bouwen

Snappen inschakelen

Zichtbaarheid paneel
aan/uit

Ctrl+Tab Schakelt de panelen in de ontwerper AAN of UIT
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Panelen

Het linkergedeelte van het venster is een gedeelte met vĳf panelen dat kan worden gebruikt om nieuwe elementen
aan het model toe te voegen:

1. Modeleigenschappen: specificeer de naam (vereist) van het model en de groep waarin het moet worden
weergegeven in de Toolbox van Processing

2. Invoer: alle invoerparameters die uw model zouden kunnen vormen
3. Algoritmes: de beschikbare algoritmes van Processing

4. Variabelen: Modellen mogen toegewezen variabelen bevatten die uniek zĳn en alleen voor hen beschikbaar
zĳn. Toegang tot deze variabelen kan worden verkregen door een binnen het model gebruikte expressie. Ze zĳn
nuttig om algoritmes binnen een model te beheren en meerdere aspecten van het model te beheren door het
wĳzigen van één enkele variabele. De variabelen kunnen worden bekeken en bewerkt in het paneel Variabelen.

5. Geschiedenis Ongedaan maken: dit paneel zal alles registreren dat in de Grafische modellen bouwen gebeurt,
wat het eenvoudiger maakt dingen te annuleren die u fout hebt gedaan.

Over beschikbare algoritmes

Sommige algoritmes, die kunnen worden uitgevoerd vanuit de Toolbox, verschĳnen niet in de lĳst met beschikbare
algoritmes wanneer u enmodel ontwerpt. Een algoritmemoet de correcte semantiek hebben om te worden opgenomen
in een model. Als een algoritme niet een dergelĳke goed gedefinieerde semantiek heeft (bĳvoorbeeld als het aantal
uitvoerlagen niet vooraf bekend is), dan is het niet mogelĳk om het binnen een model te gebruiken, en zal het niet
verschĳnen in de lĳst met algoritmes die u kunt vinden in het dialoogvenster van Grafische modellen bouwen. Aan
de andere kant zĳn sommige algoritmes specifiek voor Grafische modellen bouwen. Die algoritmes zĳn geplaatst in
de groep ‘Gereedschappen Grafische modellen bouwen’.

26.5.2 Een model maken

Het maken van een model omvat twee basisstappen:
1. Definitie van noodzakelĳke invoer. Deze invoer zal worden toegevoegd aan het venster Parameters, zodat de

gebruiker zĳn waarden kan instellen bĳ het uitvoeren van het model. Het model zelf is een algoritme, dus het
venster Parameters wordt automatisch gegenereerd zoals met alle beschikbare algoritmes in het framework
Processing.

2. Definitie van de werkstroom. Met behulp van de invoergegevens van het model wordt de werkstroom
gedefinieerd door het toevoegen van algoritmes en selecteren hoe zĳ de gedefinieerde invoer gebruiken of
hoe zĳ de uitvoer, gegenereerd door andere algoritmes in het model, gebruiken.

Definitie van invoer

De eerste stap is het definiëren van de invoer voor het model. De volgende elementen zĳn te vinden in het paneel
Invoer aan de linkerkant van het venster Grafische modellen bouwen:

Tabel 26.1: Lĳst met typen parameter voor bouwen van modellen
Annotation Layer Authentication Configuration Boolean Color Connection Name
Coordinate Operation CRS Database Schema Database Table Datetime
Distance Duration DXF Layers Enum Expression
Extent Field Aggregates Fields Mapper File/Folder Geometry
Map Layer Map Theme Matrix Mesh Dataset Groups Mesh Dataset Time
Mesh Layer Multiple Input Number Point Point Cloud Layer
Print Layout Print Layout Item Range Raster Band Raster Layer
Scale String TIN Creation Layers Vector Features Vector Field

Vervolgt op volgende pagina
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https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterAnnotationLayer.html#qgis.core.QgsProcessingParameterAnnotationLayer
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterAuthConfig.html#qgis.core.QgsProcessingParameterAuthConfig
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterBoolean.html#qgis.core.QgsProcessingParameterBoolean
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterColor.html#qgis.core.QgsProcessingParameterColor
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterProviderConnection.html#qgis.core.QgsProcessingParameterProviderConnection
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterCoordinateOperation.html#qgis.core.QgsProcessingParameterCoordinateOperation
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterCrs.html#qgis.core.QgsProcessingParameterCrs
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterDatabaseSchema.html#qgis.core.QgsProcessingParameterDatabaseSchema
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterDatabaseTable.html#qgis.core.QgsProcessingParameterDatabaseTable
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterDateTime.html#qgis.core.QgsProcessingParameterDateTime
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterDistance.html#qgis.core.QgsProcessingParameterDistance
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterDuration.html#qgis.core.QgsProcessingParameterDuration
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterDxfLayers.html#qgis.core.QgsProcessingParameterDxfLayers
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterEnum.html#qgis.core.QgsProcessingParameterEnum
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterExpression.html#qgis.core.QgsProcessingParameterExpression
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterExtent.html#qgis.core.QgsProcessingParameterExtent
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterAggregate.html#qgis.core.QgsProcessingParameterAggregate
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterFieldMapping.html#qgis.core.QgsProcessingParameterFieldMapping
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterFile.html#qgis.core.QgsProcessingParameterFile
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterGeometry.html#qgis.core.QgsProcessingParameterGeometry
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterMapLayer.html#qgis.core.QgsProcessingParameterMapLayer
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterMapTheme.html#qgis.core.QgsProcessingParameterMapTheme
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterMatrix.html#qgis.core.QgsProcessingParameterMatrix
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterMeshDatasetGroups.html#qgis.core.QgsProcessingParameterMeshDatasetGroups
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterMeshDatasetTime.html#qgis.core.QgsProcessingParameterMeshDatasetTime
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterMeshLayer.html#qgis.core.QgsProcessingParameterMeshLayer
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterMultipleLayers.html#qgis.core.QgsProcessingParameterMultipleLayers
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterNumber.html#qgis.core.QgsProcessingParameterNumber
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterPoint.html#qgis.core.QgsProcessingParameterPoint
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterPointCloudLayer.html#qgis.core.QgsProcessingParameterPointCloudLayer
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterLayout.html#qgis.core.QgsProcessingParameterLayout
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterLayoutItem.html#qgis.core.QgsProcessingParameterLayoutItem
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterRange.html#qgis.core.QgsProcessingParameterRange
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterBand.html#qgis.core.QgsProcessingParameterBand
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterRasterLayer.html#qgis.core.QgsProcessingParameterRasterLayer
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterScale.html#qgis.core.QgsProcessingParameterScale
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterString.html#qgis.core.QgsProcessingParameterString
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterTinInputLayers.html#qgis.core.QgsProcessingParameterTinInputLayers
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterFeatureSource.html#qgis.core.QgsProcessingParameterFeatureSource
https://qgis.org/pyqgis/3.28/core/QgsProcessingParameterField.html#qgis.core.QgsProcessingParameterField


QGIS Desktop 3.28 User Guide

Tabel 26.1 – Vervolgd van vorige pagina
Vector Layer Vector Tile Writer Layers

Notitie: Met de muis over de invoer gaan zal een helptip weergeven met aanvullende informatie.

Bĳ dubbelklikken op een element wordt een dialoogvenster weergegeven dat u de karakteristieken laat definiëren.
Afhankelĳk van de parameter, zal het dialoogvenster tenminste één element bevatten (de beschrĳving, wat datgene
is dat de gebruiker zal zien bĳ het uitvoeren van het model). Bĳvoorbeeld bĳ het toevoegen van een numerieke
waarde, zoals is te zien in de volgende afbeelding, moet u, in aanvulling op de beschrĳving van de parameter, een
standaardwaarde en het bereik van geldige waarden instellen.

Fig. 26.18: Definiëren parameters model
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U kunt uw invoer opgeven als verplicht voor uw model door de optie Verplicht te selecteren en door het
keuzevak Geavanceerd te selecteren kunt u er voor zorgen dat de invoer binnen het gedeelte Geavanceerd
staat. Dit is in het bĳzonder nuttig als het model veel parameters heeft en enkele daarvan belangrĳk zĳn, maar u ze
toch wilt kiezen.
Voor elke toegevoegde invoer wordt een nieuw element toegevoegd aan de werkruimte van Grafische modellen
bouwen.

Fig. 26.19: Parameters Grafische modellen bouwen

U kunt ook invoer toevoegen door het type invoer te slepen vanuit de lĳst en neer te zetten op de positie waar u
het wilt plaatsen in het venster van Grafische modellen bouwen. Als u een parameter van een bestaande invoer wilt
wĳzigen, dubbelklik er dan eenvoudigweg op en hetzelfde dialoogvenster zal verschĳnen.
Bĳ het gebruiken van een model in een ander model, worden de benodigde in- en uitvoer worden weergegeven in het
kaartvenster.

Definitie van de werkstroom

In het volgende voorbeeld zullen we twee invoeren en twee algoritmes toevoegen. Het doel van het model is om de
hoogtewaarden uit een DEM rasterlaag te kopiëren naar een lĳnlaag met het algoritme Drape, en dan de totale
stĳging van de lĳnlaag te berekenen met het algoritme Klimmen langs lijn.
Kies, op de tab Invoer, de twee invoeren als Vectorlaag voor de lĳn en Rasterlaag voor de DEM. We zĳn
nu klaar om de algoritmes toe te voegen aan de werkstroom.
Algoritmes kunnen worden gevonden op de tab Algoritmes, nagenoeg op dezelfde wĳze gegroepeerd als in de Toolbox
van Processing.
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Fig. 26.20: Invoer modellen

Dubbelklik op de naam van een algoritme en sleep en zet het neer, net zoals bĳ invoer, om een algoritme aan eenmodel
toe te voegen. Net als voor de invoeren kunt u de beschrĳving van het algoritme wĳzigen en een opmerking toevoegen.
Bĳ het toevoegen van een algoritme, zal een dialoogvenster voor de uitvoering verschĳnenmet een soortgelĳke inhoud
als die in het paneel voor uitvoering dat wordt weergegeven bĳ het uitvoeren van het algoritme vanuit de Toolbox. De
volgende afbeelding geeft de dialoogvensters weer voor ‘Drape (Z-waarde instellen vanuit raster)’ en ‘Klimmen langs
lĳn’.
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Fig. 26.21: Parameters algoritme model

Zoals u kunt zien zĳn er echter enkele verschillen. Elke parameter heeft een keuzemenu naast zich die het mogelĳk
maakt te beheren hoe het zal worden geserveerd tĳdens de werkstroom:

• Waarde: stelt u in staat een statische waarde toe te wĳzen aan de parameter. Afhankelĳk van het type
parameter zal de widget u een getal laten invoeren (5.0``), een tekenreeks (mytext), la(a)g(en) selecteren die
zĳn geladen in het project van QGIS of vanuit een map, items kiezen vanuit een lĳst, …

• Vooraf berekende waarde: opent het dialoogvenster Expressiebouwer en laat u een expressie definiëren om de
parameter te vullen. Invoer voor modellen, samen met enkele andere statistieken voor de laag, zĳn beschikbaar
als variabelen en worden vermeld aan de bovenzĳde van het dialoogvenster Zoeken van de Expressiebouwer.
De expressie wordt eenmaal geëvalueerd voordat het kind-algoritme wordt uitgevoerd en gebruikt gedurende
het uitvoeren van dat algoritme.

• Model invoer: maakt het mogelĳk een aan het model toegevoegde invoer als een parameter te gebruiken.
Eenmaal aangeklikt zal deze optie alle geschikte invoer voor de parameter vermelden.

• Uitvoer algoritme: maakt het mogelĳk de uitvoer van een ander algoritme als invoer voor het huidige algoritme
te gebruiken. Net als bĳ Model invoer zal deze optie alle geschikte invoer voor de parameter vermelden.

• De parameter uitvoer heeft ook de hierboven vermelde opties in zĳn keuzemenu:
– statische uitvoeren voor kind-algoritmes toevoegen, bĳv. altĳd de uitvoer een een kind-algoritme opslaan
naar een vooraf gedefinieerde laag van een GeoPackage of Postgres

– een expressie gebruiken, gebaseerd op uitvoerwaarden voor kind-algoritmes, bĳv. genereren van een
automatische bestandsnaam, gebaseerd op de datum van vandaag en uitvoeren naar dat bestand opslaan

– een model invoer gebruiken, bĳv. de model invoer Bestand/Map om een bestand of map voor de uitvoer
te specificeren

– een andere uitvoer van een algoritme gebruiken, bĳv. de uitvoer van het algoritme Map maken (uit
Grafische modellen bouwen)

– een aanvullende optie Uitvoer model maakt de uitvoer van het algoritme beschikbaar in het
model. Als een door het algoritme gemaakte laag alleen moet worden gebruikt als invoer voor een ander
algoritme, bewerk dat tekstvak dan niet.
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In de volgende afbeelding ziet u de twee parameters voor de invoer gedefinieerd als Invoer model en de
tĳdelĳke uitvoerlaag:

Fig. 26.22: Invoer- en uitvoerparameters algoritme

U zult ook een aanvullende parameter vinden, genaamd Afhankelĳkheden die niet beschikbaar is bĳ het aanroepen
van het algoritme in de Toolbox. Deze parameter stelt u in staat de volgorde te definiëren waarin algoritmes moeten
worden uitgevoerd, door expliciet een algoritme te definiëren als een ouder van het huidige. Dit zal het uitvoeren van
het ouder-algoritme vóór het huidige forceren.
Wanneer u de uitvoer van een eerder algoritme gebruikt als de invoer voor uw algoritme, stelt dat impliciet het
eerdere algoritme in als ouder van het huidige (en plaatst de overeenkomende pĳl in de werkruimte van Grafische
modellen bouwen). In sommige gevallen kan een algoritme echter afhankelĳk zĳn van een ander, zelfs als het er geen
uitgevoerd object van gebruikt (bĳvoorbeeld een algoritme dat een zin in SQL uitvoert op een database van PostGIS
en een ander dat een laag importeert in dezelfde database). Selecteer in dat geval slechts het eerdere algoritme in de
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parameter Afhankelĳkheden en zĳ zullen in de juiste volgorde worden uitgevoerd.
Klik, als eenmaal aan alle parameters geldige waarden zĳn toegewezen, opOK en het algoritme zal worden toegevoegd
aan de werkruimte. Het zal worden gekoppeld aan elementen in de werkruimte (algoritme of invoer) dat objecten
verschaft die worden gebruikt als invoer voor het algoritme.

Elementen kunnen naar een andere positie in het werkvenster worden gesleept met het gereedschap
Item selecteren/verplaatsen. Dit is nuttig om de structuur van het model helderder te maken en meer intuïtief. U kunt ook
de grootte van elementen wĳzigen, door hun rand vast te pakken. Dit is bĳzonder nuttig als de beschrĳving van de
invoer of het algoritme lang is. Met de optie Beeld► Snappen inschakelen geselecteerd, kan het wĳzigen van grootte
of het verplaatsen worden gebonden aan een virtueel raster, voor een meer visueel gestructureerd ontwerp van het
algoritme.
Koppelingen tussen elementen worden automatisch bĳgewerkt en u kunt een knop + zien boven- en onderin elk
algoritme. Klikken op de knop zal alle invoer en uitvoer van het algoritme vermelden zodat u een snel overzicht heeft.

Fig. 26.23: Een volledig model

Met het gereedschap Bewerken ► Groepsvak toevoegen kunt u een te verslepen vak toevoegen aan het werkvenster.
Deze mogelĳkheid is heel nuttig in grote modellen om gerelateerde elementen in het werkvenster van Grafische
modellen bouwen te groeperen en om de werkstroom helder te houden. We zouden bĳvoorbeeld alle invoer voor het
voorbeeld kunnen groeperen:
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Fig. 26.24: Model groepsvak

U kunt de naam en kleur van de vakken wĳzigen. Groepsvakken zĳn bĳzonder nuttig als zĳ samen worden gebruikt
met het gereedschap Beeld► Zoomen naar►, wat het voor u mogelĳk maakt te zoomen naar een specifiek gedeelte
van het model. U kunt ook in- en uitzoomen met het muiswiel.
U wilt misschien de volgorde van de invoeren veranderen en hoe zĳ zĳn vermeld in het hoofddialoogvenster van het
model. Aan de onderzĳde van het paneel Invoer vindt u de knop Invoer model opnieuw sorteren…
en door daarop te klikken verschĳnt een nieuw dialoogvenster dat u in staat stelt de volgorde van de invoeren te
veranderen:
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Fig. 26.25: Invoer model opnieuw sorteren

Opmerkingen kunnen ook worden toegevoegd aan invoer of algoritmes die aanwezig zĳn in Grafische modellen
bouwen. Dit kan worden gedaan door te gaan naar de tab Opmerking van het item of door met rechts te klikken. Op
dezelfde tab kan handmatig een kleur worden ingesteld voor individuele opmerkingen in het model. Opmerkingen zĳn
alleen zichtbaar in het werkvenster van Grafische modellen bouwen en niet in het dialoogvenster van het uiteindelĳke
algoritme; zĳ kunnen worden verborgen door het uitschakelen van Beeld ► Opmerkingen weergeven.

U kunt uw algoritme op elk moment uitvoeren door te klikken op de knop Model uitvoeren. Bĳ het gebruiken van de
bewerker om een model uit te voeren, zullen niet standaard waarden worden opgeslagen in de invoer. Dit betekent dat
uitvoeren van het model op een latere tĳd vanuit de bewerker het dialoogvenster vooraf zal vullen met die waarden
voor elke volgende uitvoering.
Om het algoritme te gebruiken vanuit de Toolbox, moet het zĳn opgeslagen en het dialoogvenster Grafische modellen
bouwen zĳn gesloten, om het voor de Toolbox mogelĳk te maken de inhoud te vernieuwen.
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Uw model documenteren

U moet uw model documenteren, en dat kan worden gedaan in Grafische modellen bouwen zelf. Klik op de knop
Model Help bewerken, en een dialoogvenster dat lĳkt op het volgende zal verschĳnen.

Fig. 26.26: Help bewerken

Aan de rechterkant ziet u een eenvoudige HTML-pagina, die is gemaakt met behulp van de beschrĳving van de
parameters voor de invoer en de uitvoer van het algoritme, tezamen met enkele aanvullende items zoals een algemene
beschrĳving van het model of de auteur ervan. De eerste keer dat u de bewerker voor de Help opent, zĳn al deze
beschrĳvingen leeg, maar u kunt ze bewerken met behulp van de elementen aan de linkerkant van het dialoogvenster.
Selecteer een element in het bovenste gedeelte en schrĳf dan de beschrĳving ervan in het tekstvak onderin.
Help voor een model wordt opgeslagen als deel van het model zelf.
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26.5.3 Opslaan en laden van modellen

Modellen opslaan

Gebruik de knop Model opslaan om het huidige model op te slaan en de knop Model openen om een eerder
opgeslagen model te openen. Modellen worden opgeslagen met de extensie .model3. Als het model al werd
opgeslagen vanuit het venster Grafische modellen bouwen, zult u niet naar een bestandsnaam worden gevraagd. Het
bestand zal worden gebruikt voor volgende opslag, omdat er al een bestand is geassocieerd met het model.
Vóór het opslaan van een model moet u een naam en een groep er voor invoeren in de tekstvakken in het bovenste
gedeelte van het venster.
Modellen die zĳn opgeslagen in de map models (de standaardmap als u wordt gevraagd naar een bestandsnaam
om het model op te slaan) zullen in de corresponderende tak in de Toolbox verschĳnen. Wanneer de Toolbox wordt
gestart, zoekt het in de map models naar bestanden met de extensie .model3 en laadt de modellen die zĳ bevatten.
Omdat een model in zichzelf een algoritme is, kan het aan de Toolbox worden toegevoegd, net als elk ander algoritme.

Modellen kunnen ook in het projectbestand worden opgeslagen met behulp van de knop Model in project opslaan.
Modellen die worden opgeslagen met deze methode zullen niet als bestanden .model3 naar de schĳf worden
weggeschreven, maar zullen worden ingebed in het projectbestand .qgz.

Projectmodellen zĳn beschikbaar in het menu Projectmodellen van de Toolbox en in het menu-item Project ►
Modellen.
De map Modellen kan worden ingesteld in het dialoogvenster Opties van Processing onder de groep Modellen.
Modellen die zĳn geladen uit de map models verschĳnen niet alleen in de Toolbox, maar ook in de boom met
algoritmes op de tab Algoritmes van het venster Grafische modellen bouwen. Dat betekent dat u een model kunt
invoegen als deel van een groter model, net zoals andere algoritmes.
Modellen zullen worden weergegeven in het paneel Browser en kunnen van daaruit worden uitgevoerd.

Een model als script voor Python exporteren

Zoals we in een later hoofdstuk zullen zien kunnen algoritmes van Processing worden aangeroepen vanuit de console
voor Python van QGIS en nieuwe algoritmes van Processing kunnen worden gemaakt met Python. Een snelle manier
om zo’n script voor Python te maken is om een model te maken en dat te exporteren als bestand voor Python.

Klik, om dat te doen, op Als scriptalgoritme exporteren… in de werkruimte of klik met rechts op de naam van het model
in de Toolbox van Processing en kies Model als algoritme voor Python exporteren….

Een model als afbeelding, PDF of SVG exporteren

Een model kan ook worden geëxporteerd als een afbeelding, SVG of PDF (ter illustratie) door te klikken op
Als afbeelding exporteren, Als PDF exporteren of Als SVG exporteren.

26.5.4 Bewerken van een model

U kunt het model, dat u momenteel maakt, bewerken, de werkstroom opnieuw definiëren en de relaties tussen de
algoritmes en invoer die het model definiëren.
Als u met rechts klikt op een algoritme in de werkruimte, zult u een contextmenu zien zoals dat wat hieronder wordt
weergegeven:
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Fig. 26.27: Grafische modellen bouwen, klik met rechts

Selecteren van de optie Verwĳderen zal het geselecteerde algoritme verwĳderen. Een algoritme kan alleen worden
verwĳderd als er geen andere algoritmes van afhankelĳk zĳn. Dat is, als er geen uitvoer van het algoritme wordt
gebruikt in een ander als invoer. Als u probeert een algoritme te verwĳderen waarvan andere afhankelĳk zĳn, zal een
waarschuwingsbericht, zoals dat wat hieronder wordt weergegeven, worden getoond:

Fig. 26.28: Kan algoritme niet verwijderen

Selecteren van de optie Bewerken… zal het dialoogvenster Parameter van het algoritme weergeven, zodat u de invoer-
en parameterwaarden kunt wĳzigen. Niet alle beschikbare elementen voor invoer in het model zullen verschĳnen
als beschikbare invoer. Lagen of waarden die worden gemaakt in een meer gevorderde stap in de werkstroom die is
gedefinieerd door het model, zal niet beschikbaar zĳn als zĳ cirkelverwĳzingen veroorzaken.
Selecteer de nieuwe waarden en klik op de knop OK zoals gewoonlĳk. De verbindingen tussen de elementen van het
model zullen overeenkomstig wĳzigen in de werkruimte van Grafische modellen bouwen.
Opmerking toevoegen… stelt u in staat een opmerking toe te voegen aan het algoritme om het gedrag beter te
beschrĳven.
Een model kan gedeeltelĳk worden uitgevoerd door enkele van zĳn algoritmes uit te schakelen. Selecteer de optie
Deactiveren in het contextmenu dat verschĳnt door met rechts te klikken op een element van een algoritme om dit te
doen. Het geselecteerde algoritme, en alle in het model die daarvan afhankelĳk zĳn, zullen grĳs worden weergegeven
en zullen niet worden uitgevoerd als deel van het model.
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Fig. 26.29: Model met uitgeschakelde algoritmes

Door met rechts te klikken op een algoritme dat niet actief is, zult u een menuoptie Activate zien die u kunt gebruiken
om het opnieuw te activeren.

26.6 De interface Batch-processing

26.6.1 Introductie

Alle algoritmes (inclusief modellen) kunnen worden uitgevoerd als een batch-proces. Dat is, zĳ kunnen niet slechts
met één enkele set van invoer worden uitgevoerd, maar met meerdere daarvan, het algoritme net zo vaak uitvoerende
als nodig is. Dit is handig bĳ het verwerken van grote hoeveelheden gegevens, omdat het niet nodig is het algoritme
vele keren vanuit de Toolbox te starten.
Kik met rechts op de naam in de Toolbox en selecteer de optie Uitvoeren als batch-proces in het pop-upmenu dat
verschĳnt om een algoritme als een batch-proces uit te voeren.

Fig. 26.30: Batch-proces met rechtsklikken

Indien u het dialoogvenster van de uitvoering van het algoritme hebt geopend, kunt u van daar uit ook de interface
voor het batch-proces starten, klik op de knop Run as batch process….
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Fig. 26.31: Batch-proces vanuit dialoogvenster van algoritme

26.6.2 De tabel met parameters

Uitvoeren van een batch-proces is soortgelĳk aan het eenmalig uitvoeren van een algoritme.Waarden voor parameters
moeten worden gedefinieerd, maar in dit geval hoeven we niet één enkele waarde voor elke parameter op te geven,
maar in plaats daarvan een set, één voor elke keer dat het algoritme moet worden uitgevoerd. Waarden worden
ingevoerd met behulp van een tabel zoals die welke hierna wordt weergegeven, waar elke rĳ een doorloop is en
kolommen de parameters van het algoritme zĳn.

Fig. 26.32: In batch verwerken

Vanaf de bovenste werkbalk kunt u:

• Regel toevoegen: voegt een nieuw item voor configuratie voor Processing toe.

• Rĳ(en) verwĳderen: verwĳdert geselecteerde rĳen uit de tabel. Selecteren van rĳen wordt gedaan door te klikken
op het nummer links en staat de combinatie voor het toetsenbord voor meervoudige selectie toe.

• Open een configuratiebestand voor verwerken van batch in Processing

• Opslaan de configuratie van batch voor Processing opslaan naar een bestand .JSON dat later kan worden
uitgevoerd
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Standaard bevat de tabel slechts twee rĳen:
• De eerste rĳ geeft in elke cel een keuzemenu Autom. vullen…►met opties om snel de cellen eronder te vullen.
Beschikbare opties zĳn afhankelĳk van het type parameter.

• De tweede regel (als ook elke daarop volgende) vertegenwoordigt één enkele uitvoering van het algoritme, en
elke cel bevat de waarde van één van de parameters. Het is soortgelĳk aan het dialoogvenster Parameters dat
u ziet bĳ het uitvoeren van een algoritme vanuit de Toolbox, maar met een andere schikking.

Aan de onderzĳde van de tabel, kunt u instellen of Lagen laden bĳ voltooien moet worden uitgevoerd.
Als de grootte van de tabel eenmaal is ingesteld, moet die worden gevuld met de gewenste waarden.

26.6.3 Vullen van de tabel met parameters

Voor de meeste parameters is het instellen triviaal. De van toepassing zĳnde widget, hetzelfde als in het dialoogvenster
voor één proces, wordt verschaft, wat het mogelĳk maakt eenvoudigweg de waarde in te typen, of die te selecteren
uit een lĳst met mogelĳke waarden, afhankelĳk van het type parameter. Dit is inclusief, indien compatibel, voor de
widget data-bepaald.
Voor het automatiseren van de definitie van het proces voor de batch en het vermĳden van het cel na cel vullen van
de tabel, wilt u misschien het menu Autom. vullen… van een parameter openen met het pĳltje ernaast en een van de
volgende opties selecteren om waarden in de kolom te vervangen:

• Naar beneden vullen zal de invoer voor het eerste proces nemen en dat in alle andere processen invoeren.

• Berekenen met expressie… zal u toestaan een nieuwe expressie voor QGIS te maken om te gebruiken voor
het bĳwerken van alle bestaande waarden binnen die kolom. Bestaande waarden voor parameters (inclusief die
uit andere kolommen) zĳn beschikbaar om te gebruiken binnen de expressie via variabelen. Bĳv. instellen van
het aantal segmenten, gebaseerd op de bufferafstand van elke laag:

CASE WHEN @DISTANCE > 20 THEN 12 ELSE 8 END

• Waarden toevoegen met expressie… zal nieuwe rĳen toevoegen met de waarden vanuit een expressie die
een array teruggeeft (tegengesteld aan Bereken met expressie…, die alleen op bestaande rĳen werkt). Het
bedoelde geval voor het gebruiken is om het mogelĳk te maken het dialoogvenster voor de batch te vullen
met complexe numerieke series. Bĳvoorbeeld het toevoegen van rĳen voor elke batch-buffer met de expressie
generate_series(100, 1000, 50) voor de parameter voor de afstand resulteert in nieuwe rĳen met
de waarden 100, 150, 200, … 1000.

• Bĳ het instellen van parameters voor een bestand of laag worden opties verschaft:
– Bestanden toevoegen op patroon…: voegt nieuwe rĳen toe aan de tabel voor bestanden waarvan de naam
overeenkomt met een Patroon bestand in een map Kĳken in. Bĳv. *.shp zal alle bestanden SHP in de
map toevoegen aan de lĳst. Selecteer Recursief zoeken om ook in submappen te zoeken.

– Bestanden selecteren… individueel op schĳf
– Alle bestanden uit een map toevoegen…

– Uit geopende lagen selecteren… in het actieve project
Parameters voor de uitvoergegevens geven dezelfde mogelĳkheden weer als bĳ het uitvoeren van het algoritme als
één enkel proces. Afhankelĳk van het algoritme, kan de uitvoer:

• worden overgeslagen, als de cel leeg is
• als een tĳdelĳk bestand worden opgeslagen: vult de cel met TEMPORARY_OUTPUT en onthoud om het
keuzevak Lagen laden bĳ voltooien te selecteren.

• worden opgeslagen als een gewoon bestand (.SHP, .GPKG, .XML, .PDF, .JPG,…) waarvan het pad kan
worden ingesteld met de opties voor Autom. vullen zoals eerder weergegeven. Bĳv. gebruiken van Berekenen
met expressie… om de namen voor uitvoerbestanden voor complexe expressies in te stellen als:
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'/home/me/stuff/buffer_' || left(@INPUT, 30) || '_' || @DISTANCE || '.shp'

U kunt ook het bestandspad direct intypen of het dialoogvenster voor het kiezen van een bestand gebruiken
dat verschĳnt bĳ het klikken op de betreffende knop …. Als u eenmaal het bestand hebt geselecteerd, wordt
een nieuw dialoogvenster weergegeven om automatisch vullen voor andere cellen in dezelfde kolom mogelĳk
te maken (dezelfde parameter).

Fig. 26.33: Opslaan Batch-proces

Als de standaardwaarde (Niet automatisch aanvullen) is geselecteerd, zal het eenvoudigweg de geselecteerde
bestandsnaam in de geselecteerde cel van de tabel met parameters zetten. Als een van de andere opties is
geselecteerd, zullen alle cellen onder de geselecteerde automatisch worden gevuld, gebaseerd op gedefinieerde
criteria.

– Vullen met getallen: voegt een automatisch verhogend nummer toe aan de bestandsnaam
– Vullen met parameterwaarden: u kunt een parameter selecteren waarvan de waarde in dezelfde rĳ wordt
toegevoegd aan de bestandsnaam. Dit is in het bĳzonder nuttig voor het benoemen van objecten van de
uitvoergegevens overeenkomstig die van de invoer.

• worden opgeslagen als een laag binnen een container voor een database:

# Indicate a layer within a GeoPackage file
ogr:dbname='C:/Path/To/Geopackage.gpkg' table="New_Table" (geom)

# Use the "Calculate By Expression" to output to different layers in a␣
↪→GeoPackage
'ogr:dbname=\'' || @project_folder || '/Buffers.gpkg\' table="' || @INPUT || '_
↪→' || @DISTANCE || '" (geom)'

26.6.4 Uitvoeren van het batch-proces

Klik eenvoudigweg op Uitvoeren om het batch-proces uit te voeren als u eenmaal alle noodzakelĳke waarden
hebt ingevuld. Het paneel Log wordt geactiveerd en geeft details en stappen van de uitvoering weer van het
uitvoeringsproces. De voortgang van de globale taak voor de batch zal worden weergegeven in de voortgangsbalk
aan de onderzĳde van het dialoogvenster.

26.7 Processing algoritmes gebruiken vanaf de console

De console stelt gevorderde gebruikers in staat hun productiviteit te vergroten en complexe bewerkingen uit te voeren
die niet kunnen worden uitgevoerd met een van de andere elementen van de GUI van het framework Processing.
Modellen die verscheidene algoritmes omvatten kunnen worden gedefinieerd met behulp van de interface voor de
opdrachtregel, en aanvullende bewerkingen, zoals lussen en voorwaardelĳke zinnen, kunnen worden toegevoegd om
meer flexibele en meer krachtige werkstromen te maken.
Er is geen console voor Processing in QGIS, maar alle opdrachten voor Processing zĳn in plaats daarvan beschikbaar
vanuit de in QGIS ingebouwde console voor Python. Dat betekent dat u die opdrachten in uw werk op de console kunt
inpassen en algoritmes van Processing kunt verbinden aan alle andere mogelĳkheden (inclusief methoden uit de API
van QGIS) die van daaruit beschikbaar zĳn.
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De code die u kunt uitvoeren vanuit de console van Python, zelfs als het geen specifieke methode voor Processing
aanroept, kan worden geconverteerd naar een nieuw algoritme dat u later kunt aanroepen vanuit de Toolbox, Grafische
modellen bouwen of enige andere component, net zoals u doet met een andere algoritme. In feite zĳn enkele
algoritmes, die u in de Toolbox aantreft, eenvoudige scripts.
In dit gedeelte zullen we zien hoe we algoritmes van Processing gebruiken vanuit de console voor Python in QGIS,
en ook hoe we algoritmes schrĳven met behulp van Python.

26.7.1 Algoritmes aanroepen van de console van Python

Het eerste dat u moet doen is de functies voor Processing importeren met de volgende regel:

>>> from qgis import processing

Wel, er is in de basis slechts één (interessant) ding dat u daarmee kunt doen vanaf de console: een algoritme uitvoeren.
Dat wordt gedaan met de methode run(), die de naam van het uit te voeren algoritme als zĳn eerste parameter
opneemt, en dan een variabel aantal aanvullende parameters, afhankelĳk van de vereisten van het algoritme. Dus het
eerste wat u moet weten is de naam van het uit te voeren algoritme. Dat is niet de naam die u ziet in de Toolbox, maar
eerder een unieke naam voor de opdrachtregel. U kunt het processingRegistry gebruiken om de juiste naam
voor uw algoritme te zoeken. Typ de volgende regel in uw console:

>>> for alg in QgsApplication.processingRegistry().algorithms():
print(alg.id(), "->", alg.displayName())

U zult iets als dit zien (met enkele extra toegevoegde streepjes om de leesbaarheid te vergroten).

3d:tessellate --------------> Tessellate
gdal:aspect ----------------> Aspect
gdal:assignprojection ------> Assign projection
gdal:buffervectors ---------> Buffer vectors
gdal:buildvirtualraster ----> Build Virtual Raster
gdal:cliprasterbyextent ----> Clip raster by extent
gdal:cliprasterbymasklayer -> Clip raster by mask layer
gdal:clipvectorbyextent ----> Clip vector by extent
gdal:clipvectorbypolygon ---> Clip vector by mask layer
gdal:colorrelief -----------> Color relief
gdal:contour ---------------> Contour
gdal:convertformat ---------> Convert format
gdal:dissolve --------------> Dissolve
...

Dat is een lĳst met alle ID’s voor beschikbare algoritmes, gesorteerd op naam van de provider en naam van het
algoritme, samen met hun corresponderende namen.
Als u eenmaal de naam voor de opdrachtregel van het algoritme kent, is het volgende om te bepalen wat de juiste
syntaxis is om het uit te voeren. Dat betekent weten welke parameters nodig zĳn bĳ het aanroepen van de methode
run().
Er bestaat een methode om een algoritme in detail te beschrĳven, die kan worden gebruikt om een lĳst van de
parameters te verkrĳgen die een algoritme vereist en de soorten uitvoer die het zal maken. U kunt de methode
algorithmHelp(id_van_het_algoritme) gebruiken om deze informatie te krĳgen. Gebruik het ID van
het algoritme, niet de volledige beschrĳvende naam.
Demethode aanroepenmetnative:buffer als parameter (qgis:buffer is een alias voornative:buffer
en zal ook werken), geeft u de volgende beschrĳving:

>>> processing.algorithmHelp("native:buffer")
Buffer (native:buffer)

This algorithm computes a buffer area for all the features in an
input layer, using a fixed or dynamic distance.

(Vervolgt op volgende pagina)

930 Hoofdstuk 26. QGIS framework Processing

https://qgis.org/pyqgis/3.28/core/QgsProcessingAlgorithm.html#qgis.core.QgsProcessingAlgorithm.run
https://qgis.org/pyqgis/3.28/core/QgsProcessingRegistry.html#qgis.core.QgsProcessingRegistry


QGIS Desktop 3.28 User Guide

(Vervolgd van vorige pagina)

The segments parameter controls the number of line segments to
use to approximate a quarter circle when creating rounded
offsets.

The end cap style parameter controls how line endings are handled
in the buffer.

The join style parameter specifies whether round, miter or
beveled joins should be used when offsetting corners in a line.

The miter limit parameter is only applicable for miter join
styles, and controls the maximum distance from the offset curve
to use when creating a mitered join.

----------------
Input parameters
----------------

INPUT: Input layer

Parameter type: QgsProcessingParameterFeatureSource

Accepted data types:
- str: layer ID
- str: layer name
- str: layer source
- QgsProcessingFeatureSourceDefinition
- QgsProperty
- QgsVectorLayer

DISTANCE: Distance

Parameter type: QgsProcessingParameterDistance

Accepted data types:
- int
- float
- QgsProperty

SEGMENTS: Segments

Parameter type: QgsProcessingParameterNumber

Accepted data types:
- int
- float
- QgsProperty

END_CAP_STYLE: End cap style

Parameter type: QgsProcessingParameterEnum

Available values:
- 0: Round
- 1: Flat
- 2: Square

Accepted data types:
- int

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)
- str: as string representation of int, e.g. '1'
- QgsProperty

JOIN_STYLE: Join style

Parameter type: QgsProcessingParameterEnum

Available values:
- 0: Round
- 1: Miter
- 2: Bevel

Accepted data types:
- int
- str: as string representation of int, e.g. '1'
- QgsProperty

MITER_LIMIT: Miter limit

Parameter type: QgsProcessingParameterNumber

Accepted data types:
- int
- float
- QgsProperty

DISSOLVE: Dissolve result

Parameter type: QgsProcessingParameterBoolean

Accepted data types:
- bool
- int
- str
- QgsProperty

OUTPUT: Buffered

Parameter type: QgsProcessingParameterFeatureSink

Accepted data types:
- str: destination vector file, e.g. 'd:/test.shp'
- str: 'memory:' to store result in temporary memory layer
- str: using vector provider ID prefix and destination URI,

e.g. 'postgres:...' to store result in PostGIS table
- QgsProcessingOutputLayerDefinition
- QgsProperty

----------------
Outputs
----------------

OUTPUT: <QgsProcessingOutputVectorLayer>
Buffered

Nu heeft u alles wat u nodig heeft om een algoritme uit te voeren. Zoals we al eerder hebben verteld kunnen algoritmes
worden uitgevoerd met: run(). De syntaxis ervan is als volgt:

>>> processing.run(name_of_the_algorithm, parameters)

Waar parameters een woordenboek van parameters is, dat afhankelĳk is van het algoritme dat u wilt uitvoeren, en is
exact de lĳst die de methode algorithmHelp() u geeft.
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1 >>> processing.run("native:buffer", {'INPUT': '/data/lines.shp',
2 'DISTANCE': 100.0,
3 'SEGMENTS': 10,
4 'DISSOLVE': True,
5 'END_CAP_STYLE': 0,
6 'JOIN_STYLE': 0,
7 'MITER_LIMIT': 10,
8 'OUTPUT': '/data/buffers.shp'})

Wanneer een parameter optioneel is en u wilt hem niet gebruiken, neem die dan niet op in het woordenboek.
Wanneer een parameter niet gespecificeerd is zal de standaardwaarde worden gebruikt.
Afhankelĳk van het type parameter dienen waarden verschillend te worden ingevoerd. De volgende lĳst geeft een
snel overzicht van hoe waarden in te voeren voor elk type parameter:

• Raster Layer, Vector Layer of Table. Gebruik eenvoudigweg een tekenreeks met de naam die het te gebruiken
gegevensobject identificeert (de naam die het heeft in de inhoudsopgave van QGIS) of een bestandsnaam (als
de betreffende laag niet is geopend, hĳ zal worden geopend, maar niet worden toegevoegd aan het kaartvenster).
Als u een instantie van een object van QGIS heeft dat de laag vertegenwoordigt, kunt u die ook doorgeven als
parameter.

• Enumeratie. Als een algoritme een parameter voor enumeratie heeft moet de waarde van die parameter worden
ingevuld met een waarde integer. U kunt de opdracht algorithmHelp() gebruiken om de beschikbare
opties te weten te komen, zoals hierboven. Het algoritmenative:buffer heeft bĳvoorbeeld een enumeratie
genaamd JOIN_STYLE:

JOIN_STYLE: Join style

Parameter type: QgsProcessingParameterEnum

Available values:
- 0: Round
- 1: Miter
- 2: Bevel

Accepted data types:
- int
- str: as string representation of int, e.g. '1'
- QgsProperty

In dit geval heeft de parameter drie opties. Onthoud dat de volgorde begint met nul.
• Booleaanse waarde. Gebruik True of False.
• Multiple input. De waarde is een tekenreeks met beschrĳvingen voor de invoer die zĳn gescheiden door
puntkomma’s (;). Net als in het geval van enkele lagen of tabellen, kan elke beschrĳving voor de invoer de
naam van het gegevensobject of het bestandspad zĳn.

• Table Field from XXX. Gebruik een tekenreeks met de naam van het te gebruiken veld. Deze parameter is
hoofdlettergevoelig.

• Fixed Table. Type de lĳst voor alle waarden voor de tabel, gescheiden door komma’s (,) en omsluit ze met
aanhalingstekens ("). Waarden beginnen op de bovenste rĳ en gaan van rechts naar links. U kunt ook een
2D-array van waarden gebruiken die de tabel vertegenwoordigt.

• CRS. Voer het EPSG-codenummer van het gewenste CRS in.
• Extent. U dient een tekenreeks te gebruiken met de waarden xmin, xmax, ymin en ymax, gescheiden door
komma’s (,).

Booleaanse waarden, bestand, tekenreeks en numerieke parameters behoeven geen aanvullende uitleg.
Parameters voor invoer, zoals tekenreeksen, Booleaanse waarden of numerieke waarden hebben standaardwaarden.
De standaardwaarde wordt gebruikt als de corresponderende parameter ontbreekt.
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Typ, voor gegevensobjecten voor de uitvoer, het te gebruiken bestandspad om ze op te slaan, net zoals wordt gedaan
in de Toolbox. Als het object voor de uitvoer niet is gespecificeerd, zal het resultaat worden opgeslagen naar een
tĳdelĳk bestand (of overgeslagen als het een optionele uitvoer is). De extensie van het bestand bepaalt de indeling
van het bestand. Als u een extensie invoert die niet wordt ondersteund door het algoritme, zal de standaardindeling
voor het bestand voor dat type uitvoer worden gebruikt en de corresponderende extensie worden toegevoegd aan het
opgegeven bestandspad.
Anders dan wanneer een algoritme wordt uitgevoerd vanuit de Toolbox, wordt uitvoer niet toegevoegd
aan het kaartvenster als u datzelfde algoritme uitvoert vanaf de console voor Python met run(), maar
runAndLoadResults() zal dat wel doen.
De methode run() geeft een woordenboek terug met een of meer namen voor de uitvoer (die welke worden
weergegeven in de beschrĳving van het algoritme) als sleutels en de bestandspaden van die uitvoer als waarden.

1 >>> myresult = processing.run("native:buffer", {'INPUT': '/data/lines.shp',
2 'DISTANCE': 100.0,
3 'SEGMENTS': 10,
4 'DISSOLVE': True,
5 'END_CAP_STYLE': 0,
6 'JOIN_STYLE': 0,
7 'MITER_LIMIT': 10,
8 'OUTPUT': '/data/buffers.shp'})
9 >>> myresult['OUTPUT']
10 /data/buffers.shp

U kunt uitvoer van objecten laden door de corresponderende bestandspaden door te geven aan de methode load().
Of u zou runAndLoadResults() kunnen gebruiken in plaats van run() om ze onmiddellĳk te laden.
Wanneer u een dialoogvenster voor een algoritme wilt openen vanuit de console, kunt u de methode
createAlgorithmDialog gebruiken. De enige verplichte parameter is de naam van het algoritme, maar u
kunt ook het woordenboek van de parameters definiëren, zodat het dialoogvenster automatisch zal worden gevuld:

1 >>> my_dialog = processing.createAlgorithmDialog("native:buffer", {
2 'INPUT': '/data/lines.shp',
3 'DISTANCE': 100.0,
4 'SEGMENTS': 10,
5 'DISSOLVE': True,
6 'END_CAP_STYLE': 0,
7 'JOIN_STYLE': 0,
8 'MITER_LIMIT': 10,
9 'OUTPUT': '/data/buffers.shp'})
10 >>> my_dialog.show()

De methode execAlgorithmDialog opent het dialoogvenster onmiddellĳk:

1 >>> processing.execAlgorithmDialog("native:buffer", {
2 'INPUT': '/data/lines.shp',
3 'DISTANCE': 100.0,
4 'SEGMENTS': 10,
5 'DISSOLVE': True,
6 'END_CAP_STYLE': 0,
7 'JOIN_STYLE': 0,
8 'MITER_LIMIT': 10,
9 'OUTPUT': '/data/buffers.shp'})
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26.7.2 Scripts maken en die uitvoeren vanuit de Toolbox

U kunt uw eigen algoritmes maken door de corresponderende code voor Python te schrĳven. Scripts voor Processing
breiden QgsProcessingAlgorithm uit, dus u dient een paar extra regels toe te voegen om verplichte functies
te implementeren. U vindt een menu Nieuw script maken (blanco blad) en Nieuw script uit sjabloon maken (sjabloon
dat de verplichte functies van QgsProcessingAlgorithm bevat) in het keuzemenu Scripts boven in de Toolbox
van Processing. De Processing Script Editor zal openen en dat is waar u uw code moet schrĳven. Sla het script daar
vandaan op in de map scripts (de standaardmap wanneer u het dialoogvenster Bestand opslaan opent) met de
extensie .py zou het corresponderende algoritme moeten maken.
De naam van het algoritme (die welke u zult zien in de Toolbox) wordt gedefinieerd in de code.
Laten we eens kĳken naar de volgende code, die een algoritme voor Processing definieert die een bewerking voor een
buffer uitvoert met een door de gebruiker gedefinieerde afstand voor de buffer op een vectorlaag die is gespecificeerd
door de gebruiker, na eerste de laag afgevlakt te hebben.

1 from qgis.core import (QgsProcessingAlgorithm,
2 QgsProcessingParameterNumber,
3 QgsProcessingParameterFeatureSource,
4 QgsProcessingParameterFeatureSink)
5

6 from qgis import processing
7

8 class algTest(QgsProcessingAlgorithm):
9 INPUT_BUFFERDIST = 'BUFFERDIST'
10 OUTPUT_BUFFER = 'OUTPUT_BUFFER'
11 INPUT_VECTOR = 'INPUT_VECTOR'
12

13 def __init__(self):
14 super().__init__()
15

16 def name(self):
17 return "algTest"
18

19 def displayName(self):
20 return "algTest script"
21

22 def createInstance(self):
23 return type(self)()
24

25 def initAlgorithm(self, config=None):
26 self.addParameter(QgsProcessingParameterFeatureSource(
27 self.INPUT_VECTOR, "Input vector"))
28 self.addParameter(QgsProcessingParameterNumber(
29 self.INPUT_BUFFERDIST, "Buffer distance",
30 QgsProcessingParameterNumber.Double,
31 100.0))
32 self.addParameter(QgsProcessingParameterFeatureSink(
33 self.OUTPUT_BUFFER, "Output buffer"))
34

35 def processAlgorithm(self, parameters, context, feedback):
36 #DO SOMETHING
37 algresult = processing.run("native:smoothgeometry",
38 {'INPUT': parameters[self.INPUT_VECTOR],
39 'ITERATIONS':2,
40 'OFFSET':0.25,
41 'MAX_ANGLE':180,
42 'OUTPUT': 'memory:'},
43 context=context, feedback=feedback, is_child_algorithm=True)
44 smoothed = algresult['OUTPUT']
45 algresult = processing.run('native:buffer',
46 {'INPUT': smoothed,

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)
47 'DISTANCE': parameters[self.INPUT_BUFFERDIST],
48 'SEGMENTS': 5,
49 'END_CAP_STYLE': 0,
50 'JOIN_STYLE': 0,
51 'MITER_LIMIT': 10,
52 'DISSOLVE': True,
53 'OUTPUT': parameters[self.OUTPUT_BUFFER]},
54 context=context, feedback=feedback, is_child_algorithm=True)
55 buffered = algresult['OUTPUT']
56 return {self.OUTPUT_BUFFER: buffered}

Na de nodige import zĳn de volgende functies voor QgsProcessingAlgorithm gespecificeerd:
• name(): Het ID van het algoritme (kleine letters).
• displayName(): Een door mensen te lezen naam voor het algoritme.
• createInstance(): Maak een nieuwe instance van de klasse van het algoritme.
• initAlgorithm(): Configureer de parameterDefinitions en outputDefinitions.
Hier beschrĳft u de parameters en uitvoer van het algoritme. In dit geval een bronobject voor de invoer, een
afvoer voor het object voor het resultaat en een getal voor de afstand van de buffer.

• processAlgorithm(): Voer het werk uit.
Hier voeren we eerst het algoritme smoothgeometry uit om de geometrie af te vlakken en dan voeren
we het algoritme buffer uit op de afgevlakte uitvoer. We moeten de parameter is_child_algorithm
instellen op True, om algoritmes te kunnen uitvoeren vanuit andere algoritmes. U kunt zien hoe de parameters
voor invoer en uitvoer worden gebruikt als parameters voor de algoritmes smoothgeometry en buffer.

Er zĳn een aantal verschillende typen parameter beschikbaar voor in- en uitvoer. Hieronder staat een alfabetisch
gesorteerde lĳst:

Tabel 26.2: Lĳst met typen parameters voor invoer en uitvoer van
algoritmes

QgsProcessingParameterAggregate QgsProcessingParameterAnnotationLayer QgsProcessingParameterAuthConfig QgsProcessingParameterBand
QgsProcessingParameterBoolean QgsProcessingParameterColor QgsProcessingParameterCoordinateOperation QgsProcessingParameterCrs
QgsProcessingParameterDatabaseSchema QgsProcessingParameterDatabaseTable QgsProcessingParameterDateTime QgsProcessingParameterDistance
QgsProcessingParameterEnum QgsProcessingParameterExpression QgsProcessingParameterExtent QgsProcessingParameterFeatureSink
QgsProcessingParameterFeatureSource QgsProcessingParameterField QgsProcessingParameterFieldMapping QgsProcessingParameterFile
QgsProcessingParameterFileDestination QgsProcessingParameterFolderDestination QgsProcessingParameterGeometry QgsProcessingParameterLayout
QgsProcessingParameterLayoutItem QgsProcessingParameterMapLayer QgsProcessingParameterMapTheme QgsProcessingParameterMatrix
QgsProcessingParameterMeshLayer QgsProcessingParameterMultipleLayers QgsProcessingParameterNumber QgsProcessingParameterPoint
QgsProcessingParameterPointCloudLayer QgsProcessingParameterProviderConnection QgsProcessingParameterRange QgsProcessingParameterRasterDestination
QgsProcessingParameterRasterLayer QgsProcessingParameterScale QgsProcessingParameterString QgsProcessingParameterVectorDestination
QgsProcessingParameterVectorLayer QgsProcessingParameterVectorTileWriterLayers

De eerste parameter naar de constructeurs is de naam van de parameter, en de tweede is de beschrĳving van de
parameter (voor de gebruikersinterface). De rest van de parameters voor constructie zĳn specifiek voor het type
parameter.
De invoer kan worden omgezet naar klassen voor QGIS met de functies parameterAs van
QgsProcessingAlgorithm. Bĳvoorbeeld om het opgegeven getal voor de afstand van de buffer te krĳgen als
een double:

self.parameterAsDouble(parameters, self.INPUT_BUFFERDIST, context)).

De functie processAlgorithm zou een woordenboek moeten teruggeven dat waarden bevat voor elke uitvoer die
wordt gedefinieerd door het algoritme. Dat maakt het mogelĳk om toegang te krĳgen tot deze uitvoer vanuit andere
algoritmes, inclusief andere algoritmes die in hetzelfde model zĳn opgenomen.
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Zich goed gedragende algoritmes zouden net zoveel uitvoeren definiëren en teruggeven als zin heeft. Niet-object
uitvoer, zoals getallen en tekenreeksen, zĳn zeer nuttig bĳ het uitvoeren van uw algoritme als deel van een groter
model, omdat deze waarden kunnen worden gebruikt als parameters voor invoer voor opvolgende algoritmes in het
model. Overweeg het toevoegen van numerieke uitvoer voor dingen als het aantal verwerkte objecten, het aantal
ongeldige objecten dat werd tegengekomen, het aantal uitgevoerde objecten, etc. Hoe meer uitvoer u teruggeeft des
te nuttiger uw algoritme wordt!

Terugkoppeling

Het object feedback dat wordt doorgegeven aan processAlgorithm zou moeten worden gebruikt voor
terugkoppeling van/interactie met de gebruiker. U kunt de functie setProgress() van het object feedback
gebruiken om de voortgangsbalk (0 tot 100) bĳ te werken om de gebruiker over de voortgang van het algoritme te
informeren. Dit is bĳzonder nuttig als uw algoritme veel tĳd nodig heeft om te voltooien.
Het object feedback verschaft een methode isCanceled() die zou moeten worden gemonitord om annuleren
van het algoritme door de gebruiker in te schakelen. DemethodepushInfo() vanfeedback kanworden gebruikt
om informatie naar de gebruiker te verzenden, en reportError() is handig voor het pushen van niet-fatale fouten
naar gebruikers.
Algoritmes zouden andere vormen van het verschaffen van terugkoppeling aan gebruikers moeten vermĳden, zoals
afdrukken van argumenten of loggen naar QgsMessageLog, en zouden in plaats daarvan altĳd het object feedback
moeten gebruiken. Dat maakt uitgebreide logging voor het algoritme mogelĳk, en is ook thread-veilig (wat belangrĳk
is, omdat algoritmes gewoonlĳk worden uitgevoerd in een thread op de achtergrond).

Fouten afhandelen

Als uw algoritme een fout tegenkomt die verhindert dat het wordt uitgevoerd, zoals ongeldige waarden voor invoer
of een andere voorwaarde waardoor het niet wil of kan herstellen, dan zou u een QgsProcessingException
moeten opwerpen. Bĳv.:

if feature['value'] < 20:
raise QgsProcessingException('Invalid input value {}, must be >= 20'.

↪→format(feature['value']))

Probeer het opwerpen van een QgsProcessingException voor niet-fatale fouten te voorkomen (bĳv. als een
object een geometrie null heeft), en rapporteer in plaats daarvan deze fouten via feedback.reportError()
en sla het object over. Dat helpt bĳ het “model-vriendelĳk” maken van uw algoritme, omdat het het stopzetten van de
uitvoering van een geheel algoritme vermĳdt als een niet-fatale fout wordt tegengekomen.

Documenteren van uw scripts

In het geval van modellen kunt u aanvullende documentatie voor uw scripts maken om uit te leggen wat zĳ doen en
hoe zĳ werken.
QgsProcessingAlgorithm verschaft de functies helpString(), shortHelpString() en
helpUrl() voor dat doel. Specificeer / overschrĳf deze om meer hulp te geven aan de gebruiker.
shortDescription() wordt gebruikt in de helptip wanneer over het algoritme in de Toolbox wordt gegaan.
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26.7.3 Haken voor vóór- en na-uitvoering van scripts

Scripts kunnen ook worden gebruikt als haken om voor pre- en post-uitvoering, die respectievelĳk worden uitgevoerd
vóórdat of nadat een algoritme is uitgevoerd. Dit kan worden gebruikt om taken te automatiseren die zouden moeten
worden uitgevoerd wanneer een algoritme wordt uitgevoerd.
De syntaxis is identiek aan de hierboven uitgelegde syntaxis, maar een aanvullende globale variabele genaamd alg
is beschikbaar, die het algoritme vertegenwoordigt dat zojuist is (of op het punt staat te worden) uitgevoerd.
In de groep Algemeen van het dialoogvenster Opties van Processing vindt u twee items genaamdVóór-uitvoering script
en Na-uitvoering script waar de bestandsnamen van de uit te voeren scripts in elk geval kunnen worden ingevoerd.

26.8 Processing gebruiken vanaf de opdrachtregel

QGIS heeft een gereedschap, genaamdQGIS Processing Executor, dat u in staat stelt algoritmes enmodellen
van Processing (ingebouwd of verschaft via plug-ins) direct vanaf de opdrachtregel uit te voeren, zonder QGIS
Desktop zelf te moeten starten.
Voer, vanuit een programma voor de opdrachtregel, qgis_process uit en u zou moeten krĳgen:

QGIS Processing Executor - 3.27.0-Master 'Master' (3.27.0-Master)
Usage: C:\OSGeo4W\apps\qgis-dev\bin\qgis_process.exe [--help] [--version] [--json]␣
↪→[--verbose] [--no-python] [command] [algorithm id, path to model file, or path␣
↪→to Python script] [parameters]

Options:

--help or -h Output the help
--version or -v Output all versions related to QGIS Process
--json Output results as JSON objects
--verbose Output verbose logs
--no-python Disable Python support (results in faster startup)

Available commands:

plugins list available and active plugins
plugins enable enables an installed plugin. The plugin name must be specified,␣

↪→e.g. "plugins enable cartography_tools"
plugins disable disables an installed plugin. The plugin name must be specified,

↪→ e.g. "plugins disable cartography_tools"
list list all available processing algorithms
help show help for an algorithm. The algorithm id or a path to a␣

↪→model file must be specified.
run runs an algorithm. The algorithm id or a path to a model file␣

↪→and parameter values must be specified.
Parameter values are specified after -- with PARAMETER=VALUE␣

↪→syntax.
Ordered list values for a parameter can be created by␣

↪→specifying the parameter multiple times,
e.g. --LAYERS=layer1.shp --LAYERS=layer2.shp
Alternatively, a '-' character in place of the parameters␣

↪→argument indicates that the parameters should be read from STDIN as a JSON␣
↪→object.

The JSON should be structured as a map containing at least the
↪→"inputs" key specifying a map of input parameter values.

This implies the --json option for output as a JSON object.
If required, the ellipsoid to use for distance and area␣

↪→calculations can be specified via the "--ELLIPSOID=name" argument.
If required, an existing QGIS project to use during the␣

↪→algorithm execution can be specified via the "--PROJECT_PATH=path" argument.
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Notitie: Alleen geïnstalleerde plug-ins die in hun bestand metadata.txt hebben opgenomen
hasProcessingProvider=yes worden herkend en kunnen worden geactiveerd of geladen door het
gereedschap qgis_process.

Hint: Voordat u qgis_process aanroept op een systeem zonder vensterbeheer (bĳv. een headless server), zou umoeten
instellen:

export QT_QPA_PLATFORM=offscreen

De opdracht list kan worden gebruikt om een lĳst met alle beschikbare providers en algoritmes op te halen.

qgis_process list

De opdracht help kan worden gebruikt om meer informatie op te halen over opdrachten of algoritmes.

qgis_process help qgis:regularpoints

De opdrachtrun kanworden gebruikt om een algoritme ofmodel uit te voeren. Specificeer de naam van het algoritme
of een pad naar een model als de eerste parameter.

qgis_process run native:buffer -- INPUT=source.shp DISTANCE=2 OUTPUT=buffered.shp

Als een parameter een lĳst met waarden accepteert, stel dan dezelfde variabele meerdere keren in.

qgis_process run native:mergevectorlayers -- LAYERS=input1.shp LAYERS=input2.shp␣
↪→OUTPUT=merged.shp

Bĳ het uitvoeren van een algoritme wordt een op tekst gebaseerde balk voor terugkoppeling weergegeven, en de
bewerking kan worden geannuleerd met CTRL+C.
De opdracht run ondersteunt ook meer parameters.

• --json zal uitvoer naar stdout opmaken in een JSON-gestructureerde manier.
• --ellipsoid zal de ellipsoïde instellen naar de gespecificeerde.
• --distance_units zal de gespecificeerde eenheden voor afstand gebruiken.
• --area_units zal de gespecificeerde eenheden voor gebied gebruiken.
• --project_path zal het gespecificeerde project laden om het algoritme uit te voeren.

Complexe parameters voor de invoer, d.i. typen parameter die van zichzelf worden gespecificeerd als een dictionary
type object voor algoritmes, worden ondersteund door qgis_process. De opdracht voor qgis_process moet de indeling
( met een achterliggende - in plaats van de normale lĳst met argumenten) volgen om aan te geven dat parameters
zullen worden gespecificeerd via stdin,

qgis_process run algorithmId -

Het object voor JSON moet een sleutel “inputs” bevatten, wat een kaart is van de waarden van de parameters voor de
invoer. Bĳv.

echo "{'inputs': {'INPUT': 'my_shape.shp', 'DISTANCE': 5}}" | qgis_process run␣
↪→native:buffer -

Aanvullend kunnen extra instellingen, zoals de eenheden voor afstand, eenheden voor gebied, ellipsoïde en projectpad
worden opgenomen in dit object voor JSON:
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{
'ellipsoid': 'EPSG:7019',
'distance_units': 'feet',
'area_units': 'ha',
'project_path': 'C:/temp/my_project.qgs'
'inputs': {'DISTANCE': 5, 'SEGMENTS': 8 ... }

}

Specificeren van parameters voor de invoer via stdin impliceert automatisch de indeling voor de uitvoer JSON voor
de resultaten.

26.9 Nieuwe algoritmes voor Processing schrijven als scripts voor
Python

Er bestaan twee opties voor het schrĳven van algoritmes voor Processing met Python.
• Uitbreiden van QgsProcessingAlgorithm

• De decarotor @alg gebruiken

In QGIS kunt u Nieuw script maken in het menu Scripts boven in de Processing Toolbox gebruiken om de Processing
Script bewerken te openen waar u uw code kunt schrĳven. U kunt, om de taak te vereenvoudigen, beginnen met een
sjabloon voor een script door Nieuw script uit sjabloon maken uit hetzelfde menu te gebruiken. Dat opent een sjabloon
dat QgsProcessingAlgorithm uitbreidt.
Als u het script opslaat in de map scripts (de standaardlocatie) met de extensie .py, zal het algoritme beschikbaar
komen in de Processing Toolbox.

26.9.1 QgsProcessingAlgorithm uitbreiden

De volgende code
1. neemt een vectorlaag als invoer
2. telt het aantal objecten
3. doet een bewerking voor een buffer
4. maakt een rasterlaag als resultaat van de bewerking voor de buffer
5. geeft de laag voor de buffer, de rasterlaag en het aantal objecten terug

1 from qgis.PyQt.QtCore import QCoreApplication
2 from qgis.core import (QgsProcessing,
3 QgsProcessingAlgorithm,
4 QgsProcessingException,
5 QgsProcessingOutputNumber,
6 QgsProcessingParameterDistance,
7 QgsProcessingParameterFeatureSource,
8 QgsProcessingParameterVectorDestination,
9 QgsProcessingParameterRasterDestination)
10 from qgis import processing
11

12

13 class ExampleProcessingAlgorithm(QgsProcessingAlgorithm):
14 """
15 This is an example algorithm that takes a vector layer,
16 creates some new layers and returns some results.
17 """
18

(Vervolgt op volgende pagina)
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19 def tr(self, string):
20 """
21 Returns a translatable string with the self.tr() function.
22 """
23 return QCoreApplication.translate('Processing', string)
24

25 def createInstance(self):
26 # Must return a new copy of your algorithm.
27 return ExampleProcessingAlgorithm()
28

29 def name(self):
30 """
31 Returns the unique algorithm name.
32 """
33 return 'bufferrasterextend'
34

35 def displayName(self):
36 """
37 Returns the translated algorithm name.
38 """
39 return self.tr('Buffer and export to raster (extend)')
40

41 def group(self):
42 """
43 Returns the name of the group this algorithm belongs to.
44 """
45 return self.tr('Example scripts')
46

47 def groupId(self):
48 """
49 Returns the unique ID of the group this algorithm belongs
50 to.
51 """
52 return 'examplescripts'
53

54 def shortHelpString(self):
55 """
56 Returns a localised short help string for the algorithm.
57 """
58 return self.tr('Example algorithm short description')
59

60 def initAlgorithm(self, config=None):
61 """
62 Here we define the inputs and outputs of the algorithm.
63 """
64 # 'INPUT' is the recommended name for the main input
65 # parameter.
66 self.addParameter(
67 QgsProcessingParameterFeatureSource(
68 'INPUT',
69 self.tr('Input vector layer'),
70 types=[QgsProcessing.TypeVectorAnyGeometry]
71 )
72 )
73 self.addParameter(
74 QgsProcessingParameterVectorDestination(
75 'BUFFER_OUTPUT',
76 self.tr('Buffer output'),
77 )
78 )
79 # 'OUTPUT' is the recommended name for the main output

(Vervolgt op volgende pagina)
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80 # parameter.
81 self.addParameter(
82 QgsProcessingParameterRasterDestination(
83 'OUTPUT',
84 self.tr('Raster output')
85 )
86 )
87 self.addParameter(
88 QgsProcessingParameterDistance(
89 'BUFFERDIST',
90 self.tr('BUFFERDIST'),
91 defaultValue = 1.0,
92 # Make distance units match the INPUT layer units:
93 parentParameterName='INPUT'
94 )
95 )
96 self.addParameter(
97 QgsProcessingParameterDistance(
98 'CELLSIZE',
99 self.tr('CELLSIZE'),
100 defaultValue = 10.0,
101 parentParameterName='INPUT'
102 )
103 )
104 self.addOutput(
105 QgsProcessingOutputNumber(
106 'NUMBEROFFEATURES',
107 self.tr('Number of features processed')
108 )
109 )
110

111 def processAlgorithm(self, parameters, context, feedback):
112 """
113 Here is where the processing itself takes place.
114 """
115 # First, we get the count of features from the INPUT layer.
116 # This layer is defined as a QgsProcessingParameterFeatureSource
117 # parameter, so it is retrieved by calling
118 # self.parameterAsSource.
119 input_featuresource = self.parameterAsSource(parameters,
120 'INPUT',
121 context)
122 numfeatures = input_featuresource.featureCount()
123

124 # Retrieve the buffer distance and raster cell size numeric
125 # values. Since these are numeric values, they are retrieved
126 # using self.parameterAsDouble.
127 bufferdist = self.parameterAsDouble(parameters, 'BUFFERDIST',
128 context)
129 rastercellsize = self.parameterAsDouble(parameters, 'CELLSIZE',
130 context)
131 if feedback.isCanceled():
132 return {}
133 buffer_result = processing.run(
134 'native:buffer',
135 {
136 # Here we pass on the original parameter values of INPUT
137 # and BUFFER_OUTPUT to the buffer algorithm.
138 'INPUT': parameters['INPUT'],
139 'OUTPUT': parameters['BUFFER_OUTPUT'],
140 'DISTANCE': bufferdist,
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141 'SEGMENTS': 10,
142 'DISSOLVE': True,
143 'END_CAP_STYLE': 0,
144 'JOIN_STYLE': 0,
145 'MITER_LIMIT': 10
146 },
147 # Because the buffer algorithm is being run as a step in
148 # another larger algorithm, the is_child_algorithm option
149 # should be set to True
150 is_child_algorithm=True,
151 #
152 # It's important to pass on the context and feedback objects to
153 # child algorithms, so that they can properly give feedback to
154 # users and handle cancelation requests.
155 context=context,
156 feedback=feedback)
157

158 # Check for cancelation
159 if feedback.isCanceled():
160 return {}
161

162 # Run the separate rasterization algorithm using the buffer result
163 # as an input.
164 rasterized_result = processing.run(
165 'qgis:rasterize',
166 {
167 # Here we pass the 'OUTPUT' value from the buffer's result
168 # dictionary off to the rasterize child algorithm.
169 'LAYER': buffer_result['OUTPUT'],
170 'EXTENT': buffer_result['OUTPUT'],
171 'MAP_UNITS_PER_PIXEL': rastercellsize,
172 # Use the original parameter value.
173 'OUTPUT': parameters['OUTPUT']
174 },
175 is_child_algorithm=True,
176 context=context,
177 feedback=feedback)
178

179 if feedback.isCanceled():
180 return {}
181

182 # Return the results
183 return {'OUTPUT': rasterized_result['OUTPUT'],
184 'BUFFER_OUTPUT': buffer_result['OUTPUT'],
185 'NUMBEROFFEATURES': numfeatures}

Standaardfuncties voor algoritmes van Processing
• createInstance (verplicht)

Moet een nieuwe kopie van uw algoritme teruggeven. Als u de naam van de klasse wĳzigt, zorg er dan
voor dat u ook de hier teruggegeven waarde bĳwerkt zodat die overeenkomt!

• name (verplicht)
Geeft de unieke naam van het algoritme terug, gebruikt voor het identificeren van het algoritme.

• displayName (verplicht)
Geeft de vertaalde naam van het algoritme terug.

• group
Geeft de naam van de groep terug waartoe dit algoritme behoort.

• groupId
Geeft de unieke ID van de groep terug waartoe dit algoritme behoort.
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• shortHelpString
Geeft een gelokaliseerde korte tekenreeks voor Help voor het algoritme terug.

• initAlgorithm (verplicht)
Hier definiëren we de in- en uitvoer voor het algoritme.
INPUT en OUTPUT zĳn aanbevolen namen voor de parameters voor de respectievelĳke hoofdinvoer en
hoofduitvoer.
Als een parameter afhankelĳk is van een andere parameter, wordt parentParameterName gebruikt
om deze relatie te specificeren (zou het veld / band van een laag of de eenheden voor afstand van een
laag kunnen zĳn).

• processAlgorithm (verplicht)
Dit is waar de verwerking plaatsvindt.
Parameters worden opgehaald met behulp van functies voor speciale doelen, bĳvoorbeeld
parameterAsSource en parameterAsDouble.
processing.run kan worden gebruikt om andere algoritmes van Processing uit te voeren vanuit
een algoritme van Processing. De eerste parameter is de naam van het algoritme, de tweede is een
woordenboek van de parameters voor het algoritme. is_child_algorithm is normaal ingesteld
op True bĳ het uitvoeren van een algoritme vanuit een ander algoritme. context en feedback
informeert het algoritme over de omgeving waarin het moet worden uitgevoerd en het kanaal voor
het communiceren met de gebruiker (opvangen verzoek tot annuleren, voortgang rapporteren, tekstuele
terugkoppeling geven). Bĳ het gebruiken van de parameters van (ouder) algoritmes als parameters
voor “kind”-algoritmes, zouden de originele waarden voor de parameter moeten worden gebruikt (bĳv.
parameters['OUTPUT']).
Het is goed gebruik om het object feedback te controleren op annuleren zo vaak als enigszins mogelĳk
is! Door dit te doen maakt het reageren op annuleren mogelĳk, in plaats van gebruikers te forceren te
wachten tot ongewenste verwerking optreedt.
Het algoritme zou waarden terug moeten geven voor alle waarden van de parameters voor de uitvoer die
zĳn gedefinieerd als een woordenboek. In dit geval zĳn dat de buffer en de gerasteriseerde uitvoerlagen, en
het aantal verwerkte objecten. De sleutels voor het woordenboek moeten overeen komen met de originele
parameters/namen van de uitvoer.

26.9.2 De decorator @alg

Door de decorator @alg te gebruiken kunt u uw eigen algoritmes maken door de code voor Python te schrĳven en
een aantal extra regels toe te voegen, om aanvullende informatie te verschaffen die nodig is om een correct algoritme
voor Processing te maken. Dit vereenvoudigt het maken van algoritmes en het specificeren van in- en uitvoer.
Één belangrĳke beperking met de benadering van de decorator is dat algoritmes die op deze manier worden gemaakt
worden toegevoegd aan de Processing Scriptsprovider van de gebruiker – het is niet mogelĳk om deze algoritmes toe
te voegen aan een aangepaste provider, bĳv om in plug-ins te gebruiken.
De volgende code gebruikt de decorator @alg om

1. een vectorlaag als invoer te gebruiken
2. het aantal objecten te tellen
3. een bewerking voor een buffer uit te voeren
4. een rasterlaag te maken uit het resultaat van de bewerking voor de buffer
5. geeft de laag voor de buffer, de rasterlaag en het aantal objecten terug

1 from qgis import processing
2 from qgis.processing import alg
3 from qgis.core import QgsProject
4
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5 @alg(name='bufferrasteralg', label='Buffer and export to raster (alg)',
6 group='examplescripts', group_label='Example scripts')
7 # 'INPUT' is the recommended name for the main input parameter
8 @alg.input(type=alg.SOURCE, name='INPUT', label='Input vector layer')
9 # 'OUTPUT' is the recommended name for the main output parameter
10 @alg.input(type=alg.RASTER_LAYER_DEST, name='OUTPUT',
11 label='Raster output')
12 @alg.input(type=alg.VECTOR_LAYER_DEST, name='BUFFER_OUTPUT',
13 label='Buffer output')
14 @alg.input(type=alg.DISTANCE, name='BUFFERDIST', label='BUFFER DISTANCE',
15 default=1.0)
16 @alg.input(type=alg.DISTANCE, name='CELLSIZE', label='RASTER CELL SIZE',
17 default=10.0)
18 @alg.output(type=alg.NUMBER, name='NUMBEROFFEATURES',
19 label='Number of features processed')
20

21 def bufferrasteralg(instance, parameters, context, feedback, inputs):
22 """
23 Description of the algorithm.
24 (If there is no comment here, you will get an error)
25 """
26 input_featuresource = instance.parameterAsSource(parameters,
27 'INPUT', context)
28 numfeatures = input_featuresource.featureCount()
29 bufferdist = instance.parameterAsDouble(parameters, 'BUFFERDIST',
30 context)
31 rastercellsize = instance.parameterAsDouble(parameters, 'CELLSIZE',
32 context)
33 if feedback.isCanceled():
34 return {}
35 buffer_result = processing.run('native:buffer',
36 {'INPUT': parameters['INPUT'],
37 'OUTPUT': parameters['BUFFER_OUTPUT'],
38 'DISTANCE': bufferdist,
39 'SEGMENTS': 10,
40 'DISSOLVE': True,
41 'END_CAP_STYLE': 0,
42 'JOIN_STYLE': 0,
43 'MITER_LIMIT': 10
44 },
45 is_child_algorithm=True,
46 context=context,
47 feedback=feedback)
48 if feedback.isCanceled():
49 return {}
50 rasterized_result = processing.run('qgis:rasterize',
51 {'LAYER': buffer_result['OUTPUT'],
52 'EXTENT': buffer_result['OUTPUT'],
53 'MAP_UNITS_PER_PIXEL': rastercellsize,
54 'OUTPUT': parameters['OUTPUT']
55 },
56 is_child_algorithm=True, context=context,
57 feedback=feedback)
58 if feedback.isCanceled():
59 return {}
60 return {'OUTPUT': rasterized_result['OUTPUT'],
61 'BUFFER_OUTPUT': buffer_result['OUTPUT'],
62 'NUMBEROFFEATURES': numfeatures}

Zoals u kunt zien zĳn twee algoritmes betrokken (‘native:buffer’ en ‘qgis:rasterize’). De laatste (‘qgis:rasterize’) maakt
een rasterlaag uit de bufferlaag die werd gemaakt door het eerste (‘native:buffer’).
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Het deel van de code waar deze verwerking plaatsvindt is niet moeilĳk te begrĳpen, als u het vorige hoofdstuk hebt
gelezen. De eerste regels moeten echter even nader worden uitgelegd. Ze verschaffen de informatie die nodig is om
van uw code een algoritme te maken dat kan worden uitgevoerd vanuit elk van de componenten van de GUI, zoals de
Toolbox of Grafische modellen ontwerpen.
Deze regels zĳn allemaal aanroepen naar functies van de decorator @alg, die helpen de codering van het algoritme
te vereenvoudigen.

• De decorator @alg wordt gebruikt om de naam en locatie te definiëren van het algoritme in de Toolbox.
• De decorator @alg.input wordt gebruikt om de invoer voor het algoritme te definiëren.
• De decorator @alg.output wordt gebruikt om de uitvoer voor het algoritme te definiëren.

26.9.3 Typen invoer en uitvoer voor algoritmes van Processing

Hier is de lĳst van typen invoer en uitvoer die in Processing worden ondersteund, met hun overeenkomende alg
decorator constanten (het bestand algfactory.py bevat de volledige lĳst met alg constanten). Gesorteerd op naam van
de klasse.

Typen invoer

Klasse Alg constante Beschrijving
QgsProcessingParameterAnnotationLayeralg.ANNOTATION_LAYER Een laag met annotaties
QgsProcessingParameterAuthConfig alg.AUTH_CFG Stelt gebruikers in

staat om te selecteren
uit beschikbare
configuraties voor
authenticatie of nieuwe
configuraties voor
authenticatie te maken

QgsProcessingParameterBand alg.BAND Een band van een
rasterlaag

QgsProcessingParameterBoolean alg.BOOL Een Booleaanse waarde
QgsProcessingParameterColor alg.COLOR Een kleur
QgsProcessingParameterCoordinateOperationalg.

COORDINATE_OPERATION
Een bewerking van
coördinaten (voor CRS
transformaties)

QgsProcessingParameterCrs alg.CRS Een Coördinaten
ReferentieSysteem

QgsProcessingParameterDatabaseSchemaalg.DATABASE_SCHEMA Een databaseschema
QgsProcessingParameterDatabaseTablealg.DATABASE_TABLE Een databasetabel
QgsProcessingParameterDateTime alg.DATETIME Een datum & tĳd

‘datetime’ (of een pure
datum of tĳd)

QgsProcessingParameterDistance alg.DISTANCE Een numerieke
parameter Double
voor waarden voor
afstanden.

QgsProcessingParameterEnum alg.ENUM Een enumeratie, wat
het mogelĳk maakt te
selecteren uit een set
vooraf gedefinieerde
waarden

QgsProcessingParameterExpression alg.EXPRESSION Een expressie
Vervolgt op volgende pagina
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Klasse Alg constante Beschrijving
QgsProcessingParameterExtent alg.EXTENT Een ruimtelĳk bereik

gedefinieerd door xmin,
xmax, ymin, ymax

QgsProcessingParameterField alg.FIELD Een veld in de
attributentabel van
een vectorlaag

QgsProcessingParameterFile alg.FILE Een bestandsnaam van
een bestaand bestand

QgsProcessingParameterFileDestinationalg.FILE_DEST Een bestandsnaam voor
een nieuw gemaakt
bestand voor uitvoer

QgsProcessingParameterFolderDestinationalg.FOLDER_DEST Een map (doelmap)
QgsProcessingParameterGeometry alg.GEOMETRY Een geometrie
QgsProcessingParameterNumber alg.INT Een integer (geheel

getal)
QgsProcessingParameterLayout alg.LAYOUT Een lay-out
QgsProcessingParameterLayoutItem alg.LAYOUT_ITEM Een item voor lay-out
QgsProcessingParameterMapLayer alg.MAPLAYER Een kaartlaag
QgsProcessingParameterMapTheme alg.MAP_THEME Een project kaartthema
QgsProcessingParameterMatrix alg.MATRIX Een matrix
QgsProcessingParameterMeshLayer alg.MESH_LAYER Een laag met mazen
QgsProcessingParameterMultipleLayersalg.MULTILAYER Een set lagen
QgsProcessingParameterNumber alg.NUMBER Een numerieke waarde
QgsProcessingParameterPoint alg.POINT Een punt
QgsProcessingParameterPointCloudDestinationalg.

POINTCLOUD_LAYER_DEST
Een parameter voor
het doel voor een
puntenwolklaag, voor
het specificeren van
het doelpad voor een
puntenwolklaag die
is gemaakt door het
algoritme

QgsProcessingParameterPointCloudLayeralg.POINTCLOUD_LAYER Een puntenwolkenlaag
QgsProcessingParameterProviderConnectionalg.

PROVIDER_CONNECTION
Een beschikbare
verbinding voor een
databaseprovider

QgsProcessingParameterRange alg.RANGE Een nummerreeks
QgsProcessingParameterRasterLayer alg.RASTER_LAYER Een rasterlaag
QgsProcessingParameterRasterDestinationalg.RASTER_LAYER_DEST Een parameter voor het

doel van een rasterlaag,
voor het specificeren van
het doelpad voor een
rasterlaag die is gemaakt
door het algoritme

QgsProcessingParameterScale alg.SCALE Een schaal voor de kaart
QgsProcessingParameterFeatureSink alg.SINK Een object afvoer
QgsProcessingParameterFeatureSourcealg.SOURCE Een object bron
QgsProcessingParameterString alg.STRING Een teksttekenreeks
QgsProcessingParameterVectorLayer alg.VECTOR_LAYER Een vectorlaag
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Tabel 26.3 – Vervolgd van vorige pagina
Klasse Alg constante Beschrijving
QgsProcessingParameterVectorDestinationalg.VECTOR_LAYER_DEST Een parameter voor het

doel van een vectorlaag,
voor het specificeren van
het doelpad voor een
vectorlaag die is gemaakt
door het algoritme

Typen uitvoer

Klasse Alg constante Beschrijving
QgsProcessingOutputBoolean alg.BOOL Een Booleaanse waarde
QgsProcessingOutputNumber alg.DISTANCE Een numerieke parameter

Double voor waarden voor
afstanden.

QgsProcessingOutputFile alg.FILE Een bestandsnaam van een
bestaand bestand

QgsProcessingOutputFolder alg.FOLDER Een map
QgsProcessingOutputHtml alg.HTML HTML
QgsProcessingOutputNumber alg.INT Een integer (geheel getal)
QgsProcessingOutputLayerDefinition alg.LAYERDEF Een laag-definitie
QgsProcessingOutputMapLayer alg.MAPLAYER Een kaartlaag
QgsProcessingOutputMultipleLayers alg.MULTILAYER Een set lagen
QgsProcessingOutputNumber alg.NUMBER Een numerieke waarde
QgsProcessingOutputPointCloudLayer alg.

POINTCLOUD_LAYER
Een puntenwolkenlaag

QgsProcessingOutputRasterLayer alg.RASTER_LAYER Een rasterlaag
QgsProcessingOutputString alg.STRING Een teksttekenreeks
QgsProcessingOutputVectorLayer alg.VECTOR_LAYER Een vectorlaag

26.9.4 Uitvoer algoritme afhandelen

Wanneer u een uitvoer declareert die een laag weergeeft (raster of vector), zal het algoritme proberen het toe te voegen
aan QGIS als het eenmaal voltooid is.

• Rasterlaag uitvoer: QgsProcessingParameterRasterDestination / alg.RASTER_LAYER_DEST.
• Vectorlaag uitvoer: QgsProcessingParameterVectorDestination / alg.VECTOR_LAYER_DEST.

Dus, zelfs als de methode processing.run() de lagen die het maakt niet toevoegt aan het huidige project van
de gebruiker, zullen de twee uitvoerlagen (buffer en rasterbuffer) worden geladen, omdat zĳ zĳn opgeslagen naar de
doelen die zĳn ingevoerd door de gebruiker (of naar tĳdelĳke doelen als de gebruiker geen doelen specificeert).
Als een laag wordt gemaakt als uitvoer van een algoritme, zou het ook zo moeten worden gedefinieerd. Anders
zult u niet in staat zĳn het algoritme op de juiste manier te gebruiken in Grafische modellen bouwen, omdat wat is
gedefinieerd niet overeenkomt met wat het algoritme in werkelĳkheid maakt.
U kunt tekenreeks, getallen en meer teruggeven door ze te specificeren in het woordenboek van het resultaat (zoals
gedemonstreerd voor “NUMBEROFFEATURES”), maar ze zouden altĳd expliciet moeten worden gedefinieerd als
uitvoer vanuit uw algoritme. We propageren om algoritmes zoveel nuttige waarden als mogelĳk uit te laten voeren,
omdat die waardevol kunnen zĳn bĳ later gebruik in algoritmes wanneer uw algoritme wordt gebruikt als deel van
een model.
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26.9.5 Communiceren met de gebruiker

Als uw algoritme er lang over doet om te worden verwerkt, is het een goed idee om de gebruiker over de voortgang
te informeren. U kunt feedback (QgsProcessingFeedback) hiervoor gebruiken.
De tekst voor de voortgang en de voortgangsbalk kunnen worden bĳgewerkt met behulp van twee methoden:
setProgressText(text) en setProgress(percent).
U kunt meer informatie verschaffen door te gebruiken pushCommandInfo(text),
pushDebugInfo(text), pushInfo(text) en reportError(text).
Als uw script problemen heeft, is de juiste manier om door te gaan het een uitzondering te laten opkomen van een
QgsProcessingException. U kunt een bericht doorgeven als argument aan de constructor van de uitzondering.
Processing zal zorg dragen voor de afhandeling ervan en communiceren met de gebruiker, afhankelĳk van waaruit
het algoritme wordt uitgevoerd (Toolbox, Grafische modellen bouwen, console van Python, …)

26.9.6 Documenteren van uw scripts

U kunt uw scripts documenteren door het overladen van de methoden helpString() en helpUrl() van
QgsProcessingAlgorithm.

26.9.7 Vlaggen

U kunt de methode flags() van QgsProcessingAlgorithm overschrĳven om QGIS meer te vertellen over
uw algoritme. U kunt bĳvoorbeeld QGIS vertellen dat het script moet worden verborgen in Grafische modellen
bouwen, dat het kan worden geannuleerd, dat het niet veilig met threads is, en meer.

Tip: Standaard voert Processing algoritmes uit in een afzonderlĳke thread om QGIS te kunnen laten reageren als
de taak voor processing wordt uitgevoerd. Als uw algoritme regelmatig crasht, gebruikt u waarschĳnlĳk aanroepen
naar de API die niet veilig kunnen worden uitgevoerd in een thread op de achtergrond. Probeer om de vlag
QgsProcessingAlgorithm.FlagNoThreading terug te laten geven vanuit uit algoritmes methode flags() om Processing
te forceren om uw algoritme in plaats daarvan in de hoofdthread uit te laten voeren.

26.9.8 Best practices voor het schrijven van algoritmes als scripts

Hier is een snelle samenvatting van ideeën om te overwegen wanneer u uw algoritmes als scripts maakt en, in het
bĳzonder, als u ze wilt delen met andere gebruikers van QGIS. Volgen van deze eenvoudige regels zal zorgen voor
consistentie in de verschillende elementen van Processing, zoals de Toolbox, Grafische modellen bouwen of de
interface voor Batch-processing.

• Laad geen resulterende lagen. Laat Processing uw resultaten afhandelen en lagen laden als dat nodig is.
• Definieer altĳd de uitvoer die uw algoritme maakt.
• Geef geen berichtenvensters weer of gebruik een element van de GUI vanuit het script. Als
u wilt communiceren met de gebruiker, gebruik dan de methoden van het object feedback
(QgsProcessingFeedback) of werp een QgsProcessingException op.

Er zĳn al heel veel algoritmes voor Processing beschikbaar in QGIS. U kunt de code vinden in de opslagplaats van
QGIS
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26.10 Configureren externe toepassingen

Het framewerk Processing kan worden uitgebreid met aanvullende toepassingen. Algoritmes die vertrouwen op
externe toepassingen worden beheerd door hun eigen providers van de algoritmes. Aanvullende providers kunnen
worden gevonden als afzonderlĳke plug-ins, en geïnstalleerd met Plug-ins beheren en installeren in QGIS.
Dit gedeelte zal u laten zien hoe het framework Processing te configureren zodat het deze aanvullende toepassingen
opneemt, en zal het enkele bĳzondere mogelĳkheden uitleggen van de algoritmes die op hen gebaseerd zĳn. Als u het
systeem eenmaal juist hebt geconfigureerd, zult u in staat zĳn externe algoritmes uit te voeren vanuit elke component,
zoals de Toolbox of Grafische modellen ontwerpen, net zoals u doet met elk ander algoritme.
Standaard zĳn algoritmes, die afhankelĳk zĳn van een externe toepassing en niet worden meegeleverd met QGIS,
niet ingeschakeld. U kunt ze inschakelen in het dialoogvenster Opties als zĳ al zĳn geïnstalleerd op uw systeem.

26.10.1 Een opmerking voor gebruikers van Windows

Als u nog geen gevorderde gebruiker bent en u voert QGIS uit opWindows, bent u misschien niet geïnteresseerd in het
lezen van de rest van dit hoofdstuk. Zorg er voor dat u QGIS op uw systeem installeert met behulp van het zelfstandige
installatieprogramma. Dat zal automatisch SAGA en GRASS op uw systeem installeren en ze configureren, zodat
zĳ vanuit QGIS kunnen worden uitgevoerd. Alle algoritmes van deze providers zullen gereed zĳn om te worden
uitgevoerd, zonder verdere configuratie. Als wordt geïnstalleerd met de toepassing OSGeo4W, zorg er dan voor dat
u ook SAGA en GRASS selecteert om te installeren.

26.10.2 Een opmerking met betrekking tot bestandsindelingen

Bĳ het gebruiken van externe software, betekent het openen van een bestand in QGIS niet dat het kan worden geopend
en verwerkt kan worden in die andere software. In de meeste gevallen kan andere software lezen wat u hebt geopend
in QGIS, maar in sommige gevallen hoeft dat niet zo te zĳn. Bĳ het gebruiken van databases of ongebruikelĳke
bestandsindelingen, voor raster- of vectorlagen, zouden problemen kunnen optreden. Als dat gebeurt, probeer dan
goed bekende bestandsindelingen te gebruiken waarvan u weet dat zĳ door beide programma’s worden begrepen, en
controleer de uitvoer in de console (in het paneel Log) om uit te zoeken wat er fout gaat.
U zou problemen kunnen ondervinden en niet in staat zĳn uw werk te voltooien als u een extern algoritme aanroept
met rasterlagen van GRASS als invoer. Deze lagen zullen, om deze reden, niet verschĳnen als beschikbaar voor
algoritmes.
U zou echter geen problemen moeten ondervinden met vectorlagen, omdat QGIS automatisch converteert vanuit de
originele bestandsindeling naar een die geaccepteerd wordt door de externe toepassing vóórdat de laag daaraan wordt
doorgegeven. Dit zorgt voor extra verwerkingstĳd, die significant zou kunnen zĳn voor zeer grote lagen, wees dus niet
verbaasd als het meer tĳd vergt om een laag uit een DB-verbinding te verwerken, dan voor een soortgelĳke grootte
vanuit een gegevensset in de indeling Shapefile.
Providers die geen externe toepassingen gebruiken kunnen elke laag verwerken die u kunt openen in QGIS, omdat
zĳ het voor analyse openen via QGIS.
Alle raster- en vectorindelingen, die worden geproduceerd door QGIS, kunnen als invoerlagen worden gebruikt.
Sommige providers ondersteunen bepaalde indelingen niet, maar zĳ kunnen allemaal worden geëxporteerd naar
veelvoorkomende indelingen voor rasterlagen die later automatisch kunnen worden getransformeerd door QGIS. Net
als voor invoerlagen, als een conversie nodig is, zou dat de verwerkingstĳd kunnen verhogen.
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26.10.3 Een opmerking over selecties van vectorlagen

Externe toepassingen kunnen ook bewust worden gemaakt van de selecties die bestaan in vectorlagen binnen QGIS.
Dat vereist echter het opnieuw schrĳven van alle vectorlagen voor de invoer, net als wanneer zĳ origineel in een
indeling waren die niet wordt ondersteund door de externe toepassing. Alleen wanneer er geen selectie bestaat, of de
optie Alleen geselecteerde objecten gebruiken niet is ingeschakeld in de algemene configuratie van Processing, kan een
laag direct worden doorgegeven aan een externe toepassing.
In andere gevallen is slechts het exporteren van de geselecteerde objecten nodig, wat er voor zorgt dat de tĳd voor
uitvoering langer duurt.

26.10.4 SAGA

Algoritmes van SAGA kunnen worden uitgevoerd vanuit QGIS, als SAGA is opgenomen in de installatie van QGIS.
Als u werkt op Windows bevatten zowel het zelfstandige installatieprogramma als het installatieprogramma
OSGeo4W SAGA.

Over beperkingen van het SAGA rastersysteem

De meeste algoritmes van SAGA, die meerdere invoerrasterlagen vereisen, eisen dat zĳ hetzelfde rastersysteem
hebben. Dat is, zĳ moeten hetzelfde geografische gebied bedekken en dezelfde celgrootte hebben, zodat hun
overeenkomende rasters overeenkomen. Bĳ het aanroepen van algoritmes van SAGA vanuit QGIS kunt u elke laag
gebruiken, ongeacht celgrootte en bereik ervan. Wanneer meerdere rasterlagen worden gebruikt als invoer voor een
algoritme van SAGA, hersampelt QGIS ze naar een algemeen rastersysteem en geeft ze dan door aan SAGA (tenzĳ
het algoritme van SAGA kan werken met lagen uit verschillende rastersystemen).
De definitie van dat algemene rastersysteem wordt beheerd door de gebruiker en u zult verschillende parameters
vinden in de groep SAGA van het venster Opties om dat te doen. Er zĳn twee manieren voor het instellen van de
doel-rastersystemen:

• Handmatig instellen. U definieert het bereik door het instellen van de volgende parameters:
– Resampling min X

– Resampling max X

– Resampling min Y

– Resampling max Y

– Resampling cellsize

Onthoud dat QGIS invoerlagen zal hersamplen tot dat bereik, zelfs als ze er niet mee overlappen.
• Automatisch instellen vanuit invoerlagen. Selecteer eenvoudigweg de optie Use min covering grid system for

resampling om deze optie te selecteren. Alle andere instellingen zullen worden genegeerd en het minimum
bereik dat alle invoerlagen bedekt, zal worden gebruikt. De celgrootte van de doellaag is het maximum van alle
celgrootten van de invoerlagen.

Voor algoritmes die niet meerdere rasterlagen gebruiken, of voor die welke geen uniek rastersysteem voor invoer
nodig hebben, wordt geen resamplen uitgevoerd vóór het aanroepen van SAGA en worden deze parameters niet
gebruikt.
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Beperkingen voor lagen met meerdere banden

Anders dan QGIS heeft SAGA geen ondersteuning voor lagen met meerdere banden. Als u een laag met meerdere
banden wilt gebruiken (zoals een RGB of multispectrale afbeelding), dient u die eerst te splitsen in afbeeldingen met
één band. U kunt het algoritme ‘SAGA/Grid - Tools/Split RGB image’ (wat drie afbeeldingen uit een RGB-afbeelding
maakt) of het algoritme ‘SAGA/Grid - Tools/Extract band’ (om één enkele band uit te nemen) gebruiken om dat te
doen.

Beperkingen in celgrootte

SAGA gaat er van uit dat rasterlagen dezelfde celgrootte hebben in de X- en de Y-as. Als u werkt met een laag
met verschillende waarden voor horizontale en verticale celgrootte, zou u onverwachte resultaten kunnen krĳgen. In
dat geval zal een waarschuwing worden toegevoegd aan het log van Processing, die aangeeft dat een invoerlaag niet
geschikt zou kunnen zĳn om te worden verwerkt door SAGA.

Loggen

Als QGIS SAGA aanroept doet het dat door middel van de interface voor de opdrachtregel, en dus door het doorgeven
van een set opdrachten om alle vereiste bewerkingen uit te voeren. SAGA geeft zĳn voortgang weer door informatie
te schrĳven naar de console, wat het percentage van reeds verrichte verwerking bevat, naast aanvullende inhoud. Deze
uitvoer wordt gefilterd en gebruikt om de voortgangsbalk bĳ te werken terwĳl het algoritme wordt uitgevoerd.
Zowel de opdrachten die zĳn verstuurd door QGIS, als de aanvullende informatie, die is afgedrukt door SAGA,
kunnen worden gelogd, naast andere logberichten voor de verwerking, en u zou ze handig kunnen vinden om te
kunnen zien wat er gebeurt als QGIS een algoritme van SAGA uitvoert. U zult twee instellingen vinden, namelĳk
Log console-uitvoer en Log uitvoeringsopdrachten, om dat mechanisme voor het loggen te activeren.
De meeste andere providers die externe toepassingen gebruiken en ze aanroepen via de opdrachtregel hebben
soortgelĳke opties, u zult ze dus ook op andere plaatsen in de lĳst met instellingen voor Processing vinden.

26.10.5 R-scripts

U dient de plug-in Processing R Provider te installeren en R te configureren voor QGIS om R in Processing in te
schakelen.
Configuratie wordt gedaan in Provider ► R op de tab Processing van Extra ► Opties.
Afhankelĳk van uw besturingssysteem zou umisschien R foldermoeten gebruiken om te specificeren waar uw binaire
bestanden voor R zĳn opgeslagen.

Notitie: OpWindows staat het uitvoerbare bestand van R normaal gesproken in een map (R-<version>) onder
C:\Program Files\R\. Specificeer de map en NIET het binaire bestand!
Op Linux dient u er slechts voor te zorgen dat de map R in de omgevingsvariabele PATH staat. Als R in een venster
van terminal R opstart, dan bent u klaar om te beginnen.

Na het installeren van de plug-in Processing R Provider zult u enkele voorbeeldscripts vinden in de Toolbox van
Processing:

• Scatterplot voert een functie voor R uit die een spreidingsplot produceert van twee numerieke velden van de
opgegeven vectorlaag.

• test_sf doet enkele bewerkingen die afhankelĳk zĳn van het pakket sf en kan worden gebruikt om te
controleren of het pakket sf voor R is geïnstalleerd. Als het pakket niet is geïnstalleerd, zal R proberen het
voor u te installeren (en alle pakketten waarvan het afhankelĳk is) met behulp van de gespecificeerde Package
repository in Provider ► R in de opties van Processing. De standaard is https://cran.r-project.org/. Installeren
kan enige tĳd vergen…
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• test_sp kan worden gebruikt om te controleren of het pakket sp voor R is geïnstalleerd. Als het pakket niet is
geïnstalleerd, zal R het voor proberen te installeren.

Als u R correct hebt geconfigureerd voor QGIS, zou u deze scripts uit moeten kunnen voeren.
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R-scripts toevoegen uit de collectie van QGIS

Integreren van R in QGIS is anders dan die van SAGA, met dien verstande dat er geen vooraf gedefinieerde set met
algoritmes is die u kunt uitvoeren (uitgezonderd enkele voorbeeldscripts die aanwezig zĳn in de plug-in Processing R
Provider).
Een set van voorbeeldscripts voor R is beschikbaar in de QGIS Repository. Voer de volgende stappen uit om ze te
laden en in te schakelen met de plug-in QGIS Resource Sharing.

1. Voeg de plug-in QGIS Resource Sharing toe (u zou misschien Ook de experimentele plug-ins tonen moeten
inschakelen in Extra van Plug-ins beheren en installeren)

2. Open het (Plug-ins –> Resource Sharing –> Resource Sharing)
3. Kies de tab Settings

4. Klik op Reload repositories

5. Kies de tab All

6. Selecteer QGIS R script collection in de lĳst en klik op de knop Install

7. De collectie zou nu moeten worden weergegeven op de tab Installed

8. Sluit de plug-in
9. Open de Toolbox van Processing en als alles goed is gegaan zouden de voorbeeldscripts beschikbaar moeten

zĳn onder R, in diverse groepen (slechts enkele groepen zĳn uitgeklapt in de schermafdruk hieronder).
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Fig. 26.34: De Toolbox van Processing waarin enkele scripts voor R worden weergegeven
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De scripts aan de bovenzĳde zĳn de voorbeeldscripts uit de plug-in Processing R Provider.
10. Als, om enige reden, de scripts niet beschikbaar zĳn in de Toolbox van Processing, kunt u proberen om:

1. De instellingen voor Processing te openen (Extra ► Opties ► tab Processing)
2. Ga naar Providers ► R ► R scripts folder

• Op Ubuntu, stel het pad in naar (of, beter nog, neem in het pad op):
/home/<user>/.local/share/QGIS/QGIS3/profiles/default/resource_sharing/repositories/github.com/qgis/QGIS-
Resources/collections/rscripts

• Op Windows, stel het pad in naar (of, beter nog, neem in het pad op):
C:\Users\<user>\AppData\Roaming\QGIS\QGIS3\profiles\default\resource_sharing\repositories\github.com\qgis\QGIS-
Resources\collections\rscripts

Dubbelklik om te bewerken. U kunt dan kiezen om het pad eenvoudigweg te kopiëren/plakken, of u kunt
naar de map navigeren met de knop … en druk op de knop Add in het dialoogvenster dat opent. Het
is mogelĳk om hier meerdere mappen op te geven. Zĳ zullen worden gescheiden door een puntkomma
(“;”).

Wanneer u alle R-scrips uit de QGIS 2 online collectie zou willen ophalen, kunt u QGIS R script collection (from QGIS
2) selecteren, in plaats van QGIS R script collection. U zult waarschĳnlĳk merken dat scripts, die afhankelĳk zĳn van
in- of uitvoer van vectorgegevens niet zullen werken.

R-scripts maken

U kunt scripts schrĳven en alle opdrachten voor R aanroepen, net zoals u zou doen vanuit R. Dit gedeelte laat u de
syntaxis zien voor het gebruiken van opdrachten van R in QGIS, en hoe daarin objecten van QGIS (lagen, tabellen)
te gebruiken.
U dient een scriptbestand te maken dat opdrachten van R uitvoert om een algoritme toe te voegen dat een functie in
R aanroept (of een meer complex script in R dat u heeft ontwikkeld en dat u beschikbaar zou willen hebben vanuit
QGIS).
Bestanden voor R-scripts hebben de extensie .rsx, en het maken ervan is heel gemakkelĳk als u slechts basiskennis
hebt van de syntaxis van R en scripten in R. Zĳ zouden moeten worden opgeslagen in de R scripts folder. U kunt de
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map specificeren (R scripts folder) in de groep voor instellingen van R in het dialoogvenster voor de instellingen van
Processing).
Laten we eens kĳken naar een heel eenvoudig scriptbestand, dat de methode voor R spsample aanroept om een
willekeurig raster te maken binnen de grens van de polygonen in een opgegeven polygoonlaag. Deze methode behoort
tot het pakket maptools. Omdat bĳna alle algoritmes die u zou willen opnemen in QGIS ruimtelĳke gegevens
zullen gebruiken of maken, is kennis van ruimtelĳke pakketten, zoals maptools en sp/sf, heel nuttig.

##Random points within layer extent=name
##Point pattern analysis=group
##Vector_layer=vector
##Number_of_points=number 10
##Output=output vector
library(sp)
spatpoly = as(Vector_layer, "Spatial")
pts=spsample(spatpoly,Number_of_points,type="random")
spdf=SpatialPointsDataFrame(pts, as.data.frame(pts))
Output=st_as_sf(spdf)

De eerste regels, die worden aangeduid met een Python commentaar symbool (##), definiëren de weergavenaam en
de groep van het script, en vertellen QGIS over zĳn in- en uitvoer.

Notitie: Bekĳk het gedeelte R Intro in de Trainingshandleiding en raadpleeg het gedeelte R syntaxis, om meer te
weten te komen over hoe uw eigen scripts voor R te schrĳven.

Wanneer u een parameter voor de invoer declareert, gebruikt QGIS die informatie voor twee dingen: het maakt de
gebruikersinterface om de gebruiker te vragen naar de waarde van die parameter, en maakt een overeenkomende
variabele voor R die kan worden gebruikt als invoer voor een functie van R.
In het bovenstaande voorbeeld hebben we een invoer van het type vector, genaamd Vector_layer,
gedeclareerd. Bĳ het uitvoeren van het algoritme, zal QGIS de laag openen die is geselecteerd door de gebruiker
en slaat die op in een variabele genaamd Vector_layer. Dus, de naam van een parameter is de naam van de
variabele die u in R kunt gebruiken om toegang te krĳgen tot de waarde van die parameter (u zou daarom moeten
vermĳden om gereserveerde woorden voor R te gebruiken als parameters).
Ruimtelĳke parameters, zoals vector- en rasterlagen, worden gelezen met behulp van de opdrachten st_read()
(of readOGR) en brick() (of readGDAL) (u hoeft zich geen zorgen te maken over het toevoegen van deze
opdrachten aan uw bestand voor de beschrĳving – QGIS zal dit voor u doen), en zĳ worden opgeslagen als objecten
Spatial*DataFrame.
Tabelvelden worden opgeslagen als tekenreeksen die de naam van het geselecteerde veld bevatten.
Vectorbestanden kunnen worden gelezen met behulp van de opdracht readOGR() in plaats van met st_read()
door ##load_vector_using_rgdal te specificeren. Dit zal een object Spatial*DataFrame produceren
in plaats van een object sf.
Rasterbestanden kunnen worden gelezen met behulp van de opdracht readGDAL() in plaats van met brick()
door ##load_raster_using_rgdal te specificeren.
Als u een gevorderde gebruiker bent en niet wilt dat QGIS het object maakt voor de laag, kunt u
##pass_filenames gebruiken om aan te geven dat u een tekenreeks met de bestandsnaam prefereert. In dat
geval is het aan u om het bestand te openen vóórdat een bewerking wordt uitgevoerd op de gegevens die het bevat.
Met bovenstaande informatie zĳn de eerste regels van het script voor R nu te begrĳpen (de eerste regel die niet begint
met een teken voor een opmerking in Python).

library(sp)
spatpoly = as(Vector_layer, "Spatial")
pts=spsample(polyg,numpoints,type="random")

De functie spsample wordt verschaft door de bibliotheek sp, dus het eerste wat we doen is die bibliotheek laden.
De variabele Vector_layer bevat een object sf. Omdat we een functie (spsample) gaan gebruiken uit de
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bibliotheek sp, moeten we het object sf converteren naar een object SpatialPolygonsDataFrame met de
functie as.
Dan roepen we de functie spsample aan, met dit object en de parameter voor de invoer numpoints (die het
aantal te maken punten specificeert).
Omdat we een vectoruitvoer, genaamd Output, hebben gedeclareerd, moeten we een variabele Outputmaken die
een object sf bevat.
We doen dit in twee stappen. Eerst maken we een object SpatialPolygonsDataFrame uit het resultaat van de
functie, met de functie SpatialPointsDataFrame, en dan converteren we dat object naar een object sf met de functie
st_as_sf (uit de bibliotheek sf).
U mag voor de tussenliggende variabelen elke naam gebruiken die u wilt. Zorg er alleen voor dat de variabele die uw
uiteindelĳke resultaat opslaat de gedefinieerde naam heeft (in dit geval Output), en dat het een geschikte waarde
bevat (een object sf voor uitvoer naar een vectorlaag).
In dit geval moest het resultaat, dat wordt verkregen uit de methode spsample, expliciet worden geconverteerd naar
een object SpatialPointsDataFrame, omdat het zelf een object van de klasse ppp is, dat niet kan worden
teruggegeven aan QGIS.
Als uw algoritme rasterlagen genereert, is de manier waarop zĳ worden opgeslagen afhankelĳk van het feit of u al dan
niet de optie ##dontuserasterpackage heeft gebruikt. Wanneer u die heeft gebruikt worden lagen opgeslagen
met behulp van demethode writeGDAL(). Indien niet, zal demethode writeRaster() uit het pakket raster
worden gebruikt.
Als u de optie ##pass_filenames hebt gebruikt, wordt de uitvoer gemaakt met behulp van het pakket raster
(met writeRaster()).
Als uw algoritme geen laag maakt, maar een tekstresultaat in de console, dient u aan te geven dat u wilt dat de console
wordt weergegeven als de uitvoering eenmaal is voltooid. Start eenvoudigweg de opdrachtregels die de resultaten
produceren die u wilt afdrukken met het teken > (‘groter dan’) om dat te doen. Alleen uitvoer van regels die worden
voorafgegaan door > zal worden weergegeven. Hier is bĳvoorbeeld het bestand voor de beschrĳving van een algoritme
dat een test voor normalen uitvoert op een bepaald veld (kolom) van de attributen van een vectorlaag:

##layer=vector
##field=field layer
##nortest=group
library(nortest)
>lillie.test(layer[[field]])

De uitvoer van de laatste regel wordt afgedrukt, maar de uitvoer van de eerste wordt dat niet (en ook de uitvoer van
de andere opdrachtregels, die automatisch door QGIS werden toegevoegd, worden dat niet).
Als uw algoritme iets grafisch maakt (met behulp van de methode plot()), voeg dan de volgende regel toe
(output_plots_to_html was eerder showplots):

##output_plots_to_html

Dit zal er voor zorgen dat QGIS alle grafische uitvoer voor R zal omleiden naar een tĳdelĳk bestand, wat zal worden
geopend als de uitvoering van R is voltooid.
Beide grafische en console-resultaten zullen beschikbaar zĳn in het beheer van de resultaten van Processing.
Bekĳk, voor meer informatie, de scripts voor R die zĳn opgenomen in de officiële collectie van QGIS (u kunt ze
downloaden en installeren met de plug-in QGIS Resource Sharing, zoals elders uitgelegd). De meeste daarvan zĳn
redelĳk eenvoudig en zullen u enorm helpen te begrĳpen hoe u uw eigen scripts kunt maken.

Notitie: De bibliotheken sf, rgdal en raster worden standaard geladen, dus hoeft u de twee overeenkomende
opdrachten library() niet toe te voegen. Echter, andere bibliotheken die u denkt nodig te hebbenmoeten expliciet
worden geladen door te typen library(ggplot2) (om de bibliotheek ggplot2 te laden). Als het pakket nog
niet is geïnstalleerd op uw machine zal Processing proberen het downloaden en te installeren. Op deze manier zal het
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pakket ook beschikbaar komen voor R Standalone. Onthoud dat als het pakket moet worden gedownload, het erg
lang zou kunnen duren als u uw script voor de eerste keer uitvoert.

26.10.6 R-bibliotheken

Het R-script sp_test probeert de pakketten voor R sp en raster te laden.

R-bibliotheken die worden geïnstalleerd bij het uitvoeren van sf_test

Het script voor R sf_test probeert sf en raster te laden. Als deze twee pakketten niet zĳn geïnstalleerd, zou R
kunnen proberen ze te laden en te installeren (en alle bibliotheken die daarvan afhankelĳk zĳn).
De volgende R-bibliotheken eindigen in ~/.local/share/QGIS/QGIS3/profiles/default/
processing/rscripts nadat sf_test is uitgevoerd vanuit de Toolbox van Processing op Ubuntu met
versie 2.0 van de plug-in Processing R Provider en een verse installatie van R 3.4.4 (apt package r-base-core
alleen):

abind, askpass, assertthat, backports, base64enc, BH, bit, bit64, blob, brew,␣
↪→callr, classInt, cli, colorspace, covr, crayon, crosstalk, curl, DBI, deldir,
desc, dichromat, digest, dplyr, e1071, ellipsis, evaluate, fansi, farver, fastmap,␣
↪→gdtools, ggplot2, glue, goftest, gridExtra, gtable, highr, hms,
htmltools, htmlwidgets, httpuv, httr, jsonlite, knitr, labeling, later, lazyeval,␣
↪→leafem, leaflet, leaflet.providers, leafpop, leafsync, lifecycle, lwgeom,
magrittr, maps, mapview, markdown, memoise, microbenchmark, mime, munsell, odbc,␣
↪→openssl, pillar, pkgbuild, pkgconfig, pkgload, plogr, plyr, png, polyclip,
praise, prettyunits, processx, promises, ps, purrr, R6, raster, RColorBrewer, Rcpp,
↪→ reshape2, rex, rgeos, rlang, rmarkdown, RPostgres, RPostgreSQL,
rprojroot, RSQLite, rstudioapi, satellite, scales, sf, shiny, sourcetools, sp,␣
↪→spatstat, spatstat.data, spatstat.utils, stars, stringi, stringr, svglite,
sys, systemfonts, tensor, testthat, tibble, tidyselect, tinytex, units, utf8, uuid,
↪→ vctrs, viridis, viridisLite, webshot, withr, xfun, XML, xtable

26.10.7 GRASS

Configureren van GRASS is niet veel anders dan het configureren van SAGA. Eerst moet het pad naar de map
GRASS worden gedefinieerd, maar alleen als u werkt op Windows.
Standaard probeert het framework Processing zĳn verbinding naar GRASS te configureren om de distributie van
GRASS te gebruiken die wordt meegeleverd met QGIS. Dit zou voor de meeste systemen zonder problemen moeten
werken, maar als u problemen ondervindt, zou u de verbinding naar GRASS handmatig moeten configureren. Ook
als u een andere installatie van GRASS wilt gebruiken kunt u de instelling wĳzigen zodat die verwĳst naar de map
waar die andere versie is geïnstalleerd. GRASS 7 is nodig om de algoritmes juist te laten werken.
Als u werkt op Linux hoeft u er slechts voor te zorgen dat GRASS correct is geïnstalleerd, en dat het zonder problemen
kan worden uitgevoerd vanaf een terminalvenster.
Algoritmes van GRASS gebruiken een regio voor berekeningen. Deze regio kan handmatig worden gedefinieerd met
behulp van waarden die soortgelĳk zĳn aan die welke werden gebruikt in de configuratie van SAGA, of automatisch,
met het minimum bereik dat alle gebruikte invoerlagen bedekt bĳ het elke keer uitvoeren van het algoritme. Als de
laatste benadering het gedrag is dat u prefereert, selecteer dan de optie Use min covering region in de configuratie van
de parameters in GRASS.
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26.10.8 LAStools

Voor het gebruiken van LAStools in QGIS, moet u LAStools downloaden en installeren op uw computer en de plug-in
LAStools installeren (beschikbaar in de officiële opslagplaats) in QGIS.
Op platformen voor Linux zult u Wine nodig hebben om enkele van de gereedschappen uit te kunnen voeren.
LAStools wordt geactiveerd en geconfigureerd in de opties voor Processing (Extra ► Opties, tab Processing,
Providers► LAStools), waar u de locatie van LAStools (map LAStools) en Wine (map Wine) kunt specificeren. Op
Ubuntu is de standaardmap voor Wine /usr/bin.

26.10.9 OTB-toepassingen

Toepassingen voor OTB worden volledig ondersteund in het QGIS framewerk Processing.
OTB (Orfeo ToolBox) is een bibliotheek voor het verwerken van afbeeldingen voor gegevens van remote sensing.
Het verschaft ook toepassingen die functionaliteiten voor het verwerken van afbeeldingen. De lĳst met toepassingen
en hun documentatie zĳn beschikbaar in het OTB CookBook

Notitie: Onthoud dat OTB niet wordt meegeleverd met QGIS en afzonderlĳk geïnstalleerd moet worden. Binaire
pakketten voor OTB zĳn te vinden op de downloadpagina.

QGIS Processing configureren om te zoeken naar de bibliotheek OTB:
1. Open de instellingen voor Processing: Extra ► Opties ► Processing (linkerpaneel)
2. U vindt OTB onder “Providers”:

1. Breidt de tab OTB uit
2. Stel de OTB-map in. Dat is de locatie van uw installatie van OTB.
3. Stel de OTB-toepassingsmap in. Dit is de locatie van uw toepassingen voor OTB (

<PATH_TO_OTB_INSTALLATION>/lib/otb/applications)
4. Klik op “OK” en sluit het dialoogvenster.

As de instellingen juist zĳn, zullen algoritmes van OTB beschikbaar zĳn in de Toolbox van Processing.

Documentatie voor beschikbare instellingen van OTB in QGIS Processing

• OTB-map: Dit is de map waar OTB beschikbaar is.
• OTB-toepassingsmap: Dit is/zĳn de locatie(s) van toepassingen van OTB.
Meerdere paden zĳn toegestaan.

• Niveau logger (optioneel): Niveau van logger te gebruiken door toepassingen van OTB.
Het niveau van loggen beheert de hoeveelheid details die worden afgedrukt bĳ het uitvoeren van het algoritme.
Mogelĳke waarden voor niveau van logger zĳn INFO, WARNING, CRITICAL, DEBUG. Deze waarde is
standaard INFO. Dit is een configuratie voor gevorderde gebruikers.

• Maximaal te gebruikenRAM (optioneel): standaard gebruiken toepassingen van OTB alle beschikbare RAM
van het systeem.
U kunt met deze optie echter OTB instrueren om een bepaalde hoeveelheid RAM (in MB) te gebruiken. Een
waarde van 256 wordt genegeerd door de OTB processing provider. Dit is een configuratie voor gevorderde
gebruikers.

• Geoïde-bestand (optioneel): Pad naar het geoïde-bestand.
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Deze optie stelt de waarden van de parameters elev.dem.geoid en elev.geoid in voor toepassingen van OTB.
Instellen van deze waarden als globaal stelt gebruikers in staat dit te delen over meerdere algoritmes van
Processing. Standaard leeg.

• map SRTM-tegels (optioneel): Map waar SRTM-tegels beschikbaar zĳn.
SRTM-gegevens mogen lokaal opgeslagen worden om downloaden van bestanden tĳdens het verwerken te
vermĳden. Deze optie stelt de waarden van de parameters elev.dem.path en elev.dem in voor toepassingen van
OTB. Instellen van deze waarden als globaal stelt gebruikers in staat dit te delen over meerdere algoritmes van
Processing. Standaard leeg.

Compatibiliteit tussen versies van QGIS en OTB

Alle versies van OTB (vanaf OTB 6.6.1) zĳn compatibel met de laatste versie van QGIS.

Probleemoplossing

Als u problemen hebt met toepassingen van OTB in QGIS Processing, open dan een issue op de OTB bug tracker,
met het label qgis.
Aanvullende informatie over OTB en QGIS is hier te vinden.
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Processing providers en algoritmes

Algoritmes voor Processing en hun parameters (zoals weergegeven in de gebruikersinterface) worden hier beschreven.

27.1 QGIS algoritme provider

De QGIS algoritme provider implementeert verschillende bewerkingen voor analyses en geo-verwerking door middel
van, meestal, alleen de API van QGIS. Dus nagenoeg alle algoritmes van deze provider zullen “out of the box” werken,
zonder enige aanvullende configuratie.
Deze provider bevat enkele algoritmes uit plug-ins en voegt ook zĳn eigen algoritmes toe.

27.1.1 Cartografie

Punten uitlijnen op objecten

Berekent de vereiste rotatie om puntobjecten uit te lĳnen met hun dichtstbĳgelegen object van een andere
verwĳzingslaag. Een nieuw veld wordt aan de uitvoerlaag toegevoegd, dat is gevuld met de hoek (in graden, met
de wĳzers van de klok mee) tot het dichtstbĳgelegen verwĳzingsobject.
Optioneel kan de symbologie van de uitvoerlaag worden ingesteld om automatisch het veld voor de berekende rotatie
te gebruiken om markeringssymbolen te draaien. Indien gewenst kan een maximaal te gebruiken afstand voor het
uitlĳnen van punten worden ingesteld, om te voorkomen dat geïsoleerde punten worden uitgelĳnd aan verafgelegen
objecten.

Hint: Dit algoritme is ontworpen om te worden gebruikt in gevallen zoals het uitlĳnen van puntsymbolen voor
gebouwen om de dichtstbĳzĳnde richting van een weg te volgen.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: punt] Puntobjecten waarvoor de rotatie moet

worden berekend
Referentielaag REFERENCE_LAYER[vector: elke] Laag waarvan het dichtstbĳzĳnde object

moet worden gevonden voor berekenen van
de rotatie

Maximale te
overwegen afstand
Optioneel

MAX_DISTANCE [getal]
Standaard: Niet
ingesteld

Indien geen verwĳzingsobject wordt
gevonden binnen deze afstand, wordt geen
rotatie toegewezen aan het puntobject.

Hoek veldnaam FIELD_NAME [tekenreeks]
Standaard: ‘rotation’

Veld waarin de waarde voor de rotatie moet
worden opgeslagen.

Automatisch
symbologie
toepassen

APPLY_SYMBOLOGY[Booleaanse
waarde]
Standaard: True

Roteert de markeringssymbolen van de
objecten met de waarde van het veld voor
de hoek

Uitgelĳnde laag OUTPUT [vector: punt]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer de geroteerde uitvoer
vectorlaag. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Uitgelĳnde laag OUTPUT [vector: punt] De puntenlaag met een toegevoegd

veld voor de rotatie. Indien geladen
in QGIS wordt het standaard voorzien
van de symbologie voor de invoerlaag,
met een data-bepaalde rotatie van zĳn
markeringssymbool.

Pythoncode

ID algoritme: native:angletonearest

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Stijldatabases combineren

Combineert meerdere stĳldatabases van QGIS naar één enkele stĳldatabase. Als items van hetzelfde typemet dezelfde
naam bestaan in verschillende brondatabases, zullen die worden hernoemd, zodat zĳ unieke namen hebben in de
gecombineerde database van de uitvoer.
Zie ook:
Stĳldatabase uit project maken

Parameters

Label Naam Type Beschrijving
Invoer databases INPUT [bestand] [lĳst] Bestanden die QGIS stĳlitems bevatten
Te combineren
objecten

OBJECTS [enumeratie] [lĳst] Typen van stĳlitems in de invoerdatabases
die u in de nieuwe database wilt plaatsen.
Dit kunnen zĳn:

• 0 — Symbolen
• 1 — Kleurverlopen
• 2 — Tekstindelingen
• 3 — Instellingen voor labels

Uitvoer
stĳldatabase

OUTPUT [bestand]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Uitvoerbestand .XML dat de geselecteerde
items voor de stĳl combineert. Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Beschrijving
Aantal
kleurverlopen

COLORRAMPS [getal]

Aantal
instellingen voor
labels

LABELSETTINGS [getal]

Uitvoer
stĳldatabase

OUTPUT [bestand] Uitvoerbestand .XML dat de geselecteerde
stĳlitems combineert

Aantal symbolen SYMBOLS [getal]
Aantal
tekstindelingen

TEXTFORMATS [getal]
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Pythoncode

ID algoritme: native:combinestyles

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Renderer Categorieën maken uit stijlen

Stelt een renderer voor een vectorlaag in op eenRenderer Categorieënmet overeenkomende symbolen uit een database
met stĳlen. Als er geen stĳlbestand wordt gespecificeerd, worden in plaats daarvan symbolen uit de gebruikers huidige
symboolbibliotheek gebruikt.
Een gespecificeerde expressie (of veld) wordt gebruikt om categorieën voor de renderer te maken. Elke categorie
komt individueel overeen met de symbolen die bestaan binnen de gespecificeerde QGIS XML-database met stĳlen.
Wanneer een overeenkomende symboolnaam is gevonden, wordt het symbool van de categorie ingesteld op dit
overeenkomende symbool.
Indien gewenst kan uitvoer ook naar tabellen die lĳsten bevatten van de categorieën die niet overeenkwamen met
symbolen, en symbolen die niet overeenkwamen met categorieën.

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Vectorlaag waarop een gecategoriseerde

stĳl moet worden toegepast
Categoriseren met
expressie

FIELD [expressie] Veld of expressie om de objecten te
categoriseren

Stĳldatabase
(leeg laten om
opgeslagen
symbolen te
gebruiken)

STYLE [bestand] Bestand (.XML) dat de symbolen bevat
die moeten worden toegepast op de
categorieën van de invoerlaag. Het bestand
kan worden verkregen met het gereedschap
Symbolen delen uit de Stĳlmanager. Als
geen bestand is gespecificeerd, wordt de
lokale bibliotheek van symbolen van QGIS
gebruikt.

Hoofdlettergevoelige
overeenkomst
gebruiken voor
namen van
symbolen

CASE_SENSITIVE [Booleaanse
waarde]
Standaard: False

Indien True (geselecteerd) wordt een
hoofdlettergevoelige vergelĳking toegepast
op de namen van categorieën en symbolen.

Niet-
alfanumerieke
tekens negeren in
overeenkomsten

TOLERANT [Booleaanse
waarde]
Standaard: False

Indien True (geselecteerd) worden niet-
alfanumerieke tekens in de namen van
categorieën en symbolen genegeerd, wat
een grotere tolerantie bĳ de vergelĳking
mogelĳk maakt.

Vervolgt op volgende pagina
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Tabel 27.1 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Niet
overeenkomende
categorieën
Optioneel

NON_MATCHING_CATEGORIES[tabel]
Standaard:
[Uitvoer
overslaan]

Uitvoertabel voor categorieën die niet
overeenkomen met enig symbool in de
database. Één van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Niet
overeenkomende
namen voor
symbolen
Optioneel

NON_MATCHING_SYMBOLS[tabel]
Standaard:
[Uitvoer
overslaan]

Uitvoertabel voor symbolen uit de
verschafte stĳldatabase die niet
overeenkomen met een categorie. Één
van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Niet
overeenkomende
categorieën

NON_MATCHING_CATEGORIES[tabel] Vermeldt categorieën die niet overeen
kwamen met enig symbool in de verschafte
stĳldatabase

Niet
overeenkomende
namen voor
symbolen

NON_MATCHING_SYMBOLS[tabel] Vermeldt symbolen uit de verschafte
stĳldatabase die niet overeen kwamen met
een categorie

Laag met
categorieën

OUTPUT [hetzelfde als
invoer]

De invoer vectorlaag met daarop de stĳl
met categorieën toegepast. Er wordt geen
nieuwe laag uitgevoerd.

Pythoncode

ID algoritme: native:categorizeusingstyle

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Stijldatabase uit project maken

Neemt alle stĳlobjecten (symbolen, kleurverlopen, tekstindelingen en instellingen voor labels) uit een project van
QGIS.
De uitgenomen symbolen worden opgeslagen naar een stĳldatabase vanQGIS (indelingXML), die kan worden beheerd
en geïmporteerd via het dialoogvenster Stĳlmanager.
Zie ook:
Stĳldatabases combineren

Parameters

Label Naam Type Beschrijving
Invoerproject (laat
leeg om huidige te
gebruiken)
Optioneel

INPUT [bestand] Een projectbestand van QGIS om de
stĳlitems uit te nemen

Uit te nemen
objecten

OBJECTS [enumeratie] [lĳst] Typen van stĳlitems in het invoerproject die
u in de nieuwe database wilt plaatsen. Dit
kunnen zĳn:

• 0 — Symbolen
• 1 — Kleurverlopen
• 2 — Tekstindelingen
• 3 — Instellingen voor labels

Uitvoer
stĳldatabase

OUTPUT [bestand]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer het uitvoerbestand .XML voor
de geselecteerde items voor de stĳl. Één
van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Beschrijving
Aantal
kleurverlopen

COLORRAMPS [getal] Aantal kleurverlopen

Aantal
instellingen voor
labels

LABELSETTINGS [getal] Aantal instellingen voor labels

Uitvoer
stĳldatabase

OUTPUT [bestand] Uitvoerbestand .XML voor de
geselecteerde stĳlitems

Aantal symbolen SYMBOLS [getal] Aantal symbolen
Aantal
tekstindelingen

TEXTFORMATS [getal] Aantal tekstindelingen
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Pythoncode

ID algoritme: native:stylefromproject

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Lay-out atlas als afbeelding exporteren

Exporteert een afdruklay-out van een atlas als een afbeeldingsbestand (bĳv. afbeeldingen PNG of JPEG).
Als een bedekkingslaag is ingesteld, zullen de geselecteerde instellingen voor de lay-out van de atlas die worden
weergegeven in dit algoritme worden overschreven. In dat geval zal een leeg filter of sorteren op expressie deze
instellingen uitschakelen.

Parameters

Basis parameters

Label Naam Type Beschrijving
Atlas lay-out LAYOUT [lay-out] Lay-out om te exporteren
Bedekkingslaag
Optioneel

COVERAGE_LAYER [vector: elke] Te gebruiken laag voor het maken van de
atlas

Filter-expressie FILTER_EXPRESSION[expressie] Expressie voor het filteren van de objecten
van de atlas

Sorteerexpressie
Optioneel

SORTBY_EXPRESSION[expressie] Expressie voor het sorteren van de objecten
van de atlas

Omgekeerde
volgorde sorteren
Optioneel

SORTBY_REVERSE [Booleaanse
waarde]

Omgekeerde volgorde sorteren. Gebruikt
als een expressie voor sorteren is opgegeven.

Expressie Uitvoer
bestandsnaam

FILENAME_EXPRESSION[expressie]
Standaard:
‘output_’||@atlas_featurenumber

Expressie om te gebruiken voor het maken
van bestandsnamen

Map voor uitvoer FOLDER [map] Doelmap waar de afbeeldingen zullen
worden gemaakt
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Gevorderde parameters

Label Naam Type Beschrijving
Kaartlagen toe
te wĳzen aan
niet vastgezette
kaartitem(s)
Optioneel

LAYERS [enumeratie] [laag] Weer te geven lagen in de kaartitem(s)
waarvan de inhoud niet is vergrendeld

Indeling
afbeelding

EXTENSION [enumeratie]
Standaard: png

Bestandsindeling van de gemaakt uitvoer.
De lĳst met beschikbare indelingen varieert,
afhankelĳk van het besturingssysteem en
geïnstalleerde stuurprogramma’s.

DPI
Optioneel

DPI
Standaard: Niet
ingesteld

[getal] DPI voor de uitvoerbestanden. Indien niet
ingesteld zal de waarde, die is ingesteld in de
instellingen voor de afdruklay-out, worden
gebruikt.

‘World file’
aanmaken

GEOREFERENCE [Booleaanse
waarde]
Standaard: True

Bepaalt of een ‘world file’ zou moeten
worden gemaakt

RDF-metadata
exporteren

INCLUDE_METADATA[Booleaanse
waarde]
Standaard: True

Bepaalt of RDF-metadata (titel, auteur, …)
zou moeten worden gemaakt

Antialiasing
inschakelen

ANTIALIAS [Booleaanse
waarde]
Standaard: True

Bepaalt of een anti-aliasing zou moeten
worden ingeschakeld

Uitvoer

Label Naam Type Beschrijving
Afbeeldingsbestand OUTPUT [bestand] Afbeeldingsbestanden gemaakt door de lay-

out van atlas

Pythoncode

ID algoritme: native:atlaslayouttoimage

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Lay-out van atlas als PDF exporteren (meerdere bestanden)

NEW in 3.24

Exporteert de atlas van een afdruklay-out naar meerdere PDF-bestanden.
Als een bedekkingslaag is ingesteld, zullen de geselecteerde instellingen voor de lay-out van de atlas die worden
weergegeven in dit algoritme worden overschreven. In dat geval zal een leeg filter of sorteren op expressie deze
instellingen uitschakelen.

Parameters

Basis parameters

Label Naam Type Beschrijving
Atlas lay-out LAYOUT [lay-out] Lay-out om te exporteren
Bedekkingslaag
Optioneel

COVERAGE_LAYER [vector: elke] Te gebruiken laag voor het maken van de
atlas

Filter-expressie FILTER_EXPRESSION[expressie] Expressie voor het filteren van de objecten
van de atlas

Sorteerexpressie
Optioneel

SORTBY_EXPRESSION[expressie] Expressie voor het sorteren van de objecten
van de atlas

Omgekeerde
volgorde sorteren
Optioneel

SORTBY_REVERSE [Booleaanse
waarde]

Omgekeerde volgorde sorteren. Gebruikt
als een expressie voor sorteren is opgegeven.

Uitvoer
bestandsnaam
Optioneel

OUTPUT_FILENAME[expressie] Patroon voor de naam van de PDF
uitvoerbestanden.

Map voor uitvoer OUTPUT_FOLDER [map] Doelmap voor de PDF uitvoerbestanden.
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Gevorderde parameters

Label Naam Type Beschrijving
Kaartlagen toe
te wĳzen aan
niet vastgezette
kaartitem(s)
Optioneel

LAYERS [enumeratie] [laag] Weer te geven lagen in de kaartitem(s)
waarvan de inhoud niet is vergrendeld

DPI
Optioneel

DPI
Standaard: Niet
ingesteld

[getal] DPI voor de uitvoerbestanden. Indien niet
ingesteld zal de waarde, die is ingesteld in de
instellingen voor de afdruklay-out, worden
gebruikt.

Altĳd als vectoren
exporteren

FORCE_VECTOR [Booleaanse
waarde]
Standaard: False

Bepaalt of vectorgegevens als vectoren
zouden moeten worden gelaten

Altĳd als raster
exporteren
NEW in 3.28

FORCE_RASTER [Booleaanse
waarde]
Standaard: False

Forceert dat alle items in de kaart
worden gerasteriseerd. Deze parameter
heeft voorrang boven de parameter
FORCE_VECTOR.

Voeg georeferentie
informatie toe

GEOREFERENCE [Booleaanse
waarde]
Standaard: True

Bepaalt of een ‘world file’ zou moeten
worden gemaakt

RDF-metadata
exporteren

INCLUDE_METADATA[Booleaanse
waarde]
Standaard: True

Bepaalt of RDF-metadata (titel, auteur, …)
zou moeten worden gemaakt

Uitschakelen
getegelde
rasterlagen export

DISABLE_TILED [Booleaanse
waarde]
Standaard: False

Bepaalt of raster zou moeten worden
getegeld

Geometrieën
vereenvoudigen
om de
bestandsgrootte te
verkleinen

SIMPLIFY [Booleaanse
waarde]
Standaard: True

Bepaalt of geometrieën zouden moeten
worden vereenvoudigd om de grootte van
het uitvoerbestand te verkleinen

Tekst exporteren TEXT_FORMAT [enumeratie]
Standaard: 0

Bepaalt of tekst zou moeten worden
geëxporteerd als pad of als tekstobjecten.
Mogelĳke opties zĳn:

• 0 - Tekst altĳd als paden exporteren
(Aanbevolen)

• 1 - Tekst altĳd als tekstobjecten
exporteren

Compressie
afbeelding
NEW in 3.28

IMAGE_COMPRESSION[enumeratie]
Standaard: 0

Bepaalt het niveau van compressie voor
de afbeelding en hoe geschikt het bestand
zou kunnen zĳn voor afgedrukte uitvoeren
of post-productie in externe toepassingen.
Mogelĳke opties zĳn:

• 0 - Met verlies (JPEG)
• 1 - Zonder verlies
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Uitvoer

Label Naam Type Beschrijving
PDF-bestand OUTPUT [bestand] PDF-bestand dat overeenkomt met de

geëxporteerde atlas van de lay-out

Pythoncode

ID algoritme: native:atlaslayouttomultiplepdf

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Lay-out van atlas als PDF exporteren (enkel bestand)

Exporteert de atlas van een afdruklay-out naar één enkel PDF-bestand.
Als een bedekkingslaag is ingesteld, zullen de geselecteerde instellingen voor de lay-out van de atlas die worden
weergegeven in dit algoritme worden overschreven. In dat geval zal een leeg filter of sorteren op expressie deze
instellingen uitschakelen.

Parameters

Basis parameters

Label Naam Type Beschrijving
Atlas lay-out LAYOUT [lay-out] Lay-out om te exporteren
Bedekkingslaag
Optioneel

COVERAGE_LAYER [vector: elke] Te gebruiken laag voor het maken van de
atlas

Filter-expressie FILTER_EXPRESSION[expressie] Expressie voor het filteren van de objecten
van de atlas

Sorteerexpressie
Optioneel

SORTBY_EXPRESSION[expressie] Expressie voor het sorteren van de objecten
van de atlas

Omgekeerde
volgorde sorteren
Optioneel

SORTBY_REVERSE [Booleaanse
waarde]

Omgekeerde volgorde sorteren. Gebruikt
als een expressie voor sorteren is opgegeven.

PDF-bestand OUTPUT [bestand]
Standaard: [Opslaan
naar tĳdelĳk
bestand]

Naam (inclusief pad) voor het
uitvoerbestand. Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…
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Gevorderde parameters

Label Naam Type Beschrijving
Kaartlagen toe
te wĳzen aan
niet vastgezette
kaartitem(s)
Optioneel

LAYERS [enumeratie] [laag] Weer te geven lagen in de kaartitem(s)
waarvan de inhoud niet is vergrendeld

DPI
Optioneel

DPI
Standaard: Niet
ingesteld

[getal] DPI voor de uitvoerbestanden. Indien niet
ingesteld zal de waarde, die is ingesteld in de
instellingen voor de afdruklay-out, worden
gebruikt.

Altĳd als vectoren
exporteren

FORCE_VECTOR [Booleaanse
waarde]
Standaard: False

Bepaalt of vectorgegevens als vectoren
zouden moeten worden gelaten

Altĳd als raster
exporteren
NEW in 3.28

FORCE_RASTER [Booleaanse
waarde]
Standaard: False

Forceert dat alle items in de kaart
worden gerasteriseerd. Deze parameter
heeft voorrang boven de parameter
FORCE_VECTOR.

Voeg georeferentie
informatie toe

GEOREFERENCE [Booleaanse
waarde]
Standaard: True

Bepaalt of een ‘world file’ zou moeten
worden gemaakt

RDF-metadata
exporteren

INCLUDE_METADATA[Booleaanse
waarde]
Standaard: True

Bepaalt of RDF-metadata (titel, auteur, …)
zou moeten worden gemaakt

Uitschakelen
getegelde
rasterlagen export

DISABLE_TILED [Booleaanse
waarde]
Standaard: False

Bepaalt of raster zou moeten worden
getegeld

Geometrieën
vereenvoudigen
om de
bestandsgrootte te
verkleinen

SIMPLIFY [Booleaanse
waarde]
Standaard: True

Bepaalt of geometrieën zouden moeten
worden vereenvoudigd om de grootte van
het uitvoerbestand te verkleinen

Tekst exporteren TEXT_FORMAT [enumeratie]
Standaard: 0

Bepaalt of tekst zou moeten worden
geëxporteerd als pad of als tekstobjecten.
Mogelĳke opties zĳn:

• 0 - Tekst altĳd als paden exporteren
(Aanbevolen)

• 1 - Tekst altĳd als tekstobjecten
exporteren

Compressie
afbeelding
NEW in 3.28

IMAGE_COMPRESSION[enumeratie]
Standaard: 0

Bepaalt het niveau van compressie voor
de afbeelding en hoe geschikt het bestand
zou kunnen zĳn voor afgedrukte uitvoeren
of post-productie in externe toepassingen.
Mogelĳke opties zĳn:

• 0 - Met verlies (JPEG)
• 1 - Zonder verlies

974 Hoofdstuk 27. Processing providers en algoritmes



QGIS Desktop 3.28 User Guide

Uitvoer

Label Naam Type Beschrijving
PDF-bestand OUTPUT [bestand] PDF-bestand dat overeenkomt met de

geëxporteerde atlas van de lay-out

Pythoncode

ID algoritme: native:atlaslayouttopdf

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Afdruklay-out als afbeelding exporteren

Exporteert een afdruklay-out als een afbeeldingsbestand (bĳv. afbeeldingen PNG of JPEG).

Parameters

Basis parameters

Label Naam Type Beschrijving
Afdruklay-out LAYOUT [lay-out] Lay-out om te exporteren
Afbeeldingsbestand OUTPUT [bestand]

Standaard: [Opslaan
naar tĳdelĳk
bestand]

Naam (inclusief pad) voor het
uitvoerbestand. Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…
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Gevorderde parameters

Label Naam Type Beschrijving
Kaartlagen toe
te wĳzen aan
niet vastgezette
kaartitem(s)
Optioneel

LAYERS [enumeratie] [laag] Weer te geven lagen in de kaartitem(s)
waarvan de inhoud niet is vergrendeld

DPI
Optioneel

DPI
Standaard: Niet
ingesteld

[getal] DPI voor de uitvoerbestanden. Indien niet
ingesteld zal de waarde, die is ingesteld in de
instellingen voor de afdruklay-out, worden
gebruikt.

‘World file’
aanmaken

GEOREFERENCE [Booleaanse
waarde]
Standaard: True

Bepaalt of een ‘world file’ zou moeten
worden gemaakt

RDF-metadata
exporteren

INCLUDE_METADATA[Booleaanse
waarde]
Standaard: True

Bepaalt of RDF-metadata (titel, auteur, …)
zou moeten worden gemaakt

Antialiasing
inschakelen

ANTIALIAS [Booleaanse
waarde]
Standaard: True

Bepaalt of een anti-aliasing zou moeten
worden ingeschakeld

Uitvoer

Label Naam Type Beschrijving
Afbeeldingsbestand OUTPUT [bestand] Afbeeldingsbestand dat overeenkomt met

de geëxporteerde afdruklay-out

Pythoncode

ID algoritme: native:printlayouttoimage

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Afdruklay-out als PDF exporteren

Exporteert een afdruklay-out als een PDF-bestand.
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Parameters

Basis parameters

Label Naam Type Beschrijving
Afdruklay-out LAYOUT [lay-out] Lay-out om te exporteren
PDF-bestand OUTPUT [bestand]

Standaard: [Opslaan
naar tĳdelĳk
bestand]

Naam (inclusief pad) voor het
uitvoerbestand. Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…
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Gevorderde parameters

Label Naam Type Beschrijving
Kaartlagen toe
te wĳzen aan
niet vastgezette
kaartitem(s)
Optioneel

LAYERS [enumeratie] [laag] Weer te geven lagen in de kaartitem(s)
waarvan de inhoud niet is vergrendeld

DPI
Optioneel

DPI
Standaard: Niet
ingesteld

[getal] DPI voor de uitvoerbestanden. Indien niet
ingesteld zal de waarde, die is ingesteld in de
instellingen voor de afdruklay-out, worden
gebruikt.

Altĳd als vectoren
exporteren

FORCE_VECTOR [Booleaanse
waarde]
Standaard: False

Bepaalt of vectorgegevens als vectoren
zouden moeten worden gelaten

Altĳd als raster
exporteren
NEW in 3.28

FORCE_RASTER [Booleaanse
waarde]
Standaard: False

Forceert dat alle items in de kaart
worden gerasteriseerd. Deze parameter
heeft voorrang boven de parameter
FORCE_VECTOR.

Voeg georeferentie
informatie toe

GEOREFERENCE [Booleaanse
waarde]
Standaard: True

Bepaalt of een ‘world file’ zou moeten
worden gemaakt

RDF-metadata
exporteren

INCLUDE_METADATA[Booleaanse
waarde]
Standaard: True

Bepaalt of RDF-metadata (titel, auteur, …)
zou moeten worden gemaakt

Uitschakelen
getegelde
rasterlagen export

DISABLE_TILED [Booleaanse
waarde]
Standaard: False

Bepaalt of raster zou moeten worden
getegeld

Geometrieën
vereenvoudigen
om de
bestandsgrootte te
verkleinen

SIMPLIFY [Booleaanse
waarde]
Standaard: True

Bepaalt of geometrieën zouden moeten
worden vereenvoudigd om de grootte van
het uitvoerbestand te verkleinen

Tekst exporteren TEXT_FORMAT [enumeratie]
Standaard: 0

Bepaalt of tekst zou moeten worden
geëxporteerd als pad of als tekstobjecten.
Mogelĳke opties zĳn:

• 0 - Tekst altĳd als paden exporteren
(Aanbevolen)

• 1 - Tekst altĳd als tekstobjecten
exporteren

Compressie
afbeelding
NEW in 3.28

IMAGE_COMPRESSION[enumeratie]
Standaard: 0

Bepaalt het niveau van compressie voor
de afbeelding en hoe geschikt het bestand
zou kunnen zĳn voor afgedrukte uitvoeren
of post-productie in externe toepassingen.
Mogelĳke opties zĳn:

• 0 - Met verlies (JPEG)
• 1 - Zonder verlies

Lagen exporteren
als afzonderlĳke
PDF-bestanden

SEPARATE_LAYERS[Booleaanse
waarde]
Standaard: False

Indien True zal een afzonderlĳk PDF-
bestand worden gemaakt per laag per
kaartitem in de lay-out. Aanvullend kunnen
afzonderlĳke PDF-bestanden worden
gemaakt voor andere complexe lay-
outitems, resulterend in set PDF-bestanden
die logische atomische componenten van
de lay-out bevatten.
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Uitvoer

Label Naam Type Beschrijving
PDF-bestand OUTPUT [bestand] PDF-bestand(en dat overeenkomt met de

geëxporteerde afdruklay-out

Pythoncode

ID algoritme: native:printlayouttopdf

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Labels uitnemen

NEW in 3.24

Neemt informatie van labels uit van een gerenderde kaart met een opgegeven bereik en schaal.
Als een kaartthema wordt verschaft zal de gerenderde kaart overeenkomen met de zichtbaarheid en symbologie van
dat thema. Indien leeg gelaten zullen alle zichtbare lagen van het project worden gebruikt. Uitgenomen informatie
van de label omvat: positie (weergegeven als geometrieën punt), de naam van de geassocieerde laag en object-ID,
labeltekst, rotatie (in graden, met de wĳzers van de klok mee), meerregelige uitlĳning en details over het lettertype.

Parameters
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Basis parameters

Label Naam Type Beschrijving
Kaartbereik EXTENT [bereik] Bereik van de kaart waaruit de labels

moeten worden uitgenomen
Beschikbare methoden zĳn:

• Uit laag berekenen…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

Schaal kaart SCALE [schaal] Uitgenomen labels zullen worden gerenderd
met hun eigenschappen ingesteld op deze
schaal.

Kaartthema
Optioneel

MAP_THEME [maptheme] Een kaartthema dat de lagen weergeeft
waaruit de labels moeten worden
uitgenomen. Indien niet ingesteld zullen
labels van de momenteel zichtbare lagen
worden uitgenomen.

Niet geplaatste
labels opnemen
Optioneel

INCLUDE_UNPLACED[Booleaanse
waarde]
Standaard: True

Specificeer of alle overlappende labels
zouden moeten worden uitgenomen,
inclusief de conflicterende (dus niet
geplaatste).

Uitgenomen labels OUTPUT [vector: punt]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag voor
de/het bereik(en). Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

980 Hoofdstuk 27. Processing providers en algoritmes



QGIS Desktop 3.28 User Guide

Gevorderde parameters

Label Naam Type Beschrijving
Kaartresolutie (in
DPI)
Optioneel

DPI
Standaard: 96.0

[getal]
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Uitvoer

Label Naam Type Beschrijving
Uitgenomen labels OUTPUT [vector: punt] Punt vectorlaag die de opgehaalde labels

weergeeft. Elk object heeft attributen die
zĳn bronlaag identificeren (laag, object-
ID) en de toegewezen eigenschappen voor
labelen (tekst, lettertype, grootte, rotatie,
…). Een standaard stĳl met labelen en
symbool null wordt ook toegepast op de
laag.

Waarschuwing:
Omdat
enkele
van
de
gemaakte
velden
namen
hebben
met
meer
dan
10
tekens,
zou
het
gebruiken
van
de
indeling
ESRI
shapefile
(.
SHP)
om
de
uitvoer
op
te
slaan
kunnen
leiden
tot
onverwacht
renderen
bĳ
het
laden
van
de
laag
in
QGIS.
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Pythoncode

ID algoritme: native:extractlabels

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Kaartbereik van lay-out afdrukken naar laag

Maakt een polygoonlaag die het bereik van een kaartitem (of items) van een afdruklay-out bevat, met attributen die
de kaartgroottes (in lay-outeenheden, d.i. de eenheden van de verwĳzingskaart), schaal en rotatie specificeren.
Als de parameter voor het kaartitem is gespecificeerd, dan zal alleen het overeenkomende bereik worden
geëxporteerd. Als die niet wordt gespecificeerd, worden alle kaartbereiken van de lay-out worden geëxporteerd.
Optioneel kan een specifiek CRS voor de uitvoer worden gespecificeerd. Als dat niet wordt gespecificeerd, zal het
CRS van het originele kaartitem worden gebruikt.

Parameters

Basis parameters

Label Naam Type Beschrijving
Afdruklay-out LAYOUT [enumeratie] Een afdruklay-out in het huidige project
Kaartitem
Optioneel

MAP [enumeratie]
Standaard: Alle
kaartitems

De/Het kaartitem(s) waarvan u de
informatie wilt uitnemen. Indien geen wordt
opgegeven, dan worden alle kaartitems
verwerkt.

Bereik OUTPUT [vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag voor
de/het bereik(en). Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Gevorderde parameters

Label Naam Type Beschrijving
CRS overschrĳven
Optioneel

CRS [crs]
Standaard: CRS van
de lay-out

Selecteer het CRS voor de laag waarin de
informatie zal worden gerapporteerd.
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Uitvoer

Label Naam Type Beschrijving
Kaarthoogte HEIGHT [getal]
Bereik OUTPUT [vector: polygoon] Uitvoer polygoon vectorlaag die de bereiken

bevat van alle invoer lay-outkaartitems
Rotatie kaart ROTATION [getal]
Schaal kaart SCALE [getal]
Kaartbreedte WIDTH [getal]

Pythoncode

ID algoritme: native:printlayoutmapextenttolayer

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Stijl laag instellen

Stelt de opgegeven stĳl voor een laag in. De stĳl moet zĳn gedefinieerd als een QML -bestand.
Nieuwe uitvoer wordt niet gemaakt: de stĳl wordt direct toegewezen aan de laag.

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [laag] Invoerlaag waarop u de stĳl wilt toepassen
Stĳlbestand STYLE [bestand] Pad naar het .qml-bestand van de stĳl

Uitvoer

Label Naam Type Beschrijving
OUTPUT [hetzelfde als

invoer]
De invoerlaag met daarop de nieuwe stĳl
toegepast. Er wordt geen nieuwe laag
gemaakt.
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Pythoncode

ID algoritme: native:setlayerstyle

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Topologische kleuring

Wĳst een kleurindex toe aan polygoonobjecten op een dusdanige manier dat aaneensluitende objecten niet dezelfde
kleurindex delen, onderwĳl het vereiste aantal kleuren minimaliserend.
Het algoritme maakt het mogelĳk de te gebruiken methoden voor het toewĳzen van de kleuren te kiezen.
Indien gewenst kan eenminimum aantal kleuren worden gespecificeerd. De kleurindex wordt opgeslagen in een nieuw
attribuut, genaamd color_id.
Het volgende voorbeeld laat het algoritme zien met vier gekozen verschillende kleuren; zoals u kunt zien heeft elke
kleurklasse hetzelfde aantal objecten.

Fig. 27.1: Voorbeeld Topologische kleuring

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: polygoon] De invoer polygoonlaag
Minimaal aantal
kleuren

MIN_COLORS [getal]
Standaard: 4

Het minimale aantal toe te wĳzen kleuren.
Minimum 1, maximum 1000.

Vervolgt op volgende pagina
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Tabel 27.2 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Minimale afstand
tussen objecten

MIN_DISTANCE [getal]
Standaard: 0.0

Voorkomt dat nabĳgelegen (maar niet
rakende) objecten gelĳke kleuren krĳgen
toegewezen. Minimum 0.0.

Kleurtoekenning
uitbalanceren

BALANCE [enumeratie]
Standaard: 0

Opties zĳn:
• 0 — Op aantal objecten
Probeert kleuren zo toe te wĳzen
dat er een balans is tussen het
aantal objecten en elke individuele
kleurindex.

• 1 — Op toegekende oppervlakte
Wĳst kleuren zo toe dat er een
balans is tussen het totale gebied
van objecten dat is toegewezen aan
elke kleur. Deze modus kan nuttig
zĳn om grote objecten, waardoor een
van de kleuren meer dominant zou
verschĳnen op een gekleurde kaart, te
vermĳden.

• 2 — Op afstand tussen kleuren
Wĳst kleuren dusdanig toe dat de
afstand tussen objecten van dezelfde
kleur wordt gemaximaliseerd. Deze
modus helpt om een meer uniforme
verdeling van kleuren over een kaart
te krĳgen.

Gekleurd OUTPUT [vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoerlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Gekleurd OUTPUT [vector: polygoon] Polygoon vectorlaag met een toegevoegde

kolom color_id
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Pythoncode

ID algoritme: qgis:topologicalcoloring

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Annotaties verplaatsen vanaf hoofdlaag

Verplaatst alle annotations vanaf de hoofdlaag voor annotaties in een project naar een nieuwe laag met annotaties.
Plaatsing van items kan dan worden aangepast in de laagstapel.

Parameters

Label Naam Type Beschrijving
Nieuwe laagnaam LAYER_NAME [tekenreeks]

Standaard:
‘Annotaties’

Naam van de te maken laag met annotaties

Uitvoer

Label Naam Type Beschrijving
Nieuwe laagnaam OUTPUT [laag] Een laag met items vanaf de hoofdlaag met

annotaties

Pythoncode

ID algoritme: native:transferannotationsfrommain

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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27.1.2 Database

Export to PostgreSQL

Exports a vector layer to a PostgreSQL database, creating a new relation. If a relation with the same name exists,
it can be removed before the new relation is created. Prior to this a connection between QGIS and the PostgreSQL
database has to be created (see eg Een opgeslagen verbinding maken).

Parameters

Label Name Type Description
Layer to import INPUT [vector: any] Vector layer to add to the database
Database
(connection name)

DATABASE [string] Name of the database connection (not the
database name). Existing connections will
be shown in the combobox.

Schema (schema
name)
Optional

SCHEMA [string]
Default: ‘public’

Name of the schema to store the data. It can
be a new one or already exist.

Table to import to
(leave blank to use
layer name)
Optional

TABLENAME [string]
Default: ‘’

Defines a table name for the imported
vector file. If nothing is added, the layer
name will be used.

Primary key field
Optional

PRIMARY_KEY [tablefield: any] Sets the primary key field from an existing
field in the vector layer. A column with
unique values can be used as Primary key
for the database.

Geometry column GEOMETRY_COLUMN[string]
Default: ‘geom’

Defines the name of the geometry column
in the new PostGIS table. Geometry
information for the features is stored in this
column.

Encoding
Optional

ENCODING [string]
Default: ‘UTF-8’

Defines the encoding of the output layer

Overwrite OVERWRITE [boolean]
Default: True

If the specified table exists, setting this
option to True will make sure that it is
deleted and a new table will be created
before the features are added. If this option
is False and the table exists, the algorithm
will throw an exception (“relation already
exists”).

Create spatial
index

CREATEINDEX [boolean]
Default: True

Specifies whether to create a spatial index
or not

Convert field
names to
lowercase

LOWERCASE_NAMES[boolean]
Default: True

Converts the field names of the input vector
layer to lowercase

Drop length
constraint on
character fields

DROP_STRING_LENGTH[boolean]
Default: False

Should length constraints on character fields
be dropped or not

Create single-part
geometries instead
of multi-part

FORCE_SINGLEPART[boolean]
Default: False

Should the features of the output layer
be single-part instead of multi-part. By
default the existing geometries information
are preserved.
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Outputs

The algorithm has no output.

Python code

Algorithm ID: qgis:importintopostgis

import processing
processing.run("algorithm_id", {parameter_dictionary})

The algorithm id is displayed when you hover over the algorithm in the Processing Toolbox. The parameter dictionary
provides the parameter NAMEs and values. See Processing algoritmes gebruiken vanaf de console for details on how
to run processing algorithms from the Python console.

Export to SpatiaLite

Exports a vector layer to a SpatiaLite database. Prior to this a connection between QGIS and the SpatiaLite database
has to be created (see eg SpatiaLite-lagen).

Parameters

Label Name Type Description
Layer to import INPUT [vector: any] Vector layer to add to the database
File database DATABASE [vector: any] The SQLite/SpatiaLite database file to

connect to
Table to import to
(leave blank to use
layer name)
Optional

TABLENAME [string]
Default: ‘’

Defines the table name for the imported
vector file. If nothing is specified, the layer
name will be used.

Primary key field
Optional

PRIMARY_KEY [tablefield: any] Use a field in the input vector layer as the
primary key

Geometry column GEOMETRY_COLUMN[string]
Default: ‘geom’

Defines the name of the geometry column
in the new SpatiaLite table. Geometry
information for the features is stored in this
column.

Encoding
Optional

ENCODING [string]
Default: ‘UTF-8’

Defines the encoding of the output layer

Overwrite OVERWRITE [boolean]
Default: True

If the specified table exists, setting this
option to True will make sure that it is
deleted and a new table will be created
before the features of the layer is added.
If this option is False and the table
exists, the algorithmwill throw an exception
(“table already exists”).

Create spatial
index

CREATEINDEX [boolean]
Default: True

Specifies whether to create a spatial index
or not

Convert field
names to
lowercase

LOWERCASE_NAMES[boolean]
Default: True

Convert the field names of the input vector
layer to lowercase

Drop length
constraint on
character fields

DROP_STRING_LENGTH[boolean]
Default: False

Should length constraints on character fields
be dropped or not

Vervolgt op volgende pagina
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Tabel 27.5 – Vervolgd van vorige pagina
Label Name Type Description
Create single-part
geometries instead
of multi-part

FORCE_SINGLEPART[boolean]
Default: False

Should the features of the output layer
be single-part instead of multi-part. By
default the existing geometries information
are preserved.

Outputs

The algorithm has no output.

Python code

Algorithm ID: qgis:importintospatialite

import processing
processing.run("algorithm_id", {parameter_dictionary})

The algorithm id is displayed when you hover over the algorithm in the Processing Toolbox. The parameter dictionary
provides the parameter NAMEs and values. See Processing algoritmes gebruiken vanaf de console for details on how
to run processing algorithms from the Python console.

Package layers

Adds layers to a GeoPackage.
If the GeoPackage exists and Overwrite existing GeoPackage is checked, it will be overwritten (removed
and recreated). If the GeoPackage exists and Overwrite existing GeoPackage is not checked, the layer
will be appended.
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Parameters

Label Name Type Description
Input layers LAYERS [vector: any] [list] The (vector) layers to import into the

GeoPackage. Raster layers are not
supported. If a raster layer is added, a
QgsProcessingException will be
thrown.

Overwrite existing
GeoPackage

OVERWRITE [boolean]
Default: False

If the specified GeoPackage exists, setting
this option to True will make sure that it is
deleted and a new one will be created before
the layers are added. If set to False, layers
will be appended.

Save layer styles
into GeoPackage

SAVE_STYLES [boolean]
Default: True

Save the layer styles

Save only selected
features

SELECTED_FEATURES_ONLY[boolean]
Default: False

If a layer has a selection, setting this option
to True will result in only selected features
being saved. For layers without a selection
all features will be saved.

Exporteren van
gerelateerde lagen
volgt relaties die
zĳn gedefinieerd
in het project
NEW in 3.28

EXPORT_RELATED_LAYERS[boolean]
Default: False

Als een invoerlaag relaties heeft ingesteld
in het project, zal het instellen van deze
optie op True resulteren in het exporteren
van ook zĳn gerelateerde la(a)g(en. Als de
laag objecten heeft geselecteerd, dan zullen
alleen hun gerelateerde objecten worden
geëxporteerd, tenzĳ de gerelateerde laag
ook een invoerlaag was.

Destination
GeoPackage

OUTPUT [file]
Default: [Save
to temporary
file]

Specify where to store the GeoPackage file.
One of

• Save to a Temporary File
• Save to File…

Outputs

Label Name Type Description
Layers within new
package

OUTPUT_LAYERS [string] [list] The list of layers added to the GeoPackage.

Python code

Algorithm ID: native:package

import processing
processing.run("algorithm_id", {parameter_dictionary})

The algorithm id is displayed when you hover over the algorithm in the Processing Toolbox. The parameter dictionary
provides the parameter NAMEs and values. See Processing algoritmes gebruiken vanaf de console for details on how
to run processing algorithms from the Python console.
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PostgreSQL execute and load SQL

Allows a SQL database query to be performed on a PostgreSQL database connected to QGIS and loads the result.
The algorithm won’t create a new layer: it is designed to run queries on the layer itself.
Example

1. Set all the values of an existing field to a fixed value. The SQL query string will be:

UPDATE your_table SET field_to_update=20;

In the example above, the values of the field field_to_update of the table your_table will be all set
to 20.

2. Create a new area column and calculate the area of each feature with the ST_AREA PostGIS function.

-- Create the new column "area" on the table your_table"
ALTER TABLE your_table ADD COLUMN area double precision;
-- Update the "area" column and calculate the area of each feature:
UPDATE your_table SET area=ST_AREA(geom);

Zie ook:
PostgreSQL execute SQL, SQL uitvoeren, SpatiaLite execute SQL

Parameters

Label Name Type Description
Database
(connection name)

DATABASE [string] The database connection (not the database
name). Existing connections will be shown
in the combobox.

SQL query SQL [string] Defines the SQL query, for example
'UPDATE my_table SET
field=10'.

Unique ID field
name

ID_FIELD [string]
Default: id

Sets the primary key field (a column in the
result table)

Geometry field
name
Optional

GEOMETRY_FIELD [string]
Default: ‘geom’

Name of the geometry column (a column in
the result table)

Outputs

Label Name Type Description
SQL layer OUTPUT [vector: any] The resulting vector layer to be loaded into

QGIS.
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Python code

Algorithm ID: qgis:postgisexecuteandloadsql

import processing
processing.run("algorithm_id", {parameter_dictionary})

The algorithm id is displayed when you hover over the algorithm in the Processing Toolbox. The parameter dictionary
provides the parameter NAMEs and values. See Processing algoritmes gebruiken vanaf de console for details on how
to run processing algorithms from the Python console.

PostgreSQL execute SQL

Allows a SQL database query to be performed on a PostgreSQL database connected to QGIS. The algorithm won’t
create a new layer: it is designed to run queries on the layer itself.
Example

1. Set all the values of an existing field to a fixed value. The SQL query string will be:

UPDATE your_table SET field_to_update=20;

In the example above, the values of the field field_to_update of the table your_table will be all set
to 20.

2. Create a new area column and calculate the area of each feature with the ST_AREA PostGIS function.

-- Create the new column "area" on the table your_table"
ALTER TABLE your_table ADD COLUMN area double precision;
-- Update the "area" column and calculate the area of each feature:
UPDATE your_table SET area=ST_AREA(geom);

Zie ook:
PostgreSQL execute and load SQL, SQL uitvoeren, SpatiaLite execute SQL

Parameters

Label Name Type Description
Database
(connection name)

DATABASE [string] The database connection (not the database
name). Existing connections will be shown
in the combobox.

SQL query SQL [string] Defines the SQL query, for example
'UPDATE my_table SET
field=10'.

Outputs

No output is created. The SQL query is executed in place.
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Python code

Algorithm ID: native:postgisexecutesql

import processing
processing.run("algorithm_id", {parameter_dictionary})

The algorithm id is displayed when you hover over the algorithm in the Processing Toolbox. The parameter dictionary
provides the parameter NAMEs and values. See Processing algoritmes gebruiken vanaf de console for details on how
to run processing algorithms from the Python console.

SpatiaLite execute SQL

Allows a SQL database query to be performed on a SpatiaLite database. The algorithm won’t create a new layer: it
is designed to run queries on the layer itself.
Zie ook:
PostgreSQL execute SQL, SQL uitvoeren

For some SQL query examples see PostGIS SQL Query Examples.

Parameters

Label Name Type Description
File Database DATABASE [vector] The SQLite/SpatiaLite database file to

connect to
SQL query SQL [string]

Default: ‘’
Defines the SQL query, for example
'UPDATE my_table SET
field=10'.

Outputs

No output is created. The SQL query is executed in place.

Python code

Algorithm ID: native:spatialiteexecutesql

import processing
processing.run("algorithm_id", {parameter_dictionary})

The algorithm id is displayed when you hover over the algorithm in the Processing Toolbox. The parameter dictionary
provides the parameter NAMEs and values. See Processing algoritmes gebruiken vanaf de console for details on how
to run processing algorithms from the Python console.
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SpatiaLite execute SQL (registered DB)

Allows a SQL database query to be performed on a SpatiaLite database connected to QGIS. The algorithm won’t
create a new layer: it is designed to run queries on the layer itself.
Zie ook:
PostgreSQL execute SQL, SQL uitvoeren

For some SQL query examples see PostGIS SQL Query Examples.

Parameters

Label Name Type Description
Database DATABASE [enumeration]

Default: not set
Select a SQLite/SpatiaLite database
connected to the current session

SQL query SQL [string]
Default: ‘’

Defines the SQL query, for example
'UPDATE my_table SET
field=10'.

Outputs

No output is created. The SQL query is executed in place.

Python code

Algorithm ID: native:spatialiteexecutesqlregistered

import processing
processing.run("algorithm_id", {parameter_dictionary})

The algorithm id is displayed when you hover over the algorithm in the Processing Toolbox. The parameter dictionary
provides the parameter NAMEs and values. See Processing algoritmes gebruiken vanaf de console for details on how
to run processing algorithms from the Python console.

27.1.3 Gereedschappen voor bestanden

Bestand downloaden

Downloadt een met een URL gespecificeerd bestand (met bĳvoorbeeld http: of file:). Met andere woorden: u
kunt een URL kopiëren/plakken en het bestand downloaden.

Parameters
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Basis parameters

Label Naam Type Beschrijving
URL URL [tekenreeks] De URL van het te downloaden bestand.
Doel bestand
Optioneel

OUTPUT [tekenreeks]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van het doel van het bestand.
Één van:

• Uitvoer overslaan
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Methode METHOD [enumeratie]

Standaard: 0
De voor het verzoek gebruikte methode
HTTP. Opties zĳn:

• 0 — GET
• 1 — POST

Gegevens
Optioneel

DATA [tekenreeks] De in het tekstblok toe te voegen gegevens
als het verzoek POST is.

Uitvoer

Label Naam Type Beschrijving
Doel bestand OUTPUT [tekenreeks] De locatie van het gedownloade bestand

Pythoncode

ID algoritme: qgis:filedownloader

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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27.1.4 GPS

GPS-gegevens converteren

Gebruikt het gereedschap GPSBabel om een bestand met GPS-gegevens te converteren vanuit een groot bereik aann
indeingen naar de GPX standaardindeling.

Parameters

Label Naam Type Omschrijving
Invoerbestand INPUT [bestand] Bestand dat de te converteren gegevens

bevat
Indeling FORMAT [enumeratie] Indeling van het te converteren bestand, uit

deze lĳst.
Object type FEATURE_TYPE [enumeratie]

Standaard: 0
Het type van de te converteren gegevens

• 0 —Waypoints
• 1 — Routes
• 2 — Tracks

Uitvoer OUTPUT [vector: elke]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van het uitvoer GPX-bestand.
Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Omschrijving
Uitvoerlaag OUTPUT_LAYER [vector: elke] Uitvoerlaag met gegevens in GPX

standaardindeling

Pythoncode

ID algoritme: native:convertgpsdata

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Type GPX-object converteren

Gebruikt het gereedschap GPSBabel om objecten van GPX te converteren van het ene type naar een ander (bĳv.
converteren van objecten waypoint naar een route).

Parameters

Label Naam Type Omschrijving
Invoerbestand INPUT [bestand] Bestand dat de te converteren gegevens

bevat
Conversie CONVERSION [enumeratie]

Standaard: 0
Het type toe te passen conversie

• 0 —Waypoints van een route
• 1 —Waypoints van een spoor
• 2 — Route van waypoints
• 3 — Spoor van waypoints

Uitvoer OUTPUT [vector: punt of lĳn]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoerlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Omschrijving
Uitvoer OUTPUT [vector: elke] Uitvoerlaag met geconverteerde objecten

van GPX

Pythoncode

ID algoritme: native:convertgpxfeaturetype

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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GPS-gegevens vanaf een apparaat downloaden

Gebruikt het gereedschap GPSBabel om gegevens van een GPS-apparaat te downloaden naar de GPX
standaardindeling.

Parameters

Label Naam Type Omschrijving
Apparaat DEVICE [enumeratie]

Standaard:Garmin
serieel

Het GPS-apparaat dat is gebruikt om
de gegevens te maken. Moet worden
gedeclareerd in het dialoogvenster Opties -
GPS.

Poort PORT [enumeratie] De poort waarmee het apparaat is
verbonden. Beschikbare poorten zĳn
afhankelĳk van het besturingssysteem.

Object type FEATURE_TYPE [enumeratie]
Standaard: 0

Het type van de te converteren gegevens
• 0 —Waypoints
• 1 — Routes
• 2 — Tracks

Uitvoer OUTPUT [vector: elke]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoerlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Omschrijving
Uitvoerlaag OUTPUT_LAYER [vector: elke] Uitvoerlaag met gegevens in GPX

standaardindeling

Pythoncode

ID algoritme: native:downloadgpsdata

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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GPS-gegevens uploaden naar een apparaat

Gebruikt het gereedschap GPSBabel om gegevens naar een GPS-apparaat te uploaden in de GPX standaardindeling.

Parameters

Label Naam Type Omschrijving
Invoerbestand INPUT [bestand] .GPX-bestand dat de te uploaden gegevens

bevat
Apparaat DEVICE [enumeratie]

Standaard:Garmin
serieel

Het GPS-apparaat dat is gebruikt om
de gegevens te uploaden. Moet worden
gedeclareerd in het dialoogvenster Opties -
GPS.

Poort PORT [enumeratie] De poort waarmee het apparaat is
verbonden. Beschikbare poorten zĳn
afhankelĳk van het besturingssysteem.

Object type FEATURE_TYPE [enumeratie]
Standaard: 0

Het type van de te uploaden gegevens
• 0 —Waypoints
• 1 — Routes
• 2 — Tracks

Uitvoer

Er wordt geen uitvoer gemaakt. Indien succesvol zĳn de gegevens geladen op het apparaat.

Pythoncode

ID algoritme: native:uploadgpsdata

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

27.1.5 Interpolatie

Heatmap (Schatting dichtheid kernel KDE)

Maakt een dichtheidsraster (heatmap) op basis van een invoer puntenlaag met schatting van de dichtheid van de
kernel.
De dichtheid wordt berekend op basis van het aantal punten op een locatie, grotere aantallen punten zullen resulteren
in grotere waarden. Heatmap helpt bĳ het identificeren van “Hotspots” en plekkenmet een grote dichtheid van punten.
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Parameters

Label Naam Type Beschrijving
Puntenlaag INPUT [vector: punt] Punten vectorlaag om te gebruiken voor de

heatmap
Straal RADIUS [getal]

Standaard: 100.0
De straal om te zoeken (of kernel
bandbreedte) in kaarteenheden. De
straal geeft de afstand rondom een punt
weer waar dat punt nog invloed heeft.
Grotere waarden resulteren in grotere
afvlakking, kleinere waarden geven meer
details en variatie in dichtheid van punten.

Grootte
uitvoerraster

PIXEL_SIZE [getal]
Standaard: 0.1

Pixelgrootte in uitvoer rasterlaag in
laageenheden.
In de GUI mag de grootte worden
gespecificeerd door het aantal rĳen
(Aantal rijen) / kolommen
(Aantal kolommen) of de pixelgrootte
(Pixelgrootte X / Pixelgrootte
Y). Verhogen van het aantal rĳen of
kolommen zullen de celgrootte verminderen
en de bestandsgrootte van het uitvoerraster
verhogen. De waarden in Rijen,
Kolommen, Pixelgrootte X en
Pixelgrootte Y zullen tegelĳk
worden bĳgewerkt - verdubbelen van het
aantal rĳen zal automatisch ook het aantal
kolommen verdubbelen, de celgrootte
zal worden gehalveerd. Het bereik van
het uitvoerraster zal hetzelfde blĳven (bĳ
benadering).

Radius uit veld
Optioneel

RADIUS_FIELD [tabelveld:
numeriek]

Stelt de straal in voor elk object vanuit een
attribuutveld in de invoerlaag.

Gewicht uit veld
Optioneel

WEIGHT_FIELD [tabelveld:
numeriek]

Geeft de mogelĳkheid om voor objecten
een attribuutveld als gewogen veld te geven.
Dit kan worden gebruikt om bepaalde
objecten meer invloed te geven op de
resulterende heatmap.

Vervolgt op volgende pagina
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Tabel 27.13 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Kernel vorm KERNEL [enumeratie]

Standaard: 0
Beheert de mate waarin de invloed van een
punt afneemt als de afstand tot het punt
toeneemt. Verschillende kernel vormen
vervallen met verschillende mate, een
triweight kernel geeft objecten een groter
gewicht voor afstanden dichter bĳ het
punt dan de Epanechnikov kernel doet.
Als gevolg hiervan resulteert een triweight
kernel in “scherpere” hotspots en resulteert
Epanechnikov in meer ”vlakkere” hotspots.
Er zĳn vele vormen beschikbaar (bekĳk
de pagina van Wikipedia voor meer
informatie):

• 0 — Vierdegraads
• 1 — Driehoekig
• 2 — Uniform
• 3 — Triweight
• 4 — Epanechnikov

Ratio verval
(Alleen
triangulaire
kernels)
Optioneel

DECAY [getal]
Standaard: 0.0

Kan worden gebruikt bĳ driehoekige
kernels om meer controle te krĳgen over in
welke mate de hitte afneemt met de afstand
tot het object.

• Waarde 0 (= minimum) geeft aan dat
de hitte geconcentreerd zĳn in het
centrum van de opgegeven straal en
volledig gedoofd zal zĳn aan de rand.

• Een waarde van 0,5 geeft aan dat
pixels aan de rand van de straal de
helft van de hitte uitstralen van de
pixels in het centrum van de straal om
te zoeken.

• Een waarde van 1 betekent dat de
hitte gelĳkmatig is verdeeld over de
gehele cirkel van de straal. (Dit is
gelĳk aan de kernel ‘Uniform’)

• Een waarde groter dan 1 geeft aan dat
de hitte aan de randen van de straal
groter is dan in het centrum.

Op schaal brengen
uitvoerwaarde

OUTPUT_VALUE [enumeratie]
Default: Ruw

Maakt het mogelĳk de waarden voor het
uitvoerraster voor de heatmap te wĳzigen.
Één van:

• 0 — Ruw
• 1 — Geschaald

Heatmap OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer de rasterlaag met waarden voor
dichtheid van de kernel. Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…
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Uitvoer

Label Naam Type Beschrijving
Heatmap OUTPUT [raster] Rasterlaag met waarden voor dichtheid van

de kernel

Voorbeeld: Maken van een Heatmap

Voor het volgende voorbeeld zullen we de punten vectorlaag airports van de voorbeeld gegevensset van QGIS (zie
Voorbeeldgegevens downloaden) gebruiken. Een andere goede handleiding voor QGIS voor het maken van heatmaps
kan gevonden worden op http://qgistutorials.com.
In Fig. 27.2 worden de vliegvelden van Alaska weergegeven.

Fig. 27.2: Vliegvelden van Alaska

1. Open het algoritme Heatmap (Schatting dichtheid kernel KDE) uit de groep Interpolatie van QGIS

2. Selecteer, voor het veld Puntenlaag , airports uit de lĳst van geladen puntlagen in het huidige project.
3. Wĳzig het veld Straal naar 1000000 meters.
4. Wĳzig de Grootte pixel X naar 1000. De Grootte pixel Y, Rĳen en Kolommen worden automatisch bĳgewerkt.
5. Klik op Uitvoeren om de heatmap voor vliegvelden te maken en te laden (zie Fig. 27.4).
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Fig. 27.3: Het dialoogvenster Heatmap

QGIS zal de heatmap maken en die toevoegen aan uw kaartvenster. Standaard is de heatmap opgemaakt in
grĳswaarden, met lichtere gebieden die hogere concentraties vliegvelden weergeven. De heatmap kan nu in QGIS
worden opgemaakt om het uiterlĳk te verbeteren.
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Fig. 27.4: De heatmap ziet er na het laden uit als een grijs vlak

1. Open het dialoogvenster Eigenschappen voor de laag heatmap_airports (selecteer de laag
heatmap_airports, druk op de rechtermuisknop en selecteer in het menu Eigenschappen).

2. Selecteer de tab Symbologie.

3. Wĳzig het Rendertype naar ‘Enkelbands pseudokleur’.

4. Selecteer een geschikt Kleurverloop , bĳvoorbeeld YlOrRd.
5. Klik op de knop Classificeren.
6. Druk op OK om de laag bĳ te werken.

Het uiteindelĳke resultaat wordt getoond in Fig. 27.5.
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Fig. 27.5: Opgemaakte Heatmap van vliegvelden van Alaska

Pythoncode

ID algoritme: qgis:heatmapkerneldensityestimation

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

IDW-interpolatie

Maakt een Inverse Distance Weighted (IDW) interpolatie van een punten vectorlaag.
Monsterpunten worden gewogen gedurende het interpoleren zodat de invloed van één punt relatief ten opzichte van
een ander vermindert met de afstand vanaf het onbekende punt dat u wilt maken.
De methode IDW-interpolatie heeft ook enkele nadelen: de kwaliteit van het resultaat van de interpolatie kan minder
worden als de verdeling van de monsterpunten van gegevens oneven is.
Verder zouden maximum en minimum waarden in het geïnterpoleerde oppervlak alleen voor kunnen komen op
monsterpunten van de gegevens.
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Parameters

Label Naam Type Beschrijving
Invoerla(a)g(en) INTERPOLATION_DATA[tekenreeks] Vectorlaag(-lagen) en veld(en) om te

gebruiken voor de interpolatie, gecodeerd
in een tekenreeks (bekĳk de klasse
ParameterInterpolationData in
InterpolationWidgets voor meer details).
De volgende elementen van de GUI worden
verschaft om de tekenreeks met gegevens
voor de interpolatie samen te stellen:

• Vectorlaag [vector: elke]
• Interpolatie attribuut [tabelveld:
numeriek]: Attribuut om te
gebruiken in de interpolatie

• Z-coördinaat gebruiken voor
interpolatie [Booleaanse waarde]:
Gebruikt de in de laag opgeslagen
Z-waarden (Standaard: False)

Voor elk van de toegevoegde combinaties
laag-veld kan een type worden gekozen:

• Punten
• Gestructureerde lĳnen
• Afgebroken lĳnen

In de tekenreeks worden de elementen
laag-veld gescheiden door '::|::'. De
sub-elementen van de elementen laag-veld
worden gescheiden door '::~::'.

Afstandscoëfficiënt
P

DISTANCE_COEFFICIENT[getal]
Standaard: 2.0

Stelt de afstandscoëfficiënt in voor de
interpolatie. Minimum: 0.0, maximum:
100.0.

Bereik (xmin,
xmax, ymin,
ymax)

EXTENT [bereik] Bereik van de uitvoer rasterlaag.
Beschikbare methoden zĳn:

• Uit laag berekenen…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

Vervolgt op volgende pagina
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Tabel 27.15 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Grootte
uitvoerraster

PIXEL_SIZE [getal]
Standaard: 0.1

Pixelgrootte in uitvoer rasterlaag in
laageenheden.
In de GUI mag de grootte worden
gespecificeerd door het aantal rĳen
(Aantal rijen) / kolommen
(Aantal kolommen) of de pixelgrootte
(Pixelgrootte X / Pixelgrootte
Y). Verhogen van het aantal rĳen of
kolommen zullen de celgrootte verminderen
en de bestandsgrootte van het uitvoerraster
verhogen. De waarden in Rijen,
Kolommen, Pixelgrootte X en
Pixelgrootte Y zullen tegelĳk
worden bĳgewerkt - verdubbelen van het
aantal rĳen zal automatisch ook het aantal
kolommen verdubbelen, de celgrootte
zal worden gehalveerd. Het bereik van
het uitvoerraster zal hetzelfde blĳven (bĳ
benadering).

Geïnterpoleerd OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Rasterlaag met geïnterpoleerde waarden.
Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Beschrijving
Geïnterpoleerd OUTPUT [raster] Rasterlaag met geïnterpoleerde waarden

Pythoncode

ID algoritme: qgis:idwinterpolation

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

1008 Hoofdstuk 27. Processing providers en algoritmes



QGIS Desktop 3.28 User Guide

Lijndichtheid

Berekent voor elke rastercel de dichtheid van lineaire objecten in een circulaire omgeving. Deze meting wordt
verkregen door alle lĳnsegmenten die kruisen met de circulaire omgeving bĳ elkaar op te tellen en de som daarvan
te delen door het gebied van een dergelĳke omgeving. Een weegfactor kan worden toegepast op de lĳnsegmenten.

Fig. 27.6: Voorbeeld lijndichtheid. Bron invoerlaag: Wegen Overijssel - Nederland (OSM).

Parameters

Label Naam Type Beschrijving
Invoer lĳnlaag INPUT [vector: elke] Invoer vectorlaag die de lĳnobjecten bevat
Veld Gewicht WEIGHT [getal] Veld van de laag die de weegfactor bevat om

bĳ de berekening te gebruiken
Zoekradius RADIUS [getal]

Standaard: 10
Straal van de circulaire omgeving.
Eenheden kunnen hier worden
gespecificeerd.

Pixelgrootte PIXEL_SIZE [getal]
Standaard: 10

Pixelgrootte voor uitvoer rasterlaag in
laageenheden. Het raster heeft vierkante
pixels.

Raster dichtheid
lĳn

OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

De uitvoer als een rasterlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

27.1. QGIS algoritme provider 1009



QGIS Desktop 3.28 User Guide

Uitvoer

Label Naam Type Beschrijving
Raster dichtheid
lĳn

OUTPUT [raster] De uitvoer rasterlaag voor lĳndichtheid

Pythoncode

ID algoritme: native:linedensity

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

TIN-interpolatie

Maakt een Triangulated Irregular Network (TIN) interpolatie van een punten vectorlaag.
Met de methode TIN kunt u een oppervlak maken dat wordt gevormd door driehoeken van dichtstbĳ gelegen punten.
Omgeschreven cirkels worden rondom geselecteerdemonsterpunten gemaakt omdit te doen en hun kruisingenworden
verbondenmet een netwerk van niet-overlappende en zo compactmogelĳke driehoeken. De resulterende oppervlakten
zĳn niet afgevlakt.
Het algoritme maakt zowel de rasterlaag met de geïnterpoleerde waarden als de vector lĳnenlaag met de grenzen van
de driehoeken.

Parameters

1010 Hoofdstuk 27. Processing providers en algoritmes



QGIS Desktop 3.28 User Guide

Label Naam Type Beschrijving
Invoerla(a)g(en) INTERPOLATION_DATA[tekenreeks] Vectorlaag(-lagen) en veld(en) om te

gebruiken voor de interpolatie, gecodeerd
in een tekenreeks (bekĳk de klasse
ParameterInterpolationData in
InterpolationWidgets voor meer details).
De volgende elementen van de GUI worden
verschaft om de tekenreeks met gegevens
voor de interpolatie samen te stellen:

• Vectorlaag [vector: elke]
• Interpolatie attribuut [tabelveld:
numeriek]: Attribuut om te
gebruiken in de interpolatie

• Z-coördinaat gebruiken voor
interpolatie [Booleaanse waarde]:
Gebruikt de in de laag opgeslagen
Z-waarden (Standaard: False)

Voor elk van de toegevoegde combinaties
laag-veld kan een type worden gekozen:

• Punten
• Gestructureerde lĳnen
• Afgebroken lĳnen

In de tekenreeks worden de elementen
laag-veld gescheiden door '::|::'. De
sub-elementen van de elementen laag-veld
worden gescheiden door '::~::'.

Interpolatie
methode

METHOD [enumeratie]
Standaard: 0

De te gebruiken methode voor interpolatie
instellen. Één van:

• Lineair
• Clough-Toucher (kubisch)

Bereik (xmin,
xmax, ymin,
ymax)

EXTENT [bereik] Bereik van de uitvoer rasterlaag.
Beschikbare methoden zĳn:

• Uit laag berekenen…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

Vervolgt op volgende pagina
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Tabel 27.19 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Grootte
uitvoerraster

PIXEL_SIZE [getal]
Standaard: 0.1

Pixelgrootte in uitvoer rasterlaag in
laageenheden.
In de GUI mag de grootte worden
gespecificeerd door het aantal rĳen
(Aantal rijen) / kolommen
(Aantal kolommen) of de pixelgrootte
(Pixelgrootte X / Pixelgrootte
Y). Verhogen van het aantal rĳen of
kolommen zullen de celgrootte verminderen
en de bestandsgrootte van het uitvoerraster
verhogen. De waarden in Rijen,
Kolommen, Pixelgrootte X en
Pixelgrootte Y zullen tegelĳk
worden bĳgewerkt - verdubbelen van het
aantal rĳen zal automatisch ook het aantal
kolommen verdubbelen, de celgrootte
zal worden gehalveerd. Het bereik van
het uitvoerraster zal hetzelfde blĳven (bĳ
benadering).

Geïnterpoleerd OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

De uitvoer TIN-interpolatie als een
rasterlaag. Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Triangulatie TRIANGULATION [vector: lĳn]
Standaard:
[Uitvoer
overslaan]

De uitvoer TIN als een vectorlaag. Één van:
• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Geïnterpoleerd OUTPUT [raster] De uitvoer TIN-interpolatie als een

rasterlaag
Triangulatie TRIANGULATION [vector: lĳn] De uitvoer TIN als een vectorlaag
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Pythoncode

ID algoritme: qgis:tininterpolation

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

27.1.6 Gereedschappen voor lagen

Informatie van lagen exporteren

Maakt een polygoonlaag met objecten die overeenkomen met het bereik van geselecteerde la(a)g(en).
Aanvullende details van de laag (CRS, provider naam, bestandspad, laagnaam, filter voor subset, abstract en
naamsvermelding) worden als attributen aan elk object gehecht.

Parameters

Label Naam Type Beschrijving
Invoerlagen LAYERS [vector: elke] [lĳst] Invoer vectorlagen waaruit informatie moet

worden verkregen.
Uitvoer OUTPUT [vector: polygoon]

Standaard:
[Tijdelijke
laag maken]

Specificatie van de uitvoerlaag met de
informatie. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Uitvoer OUTPUT [vector: polygoon] Polygoon vectorlaag die het bereik van de

invoerlagen weergeeft en de geassocieerde
informatie in attributen.
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Pythoncode

ID algoritme: native:exportlayersinformation

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Naar werkblad exporteren

Exporteert de attributen van een selectie vectorlagen naar een werkbladdocument of voegt ze optioneel toe aan een
bestaand werkbladdocument als aanvullende werkbladen.

Parameters

Label Naam Type Beschrijving
Invoerlagen LAYERS [vector: elke] [lĳst] Invoer vectorlagen. Het werkblad voor de

uitvoer zal bestaan uit één blad, voor elke
laag, dat de attributen van deze laag bevat.

Aliassen van
velden als
kolomkoppen
gebruiken

USE_ALIAS [Booleaanse
waarde]
Standaard: False

Gebruik de aliassen van de velden uit de
attributentabel voor het werkblad.

Opgemaakte
waarden
exporteren in
plaats van ruwe
waarden

FORMATTED_VALUES[Booleaanse
waarde]
Standaard: False

Indien True exporteert het de opgemaakte,
voor mensen leesbare waarden (bĳv. uit een
waardenkaart of waarderelatie) naar het
werkblad.

Bestaande
werkblad
overschrĳven

OVERWRITE [Booleaanse
waarde]
Standaard: True

Als het gespecificeerde werkblad bestaat,
zal het instellen van deze optie naar True
het bestaande werkblad overschrĳven. Als
deze optie False is en het werkblad
bestaat, zullen de lagen worden toegevoegd
als aanvullende bladen.

Doel werkblad OUTPUT [bestand]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Uitvoer werkblad met een blad voor elke
laag. Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…
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Uitvoer

Label Naam Type Beschrijving
Doel werkblad OUTPUT [bestand] Werkblad met een blad voor elke laag.
Lagen in werkblad OUTPUT_LAYERS [lĳst] Lĳst met aan het werkblad toegevoegde

bladen.

Pythoncode

ID algoritme: native:exporttospreadsheet

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Bereik laag uitnemen

Genereert een vectorlaag met het minimale begrenzingsvak (rechthoek met N-Z-oriëntatie) dat alle objecten van de
invoer bedekt.
De uitvoerlaag bevat één enkel begrenzingsvak voor de gehele invoerlaag.

Fig. 27.7: In rood het begrenzingsvak van de bronlaag

Standaard menu: Vector ► Onderzoeksgereedschap
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Parameters

Label Naam Type Beschrijving
Laag INPUT [laag] Invoerlaag
Bereik OUTPUT [vector: polygoon]

Standaard:
[Tijdelijke
laag maken]

Specificeer de polygoon vectorlaag voor het
bereik van de uitvoer. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Bereik OUTPUT [vector: polygoon] Uitvoer (polygoon) vectorlaag met het

bereik (minimum begrenzingsvak)

Pythoncode

ID algoritme: qgis:polygonfromlayerextent

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

27.1.7 Mazen

Contouren exporteren

Maakt contouren als een vectorlaag vanuit een mazen scalaire gegevensset.

Parameters

Label Naam Type Beschrijving
Invoer laag met
mazen

INPUT [mazen] De laag met mazen waaruit de gegevens
moeten worden geëxporteerd

Groepen
gegevenssets

DATASET_GROUPS [layer] [list] De groepen gegevenssets

Vervolgt op volgende pagina
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Tabel 27.21 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Tĳd gegevensset DATASET_TIME [datetime] De tĳdsperiode waarmee rekening moet

worden gehouden
• 0 — Huidige tĳd kaartvenster
• 1 — Gedefinieerde datum/tĳd
• 2 — Tĳdstap groep gegevensset

Verhogen voor
contourniveaus
Optioneel

INCREMENT [getal]
Standaard: Niet
ingesteld

Interval tussen gemaakte niveaus.

Minimum
contourniveau
Optioneel

MINIMUM [getal]
Standaard: Niet
ingesteld

Startniveau voor waarden van contouren.

Maximum
contourniveau
Optioneel

MAXIMUM [getal]
Standaard: Niet
ingesteld

Maximumwaarden van contouren, d.i. geen
van de gemaakte niveaus mag groter zĳn
dan deze waarde.

Lĳst van niveaus
contouren
Optioneel

CONTOUR_LEVEL_LIST[getal]
Standaard: Niet
ingesteld

Lĳst van gewenste niveaus van contouren
(gescheiden door komma’s). Indien gevuld
wordt geen rekening gehouden met de
velden voor verhoging, minimum, en
maximum.

Uitvoer
coördinatensysteem
Optioneel

CRS_OUTPUT [crs] Op de uitvoer toe te wĳzen coördinaten
referentiesysteem

Geëxporteerde
contourlĳnen

OUTPUT_LINES [vector: lĳn]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer lĳnlaag die de
contouren van de laagmetmazenweergeeft.
Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Geëxporteerde
contourpolygonen

OUTPUT_POLYGONS[vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer polygonenlaag die de
contouren van de laagmetmazenweergeeft.
Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Beschrijving
Geëxporteerde
contourlĳnen

OUTPUT_LINES [vector: lĳn] Lĳnlaag die de contouren van de laag met
mazen weergeeft.

Geëxporteerde
contourpolygonen

OUTPUT_POLYGONS[vector: polygoon] Polygonenlaag die de contouren van de laag
met mazen weergeeft.

Pythoncode

ID algoritme: native:meshcontours

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Doorsnede exporteren van waarden van gegevensset op lijnen van mazen

Neemt de waarden van een gegevensset met mazen uit lĳnen die zĳn opgenomen in een vectorlaag.
Elke lĳn wordt afzonderlĳk gemaakt met een parameter voor de afstand van de resolutie voor het uitnemen van
waarden op zĳn punten.

Parameters

Label Naam Type Beschrijving
Invoer laag met
mazen

INPUT [mazen] De laag met mazen waaruit de gegevens
moeten worden geëxporteerd

Groepen
gegevenssets

DATASET_GROUPS [layer] [list] De groepen gegevenssets

Tĳd gegevensset DATASET_TIME [datetime] De tĳdsperiode waarmee rekening moet
worden gehouden

• 0 — Huidige tĳd kaartvenster
• 1 — Gedefinieerde datum/tĳd
• 2 — Tĳdstap groep gegevensset

Lĳnen voor
exporteren van
gegevens

INPUT_LINES [vector: lĳn] Lĳnen waarvan de gegevens zullen worden
uitgenomen uit de gegevensset met mazen

Resolutie voor
segmenteren lĳn

RESOLUTION [getal]
Standaard: 10.0

De afstand tussen punten op de lĳnen
waarvan de gegevens zullen worden
uitgenomen uit de gegevensset met mazen.

Telling getallen
voor waarden
gegevensset

DATASET_DIGITS [getal]
Standaard: 2

Aantal getallen waarop waarden van de
gegevensset moeten worden afgerond

Vervolgt op volgende pagina
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Tabel 27.22 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Geëxporteerd
CSV-bestand
gegevens

OUTPUT [bestand]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoerlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Beschrijving
Geëxporteerd
CSV-bestand
gegevens

OUTPUT [bestand]

Pythoncode

ID algoritme: native:meshexportcrosssection

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Randen mazen exporteren

Exporteert de randen van een laag met mazen naar een lĳn vectorlaag, met de waarden op randen van de gegevensset
als waarden voor attributen.

Parameters

Label Naam Type Beschrijving
Invoer laag met
mazen

INPUT [mazen] De laag met mazen waaruit de gegevens
moeten worden geëxporteerd

Groepen
gegevenssets

DATASET_GROUPS [layer] [list] De groepen gegevenssets

Tĳd gegevensset DATASET_TIME [datetime] De tĳdsperiode waarmee rekening moet
worden gehouden

• 0 — Huidige tĳd kaartvenster
• 1 — Gedefinieerde datum/tĳd
• 2 — Tĳdstap groep gegevensset

Uitvoer
coördinatensysteem
Optioneel

CRS_OUTPUT [crs] Op de uitvoer toe te wĳzen coördinaten
referentiesysteem

Vervolgt op volgende pagina
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Tabel 27.23 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Optie vector
exporteren

VECTOR_OPTION [enumeratie] Type coördinaat van waarde van de vector
voor exporteren.

• 0 — Cartesiaans (x,y)
• 1 — Polair (omvang, graad)
• 2 — Cartesiaans en polair

Uitvoer vectorlaag OUTPUT [vector: lĳn]
Standaard:
[Tijdelijke
laag maken]

Specificatie van de uitvoerlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Uitvoer vectorlaag OUTPUT [vector: lĳn] Uitvoer vector lĳnlaag die de randen

van de invoerlaag met mazen bevat met
geassocieerde waarden van de gegevensset

Pythoncode

ID algoritme: native:exportmeshedges

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Zijden mazen exporteren

Exporteert de zĳden van een laag met mazen naar een polygoon vectorlaag, met de waarden op zĳden van de
gegevensset als waarden voor attributen.

Parameters

Label Naam Type Beschrijving
Invoer laag met
mazen

INPUT [mazen] De laag met mazen waaruit de gegevens
moeten worden geëxporteerd

Groepen
gegevenssets

DATASET_GROUPS [layer] [list] De groepen gegevenssets

Vervolgt op volgende pagina
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Tabel 27.24 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Tĳd gegevensset DATASET_TIME [datetime] De tĳdsperiode waarmee rekening moet

worden gehouden
• 0 — Huidige tĳd kaartvenster
• 1 — Gedefinieerde datum/tĳd
• 2 — Tĳdstap groep gegevensset

Uitvoer
coördinatensysteem
Optioneel

CRS_OUTPUT [crs] Op de uitvoer toe te wĳzen coördinaten
referentiesysteem

Optie vector
exporteren

VECTOR_OPTION [enumeratie] Type coördinaat van waarde van de vector
voor exporteren.

• 0 — Cartesiaans (x,y)
• 1 — Polair (omvang, graad)
• 2 — Cartesiaans en polair

Uitvoer vectorlaag OUTPUT [vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificatie van de uitvoerlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Uitvoer vectorlaag OUTPUT [vector: polygoon] Uitvoer vector polygonenlaag die de zĳden

van de invoerlaag met mazen bevat met
geassocieerde waarden van de gegevensset

Pythoncode

ID algoritme: native:exportmeshfaces

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Mazen op raster exporteren

Exporteert de waarden van een gegevensset van een laag met mazen naar een gerasterde punt vectorlaag, met de
waarden op dit punt als waarden voor attributen.
Voor gegevens in volume (3D-gestapelde waarden voor gegevensset), worden de geëxporteerde waarden van de
gegevensset gemiddeld op de zĳden met de methode die is gedefinieerd in de eigenschappen van de laag met mazen
(standaard is de methode Multi-niveau gemiddelde). 1D-mazen worden niet ondersteund.

Parameters

Label Naam Type Beschrijving
Invoer laag met
mazen

INPUT [mazen] De laag met mazen waaruit de gegevens
moeten worden geëxporteerd

Groepen
gegevenssets

DATASET_GROUPS [layer] [list] De groepen gegevenssets

Tĳd gegevensset DATASET_TIME [datetime] De tĳdsperiode waarmee rekening moet
worden gehouden

• 0 — Huidige tĳd kaartvenster
• 1 — Gedefinieerde datum/tĳd
• 2 — Tĳdstap groep gegevensset

Bereik
Optioneel

EXTENT [bereik] Specificeer het ruimtelĳke bereik waarvan
de gegevens moeten worden verwerkt.
Beschikbare methoden zĳn:

• Uit laag berekenen…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

Rasterafstand
Optioneel

GRID_SPACING [getal]
Standaard: 10.0

Te gebruiken afstand tussen de
monsterpunten

Uitvoer
coördinatensysteem
Optioneel

CRS_OUTPUT [crs] Op de uitvoer toe te wĳzen coördinaten
referentiesysteem

Optie vector
exporteren

VECTOR_OPTION [enumeratie] Type coördinaat van waarde van de vector
voor exporteren.

• 0 — Cartesiaans (x,y)
• 1 — Polair (omvang, graad)
• 2 — Cartesiaans en polair

Vervolgt op volgende pagina
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Tabel 27.25 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Uitvoer vectorlaag OUTPUT [vector: punt]

Standaard:
[Tijdelijke
laag maken]

Specificatie van de uitvoerlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Uitvoer vectorlaag OUTPUT [vector: punt] Uitvoer vector puntenlaag met waarden van

de gegevensset die zĳn berekend voor de
overgelegde zĳde.

Pythoncode

ID algoritme: native:exportmeshongrid

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Punten van mazen exporteren

Exporteert de punten van een laag met mazen naar een punt vectorlaag, met de waarden op punten van de gegevensset
als waarden voor attributen.

Parameters

Label Naam Type Beschrijving
Invoer laag met
mazen

INPUT [mazen] De laag met mazen waaruit de gegevens
moeten worden geëxporteerd

Groepen
gegevenssets

DATASET_GROUPS [layer] [list] De groepen gegevenssets

Tĳd gegevensset DATASET_TIME [datetime] De tĳdsperiode waarmee rekening moet
worden gehouden

• 0 — Huidige tĳd kaartvenster
• 1 — Gedefinieerde datum/tĳd
• 2 — Tĳdstap groep gegevensset

Vervolgt op volgende pagina
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Tabel 27.26 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Uitvoer
coördinatensysteem
Optioneel

CRS_OUTPUT [crs] Op de uitvoer toe te wĳzen coördinaten
referentiesysteem

Optie vector
exporteren

VECTOR_OPTION [enumeratie] Type coördinaat van waarde van de vector
voor exporteren.

• 0 — Cartesiaans (x,y)
• 1 — Polair (omvang, graad)
• 2 — Cartesiaans en polair

Uitvoer vectorlaag OUTPUT [vector: punt]
Standaard:
[Tijdelijke
laag maken]

Specificatie van de uitvoerlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Uitvoer vectorlaag OUTPUT [vector: punt] Uitvoer vector puntenlaag die de punten

van de invoerlaag met mazen bevat met
geassocieerde waarden van de gegevensset

Pythoncode

ID algoritme: native:exportmeshvertices

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Waarden van tijdreeksen van punten van een gegevensset met mazen exporteren

Neemt de waarden uit van tĳdreeksen van punten van een gegevensset met mazen die zĳn opgenomen in een
vectorlaag.
Als de tĳdstap wordt behouden op zĳn standaardwaarde (0 uren), is de gebruikte tĳdstap die van de eerste twee
gegevenssets van de eerste geselecteerde groep van de gegevensset.
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Parameters

Label Naam Type Beschrijving
Invoer laag met
mazen

INPUT [mazen] De laag met mazen waaruit de gegevens
moeten worden uitgenomen

Groepen
gegevenssets

DATASET_GROUPS [layer] [list] De groepen gegevenssets

Begintĳd STARTING_TIME [datetime] Het begin van de tĳdsperiode waarmee
rekening moet worden gehouden

• 0 — Huidige tĳd kaartvenster
• 1 — Gedefinieerde datum/tĳd
• 2 — Tĳdstap groep gegevensset

Eindtĳd FINISHING_TIME [datetime] Het einde van de tĳdsperiode waarmee
rekening moet worden gehouden

• 0 — Huidige tĳd kaartvenster
• 1 — Gedefinieerde datum/tĳd
• 2 — Tĳdstap groep gegevensset

Tĳdstap (uren)
Optioneel

TIME_STEP [getal]
Standaard: 0

Tĳd tussen twee opvolgende stappen om
uit te nemen. Behoud 0 om de tĳdstap
van de eerste geselecteerde groep van de
gegevensset te gebruiken.

Punten voor
exporteren van
gegevens

INPUT_POINTS [vector: punt] Vectorlaag die de punten bevat waarvan de
gegevens zullen worden uitgenomen uit de
gegevensset met mazen

Telling getallen
voor coördinaten

COORDINATES_DIGITS[getal] Aantal getallen waarop waarden van de
coördinaten moeten worden afgerond
Standaard: 2

Telling getallen
voor waarden
gegevensset

DATASET_DIGITS [getal]
Standaard: 2

Aantal getallen waarop waarden van de
gegevensset moeten worden afgerond

Geëxporteerd
CSV-bestand
gegevens

OUTPUT [bestand]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoerlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Beschrijving
Geëxporteerd
CSV-bestand
gegevens

OUTPUT [bestand] .CSV-bestand dat de waarden van de
tĳdreeksen van de gegevensset met mazen
bevat uit de overgelegde puntobjecten
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Pythoncode

ID algoritme: native:meshexporttimeseries

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Gegevensset laag met mazen rasteriseren

Maakt een rasterlaag uit een gegevensset met mazen.
Voor gegevens in volume (3D-gestapelde waarden voor gegevensset), worden de geëxporteerde waarden van de
gegevensset gemiddeld op de zĳden met de methode die is gedefinieerd in de eigenschappen van de laag met mazen
(standaard is de methode Multi-niveau gemiddelde). 1D-mazen worden niet ondersteund.

Parameters

Label Naam Type Beschrijving
Invoer laag met
mazen

INPUT [mazen] De laag met mazen waaruit de gegevens
moeten worden geëxporteerd

Groepen
gegevenssets

DATASET_GROUPS [layer] [list] De groepen gegevenssets

Tĳd gegevensset DATASET_TIME [datetime] De tĳdsperiode waarmee rekening moet
worden gehouden

• 0 — Huidige tĳd kaartvenster
• 1 — Gedefinieerde datum/tĳd
• 2 — Tĳdstap groep gegevensset

Bereik
Optioneel

EXTENT [bereik] Specificeer het ruimtelĳke bereik waarvan
de gegevens moeten worden verwerkt.
Beschikbare methoden zĳn:

• Uit laag berekenen…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

Vervolgt op volgende pagina
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Tabel 27.28 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Pixelgrootte PIXEL_SIZE [getal]

Standaard: 1.0
Pixelgrootte van de uitvoer rasterlaag.

Uitvoer
coördinatensysteem
Optioneel

CRS_OUTPUT [crs] Op de uitvoer toe te wĳzen coördinaten
referentiesysteem

Uitvoer rasterlaag OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoerlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Beschrijving
Uitvoer rasterlaag OUTPUT [raster] Uitvoer rasterlaag met waarden van de

gegevensset die zĳn berekend uit de laag
met mazen.

Pythoncode

ID algoritme: native:meshrasterize

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

TIN-mazen maken

Maakt een TIN-laag met mazen uit vector lagen. De TIN met mazen wordt gemaakt met een Delaunay-triangulatie.

Parameters

Label Naam Type Beschrijving
Invoerlagen SOURCE_DATA [vector: elke] [lĳst] Te combineren vectorlagen om de laag met

mazen te maken.
Vectorlaag GUI ONLY [vector: elke] [lĳst] Een selectiemiddel voor de te combineren

vectorlagen om de laag met mazen te
maken.

Waarde op punt GUI ONLY [tabelveld: elk] Een selectiemiddel voor het te gebruiken
veld uit de geselecteerde laag. Elk punt
krĳgt de corresponderende waarde van zĳn
originele object toegewezen.

Vervolgt op volgende pagina
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Tabel 27.29 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Gerbuik Z-
coördinaat voor
waarde op punt

GUI ONLY [Booleaanse
waarde]
Standaard: False

Indien geselecteerd wordt de waarde Z van
de punten van de vectorlaag of punten van
polygonen/lĳnen gebruikt om de waarde
Z van het punt van de laag met mazen
toe te wĳzen. Alleen beschikbaar als de
invoerlagen 3D zĳn.

Indeling uitvoer MESH_FORMAT [enumeratie]
Standaard: 2DM

Indeling uitvoer van de gemaakte laag
• 0 — 2DM
• 1 — SELAFIN
• 2 — PLY
• 3 — Ugrid

Uitvoer
coördinatensysteem
Optioneel

CRS_OUTPUT [crs] Op de uitvoer toe te wĳzen coördinaten
referentiesysteem

Uitvoerbestand OUTPUT_MESH [mazen]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoerlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Beschrijving
Uitvoerbestand OUTPUT_MESH [mazen] Uitvoer laag met mazen met waarden van

de gegevensset die zĳn berekend uit de
vectorlagen.

Pythoncode

ID algoritmer: native:tinmeshcreation

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

1028 Hoofdstuk 27. Processing providers en algoritmes



QGIS Desktop 3.28 User Guide

27.1.8 Gereedschappen Grafische modellen bouwen

Waarschuwing: Deze gereedschappen zĳn alleen beschikbaar in Grafische modellen bouwen. Zĳ zĳn niet
beschikbaar in de Toolbox van Processing.

Voorwaardelijke tak

Voegt een voorwaardelĳke tak toe aan het model, wat het mogelĳk maakt delen van het model uit te voeren, gebaseerd
op het resultaat van de evaluatie van een expressie. Meestal door afhankelĳkheden van het gereedschap te gebruiken
om de stroom van een model te beheren.

Parameters

Label Naam Type Beschrijving
Veld BRANCH [tekenreeks] Naam van de voorwaarde
Veld CONDITION [expressie] Te evalueren expressie

Uitvoer

Geen.

Pythoncode

ID algoritme: native:condition

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Map maken

Maakt een nieuwe map op een bestandssysteem. Mappen zullen recursief worden gemaakt, wat alle vereiste
oudermappen maakt om het volledige gespecificeerde pad voor de map te construeren. Er wordt geen fout gemeld
als de map al bestaat.

Parameters

Label Naam Type Beschrijving
Pad map PATH [tekenreeks] Te maken pad voor map
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Uitvoer

Label Naam Type Beschrijving
Uitvoer OUTPUT [map] Gemaakte map

Pythoncode

ID algoritme: native:createdirectory

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Objectenfilter

Filtert objecten van de invoerlaag en verplaatst ze naar één of verschillende uitvoer(en). Als u geen namen van
attributen weet die voorkomen in alle mogelĳke invoerlagen, is filteren alleen mogelĳk op de geometrie van het
object en algemene mechanismes voor het record, zoals $id en uuid.

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] De invoerlaag.
Uitvoeren en
filters
(een of meer)

OUTPUT_<name
of the
filter>

[hetzelfde als
invoer]

De uitvoerlagen met filters (net zoveel als er
filters zĳn).

Uitvoer

Label Naam Type Beschrijving
Uitvoer
(een of meer)

native:filter_1:OUTPUT_<name
of filter>

[hetzelfde als
invoer]

De uitvoerlagenmet gefilterde objecten (net
zoveel als er filters zĳn).

Pythoncode

ID algoritme: native:filter

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Filter lagen op type

Filtert lagen op hun type. Inkomende lagen zullen worden omgeleid naar verschillende uitvoerlagen, gebaseerd op de
vraag of zĳ een vector- of rasterlaag zĳn.

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [laag] Algemene kaartlaag

Uitvoer

Label Naam Type Beschrijving
Vectorobjecten
Optioneel

VECTOR [vector] Een vectorlaag van de invoer, indien
compatibel

Rasterlaag
Optioneel

RASTER [raster] Een rasterlaag van de invoer, indien
compatibel

Pythoncode

ID algoritme: native:filterlayersbytype

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Laag in project laden

Laadt een laag in het huidige project.

Parameters

Label Naam Type Beschrijving
Laag INPUT [laag] Laag om te laden in de legenda
Naam geladen
laag

NAME [tekenreeks] Naam van de geladen laag
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Uitvoer

Label Naam Type Beschrijving
Laag OUTPUT [hetzelfde als

invoer]
De (hernoemde) geladen laag

Pythoncode

ID algoritme: native:loadlayer

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Uitzondering opwerpen

Werpt een uitzondering op en annuleert de uitvoering van het model. Het bericht voor de uitzondering kan worden
aangepast en optioneel kan een op een expressie gebaseerde voorwaarde worden gespecificeerd. Als een voorwaarde
als expressie wordt gebruikt dan zal de uitzondering alleen worden opgeworpen als het resultaat van de expressie true
is. Een resultaat false geeft aan dat er geen uitzondering zal worden opgeworpen en dat de uitvoering van het model
zonder onderbreking kan worden voortgezet.

Parameters

Label Naam Type Beschrijving
Melding MESSAGE [tekenreeks] Weer te geven bericht
Voorwaarde
Optioneel

CONDITION [expressie] Te evalueren expressie indien true

Uitvoer

Een bericht in het paneel Log.

Pythoncode

ID algoritme: native:raiseexception

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Foutbericht sturen

NEW in 3.26

Stuurt een bericht naar het log. Het bericht kan worden aangepast en optioneel kan een, op een expressie gebaseerde,
voorwaarde worden gespecificeerd. Als een voorwaarde als expressie wordt gebruikt dan zal het bericht alleen worden
gelogd als het resultaat van de expressie true is. Een resultaat false geeft aan dat er geen bericht zal worden gelogd.

Parameters

Label Naam Type Beschrijving
Informatie-
bericht

MESSAGE [tekenreeks] Weer te geven bericht

Voorwaarde
Optioneel

CONDITION [expressie] Te evalueren expressie indien true

Uitvoer

Een bericht in het paneel Log.

Pythoncode

ID algoritme: native:raisemessage

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Waarschuwing opwerpen

Werpt een waarschuwing op in het log. Het bericht voor de waarschuwing kan worden aangepast en optioneel kan een,
op een expressie gebaseerde, voorwaarde worden gespecificeerd. Als een voorwaarde als expressie wordt gebruikt
dan zal de waarschuwing alleen worden gelogd als het resultaat van de expressie true is. Een resultaat false geeft aan
dat er geen waarschuwing zal worden gelogd.

Parameters

Label Naam Type Beschrijving
Melding MESSAGE [tekenreeks] Weer te geven bericht
Voorwaarde
Optioneel

CONDITION [expressie] Te evalueren expressie indien true
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Uitvoer

Een bericht in het paneel Log.

Pythoncode

ID algoritme: native:raisewarning

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Laag hernoemen

Hernoemt een laag.

Parameters

Label Naam Type Beschrijving
Laag INPUT [laag] Te hernoemen laag
Nieuwe naam NAME [tekenreeks] De nieuwe naam van de laag

Uitvoer

Label Naam Type Beschrijving
Laag OUTPUT [hetzelfde als

invoer]
De (hernoemde) uitvoerlaag

Pythoncode

ID algoritme: native:renamelayer

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Log opslaan naar bestand

Slaat het log van het uitvoeren van het model op als een bestand. Optioneel kan het log worden opgeslagen in een als
HTML opgemaakte versie.

Parameters

Label Naam Type Beschrijving
HTML gebruiken USE_HTML [Booleaanse

waarde]
Standaard: False

HTML-opmaak gebruiken

Uitvoer

Label Naam Type Beschrijving
Bestand OUTPUT [tekenreeks] Bestemming van het log

Pythoncode

ID algoritme: native:savelog

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Projectvariabele instellen

Stelt een variabele voor een expressie voor het huidige project in

Parameters

Label Naam Type Beschrijving
Naam variabele NAME [tekenreeks] Naam van de variabele
Waarde variabele VALUE [tekenreeks] Waarde die moet worden opgeslagen
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Uitvoer

Geen.

Pythoncode

ID algoritme: native:setprojectvariable

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Tekenreeks samenvoeging

Voegt twee tekenreeksen samen tot één enkele in Grafische modellen bouwen van Processing.

Parameters

Label Naam Type Beschrijving
Invoer 1 INPUT_1 [tekenreeks] Eerste tekenreeks
Invoer 2 INPUT_2 [tekenreeks] Tweede tekenreeks

Uitvoer

Label Naam Type Beschrijving
Samenvoeging CONCATENATION [tekenreeks] De samengevoegde tekenreeks

Pythoncode

ID algoritme: native:stringconcatenation

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Variabele bufferafstand

Waarschuwing: Dit algoritme is vervallen en kan op elk moment worden verwĳderd. Gebruik in plaats daarvan
het algoritme Buffer.

Berekent een buffergebied voor alle objecten op een invoerlaag.
De grootte van de buffer voor een bepaald object wordt gedefinieerd door een attribuut, wat het mogelĳk maakt dat
verschillende objecten verschillende grootten buffers hebben.
Zie ook:
Buffer

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Veld voor afstand DISTANCE [tabelveld:

numeriek]
Attribuut voor de straal van de afstand voor
de buffer

Segmenten SEGMENTS [getal]
Standaard: 5

Beheert het aantal te gebruiken
lĳnsegmenten om een kwart cirkel te
benaderen bĳ het maken van ronde
verschuivingen.

Resultaat
samenvoegen

DISSOLVE [Booleaanse
waarde]
Standaard: False

Kies om de uiteindelĳke buffer samen
te voegen, wat resulteert in één enkel
object die alle ingevoerde objecten bedekt.

Fig. 27.8: Normale en samengevoegde
buffer

Stĳl eindkap END_CAP_STYLE [enumeratie]
Standaard: Rond

Beheert hoe einden van lĳnen
worden afgehandeld in de buffer.

Fig. 27.9: Ronde, vlakke en vierkante
eindstĳlen

Verbindingsstĳl JOIN_STYLE [enumeratie]
Standaard: Rond

Specificeert of ronde, hoekige of puntige
verbindingsstĳlen zouden moeten worden
gebruikt bĳ het verschuiven van hoeken in
een lĳn.

Vervolgt op volgende pagina
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Tabel 27.30 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Maximale
puntlengte bĳ
scherpe hoeken

MITER_LIMIT [getal]
Standaard: 2.0

Alleen van toepassing voor puntige
verbindingsstĳlen, en beheert de maximale
afstand van de te gebruiken boog voor de
verschuiving bĳ het maken van een puntige
verbindingsstĳl.

Uitvoer

Label Naam Type Beschrijving
Buffer OUTPUT [vector: polygoon] Buffer polygoon vectorlaag.

Pythoncode

ID algoritme: qgis:variabledistancebuffer

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

27.1.9 Netwerkanalyse

Servicegebied (vanuit laag)

Geeft alle randen of delen van randen terug van een netwerk die kunnen worden bereikt binnen een afstand of een
tĳdsduur, beginnend vanaf een puntenlaag. Dit maakt het evalueren van de toegankelĳkheid in een netwerk mogelĳk,
bĳv. naar welke plaatsen kan ik navigeren in een netwerk van wegen zonder meer kosten te maken dan een opgegeven
waarde (de kosten kunnen een afstand of een tĳdsduur zĳn).

Parameters

Basis parameters

Label Naam Type Beschrijving
Vectorlaag die
netwerk weergeeft

INPUT [vector: lĳn] Lĳnen vectorlaag die het betreffende
netwerk weergeeft

Vectorlaag met
beginpunten

START_POINTS [vector: punt] Punten vectorlaag waarvan de objecten
worden gebruikt als beginpunten om de
servicegebieden te maken

Te berekenen type
pad

STRATEGY [enumeratie]
Standaard: 0

Het te berekenen type pad. Één van:
• 0 — Kortste
• 1 — Snelste

Vervolgt op volgende pagina
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Tabel 27.31 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
**Reiskosten
(afstand voor
“Kortste”, tĳd voor
“Snelste”*

TRAVEL_COST [getal]
Standaard: 0

De waarde wordt berekend als een afstand
(in de eenheden van de netwerklaag) bĳ het
zoeken naar het Kortste pad en als tĳd (in
uren) voor het Snelste pad.

Servicegebied
(lĳnen)

OUTPUT_LINES [vector: lĳn]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer lĳnlaag voor het
servicegebied. Één van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Servicegebied
(grensknopen)

OUTPUT [vector: punt]
Standaard:
[Uitvoer
overslaan]

Specificeer de uitvoer puntenlaag voor de
grensknopen van het servicegebied. Één
van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Gevorderde parameters

Label Naam Type Beschrijving
Veld Richting
Optioneel

DIRECTION_FIELD[tabelveld: string]
Standaard: 0.0

Het te gebruiken veld om de richtingen voor
de randen van het netwerk te specificeren.
De in dit veld gebruikte waarden worden
gespecificeerd met de drie parameters
Waarde voor voorwaartse
richting, Waarde voor
achterwaartse richting en
Waarde voor beide richtingen.
Voorwaartse en achterwaartse richtingen
corresponderen met een kant in één
richting, “beide richtingen” geven een kant
met twee richtingen aan. Als een object
geen waarde in dit veld heeft, of als er
geen veld is ingesteld, dan zal de instelling
voor de standaard richting (verschaft met
de parameter Standaard richting)
worden gebruikt.

Waarde voor
voorwaartse
richting
Optioneel

VALUE_FORWARD [tekenreeks]
Standaard: ‘’ (lege
tekenreeks)

Ingestelde waarde in het veld Richting om
kanten met een voorwaartse richting te
identificeren

Vervolgt op volgende pagina
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Tabel 27.32 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Waarde voor
achterwaartse
richting
Optioneel

VALUE_BACKWARD [tekenreeks]
Standaard: ‘’ (lege
tekenreeks)

Ingestelde waarde in het veld Richting om
kanten met een achterwaartse richting te
identificeren

Waarde voor beide
richtingen
Optioneel

VALUE_BOTH [tekenreeks]
Standaard: ‘’ (lege
tekenreeks)

Ingestelde waarde in het veld Richting om
kanten met richting in beide kanten te
identificeren

Standaard
richting

DEFAULT_DIRECTION[enumeratie]
Standaard: 2

Als een object geen waarde in het veld
Richting heeft, of als er geen veld Richting
is ingesteld, dan wordt deze waarde voor de
richting gebruikt. Één van:

• 0 — Voorwaartse richting
• 1 — Achterwaartse richting
• 2 — Beide richtingen

Veld Snelheid
Optioneel

SPEED_FIELD [tabelveld: string] Veld dat de waarde voor de snelheid (inkm/
u) verschaft voor de kanten van het netwerk
bĳ het zoeken naar het snelste pad.
Als een object geen waarde in dit veld heeft,
of als er geen veld is ingesteld dan wordt
de standaard instelling voor de snelheid
(verschaft door de parameter Standaard
snelheid) gebruikt.

Standaard
snelheid (km/u)

DEFAULT_SPEED [getal]
Standaard: 50.0

Te gebruiken waarde om de reistĳd te
berekenen als er geen snelheidsveld is
opgegeven voor een kant.

Topologie
tolerantie

TOLERANCE [getal]
Standaard: 0.0

Twee lĳnen met knopen, dichter bĳ elkaar
dan de gespecificeerde tolerantie, worden
als verbonden beschouwd

Inclusief punten
boven-/ondergrens

INCLUDE_BOUNDS [Booleaanse
waarde]
Standaard: False

Maakt een uitvoer puntenlaag met twee
punten voor elke rand aan de grenzen van
het servicegebied. Één punt is het begin van
die kant, het andere is het einde.

Uitvoer

Label Naam Type Beschrijving
Servicegebied
(grensknopen)

OUTPUT [vector: punt] De uitvoer puntenlaag voor de grensknopen
van het servicegebied.

Servicegebied
(lĳnen)

OUTPUT_LINES [vector: lĳn] Lĳnlaag die de delen van het netwerk
weergeeft die, tegen de opgegeven
kosten, kunnen worden bereikt vanuit
de beginpunten.
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Pythoncode

ID algoritme: qgis:serviceareafromlayer

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Servicegebied (vanaf punt)

Geeft alle randen of delen van randen terug van een netwerk die kunnen worden bereikt binnen een opgegeven afstand
of tĳdsduur, beginnend vanaf een puntobject. Dit maakt evalueren van de toegankelĳkheid in een netwerk mogelĳk,
bĳv. naar welke plaatsen kan ik navigeren in een netwerk van wegen zonder meer kosten te maken dan een opgegeven
waarde (de kosten kunnen een afstand of een tĳdsduur zĳn).

Parameters

Basis parameters

Label Naam Type Beschrijving
Vectorlaag die
netwerk weergeeft

INPUT [vector: lĳn] Lĳnen vectorlaag die het betreffende
netwerk weergeeft

Beginpunt (x, y) START_POINT [coördinaten] Coördinaat van het punt waar omheen het
servicegebied moet worden berekend.

Te berekenen type
pad

STRATEGY [enumeratie]
Standaard: 0

Het te berekenen type pad. Één van:
• 0 — Kortste
• 1 — Snelste

**Reiskosten
(afstand voor
“Kortste”, tĳd voor
“Snelste”*

TRAVEL_COST [getal]
Standaard: 0

De waarde wordt berekend als een afstand
(in de eenheden van de netwerklaag) bĳ het
zoeken naar het Kortste pad en als tĳd (in
uren) voor het Snelste pad.

Servicegebied
(lĳnen)

OUTPUT_LINES [vector: lĳn]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer lĳnlaag voor het
servicegebied. Één van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Vervolgt op volgende pagina
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Tabel 27.33 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Servicegebied
(grensknopen)

OUTPUT [vector: punt]
Standaard:
[Uitvoer
overslaan]

Specificeer de uitvoer puntenlaag voor de
grensknopen van het servicegebied. Één
van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Gevorderde parameters

Label Naam Type Beschrijving
Veld Richting
Optioneel

DIRECTION_FIELD[tabelveld: string]
Standaard: 0.0

Het te gebruiken veld om de richtingen voor
de randen van het netwerk te specificeren.
De in dit veld gebruikte waarden worden
gespecificeerd met de drie parameters
Waarde voor voorwaartse
richting, Waarde voor
achterwaartse richting en
Waarde voor beide richtingen.
Voorwaartse en achterwaartse richtingen
corresponderen met een kant in één
richting, “beide richtingen” geven een kant
met twee richtingen aan. Als een object
geen waarde in dit veld heeft, of als er
geen veld is ingesteld, dan zal de instelling
voor de standaard richting (verschaft met
de parameter Standaard richting)
worden gebruikt.

Waarde voor
voorwaartse
richting
Optioneel

VALUE_FORWARD [tekenreeks]
Standaard: ‘’ (lege
tekenreeks)

Ingestelde waarde in het veld Richting om
kanten met een voorwaartse richting te
identificeren

Waarde voor
achterwaartse
richting
Optioneel

VALUE_BACKWARD [tekenreeks]
Standaard: ‘’ (lege
tekenreeks)

Ingestelde waarde in het veld Richting om
kanten met een achterwaartse richting te
identificeren

Waarde voor beide
richtingen
Optioneel

VALUE_BOTH [tekenreeks]
Standaard: ‘’ (lege
tekenreeks)

Ingestelde waarde in het veld Richting om
kanten met richting in beide kanten te
identificeren

Standaard
richting

DEFAULT_DIRECTION[enumeratie]
Standaard: 2

Als een object geen waarde in het veld
Richting heeft, of als er geen veld Richting
is ingesteld, dan wordt deze waarde voor de
richting gebruikt. Één van:

• 0 — Voorwaartse richting
• 1 — Achterwaartse richting
• 2 — Beide richtingen

Vervolgt op volgende pagina
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Tabel 27.34 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Veld Snelheid
Optioneel

SPEED_FIELD [tabelveld: string] Veld dat de waarde voor de snelheid (inkm/
u) verschaft voor de kanten van het netwerk
bĳ het zoeken naar het snelste pad.
Als een object geen waarde in dit veld heeft,
of als er geen veld is ingesteld dan wordt
de standaard instelling voor de snelheid
(verschaft door de parameter Standaard
snelheid) gebruikt.

Standaard
snelheid (km/u)

DEFAULT_SPEED [getal]
Standaard: 50.0

Te gebruiken waarde om de reistĳd te
berekenen als er geen snelheidsveld is
opgegeven voor een kant.

Topologie
tolerantie

TOLERANCE [getal]
Standaard: 0.0

Twee lĳnen met knopen, dichter bĳ elkaar
dan de gespecificeerde tolerantie, worden
als verbonden beschouwd

Inclusief punten
boven-/ondergrens

INCLUDE_BOUNDS [Booleaanse
waarde]
Standaard: False

Maakt een uitvoer puntenlaag met twee
punten voor elke rand aan de grenzen van
het servicegebied. Één punt is het begin van
die kant, het andere is het einde.

Uitvoer

Label Naam Type Beschrijving
Servicegebied
(grensknopen)

OUTPUT [vector: punt] De uitvoer puntenlaag voor de grensknopen
van het servicegebied.

Servicegebied
(lĳnen)

OUTPUT_LINES [vector: lĳn] Lĳnlaag die de delen van het netwerk
weergeeft die, tegen de opgegeven
kosten, kunnen worden bereikt vanuit
het beginpunt.

Pythoncode

ID algoritme: native:serviceareafrompoint

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Kortste pad (laag naar punt)

Berekent de optimale (kortste of snelste) route vanuit meerdere startpunten die worden gedefinieerd door een
vectorlaag en een opgegeven eindpunt.

Parameters

Basis parameters

Label Naam Type Beschrijving
Vectorlaag die
netwerk weergeeft

INPUT [vector: lĳn] Lĳnen vectorlaag die het betreffende
netwerk weergeeft

Te berekenen type
pad

STRATEGY [enumeratie]
Standaard: 0

Het te berekenen type pad. Één van:
• 0 — Kortste
• 1 — Snelste

Vectorlaag met
beginpunten

START_POINTS [vector: punt] Punten vectorlaag waarvan de objecten
worden gebruikt als beginpunten van de
routes

Eindpunt (x, y) END_POINT [coördinaten] Object punt dat het eindpunt van de routes
weergeeft

Kortste pad OUTPUT [vector: lĳn] Specificeer de uitvoer lĳnlaag voor de
kortste paden. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Gevorderde parameters

Label Naam Type Beschrijving
Veld Richting
Optioneel

DIRECTION_FIELD[tabelveld: string]
Standaard: 0.0

Het te gebruiken veld om de richtingen voor
de randen van het netwerk te specificeren.
De in dit veld gebruikte waarden worden
gespecificeerd met de drie parameters
Waarde voor voorwaartse
richting, Waarde voor
achterwaartse richting en
Waarde voor beide richtingen.
Voorwaartse en achterwaartse richtingen
corresponderen met een kant in één
richting, “beide richtingen” geven een kant
met twee richtingen aan. Als een object
geen waarde in dit veld heeft, of als er
geen veld is ingesteld, dan zal de instelling
voor de standaard richting (verschaft met
de parameter Standaard richting)
worden gebruikt.

Vervolgt op volgende pagina
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Tabel 27.36 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Waarde voor
voorwaartse
richting
Optioneel

VALUE_FORWARD [tekenreeks]
Standaard: ‘’ (lege
tekenreeks)

Ingestelde waarde in het veld Richting om
kanten met een voorwaartse richting te
identificeren

Waarde voor
achterwaartse
richting
Optioneel

VALUE_BACKWARD [tekenreeks]
Standaard: ‘’ (lege
tekenreeks)

Ingestelde waarde in het veld Richting om
kanten met een achterwaartse richting te
identificeren

Waarde voor beide
richtingen
Optioneel

VALUE_BOTH [tekenreeks]
Standaard: ‘’ (lege
tekenreeks)

Ingestelde waarde in het veld Richting om
kanten met richting in beide kanten te
identificeren

Standaard
richting

DEFAULT_DIRECTION[enumeratie]
Standaard: 2

Als een object geen waarde in het veld
Richting heeft, of als er geen veld Richting
is ingesteld, dan wordt deze waarde voor de
richting gebruikt. Één van:

• 0 — Voorwaartse richting
• 1 — Achterwaartse richting
• 2 — Beide richtingen

Veld Snelheid
Optioneel

SPEED_FIELD [tabelveld: string] Veld dat de waarde voor de snelheid (inkm/
u) verschaft voor de kanten van het netwerk
bĳ het zoeken naar het snelste pad.
Als een object geen waarde in dit veld heeft,
of als er geen veld is ingesteld dan wordt
de standaard instelling voor de snelheid
(verschaft door de parameter Standaard
snelheid) gebruikt.

Standaard
snelheid (km/u)

DEFAULT_SPEED [getal]
Standaard: 50.0

Te gebruiken waarde om de reistĳd te
berekenen als er geen snelheidsveld is
opgegeven voor een kant.

Topologie
tolerantie

TOLERANCE [getal]
Standaard: 0.0

Twee lĳnen met knopen, dichter bĳ elkaar
dan de gespecificeerde tolerantie, worden
als verbonden beschouwd

Uitvoer

Label Naam Type Beschrijving
Kortste pad OUTPUT [vector: lĳn] Lĳnlaag van het kortste of snelste pad vanuit

elk van de beginpunten tot het eindpunt.

Pythoncode

ID algoritme: native:shortestpathlayertopoint

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Kortste pad (punt naar laag)

Berekent de optimale (kortste of snelste) routes tussen een opgegeven startpunt en meerdere eindpunten, die worden
gedefinieerd door een punten vectorlaag.

Parameters

Basis parameters

Label Naam Type Beschrijving
Vectorlaag die
netwerk weergeeft

INPUT [vector: lĳn] Lĳnen vectorlaag die het betreffende
netwerk weergeeft

Te berekenen type
pad

STRATEGY [enumeratie]
Standaard: 0

Het te berekenen type pad. Één van:
• 0 — Kortste
• 1 — Snelste

Beginpunt (x, y) START_POINT [coördinaten] Object punt dat het beginpunt van de routes
weergeeft

Vectorlaag met
eindpunten

END_POINTS [vector: punt] Punten vectorlaag waarvan de objecten
worden gebruikt als eindpunten van de
routes

Kortste pad OUTPUT [vector: lĳn] Specificeer de uitvoer lĳnlaag voor de
kortste paden. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Gevorderde parameters

Label Naam Type Beschrijving
Veld Richting
Optioneel

DIRECTION_FIELD[tabelveld: string]
Standaard: 0.0

Het te gebruiken veld om de richtingen voor
de randen van het netwerk te specificeren.
De in dit veld gebruikte waarden worden
gespecificeerd met de drie parameters
Waarde voor voorwaartse
richting, Waarde voor
achterwaartse richting en
Waarde voor beide richtingen.
Voorwaartse en achterwaartse richtingen
corresponderen met een kant in één
richting, “beide richtingen” geven een kant
met twee richtingen aan. Als een object
geen waarde in dit veld heeft, of als er
geen veld is ingesteld, dan zal de instelling
voor de standaard richting (verschaft met
de parameter Standaard richting)
worden gebruikt.

Vervolgt op volgende pagina
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Tabel 27.38 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Waarde voor
voorwaartse
richting
Optioneel

VALUE_FORWARD [tekenreeks]
Standaard: ‘’ (lege
tekenreeks)

Ingestelde waarde in het veld Richting om
kanten met een voorwaartse richting te
identificeren

Waarde voor
achterwaartse
richting
Optioneel

VALUE_BACKWARD [tekenreeks]
Standaard: ‘’ (lege
tekenreeks)

Ingestelde waarde in het veld Richting om
kanten met een achterwaartse richting te
identificeren

Waarde voor beide
richtingen
Optioneel

VALUE_BOTH [tekenreeks]
Standaard: ‘’ (lege
tekenreeks)

Ingestelde waarde in het veld Richting om
kanten met richting in beide kanten te
identificeren

Standaard
richting

DEFAULT_DIRECTION[enumeratie]
Standaard: 2

Als een object geen waarde in het veld
Richting heeft, of als er geen veld Richting
is ingesteld, dan wordt deze waarde voor de
richting gebruikt. Één van:

• 0 — Voorwaartse richting
• 1 — Achterwaartse richting
• 2 — Beide richtingen

Veld Snelheid
Optioneel

SPEED_FIELD [tabelveld: string] Veld dat de waarde voor de snelheid (inkm/
u) verschaft voor de kanten van het netwerk
bĳ het zoeken naar het snelste pad.
Als een object geen waarde in dit veld heeft,
of als er geen veld is ingesteld dan wordt
de standaard instelling voor de snelheid
(verschaft door de parameter Standaard
snelheid) gebruikt.

Standaard
snelheid (km/u)

DEFAULT_SPEED [getal]
Standaard: 50.0

Te gebruiken waarde om de reistĳd te
berekenen als er geen snelheidsveld is
opgegeven voor een kant.

Topologie
tolerantie

TOLERANCE [getal]
Standaard: 0.0

Twee lĳnen met knopen, dichter bĳ elkaar
dan de gespecificeerde tolerantie, worden
als verbonden beschouwd

Uitvoer

Label Naam Type Beschrijving
Kortste pad OUTPUT [vector: lĳn] Lĳnlaag van het kortste of snelste pad vanuit

elk van de beginpunten tot het eindpunt.

Pythoncode

ID algoritme: native:shortestpathpointtolayer

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Kortste pad (punt naar punt)

Berekent de optimale (kortste of snelste) route tussen een opgegeven startpunt en een opgegeven eindpunt.

Parameters

Basis parameters

Label Naam Type Beschrijving
Vectorlaag die
netwerk weergeeft

INPUT [vector: lĳn] Lĳnen vectorlaag die het betreffende
netwerk weergeeft

Te berekenen type
pad

STRATEGY [enumeratie]
Standaard: 0

Het te berekenen type pad. Één van:
• 0 — Kortste
• 1 — Snelste

Beginpunt (x, y) START_POINT [coördinaten] Object punt dat het beginpunt van de routes
weergeeft

Eindpunt (x, y) END_POINT [coördinaten] Object punt dat het eindpunt van de routes
weergeeft

Kortste pad OUTPUT [vector: lĳn] Specificeer de uitvoer lĳnlaag voor de
kortste paden. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Gevorderde parameters

Label Naam Type Beschrijving
Veld Richting
Optioneel

DIRECTION_FIELD[tabelveld: string]
Standaard: 0.0

Het te gebruiken veld om de richtingen voor
de randen van het netwerk te specificeren.
De in dit veld gebruikte waarden worden
gespecificeerd met de drie parameters
Waarde voor voorwaartse
richting, Waarde voor
achterwaartse richting en
Waarde voor beide richtingen.
Voorwaartse en achterwaartse richtingen
corresponderen met een kant in één
richting, “beide richtingen” geven een kant
met twee richtingen aan. Als een object
geen waarde in dit veld heeft, of als er
geen veld is ingesteld, dan zal de instelling
voor de standaard richting (verschaft met
de parameter Standaard richting)
worden gebruikt.

Vervolgt op volgende pagina
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Tabel 27.40 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Waarde voor
voorwaartse
richting
Optioneel

VALUE_FORWARD [tekenreeks]
Standaard: ‘’ (lege
tekenreeks)

Ingestelde waarde in het veld Richting om
kanten met een voorwaartse richting te
identificeren

Waarde voor
achterwaartse
richting
Optioneel

VALUE_BACKWARD [tekenreeks]
Standaard: ‘’ (lege
tekenreeks)

Ingestelde waarde in het veld Richting om
kanten met een achterwaartse richting te
identificeren

Waarde voor beide
richtingen
Optioneel

VALUE_BOTH [tekenreeks]
Standaard: ‘’ (lege
tekenreeks)

Ingestelde waarde in het veld Richting om
kanten met richting in beide kanten te
identificeren

Standaard
richting

DEFAULT_DIRECTION[enumeratie]
Standaard: 2

Als een object geen waarde in het veld
Richting heeft, of als er geen veld Richting
is ingesteld, dan wordt deze waarde voor de
richting gebruikt. Één van:

• 0 — Voorwaartse richting
• 1 — Achterwaartse richting
• 2 — Beide richtingen

Veld Snelheid
Optioneel

SPEED_FIELD [tabelveld: string] Veld dat de waarde voor de snelheid (inkm/
u) verschaft voor de kanten van het netwerk
bĳ het zoeken naar het snelste pad.
Als een object geen waarde in dit veld heeft,
of als er geen veld is ingesteld dan wordt
de standaard instelling voor de snelheid
(verschaft door de parameter Standaard
snelheid) gebruikt.

Standaard
snelheid (km/u)

DEFAULT_SPEED [getal]
Standaard: 50.0

Te gebruiken waarde om de reistĳd te
berekenen als er geen snelheidsveld is
opgegeven voor een kant.

Topologie
tolerantie

TOLERANCE [getal]
Standaard: 0.0

Twee lĳnen met knopen, dichter bĳ elkaar
dan de gespecificeerde tolerantie, worden
als verbonden beschouwd

Uitvoer

Label Naam Type Beschrijving
Kortste pad OUTPUT [vector: lĳn] Lĳnlaag van het kortste of snelste pad vanuit

elk van de beginpunten tot het eindpunt

Pythoncode

ID algoritme: native:shortestpathpointtopoint

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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27.1.10 Plots

Plot Balken

Maakt een plot Balken uit een categorie en een veld van een laag.

Parameters

Label Naam Type Omschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Naam veld voor
categorie

NAME_FIELD [tabelveld: elk] Veld van de categorie om te gebruiken voor
het groeperen van de balken (X-as)

Veld Waarde VALUE_FIELD [tabelveld: elk] Waarde om te gebruiken voor het plot (Y-
as).

Plot Balken OUTPUT [html]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Het HTML-bestand voor het plot
specificeren. Één van:

• Opslaan als tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Omschrijving
Plot Balken OUTPUT [html] HTML-bestand van het plot, beschikbaar in

Processing ► Resultaten bekĳken.

Pythoncode

ID algoritme: qgis:barplot

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Boxplot

Maakt een plot Balken uit een veld Categorie en een numeriek veld van een laag.
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Parameters

Label Naam Type Omschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Veld
categorienaam

NAME_FIELD [tabelveld: elk] Veld van de categorie om te gebruiken voor
het groeperen van de balken (X-as)

Veld Waarde VALUE_FIELD [tabelveld: elk] Waarde om te gebruiken voor het plot (Y-
as).

Aanvullende
regels voor
statistieken

MSD [enumeratie]
Standaard: 0

Aanvullende statistische informatie om aan
het plot toe te voegen. Één van:

• 0 — Gemiddelde weergeven
• 1 — Standaard afwĳking weergeven
• 2 — Gemiddelde en standaard
afwĳking niet weergeven

Plot Balken OUTPUT [html]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Het HTML-bestand voor het plot
specificeren. Één van:

• Opslaan als tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Omschrijving
Plot Balken OUTPUT [html] HTML-bestand van het plot, beschikbaar in

Processing ► Resultaten bekĳken.

Pythoncode

ID algoritme: qgis:boxplot

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Plot van gemiddelde en standaardafwijking

Maakt een boxplot met waarden voor gemiddelde en standaard afwĳking.

27.1. QGIS algoritme provider 1051



QGIS Desktop 3.28 User Guide

Parameters

Label Naam Type Omschrijving
Invoertabel INPUT [vector: elke] Invoer vectorlaag
Veld
categorienaam

NAME_FIELD [tabelveld: elk] Veld van de categorie om te gebruiken voor
het groeperen van de balken (X-as)

Veld Waarde VALUE_FIELD [tabelveld: elk] Waarde om te gebruiken voor het plot (Y-
as).

Plot OUTPUT [html]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Het HTML-bestand voor het plot
specificeren. Één van:

• Opslaan als tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Omschrijving
Plot OUTPUT [html] HTML-bestand van het plot, beschikbaar in

Processing ► Resultaten bekĳken.

Pythoncode

ID algoritme: qgis:meanandstandarddeviationplot

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Plot Polair

Maakt een Polair plot, gebaseerd op de waarde van een invoer vectorlaag.
Twee velden moeten als parameters worden ingevoerd: één dat de categorie definieert (om objecten te groeperen) en
een ander met de te plotten variabele (dit moet een numerieke zĳn).
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Parameters

Label Naam Type Omschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Veld
categorienaam

NAME_FIELD [tabelveld: elk] Veld van de categorie om te gebruiken voor
het groeperen van de objecten (X-as)

Veld Waarde VALUE_FIELD [tabelveld: elk] Waarde om te gebruiken voor het plot (Y-
as).

Polair plot OUTPUT [html]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Het HTML-bestand voor het plot
specificeren. Één van:

• Opslaan als tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Omschrijving
Polair plot OUTPUT [html] HTML-bestand van het plot, beschikbaar in

Processing ► Resultaten bekĳken.

Pythoncode

ID algoritme: qgis:polarplot

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Histogram rasterlaag

Maakt een histogram met de waarden van een rasterlaag.

Parameters

Label Naam Type Omschrijving
Invoerlaag INPUT [raster] Invoer rasterlaag
Bandnummer BAND [rasterband] Rasterband om te gebruiken voor het

histogram
aantal klassen BINS [getal]

Standaard: 10
Het aantal in het histogram te gebruiken
klassen (X-as). Minimaal 2.

Histogram OUTPUT [html]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Het HTML-bestand voor het plot
specificeren. Één van:

• Opslaan als tĳdelĳk bestand
• Opslaan als bestand…
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Uitvoer

Label Naam Type Omschrijving
Histogram OUTPUT [html] HTML-bestand van het plot, beschikbaar in

Processing ► Resultaten bekĳken.

Pythoncode

ID algoritme: qgis:rasterlayerhistogram

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Histogram vectorlaag

Maakt een histogram met de waarden van het attribuut van een vectorlaag.
Het voor de berekening van het histogram te gebruiken attribuut moet numeriek zĳn.

Parameters

Label Naam Type Omschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Attribuut FIELD [tabelveld: elk] Waarde om te gebruiken voor het plot (Y-

as).
aantal klassen BINS [getal]

Standaard: 10
Het aantal in het histogram te gebruiken
klassen (X-as). Minimaal 2.

Histogram OUTPUT [html]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Het HTML-bestand voor het plot
specificeren. Één van:

• Opslaan als tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Omschrijving
Histogram OUTPUT [html] HTML-bestand van het plot, beschikbaar in

Processing ► Resultaten bekĳken.
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Pythoncode

ID algoritme: qgis:vectorlayerhistogram

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Verspreidingsplot vectorlaag

Maakt een eenvoudig X - Y verspreidingsplot voor een vectorlaag.

Parameters

Label Naam Type Omschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
X-attribuut XFIELD [tabelveld: elk] Veld om te gebruiken voor de X-as
Y-attribuut YFIELD [tabelveld: elk] Veld om te gebruiken voor de Y-as
Plot verspreid OUTPUT [html]

Standaard:
[Opslaan naar
tijdelijk
bestand]

Het HTML-bestand voor het plot
specificeren. Één van:

• Opslaan als tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Omschrijving
Plot verspreid OUTPUT [html] HTML-bestand van het plot, beschikbaar in

Processing ► Resultaten bekĳken.

Pythoncode

ID algoritme: qgis:vectorlayerscatterplot

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Vectorlaag verspreidingsplot 3D

Maakt een 3D verspreidingsplot voor een vectorlaag.

Parameters

Label Naam Type Omschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
X-attribuut XFIELD [tabelveld: elk] Veld om te gebruiken voor de X-as
Y-attribuut YFIELD [tabelveld: elk] Veld om te gebruiken voor de Y-as
Z-attribuut ZFIELD [tabelveld: elk] Veld om te gebruiken voor de Z-as
Histogram OUTPUT [html]

Standaard:
[Opslaan naar
tijdelijk
bestand]

Het HTML-bestand voor het plot
specificeren. Één van:

• Opslaan als tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Omschrijving
Histogram OUTPUT [html] HTML-bestand van het plot, beschikbaar in

Processing ► Resultaten bekĳken.

Pythoncode

ID algoritme: qgis:scatter3dplot

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

27.1.11 Rasteranalyse

Rang percentage gestapelde cellen uit waarde

Berekent de celsgewĳze waarde voor de rang in percentage van een stapel rasters, gebaseerd op één enkele
invoerwaarde en schrĳft ze naar een uitvoerraster.
Op elke cellocatie wordt de gespecificeerde waarde gewaardeerd in rang van de respectievelĳke waarden in de stapel
van alle overlegde en gesorteerde celwaarden uit de invoerrasters. Voor waarden buiten de verdeling van de gestapelde
waarden geeft het algoritme Geen gegevens terug omdat de waarde niet kan worden gerangschikt vanuit de andere
celwaarden.
Er zĳn twee methoden voor berekening van het percentage:

• Inclusieve lineaire interpolatie (PERCENTRANK.INC)
• Exclusieve lineaire interpolatie (PERCENTRANK.EXC)
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De methoden voor lineaire interpolatie geven de unieke rang in percentage terug voor verschillende waarden. Beide
methoden voor interpolatie volgen hun methoden voor tegenhangers die zĳn geïmplementeerd door LibreOffice of
Microsoft Excel.
Het bereik en resolutie van het uitvoerraster wordt gedefinieerd door een verwĳzingsraster. Als de lagen van het
invoerraster niet overeenkomen met de grootte van de cellen van het verwĳzingsraster zal de laag opnieuw worden
gesampled met Nearest neighbor-resampling. Waarden Geen Gegevens in enige invoerlaag zullen resulteren in een
celuitvoer Geen gegevens als de parameter “Geen gegevens negeren” niet is ingesteld. Het gegevenstype voor het
uitvoerraster is altĳd Float32.

Fig. 27.10: Rang in percentage Waarde = 1. Cellen Geen gegevens (grijs) zijn genegeerd.

Zie ook:
Percentiel stapelen cellen, Rang percentage gestapelde cellen uit rasterlaag

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlagen INPUT [raster] [lĳst] De te evalueren rasterlagen. Indien

multibandrasters worden gebruikt in de
stapel van rastergegevens, zal het algoritme
altĳd de analyse uitvoeren op de eerste
band van de rasters

Vervolgt op volgende pagina
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Tabel 27.42 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Methode METHOD [enumeratie]

Standaard: 0
Methode voor berekening van het
percentage:

• 0 — Inclusieve lineaire interpolatie
(PERCENTRANK.INC)

• 1 — Exclusieve lineaire interpolatie
(PERCENTRANK.EXC)

Waarde VALUE [getal]
Standaard: 10.0

Waarde waarvan de rang moet worden
bepaald vanuit de respectievelĳke waarden
in de stapel van overgelegde en gesorteerde
celwaarden uit de invoerrasters

Waarden
GeenGegevens
negeren

IGNORE_NODATA [Booleaanse
waarde]
Standaard: True

Indien niet geselecteerd zullen cellen Geen
gegevens in de gegevens van de invoerlagen
resulteren in een cel Geen gegevens in het
uitvoerraster

Verwĳzingslaag REFERENCE_LAYER[raster] De verwĳzingslaag voor het maken van de
uitvoerlaag (bereik, CRS, pixeldimensies)

Uitvoerlaag OUTPUT [hetzelfde als
invoer]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van het uitvoerraster. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Uitvoer waarde
‘Geen gegevens’

OUTPUT_NODATA_VALUE[getal]
Standaard: -9999.0

Te gebruiken waarde voor Geen gegevens in
het uitvoerraster

Uitvoer

Label Naam Type Beschrijving
Uitvoerlaag OUTPUT [raster] Uitvoer rasterlaag die het resultaat bevat
CRS identificatie
autoriteit

CRS_AUTHID [tekenreeks] Het coördinaten referentiesysteem van de
uitvoer rasterlaag

Bereik EXTENT [tekenreeks] Het ruimtelĳke bereik van de uitvoer
rasterlaag

Breedte in pixels WIDTH_IN_PIXELS[geheel getal] Aantal kolommen in de uitvoer rasterlaag
Hoogte in pixels HEIGHT_IN_PIXELS[geheel getal] Aantal rĳen in de uitvoer rasterlaag
Totaal aantal
pixels

TOTAL_PIXEL_COUNT[geheel getal] Het aantal pixels in de uitvoer rasterlaag
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Pythoncode

ID algoritme: native:cellstackpercentrankfromvalue

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Percentiel stapelen cellen

Berekent de celsgewĳze waarde voor percentiel van een stapel rasters en schrĳft de resultaten naar een uitvoerraster.
Het terug te geven percentiel wordt bepaald door de invoerwaarde voor het percentiel (bereiken tussen 0 en 1). Op
elke cellocatie wordt het gespecificeerde percentiel verkregen met de respectievelĳke waarde uit de stapel van alle
overlegde en gesorteerde celwaarden van de invoerrasters.
Er zĳn drie methoden voor berekening van het percentage:

• Dichtstbĳzĳnde rang: geeft de waarde weer die het dichtst bĳ het gespecificeerde percentiel ligt
• Inclusieve lineaire interpolatie (PERCENTRANK.INC)
• Exclusieve lineaire interpolatie (PERCENTRANK.EXC)

De methoden voor lineaire interpolatie geven de unieke waarden terug voor verschillende percentielen. Beide
methoden voor interpolatie volgen hun methoden voor tegenhangers die zĳn geïmplementeerd door LibreOffice of
Microsoft Excel.
Het bereik en resolutie van het uitvoerraster wordt gedefinieerd door een verwĳzingsraster. Als de lagen van het
invoerraster niet overeenkomen met de grootte van de cellen van het verwĳzingsraster zal de laag opnieuw worden
gesampled met Nearest neighbor-resampling. Waarden Geen Gegevens in enige invoerlaag zullen resulteren in een
celuitvoer Geen gegevens als de parameter “Geen gegevens negeren” niet is ingesteld. Het gegevenstype voor het
uitvoerraster is altĳd Float32.

Fig. 27.11: Percentiel = 0.25. Cellen Geen gegevens (grijs) zijn genegeerd.
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Zie ook:
Percentiel stapelen cellen, Rang percentage gestapelde cellen uit rasterlaag

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlagen INPUT [raster] [lĳst] De te evalueren rasterlagen. Indien

multibandrasters worden gebruikt in de
stapel van rastergegevens, zal het algoritme
altĳd de analyse uitvoeren op de eerste
band van de rasters

Methode METHOD [enumeratie]
Standaard: 0

Methode voor berekening van het
percentage:

• 0 — Dichtstbĳzĳnde rang: geeft de
waarde weer die het dichtst bĳ het
gespecificeerde percentiel ligt

• 1 — Inclusieve lineaire interpolatie
(PERCENTRANK.INC)

• 2 — Exclusieve lineaire interpolatie
(PERCENTRANK.EXC)

Percentiel VALUE [getal]
Standaard: 0.25

Waarde waarvan de rang moet worden
bepaald vanuit de respectievelĳke waarden
in de stapel van alle overgelegde en
gesorteerde celwaarden uit de invoerrasters.
Tussen 0 en 1.

Waarden
GeenGegevens
negeren

IGNORE_NODATA [Booleaanse
waarde]
Standaard: True

Indien niet geselecteerd zullen cellen Geen
gegevens in de gegevens van de invoerlagen
resulteren in een cel Geen gegevens in het
uitvoerraster

Verwĳzingslaag REFERENCE_LAYER[raster] De verwĳzingslaag voor het maken van de
uitvoerlaag (bereik, CRS, pixeldimensies)

Uitvoerlaag OUTPUT [hetzelfde als
invoer]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van het uitvoerraster. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Uitvoer waarde
‘Geen gegevens’

OUTPUT_NODATA_VALUE[getal]
Standaard: -9999.0

Te gebruiken waarde voor Geen gegevens in
het uitvoerraster
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Uitvoer

Label Naam Type Beschrijving
Uitvoerlaag OUTPUT [raster] Uitvoer rasterlaag die het resultaat bevat
CRS identificatie
autoriteit

CRS_AUTHID [tekenreeks] Het coördinaten referentiesysteem van de
uitvoer rasterlaag

Bereik EXTENT [tekenreeks] Het ruimtelĳke bereik van de uitvoer
rasterlaag

Breedte in pixels WIDTH_IN_PIXELS[geheel getal] Aantal kolommen in de uitvoer rasterlaag
Hoogte in pixels HEIGHT_IN_PIXELS[geheel getal] Aantal rĳen in de uitvoer rasterlaag
Totaal aantal
pixels

TOTAL_PIXEL_COUNT[geheel getal] Het aantal pixels in de uitvoer rasterlaag

Pythoncode

ID algoritme: native:cellstackpercentile

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Rang percentage gestapelde cellen uit rasterlaag

Berekent de celsgewĳze waarde voor de rang in percentage van een stapel rasters, gebaseerd op een raster met
invoerwaarden en schrĳft ze naar een uitvoerraster.
Op elke cellocatie wordt de huidige waarde van het waardenraster gebruikt voor het in rang waarderen van de
respectievelĳke waarden in de stapel van alle overlegde en gesorteerde celwaarden van de invoerrasters. Voor waarden
buiten de verdeling van de gestapelde waarden, geeft het algoritme Geen gegevens terug omdat de waarde niet kan
worden gerangschikt vanuit de andere celwaarden.
Er zĳn twee methoden voor berekening van het percentage:

• Inclusieve lineaire interpolatie (PERCENTRANK.INC)
• Exclusieve lineaire interpolatie (PERCENTRANK.EXC)

De methoden voor lineaire interpolatie geven de unieke waarden terug voor verschillende percentielen. Beide
methoden voor interpolatie volgen hun methoden voor tegenhangers die zĳn geïmplementeerd door LibreOffice of
Microsoft Excel.
Het bereik en resolutie van het uitvoerraster wordt gedefinieerd door een verwĳzingsraster. Als de lagen van het
invoerraster niet overeenkomen met de grootte van de cellen van het verwĳzingsraster zal de laag opnieuw worden
gesampled met Nearest neighbor-resampling. Waarden Geen Gegevens in enige invoerlaag zullen resulteren in een
celuitvoer Geen gegevens als de parameter “Geen gegevens negeren” niet is ingesteld. Het gegevenstype voor het
uitvoerraster is altĳd Float32.
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Fig. 27.12: Rang voor waarden van cellen in rasterlaag. Cellen Geen gegevens (grijs) zijn genegeerd.

Zie ook:
Percentiel stapelen cellen, Rang percentage gestapelde cellen uit waarde

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlagen INPUT [raster] [lĳst] De te evalueren rasterlagen. Indien

multibandrasters worden gebruikt in de
stapel van rastergegevens, zal het algoritme
altĳd de analyse uitvoeren op de eerste
band van de rasters

Waardenrasterlaag INPUT_VALUE_RASTER[raster] De laag waarvan de rand van de waarden
moet worden bepaald uit de stapel met alle
overgelegde lagen

Waarde
rasterband

VALUE_RASTER_BAND[geheel getal]
Standaard: 1

Band van de “waardenrasterlaag” ommee te
vergelĳken

Methode METHOD [enumeratie]
Standaard: 0

Methode voor berekening van het
percentage:

• 0 — Inclusieve lineaire interpolatie
(PERCENTRANK.INC)

• 1 — Exclusieve lineaire interpolatie
(PERCENTRANK.EXC)

Waarden
GeenGegevens
negeren

IGNORE_NODATA [Booleaanse
waarde]
Standaard: True

Indien niet geselecteerd zullen cellen Geen
gegevens in de gegevens van de invoerlagen
resulteren in een cel Geen gegevens in het
uitvoerraster

Vervolgt op volgende pagina
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Tabel 27.46 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Verwĳzingslaag REFERENCE_LAYER[raster] De verwĳzingslaag voor het maken van de

uitvoerlaag (bereik, CRS, pixeldimensies)
Uitvoerlaag OUTPUT [hetzelfde als

invoer]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van het uitvoerraster. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Uitvoer waarde
‘Geen gegevens’

OUTPUT_NODATA_VALUE[getal]
Standaard: -9999.0

Te gebruiken waarde voor Geen gegevens in
het uitvoerraster

Uitvoer

Label Naam Type Beschrijving
Uitvoerlaag OUTPUT [raster] Uitvoer rasterlaag die het resultaat bevat
CRS identificatie
autoriteit

CRS_AUTHID [tekenreeks] Het coördinaten referentiesysteem van de
uitvoer rasterlaag

Bereik EXTENT [tekenreeks] Het ruimtelĳke bereik van de uitvoer
rasterlaag

Breedte in pixels WIDTH_IN_PIXELS[geheel getal] Aantal kolommen in de uitvoer rasterlaag
Hoogte in pixels HEIGHT_IN_PIXELS[geheel getal] Aantal rĳen in de uitvoer rasterlaag
Totaal aantal
pixels

TOTAL_PIXEL_COUNT[geheel getal] Het aantal pixels in de uitvoer rasterlaag

Pythoncode

ID algoritme: native:cellstackpercentrankfromrasterlayer

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Celstatistieken

Berekent per-cel statistieken gebaseerd op invoer rasterlagen en schrĳft voor elke cel de resulterende statistieken naar
een uitvoerraster. Op elke locatie van een cel wordt de uitvoerwaarde gedefinieerd als een functie van alle overlegde
celwaarden van de invoerrasters.
Standaard zal een cel Geen gegevens in ENIGE van de invoerlagen resulteren in een cel GeenGegevens in het
uitvoerraster. Als de optie Waarden GeenGegevens negeren is geselecteerd, dan zal invoer Geen gegevens worden
genegeerd in de berekening van de statistieken. Dit kan resulteren in uitvoer Geen gegevens voor locaties waar alle
cellen Geen gegevens zĳn.
De parameter Referentielaag specificeert een bestaande rasterlaag om te gebruiken als verwĳzing bĳ het maken van
het uitvoerraster. Het uitvoerraster zal hetzelfde bereik, CRS en pixeldimensies hebben als deze laag.
Details berekening: Invoer rasterlagen die niet overeenkomen met de celgrootte van de verwĳzingslaag zullen
worden gesampled met Nearest neighbor resampling. Het gegevenstype van het uitvoerraster zal worden
ingesteld op het meest complexe gegevenstype dat aanwezig is in de invoer gegevenssets, behalve wanneer de functies
Gemiddelde, Standaardafwijking en Variantieworden gebruikt (gegevenstype is dan altĳd Float32
of Float64, afhankelĳk van het invoertype float) of Aantal en Variëteit (gegevenstype is altĳd Int32).

• Aantal: De statistiek Aantal zal altĳd resulteren in het aantal cellen zonder waarden GeenGegevens op de
huidige cellocatie.

• Mediaan: Als het aantal invoerlagen even is, zal de mediaan worden berekend als het rekenkundige
gemiddelde van de twee middelste waarden van de gesorteerde invoerwaarden van de cellen.

• Minderheid/Meerderheid: Als er geen unieke minderheid of meerderheid kon worden gevonden, zal
het resultaat Geen gegevens zĳn, behalve als alle celwaarden voor de invoer gelĳk zĳn.

Fig. 27.13: Voorbeeld met alle statistische functies. Met cellen Geen gegevens (grijs) wordt rekening gehouden.
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Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlagen INPUT [raster] [lĳst] Invoer rasterlagen
Statistiek STATISTIC [enumeratie]

Standaard: 0
Beschikbare statistieken. Opties:

• 0 — Som
• 1 — Aantal
• 2 — Gemiddelde
• 3 — Mediaan
• 4 — Standaardafwĳking
• 5 — Variantie
• 6 — Minimum
• 7 — Maximum
• 8 — Minderheid (minst
voorkomende waarde)

• 9 — Meerderheid (meest
voorkomende waarde)

• 10 — Bereik (max - min)
• 11 — Variëteit (aantal unieke
waarden)

Waarden
GeenGegevens
negeren

IGNORE_NODATA [Booleaanse
waarde]
Standaard: True

Bereken statistieken ook voor alle stapels
van cellen, negeer voorkomende cellen
GeenGegevens.

Verwĳzingslaag REF_LAYER [raster] De verwĳzingslaag waaruit de uitvoerlaag
moet worden gemaakt (bereik, CRS,
pixeldimensies)

Uitvoerlaag OUTPUT [hetzelfde als
invoer]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van het uitvoerraster. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Uitvoer waarde
‘Geen gegevens’
Optioneel

OUTPUT_NO_DATA_VALUE[getal]
Standaard: -9999.0

Te gebruiken waarde voor Geen gegevens in
het uitvoerraster
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Uitvoer

Label Naam Type Beschrijving
CRS identificatie
autoriteit

CRS_AUTHID [crs] Het coördinaten referentiesysteem van de
uitvoer rasterlaag

Bereik EXTENT [tekenreeks] Het ruimtelĳke bereik van de uitvoer
rasterlaag

Hoogte in pixels HEIGHT_IN_PIXELS[geheel getal] Aantal rĳen in de uitvoer rasterlaag
Uitvoerraster OUTPUT [raster] Uitvoer rasterlaag die het resultaat bevat
Totaal aantal
pixels

TOTAL_PIXEL_COUNT[geheel getal] Het aantal pixels in de uitvoer rasterlaag

Breedte in pixels WIDTH_IN_PIXELS[geheel getal] Aantal kolommen in de uitvoer rasterlaag

Pythoncode

ID algoritme: native:cellstatistics

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Gelijk aan frequentie

Evalueert op een ‘cel-per-cel’-basis de frequentie (aantal keren) dat de waarden van een invoerstapel van rasters gelĳk
zĳn aan de waarde van een waardenlaag. Het bereik van de uitvoerraster en de resolutie worden gedefinieerd door de
laag van het invoerraster en is altĳd van het type Int32.
Indien multibandrasters worden gebruikt in de stapel van rastergegevens, zal het algoritme altĳd de analyse uitvoeren
op de eerste band van de rasters - gebruik GDAL om andere banden voor de analyse te gebruiken. De waarde voor
de uitvoer Geen gegevens kan handmatig worden ingesteld.
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Fig. 27.14: Voor elke cel in het uitvoerraster geeft de waarde het aantal keren weer dat de corresponderende cellen
in de lijst met rasters hetzelfde zijn als in het waardenraster. Met cellen Geen gegevens (grijs) wordt rekening
gehouden.

Zie ook:
Groter dan frequentie, Kleiner dan frequentie

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoer
waardenraster

INPUT_VALUE_RASTER[raster] De invoer waardenlaag die dient als
verwĳzingslaag voor de monsterlagen

Waarde
rasterband

INPUT_VALUE_RASTER_BAND[rasterband]
Standaard: De
eerste band van de
rasterlaag

Selecteer de band die u als monster wilt
gebruiken

Invoer rasterlagen INPUT_RASTERS [raster] [lĳst] De te evalueren rasterlagen. Indien
multibandrasters worden gebruikt in de
stapel van rastergegevens, zal het algoritme
altĳd de analyse uitvoeren op de eerste
band van de rasters

Waarden
GeenGegevens
negeren

IGNORE_NODATA [Booleaanse
waarde]
Standaard: False

Indien niet geselecteerd zullen cellen
Geen gegevens in het waardenraster in
de gegevens van de gestapelde lagen
resulteren in een cel Geen gegevens in het
uitvoerraster

Vervolgt op volgende pagina
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Tabel 27.49 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Uitvoerlaag OUTPUT [hetzelfde als

invoer]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van het uitvoerraster. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Uitvoer waarde
‘Geen gegevens’
Optioneel

OUTPUT_NO_DATA_VALUE[getal]
Standaard: -9999.0

Te gebruiken waarde voor Geen gegevens in
het uitvoerraster

Uitvoer

Label Naam Type Beschrijving
Uitvoerlaag OUTPUT [raster] Uitvoer rasterlaag die het resultaat bevat
CRS identificatie
autoriteit

CRS_AUTHID [tekenreeks] Het coördinaten referentiesysteem van de
uitvoer rasterlaag

Bereik EXTENT [tekenreeks] Het ruimtelĳke bereik van de uitvoer
rasterlaag

Aantal cellen
met gelĳk aantal
voorkomen van
waarde

FOUND_LOCATIONS_COUNT[getal]

Hoogte in pixels HEIGHT_IN_PIXELS[getal] Aantal rĳen in de uitvoer rasterlaag
Totaal aantal
pixels

TOTAL_PIXEL_COUNT[geheel getal] Het aantal pixels in de uitvoer rasterlaag

Gemiddelde
frequentie op
geldige cellocaties

MEAN_FREQUENCY_PER_LOCATION[getal]

Aantal voorkomen
van waarden

OCCURRENCE_COUNT[getal]

Breedte in pixels WIDTH_IN_PIXELS[geheel getal] Aantal kolommen in de uitvoer rasterlaag

Pythoncode

ID algoritme: native:equaltofrequency

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Raster onscherp maken (Gaussiaans lidmaatschap)

Transformeert een invoerraster naar een onscherp gemaakt raster door het toewĳzen van een waarde voor
lidmaatschap aan elke pixel, met behulp van een functie voor Gaussiaans lidmaatschap. Waarden voor lidmaatschap
liggen in het bereik van 0 tot en met 1. In het onscherp gemaakte raster impliceert een waarde van 0 geen lidmaatschap
van de gedefinieerde onscherp gemaakte set, terwĳl een waarde van 1 volledig lidmaatschap betekent. De functie voor
Gaussiaans lidmaatschap wordt gedefinieerd als , waar f1 de spreiding is en f2 het middelpunt.

Fig. 27.15: Voorbeeld Raster onscherp maken. Bron invoerraster: Land Tirol - data.tirol.gv.at.

Zie ook:
Raster onscherp maken (groot lidmaatschap) Raster onscherp maken (lineair lidmaatschap), Raster onscherp maken
(nabĳ lidmaatschap), Raster onscherp maken (macht lidmaatschap), Raster onscherp maken (klein lidmaatschap)

Parameters

Label Naam Type Beschrijving
Invoerraster INPUT [raster] Invoer rasterlaag
Bandnummer BAND [rasterband]

Standaard: De
eerste band van de
rasterlaag

Als het raster meerdere banden bevat, kies
dan de band om onscherp te maken.

Functie
middelpunt

FUZZYMIDPOINT [getal]
Standaard: 10

Middelpunt van de Gaussiaanse functie

Functie spreiding FUZZYSPREAD [getal]
Standaard: 0.01

Spreiding van de Gaussiaanse functie

Onscherp
gemaakt raster

OUTPUT [hetzelfde als
invoer]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van het uitvoerraster. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…
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Uitvoer

Label Naam Type Beschrijving
Onscherp
gemaakt raster

OUTPUT [hetzelfde als
invoer]

Uitvoer rasterlaag die het resultaat bevat

CRS identificatie
autoriteit

CRS_AUTHID [crs] Het coördinaten referentiesysteem van de
uitvoer rasterlaag

Bereik EXTENT [tekenreeks] Het ruimtelĳke bereik van de uitvoer
rasterlaag

Breedte in pixels WIDTH_IN_PIXELS[geheel getal] Aantal kolommen in de uitvoer rasterlaag
Hoogte in pixels HEIGHT_IN_PIXELS[geheel getal] Aantal rĳen in de uitvoer rasterlaag
Totaal aantal
pixels

TOTAL_PIXEL_COUNT[geheel getal] Het aantal pixels in de uitvoer rasterlaag

Pythoncode

ID algoritme: native:fuzzifyrastergaussianmembership

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Raster onscherp maken (groot lidmaatschap)

Transformeert een invoerraster naar een onscherp gemaakt raster door het toewĳzen van een waarde voor
lidmaatschap aan elke pixel, met behulp van een functie voor groot lidmaatschap. Waarden voor lidmaatschap liggen
in het bereik van 0 tot en met 1. In het onscherp gemaakte raster impliceert een waarde van 0 geen lidmaatschap van
de gedefinieerde onscherp gemaakte set, terwĳl een waarde van 1 volledig lidmaatschap betekent. De functie voor

groot lidmaatschap wordt gedefinieerd als , waar f1 de spreiding is en f2 het middelpunt.
Zie ook:
Raster onscherp maken (Gaussiaans lidmaatschap), Raster onscherp maken (lineair lidmaatschap), Raster onscherp
maken (nabĳ lidmaatschap), Raster onscherp maken (macht lidmaatschap), Raster onscherp maken (klein
lidmaatschap)
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Parameters

Label Naam Type Beschrijving
Invoerraster INPUT [raster] Invoer rasterlaag
Bandnummer BAND [rasterband]

Standaard: De
eerste band van de
rasterlaag

Als het raster meerdere banden bevat, kies
dan de band om onscherp te maken.

Functie
middelpunt

FUZZYMIDPOINT [getal]
Standaard: 50

Middelpunt van de functie groot

Functie spreiding FUZZYSPREAD [getal]
Standaard: 5

Spreiding van de functie groot

Onscherp
gemaakt raster

OUTPUT [hetzelfde als
invoer]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van het uitvoerraster. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Beschrijving
Onscherp
gemaakt raster

OUTPUT [hetzelfde als
invoer]

Uitvoer rasterlaag die het resultaat bevat

CRS identificatie
autoriteit

CRS_AUTHID [crs] Het coördinaten referentiesysteem van de
uitvoer rasterlaag

Bereik EXTENT [tekenreeks] Het ruimtelĳke bereik van de uitvoer
rasterlaag

Breedte in pixels WIDTH_IN_PIXELS[geheel getal] Aantal kolommen in de uitvoer rasterlaag
Hoogte in pixels HEIGHT_IN_PIXELS[geheel getal] Aantal rĳen in de uitvoer rasterlaag
Totaal aantal
pixels

TOTAL_PIXEL_COUNT[geheel getal] Het aantal pixels in de uitvoer rasterlaag

Pythoncode

ID algoritme: native:fuzzifyrasterlargemembership

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Raster onscherp maken (lineair lidmaatschap)

Transformeert een invoerraster naar een onscherp gemaakt raster door het toewĳzen van een waarde voor
lidmaatschap aan elke pixel, met behulp van een functie voor lineair lidmaatschap. Waarden voor lidmaatschap liggen
in het bereik van 0 tot enmet 1. In het onscherp gemaakte raster impliceert een waarde van 0 geen lidmaatschap van de
gedefinieerde onscherp gemaakte set, terwĳl een waarde van 1 volledig lidmaatschap betekent. De functie voor lineair

lidmaatschap wordt gedefinieerd als , waar a de lage verbinding is en b de hoge verbinding.
Deze vergelĳking wĳst waarden voor lidmaatschap toe met een lineaire transformatie voor pixelwaarden tussen de
lage en hoge verbindingen. Waarden van pixels die kleiner zĳn dan de lage verbinding krĳgen 0 lidmaatschap, terwĳl
pixelwaarden die groter zĳn dan de hoge verbinding lidmaatschap 1 krĳgen.
Zie ook:
Raster onscherp maken (Gaussiaans lidmaatschap), Raster onscherp maken (groot lidmaatschap), Raster onscherp
maken (nabĳ lidmaatschap), Raster onscherp maken (macht lidmaatschap), Raster onscherp maken (klein
lidmaatschap)

Parameters

Label Naam Type Beschrijving
Invoerraster INPUT [raster] Invoer rasterlaag
Bandnummer BAND [rasterband]

Standaard: De
eerste band van de
rasterlaag

Als het raster meerdere banden bevat, kies
dan de band om onscherp te maken.

Lage verbinding
onscherp
lidmaatschap

FUZZYLOWBOUND [getal]
Standaard: 0

Lage verbinding van de functie lineair

Hoge verbinding
onscherp
lidmaatschap

FUZZYHIGHBOUND [getal]
Standaard: 1

Hoge verbinding van de functie lineair

Onscherp
gemaakt raster

OUTPUT [hetzelfde als
invoer]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van het uitvoerraster. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Beschrijving
Onscherp
gemaakt raster

OUTPUT [hetzelfde als
invoer]

Uitvoer rasterlaag die het resultaat bevat

CRS identificatie
autoriteit

CRS_AUTHID [crs] Het coördinaten referentiesysteem van de
uitvoer rasterlaag

Bereik EXTENT [tekenreeks] Het ruimtelĳke bereik van de uitvoer
rasterlaag

Breedte in pixels WIDTH_IN_PIXELS[geheel getal] Aantal kolommen in de uitvoer rasterlaag
Hoogte in pixels HEIGHT_IN_PIXELS[geheel getal] Aantal rĳen in de uitvoer rasterlaag
Totaal aantal
pixels

TOTAL_PIXEL_COUNT[geheel getal] Het aantal pixels in de uitvoer rasterlaag
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Pythoncode

ID algoritme: native:fuzzifyrasterlinearmembership

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Raster onscherp maken (nabij lidmaatschap)

Transformeert een invoerraster naar een onscherp gemaakt raster door het toewĳzen van een waarde voor
lidmaatschap aan elke pixel, met behulp van een functie voor nabĳ lidmaatschap. Waarden voor lidmaatschap liggen
in het bereik van 0 tot en met 1. In het onscherp gemaakte raster impliceert een waarde van 0 geen lidmaatschap van
de gedefinieerde onscherp gemaakte set, terwĳl een waarde van 1 volledig lidmaatschap betekent. De functie voor

nabĳ lidmaatschap wordt gedefinieerd als , waar f1 de spreiding is en f2 het middelpunt.
Zie ook:
Raster onscherp maken (Gaussiaans lidmaatschap), Raster onscherp maken (groot lidmaatschap), Raster onscherp
maken (lineair lidmaatschap), Raster onscherp maken (macht lidmaatschap), Raster onscherp maken (klein
lidmaatschap)

Parameters

Label Naam Type Beschrijving
Invoerraster INPUT [raster] Invoer rasterlaag
Bandnummer BAND [rasterband]

Standaard: De
eerste band van de
rasterlaag

Als het raster meerdere banden bevat, kies
dan de band om onscherp te maken.

Functie
middelpunt

FUZZYMIDPOINT [getal]
Standaard: 50

Middelpunt van de functie nabĳ

Functie spreiding FUZZYSPREAD [getal]
Standaard: 0.01

Spreiding van de functie nabĳ

Onscherp
gemaakt raster

OUTPUT [hetzelfde als
invoer]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van het uitvoerraster. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…
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Uitvoer

Label Naam Type Beschrijving
Onscherp
gemaakt raster

OUTPUT [hetzelfde als
invoer]

Uitvoer rasterlaag die het resultaat bevat

CRS identificatie
autoriteit

CRS_AUTHID [crs] Het coördinaten referentiesysteem van de
uitvoer rasterlaag

Bereik EXTENT [tekenreeks] Het ruimtelĳke bereik van de uitvoer
rasterlaag

Breedte in pixels WIDTH_IN_PIXELS[geheel getal] Aantal kolommen in de uitvoer rasterlaag
Hoogte in pixels HEIGHT_IN_PIXELS[geheel getal] Aantal rĳen in de uitvoer rasterlaag
Totaal aantal
pixels

TOTAL_PIXEL_COUNT[geheel getal] Het aantal pixels in de uitvoer rasterlaag

Pythoncode

ID algoritme: native:fuzzifyrasternearmembership

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Raster onscherp maken (macht lidmaatschap)

Transformeert een invoerraster naar een onscherp gemaakt raster door het toewĳzen van een waarde voor
lidmaatschap aan elke pixel, met behulp van een functie voor macht lidmaatschap. Waarden voor lidmaatschap liggen
in het bereik van 0 tot en met 1. In het onscherp gemaakte raster impliceert een waarde van 0 geen lidmaatschap
van de gedefinieerde onscherp gemaakte set, terwĳl een waarde van 1 volledig lidmaatschap betekent. De functie

voor macht lidmaatschap wordt gedefinieerd als , waar a de lage verbinding is en b de hoge
verbinding, en f1 de exponent. Deze vergelĳking wĳst waarden voor lidmaatschap toe met een macht transformatie
voor pixelwaarden tussen de lage en hoge verbindingen. Waarden van pixels die kleiner zĳn dan de lage verbinding
krĳgen 0 lidmaatschap, terwĳl pixelwaarden die groter zĳn dan de hoge verbinding lidmaatschap 1 krĳgen.
Zie ook:
Raster onscherp maken (Gaussiaans lidmaatschap), Raster onscherp maken (groot lidmaatschap), Raster onscherp
maken (lineair lidmaatschap), Raster onscherp maken (nabĳ lidmaatschap), Raster onscherp maken (klein
lidmaatschap)
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Parameters

Label Naam Type Beschrijving
Invoerraster INPUT [raster] Invoer rasterlaag
Bandnummer BAND [rasterband]

Standaard: De
eerste band van de
rasterlaag

Als het raster meerdere banden bevat, kies
dan de band om onscherp te maken.

Lage verbinding
onscherp
lidmaatschap

FUZZYLOWBOUND [getal]
Standaard: 0

Lage verbinding van de functie macht

Hoge verbinding
onscherp
lidmaatschap

FUZZYHIGHBOUND [getal]
Standaard: 1

Hoge verbinding van de functie macht

Hoge verbinding
onscherp
lidmaatschap

FUZZYEXPONENT [getal]
Standaard: 2

Exponent van de functie macht

Onscherp
gemaakt raster

OUTPUT [hetzelfde als
invoer]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van het uitvoerraster. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Beschrijving
Onscherp
gemaakt raster

OUTPUT [hetzelfde als
invoer]

Uitvoer rasterlaag die het resultaat bevat

CRS identificatie
autoriteit

CRS_AUTHID [crs] Het coördinaten referentiesysteem van de
uitvoer rasterlaag

Bereik EXTENT [tekenreeks] Het ruimtelĳke bereik van de uitvoer
rasterlaag

Breedte in pixels WIDTH_IN_PIXELS[geheel getal] Aantal kolommen in de uitvoer rasterlaag
Hoogte in pixels HEIGHT_IN_PIXELS[geheel getal] Aantal rĳen in de uitvoer rasterlaag
Totaal aantal
pixels

TOTAL_PIXEL_COUNT[geheel getal] Het aantal pixels in de uitvoer rasterlaag

Pythoncode

ID algoritme: native:fuzzifyrasterpowermembership

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Raster onscherp maken (klein lidmaatschap)

Transformeert een invoerraster naar een onscherp gemaakt raster door het toewĳzen van een waarde voor
lidmaatschap aan elke pixel, met behulp van een functie voor klein lidmaatschap. Waarden voor lidmaatschap liggen
in het bereik van 0 tot en met 1. In het onscherp gemaakte raster impliceert een waarde van 0 geen lidmaatschap van
de gedefinieerde onscherp gemaakte set, terwĳl een waarde van 1 volledig lidmaatschap betekent. De functie voor

klein lidmaatschap wordt gedefinieerd als , waar f1 de spreiding is en f2 het middelpunt.
Zie ook:
Raster onscherp maken (Gaussiaans lidmaatschap), Raster onscherp maken (groot lidmaatschap) Raster onscherp
maken (lineair lidmaatschap), Raster onscherp maken (nabĳ lidmaatschap), Raster onscherp maken (macht
lidmaatschap)

Parameters

Label Naam Type Beschrijving
Invoerraster INPUT [raster] Invoer rasterlaag
Bandnummer BAND [rasterband]

Standaard: De
eerste band van de
rasterlaag

Als het raster meerdere banden bevat, kies
dan de band om onscherp te maken.

Functie
middelpunt

FUZZYMIDPOINT [getal]
Standaard: 50

Middelpunt van de functie klein

Functie spreiding FUZZYSPREAD [getal]
Standaard: 5

Spreiding van de functie klein

Onscherp
gemaakt raster

OUTPUT [hetzelfde als
invoer]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van het uitvoerraster. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Beschrijving
Onscherp
gemaakt raster

OUTPUT [hetzelfde als
invoer]

Uitvoer rasterlaag die het resultaat bevat

CRS identificatie
autoriteit

CRS_AUTHID [crs] Het coördinaten referentiesysteem van de
uitvoer rasterlaag

Bereik EXTENT [tekenreeks] Het ruimtelĳke bereik van de uitvoer
rasterlaag

Breedte in pixels WIDTH_IN_PIXELS[geheel getal] Aantal kolommen in de uitvoer rasterlaag
Hoogte in pixels HEIGHT_IN_PIXELS[geheel getal] Aantal rĳen in de uitvoer rasterlaag
Totaal aantal
pixels

TOTAL_PIXEL_COUNT[geheel getal] Het aantal pixels in de uitvoer rasterlaag
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Pythoncode

ID algoritme: native:fuzzifyrastersmallmembership

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Groter dan frequentie

Evalueert op een ‘cel-per-cel’-basis de frequentie (aantal keren) dat de waarden van een invoerstapel van rasters gelĳk
zĳn aan de waarde van een waardenraster. Het bereik van de uitvoerraster en de resolutie worden gedefinieerd door
de laag van het invoerraster en is altĳd van het type Int32.
Indien multibandrasters worden gebruikt in de stapel van rastergegevens, zal het algoritme altĳd de analyse uitvoeren
op de eerste band van de rasters - gebruik GDAL om andere banden voor de analyse te gebruiken. De waarde voor
de uitvoer Geen gegevens kan handmatig worden ingesteld.

Fig. 27.16: Voor elke cel in het uitvoerraster geeft de waarde het aantal keren weer dat de corresponderende cellen
in de lijst met rasters groter zijn dan in het waardenraster. Met cellen Geen gegevens (grijs) wordt rekening
gehouden.

Zie ook:
Gelĳk aan frequentie, Kleiner dan frequentie
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Parameters

Basis parameters

Label Naam Type Beschrijving
Invoer
waardenraster

INPUT_VALUE_RASTER[raster] De invoer waardenlaag die dient als
verwĳzingslaag voor de monsterlagen

Waarde
rasterband

INPUT_VALUE_RASTER_BAND[rasterband]
Standaard: De
eerste band van de
rasterlaag

Selecteer de band die u als monster wilt
gebruiken

Invoer rasterlagen INPUT_RASTERS [raster] [lĳst] De te evalueren rasterlagen. Indien
multibandrasters worden gebruikt in de
stapel van rastergegevens, zal het algoritme
altĳd de analyse uitvoeren op de eerste
band van de rasters

Waarden
GeenGegevens
negeren

IGNORE_NODATA [Booleaanse
waarde]
Standaard: False

Indien niet geselecteerd zullen cellen
Geen gegevens in het waardenraster in
de gegevens van de gestapelde lagen
resulteren in een cel Geen gegevens in het
uitvoerraster

Uitvoerlaag OUTPUT [hetzelfde als
invoer]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van het uitvoerraster. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Uitvoer waarde
‘Geen gegevens’
Optioneel

OUTPUT_NO_DATA_VALUE[getal]
Standaard: -9999.0

Te gebruiken waarde voor Geen gegevens in
het uitvoerraster
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Uitvoer

Label Naam Type Beschrijving
Uitvoerlaag OUTPUT [raster] Uitvoer rasterlaag die het resultaat bevat
CRS identificatie
autoriteit

CRS_AUTHID [tekenreeks] Het coördinaten referentiesysteem van de
uitvoer rasterlaag

Bereik EXTENT [tekenreeks] Het ruimtelĳke bereik van de uitvoer
rasterlaag

Aantal cellen
met gelĳk aantal
voorkomen van
waarde

FOUND_LOCATIONS_COUNT[getal]

Hoogte in pixels HEIGHT_IN_PIXELS[getal] Aantal rĳen in de uitvoer rasterlaag
Totaal aantal
pixels

TOTAL_PIXEL_COUNT[geheel getal] Het aantal pixels in de uitvoer rasterlaag

Gemiddelde
frequentie op
geldige cellocaties

MEAN_FREQUENCY_PER_LOCATION[getal]

Aantal voorkomen
van waarden

OCCURRENCE_COUNT[getal]

Breedte in pixels WIDTH_IN_PIXELS[geheel getal] Aantal kolommen in de uitvoer rasterlaag

Pythoncode

ID algoritme: native:greaterthanfrequency

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Hoogste positie in stapel rasters

Evalueert op een ‘cel-per-cel’-basis de positie van het raster met de hoogste waarde in een stapel rasters. Het tellen van
de positie begint met 1 en reikt tot het totale aantal rasters voor de invoer. De volgorde van de invoerrasters is relevant
voor het algoritme. Indien meerdere rasters de hoogste waarden bevatten, zal het eerste raster worden gebruikt voor
de waarde van de positie.
Indien multibandrasters worden gebruikt in de stapel van rastergegevens, zal het algoritme altĳd de analyse uitvoeren
op de eerste band van de rasters - gebruik GDAL om andere banden voor de analyse te gebruiken. De waarde voor
de uitvoer Geen gegevens kan handmatig worden ingesteld.. Elke cel Geen gegevens in de stapel met invoerrasters zal
resulteren in een cel Geen gegevens in het uitvoerraster, tenzĳ de parameter “Geen gegevens negeren” is geselecteerd.
De waarde van de uitvoer voor Geen gegevens kan handmatig worden ingesteld. Het bereik van de uitvoerraster en
de resolutie worden gedefinieerd door een verwĳzingslaag en is altĳd van het type Int32.
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Zie ook:
Laagste positie in stapel rasters

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoer rasterlagen INPUT_RASTERS [raster] [lĳst] Lĳst met rasterlagen waarmee moet worden

vergeleken
Verwĳzingslaag REFERENCE_LAYER[raster] De verwĳzingslaag voor het maken van de

uitvoerlaag (bereik, CRS, pixeldimensies)
Waarden
GeenGegevens
negeren

IGNORE_NODATA [Booleaanse
waarde]
Standaard: False

Indien niet geselecteerd zullen cellen Geen
gegevens in de gegevens van de gestapelde
lagen resulteren in een cel Geen gegevens
in het uitvoerraster

Uitvoerlaag OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van het uitvoerraster dat het
resultaat bevat. Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…
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Gevorderde parameters

Label Naam Type Beschrijving
Uitvoer waarde
‘Geen gegevens’

OUTPUT_NODATA_VALUE[getal]
Standaard: -9999.0

Te gebruiken waarde voor Geen gegevens in
het uitvoerraster

Uitvoer

Label Naam Type Beschrijving
Uitvoerlaag OUTPUT [raster] Uitvoer rasterlaag die het resultaat bevat
CRS identificatie
autoriteit

CRS_AUTHID [tekenreeks] Het coördinaten referentiesysteem van de
uitvoer rasterlaag

Bereik EXTENT [tekenreeks] Het ruimtelĳke bereik van de uitvoer
rasterlaag

Breedte in pixels WIDTH_IN_PIXELS[geheel getal] Aantal kolommen in de uitvoer rasterlaag
Hoogte in pixels HEIGHT_IN_PIXELS[geheel getal] Aantal rĳen in de uitvoer rasterlaag
Totaal aantal
pixels

TOTAL_PIXEL_COUNT[geheel getal] Het aantal pixels in de uitvoer rasterlaag

Pythoncode

ID algoritme: native:highestpositioninrasterstack

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Kleiner dan frequentie

Evalueert op een ‘cel-per-cel’-basis de frequentie (aantal keren) dat de waarden van een invoerstapel van rasters kleiner
zĳn dan de waarde van een waardenraster. Het bereik van de uitvoerraster en de resolutie worden gedefinieerd door
de laag van het invoerraster en is altĳd van het type Int32.
Indien multibandrasters worden gebruikt in de stapel van rastergegevens, zal het algoritme altĳd de analyse uitvoeren
op de eerste band van de rasters - gebruik GDAL om andere banden voor de analyse te gebruiken. De waarde voor
de uitvoer Geen gegevens kan handmatig worden ingesteld.
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Fig. 27.17: Voor elke cel in het uitvoerraster geeft de waarde het aantal keren weer dat de corresponderende cellen
in de lijst met rasters kleiner zijn dan in het waardenraster. Met cellen Geen gegevens (grijs) wordt rekening
gehouden.

Zie ook:
Gelĳk aan frequentie, Groter dan frequentie

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoer
waardenraster

INPUT_VALUE_RASTER[raster] De invoer waardenlaag die dient als
verwĳzingslaag voor de monsterlagen

Waarde
rasterband

INPUT_VALUE_RASTER_BAND[rasterband]
Standaard: De
eerste band van de
rasterlaag

Selecteer de band die u als monster wilt
gebruiken

Invoer rasterlagen INPUT_RASTERS [raster] [lĳst] De te evalueren rasterlagen. Indien
multibandrasters worden gebruikt in de
stapel van rastergegevens, zal het algoritme
altĳd de analyse uitvoeren op de eerste
band van de rasters

Waarden
GeenGegevens
negeren

IGNORE_NODATA [Booleaanse
waarde]
Standaard: False

Indien niet geselecteerd zullen cellen
Geen gegevens in het waardenraster in
de gegevens van de gestapelde lagen
resulteren in een cel Geen gegevens in het
uitvoerraster

Vervolgt op volgende pagina
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Tabel 27.56 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Uitvoerlaag OUTPUT [hetzelfde als

invoer]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van het uitvoerraster. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Uitvoer waarde
‘Geen gegevens’
Optioneel

OUTPUT_NO_DATA_VALUE[getal]
Standaard: -9999.0

Te gebruiken waarde voor Geen gegevens in
het uitvoerraster

Uitvoer

Label Naam Type Beschrijving
Uitvoerlaag OUTPUT [raster] Uitvoer rasterlaag die het resultaat bevat
CRS identificatie
autoriteit

CRS_AUTHID [tekenreeks] Het coördinaten referentiesysteem van de
uitvoer rasterlaag

Bereik EXTENT [tekenreeks] Het ruimtelĳke bereik van de uitvoer
rasterlaag

Aantal cellen
met gelĳk aantal
voorkomen van
waarde

FOUND_LOCATIONS_COUNT[getal]

Hoogte in pixels HEIGHT_IN_PIXELS[getal] Aantal rĳen in de uitvoer rasterlaag
Totaal aantal
pixels

TOTAL_PIXEL_COUNT[geheel getal] Het aantal pixels in de uitvoer rasterlaag

Gemiddelde
frequentie op
geldige cellocaties

MEAN_FREQUENCY_PER_LOCATION[getal]

Aantal voorkomen
van waarden

OCCURRENCE_COUNT[getal]

Breedte in pixels WIDTH_IN_PIXELS[geheel getal] Aantal kolommen in de uitvoer rasterlaag

Pythoncode

ID algoritme: native:lessthanfrequency

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Laagste positie in stapel rasters

Evalueert op een ‘cel-per-cel’-basis de positie van het raster met de laagste waarde in een stapel rasters. Het tellen van
de positie begint met 1 en reikt tot het totale aantal rasters voor de invoer. De volgorde van de invoerrasters is relevant
voor het algoritme. Indien meerdere rasters de laagste waarden bevatten, zal het eerste raster worden gebruikt voor
de waarde van de positie.
Indien multibandrasters worden gebruikt in de stapel van rastergegevens, zal het algoritme altĳd de analyse uitvoeren
op de eerste band van de rasters - gebruik GDAL om andere banden voor de analyse te gebruiken. De waarde voor
de uitvoer Geen gegevens kan handmatig worden ingesteld.. Elke cel Geen gegevens in de stapel met invoerrasters zal
resulteren in een cel Geen gegevens in het uitvoerraster, tenzĳ de parameter “Geen gegevens negeren” is geselecteerd.
De waarde van de uitvoer voor Geen gegevens kan handmatig worden ingesteld. Het bereik van de uitvoerraster en
de resolutie worden gedefinieerd door een verwĳzingslaag en is altĳd van het type Int32.

Zie ook:
Hoogste positie in stapel rasters

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoer rasterlagen INPUT_RASTERS [raster] [lĳst] Lĳst met rasterlagen waarmee moet worden

vergeleken
Verwĳzingslaag REFERENCE_LAYER[raster] De verwĳzingslaag voor het maken van de

uitvoerlaag (bereik, CRS, pixeldimensies)
Waarden
GeenGegevens
negeren

IGNORE_NODATA [Booleaanse
waarde]
Standaard: False

Indien niet geselecteerd zullen cellen Geen
gegevens in de gegevens van de gestapelde
lagen resulteren in een cel Geen gegevens
in het uitvoerraster

Vervolgt op volgende pagina

1084 Hoofdstuk 27. Processing providers en algoritmes



QGIS Desktop 3.28 User Guide

Tabel 27.58 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Uitvoerlaag OUTPUT [raster]

Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van het uitvoerraster dat het
resultaat bevat. Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Uitvoer waarde
‘Geen gegevens’

OUTPUT_NODATA_VALUE[getal]
Standaard: -9999.0

Te gebruiken waarde voor Geen gegevens in
het uitvoerraster

Uitvoer

Label Naam Type Beschrijving
Uitvoerlaag OUTPUT [raster] Uitvoer rasterlaag die het resultaat bevat
CRS identificatie
autoriteit

CRS_AUTHID [tekenreeks] Het coördinaten referentiesysteem van de
uitvoer rasterlaag

Bereik EXTENT [tekenreeks] Het ruimtelĳke bereik van de uitvoer
rasterlaag

Breedte in pixels WIDTH_IN_PIXELS[geheel getal] Aantal kolommen in de uitvoer rasterlaag
Hoogte in pixels HEIGHT_IN_PIXELS[geheel getal] Aantal rĳen in de uitvoer rasterlaag
Totaal aantal
pixels

TOTAL_PIXEL_COUNT[geheel getal] Het aantal pixels in de uitvoer rasterlaag

Pythoncode

ID algoritme: native:lowestpositioninrasterstack

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Raster Booleaanse EN

Berekent de Booleaanse EN voor een set invoerrasters. Als alle invoerrasters een waarde niet-nul hebben voor een
pixel, zal die pixel worden ingesteld op 1 in het uitvoerraster. Als enig invoerraster waarden 0 heeft voor de pixel, zal
het worden ingesteld op 0 in het uitvoerraster.
De parameter voor de verwĳzingslaag specificeert een te gebruiken bestaande rasterlaag als een verwĳzing bĳ het
maken van het uitvoerraster. Het uitvoerraster zal hetzelfde bereik, CRS, en pixeldimensies hebben als deze laag.
Standaard zal een pixel Geen gegevens in ENIGE invoerlaag resulteren in een pixel Geen gegevens in het uitvoerraster.
Als de optie Waarden Geen gegevens als false behandelen is geselecteerd, dan zal invoer Geen gegevens hetzelfde
worden behandeld als een invoerwaarde 0.
Zie ook:
Raster Booleaanse OF

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlagen INPUT [raster] [lĳst] Lĳst met invoer rasterlagen
Verwĳzingslaag REF_LAYER [raster] De verwĳzingslaag waaruit de uitvoerlaag

moet worden gemaakt (bereik, CRS,
pixeldimensies)

Waarden Geen
gegevens als false
behandelen

NODATA_AS_FALSE[Booleaanse
waarde]
Standaard: False

Waarde Geen gegevens in de
invoerbestanden behandelen als 0 bĳ
het uitvoeren van de bewerking

Uitvoerlaag OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van het uitvoerraster dat het
resultaat bevat. Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Uitvoer waarde
‘Geen gegevens’

NO_DATA [getal]
Standaard: -9999.0

Te gebruiken waarde voor Geen gegevens in
het uitvoerraster

Vervolgt op volgende pagina
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Tabel 27.61 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Type
uitvoergegevens

DATA_TYPE [enumeratie]
Standaard: 5

Uitvoer rastergegevenstype. Opties:
• 0 — Byte (8-bit unsigned integer
(quint8))

• 1 — Int16 (16-bit signed integer
(qint16))

• 2 — UInt16 (16-bit unsigned integer
(quint16))

• 3 — Int32 (32-bit signed integer
(qint32))

• 4 — UInt32 (32-bit unsigned integer
(quint32))

• 5 — Float32 (32-bit floating point
(float))

• 6 — Float64 (64-bit floating point
(double))

• 7 — CInt16 (Complex Int16)
• 8 — CInt32 (Complex Int32)
• 9 — CFloat32 (Complex Float32)
• 10 — CFloat64 (Complex Float64)

Beschikbare opties zĳn afhankelĳk van de
versie van GDAL die is ingebouwd in QGIS
(bekĳk menu Help ► Info)

Uitvoer

Label Naam Type Beschrijving
Bereik EXTENT [tekenreeks] Het ruimtelĳke bereik van de uitvoer

rasterlaag
CRS identificatie
autoriteit

CRS_AUTHID [crs] Het coördinaten referentiesysteem van de
uitvoer rasterlaag

Breedte in pixels WIDTH_IN_PIXELS[geheel getal] Aantal kolommen in de uitvoer rasterlaag
Hoogte in pixels HEIGHT_IN_PIXELS[geheel getal] Aantal rĳen in de uitvoer rasterlaag
Totaal aantal
pixels

TOTAL_PIXEL_COUNT[geheel getal] Het aantal pixels in de uitvoer rasterlaag

Telling pixels
NODATA

NODATA_PIXEL_COUNT[geheel getal] Het aantal pixels Geen gegevens van de
uitvoer rasterlaag

Aantal pixels
TRUE

TRUE_PIXEL_COUNT[geheel getal] Het aantal pixels True (waarde = 1) in de
uitvoer rasterlaag

Aantal pixels
FALSE

FALSE_PIXEL_COUNT[geheel getal] Het aantal pixels False (waarde = 0) in de
uitvoer rasterlaag

Uitvoerlaag OUTPUT [raster] Uitvoer rasterlaag die het resultaat bevat
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Pythoncode

ID algoritme: native:rasterbooleanand

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Raster Booleaanse OF

Berekent de Booleaanse OF voor een set invoerrasters. Als alle invoerrasters een nulwaarde hebben voor een pixel,
zal die pixel worden ingesteld op 0 in het uitvoerraster. Als enig invoerraster waarden 1 heeft voor de pixel, zal het
worden ingesteld op 1 in het uitvoerraster.
De parameter voor de verwĳzingslaag specificeert een te gebruiken bestaande rasterlaag als een verwĳzing bĳ het
maken van het uitvoerraster. Het uitvoerraster zal hetzelfde bereik, CRS, en pixeldimensies hebben als deze laag.
Standaard zal een pixel Geen gegevens in ENIGE invoerlaag resulteren in een pixel Geen gegevens in het uitvoerraster.
Als de optie Waarden Geen gegevens als false behandelen is geselecteerd, dan zal invoer Geen gegevens hetzelfde
worden behandeld als een invoerwaarde 0.
Zie ook:
Raster Booleaanse EN

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlagen INPUT [raster] [lĳst] Lĳst met invoer rasterlagen
Verwĳzingslaag REF_LAYER [raster] De verwĳzingslaag waaruit de uitvoerlaag

moet worden gemaakt (bereik, CRS,
pixeldimensies)

Waarden Geen
gegevens als false
behandelen

NODATA_AS_FALSE[Booleaanse
waarde]
Standaard: False

Waarde Geen gegevens in de
invoerbestanden behandelen als 0 bĳ
het uitvoeren van de bewerking

Uitvoerlaag OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van het uitvoerraster dat het
resultaat bevat. Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…
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Gevorderde parameters

Label Naam Type Beschrijving
Uitvoer waarde
‘Geen gegevens’

NO_DATA [getal]
Standaard: -9999.0

Te gebruiken waarde voor Geen gegevens in
het uitvoerraster

Type
uitvoergegevens

DATA_TYPE [enumeratie]
Standaard: 5

Uitvoer rastergegevenstype. Opties:
• 0 — Byte (8-bit unsigned integer
(quint8))

• 1 — Int16 (16-bit signed integer
(qint16))

• 2 — UInt16 (16-bit unsigned integer
(quint16))

• 3 — Int32 (32-bit signed integer
(qint32))

• 4 — UInt32 (32-bit unsigned integer
(quint32))

• 5 — Float32 (32-bit floating point
(float))

• 6 — Float64 (64-bit floating point
(double))

• 7 — CInt16 (Complex Int16)
• 8 — CInt32 (Complex Int32)
• 9 — CFloat32 (Complex Float32)
• 10 — CFloat64 (Complex Float64)

Beschikbare opties zĳn afhankelĳk van de
versie van GDAL die is ingebouwd in QGIS
(bekĳk menu Help ► Info)

Uitvoer

Label Naam Type Beschrijving
Bereik EXTENT [tekenreeks] Het ruimtelĳke bereik van de uitvoer

rasterlaag
CRS identificatie
autoriteit

CRS_AUTHID [crs] Het coördinaten referentiesysteem van de
uitvoer rasterlaag

Breedte in pixels WIDTH_IN_PIXELS[geheel getal] Aantal kolommen in de uitvoer rasterlaag
Hoogte in pixels HEIGHT_IN_PIXELS[geheel getal] Aantal rĳen in de uitvoer rasterlaag
Totaal aantal
pixels

TOTAL_PIXEL_COUNT[geheel getal] Het aantal pixels in de uitvoer rasterlaag

Telling pixels
NODATA

NODATA_PIXEL_COUNT[geheel getal] Het aantal pixels Geen gegevens van de
uitvoer rasterlaag

Aantal pixels
TRUE

TRUE_PIXEL_COUNT[geheel getal] Het aantal pixels True (waarde = 1) in de
uitvoer rasterlaag

Aantal pixels
FALSE

FALSE_PIXEL_COUNT[geheel getal] Het aantal pixels False (waarde = 0) in de
uitvoer rasterlaag

Uitvoerlaag OUTPUT [raster] Uitvoer rasterlaag die het resultaat bevat
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Pythoncode

ID algoritme: native:rasterbooleanor

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Raster calculator

Voert algebraïsche bewerkingen uit op rasterlagen.
De resulterende laag zal zĳn waarden hebben berekend overeenkomstig een expressie. De expressie mag numerieke
waarden, operatoren en verwĳzingen bevatten naar elk van de lagen in het huidige project.

Notitie: Bĳ het gebruiken van de calculator inDe interface Batch-processing of vanuit deQGIS Python-consolemoeten
de te gebruiken bestanden worden gespecificeerd. Naar de corresponderende lagen wordt verwezen met de basisnaam
van het bestand (zonder het volledige pad). Als bĳvoorbeeld een laag wordt gebruikt vanuit pad/naar/mijn/
rasterbestand.tif, zal naar de eerste band van die laag worden verwezen als rasterbestand.tif@1.

Zie ook:
Rasterberekeningen

Parameters

Label Naam Type Beschrijving
Lagen Alleen GUI Vermeld de lĳst met alle rasterlagen die

zĳn geladen in de legenda. Deze kunnen
worden gebruikt om het vak voor de
expressie te vullen (dubbelklikken om
toe te voegen). Naar rasterlagen wordt
verwezen met hun naam en het nummer van
de band: laag_naam@band_nummer.
Naar bĳvoorbeeld de eerste band van een
laag genaamd DEM zal worden verwezen als
DEM@1.

Operatoren Alleen GUI Bevat enkele knoppen, zoals op
rekenmachines, die kunnen worden
gebruikt om het vak voor de expressie te
vullen.

Expressie EXPRESSION [tekenreeks] Expressie die zal worden gebruikt om de
uitvoer rasterlaag te berekenen. U kunt
de verschafte knoppen met operatoren
gebruiken om de expressie direct in dit vak
te typen.

Vervolgt op volgende pagina
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Tabel 27.66 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Vooraf
gedefinieerde
expressies

Alleen GUI U kunt de vooraf gedefinieerde expressie
NDVI gebruiken of u kunt nieuwe
expressies voor berekeningen maken. De
knop Toevoegen… laadt een gedefinieerde
expressie (en laat u de parameters instellen).
De knop Opslaan… laat u een nieuwe
expressie definiëren.

Verwĳzingsla(a)g(en)
(gebruikt voor
automatisch
bereik, celgrootte
en CRS)
Optioneel

LAYERS [raster] [lĳst] La(a)g(en) die zullen worden gebruikt om
bereik, celgrootte en CRS op te halen.
Door de laag in dit vak te selecteren
vermĳdt u het handmatig invullen van alle
andere parameters. Naar rasterlagen wordt
verwezen met hun naam en het nummer van
de band: laag_naam@band_nummer.
Naar bĳvoorbeeld de eerste band van een
laag genaamd DEM zal worden verwezen als
DEM@1.

Celgrootte
(gebruik 0 of
laat leeg om
automatisch in te
stellen)
Optioneel

CELLSIZE [getal] Celgrootte van de uitvoer rasterlaag. Als de
celgrootte niet wordt gespecificeerd, zal de
minimum celgrootte van de geselecteerde
verwĳzingsla(a)g(en) worden gebruikt. De
celgrootte is hetzelfde voor zowel de X- als
de Y-as.

Uitvoer bereik
Optioneel

EXTENT [bereik] Specificeer het ruimtelĳke bereik van de
uitvoer rasterlaag. Als het bereik niet is
gespecificeerd, zal het minimale bereik, dat
alle geselecteerde verwĳzingslagen bedekt,
worden gebruikt.
Beschikbare methoden zĳn:

• Uit laag berekenen…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

Uitvoer CRS
Optioneel

CRS [crs] CRS van de uitvoer rasterlaag. Als het CRS
niet is gespecificeerd, zal het CRS van de
eerste verwĳzingslaag worden gebruikt.

Vervolgt op volgende pagina
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Tabel 27.66 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Uitvoer OUTPUT [raster]

Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van het uitvoerraster. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Beschrijving
Uitvoer OUTPUT [raster] Uitvoer rasterbestand met de berekende

waarden.

Pythoncode

ID algoritme: qgis:rastercalculator

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Rasterlaag eigenschappen

Geeft basiseigenschappen van de opgegeven rasterlaag terug, inclusief het bereik, grootte in pixels en dimensies van
pixels (in kaarteenheden), aantal banden en waarde Geen gegevens.
Dit algoritme is bedoeld om te gebruiken als een middel om deze nuttige eigenschappen uit te nemen om te gebruiken
als de invoerwaarden voor andere algoritmes in een model - bĳv. om het mogelĳk te maken pixelgrootten van een
bestaand raster door te geven aan een rasteralgoritme van GDAL.

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Invoer rasterlaag
Bandnummer
Optioneel

BAND [rasterband]
Standaard: Niet
bepaald

Of ook eigenschappen van een specifieke
band moeten worden teruggegeven. Als een
band is gespecificeerd, wordt de waarde
Geen gegevens voor de geselecteerde band
ook teruggeven.
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Uitvoer

Label Naam Type Beschrijving
Aantal banden in
raster

BAND_COUNT [getal] Het aantal banden in het raster

CRS identificatie
autoriteit

CRS_AUTHID [tekenreeks] Het coördinaten referentiesysteem van de
uitvoer rasterlaag

Bereik EXTENT [tekenreeks] Het bereik van de rasterlaag in het CRS
Band heeft geen
waarde Geen
gegevens ingesteld

HAS_NODATA_VALUE[Booleaanse
waarde]

Geeft aan of de rasterlaag een waarde heeft
ingesteld voor pixels Geen gegevens in de
geselecteerde band

Hoogte in pixels HEIGHT_IN_PIXELS[geheel getal] Het aantal kolommen in de rasterlaag
Band waarde
Geen gegevens

NODATA_VALUE [getal] De waarde (indien ingesteld) van de pixels
Geen gegevens in de geselecteerde band

Pixelgrootte
(hoogte) in
kaarteenheden

PIXEL_HEIGHT [geheel getal] Verticale grootte in kaarteenheden van de
pixel

Pixelgrootte
(breedte) in
kaarteenheden

PIXEL_WIDTH [geheel getal] Horizontale grootte in kaarteenheden van
de pixel

Breedte in pixels WIDTH_IN_PIXELS[geheel getal] Het aantal rĳen in de rasterlaag
Maximum X-
coördinaat

X_MAX [getal]

Minimum X-
coördinaat

X_MIN [getal]

Maximum Y-
coördinaat

Y_MAX [getal]

Minimum Y-
coördinaat

Y_MIN [getal]

Pythoncode

ID algoritme: native:rasterlayerproperties

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Raster laagstatistieken

Berekent basisstatistieken uit de waarden van een opgegeven band van de rasterlaag. De uitvoer wordt geladen in het
menu Processing ► Resultaten bekĳken.

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Invoer rasterlaag
Bandnummer BAND [rasterband]

Standaard: De
eerste band van de
invoerlaag

Als het raster meerdere banden bevat, kies
de band waarvan u de statistieken wilt
hebben.

Statistieken OUTPUT_HTML_FILE[html]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van het uitvoerbestand.
• Uitvoer overslaan
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Beschrijving
Maximum waarde MAX [getal]
Gemiddelde
waarde

MEAN [getal]

Minimum waarde MIN [getal]
Statistieken OUTPUT_HTML_FILE[html] Het uitvoerbestand dat de volgende

informatie bevat:
• Geanalyseerd bestand: pad van de
rasterlaag

• Minimum waarde: minimum waarde
van het raster

• Maximum waarde: maximum
waarde van het raster

• Bereik: verschil tussen de maximum
en de minimum waarden

• Som: totale som van de waarden
• Gemiddelde waarde: gemiddelde van
de waarden

• Standaardafwĳking:
standaardafwĳking van de waarden

• Som van de vierkanten: som
van de vierkante verschillen van
elke observatie uit het algehele
gemiddelde

Bereik RANGE [getal]
Standaard
afwĳking

STD_DEV [getal]

Som SUM [getal]
Kwadraatsom SUM_OF_SQUARES [getal]
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Pythoncode

ID algoritme: native:rasterlayerstatistics

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Rasterlaag rapport unieke waarden

Geeft de telling en het gebied terug van elke unieke waarde in een opgegeven rasterlaag.

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Invoer rasterlaag
Bandnummer BAND [rasterband]

Standaard: De
eerste band van de
invoerlaag

Als het raster meerdere banden bevat, kies
de band waarvan u de statistieken wilt
hebben.

Rapport Unieke
waarden

OUTPUT_HTML_FILE[bestand]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van het uitvoerbestand.
• Uitvoer overslaan
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Tabel Unieke
waarden

OUTPUT_TABLE [tabel]
Standaard:
[Uitvoer
overslaan]

Specificatie van de tabel voor unieke
waarden:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
CRS identificatie
autoriteit

CRS_AUTHID [tekenreeks] Het coördinaten referentiesysteem van de
uitvoer rasterlaag

Bereik EXTENT [tekenreeks] Het ruimtelĳke bereik van de uitvoer
rasterlaag

Hoogte in pixels HEIGHT_IN_PIXELS[geheel getal] Aantal rĳen in de uitvoer rasterlaag
Telling pixels
NODATA

NODATA_PIXEL_COUNT[getal] Het aantal pixels Geen gegevens in de
uitvoer rasterlaag

Vervolgt op volgende pagina
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Tabel 27.69 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Totaal aantal
pixels

TOTAL_PIXEL_COUNT[geheel getal] Het aantal pixels in de uitvoer rasterlaag

Rapport Unieke
waarden

OUTPUT_HTML_FILE[html] Het uitvoer HTML-bestand bevat de
volgende informatie:

• Geanalyseerd bestand: het pad van de
rasterlaag

• Bereik: xmin, ymin, xmax, ymax
coördinaten van het bereik

• Projectie: projectie van de laag
• Breedte in pixels: aantal kolommen
en grootte pixelbreedte

• Hoogte in pixels: aantal rĳen en
grootte pixelbreedte

• Totaal aantal pixels: telling van alle
pixels

• Aantal pixels NODATA: telling
aantal pixels met waarde NODATA

Tabel Unieke
waarden

OUTPUT_TABLE [tabel] Een tabel met drie kolommen:
• waarde: pixelwaarde
• aantal: telling van pixels met deze
waarde

• m2: totale gebied in vierkante meters
van pixels met deze waarde.

Breedte in pixels WIDTH_IN_PIXELS[geheel getal] Aantal kolommen in de uitvoer rasterlaag

Pythoncode

ID algoritme: native:rasterlayeruniquevaluesreport

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Rasterlaag gebiedsstatistieken

Berekent statistieken voor de waarden van een rasterlaag, gecategoriseerd in gebieden, gedefinieerd in een andere
rasterlaag.
Zie ook:
Gebiedsstatistieken
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Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Invoer rasterlaag
Bandnummer BAND [rasterband]

Standaard: De
eerste band van de
rasterlaag

Als het raster meerdere banden bevat, kies
dan de band waarvoor u de statistieken wilt
berekenen.

Gebiedslaag ZONES [raster] Rasterlaag die de gebieden definieert.
Gebieden worden opgegeven door
aansluitende pixels die dezelfde waarde
voor de pixel hebben.

Bandnummer
gebieden

ZONES_BAND [rasterband]
Standaard: De
eerste band van de
rasterlaag

Als het raster meerdere banden bevat, kies
dan de band die de gebieden bevat

Statistieken OUTPUT_TABLE [tabel]
Standaard:
[Tijdelijke
laag maken]

Specificatie van het uitvoerrapport. Één
van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Gevorderde parameters

Label Naam Type Beschrijving
Verwĳzingslaag
Optioneel

REF_LAYER [enumeratie]
Standaard: 0

Rasterlaag die gebruikt wordt voor het
berekenen van de zwaartepunten, die zullen
worden gebruikt als verwĳzing bĳ het
bepalen van de gebieden in de uitvoerlaag.
Één van:

• 0 — Invoerlaag: gebieden worden
bepaald door de waarde van het
gebied van de rasterlaag te samplen
op het zwaartepunt van elke pixel van
de bron-rasterlaag

• 1 — Gebiedslaag: de invoer
rasterlaag zal worden gesampeld
op het zwaartepunt van elke pixel
van de rasterlaag met gebieden
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Uitvoer

Label Naam Type Beschrijving
CRS identificatie
autoriteit

CRS_AUTHID [tekenreeks] Het coördinaten referentiesysteem van de
uitvoer rasterlaag

Bereik EXTENT [tekenreeks] Het ruimtelĳke bereik van de uitvoer
rasterlaag

Hoogte in pixels HEIGHT_IN_PIXELS[geheel getal] Aantal rĳen in de uitvoer rasterlaag
Telling pixels
NODATA

NODATA_PIXEL_COUNT[getal] Het aantal pixels Geen gegevens in de
uitvoer rasterlaag

Statistieken OUTPUT_TABLE [tabel] De uitvoerlaag bevat de volgende informatie
voor elk gebied:

• Gebied: het gebied in vierkante
rastereenheden in het gebied;

• Som: de totale som van de
pixelwaarden in het gebied;

• Aantal: het aantal pixels in het gebied;
• Min: de minimum pixelwaarde in het
gebied;

• Max: de maximum pixelwaarde in
het gebied;

• Gemiddelde: het gemiddelde van de
pixelwaarden in het gebied;

Totaal aantal
pixels

TOTAL_PIXEL_COUNT[getal] Het aantal pixels in de uitvoer rasterlaag

Breedte in pixels WIDTH_IN_PIXELS[getal] Aantal kolommen in de uitvoer rasterlaag

Pythoncode

ID algoritme: native:rasterlayerzonalstats

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Rasteroppervlak volume

Berekent het volume onder het oppervlak van een raster, relatief aan een opgegeven basisniveau. Dit is voornamelĳk
nuttig voor Digital Elevation Models (DEM).

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Invoerraster, dat een oppervlak weergeeft
Bandnummer BAND [rasterband]

Standaard: De
eerste band van de
rasterlaag

Als het raster meerdere banden bevat,
kies dan de band die het oppervlak zal
definiëren.

Basisniveau LEVEL [getal]
Standaard: 0.0

Definieer een basis- of verwĳzingswaarde.
Deze basis wordt gebruikt bĳ de berekening
van het volume, overeenkomstig de
parameter Methode (zi hieronder).

Methode METHOD [enumeratie]
Standaard: 0

Definieer de methode voor het berekenen
van het volume, gegeven het verschil
tussen de raster pixelwaarde en het
Basisniveau. Opties:

• 0 — Tel alleen boven basisniveau:
alleen pixels boven het basisniveau
zullen worden toegevoegd aan het
volume.

• 1 — Tel alleen onder basisniveau:
alleen pixels onder het basisniveau
zullen worden toegevoegd aan het
volume.

• 2 — Volumes onder basisniveau
aftrekken: pixels boven het
basisniveau zullen aan het volume
worden toegevoegd, pixels onder
het basisniveau zullen worden
afgetrokken van het volume.

• 3 — Volumes onder basisniveau
optellen: Voeg aan het volume
toe, ongeacht of de pixel boven
of onder het basisniveau ligt. Dit
is equivalent aan de som van de
absolute waarden van het verschil
tussen de pixelwaarde en het
basisniveau.

Oppervlakte
volume rapport

OUTPUT_HTML_FILE[html]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van het uitvoer HTML-rapport.
Één van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Vervolgt op volgende pagina
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Tabel 27.73 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Oppervlakte
volume tabel

OUTPUT_TABLE [tabel]
Standaard:
[Uitvoer
overslaan]

Specificatie van de uitvoertabel. Één van:
• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Volume VOLUME [getal] Het berekende volume
Gebied AREA [getal] Het gebied in vierkante kaarteenheden
Aantal pixels PIXEL_COUNT [getal] Het totale aantal pixels dat is geanalyseerd
Oppervlakte
volume rapport

OUTPUT_HTML_FILE[html] Het uitvoerrapport (dat volume, gebied en
aantal pixels bevat) in indeling HTML

Oppervlakte
volume tabel

OUTPUT_TABLE [tabel] De uitvoertabel (die volume, gebied en
aantal pixels bevat)

Pythoncode

ID algoritme: native:rastersurfacevolume

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Opnieuw classificeren op laag

Classificeert een rasterband opnieuw door nieuwewaarden voor klassen toe te wĳzen, gebaseerd op de gespecificeerde
bereiken in een vectortabel.

Parameters

Basis parameters

Label Naam Type Beschrijving
Rasterlaag INPUT_RASTER [raster] Rasterlaag die opnieuw moet worden

geclassificeerd
Vervolgt op volgende pagina
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Tabel 27.74 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Bandnummer RASTER_BAND [rasterband]

Standaard: De
eerste band van de
rasterlaag

Als het raster meerdere banden bevat,
kies dan de band die u opnieuw wilt
classificeren.

Laag die de
overgangen van
klassen bevat

INPUT_TABLE [vector: elke] Vectorlaag die de waarden bevat die moeten
worden gebruikt voor het classificeren.

Veld voor
minimum waarde
klasse

MIN_FIELD [tabelveld:
numeriek]

Veldmet deminimumwaarde van het bereik
voor de klasse. Gebruik -inf om de laagst
mogelĳke waarde vast te leggen.

Veld voor
maximum waarde
klasse

MAX_FIELD [tabelveld:
numeriek]

Veld met de maximumwaarde van het
bereik voor de klasse. Gebruik inf om de
hoogst mogelĳke waarde vast te leggen.

Veld
uitvoerwaarde

VALUE_FIELD [tabelveld:
numeriek]

Veld met de waarde die zal worden
toegewezen aan de pixels die vallen in
de klasse (tussen de overeenkomende min.
en max. waarden). Gebruik nan om de
waarde voor het bereik in te stellen op Geen
gegevens.

Opnieuw
geclassificeerd
raster

OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van het uitvoerraster. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Uitvoer waarde
‘Geen gegevens’

NO_DATA [getal]
Standaard: -9999.0

Waarde om toe te passen op waarden Geen
gegevens.

Grenzen bereik RANGE_BOUNDARIES[enumeratie]
Standaard: 0

Definieert regels voor vergelĳking voor het
classificeren. Opties:

• 0 — min < waarde <= max
• 1 — min <= waarde < max
• 2 — min <= waarde <= max
• 3 — min < waarde < max

Geen gegevens
gebruiken als
geen bereik
overeenkomt met
waarde

NODATA_FOR_MISSING[Booleaanse
waarde]
Standaard: False

Toegepast op de waarden Geen gegevens
voor bandwaarden die niet in enige klasse
vallen. Indien False wordt de originele
waarde behouden.

Vervolgt op volgende pagina
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Tabel 27.75 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Type
uitvoergegevens

DATA_TYPE [enumeratie]
Standaard: 5

Definieert de indeling voor het uitvoer
rasterbestand. Opties:

• 0 — Byte (8-bit unsigned integer
(quint8))

• 1 — Int16 (16-bit signed integer
(qint16))

• 2 — UInt16 (16-bit unsigned integer
(quint16))

• 3 — Int32 (32-bit signed integer
(qint32))

• 4 — UInt32 (32-bit unsigned integer
(quint32))

• 5 — Float32 (32-bit floating point
(float))

• 6 — Float64 (64-bit floating point
(double))

• 7 — CInt16 (Complex Int16)
• 8 — CInt32 (Complex Int32)
• 9 — CFloat32 (Complex Float32)
• 10 — CFloat64 (Complex Float64)

Beschikbare opties zĳn afhankelĳk van de
versie van GDAL die is ingebouwd in QGIS
(bekĳk menu Help ► Info)

Uitvoer

Label Naam Type Beschrijving
Opnieuw
geclassificeerd
raster

OUTPUT [raster] Uitvoer rasterlaag met opnieuw
geclassificeerde bandwaarden

Pythoncode

ID algoritme: native:reclassifybylayer

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

1102 Hoofdstuk 27. Processing providers en algoritmes



QGIS Desktop 3.28 User Guide

Opnieuw classificeren op tabel

Classificeert een rasterband opnieuw door nieuwewaarden voor klassen toe te wĳzen, gebaseerd op de gespecificeerde
bereiken in een vaste tabel.

Parameters

Basis parameters

Label Naam Type Beschrijving
Rasterlaag INPUT_RASTER [raster] Rasterlaag die opnieuw moet worden

geclassificeerd
Bandnummer RASTER_BAND [rasterband]

Standaard: 1
Rasterband waarvan u de waarden opnieuw
wilt berekenen.

Tabel voor
opnieuw
classificeren

TABLE [tabel] Een tabel met 3 kolommen waarin de
waarden zĳn ingesteld op de grenzen van
elke klasse (Minimum en Maximum) en
de nieuwe Waarde die moet worden
toegewezen aan de bandwaarden die in die
klasse vallen. De waarde -inf kan worden
gebruikt als minimum, inf als maximum
en nan kan worden gebruikt om de uitvoer
in te stellen als Geen gegevens.

Opnieuw
geclassificeerd
raster

OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoer rasterlaag. Één
van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Uitvoer waarde
‘Geen gegevens’

NO_DATA [getal]
Standaard: -9999.0

Waarde om toe te passen op waarden Geen
gegevens.

Grenzen bereik RANGE_BOUNDARIES[enumeratie]
Standaard: 0

Definieert regels voor vergelĳking voor het
classificeren. Opties:

• 0 — min < waarde <= max
• 1 — min <= waarde < max
• 2 — min <= waarde <= max
• 3 — min < waarde < max

Geen gegevens
gebruiken als
geen bereik
overeenkomt met
waarde

NODATA_FOR_MISSING[Booleaanse
waarde]
Standaard: False

Toegepast op de waarden Geen gegevens
voor bandwaarden die niet in enige klasse
vallen. Indien False wordt de originele
waarde behouden.

Vervolgt op volgende pagina
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Tabel 27.77 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Type
uitvoergegevens

DATA_TYPE [enumeratie]
Standaard: 5

Definieert de indeling voor het uitvoer
rasterbestand. Opties:

• 0 — Byte (8-bit unsigned integer
(quint8))

• 1 — Int16 (16-bit signed integer
(qint16))

• 2 — UInt16 (16-bit unsigned integer
(quint16))

• 3 — Int32 (32-bit signed integer
(qint32))

• 4 — UInt32 (32-bit unsigned integer
(quint32))

• 5 — Float32 (32-bit floating point
(float))

• 6 — Float64 (64-bit floating point
(double))

• 7 — CInt16 (Complex Int16)
• 8 — CInt32 (Complex Int32)
• 9 — CFloat32 (Complex Float32)
• 10 — CFloat64 (Complex Float64)

Beschikbare opties zĳn afhankelĳk van de
versie van GDAL die is ingebouwd in QGIS
(bekĳk menu Help ► Info)

Uitvoer

Label Naam Type Beschrijving
Opnieuw
geclassificeerd
raster

OUTPUT [raster] Uitvoer rasterlaag met opnieuw
geclassificeerde bandwaarden

Pythoncode

ID algoritme: native:reclassifybytable

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Raster opnieuw op schaal brengen

Schaalt een rasterlaag opnieuw naar een nieuw waardenbereik, daarbĳ de vorm (verdeling) van het histogram van het
raster (pixelwaarden) behoudend. Waarden voor invoer worden in kaart gebracht met een lineaire interpolatie vanuit
de minimum en maximum pixelwaarden van het bronraster naar het minimum en maximum pixelbereik van het doel.
Standaard behoudt het algoritme de originele waarden Geen gegevens, maar er is een optie om die te overschrĳven.

Fig. 27.18: Waarden opnieuw op schaal brengen voor een rasterlaag van [0 - 50] naar [100 - 1000]

Parameters

Label Naam Type Beschrijving
Invoerraster INPUT [raster] Te gebruiken rasterlaag voor

opnieuw op schaal brengen
Bandnummer BAND [rasterband]

Standaard: De
eerste band van de
invoerlaag

Kies, als het raster multiband is,
een band.

Nieuwe minimumwaarde MINIMUM [getal]
Standaardwaarde:
0.0

Te gebruiken minimum
pixelwaarde in de opnieuw op
schaal te brengen laag

Nieuwe maximumwaarde MAXIMUM [getal]
Standaardwaarde:
255.0

Te gebruiken maximum
pixelwaarde in de opnieuw op
schaal te brengen laag

Nieuwe waarde Geen
gegevens
Optioneel

NODATA [getal]
Standaardwaarde:
Niet ingesteld

Toe te wĳzen waarde aan
de pixels Geen gegevens.
Indien niet ingesteld worden
de originele waarden Geen
gegevens behouden.

Opnieuw op schaal gebracht OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoer
rasterlaag. Één van:

• Opslaan naar tĳdelĳk
bestand

• Opslaan als bestand…
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Uitvoer

Label Naam Type Beschrijving
Opnieuw op schaal
gebracht

OUTPUT [raster] Uitvoer rasterlaag met opnieuw op schaal
gebrachte bandwaarden

Pythoncode

ID algoritme: native:rescaleraster

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Raster afronden

Rondt de celwaarden van de gegevensset van een raster af naar het gespecificeerde aantal decimalen.
Als alternatief kan een negatief aantal decimale plaatsen worden gebruikt om waarden af te ronden naar de macht van
een basis n. Bĳvoorbeeld met een Basiswaarde n van 10 en Decimale plaatsen -1, rondt het algoritme celwaarden af
naar veelvouden van 10, -2 rondt af naar veelvouden van 100, enzovoort. Willekeurige basiswaarden kunnen worden
gekozen, het algoritme past hetzelfde principe voor vermenigvuldigen toe. Afronden van celwaarden naar veelvouden
van een basis n kan worden gebruikt om rasterlagen te generaliseren.
Het algoritme behoudt het gegevenstype van het invoerraster. Daarom kunnen rasters byte/integer alleen worden
afgerond naar een veelvoud van basis n, anders wordt een waarschuwing weergegeven en wordt het raster gekopieerd
als een raster byte/integer.

Fig. 27.19: Waarden van een raster afronden
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Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerraster INPUT [raster] Het te verwerken raster.
Bandnummer BAND [getal]

Standaard: 1
De band van het raster

Richting voor
afronden

ROUNDING_DIRECTION[lĳst]
Standaard: 1

Hoe de afgeronde doelwaarde te kiezen.
Opties zĳn:

• 0 — Afgerond naar boven
• 1 — Afgerond naar dichtstbĳzĳnde
• 2 — Afgerond naar beneden

Aantal plaatsen
achter de komma

DECIMAL_PLACES [getal]
Standaard: 2

Aantal plaatsen achter de komma om naar
af te ronden. Gebruik negatievewaarden om
celwaarden af te ronden naar een veelvoud
van een basis n

Uitvoerraster OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoerlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Basis n voor
afronden naar
veelvouden van n

BASE_N [getal]
Standaard: 10

Als de parameter DECIMAL_PLACES
negatief is, worden rasterwaarden afgerond
naar veelvouden van de waarde in basis n

Uitvoer

Label Naam Type Beschrijving
Uitvoerraster OUTPUT [raster] De uitvoer rasterlaag met afgeronde

waarden voor de geselecteerde band.

Pythoncode

ID algoritme: native:roundrastervalues

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Monster rasterwaarden

Neemt rasterwaarden uit op locaties van punten. Als de rasterlaag multiband is worden uit elke band monsters
genomen.
De attributentabel van de resulterende laag zal net zoveel kolommen hebben als het aantal banden voor de rasterlaag.

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: punt] Punt vectorlaag om te gebruiken

voor het nemen van de monsters
Rasterlaag RASTERCOPY [raster] Rasterlaag waaruit monsters

moeten worden genomen op de
opgegeven puntlocaties.

Voorvoegsel uitvoerkolom COLUMN_PREFIX [tekenreeks]
Standaard:
‘SAMPLE_’

Voorvoegsel voor de namen van
de toegevoegde kolommen.

Gemonsterd
Optioneel

OUTPUT [vector: punt]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoerlaag die
de waarden van de monsters
bevat. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar
GeoPackage…

• Opslaan als tabel voor
database…

De bestandscodering kan hier
ook gewĳzigd worden.

Uitvoer

Label Naam Type Beschrijving
Gemonsterd OUTPUT [vector: punt] De uitvoerlaag die de waarden van de

monsters bevat.

Pythoncode

ID algoritme: native:rastersampling

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Zonehistogram

Voegt velden toe die het aantal unieke waarden uit een rasterlaag, opgenomen in als polygonen gedefinieerde zones,
weergeven.
De attributentabel van de uitvoerlaag zal net zoveel velden hebben als het aantal unieke waarden van de rasterlaag die
kruisen met de polygo(o)n(en).

Fig. 27.20: Voorbeeld histogram rasterlaag
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Parameters

Label Naam Type Beschrijving
Rasterlaag INPUT_RASTER [raster] Invoer rasterlaag
Bandnummer RASTER_BAND [rasterband]

Standaard: De
eerste band van de
invoerlaag

Kies, als het raster multiband is, een band.

Vectorlaag die
gebieden bevat

INPUT_VECTOR [vector: polygoon] Vector polygonenlaag die de gebieden
definieert.

Voorvoegsel
uitvoerkolom

COLUMN_PREFIX
Optioneel

[tekenreeks]
Standaard:
‘HISTO_’

Voorvoegsel voor de namen van de
kolommen voor de uitvoer.

Uitvoer gebieden OUTPUT [vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer polygonenlaag. Één
van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Uitvoer gebieden OUTPUT [vector: polygoon] De uitvoer vector polygonenlaag.

Pythoncode

ID algoritme: native:zonalhistogram

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Gebiedsstatistieken

Berekent statistieken van een rasterlaag voor elk object van een overlappende polygoon vectorlaag.
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: polygoon] Vector polygonenlaag die de gebieden

bevat.
Rasterlaag INPUT_RASTER [raster] Invoer rasterlaag
Rasterband RASTER_BAND [rasterband]

Standaard: De
eerste band van de
invoerlaag

Kies, als het raster multiband is, een band
voor de statistieken.

Voorvoegsel
uitvoerkolom

COLUMN_PREFIX [tekenreeks]
Standaard: ‘_’

Voorvoegsel voor de namen van de
kolommen voor de uitvoer.

Te berekenen
statistieken

STATISTICS [enumeratie] [lĳst]
Standaard: [0,1,2]

Lĳst met statistische operator voor de
uitvoer. Opties:

• 0 — Aantal
• 1 — Som
• 2 — Gemiddelde
• 3 — Mediaan
• 4 — Std. afw.
• 5 — Minimum
• 6 — Maximum
• 7 — Bereik
• 8 — Minderheid
• 9 — Meerderheid
• 10 — Variëteit
• 11 — Variantie

Gebiedsstatistieken OUTPUT [vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer polygonenlaag. Één
van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Gebiedsstatistieken OUTPUT [vector: polygoon] De vectorlaag met gebieden met de

toegevoegde statistieken.
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Pythoncode

ID algoritme: native:zonalstatisticsfb

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

27.1.12 Raster maken

Constante rasterlaag maken

Maakt een rasterlaag voor opgegeven bereik en celgrootte, gevuld met de gespecificeerde waarde.
Aanvullend kan een gegevenstype worden gespecificeerd voor de uitvoer. Het algoritme zal worden afgebroken als er
een waarde is ingevoerd die niet kan worden weergegeven door het geselecteerde gegevenstype voor het uitvoerraster.

Parameters
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Basis parameters

Label Naam Type Omschrijving
Gewenst bereik EXTENT [bereik] Specificeer het ruimtelĳke bereik van de

laag van het uitvoerraster. Het zal intern
worden uitgebreid naar een veelvoud van de
tegelgrootte.
Beschikbare methoden zĳn:

• Berekenen uit laag…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

Doel-CRS TARGET_CRS [crs]
Standaard: project
CRS

CRS voor de uitvoer rasterlaag

Pixelgrootte PIXEL_SIZE [getal]
Standaard: 0.1

Pixelgrootte (X=Y) in kaarteenheden.
Minimumwaarde: 0.01

Constante waarde NUMBER [getal]
Standaard: 1

Constante pixelwaarde voor de uitvoer
rasterlaag.

Constante OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoerlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Omschrijving
Gegevenstype
uitvoerraster

OUTPUT_TYPE
Standaard: 5

[enumeratie] Definieert het gegevenstype voor het
uitvoer rasterbestand. Opties:

• 0 — Byte
• 1 — Integer16
• 2 — Unsigned Integer16
• 3 — Integer32
• 4 — Unsigned Integer32
• 5 — Float32
• 6 — Float64
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Uitvoer

Label Naam Type Omschrijving
Constante OUTPUT [raster] Raster dat het gewenste bereik bedekt met

de gespecificeerde pixelgrootte en waarde.

Pythoncode

ID algoritme: native:createconstantrasterlayer

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Willekeurige rasterlaag maken (binomiale verdeling)

Maakt een rasterlaag voor opgegeven bereik en celgrootte, gevuld met de binomiaal verdeelde willekeurige waarden.
Standaard zullen de gekozen waarden een Nworden gegeven van 10 en een waarschĳnlĳkheid van 0.5. Dit kan worden
overschreven door de gevorderde parameter te gebruiken voor N en waarschĳnlĳkheid. Het type rastergegevens wordt
ingesteld op Integer (standaard Integer16). De binomiale verdeling willekeurige waarden worden gedefinieerd als
positieve integer-getallen. Een raster floating point zal een omzetting weergeven van waarden integer naar floating
point.

Parameters
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Basis parameters

Label Naam Type Omschrijving
Gewenst bereik EXTENT [bereik] Specificeer het ruimtelĳke bereik van de

laag van het uitvoerraster. Het zal intern
worden uitgebreid naar een veelvoud van de
tegelgrootte.
Beschikbare methoden zĳn:

• Berekenen uit laag…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

Doel-CRS TARGET_CRS [crs]
Standaard: project
CRS

CRS voor de uitvoer rasterlaag

Pixelgrootte PIXEL_SIZE [getal]
Standaard: 0.1

Pixelgrootte (X=Y) in kaarteenheden.
Minimumwaarde: 0.01

Uitvoerraster OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoerlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…
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Gevorderde parameters

Label Naam Type Omschrijving
Gegevenstype
uitvoerraster

OUTPUT_TYPE
Standaard: 0

[enumeratie] Definieert het gegevenstype voor het
uitvoer rasterbestand. Opties:

• 0 — Integer16
• 1 — Unsigned Integer16
• 2 — Integer32
• 3 — Unsigned Integer32
• 4 — Float32
• 5 — Float64

N N [getal]
Standaard: 10

Waarschĳnlĳkheid PROBABILITY [getal]
Standaard: 0.5

Uitvoer

Label Naam Type Omschrijving
Uitvoerraster OUTPUT [raster] Raster dat het gewenste bereik bedekt

met de celgrootten gevuld met willekeurige
waarden.

Pythoncode

ID algoritme: native:createrandombinomialrasterlayer

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Willekeurige rasterlaag maken (exponentiële verdeling)

Maakt een rasterlaag voor opgegeven bereik en celgrootte, gevuld met de exponentieel verdeelde willekeurige
waarden.
Standaard zullen de gekozen waarden een lambda worden gegeven van 1.0. Dit kan worden overschreven door de
gevorderde parameter te gebruiken voor lambda. Het type rastergegevens wordt standaard ingesteld op Float32, omdat
de willekeurige waarden voor de exponentiële verdeling getallen met zwevende punten zĳn.
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Parameters

Basis parameters

Label Naam Type Omschrijving
Gewenst bereik EXTENT [bereik] Specificeer het ruimtelĳke bereik van de

laag van het uitvoerraster. Het zal intern
worden uitgebreid naar een veelvoud van de
tegelgrootte.
Beschikbare methoden zĳn:

• Berekenen uit laag…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

Doel-CRS TARGET_CRS [crs]
Standaard: project
CRS

CRS voor de uitvoer rasterlaag

Pixelgrootte PIXEL_SIZE [getal]
Standaard: 1.0

Pixelgrootte (X=Y) in kaarteenheden.
Minimumwaarde: 0.01

Uitvoerraster OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoerlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Omschrijving
Gegevenstype
uitvoerraster

OUTPUT_TYPE
Standaard: 0

[enumeratie] Definieert het gegevenstype voor het
uitvoer rasterbestand. Opties:

• 0 — Float32
• 1 — Float64

Lambda LAMBDA [getal]
Standaard: 1.0
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Uitvoer

Label Naam Type Omschrijving
Uitvoerraster OUTPUT [raster] Raster dat het gewenste bereik bedekt

met de celgrootten gevuld met willekeurige
waarden.

Pythoncode

ID algoritme: native:createrandomexponentialrasterlayer

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Willekeurige rasterlaag maken (gamma verdeling)

Maakt een rasterlaag voor opgegeven bereik en celgrootte, gevuld met gamma verdeelde willekeurige waarden.
Standaard zullen de gekozen waarden een alfa worden gegeven van 1.0. Dit kan worden overschreven door de
gevorderde parameter te gebruiken voor alfa en bèta. Het type rastergegevens wordt standaard ingesteld op Float32,
omdat de willekeurige waarden voor de gamma-verdeling getallen met zwevende punten zĳn.

Parameters
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Basis parameters

Label Naam Type Omschrijving
Gewenst bereik EXTENT [bereik] Specificeer het ruimtelĳke bereik van de

laag van het uitvoerraster. Het zal intern
worden uitgebreid naar een veelvoud van de
tegelgrootte.
Beschikbare methoden zĳn:

• Berekenen uit laag…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

Doel-CRS TARGET_CRS [crs]
Standaard: project
CRS

CRS voor de uitvoer rasterlaag

Pixelgrootte PIXEL_SIZE [getal]
Standaard: 1.0

Pixelgrootte (X=Y) in kaarteenheden.
Minimumwaarde: 0.01

Uitvoerraster OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoerlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Omschrijving
Gegevenstype
uitvoerraster

OUTPUT_TYPE
Standaard: 0

[enumeratie] Definieert het gegevenstype voor het
uitvoer rasterbestand. Opties:

• 0 — Float32
• 1 — Float64

Alfa ALPHA [getal]
Standaard: 1.0

Bèta BETA [getal]
Standaard: 1.0
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Uitvoer

Label Naam Type Omschrijving
Uitvoerraster OUTPUT [raster] Raster dat het gewenste bereik bedekt

met de celgrootten gevuld met willekeurig
verdeelde waarden.

Pythoncode

ID algoritme: native:createrandomgammarasterlayer

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Willekeurige rasterlaag maken (geometrische verdeling)

Maakt een rasterlaag voor opgegeven bereik en celgrootte, gevuldmet de geometrisch verdeelde willekeurige waarden.
Standaard zullen de gekozen waarden een waarschĳnlĳkheid van 0.5 worden gegeven. Dit kan worden overschreven
door de gevorderde parameter te gebruiken voor de gemiddelde waarde. Het type rastergegevens wordt ingesteld op
type Integer (standaard Integer16). De geometrische verdeling willekeurige waarden worden gedefinieerd als positieve
integer-getallen. Een raster floating point zal een omzetting weergeven van waarden integer naar floating point.

Parameters

1120 Hoofdstuk 27. Processing providers en algoritmes



QGIS Desktop 3.28 User Guide

Basis parameters

Label Naam Type Omschrijving
Gewenst bereik EXTENT [bereik] Specificeer het ruimtelĳke bereik van de

laag van het uitvoerraster. Het zal intern
worden uitgebreid naar een veelvoud van de
tegelgrootte.
Beschikbare methoden zĳn:

• Berekenen uit laag…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

Doel-CRS TARGET_CRS [crs]
Standaard: project
CRS

CRS voor de uitvoer rasterlaag

Pixelgrootte PIXEL_SIZE [getal]
Standaard: 1.0

Pixelgrootte (X=Y) in kaarteenheden.
Minimumwaarde: 0.01

Uitvoerraster OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoerlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Omschrijving
Gegevenstype
uitvoerraster

OUTPUT_TYPE
Standaard: 0

[enumeratie] Definieert het gegevenstype voor het
uitvoer rasterbestand. Opties:

• 0 — Integer16
• 1 — Unsigned Integer16
• 2 — Integer32
• 3 — Unsigned Integer32
• 4 — Float32
• 5 — Float64

Waarschĳnlĳkheid PROBABILITY [getal]
Standaard: 0.5
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Uitvoer

Label Naam Type Omschrijving
Uitvoerraster OUTPUT [raster] Raster dat het gewenste bereik bedekt

met de celgrootten gevuld met willekeurig
verdeelde waarden.

Pythoncode

ID algoritme: native:createrandomgeometricrasterlayer

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Willekeurige rasterlaag maken (negatieve binomiale verdeling)

Maakt een rasterlaag voor opgegeven bereik en celgrootte, gevuld met de negatief binomiaal verdeelde willekeurige
waarden.
Standaard zullen de gekozen waarden een verdelingsparameter k worden gegeven van 10.0 en een waarschĳnlĳkheid
van 0.5. Dit kan worden overschreven door de gevorderde parameter te gebruiken voor k en waarschĳnlĳkheid. Het
type rastergegevens wordt ingesteld op Integer (standaard Integer16). De negatief binomiaal verdeelde willekeurige
waarden worden gedefinieerd als positieve integer-getallen. Een raster floating point zal een omzetting weergeven
van waarden integer naar floating point.

Parameters
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Basis parameters

Label Naam Type Omschrijving
Gewenst bereik EXTENT [bereik] Specificeer het ruimtelĳke bereik van de

laag van het uitvoerraster. Het zal intern
worden uitgebreid naar een veelvoud van de
tegelgrootte.
Beschikbare methoden zĳn:

• Berekenen uit laag…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

Doel-CRS TARGET_CRS [crs]
Standaard: project
CRS

CRS voor de uitvoer rasterlaag

Pixelgrootte PIXEL_SIZE [getal]
Standaard: 1.0

Pixelgrootte (X=Y) in kaarteenheden.
Minimumwaarde: 0.01

Uitvoerraster OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoerlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

27.1. QGIS algoritme provider 1123



QGIS Desktop 3.28 User Guide

Gevorderde parameters

Label Naam Type Omschrijving
Gegevenstype
uitvoerraster

OUTPUT_TYPE
Standaard: 0

[enumeratie] Definieert het gegevenstype voor het
uitvoer rasterbestand. Opties:

• 0 — Integer16
• 1 — Unsigned Integer16
• 2 — Integer32
• 3 — Unsigned Integer32
• 4 — Float32
• 5 — Float64

Parameter
verdeling k

K_PARAMETER [getal]
Standaard: 10

Waarschĳnlĳkheid PROBABILITY [getal]
Standaard: 0.5

Uitvoer

Label Naam Type Omschrijving
Uitvoerraster OUTPUT [raster] Raster dat het gewenste bereik bedekt

met de celgrootten gevuld met willekeurig
verdeelde waarden.

Pythoncode

ID algoritme: native:createrandomnegativebinomialrasterlayer

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Willekeurige rasterlaag maken (normale verdeling)

Maakt een rasterlaag voor opgegeven bereik en celgrootte, gevuld met de normaal verdeelde willekeurige waarden.
Standaard zullen de gekozen waarden een gemiddelde worden gegeven van 0.0 en een standaardafwĳking van 1.0.
Dit kan worden overschreven door de gevorderde parameters te gebruiken voor de waarden van gemiddelde en
standaardafwĳking. Het type rastergegevens wordt standaard ingesteld op Float32, omdat de willekeurige waarden
voor de normale verdeling getallen floating point zĳn.
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Parameters

Basis parameters

Label Naam Type Omschrijving
Gewenst bereik EXTENT [bereik] Specificeer het ruimtelĳke bereik van de

laag van het uitvoerraster. Het zal intern
worden uitgebreid naar een veelvoud van de
tegelgrootte.
Beschikbare methoden zĳn:

• Berekenen uit laag…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

Doel-CRS TARGET_CRS [crs]
Standaard: project
CRS

CRS voor de uitvoer rasterlaag

Pixelgrootte PIXEL_SIZE [getal]
Standaard: 1.0

Pixelgrootte (X=Y) in kaarteenheden.
Minimumwaarde: 0.01

Uitvoerraster OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoerlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Omschrijving
Gegevenstype
uitvoerraster

OUTPUT_TYPE
Standaard: 0

[enumeratie] Definieert het gegevenstype voor het
uitvoer rasterbestand. Opties:

• 0 — Float32
• 1 — Float64

Gemiddelde van
normale verdeling

MEAN [getal]
Standaard: 0.0

Standaardafwĳking
van normale
verdeling

STDDEV [getal]
Standaard: 1.0
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Uitvoer

Label Naam Type Omschrijving
Uitvoerraster OUTPUT [raster] Raster dat het gewenste bereik bedekt

met de celgrootten gevuld met willekeurig
verdeelde waarden.

Pythoncode

ID algoritme: native:createrandomnormalrasterlayer

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Willekeurige rasterlaag maken (Poisson verdeling)

Maakt een rasterlaag voor opgegeven bereik en celgrootte, gevuld met Poisson verdeelde willekeurige waarden.
Standaard zullen de gekozen waarden een gemiddelde worden gegeven van 1.0. Dit kan worden overschreven door
de gevorderde parameter te gebruiken voor de gemiddelde waarde. Het type rastergegevens wordt ingesteld op type
Integer (standaard Integer16). De Poisson verdeling willekeurige waarden zĳn positieve integer-getallen. Een raster
floating point zal een omzetting weergeven van waarden integer naar floating point.

Parameters
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Basis parameters

Label Naam Type Omschrijving
Gewenst bereik EXTENT [bereik] Specificeer het ruimtelĳke bereik van de

laag van het uitvoerraster. Het zal intern
worden uitgebreid naar een veelvoud van de
tegelgrootte.
Beschikbare methoden zĳn:

• Berekenen uit laag…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

Doel-CRS TARGET_CRS [crs]
Standaard: project
CRS

CRS voor de uitvoer rasterlaag

Pixelgrootte PIXEL_SIZE [getal]
Standaard: 1.0

Pixelgrootte (X=Y) in kaarteenheden.
Minimumwaarde: 0.01

Uitvoerraster OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoerlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Omschrijving
Gegevenstype
uitvoerraster

OUTPUT_TYPE
Standaard: 0

[enumeratie] Definieert het gegevenstype voor het
uitvoer rasterbestand. Opties:

• 0 — Integer16
• 1 — Unsigned Integer16
• 2 — Integer32
• 3 — Unsigned Integer32
• 4 — Float32
• 5 — Float64

Gemiddelde MEAN [getal]
Standaard: 1.0
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Uitvoer

Label Naam Type Omschrijving
Uitvoerraster OUTPUT [raster] Raster dat het gewenste bereik bedekt

met de celgrootten gevuld met willekeurig
verdeelde waarden.

Pythoncode

ID algoritme: native:createrandompoissonrasterlayer

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Willekeurige rasterlaag maken (uniforme verdeling)

Maakt een rasterlaag voor opgegeven bereik en celgrootte, gevuld met willekeurige waarden.
Standaard zullen de waarden liggen tussen de minimum- en maximumwaarde van het gespecificeerde type
uitvoerraster. Dit kan worden overschreven door de gevorderde parameters te gebruiken voor de waarden van
onder- en bovengrens. Als de begrenzingen dezelfde waarde hebben of beide nul zĳn (standaard) zal het algoritme
willekeurige waarden maken in het volledige waardebereik van het gekozen gegevenstype voor het raster. Kiezen van
grenzen buiten het te accepteren bereik van het type uitvoerraster zal het algoritme afbreken.

Parameters
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Basis parameters

Label Naam Type Omschrijving
Gewenst bereik EXTENT [bereik] Specificeer het ruimtelĳke bereik van de

laag van het uitvoerraster. Het zal intern
worden uitgebreid naar een veelvoud van de
tegelgrootte.
Beschikbare methoden zĳn:

• Berekenen uit laag…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

Doel-CRS TARGET_CRS [crs]
Standaard: project
CRS

CRS voor de uitvoer rasterlaag

Pixelgrootte PIXEL_SIZE [getal]
Standaard: 1.0

Pixelgrootte (X=Y) in kaarteenheden.
Minimumwaarde: 0.01

Uitvoerraster OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoerlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…
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Gevorderde parameters

Label Naam Type Omschrijving
Gegevenstype
uitvoerraster

OUTPUT_TYPE
Standaard: 5

[enumeratie] Definieert het gegevenstype voor het
uitvoer rasterbestand. Opties:

• 0 — Byte
• 1 — Integer16
• 2 — Unsigned Integer16
• 3 — Integer32
• 4 — Unsigned Integer32
• 5 — Float32
• 6 — Float64

Ondergrens voor
willekeurig bereik
van getallen

LOWER_BOUND [getal]
Standaard: 0.0

Bovengrens voor
willekeurig bereik
van getallen

UPPER_BOUND [getal]
Standaard: 0.0

Uitvoer

Label Naam Type Omschrijving
Uitvoerraster OUTPUT [raster] Raster dat het gewenste bereik bedekt

met de celgrootten gevuld met willekeurig
verdeelde waarden.

Pythoncode

ID algoritme: native:createrandomuniformrasterlayer

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

27.1.13 Raster Terreinanalyse

Ligging

Berekent de ligging van de invoer Digital Terrain Model. De uiteindelĳke rasterlaag voor de ligging bevat waarden
van 0 tot en met 360 die de richting van de helling aangeven: beginnend vanuit het noorden (0°) en doorlopend met
de klok mee.
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Fig. 27.21: Waarden voor ligging

De volgende afbeelding geeft de laag voor de ligging weer, geclassificeerd met een kleurverloop:

Fig. 27.22: Laag voor de ligging opnieuw geclassificeerd
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Parameters

Label Naam Type Beschrijving
Hoogtelaag INPUT [raster] Digital Terrain Model-rasterlaag
Z-factor Z_FACTOR [getal]

Standaard: 1.0
Verticale overdrĳving. Deze parameter is
nuttig als de eenheden voor Z verschillen
van die voor X en Y, bĳvoorbeeld mĳlen en
meters. U kunt deze parameter gebruiken
om het uiteindelĳke resultaat aan te passen.
De standaard is 1 (geen overdrĳving).

Aspect OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer de uitvoerlaag voor het aspect.
Één van:

• Opslaan als tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Beschrijving
Aspect OUTPUT [raster] De uitvoerlaag voor het aspect

Pythoncode

ID algoritme: qgis:aspect

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Schaduw voor heuvels

Berekent de rasterlaag voor schaduw op de heuvels, gegeven een invoer Digital Terrain Model.
De schaduw op de laagwordt berekend overeenkomstig de positie van de zon: u heeft de opties om zowel de horizontale
hoek (azimut) als de verticale hoek (hoogte van de zon) van de zon te wĳzigen.

Fig. 27.23: Azimut en verticale hoek
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De laag met de schaduw voor de heuvels bevat waarden van 0 (volledige schaduw) tot en met 255 (volledig in de zon).
Schaduw voor de heuvels wordt gewoonlĳk gebruikt om het reliëf van het gebied beter te kunnen begrĳpen.

Fig. 27.24: Laag met schaduw voor de heuvels met azimut 300 en verticale hoek van 45|degree|

Het is bĳzonder interessant om de laag met schaduw voor de heuvels een transparante waarde te geven en te laten
overlappen met het hoogteraster:

Fig. 27.25: Overlappen van de schaduw voor de heuvels met de hoogtelaag

27.1. QGIS algoritme provider 1133



QGIS Desktop 3.28 User Guide

Parameters

Label Naam Type Beschrijving
Hoogtelaag INPUT [raster] Digital Terrain Model-rasterlaag
Z-factor Z_FACTOR [getal]

Standaard: 1.0
Verticale overdrĳving. Deze parameter is
nuttig als de eenheden voor Z verschillen
van die voor X en Y, bĳvoorbeeld mĳlen en
meters. U kunt deze parameter gebruiken
om dit aan te passen. Verhogen van
de waarde van deze parameter zal het
uiteindelĳke resultaat overdrĳven (ziet er
meer “heuvelig” uit). De standaard is 1
(geen overdrĳving).

Azimut
(horizontale
hoek)

AZIMUTH [getal]
Standaard: 300.0

Stel de horizontale hoek (in graden) ten
opzichte van de zon in (met de klok mee).
Bereik: 0 tot en met 360. 0 is Noord.

Verticale hoek V_ANGLE [getal]
Standaard: 40.0

Stelt de verticale hoek (in graden) ten
opzichte van de zon in, dat is de hoogte van
de zon. Het bereik van deze waarden loopt
vanaf 0 (minimale hoogte) tot en met 90
(maximale hoogte).

Schaduw voor
heuvels

OUTPUT [raster]
Standaard:
Opslaan naar
tijdelijk
bestand

Specificeer de uitvoerlaag voor de schaduw
voor de heuvels. Één van:

• Opslaan als tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Beschrijving
Schaduw voor
heuvels

OUTPUT [raster] De uitvoerlaag voor de schaduw van de
heuvels

Pythoncode

ID algoritme: qgis:hillshade

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Hypsometrische bogen

Berekent hypsometrische bogen voor een Digital Elevation Model als invoer. Bogen worden gemaakt als CSV-
bestanden in een map voor de uitvoer, gespecificeerd door de gebruiker.
Een hypsometrische boog is een cumulatief histogram van hoogtewaarden in een geografisch gebied.
U kunt hypsometrische bogen gebruiken om verschillen te ontdekken in het landschap wegens de geomorfologie van
het gebied.

Parameters

Label Naam Type Beschrijving
DEM om te
analyseren

INPUT_DEM [raster] Digital Terrain Model-rasterlaag die
gebruikt moet worden voor berekenen van
hoogten

Grenslaag BOUNDARY_LAYER [vector: polygoon] Polygoon vectorlaag met grenzen van
gebieden die gebruikt moet worden om
hypsometrische bogen te berekenen.

Stap STEP [getal]
Standaard: 100.0

Verticale afstand tussen bogen

% van gebied
gebruiken
in plaats van
absolute waarde

USE_PERCENTAGE [Booleaanse
waarde]
Standaard: False

Percentage van gebied wegschrĳven naar
veld “Area” van het CSV-bestand in plaats
van het absolute gebied

Hypsometrische
bogen

OUTPUT_DIRECTORY[map] Specificeer de map voor de uitvoer van de
hypsometrische bogen. Één van:

• Opslaan in tĳdelĳke map
• Opslaan naar map

Uitvoer

Label Naam Type Beschrijving
Hypsometrische
bogen

OUTPUT_DIRECTORY[map] Map waar de bestanden met de
hypsometrische bogen zullen worden
opgeslagen. Voor elk object uit de invoer
vectorlaag zal een CSV-bestand met
waarden voor gebied en hoogte worden
gemaakt.
De bestandsnamen beginnen met
histogram_, gevolgd door de laagnaam
en het ID van het object.
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Pythoncode

ID algoritme: qgis:hypsometriccurves

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Reliëf

Maakt een reliëflaag met schaduw uit gegevens voor digitale hoogte. U kunt handmatig kleuren voor het reliëf
specificeren of u kunt het algoritme automatisch alle klassen voor het reliëf laten kiezen.
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Fig. 27.26: Reliëflaag

Parameters

Label Naam Type Beschrijving
Hoogtelaag INPUT [raster] Digital Terrain Model-rasterlaag
Z-factor Z_FACTOR [getal]

Standaard: 1.0
Verticale overdrĳving. Deze parameter is
nuttig als de eenheden voor Z verschillen
van die voor X en Y, bĳvoorbeeld mĳlen en
meters. U kunt deze parameter gebruiken
om dit aan te passen. Verhogen van
de waarde van deze parameter zal het
uiteindelĳke resultaat overdrĳven (ziet er
meer “heuvelig” uit). De standaard is 1
(geen overdrĳving).

Automatisch
klassen voor reliëf
genereren

AUTO_COLORS [Booleaanse
waarde]
Standaard: False

Als u deze optie selecteert, zal het
algoritme automatisch alle klassen voor de
reliëfkleuren maken

Vervolgt op volgende pagina
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Tabel 27.83 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Reliëfkleuren
Optioneel

COLORS [widget tabel] Gebruik de widget tabel als u de kleuren
handmatig wilt kiezen. U kunt net zoveel
klassen voor kleuren toevoegen als u wilt:
voor elke klasse kunt u de onder- en
bovengrens kiezen en tenslotte, door te
klikken op de rĳ voor de kleur, kunt
u de kleur kiezen met de widget Kleur.

Fig. 27.27: Handmatig reliëf kleurklassen
instellen
De knoppen in het paneel aan de
rechterkant geven u de kans om:
kleurklassen toe te voegen of te
verwĳderen, de volgorde van reeds
gedefinieerde kleurklassen te wĳzigen,
een bestaand bestand met kleurklassen te
openen en de huidige klassen als bestand
op te slaan.

Reliëf OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer de uitvoer rasterlaag voor het
reliëf. Één van:

• Opslaan als tĳdelĳk bestand
• Opslaan als bestand…

Frequentieverdeling
Optioneel

FREQUENCY_DISTRIBUTION[tabel]
Standaard:
[Uitvoer
overslaan]

Specificeer de CSV-tabel voor de uitvoer
van de frequentieverdeling. Één van:

• Uitvoer overslaan
• Opslaan als tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Beschrijving
Reliëf OUTPUT [raster] De uitvoer rasterlaag voor het reliëf
Frequentieverdeling OUTPUT [tabel] De uitvoer voor de frequentieverdeling
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Pythoncode

ID algoritme: qgis:relief

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Ruwheidsindex

Berekent de kwantitatieve meting van de heterogeniteit van het terrein, beschreven door Riley et al. (1999). Het wordt
berekend voor elke locatie, door de wĳziging in hoogte binnen het raster van 3x3-pixel samen te vatten.
Elke pixel bevat het verschil in hoogte vanuit een centrumcel en de 8 cellen daar omheen.

Fig. 27.28: Laag voor ruwheid van lage (rood) tot hoge waarden (groen)
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Parameters

Label Naam Type Beschrijving
Hoogtelaag INPUT [raster] Digital Terrain Model-rasterlaag
Z-factor Z_FACTOR [getal]

Standaard: 1.0
Verticale overdrĳving. Deze parameter is
nuttig als de eenheden voor Z verschillen
van die voor X en Y, bĳvoorbeeld mĳlen en
meters. U kunt deze parameter gebruiken
om dit aan te passen. Verhogen van
de waarde van deze parameter zal het
uiteindelĳke resultaat overdrĳven (laat het
er meer ruwer uitzien). De standaard is 1
(geen overdrĳving).

Ruwheid OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer de uitvoer rasterlaag voor de
ruwheid. Één van:

• Opslaan als tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Beschrijving
Ruwheid OUTPUT [raster] De uitvoer rasterlaag voor de ruwheid

Pythoncode

ID algoritme: qgis:ruggednessindex

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Helling

Berekent de helling vanuit een invoer rasterlaag. De helling is de hoek van de helling van het terrein enwordt uitgedrukt
in graden.

Fig. 27.29: Vlakke gebieden in rood, steile gebieden in blauw

Parameters

Label Naam Type Beschrijving
Hoogtelaag INPUT [raster] Digital Terrain Model-rasterlaag
Z-factor Z_FACTOR [getal]

Standaard: 1.0
Verticale overdrĳving. Deze parameter is
nuttig als de eenheden voor Z verschillen
van die voor X en Y, bĳvoorbeeld mĳlen en
meters. U kunt deze parameter gebruiken
om dit aan te passen. Verhogen van
de waarde van deze parameter zal het
uiteindelĳke resultaat overdrĳven (maakt
het steiler). De standaard is 1 (geen
overdrĳving).

Helling OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer de uitvoer rasterlaag voor de
helling. Één van:

• Opslaan als tĳdelĳk bestand
• Opslaan als bestand…
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Uitvoer

Label Naam Type Beschrijving
Helling OUTPUT [raster] De uitvoer rasterlaag voor de helling

Pythoncode

ID algoritme: qgis:slope

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

27.1.14 Raster-gereedschappen

Kaart naar raster converteren

Maakt een rasterafbeelding van de inhoud van het kaartvenster.
Een kaartthema kan worden geselecteerd om een vooraf bepaalde set van lagen met een gedefinieerde stĳl voor elke
laag te renderen.
Als alternatief kan één enkele laag worden geselecteerd als er geen kaartthema is ingesteld.
Als noch een thema voor de kaart, noch een laag is ingesteld, zal de huidige inhoud van het kaartvenster worden
gerenderd. Het minimale ingevoerde bereik zal intern worden uitgebreid tot een veelvoud van de tegelgrootte.

Parameters
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Label Naam Type Beschrijving
Minimale bereik
om te renderen
(xmin, xmax,
ymin, ymax)

EXTENT [bereik] Specificeer het bereik van de laag van
het uitvoerraster. Het zal intern worden
uitgebreid naar een veelvoud van de
tegelgrootte.
Beschikbare methoden zĳn:

• Uit laag berekenen…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

Tegelgrootte TILE_SIZE [getal]
Standaard: 1024

Grootte van de tegel voor de uitvoer
rasterlaag. Minimale waarde: 64.

Kaarteenheden
per pixel

MAP_UNITS_PER_PIXEL[getal]
Standaard: 100.0

Pixelgrootte (in kaarteenheden). Minimum
waarde: 0.0

Achtergrond
transparant
maken

MAKE_BACKGROUND_TRANSPARENT[Booleaanse
waarde]
Standaard: False

Altĳd de kaart exporteren met een
transparante achtergrond. Voert een
afbeelding RGBA uit (in plaats van RGB)
indien ingesteld op True.

Kaartthema om te
renderen
Optioneel

MAP_THEME [enumeratie] Gebruik een bestaand kaartthema voor het
renderen.

Enkele laag om te
renderen
Optioneel

LAYER [enumeratie] Kies één enkele laag voor het renderen.

Uitvoerlaag OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoerlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…
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Uitvoer

Label Naam Type Beschrijving
Uitvoerlaag OUTPUT [raster] Uitvoer rasterlaag

Pythoncode

ID algoritme: native:rasterize

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Cellen met Geen gegevens vullen

Stelt de waarden Geen gegevens in het invoerraster opnieuw in op een gekozen waarde, wat resulteert in een raster
gegevensset zonder pixels Geen gegevens.
Het algoritme respecteert het gegevenstype van het invoerraster, bĳv. een vulwaarde van een floating point zal worden
afgebroken indien toegepast op een raster met integers.

Fig. 27.30: Waarden Geen gegevens vullen (in grijs) voor een raster
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Parameters

Label Naam Type Beschrijving
Invoerraster INPUT [raster] Het te verwerken raster.
Bandnummer BAND [getal]

Standaard: 1
De band van het raster

Vulwaarde FILL_VALUE [getal]
Standaard: 1.0

Stel de te gebruiken waarde in voor de pixels
Geen gegevens

Uitvoerraster OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoerlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Beschrijving
Uitvoerraster OUTPUT [raster] Het uitvoerraster met gevulde

gegevenscellen.

Pythoncode

ID algoritme: native:fillnodata

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

XYZ-tegels maken (Map)

Maakt raster-“XYZ”-tegels uit het huidige project van QGIS als individuele afbeeldingen naar een mappenstructuur.

Parameters
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Label Naam Type Beschrijving
Bereik (xmin,
xmax, ymin,
ymax)

EXTENT [bereik] Specificeer het bereik van de tegels. Het zal
intern worden uitgebreid naar een veelvoud
van de tegelgrootte.
Beschikbare methoden zĳn:

• Uit laag berekenen…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

Minimum zoom ZOOM_MIN [getal]
Standaard: 12

Minimum 0, maximum 25.

Maximum zoom ZOOM_MAX [getal]
Standaard: 12

Minimum 0, maximum 25.

DPI DPI [getal]
Standaard: 96

Minimum 48, maximum 600.

Achtergrondkleur
Optioneel

BACKGROUND_COLOR[kleur]
Standaard:
QColor(0, 0, 0,
0)

Kies de achtergrondkleur voor de tegels

Indeling tegels TILE_FORMAT [enumeratie]
Standaard: 0

Één van:
• 0 — PNG
• 1 — JPG

Kwaliteit (alleen
JPG)
Optioneel

QUALITY [getal]
Standaard: 75

Minimum 1, maximum 100.

Grootte Metatile
Optioneel

METATILESIZE [getal]
Standaard: 4

Specificeer een aangepaste grootte voor
metatile bĳ het maken van XYZ-tegels.
Hogere waarden kunnen het renderen
van tegels versnellen en beter labelen
verschaffen (minder gaten zonder labels)
ten koste van het gebruiken van meer
geheugen. Minimum 1, maximum 20.

Tegelbreedte
Optioneel

TILE_WIDTH [getal]
Standaard: 256

Minimum 1, maximum 4096.

Tegelhoogte
Optioneel

TILE_HEIGHT [getal]
Standaard: 256

Minimum 1, maximum 4096.

Vervolgt op volgende pagina
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Tabel 27.85 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Gebruik
geïnverteerde
Y-as tegel (TMS-
conventies)
Optioneel

TMS_CONVENTION [Booleaanse
waarde]
Standaard: False

Map voor uitvoer
Optioneel

OUTPUT_DIRECTORY[map]
Standaard:
[Opslaan naar
tijdelijke
map]

Specificatie van de map voor de uitvoer
(voor de tegels). Één van:

• Uitvoer overslaan
• Opslaan in tĳdelĳke map
• Opslaan naar map

Uitvoer html
(Leaflet)
Optioneel

OUTPUT_HTML [html]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van het uitvoer HTML-
bestand. Één van:

• Uitvoer overslaan
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Beschrijving
Map voor uitvoer OUTPUT_DIRECTORY[map] Map voor de uitvoer (voor de tegels)
Uitvoer html
(Leaflet)

OUTPUT_HTML [html] Het uitvoer XML-bestand (Leaflet)

Pythoncode

ID algoritme: qgis:tilesxyzdirectory

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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XYZ-tegels maken (MBTiles)

Maakt raster-“XYZ”-tegels uit het huidige project van QGIS als één enkel bestand in de indeling “MBTiles”.

Parameters

Label Naam Type Beschrijving
Bereik (xmin,
xmax, ymin,
ymax)

EXTENT [bereik] Specificeer het bereik van de tegels. Het zal
intern worden uitgebreid naar een veelvoud
van de tegelgrootte.
Beschikbare methoden zĳn:

• Uit laag berekenen…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

Minimum zoom ZOOM_MIN [getal]
Standaard: 12

Minimum 0, maximum 25.

Maximum zoom ZOOM_MAX [getal]
Standaard: 12

Minimum 0, maximum 25.

DPI DPI [getal]
Standaard: 96

Minimum 48, maximum 600.

Achtergrondkleur
Optioneel

BACKGROUND_COLOR[kleur]
Standaard:
QColor(0, 0, 0,
0)

Kies de achtergrondkleur voor de tegels

Indeling tegels TILE_FORMAT [enumeratie]
Standaard: 0

Één van:
• 0 — PNG
• 1 — JPG

Kwaliteit (alleen
JPG)
Optioneel

QUALITY [getal]
Standaard: 75

Minimum 1, maximum 100.

Grootte Metatile
Optioneel

METATILESIZE [getal]
Standaard: 4

Specificeer een aangepaste grootte voor
metatile bĳ het maken van XYZ-tegels.
Hogere waarden kunnen het renderen
van tegels versnellen en beter labelen
verschaffen (minder gaten zonder labels)
ten koste van het gebruiken van meer
geheugen. Minimum 1, maximum 20.

Vervolgt op volgende pagina
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Tabel 27.86 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Uitvoerbestand
(voor MBTiles)

OUTPUT_FILE [bestand]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoerlaag. Één van:
• Uitvoer overslaan
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Beschrijving
Uitvoerbestand
(voor MBTiles)

OUTPUT_FILE [bestand] Het uitvoerbestand.

Pythoncode

ID algoritme: qgis:tilesxyzmbtiles

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

27.1.15 Vector-analyse

Basisstatistieken voor velden

Maakt basisstatistieken voor een veld van de attributentabel van een vectorlaag.
Velden numeriek, date, time en string worden ondersteund.
De teruggegeven statistieken zĳn afhankelĳk van het type veld.
Statistieken worden als een HTML-bestand gemaakt en zĳn beschikbaar in Processing ► Resultaten bekĳken.
Standaard menu: Vector ► Analyse-gereedschap
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Parameters

Label Naam Type Beschrijving
Invoer vector INPUT_LAYER [vector: elke] Vectorlaag waarvoor de statistieken moeten

worden berekend
Veld waarop
statistieken
moeten worden
berekend

FIELD_NAME [tabelveld: elk] Elk ondersteund tabelveld om de
statistieken voor te berekenen

Statistieken
Optioneel

OUTPUT_HTML_FILE[html]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van het bestand voor de
berekende statistieken. Één van:

• Uitvoer overslaan
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Beschrijving
Statistieken OUTPUT_HTML_FILE[html] HTML-bestand met de

berekende statistieken
Aantal COUNT [getal]
Aantal unieke waarden UNIQUE [getal]
Aantal lege (null) waarden EMPTY [getal]
Aantal niet-lege waarden FILLED [getal]
Minimum waarde MIN [hetzelfde als

invoer]
Maximum waarde MAX [hetzelfde als

invoer]
Minimum lengte MIN_LENGTH [getal]
Maximum lengte MAX_LENGTH [getal]
Gemiddelde lengte MEAN_LENGTH [getal]
Coëfficiënt van variatie CV [getal]
Som SUM [getal]
Gemiddelde waarde MEAN [getal]
Standaard afwĳking STD_DEV [getal]
Bereik RANGE [getal]
Mediaan MEDIAN [getal]
Minderheid (minst voorkomende
waarde)

MINORITY [hetzelfde als
invoer]

Meerderheid (meest frequent
voorkomende waarde)

MAJORITY [hetzelfde als
invoer]

Eerste kwartiel FIRSTQUARTILE [getal]
Derde kwartiel THIRDQUARTILE [getal]
Interkwartiel bereik (IQR) IQR [getal]
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Pythoncode

ID algoritme: qgis:basicstatisticsforfields

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Klimmen langs lijn

Berekent de totale klim en afdaling langs geometrieën lĳn. De invoerlaagmoet waarden Z hebben. Als er geenwaarden
Z beschikbaar zĳn, kan het algoritme Drape (Z-waarde instellen vanuit raster) worden gebruikt om waarden Z toe te
voegen vanuit een DEM-laag.
De uitvoerlaag is een kopie van de invoerlaag met aanvullende velden die de totale klim (climb), totale afdaling
(descent), de minimum hoogte (minelev) en de maximum hoogte (maxelev) bevatten voor elke geometrie
lĳn. Als de invoerlaag velden bevat met dezelfde namen als deze toegevoegde velden, zullen zĳ worden hernoemd
(veldnamen zullen worden gewĳzigd naar “name_2”, “name_3”, etc, totdat de eerste niet-duplicaat naam wordt
gevonden).

Parameters

Label Naam Type Beschrijving
Lĳnlaag INPUT [vector: lĳn] Lĳnlaag waaruit de kim moet worden

berekend. Moet waarden Z hebben
Klimlaag OUTPUT [vector: lĳn]

Standaard:
[Tijdelijke
laag maken]

Specificatie van de uitvoer (lĳn)laag. Één
van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Beschrijving
Klimlaag OUTPUT [vector: lĳn] Lĳnlaag die de nieuwe attributen bevat met

de resultaten uit de berekeningen voor het
klimmen.

Totale klim TOTALCLIMB [getal] De som van het klimmen voor alle
geometrieën lĳn in de invoerlaag

Totale afdaling TOTALDESCENT [getal] De som van het afdalen voor alle
geometrieën lĳn in de invoerlaag

Minimum hoogte MINELEVATION [getal] De minimum hoogte voor de geometrieën
in de laag

Maximum hoogte MAXELEVATION [getal] De maximum hoogte voor de geometrieën
in de laag

Pythoncode

ID algoritme: qgis:climbalongline

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Punten in polygonen tellen

Neemt een punt- en een polygoonlaag en telt het aantal punten van de puntlaag in elk van de polygonen van de
polygoonlaag.
Een nieuwe polygoonlaag wordt gemaakt, met exact dezelfde inhoud als de invoer polygoonlaag, maar met een extra
aanvullend veld met het aantal punten dat correspondeert met elke polygoon.
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Fig. 27.31: De labels in de polygonen geven de telling van de punten weer

Een optioneel veld voor weging kan worden gebruikt om gewicht toe te kennen aan elk punt. Als alternatief kan een
uniek klasseveld gespecificeerd worden. Als beide opties worden gebruikt zal het veld voor weging voorrang hebben
en zal het unieke klasseveld worden genegeerd.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten polygoon
Standaard menu: Vector ► Analyse-gereedschap

Parameters

Label Naam Type Beschrijving
Polygonen POLYGONS [vector: polygoon] Polygoonlaag waarvan de objecten zĳn

geassocieerd met de telling van de punten
die zĳ bevatten

Punten POINTS [vector: punt] Puntlaag waarvan de objecten moeten
worden geteld

Veld Gewicht
Optioneel

WEIGHT [tabelveld: elk] Een veld uit de puntenlaag. De verrichte
telling zal de som zĳn van het veld Gewicht
van de punten die zĳn opgenomen in
de polygoon. Als het veld Gewicht niet
numeriek is, zal de telling 0 zĳn.

Veld Klasse
Optioneel

CLASSFIELD [tabelveld: elk] Punten worden geclassificeerd gebaseerd
op het geselecteerde attribuut en indien er
verscheidene punten met dezelfde waarde
voor het attribuut binnen de polygoon
liggen, wordt er slechts één geteld. De
uiteindelĳke telling van de punten in een
polygoon is daarom het aantal verschillende
klassen dat daarin wordt aangetroffen.

Vervolgt op volgende pagina
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Tabel 27.88 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Naam veld voor
telling

FIELD [tekenreeks]
Standaard:
‘NUMPOINTS’

De naam van het veld om de telling van de
punten in op te slaan

Aantal OUTPUT [vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificatie van de uitvoerlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Aantal OUTPUT [vector: polygoon] Resulterende laag met de attributentabel die

de nieuwe kolom voor het tellen van de
punten bevat

Pythoncode

ID algoritme: native:countpointsinpolygon

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

DBSCAN clusteren

Clustert puntobjecten, gebaseerd op een 2D-implementatie van het algoritme Density-based spatial clustering of
applications with noise (DBSCAN).
Het algoritme vereist twee parameters, een minimum grootte voor de cluster, en de maximale toegestane afstand
tussen de geclusterde punten.
Zie ook:
ST-DBSCAN clusteren, Clusteren K-gemiddelde
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Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: punt] Laag om te analyseren
Minimale grootte
clusters

MIN_SIZE [getal]
Standaard: 5

Minimale aantal objecten om een cluster te
maken

Maximale afstand
tussen punten van
de cluster

EPS [getal]
Standaard: 1.0

Afstand waarboven twee objecten niet
kunnen behoren tot dezelfde cluster (eps)

Clusters OUTPUT [vector: punt]
Standaard:
[Tijdelijke
laag maken]

Specificeer de vectorlaag voor het resultaat
van het clusteren. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Gevorderde parameters

Label Naam Type Beschrijving
Randpunten
als vervuiling
beschouwen
(DBSCAN*)
Optioneel

DBSCAN* [Booleaanse
waarde]
Standaard: False

Indien geselecteerd worden punten op de
rand van een cluster op zichzelf beschouwd
als niet geclusterde punten, en alleen punten
binnen een cluster worden getagd als
geclusterd.

Naam veld voor
cluster

FIELD_NAME [tekenreeks]
Standaard:
‘CLUSTER_ID’

Naam van het veld waar het geassocieerde
nummer van de cluster moet worden
opgeslagen

Naam veld voor
grootte cluster

SIZE_FIELD_NAME[tekenreeks]
Standaard:
‘CLUSTER_SIZE’

Naam van het veld met het aantal objecten
in dezelfde cluster

Uitvoer

Label Naam Type Beschrijving
Clusters OUTPUT [vector: punt] Vectorlaag die de originele objecten bevat

met een veld die de cluster instelt waartoe
zĳ behoren

Aantal clusters NUM_CLUSTERS [getal] Aantal ontdekte clusters
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Pythoncode

ID algoritme: native:dbscanclustering

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Afstandsmatrix

Berekent voor puntobjecten afstanden tot hun dichtstbĳzĳnde objecten op dezelfde laag of op een andere laag.
Standaard menu: Vector ► Analyse-gereedschap

Zie ook:
Koppel attributen op dichtstbĳzĳnde

Parameters

Label Naam Type Beschrijving
Invoer puntenlaag INPUT [vector: punt] Puntlaag waarvoor de afstandsmatrix wordt

berekend (punten vanaf)
Invoer unieke ID-
veld

INPUT_FIELD [tabelveld: elk] Te gebruiken veld om objecten van de
invoerlaag uniek te kunnen identificeren.
Gebruikt in de attributentabel voor de
uitvoer.

Doel-puntenlaag TARGET [vector: punt] Puntenlaag die de gezochte dichtstbĳzĳnde
punt(en) bevat (punten tot)

Doel unieke
ID-veld

TARGET_FIELD [tabelveld: elk] Te gebruiken veld om objecten van de
doellaag uniek te kunnen identificeren.
Gebruikt in de attributentabel voor de
uitvoer.

Uitvoer
matrixtype

MATRIX_TYPE [enumeratie]
Standaard: 0

Verschillende typen berekening zĳn
beschikbaar:

• 0 — Lineaire (N * k x 3)
afstandsmatrix: rapporteert voor
elk invoerpunt de afstand tot elk van
de k dichtst bĳ gelegen doelpunten.
De matrix voor de uitvoer bestaat
uit maximaal k rĳen per invoerpunt,
en elke rĳ heeft drie kolommen:
InputID, TargetID en Distance.

• 1 — Standaard (N x T)
afstandsmatrix

• 2 — Samenvatting afstandsmatrix
(gemiddelde, std. afw., min, max):
rapporteert voor elk invoerpunt
statistieken over de afstanden tot zĳn
doelpunten.

Vervolgt op volgende pagina
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Tabel 27.91 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Alleen
dichtstbĳzĳnde
(k) doelpunten
gebruiken

NEAREST_POINTS [getal]
Standaard: 0

U kunt er voor kiezen om de afstanden
tot alle punten in de doellaag te berekenen
(0) of te beperken tot een aantal (k)
dichtstbĳzĳnde objecten.

Afstandsmatrix OUTPUT [vector: punt]
Standaard:
[Tijdelijke
laag maken]

Specificatie van de uitvoer vectorlaag. Één
van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Afstandsmatrix OUTPUT [vector: punt] Punt (of MultiPunt in het geval van de

“Lineaire (N * k x 3)”) vectorlaag die
de berekening van de afstand bevat voor
elk object van de invoer. De objecten
en attributentabel ervan zĳn afhankelĳk
van het geselecteerde matrixtype voor de
uitvoer.

Pythoncode

ID algoritme: qgis:distancematrix

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Afstand tot dichtstbijzijnde naaf (lijn naar naaf)

Maakt lĳnen die elk object van een invoer vector verbinden met het dichtstbĳzĳnde object in een doellaag. Afstanden
worden berekend op basis van het midden van elk object.
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Fig. 27.32: Geef de dichtstbijzijnde naaf weer voor de rode objecten voor invoer

Zie ook:
Afstand tot dichtstbĳzĳnde naaf (punten), Koppel attributen op dichtstbĳzĳnde
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Parameters

Label Naam Type Beschrijving
Bron puntenlaag INPUT [vector: elke] Vectorlaag waarvoor het dichtstbĳzĳnde

object wordt gezocht
Doel navenlaag HUBS [vector: elke] Vectorlaag die de objecten bevat waarnaar

gezocht moet worden
Naaflaag naam
attribuut

FIELD [tabelveld: elk] Te gebruiken veld om objecten van de
doellaag uniek te kunnen identificeren.
Gebruikt in de attributentabel voor de
uitvoer

Maateenheid UNIT [enumeratie]
Standaard: 0

Eenheden waarin de afstand tot het
dichtstbĳzĳnde object moet worden
gerapporteerd:

• 0 — Meters
• 1 — Voet
• 2 — Mĳlen
• 3 — Kilometers
• 4 — Laag-eenheden

Afstand tot hub OUTPUT [vector: lĳn]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer lĳnlaag die de
overeenkomende punten verbindt. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Afstand tot hub OUTPUT [vector: lĳn] Lĳn vectorlaag met de attributen van de

objecten voor de invoer, de identificatie
voor hun dichtstbĳzĳnde object en de
berekende afstand.

Pythoncode

ID algoritme: qgis:distancetonearesthublinetohub

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

27.1. QGIS algoritme provider 1159



QGIS Desktop 3.28 User Guide

Afstand tot dichtstbijzijnde naaf (punten)

Maakt een puntlaag die hetmidden van de invoerobjecten weergeeft, met als aanvulling twee velden die de identificatie
bevatten van het dichtstbĳzĳnde object (gebaseerd op zĳn middelpunt) en de afstand tussen de punten.
Zie ook:
Afstand tot dichtstbĳzĳnde naaf (lĳn naar naaf), Koppel attributen op dichtstbĳzĳnde

Parameters

Label Naam Type Beschrijving
Bron puntenlaag INPUT [vector: elke] Vectorlaag waarvoor het dichtstbĳzĳnde

object wordt gezocht
Doel navenlaag HUBS [vector: elke] Vectorlaag die de objecten bevat waarnaar

gezocht moet worden
Naaflaag naam
attribuut

FIELD [tabelveld: elk] Te gebruiken veld om objecten van de
doellaag uniek te kunnen identificeren.
Gebruikt in de attributentabel voor de
uitvoer

Maateenheid UNIT [enumeratie]
Standaard: 0

Eenheden waarin de afstand tot het
dichtstbĳzĳnde object moet worden
gerapporteerd:

• 0 — Meters
• 1 — Voet
• 2 — Mĳlen
• 3 — Kilometers
• 4 — Laag-eenheden

Afstand tot hub OUTPUT [vector: punt]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer punt vectorlaag met
de dichtstbĳzĳnde hub. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Afstand tot hub OUTPUT [vector: punt] Punt vectorlaag die het midden van de

bronobjecten met hun attributen, de
identificatie van het dichtstbĳzĳnde object
en hun berekende afstand weergeeft.
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Pythoncode

ID algoritme: qgis:distancetonearesthubpoints

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Samenvoegen op lijnen (naaflijnen)

Maakt naaf- en spaakdiagrammen door lĳnen uit punten op de spaaklaag te verbinden met overeenkomende punten
op de naaflaag.
Het bepalen van welke naaf naar elk punt gaat is gebaseerd op een overeenkomst in het Naaf ID-veld van de
naafpunten en het Spaak ID-veld van de spaakpunten.
Als invoerlagen geen puntlagen zĳn wordt een punt op de oppervlakte van de geometrieën genomen als de locatie om
te verbinden.
Optioneel kunnen geodetische lĳnen worden gemaakt, die het kortste pad weergeven op het oppervlak van een
ellipsoïde. Wanneer Geodetische lĳnen maken wordt gebruikt, is het mogelĳk de gemaakte lĳnen te splitsen op de
antimeridiaan (±180 graden longitude), wat het renderen van de lĳnen kan verbeteren. Aanvullend kan de afstand
tussen punten worden gespecificeerd. Een kleinere afstand resulteert in een dichter, meer nauwkeuriger lĳn.

Fig. 27.33: Punten koppelen, gebaseerd op een gedeeld veld / attribuut

Parameters

Basis parameters

Label Naam Type Beschrijving
Naaf puntlaag HUBS [vector: elke] Invoerlaag
Naaf ID-veld HUB_FIELD [tabelveld: elk] Veld van de naaflaag met samen te voegen

ID
Velden van naaflaag
om te kopiëren (laat
leeg om alle velden
te kopiëren)
Optioneel

HUB_FIELDS [tabelveld: elk]
[lĳst]

De veld(en) van de spaaklaag om
te kopiëren. Indien geen veld(en)
wordt/worden gekozen worden alle velden
genomen.

Vervolgt op volgende pagina
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Tabel 27.93 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Spaak puntlaag SPOKES [vector: elke] Aanvullende spaak puntlaag
Spaak ID-veld SPOKE_FIELD [tabelveld: elk] Veld van de spaaklaag met samen te voegen

ID
Velden van
spaaklaag om
te kopiëren (laat
leeg om alle velden
te kopiëren)
Optioneel

SPOKE_FIELDS [tabelveld: elk]
[lĳst]

Veld(en) van de spaaklaag om te kopiëren.
Indien geen velden worden gekozen worden
alle velden behouden.

Geodetische lĳnen
maken

GEODESIC [Booleaanse
waarde]
Standaard: False

Maak geodetische lĳnen (het kortste pad op
het oppervlak van een ellipsoïde)

Naaflĳnen OUTPUT [vector: lĳn]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer hub lĳn vectorlaag.
Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Gevorderde parameters

Label Naam Type Beschrijving
Afstand tussen
punten (alleen
geodetische lĳnen)

GEODESIC_DISTANCE[getal]
Standaard: 1000.0
(kilometers)

Afstand tussen opeenvolgende punten (in
kilometers). Een kleinere afstand resulteert
in een dichtere, meer nauwkeuriger lĳn

Splitst lĳnen op
de antimeridiaan
(±180 graden
longitude)

ANTIMERIDIAN_SPLIT[Booleaanse
waarde]
Standaard: False

Splitst lĳnen op ±180 graden longitude (om
renderen van de lĳnen te verbeteren)

Uitvoer

Label Naam Type Beschrijving
Naaflĳnen OUTPUT [vector: lĳn] De resulterende lĳnlaag die

overeenkomende punten in invoerlagen
verbindt
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Pythoncode

ID algoritme: native:hublines

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Clusteren K-gemiddelde

Berekent het op 2D-afstand gebaseerde K-gemiddelde nummer voor de cluster voor elk invoerobject.
Clusteren op K-gemiddelde heeft tot doel de objecten op te delen in K clusters, waarin elk object behoort tot de cluster
met het dichtstbĳ gelegen gemiddelde. Het gemiddelde punt wordt weergegeven door het massamiddelpunt van de
geclusterde objecten.
Als invoergeometrieën lĳnen of polygonen zĳn, wordt het clusteren gebaseerd op het zwaartepunt van het object.
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Fig. 27.34: Een vijf klassen punt clusters

Zie ook:
DBSCAN clusteren, ST-DBSCAN clusteren
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Laag om te analyseren
Aantal clusters CLUSTERS [getal]

Standaard: 5
Aantal te maken clusters met de objecten

Clusters OUTPUT [vector: elke]
Standaard:
[Tĳdelĳke laag
maken]

Specificeer de uitvoer vectorlaag voor de
gemaakte clusters. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Gevorderde parameters

Label Naam Type Beschrijving
Naam veld voor
cluster

FIELD_NAME [tekenreeks]
Standaard:
‘CLUSTER_ID’

Naam van het veld waar het geassocieerde
nummer van de cluster moet worden
opgeslagen

Naam veld voor
grootte cluster

SIZE_FIELD_NAME[tekenreeks]
Standaard:
‘CLUSTER_SIZE’

Naam van het veld met het aantal objecten
in dezelfde cluster

Uitvoer

Label Naam Type Beschrijving
Clusters OUTPUT [vector: elke] Vectorlaag die de originele objecten bevat

met velden die de cluster specificeert
waartoe zĳ behoren en hun nummer erin

Pythoncode

ID algoritme: native:kmeansclustering

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Lijst unieke waarden

Vermeldt unieke waarden van een veld in een attributentabel en telt hun aantal.
Standaard menu: Vector ► Analyse-gereedschap

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Laag om te analyseren
Doelveld(en) FIELDS [tabelveld: elk] Veld om te analyseren
Unieke waarden
Optioneel

OUTPUT [tabel]
Standaard:
[Tĳdelĳke laag
maken]

Specificeer de samenvattende tabellaag met
unieke waarden. Één van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

HTMLrapport
Optioneel

OUTPUT_HTML_FILE[html]
Standaard:
[Opslaan naar
tijdelijk
bestand]

HTML-rapport van unieke waarden in de
Processing ► Resultaten bekĳken. Één van:

• Uitvoer overslaan
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Beschrijving
Unieke waarden OUTPUT [tabel] Overzicht tabellaag met unieke waarden
HTMLrapport OUTPUT_HTML_FILE[html] HTML-rapport van unieke waarden. Kan

worden geopend in Processing► Resultaten
bekĳken.

Totaal unieke
waarden

TOTAL_VALUES [getal] Het aantal unieke waarden in het invoerveld

Unieke waarden
samengevoegd

UNIQUE_VALUES [tekenreeks] Een tekenreeks met de kommagescheiden
lĳst van unieke waarden, gevonden in het
invoerveld

Pythoncode

ID algoritme: qgis:listuniquevalues

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Gemiddelde coördina(a)t(en)

Berekent een puntlaag met het massamiddelpunt van de geometrieën op de invoerlaag.
Een attribuut kan worden gespecificeerd om het gewicht te bevatten dat aan elk object moet worden toegekend bĳ
het berekenen van het massacentrum.
Als een attribuut is geselecteerd in de parameter, zullen objecten worden gegroepeerd overeenkomstig de waarden in
dit veld. In plaats van één enkel punt met het massacentrum van de gehele laag, zal de uitvoerlaag een massacentrum
bevatten van de objecten voor elke categorie.
Standaard menu: Vector ► Analyse-gereedschap

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Veld Gewicht
Optioneel

WEIGHT [tabelveld:
numeriek]

Te gebruiken veld als u een gewogen
gemiddelde wilt uitvoeren

Uniek ID-veld UID [tabelveld:
numeriek]

Uniek veld waarop het berekenen van het
gemiddelde zal worden uitgevoerd

Gemiddelde
coördinaten

OUTPUT [vector: punt]
Standaard:
[Tĳdelĳke laag
maken]

Specificeer de (punt vector)laag voor het
resultaat. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Gemiddelde
coördinaten

OUTPUT [vector: punt] Resulterende punt(en)laag

Pythoncode

ID algoritme: native:meancoordinates

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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‘Dichtstbijzijnde buur’-analyse

Voert een analyse Nearest neighbor uit op een puntenlaag. De uitvoer vertelt u hou uw gegevens zĳn verdeeld
(geclusterd, willekeurig of verdeeld).
Uitvoer wordt gemaakt als een HTML-bestand met de berekende statistische waarden:

• Aangetroffen gemiddelde afstand
• Verwachtte gemiddelde afstand
• ‘Nearest neighbour’-index
• Aantal punten
• Z-score: Vergelĳken van de Z-score met de normale verdeling vertelt u hoe uw gegevens zĳn verdeeld. Een lage
Z-score betekent dat de gegevens waarschĳnlĳk niet het resultaat zĳn van een ruimtelĳk willekeurig proces,
terwĳl een hoge Z-score betekent dat uw gegevens waarschĳnlĳk het resultaat zĳn van een ruimtelĳkwillekeurig
proces.

Standaard menu: Vector ► Analyse-gereedschap

Zie ook:
Koppel attributen op dichtstbĳzĳnde
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: punt] Punt vectorlaag waarvoor de statistieken

moeten worden berekend
Dichtstbĳzĳnde
buur
Optioneel

OUTPUT_HTML_FILE[html]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van het HTML-bestand voor de
berekende statistieken. Één van:

• Uitvoer overslaan
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Beschrijving
Dichtstbĳzĳnde
buur

OUTPUT_HTML_FILE[html] HTML-bestand met de berekende
statistieken

Aangetroffen
gemiddelde
afstand

OBSERVED_MD [getal] Aangetroffen gemiddelde afstand

Verwachtte
gemiddelde
afstand

EXPECTED_MD [getal] Verwachtte gemiddelde afstand

‘Nearest
neighbour’-index

NN_INDEX [getal] ‘Nearest neighbour’-index

Aantal punten POINT_COUNT [getal] Aantal punten
Z-score Z_SCORE [getal] Z-score

Pythoncode

ID algoritme: native:nearestneighbouranalysis

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Analyse Overlappen

Berekent het gebied en het bedekkingspercentage waarmee objecten op een invoerlaag worden overlapt door objecten
uit een selectie van overleglagen.
Nieuwe attributen worden toegevoegd aan de uitvoerlaag die het totale overlappende gebied aangeven en het
percentage van de invoerobjecten die worden overlapt door elk van de geselecteerde overleglagen.

27.1. QGIS algoritme provider 1169



QGIS Desktop 3.28 User Guide

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] De invoerlaag.
Overleglagen LAYERS [vector: elke] [lĳst] De over te leggen lagen.
Overlapt OUTPUT [hetzelfde als

invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Gevorderde parameters

Label Naam Type Beschrijving
Rastergrootte
NEW in 3.28
Optioneel

GRID_SIZE [getal]
Standaard: Niet
ingesteld

Indien opgegeven worden de geometrieën
voor de invoer gesnapt aan een raster van
de opgegeven grootte, en de resulterende
punten worden berekend op datzelfde
raster. Vereist GEOS 3.9.0 of hoger.

Uitvoer

Label Naam Type Beschrijving
Overlapt OUTPUT [hetzelfde als

invoer]
De uitvoerlaag met aanvullende velden
die de overlapping rapporteren (in
kaarteenheden en percentage) van het
invoerobject, overlapt door elk van de
geselecteerde lagen.

Pythoncode

ID algoritme: native:calculatevectoroverlaps

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Kortste lijn tussen objecten

NEW in 3.24

Maakt een lĳnlaag als de kortste lĳn tussen de bron- en de doellaag. Standaard wordt alleen rekening gehouden
met het eerste dichtstbĳzĳnde object van de doellaag. Het nummer voor het n-dichtstbĳzĳnde object kan worden
gespecificeerd. Als een maximale afstand is gespecificeerd, dan worden alleen objecten die dichterbĳ liggen dan die
afstand worden overwogen.
De objecten voor de uitvoer zullen alle attribuutwaarden van de bronlaag bevatten, alle attributen van het n-
dichtstbĳzĳnde object en het aanvullende veld voor de afstand.

Belangrĳk: Dit algoritme gebruikt alleen maar Cartesiaanse berekeningen voor afstand, en neemt geen geodetische
of ellipsoïde eigenschappen in overweging bĳ het bepalen van de nabĳheid van objecten. De maateenheid en het
coördinatensysteem zĳn gebaseerd op het coördinatensysteem van de bronlaag.

Fig. 27.35: Kortste lijn van objecten punt naar lijnen
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Parameters

Label Naam Type Beschrijving
Bronlaag SOURCE [vector: elke] Laag van waaruit gezocht moet worden naar

dichtstbĳzĳnde buren
Doellaag DESTINATION [vector: elke] Laag waarin gezocht moet worden naar

dichtstbĳzĳnde buren
Methode METHOD [enumeratie]

Standaard: 0
Methode voor berekening van de kortst
mogelĳke afstand. Mogelĳke waarden zĳn:

• 0— Afstand tot dichtstbĳzĳnde punt
op object

• 1 — Afstand tot zwaartepunt van
object

Maximum aantal
buren

NEIGHBORS [getal]
Standaard: 1

Maximale aantal buren om naar te zoeken

Maximum afstand
Optioneel

DISTANCE [getal] Alleen objecten die dichterbĳ liggen dan
deze afstand zullen in overweging worden
genomen.

Kortste lĳnen OUTPUT [vector: lĳn]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Uitvoerlaag OUTPUT [vector: lĳn] Lĳn vectorlaag die bronobjecten

samenvoegt met hun dichtstbĳzĳnde
bu(u)r(en) in de doellaag. Bevat alle
attributen voor zowel de bron- als de
doelobjecten, en de berekende afstand.

Pythoncode

ID algoritme: native:shortestline

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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ST-DBSCAN clusteren

Clustert puntobjecten, gebaseerd op een 2D-implementatie van het tĳdruimte algoritme Density-based clustering of
applications with noise (ST-DBSCAN).
Zie ook:
DBSCAN clusteren, Clusteren K-gemiddelde

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: punt] Laag om te analyseren
Datum/tĳd veld DATETIME_FIELD [tabelveld: datum] Veld dat de informatie over tĳd bevat
Minimale grootte
clusters

MIN_SIZE [getal]
Standaard: 5

Minimale aantal objecten om een cluster te
maken

Maximale afstand
tussen punten van
de cluster

EPS [getal]
Standaard: 1.0

Afstand waarboven twee objecten niet
kunnen behoren tot dezelfde cluster (eps)

Maximale
tĳdsduur tussen
geclusterde
punten

EPS2 [getal]
Standaard: 0.0
(dagen)

Tĳdsduur waarbuiten twee objecten niet
kunnen behoren tot dezelfde cluster (eps2).
Beschikbare eenheden voor tĳd zĳn
milliseconden, seconden, minuten, uren,
dagen en weken.

Clusters OUTPUT [vector: punt]
Standaard:
[Tijdelijke
laag maken]

Specificeer de vectorlaag voor het resultaat
van het clusteren. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Gevorderde parameters

Label Naam Type Beschrijving
Randpunten
als vervuiling
beschouwen
(DBSCAN*)
Optioneel

DBSCAN* [Booleaanse
waarde]
Standaard: False

Indien geselecteerd worden punten op de
rand van een cluster op zichzelf beschouwd
als niet geclusterde punten, en alleen punten
binnen een cluster worden getagd als
geclusterd.

Naam veld voor
cluster

FIELD_NAME [tekenreeks]
Standaard:
‘CLUSTER_ID’

Naam van het veld waar het geassocieerde
nummer van de cluster moet worden
opgeslagen

Naam veld voor
grootte cluster

SIZE_FIELD_NAME[tekenreeks]
Standaard:
‘CLUSTER_SIZE’

Naam van het veld met het aantal objecten
in dezelfde cluster
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Uitvoer

Label Naam Type Beschrijving
Clusters OUTPUT [vector: punt] Vectorlaag die de originele objecten bevat

met een veld die de cluster instelt waartoe
zĳ behoren

Aantal clusters NUM_CLUSTERS [getal] Aantal ontdekte clusters

Pythoncode

ID algoritme: native:stdbscanclustering

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Statistieken op categorieën

Berekent statistieken van velden, afhankelĳk van een ouderklasse. De ouderklasse is een combinatie van waarden uit
andere velden.

Parameters

Label Naam Type Beschrijving
Invoer vectorlaag INPUT [vector: elke] Invoer vectorlaag met unieke klassen en

waarden
Veld waarop
statistieken
moeten worden
berekend (indien
leeg wordt alleen
aantal berekend)
Optioneel

VALUES_FIELD_NAME[tabelveld: elk] Indien leeg zal alleen het aantal worden
berekend

Veld(en) met
categorieën

CATEGORIES_FIELD_NAME[vector: elke] [lĳst] De velden die (gecombineerd) de
categorieën definiëren

Statistieken op
categorie

OUTPUT [tabel]
Standaard:
[Tijdelijke
laag maken]

Specificatie van de uitvoertabel voor de
berekende statistieken. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Beschrijving
Statistieken op
categorie

OUTPUT [tabel] Tabel die de statistieken bevat

Afhankelĳk van het veld dat wordt geanalyseerd, worden de volgende statistieken teruggegeven voor elke
gegroepeerde waarde:

Statistieken Tekenreeks Numeriek Datum

Aantal (COUNT)
Unieke waarden (UNIQUE)
Lege (Null) waarden (EMPTY)
Niet-lege waarden (FILLED)
Minimale waarde (MIN)
Maximale waarde (MAX)
Bereik (RANGE)
Som (SUM)
Gemiddelde waarde (MEAN)
Waarde mediaan (MEDIAN)
Standaardafwĳking (STD_DEV)
Coëfficiënt van variatie (CV)
Minderheid (minst voorkomende waarde - MINORITY)
Meerderheid (meest voorkomende waarde - MAJORITY)
Eerste kwartiel (FIRSTQUARTILE)
Derde kwartiel (THIRDQUARTILE)
Interkwartiel bereik (IQR)
Minimum lengte (MIN_LENGTH)
Gemiddelde lengte (MEAN_LENGTH)
Maximum lengte (MAX_LENGTH)

Pythoncode

ID algoritme: qgis:statisticsbycategories

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Lijnlengtes sommeren

Neemt een polygoonlaag en een lĳnlaag en meet de totale lengte van de lĳnen en het totale aantal daarvan dat elke
polygoon kruist.
De resulterende laag heeft dezelfde objecten als de invoer polygoonlaag, maar met twee aanvullende attributen die de
lengte van en het aantal lĳnen bevatten voor elke polygoon.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten polygoon
Standaard menu: Vector ► Analyse-gereedschap

Parameters

Label Naam Type Beschrijving
Lĳnen LINES [vector: lĳn] Invoer lĳn vectorlaag
Polygonen POLYGONS [vector: polygoon] Polygoon vectorlaag
Veldnaam voor
lengte lĳnen

LEN_FIELD [tekenreeks]
Standaard:
‘LENGTH’

Naam van het veld voor de lengten van de
lĳnen

Veldnaam voor
aantal lĳnen

COUNT_FIELD [tekenreeks]
Standaard:
‘COUNT’

Naam van het veld voor de telling van de
lĳnen

Lĳn lengte OUTPUT [vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer polygoonlaag met de
gemaakte statistieken. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Lĳn lengte OUTPUT [vector: polygoon] Polygoon uitvoerlaag met velden voor

lengten van lĳnen en aantal lĳnen

Pythoncode

ID algoritme: native:sumlinelengths

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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27.1.16 Vector maken

Array van verschoven (parallelle) lijnen

Maakt kopieën van lĳnobjecten in een laag, door meerdere verschoven versies van elk object te maken. Elke kopie
wordt oplopend verschoven met een gespecificeerde afstand.
Positieve afstanden verschuiven lĳnen naar links, en negatieve afstanden zullen ze naar rechts verschuiven.

Fig. 27.36: In blauw de bronlaag, in rood de verschoven lijn

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten lĳn
Zie ook:
Verspringing lĳnen, Array van getransleerde objecten

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn] Invoer lĳn vectorlaag om te gebruiken voor

de verschuivingen.

Aantal te maken
objecten

COUNT [getal ]
Standaard: 10

Aantal te maken verschoven kopieën voor
elk object

Stap afstand
verspringing

OFFSET [getal ]
Standaard: 1.0

Afstand tussen twee opeenvolgende
verschoven kopieën

Verschuiving
lĳnen

OUTPUT [vector: lĳn]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer lĳnlaag met
verschoven objecten. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.
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Gevorderde parameters

Label Naam Type Beschrijving
Segmenten SEGMENTS [getal]

Standaard: 8
Aantal te gebruiken lĳnsegmenten om een
kwart cirkel te benaderen bĳ het maken van
afgeronde verschuivingen

Verbindingsstĳl JOIN_STYLE [enumeratie]
Standaard: 0

Specificeert of ronde, hoekige of puntige
verbindingsstĳlen zouden moeten worden
gebruikt bĳ het verschuiven van hoeken in
een lĳn. Één van:

• 0 — Rond
• 1 — Puntig
• 2 — Hoekig

Fig. 27.37: Ronde, diagonale en schuine
koppelstĳlen

Maximale
puntlengte bĳ
scherpe hoeken

MITER_LIMIT [getal]
Standaard: 2.0

Stelt de maximale afstand van de
te gebruiken geometrie voor de
verschuiving bĳ het maken van een
puntige verbindingsstĳl in als een factor
van de afstand van de verschuiving
(alleen van toepassing voor puntige
verbindingsstĳlen). Minimum: 1.0

Fig. 27.38: Een buffer van 10m met een
limiet van 2 en een buffer van 10m met een
limiet van 1

Uitvoer

Label Naam Type Beschrijving
Verschuiving
lĳnen

OUTPUT [vector: lĳn] Uitvoer lĳnlaag met de verschoven
objecten. De originele objecten worden ook
gekopieerd.
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Pythoncode

ID algoritme: native:arrayoffsetlines

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Array van getransleerde objecten

Maakt kopieën van objecten in een laag door meerdere getransleerde versies van elk object te maken. Elke kopie
wordt oplopend verplaatst met een vooraf opgegeven hoeveelheid op de X-, Y- en/of Z-as.
Waarden M die aanwezig zĳn in de geometrie kunnen ook worden getransleerd.

Fig. 27.39: Invoerlagen in blauwe tinten, uitvoerlagen met vertaalde objecten in rode tinten

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt, lĳn en polygoon
Zie ook:
Transleren, Array van verschoven (parallelle) lĳnen

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Te transleren invoer vectorlaag

Aantal te maken
objecten

COUNT [getal ]
Standaard: 10

Aantal te maken kopieën voor elk object

Vervolgt op volgende pagina
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Tabel 27.103 – Vervolgd van vorige pagina
Label Naam Type Beschrijving

Stap afstand (X-
as)

DELTA_X [getal ]
Standaard: 0.0

Toe te passen verplaatsing op de X-as

Stap afstand (Y-
as)

DELTA_Y [getal ]
Standaard: 0.0

Toe te passen verplaatsing op de Y-as

Stap afstand (Z-
as)

DELTA_Z [getal ]
Standaard: 0.0

Toe te passen verplaatsing op de Z-as

Stap afstand (M-
waarden)

DELTA_M [getal ]
Standaard: 0.0

Toe te passen verplaatsing op M

Translatie OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Uitvoer lĳnlaag met de getransleerde
(verplaatste) kopieën van de objecten. De
originele objecten worden ook gekopieerd.
Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Translatie OUTPUT [hetzelfde als

invoer]
Uitvoer lĳnlaag met de getransleerde
(verplaatste) kopieën van de objecten. De
originele objecten worden ook gekopieerd.

Pythoncode

ID algoritme: native:arraytranslatedfeatures

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Grid maken

Maakt een vectorlaag met een raster dat een opgegeven bereik bedekt. Rastercellen mogen een verschillende vorm
hebben:

Fig. 27.40: Verschillende vormen rastercellen

De grootte van elk element in het raster wordt gedefinieerd met een horizontale en verticale afstand.
Het CRS voor de uitvoerlaag moet worden gedefinieerd.
Het bereik van het raster en de waarden voor de afstanden moeten worden opgegeven in de coördinaten en eenheden
van dit CRS.
Standaard menu: Vector ► Onderzoeksgereedschap

Parameters

Label Naam Type Beschrijving
Type raster TYPE [enumeratie]

Standaard: 0
Vorm van het raster. Één van:

• 0 — Punt
• 1 — Lĳn
• 2 — Rechthoek (polygoon)
• 3 — Diamant (polygoon)
• 4 — Hexagoon (polygoon)

Vervolgt op volgende pagina

27.1. QGIS algoritme provider 1181



QGIS Desktop 3.28 User Guide

Tabel 27.104 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Bereik raster EXTENT [bereik] Bereik van het raster

Beschikbare methoden zĳn:
• Uit laag berekenen…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

Horizontale
afstand

HSPACING [getal]
Standaard: 1.0

Grootte van een rastercel op de X-as

Verticale afstand VSPACING [getal]
Standaard: 1.0

Grootte van een rastercel op de Y-as

Horizontale
overlegging

HOVERLAY [getal]
Standaard: 0.0

Maximale afstand voor overleggen tussen
twee opeenvolgende rastercellen op de X-as

Verticale
overlegging

VOVERLAY [getal]
Standaard: 0.0

Maximale afstand voor overleggen tussen
twee opeenvolgende rastercellen op de Y-as

CRS raster CRS [crs]
Standaard: project
CRS

Op het raster toe te passen coördinaten
referentiesysteem

Raster OUTPUT [vector: elke]
Standaard:
[Tijdelijke
laag maken]

Resulterende vector rasterlaag. Eén van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Raster OUTPUT [vector: elke] Resulterende vector rasterlaag. Het type

geometrie voor de uitvoer (punt, lĳn of
polygoon) is afhankelĳk van het Type
raster.

1182 Hoofdstuk 27. Processing providers en algoritmes



QGIS Desktop 3.28 User Guide

Pythoncode

ID algoritme: native:creategrid

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Puntenlaag uit tabel maken

Maakt een puntenlaag uit een tabel met kolommen die velden voor coördinaten bevatten.
Naast X- en Y-coördinaten kunt u ook velden Z en M specificeren.

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag of een tabel.
X-veld XFIELD [tabelveld: elk] Veld dat de X-coördinaat bevat
Y-veld YFIELD [tabelveld: elk] Veld dat de Y-coördinaat bevat
Z-veld
Optioneel

ZFIELD [tabelveld: elk] Veld dat de Z-coördinaat bevat

M-veld
Optioneel

MFIELD [tabelveld: elk] Veld dat de waarde M bevat

Doel-CRS TARGET_CRS [crs]
Standaard:
EPSG:4326

Coördinaten referentiesysteem te gebruiken
voor de laag. Voor opgegeven coördinaten
wordt aangenomen dat zĳ conform zĳn.

Punten uit tabel OUTPUT [vector: punt]
Standaard:
[Tijdelijke
laag maken]

Specificeer de resulterende puntlaag. Één
van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Punten uit tabel OUTPUT [vector: punt] De resulterende puntlaag
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Pythoncode

ID algoritme: native:createpointslayerfromtable

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Genereer punten (pixel centroïden) langs lijn

Maakt een punt vectorlaag uit een invoerraster en lĳnlaag.
De punten corresponderen met de zwaartepunten van de pixels die de lĳnlaag kruisen.

Fig. 27.41: Punten van de zwaartepunten van de pixels

Parameters

Label Naam Type Beschrijving
Rasterlaag INPUT_RASTER [raster] Invoer rasterlaag
Vectorlaag INPUT_VECTOR [vector: lĳn] Invoer lĳn-vectorlaag
Punten langs lĳn OUTPUT [vector: punt]

Standaard:
[Tijdelijke
laag maken]

De resulterende puntlaag van
zwaartepunten van pixels. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Beschrijving
Punten langs lĳn OUTPUT [vector: punt] De resulterende puntlaag van

zwaartepunten van pixels

Pythoncode

ID algoritme: qgis:generatepointspixelcentroidsalongline

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Genereer punten (pixel centroïden) binnen polygonen

Maakt een punt vectorlaag uit een invoerraster en polygoonlaag.
De punten corresponderen met de zwaartepunten van de pixels die de polygoonlaag kruisen.
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Fig. 27.42: Punten van de zwaartepunten van de pixels
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Parameters

Label Naam Type Beschrijving
Rasterlaag INPUT_RASTER [raster] Invoer rasterlaag
Vectorlaag INPUT_VECTOR [vector: polygoon] Invoer polygoon-vectorlaag
Punten binnen
polygonen

OUTPUT [vector: punt]
Standaard:
[Tijdelijke
laag maken]

De resulterende puntlaag van
zwaartepunten van pixels. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Punten binnen
polygonen

OUTPUT [vector: punt] De resulterende puntlaag van
zwaartepunten van pixels.

Pythoncode

ID algoritme: native:generatepointspixelcentroidsinsidepolygons

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Foto’s met geoverwijzingen importeren

Maakt een puntlaag die correspondeert met de locaties met geoverwĳzingen van JPEG-afbeeldingen in een bronmap.
De puntlaag zal één enkel PuntZ-object bevatten per invoerbestand van waaruit de geotags kunnen worden gelezen.
Informatie voor de hoogte uit de geotags zal worden gebruikt om de waarde Z van het punt in te stellen.
Naast lengte- en breedtegraad, kan ook informatie over hoogte, richting en tĳdstempel, indien aanwezig in de foto,
aan het punt worden toegevoegd als attributen.
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Parameters

Label Naam Type Beschrijving
Map voor invoer FOLDER [map] Pad naar de bronmap die de foto’s met

geoverwĳzingen bevat
Recursief scannen RECURSIVE [Booleaanse

waarde]
Standaard: False

Indien geselecteerd zullen de map en zĳn
submappen worden gescand

Foto’s
Optioneel

OUTPUT [vector: punt]
Standaard:
[Tijdelijke
laag maken]

Specificeer de punt vectorlaag voor de
foto’s met geoverwĳzingen. Één van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Ongeldige
fototabel
Optioneel

INVALID [tabel]
Standaard:
[Uitvoer
overslaan]

Specificeer de tabel van niet te lezen of
foto’s zonder geoverwĳzingen. Één van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Foto’s OUTPUT [vector: punt] Punt vectorlaag met foto’s met

geoverwĳzingen. Het formulier van
de laag wordt automatisch gevuld met
instellingen voor paden en voorbeelden van
de foto’s.

Ongeldige
fototabel
Optioneel

INVALID [tabel] Een tabel van niet te lezen of foto’s zonder
geoverwĳzingen kan ook worden gemaakt.

Pythoncode

ID algoritme: native:importphotos

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Punten naar pad

Converteert een puntenlaag naar een lĳnlaag, door punten samen te voegen in een volgorde die is gedefinieerd door
een expressie of een veld in de invoer puntenlaag.
Punten mogen worden gegroepeerd door een veld of een expressie om lĳn-objecten te onderscheiden.
In aanvulling op de lĳn vectorlaag wordt een tekstbestand uitgevoerd dat de resulterende lĳn als beginpunt beschrĳft
en een reeks peilingen / richtingen (relatief ten opzichte van het azimut) en afstanden.

Parameters

Label Naam Type Beschrijving
Invoer puntlaag INPUT [vector: punt] Invoer punt-vectorlaag
Gesloten paden
maken

CLOSE_PATH [Booleaanse
waarde]
Standaard: False

Indien geselecteerd zullen het eerste en
laatste punt van de lĳn worden verbonden
en het gemaakte pad sluiten

Expressie voor
volgorde
Optioneel

ORDER_EXPRESSION[expressie] Veld of expressie die de volgorde verschaft
voor het verbinden van de punten in het
pad. Indien niet ingesteld wordt het object-
ID ($id) gebruikt.

Tekst die getallen
bevat natuurlĳk
sorteren
Optioneel

NATURAL_SORT [Booleaanse
waarde]
Standaard: False

Indien geselecteerd worden de objecten
natuurlĳk gesorteerd, gebaseerd op de
opgegeven expressie (d.i. ‘a9’ < ‘a10’).

Expressie
groeperen pad
Optioneel

GROUP_EXPRESSION[expressie] Puntobjecten met dezelfde waarde in
het veld of expressie zullen worden
gegroepeerd in dezelfde lĳn. Indien niet
ingesteld wordt één enkel pad getekend met
alle punten van de invoer.

Paden OUTPUT [vector: lĳn]
Standaard:
[Tijdelijke
laag maken]

Specificeer de lĳn vectorlaag voor het pad.
Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Folder voor
tekstuitvoer
Optioneel

OUTPUT_TEXT_DIR[map]
Standaard:
[Uitvoer
overslaan]

Specificeer de map die de bestanden voor
het beschrĳven van bestanden of punten en
paden zal bevatten. Één van:

• Uitvoer overslaan
• Opslaan in tĳdelĳke map
• Opslaan naar map
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Uitvoer

Label Naam Type Beschrijving
Paden OUTPUT [vector: lĳn] Lĳn vectorlaag van het pad
Folder voor
tekstuitvoer

OUTPUT_TEXT_DIR[map] Map die de bestanden voor beschrĳven van
punten en paden bevat

Pythoncode

ID algoritme: native:pointstopath

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Willekeurige punten langs lijn

Maakt een nieuwe puntlaag, met punten geplaatst op de lĳnen van een andere laag.
Voor elke lĳn op de invoerlaag wordt een opgegeven aantal punten toegevoegd aan de resulterende laag. De procedure
voor het toevoegen van een punt is:

1. selecteer willekeurig een lĳnobject uit de invoerlaag
2. als het object meerdelig is, selecteer dan een willekeurig deel ervan
3. selecteer willekeurig een segment van die lĳn
4. selecteer willekeurig een positie op dat segment

De procedure betekent dat gebogen delen van de lĳnen (met relatief korte segmenten) meer punten zal hebben dan
rechte gedeelten (met relatief lange segmenten), zoals gedemonstreerd in de afbeelding hieronder, waar de uitvoer
van het algoritmeWillekeurige punten langs lĳn kan worden vergeleken met de uitvoer van het algoritmeWillekeurige
punten op lĳnen (dat punten produceert met een, gemiddeld, gelĳke verdeling langs de lĳnen).

Fig. 27.43: Voorbeeld uitvoer algoritme. Links:Willekeurige punten langs lijn, rechts:Willekeurige punten op lijnen
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Een minimale afstand kan worden gespecificeerd, om te vermĳden dat punten te dicht op elkaar worden geplaatst.
Zie ook:
Willekeurige punten op lĳnen

Parameters

Label Naam Type Beschrijving
Invoer puntlaag INPUT [vector: lĳn] Invoer lĳn-vectorlaag
Aantal punten POINTS_NUMBER [getal]

Standaard: 1
Aantal te maken punten

Minimale afstand
tussen punten

MIN_DISTANCE [getal]
Standaard: 0.0

De minimale afstand tussen punten

Willekeurige
punten

OUTPUT [vector: punt]
Standaard:
[Tijdelijke
laag maken]

De uitvoer willekeurige punten. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Willekeurige
punten

OUTPUT [vector: punt] De uitvoer willekeurige puntlaag

Pythoncode

ID algoritme: qgis:qgisrandompointsalongline

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Willekeurige punten in bereik

Maakt een nieuwe puntlaag met een opgegeven aantal willekeurige punten, alle binnen een opgegeven bereik.
Een afstandsfactor kan worden gespecificeerd, om te vermĳden dat punten te dicht bĳ elkaar staan. Als de minimale
afstand tussen punten het onmogelĳk maakt nieuwe punten te maken, kan ofwel de afstand worden verkleind of het
maximale aantal pogingen kan worden vergroot.
Standaard menu: Vector ► Onderzoeksgereedschap
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Parameters

Basis parameters

Label Naam Type Beschrijving
Bereik invoer EXTENT [bereik] Kaartbereik voor de willekeurige punten

Beschikbare methoden zĳn:
• Uit laag berekenen…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

Aantal punten POINTS_NUMBER [getal]
Standaard: 1

Aantal te maken punten

Minimale afstand
tussen punten

MIN_DISTANCE [getal]
Standaard: 0.0

De minimale afstand tussen punten

Doel-CRS TARGET_CRS [crs]
Standaard: project
CRS

CRS van de laag met willekeurige punten

Willekeurige
punten

OUTPUT [vector: punt]
Standaard:
[Tijdelijke
laag maken]

De uitvoer willekeurige punten. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Gevorderde parameters

Label Naam Type Beschrijving
Maximale aantal
zoekpogingen,
gegeven de
minimale afstand

MAX_ATTEMPTS [getal]
Standaard: 200

Maximale aantal pogingen om punten te
plaatsen
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Uitvoer

Label Naam Type Beschrijving
Willekeurige
punten

OUTPUT [vector: punt] De uitvoer willekeurige puntlaag

Pythoncode

ID algoritme: native:randompointsinextent

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Willekeurige punten binnen grenzen van laag

Maakt een nieuwe puntlaag met een opgegeven aantal willekeurige punten, alle binnen het bereik van een opgegeven
laag.
Een minimale afstand kan worden gespecificeerd, om te vermĳden dat punten te dicht op elkaar worden geplaatst.
Standaard menu: Vector ► Onderzoeksgereedschap

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: polygoon] Invoer polygoonlaag die het gebied

definieert
Aantal punten POINTS_NUMBER [getal]

Standaard: 1
Aantal te maken punten

Minimale afstand
tussen punten

MIN_DISTANCE [getal]
Standaard: 0.0

De minimale afstand tussen punten

Willekeurige
punten

OUTPUT [vector: punt]
Standaard:
[Tijdelijke
laag maken]

De uitvoer willekeurige punten. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Beschrijving
Willekeurige
punten

OUTPUT [vector: punt] De uitvoer willekeurige puntlaag

Pythoncode

ID algoritme: qgis:randompointsinlayerbounds

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Willekeurige punten in polygonen

Maakt een puntlaag met punten geplaatst in de polygonen van een andere laag.
Voor elk object geometrie, (polygoon / multipolygoon), op de invoerlaag wordt het opgegeven aantal punten
toegevoegd aan de resulterende laag.
Per object en globale minimale afstanden kunnen worden gespecificeerd om te vermĳden dat punten te dicht bĳ elkaar
komen te staan in de uitvoer puntlaag. Als een minimale afstand is gespecificeerd, zou het misschien niet mogelĳk
kunnen zĳn om het gespecificeerde aantal punten voor elk object te maken. Het totale aantal gemaakte punten en
ontbrekende punten zĳn als uitvoer van het algoritme beschikbaar.
De afbeelding hieronder geeft het effect per object en globale minimale afstanden weer en nul/niet-nul minimale
afstanden (gemaakt met hetzelfde zaad zodat tenminste het eerste gemaakte punt hetzelfde is).

Fig. 27.44: Tien punten per object polygoon, links: min. afstanden = 0, midden: min. afstanden = 1, rechts: min.
afstand = 1, globale min. afstand = 0

Het maximale aantal pogingen per punt kan worden gespecificeerd. Dit is alleen relevant voor niet-nul minimale
afstand.
Een zaad voor het maken van de willekeurige getallen mag worden opgegeven, wat het mogelĳk maakt identieke
willekeurige getalreeksen voor verschillende uitvoeringen van het algoritme te krĳgen.
De attributen van het object polygoon waarop het punt werd gemaakt mag worden opgenomen (Polygoon-attributen
opnemen).
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Als u bĳ benadering dezelfde dichtheid voor punten wilt voor alle objecten, kunt u het aantal punten data-bepalen
met het gebied van de geometrie van het object polygoon.
Zie ook:
Willekeurige punten binnen polygonen

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoer polygonen-
laag

INPUT [vector: lĳn] Invoer polygoon-vectorlaag

Aantal punten
voor elk object

POINTS_NUMBER [getal ]
Standaard: 1

Aantal te maken punten

Minimale afstand
tussen punten
Optioneel

MIN_DISTANCE [getal ]
Standaard: 0.0

De minimale afstand tussen punten binnen
één object polygoon

Willekeurige
punten in
polygonen

OUTPUT [vector: punt]
Standaard:
[Tijdelijke
laag maken]

De uitvoer willekeurige punten. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Gevorderde parameters

Label Naam Type Beschrijving

Globale minimale
afstand tussen
punten
Optioneel

MIN_DISTANCE_GLOBAL[getal ]
Standaard: 0.0

De globale minimale afstand tussen punten.
Zou kleiner moeten zĳn dan Minimale
afstand tussen punten (per object) om die
parameter effect te laten hebben.

Maximale aantal
zoekpogingen
(voor Min. afst. >
0)
Optioneel

MAX_TRIES_PER_POINT[getal ]
Standaard: 10

Het maximale aantal pogingen per punt.
Alleen relevant als de minimale afstand
tussen punten is ingesteld (en groter is dan
0).

Willekeurig zaad
Optioneel

SEED [getal]
Standaard: Niet
ingesteld

Het te gebruiken zaad voor het maken van
de willekeurige getallen.

Polygoon-
attributen
opnemen

INCLUDE_POLYGON_ATTRIBUTES[Booleaanse
waarde]
Standaard: True

Indien ingesteld zal een punt de attributen
krĳgen van de lĳn waarop het is geplaatst.
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Uitvoer

Label Naam Type Beschrijving
Willekeurige
punten in
polygonen

OUTPUT [vector: punt] De uitvoer willekeurige puntlaag

Aantal objecten
met lege of geen
geometrie

FEATURES_WITH_EMPTY_OR_NO_GEOMETRY[getal]

Totale aantal
gemaakte punten

OUTPUT_POINTS [getal]

Aantal
ontbrekende
punten

POINTS_MISSED [getal] Het aantal punten dat niet kon worden
gemaakt vanwege de beperking van de
minimale afstand.

Aantal objecten
met ontbrekende
punten

POLYGONS_WITH_MISSED_POINTS[getal] Niet inclusief objecten met lege of geen
geometrie

Pythoncode

ID algoritme: native:randompointsinpolygons

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Willekeurige punten binnen polygonen

Maakt een nieuwe puntlaag met een opgegeven aantal willekeurige punten binnen elke polygoon van de invoer
polygoonlaag.
Twee strategieën voor monsterneming zĳn beschikbaar:

• Punten tellen: aantal punten voor elk object
• Punten dichtheid: dichtheid van punten voor elk object

Een minimale afstand kan worden gespecificeerd, om te vermĳden dat punten te dicht op elkaar worden geplaatst.
Standaard menu: Vector ► Onderzoeksgereedschap

Zie ook:
Willekeurige punten in polygonen
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: polygoon] Invoer polygoon-vectorlaag
Strategie voor
monsterneming

STRATEGY [enumeratie]
Standaard: 0

Te gebruiken strategie voor
monsterneming. Één van:

• 0—Punten tellen: aantal punten voor
elk object

• 1 — Punten dichtheid: dichtheid van
punten voor elk object

Punten tellen of
dichtheid

VALUE [getal ]
Standaard: 1.0

Het aantal of dichtheid van punten,
afhankelĳk van de gekozen Strategie voor
monsterneming.

Minimale afstand
tussen punten

MIN_DISTANCE [getal]
Standaard: 0.0

De minimale afstand tussen punten

Willekeurige
punten

OUTPUT [vector: punt]
Standaard:
[Tijdelijke
laag maken]

De uitvoer willekeurige punten. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Willekeurige
punten

OUTPUT [vector: punt] De uitvoer willekeurige puntlaag

Pythoncode

ID algoritme: qgis:randompointsinsidepolygons

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Willekeurige punten op lijnen

Maakt een nieuwe puntlaag, met punten geplaatst op de lĳnen van een andere laag.
Voor elk object geometrie, (lĳn / multilĳn), op de invoerlaag wordt het opgegeven aantal punten toegevoegd aan de
resulterende laag.
Per object en globale minimale afstanden kunnen worden gespecificeerd om te vermĳden dat punten te dicht bĳ elkaar
komen te staan in de uitvoer puntlaag. Als een minimale afstand is gespecificeerd, zou het misschien niet mogelĳk
kunnen zĳn om het gespecificeerde aantal punten voor elk object te maken. Het totale aantal gemaakte punten en
ontbrekende punten zĳn als uitvoer van het algoritme beschikbaar.
De afbeelding hieronder geeft het effect per object en globale minimale afstanden weer en nul/niet-nul minimale
afstanden (gemaakt met hetzelfde zaad zodat tenminste het eerste gemaakte punt hetzelfde is).

Fig. 27.45: Vijf punten per object lijn, links: min. afstanden = 0, midden: min. afstanden != 0, rechts: min. afstand !=
0, globale min. afstand = 0

Het maximale aantal pogingen per punt kan worden gespecificeerd. Dit is alleen relevant voor niet-nul minimale
afstand.
Een zaad voor het maken van de willekeurige getallen mag worden opgegeven, wat het mogelĳk maakt identieke
willekeurige getalreeksen voor verschillende uitvoeringen van het algoritme te krĳgen.
De attributen van het object lĳn waarop het punt werd gemaakt mag worden opgenomen (Attributen van lĳn opnemen).
Als u bĳ benadering dezelfde dichtheid voor punten wilt voor alle lĳnobjecten, kunt u het aantal punten data-bepalen
met de lengte van de geometrie van het object lĳn.
Zie ook:
Willekeurige punten langs lĳn
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Parameters

Basis parameters

Label Naam Type Beschrijving
Invoer lĳnenlaag INPUT [vector: lĳn] Invoer lĳn-vectorlaag

Aantal punten
voor elk object

POINTS_NUMBER [getal ]
Standaard: 1

Aantal te maken punten

Minimale afstand
tussen objecten
(per object)
Optioneel

MIN_DISTANCE [getal ]
Standaard: 0.0

De minimale afstand tussen punten binnen
één object lĳn

Willekeurige
punten op lĳnen

OUTPUT [vector: punt]
Standaard:
[Tijdelijke
laag maken]

De uitvoer willekeurige punten. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Gevorderde parameters

Label Naam Type Beschrijving

Globale minimale
afstand tussen
punten
Optioneel

MIN_DISTANCE_GLOBAL[getal ]
Standaard: 0.0

De globale minimale afstand tussen punten.
Zou kleiner moeten zĳn dan Minimale
afstand tussen punten (per object) om die
parameter effect te laten hebben.

Maximale aantal
zoekpogingen
(voor Min. afst. >
0)
Optioneel

MAX_TRIES_PER_POINT[getal ]
Standaard: 10

Het maximale aantal pogingen per punt.
Alleen relevant als de minimale afstand
tussen punten is ingesteld (en groter is dan
0).

Willekeurig zaad
Optioneel

SEED [getal]
Standaard: Niet
ingesteld

Het te gebruiken zaad voor het maken van
de willekeurige getallen.

Attributen van lĳn
opnemen

INCLUDE_LINE_ATTRIBUTES[Booleaanse
waarde]
Standaard: True

Indien ingesteld zal een punt de attributen
krĳgen van de lĳn waarop het is geplaatst.
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Uitvoer

Label Naam Type Beschrijving
Willekeurige
punten op lĳnen

OUTPUT [vector: punt] De uitvoer willekeurige puntlaag

Aantal objecten
met lege of geen
geometrie

FEATURES_WITH_EMPTY_OR_NO_GEOMETRY[getal]

Aantal objecten
met ontbrekende
punten

LINES_WITH_MISSED_POINTS[getal] Niet inclusief objecten met lege of geen
geometrie

Totale aantal
gemaakte punten

POINTS_GENERATED[getal]

Aantal
ontbrekende
punten

POINTS_MISSED [getal] Het aantal punten dat niet kon worden
gemaakt vanwege de beperking van de
minimale afstand.

Pythoncode

ID algoritme: native:randompointsonlines

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Pixels naar punten rasteren

Maakt een vectorlaag met punten die overeenkomen met elke pixel in een rasterlaag.
Converteert een vectorlaag naar een rasterlaag door puntobjecten te maken uit elk middelpunt voor individuele pixels
in de rasterlaag. Alle pixels met Geen gegevens worden in de uitvoer genegeerd.
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Parameters

Label Naam Type Beschrijving
Rasterlaag INPUT_RASTER [raster] Invoer rasterlaag
Bandnummer RASTER_BAND [rasterband] Rasterband waaruit de gegevens moeten

worden uitgenomen
Veldnaam FIELD_NAME [tekenreeks]

Standaard:
‘WAARDE’

Naam van het veld waarin de waarde voor
de rasterband moet worden opgeslagen

Vectorpunten OUTPUT [vector: punt]
Standaard:
[Tijdelijke
laag maken]

Specificeer de resulterende puntlaag van
zwaartepunten van pixels. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Vectorpunten OUTPUT [vector: punt] De resulterende puntlaag met

zwaartepunten van pixels

Pythoncode

ID algoritme: native:pixelstopoints

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Pixels naar polygonen rasteren

Maakt een vectorlaag met polygonen die overeenkomen met elke pixel in een rasterlaag.
Converteert een rasterlaag naar een vectorlaag door objecten polygoon te maken uit elk bereik voor individuele pixels
in de rasterlaag. Alle pixels met Geen gegevens worden in de uitvoer genegeerd.
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Parameters

Label Naam Type Beschrijving
Rasterlaag INPUT_RASTER [raster] Invoer rasterlaag
Bandnummer RASTER_BAND [rasterband] Rasterband waaruit de gegevens moeten

worden uitgenomen
Veldnaam FIELD_NAME [tekenreeks]

Standaard:
‘WAARDE’

Naam van het veld waarin de waarde voor
de rasterband moet worden opgeslagen

Vectorpolygonen OUTPUT [vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificeer de resulterende polygoonlaag
van bereiken van pixels. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Vectorpolygonen OUTPUT [vector: polygoon] Resulterende polygoonlaag van bereik van

pixels

Pythoncode

ID algoritme: native:pixelstopolygons

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Regelmatige punten

Maakt een nieuwe puntlaag waarvan de punten zĳn geplaatst in een regelmatig raster met een opgegeven bereik.
Het raster wordt gespecificeerd door ofwel de afstand tussen de punten (dezelfde afstand voor alle dimensies) of door
het aantal te maken punten. In het laatste geval zal de afstand worden bepaald uit het bereik. Tenminste het door
de gebruiker gespecificeerde aantal punten wordt in het laatste geval gemaakt om een volledig rechthoekig raster te
maken.
Willekeurige verschuivingen voor de afstand tussen de punten kunnen worden toegepast, wat resulteert in een niet-
regelmatig patroon van punten.
Standaard menu: Vector ► Onderzoeksgereedschap
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Parameters

Label Naam Type Beschrijving
Invoer bereik
(xmin, xmax,
ymin, ymax)

EXTENT [bereik] Kaartbereik voor de willekeurige punten
Beschikbare methoden zĳn:

• Uit laag berekenen…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

Punt
afstand/aantal

SPACING [getal]
Standaard: 100

Afstand tussen de punten, of het aantal
punten, afhankelĳk van het feit of Punt
afstand gebruiken is geselecteerd of
niet.

Beginwaarde voor
hoek (LH kant)

INSET [getal]
Standaard: 0.0

Verschuift de punten relatief ten opzichte
van de linkerbovenhoek. De waarde wordt
gebruikt voor zowel de X- als de Y-as.

Willekeurige
verspringing voor
tussenruimte van
punten

RANDOMIZE [Booleaanse
waarde]
Standaard: False

Indien geselecteerd zullen de punten een
willekeurige afstand hebben

Punt afstand
gebruiken

IS_SPACING [Booleaanse
waarde]
Standaard: True

Indien niet geselecteerd zal geen rekening
worden gehouden met de afstand voor de
punten

Uitvoerlaag CRS CRS [crs]
Standaard: project
CRS

CRS van de laag met willekeurige punten

Regelmatige
punten

OUTPUT [vector: punt]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoerlaag met regelmatige
punten. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Beschrijving
Regelmatige
punten

OUTPUT [vector: punt] De uitvoer regelmatige puntlaag.

Pythoncode

ID algoritme: qgis:regularpoints

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

27.1.17 Vector algemeen

Projectie toekennen

Wĳst een nieuwe projectie toe aan een vectorlaag.
Het maakt een nieuwe laag met exact dezelfde objecten en geometrieën als die van de invoer, maar toegewezen aan
een ander CRS. De geometrieën worden niet opnieuw geprojecteerd, maar aan hen wordt slechts een ander CRS
toegewezen.
Dit algoritme kan worden gebruikt om lagen te repareren die een onjuiste projectie hebben toegewezen gekregen.
Attributen worden niet aangepast door dit algoritme.
Zie ook:
Projectie voor Shapefile definiëren, Projectie zoeken, Laag opnieuw projecteren

Parameters

Label Naam Type Omschrijving
Invoerlaag INPUT [vector: elke] Vectorlaag met verkeerd of ontbrekend

CRS
Toegewezen CRS CRS [crs]

Standaard:
EPSG:4326
- WGS84

Selecteer het nieuwe toe te wĳzen CRS voor
de vectorlaag

Toegewezen CRS
Optioneel

OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Omschrijving
Toegewezen CRS OUTPUT [hetzelfde als

invoer]
Vectorlaag met toegewezen projectie

Pythoncode

ID algoritme: native:assignprojection

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Bulk geocodering Nominatim

Voert geocoderen in bulk uit met behulp van de service Nominatim tegen een veld tekenreeks van een invoerlaag. De
uitvoerlaag zal een geometrie punt hebben die de geogecodeerde locatie weergeeft, als ook een aantal attributen die
zĳn geassocieerd aan de geogecodeerde locatie.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt

Notitie: Dit algoritme voldoet aan het gebruiksbeleid van de service voor geocodering Nominatim die wordt verschaft
door de OpenStreetMap Foundation.

Parameters

Label Naam Type Omschrijving
Invoerlaag INPUT [vector: elke] Vectorlaag waaruit de objecten moeten

worden voorzien van geocodering
Adresveld FIELD [tabelveld: string] Veld dat de adressen bevat voor

geocodering
Voorzien van
geocode

OUTPUT [vector: punt]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoerlaag die alleen de
adressen met geocode bevat. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Omschrijving
Voorzien van
geocode

OUTPUT [vector: punt] Vectorlaag met objecten punt die
corresponderen met de adressen met
geocode

Pythoncode

ID algoritme: native:batchnominatimgeocoder

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Laag converteren naar Favoriete plaatsen

Maakt Favoriete plaatsen, corresponderend met het bereik van objecten die zĳn opgenomen in een laag.

Parameters

Label Naam Type Omschrijving
Invoerlaag INPUT [vector: lĳn,

polygoon]
De invoer vectorlaag

Doel Favoriete
plaats

DESTINATION [enumeratie]
Standaard: 0

Selecteer het doel voor de Favoriete
plaatsen. Één van:

• 0 — Favoriete plaatsen van project
• 1— Favoriete plaatsen van gebruiker

Veld Naam NAME_EXPRESSION[expressie] Veld of expressie dat namen zal geven aan
de gemaakte Favoriete plaatsen

Groeperingsveld GROUP_EXPRESSION[expressie] Veld of expressie dat groepen zal maken
voor de gemaakte Favoriete plaatsen

Uitvoer

Label Naam Type Omschrijving
Aantal
toegevoegde
Favoriete plaatsen

COUNT [getal]

1206 Hoofdstuk 27. Processing providers en algoritmes



QGIS Desktop 3.28 User Guide

Pythoncode

ID algoritme: native:layertobookmarks

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Favoriete plaatsen converteren naar laag

Maakt een nieuwe laag die objecten polygoon bevat voor opgeslagen Favoriete plaatsen. Het exporteren kan worden
gefilterd op alleen Favoriete plaatsen die tot het huidige project behoren, op alle Favoriete plaatsen van de gebruiker,
of een combinatie van beide.

Parameters

Label Naam Type Omschrijving
Bron Favoriete
plaats

SOURCE [enumeratie] [lĳst]
Standaard: [0,1]

Selecteer de bron(nen) voor de Favoriete
plaatsen. Één of meer van:

• 0 — Favoriete plaatsen van project
• 1— Favoriete plaatsen van gebruiker

Uitvoer CRS CRS [crs]
Standaard:
EPSG:4326
- WGS84

Het CRS van de uitvoerlaag

Uitvoer OUTPUT [vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoerlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Omschrijving
Uitvoer OUTPUT [vector: polygoon] De uitvoer (Favoriete plaatsen) vectorlaag
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Pythoncode

ID algoritme: native:bookmarkstolayer

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Index voor attributen aanmaken

Maakt een index van een veld in de attributentabel om bevragingen sneller te maken. De ondersteuning voor het
maken van indexen is afhankelĳk van de provider van de gegevenslaag en het type veld.
Er wordt geen uitvoer gemaakt: de index wordt opgeslagen op de laag zelf.

Parameters

Label Naam Type Omschrijving
Invoerlaag INPUT [vector: elke] Selecteer de vectorlaag die u wilt gebruiken

om een index voor attributen te maken
Attribuut voor de
index

FIELD [tabelveld: elk] Veld van de vectorlaag

Uitvoer

Label Naam Type Omschrijving
Geïndexeerde laag OUTPUT [hetzelfde als

invoer]
Een kopie van de invoer vectorlaag met een
index voor het gespecificeerde veld

Pythoncode

ID algoritme: native:createattributeindex

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Ruimtelijke index maken

Maakt een index om toegang tot de objecten in een laag sneller te maken, gebaseerd op hun ruimtelĳke locatie.
Ondersteuning voor het maken van ruimtelĳke indexen is afhankelĳk van de provider van de gegevenslaag.
Er worden geen nieuwe lagen voor uitvoer gemaakt.
Standaard menu: Vector ► Datamanagement-gereedschap

Parameters

Label Naam Type Omschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag

Uitvoer

Label Naam Type Omschrijving
Geïndexeerde laag OUTPUT [hetzelfde als

invoer]
Een kopie van de invoer vectorlaag met een
ruimtelĳke index

Pythoncode

ID algoritme: native:createspatialindex

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Projectie voor Shapefile definiëren

Stelt het CRS (projectie) van een bestaande gegevensset in de indeling Shapefile in op het opgegeven CRS. Dit is
bĳzonder nuttig als een gegevensset in de indeling Shapefile het bestand prj mist en u de juiste projectie weet.
In tegenstelling tot het algoritme Projectie toekennen, past het de huidige laag aan en zal het geen nieuwe laag uitvoeren.

Notitie: Voor gegevenssets van Shapefile zullen de bestanden .prj en .qpj worden overschreven - of gemaakt
indien ze ontbreken - om overeen te komen met het opgegeven CRS.

Standaard menu: Vector ► Datamanagement-gereedschap

Zie ook:
Projectie toekennen, Projectie zoeken, Laag opnieuw projecteren

27.1. QGIS algoritme provider 1209



QGIS Desktop 3.28 User Guide

Parameters

Label Naam Type Omschrijving
Invoerlaag INPUT [vector: elke] Vectorlaag met ontbrekende informatie

voor projectie
CRS CRS [crs] Selecteer het toe te wĳzen CRS voor de

vectorlaag

Uitvoer

Label Naam Type Omschrijving
INPUT [hetzelfde als

invoer]
De invoer vectorlaag met de gedefinieerde
projectie

Pythoncode

ID algoritme: qgis:definecurrentprojection

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Duplicaten van geometrieën verwijderen

Zoekt en verwĳdert duplicaten van geometrieën.
Attributen worden niet gecontroleerd, dus in het geval dat twee objecten identieke geometrieën hebben, maar
verschillende attributen, zal slechts één ervan worden toegevoegd aan de laag met resultaten.
Zie ook:
Geometrieën verwĳderen, Geometrieën null verwĳderen, Duplicaten verwĳderen op attribuut

Parameters

Label Naam Type Omschrijving
Invoerlaag INPUT [vector: elke] De laag met duplicaat-geometrieën die u

wilt opruimen
Schoongemaakt OUTPUT [hetzelfde als

invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoerlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Omschrijving
Aantal
verwĳderde
duplicaatrecords

DUPLICATE_COUNT[getal] Aantal verwĳderde duplicaatrecords

Schoongemaakt OUTPUT [hetzelfde als
invoer]

De uitvoer vectorlaag zonder duplicaat-
geometrieën

Aantal behouden
records

RETAINED_COUNT [getal] Aantal unieke records

Pythoncode

ID algoritme: native:deleteduplicategeometries

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Duplicaten verwijderen op attribuut

Verwĳdert duplicaatrĳen door alleen rekening te houden met het/de gespecificeerde veld / velden. De eerste
overeenkomende rĳ zal worden behouden, en duplicaten zullen worden verwĳderd.
Optioneel kunnen deze duplicaatrecords worden opgeslagen naar een afzonderlĳke uitvoer, voor analyse.
Zie ook:
Duplicaten van geometrieën verwĳderen

Parameters

Label Naam Type Omschrijving
Invoerlaag INPUT [vector: elke] De invoerlaag
Veld waarvoor
duplicaten moet
overeenkomen

FIELDS [tabelveld: elk]
[lĳst]

Velden die duplicaten definiëren. Objecten
met identieke waarden voor al deze velden
worden geacht duplicaten te zĳn.

Gefilterd (geen
duplicaten)

OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoerlaag die de unieke
objecten bevat. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Vervolgt op volgende pagina
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Tabel 27.117 – Vervolgd van vorige pagina
Label Naam Type Omschrijving
Gefilterd
(duplicaten)
Optioneel

DUPLICATES [hetzelfde als
invoer]
Standaard:
[Uitvoer
overslaan]

Specificeer de uitvoerlaag die alleen de
duplicaten bevat. Één van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Omschrijving
Gefilterd
(duplicaten)
Optioneel

DUPLICATES [hetzelfde als
invoer]
Standaard:
[Uitvoer
overslaan]

Vectorlaag die de verwĳderde objecten
bevat. Zal niet worden gemaakt indien
niet gespecificeerd (gelaten als [Uitvoer
overslaan]).

Aantal
verwĳderde
duplicaatrecords

DUPLICATE_COUNT[getal] Aantal verwĳderde duplicaatrecords

Gefilterd (geen
duplicaten)

OUTPUT [hetzelfde als
invoer]

Vectorlaag die de unieke objecten bevat.

Aantal behouden
records

RETAINED_COUNT [getal] Aantal unieke records

Pythoncode

ID algoritme: native:removeduplicatesbyattribute

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Wijzigingen in gegevensset detecteren

Vergelĳkt twee vectorlagen en bepaalt welk objecten niet gewĳzigd, toegevoegd of verwĳderd zĳn tussen die twee.
Het is ontworpen voor het vergelĳken van twee verschillende versies van dezelfde gegevensset.

Fig. 27.46: Voorbeeld Wijzigingen in gegevensset detecteren

Parameters

Label Naam Type Omschrijving
Originele laag ORIGINAL [vector: elke] De vectorlaag die wordt beschouwd als de

originele versie
Gereviseerde laag REVISED [vector: elke] De gereviseerde of aangepaste vectorlaag
Attributen
waarmee rekening
moet worden
gehouden voor een
overeenkomst
Optioneel

COMPARE_ATTRIBUTES[tabelveld: elk]
[lĳst]

Attributen waarmee rekening moet
worden gehouden voor een overeenkomst.
Standaard worden alle attributen
vergeleken.

Gedrag voor
vergelĳken van
geometrie
Optioneel

MATCH_TYPE [enumeratie]
Standaard: 1

Definieert de criteria voor vergelĳken.
Opties:

• 0 — Exacte overeenkomst: bevat de
volgorde en het aantal punten van
geometrieën

• 1 — Tolerante overeenkomst
(Topologische gelĳkheid):
geometrieën worden als gelĳk
beschouwd

Ongewĳzigde
objecten
Optioneel

UNCHANGED [vector: hetzelfde
als de Originele
laag]

Specificeer de uitvoerlaag die de
ongewĳzigde objecten bevat. Één van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Vervolgt op volgende pagina
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Tabel 27.119 – Vervolgd van vorige pagina
Label Naam Type Omschrijving
Toegevoegde
objecten
Optioneel

ADDED [vector: hetzelfde
als de Originele
laag]

Specificeer de uitvoerlaag die de
toegevoegde objecten bevat. Één van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Verwĳderde
objecten
Optioneel

DELETED [vector: hetzelfde
als de Originele
laag]

Specificeer de uitvoerlaag die de
verwĳderde objecten bevat. Één van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Omschrijving
Ongewĳzigde
objecten

UNCHANGED [vector: hetzelfde
als de Originele
laag]

Vectorlaag die de ongewĳzigde objecten
bevat.

Toegevoegde
objecten

ADDED [vector: hetzelfde
als de Originele
laag]

Vectorlaag die de toegevoegde objecten
bevat.

Verwĳderde
objecten

DELETED [vector: hetzelfde
als de Originele
laag]

Vectorlaag die de verwĳderde objecten
bevat.

Aantal
ongewĳzigde
objecten

UNCHANGED_COUNT[getal] Aantal ongewĳzigde objecten.

Aantal
toegevoegde
objecten in
gereviseerde
laag

ADDED_COUNT [getal] Aantal toegevoegde objecten in
gereviseerde laag.

Aantal
verwĳderde
objecten uit
originele laag

DELETED_COUNT [getal] Aantal verwĳderde objecten uit originele
laag.
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Pythoncode

ID algoritme: native:detectvectorchanges

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Geometrieën verwijderen

Maakt een eenvoudige kopie zonder geometrie van de attributentabel van de invoerlaag van de bronlaag.
Als het bestand wordt opgeslagen in een lokale map kunt u kiezen uit veel verschillende bestandsindelingen.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt, lĳn en polygoon
Zie ook:
Duplicaten van geometrieën verwĳderen, Geometrieën null verwĳderen

Parameters

Label Naam Type Omschrijving
Invoerlaag INPUT [vector: elke] De invoer vectorlaag
Verwĳderde
geometrieën

OUTPUT [tabel] Specificeer de uitvoerlaag zonder
geometrieën. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Omschrijving
Verwĳderde
geometrieën

OUTPUT [tabel] De uitvoerlaag zonder geometrieën. Een
kopie van de originele attributentabel.
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Pythoncode

ID algoritme: native:dropgeometries

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

SQL uitvoeren

Voert een eenvoudige of complexe query met syntaxis van SQL uit op de bronlaag.
Databronnen voor invoer worden geïdentificeerd met input1, input2… inputN en een eenvoudige query zou
eruit zien als SELECT * FROM input1.
Naast een eenvoudige query kunt u expressies of variabelen toevoegen binnen de parameter SQL query zelf. Dit
is in het bĳzonder nuttig als dit algoritme wordt uitgevoerd in een model van Processing en u wilt een model invoer
gebruiken als een parameter van de query. Een voorbeeld van een query zou dan zĳn SELECT * FROM [%
@table %] waar @table de variabele is die de model invoer identificeert.
Het resultaat van de query zal worden toegevoegd als een nieuwe laag.
Zie ook:
SpatiaLite execute SQL, PostgreSQL execute SQL

Parameters

Label Naam Type Omschrijving
Aanvullende
databronnen voor
invoer (input1, …,
inputN genoemd
in de query)

INPUT_DATASOURCES[vector: elke] [lĳst] Lĳst van te bevragen lagen. In de bewerker
voor SQL kunt u naar deze lagen verwĳzen
met hun echte naam, maar ook als invoer1,
invoer2, invoerN, afhankelĳk van hoeveel
lagen zĳn gekozen.

SQL-query INPUT_QUERY [tekenreeks] Typ de tekenreeks van uw query voor SQL,
bĳv. SELECT * FROM input1.

Uniek veld voor
identificatie
Optioneel

INPUT_UID_FIELD[tekenreeks] Specificeer de kolom met de unieke ID

Geometrie-veld
Optioneel

INPUT_GEOMETRY_FIELD[tekenreeks] Specificeer het geometrie-veld

Type geometrie
Optioneel

INPUT_GEOMETRY_TYPE[enumeratie]
Standaard: 0

Kies de geometrie voor het resultaat.
Standaard zal het algoritme het automatisch
detecteren. Één van:

• 0 — Automatisch detecteren
• 1 — Geen geometrie
• 2 — Point
• 3 — LineString
• 4 — Polygon
• 5 — MultiPoint
• 6 — MultiLineString
• 7 — MultiPolygon

Vervolgt op volgende pagina
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Tabel 27.121 – Vervolgd van vorige pagina
Label Naam Type Omschrijving
CRS
Optioneel

INPUT_GEOMETRY_CRS[crs] Het CRS dat aan de uitvoerlaag moet
worden toegewezen

SQL uitvoer OUTPUT [vector: elke]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoerlaag die wordt
gemaakt door de query. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Omschrijving
SQL uitvoer OUTPUT [vector: elke] Vectorlaag gemaakt door de query

Pythoncode

ID algoritme: qgis:executesql

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Lagen naar DXF exporteren

Exporteert lagen naar een bestand DXF. Voor elke laag kunt u een veld kiezen waarvan de waarden worden gebruikt
om objecten te splitsen in de gemaakte doellagen in de uitvoer voor DXF.
Zie ook:
Nieuwe DXF-bestanden maken

27.1. QGIS algoritme provider 1217



QGIS Desktop 3.28 User Guide

Parameters

Label Naam Type Omschrijving
Invoerlagen LAYERS [vector: elke] [lĳst] Te exporteren invoer vectorlagen
Symbologie
modus

SYMBOLOGY_MODE [enumeratie]
Standaard: 0

Type symbologie die moet worden
toegepast op de uitvoerlagen. U kunt kiezen
uit:

• 0 — Geen symbologie
• 1 — Objectsymbologie
• 2 — Symbologie symboollaag

Symbologie schaal SYMBOLOGY_SCALE[schaal]
Standaard: 1:1 000
000

Standaard schaal voor de gegevensexport.

Codering ENCODING [enumeratie] Codering die moet worden toegepast op de
lagen.

CRS CRS [crs] Het CRS van de uitvoerlaag kiezen
Titel van laag als
naam gebruiken

USE_LAYER_TITLE[Booleaanse
waarde]
Standaard: False

Benoem de uitvoerlaag met de titel van de
laag (zoals ingesteld in QGIS) in plaats van
de naam van de laag.

2D uitvoer
forceren

FORCE_2D [Booleaanse
waarde]
Standaard: False

Labels als
elementen
MTEXT
exporteren

MTEXT [Booleaanse
waarde]
Standaard: False

Labels als elementen MTEXT of TEXT
exporteren

DXF OUTPUT [bestand]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van het uitvoer DXF-bestand.
Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Omschrijving
DXF OUTPUT [bestand] .DXF bestand dat de invoerlagen bevat

Pythoncode

ID algoritme: native:dxfexport

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Geselecteerde objecten uitnemen

Slaat de geselecteerde objecten als een nieuwe laag op.

Notitie: Als de geselecteerde laag geen geselecteerde objecten heeft, zal de nieuw gemaakte laag leeg zĳn.

Parameters

Label Naam Type Omschrijving
Invoerlaag INPUT [vector: elke] Laag waaruit de selectie moet worden

geselecteerd
Geselecteerde
objecten

OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de vectorlaag voor de
geselecteerde objecten. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Omschrijving
Geselecteerde
objecten

OUTPUT [hetzelfde als
invoer]

Vectorlaag met alleen de geselecteerde
objecten, of zonder objecten als niets werd
geselecteerd.

Pythoncode

ID algoritme: native:saveselectedfeatures

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Codering Shapefile uitnemen

Neemt de informatie uit voor de codering van attributen, die is ingebed in een Shapefile. Zowel de codering die is
gespecificeerd in een optioneel bestand .:file:.cpg als details voor de codering die aanwezig zĳn in het .dbf LDID
kopblok worden uitgenomen.

Parameters

Label Naam Type Omschrijving
Invoerlaag INPUT [vector: elke] Laag van ESRI Shapefile (.SHP) waaruit

de informatie voor de codering moet
worden uitgenomen.

Uitvoer

Label Naam Type Omschrijving
Shapefile codering ENCODING [tekenreeks] Informatie voor de codering gespecificeerd

in het invoerbestand
CPG-codering CPG_ENCODING [tekenreeks] Informatie voor de codering gespecificeerd

in een optioneel bestand .CPG
LDID-codering LDID_ENCODING [tekenreeks] Informatie voor de codering gespecificeerd

in het .dbf LDID kopblok

Pythoncode

ID algoritme: native:shpencodinginfo

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Projectie zoeken

Maakt een verkorte lĳst van kandidaat coördinaten referentiesystemen, bĳvoorbeeld voor een laag met een onbekende
projectie.
Het gebied, dat de laag verwacht wordt te bedekken, moet zĳn gespecificeerd via de parameter Doelgebied. Het
coördinaten referentiesysteem voor dit doelgebied moet bekend zĳn bĳ QGIS.
Het algoritme werkt door het bereik van de laag te testen in elk bekend referentiesysteem en dan die te vermelden
waarvan de grenzen nabĳ het doelgebied liggen, als de laag in deze projectie zou zĳn.
Zie ook:
Projectie toekennen, Projectie voor Shapefile definiëren, Laag opnieuw projecteren
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Parameters

Label Naam Type Omschrijving
Invoerlaag INPUT [vector: elke] Laag met onbekende projectie
Doelgebied voor
laag (xmin, xmax,
ymin, ymax)

TARGET_AREA [bereik] Het gebied dat de laag bedekt.
Beschikbare methoden zĳn:

• Uit laag berekenen…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

CRS-kandidaten OUTPUT [tabel]
Standaard:
[Tijdelijke
laag maken]

Specificeer de tabel (laag zonder geometrie)
voor de suggesties voor het CRS (EPSG-
codes). Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Omschrijving
CRS-kandidaten OUTPUT [tabel] Een tabel met alle CRSen (EPSG-codes)

van de overeenkomende criteria.
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Pythoncode

ID algoritme: qgis:findprojection

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Relatie afvlakken

Vlakt een relatie af voor een vectorlaag, exporteert een enkele laag die één ouderobject per gerelateerd object bevat.
Dit ouderobject bevat alle attributen voor de gerelateerde objecten. Dit maakt het mogelĳk de relatie te verkrĳgen als
een gewone tabel die bĳv. kan worden geëxporteerd naar CSV.

Fig. 27.47: Formulier van een region met gerelateerde kinderen (links) - Een duplicaat region-object voor elk
gerelateerd kind, met samengevoegde attributen (rechts)

Parameters

Label Naam Type Omschrijving
Invoerlaag INPUT [vector: elke] Laag met de relatie die gede-normaliseerd

zou moeten worden
Afgevlakte laag
Optioneel

OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer (afgevlakte) laag.
Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Omschrijving
Afgevlakte laag OUTPUT [hetzelfde als

invoer]
Een laag die hoofdobjecten bevat met alle
attributen voor de gerelateerde objecten

Pythoncode

ID algoritme: native:flattenrelationships

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Attributen koppelen op veldwaarde

Neemt een invoer vectorlaag en maakt een nieuwe vectorlaag die een uitgebreide versie is van die van de invoer, met
aanvullende attributen in zĳn attributentabel.
De aanvullende attributen en hun waarden worden uit een tweede vectorlaag genomen. Een attribuut is geselecteerd
in elk van hen om de criteria voor het samenvoegen te definiëren.
Zie ook:
Koppel attributen op dichtstbĳzĳnde, Koppel attributen op basis van plaats

Parameters

Label Naam Type Omschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag. De uitvoerlaag zal

bestaan uit de objecten van deze laag met
attributen van overeenkomende objecten in
de tweede laag.

Tabelveld FIELD [tabelveld: elk] Veld van de bronlaag te gebruiken voor het
samenvoegen

Invoerlaag 2 INPUT_2 [vector: elke] Laag met de te koppelen attributentabel
Tabelveld 2 FIELD_2 [tabelveld: elk] Veld van de tweede (koppel-) laag om te

gebruiken om samen te voegen. Het type
veld moet gelĳk zĳn aan (of compatibel
met) het type tabelveld voor de invoer.

Velden van laag 2
om te kopiëren
Optioneel

FIELDS_TO_COPY [tabelveld: elk]
[lĳst]

Selecteer de specifieke velden die u wilt
toevoegen. Standaard worden alle velden
toegevoegd.

Vervolgt op volgende pagina
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Tabel 27.125 – Vervolgd van vorige pagina
Label Naam Type Omschrijving
Verbindingsstĳl METHOD [enumeratie]

Standaard: 1
Het type van de uiteindelĳke gekoppelde
laag. Één van:

• 0 — Afzonderlĳk object maken voor
elk overeenkomend object (één-tot-
veel)

• 1 — Alleen attributen gebruiken van
eerste overeenkomende object (één-
tot-één)

Records
verwĳderen
die niet konden
worden gekoppeld

DISCARD_NONMATCHING[Booleaanse
waarde]
Standaard: True

Selecteren als u de objecten, die niet konden
worden gekoppeld, niet wilt behouden

Voorvoegsel
samengevoegde
velden
Optioneel

PREFIX [tekenreeks] Voeg een voorvoegsel toe aan gekoppelde
velden om ze gemakkelĳk te kunnen
identificeren en botsingen tussen namen van
velden te vermĳden

Samengevoegde
laag
Optioneel

OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag voor de
koppeling. Één van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Niet samen te
voegen objecten
uit eerste laag
Optioneel

NON_MATCHING [hetzelfde als
invoer]
Standaard:
[Uitvoer
overslaan]

Specificeer de uitvoer vectorlaag voor niet
samen te voegen objecten uit de eerste laag.
Één van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Omschrijving
Aantal niet samen
te voegen objecten
uit invoertabel

JOINED_COUNT [getal]

Niet samen te
voegen objecten
uit eerste laag
Optioneel

NON_MATCHING [hetzelfde als
invoer]

Vectorlaag met de niet-overeenkomende
objecten

Samengevoegde
laag
Optioneel

OUTPUT [hetzelfde als
invoer]

Uitvoer vectorlaag met toegevoegde
attributen van de koppeling

Aantal
samengevoegde
objecten uit
invoertabel
Optioneel

UNJOINABLE_COUNT[getal]

Pythoncode

ID algoritme: native:joinattributestable

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Koppel attributen op basis van plaats

Neemt een invoer vectorlaag en maakt een nieuwe vectorlaag die een uitgebreide versie is van die van de invoer, met
aanvullende attributen in zĳn attributentabel.
De aanvullende attributen en hun waarden worden uit een tweede vectorlaag genomen. Een ruimtelĳk criterium wordt
toegepast om de waarden uit de tweede vectorlaag te selecteren die worden toegevoegd aan elk object uit de eerste
laag.
Standaard menu: Vector ► Datamanagement-gereedschap

Zie ook:
Koppel attributen op dichtstbĳzĳnde, Attributen koppelen op veldwaarde, Koppel attributen op basis van plaats
(samenvatting)

27.1. QGIS algoritme provider 1225



QGIS Desktop 3.28 User Guide

Ruimtelijke relaties verkennen

Geometrische gezegdes zĳn functies met Booleaanse waarden die worden gebruikt om de ruimtelĳke relatie te bepalen
die een object heeft met een ander door te vergelĳken of en hoe hun geometrieën een portie van hun ruimte delen.

Fig. 27.48: Zoeken naar ruimtelijke relaties tussen lagen

Gebruik makend van de afbeelding hierboven zoeken we naar de groene cirkels door ze ruimtelĳk te vergelĳken met
het rechthoekige oranje object. Beschikbare geometrische gezegdes zĳn:
Kruisen

Test of een geometrie een andere kruist. Geeft 1 ( true) terug als de geometrieën elkaar ruimtelĳk kruisen (een
stukje ruimte met elkaar delen - overlappen of raken) en 0 als zĳ dat niet doen. In de afbeelding hierboven zou
dit de cirkels 1, 2 en 3 teruggeven.

Bevat
Geeft 1 (true) terug als en alleen als er geen punten van b in het buitenste van a liggen, en ten minste één punt
van het interieur van b ligt in het interieur van a. In de afbeelding zou geen cirkel worden teruggegeven, maar
de rechthoek zou dat wel worden als u er op de omgekeerde wĳze naar zou zoeken, omdat het cirkel 1 volledig
bevat. Dit is het tegengestelde van zĳn binnen.

Raakt niet
Geeft 1 (true) terug als de geometrieën geen deel van de ruimte met elkaar delen (niet overlappen, elkaar niet
raken). Alleen cirkel 4 wordt teruggegeven.

Gelijk
Geeft 1 (true) terug als en alleen als geometrieën exact hetzelfde zĳn. Geen cirkels zullen worden teruggegeven.

Raakt
Test of een geometrie een andere raakt. Geeft 1 (true) terug als de geometrieën tenminste één
gemeenschappelĳk punt hebben, maar hun interieurs niet kruisen. Alleen cirkel 3 wordt teruggegeven.

Overlapt
Test of een geometrie een andere overlapt. Geeft 1 (true) terug als de geometrieën ruimte delen, van dezelfde
dimensie zĳn, maar niet volledig door elkaar worden omvat. Alleen cirkel 2 wordt teruggegeven.
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Zijn binnen
Test of een geometrie in een andere ligt. Geeft 1 (true) terug als geometrie a volledig binnen geometrie b ligt.
Alleen cirkel 1 wordt teruggegeven.

Kruisen
Geeft 1 (true) terug als de opgegeven geometrieën enkele, maar niet alle, punten in het interieur
gemeenschappelĳk hebben en de feitelĳke kruising van een lagere dimensie is dan de hoogste opgegeven
geometrie. Bĳvoorbeeld een lĳn die een polygoon kruist zal een lĳn kruisen (true). Twee lĳnen die elkaar
kruisen zal als een punt kruisen (true). Twee polygonen kruisen als een polygoon (false). In de afbeelding
zullen geen cirkels worden teruggegeven.

Parameters

Label Naam Type Omschrijving
Samenvoegen met
objecten in

INPUT [vector: elke] Invoer vectorlaag. De uitvoerlaag zal
bestaan uit de objecten van deze laag met
attributen van overeenkomende objecten in
de tweede laag.

Waar de objecten PREDICATE [enumeratie] [lĳst]
Standaard: [0]

Type ruimtelĳke relatie dat het bronobject
zou moeten hebben met een doelobject,
zodat zĳ zouden kunnen worden
samengevoegd. Één of meer van:

• 0 — kruist met
• 1 — bevat
• 2 — is gelĳk aan
• 2 — raken
• 4 — overlappen
• 5 — zĳn binnen
• 6 — kruisen

Als meer dan één voorwaarde wordt
gekozen, moet aan tenminste één worden
voldaan (bewerking OR) om een object uit
te kunnen nemen.

In vergelĳking
met

JOIN [vector: elke] De samen te voegen laag. Objecten van deze
vectorlaag zullen hun attributen toevoegen
aan de attributentabel van de bronlaag, als
zĳ voldoen aan de ruimtelĳke relatie.

Velden die
moeten worden
toegevoegd (laat
leeg om alle velden
te gebruiken)
Optioneel

JOIN_FIELDS [tabelveld: elk]
[lĳst]

Selecteer de specifieke velden die u wilt
toevoegen vanuit de samen te voegen laag.
Standaard worden alle velden toegevoegd.

Verbindingsstĳl METHOD [enumeratie] Het type van de uiteindelĳke gekoppelde
laag. Één van:

• 0 — Afzonderlĳk object maken voor
elk overeenkomend object (één-tot-
veel)

• 1 — Alleen attributen gebruiken van
eerste overeenkomende object (één-
tot-één)

• 2 — Alleen attributen gebruiken van
object met grootste overlapping (één-
tot-één)

Vervolgt op volgende pagina
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Tabel 27.126 – Vervolgd van vorige pagina
Label Naam Type Omschrijving
Records
verwĳderen
die niet konden
worden gekoppeld

DISCARD_NONMATCHING[Booleaanse
waarde]
Standaard: False

Verwĳder objecten van de invoerlaag, die
niet konden worden gekoppeld, uit de
uitvoer

Voorvoegsel
samengevoegde
velden
Optioneel

PREFIX [tekenreeks] Voeg een voorvoegsel toe aan gekoppelde
velden om ze gemakkelĳk te kunnen
identificeren en botsingen tussen namen van
velden te vermĳden

Samengevoegde
laag
Optioneel

OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag voor de
koppeling. Één van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Niet samen te
voegen objecten
uit eerste laag
Optioneel

NON_MATCHING [hetzelfde als
invoer]
Standaard:
[Uitvoer
overslaan]

Specificeer de uitvoer vectorlaag voor niet
samen te voegen objecten uit de eerste laag.
Één van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Omschrijving
Aantal niet samen
te voegen objecten
uit invoertabel

JOINED_COUNT [getal]

Niet samen te
voegen objecten
uit eerste laag
Optioneel

NON_MATCHING [hetzelfde als
invoer]

Vectorlaag met de niet overeenkomende
objecten

Samengevoegde
laag

OUTPUT [hetzelfde als
invoer]

Uitvoer vectorlaag met toegevoegde
attributen van de koppeling
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Pythoncode

ID algoritme: native:joinattributesbylocation

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Koppel attributen op basis van plaats (samenvatting)

Neemt een invoer vectorlaag en maakt een nieuwe vectorlaag die een uitgebreide versie is van die van de invoer, met
aanvullende attributen in zĳn attributentabel.
De aanvullende attributen en hun waarden worden uit een tweede vectorlaag genomen. Een ruimtelĳk criterium wordt
toegepast om de waarden uit de tweede vectorlaag te selecteren die worden toegevoegd aan elk object uit de eerste
laag.
Het algoritme berekent een statistische samenvatting voor de waarden uit overeenkomende objecten op de tweede
laag (bĳv. maximum waarde, gemiddelde waarde, etc).
Zie ook:
Koppel attributen op basis van plaats

Ruimtelijke relaties verkennen

Geometrische gezegdes zĳn functies met Booleaanse waarden die worden gebruikt om de ruimtelĳke relatie te bepalen
die een object heeft met een ander door te vergelĳken of en hoe hun geometrieën een portie van hun ruimte delen.

Fig. 27.49: Zoeken naar ruimtelijke relaties tussen lagen
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Gebruik makend van de afbeelding hierboven zoeken we naar de groene cirkels door ze ruimtelĳk te vergelĳken met
het rechthoekige oranje object. Beschikbare geometrische gezegdes zĳn:
Kruisen

Test of een geometrie een andere kruist. Geeft 1 ( true) terug als de geometrieën elkaar ruimtelĳk kruisen (een
stukje ruimte met elkaar delen - overlappen of raken) en 0 als zĳ dat niet doen. In de afbeelding hierboven zou
dit de cirkels 1, 2 en 3 teruggeven.

Bevat
Geeft 1 (true) terug als en alleen als er geen punten van b in het buitenste van a liggen, en ten minste één punt
van het interieur van b ligt in het interieur van a. In de afbeelding zou geen cirkel worden teruggegeven, maar
de rechthoek zou dat wel worden als u er op de omgekeerde wĳze naar zou zoeken, omdat het cirkel 1 volledig
bevat. Dit is het tegengestelde van zĳn binnen.

Raakt niet
Geeft 1 (true) terug als de geometrieën geen deel van de ruimte met elkaar delen (niet overlappen, elkaar niet
raken). Alleen cirkel 4 wordt teruggegeven.

Gelijk
Geeft 1 (true) terug als en alleen als geometrieën exact hetzelfde zĳn. Geen cirkels zullen worden teruggegeven.

Raakt
Test of een geometrie een andere raakt. Geeft 1 (true) terug als de geometrieën tenminste één
gemeenschappelĳk punt hebben, maar hun interieurs niet kruisen. Alleen cirkel 3 wordt teruggegeven.

Overlapt
Test of een geometrie een andere overlapt. Geeft 1 (true) terug als de geometrieën ruimte delen, van dezelfde
dimensie zĳn, maar niet volledig door elkaar worden omvat. Alleen cirkel 2 wordt teruggegeven.

Zijn binnen
Test of een geometrie in een andere ligt. Geeft 1 (true) terug als geometrie a volledig binnen geometrie b ligt.
Alleen cirkel 1 wordt teruggegeven.

Kruisen
Geeft 1 (true) terug als de opgegeven geometrieën enkele, maar niet alle, punten in het interieur
gemeenschappelĳk hebben en de feitelĳke kruising van een lagere dimensie is dan de hoogste opgegeven
geometrie. Bĳvoorbeeld een lĳn die een polygoon kruist zal een lĳn kruisen (true). Twee lĳnen die elkaar
kruisen zal als een punt kruisen (true). Twee polygonen kruisen als een polygoon (false). In de afbeelding
zullen geen cirkels worden teruggegeven.

Parameters

Label Naam Type Omschrijving
Samenvoegen met
objecten in

INPUT [vector: elke] Invoer vectorlaag. De uitvoerlaag zal
bestaan uit de objecten van deze laag met
attributen van overeenkomende objecten in
de tweede laag.

Vervolgt op volgende pagina
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Tabel 27.127 – Vervolgd van vorige pagina
Label Naam Type Omschrijving
Waar de objecten PREDICATE [enumeratie] [lĳst]

Standaard: [0]
Type ruimtelĳke relatie dat het bronobject
zou moeten hebben met een doelobject,
zodat zĳ zouden kunnen worden
samengevoegd. Één of meer van:

• 0 — kruist met
• 1 — bevat
• 2 — is gelĳk aan
• 2 — raken
• 4 — overlappen
• 5 — zĳn binnen
• 6 — kruisen

Als meer dan één voorwaarde wordt
gekozen, moet aan tenminste één worden
voldaan (bewerking OR) om een object uit
te kunnen nemen.

In vergelĳking
met

JOIN [vector: elke] De samen te voegen laag. Objecten van
deze vectorlaag zullen hun samenvattingen
van hun attributen toevoegen aan de
attributentabel van de bronlaag, als zĳ
voldoen aan de ruimtelĳke relatie.

Velden die
moeten worden
samengevat (laat
leeg om alle velden
te gebruiken)
Optioneel

JOIN_FIELDS [tabelveld: elk]
[lĳst]

Selecteer de specifieke velden die u wilt
toevoegen vanuit de samen te voegen laag.
Standaard worden alle velden toegevoegd.

Overzichten die
moeten worden
berekend (laat
leeg om alle velden
te gebruiken)
Optioneel

SUMMARIES [enumeratie] [lĳst]
Standaard: []

Voor elk invoerobject worden statistieken
berekend voor samengevoegde velden of
hun overeenkomende objecten. Één ofmeer
van:

• 0 — count
• 1 — uniek
• 2 — min
• 3 — max
• 4 — range
• 5 — sum
• 6 — mean
• 7 — median
• 8 — stddev
• 9 — minority
• 10 — majority
• 11 — q1
• 12 — q3
• 13 — iqr
• 14 — leeg
• 15 — gevuld
• 16 — min_length
• 17 — max_length
• 18 — mean_length

Records
verwĳderen
die niet konden
worden gekoppeld

DISCARD_NONMATCHING[Booleaanse
waarde]
Standaard: False

Verwĳder objecten van de invoerlaag, die
niet konden worden gekoppeld, uit de
uitvoer

Vervolgt op volgende pagina
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Tabel 27.127 – Vervolgd van vorige pagina
Label Naam Type Omschrijving
Samengevoegde
laag

OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag voor de
koppeling. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Omschrijving
Samengevoegde
laag

OUTPUT [hetzelfde als
invoer]

Uitvoer vectorlaag met samengevatte
attributen van de koppeling

Pythoncode

ID algoritme: qgis:joinbylocationsummary

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Koppel attributen op dichtstbijzijnde

Neemt een invoer vectorlaag en maakt een nieuwe vectorlaag met aanvullende velden in zĳn attributentabel. De
aanvullende attributen en hun waarden worden genomen uit een tweede vectorlaag. Objecten worden gekoppeld door
de dichtstbĳzĳnde objecten uit elke laag te zoeken.
Standaard wordt alleen het dichtstbĳzĳnde object gekoppeld, maar de koppeling kan ook de k-dichtstbĳzĳnde
naburige objecten koppelen.
Als een maximum afstand is gespecificeerd, zullen alleen objecten die dichterbĳ liggen dan deze afstand
overeenkomen.
Zie ook:
‘Dichtstbĳzĳnde buur’-analyse, Attributen koppelen op veldwaarde, Koppel attributen op basis van plaats,
Afstandsmatrix
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Parameters

Label Naam Type Omschrijving
Invoerlaag INPUT [vector: elke] De invoerlaag.
Invoerlaag 2 INPUT_2 [vector: elke] De koppellaag.
Velden van laag
2 om te kopiëren
(laat leeg om alle
velden te kopiëren)

FIELDS_TO_COPY [velden] Velden van koppellaag om te kopiëren
(indien leeg, worden alle velden
gekopieerd).

Records
verwĳderen
die niet konden
worden gekoppeld

DISCARD_NONMATCHING[Booleaanse
waarde]
Standaard: False

Verwĳder records van de invoerlaag, die
niet konden worden gekoppeld, uit de
uitvoer

Voorvoegsel
samengevoegde
velden

PREFIX [tekenreeks] Voorvoegsel samengevoegde velden

Maximum
dichtstbĳzĳnde
buren

NEIGHBORS [getal]
Standaard: 1

Maximum aantal dichtstbĳzĳnde buren

Maximum afstand MAX_DISTANCE [getal] Maximum zoekafstand
Samengevoegde
laag
Optioneel

OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoerlaag die de
samengevoegde objecten bevat. Één
van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Niet samen te
voegen objecten
uit eerste laag

NON_MATCHING [hetzelfde als
invoer]
Standaard:
[Uitvoer
overslaan]

Specificeer de vectorlaag die de objecten
bevat die niet samengevoegd konden
worden. Één van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Omschrijving
Samengevoegde
laag

OUTPUT [hetzelfde als
invoer]

De uitvoer samengevoegde laag

Niet samen te
voegen objecten
uit eerste laag

NON_MATCHING [hetzelfde als
invoer]

Laag die de objecten bevat uit de eerste laag,
die niet konden worden samengevoegd met
objecten in de koppellaag.

Vervolgt op volgende pagina
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Tabel 27.129 – Vervolgd van vorige pagina
Label Naam Type Omschrijving
Aantal niet samen
te voegen objecten
uit invoertabel

JOINED_COUNT [getal] Aantal objecten uit de invoertabel die zĳn
samengevoegd.

Aantal
samengevoegde
objecten uit
invoertabel

UNJOINABLE_COUNT[getal] Aantal objecten uit de invoertabel die niet
konden worden samengevoegd.

Pythoncode

ID algoritme: native:joinbynearest

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Vectorlagen samenvoegen

Combineert meerdere vectorlagen met hetzelfde type geometrie naar één enkele.
De attributentabel van de resulterende laag zal de velden bevatten uit alle invoerlagen. Als er velden worden gevonden
met dezelfde naam, maar van een ander type, dan zal het geëxporteerde veld automatisch worden geconverteerd naar
een veldtype tekenreeks. Nieuwe velden die de originele naam van de laag en de bron opslaan worden ook toegevoegd.
Als een van de invoerlagen waarden Z of M bevat, dan zal de uitvoerlaag die waarden ook bevatten. Soortgelĳk geldt
ook dat als een van de invoerlagen meerdelig is, dan zal de uitvoerlaag ook een meerdelige laag zĳn.
Optioneel kan het doel coördinaten referentiesysteem (CRS) voor de samengevoegde laag worden ingesteld. Als dat
niet is ingesteld zal het CRS uit de eerste invoerlaag worden genomen. Alle lagen zullen opnieuwworden geprojecteerd
om overeen te komen met dit CRS.

Standaard menu: Vector ► Datamanagement-gereedschap

Zie ook:
Vectorlaag splitsen
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Parameters

Label Naam Type Omschrijving
Invoerlagen LAYERS [vector: elke] [lĳst] De lagen die moeten worden samengevoegd

naar één enkele laag. Lagen zouden van
hetzelfde type geometrie moeten zĳn.

Doel-CRS
Optioneel

CRS [crs] Kies het CRS voor de uitvoerlaag. Indien
niet gespecificeerd, zal het CRS van de
eerste invoerlaag worden gebruikt.

Samengevoegd OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Omschrijving
Samengevoegd OUTPUT [hetzelfde als

invoer]
Uitvoer vectorlaag die alle objecten en
attributen uit de invoerlagen bevat.

Pythoncode

ID algoritme: native:mergevectorlayers

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Sorteren op expressie

Sorteert een vectorlaag overeenkomstig een expressie: wĳzigt de index van objecten overeenkomstig een expressie.
Wees voorzichtig, het zou misschien niet werken zoals verwacht met enkele providers, de volgorde zou niet elke keer
behouden kunnen worden.
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Parameters

Label Naam Type Omschrijving
Invoerlaag INPUT [vector: elke] Te sorteren invoer vectorlaag
Expressie EXPRESSION [expressie] Expressie om mee te sorteren
Oplopend sorteren ASCENDING [Booleaanse

waarde]
Standaard: True

Indien geselecteerd zal de vectorlaag
worden gesorteerd van lage naar hoge
waarden.

Eerst null sorteren NULLS_FIRST [Booleaanse
waarde]
Standaard: False

Indien geselecteerd worden waarden Null
als eerste geplaatst

Gesorteerd OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Omschrijving
Gesorteerd OUTPUT [hetzelfde als

invoer]
Uitvoer (gesorteerde) vectorlaag

Pythoncode

ID algoritme: native:orderbyexpression

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Shapefile repareren

Repareert een defecte gegevensset ESRI Shapefile door het SHX-bestand (opnieuw) te maken.
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Parameters

Label Naam Type Omschrijving
Invoer shapefile INPUT [bestand] Volledige pad naar de gegevensset ESRI

Shapefile met een ontbrekend of defect
SHX-bestand

Uitvoer

Label Naam Type Omschrijving
Gerepareerde laag OUTPUT [vector: elke] De invoer vectorlaag met het gerepareerde

SHX-bestand

Pythoncode

ID algoritme: native:repairshapefile

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Laag opnieuw projecteren

Projecteert een vectorlaag opnieuw naar een ander CRS. De opnieuw geprojecteerde laag zal dezelfde objecten en
attributen als de invoerlaag hebben.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt, lĳn en polygoon
Zie ook:
Projectie toekennen, Projectie voor Shapefile definiëren, Projectie zoeken

Parameters
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Basis parameters

Label Naam Type Omschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag om opnieuw te

projecteren
Doel-CRS TARGET_CRS [crs]

Standaard:
EPSG:4326
- WGS84

Doel coördinaten referentie systeem

Opnieuw
geprojecteerd

OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Gevorderde parameters

Label Naam Type Omschrijving
Coördinaten
bewerken
Optioneel

OPERATION [tekenreeks] Specifieke te gebruiken bewerking voor een
bepaalde taak voor opnieuw projecteren,
in plaats van het altĳd gebruiken van het
forceren van de transformatie-instellingen
van het huidige project. Nuttig bĳ het
opnieuw projecteren van een bepaalde laag
en beheer over de exacte transformatie-
pĳplĳn is vereist. Vereist proj versie >= 6.
Lees meer op Datumtransformaties.

Uitvoer

Label Naam Type Omschrijving
Opnieuw
geprojecteerd

OUTPUT [hetzelfde als
invoer]

Uitvoer (opnieuw geprojecteerde)
vectorlaag

Pythoncode

ID algoritme: native:reprojectlayer

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Vectorobjecten opslaan naar bestand

Slaat vectorobjecten op naar een gespecificeerd bestand voor de gegevensset.
Voor indelingen van gegevenssets ondersteunde lagenmag een optionele parameter voor de laagnaamworden gebruikt
om een aangepaste tekenreeks te specificeren. Optionele opties voorGDAL-gedefinieerde gegevensset en laag kunnen
worden gespecificeerd. Voor meer informatie hierover, lees de online documentatie van GDAL over de indeling.

Parameters

Basis parameters

Label Naam Type Omschrijving
Vectorobjecten INPUT [vector: elke] Invoer vectorlaag.
Opgeslagen
objecten

OUTPUT [hetzelfde als
invoer]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer het bestand waarin de objecten
moeten worden opgeslagen. Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Omschrijving
Laagnaam
Optioneel

LAYER_NAME [tekenreeks] Te gebruiken naam voor de uitvoerlaag

Opties voor
GDAL-
gegevensset
Optioneel

DATASOURCE_OPTIONS[tekenreeks] Opties voor het maken van GDAL-
gegevensset voor de indeling van de
uitvoer. Afzonderlĳke individuele opties
met puntkomma’s.

Opties voor laag
van GDAL
Optioneel

LAYER_OPTIONS [tekenreeks] Opties voor het maken van laag van
GDAL voor de indeling van de uitvoer.
Afzonderlĳke individuele opties met
puntkomma’s.

Uitvoer

Label Naam Type Omschrijving
Opgeslagen
objecten

OUTPUT [hetzelfde als
invoer]

Vectorlaag met de opgeslagen objecten.

Bestandsnaam en
pad

FILE_PATH [tekenreeks] Naam voor uitvoerbestand en pad.

Laagnaam LAYER_NAME [tekenreeks] Naam van de laag, indien aanwezig.
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Pythoncode

ID algoritme: native:savefeatures

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Codering van laag instellen

Stelt de gebruikte codering in voor het lezen van de attributen van de laag. Er worden geen permanente wĳzigingen
aan de laag gemaakt, anders dan hoe het lezen van de laag wordt beïnvloed gedurende de huidige sessie.

Notitie: Wĳzigen van de codering wordt alleen ondersteund voor sommige gegevensbronnen voor de vectorlaag.

Parameters

Label Naam Type Omschrijving
Opgeslagen
objecten

INPUT [vector: elke] Vectorlaag waarvoor de codering moet
worden ingesteld.

Codering ENCODING [tekenreeks] Codering van tekst om de laag toe te wĳzen
aan de huidige sessie van QGIS.

Uitvoer

Label Naam Type Omschrijving
Uitvoerlaag OUTPUT [hetzelfde als

invoer]
Invoer vectorlaag met de ingestelde
codering.

Pythoncode

ID algoritme: native:setlayerencoding

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Objecten splitsen op teken

Objecten worden gesplitst in meerdere uitvoerobjecten, door de waarde van een veld te splitsen op een gespecificeerd
teken. Als bĳvoorbeeld een laag objecten bevat met meerdere kommagescheiden waarden opgenomen in één veld, kan
dit algoritme worden gebruikt om deze waarden te splitsen naar meerdere uitvoerobjecten. Geometrieën en andere
attributen blĳven in de uitvoer ongewĳzigd. Optioneel mag de tekenreeks voor de scheiding een reguliere expressie
zĳn, voor toegevoegde flexibiliteit.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt, lĳn en polygoon

Parameters

Label Naam Type Omschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Splitsen op
waarden in veld

FIELD [tabelveld: elk] Te gebruiken veld voor splitsen

Waarden splitsen
op teken

CHAR [tekenreeks] Te gebruiken teken voor splitsen

Reguliere
expressie als
scheiding
gebruiken

REGEX [Booleaanse
waarde]
Standaard: False

Splitsen OUTPUT [hetzelfde als
invoer]
Standaard:
Tijdelijke
laag maken

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Omschrijving
Splitsen OUTPUT [hetzelfde als

invoer]
De uitvoer vectorlaag.

Pythoncode

ID algoritme: native:splitfeaturesbycharacter

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Vectorlaag splitsen

Maakt een set van vectors in een map voor uitvoer, gebaseerd op een invoerlaag en een attribuut. De map voor de
uitvoer zal net zoveel lagen bevatten als de gevonden unieke waarden in het gewenste veld.
Het aantal gemaakte bestanden is gelĳk aan het aantal verschillende gevonden waarden voor het gespecificeerde
attribuut.
Dit is de tegengestelde bewerking van samenvoegen.
Standaard menu: Vector ► Datamanagement-gereedschap

Zie ook:
Vectorlagen samenvoegen

Parameters

Basis parameters

Label Naam Type Omschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Uniek ID-veld FIELD [tabelveld: elk] Te gebruiken veld voor splitsen
Map voor uitvoer OUTPUT [map]

Standaard:
[Opslaan naar
tijdelijke
map]

Specificeer de map voor de uitvoerlagen.
Één van:

• Opslaan in tĳdelĳke map
• Opslaan naar map

Gevorderde parameters

Label Naam Type Omschrijving
Type
uitvoerbestand
Optioneel

FILE_TYPE [enumeratie]
Standaard: gpkg in
het dialoogvenster

Selecteer de extensie voor de
uitvoerbestanden. Indien niet
gespecificeerd of ongeldig, zal de indeling
voor de uitvoerbestanden die zĳn welke is
ingesteld voor de instelling van Processing
“Standaard uitvoer vectorlaagextensie”.

Uitvoer

Label Naam Type Omschrijving
Map voor uitvoer OUTPUT [map] De map voor de uitvoerlagen
Uitvoerlagen OUTPUT_LAYERS [hetzelfde als

invoer] [lĳst]
De uitvoer vectorlagen die het resultaat van
het splitsen zĳn.
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Pythoncode

ID algoritme: native:splitvectorlayer

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Tabel afbreken

Verkleint een laag door alle objecten van die laag te verwĳderen.

Waarschuwing: Dit algoritme past de laag ter plekke aan en verwĳderde objecten kunnen niet worden
teruggeplaatst!

Parameters

Label Naam Type Omschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag

Uitvoer

Label Naam Type Omschrijving
Afgebroken laag OUTPUT [map] De afgebroken (lege) laag

Pythoncode

ID algoritme: native:truncatetable

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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27.1.18 Vector geometrie

Attributen voor geometrie toevoegen

Berekent geometrische eigenschappen van de objecten in een vectorlaag en neemt die op in de uitvoerlaag.
Het maakt een nieuwe vectorlaag met dezelfde inhoud als die van de invoer, maar met aanvullende attributen die
geometrische berekeningen bevatten, gebaseerd op een geselecteerd CRS.
De aan de tabel toegevoegde attributen zĳn afhankelĳk van het type geometrie en de dimensie van de invoerlaag:

• voor lagen punt: coördinaten X (xcoord), Y (ycoord), Z (zcoord) en/of waarde M (mvalue)
• voor lagen lĳn: length en voor de typen geometrie LineString en CompoundCurve, ook de sinuosity
en rechte afstand (straightdis) van het object

• voor lagen polygoon: perimeter en area
Standaard menu: Vector ► Geometrie-gereedschappen

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Bereken met CALC_METHOD [enumeratie]

Standaard: 0
Parameters voor berekeningen om
te gebruiken voor de geometrische
eigenschappen. Één van:

• 0 — Laag-CRS
• 1 — Project-CRS
• 2 — Ellipsoïde

Geom-info
toegevoegd

OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer (kopie van invoermet
geometrieën). Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Geom-info
toegevoegd

OUTPUT [hetzelfde als
invoer]

Kopie van de invoer vectorlaag met
toevoeging van de velden voor geometrie
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Pythoncode

ID algoritme: qgis:exportaddgeometrycolumns

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Affiene transformatie

Past een affiene transformatie toe op de geometrieën van de laag. Affiene transformaties kunnen vertalingen, op
schaal brengen en rotatie bevatten. De bewerkingen worden uitgevoerd in de volgende volgorde: op schaal brengen,
rotatie en vertaling.
Waarden Z en M (indien aanwezig) kunnen worden vertaald en op schaal gebracht.

Fig. 27.50: Vector puntlaag (groene punten) vóór (links), en na (rechts) een affiene transformatie (vertaling).

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt, lĳn en polygoon
Zie ook:
Transleren

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag

Vertaling (X-as) DELTA_X [getal ]
Standaard: 0

Toe te passen verplaatsing op de X-as.

Vertaling (Y-as) DELTA_Y [getal ]
Standaard: 0

Toe te passen verplaatsing op de Y-as.

Vervolgt op volgende pagina
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Tabel 27.133 – Vervolgd van vorige pagina
Label Naam Type Beschrijving

Vertaling (Z-as) DELTA_Z [getal ]
Standaard: 0

Toe te passen verplaatsing op de Z-as.

Vertaling
(waarden M)

DELTA_M [getal ]
Standaard: 0

Toe te passen verschuiving op waarden M.

Schaalfactor
(X-as)

SCALE_X [getal ]
Standaard: 1

Schaalwaarde (vergoten of verkleinen) om
toe te passen op de X-as.

Schaalfactor
(Y-as)

SCALE_Y [getal ]
Standaard: 1

Schaalwaarde (vergoten of verkleinen) om
toe te passen op de Y-as.

Schaalfactor
(Z-as)

SCALE_Z [getal ]
Standaard: 1

Schaalwaarde (vergoten of verkleinen) om
toe te passen op de Z-as.

Schaalfactor
(waarden M)

SCALE_M [getal ]
Standaard: 1

Schaalwaarde (vergoten of verkleinen) om
toe te passen op waarden M.

Rotatie rondom Z-
as (graden tegen
de klok in)

ROTATION_Z [getal ]
Standaard: 0

Hoek voor de rotatie in graden.

Getransformeerd OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Getransformeerd OUTPUT [hetzelfde als

invoer]
Uitvoer (getransformeerde) vectorlaag.

Pythoncode

ID algoritme: native:affinetransform

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Samenvoegen

Neemt een vector-of tabellaag en maakt een nieuwe laag door objecten samen te voegen, gebaseerd op een expressie
group by.
Objecten waar de expressie group by dezelfde waarde teruggeeft worden gegroepeerd.
Het is mogelĳk alle bronobjecten samen te voegen met een constante waarde in de parameter group by,
bĳvoorbeeld: NULL.
Het is ook mogelĳk objecten te groeperen op meerdere velden met de functie Array, bĳvoorbeeld: Array(“Veld1”,
“Veld2”).
Geometrieën (indien aanwezig) worden gecombineerd tot één meerdelige geometrie voor elke groep. Attributen voor
uitvoer worden berekend afhankelĳk van elke opgegeven definitie voor samenvoegen.
Dit algoritme maakt het mogelĳk de standaard functies voor samenvoegen van het programma voor expressies van
QGIS te gebruiken.
Zie ook:
Geometrieën verzamelen, Samensmelten

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Groeperen op
expressie

GROUP_BY [tabelveld: elk]
Standaard: ‘NULL’

Kies het veld waarop gegroepeerd moet
worden. Indien NULL zullen alle objecten
worden gegroepeerd.

Vervolgt op volgende pagina
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Tabel 27.135 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Samenvoegen AGGREGATES [lĳst] Lĳst van velden in de uitvoerlaag met hun

definities. Voorbeeld van een velddefinitie:
{‘aggregate’: ‘sum’, ‘delimiter’: ‘,’, ‘input’:
‘ $area’, ‘length’: 10, ‘name’: ‘totarea’,
‘precision’: 0, ‘type’: 6}
Standaard bevat de lĳst alle velden van de
invoerlaag. U kunt, in de GUI, deze velden
en hun definities bewerken, en u kunt ook:

• Klikken op de knop om een
nieuw veld toe te voegen.

• Klikken op om het geselecteerde
veld te verwĳderen.

• en gebruiken om de volgorde
van de velden te wĳzigen.

• Klikken op om terug te zetten
naar de standaard (de velden van de
invoerlaag).

Voor elk van de velden waaruit u informatie
zou willen ophalen, dient u het volgende te
definiëren:
Invoer expressie [expressie]
(input)

Veld of expressie uit de invoerlaag.
Functie Samenvoegen
[enumeratie] (aggregate)

Functie om te gebruiken in de invoer
expressie om de samengevoegde
waarde terug te geven.
Standaard: concatenate (voor
gegevenstype tekenreeks), sum (voor
numerieke gegevenstypen)

Scheidingsteken [tekenreeks]
(delimiter)

Teksttekenreeks om samengevoegde
waarden te scheiden, bĳvoorbeeld in
het geval van samenvoegingen.
Standaard: ,

Naam veld uitvoer [tekenreeks]
(name)

Naam van het samengevoegde veld
in de uitvoerlaag. Standaard wordt de
invoernaam behouden.

Type [enumeratie] (type)
Gegevenstype van het veld van de
uitvoer. Één van:

• 1 — Booleaanse waarde
• 2 — Integer
• 4 — Integer64
• 6 — Double
• 10 — String
• 14 — Date
• 16 — DateTime

Lengte [getal] (length)
Lengte van het veld van de uitvoer.

Precisie [getal] (precision)
Precisie van het veld van de uitvoer.

Vervolgt op volgende pagina
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Tabel 27.135 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Velden uit laag
laden

Alleen GUI [vector: elke] U kunt ook velden uit een andere laag
laden en die velden gebruiken voor het
samenvoegen

Samengevoegd OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoerlaag (samengevoegd).
Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Samengevoegd OUTPUT [hetzelfde als

invoer]
Multigeometrie vectorlaag met
samengevoegde waarden

Pythoncode

ID algoritme: native:aggregate

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Grens

Geeft de sluiting terug van de gecombineerde grens van de geometrieën voor de invoer (d.i. de topologische grens
van de geometrie).
Alleen voor polygoon- en lĳnlagen.
Voor geometrieën polygoon bestaat de grens uit alle lĳnen die de ringen van de polygoon maken

Fig. 27.51: Grenzen (zwart gestreepte lijn) van de bron-polygoonlaag

Voor geometrieën lĳnen zĳn de grenzen hun eindpunten

Fig. 27.52: Grenslaag (rode punten) voor lijnen. In geel een geselecteerd object.
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn,

polygoon]
Invoer lĳn- of polygoonvectorlaag

Grens OUTPUT [vector: punt, lĳn]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoerlaag (grens). Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Grens OUTPUT [vector: punt, lĳn] Grens van de invoerlaag (punt voor lĳn en

lĳn voor polygoon)

Pythoncode

ID algoritme: native:boundary

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Begrenzingsvakken

Berekent het begrenzingsvak (enveloppe) van elk object in een invoerlaag. Geometrieën polygoon en lĳn worden
ondersteund.

Fig. 27.53: Zwarte lijnen geven de begrenzingsvakken van elk object polygoon weer

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten polygoon
Zie ook:
Minimum begrenzing geometrie

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn,

polygoon]
Invoer lĳn- of polygoonvectorlaag

Grenzen OUTPUT [vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoerlaag
(begrenzingsvak). Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Beschrijving
Grenzen OUTPUT [vector: polygoon] Begrenzingsvakken van de invoerlaag

Pythoncode

ID algoritme: native:boundingboxes

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Buffer

Berekent een buffergebied met een vaste of data-bepaalde afstand voor alle objecten op een invoerlaag.
Het is mogelĳk een negatieve afstand te gebruiken voor invoerlagen polygoon. In dat geval zal de buffer resulteren in
een kleinere polygoon (setback).

Fig. 27.54: Buffer (in geel) van punten, lijn, polygoon met positieve buffer, en polygoon met negatieve buffer

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten polygoon
Standaard menu: Vector ► Geoprocessing-gereedschap.
Zie ook:
Variabele bufferafstand, Multi-ring buffer (constante afstand), Variabele breedte buffer (op M-waarde)
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag

Afstand DISTANCE [getal ]
Standaard: 10.0

Afstand voor de buffer (vanuit de grens van
elk object). U kunt de knop Data-bepaalde
‘override’ aan de rechterkant gebruiken om
een veld te kiezen vanwaaruit de straal moet
worden berekend. Op deze manier kunt u
een verschillende straal hebben voor elk
object (zie Variabele bufferafstand).

Segmenten SEGMENTS [getal]
Standaard: 5

Beheert het aantal te gebruiken
lĳnsegmenten om een kwart cirkel te
benaderen bĳ het maken van ronde
verschuivingen.

Stĳl eindkap END_CAP_STYLE [enumeratie]
Standaard: 0

Beheert hoe einden van lĳnen worden
afgehandeld in de buffer. Één van:

• 0 — Afgerond
• 1 — Vlak
• 2 — Vierkant

Fig. 27.55: Ronde, vlakke en vierkante
eindstĳlen

Verbindingsstĳl JOIN_STYLE [enumeratie]
Standaard: 0

Specificeert of ronde, hoekige of puntige
verbindingsstĳlen zouden moeten worden
gebruikt bĳ het verschuiven van hoeken in
een lĳn. Opties zĳn:

• 0 — Afgerond
• 1 — Puntig
• 2 — Hoekig

Fig. 27.56: Ronde, diagonale en schuine
koppelstĳlen

Vervolgt op volgende pagina
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Tabel 27.136 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Maximale
puntlengte bĳ
scherpe hoeken

MITER_LIMIT [getal]
Standaard: 2.0

Stelt de maximale afstand van de
te gebruiken geometrie voor de
verschuiving bĳ het maken van een
puntige verbindingsstĳl in als een factor
van de afstand van de verschuiving
(alleen van toepassing voor puntige
verbindingsstĳlen). Minimum: 1.0

Fig. 27.57: Een buffer van 10m met een
limiet van 2 en een buffer van 10m met een
limiet van 1

Resultaat
samenvoegen

DISSOLVE [Booleaanse
waarde]
Standaard: False

De uiteindelĳke buffer samenvoegen.
Indien True (geselecteerd) zullen
overlappende buffers worden
samengesmolten (gecombineerd)
tot een één enkel meerdelig object.

Fig. 27.58: Standaard (drie eendelige
objecten - links), samengevoegd (1
meerdelig object met 2 delen - rechts)

Gebufferd OUTPUT [vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoerlaag (buffer). Één
van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Beschrijving
Gebufferd OUTPUT [vector: polygoon] Uitvoer (buffer) polygoonlaag

Pythoncode

ID algoritme: native:buffer

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Zwaartepunten

Maakt een nieuwe puntenlaag met punten die het zwaartepunt van de geometrieën van de invoerlaag weergeven.
Het zwaartepunt is één enkel punt dat het midden (van alle delen) van het object weergeeft, dus het kan buiten de
grenzen van het object liggen. Maar het kan ook een punt zĳn op elk deel van het object.
De attributen van de punten in de uitvoerlaag zĳn hetzelfde als voor de originele objecten.

Fig. 27.59: De rode sterren geven de zwaartepunten van de objecten van de invoerlaag weer.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt
Standaard menu: Vector ► Geometrie-gereedschappen
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Zie ook:
Punt op oppervlak

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Zwaartepunt voor
elk deel maken

ALL_PARTS [Booleaanse waarde
]

Standaard: False

Indien True (geselecteerd) zal een punt
voor elk afzonderlĳk deel van de geometrie
worden gemaakt

Zwaartepunten OUTPUT [vector: punt]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoerlaag (zwaartepunten).
Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Zwaartepunten OUTPUT [vector: punt] Uitvoer punten vectorlaag (zwaartepunten)

Pythoncode

ID algoritme: native:centroids

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Geldigheid controleren

Voert een controle op geldigheid uit op de geometrieën van een vectorlaag.
De geometrieën worden geclassificeerd in drie groepen (geldig, ongeldig en fout) en voor elke groep wordt een
vectorlaag met zĳn objecten gemaakt:

• De laag Geldige uitvoer bevat alleen de geldige objecten (zonder topologische fouten).
• De laag Ongeldige uitvoer bevat alle door het algoritme gevonden ongeldige objecten.
• De laag Foutieve uitvoer is de puntenlaag waar de ongeldige objecten zĳn gevonden.
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De attributentabel van de gemaakte lagen zal enige aanvullende informatie bevatten (“message” voor de laag Foutieve
uitvoer, “FID” en “_errors” voor de laag Ongeldige uitvoer en alleen “FID” voor de laag Geldige uitvoer):
De attributentabel van elke gemaakte vectorlaag zal enige aanvullende informatie bevatten (aantal gevonden fouten
en type fouten):

Fig. 27.60: Links: de invoerlaag. Rechts: de geldige laag (groen), de ongeldige laag (oranje)

Standaard menu: Vector ► Geometrie-gereedschappen

Zie ook:
Geometrieën repareren en de bronplug-in Plug-in Geometrieën controleren

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT_LAYER [vector: elke] Invoer vectorlaag
Methode METHOD [enumeratie]

Standaard: 2
Te gebruiken methode om geldigheid te
controleren. Opties:

• 0: De geselecteerde in de instellingen
voor digitaliseren

• 1: QGIS
• 2: GEOS

Zelfkruisende
ringen negeren

IGNORE_RING_SELF_INTERSECTION[Booleaanse
waarde]
Standaard: False

Zelfkruisende ringen negeren bĳ
controleren van geldigheid.

Geldige uitvoer VALID_OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de vectorlaag die een kopie
bevat van de geldige objecten van de
bronlaag. Één van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Vervolgt op volgende pagina
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Tabel 27.137 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Ongeldige uitvoer INVALID_OUTPUT [hetzelfde als

invoer]
Standaard:
[Tijdelijke
laag maken]

Vectorlaag die een kopie bevat van de
ongeldige objecten van de bronlaag, met het
veld _errors dat het overzicht geeft van
de gevonden fout(en). Één van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Foutieve uitvoer ERROR_OUTPUT [vector: punt]
Standaard:
[Tijdelijke
laag maken]

Puntenlaag van de exacte positie van de
problemen met de geldigheid, gedetecteerd
met het veld message dat de gevonden
fout(en) beschrĳft. Één van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Aantal fouten ERROR_COUNT [getal] Het aantal geometrieën dat fouten

veroorzaakte.
Foutieve uitvoer ERROR_OUTPUT [vector: punt] Puntenlaag van de exacte positie van de

problemen met de geldigheid, gedetecteerd
met het veld message dat de gevonden
fout(en) beschrĳft.

Aantal ongeldige
objecten

INVALID_COUNT [getal] Het aantal ongeldige geometrieën.

Ongeldige uitvoer INVALID_OUTPUT [hetzelfde als
invoer]

Vectorlaag die een kopie bevat van de
ongeldige objecten van de bronlaag, met het
veld _errors dat het overzicht geeft van
de gevonden fout(en).

Aantal geldige
objecten

VALID_COUNT [getal] Het aantal geldige geometrieën.

Geldige uitvoer VALID_OUTPUT [hetzelfde als
invoer]

Vectorlaag die een kopie bevat van de
geldige objecten van de bronlaag.

27.1. QGIS algoritme provider 1259



QGIS Desktop 3.28 User Guide

Pythoncode

ID algoritme: qgis:checkvalidity

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Typen foutberichten en hun betekenissen

Tabel 27.139: Als de methode GEOS werd gebruikt kunnen de volgende
foutberichten optreden:

Foutbericht Uitleg Voorbeeld

Herhaald punt Deze fout treedt op als een
bepaald punt wordt herhaald.

Ring is zelfkruisend Deze fout treedt op als een
geometrie zichzelf raakt en een
ring maakt.

Vervolgt op volgende pagina
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Tabel 27.139 – Vervolgd van vorige pagina
Foutbericht Uitleg Voorbeeld

Zelfkruisend Deze fout treedt op als een
geometrie zichzelf raakt.

Fout bĳ valideren van topologie
Gat ligt buiten schil
Gaten zĳn genest
Interieur is niet verbonden

Geneste schillen Deze fout treedt op als een
geometrie polygoon bovenop
een andere geometrie polygoon
ligt.

Duplicaatringen Deze fout treedt op als twee
ringen (exterieur of interieur)
van een geometrie polygoon
identiek zĳn

Te weinig punten in component
van geometrie

Vervolgt op volgende pagina
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Tabel 27.139 – Vervolgd van vorige pagina
Foutbericht Uitleg Voorbeeld
Ongeldig coördinaat Voor een geometrie punt treedt

deze fout op als de geometrie
geen correct paar coördinaten
heeft. Het paar coördinaten
bevat geen waarde latitude en
een waarde longitude, in die
volgorde.

Ring is niet gesloten

Tabel 27.140: Als de methode QGIS werd gebruikt kunnen de volgende
foutberichten optreden:

Foutbericht Uitleg Voorbeeld
Segment %1 van ring %2 van
polygoon %3 kruist segment %4
van ring %5 van polygoon %6 op
%7
Ring %1 met minder dan vier
punten
Ring %1 niet gesloten
Lĳn %1 heeft minder dan twee
punten

Lĳn %1 bevat %n dubbele punt(en)
bĳ %2

Deze fout treedt op als
opeenvolgende punten op een
lĳn dezelfde coördinaten hebben.

Segmenten %1 en %2 van lĳn %3
kruisen bĳ %4

Deze fout treedt op als een lĳn
zichzelf kruist (twee segmenten van
de lĳn kruisen elkaar).

Vervolgt op volgende pagina
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Tabel 27.140 – Vervolgd van vorige pagina
Foutbericht Uitleg Voorbeeld

Ring is zelfkruisend Deze fout treedt op als een buitenste
of binnenste (eiland) ring / grens
van een geometrie polygoon
zichzelf kruist.

Ring %1 van polygoon %2 niet
binnen buitenste ring

Polygoon %1 ligt binnen polygoon
%2

Deze fout treedt op als een deel
van een geometrie MultiPolygoon
binnen een gat van een geometrie
MultiPolygoon ligt.

Geometrieën verzamelen

Neemt een vectorlaag en verzamelt daarvan de geometrieën in nieuwe meerdelige geometrieën.
Eén of meer attributen kunnen worden gespecificeerd om alleen geometrieën te verzamelen die behoren tot dezelfde
klasse (die dezelfde waarde hebben voor de gespecificeerde attributen), als alternatief kunnen alle geometrieën
worden verzameld.
Alle uitgevoerde geometrieën zullen worden geconverteerd naar geometrieënmetmeerdere delen, zelfs diemet slechts
één enkel deel. Dit algoritme smelt geen overlappende geometrieën samen - zĳ zullen worden verzameld zonder de
vorm van elke deel van de geometrie aan te passen.
Bekĳk de algoritmes ‘Promote to multipart’ of ‘Aggregate’ voor alternatieve opties.
Standaard menu: Vector ► Geometrie-gereedschappen

Zie ook:
Samenvoegen, Bevorderen naar meerdelig, Samensmelten
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Unieke ID-velden FIELD [tabelveld: elk]

[lĳst]
Kies één of meer attributen om de
geometrieën van te verzamelen

Verzameld OUTPUT [hetzelfde als
invoer]

Vectorlaag met verzamelde geometrieën

Uitvoer

Label Naam Type Beschrijving
Verzameld OUTPUT [hetzelfde als

invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag voor de
verzamelde objecten. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Pythoncode

ID algoritme: native:collect

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Holle schil (alfavormen)

Berekent de concave hull (holle schil) van de objecten op een invoer puntenlaag.

Fig. 27.61: Holle schillen (concave hulls) met verschillende drempels (0.3, 0.6, 0.9)

Zie ook:
Convex hull (Bolle schil), Holle schil (k-dichtstbĳzĳnde buur)

Parameters

Label Naam Type Beschrijving
Invoer puntlaag INPUT [vector: punt] Invoer punt-vectorlaag
Drempel ALPHA [getal]

Standaard: 0.3
Getal tussen 0 (maximale concave hull) tot
en met 1 (convex hull).

Gaten toestaan HOLES [Booleaanse
waarde]
Standaard: True

Kiezen of gaten zĳn toegestaan in de
uiteindelĳke holle schil

Meerdelige
geometrie splitsen
in eendelige
geometrieën

NO_MULTIGEOMETRY[Booleaanse
waarde]
Standaard: True

Selecteren indien u ééndelige geometrieën
wilt in plaats van meerdelige.

Holle schil OUTPUT [vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Beschrijving
Holle schil OUTPUT [vector: polygoon] De uitvoer vectorlaag

Pythoncode

ID algoritme: qgis:concavehull

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Holle schil (k-dichtstbijzijnde buur)

Maakt een polygoon holle schil (concave hull) uit een set punten. Als de invoerlaag een lĳn of polygoonlaag is, zal
het de hoekpunten gebruiken.
Het aantal te overwegen buren bepaalt de holling van de uitvoerpolygoon. Een lager getal zal resulteren in een concave
hull die de punten zeer dicht volgt, waar een hoger getal een gladdere vorm zal hebben. Het minimaal in aanmerking
komende buurpunten is 3. Een waarde gelĳk aan of groter dan het aantal punten zal resulteren in een convex hull.
Als een veld is geselecteerd zal het algoritme de objecten op de invoerlaag groeperen met unieke waarden in dat veld
en individuele polygonen in de uitvoerlaag maken voor elke groep.
Zie ook:
Holle schil (alfavormen)
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Aantal naburige
punten waarmee
rekening moet
worden gehouden
(een lager getal
is meer hol, een
hoger getal is
vlakker)

KNEIGHBORS [getal]
Standaard: 3

Bepaalt de holling van de uitvoerpolygoon.
Een lager getal zal resulteren in een holle
schil (concave hull) die de punten zeer dicht
volgt, terwĳl een hoger getal er voor zal
zorgen dat de polygoon er meer uitziet als
de bolle schil (convex hull). (als het aantal
punten gelĳk of groter is dan het aantal
objecten, zal het resultaat een convex hull
zĳn). Minimum waarde: 3.

Veld
Optioneel

FIELD [tabelveld: elk]
Standaard: Geen

Indien gespecificeerd wordt één polygoon
concave hull gemaakt voor elke unieke
waarde van het veld (door objecten te
selecteren met deze waarde).

Holle schil OUTPUT [vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Holle schil OUTPUT [vector: polygoon] De uitvoer vectorlaag

Pythoncode

ID algoritme: qgis:knearestconcavehull

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Type geometrie converteren

Maakt een nieuwe laag, gebaseerd op een bestaande, met een ander type geometrie.
De attributentabel van de uitvoerlaag is dezelfde als die van de invoerlaag.
Niet alle conversies zĳn mogelĳk. Een lĳnlaag, bĳvoorbeeld, kan worden geconverteerd naar een puntenlaag, maar
een puntenlaag kan niet worden geconverteerd naar een lĳnlaag.
Zie ook:
Polygoniseren, Lĳnen naar polygonen, Polygonen naar lĳnen, Punten naar pad

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Nieuw type
geometrie

TYPE [enumeratie]
Standaard: 0

Type geometrie om toe te passen op de
objecten van de uitvoer. Één van:

• 0 — Zwaartepunten
• 1 — Knopen
• 2 — Lĳnen
• 3 — Multilĳnen
• 4 — Polygonen

Geconverteerd OUTPUT [vector: elke]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Geconverteerd OUTPUT [vector: elke] Uitvoer vectorlaag - het type is afhankelĳk

van de parameters

Pythoncode

ID algoritme: qgis:convertgeometrytype

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Converteren naar gebogen geometrieën

Converteert een geometrie naar zĳn equivalent als gebogen geometrie.
Reeds gebogen geometrieën zullen zonder wĳzigingen worden behouden.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten lĳn en polygoon

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn of

polygoon]
Invoer vectorlaag

Maximum afstand
tolerantie

DISTANCE [getal]
Standaard:
0.000001

De maximale toegestane afstand tussen
de originele locatie van punten en waar
zĳ zouden vallen op de geconverteerde
gebogen geometrieën.

Maximum hoek
tolerantie

ANGLE [getal]
Standaard:
0.000001

Segmenten worden beschouwd als geschikt
voor vervangen door een boog als de
punten allemaal regelmatig zĳn geplaatst
op de kandidaat-boog. Deze parameter
specificeert de maximale toegestane
afwĳking van de hoek (in graden) bĳ het
testen van de regelmatige plaatsing van de
punten. Tussen 0 en 45°.

Bogen OUTPUT [vector:
compoundboog
of boogpolygoon]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Bogen OUTPUT [vector:

compoundboog
of boogpolygoon]

Uitvoer vectorlaag met gebogen
geometrieën.
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Pythoncode

ID algoritme: native:converttocurves

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Convex hull (Bolle schil)

Berekent de convex hull (bolle schil) voor elk object in een invoerlaag.
Bekĳk het algoritme ‘Minimum begrenzing geometrie’ voor een berekening van de convex hull die de gehele laag
bedekt of gegroepeerde subsets van objecten.

Fig. 27.62: Zwarte lijnen geven de convex hull voor elk object van de laag weer

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten polygoon
Standaard menu: Vector ► Geoprocessing-gereedschap.
Zie ook:
Minimum begrenzing geometrie, Holle schil (alfavormen)
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Bolle schil (convex
hull)

OUTPUT [vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Bolle schil (convex
hull)

OUTPUT [vector: polygoon] De uitvoer (bolle schil) vectorlaag

Pythoncode

ID algoritme: native:convexhull

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Laag uit bereik maken

Maakt een nieuwe vectorlaag die één enkel object bevat met een geometrie die overeenkomt met het bereik van de
invoerlaag.
Het kan in modellen worden gebruikt om een letterlĳk bereik (indeling xmin, xmax, ymin, ymax) naar een laag
te converteren die kan worden gebruikt voor andere algoritmes die een op een laag gebaseerde invoer vereisen.
Zie ook:
Laag uit punt maken
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Parameters

Label Naam Type Beschrijving
Bereik (xmin,
xmax, ymin,
ymax)

INPUT [bereik] Bereik invoer
Beschikbare methoden zĳn:

• Uit laag berekenen…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

Bereik OUTPUT [vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Bereik OUTPUT [vector: polygoon] De uitvoer (bereik) vectorlaag

Pythoncode

ID algoritme: native:extenttolayer

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

1272 Hoofdstuk 27. Processing providers en algoritmes



QGIS Desktop 3.28 User Guide

Laag uit punt maken

Maakt een nieuwe vectorlaag die één enkel object bevat met een geometrie die overeenkomt met een parameter punt.
Het kan worden gebruikt in modellen om een punt te converteren naar een puntlaag voor algoritmes die een op een
laag gebaseerde invoer vereisen.
Zie ook:
Laag uit bereik maken

Parameters

Label Naam Type Beschrijving
Punt INPUT [coördinaten] Invoer punt, inclusief info over CRS

(voorbeeld: 397254,6214446
[EPSG:32632]).
Als het CRS niet wordt opgegeven, zal het
project-CRS worden gebruikt.
Het punt kan worden gespecificeerd door te
klikken in het kaartvenster.

Punt OUTPUT [vector: punt]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoerlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Punt OUTPUT [vector: punt] De uitvoer punt vectorlaag die het

invoerpunt bevat.

Pythoncode

ID algoritme: native:pointtolayer

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Wigvormige buffers maken

Maakt wigvormige buffers vanuit invoerpunten.

Fig. 27.63: Wigvormige buffers

De eigen uitvoer voor dit algoritme zĳn geometrieën CurvePolygon, maar deze mogen automatisch worden
gesegmenteerd naar polygonen, afhankelĳk van de indeling van de uitvoer.
Zie ook:
Buffer, Variabele breedte buffer (op M-waarde), Taps toelopende buffers

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: punt] Invoer punt-vectorlaag

Azimut (graden
vanaf Noord)

AZIMUTH [getal ]
Standaard: 0.0

Hoek (in graden) als de middelste waarde
van de wig

Vervolgt op volgende pagina
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Tabel 27.143 – Vervolgd van vorige pagina
Label Naam Type Beschrijving

Wigbreedte (in
graden)

WIDTH [getal ]
Standaard: 45.0

Breedte buffer (in graden). De wig
zich zal uitstrekken tot de helft van
de breedte van de hoek aan elke
zĳde van de richting van de azimut.

Fig. 27.64: Waarden azimut en breedte van
de wigvormige buffer.

Buitenste straal OUTER_RADIUS [getal ]
Standaard: 1.0

De buitenste grootte (lengte) van de wig: de
grootte wordt berekend vanaf het bronpunt
tot de rand van de vorm van de wig.

Binnenste straal
Optioneel

INNER_RADIUS [getal ]
Standaard: 0.0

Waarde voor de binnenste straal. Indien 0
zal de wig beginnen vanuit het bronpunt.

Buffers OUTPUT [vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Buffers OUTPUT [vector: polygoon] De uitvoer (wigbuffer) vectorlaag
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Pythoncode

ID algoritme: native:wedgebuffers

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Delauney-triangulatie

Maakt een polygoonlaag met de Delaunay-triangulatie die overeenkomt met de invoer puntenlaag.

Fig. 27.65: Delaunay-triangulatie op punten

Standaard menu: Vector ► Geometrie-gereedschappen

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: punt] Invoer punt-vectorlaag
Delaunay-
triangulatie

OUTPUT [vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Beschrijving
Delaunay-
triangulatie

OUTPUT [vector: polygoon] De uitvoer (Delaunay-triangulatie)
vectorlaag

Pythoncode

ID algoritme: qgis:delaunaytriangulation

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Gaten verwijderen

Neemt een polygonen-laag en verwĳdert gaten in polygonen. Het maakt een nieuwe vectorlaag waarin polygonen met
gaten zĳn vervangen door polygonen met alleen hun externe ring. Attributen worden niet aangepast.
Een optionele parameter voor een minimum gebied maakt het mogelĳk alleen gaten te verwĳderen die kleiner zĳn
dan een bepaalde drempelwaarde voor het gebied. Deze parameter laten staan op 0.0 leidt er toe dat alle gaten zullen
worden verwĳderd.

Fig. 27.66: Voor en na het schoonmaken

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten polygoon
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: polygoon] Invoer polygoon-vectorlaag

Gaten met een
gebied kleiner dan
… verwĳderen
Optioneel

MIN_AREA [getal ]
Standaard: 0.0

Alleen gaten met een gebied dat kleiner
is dan deze drempel zullen worden
verwĳderd. Met waarde 0.0 zullen alle
gaten worden verwĳderd.

Schoongemaakt OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Schoongemaakt OUTPUT [hetzelfde als

invoer]
De uitvoer (schoongemaakte) vectorlaag

Pythoncode

ID algoritme: native:deleteholes

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Verdichten op aantal

Neemt een polygonen-laag en maakt een nieuwe polygonen-laag waarin de geometrieën een groter aantal punten
hebben dan de originele.
Als de invoergeometrie Z- of M-waarden bevat zullen die lineair worden geïnterpoleerd voor de nieuwe punten.
Het aantal toe te voegen nieuwe punten voor elk segment wordt gespecificeerd als een parameter voor de invoer.
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Fig. 27.67: Rode punten geven de punten weer voor en na het verdichten

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten lĳn en polygoon
Standaard menu: Vector ► Geometrie-gereedschappen

Zie ook:
Verdichten op interval

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn,

polygoon]
Invoer lĳn- of polygoonvectorlaag

Toe te voegen
punten

VERTICES [getal]
Standaard: 1

Aantal aan elk segment toe te voegen
punten

Verdicht OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Verdicht OUTPUT [hetzelfde als

invoer]
De uitvoer (verdichte) vectorlaag
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Pythoncode

ID algoritme: native:densifygeometries

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Verdichten op interval

Neemt een polygonen-laag en maakt een nieuwe polygonen-laag waarin de geometrieën een groter aantal punten
hebben dan de originele.
De geometrieën worden verdicht door binnen elk segment regelmatig geplaatste extra punten toe te voegen zodat de
maximale afstand tussen twee punten de gespecificeerde afstand niet overschrĳdt.
Als de invoergeometrie Z- of M-waarden bevat zullen die lineair worden geïnterpoleerd voor de nieuwe punten.
Voorbeeld
Specificeren van een afstand van 3 zou er voor zorgen dat het segment [0 0] -> [10 0] zal worden geconverteerd
naar [0 0] -> [2.5 0] -> [5 0] -> [7.5 0] -> [10 0], omdat 3 extra punten op het segment
zĳn vereist en door ze te plaatsen in stappen van 2.5, is het mogelĳk dat zĳ gelĳkmatig worden verspreid over het
segment.

Fig. 27.68: Geometrie verdichten met een opgegeven interval

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten lĳn en polygoon
Zie ook:
Verdichten op aantal
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn,

polygoon]
Invoer lĳn- of polygoonvectorlaag

Interval tussen toe
te voegen punten

INTERVAL [getal ]
Standaard: 1.0

Maximum afstand tussen twee
opeenvolgende punten

Verdicht OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Verdicht OUTPUT [hetzelfde als

invoer]
De uitvoer (verdichte) vectorlaag

Pythoncode

ID algoritme: native:densifygeometriesgivenaninterval

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Samensmelten

Neemt een vectorlaag en combineert de objecten daarvan naar nieuwe objecten. Eén of meer attributen kunnen
worden gespecificeerd om alleen geometrieën samen te smelten die behoren tot dezelfde klasse (die dezelfde waarde
hebben voor de gespecificeerde attributen). Als alternatief kunnen alle objecten worden samengesmolten tot één
object.
Alle geometrieën voor de uitvoer zullen worden geconverteerd naar multi-geometrieën. In het geval dat de invoer
een polygonenlaag is, zullen gedeelde grenzen van aanliggende polygonen die worden samengevoegd, worden gewist.
Indien ingeschakeld zal de optionele instelling “Losgemaakte objecten afzonderlĳk behouden” er voor zorgen dat
objecten en delen die niet overlappen of raken, worden geëxporteerd als afzonderlĳke objecten (in plaats van delen
van één enkel meerdelig object).
De resulterende attributentabel zal dezelfde velden hebben als de invoerlaag. De waarden in de velden van de
uitvoerlaag zĳn die van het eerste object van de invoer dat zal worden verwerkt.
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Fig. 27.69: Samenvoegen van een laag tot één enkel meerdelig object

Standaard menu: Vector ► Geoprocessing-gereedschap.
Zie ook:
Samenvoegen, Geometrieën verzamelen

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Veld(en) voor
samensmelten
Optioneel

FIELD [tabelveld: elk]
[lĳst]
Standaard: []

Objecten die dezelfde waarde hebben
voor het geselecteerde veld(en) zullen
worden vervangen door één enkel en hun
geometrieën worden samengevoegd.
Als geen veld wordt opgegeven dan
worden alle objecten samengesmolten, wat
resulteert in één enkel (meerdelig) object.

Fig. 27.70: De polygonenlaag samenvoegen
op een gemeenschappelĳk attribuut (2
meerdelige objecten)

Samengesmolten OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.
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Gevorderde parameters

Label Naam Type Beschrijving
Losgemaakte
objecten
afzonderlĳk
behouden
NEW in 3.26

SEPARATE_DISJOINT[Booleaanse
waarde]
Standaard: False

Delen van losgemaakte objecten worden
geëxporteerd als afzonderlĳke objecten (in
plaats van delen van een meerdelig object).

Fig. 27.71: bron (links), alles samengevoegd
(3 afzonderlĳke objecten - rechts)

Fig. 27.72: bron (links), samengevoegd op
veld (5 afzonderlĳke objecten - rechts)

Uitvoer

Label Naam Type Beschrijving
Samengesmolten OUTPUT [hetzelfde als

invoer]
De uitvoerlaag met samengesmolten
geometrieën

Pythoncode

ID algoritme: native:dissolve

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Drape (Z-waarde instellen vanuit raster)

Gebruikt waarden die zĳn verzameld uit een band in een rasterlaag om de waarde Z in te stellen voor elk overlappend
punt in het object geometrie. De rasterwaarden kunnen optioneel worden geschaald met een vooraf ingestelde
hoeveelheid.
Als waarden Z al bestaan in de laag zullen zĳ worden overschreven door de nieuwe waarde. Als waarden Z niet bestaan
zal de geometrie worden opgewaardeerd om waarden Z te bevatten.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt, lĳn en polygoon met Z ingeschakeld
Zie ook:
M-waarde instellen uit raster, Z-waarde instellen
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Rasterlaag RASTER [raster] Rasterlaag met waarden Z
Bandnummer BAND [rasterband]

Standaard: 1
Rasterband waaruit de waarden Z moeten
worden genomen

Waarde voor
Geen data of
niet-kruisende
punten

NODATA [getal ]
Standaard: 0

Te gebruiken waarde in het geval dat het
punt niet kruist met (een geldige pixel van)
het raster

Schaalfactor SCALE [getal ]
Standaard: 1.0

Waarde voor op schaal brengen: de waarden
van de band worden vermenigvuldigd met
deze waarde.

Verschuiving
NEW in 3.28

OFFSET [getal ]
Standaard: 0.0

Waarde verschuiving: het wordt algebraïsch
toegevoegd aan de waarden van de band na
het toepassen van de “Schaalfactor”.

Bĳgewerkt OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag (met
waarden Z uit de rasterlaag). Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Bĳgewerkt OUTPUT [hetzelfde als

invoer]
De uitvoer vectorlaag met waarden Z uit de
rasterlaag

Pythoncode

ID algoritme: native:setzfromraster

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Waarden M/Z verwijderen

Verwĳdert waarden M (meting) of Z (hoogte) uit geometrieën voor de invoer.
Zie ook:
M-waarde instellen, Z-waarde instellen

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag met waarden M of Z
Waarden M
verwĳderen

DROP_M_VALUES [Booleaanse
waarde]
Standaard: False

Verwĳdert de waarden M uit de
geometrieën

Waarden Z
verwĳderen

DROP_Z_VALUES [Booleaanse
waarde]
Standaard: False

Verwĳdert de waarden Z uit de geometrieën

Z/M verwĳderd OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Z/M verwĳderd OUTPUT [hetzelfde als

invoer]
De uitvoer vectorlaag (identiek aan de
invoerlaag, met als enig verschil dat de
dimensiesM en/of Z uit de geometrieën zĳn
verwĳderd).

Pythoncode

ID algoritme: native:dropmzvalues

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Geselecteerde polygonen opruimen

Combineert geselecteerde polygonen van de invoerlaag met bepaalde aansluitende polygonen door hun
gemeenschappelĳke grens te wissen. De aansluitende polygoon mag ofwel die zĳn met het grootste of kleinste gebied
of die welke de langste gemeenschappelĳke grens deelt met de polygoon die moet worden geëlimineerd.
Elimineren wordt normaal gesproken gebruikt om splinterpolygonen te verwĳderen, d.i. hele kleine polygonen die
het resultaat zĳn van processen van het kruisen van polygonen waar grenzen van de invoer soortgelĳk zĳn, maar niet
identiek.
Standaard menu: Vector ► Geoprocessing-gereedschap.
Zie ook:
Geometrieën repareren

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: polygoon] Invoer polygoon-vectorlaag
Voeg de selectie
samen met de
naburige polygoon
met het …

MODE [enumeratie]
Standaard: Geen

Kies de te gebruiken parameter om
te komen tot het verwĳderen van de
geselecteerde polygonen:

• 0 — grootste gebied
• 1 — kleinste gebied
• 2 — grootste gedeelde grens

Geëlimineerd OUTPUT [vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Geëlimineerd OUTPUT [vector: polygoon] De uitvoer polygoon vectorlaag.

Pythoncode

ID algoritme: qgis:eliminateselectedpolygons

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Lijnen uitvergroten

Neemt een lĳnenlaag enmaakt een nieuwewaarin elke lĳnenlaag wordt vervangen door een set lĳnen die de segmenten
uit de originele lĳn weregeven.
Elke lĳn in de resulterende laag bevat slechts een begin- en eindpunt, zonder tussenliggende punten ertussen.

Fig. 27.73: De originele lijnenlaag en de uitvergrote

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten lĳn
Zie ook:
Onderverdelen, Lĳn subdeel

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn] Invoer lĳn-vectorlaag
Uitvergroot OUTPUT [vector: lĳn]

Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Beschrijving
Uitvergroot OUTPUT [vector: lĳn] De uitvoer lĳn vectorlaag met objecten die

elk segment van de invoerlaag weergeven.

Pythoncode

ID algoritme: native:explodelines

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Lijnen verlengen

Verlengt een geometrie lĳn met een vastgestelde lengte aan begin en einde van de lĳn
Lĳnen worden verlengd in de richting van het eerste en laatste segment van de lĳn.

Fig. 27.74: De rode strepen geven de initiële en uiteindelijke verlenging van de originele laag weer

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten lĳn
Zie ook:
Lĳn subdeel
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn] Invoer lĳn-vectorlaag

Beginafstand START_DISTANCE [getal ] Afstand waarmee het eerste segment van de
lĳn moet worden verlengd (beginpunt)

Eindafstand END_DISTANCE [getal ] Afstand waarmee het laatste segment van de
lĳn moet worden verlengd (eindpunt)

Verlengd OUTPUT [vector: lĳn]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Verlengd OUTPUT [vector: lĳn] De uitvoer (verlengde) lĳn vectorlaag.

Pythoncode

ID algoritme: native:extendlines

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

M-waarden uitnemen

Neemt waarden M, uit de geometrieën, naar attributen van objecten uit.
Standaard wordt alleen dewaardeMuit het eerste punt van elk object uitgenomen. Het algoritme kan echter, optioneel,
statistieken berekenen over alle waarden M van de geometrie, inclusief som, gemiddelde, minimum en maximum.
Zie ook:
Z-waarden uitnemen, M-waarde instellen,Waarden M/Z verwĳderen
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Te berekenen
overzichten

SUMMARIES [enumeratie]
Standaard: [0]

Statistieken over de waarden M van een
geometrie. Één of meer van:

• 0 — Eerste
• 1 — Laatste
• 2 — Aantal
• 3 — Som
• 4 — Gemiddelde
• 5 — Mediaan
• 6 — St.afw (pop)
• 7 — Minimum
• 8 — Maximum
• 9 — Bereik
• 10 — Minderheid
• 11 — Meerderheid
• 12 — Variëteit
• 13 — Q1
• 14 — Q3
• 15 — IQR

Voorvoegsel
uitvoerkolom

COLUMN_PREFIX [tekenreeks]
Standaard: ‘m_’

Het voorvoegsel voor de uitvoerkolom (M).

Uitgenomen OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoerlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Uitgenomen OUTPUT [hetzelfde als

invoer]
De uitvoer vectorlaag (met waarden M)

Pythoncode

ID algoritme: native:extractmvalues

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Specifieke punten uitnemen

Neemt een vectorlaag en maakt een puntenlaag met punten die specifieke punten in de invoergeometrieën weergeven.
Dit algoritme kan bĳvoorbeeld worden gebruikt om de eerste en laatste punten uit de geometrie uit te nemen. De
attributen die zĳn geassocieerd met elk punt zĳn dezelfde als die welke zĳn geassocieerd met het object waartoe het
punt behoort.
De parameter voor index van punten accepteert een kommagescheiden tekenreeks die de index van de uit te nemen
punten specificeert. Het eerste punt correspondeert met de index 0, het tweede punt heeft index 1, etc. Negatieve
indexen kunnen worden gebruikt om punten te zoeken aan het einde van de geometrie, bĳv. index -1 correspondeert
met het laatste punt, -2 correspondeert met het voorlaatste punt, etc.
Aanvullende velden worden toegevoegd aan de punten die de specifieke positie van het punt aangeven (bĳv. 0, -1,
etc.), de originele index van het punt, het deel van de punt en zĳn index binnen het deel (als ook zĳn ring voor
polygonen), afstand langs de originele geometrie en bisectore hoek van de punt voor de originele geometrie.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt
Zie ook:
Punten uitnemen, Punten filteren op M-waarde, Punten filteren op Z-waarde

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Indices punten VERTICES [tekenreeks]

Standaard: ‘0’
Kommagescheiden tekenreeks van de
indices van de uit te nemen punten.

Punten OUTPUT [vector: punt]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Punten OUTPUT [vector: punt] De uitvoer (punt) vectorlaag die de

gespecificeerde punten uit de geometrieën
van de invoerlaag bevat.
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Pythoncode

ID algoritme: native:extractspecificvertices

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Punten uitnemen

Neemt een vectorlaag en maakt een puntenlaag met punten die punten in de invoergeometrieën weergeven.
De attributen die zĳn geassocieerd met elk punt zĳn dezelfde als die welke zĳn geassocieerd met het object waartoe
het punt behoort.
Aanvullende velden worden toegevoegd aan de punten die de puntindex aangeven (beginnend met 0), het deel van
het object en zĳn index binnen het deel (als ook zĳn ring voor polygonen), afstand langs de originele geometrie en
bisectore hoek van het punt voor de originele geometrie.

Fig. 27.75: Punten uitgenomen uit lijn- en polygonen-laag

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt
Standaard menu: Vector ► Geometrie-gereedschappen

Zie ook:
Specifieke punten uitnemen, Punten filteren op M-waarde, Punten filteren op Z-waarde

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Punten OUTPUT [vector: punt]

Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Beschrijving
Punten OUTPUT [vector: punt] De uitvoer (punt) vectorlaag die de punten

uit de geometrieën van de invoerlaag bevat.

Pythoncode

ID algoritme: native:extractvertices

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Z-waarden uitnemen

Neemt waarden Z, uit de geometrieën, naar attributen van objecten uit.
Standaard wordt alleen de waarde Z uit het eerste punt van elk object uitgenomen. Het algoritme kan echter, optioneel,
statistieken berekenen over alle waarden Z van de geometrie, inclusief som, gemiddelde, minimum en maximum.
Zie ook:
M-waarden uitnemen, Z-waarde instellen,Waarden M/Z verwĳderen

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Te berekenen
overzichten

SUMMARIES [enumeratie]
Standaard: [0]

Statistieken over de waarden Z van een
geometrie. Één of meer van:

• 0 — Eerste
• 1 — Laatste
• 2 — Aantal
• 3 — Som
• 4 — Gemiddelde
• 5 — Mediaan
• 6 — St.afw (pop)
• 7 — Minimum
• 8 — Maximum
• 9 — Bereik
• 10 — Minderheid
• 11 — Meerderheid
• 12 — Variëteit
• 13 — Q1
• 14 — Q3
• 15 — IQR

Vervolgt op volgende pagina
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Tabel 27.146 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Voorvoegsel
uitvoerkolom

COLUMN_PREFIX [tekenreeks]
Standaard: ‘z_’

Het voorvoegsel voor de uitvoerkolom (Z).

Uitgenomen OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoerlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Uitgenomen OUTPUT [hetzelfde als

invoer]
De uitvoer vectorlaag (met waarden Z)

Pythoncode

ID algoritme: native:extractzvalues

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Punten filteren op M-waarde

Filtert punten uit op basis van hun waarde M en geeft geometrieën terug die alleen punten hebben die een waarde
M hebben die groter is dan, of gelĳk aan, de gespecificeerde minimale waarde, en/of kleiner dan of gelĳk aan de
maximale waarde.
Als de minimum waarde niet wordt gespecificeerd dan wordt alleen de maximum waarde getest, en op soortgelĳke
wĳze wordt alleen de minimum waarde getest als de maximum waarde niet wordt gespecifieerd.

Fig. 27.76: De rode lijn geeft de zwarte lijn weer met alleen punten waarvan de waarde M is <=10.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten lĳn en polygoon met M ingeschakeld
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Notitie: Afhankelĳk van de attributen voor de geometrieën voor de invoer en de gebruikte filters zouden de door
dit algoritme gemaakte resulterende geometrieën niet langer geldig kunnen zĳn.

Zie ook:
Punten filteren op Z-waarde, Punten uitnemen, Specifieke punten uitnemen

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn,

polygoon]
Invoer lĳn of polygoon vectorlaag waaruit
de punten moeten worden verwĳderd

Minimum
Optioneel

MIN [getal ]
Standaard: niet
ingesteld

Minimum toegestane waarden M

Maximum
Optioneel

MAX [getal ]
Standaard: niet
ingesteld

Maximum toegestane waarden M

Gefilterd OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Gefilterd OUTPUT [hetzelfde als

invoer]
De uitvoer vectorlaag van objecten met
alleen de gefilterde punten.

Pythoncode

ID algoritme: native:filterverticesbym

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Punten filteren op Z-waarde

Filtert punten uit op basis van hun waarde Z en geeft geometrieën terug die alleen punten hebben die een waarde
Z hebben die groter is dan, of gelĳk aan, de gespecificeerde minimale waarde, en/of kleiner dan of gelĳk aan de
maximale waarde.
Als de minimum waarde niet wordt gespecificeerd dan wordt alleen de maximum waarde getest, en op soortgelĳke
wĳze wordt alleen de minimum waarde getest als de maximum waarde niet wordt gespecifieerd.

Fig. 27.77: De rode lijn geeft de zwarte lijn weer met alleen punten waarvan de Z-waarde is <=10.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten lĳn en polygoon met Z ingeschakeld

Notitie: Afhankelĳk van de attributen voor de geometrieën voor de invoer en de gebruikte filters zouden de door
dit algoritme gemaakte resulterende geometrieën niet langer geldig kunnen zĳn. U zou misschien het algoritme
Geometrieën repareren moeten uitvoeren om hun geldigheid te verzekeren.

Zie ook:
Punten filteren op M-waarde, Punten uitnemen, Specifieke punten uitnemen

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn,

polygoon]
Invoer lĳn of polygoon vectorlaag waaruit
de punten moeten worden verwĳderd

Minimum
Optioneel

MIN [getal ]
Standaard: niet
ingesteld

Minimum toegestane waarden Z

Maximum
Optioneel

MAX [getal ]
Standaard: niet
ingesteld

Maximum toegestane waarden Z

Gefilterd OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Beschrijving
Gefilterd OUTPUT [hetzelfde als

invoer]
De uitvoer vectorlaag van objecten met
alleen de gefilterde punten.

Pythoncode

ID algoritme: native:filterverticesbyz

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Geometrieën repareren

Probeert een geldige weergave te maken van een opgegeven ongeldige geometrie zonder een van de invoerpunten te
verliezen. Reeds geldige geometrieën worden teruggegeven zonder verdere interventie. Heeft als uitvoer altĳd een
multi-geometrielaag.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt, lĳn en polygoon zonder M ingeschakeld

Notitie: Waarden M zullen uit de uitvoer worden verwĳderd.

Zie ook:
Geldigheid controleren
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Methode voor
repareren
NEW in 3.28

METHOD [enumeratie]
Standaard: 1

Gebruikte methode voor repareren van de
geometrieën. Één van:

• 0 — Lijnenwerk: combineert alle
ringen naar een set met geknoopte
lĳnen en trekt dan geldige polygonen
af van dat lĳnenwerk

• 1 — Structuur: maakt eerst
alle ringen geldig en voegt dan
omhulsels samen en strekt gaten
van de omhulsels af om een geldig
resultaat te maken. Gaat ervan uit
dat gaten en omhulsels correct zĳn
gecategoriseerd. Vereist een versie
van QGIS die is gebouwd met GEOS
3.10 of later (controleer het menu
Help ► Info).

Gerepareerde
geometrieën

OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Gerepareerde
geometrieën

OUTPUT [hetzelfde als
invoer]

De uitvoerlaag met gerepareerde
geometrieën.

Pythoncode

ID algoritme: native:fixgeometries

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Rechterhandregel forceren

Forceert geometrieën polygoon om de rechterhandregel te respecteren, waarin het gebied, dat is gebonden aan een
polygoon, aan de rechterkant van de grens ligt. In het bĳzonder, de buitenste ring is georiënteerd in een richting met
de klok mee en eventuele binnenste ringen in een richting tegen de wĳzers van de klok in.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten polygoon

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: polygoon] Invoer vectorlaag
Geheroriënteerd OUTPUT [vector: polygoon]

Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Geheroriënteerd OUTPUT [vector: polygoon] De uitvoer vectorlaag met geheroriënteerde

geometrieën.

Pythoncode

ID algoritme: native:forcerhr

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Geodetische lijnsplitsing op antimeridiaan

Splitst een lĳn naar meerdere geodetische segmenten, iedere keer als de lĳn de antimeridiaan kruist (±180 graden
longitude).
Splitsen op de antimeridiaan helpt de visuele weergave van de lĳnen in sommige projecties. De teruggegeven
geometrie zal altĳd een meerdelige geometrie zĳn.
Iedere keer als lĳnsegmenten in de invoergeometrie de antimeridiaan kruisen, zullen zĳ worden geplitst in twee
segmenten, waarbĳ de latitude van het breekpunt wordt bepaald door een geodetische lĳn die de punten aan beide
zĳden van dit segment verbindt. De huidige instelling voor de ellipsoïde van het project zal worden gebruikt bĳ het
berekenen van dit breekpunt.
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Als de invoergeometrie waarden M of Z bevat, zullen die lineair worden geïnterpoleerd voor de nieuwe punten,
gemaakt op de antimeridaan.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten lĳn

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn] Invoer lĳn-vectorlaag
Splitsen OUTPUT [vector: lĳn]

Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer lĳn vectorlaag. Één
van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Splitsen OUTPUT [vector: lĳn] De uitvoer lĳn vectorlaag, gesplitst op de

antimeridiaan.

Pythoncode

ID algoritme: native:antimeridiansplit

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Geometrie met expressie

Werkt bestaande geometrieën bĳ (of maakt nieuwe geometrieën) voor invoerobjecten door middel van een expressie
voor QGIS.
Dit maakt complexe aanpassingen aan de geometrie mogelĳk die alle flexibiliteit van het programma voor expressies
in QGIS kan gebruiken om geometrieën te bewerken en te maken voor uitvoerobjecten.
Voor hulp met de functies van expressies in QGIS, bekĳk de ingebouwde Help, beschikbaar in de expressiebouwer.
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Uitvoer type
geometrie

OUTPUT_GEOMETRY[enumeratie]
Standaard: 0

De geometrie voor de uitvoer is sterk
afhankelĳk van de expressie: bĳvoorbeeld
als u een buffer maakt moet het type
geometrie een polygoon zĳn. Één van:

• 0 — Polygoon
• 1 — Lĳn
• 2 — Punt

Uitvoergeometrie
heeft waarden Z

WITH_Z [Booleaanse
waarde]
Standaard: False

Kies of de uitvoergeometrie de dimensie Z
zou moeten hebben

Uitvoergeometrie
heeft waarden M

WITH_M [Booleaanse
waarde]
Standaard: False

Kies of de uitvoergeometrie de dimensie M
zou moeten hebben

Geometrie-
expressie

EXPRESSION [expressie]
Standaard:
‘$geometry’

Voeg de geometrie-expressie toe die u
wilt gebruiken. U kunt de knop gebruiken
om het dialoogvenster Expressiebouwer te
openen. Het dialoogvenster vermeldt alle
relevante expressies, samen met hun Help
en richtlĳnen.

Aangepaste
geometrie

OUTPUT [vector: elke]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Aangepaste
geometrie

OUTPUT [vector: elke] De uitvoer vectorlaag

Pythoncode

ID algoritme: native:geometrybyexpression

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Punt op lijn interpoleren

Maakt een geometrie punt, geïnterpoleerd op een ingestelde afstand langs geometrieën lĳn of boog.
Waarden Z en M worden lineair geïnterpoleerd uit bestaande waarden.
Als een meerdelige geometrie wordt tegengekomen wordt alleen het eerste deel in aanmerking genomen bĳ het
berekenen van de subtekenreeks.
Als de gespecificeerde afstand groeter is dan de lengte van het invoerobject heeft het resulterende object een geometrie
null.

Fig. 27.78: Geïnterpoleerd punt op 500m van het begin van de lijn

Zie ook:
Punten langs geometrie

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn,

polygoon]
Invoer lĳn- of polygoonvectorlaag

Afstand DISTANCE [getal ]
Standaard: 0.0

Afstand vanaf het begin van de lĳn

Geïnterpoleerde
punten

OUTPUT [vector: punt]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Geïnterpoleerde
punten

OUTPUT [vector: punt] De uitvoer punt vectorlaagmet objecten, die
zĳn geplaatst op een ingestelde afstand langs
de lĳn of de grens van de polygoon
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Pythoncode

ID algoritme: native:interpolatepoint

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

N grootste delen behouden

Neemt een laagmet polygonen ofmultipolygonen en geeft een nieuwe laag terug waarin alleen de n grootste polygonen
van elk object multipolygoon worden behouden. Als een object n of minder delen heeft zal het object slechts worden
gekopieerd.

Fig. 27.79: Met de wijzers van de klok mee vanaf linksboven: originele meerdelige object, een, twee en drie grootste
behouden delen
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Parameters

Label Naam Type Beschrijving
Polygonen INPUT [vector: polygoon] Invoer polygoon-vectorlaag
Te behouden delen PARTS [getal]

Standaard: 1
Aantal te behouden delen. Indien 1 wordt
alleen het grootste deel van het object
behouden.

Delen OUTPUT [vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer polygoon vectorlaag.
Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Delen OUTPUT [vector: polygoon] De uitvoer polygoon vectorlaag met de n

grootste delen van elk object

Pythoncode

ID algoritme: qgis:keepnbiggestparts

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Lijn subdeel

Geeft het gedeelte van een lĳn (of boog) terug dat valt tussen de gespecificeerde begin- en eindafstanden (gemeten
vanaf het begin van de lĳn).
Waarden Z en M worden lineair geïnterpoleerd uit bestaande waarden.
Als een meerdelige geometrie wordt tegengekomen wordt alleen het eerste deel in aanmerking genomen bĳ het
berekenen van de subtekenreeks.
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Fig. 27.80: Subdeel lijn met beginafstand ingesteld op 0 meter en de eindafstand op 250 meter.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten lĳn
Zie ook:
Lĳnen verlengen

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn] Invoer lĳn-vectorlaag

Beginafstand START_DISTANCE [getal ] Afstand langs de invoerlĳn naar het
beginpunt van het uit te voeren object

Eindafstand END_DISTANCE [getal ] Afstand langs de invoerlĳn naar het
eindpunt van het uit te voeren object

Subtekenreeks OUTPUT [vector: lĳn]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer lĳn vectorlaag. Één
van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Beschrijving
Subtekenreeks OUTPUT [vector: lĳn] De uitvoer lĳn vectorlaag.

Pythoncode

ID algoritme: native:linesubstring

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Lijnen naar polygonen

Maakt een polygonen-laag waarbĳ de lĳnen van een invoer lĳnlaag worden gebruikt als ringen voor de polygoon.
De attributentabel van de uitvoerlaag is dezelfde als die van de invoerlaag.
Standaard menu: Vector ► Geometrie-gereedschappen

Zie ook:
Polygonen naar lĳnen, Polygoniseren, Type geometrie converteren

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn] Invoer lĳn-vectorlaag
Polygonen OUTPUT [vector: polygoon]

Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer polygoon vectorlaag.
Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Beschrijving
Polygonen OUTPUT [vector: polygoon] De uitvoer polygoon vectorlaag.

Pythoncode

ID algoritme: qgis:linestopolygons

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Lijnen samenvoegen

Voegt alle verbonden delen van geometrieën MultiLineString samen tot enkele geometrieën LineString.
Als enig deel van de ingevoerde geometrieën MultiLineString niet is verbonden, zal de resulterende geometrie een
MultiLineString zĳn die lĳnen bevat die konden worden samengevoegd en alle niet verbonden delen van lĳnen.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten lĳn

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn] Invoer lĳn-vectorlaag
Samengevoegd OUTPUT [vector: lĳn]

Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer lĳn vectorlaag. Één
van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Beschrijving
Samengevoegd OUTPUT [vector: lĳn] De uitvoer (samengevoegde) lĳn vectorlaag.

Pythoncode

ID algoritme: native:mergelines

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Minimum begrenzing geometrie

Maakt geometrieën die de objecten van een invoerlaag omsluiten. De objecten kunnen worden gegroepeerd op een
veld. De uitvoerlaag zal dan één object per gegroepeerde waarde bevatten, met een geometrie (MBB) die alleen de
geometrieën van de objecten met een overeenkomende waarde bedekt.
De volgende omsluitende typen geometrie worden ondersteund:

• begrenzingsvak (enveloppe)
• georiënteerde rechthoek
• cirkel
• bolle schil (convex hull)

Fig. 27.81: Met de wijzers van de klok mee, vanaf linksboven: enveloppe, georiënteerde rechthoek, cirkel, bolle schil
(convex hull)
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Zie ook:
Minimale omsluitende cirkels

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Veld
Optioneel

FIELD [tabelveld: elk] Objecten kunnen worden gegroepeerd
op een veld. Indien ingesteld zorgt dit
er voor dat de uitvoerlaag één object
per gegroepeerde waarde bevat, met een
minimale geometrie die alleen de objecten
met een overeenkomende waarde bedekt.

Type geometrie TYPE [enumeratie]
Standaard: 0

Omsluitende typen geometrie. Één van:
• 0 — Enveloppe (Begrenzingsvak)
• 1 — Minimum georiënteerde
rechthoek

• 2 — Minimale omsluitende cirkel
• 3 — Convex Hull

Begrensde
geometrie

OUTPUT [vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer polygoon vectorlaag.
Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Begrensde
geometrie

OUTPUT [vector: polygoon] De uitvoer (begrensde) polygoon
vectorlaag.

Pythoncode

ID algoritme: qgis:minimumboundinggeometry

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Minimale omsluitende cirkels

Berekent de minimale omsluitende cirkels voor de objecten in de invoerlaag.

Fig. 27.82: Omsluitende cirkels voor elk object

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten polygoon
Zie ook:
Minimum begrenzing geometrie

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Aantal segmenten
in cirkels

SEGMENTS [getal]
Standaard: 72

Het gebruikte aantal segmenten om een
cirkel te benaderen. Minimum 8, maximum
100000.

Minimum
omsluitende
cirkels

OUTPUT [vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer polygoon vectorlaag.
Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Beschrijving
Minimum
omsluitende
cirkels

OUTPUT [vector: polygoon] De uitvoer polygoon vectorlaag.

Pythoncode

ID algoritme: native:minimumenclosingcircle

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Multi-ring buffer (constante afstand)

Berekent multi-ring (donut) buffer voor de objecten van de invoerlaag, met een vaste of dynamische afstand en aantal
ringen.

Fig. 27.83: Multi-ring buffer voor een lijn-, punt- en polygoonlaag

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten polygoon
Zie ook:
Buffer, Variabele bufferafstand, Rechthoeken, ovalen, diamanten, Enkelzĳdige buffer
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag

Aantal ringen RINGS [getal ]
Standaard: 1

Het aantal ringen. Het mag een unieke
waarde zĳn (hetzelfde aantal ringen voor
alle objecten) of het mag worden genomen
uit gegevens van de objecten (het aantal
ringen is afhankelĳk van de waarden van de
objecten).

Afstand tussen
ringen

DISTANCE [getal ]
Standaard: 1.0

Afstand tussen de ringen. Het mag een
unieke waarde zĳn (dezelfde afstand voor
alle objecten) of het mag worden genomen
uit gegevens van de objecten (de afstand
is afhankelĳk van de waarden van de
objecten).

Multi-ring
buffer (constante
afstand)

OUTPUT [vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer polygoon vectorlaag.
Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Multi-ring
buffer (constante
afstand)

OUTPUT [vector: polygoon] De uitvoer polygoon vectorlaag.

Pythoncode

ID algoritme: native:multiringconstantbuffer

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Meerdelige naar enkele

Splitst meerdelige objecten in de invoerlaag naar eendelige objecten.
De attributen van de uitvoerlaag zĳn hetzelfde als die van de originelen, maar opgedeeld in eendelige objecten.

Fig. 27.84: Links de meerdelige bronlaag en rechts het resultaat met enkele delen

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt, lĳn en polygoon
Standaard menu: Vector ► Geometrie-gereedschappen

Zie ook:
Geometrieën verzamelen, Bevorderen naar meerdelig

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Eendelig OUTPUT [hetzelfde als

invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer polygoon vectorlaag.
Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Eendelig OUTPUT [hetzelfde als

invoer]
De uitvoer vectorlaag.

27.1. QGIS algoritme provider 1313



QGIS Desktop 3.28 User Guide

Pythoncode

ID algoritme: native:multiparttosingleparts

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Verspringing lijnen

Verschuift lĳnen met een gespecificeerde afstand. Positieve afstanden verschuiven lĳnen naar links, en negatieve
afstanden zullen ze naar rechts verschuiven.

Fig. 27.85: In blauw de bronlaag, in rood de verschoven lijn

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten lĳn
Zie ook:
Array van verschoven (parallelle) lĳnen, Transleren

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn] Invoer lĳn-vectorlaag

Afstand DISTANCE [getal ]
Standaard: 10.0

Afstand voor verschuiving. U kunt de knop
Data-bepaald aan de rechterkant gebruiken
om een veld te kiezen waarvan de straal
zal worden berekend. Op deze manier kunt
u een andere straal maken voor elk object
(bekĳk Variabele bufferafstand).

Segmenten SEGMENTS [getal]
Standaard: 8

Beheert het aantal te gebruiken
lĳnsegmenten om een kwart cirkel te
benaderen bĳ het maken van ronde
verschuivingen.

Vervolgt op volgende pagina
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Tabel 27.151 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Verbindingsstĳl JOIN_STYLE [enumeratie]

Standaard: 0
Specificeert of ronde, hoekige of puntige
verbindingsstĳlen zouden moeten worden
gebruikt bĳ het verschuiven van hoeken in
een lĳn. Opties zĳn:

• 0 — Afgerond
• 1 — Puntig
• 2 — Hoekig

Fig. 27.86: Ronde, diagonale en schuine
koppelstĳlen

Maximale
puntlengte bĳ
scherpe hoeken

MITER_LIMIT [getal]
Standaard: 2.0

Stelt de maximale afstand van de
te gebruiken geometrie voor de
verschuiving bĳ het maken van een
puntige verbindingsstĳl in als een factor
van de afstand van de verschuiving
(alleen van toepassing voor puntige
verbindingsstĳlen). Minimum: 1.0

Fig. 27.87: Een buffer van 10m met een
limiet van 2 en een buffer van 10m met een
limiet van 1

Verschuiving OUTPUT [vector: lĳn]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer (verschoven) laag.
Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Beschrijving
Verschuiving OUTPUT [vector: lĳn] Uitvoer (verschoven) lĳnlaag

Pythoncode

ID algoritme: native:offsetline

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Georiënteerd minimum begrenzingsvak

Berekent het minimale gebied voor de gedraaide rechthoek voor elk object in de invoerlaag.

Fig. 27.88: Georiënteerd minimum begrenzingsvak

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten polygoon
Zie ook:
Minimum begrenzing geometrie
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Begrenzingsvakken OUTPUT [vector: polygoon]

Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer polygoon vectorlaag.
Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Begrenzingsvakken OUTPUT [vector: polygoon] De uitvoer polygoon vectorlaag.

Pythoncode

ID algoritme: native:orientedminimumboundingbox

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Loodrecht maken

Probeert de geometrieën van de invoer lĳn- of polygoonlaag loodrecht te maken. Dit proces verschuift de punten in
de geometrieën om te proberen elke hoek in de geometrie ofwel een rechte hoek te maken, of een rechte lĳn.

Fig. 27.89: In blauw de bronlaag en in rood het loodrecht gemaakte resultaat

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten lĳn en polygoon

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn,

polygoon]
Invoer lĳn- of polygoonvectorlaag

Maximum
tolerantie hoek
(graden)

ANGLE_TOLERANCE[getal]
Standaard: 15

Specificeer de maximale afwĳking van een
rechte hoek of rechte lĳn dat een punt mag
hebben om te worden aangepast. Kleinere
toleranties betekenen dat alleen punten die
al dicht bĳ rechte hoeken liggen zullen
worden aangepast, en grotere toleranties
betekenen dat punten die verder afwĳken
van rechte hoeken ook zullen worden
aangepast.

Maximum
aantal doorlopen
algoritme

MAX_ITERATIONS [getal]
Standaard: 1000

Instellen van een hoger getal voor het
aantal doorlopen zal resulteren in een meer
loodrechte geometrie, ten koste van extra
verwerkingstĳd.

Vervolgt op volgende pagina
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Tabel 27.152 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Loodrecht
gemaakt

OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer polygoon vectorlaag.
Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Loodrecht
gemaakt

OUTPUT [hetzelfde als
invoer]

De uitvoer polygoon vectorlaag met
aangepaste hoeken.

Pythoncode

ID algoritme: native:orthogonalize

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Punt op oppervlak

Geeft, voor elk object van de invoerlaag, een punt terug dat gegarandeerd op de oppervlakte van de geometrie van
het object ligt.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt
Zie ook:
Zwaartepunten
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Punt op oppervlak
voor elk deel
maken

ANGLE_TOLERANCE[Booleaanse waarde
]

Indien geselecteerd zal een punt worden
gemaakt voor elk deel van de geometrie.

Punt OUTPUT [vector: punt]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer punt vectorlaag. Één
van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Punt OUTPUT [vector: punt] De uitvoer punt vectorlaag.

Pythoncode

ID algoritme: native:pointonsurface

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Punten langs geometrie

Maakt punten met regelmatige intervallen langs een geometrie lĳn of polygoon. Aan de gemaakte punten zullen
nieuwe attributen worden toegevoegd voor de afstand langs de geometrie en de hoek van de lĳn op het punt.
Een optionele verschuiving voor begin en eind kan worden gespecificeerd, wat beheert hoe ver van het begin en eind
van de geometrie de punten zouden moeten worden gemaakt.
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Fig. 27.90: Gemaakte punten langs de bron lijnen-laag

Zie ook:
Punt op lĳn interpoleren

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn,

polygoon]
Invoer lĳn- of polygoonvectorlaag

Afstand DISTANCE [getal ]
Standaard: 1.0

Afstand tussen twee opeenvolgende punten
op de lĳn

Begin
verschuiving

START_OFFSET [getal ]
Standaard: 0.0

Afstand vanaf het begin van de invoerlĳn
die de positie van het eerste punt weergeeft.

Einde
verschuiving

END_OFFSET [getal ]
Standaard: 0.0

Afstand vanaf het einde van de invoerlĳn
die de positie weergeeft waarna geen object
punt meer zou moeten worden gemaakt.

Geïnterpoleerde
punten

OUTPUT [vector: punt]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Beschrijving
Geïnterpoleerde
punten

OUTPUT [vector: punt] Punt vectorlaag met objecten die zĳn
geplaatst langs lĳnen of polygoongrenzen
van de invoerlaag.

Pythoncode

ID algoritme: native:pointsalonglines

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Punten verplaatsen

Gegeven een afstand voor nabĳheid, identificeert nabĳgelegen punt-objecten en verdeelt die radiaal over een
cirkel waarvan het midden hun middelpunt weergeeft. Een handig gereedschap om over elkaar gelegde objecten
te verspreiden.

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: punt] Invoer punt-vectorlaag
Minimale afstand
naar andere
punten

PROXIMITY [getal]
Standaard: 1.0

Afstand tot waar objecten punt worden
geacht nabĳ te zĳn gelegen. Nabĳer gelegen
objecten worden sowieso verdeeld.

VerplaatsingsafstandDISTANCE [getal]
Standaard: 1.0

Straal van de cirkel waarop nabĳgelegen
objecten worden geplaatst

Horizontale
verdeling in geval
van twee punten

HORIZONTAL [Booleaanse
waarde]
Standaard: False

Wanneer slechts twee punten worden
geïdentificeerd als nabĳ, lĳn ze dan
horizontaal uit op de cirkel in plaats van
verticaal.

Verplaatst OUTPUT [vector: punt]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Beschrijving
Verplaatst OUTPUT [vector: punt] Uitvoer punt vectorlaag

Pythoncode

ID algoritme: qgis:pointsdisplacement

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Pool van ontoegankelijkheid

Berekent de Pool van Ontoegankelĳkheid voor een polygonen-laag, wat het meest veraf gelegen interne punt vanaf
de rand van het oppervlak is.
Dit algoritme gebruikt het algoritme ‘polylabel’ (Vladimir Agafonkin, 2016), wat een iteratieve benadering is die
gegarandeerd het ware punt van de Pool van Ontoegankelĳkheid vind binnen een gespecificeerde tolerantie. Een
meer preciezere tolerantie (lagere waarde) vereist meer doorlopen en zullen langer duren om te berekenen.
De afstand van de berekende pool tot de grens van de polygoon zal worden opgeslagen als een nieuw attribuut in de
uitvoerlaag.

Fig. 27.91: Pool van ontoegankelijkheid
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: polygoon] Invoer vectorlaag
Tolerantie TOLERANCE [getal]

Standaard: 1.0
Stel de tolerantie voor de berekening in

Punt OUTPUT [vector: punt]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer polygoon vectorlaag.
Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Punt OUTPUT [vector: punt] De uitvoer punt vectorlaag

Pythoncode

ID algoritme: native:poleofinaccessibility

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Polygoniseren

Maakt een polygoonlaag waarvan de grenzen van de objecten worden gemaakt uit een lĳnlaag of gesloten objecten.

Fig. 27.92: De gele polygonen gemaakt uit de gesloten lijnen

Notitie: De lĳnen-laag moet gesloten vormen hebben om te kunnen worden getransformeerd naar een polygoon.

Zie ook:
Polygonen naar lĳnen, Lĳnen naar polygonen, Type geometrie converteren

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn] Invoer lĳn-vectorlaag
Velden uit
invoerlaag
behouden
Optioneel

KEEP_FIELDS [Booleaanse
waarde]
Standaard: False

Selecteren om de velden (alleen de
tabelstructuur, niet de waarden) van de
invoerlaag te behouden

Polygonen uit
lĳnen

OUTPUT [vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer polygoon vectorlaag.
Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Beschrijving
Polygonen uit
lĳnen

OUTPUT [vector: polygoon] De uitvoer polygoon vectorlaag uit lĳnen

Pythoncode

ID algoritme: native:polygonize

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Polygonen naar lijnen

Dit algoritme neemt een polygonen-laag en maakt een lĳnenlaag met lĳnen die de grenzen van de polygonen in de
invoerlaag weergeven.
De attributentabel van de uitvoerlaag is dezelfde als die van de invoerlaag.

Fig. 27.93: Zwarte lijnen als het resultaat van het algoritme

Standaard menu: Vector ► Geometrie-gereedschappen

Zie ook:
Lĳnen naar polygonen, Polygoniseren, Type geometrie converteren
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: polygoon] Invoer polygoon-vectorlaag
Lĳnen OUTPUT [vector: lĳn]

Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer lĳn vectorlaag. Één
van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Lĳnen OUTPUT [vector: lĳn] De uitvoer lĳn vectorlaag uit polygonen

Pythoncode

ID algoritme: native:polygonstolines

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Punten projecteren (Cartesiaans)

Projecteert geometrieën punt op een gespecificeerde afstand en richting (azimut).

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: punt] Invoer punt-vectorlaag

Richting (graden
vanaf Noord)

BEARING [getal ]
Standaard: 0.0

Hoek met de wĳzers van de klok mee,
beginnend vanaf Noord, in eenheid graden
(°)

Afstand DISTANCE [getal ]
Standaard: 1.0

Afstand om geometrieën te verschuiven, in
laageenheden

Vervolgt op volgende pagina
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Tabel 27.155 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Geprojecteerd OUTPUT [vector: punt]

Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer punt vectorlaag. Één
van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Geprojecteerd OUTPUT [vector: punt] De uitvoer (geprojecteerde) punt vectorlaag

Pythoncode

ID algoritme: native:projectpointcartesian

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Bevorderen naar meerdelig

Dit algoritme neemt een vectorlaag met enkelvoudige geometrieën en maakt een nieuwe waarin alle geometrieën uit
meerdere delen bestaan.
Objecten voor de invoer die al bestaan uit meerdere delen zullen ongewĳzigd blĳven.
Dit algoritme kan worden gebruikt om geometrieën te forceren tot typen met meerdere delen om te zorgen dat zĳ
compatibel zĳn met gegevensproviders die objecten met meerdere delen vereisen.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt, lĳn en polygoon
Zie ook:
Samenvoegen, Geometrieën verzamelen
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Meerdelig OUTPUT [hetzelfde als

invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer meerdelige
vectorlaag. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Meerdelig OUTPUT [hetzelfde als

invoer]
De uitvoer meerdelige vectorlaag

Pythoncode

ID algoritme: native:promotetomulti

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Rechthoeken, ovalen, diamanten

Maakt een buffergebied met een rechthoekige, ovale of diamantvorm voor elk object van de invoer puntenlaag.
De parameters voor de vorm kunnen vast zĳn voor alle objecten of dynamisch door een veld of een expressie te
gebruiken.

Fig. 27.94: Verschillende vormen buffer met dynamische parameters
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: punt] Invoer punt-vectorlaag
Vorm buffer SHAPE [enumeratie] De te gebruiken vorm. Één van:

• 0 — Rechthoeken
• 1 — Ovalen
• 2 — Diamanten

Breedte WIDTH [getal ]
Standaard: 1.0

Breedte van de vorm van de buffer

Hoogte HEIGHT [getal ]
Standaard: 1.0

Hoogte van de vorm van de buffer

Rotatie
Optioneel

ROTATION [getal ]
Standaard: Geen

Rotatie van de vorm van de buffer

Aantal segmenten SEGMENTS [getal]
Standaard: 36

Aantal segmenten voor een volledige cirkel
(vorm Ovaal)

Uitvoer OUTPUT [vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Uitvoer OUTPUT [vector: polygoon] De uitvoer vectorlaag (met de vormen voor

de buffer)

Pythoncode

ID algoritme: native:rectanglesovalsdiamonds

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Duplicaatpunten verwijderen

Verwĳdert duplicaatpunten uit objecten, waarbĳ het verwĳderen van de punten niet leidt tot een gedegenereerde
geometrie.
De parameter Tolerantie specifieert de tolerantie voor coördinaten bĳ het bepalen of punten identiek zĳn.
Standaard wordt met waarden Z geen rekening gehouden bĳ het detecteren van duplicaatpunten. Bĳv. twee punten
met hetzelfde X- en Y-coördinaat, maar verschillende waarden Z, zullen nog steeds als duplicaten worden beschouwd
en één ervan zal worden verwĳderd. Als de parameter Z-waarde gebruiken true is, dan worden de waarden Z ook
getest en punten met dezelfde X en Y, maar met verschillende Z, zullen worden behouden.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt, lĳn en polygoon

Notitie: Duplicaatpunten worden, tussen de verschillende delen van een geometrie met meerdere delen, niet getest.
Bĳv. een geometrie multipunt met overlappende punten zal door deze methode niet worden gewĳzigd.

Zie ook:
Punten uitnemen, Specifieke punten uitnemen, Duplicaten van geometrieën verwĳderen

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag

Tolerantie TOLERANCE [getal ]
Standaard:
0.000001

Punten die dichterbĳ liggen dan de
gespecificeerde afstand worden als
duplicaten beschouwd

Z-waarde
gebruiken

USE_Z_VALUE [Booleaanse waarde
]

Standaard: False

Als de parameter Z-waarde gebruiken true
is, dan worden de waarden Z ook getest
en punten met dezelfde X en Y, maar
verschillende Z, zullen worden behouden.

Schoongemaakt OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Schoongemaakt OUTPUT [hetzelfde als

invoer]
De uitvoer vectorlaag (zonder
duplicaatpunten)
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Pythoncode

ID algoritme: native:removeduplicatevertices

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Geometrieën null verwijderen

Verwĳdert alle objecten die geen geometrie hebben uit een vectorlaag. Alle andere objecten zullen ongewĳzigd
gekopieerd worden.
De objecten met een geometrie null kunnen worden opgeslagen naar een afzonderlĳke laag.
Als Ook lege geometrieën verwĳderen is geselecteerd, verwĳdert het algoritme objecten waarvan de geometrieën geen
coördinaten hebben, d.i. geometrieën die leeg zĳn. In dat geval zal ook de uitvoer null deze optie reflecteren, bevat
zowel null als lege geometrieën.
Zie ook:
Duplicaten van geometrieën verwĳderen

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag (zonder niet-NULL

geometrieën)
Ook lege
geometrieën
verwĳderen

REMOVE_EMPTY [Booleaanse
waarde]

Niet-Null
geometrieën

OUTPUT
Optioneel

[hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag voor de
niet-NULL (en niet lege) geometrieën. Één
van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Null geometrieën
Optioneel

NULL_OUTPUT [hetzelfde als
invoer]
Standaard:
[Uitvoer
overslaan]

Specificeer de uitvoer vectorlaag voor de
NULL (en lege) geometrieën. Één van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Beschrijving
Null geometrieën NULL_OUTPUT [hetzelfde als

invoer]
De uitvoer vectorlaag (voor NULL en,
indien gekozen, lege geometrieën)

Niet-Null
geometrieën

OUTPUT [hetzelfde als
invoer]

De uitvoer vectorlaag (zonder NULL en,
indien gekozen, lege geometrieën)

Pythoncode

ID algoritme: native:removenullgeometries

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Omgekeerde lijnrichting

Draait de huidige richting van een lĳnen-laag om.

Fig. 27.95: Voor en na het omdraaien van de richting

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten lĳn

27.1. QGIS algoritme provider 1333



QGIS Desktop 3.28 User Guide

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn] Invoer lĳn-vectorlaag
Omgedraaid OUTPUT [vector: lĳn]

Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer lĳn vectorlaag. Één
van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Omgedraaid OUTPUT [vector: lĳn] De uitvoer lĳnlaag (met omgedraaide

lĳnen)

Pythoncode

ID algoritme: native:reverselinedirection

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Rotatie

Draait objectgeometrieënmet een gespecificeerde hoekmet de wĳzers van de klokmee. Het draaien wordt uitgevoerd
vanuit het zwaartepunt van elk object, of optioneel vanuit een uniek vooraf ingesteld punt.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt, lĳn en polygoon
Zie ook:
Transleren, X- en Y-coördinaten wisselen
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag

Rotatie (graden
met de klok mee)

ANGLE [getal ]
Standaard: 0.0

Hoek voor de rotatie, in graden

Ankerpunt rotatie
(X, Y)
Optioneel

ANCHOR [punt]
Standaard: Geen

X,Y-coördinaten van het punt waar vanuit
het draaien van de objecten moet gebeuren.
Indien niet ingesteld gebeurt het draaien
rondom het zwaartepunt van elk object.

Geroteerd OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag (met
geroteerde geometrieën). Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Geroteerd OUTPUT [hetzelfde als

invoer]
De uitvoer vectorlaag met geroteerde
geometrieën

Pythoncode

ID algoritme: native:rotatefeatures

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Rondheid

NEW in 3.24

Berekent de rondheid van elk object en slaat die op als een nieuw veld. De invoer vectorlaag moet polygonen bevatten.
De rondheid van een polygoon wordt gedefinieerd als 4π × gebied polygoon / perimeter². De waarde van de rondheid
varieert tussen 0 en 1. Een perfecte cirkel heeft een rondheid van 1, terwĳl een volledig platte polygoon een rondheid
heeft van 0.

Notitie: Het algoritme geeft NULL terug voor meerdelige polygoonobjecten.
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Maakt objecten op hun plaats aanpassen mogelĳk voor objecten polygoon

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: polygoon] Invoer vectorlaag
Rondheid OUTPUT [vector: polygoon]

Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag (met veld
voor rondheid). Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Geroteerd OUTPUT [hetzelfde als

invoer]
De uitvoer vectorlaag met de waarde voor
rondheid in een veld

Pythoncode

ID algoritme: native:roundness

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Segmenteren op maximum hoek

Segmenteert een geometrie door het converteren van gebogen gedeelten naar lineaire gedeelten.
Het segmenteren wordt uitgevoerd door de maximale hoek van de radius te specificeren tussen punten op de recht
gemaakte geometrie (bĳv. de hoek van de boog die werd gemaakt vanuit het originele midden van de boog ten opzichte
van opvolgende punten op de gelineairiseerde geometrie). Niet gebogen geometrieën zullen zonder wĳzigingen
worden behouden.
Zie ook:
Segmenteren op maximum afstand, Vereenvoudigen, Glad maken
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn,

polygoon]
Invoer lĳn- of polygoonvectorlaag

Maximum hoek
tussen punten
(graden)

ANGLE [getal ]
Standaard: 5.0

Maximum toegestane hoek voor de straal
tussen punten op de recht gemaakte
geometrie

Gesegmenteerd OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag (met
gesegmenteerde geometrieën). Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Gesegmenteerd OUTPUT [hetzelfde als

invoer]
De uitvoer vectorlaag met gesegmenteerde
geometrieën

Pythoncode

ID algoritme: native:segmentizebymaxangle

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Segmenteren op maximum afstand

Segmenteert een geometrie door het converteren van gebogen gedeelten naar lineaire gedeelten.
Het segmenteren wordt uitgevoerd door de maximale afstand voor verspringen te specificeren tussen de originele
boog en de gesegmenteerde weergave. Niet gebogen geometrieën zullen zonder wĳzigingen worden behouden.
Zie ook:
Segmenteren op maximum hoek, Vereenvoudigen, Glad maken
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn,

polygoon]
Invoer lĳn- of polygoonvectorlaag

Maximum afstand
verschuiving

DISTANCE [getal ]
Standaard: 1.0

Maximale toegestane afstand voor
verschuiving tussen de originele boog
en de gesegmenteerde weergave, in
eenheden van de laag.

Gesegmenteerd OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag (met
gesegmenteerde geometrieën). Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Gesegmenteerd OUTPUT [hetzelfde als

invoer]
De uitvoer vectorlaag met gesegmenteerde
geometrieën

Pythoncode

ID algoritme: native:segmentizebymaxdistance

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

M-waarde instellen

Stelt de waarde M in voor geometrieën op een laag.
Als waarden M al in de laag bestaan, zullen zĳ worden overschreven door de nieuwe waarde. Als waarden M niet
bestaan, zal de geometrie worden opgewaardeerd om waardenM te bevatten en de gespecificeerde waarde zal worden
gebruikt als de initiële waarde M voor alle geometrieën.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt, lĳn en polygoon met M ingeschakeld

Tip: Gebruik de knop Objecten identificeren omde toegevoegdewaardeM te controleren: de resultaten zĳn beschikbaar
in het dialoogvenster Identificatieresultaten.
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Zie ook:
M-waarde instellen uit raster, Z-waarde instellen,Waarden M/Z verwĳderen

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag

Waarde M M_VALUE [getal ]
Standaard: 0.0

Waarde M om toe te wĳzen aan de
geometrieën van de objecten

M toegevoegd OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
M toegevoegd OUTPUT [hetzelfde als

invoer]
De uitvoer vectorlaag (met waarden M
toegevoegd aan de geometrieën)

Pythoncode

ID algoritme: native:setmvalue

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

M-waarde instellen uit raster

Gebruikt waarden die zĳn verzameld uit een band in een rasterlaag om de waarde M in te stellen voor elk overlappend
punt in het object geometrie. De rasterwaarden kunnen optioneel worden geschaald met een vooraf ingestelde
hoeveelheid.
Als waarden M al bestaan in de laag zullen zĳ worden overschreven door de nieuwe waarde. Als waarden M niet
bestaan zal de geometrie worden opgewaardeerd om waarden M te bevatten.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt, lĳn en polygoon met M ingeschakeld
Zie ook:
Drape (Z-waarde instellen vanuit raster), M-waarde instellen
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Rasterlaag RASTER [raster] Rasterlaag met waarden M
Bandnummer BAND [rasterband]

Standaard: 1
De rasterband waaruit de waarden M
moeten worden genomen

Waarde voor
Geen data of
niet-kruisende
punten

NODATA [number ]
Standaard: 0.0

Te gebruiken waarde in het geval dat het
punt niet kruist met (een geldige pixel van)
het raster

Schaalfactor SCALE [getal ]
Standaard: 1.0

Waarde voor op schaal brengen: de waarden
van de band worden vermenigvuldigd met
deze waarde.

Verschuiving
NEW in 3.28

OFFSET [getal ]
Standaard: 0.0

Waarde verschuiving: het wordt algebraïsch
toegevoegd aan de waarden van de band na
het toepassen van de “Schaalfactor”.

Bĳgewerkt OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag (met
bĳgewerkte waarden M). Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Bĳgewerkt OUTPUT [hetzelfde als

invoer]
De uitvoer vectorlaag (met bĳgewerkte
waarden M)

Pythoncode

ID algoritme: native:setmfromraster

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Z-waarde instellen

Stelt de waarde Z voor geometrieën op een laag in.
Als waarden Z al bestaan in de laag zullen zĳ worden overschreven door de nieuwe waarde. Als waarden Z niet bestaan
zal de geometrie worden opgewaardeerd om waarden Z te bevatten en de gespecificeerde waarde zal worden gebruikt
als de initiële waarde Z voor alle geometrieën.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt, lĳn en polygoon met Z ingeschakeld

Tip: Gebruik de knop Objecten identificeren om de toegevoegd waarde Z te controleren: de resultaten zĳn beschikbaar
in het dialoogvenster Identificatieresultaten.

Zie ook:
Drape (Z-waarde instellen vanuit raster), M-waarde instellen,Waarden M/Z verwĳderen

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag

Waarde Z Z_VALUE [getal ]
Standaard: 0.0

Waarde Z om toe te wĳzen aan de
geometrieën van de objecten

Z toegevoegd OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Z toegevoegd OUTPUT [hetzelfde als

invoer]
De uitvoer vectorlaag (met toegewezen
waarden Z)

Pythoncode

ID algoritme: native:setzvalue

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Vereenvoudigen

Vereenvoudigt de geometrieën in een lĳnen- of polygonen-laag. Het maakt een nieuwe laag met dezelfde objecten als
die in de invoerlaag, maar met geometrieën die een kleiner aantal punten bevatten.
Het algoritme geeft een keuze voor methoden van vereenvoudiging, inclusief gebaseerd op afstand (het algoritme
“Douglas-Peucker”), gebaseerd op gebied (algoritme “Visvalingam”) en snappen van geometrieën aan een raster.

Fig. 27.96: Met de klok mee vanaf linksboven: bronlaag en vergrotende toleranties voor vereenvoudiging

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten lĳn en polygoon
Standaard menu: Vector ► Geometrie-gereedschappen

Zie ook:
Glad maken, Verdichten op aantal, Verdichten op interval

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn,

polygoon]
Invoer lĳn- of polygoonvectorlaag

VereenvoudigingsmethodeMETHOD [enumeratie]
Standaard: 0

Vereenvoudigingsmethode. Één van:
• 0 — Afstand (Douglas-Peucker)
• 1 — Snappen aan raster
• 2 — Gebied (Visvalingam)

Vervolgt op volgende pagina
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Tabel 27.160 – Vervolgd van vorige pagina
Label Naam Type Beschrijving

Tolerantie TOLERANCE [getal ]
Standaard: 1.0

Drempel tolerantie (in eenheden van de
laag): als de afstand tussen twee knopen
kleiner is dan de waarde van de tolerantie,
zal het segment worden vereenvoudigt en de
punten zullen worden verwĳderd.

Vereenvoudigd OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer (vereenvoudigde)
vectorlaag. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Vereenvoudigd OUTPUT [hetzelfde als

invoer]
De uitvoer (vereenvoudigde) vectorlaag

Pythoncode

ID algoritme: native:simplifygeometries

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Enkelzijdige buffer

Berekent een buffer voor lĳnen met een gespecificeerde afstand aan slechts één zĳde van de lĳn.
Buffer resulteert altĳd in een polygonen-laag.

Fig. 27.97: Linker- versus rechterkant buffer op dezelfde vector lijnen-laag

Zie ook:
Buffer

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn] Invoer lĳn-vectorlaag
Afstand DISTANCE [getal]

Standaard: 10.0
Bufferafstand

Zĳde SIDE [enumeratie]
Standaard: 0

Aan welke zĳde de buffer te maken. Één
van:

• 0 – Links
• 1 – Rechts

Segmenten SEGMENTS [getal]
Standaard: 8

Beheert het aantal te gebruiken
lĳnsegmenten om een kwart cirkel te
benaderen bĳ het maken van ronde
verschuivingen.

Verbindingsstĳl JOIN_STYLE [enumeratie]
Standaard: 0

Specificeert of ronde, hoekige of puntige
verbindingsstĳlen zouden moeten worden
gebruikt bĳ het verschuiven van hoeken in
een lĳn. Opties zĳn:

• 0 — Afgerond
• 1 — Puntig
• 2 — Hoekig

Fig. 27.98: Ronde, diagonale en schuine
koppelstĳlen

Vervolgt op volgende pagina
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Tabel 27.161 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Maximale
puntlengte bĳ
scherpe hoeken

MITER_LIMIT [getal]
Standaard: 2.0

Stelt de maximale afstand van de
te gebruiken geometrie voor de
verschuiving bĳ het maken van een
puntige verbindingsstĳl in als een factor
van de afstand van de verschuiving
(alleen van toepassing voor puntige
verbindingsstĳlen). Minimum: 1.0

Fig. 27.99: Een buffer van 10m met een
limiet van 2 en een buffer van 10m met een
limiet van 1

Buffer OUTPUT [vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoerlaag (buffer). Één
van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Buffer OUTPUT [vector: polygoon] Uitvoer (buffer) polygoonlaag

Pythoncode

ID algoritme: native:singlesidedbuffer

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Glad maken

Vlakt de geometrieën in een lĳn- of polygoonlaag af, door meerdere punten en hoeken toe te voegen aan de
geometrieën van de objecten.
De parameter Doorlopen geeft aan hoeveel doorlopen voor afvlakken zullen worden toegepast op elke geometrie.
Meer doorlopen resulteren in gladdere geometrieën ten koste van het toenemen van het aantal punten in deze
geometrieën.

Fig. 27.100: Verhogen van het aantal doorlopen zorgt voor meer afgevlakte geometrieën

De parameter Verspringing beheert hoe “nauw” de afgevlakte geometrieën de originele geometrieën volgen. Kleinere
waarden resulteren in nauwer glad maken, grotere waarden resulteren in losser glad maken.

Fig. 27.101: Blauw: de invoerlaag. Verschuiving 0.25 geeft de rode lijn, terwijl verschuiving 0.50 de groene lijn geeft.

De parameter Maximale hoek kan worden gebruikt om het glad maken van knopen met grote hoeken te voorkomen.
Elke knoop waar de hoek van de segmenten aan beide zĳden groter is dan dit zal niet worden glad gemaakt.
Bĳvoorbeeld: het instellen van de maximale hoek op 90 graden of lager zou rechte hoeken in de geometrie behouden.
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Maakt objecten op hun plaats aanpassen mogelĳk voor objecten lĳn en polygoon
Zie ook:
Vereenvoudigen, Verdichten op aantal, Verdichten op interval

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn,

polygoon]
Invoer lĳn- of polygoonvectorlaag

Doorlopen ITERATIONS [getal ]
Standaard: 1

Verhogen van het aantal doorlopen zorgt
voor meer afgevlakte geometrieën (en meer
punten).

Verschuiving OFFSET [getal ]
Standaard: 0.25

Verhogen van waarden zal de afgevlakte
lĳnen / grenzen verplaatsen, verder weg van
de invoerlĳnen / grenzen.

Maximum hoek
voor knoop om af
te vlakken

MAX_ANGLE [getal ]
Standaard: 180.0

Elke knoop onder deze waarde zal worden
afgevlakt

Afgevlakt OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer (afgevlakte) laag.
Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Afgevlakt OUTPUT [hetzelfde als

invoer]
Uitvoer (afgevlakte) vectorlaag

Pythoncode

ID algoritme: native:smoothgeometry

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Geometrieën aan laag snappen

Snapt de geometrieën op een laag aan ofwel de geometrieën van een andere laag of aan geometrieën op dezelfde laag.
Vergelĳken wordt gedaan gebaseerd op een afstand voor tolerantie, en punten zullen, indien vereist, worden ingevoegd
of verwĳderd om de geometrieën te laten overeenkomen met de geometrieën voor verwĳzing.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt, lĳn en polygoon
Zie ook:
Punten aan grid snappen

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Verwĳzingslaag REFERENCE_LAYER[vector: elke] Vectorlaag waaraan gesnapt moet worden
Tolerantie TOLERANCE [getal]

Standaard: 10.0
Beheren hoe dicht, bĳ de geometrieën van
de verwĳzingslaag, invoerpunten moeten
zĳn voordat zĳ worden gesnapt.

Vervolgt op volgende pagina
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Tabel 27.163 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Gedrag* BEHAVIOR [enumeratie]

Standaard: 0
Snappen kan worden gedaan aan een
bestaande knoop of een segment (het
dichtstbĳzĳnde punt voor het te verplaatsen
punt). Beschikbare opties voor snappen:

• 0 — Voorkeur voor uitgelĳnde
knopen, voeg extra punten toe waar
vereist
Voorkeur om aan knopen te snappen,
zelfs als een segment dichterbĳ zou
zĳn dan een knoop. Nieuwe knopen
zullen worden ingevoegd om er voor
te zorgen dat geometrieën elkaar
exact volgen wanneer zĳ binnen de
toegestane tolerantie liggen.

• 1 — Voorkeur voor dichtstbĳzĳnde
punt, voeg extra punten toe waar
vereist
Snap aan het dichtstbĳzĳnde punt,
ongeacht of het een knoop of een
segment is. Nieuwe knopen zullen
worden ingevoegd om er voor te
zorgen dat geometrieën elkaar
exact volgen wanneer zĳ binnen de
toegestane tolerantie liggen.

• 2 — Voorkeur voor uitgelĳnde
knopen, geen nieuwe punten
toevoegen
Voorkeur om aan knopen te snappen,
zelfs als een segment dichterbĳ zou
zĳn dan een knoop. Er zullen geen
nieuwe knopen worden ingevoegd.

• 3 — Voorkeur voor dichtstbĳzĳnde
punt, geen nieuwe punten toevoegen
Snap aan het dichtstbĳzĳnde punt,
ongeacht of het een knoop of een
segment is. Er zullen geen nieuwe
knopen worden ingevoegd.

• 4 — Alleen eindpunten verplaatsen,
voorkeur voor uitlĳnen van knopen
Alleen snappen aan begin-
/eindpunten van lĳnen (puntobjecten
zullen ook worden gesnapt, objecten
polygoon zullen niet worden
aangepast), voorkeur voor snappen
aan knopen.

• 5 — Alleen eindpunten verplaatsen,
voorkeur voor dichtstbĳzĳnde punt
Alleen snappen aan begin-
/eindpunten van lĳnen (puntobjecten
zullen ook worden gesnapt,
objecten polygoon zullen niet
worden aangepast), snappen aan
dichtstbĳzĳnde punt.

• 6 — Alleen eindpunten aan
eindpunten snappen
De begin-/eindpunten van lĳnen
alleen snappen aan andere begin-
/eindpunten van lĳnen

• 7 — Aan ankers voor knopen
vastzetten (alleen enkele laag)

Vervolgt op volgende pagina
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Tabel 27.163 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Gesnapte
geometrie

OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer (gesnapte) laag. Één
van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Gesnapte
geometrie

OUTPUT [hetzelfde als
invoer]

Uitvoer (gesnapte) vectorlaag

Pythoncode

ID algoritme: native:snapgeometries

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Punten aan grid snappen

Past de coördinaten van geometrieën op een vectorlaag aan, zodat alle punten worden gesnapt aan het dichtstbĳzĳnde
punt van een raster.
Als de gesnapte geometrie niet kan worden berekend (of totaal is samengevouwen) zal de geometrie van het object
worden opgeschoond.
Snappen kan worden uitgevoerd op de X-, Y-, Z- of M-as. Een afstand voor het raster van 0 voor enige as zal snappen
voor die as uitschakelen.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt, lĳn en polygoon

Notitie: Snappen aan raster kan in enkele randgevallen een ongeldige geometrie veroorzaken.

Zie ook:
Geometrieën aan laag snappen
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag

X rasterafstand HSPACING [getal ]
Standaard: 1.0

Rasterafstand op de X-as

Y rasterafstand VSPACING [getal ]
Standaard: 1.0

Rasterafstand op de Y-as

Z rasterafstand ZSPACING [getal ]
Standaard: 0.0

Rasterafstand op de Z-as

M rasterafstand MSPACING [getal ]
Standaard: 0.0

Rasterafstand op de M-as

Gesnapt OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer (gesnapte) laag. Één
van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Gesnapt OUTPUT [hetzelfde als

invoer]
Uitvoer (gesnapte) vectorlaag

Pythoncode

ID algoritme: native:snappointstogrid

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Lijnen splitsen op maximum lengte

Neemt een lĳn (of boog) laag en splitst elk object naar meerdere delen, waarbĳ elk deel van een gespecificeerde
maximum lengte is. Waarden Z en M aan het begin en einde van de nieuwe sublĳn worden lineair geïnterpoleerd
vanuit bestaande waarden.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten lĳn

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn] De invoer lĳn vectorlaag

Maximum
lĳnlengte

LENGTH [getal ]
Standaard: 10.0

De maximum lengte van een lĳn in de
uitvoer.

Splitsen OUTPUT [vector: lĳn]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer lĳn vectorlaag. Één
van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Splitsen OUTPUT [vector: lĳn] De nieuwe lĳn vectorlaag - de lengte van de

geometrieën van het object zĳn kleiner of
gelĳk aan de lengte die is gespecificeerd in
de parameter LENGTH.

Pythoncode

ID algoritme: native:splitlinesbylength

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Onderverdelen

Deelt de geometrie op. De teruggegeven geometrie zal een verzameling zĳn die onderverdeelde delen van de originele
geometrie bevat, waarbĳ een deel niet meer dan het gespecificeerde aantal knopen heeft.
Dit is handig voor het opdelen van een complexe geometrie in minder complexe delen, gemakkelĳker ruimtelĳk
te indexeren en sneller bĳ het uitvoeren van ruimtelĳke bewerkingen. Gebogen geometrieën zullen worden
gesegmenteerd vóór het onderverdelen.

Fig. 27.102: Links de invoerlaag, midden maximale waarde voor knopen is 100 en rechts maximale waarde is 200

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt, lĳn en polygoon

Notitie: Onderverdelen van een geometrie kan delen van geometrieën maken die niet geldig zouden kunnen zĳn en
zouden zelfkruisingen kunnen bevatten.

Zie ook:
Lĳnen uitvergroten, Lĳn subdeel

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] De invoer vectorlaag

Maximum aantal
knopen in delen

MAX_NODES [getal ]
Standaard: 256

Maximum aantal punten dat elke nieuwe
geometrie mag hebben. Minder sub-delen
voor hogere waarden.

Onderverdeeld OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer (onderverdeelde)
vectorlaag. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Beschrijving
Onderverdeeld OUTPUT [hetzelfde als

invoer]
Uitvoer vectorlaag

Pythoncode

ID algoritme: native:subdivide

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

X- en Y-coördinaten wisselen

Verwisselt de waarden voor X- en Y-coördinaten in geometrieën voor invoer.
Het kan worden gebruikt om geometrieën te repareren waarvan per abuis de waarden voor breedte- en lengtegraad
zĳn omgedraaid.

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt, lĳn en polygoon
Zie ook:
Transleren, Rotatie

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] De invoer vectorlaag
Verwisseld OUTPUT [hetzelfde als

invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Beschrijving
Verwisseld OUTPUT [hetzelfde als

invoer]
Uitvoer (verwisselde) vectorlaag

Pythoncode

ID algoritme: native:swapxy

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Taps toelopende buffers

Maakt taps toelopende buffers langs geometrieën lĳn met behulp van een gespecificeerde diameter voor begin en
eind van de buffer.

Fig. 27.103: Voorbeeld Taps toelopende buffers

Zie ook:
Variabele breedte buffer (op M-waarde), Buffer,Wigvormige buffers maken
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn] Invoer lĳn-vectorlaag

Beginbreedte START_WIDTH [getal ]
Standaard: 0.0

Geeft de straal van de buffer weer die wordt
toegepast op het beginpunt van het object
lĳn.

Eindbreedte END_WIDTH [getal ]
Standaard: 0.0

Geeft de straal van de buffer weer die wordt
toegepast op het eindpunt van het object lĳn.

Segmenten SEGMENTS [getal ]
Standaard: 16

Beheert het aantal te gebruiken
lĳnsegmenten om een kwart cirkel te
benaderen bĳ het maken van ronde
verschuivingen.

Gebufferd OUTPUT [vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoerlaag (buffer). Één
van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Gebufferd OUTPUT [vector: polygoon] Uitvoer (buffer) polygoonlaag

Pythoncode

ID algoritme: native:taperedbuffer

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Tegelen

Tegelt een geometrie polygonen-laag, waarbĳ de geometrieën worden opgedeeld in driehoekige componenten.
De uitvoerlaag bestaat uit geometrieën multipolygoon voor elk invoerobject, waarbĳ elke multipolygoon bestaat uit
meerdere driehoekige component-polygonen.

Fig. 27.104: Getegelde polygoon (rechts)

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten polygoon

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: polygoon] Invoer polygoon-vectorlaag
Mozaïek OUTPUT [vector: polygoon]

Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoerlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Mozaïek OUTPUT [vector: polygoon] Uitvoer multipolygoon Z laag
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Pythoncode

ID algoritme: 3d:tessellate

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Doorsnede

Dit algoritme maakt doorsneden op hoekpunten voor (multi)lĳnen.
Een doorsnede is een lĳn, geplaatst onder een hoek (standaard loodrecht) op de polylĳnen voor de invoer (op
hoekpunten).
Veld(en) uit object(en) worden teruggegeven in de doorsnede met deze nieuwe velden:

• TR_FID: ID van het originele object
• TR_ID: ID van de doorsnede. Elke doorsnede heeft een unieke ID
• TR_SEGMENT: ID van het segment van de lĳn
• TR_ANGLE: Hoek in graden vanuit de originele lĳn op het hoekpunt
• TR_LENGTH: Totale lengte van de teruggegeven doorsnede
• TR_ORIENT: Zĳde van de doorsnede (alleen linker of rechterkant van de lĳn, of beide zĳden)

Fig. 27.105: Gestreepte rode lijnen geven de doorsnede weer van de invoer lijnen-laag

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn] Invoer lĳn-vectorlaag

Lengte van de
doorsnede

LENGTH [getal ]
Standaard: 5.0

Lengte van de doorsnede in kaarteenheden

Vervolgt op volgende pagina
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Tabel 27.166 – Vervolgd van vorige pagina
Label Naam Type Beschrijving

Hoek in graden
vanuit de originele
lĳn op de punten

ANGLE [getal ]
Standaard: 90.0

De hoek van de doorsnede wĳzigen

Zĳde waar de
doorsnede moet
worden gemaakt

SIDE [enumeratie] De zĳde van de doorsnede kiezen.
Beschikbare opties zĳn:

• 0 — Links
• 1 — Rechts
• 2 — Beide

Doorsnede OUTPUT [vector: lĳn]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer lĳnlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Doorsnede OUTPUT [vector: lĳn] Uitvoer lĳnlaag

Pythoncode

ID algoritme: native:transect

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Transleren

Verplaatst de geometrieën binnen een laag, door te verschuiven met een vooraf gespecificeerde verplaatsing X en Y.
Waarden Z en M die aanwezig zĳn in de geometrie kunnen ook worden getransleerd.
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Fig. 27.106: Gestreepte lijnen geven de getransleerde geometrie weer van de invoerlaag

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt, lĳn en polygoon
Zie ook:
Array van getransleerde objecten, Verspringing lĳnen, Rotatie, X- en Y-coördinaten wisselen

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag

Afstand
verschuiving
(X-as)

DELTA_X [getal ]
Standaard: 0.0

Toe te passen verplaatsing op de X-as

Afstand
verschuiving
(Y-as)

DELTA_Y [getal ]
Standaard: 0.0

Toe te passen verplaatsing op de Y-as

Afstand
verschuiving
(Z-as)

DELTA_Z [getal ]
Standaard: 0.0

Toe te passen verplaatsing op de Z-as

Afstand
verschuiving
(waarden M)

DELTA_M [getal ]
Standaard: 0.0

Toe te passen verplaatsen op de M-as

Translatie OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Beschrijving
Translatie OUTPUT [hetzelfde als

invoer]
Uitvoer vectorlaag

Pythoncode

ID algoritme: native:translategeometry

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Variabele breedte buffer (op M-waarde)

Maakt buffers met een variabele breedte langs lĳnen met behulp van de waardeM van de lĳngeometrieën als diameter
van de buffer op elke hoek.

Fig. 27.107: Voorbeeld Variabele buffer
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Zie ook:
Taps toelopende buffers, Buffer, M-waarde instellen, Variabele bufferafstand

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn] Invoer lĳn-vectorlaag

Segmenten SEGMENTS [getal ]
Standaard: 16

Aantal buffersegmenten per kwartcirkel.
Het mag een unieke waarde zĳn (dezelfde
waarde voor alle objecten) of het mag
worden genomen uit gegevens van de
objecten (de afstand is afhankelĳk van de
attributen van de objecten).

Gebufferd OUTPUT [vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoerlaag (buffer). Één
van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Gebufferd OUTPUT [vector: polygoon] Variabele buffer polygoonlaag

Pythoncode

ID algoritme: native:bufferbym

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Voronoi-polygonen

Neemt een puntlaag en maakt een polygoonlaag die de Voronoi-polygonen bevat (ook bekend als Thiessen-
polygonen), die corresponderen met die invoerpunten.
Elke locatie binnen een Voronoi-polygoon is dichter bĳ het geassocieerde punt dan enig ander punt.

Fig. 27.108: Voronoi-polygonen

Standaard menu: Vector ► Geometrie-gereedschappen

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: punt] Invoer punt-vectorlaag
Buffer regio (%
van bereik)

BUFFER [getal]
Standaard: 0.0

Het bereik van de uitvoerlaag zal zoveel
groter zĳn dan het bereik van de invoerlaag

Voronoi-
polygonen

OUTPUT [vector: polygoon]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoerlaag (met de Voronoi-
polygonen). Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Beschrijving
Voronoi-
polygonen

OUTPUT [vector: polygoon] Voronoi-polygonen van de invoer punt
vectorlaag

Pythoncode

ID algoritme: qgis:voronoipolygons

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

27.1.19 Vector op elkaar leggen

Clippen

Knipt een vectorlaag bĳ met behulp van de objecten van een aanvullende polygoonlaag.
Alleen de delen van de polygonen op de invoerlaag die vallen binnen de polygonen van de overleglaag zullen worden
toegevoegd aan de laag met resultaten.

Waarschuwing: Past alleen geometrie aan
Deze bewerking past alleen de geometrie van het object aan. De waarden van de attributen van de objecten worden
niet aangepast, hoewel eigenschappen zoals het gebied of de lengte van objecten wel zullen worden aangepast
door de bewerking clippen. Als dergelĳke eigenschappen worden opgeslagen als attributen, moeten deze attributen
handmatig worden bĳgewerkt.

Dit algoritme gebruikt ruimtelĳke indexen voor de providers, vooraf bereide geometrieën en past een bewerking
knippen toe als de geometrie niet geheel wordt omsloten door de masker-geometrie.

Fig. 27.109: Bewerking Clippen tussen een invoerlaag met twee objecten ‘a’ en een overleglaag met één enkel object
‘b’ (links) - resulterend in een nieuwe laag met de aangepaste objecten ‘a’ (rechts)

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt, lĳn en polygoon
Standaard menu: Vector ► Geoprocessing-gereedschap.
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Zie ook:
Kruising, Verschil

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] De laag die de objecten bevat die moeten

worden geclipt
Overleglaag OVERLAY [vector: polygoon] Laag die de objecten voor het clippen bevat
Geclipt OUTPUT [hetzelfde als

invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de laag die de objecten moet
bevatten van de invoerlaag die liggen binnen
de overleglaag (clippende). Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Geclipt OUTPUT [hetzelfde als

invoer]
Laag die de objecten bevat die zĳn
afgesplitst van de invoerlaag door de
overleglaag.

Pythoncode

ID algoritme: qgis:clip

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Verschil

Neemt objecten uit van de invoerlaag die niet vallen binnen de grenzen van de overleglaag.
Objecten van de invoerlaag die gedeeltelĳk object(en) van de overleglaag overlappen worden gesplitst langs de grenzen
van die object(en) en alleen de gedeelten buiten de objecten van de overleglaag worden behouden.

Waarschuwing: Past alleen geometrie aan
Deze bewerking past alleen de geometrie van het object aan. De waarden van de attributen van de objecten worden
niet aangepast, hoewel eigenschappen zoals het gebied of de lengte van objecten wel zullen worden aangepast
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door de bewerking clippen. Als dergelĳke eigenschappen worden opgeslagen als attributen, moeten deze attributen
handmatig worden bĳgewerkt.

Fig. 27.110: Bewerking Verschil tussen een invoerlaag met twee objecten ‘a’ en een overleglaag met één enkel object
‘b’ (links) - resulterend in een nieuwe laag met de aangepaste objecten ‘a’ (rechts)

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt, lĳn en polygoon
Standaard menu: Vector ► Geoprocessing-gereedschap.
Zie ook:
Verschil (meerdere), Symmetrisch verschil, Clippen

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Laag waarvan (delen van) objecten moeten

worden uitgenomen.
Overleglaag OVERLAY [vector: elke] Laag die de geometrieën bevat die zullen

worden afgetrokken van de geometrieën
van de invoerlaag. Het wordt verwacht
tenminste net zoveel dimensies (punt: 0D,
lĳn: 1D, polygoon: 2D, volume: 3D)
te hebben als de geometrieën van de
invoerlaag.

Verschil OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de laag die (delen van) objecten
van de invoerlaag bevat die niet binnen de
overleglaag liggen. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.
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Gevorderde parameters

Label Naam Type Beschrijving
Rastergrootte
NEW in 3.28
Optioneel

GRID_SIZE [getal]
Standaard: Niet
ingesteld

Indien opgegeven worden de geometrieën
voor de invoer gesnapt aan een raster van
de opgegeven grootte, en de resulterende
punten worden berekend op datzelfde
raster. Vereist GEOS 3.9.0 of hoger.

Uitvoer

Label Naam Type Beschrijving
Verschil OUTPUT [hetzelfde als

invoer]
Laag die (delen van) objecten van de
invoerlaag bevat die niet worden overlapt
door de overleglaag.

Pythoncode

ID algoritme: qgis:difference

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Verschil (meerdere)

NEW in 3.26

Neemt objecten uit de invoerlaag die volledig buiten vallen of slechts gedeeltelĳk de objecten overlappen van een/de
overgelegde la(a)g(en).
Voor elke overgelegde laag wordt het verschil berekend tussen het resultaat van alle eerdere bewerkingen Verschil
en deze overgelegde laag. Objecten van de invoerlaag die gedeeltelĳk object(en) overlappen in de overgelegde laag
worden gesplitst langs de grens van dat object en alleen de gedeelten buiten de objecten van de overgelegde laag
worden behouden.

Waarschuwing: Past alleen geometrie aan
Deze bewerking past alleen de geometrie van het object aan. De waarden van de attributen van de objecten worden
niet aangepast, hoewel eigenschappen zoals het gebied of de lengte van objecten wel zullen worden aangepast
door de bewerking clippen. Als dergelĳke eigenschappen worden opgeslagen als attributen, moeten deze attributen
handmatig worden bĳgewerkt.
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Fig. 27.111: Bewerking Verschil tussen een invoerlaag met twee objecten ‘a’ en een overleglagen met één enkel object
‘b’ en ‘c’ (links) - resulterend in een nieuwe laag met de aangepaste objecten ‘a’ (rechts)

Zie ook:
Verschil, Symmetrisch verschil, Clippen

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Laag waarvan (delen van) objecten moeten

worden uitgenomen.
Overleglagen OVERLAYS [vector: elke] [lĳst] Lĳst met lagen die de geometrieën bevatten

die zullen worden afgetrokken van de
geometrieën van de invoerlaag. Zĳ worden
verwacht tenminste net zoveel dimensies
(punt: 0D, lĳn: 1D, polygoon: 2D, volume:
3D) te hebben als de geometrieën van de
invoerlaag.

Verschil OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de laag die (delen van) objecten
van de invoerlaag moet bevatten die geen
objecten van de overleglaag overlappen. Één
van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Verschil OUTPUT [hetzelfde als

invoer]
Laag die (delen van) objecten van de
invoerlaag bevat die geen objecten van de
overleglagen overlappen.
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Pythoncode

ID algoritme: qgis:multidifference

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Uitnemen/clippen op bereik

Maakt een nieuwe vectorlaag die alleen objecten bevat die vallen binnen een gespecificeerd bereik.
Alle objecten die kruisen met het bereik zullen worden opgenomen.

Fig. 27.112: Bewerking voor uitnemen tussen een invoerlaag met drie objecten ‘a’ en een gestreept bereik (links) -
resulterende objecten met gestreept bereik voor verwijzing (rechts)

Zie ook:
Clippen
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Laag waarvan (delen van) objecten moeten

worden uitgenomen.
Bereik (xmin,
xmax, ymin,
ymax)

EXTENT [bereik] Bereik voor clippen.
Beschikbare methoden zĳn:

• Uit laag berekenen…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

Objecten naar
bereik clippen

CLIP [Booleaanse
waarde]
Standaard: False

Indien geselecteerd zullen geometrieën
voor de uitvoer automatisch worden
geconverteerd naar multi-geometrieën om
uniforme typen voor uitvoer te krĳgen.
Meer nog, de geometrieën zullen worden
geclipt tot het gekozen bereik in plaats van
de gehele geometrie als uitvoer te nemen.

Fig. 27.113: Bewerking voor uitnemen
tussen een invoerlaag met drie objecten
‘a’ en een gestreept bereik (links) -
resulterende objecten met gestreept bereik
voor verwĳzing (rechts)

Uitgenomen OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de laag die de objecten moet
bevatten van de invoerlaag die liggen binnen
het bereik om te clippen. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.
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Uitvoer

Label Naam Type Beschrijving
Uitgenomen OUTPUT [hetzelfde als

invoer]
Laag die de geclipte objecten bevat.

Pythoncode

ID algoritme: qgis:extractbyextent

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Kruising

Neemt delen van objecten van de invoerlaag uit die objecten op de overleglaag overlappen.
Objecten op de kruisingslaag worden de attributen toegewezen van de overlappende objecten uit zowel de invoerlaag
als de overleglaag.

Waarschuwing: Past alleen geometrie aan
Deze bewerking past alleen de geometrie van het object aan. De waarden van de attributen van de objecten worden
niet aangepast, hoewel eigenschappen zoals het gebied of de lengte van objecten wel zullen worden aangepast
door de bewerking clippen. Als dergelĳke eigenschappen worden opgeslagen als attributen, moeten deze attributen
handmatig worden bĳgewerkt.

Fig. 27.114: Bewerking Kruising tussen een invoerlaag met twee objecten ‘a’ en een overleglagen met één enkel object
‘b’ (links) - overlappende gebieden worden een nieuwe laag met twee objecten met attributen van beide lagen (rechts)

Standaard menu: Vector ► Geoprocessing-gereedschap.
Zie ook:
Kruising (meerdere), Clippen, Verschil
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Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Laag waarvan (delen van) objecten moeten

worden uitgenomen.
Overleglaag OVERLAY [vector: elke] Laag die de objecten bevat die moeten

worden gecontroleerd op overlappen. Van
de geometrie ervan wordt verwacht dat die
tenminste net zoveel dimensies (punt: 0D,
lĳn: 1D, polygoon: 2D, volume: 3D) heeft
als die van de invoerlaag.

Invoervelden om
te behouden (laat
leeg om alle velden
te behouden)
Optioneel

INPUT_FIELDS [tabelveld: elk]
[lĳst]
Standaard: Geen

Veld(en) van de invoerlaag om te behouden
in de uitvoer. Indien geen velden worden
gekozen worden alle velden behouden.

Velden voor
overleggen
behouden (laat
leeg om alle velden
te behouden)
Optioneel

OVERLAY_FIELDS [tabelveld: elk]
[lĳst]
Standaard: Geen

Veld(en) van de overleglaag die moeten
worden behouden in de uitvoer. Als er geen
velden worden gekozen worden alle velden
genomen. Aan duplicaat veldnamen zal een
getal als achtervoegsel worden toegevoegd
om botsingen te voorkomen.

Kruisen OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de laag die (delen van) objecten
van de invoerlaag bevat die één of meer
objecten van de overleglaag overlappen. Één
van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Gevorderde parameters

Label Naam Type Beschrijving
Voorvoegsel
velden overleggen
Optioneel

OVERLAY_FIELDS_PREFIX[tekenreeks] Voeg een voorvoegsel toe om velden van de
overleglaag te identificeren. Aan duplicaat
veldnamen zal een getal als achtervoegsel
worden toegevoegd om botsingen te
voorkomen.

Rastergrootte
NEW in 3.28
Optioneel

GRID_SIZE [getal]
Standaard: Niet
ingesteld

Indien opgegeven worden de geometrieën
voor de invoer gesnapt aan een raster van
de opgegeven grootte, en de resulterende
punten worden berekend op datzelfde
raster. Vereist GEOS 3.9.0 of hoger.
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Uitvoer

Label Naam Type Beschrijving
Kruisen OUTPUT [hetzelfde als

invoer]
Laag die (delen van) objecten van de
invoerlaag bevat die de overleglaag
overlappen.

Pythoncode

ID algoritme: qgis:intersection

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Kruising (meerdere)

NEW in 3.26

Neemt de overlappende gedeelten uit van objecten in de invoer- en alle overleglagen.
Objecten op de uitvoerlaag worden de attributen toegewezen van de overlappende objecten uit zowel de invoerlaag
als de overleglagen.

Waarschuwing: Past alleen geometrie aan
Deze bewerking past alleen de geometrie van het object aan. De waarden van de attributen van de objecten worden
niet aangepast, hoewel eigenschappen zoals het gebied of de lengte van objecten wel zullen worden aangepast
door de bewerking clippen. Als dergelĳke eigenschappen worden opgeslagen als attributen, moeten deze attributen
handmatig worden bĳgewerkt.

Fig. 27.115: Bewerking Kruising tussen een invoerlaag met twee objecten ‘a’ en overleglagen met één enkel object ‘b’
en ‘c’ (links) - overlappende gebieden worden een nieuwe laag met twee objecten met attributen van alle lagen (rechts)

Zie ook:
Kruising, Clippen, Verschil
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Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Laag waarvan (delen van) objecten moeten

worden uitgenomen.
Overleglagen OVERLAYS [vector: elke] [lĳst] Lagen die de objecten bevatten die moeten

worden gecontroleerd op overlappen.
Van de geometrie van de objecten wordt
verwacht dat die tenminste net zoveel
dimensies (punt: 0D, lĳn: 1D, polygoon:
2D, volume: 3D) heeft als die van de
invoerlaag.

Gevorderde parameters

Label Naam Type Beschrijving
Voorvoegsel
velden overleggen
Optioneel

OVERLAY_FIELDS_PREFIX[tekenreeks] Voeg een voorvoegsel toe om velden van de
overleglagen te identificeren. Aan duplicaat
veldnamen zal een getal als achtervoegsel
worden toegevoegd om botsingen te
voorkomen.

Uitvoer

Label Naam Type Beschrijving
Kruisen OUTPUT [hetzelfde als

invoer]
Laag die (delen van) objecten van de
invoerlaag bevat die alle overleglagen
overlappen.

Pythoncode

ID algoritme: qgis:multiintersection

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Kruisingen van lijnen

Maakt puntobjecten waar de lĳnen van de twee lĳnen elkaar kruisen.

Fig. 27.116: Punten van kruisingen

Standaard menu: Vector ► Analyse-gereedschap

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn] Invoer lĳnlaag.
Kruisende laag INTERSECT [vector: lĳn] Te gebruiken laag om kruisende lĳnen te

zoeken.
Invoervelden om
te behouden (laat
leeg om alle velden
te behouden)
Optioneel

INPUT_FIELDS [tabelveld: elk]
[lĳst]
Standaard: Geen

Veld(en) van de invoerlaag om te behouden
in de uitvoer. Indien geen velden worden
gekozen worden alle velden behouden.

Velden voor
kruisen behouden
(laat leeg om
alle velden te
behouden)
Optioneel

INTERSECT_FIELDS[tabelveld: elk]
[lĳst]
Standaard: Geen

Veld(en) van de kruisingslaag die moeten
worden behouden in de uitvoer. Als er geen
velden worden gekozen worden alle velden
genomen. Aan duplicaat veldnamen zal een
getal als achtervoegsel worden toegevoegd
om botsingen te voorkomen.

Vervolgt op volgende pagina
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Tabel 27.176 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Kruisen OUTPUT [vector: punt]

Standaard:
[Tijdelijke
laag maken]

Specificeer de laag die de kruisende punten
bevat van de lĳnen van de invoer- en
overleglaag. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Gevorderde parameters

Label Naam Type Beschrijving
Voorvoegsel
velden kruisen
Optioneel

INTERSECT_FIELDS_PREFIX[tekenreeks] Voeg een voorvoegsel toe om velden van de
kruisingslaag te identificeren.

Uitvoer

Label Naam Type Beschrijving
Kruisingen OUTPUT [vector: punt] Punt vectorlaag van de kruisingen van

lĳnen, met attributen van beide lagen.

Pythoncode

ID algoritme: qgis:lineintersections

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Splitsen met lijnen

Splitst de lĳnen of polygonen in een laag met behulp van de lĳnen in een andere laag om de breekpunten te definiëren.
Kruisingen tussen geometrieën in beide lagen worden als punten om te splitsen beschouwd.
Uitvoer zal multi-geometrieën bevatten voor de gesplitste objecten.
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Fig. 27.117: Lijnen splitsen

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten lĳn en polygoon

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: lĳn,

polygoon]
Laag die de lĳnen of polygonen bevat die
moeten worden gesplitst.

Laag splitsen LINES [vector: lĳn,
polygoon]

Laag waarvan de lĳnen of ringen worden
gebruikt om de breekpunten te definiëren.

Splitsen OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de laag die de gesplitste (voor
het geval zĳ worden gekruist door een lĳn
in de te splitsen laag) objecten lĳn/polygoon
van de invoerlaag bevat. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Splitsen OUTPUT [hetzelfde als

invoer]
Uitvoer vectorlaag met gesplitste lĳnen of
polygonen van de invoerlaag.

Pythoncode

ID algoritme: qgis:splitwithlines

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Symmetrisch verschil

Maakt een laag die objecten bevat uit zowel de invoer- als de overleglaag, maar met de overlappende gedeelten tussen
de twee lagen verwĳderd.
De attributentabel van de laag voor het symmetrisch verschil bevat attributen uit zowel de invoerlaag als de overleglaag.

Waarschuwing: Past alleen geometrie aan
Deze bewerking past alleen de geometrie van het object aan. De waarden van de attributen van de objecten worden
niet aangepast, hoewel eigenschappen zoals het gebied of de lengte van objecten wel zullen worden aangepast
door de bewerking clippen. Als dergelĳke eigenschappen worden opgeslagen als attributen, moeten deze attributen
handmatig worden bĳgewerkt.

Fig. 27.118: Bewerking Symmetrisch verschil tussen een invoerlaag met twee objecten en een overleglaag met één
enkel object ‘b’ (links) - resulterende laag met drie objecten met attributen van beide lagen (rechts)

Standaard menu: Vector ► Geoprocessing-gereedschap.
Zie ook:
Verschil, Clippen, Kruising

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Eerste laag waarvan (delen van) objecten

moeten worden uitgenomen.
Overleglaag OVERLAY [vector: elke] Tweede laag waaruit (delen van) objecten

moeten worden uitgenomen. Idealiter zou
het type geometrie hetzelfde moeten zĳn als
die van de invoerlaag.

Symmetrisch
verschil

OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de laag die (delen van) de
objecten bevat uit de invoer- en overleglaag
die geen objecten overlappen van de andere
laag. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.
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Gevorderde parameters

Label Naam Type Beschrijving
Voorvoegsel
velden overleggen
Optioneel

OVERLAY_FIELDS_PREFIX[tekenreeks] Voeg een voorvoegsel toe om velden van de
overleglaag te identificeren. Aan duplicaat
veldnamen zal een getal als achtervoegsel
worden toegevoegd om botsingen te
voorkomen.

Rastergrootte
NEW in 3.28
Optioneel

GRID_SIZE [getal]
Standaard: Niet
ingesteld

Indien opgegeven worden de geometrieën
voor de invoer gesnapt aan een raster van
de opgegeven grootte, en de resulterende
punten worden berekend op datzelfde
raster. Vereist GEOS 3.9.0 of hoger.

Uitvoer

Label Naam Type Beschrijving
Symmetrisch
verschil

OUTPUT [hetzelfde als
invoer]

Laag die (delen van) objecten van elke
laag bevat die niet worden de andere laag
overlappen, met attributen van beide lagen.

Pythoncode

ID algoritme: qgis:symmetricaldifference

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Verenigen

Controleert het overlappen tussen objecten op de invoerlaag en maakt afzonderlĳke objecten voor overlappende en
niet-overlappende gedeelten. Het gebied van het overlappen zal net zoveel identieke overlappende objecten maken als
er objecten zĳn die deel uitmaken van het overlappen.

Fig. 27.119: Bewerking Verenigen met één enkele invoerlaag met twee overlappende objecten (links) - resulterende
in vier objecten (midden) - objecten zijn verplaatst voor duidelijkheid (rechts)

Een overleglaag kan ook worden gebruikt, in welk geval objecten van elke laag worden gesplitst op hun overlapping
met de andere, een laag makend die alle gedeelten van zowel de invoer- als de overleglaag bevat. Objecten op dezelfde
laag zullen elkaar niet splitsen. De attributentabel van de verenigde laag wordt gevuld met waarden van de attributen
uit de respectievelĳke originele laag voor niet-overlappende objecten, en de waarden van attributen uit beide lagen
voor overlappende objecten.

Fig. 27.120: Bewerking Verenigen tussen een invoerlaag met twee objecten ‘a’ en een overleglaag met één enkel object
‘b’ (links) - resulterend in een laag met vijf objecten met attributen van beide lagen (rechts)

Notitie: Met een overleglaag zullen objecten op dezelfde laag elkaar niet splitsen. Als u overlappingen op dezelfde
laag wilt splitsen, als ook op andere lagen, voer dan eerst het algoritme met meerdere lagen uit en voer dan het
algoritme opnieuw uit met alleen de eerdere uitvoer.

Standaard menu: Vector ► Geoprocessing-gereedschap.
Zie ook:
Verenigen (meerdere), Clippen, Verschil, Kruising
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Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag om te splitsen op

kruisingen.
Overleglaag
Optioneel

OVERLAY [vector: elke] Laag die zal worden gecombineerd met
de eerste. Idealiter zou het type geometrie
hetzelfde moeten zĳn als die van de
invoerlaag.

Verenigen OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de laag die de (gesplitste en
gedupliceerde) objecten bevat uit de invoer-
en overleglaag. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Gevorderde parameters

Label Naam Type Beschrijving
Voorvoegsel
velden overleggen
Optioneel

OVERLAY_FIELDS_PREFIX[tekenreeks] Voeg een voorvoegsel toe om velden van de
overleglaag te identificeren. Aan duplicaat
veldnamen zal een getal als achtervoegsel
worden toegevoegd om botsingen te
voorkomen.

Rastergrootte
NEW in 3.28
Optioneel

GRID_SIZE [getal]
Standaard: Niet
ingesteld

Indien opgegeven worden de geometrieën
voor de invoer gesnapt aan een raster van
de opgegeven grootte, en de resulterende
punten worden berekend op datzelfde
raster. Vereist GEOS 3.9.0 of hoger.

Uitvoer

Label Naam Type Beschrijving
Verenigen OUTPUT [hetzelfde als

invoer]
Laag die alle overlappende en niet-
overlappende delen van de verwerkte
la(a)g(en) bevat.
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Pythoncode

ID algoritme: qgis:union

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Verenigen (meerdere)

NEW in 3.26

Controleert het overlappen tussen objecten op de invoerlaag en maakt afzonderlĳke objecten voor overlappende en
niet-overlappende gedeelten. Het gebied van het overlappen zal net zoveel identieke overlappende objecten maken als
er objecten zĳn die deel uitmaken van het overlappen.

Fig. 27.121: Bewerking Verenigen met één enkele invoerlaag met twee overlappende objecten (links) - resulterende
in vier objecten (midden) - objecten zijn verplaatst voor duidelijkheid (rechts)

Meerdere overleglagen kunnen ook worden gebruikt, in welk geval objecten van elke laag worden gesplitst op hun
overlapping met de andere, een laag makend die alle gedeelten van zowel de invoer- als de overleglaag bevat. Objecten
op dezelfde laag zullen elkaar niet splitsen. De attributentabel van de verenigde laag wordt gevuld met waarden van
de attributen uit de respectievelĳke originele laag voor niet-overlappende objecten, en de waarden van attributen uit
beide lagen voor overlappende objecten.

Fig. 27.122: Bewerking Verenigen tussen een invoerlaag met twee objecten ‘a’ en een overleglaag met één enkel object
‘b’ (links) - resulterend in een laag met elf objecten met attributen van alle lagen (rechts)

Notitie: Met een overleglaag zullen objecten op dezelfde laag elkaar niet splitsen. Als u overlappingen op dezelfde
laag wilt splitsen, als ook op andere lagen, voer dan eerst het algoritme met meerdere lagen uit en voer dan het
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algoritme opnieuw uit met alleen de eerdere uitvoer.

Zie ook:
Verenigen, Clippen, Verschil, Kruising

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag om te splitsen op

kruisingen.
Overleglagen
Optioneel

OVERLAYS [vector: elke] [lĳst] Lagen die zullen worden gecombineerd met
de eerste. Idealiter zou het type geometrie
hetzelfde moeten zĳn als die van de
invoerlaag.

Verenigen OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de laag die de (gesplitste en
gedupliceerde) objecten bevat uit de invoer-
en overleglagen. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Gevorderde parameters

Label Naam Type Beschrijving
Voorvoegsel
velden overleggen
Optioneel

OVERLAY_FIELDS_PREFIX[tekenreeks] Voeg een voorvoegsel toe om velden van de
overleglagen te identificeren. Aan duplicaat
veldnamen zal een getal als achtervoegsel
worden toegevoegd om botsingen te
voorkomen.

Uitvoer

Label Naam Type Beschrijving
Verenigen OUTPUT [hetzelfde als

invoer]
Laag die alle overlappende en niet-
overlappende delen van de verwerkte
la(a)g(en) bevat, met attributen van alle
lagen.
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Pythoncode

ID algoritme: qgis:multiunion

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

27.1.20 Vector selectie

Uitnemen op attribuut

Maakt twee vectorlagen uit een invoerlaag: een zal alleen de overeenkomende objecten bevatten terwĳl de tweede
alle niet overeenkomende objecten zal bevatten.
De criteria voor het toevoegen van objecten aan de resulterende laag zĳn gebaseerd op de waarden van een attribuut
van de invoerlaag.
Zie ook:
Op attribuut selecteren

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Laag waaruit de objecten moeten worden

uitgenomen.
Attribuut
selecteren

FIELD [tabelveld: elk] Veld om de laag te filteren

Operator OPERATOR [enumeratie]
Standaard: 0

Veel verschillende operatoren zĳn
beschikbaar:

• 0 — =
• 1 — ̸=
• 2 — >
• 3 — >=
• 4 — <
• 5 — <=
• 6 — begint met
• 7 — bevat
• 8 — is null
• 9 — is niet null
• 10 — bevat niet

Waarde
Optioneel

VALUE [tekenreeks] Waarde die moet worden geëvalueerd

Vervolgt op volgende pagina
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Tabel 27.181 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Uitgenomen
(attribuut)

OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag voor
overeenkomende objecten. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitgenomen (niet
overeenkomend)

FAIL_OUTPUT [hetzelfde als
invoer]
Standaard:
[Uitvoer
overslaan]

Specificeer de uitvoer vectorlaag voor niet-
overeenkomende objecten. Één van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Uitgenomen
(attribuut)

OUTPUT [hetzelfde als
invoer]

Vectorlaag met overeenkomende objecten
uit de invoerlaag

Uitgenomen (niet
overeenkomend)

FAIL_OUTPUT [hetzelfde als
invoer]

Vectorlaag met niet-overeenkomende
objecten uit de invoerlaag

Pythoncode

ID algoritme: qgis:extractbyattribute

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmen van Processing uit te voeren vanuit
de console voor Python.
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Uitnemen met expressie

Maakt twee vectorlagen uit een invoerlaag: een zal alleen de overeenkomende objecten bevatten terwĳl de tweede
alle niet overeenkomende objecten zal bevatten.
De criteria voor het toevoegen van objecten aan de resulterende laag zĳn gebaseerd op een expressie voor QGIS. Voor
meer informatie over expressies, bekĳk de Expressies.
Zie ook:
Selecteren met expressie

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Expressie EXPRESSION [expressie] Expressie om de vectorlaag te filteren
Overeenkomende
objecten

OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag voor
overeenkomende objecten. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Niet
overeenkomend

FAIL_OUTPUT [hetzelfde als
invoer]
Standaard:
[Uitvoer
overslaan]

Specificeer de uitvoer vectorlaag voor niet-
overeenkomende objecten. Één van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Overeenkomende
objecten

OUTPUT [hetzelfde als
invoer]

Vectorlaag met overeenkomende objecten
uit de invoerlaag

Niet
overeenkomend

FAIL_OUTPUT [hetzelfde als
invoer]

Vectorlaag met niet-overeenkomende
objecten uit de invoerlaag
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Pythoncode

ID algoritme: qgis:extractbyexpression

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmen van Processing uit te voeren vanuit
de console voor Python.

Extract by location

Maakt een nieuwe vectorlaag die alleen overeenkomende objecten uit een invoerlaag bevat.
De criteria voor het toevoegen van objecten aan de resulterende laag zĳn gebaseerd op de ruimtelĳke relatie tussen
elk object en de objecten in een aanvullende laag.
Zie ook:
Selecteren op plaats, Uitnemen binnen afstand

Ruimtelijke relaties verkennen

Geometrische gezegdes zĳn functies met Booleaanse waarden die worden gebruikt om de ruimtelĳke relatie te bepalen
die een object heeft met een ander door te vergelĳken of en hoe hun geometrieën een portie van hun ruimte delen.

Fig. 27.123: Zoeken naar ruimtelijke relaties tussen lagen

Gebruik makend van de afbeelding hierboven zoeken we naar de groene cirkels door ze ruimtelĳk te vergelĳken met
het rechthoekige oranje object. Beschikbare geometrische gezegdes zĳn:
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Kruisen
Test of een geometrie een andere kruist. Geeft 1 ( true) terug als de geometrieën elkaar ruimtelĳk kruisen (een
stukje ruimte met elkaar delen - overlappen of raken) en 0 als zĳ dat niet doen. In de afbeelding hierboven zou
dit de cirkels 1, 2 en 3 teruggeven.

Bevat
Geeft 1 (true) terug als en alleen als er geen punten van b in het buitenste van a liggen, en ten minste één punt
van het interieur van b ligt in het interieur van a. In de afbeelding zou geen cirkel worden teruggegeven, maar
de rechthoek zou dat wel worden als u er op de omgekeerde wĳze naar zou zoeken, omdat het cirkel 1 volledig
bevat. Dit is het tegengestelde van zĳn binnen.

Raakt niet
Geeft 1 (true) terug als de geometrieën geen deel van de ruimte met elkaar delen (niet overlappen, elkaar niet
raken). Alleen cirkel 4 wordt teruggegeven.

Gelijk
Geeft 1 (true) terug als en alleen als geometrieën exact hetzelfde zĳn. Geen cirkels zullen worden teruggegeven.

Raakt
Test of een geometrie een andere raakt. Geeft 1 (true) terug als de geometrieën tenminste één
gemeenschappelĳk punt hebben, maar hun interieurs niet kruisen. Alleen cirkel 3 wordt teruggegeven.

Overlapt
Test of een geometrie een andere overlapt. Geeft 1 (true) terug als de geometrieën ruimte delen, van dezelfde
dimensie zĳn, maar niet volledig door elkaar worden omvat. Alleen cirkel 2 wordt teruggegeven.

Zijn binnen
Test of een geometrie in een andere ligt. Geeft 1 (true) terug als geometrie a volledig binnen geometrie b ligt.
Alleen cirkel 1 wordt teruggegeven.

Kruisen
Geeft 1 (true) terug als de opgegeven geometrieën enkele, maar niet alle, punten in het interieur
gemeenschappelĳk hebben en de feitelĳke kruising van een lagere dimensie is dan de hoogste opgegeven
geometrie. Bĳvoorbeeld een lĳn die een polygoon kruist zal een lĳn kruisen (true). Twee lĳnen die elkaar
kruisen zal als een punt kruisen (true). Twee polygonen kruisen als een polygoon (false). In de afbeelding
zullen geen cirkels worden teruggegeven.

Parameters

Label Naam Type Beschrijving
Objecten
uitnemen uit

INPUT [vector: elke] Invoer vectorlaag

Waar de objecten
(geometrisch
voorvoegsel)

PREDICATE [enumeratie] [lĳst]
Standaard: [0]

Type ruimtelĳke relatie dat het invoerobject
zou moeten hebben met een kruisend
object, zodat het zou kunnen worden
geselecteerd. Één of meer van:

• 0 — kruist met
• 1 — bevat
• 2 — raakt niet
• 3 — gelĳk zĳn aan
• 4 — raken
• 5 — overlappen
• 6 — zĳn binnen
• 7 — kruisen

Als meer dan één voorwaarde wordt
gekozen, moet aan tenminste één worden
voldaan (bewerking OR) om een object uit
te kunnen nemen.

Vervolgt op volgende pagina
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Tabel 27.182 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Door objecten te
vergelĳken van

INTERSECT [vector: elke] Kruisingslaag

Uitgenomen
(locatie)

OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag voor
de objecten die de gekozen ruimtelĳke
relatie(s) hebben met één of meer objecten
in de vergelĳkingslaag. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Uitgenomen
(locatie)

OUTPUT [hetzelfde als
invoer]

Vectorlaag met objecten uit de invoerlaag
die de gekozen ruimtelĳke relatie(s) hebben
met objecten in de vergelĳkingslaag.

Pythoncode

ID algoritme: qgis:extractbylocation

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmen van Processing uit te voeren vanuit
de console voor Python.

Uitnemen binnen afstand

Maakt een nieuwe vectorlaag die alleen overeenkomende objecten uit een invoerlaag bevat. Objecten worden
gekopieerd wanneer zĳ binnen de gespecificeerde maximale afstand van de objecten in een aanvullende
verwĳzingslaag liggen.
Zie ook:
Selecteren binnen afstand, Extract by location
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Parameters

Label Naam Type Beschrijving
Objecten
uitnemen uit

INPUT [vector: elke] Invoer vectorlaag waaruit objecten moeten
worden gekopieerd

Door objecten te
vergelĳken van

REFERENCE [vector: elke] Vectorlaag waarvan de nabĳheid van
objecten wordt gebruikt

Waar de objecten
in liggen

DISTANCE [getal]
Standaard: 100

De maximale afstand rondom
verwĳzingsobjecten waarbinnen
invoerobjecten moeten worden geselecteerd

Bestaande selectie
aanpassen met

METHOD [enumeratie]
Standaard: 0

Hoe de selectie van het algoritme zou
moeten worden beheerd. Één van:

• 0 — nieuwe selectie maken
• 1— toevoegen aan bestaande selectie
• 2 — binnen huidige selectie
selecteren

• 3 — verwĳderen uit bestaande
selectie

Uitgenomen
(locatie)

OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag voor de
objecten die binnen de ingestelde afstand
liggen vanaf verwĳzingsobjecten. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Uitgenomen
(locatie)

OUTPUT [hetzelfde als
invoer]

Vectorlaag met objecten uit de invoerlaag
die overeenkomen met de voorwaarde voor
de afstand vanaf de verwĳzingsobkjecten

Pythoncode

ID algoritme: native:extractwithindistance

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmen van Processing uit te voeren vanuit
de console voor Python.
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Filter op type geometrie

Filtert objecten op hun type geometrie. Inkomende objecten zullen worden omgeleid naar verschillende uitvoerlagen,
gebaseerd op de vraag of zĳ een punt, lĳn of polygoon geometrie hebben.

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Te analyseren laag

Uitvoer

Label Naam Type Beschrijving
Objecten Punt
Optioneel

POINTS [vector: punt] Laag met punten

Objecten Lĳn
Optioneel

LINES [vector: lĳn] Laag met lĳnen

Objecten Polygoon
Optioneel

POLYGONS [vector: polygoon] Laag met polygonen

Objecten zonder
geometrie
Optioneel

NO_GEOMETRY [tabel] Vectorlaag zonder geometrie

Pythoncode

ID algoritme: native:filterbygeometry

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmen van Processing uit te voeren vanuit
de console voor Python.

Random extract

Gebruikt een vectorlaag en maakt een nieuwe die alleen een subset van de objecten in de invoerlaag bevat.
De subset wordt willekeurig gedefinieerd, op basis van object-ID’s, met behulp van een percentage of waarde voor
telling om het totale aantal objecten in de subset te definiëren.
Zie ook:
Willekeurige selectie
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Bron vectorlaag waaruit de objecten moeten

worden geselecteerd
Methode METHOD [enumeratie]

Standaard: 0
Methoden voor willekeurige selectie. Één
van:

• 0 — Aantal geselecteerde objecten
• 1 — Percentage geselecteerde
objecten

Aantal/percentage
geselecteerde
objecten

NUMBER [getal]
Standaard: 10

Aantal/percentage van te selecteren
objecten

Uitgenomen
(willekeurig)

OUTPUT [vector: elke]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag voor de
willekeurig geselecteerde objecten. Één
van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Uitgenomen
(willekeurig)

OUTPUT [hetzelfde als
invoer]

Vectorlaag die willekeurig geselecteerde
objecten uit de invoerlaag bevat

Pythoncode

ID algoritme: qgis:randomextract

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmen van Processing uit te voeren vanuit
de console voor Python.
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Willekeurige selectie binnen subsets

Gebruikt een vectorlaag en maakt een nieuwe die alleen een subset van de objecten in de invoerlaag bevat.
De subset wordt willekeurig gedefinieerd, gebaseerd op object-ID’s, met behulp van een percentage of waarde voor
telling om het totale aantal objecten in de subset te definiëren. De waarde van het percentage/aantal wordt niet op
de gehele laag toegepast, maar in plaats daarvan op elke categorie. Categorieën worden gedefinieerd overeenkomstig
een opgegeven attribuut.
Zie ook:
Willekeurige selectie binnen subsets

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Vectorlaag waaruit de objecten moeten

worden geselecteerd
Veld ID FIELD [tabelveld: elk] Categorie van de bron vectorlaag waaruit de

objecten moeten worden geselecteerd
Methode METHOD [enumeratie]

Standaard: 0
Methoden voor willekeurige selectie. Één
van:

• 0 — Aantal geselecteerde objecten
• 1 — Percentage geselecteerde
objecten

Aantal/percentage
geselecteerde
objecten

NUMBER [getal]
Standaard: 10

Aantal/percentage van te selecteren
objecten

Uitgenomen
(willekeurig
gestratificeerd)

OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoer vectorlaag voor de
willekeurig geselecteerde objecten. Één
van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Uitgenomen
(willekeurig
gestratificeerd)

OUTPUT [hetzelfde als
invoer]

Vectorlaag die willekeurig geselecteerde
objecten uit de invoerlaag bevat
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Pythoncode

ID algoritme: qgis:randomextractwithinsubsets

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmen van Processing uit te voeren vanuit
de console voor Python.

Willekeurige selectie

Gebruikt een vectorlaag en selecteert een subset van de objecten daarvan. Er wordt door het algoritme geen nieuwe
laag gemaakt.
De subset wordt willekeurig gedefinieerd, op basis van object-ID’s, met behulp van een percentage of waarde voor
telling om het totale aantal objecten in de subset te definiëren.
Standaard menu: Vector ► Onderzoeksgereedschap

Zie ook:
Random extract

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Vectorlaag voor de selectie
Methode METHOD [enumeratie]

Standaard: 0
Methoden voor willekeurige selectie. Één
van:

• 0 — Aantal geselecteerde objecten
• 1 — Percentage geselecteerde
objecten

Aantal/percentage
geselecteerde
objecten

NUMBER [getal]
Standaard: 10

Aantal/percentage van te selecteren
objecten

Uitvoer

Label Naam Type Beschrijving
Invoerlaag INPUT [hetzelfde als

invoer]
De invoerlaag met objecten geselecteerd
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Pythoncode

ID algoritme: qgis:randomselection

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmen van Processing uit te voeren vanuit
de console voor Python.

Willekeurige selectie binnen subsets

Gebruikt een vectorlaag en selecteert een subset van de objecten daarvan. Er wordt door het algoritme geen nieuwe
laag gemaakt.
De subset wordt willekeurig gedefinieerd, op basis van object-ID’s, met behulp van een percentage of waarde voor
telling om het totale aantal objecten in de subset te definiëren.
De waarde voor percentage/telling wordt niet toegepast op de gehele laag, maar in plaats daarvan op elke categorie.
Categorieënworden gedefinieerd overeenkomstig een opgegeven attribuut, dat ook is gespecificeerd als een parameter
voor de invoer van het algoritme.
Er wordt geen uitvoer gemaakt.
Standaard menu: Vector ► Onderzoeksgereedschap

Zie ook:
Willekeurige selectie binnen subsets

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Vectorlaag waaruit de objecten moeten

worden geselecteerd
Veld ID FIELD [tabelveld: elk] Categorie van de vectorlaag waaruit de

objecten moeten worden geselecteerd
Methode METHOD [enumeratie]

Standaard: 0
Methoden voor willekeurige selectie. Één
van:

• 0 — Aantal geselecteerde objecten
• 1 — Percentage geselecteerde
objecten

Aantal/percentage
geselecteerde
objecten

NUMBER [getal]
Standaard: 10

Aantal/percentage van te selecteren
objecten
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Uitvoer

Label Naam Type Beschrijving
Invoerlaag INPUT [hetzelfde als

invoer]
De invoerlaag met objecten geselecteerd

Pythoncode

ID algoritme: qgis:randomselectionwithinsubsets

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmen van Processing uit te voeren vanuit
de console voor Python.

Op attribuut selecteren

Maakt een selectie in een vectorlaag.
De criteria voor het selecteren van objecten zĳn gebaseerd op de waarden van een attribuut van de invoerlaag.
Zie ook:
Uitnemen op attribuut

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Vectorlaag waaruit de objecten moeten

worden geselecteerd
Attribuut
selecteren

FIELD [tabelveld: elk] Veld om de laag te filteren

Operator OPERATOR [enumeratie]
Standaard: 0

Veel verschillende operatoren zĳn
beschikbaar:

• 0 — =
• 1 — ̸=
• 2 — >
• 3 — >=
• 4 — <
• 5 — <=
• 6 — begint met
• 7 — bevat
• 8 — is null
• 9 — is niet null
• 10 — bevat niet

Waarde
Optioneel

VALUE [tekenreeks] Waarde die moet worden geëvalueerd

Vervolgt op volgende pagina
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Tabel 27.186 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Bestaande selectie
aanpassen met

METHOD [enumeratie]
Standaard: 0

Hoe de selectie van het algoritme zou
moeten worden beheerd. Één van:

• 0 — nieuwe selectie maken
• 1— toevoegen aan bestaande selectie
• 2 — uit bestaande selectie
verwĳderen

• 3 — binnen huidige selectie
selecteren

Uitvoer

Label Naam Type Beschrijving
Invoerlaag INPUT [hetzelfde als

invoer]
De invoerlaag met objecten geselecteerd

Pythoncode

ID algoritme: qgis:selectbyattribute

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmen van Processing uit te voeren vanuit
de console voor Python.

Selecteren met expressie

Maakt een selectie in een vectorlaag.
De criteria voor het selecteren van objecten zĳn gebaseerd op een expressie voor QGIS. Voor meer informatie over
expressies, bekĳk de Expressies.
Zie ook:
Uitnemen met expressie
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Expressie EXPRESSION [expressie] Expressie om de vectorlaag te filteren
Bestaande selectie
aanpassen met

METHOD [enumeratie]
Standaard: 0

Hoe de selectie van het algoritme zou
moeten worden beheerd. Één van:

• 0 — nieuwe selectie maken
• 1— toevoegen aan bestaande selectie
• 2 — uit bestaande selectie
verwĳderen

• 3 — binnen huidige selectie
selecteren

Uitvoer

Label Naam Type Beschrijving
Invoerlaag INPUT [hetzelfde als

invoer]
De invoerlaag met objecten geselecteerd

Pythoncode

ID algoritme: qgis:selectbyexpression

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmen van Processing uit te voeren vanuit
de console voor Python.

Selecteren op plaats

Maakt een selectie in een vectorlaag.
De criteria voor het selecteren van objecten zĳn gebaseerd op de ruimtelĳke relatie tussen elk object en de objecten
in een aanvullende laag.
Standaard menu: Vector ► Onderzoeksgereedschap

Zie ook:
Extract by location, Selecteren binnen afstand
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Ruimtelijke relaties verkennen

Geometrische gezegdes zĳn functies met Booleaanse waarden die worden gebruikt om de ruimtelĳke relatie te bepalen
die een object heeft met een ander door te vergelĳken of en hoe hun geometrieën een portie van hun ruimte delen.

Fig. 27.124: Zoeken naar ruimtelijke relaties tussen lagen

Gebruik makend van de afbeelding hierboven zoeken we naar de groene cirkels door ze ruimtelĳk te vergelĳken met
het rechthoekige oranje object. Beschikbare geometrische gezegdes zĳn:
Kruisen

Test of een geometrie een andere kruist. Geeft 1 ( true) terug als de geometrieën elkaar ruimtelĳk kruisen (een
stukje ruimte met elkaar delen - overlappen of raken) en 0 als zĳ dat niet doen. In de afbeelding hierboven zou
dit de cirkels 1, 2 en 3 teruggeven.

Bevat
Geeft 1 (true) terug als en alleen als er geen punten van b in het buitenste van a liggen, en ten minste één punt
van het interieur van b ligt in het interieur van a. In de afbeelding zou geen cirkel worden teruggegeven, maar
de rechthoek zou dat wel worden als u er op de omgekeerde wĳze naar zou zoeken, omdat het cirkel 1 volledig
bevat. Dit is het tegengestelde van zĳn binnen.

Raakt niet
Geeft 1 (true) terug als de geometrieën geen deel van de ruimte met elkaar delen (niet overlappen, elkaar niet
raken). Alleen cirkel 4 wordt teruggegeven.

Gelijk
Geeft 1 (true) terug als en alleen als geometrieën exact hetzelfde zĳn. Geen cirkels zullen worden teruggegeven.

Raakt
Test of een geometrie een andere raakt. Geeft 1 (true) terug als de geometrieën tenminste één
gemeenschappelĳk punt hebben, maar hun interieurs niet kruisen. Alleen cirkel 3 wordt teruggegeven.

Overlapt
Test of een geometrie een andere overlapt. Geeft 1 (true) terug als de geometrieën ruimte delen, van dezelfde
dimensie zĳn, maar niet volledig door elkaar worden omvat. Alleen cirkel 2 wordt teruggegeven.
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Zijn binnen
Test of een geometrie in een andere ligt. Geeft 1 (true) terug als geometrie a volledig binnen geometrie b ligt.
Alleen cirkel 1 wordt teruggegeven.

Kruisen
Geeft 1 (true) terug als de opgegeven geometrieën enkele, maar niet alle, punten in het interieur
gemeenschappelĳk hebben en de feitelĳke kruising van een lagere dimensie is dan de hoogste opgegeven
geometrie. Bĳvoorbeeld een lĳn die een polygoon kruist zal een lĳn kruisen (true). Twee lĳnen die elkaar
kruisen zal als een punt kruisen (true). Twee polygonen kruisen als een polygoon (false). In de afbeelding
zullen geen cirkels worden teruggegeven.

Parameters

Label Naam Type Beschrijving
Objecten
selecteren uit

INPUT [vector: elke] Invoer vectorlaag

Waar de objecten
(geometrisch
voorvoegsel)

PREDICATE [enumeratie] [lĳst]
Standaard: [0]

Type ruimtelĳke relatie dat het invoerobject
zou moeten hebben met een kruisend
object, zodat het zou kunnen worden
geselecteerd. Één of meer van:

• 0 — kruist met
• 1 — bevat
• 2 — raakt niet
• 3 — gelĳk zĳn aan
• 4 — raken
• 5 — overlappen
• 6 — zĳn binnen
• 7 — kruisen

Als meer dan één voorwaarde wordt
gekozen, moet aan tenminste één worden
voldaan (bewerking OR) om een object uit
te kunnen nemen.

Door objecten te
vergelĳken van

INTERSECT [vector: elke] Kruisingslaag

Bestaande selectie
aanpassen met

METHOD [enumeratie]
Standaard: 0

Hoe de selectie van het algoritme zou
moeten worden beheerd. Één van:

• 0 — nieuwe selectie maken
• 1— toevoegen aan bestaande selectie
• 2 — binnen huidige selectie
selecteren

• 3 — verwĳderen uit bestaande
selectie
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Uitvoer

Label Naam Type Beschrijving
Invoerlaag INPUT [hetzelfde als

invoer]
De invoerlaag met objecten geselecteerd

Pythoncode

ID algoritme: qgis:selectbylocation

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmen van Processing uit te voeren vanuit
de console voor Python.

Selecteren binnen afstand

Maakt een selectie in een invoerlaag. Objecten worden geselecteerd wanneer zĳ binnen de gespecificeerde maximale
afstand van de objecten in een aanvullende verwĳzingslaag liggen.
Zie ook:
Uitnemen binnen afstand, Selecteren op plaats

Parameters

Label Naam Type Beschrijving
Objecten
selecteren uit

INPUT [vector: elke] Invoer vectorlaag waaruit objecten moeten
worden geselecteerd

Door objecten te
vergelĳken van

REFERENCE [vector: elke] Vectorlaag waarvan de nabĳheid van
objecten wordt gebruikt

Waar de objecten
in liggen

DISTANCE [getal]
Standaard: 100

De maximale afstand rondom
verwĳzingsobjecten waarbinnen
invoerobjecten moeten worden geselecteerd

Bestaande selectie
aanpassen met

METHOD [enumeratie]
Standaard: 0

Hoe de selectie van het algoritme zou
moeten worden beheerd. Één van:

• 0 — nieuwe selectie maken
• 1— toevoegen aan bestaande selectie
• 2 — binnen huidige selectie
selecteren

• 3 — verwĳderen uit bestaande
selectie

27.1. QGIS algoritme provider 1401



QGIS Desktop 3.28 User Guide

Uitvoer

Label Naam Type Beschrijving
Invoerlaag INPUT [hetzelfde als

invoer]
De invoerlaag met objecten geselecteerd

Pythoncode

ID algoritme: native:selectwithindistance

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmen van Processing uit te voeren vanuit
de console voor Python.

27.1.21 Vector tabel

Automatisch ophogend veld toevoegen

Voegt een nieuw veld geheel getal toe aan een vectorlaag, met een opeenvolgende waarde voor elk object.
Dit veld kan worden gebruikt als unieke ID voor objecten op de laag. Het nieuwe attribuut wordt niet toegevoegd aan
de invoerlaag, maar in plaats daarvan wordt een nieuwe laag gemaakt.
De initiële startwaarde voor de ophogende reeks kan worden gespecificeerd. Optioneel kan de ophogende reeks
worden gebaseerd op het groeperen van velden en een sorteervolgorde voor de objecten kan ook worden
gespecificeerd.

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] De invoer vectorlaag.
Veldnaam FIELD_NAME [tekenreeks]

Standaard: ‘AUTO’
Naam van het veld met automatisch
ophogende waarden

Begin waarden
met
Optioneel

START [getal]
Standaard: 0

Kies het initiële getal voor de telling van het
ophogen

Waarde Modulus
Optioneel

MODULUS [getal]
Standaard: 0

Specificeren van een optionele waarde
Modulus zal het tellen opnieuw starten met
START, elke keer als de waarde de waarde
Modulus bereikt. 0 betekent niet opnieuw
starten.

Waarden
groeperen op
Optioneel

GROUP_FIELDS [tabelveld: elk]
[lĳst]

Groeperen veld(en) selecteren: in plaats van
één enkele doorgang voor het tellen van de
gehele laag, wordt een afzonderlĳke telling
doorgevoerd voor elke teruggegeven waarde
voor de combinatie van deze velden.

Vervolgt op volgende pagina
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Tabel 27.189 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Sorteerexpressie
Optioneel

SORT_EXPRESSION[expressie] Gebruik een expressie om de objecten op
de laag te sorteren, ofwel globaal of, indien
ingesteld, gebaseerd op gegroepeerde
velden.

Oplopend sorteren SORT_ASCENDING [Booleaanse
waarde]
Standaard: True

Wanneer een sorteerexpressie is
ingesteld, gebruik dan deze optie om
de volgorde te beheren waarin objecten
waarden toegewezen krĳgen.

Eerst null sorteren SORT_NULLS_FIRST[Booleaanse
waarde]
Standaard: False

Wanneer een sorteerexpressie is
ingesteld, gebruik dan deze optie om in te
stellen of waarden Null als eerste moeten
worden geteld of als laatste.

Verhoogd OUTPUT [hetzelfde als
invoer]
Standaard:
[Tĳdelĳke laag
maken]

Specificeer de uitvoer vectorlaag met het
automatisch ophogend veld. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Verhoogd OUTPUT [hetzelfde als

invoer]
Vectorlaag met automatisch ophogend veld

Pythoncode

ID algoritme: native:addautoincrementalfield

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Veld aan attributentabel toevoegen

Voegt een nieuw veld toe aan een vectorlaag.
De naam en karakteristieken van het attribuut worden gedefinieerd als parameters.
Het nieuwe attribuut wordt niet toegevoegd aan de invoerlaag, maar in plaats daarvan wordt een nieuwe laag gemaakt.

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] De invoerlaag
Veldnaam FIELD_NAME [tekenreeks] Naam voor het nieuwe veld
Veldtype FIELD_TYPE [enumeratie]

Standaard: 0
Type voor het nieuwe veld. U kunt kiezen
uit:

• 0 — Integer
• 1 — Float
• 2 — Tekenreeks

Veldlengte FIELD_LENGTH [getal]
Standaard: 10

Lengte van het veld

Precisie veld FIELD_PRECISION[getal]
Standaard: 0

Precisie van het veld. Nuttig met veldtype
Float.

Toegevoegd OUTPUT [hetzelfde als
invoer]
Standaard:
[Tĳdelĳke laag
maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Toegevoegd OUTPUT [hetzelfde als

invoer]
Vectorlaag met nieuw toegevoegde veld

Pythoncode

ID algoritme: native:addfieldtoattributestable

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Unieke waarde indexveld toevoegen

Neemt een vectorlaag en een attribuut en voegt een nieuw numeriek veld toe.
Waarden in dit veld corresponderen met waarden in het gespecificeerde attribuut, dus objecten met dezelfde waarde
voor het attribuut, zullen dezelfde waarde in het nieuwe numerieke veld hebben.
Dit maakt een numeriek equivalent van het gespecificeerde attribuut, wat dezelfde klassen definieert.
Het nieuwe attribuut wordt niet toegevoegd aan de invoerlaag, maar in plaats daarvan wordt een nieuwe laag gemaakt.

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] De invoerlaag.
Veld Klasse FIELD [tabelveld: elk] Objecten die dezelfde waarde voor dit veld

hebben krĳgen dezelfde index.
Uitvoer veldnaam FIELD_NAME [tekenreeks]

Standaard:
‘NUM_FIELD’

Naam van het nieuwe veld met de indexen.

Laag met
indexveld

OUTPUT [vector: elke]
Standaard:
[Tĳdelĳke laag
maken]

Vectorlaag met numerieke veld met de
indexen. Één van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Overzicht klassen SUMMARY_OUTPUT [tabel]
Standaard:
[Uitvoer
overslaan]

Specificeer de tabel die het overzicht moet
bevatten van het veld klasse, gekoppeld aan
de corresponderende unieke waarde. Één
van:

• Uitvoer overslaan
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Laag met
indexveld

OUTPUT [hetzelfde als
invoer]

Vectorlaag met numerieke veld met de
indexen.

Overzicht klassen SUMMARY_OUTPUT [tabel] Tabel met overzicht van het veld Klasse,
gerelateerd aan de corresponderende unieke
waarde.
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Pythoncode

ID algoritme: native:adduniquevalueindexfield

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Velden X/Y toevoegen aan laag

Voegt velden X en Y (of latitude/longitude) toe aan een puntenlaag. De velden X/Y kunnen in een ander CRS, dan
dat van de laag, worden berekend (bĳv. maken van velden latitude/longitude voor een laag in een geprojecteerd CRS).

Maakt objecten op hun plaats aanpassen mogelĳk voor objecten punt

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: punt] De invoerlaag.
Coördinatensysteem CRS [crs]

Standaard:
EPSG:4326

Te gebruiken coördinaten referentiesysteem
voor de te maken velden X en Y.

Voorvoegsel veld
Optioneel

PREFIX [tekenreeks] Voorvoegsel om toe te voegen aan de
nieuwe veldnamen om botsingenmet velden
van de invoerlaag te vermĳden.

Toegevoegde
velden

OUTPUT [vector: punt]
Standaard:
[Tĳdelĳke laag
maken]

Specificeer de uitvoerlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Toegevoegde
velden

OUTPUT [vector: punt] De uitvoerlaag - identiek aan de invoerlaag,
maar met twee nieuwe velden double, X en
Y.
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Pythoncode

ID algoritme: native:addxyfieldstolayer

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Geavanceerde Python veldberekening

Voegt een nieuw attribuut toe aan een vectorlaag, met waarden die resulteren uit het toepassen van een expressie op
elk object.
De expressie wordt gedefinieerd als een functie voor Python.

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Naam
resultaatveld

FIELD_NAME [tekenreeks]
Standaard:
‘NewField’

Naam voor het nieuwe veld

Veldtype FIELD_TYPE [enumeratie]
Standaard: 0

Type voor het nieuwe veld. Één van:
• 0 — Integer
• 1 — Float
• 2 — Tekenreeks

Veldlengte FIELD_LENGTH [getal]
Standaard: 10

Lengte van het veld

Precisie veld FIELD_PRECISION[getal]
Standaard: 3

Precisie van het veld. Nuttig met veldtype
Float.

Globale expressie
Optioneel

GLOBAL [tekenreeks] De code in het gedeelte Globale expressie
zal slechts één keer worden uitgevoerd,
voordat veldberekening begint met het
doorlopen van alle objecten van de
invoerlaag. Daarom is dit de juiste plaats
om de benodigde modules te importeren of
variabelen te berekenen die zullen worden
gebruikt in opvolgende berekeningen.

Formule FORMULA [tekenreeks] De te evalueren formule voor Python.
Bĳvoorbeeld om het gebied te berekenen
van een invoer polygoonlaag kunt u
toevoegen:
value = $geom.area()

Vervolgt op volgende pagina
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Tabel 27.193 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Berekend OUTPUT [hetzelfde als

invoer]
Standaard:
[Tĳdelĳke laag
maken]

Specificeer de vectorlaag met het nieuwe
berekende veld. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Berekend OUTPUT [hetzelfde als

invoer]
Vectorlaag met het nieuwe berekende veld

Pythoncode

ID algoritme: qgis:advancedpythonfieldcalculator

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Veld(en) verwijderen

Neemt een vectorlaag en maakt een nieuwe die exact dezelfde objecten heeft, maar zonder de geselecteerde
kolommen.
Zie ook:
Velden behouden
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag waaruit veld(en) moeten

worden verwĳderd
Te verwĳderen
velden

COLUMN [tabelveld: elk]
[lĳst]

De/Het te verwĳderen veld(en)

Resterende velden OUTPUT [hetzelfde als
invoer]
Standaard:
[Tĳdelĳke laag
maken]

Specificeer de uitvoer vectorlaag met de
resterende velden. Één van:

• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Resterende velden OUTPUT [hetzelfde als

invoer]
Vectorlaag met de resterende velden

Pythoncode

ID algoritme: native:deletecolumn

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Veld HStore uitvergroten

Maakt een kopie van de invoerlaag en voegt een nieuw veld toe voor elke unieke sleutel in het veld HStore.
De lĳst met verwachte velden is een optionele kommagescheiden lĳst. Als deze lĳst is gespecificeerd, worden alleen
die velden toegevoegd en wordt het veld HStore bĳgewerkt. Standaard worden alle unieke sleutels toegevoegd.
De PostgreSQL HStore is een eenvoudige opslag voor sleutel-waarde, gebruikt in PostgreSQL en GDAL (bĳ het
lezen van een bestand van OSM met het veld other_tags.
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Veld HStore FIELD [tabelveld: elk] De/Het te verwĳderen veld(en)
Lĳst met
verwachte velden,
gescheiden door
een komma
Optioneel

EXPECTED_FIELDS[tekenreeks]
Standaard: ‘’

Kommagescheiden lĳst met uit te nemen
velden. Het veld HStore zal worden
bĳgewerkt na het verwĳderen van deze
sleutels.

Uitvergroot OUTPUT [hetzelfde als
invoer]
Standaard:
[Tĳdelĳke laag
maken]

Specificeer de uitvoer vectorlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Uitvergroot OUTPUT [hetzelfde als

invoer]
Uitvoer vectorlaag

Pythoncode

ID algoritme: native:explodehstorefield

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Binair veld uitnemen

Neemt de inhoud uit een binair veld, slaat het op in individuele bestanden. Bestandsnamen kunnen worden gemaakt
met waarden die zĳn genomen uit een attribuut van de brontabel, of gebaseerd op een meer complexe expressie.
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag die de binaire gegevens

bevat
Binair veld FIELD [tabelveld: elk] Veld dat de binaire gegevens bevat
Bestandsnaam FILENAME [expressie] Veld of op expressie gebaseerde tekst om

elk uitvoerbestand te benoemen
Doelmap FOLDER [map]

Standaard:
[Opslaan naar
tijdelijke
map]

Map waarin de uitvoerbestanden moeten
worden opgeslagen. Één van:

• Opslaan in tĳdelĳke map
• Opslaan naar map

Uitvoer

Label Naam Type Beschrijving
Map FOLDER [map] De map die de uitvoerbestanden bevat.

Pythoncode

ID algoritme: native:extractbinary

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Veldberekening

Opent Veldberekening (zie Expressies). U kunt alle ondersteunde expressies en functies gebruiken.
Een nieuwe laag wordt gemaakt met het resultaat van de expressie.
Veldberekening is bĳzonder nuttig indien gebruikt met Grafische modellen ontwerpen.

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Laag die moet worden berekend
Uitvoer veldnaam FIELD_NAME [tekenreeks] De naam van het veld voor de resultaten:

Vervolgt op volgende pagina
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Tabel 27.195 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Veldtype uitvoer FIELD_TYPE [enumeratie]

Standaard: 0
Type voor het veld. Één van:

• 0 — Float
• 1 — Integer (geheel getal)
• 2 — Tekenreeks
• 3 — Date (Datum)

Veldbreedte
uitvoer

FIELD_LENGTH [getal]
Standaard: 10

De lengte van het veld met de resultaten
(minimum 0)

Precisie veld FIELD_PRECISION[getal]
Standaard: 3

De precisie van het veld met de resultaten
(minimum 0, maximum 15)

Nieuw veld maken NEW_FIELD [Booleaanse
waarde]
Standaard: True

Zou het veld met resultaten een nieuw veld
moeten zĳn

Formule FORMULA [expressie] De te gebruiken formule om het resultaat te
berekenen

Uitvoerbestand OUTPUT [vector: elke]
Standaard:
[Tĳdelĳke laag
maken]

Specificatie van de uitvoerlaag.
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Berekend OUTPUT [vector: elke] Uitvoerlaag met de berekende veldwaarden

Pythoncode

ID algoritme: native:fieldcalculator

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Bijgewerkte velden

Maakt het bewerken van de structuur van de attributentabel van een vectorlaag mogelĳk.
Velden kunnen worden aangepast in hun type en naam, met in kaart gebrachte velden.
De originele laag wordt niet aangepast. Een nieuwe laag wordt gemaakt, die een aangepaste attributentabel bevat,
overeenkomstig de opgegeven kaart voor de velden.

Notitie: Bĳ het gebruiken van een sjabloonlaag met beperkingen op velden, wordt de informatie weergegeven in de
widget met een gekleurde achtergrond en Helptip. Behandel deze informatie als een hint gedurende de configuratie.
Geen beperkingen zullen aan een uitvoerlaag worden toegevoegd noch zullen zĳ worden gecontroleerd of gehandhaafd
door het algoritme.

Het algoritme Bĳgewerkte velden stelt u in staat om:
• Veldnamen en types te wĳzigen
• Velden toe te voegen en te verwĳderen
• Velden opnieuw te sorteren
• Nieuwe velden te berekenen, gebaseerd op expressies
• Lĳst met velden te laden vanuit andere laag
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Fig. 27.125: Dialoogvenster Bijgewerkte velden

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] De aan te passen laag

Vervolgt op volgende pagina
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Tabel 27.196 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Velden in kaart
brengen

FIELDS_MAPPING [lĳst] Lĳst met uitvoervelden en hun definities.
De ingebedde tabel vermeldt alle velden
van de bronlaag en stelt u in staat ze te
bewerken:

• Klik op om een nieuw veld te
maken.

• Klik op om een veld te
verwĳderen.

• Gebruik en om de
geselecteerde volgorde van velden te
wĳzigen.

• Klik op om terug te zetten naar
de standaard weergave.

Voor elk van de velden die u opnieuw zou
willen gebruiken, dient u de volgende opties
in te vullen:
Bron expressie (expression)
[expressie]

Veld of expressie uit de invoerlaag.
Veldnaam (name) [string]

Naam van het veld in de uitvoerlaag.
Standaard wordt de naam van de
invoerlaag behouden.

Type (type) [enumeratie]
Gegevenstype van het veld voor
uitvoer. Beschikbare typen zĳ
afhankelĳk van de provider voor de
uitvoerlaag.

Lengte (length) [getal]
Lengte van het veld van de uitvoer.

Precisie (precision) [getal]
Precisie van het veld van de uitvoer.

Beperkingen (constraints) [string]
Bĳ het gebruiken van een
sjabloonlaag, geeft aan of er
beperkingen zĳn toegepast op het
veld van het sjabloon. Ga over de cel
om de beperkingen weer te geven.

Velden uit sjabloonlaag laden
Maakt het mogelĳk een laag te
selecteren uit het huidige project als
een sjabloon en (met Velden laden)
met bovenstaande opties “Velden in
kaart brengen” te vullen met zĳn
velden en hun definities.

Vervolgt op volgende pagina
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Tabel 27.196 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Bĳgewerkt OUTPUT [vector: elke]

Standaard:
[Tĳdelĳke laag
maken]

Specificatie van de uitvoerlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Bĳgewerkt OUTPUT [vector: elke] Uitvoerlaag met bĳgewerkte velden

Pythoncode

ID algoritme: native:refactorfields

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Veld hernoemen

Hernoemt een bestaand veld van een vectorlaag.
De originele laag wordt niet aangepast. Een nieuwe laag wordt gemaakt, waarvan de attributentabel het hernoemde
veld bevat.
Zie ook:
Bĳgewerkte velden

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] De invoer vectorlaag
Te hernoemen veld FIELD [tabelveld: elk] Het veld dat moet worden gewĳzigd
Nieuwe veldnaam NEW_NAME [tekenreeks] De nieuwe veldnaam

Vervolgt op volgende pagina
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Tabel 27.197 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Hernoemd OUTPUT [vector: hetzelfde

als invoer]
Standaard:
[Tĳdelĳke laag
maken]

Specificatie van de uitvoerlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Hernoemd OUTPUT [vector: hetzelfde

als invoer]
Uitvoerlaag met het hernoemde veld

Pythoncode

ID algoritme: qgis:renametablefield

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Velden behouden

Neemt een vectorlaag en maakt een nieuwe die alleen de geselecteerde velden bevat. Alle andere velden zullen zĳn
verwĳderd.
Zie ook:
Veld(en) verwĳderen

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] De invoer vectorlaag
Te behouden
velden

FIELDS [tabelveld: elk]
[lĳst]

Lĳst met in de laag te behouden velden

Vervolgt op volgende pagina
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Tabel 27.198 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Behouden velden OUTPUT [vector: hetzelfde

als invoer]
Standaard:
[Tĳdelĳke laag
maken]

Specificatie van de uitvoerlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Behouden velden OUTPUT [vector: hetzelfde

als invoer]
Uitvoerlaag met het behouden velden

Pythoncode

ID algoritme: native:retainfields

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Tekst naar float

Past het type van een opgegeven attribuut in een vectorlaag aan, converteert een tekstattribuut dat numerieke
tekenreeksen bevat naar een numeriek attribuut (bĳv. ‘1’ naar 1.0).
Het algoritme maakt een nieuwe vectorlaag dus die van de bron wordt niet aangepast
Als de conversie niet mogelĳk is zal de geselecteerde kolom waarden NULL hebben.
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] De invoer vectorlaag.
Tekstattribuut te
converteren naar
float

FIELD [tabelveld: string] Het veld met de tekenreeks voor de
invoerlaag die moet worden geconverteerd
naar een veld Float.

Float uit tekst OUTPUT [hetzelfde als
invoer]
Standaard:
[Tijdelijke
laag maken]

Specificeer de uitvoerlaag. Één van:
• Tĳdelĳke laag maken
(TEMPORARY_OUTPUT)

• Opslaan als bestand…
• Opslaan naar GeoPackage…
• Opslaan als tabel voor database…
• Aan laag toevoegen…

De bestandscodering kan hier ook gewĳzigd
worden.

Uitvoer

Label Naam Type Beschrijving
Float uit tekst OUTPUT [hetzelfde als

invoer]
Uitvoer vectorlaag met veld met tekenreeks
die is geconverteerd naar Float

Pythoncode

ID algoritme: qgis:texttofloat

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

27.1.22 Vectortegels

Vectortegels schrijven (MBTiles)

Exporteert één of meer vectorlagen naar vectortegels - een gegevensindeling die is geoptimaliseerd voor het renderen
van kaarten en een kleine gegevensgrootte.
MBTiles is een specificatie voor het opslaan van getegelde kaartgegevens in databases van SQLite voor direct gebruik
en voor overdracht. MBTiles-bestanden worden ook wel tegelsets genoemd.
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Parameters

Label Naam Type Beschrijving
Invoerlagen INPUT [vector: elke] [lĳst] Een lĳst van te combineren lagen om de

vectorbestanden te maken.
Minimum
zoomniveau

MIN_ZOOM [getal]
Standaard: 0

Het laagste zoomniveau waarop de tegelset
gegevens verschaft. In te stellen van 0 tot en
met 24.

Maximum
zoomniveau

MAX_ZOOM [getal]
Standaard: 3

Het hoogste zoomniveau waarop de tegelset
gegevens verschaft. In te stellen van 0 tot en
met 24.

Bereik
Optioneel

EXTENT [bereik]
Standaard: Niet
ingesteld

Het maximum bereik van het gerenderde
kaartgebied. Grenzen moeten een gebied
definiëren dat wordt bedekt door alle
zoomniveaus.

Metadata: Naam
Optioneel

META_NAME [tekenreeks] Naam van de tegelset

Metadata:
Beschrĳving
Optioneel

META_DESCRIPTION[tekenreeks] Een beschrĳving van de inhoud van de
tegelset

Metadata:
Naamsvermelding
Optioneel

META_ATTRIBUTION[tekenreeks] Een tekenreeks voor naamsvermelding die
de bronnen van de gegevens verklaart en/of
stĳl voor de kaart.

Metadata: Versie
Optioneel

META_VERSION [tekenreeks] De versie van de tegelset. Dit verwĳst naar
een revisie van de tegelset zelf, niet van de
specificatie van de MBTiles.

Metadata: Type
Optioneel

META_TYPE [tekenreeks] Type tegelset. Mogelĳke waarden zĳn
overlay of baselayer.

Metadata:
Midden
Optioneel

META_CENTER [tekenreeks] Het middelpunt (tekenreeks van
kommagescheiden getallen: de longitude,
latitude en het zoomniveau) van de
standaardweergave van de kaart. Voorbeeld:
-122.1906,37.7599,11

Doel MBTiles OUTPUT [vectortegels]
Standaard: [Opslaan
naar tĳdelĳk
bestand]

Specificatie van het uitvoer MBTiles-
bestand. Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Beschrijving
Doel MBTiles OUTPUT [bestand] Uitvoer vectortegelsbestand .mbtiles.
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Pythoncode

ID algoritme: native:writevectortiles_mbtiles

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Vectortegels schrijven (XYZ)

Exporteert één of meer vectorlagen naar vectortegels - een gegevensindeling die is geoptimaliseerd voor het renderen
van kaarten en een kleine gegevensgrootte.

Parameters

Label Naam Type Beschrijving
Bestandssjabloon XYZ_TEMPLATE [tekenreeks]

Standaard:
‘{z}/{x}/{y}.pbf’

Sjabloon voor het maken van de URL voor
vectortegels

Invoerlagen INPUT [vector: elke] [lĳst] Een lĳst van te combineren lagen om de
vectorbestanden te maken.

Minimum
zoomniveau

MIN_ZOOM [getal]
Standaard: 0

Het laagste zoomniveau waarop de tegelset
gegevens verschaft. In te stellen van 0 tot en
met 24.

Maximum
zoomniveau

MAX_ZOOM [getal]
Standaard: 3

Het hoogste zoomniveau waarop de tegelset
gegevens verschaft. In te stellen van 0 tot en
met 24.

Bereik
Optioneel

EXTENT [bereik]
Standaard: Niet
ingesteld

Het maximum bereik van het gerenderde
kaartgebied. Grenzen moeten een gebied
definiëren dat wordt bedekt door alle
zoomniveaus.

Map voor uitvoer OUTPUT_DIRECTORY[map]
Standaard: [Opslaan
naar tĳdelĳke map]

Specificatie van de map voor de uitvoer
vectortegels. Één van:

• Opslaan in tĳdelĳke map
• Opslaan naar map

Uitvoer

Label Naam Type Beschrijving
Map voor uitvoer OUTPUT_DIRECTORY[map] Een map die verschillende subsets van

de bestanden met vectortegels (.pbf)
bevat, opgeslagen in submappen die
overeenkomen met de zoomniveaus.
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Pythoncode

ID algoritme: native:writevectortiles_xyz

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

27.2 GDAL algoritme provider

GDAL (Geospatial Data Abstraction Library) is een vertaalbibliotheek voor raster en vector georuimtelĳke
gegevensindelingen. Algoritmes in het Processing Framework zĳn afgeleid van de GDAL rasterprogramma’s en
GDAL vectorprogramma’s.

27.2.1 Rasteranalyse

Aspect

Genereert een kaart voor het aspect vanuit elk door GDAL ondersteund hoogteraster. Aspect is de kompasrichting
waarnaar de helling kĳkt. De pixels zullen een waarde hebben van 0-360°, gemeten in graden vanaf Noord, wat de
azimut aangeeft. In de Noordelĳke hemisfeer ligt de noordzĳde van hellingen vaak in de schaduw (kleine azimut van
0°-90°), terwĳl de zuidelĳke zĳde meer zonnestraling ontvangt (grotere azimut van 180°-270°).
Dit algoritme is afgeleid van de GDAL DEM utility.
Standaard menu: Raster ► Analyse

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Invoer hoogte rasterlaag
Bandnummer BAND [rasterband]

Standaard: 1
Het nummer van de band die als hoogte
moet worden gebruikt

Trigonometrische
hoek teruggeven in
plaats van azimut

TRIG_ANGLE [Booleaanse
waarde]
Standaard: False

Activeren van de trigonometrische hoek
resulteert in verschillende categorieën: 0°
(=Oost), 90° (Noord), 180° (=West), 270°
(=Zuid).

Geef 0 voor vlak
terug in plaats van
-9999

ZERO_FLAT [Booleaanse
waarde]
Standaard: False

Activeren van deze optie zal een 0-waarde
invoegen voor de waarde -9999 in vlakke
gebieden.

Randen berekenen COMPUTE_EDGES [Booleaanse
waarde]
Standaard: False

Maakt randen uit het hoogteraster

Gebruik formule
Zevenbergen&Thorne
in plaats van die
van Horn

ZEVENBERGEN [Booleaanse
waarde]
Standaard: False

Activeert de formule Zevenbergen&Thorne
voor gladdere landschappen

Vervolgt op volgende pagina
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Tabel 27.199 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Aspect OUTPUT [raster]

Standaard:
[Opslaan naar
tijdelijk
bestand]

Uitvoer rasterlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’

Voor toevoegen van een of meer
opties voor het beheren van het te
maken bestand (kleuren, blokgrootte,
bestandsompressie…). Voor het
gemak kunt u vertrouwen op vooraf
gedefinieerde profielen (bekĳk :ref:` het
gedeelte over opties voor GDAL driver
<gdal_createoptions>`).
Voor Batch-processen en Modelontwerper:
scheid meerdere opties door een teken pipe
(|).

Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: Geen

Extra GDAL opties voor opdrachtregel
toevoegen

Uitvoer

Label Naam Type Beschrijving
Aspect OUTPUT [raster] Uitvoerraster met waarden voor hoeken in

graden

Pythoncode

ID algoritme: gdal:aspect

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Kleurreliëf

Genereert een kaart met kleurreliëf uit elk door GDAL ondersteund hoogteraster. Kleurreliëfen kunnen in het
bĳzonder worden gebruikt om hoogten weer te geven. Het algoritme voert een 4-bands raster uit met waarden die
zĳn berekend uit de hoogte en een op tekst gebaseerd configuratiebestand voor kleur. Standaard worden de kleuren
tussen de opgegeven waarden voor de hoogte naadloos gemengd en het resultaat is een leuk gekleurd hoogteraster.
Dit algoritme is afgeleid van de GDAL DEM utility.

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Invoer hoogte rasterlaag
Bandnummer BAND [rasterband]

Standaard: 1
Het nummer van de band die als hoogte
moet worden gebruikt

Randen berekenen COMPUTE_EDGES [Booleaanse
waarde]
Standaard: False

Maakt randen uit het hoogteraster

Kleur-
configuratiebestand

COLOR_TABLE [bestand] Een op tekst gebaseerd configuratiebestand
voor kleur

modus
Overeenkomst

MATCH_MODE [enumeratie]
Standaard: 2

Één van:
• 0 — Strikte kleurovereenkomsten
gebruiken

• 1 — Dichtstbĳzĳnde RGBA
quadruplet gebruiken

• 2 — Gladde gemengde kleuren
gebruiken

Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’

Voor toevoegen van een of meer
opties voor het beheren van het te
maken bestand (kleuren, blokgrootte,
bestandsompressie…). Voor het
gemak kunt u vertrouwen op vooraf
gedefinieerde profielen (bekĳk :ref:` het
gedeelte over opties voor GDAL driver
<gdal_createoptions>`).
Voor Batch-processen en Modelontwerper:
scheid meerdere opties door een teken pipe
(|).

Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: Geen

Extra GDAL opties voor opdrachtregel
toevoegen

Kleurreliëf OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Uitvoer rasterlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…
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Uitvoer

Label Naam Type Beschrijving
Kleurreliëf OUTPUT [raster] Een 4-bands uitvoerraster

Pythoncode

ID algoritme: gdal:colorrelief

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

‘Geen gegevens’ vullen

Vult regio’s in het raster met waarden ‘Geen gegevens’ door interpolatie vanaf de randen. De waarden voor de regio’s
met ‘Geen gegevens’ worden berekend door de omringende pixelwaarden met behulp van gewogen inverse afstand.
Na het interpoleren worden de resultaten gladder gemaakt. Invoer kan elke door GDAL ondersteund rasterlaag zĳn.
Dit algoritme is in het algemeen geschikt voor het interpoleren van ontbrekende regio’s van nagenoeg doorlopend
variërende rasters (zoals bĳvoorbeeld hoogtemodellen). Het is ook geschikt voor het vullen van kleine gaten en
scheuren in meer onregelmatig variërende afbeeldingen (zoals luchtfoto’s). Het is in het algemeen niet zo geschikt
voor interpoleren van een raster met schaarse gegevens voor punten.
Dit algoritme is afgeleid van de GDAL fillnodata utility.
Standaard menu: Raster ► Analyse

Parameters

Basis parameters

Label Naam Type Beschrijving
Label Naam Type Beschrĳving
Invoerlaag INPUT [raster] Invoer rasterlaag
Bandnummer BAND [rasterband]

Standaard: 1
De band die moet worden bewerkt.
Waarden ‘Geen gegevens’ moeten worden
weergegeven door de waarde 0.

Maximale afstand
(in pixels) vanaf
waar moet worden
gezocht om te
interpoleren

DISTANCE [getal]
Standaard: 10

Het aantal pixels waarnaar in alle richtingen
moet worden gezocht om vanuit te
interpoleren

Aantal doorlopen
voor glad maken
die moeten worden
uitgevoerd na het
interpoleren

ITERATIONS [getal]
Standaard: 0

Het aantal doorlopen van het filter 3x3 dat
moet worden uitgevoerd (0 of meer) om
de resultaten van de interpolatie gladder te
maken.

Vervolgt op volgende pagina
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Tabel 27.202 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Standaard
geldigheidsmasker
niet gebruiken
voor de
invoerband

NO_MASK [Booleaanse
waarde]
Standaard: False

Activeert het gebruiker gedefinieerde
geldigheidsmasker

Geldigheidsmasker MASK_LAYER [raster] Een rasterlaag die definieert welke gebieden
moeten worden gevuld

Gevuld OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoer rasterlaag. Één
van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’

Voor toevoegen van een of meer
opties voor het beheren van het te
maken bestand (kleuren, blokgrootte,
bestandsompressie…). Voor het
gemak kunt u vertrouwen op vooraf
gedefinieerde profielen (bekĳk :ref:` het
gedeelte over opties voor GDAL driver
<gdal_createoptions>`).
Voor Batch-processen en Modelontwerper:
scheid meerdere opties door een teken pipe
(|).

Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: Geen

Extra GDAL opties voor opdrachtregel
toevoegen

Uitvoer

Label Naam Type Beschrijving
Gevuld OUTPUT [raster] Uitvoer raster

Pythoncode

ID algoritme: gdal:fillnodata

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Grid (Data metrics)

Berekent enkele gegevensmetrieken voor gegevens met het gespecificeerde venster en uitvoer geometrie voor het grid.
Dit algoritme is afgeleid van de GDAL grid utility.
Standaard menu: Raster ► Analyse

Zie ook:
GDAL grid tutorial

Parameters

Basis parameters

Label Naam Type Beschrijving
Puntenlaag INPUT [vector: punt] Invoer punt-vectorlaag
Te gebruiken
gegevensmetrieken

METRIC [enumeratie]
Standaard: 0

Één van:
• 0 — Minimum, minimale waarde
gevonden in de zoek-ellips van het
knooppunt van het grid

• 1 — Maximum, maximale waarde
gevonden in de zoek-ellips van het
knooppunt van het grid

• 2 — Bereik, een verschil tussen
de minimale en maximale waarden
gevonden in de zoek-ellips van het
knooppunt van het grid

• 3 — Aantal, een aantal
gegevenspunten gevonden in de
zoek-ellips van het knooppunt van
het grid

• 4 — Gemiddelde afstand, een
gemiddelde afstand tussen het
knooppunt van het grid (centrum
van de zoek-ellips) en alle
gegevenspunten gevonden in de
zoek-ellips van het knooppunt van
het grid

• 5 — Gemiddelde afstand tussen
punten, een gemiddelde afstand
tussen de gegevenspunten, gevonden
in de zoek-ellips van het knooppunt
van het grid. De afstand tussen elk
paar punten binnen de ellips wordt
berekend en het gemiddelde van alle
afstanden wordt ingesteld als waarde
voor het knooppunt van het grid

De eerste radius
van de zoek-ellips

RADIUS_1 [getal]
Standaard: 0.0

De eerste radius (X-as als de rotatiehoek 0
is) van de zoek-ellips

**De tweede radius
van de zoek-ellips
**

RADIUS_2 [getal]
Standaard: 0.0

De tweede radius (Y-as als de rotatiehoek 0
is) van de zoek-ellips

Vervolgt op volgende pagina
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Tabel 27.204 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Hoek voor de
rotatie van de
zoek-ellips in
graden (tegen de
wĳzers van de
klok in)

ANGLE [getal]
Standaard: 0.0

Hoek van de rotatie van de ellips in graden.
Ellips roteert tegen de wĳzers van de klok
in.

Minimale aantal
te gebruiken
gegevenspunten

MIN_POINTS [getal]
Standaard: 0.0

Minimum aantal gegevenspunten om te
middelen. Indien er minder punten worden
gevonden in het knooppunt van het grid
wordt dat geacht leeg te zĳn en zal
worden gevuld met de markering voor
‘Geen gegevens’.

Geen gegevens NODATA [getal]
Standaard: 0.0

Markering ‘Geen gegevens’ om lege punten
te vullen

Geïnterpoleerd
(gegevensmetrieken)

OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer de uitvoer rasterlaag met
geïnterpoleerde waarden. Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Z-waarde uit veld
Optioneel

Z_FIELD [tabelveld:
numeriek]

Veld voor de interpolatie

Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’

Voor toevoegen van een of meer
opties voor het beheren van het te
maken bestand (kleuren, blokgrootte,
bestandsompressie…). Voor het
gemak kunt u vertrouwen op vooraf
gedefinieerde profielen (bekĳk :ref:` het
gedeelte over opties voor GDAL driver
<gdal_createoptions>`).
Voor Batch-processen en Modelontwerper:
scheid meerdere opties door een teken pipe
(|).

Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: Geen

Extra GDAL opties voor opdrachtregel
toevoegen

Vervolgt op volgende pagina
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Tabel 27.205 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Type
uitvoergegevens

DATA_TYPE [enumeratie]
Standaard: 5

Definieert het gegevenstype voor het
uitvoer rasterbestand. Opties:

• 0 — Byte (8-bit unsigned integer
(quint8))

• 1 — Int16 (16-bit signed integer
(qint16))

• 2 — UInt16 (16-bit unsigned integer
(quint16))

• 3 — UInt32 (32-bit unsigned integer
(quint32))

• 4 — Int32 (32-bit signed integer
(qint32))

• 5 — Float32 (32-bit floating point
(float))

• 6 — Float64 (64-bit floating point
(double))

• 7 — CInt16 (Complex Int16)
• 8 — CInt32 (Complex Int32)
• 9 — CFloat32 (Complex Float32)
• 10 — CFloat64 (Complex Float64)

Beschikbare opties zĳn afhankelĳk van de
versie van GDAL die is ingebouwd in QGIS
(bekĳk menu Help ► Info)

Uitvoer

Label Naam Type Beschrijving
Geïnterpoleerd
(gegevensmetrieken)

OUTPUT [raster] Uitvoer rasterbestand met geïnterpoleerde
waarden

Pythoncode

ID algoritme: gdal:griddatametrics

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Raster (IDW met zoeken naar Nearest neighbor)

Berekent de Inverse Distance to a Power gridding gecombineerd met de methode Nearest neighbor. Ideaal als een
maximaal aantal te gebruiken gegevenspunten wordt vereist.
Dit algoritme is afgeleid van de GDAL grid utility.
Zie ook:
GDAL grid tutorial

Parameters

Label Naam Type Beschrijving
Puntenlaag INPUT [vector: punt] Invoer punt-vectorlaag
Gewogen macht POWER [getal]

Standaard: 2.0
Gewogen macht

Glad maken SMOOTHING [getal]
Standaard: 0.0

Parameter voor Glad maken

De radius van de
zoekcirkel

RADIUS [getal]
Standaard: 1.0

De radius van de zoekcirkel

Maximale aantal
te gebruiken
gegevenspunten

MAX_POINTS [getal]
Standaard: 12

Zoek niet naar meer punten dan dit aantal.

Minimale aantal
te gebruiken
gegevenspunten

MIN_POINTS [getal]
Standaard: 0

Minimum aantal gegevenspunten om te
middelen. Indien er minder punten worden
gevonden in het knooppunt van het grid
wordt dat geacht leeg te zĳn en zal
worden gevuld met de markering voor
‘Geen gegevens’.

Geen gegevens NODATA [getal]
Standaard: 0.0

Markering ‘Geen gegevens’ om lege punten
te vullen

Geïnterpoleerd
(IDW met NN-
zoeken)

OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer de uitvoer rasterlaag met
geïnterpoleerde waarden. Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Z-waarde uit veld
Optioneel

Z_FIELD [tabelveld:
numeriek]

Veld voor de interpolatie

Vervolgt op volgende pagina
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Tabel 27.207 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’

Voor toevoegen van een of meer
opties voor het beheren van het te
maken bestand (kleuren, blokgrootte,
bestandsompressie…). Voor het
gemak kunt u vertrouwen op vooraf
gedefinieerde profielen (bekĳk :ref:` het
gedeelte over opties voor GDAL driver
<gdal_createoptions>`).
Voor Batch-processen en Modelontwerper:
scheid meerdere opties door een teken pipe
(|).

Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: Geen

Extra GDAL opties voor opdrachtregel
toevoegen

Type
uitvoergegevens

DATA_TYPE [enumeratie]
Standaard: 5

Definieert het gegevenstype voor het
uitvoer rasterbestand. Opties:

• 0 — Byte (8-bit unsigned integer
(quint8))

• 1 — Int16 (16-bit signed integer
(qint16))

• 2 — UInt16 (16-bit unsigned integer
(quint16))

• 3 — UInt32 (32-bit unsigned integer
(quint32))

• 4 — Int32 (32-bit signed integer
(qint32))

• 5 — Float32 (32-bit floating point
(float))

• 6 — Float64 (64-bit floating point
(double))

• 7 — CInt16 (Complex Int16)
• 8 — CInt32 (Complex Int32)
• 9 — CFloat32 (Complex Float32)
• 10 — CFloat64 (Complex Float64)

Beschikbare opties zĳn afhankelĳk van de
versie van GDAL die is ingebouwd in QGIS
(bekĳk menu Help ► Info)

Uitvoer

Label Naam Type Beschrijving
Geïnterpoleerd
(IDW met NN-
zoeken)

OUTPUT [raster] Uitvoer rasterbestand met geïnterpoleerde
waarden
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Pythoncode

ID algoritme: gdal:gridinversedistancenearestneighbor

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Grid (Inverse distance to a power)

De Inverse Distance to a Power gridding methode is een interpolator voor het gewogen gemiddelde.
U zou de arrays voor de invoer moeten vullen met de verspreide waarden voor gegevens inclusief de coördinaten van
elk gegevenspunt en geometrie voor het grid moeten uitvoeren. De functie zal de geïnterpoleerde waarde voor de
opgegeven positie in het uitvoerraster berekenen.
Dit algoritme is afgeleid van de GDAL grid utility.
Standaard menu: Raster ► Analyse

Zie ook:
GDAL grid tutorial

Parameters

Basis parameters

Label Naam Type Beschrijving
Puntenlaag INPUT [vector: punt] Invoer punt-vectorlaag
Gewogen macht POWER [getal]

Standaard: 2.0
Gewogen macht

Glad maken SMOOTHING [getal]
Standaard: 0.0

Parameter voor Glad maken

De eerste radius
van de zoek-ellips

RADIUS_1 [getal]
Standaard: 0.0

De eerste radius (X-as als de rotatiehoek 0
is) van de zoek-ellips

**De tweede radius
van de zoek-ellips
**

RADIUS_2 [getal]
Standaard: 0.0

De tweede radius (Y-as als de rotatiehoek 0
is) van de zoek-ellips

Hoek voor de
rotatie van de
zoek-ellips in
graden (tegen de
wĳzers van de
klok in)

ANGLE [getal]
Standaard: 0.0

Hoek van de rotatie van de ellips in graden.
Ellips roteert tegen de wĳzers van de klok
in.

Maximale aantal
te gebruiken
gegevenspunten

MAX_POINTS [getal]
Standaard: 0

Zoek niet naar meer punten dan dit aantal.

Vervolgt op volgende pagina
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Tabel 27.208 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Minimale aantal
te gebruiken
gegevenspunten

MIN_POINTS [getal]
Standaard: 0

Minimum aantal gegevenspunten om te
middelen. Indien er minder punten worden
gevonden in het knooppunt van het grid
wordt dat geacht leeg te zĳn en zal
worden gevuld met de markering voor
‘Geen gegevens’.

Geen gegevens NODATA [getal]
Standaard: 0.0

Markering ‘Geen gegevens’ om lege punten
te vullen

Geïnterpoleerd
(IDW)

OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer de uitvoer rasterlaag met
geïnterpoleerde waarden. Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Z-waarde uit veld
Optioneel

Z_FIELD [tabelveld:
numeriek]

Veld voor de interpolatie

Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’

Voor toevoegen van een of meer
opties voor het beheren van het te
maken bestand (kleuren, blokgrootte,
bestandsompressie…). Voor het
gemak kunt u vertrouwen op vooraf
gedefinieerde profielen (bekĳk :ref:` het
gedeelte over opties voor GDAL driver
<gdal_createoptions>`).
Voor Batch-processen en Modelontwerper:
scheid meerdere opties door een teken pipe
(|).

Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: Geen

Extra GDAL opties voor opdrachtregel
toevoegen

Vervolgt op volgende pagina
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Tabel 27.209 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Type
uitvoergegevens

DATA_TYPE [enumeratie]
Standaard: 5

Definieert het gegevenstype voor het
uitvoer rasterbestand. Opties:

• 0 — Byte (8-bit unsigned integer
(quint8))

• 1 — Int16 (16-bit signed integer
(qint16))

• 2 — UInt16 (16-bit unsigned integer
(quint16))

• 3 — UInt32 (32-bit unsigned integer
(quint32))

• 4 — Int32 (32-bit signed integer
(qint32))

• 5 — Float32 (32-bit floating point
(float))

• 6 — Float64 (64-bit floating point
(double))

• 7 — CInt16 (Complex Int16)
• 8 — CInt32 (Complex Int32)
• 9 — CFloat32 (Complex Float32)
• 10 — CFloat64 (Complex Float64)

Beschikbare opties zĳn afhankelĳk van de
versie van GDAL die is ingebouwd in QGIS
(bekĳk menu Help ► Info)

Uitvoer

Label Naam Type Beschrijving
Geïnterpoleerd
(IDW)

OUTPUT [raster] Uitvoer rasterbestand met geïnterpoleerde
waarden

Pythoncode

ID algoritme: gdal:gridinversedistance

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Raster (Lineair)

De methode Lineair voert een lineaire interpolatie uit door een Delaunay-triangulatie te berekenen voor de wolk met
punten, uitzoekt in welke driehoek van de triangulatie het punt ligt, en een lineaire interpolatie uit te voeren vanuit de
coördinaten voor het massacentrum in de driehoek. Als het punt niet in een driehoek ligt. afhankelĳk van de straal,
zal het algoritme de waarde nemen van het dichtstbĳ zĳnde punt of de waarde ‘Geen gegevens’.
Dit algoritme is afgeleid van de GDAL grid utility.

Parameters

Basis parameters

Label Naam Type Beschrijving
Puntenlaag INPUT [vector: punt] Invoer punt-vectorlaag
Zoekafstand RADIUS [getal]

Standaard: -1.0
In het geval het punt dat moet worden
geïnterpoleerd niet past in een driehoek
van de Delaunay-triangulatie, gebruik dan
de maximum afstand om te zoeken naar
een dichtstbĳzĳnde buur, of gebruik anders
‘Geen gegevens’. Indien ingesteld op -1 is
de zoekafstand oneindig. Indien ingesteld
op 0 zal de waarde ‘Geen gegevens’ worden
gebruikt.

Geen gegevens NODATA [getal]
Standaard: 0.0

Markering ‘Geen gegevens’ om lege punten
te vullen

Geïnterpoleerd
(Lineair)

OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer de uitvoer rasterlaag met
geïnterpoleerde waarden. Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Z-waarde uit veld
Optioneel

Z_FIELD [tabelveld:
numeriek]

Veld voor de interpolatie

Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’

Voor toevoegen van een of meer
opties voor het beheren van het te
maken bestand (kleuren, blokgrootte,
bestandsompressie…). Voor het
gemak kunt u vertrouwen op vooraf
gedefinieerde profielen (bekĳk :ref:` het
gedeelte over opties voor GDAL driver
<gdal_createoptions>`).
Voor Batch-processen en Modelontwerper:
scheid meerdere opties door een teken pipe
(|).

Vervolgt op volgende pagina
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Tabel 27.211 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: Geen

Extra GDAL opties voor opdrachtregel
toevoegen

Type
uitvoergegevens

DATA_TYPE [enumeratie]
Standaard: 5

Definieert het gegevenstype voor het
uitvoer rasterbestand. Opties:

• 0 — Byte (8-bit unsigned integer
(quint8))

• 1 — Int16 (16-bit signed integer
(qint16))

• 2 — UInt16 (16-bit unsigned integer
(quint16))

• 3 — UInt32 (32-bit unsigned integer
(quint32))

• 4 — Int32 (32-bit signed integer
(qint32))

• 5 — Float32 (32-bit floating point
(float))

• 6 — Float64 (64-bit floating point
(double))

• 7 — CInt16 (Complex Int16)
• 8 — CInt32 (Complex Int32)
• 9 — CFloat32 (Complex Float32)
• 10 — CFloat64 (Complex Float64)

Beschikbare opties zĳn afhankelĳk van de
versie van GDAL die is ingebouwd in QGIS
(bekĳk menu Help ► Info)

Uitvoer

Label Naam Type Beschrijving
Geïnterpoleerd
(Lineair)

OUTPUT [raster] Uitvoer rasterbestand met geïnterpoleerde
waarden

Pythoncode

ID algoritme: gdal:gridlinear

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

1436 Hoofdstuk 27. Processing providers en algoritmes



QGIS Desktop 3.28 User Guide

Grid (Moving average)

Het Moving Average is een eenvoudig algoritme voor gemiddelden. Het gebruikt een verplaatsend venster van
elliptische vorm om naar waarden te zoeken en middelt alle gegevenspunten binnen het venster. De zoek-ellips kan
worden geroteerd naar een gespecificeerde hoek, het centrum van de ellips geplaatst op het knooppunt van het grid.
Ook kan het minimum aantal gegevenspunten dat moet worden gemiddeld worden ingesteld. Als er niet genoeg punten
in het venster zĳn, wordt het knooppunt van het grid geacht leeg te zĳn en zal worden gevuld met de gespecificeerde
waarde ‘Geen gegevens’.
Dit algoritme is afgeleid van de GDAL grid utility.
Standaard menu: Raster ► Analyse

Zie ook:
GDAL grid tutorial

Parameters

Basis parameters

Label Naam Type Beschrijving
Puntenlaag INPUT [vector: punt] Invoer punt-vectorlaag
De eerste radius
van de zoek-ellips

RADIUS_1 [getal]
Standaard: 0.0

De eerste radius (X-as als de rotatiehoek 0
is) van de zoek-ellips

**De tweede radius
van de zoek-ellips
**

RADIUS_2 [getal]
Standaard: 0.0

De tweede radius (Y-as als de rotatiehoek 0
is) van de zoek-ellips

Hoek voor de
rotatie van de
zoek-ellips in
graden (tegen de
wĳzers van de
klok in)

ANGLE [getal]
Standaard: 0.0

Hoek van de rotatie van de ellips in graden.
Ellips roteert tegen de wĳzers van de klok
in.

Minimale aantal
te gebruiken
gegevenspunten

MIN_POINTS [getal]
Standaard: 0.0

Minimum aantal gegevenspunten om te
middelen. Indien er minder punten worden
gevonden in het knooppunt van het grid
wordt dat geacht leeg te zĳn en zal
worden gevuld met de markering voor
‘Geen gegevens’.

Geen gegevens NODATA [getal]
Standaard: 0.0

Markering ‘Geen gegevens’ om lege punten
te vullen

Geïnterpoleerd
(gemiddelde
verplaatsing)

OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer de uitvoer rasterlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…
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Gevorderde parameters

Label Naam Type Beschrijving
Z-waarde uit veld
Optioneel

Z_FIELD [tabelveld:
numeriek]

Veld voor de interpolatie

Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’

Voor toevoegen van een of meer
opties voor het beheren van het te
maken bestand (kleuren, blokgrootte,
bestandsompressie…). Voor het
gemak kunt u vertrouwen op vooraf
gedefinieerde profielen (bekĳk :ref:` het
gedeelte over opties voor GDAL driver
<gdal_createoptions>`).
Voor Batch-processen en Modelontwerper:
scheid meerdere opties door een teken pipe
(|).

Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: Geen

Extra GDAL opties voor opdrachtregel
toevoegen

Type
uitvoergegevens

DATA_TYPE [enumeratie]
Standaard: 5

Definieert het gegevenstype voor het
uitvoer rasterbestand. Opties:

• 0 — Byte (8-bit unsigned integer
(quint8))

• 1 — Int16 (16-bit signed integer
(qint16))

• 2 — UInt16 (16-bit unsigned integer
(quint16))

• 3 — UInt32 (32-bit unsigned integer
(quint32))

• 4 — Int32 (32-bit signed integer
(qint32))

• 5 — Float32 (32-bit floating point
(float))

• 6 — Float64 (64-bit floating point
(double))

• 7 — CInt16 (Complex Int16)
• 8 — CInt32 (Complex Int32)
• 9 — CFloat32 (Complex Float32)
• 10 — CFloat64 (Complex Float64)

Beschikbare opties zĳn afhankelĳk van de
versie van GDAL die is ingebouwd in QGIS
(bekĳk menu Help ► Info)
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Uitvoer

Label Naam Type Beschrijving
Geïnterpoleerd
(gemiddelde
verplaatsing)

OUTPUT [raster] Uitvoer rasterbestand met geïnterpoleerde
waarden

Pythoncode

ID algoritme: gdal:gridaverage

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Grid (Nearest neighbor)

De methode Nearest Neighbor voert geen interpolatie of glad maken uit, het neemt eenvoudigweg de waarde van het
dichtstbĳzĳnde gevonden punt in de zoek-ellips van het knooppunt van het grid en geeft dat als resultaat terug. Indien
er geen punt wordt gevonden, wordt de gespecificeerde waarde voor ‘Geen gegevens’ teruggegeven.
Dit algoritme is afgeleid van de GDAL grid utility.
Standaard menu: Raster ► Analyse

Zie ook:
GDAL grid tutorial

Parameters

Basis parameters

Label Naam Type Beschrijving
Puntenlaag INPUT [vector: punt] Invoer punt-vectorlaag
De eerste radius
van de zoek-ellips

RADIUS_1 [getal]
Standaard: 0.0

De eerste radius (X-as als de rotatiehoek 0
is) van de zoek-ellips

**De tweede radius
van de zoek-ellips
**

RADIUS_2 [getal]
Standaard: 0.0

De tweede radius (Y-as als de rotatiehoek 0
is) van de zoek-ellips

Hoek voor de
rotatie van de
zoek-ellips in
graden (tegen de
wĳzers van de
klok in)

ANGLE [getal]
Standaard: 0.0

Hoek van de rotatie van de ellips in graden.
Ellips roteert tegen de wĳzers van de klok
in.

Geen gegevens NODATA [getal]
Standaard: 0.0

Markering ‘Geen gegevens’ om lege punten
te vullen

Vervolgt op volgende pagina
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Tabel 27.214 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Geïnterpoleerd
(Dichtstbĳzĳnde
buur)

OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer de uitvoer rasterlaag met
geïnterpoleerde waarden. Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Z-waarde uit veld
Optioneel

Z_FIELD [tabelveld:
numeriek]

Veld voor de interpolatie

Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’

Voor toevoegen van een of meer
opties voor het beheren van het te
maken bestand (kleuren, blokgrootte,
bestandsompressie…). Voor het
gemak kunt u vertrouwen op vooraf
gedefinieerde profielen (bekĳk :ref:` het
gedeelte over opties voor GDAL driver
<gdal_createoptions>`).
Voor Batch-processen en Modelontwerper:
scheid meerdere opties door een teken pipe
(|).

Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: Geen

Extra GDAL opties voor opdrachtregel
toevoegen

Type
uitvoergegevens

DATA_TYPE [enumeratie]
Standaard: 5

Definieert het gegevenstype voor het
uitvoer rasterbestand. Opties:

• 0 — Byte (8-bit unsigned integer
(quint8))

• 1 — Int16 (16-bit signed integer
(qint16))

• 2 — UInt16 (16-bit unsigned integer
(quint16))

• 3 — UInt32 (32-bit unsigned integer
(quint32))

• 4 — Int32 (32-bit signed integer
(qint32))

• 5 — Float32 (32-bit floating point
(float))

• 6 — Float64 (64-bit floating point
(double))

• 7 — CInt16 (Complex Int16)
• 8 — CInt32 (Complex Int32)
• 9 — CFloat32 (Complex Float32)
• 10 — CFloat64 (Complex Float64)

Beschikbare opties zĳn afhankelĳk van de
versie van GDAL die is ingebouwd in QGIS
(bekĳk menu Help ► Info)
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Uitvoer

Label Naam Type Beschrijving
Geïnterpoleerd
(Dichtstbĳzĳnde
buur)

OUTPUT [raster] Uitvoer rasterbestand met geïnterpoleerde
waarden

Pythoncode

ID algoritme: gdal:gridnearestneighbor

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Schaduw voor heuvels

Voert een raster uit met een keurig effect van een reliëf van schaduwen. Het is zeer nuttig voor het visualiseren van
het terrein. U kunt optioneel de azimut en hoogte van de lichtbron specificeren, een verticale factor voor vergroten
en een schaalfactor om rekening te houden met verschillen tussen verticale en horizontale eenheden.
Dit algoritme is afgeleid van de GDAL DEM utility.
Standaard menu: Raster ► Analyse

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Invoer hoogte rasterlaag
Bandnummer BAND [rasterband]

Standaard: 1
Band die de informatie voor de hoogte bevat

Z-factor (verticale
overdrĳving)

Z_FACTOR [getal]
Standaard: 1.0

De factor overdrĳft de hoogte van het
uitvoer hoogteraster

Schaal (ratio van
verticale eenheden
naar horizontale)

SCALE [getal]
Standaard: 1.0

De verhouding van verticale eenheden tot
horizontale eenheden

Azimut van het
licht

AZIMUTH [getal]
Standaard: 315.0

Definieert het azimut van het licht dat
schĳnt op het hoogteraster in graden. Als
het van de bovenzĳde van het raster komt
is de waarde 0, als het uit het oosten komt is
het 90, enzovoort.

Hellingshoek van
het licht

ALTITUDE [getal]
Standaard: 45.0

Definieert de hoogte van het licht, in
graden. 90 als het licht van boven het
hoogteraster komt, 0 als het scheerlicht is.

Vervolgt op volgende pagina

27.2. GDAL algoritme provider 1441

https://gdal.org/programs/gdaldem.html


QGIS Desktop 3.28 User Guide

Tabel 27.216 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Randen berekenen COMPUTE_EDGES [Booleaanse

waarde]
Standaard: False

Maakt randen uit het hoogteraster

Gebruik formule
Zevenbergen&Thorne
(in plaats van die
van Horn)

ZEVENBERGEN [Booleaanse
waarde]
Standaard: False

Activeert de formule Zevenbergen&Thorne
voor gladdere landschappen

Gecombineerde
schaduw

COMBINED [Booleaanse
waarde]
Standaard: False

Multidirectionele
schaduw

MULTIDIRECTIONAL[Booleaanse
waarde]
Standaard: False

Schaduw voor
heuvels

OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer de uitvoer rasterlaag met
geïnterpoleerde waarden. Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’

Voor toevoegen van een of meer
opties voor het beheren van het te
maken bestand (kleuren, blokgrootte,
bestandsompressie…). Voor het
gemak kunt u vertrouwen op vooraf
gedefinieerde profielen (bekĳk :ref:` het
gedeelte over opties voor GDAL driver
<gdal_createoptions>`).
Voor Batch-processen en Modelontwerper:
scheid meerdere opties door een teken pipe
(|).

Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: Geen

Extra GDAL opties voor opdrachtregel
toevoegen

Uitvoer

Label Naam Type Beschrijving
Schaduw voor
heuvels

OUTPUT [raster] Uitvoer rasterbestand met geïnterpoleerde
waarden

1442 Hoofdstuk 27. Processing providers en algoritmes



QGIS Desktop 3.28 User Guide

Pythoncode

ID algoritme: gdal:hillshade

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Near black

Converteert bĳna zwarte/witte grenzen naar zwart.
Dit algoritme zal een afbeelding scannen en proberen om alle pixels, die bĳna of exact zwart, wit of een of
meer aangepaste kleuren zĳn, rondom de rand, instellen op zwart of wit. Dit wordt vaak gebruikt om met verlies
gecomprimeerde luchtfoto’s “te repareren” zodat kleurpixels kunnen worden behandeld als transparant bĳ mozaïeken.
Dit algoritme is afgeleid van de GDAL nearblack utility.
Standaard menu: Raster ► Analyse

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Invoer hoogte rasterlaag
Hoe ver vanaf
zwart (wit)

NEAR [getal]
Standaard: 15

Selecteer hoe ver de pixelwaarden mogen
zĳn vanaf zwart, wit of de aangepaste
kleuren en nog steeds beschouwd worden
als bĳna zwart, wit of aangepaste kleur.

Zoek naar bĳna
witte pixels in
plaats van bĳna
zwarte

WHITE [Booleaanse
waarde]
Standaard: False

Zoek naar bĳna witte (255) pixels in
plaats van bĳna zwarte pixels

Bĳna zwart OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer de uitvoer rasterlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters
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Label Naam Type Beschrijving
Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’

Voor toevoegen van een of meer
opties voor het beheren van het te
maken bestand (kleuren, blokgrootte,
bestandsompressie…). Voor het
gemak kunt u vertrouwen op vooraf
gedefinieerde profielen (bekĳk :ref:` het
gedeelte over opties voor GDAL driver
<gdal_createoptions>`).
Voor Batch-processen en Modelontwerper:
scheid meerdere opties door een teken pipe
(|).

Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: Geen

Extra GDAL opties voor opdrachtregel
toevoegen

Uitvoer

Label Naam Type Beschrijving
Bĳna zwart OUTPUT [raster] Uitvoer raster

Pythoncode

ID algoritme: gdal:nearblack

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Proximity (raster afstand)

Maakt een nabĳheidskaart voor een raster die de afstand aangeeft van het centrum van elke pixel tot het centrum
van de dichtstbĳzĳnde pixel die is geïdentificeerd als een doelpixel. Doelpixels zĳn die in het bronraster waarvoor de
raster pixelwaarde in de verzameling van waarden van doelpixels ligt.
Dit algoritme is afgeleid van de GDAL proximity utility.
Standaard menu: Raster ► Analyse
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Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Invoer hoogte rasterlaag
Bandnummer BAND [rasterband]

Standaard: 1
Band die de informatie voor de hoogte bevat

Een lĳst van
pixelwaarden in
de bronafbeelding
die als doelpixels
moeten worden
beschouwd
Optioneel

VALUES [tekenreeks]
Standaard: ‘’

Een lĳst van waarden voor doelpixels
in de bronafbeelding die als doelpixels
moeten worden beschouwd. Indien niet
gespecificeerd, worden alle pixels met een
waarde die niet nul is beschouwd als
doelpixels.

Afstandseenheden UNITS [enumeratie]
Standaard: 1

Geef aan of gegenereerde afstanden in
pixels of in geo-verwezen coördinaten
zouden moeten zĳn. Één van:

• 0 — Coördinaten met
geoverwĳzingen

• 1 — Pixelcoördinaten

De maximale
afstand die moet
worden gemaakt
Optioneel

MAX_DISTANCE [getal]
Standaard: 0.0

De maximale te maken afstand. De waarde
‘Geen gegevens’ zal worden gebruikt
voor pixels buiten deze afstand. Indien
geen waarde ‘Geen gegevens’ wordt
opgegeven, zal de band voor uitvoer
worden bevraagd naar zĳn waarde ‘Geen
gegevens’. Als de uitvoerband geen waarde
‘Geen gegevens’ heeft, dan zal de waarde
65535 worden gebruikt. Afstand wordt
geïnterpreteerd overeenkomstig de waarde
van Afstandseenheden.

Waarde die moet
worden toegepast
op alle pixels
die binnen de
-maxdist van
doelpixels liggen
Optioneel

REPLACE [getal]
Standaard: 0.0

Specificeer een waarde die moet worden
toegepast op alle pixels die dichterbĳ liggen
dan de maximum afstand vanaf doelpixels
(inclusief de doelpixels) in plaats van een
waarde voor de afstand.

Waarde Geen
gegevens om
te gebruiken
voor het doel-
nabĳheidsraster
Optioneel

NODATA [getal]
Standaard: 0.0

Specificeer de waarde ‘Geen gegevens’ om
te gebruiken voor het uitvoerraster

Nabĳheidskaart OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer de uitvoer rasterlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…
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Gevorderde parameters

Label Naam Type Beschrijving
Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’

Voor toevoegen van een of meer
opties voor het beheren van het te
maken bestand (kleuren, blokgrootte,
bestandsompressie…). Voor het
gemak kunt u vertrouwen op vooraf
gedefinieerde profielen (bekĳk :ref:` het
gedeelte over opties voor GDAL driver
<gdal_createoptions>`).
Voor Batch-processen en Modelontwerper:
scheid meerdere opties door een teken pipe
(|).

Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: Geen

Extra GDAL opties voor opdrachtregel
toevoegen

Type
uitvoergegevens

DATA_TYPE [enumeratie]
Standaard: 5

Definieert het gegevenstype voor het
uitvoer rasterbestand. Opties:

• 0 — Byte (8-bit unsigned integer
(quint8))

• 1 — Int16 (16-bit signed integer
(qint16))

• 2 — UInt16 (16-bit unsigned integer
(quint16))

• 3 — UInt32 (32-bit unsigned integer
(quint32))

• 4 — Int32 (32-bit signed integer
(qint32))

• 5 — Float32 (32-bit floating point
(float))

• 6 — Float64 (64-bit floating point
(double))

• 7 — CInt16 (Complex Int16)
• 8 — CInt32 (Complex Int32)
• 9 — CFloat32 (Complex Float32)
• 10 — CFloat64 (Complex Float64)

Beschikbare opties zĳn afhankelĳk van de
versie van GDAL die is ingebouwd in QGIS
(bekĳk menu Help ► Info)

Uitvoer

Label Naam Type Beschrijving
Nabĳheidskaart OUTPUT [raster] Uitvoer raster
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Pythoncode

ID algoritme: gdal:proximity

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Ruw

Voert een enkelbands raster uit met berekende waarden uit de hoogte. Ruwheid is de mate van onregelmatigheid van
het oppervlak. Het wordt berekend door het grootste verschil tussen cellen van een centrale pixel en de omringende
cellen. De bepaling van de ruwheid speelt een rol bĳ de analyse van terreinhoogte-gegevens, het is nuttig bĳ
berekeningen van de morfologie van rivieren, in klimatologie en fysische geografie in het algemeen.
Dit algoritme is afgeleid van de GDAL DEM utility.
Standaard menu: Raster ► Analyse

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Invoer hoogte rasterlaag
Bandnummer BAND [rasterband]

Standaard: 1
Het nummer van de band die als hoogte
moet worden gebruikt

Randen berekenen COMPUTE_EDGES [Booleaanse
waarde]
Standaard: False

Maakt randen uit het hoogteraster

Ruwheid OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer de uitvoer rasterlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters
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Label Naam Type Beschrijving
Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’

Voor toevoegen van een of meer
opties voor het beheren van het te
maken bestand (kleuren, blokgrootte,
bestandsompressie…). Voor het
gemak kunt u vertrouwen op vooraf
gedefinieerde profielen (bekĳk :ref:` het
gedeelte over opties voor GDAL driver
<gdal_createoptions>`).
Voor Batch-processen en Modelontwerper:
scheid meerdere opties door een teken pipe
(|).

Uitvoer

Label Naam Type Beschrijving
Ruwheid OUTPUT [raster] Enkelbands uitvoerraster voor ruwheid. De

waarde -9999 wordt gebruikt als waarde
‘Geen gegevens’.

Pythoncode

ID algoritme: gdal:roughness

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Sieve

Verwĳdert raster-polygonen die kleiner zĳn dan een opgegeven drempelwaarde (in pixels) en vervangt ze door
de pixelwaarde van het grootste buur-polygoon. Het is nuttig als u een groot aantal kleine gebieden heeft op uw
rasterkaart.
Dit algoritme is afgeleid van de GDAL sieve utility.
Standaard menu: Raster ► Analyse

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Invoer hoogte rasterlaag
Drempel THRESHOLD [getal]

Standaard: 10
Alleen rasterpolygonen die kleiner zĳn dan
deze grootte zullen worden verwĳderd

Vervolgt op volgende pagina
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Tabel 27.224 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
8-connectedness
gebruiken

EIGHT_CONNECTEDNESS[Booleaanse
waarde]
Standaard: False

8-connectedness gebruiken in plaats van 4-
connectedness

Standaard
geldigheidsmasker
niet gebruiken
voor de
invoerband

NO_MASK [Booleaanse
waarde]
Standaard: False

Geldigheidsmasker
Optioneel

MASK_LAYER [raster] Te gebruiken geldigheidsmasker in plaats
van de standaard

Gezeefd OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer de uitvoer rasterlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: Geen

Extra GDAL opties voor opdrachtregel
toevoegen

Uitvoer

Label Naam Type Beschrijving
Gezeefd OUTPUT [raster] Uitvoer rasterlaag.

Pythoncode

ID algoritme: gdal:sieve

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Helling

Maakt een hellingskaart uit elk door GDAL ondersteund hoogteraster. Helling is de stĳgingshoek ten opzichte van
horizontaal. U heeft de optie om te specificeren welk type waarde u voor de helling wilt: graden of percentage helling.
Dit algoritme is afgeleid van de GDAL DEM utility.
Standaard menu: Raster ► Analyse

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Invoer hoogte rasterlaag
Bandnummer BAND [rasterband]

Standaard: 1
Band die de informatie voor de hoogte bevat

Verhouding van
verticale eenheden
naar horizontale

SCALE [getal]
Standaard: 1.0

De verhouding van verticale eenheden tot
horizontale eenheden

Helling weergeven
in procenten (in
plaats van graden)

AS_PERCENT [Booleaanse
waarde]
Standaard: False

Helling weergeven in procenten in plaats
van in graden

Randen berekenen COMPUTE_EDGES [Booleaanse
waarde]
Standaard: False

Maakt randen uit het hoogteraster

Gebruik formule
Zevenbergen&Thorne
(in plaats van die
van Horn)

ZEVENBERGEN [Booleaanse
waarde]
Standaard: False

Activeert de formule Zevenbergen&Thorne
voor gladdere landschappen

Helling OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer de uitvoer rasterlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’

Voor toevoegen van een of meer
opties voor het beheren van het te
maken bestand (kleuren, blokgrootte,
bestandsompressie…). Voor het
gemak kunt u vertrouwen op vooraf
gedefinieerde profielen (bekĳk :ref:` het
gedeelte over opties voor GDAL driver
<gdal_createoptions>`).
Voor Batch-processen en Modelontwerper:
scheid meerdere opties door een teken pipe
(|).

Vervolgt op volgende pagina
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Tabel 27.227 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: Geen

Extra GDAL opties voor opdrachtregel
toevoegen

Uitvoer

Label Naam Type Beschrijving
Helling OUTPUT [raster] Uitvoer raster

Pythoncode

ID algoritme: gdal:slope

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Terrein Ruwheid Index (TRI)

Voert een enkelbands raster uit met waarden die zĳn berekend uit de hoogten. TRI staat voor Terrain Ruggedness
Index, wat wordt gedefinieerd als het gemiddelde verschil tussen een centrale pixel en zĳn omringende cellen.
Dit algoritme is afgeleid van de GDAL DEM utility.
Standaard menu: Raster ► Analyse

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Invoer hoogte rasterlaag
Bandnummer BAND [rasterband]

Standaard: 1
Het nummer van de band die als hoogte
moet worden gebruikt

Randen berekenen COMPUTE_EDGES [Booleaanse
waarde]
Standaard: False

Maakt randen uit het hoogteraster

Terrein Ruwheid
Index

OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer de uitvoer rasterlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…
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Gevorderde parameters

Label Naam Type Beschrijving
Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’

Voor toevoegen van een of meer
opties voor het beheren van het te
maken bestand (kleuren, blokgrootte,
bestandsompressie…). Voor het
gemak kunt u vertrouwen op vooraf
gedefinieerde profielen (bekĳk :ref:` het
gedeelte over opties voor GDAL driver
<gdal_createoptions>`).
Voor Batch-processen en Modelontwerper:
scheid meerdere opties door een teken pipe
(|).

Uitvoer

Label Naam Type Beschrijving
Terrein Ruwheid
Index

OUTPUT [raster] Enkelbands uitvoerraster. De waarde -9999
wordt gebruikt als waarde ‘Geen gegevens’.

Pythoncode

ID algoritme: gdal:triterrainruggednessindex

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Topografische Positie Index (TPI)

Voert een enkelbands raster uit met waarden die zĳn berekend uit de hoogte. TPI staat voor Topographic Position
Index, die wordt gedefinieerd als het verschil tussen een centrale pixel en het gemiddelde van zĳn omringende cellen.
Dit algoritme is afgeleid van de GDAL DEM utility.
Standaard menu: Raster ► Analyse
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Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Invoer hoogte rasterlaag
Bandnummer BAND [rasterband]

Standaard: 1
Het nummer van de band om als waarden
voor hoogte te gebruiken

Randen berekenen COMPUTE_EDGES [Booleaanse
waarde]
Standaard: False

Maakt randen uit het hoogteraster

Terrein Ruwheid
Index

OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer de uitvoer rasterlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’

Voor toevoegen van een of meer
opties voor het beheren van het te
maken bestand (kleuren, blokgrootte,
bestandsompressie…). Voor het
gemak kunt u vertrouwen op vooraf
gedefinieerde profielen (bekĳk :ref:` het
gedeelte over opties voor GDAL driver
<gdal_createoptions>`).
Voor Batch-processen en Modelontwerper:
scheid meerdere opties door een teken pipe
(|).

Uitvoer

Label Naam Type Beschrijving
Terrein Ruwheid
Index

OUTPUT [raster] Uitvoer raster.

Pythoncode

ID algoritme: gdal:tpitopographicpositionindex

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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27.2.2 Raster conversie

gdal2xyz

Converteert rastergegevens naar de indeling XYZ ASCII.

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Rasterlaag die moet worden geconverteerd
Bandnummer BAND [rasterband]

Standaard: De
eerste band van de
invoerlaag

Als het raster meerdere banden bevat, kies
dan de band die u wilt converteren

Komma-
gescheiden
waarden uitvoeren

CSV [Booleaanse
waarde]
Standaard: False

Stelt in of het uitvoerbestand moet zĳn van
het type komma-gescheiden waarden (csv).

XYZ ASCII-
bestand

OUTPUT [bestand]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoerlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Beschrijving
XYZ ASCII-
bestand

INPUT [tabel] Tabelbestand dat de geëxporteerde waarden
uit de rasterband bevat.

Pythoncode

ID algoritme: gdal:gdal2xyz

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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PCT naar RGB

Converteert een 8-bit gepaletteerde afbeelding naar 24-bit RGB. Het zal een pseudokleur-band in het invoerbestand
converteren naar een bestand RGB in de gewenste indeling.
Dit algoritme is afgeleid van de GDAL pct2rgb utility.
Standaard menu: Raster ► Conversie

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Invoer 8-bit rasterafbeelding
Bandnummer BAND [rasterband]

Standaard: De
eerste band van de
invoerlaag

Als het raster meerdere banden bevat, kies
dan de band die u wilt converteren

Een RGBA-
bestand maken

RGBA [Booleaanse
waarde]
Standaard: False

Stelt in of het uitvoerbestand moet zĳn van
het type RGBA.

PCT naar RGB OUTPUT [bestand]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoerlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Beschrijving
PCT naar RGB OUTPUT [raster] 24-bit RGB rasterafbeelding

Pythoncode

ID algoritme: gdal:pcttorgb

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Polygoniseren (raster naar vector)

Maakt vector polygonen voor alle verbonden regio’s van pixels in het raster die een gemeenschappelĳke waarde voor
de pixel delen. Elk polygoon wordt gemaakt met een attribuut dat de waarde van de pixel van die polygoon aangeeft.
Dit algoritme is afgeleid van de GDAL polygonize utility.
Standaard menu: Raster ► Conversie

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Invoer rasterlaag
Bandnummer BAND [rasterband]

Standaard: De
eerste band van de
invoerlaag

Als het raster meerdere banden bevat, kies
dan de band die u wilt gebruiken

Naam van het te
maken veld

FIELD [tekenreeks]
Standaard: ‘DN’

Specificeer de veldnaam voor de attributen
van de verbonden regio’s.

8-connectedness
gebruiken

EIGHT_CONNECTEDNESS[Booleaanse
waarde]
Standaard: False

Indien niet ingesteld moeten rastercellen
een gemeenschappelĳke grens hebben om
als verbonden te worden beschouwd (4-
connected). Indien ingesteld worden elkaar
rakende rastercellen ook als verbonden
beschouwd(8-connected).

Gevectoriseerd OUTPUT [vector: polygoon]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoer (polygoon)
vectorlaag. Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: Geen

Extra GDAL opties voor opdrachtregel
toevoegen

Uitvoer

Label Naam Type Beschrijving
Gevectoriseerd OUTPUT [vector: polygoon] Uitvoer vectorlaag
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Pythoncode

ID algoritme: gdal:polygonize

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Banden herschikken

Maakt een nieuw raster met geselecteerde band(en) uit een opgegeven rasterlaag. Het algoritme maakt het ook
mogelĳk de banden voor het nieuw gemaakte raster opnieuw te schikken.
Dit algoritme is afgeleid van de GDAL translate utility.

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Invoer rasterlaag
Geselecteerde
band(en)

BANDS [rasterband] [lĳst]
Standaard: Geen

Gesorteerde lĳst van de te gebruiken banden
om het nieuwe raster te maken

Geconverteerd OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoerlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…
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Gevorderde parameters

Label Naam Type Beschrijving
Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’

Voor toevoegen van een of meer
opties voor het beheren van het te
maken bestand (kleuren, blokgrootte,
bestandsompressie…). Voor het
gemak kunt u vertrouwen op vooraf
gedefinieerde profielen (bekĳk :ref:` het
gedeelte over opties voor GDAL driver
<gdal_createoptions>`).
Voor Batch-processen en Modelontwerper:
scheid meerdere opties door een teken pipe
(|).

Type
uitvoergegevens

DATA_TYPE [enumeratie]
Standaard: 0

Definieert het gegevenstype voor het
uitvoer rasterbestand. Opties:

• 0 — Gegevenstype van invoerlaag
gebruiken

• 1 — Byte (8-bit unsigned integer
(quint8))

• 2 — Int16 (16-bit signed integer
(qint16))

• 3 — UInt16 (16-bit unsigned integer
(quint16))

• 4 — UInt32 (32-bit unsigned integer
(quint32))

• 5 — Int32 (32-bit signed integer
(qint32))

• 6 — Float32 (32-bit floating point
(float))

• 7 — Float64 (64-bit floating point
(double))

• 8 — CInt16 (Complex Int16)
• 9 — CInt32 (Complex Int32)
• 10 — CFloat32 (Complex Float32)
• 11 — CFloat64 (Complex Float64)

Beschikbare opties zĳn afhankelĳk van de
versie van GDAL die is ingebouwd in QGIS
(bekĳk menu Help ► Info)

Uitvoer

Label Naam Type Beschrijving
Geconverteerd OUTPUT [raster] Uitvoer rasterlaag met opnieuw geschikte

banden.
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Pythoncode

ID algoritme: gdal:rearrange_bands

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

RGB naar PCT

Converteert een 24-bit RGB-afbeelding naar een 8-bit gepaletteerde. Berekent een optimale tabel voor de pseudo-
kleur voor de opgegeven RGB-afbeelding met een algoritme voor mediaan afsnĳden op een gedownsampled
histogram voor RGB. Dan converteert het de afbeelding naar een afbeelding met pseudokleuren met de kleurentabel.
Deze conversie gebruikt Floyd-Steinberg dithering (foutdiffusie) om de visuele kwaliteit van het uitvoerbestand te
maximaliseren.
Als u een rasterkaart opnieuw wilt classificeren en het aantal klassen wilt verkleinen, kan het nuttig zĳn uw afbeelding
eerst te downsamplen met dit algoritme.
Dit algoritme is afgeleid van de GDAL rgb2pct utility.
Standaard menu: Raster ► Conversie

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Invoer (RGB) rasterlaag
Aantal kleuren NCOLORS [getal]

Standaard: 2
Het aantal kleuren dat de resulterende
afbeelding zal bevatten. Een waarde tussen
2-256 is mogelĳk.

RGB naar PCT OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoerlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Uitvoer

Label Naam Type Beschrijving
RGB naar PCT OUTPUT [raster] Uitvoer rasterlaag.
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Pythoncode

ID algoritme: gdal:rgbtopct

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Vertalen (indeling converteren)

Rastergegevens converteren naar verschillende indelingen.
Dit algoritme is afgeleid van de GDAL translate utility.
Standaard menu: Raster ► Conversie

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Invoer rasterlaag
De projectie voor
het uitvoerbestand
overschrĳven
Optioneel

TARGET_CRS [crs] Specificeer een projectie voor het
uitvoerbestand

Wĳs een
specifieke waarde
Geen data toe aan
de uitvoerbanden
Optioneel

NODATA [getal]
Standaard: Niet
ingesteld

Definieert een te gebruiken waarde voor de
waarden Geen gegevens in het uitvoerraster

Kopieer alle
sub-gegevenssets
van dit bestand
naar individuele
uitvoerbestanden

COPY_SUBDATASETS[Booleaanse
waarde]
Standaard: False

Individuele bestanden maken voor sub-
gegevenssets

Geconverteerd OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoer (vertaalde)
rasterlaag. Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…
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Gevorderde parameters

Label Naam Type Beschrijving
Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’

Voor toevoegen van een of meer
opties voor het beheren van het te
maken bestand (kleuren, blokgrootte,
bestandsompressie…). Voor het
gemak kunt u vertrouwen op vooraf
gedefinieerde profielen (bekĳk :ref:` het
gedeelte over opties voor GDAL driver
<gdal_createoptions>`).
Voor Batch-processen en Modelontwerper:
scheid meerdere opties door een teken pipe
(|).

Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: Geen

Extra GDAL opties voor opdrachtregel
toevoegen

Type
uitvoergegevens

DATA_TYPE [enumeratie]
Standaard: 0

Definieert het gegevenstype voor het
uitvoer rasterbestand. Opties:

• 0 — Gegevenstype van invoerlaag
gebruiken

• 1 — Byte (8-bit unsigned integer
(quint8))

• 2 — Int16 (16-bit signed integer
(qint16))

• 3 — UInt16 (16-bit unsigned integer
(quint16))

• 4 — UInt32 (32-bit unsigned integer
(quint32))

• 5 — Int32 (32-bit signed integer
(qint32))

• 6 — Float32 (32-bit floating point
(float))

• 7 — Float64 (64-bit floating point
(double))

• 8 — CInt16 (Complex Int16)
• 9 — CInt32 (Complex Int32)
• 10 — CFloat32 (Complex Float32)
• 11 — CFloat64 (Complex Float64)

Beschikbare opties zĳn afhankelĳk van de
versie van GDAL die is ingebouwd in QGIS
(bekĳk menu Help ► Info)
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Uitvoer

Label Naam Type Beschrijving
Geconverteerd OUTPUT [raster] Uitvoer (vertaalde) rasterlaag.

Pythoncode

ID algoritme: gdal:translate

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

27.2.3 Raster uitnemen

Raster op bereik clippen

Verkleint een door GDAL ondersteund rasterbestand tot een opgegeven bereik.
Dit algoritme is afgeleid van de GDAL translate utility.
Standaard menu: Raster ► Extractie

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Het invoerraster

Vervolgt op volgende pagina
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Tabel 27.238 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Bereik clippen EXTENT [bereik] Bereik dat zou moeten worden gebruikt

voor het uitvoerraster. Alleen pixels binnen
het gespecificeerde begrenzingsvak zullen
in de uitvoer worden opgenomen.
Beschikbare methoden zĳn:

• Uit laag berekenen…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

De projectie voor
het uitvoerbestand
overschrĳven

OVERCRS [Booleaanse
waarde]
Standaard: False

Indien geselecteerd wordt aan het
uitvoerbestand het CRS van het
invoerbestand toegewezen.

Wĳs een
specifieke waarde
Geen data toe aan
de uitvoerbanden
Optioneel

NODATA [getal]
Standaard: Geen

Definieert een waarde die zou moeten
worden ingevoegd voor de waarden Geen
gegevens in het uitvoerraster.

Geclipt (bereik) OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoer rasterlaag. Één
van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…
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Gevorderde parameters

Label Naam Type Beschrijving
Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’

Voor toevoegen van een of meer
opties voor het beheren van het te
maken bestand (kleuren, blokgrootte,
bestandsompressie…). Voor het
gemak kunt u vertrouwen op vooraf
gedefinieerde profielen (bekĳk :ref:` het
gedeelte over opties voor GDAL driver
<gdal_createoptions>`).
Voor Batch-processen en Modelontwerper:
scheid meerdere opties door een teken pipe
(|).

Type
uitvoergegevens

DATA_TYPE [enumeratie]
Standaard: 0

Definieert de indeling voor het
uitvoerraster.
Opties:

• 0 — Gegevenstype van invoerlaag
gebruiken

• 1 — Byte (8-bit unsigned integer
(quint8))

• 2 — Int16 (16-bit signed integer
(qint16))

• 3 — UInt16 (16-bit unsigned integer
(quint16))

• 4 — UInt32 (32-bit unsigned integer
(quint32))

• 5 — Int32 (32-bit signed integer
(qint32))

• 6 — Float32 (32-bit floating point
(float))

• 7 — Float64 (64-bit floating point
(double))

• 8 — CInt16 (Complex Int16)
• 9 — CInt32 (Complex Int32)
• 10 — CFloat32 (Complex Float32)
• 11 — CFloat64 (Complex Float64)

Beschikbare opties zĳn afhankelĳk van de
versie van GDAL die is ingebouwd in QGIS
(bekĳk menu Help ► Info)

Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: Geen

Extra GDAL opties voor opdrachtregel
toevoegen
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Uitvoer

Label Naam Type Beschrijving
Geclipt (bereik) OUTPUT [raster] Uitvoer rasterlaag geclipt op het opgegeven

bereik

Pythoncode

ID algoritme: gdal:cliprasterbyextent

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Raster op maskerlaag clippen

Verkleint een door GDAL ondersteund rasterbestand met een vector maskerlaag.
Dit algoritme is afgeleid van de GDAL warp utility.
Standaard menu: Raster ► Extractie

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Het invoerraster
Maskerlaag MASK [vector: polygoon] Vectormasker voor het clippen

van het raster
Bron-CRS SOURCE_CRS [crs] Stel de te gebruiken

coördinatenreferentie in
voor het invoerraster

Doel-CRS TARGET_CRS [crs] Stel de te gebruiken
coördinatenreferentie in
voor de maskeerlaag
Vervolgt op volgende pagina
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Tabel 27.239 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Doelbereik
NEW in 3.24
Optioneel

TARGET_EXTENT [bereik] Bereik van het te maken
bestand.
Beschikbare methoden zĳn:

• Uit laag berekenen…:
gebruikt het bereik
van een laag die in het
huidige project is geladen

• Berekenen uit kaart
afdruklay-out…:
gebruikt het bereik
van een afdruklay-out
kaart-item in het actieve
project

• Berekenen uit Favoriete
plaats…: gebruikt
het bereik van een
opgeslagen Favoriete
plaats

• Huidige bereik van
kaartvenster gebruiken

• Tekenen in kaartvenster:
klik en sleep een
rechthoek die het gebied
beperkt tot dat waarmee
rekening moet worden
gehouden

• Voer de coördinaten in
als xmin, xmax,
ymin, ymax

Wĳs een specifieke waarde
Geen data toe aan de
uitvoerbanden
Optioneel

NODATA [getal]
Standaard: Geen

Definieert een waarde die zou
moeten worden ingevoegd voor
de waarden Geen gegevens in
het uitvoerraster.

Maak een alfa-band voor
uitvoer

ALPHA_BAND [Booleaanse
waarde]
Standaard: False

Maakt een alfaband voor het
resultaat. De alfaband bevat dan
de waarden voor transparantie
van de pixels.

Bereik van het geclipte raster
overeen laten komen met het
bereik van de maskerlaag

CROP_TO_CUTLINE[Booleaanse
waarde]
Standaard: True

Past, indien geselecteerd, het
bereik van de vectorlaag toe op
het uitvoerraster.

Resolutie voor invoerraster
behouden

KEEP_RESOLUTION[Booleaanse
waarde]
Standaard: False

De resolutie van het
uitvoerraster zal niet worden
gewĳzigd

Stel de resolutie voor het
uitvoerbestand in

SET_RESOLUTION [Booleaanse
waarde]
Standaard: False

Moet de resolutie voor de
uitvoer (celgrootte) worden
gespecificeerd

X-resolutie voor
uitvoerbanden
Optioneel

X_RESOLUTION [getal]
Standaard: Geen

De breedte van de cellen in het
uitvoerraster

Y-resolutie voor
uitvoerbanden
Optioneel

Y_RESOLUTION [getal]
Standaard: Geen

De hoogte van de cellen in het
uitvoerraster

Vervolgt op volgende pagina
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Tabel 27.239 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Maak gebruik van
implementatie voor
multithreaded warping

MULTITHREADING [Booleaanse
waarde]
Standaard: False

Twee threads zullen worden
gebruikt om gedeelten van
afbeelding te verwerken en
tegelĳkertĳd bewerking voor
invoer/uitvoer uitvoeren.
Onthoud dat de berekening zelf
niet multithreaded is.

Geclipt (masker) OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoer
rasterlaag. Één van:

• Opslaan naar tĳdelĳk
bestand

• Opslaan als bestand…
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Gevorderde parameters

Label Naam Type Beschrijving
Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’

Voor toevoegen van een of meer
opties voor het beheren van het te
maken bestand (kleuren, blokgrootte,
bestandsompressie…). Voor het
gemak kunt u vertrouwen op vooraf
gedefinieerde profielen (bekĳk :ref:` het
gedeelte over opties voor GDAL driver
<gdal_createoptions>`).
Voor Batch-processen en Modelontwerper:
scheid meerdere opties door een teken pipe
(|).

Type
uitvoergegevens

DATA_TYPE [enumeratie]
Standaard: 0

Definieert de indeling voor het
uitvoerraster.
Opties:

• 0 — Gegevenstype van invoerlaag
gebruiken

• 1 — Byte (8-bit unsigned integer
(quint8))

• 2 — Int16 (16-bit signed integer
(qint16))

• 3 — UInt16 (16-bit unsigned integer
(quint16))

• 4 — UInt32 (32-bit unsigned integer
(quint32))

• 5 — Int32 (32-bit signed integer
(qint32))

• 6 — Float32 (32-bit floating point
(float))

• 7 — Float64 (64-bit floating point
(double))

• 8 — CInt16 (Complex Int16)
• 9 — CInt32 (Complex Int32)
• 10 — CFloat32 (Complex Float32)
• 11 — CFloat64 (Complex Float64)

Beschikbare opties zĳn afhankelĳk van de
versie van GDAL die is ingebouwd in QGIS
(bekĳk menu Help ► Info)

Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: Geen

Extra GDAL opties voor opdrachtregel
toevoegen
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Uitvoer

Label Naam Type Beschrijving
Geclipt (masker) OUTPUT [raster] Uitvoer rasterlaag geclipt op de vectorlaag

Pythoncode

ID algoritme: gdal:cliprasterbymasklayer

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Contour

Neemt contourlĳnen uit elk door GDAL ondersteund hoogteraster uit.
Dit algoritme is afgeleid van de GDAL contour utility.
Standaard menu: Raster ► Extractie

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Invoerraster
Bandnummer BAND [rasterband]

Standaard: 1
Rasterband waaruit de contouren moeten
worden gemaakt

Interval voor
contourlĳnen

INTERVAL [getal]
Standaard: 10.0

Definieert de interval tussen de
contourlĳnen in de opgegeven eenheden
van het hoogteraster. (minimum waarde 0)

Naam attribuut
(indien niet
ingesteld wordt
geen attribuut
voor hoogte
aangehecht)
Optioneel

FIELD_NAME [tekenreeks]
Standaard: ‘ELEV’

Geef een naam op voor het attribuut waarin
de hoogte moet worden geplaatst.

Verspringing
vanaf nul relatief
ten opzichte van
waar intervallen te
interpreteren
Optioneel

OFFSET [getal]
Standaard: 0.0

Vervolgt op volgende pagina
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Tabel 27.240 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Contouren OUTPUT [vector: lĳn]

Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoer vectorlaag. Één
van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
3D-vector maken CREATE_3D [Booleaanse

waarde]
Standaard: False

Forceert het maken van 3D-vectoren in
plaats van 2D. Inclusief hoogte uit elk punt.

Alle
rasterwaarden als
geldig behandelen

IGNORE_NODATA [Booleaanse
waarde]
Standaard: False

Negeert waarden Geen gegevens in de
gegevensset.

Invoer
pixelwaarde
behandelen als
“geen gegevens”
Optioneel

NODATA [getal]
Standaard: Geen

Definieert een waarde die zou moeten
worden ingevoegd voor de waarden Geen
gegevens in het uitvoerraster.

Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: Geen

Voeg extra GDAL-opties voor
de opdrachtregel toe. Bekĳk de
overeenkomstige documentatie voor
de GDAL-utility.

Uitvoer

Label Naam Type Beschrijving
Contouren OUTPUT [vector: lĳn] Uitvoer vectorlaag met contourlĳnen

Pythoncode

ID algoritme: gdal:contour

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Polygonen contour

Neemt polygonen contour uit elk door GDAL-ondersteund hoogteraster uit.
Dit algoritme is afgeleid van de GDAL contour utility.

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Invoerraster
Bandnummer BAND [rasterband]

Standaard: 1
Rasterband waaruit de contouren moeten
worden gemaakt

Interval voor
contourlĳnen

INTERVAL [getal]
Standaard: 10.0

Definieert de interval tussen de
contourlĳnen in de opgegeven eenheden
van het hoogteraster. (minimum waarde 0)

Verspringing
vanaf nul relatief
ten opzichte van
waar intervallen te
interpreteren
Optioneel

OFFSET [getal]
Standaard: 0.0

Naam
attribuut voor
minimumhoogte
van polygoon
contour
Optioneel

FIELD_NAME_MIN [tekenreeks]
Standaard:
‘ELEV_MIN’

Geef een naam op voor het attribuut
waarin de minimumhoogte van de polygoon
contour moet worden geplaatst. Indien
niet opgegeven wordt geen attribuut voor
minimumhoogte opgenomen.

Naam
attribuut voor
maximumhoogte
van polygoon
contour
Optioneel

FIELD_NAME_MAX [tekenreeks]
Standaard:
‘ELEV_MAX’

Geef een naam op voor het attribuut waarin
de maximumhoogte van de polygoon
contour moet worden geplaatst. Indien
niet opgegeven wordt geen attribuut voor
maximumhoogte opgenomen.

Contouren OUTPUT [vector: polygoon]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoer vectorlaag. Één
van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…
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Gevorderde parameters

Label Naam Type Beschrijving
3D-vector maken CREATE_3D [Booleaanse

waarde]
Standaard: False

Forceert het maken van 3D-vectoren in
plaats van 2D. Inclusief hoogte uit elk punt.

Alle
rasterwaarden als
geldig behandelen

IGNORE_NODATA [Booleaanse
waarde]
Standaard: False

Negeert waarden Geen gegevens in de
gegevensset.

Invoer
pixelwaarde
behandelen als
“geen gegevens”
Optioneel

NODATA [getal]
Standaard: Geen

Definieert een waarde die zou moeten
worden ingevoegd voor de waarden Geen
gegevens in het uitvoerraster.

Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: Geen

Voeg extra GDAL-opties voor
de opdrachtregel toe. Bekĳk de
overeenkomstige documentatie voor
de GDAL-utility.

Uitvoer

Label Naam Type Beschrijving
Contouren OUTPUT [vector: polygoon] Uitvoer vectorlaag met polygonen contour

Pythoncode

ID algoritme: gdal:contour_polygon

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

27.2.4 Raster diversen

Overzichten aanmaken (Piramiden)

Overzichten (piramiden) kunnen worden gemaakt om de tĳd die nodig is voor het renderen van rasterlagen te
versnellen. Overzichten zĳn kopieën van de gegevens in een lage resolutie die QGIS gebruikt, onafhankelĳk van
het zoomniveau.
Dit algoritme is afgeleid van de GDAL addo utility.
Standaard menu: Raster ► Diversen
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Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Invoer rasterlaag
Alle bestaande
overzichten
verwĳderen

CLEAN [Booleaanse
waarde]
Standaard: False

Verwĳdert bestaande overzichten uit
het raster. Standaard worden deze niet
verwĳderd.

Gevorderde parameters

Label Naam Type Beschrijving
Niveaus
overzichten

LEVELS [tekenreeks]
Standaard: ‘2 4 8 16’

Definieert het aantal niveaus voor
overzichten, berekend met de originele
resolutie van de invoer rasterlaag. Standaard
zullen 4 niveaus in overweging worden
genomen.

Methode voor
resamplen
Optioneel

RESAMPLING [enumeratie]
Standaard: 0

Berekent de overzichten met een
gedefinieerde methode voor resamplen.
Mogelĳke methoden voor resamplen zĳn:

• 0 — Dichtstbĳzĳnde buur
(nearest)

• 1 – Gemiddelde (average)
• 2 – Gaussiaans (gauss)
• 3 – Kubische convolutie (cubic)
• 4 – B-Spline convolutie
(cubicspline)

• 5 – Lanczos venstersinc (lanczos)
• 6 – Gemiddelde MP
(average_mp)

• 7 – Gemiddelde in ruimteMag/Phase
(average_magphase)

• 8 – Modus (mode)

Overzichtsindeling
Optioneel

FORMAT [enumeratie]
Standaard: 0

De overzichten kunnen intern worden
opgeslagen, of extern als GTiff of ERDAS
Imagine-bestand. Standaard worden de
overzichten opgeslagen in het uitvoerraster.
Mogelĳke methoden voor indeling zĳn:

• 0 — Intern (indien mogelĳk)
• 1 — Extern (GTiff .ovr)
• 2 — Extern (ERDAS Imagine .aux)

Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: Geen

Extra GDAL opties voor opdrachtregel
toevoegen
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Uitvoer

Label Naam Type Beschrijving
Als piramiden OUTPUT [raster] Uitvoer rasterlaag met overzichten

Pythoncode

ID algoritme: gdal:overviews

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Virtueel raster bouwen

Bouwt een VRT (Virtual Dataset), dat is een mozaïek van de lĳst van ingevoerde, door GDAL ondersteunde, rasters.
Met een mozaïek kunt u verschillende rasterbestanden samenvoegen.
Het algoritme is afgeleid van de GDAL buildvrt utility.
Standaard menu: Raster ► Diversen

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlagen INPUT [raster] [lĳst] Door GDAL ondersteunde rasterlagen.
Resolutie RESOLUTION [enumeratie]

Standaard: 0
De resolutie voor de uitvoer van het
mozaïek. Standaard zal de gemiddelde
resolutie van de rasterbestanden worden
gekozen.
Opties:

• 0 – Gemiddelde (average)
• 1 — Hoogste (highest)
• 2 — Laagste (lowest)

Plaats elk
invoerbestand
in een afzonderlĳk
band

SEPARATE [Booleaanse
waarde]
Standaard: False

Met ‘True’ kunt u definiëren dat elk
rasterbestand naar een afzonderlĳk
gestapelde band in de VRT-band gaat.

Verschillende
projecties toestaan

PROJ_DIFFERENCE[Booleaanse
waarde]
Standaard: False

Staat toe dat de uitvoerbanden verschillende
projecties hebben, afgeleid van de projectie
van de ingevoerde rasterlagen.

Vervolgt op volgende pagina
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Tabel 27.243 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Virtueel OUTPUT [raster]

Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoer rasterlaag. Één
van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Alfa-maskerband
toevoegen aan
VRT als het
bronraster er geen
heeft

ADD_ALPHA [Booleaanse
waarde]
Standaard: False

Voegt een alfa-maskerband toe aan het
VRT als het bronraster er geen heeft.

Projectie voor het
uitvoerbestand
overschrĳven
Optioneel

ASSIGN_CRS [crs]
Standaard: Geen

Overschrĳft de projectie voor het
uitvoerbestand. Er wordt niet opnieuw
geprojecteerd.

Algoritme voor
Resamplen

RESAMPLING [enumeratie]
Standaard: 0

Opties voor Te gebruiken algoritme voor
resamplen:

• 0 — Dichtstbĳzĳnde buur
(nearest)

• 1 — Bilineair (bilinear)
• 2 — Kubische convolutie (cubic)
• 3 — B-Spline convolutie
(cubicspline)

• 4 — Lanczos venstersinc
(lanczos)

• 5 — Gemiddelde (average)
• 6 — Modus (mode)

Waarde(n)
Geen data voor
invoerbanden
(gescheiden door
spatie)
Optioneel

SRC_NODATA [tekenreeks]
Standaard: Geen

Door spatie gescheiden waarde(n) Geen
data voor uitvoerband(en)

Aanvullende
parameters
opdrachtregel

EXTRA [tekenreeks]
Standaard: Geen

Extra GDAL opties voor opdrachtregel
toevoegen
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Uitvoer

Label Naam Type Beschrijving
Virtueel OUTPUT [raster] Uitvoer rasterlaag

Pythoncode

ID algoritme: gdal:buildvirtualraster

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

gdal2tiles

Maakt een kaart met kleine tegels en metadata, volgens de &#x60;OSGeo Tile Map Service Specification
&lt;https://wiki.osgeo.org/wiki/Tile_Map_Service_Specification&gt;&#x60;_. Bekĳk ook de OpenGIS Web Map
Tile Service Implementation Standard. Eenvoudige webpagina’s met weergaven, gebaseerd op Google Maps,
OpenLayers en Leaflet worden ook gemaakt. U dient alleen de gemaakte map te uploaden naar een webserver om
uw kaarten online in de webbrowser te verkennen.
Dit algoritme maakt ook de benodigde metadata voor Google Earth (KML SuperOverlay), in het geval dat de
verschafte map de projectie EPSG:4326 gebruikt.
ESRI world-bestanden en ingebedde geoverwĳzingen worden gebruikt bĳ het maken van de tegels, maar u kunt ook
een afbeelding publiceren zonder juiste geoverwĳzingen.
Dit algoritme is afgeleid van de GDAL gdal2tiles utility.

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Door GDAL ondersteunde rasterlaag.
Profiel tegel
snĳden

PROFILE [enumeratie]
Standaard: 0

Één van:
• 0 — Mercator (mercator)
• 1 — Geodetisch (geodetic)
• 2 — Raster (raster)

Zoomniveaus om
te renderen
Optioneel

ZOOM [tekenreeks]
Standaard: ‘’

Vervolgt op volgende pagina
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Tabel 27.244 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Te maken
webweergave

VIEWER [enumereren]
Standaard: 0

Één van:
• 0 — Alle (all)
• 1 — GoogleMaps (google)
• 2 — OpenLayers (openlayers)
• 3 — Leaflet (leaflet)
• 4 — Geen (none)

Titel van de kaart
Optioneel

TITLE [tekenreeks]
Standaard: ‘’

Auteursrecht voor
de kaart

COPYRIGHT [tekenreeks]
Standaard: ‘’

Map voor uitvoer OUTPUT [map]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer de map voor de uitvoer van de
tegels. Één van:

• Opslaan in tĳdelĳke map
• Opslaan naar map
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Gevorderde parameters

Label Naam Type Beschrijving
Methode voor
resamplen

RESAMPLING [enumeratie]
Standaard: 0

Opties voor Te gebruiken algoritme voor
resamplen:

• 0 – Gemiddelde (average)
• 1 — Dichtstbĳzĳnde buur (near)
• 2 — Bilineair (bilinear)
• 3 — Kubisch (cubic)
• 4 — Kubische spline
(cubicspline)

• 5 — Lanczos venstersinc
(lanczos)

• 6 — Antialias (antialias)

Het ruimtelĳke
referentiesysteem
dat is gebruikt
voor de
invoergegevens
van de bron
Optioneel

SOURCE_CRS [crs]
Standaard: Geen

Transparantiewaarde
om toe te
wĳzen aan de
invoergegevens
Optioneel

NODATA [getal]
Standaard: 0.0

URL-adres waar
de gemaakte tegels
zullen worden
gepubliceerd
Optioneel

URL [tekenreeks]
Standaard: ‘’

Google Maps
API-sleutel
(http://code.google.com/apis/maps/signup.html)
Optioneel

GOOGLE_KEY [tekenreeks]
Standaard: ‘’

Uw API-sleutel voor Google Maps.

Bing Maps
API-sleutel
(https://www.bingmapsportal.com/)
Optioneel

BING_KEY [tekenreeks]
Standaard: ‘’

Uw API-sleutel voor Bing.

Alleen
ontbrekende
bestanden maken

RESUME [Booleaanse
waarde]
Standaard: False

KML voor Google
Earth maken

KML [Booleaanse
waarde]
Standaard: False

Automatisch
maken van KML-
bestanden voor
EPSG:4326
vermĳden

NO_KML [Booleaanse
waarde]
Standaard: False
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Uitvoer

Label Naam Type Beschrijving
Map voor uitvoer OUTPUT [map] De map voor de uitvoer (voor de tegels)

Pythoncode

ID algoritme: gdal:gdal2tiles

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Samenvoegen

Voegt rasterbestanden op een eenvoudige manier samen. Hier kunt u een tabel met pseudokleur uit een invoerraster
gebruiken en het type uitvoerraster definiëren. Alle afbeeldingen moeten in hetzelfde coördinatensysteem zĳn.
Dit algoritme is afgeleid van de GDAL merge utility.
Standaard menu: Raster ► Diversen

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlagen INPUT [raster] [lĳst] Invoer rasterlagen
Pseudokleurentabel
uit eerste laag
nemen

PCT [Booleaanse
waarde]
Standaard: False

De tabel met pseudokleuren uit de eerste
laag zal worden gebruikt voor het kleuren

Plaats elk
invoerbestand
in een afzonderlĳk
band

SEPARATE [Booleaanse
waarde]
Standaard: False

Plaats elk invoerbestand in een
afzonderlĳke band

Vervolgt op volgende pagina
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Tabel 27.245 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Type
uitvoergegevens

DATA_TYPE [enumeratie]
Standaard: 5

Definieert de indeling voor het uitvoer
rasterbestand. Opties:

• 0 — Byte (8-bit unsigned integer
(quint8))

• 1 — Int16 (16-bit signed integer
(qint16))

• 2 — UInt16 (16-bit unsigned integer
(quint16))

• 3 — UInt32 (32-bit unsigned integer
(quint32))

• 4 — Int32 (32-bit signed integer
(qint32))

• 5 — Float32 (32-bit floating point
(float))

• 6 — Float64 (64-bit floating point
(double))

• 7 — CInt16 (Complex Int16)
• 8 — CInt32 (Complex Int32)
• 9 — CFloat32 (Complex Float32)
• 10 — CFloat64 (Complex Float64)

Beschikbare opties zĳn afhankelĳk van de
versie van GDAL die is ingebouwd in QGIS
(bekĳk menu Help ► Info)

Samengevoegd OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoer rasterlaag. Één
van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

1480 Hoofdstuk 27. Processing providers en algoritmes



QGIS Desktop 3.28 User Guide

Gevorderde parameters

Label Naam Type Beschrijving
Invoer
pixelwaarde
behandelen als
“Geen gegevens”
Optioneel

NODATA_INPUT [getal]
Standaard: Geen

Negeert pixels met deze pixelwaarde bĳ het
samenvoegen vanuit andere bestanden.

Specifieke waarde
“Geen data”
aan de uitvoer
toewĳzen
Optioneel

NODATA_OUTPUT [getal]
Standaard: Geen

Wĳst een specifieke waarde Geen data toe
aan uitvoerbanden.

Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’

Voor toevoegen van een of meer
opties voor het beheren van het te
maken bestand (kleuren, blokgrootte,
bestandsompressie…). Voor het
gemak kunt u vertrouwen op vooraf
gedefinieerde profielen (bekĳk :ref:` het
gedeelte over opties voor GDAL driver
<gdal_createoptions>`).
Voor Batch-processen en Modelontwerper:
scheid meerdere opties door een teken pipe
(|).

Aanvullende
parameters
opdrachtregel

EXTRA [tekenreeks]
Standaard: Geen

Extra GDAL opties voor opdrachtregel
toevoegen

Uitvoer

Label Naam Type Beschrijving
Samengevoegd OUTPUT [raster] Uitvoer rasterlaag

Pythoncode

ID algoritme: gdal:merge

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Pansharpening

Voert een bewerking voor pansharpening uit. Het kan een “klassieke” gegevensset voor de uitvoer maken (zoals
GeoTIFF), of een gegevensset VRT die de bewerking van pansharpening beschrĳft.
Bekĳk GDAL Pansharpen.

Parameters

Basis parameters

Label Naam Type Beschrijving
Spectrale
gegevensset

SPECTRAL [raster] Invoer (spectrale) rasterlaag

Panchromatische
gegevensset

PANCHROMATIC [raster] Invoer (panchromatische) rasterlaag

Uitvoer OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer de uitvoer (scherper gemaakte)
rasterlaag. Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Algoritme voor
Resamplen

RESAMPLING [enumeratie]
Standaard: 2

Opties voor Te gebruiken algoritme voor
resamplen:

• 0 — Dichtstbĳzĳnde buur
(nearest)

• 1 — Bilineair (bilinear)
• 2 — Kubisch (cubic)
• 3 — Kubische spline
(cubicspline)

• 4 — Lanczos venstersinc
(lanczos)

• 5 — Gemiddelde (average)

Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’

Voor toevoegen van een of meer
opties voor het beheren van het te
maken bestand (kleuren, blokgrootte,
bestandsompressie…). Voor het
gemak kunt u vertrouwen op vooraf
gedefinieerde profielen (bekĳk :ref:` het
gedeelte over opties voor GDAL driver
<gdal_createoptions>`).
Voor Batch-processen en Modelontwerper:
scheid meerdere opties door een teken pipe
(|).

Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: Geen

Extra GDAL opties voor opdrachtregel
toevoegen
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Uitvoer

Label Naam Type Beschrijving
Uitvoer OUTPUT [raster] Uitvoer (scherper gemaakte) rasterlaag.

Pythoncode

ID algoritme: gdal:pansharp

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Raster calculator

Raster calculator voor de opdrachtregel met NumPy-syntaxis. Gebruik elke door NumPy-arrays ondersteunde basis
berekening, zoals +, -, *, en / naast logische operatoren, zoals >. Onthoud dat alle invoerrasters dezelfde dimensies
moeten hebben, maar er wordt geen controle voor de projectie uitgevoerd.
Bekĳk de documenten voor GDAL Raster Calculator utility.
Zie ook:
Raster calculator

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag A INPUT_A [raster] Eerste invoer rasterlaag (verplicht)
Nummer van de
rasterband voor A

BAND_A [rasterband] Band voor invoerlaag A (verplicht)

Invoerlaag B
Optioneel

INPUT_B [raster]
Standaard: Geen

Tweede invoer rasterlaag

Nummer van de
rasterband voor B
Optioneel

BAND_B [rasterband] Band voor invoerlaag B

Invoerlaag C
Optioneel

INPUT_C [raster]
Standaard: Geen

Derde invoer rasterlaag

Nummer van de
rasterband voor C
Optioneel

BAND_C [rasterband] Band voor invoerlaag C

Invoerlaag D
Optioneel

INPUT_D [raster]
Standaard: Geen

Vierde invoer rasterlaag

Nummer van de
rasterband voor D
Optioneel

BAND_D [rasterband] Band voor invoerlaag D

Vervolgt op volgende pagina
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Tabel 27.247 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Invoerlaag E
Optioneel

INPUT_E [raster]
Standaard: Geen

Vĳfde invoer rasterlaag

Nummer van de
rasterband voor E
Optioneel

BAND_E [rasterband] Band voor invoerlaag E

Invoerlaag F
Optioneel

INPUT_F [raster] Zesde invoer rasterlaag

Nummer van de
rasterband voor F
Optioneel

BAND_F [rasterband]
Standaard: Geen

Band voor invoerlaag F

Berekening in
syntaxis voor
gdalnumeric met
behulp van +-/* of
elke functie voor
NumPy-arrays
(d.i. logical_and())

FORMULA [tekenreeks]
Standaard: ‘’

De formule voor de berekening.
Voorbeelden:

• A*(A>0) — voert de waarde van
het raster A uit als de waarde van A
groter is dan 0. Indien niet wordt 0
uitgevoerd.

• A*(A>0 and A>B) — voert
de waarde van A uit als die waarde
groter is dan 0 en groter dan de
waarde van B. Indien niet wordt 0
uitgevoerd.

• A*logical_or(A<=177,
A>=185)— voert de waarde van A
uit als A <= 177 of A >= 185. Indien
niet wordt 0 uitgevoerd.

• sqrt(A*A+B*B) — voert de
vierkantswortel van de som van de
waarde van A kwadraat en de waarde
van B kwadraat.

Waarde Geen
gegevens instellen
Optioneel

NO_DATA [getal]
Standaard: Geen

Te gebruiken waarde voor Geen gegevens

Uitvoer bereik
NEW in 3.24
Optioneel

INPUT [bereik] Aangepast bereik van het uitvoerraster.
Alleen beschikbaar met GDAL 3.3+.
Beschikbare methoden zĳn:

• Uit laag berekenen…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

Vervolgt op volgende pagina
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Tabel 27.247 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Type raster
uitvoer

RTYPE [enumeratie]
Standaard: 5

Definieert het gegevenstype voor het
uitvoer rasterbestand. Opties:

• 0 — Byte (8-bit unsigned integer
(quint8))

• 1 — Int16 (16-bit signed integer
(qint16))

• 2 — UInt16 (16-bit unsigned integer
(quint16))

• 3 — UInt32 (32-bit unsigned integer
(quint32))

• 4 — Int32 (32-bit signed integer
(qint32))

• 5 — Float32 (32-bit floating point
(float))

• 6 — Float64 (64-bit floating point
(double))

Beschikbare opties zĳn afhankelĳk van de
versie van GDAL die is ingebouwd in QGIS
(bekĳk menu Help ► Info)

Berekend OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer de uitvoer (berekende)
rasterlaag. Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’

Voor toevoegen van een of meer
opties voor het beheren van het te
maken bestand (kleuren, blokgrootte,
bestandsompressie…). Voor het
gemak kunt u vertrouwen op vooraf
gedefinieerde profielen (bekĳk :ref:` het
gedeelte over opties voor GDAL driver
<gdal_createoptions>`).
Voor Batch-processen en Modelontwerper:
scheid meerdere opties door een teken pipe
(|).

Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: ‘’

Extra GDAL opties voor opdrachtregel
toevoegen
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Uitvoer

Label Naam Type Beschrijving
Berekend OUTPUT [raster] Uitvoer (berekende) rasterlaag

Pythoncode

ID algoritme: gdal:rastercalculator

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Rasterinformatie

Het programma gdalinfo vermeldt diverse informatie over een door GDAL ondersteunde gegevensset voor rasters.
Dit algoritme is afgeleid van de GDAL info utility.
Standaard menu: Raster ► Diversen

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Invoer rasterlaag
Berekenen van de
actuele min/max-
waarden voor elke
band forceren

MIN_MAX [Booleaanse
waarde]
Standaard: False

Forceert het berekenen van de feitelĳke
waarden min/max voor elke band in de
gegevensset

Statistieken voor
afbeelding lezen
en weergeven
(berekenen
forceren indien
nodig)

STATS [Booleaanse
waarde]
Standaard: False

Leest en geeft statistieken voor
afbeeldingen weer. Forceert berekenen
indien er geen statistieken zĳn opgeslagen
in een afbeelding.

Info over GCP
onderdrukken

NO_GCP [Booleaanse
waarde]
Standaard: False

Onderdrukt het afdrukken van de lĳst met
grond controlepunten. Het kan nuttig zĳn
voor gegevenssets met een groot aantal
GCP’s, zoals L1B AVHRR of HDF4
MODIS die er duizenden van bevatten.

Info over
metadata
onderdrukken

NO_METADATA [Booleaanse
waarde]
Standaard: False

Onderdrukt het afdrukken van metadata.
Sommige gegevenssets kunnen enorm veel
tekenreeksen voor metadata bevatten.

Vervolgt op volgende pagina
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Tabel 27.249 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Laaginformatie OUTPUT [html]

Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer het HTML-bestand voor de
uitvoer. Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: Geen

Extra GDAL opties voor opdrachtregel
toevoegen

Uitvoer

Label Naam Type Beschrijving
Laaginformatie OUTPUT [html] Het HTML-bestand dat informatie over de

input rasterlaag bevat

Pythoncode

ID algoritme: gdal:gdalinfo

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Opnieuw tegelen

Tegelt een set invoerbestanden opnieuw. Alle invoerbestanden moeten geoverwĳzingen in hetzelfde
coördinatensysteem hebben en een overeenkomend aantal banden hebben. Optioneel worden niveaus van piramiden
gemaakt.
Dit algoritme is afgeleid van de GDAL Retile utility.
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Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerbestanden INPUT [raster] [lĳst] De invoer rasterbestanden
Tegelbreedte TILE_SIZE_X [getal]

Standaard: 256
Breedte van de tegels in pixels (minimum 0)

Tegelhoogte TILE_SIZE_Y [getal]
Standaard: 256

Hoogte van de tegels in pixels (minimum 0)

Overlapping in
pixels tussen
opeenvolgende
tegels

OVERLAP [getal]
Standaard: 0

Aantal te bouwen
niveaus voor
piramiden

LEVELS [getal]
Standaard: 1

Minimum: 0

Map voor uitvoer OUTPUT [map]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer de map voor de uitvoer van de
tegels. Één van:

• Opslaan in tĳdelĳke map
• Opslaan naar map

CSV-bestand met
de informatie voor
geoverwĳzingen
voor de tegel(s)

OUTPUT_CSV [bestand]
Standaard:
[Uitvoer
overslaan]

Specificeer het uitvoerbestand voor de
tegels. Één van:

• Uitvoer overslaan
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Bron coördinaten
referentiesysteem
Optioneel

SOURCE_CRS [crs]
Standaard: Geen

Methode voor
resamplen

RESAMPLING [enumeratie]
Standaard: 0

Opties voor Te gebruiken algoritme voor
resamplen:

• 0 — Dichtstbĳzĳnde buur
(nearest)

• 1 — Bilineair (bilinear)
• 2 — Kubisch (cubic)
• 3 — Kubische spline
(cubicspline)

• 4 — Lanczos venstersinc
(lanczos)

Scheidingsteken
voor kolom dat
is gebruikt in het
CSV-bestand
Optioneel

DELIMITER [tekenreeks]
Standaard: ‘;’

Te gebruiken scheidingsteken voor het
CSV-bestand met de informatie voor
geoverwĳzingen voor de tegel(s)

Vervolgt op volgende pagina
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Tabel 27.252 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’

Voor toevoegen van een of meer
opties voor het beheren van het te
maken bestand (kleuren, blokgrootte,
bestandsompressie…). Voor het
gemak kunt u vertrouwen op vooraf
gedefinieerde profielen (bekĳk :ref:` het
gedeelte over opties voor GDAL driver
<gdal_createoptions>`).
Voor Batch-processen en Modelontwerper:
scheid meerdere opties door een teken pipe
(|).

Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: ‘’

Extra GDAL opties voor opdrachtregel
toevoegen

Type
uitvoergegevens

DATA_TYPE [enumeratie]
Standaard: 5

Definieert de indeling voor het uitvoer
rasterbestand. Opties:

• 0 — Byte (8-bit unsigned integer
(quint8))

• 1 — Int16 (16-bit signed integer
(qint16))

• 2 — UInt16 (16-bit unsigned integer
(quint16))

• 3 — UInt32 (32-bit unsigned integer
(quint32))

• 4 — Int32 (32-bit signed integer
(qint32))

• 5 — Float32 (32-bit floating point
(float))

• 6 — Float64 (64-bit floating point
(double))

• 7 — CInt16 (Complex Int16)
• 8 — CInt32 (Complex Int32)
• 9 — CFloat32 (Complex Float32)
• 10 — CFloat64 (Complex Float64)

Beschikbare opties zĳn afhankelĳk van de
versie van GDAL die is ingebouwd in QGIS
(bekĳk menu Help ► Info)

Alleen de
piramiden bouwen

ONLY_PYRAMIDS [Booleaanse
waarde]
Standaard: False

Een afzonderlĳke
map voor elke rĳ
tegels gebruiken

DIR_FOR_ROW [Booleaanse
waarde]
Standaard: False
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Uitvoer

Label Naam Type Beschrijving
Map voor uitvoer OUTPUT [map] De map voor de uitvoer van de tegels.
CSV-bestand met
de informatie voor
geoverwĳzingen
voor de tegel(s)

OUTPUT_CSV [bestand] Het CSV-bestand met de informatie voor
geoverwĳzingen voor de tegels.

Pythoncode

ID algoritme: gdal:retile

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Tegelindex

Bouwt een vectorlaag met één record voor elk ingevoerd rasterbestand, een attribuut dat de bestandsnaam bevat en
een polygoon-geometrie voor de omtrek van het raster. Deze uitvoer is geschikt om te gebruiken met MapServer als
een raster tegelindex.
Dit algoritme is afgeleid van de GDAL Tile Index utility.
Standaard menu: Raster ► Diversen

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerbestanden LAYERS [raster] [lĳst] De invoer rasterbestanden. Mogen

meerdere bestanden zĳn.
Veldnaam die
het bestandspad
bevat naar de
geïndexeerde
rasters

PATH_FIELD_NAME
Optional

[tekenreeks]
Standaard: ‘location’

De naam voor het veld in de uitvoer
dat de bestandspaden/-locaties naar de
geïndexeerde rasters bevat.

Absolute pad naar
de geïndexeerde
rasters opslaan

ABSOLUTE_PATH [Booleaanse
waarde]
Standaard: False

Stelt in of het absolute pad naar de
rasterbestanden wordt opgeslagen in het
bestand voor de tegelindex. Standaard
zullen de bestandsnamen van de rasters
exact in het bestand worden vermeld zoals
zĳ in de opdracht zĳn vermeld.

Vervolgt op volgende pagina

1490 Hoofdstuk 27. Processing providers en algoritmes

https://gdal.org/programs/gdaltindex.html


QGIS Desktop 3.28 User Guide

Tabel 27.253 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Bestanden met
een andere
projectieverwĳzing
overslaan

PROJ_DIFFERENCE[Booleaanse
waarde]
Standaard: False

Alleen bestanden met dezelfde projectie
als bestanden die al zĳn ingevoegd in de
tegelindex zullen worden ingevoegd.
Standaard wordt de projectie niet
gecontroleerd en wordt alle invoer
geaccepteerd.

Tegelindex OUTPUT [vector: polygoon]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer de polygoon vectorlaag
waarnaar de indexmoet worden geschreven.
Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Geometrieën
naar het
opgegeven CRS
transformeren
Optioneel

TARGET_CRS [crs] Geometrieën van de invoerbestanden
zullen worden getransformeerd naar
het gespecificeerde doel coördinaten
referentiesysteem. Standaard worden
eenvoudige rechthoekige polygonen
gemaakt in hetzelfde coördinaten
referentiesysteem als van de invoerrasters.

De naam van het
veld om het SRS
van elke tegel in op
te slaan
Optioneel

CRS_FIELD_NAME [tekenreeks] De naam van het veld om het SRS van elke
tegel in op te slaan

De indeling
waarin het CRS
van elke tegel
moet worden
geschreven

CRS_FORMAT [enumeratie]
Standaard: 0

Indeling voor het CRS. Één van:
• 0 – Automatisch (AUTO)
• 1 – Wel-bekende tekst (WKT)
• 2 – EPSG (EPSG)
• 3 – Proj.4 (PROJ)

Uitvoer

Label Naam Type Beschrijving
Tegelindex OUTPUT [vector: polygoon] De polygoon vectorlaag met de tegelindex.
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Pythoncode

ID algoritme: gdal:tileindex

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Zichtgebied

Berekent een raster voor het zichtgebied vanuit een invoerraster DEM, met de methode die wordt gedefinieerd in
Wang2000, voor een door de gebruiker gedefinieerd punt.

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Invoer hoogte rasterlaag
Bandnummer BAND [rasterband]

Standaard: 1
Het nummer van de band die als hoogte
moet worden gebruikt

Locatie
waarnemer

OBSERVER [punt] De locatie van de waarnemer

Hoogte
waarnemer

OBSERVER_HEIGHT[getal]
Standaard: 1.0

De hoogte van de waarnemer, in de
eenheden van de DEM

Doelhoogte TARGET_HEIGHT [getal]
Standaard: 1.0

De hoogte van het doelelement, in de
eenheden van de DEM

Maximale afstand
vanaf waarnemer
om zichtbaarheid
te berekenen

MAX_DISTANCE [getal]
Standaard: 100.0

Maximale afstand vanaf waarnemer om
zichtbaarheid te berekenen, in de eenheden
van de DEM

Uitvoer OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Uitvoer rasterlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters
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Label Naam Type Beschrijving
Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’

Voor toevoegen van een of meer
opties voor het beheren van het te
maken bestand (kleuren, blokgrootte,
bestandsompressie…). Voor het
gemak kunt u vertrouwen op vooraf
gedefinieerde profielen (bekĳk :ref:` het
gedeelte over opties voor GDAL driver
<gdal_createoptions>`).
Voor Batch-processen en Modelontwerper:
scheid meerdere opties door een teken pipe
(|).

Aanvullende
parameters
opdrachtregel

EXTRA [tekenreeks]
Standaard: Geen

Extra GDAL opties voor opdrachtregel
toevoegen

Uitvoer

Label Naam Type Beschrijving
Uitvoer OUTPUT [raster] De rasterlaag die het zichtgebied weergeeft.

Pythoncode

ID algoritme: gdal:viewshed

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

27.2.5 Rasterprojecties

Projectie toekennen

Past een coördinatensysteem toe aan een raster gegevensset.
Dit algoritme is afgeleid van de GDAL edit utility.
Standaard menu: Raster ► Projecties
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Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT_LAYER [raster] Invoer rasterlaag
Gewenst CRS CRS [crs] De projectie (CRS) van de uitvoerlaag

Uitvoer

Label Naam Type Beschrijving
Laag met projectie OUTPUT [raster] De uitvoer rasterlaag (met de nieuwe

informatie over de projectie)

Pythoncode

ID algoritme: gdal:assignprojection

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Projectie uitnemen

Neemt de projectie uit een rasterbestand en schrĳft die naar een world-bestand met de extensie .wld.
Dit algoritme is afgeleid van de GDAL srsinfo utility.
Standaard menu: Raster ► Projecties

Parameters

Label Naam Type Beschrijving
Invoerbestand INPUT_LAYER [raster] Invoer raster. De rasterlaag moet gebaseerd

zĳn op een bestand, omdat het algoritme
het pad naar het rasterbestand gebruikt als
de locatie van het gemaakte bestand .wld.
Gebruiken van een raster dat niet gebaseerd
is op een bestand zal tot een fout leiden.

Ook prj-bestand
maken

PRJ_FILE_CREATE[Booleaanse
waarde]
Standaard: False

Als dit is geactiveerd wordt ook een .prj-
bestand, dat de informatie voor de projectie
bevat, gemaakt.
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Uitvoer

Label Naam Type Beschrijving
World file WORLD_FILE [bestand] Tekstbestand met de extensie .wld dat

parameters voor de transformatie van het
rasterbestand bevat.

ESRI Shapefile
prj-bestand

PRJ_FILE [bestand] Tekstbestand met de extensie .prj dat het
CRS beschrĳft. Zal Geen zĳn als Ook .prj-
bestand maken False is.

Pythoncode

ID algoritme: gdal:extractprojection

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Warp (opnieuw projecteren)

Projecteert een rasterlaag opnieuw, naar een ander Coördinaten ReferentieSysteem (CRS). De resolutie voor het
uitvoerbestand en de methode voor resamplen kunnen worden gekozen.
Dit algoritme is afgeleid van de GDAL warp utility.
Standaard menu: Raster ► Projecties

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [raster] Invoer rasterlaag om opnieuw te projecteren
Bron-CRS
Optioneel

SOURCE_CRS [crs] Definieert het CRS van de invoer rasterlaag

Doel-CRS
Optioneel

TARGET_CRS [crs]
Standaard:
EPSG:4326

Het CRS van de uitvoerlaag

Vervolgt op volgende pagina
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Tabel 27.257 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Te gebruiken
methode voor
resamplen

RESAMPLING [enumeratie]
Standaard: 0

Te gebruiken methode voor resamplen van
de pixelwaarde. Opties:

• 0 — Dichtstbĳzĳnde buur
• 1 — Bilineair
• 2 — Kubisch
• 3 — Kubische spline
• 4 — Lanczos venstersinc
• 5 — Gemiddelde
• 6 — Modus
• 7 — Maximum
• 8 — Minimum
• 9 — Mediaan
• 10 — Eerste kwartiel
• 11 — Derde kwartiel

Waarde Geen
data voor
uitvoerbanden
Optioneel

NODATA [getal]
Standaard: Geen

Stelt de waarde Geen data voor
uitvoerbanden in. Indien niet opgegeven
dan zullen waarden Geen data worden
gekopieerd vanuit de bron-gegevensset.

Resolutie
uitvoerbestand
in geo-verwezen
eenheden van doel
Optioneel

TARGET_RESOLUTION[getal]
Standaard: Geen

Definieert de resolutie voor het
uitvoerbestand van het resultaat van
het opnieuw projecteren

Opnieuw
geprojecteerd

OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoer rasterlaag. Één
van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Gevorderde parameters

Label Naam Type Beschrijving
Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’

Voor toevoegen van een of meer
opties voor het beheren van het te
maken bestand (kleuren, blokgrootte,
bestandsompressie…). Voor het
gemak kunt u vertrouwen op vooraf
gedefinieerde profielen (bekĳk :ref:` het
gedeelte over opties voor GDAL driver
<gdal_createoptions>`).
Voor Batch-processen en Modelontwerper:
scheid meerdere opties door een teken pipe
(|).

Vervolgt op volgende pagina
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Tabel 27.258 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Type
uitvoergegevens

DATA_TYPE [enumeratie]
Standaard: 0

Definieert de indeling voor het uitvoer
rasterbestand. Opties:

• 0 — Gegevenstype van invoerlaag
gebruiken

• 1 — Byte (8-bit unsigned integer
(quint8))

• 2 — Int16 (16-bit signed integer
(qint16))

• 3 — UInt16 (16-bit unsigned integer
(quint16))

• 4 — UInt32 (32-bit unsigned integer
(quint32))

• 5 — Int32 (32-bit signed integer
(qint32))

• 6 — Float32 (32-bit floating point
(float))

• 7 — Float64 (64-bit floating point
(double))

• 8 — CInt16 (Complex Int16)
• 9 — CInt32 (Complex Int32)
• 10 — CFloat32 (Complex Float32)
• 11 — CFloat64 (Complex Float64)

Beschikbare opties zĳn afhankelĳk van de
versie van GDAL die is ingebouwd in QGIS
(bekĳk menu Help ► Info)

Bereik met
geoverwĳzingen
voor te maken
uitvoerbestand
Optioneel

TARGET_EXTENT [bereik] Stelt het bereik met geoverwĳzingen in voor
het te maken uitvoerbestand (standaard in
het Doel-CRS. In het CRS van het doel
rasterbereik, indien gespecificeerd).
Beschikbare methoden zĳn:

• Uit laag berekenen…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

Vervolgt op volgende pagina
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Tabel 27.258 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
CRS van het doel-
rasterbereik
Optioneel

TARGET_EXTENT_CRS[crs] Specificeert het CRS waarin de opgegeven
coördinaten voor het bereik van
het uitvoerbestand moeten worden
geïnterpreteerd. Dit moet niet worden
verward met het doel CRS voor de uitvoer
van de gegevensset. Het is in plaats
daarvan voor het gemak, bĳv. wanneer
u de coördinaten voor de uitvoer weet in
een geodetisch CRS met long/lat, maar
de resultaten wilt in een geprojecteerd
coördinatensysteem.

Maak gebruik van
implementatie
voor
multithreaded
warping

MULTITHREADING [Booleaanse
waarde]
Standaard: False

Twee threads zullen worden gebruikt
om gedeelten van de afbeelding te
verwerken en tegelĳkertĳd bewerkingen
voor invoer/uitvoer uitvoeren. Onthoud dat
de berekening zelf niet multithreaded is.

Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: Geen

Extra GDAL opties voor opdrachtregel
toevoegen.

Uitvoer

Label Naam Type Beschrijving
Opnieuw
geprojecteerd

OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Opnieuw geprojecteerde uitvoer rasterlaag

Pythoncode

ID algoritme: gdal:warpreproject

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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27.2.6 Vector conversie

Indeling converteren

Converteert een door OGR ondersteunde vectorlaag naar een andere door OGR ondersteunde indeling.
Dit algoritme is afgeleid van de ogr2ogr utility.

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Alle lagen van
gegevensset
converteren
NEW in 3.24

CONVERT_ALL_LAYERS[Booleaanse
waarde]
Standaard: False

Converteert de gehele gegevensset.
Ondersteunde indelingen voor uitvoer voor
deze optie zĳn GPKG en GML.

Geconverteerd OUTPUT [hetzelfde als
invoer]

Specificatie van de uitvoer vectorlaag. Één
van:

• Opslaan als tĳdelĳk bestand
• Opslaan als bestand…

Voor Opslaan naar bestand
moet de indeling voor de uitvoer worden
gespecificeerd. Alle GDAL indelingen
voor vector worden ondersteund. Voor
Opslaan als tijdelijk bestand
zal de QGIS standaard indeling voor vector
worden gebruikt.

Gevorderde parameters

Label Naam Type Beschrijving
Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’ (geen
aanvullende opties)

Aanvullende opties voor maken GDAL.

Uitvoer

Label Naam Type Beschrijving
Geconverteerd OUTPUT [hetzelfde als

invoer]
De uitvoer vectorlaag
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Pythoncode

ID algoritme: gdal:convertformat

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Rasteriseren (overschrijven met attribuut)

Overschrĳft een rasterlaag met waarden uit een vectorlaag. Nieuwe waarden worden toegewezen, gebaseerd op de
waarde van het attribuut van het overlappende vectorobject.
Dit algoritme is afgeleid van de GDAL rasterize utility.

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Invoer rasterlaag INPUT_RASTER [raster] Invoer rasterlaag
Veld te gebruiken
voor ingebrande
waarde
Optioneel

FIELD [tabelveld:
numeriek]

Definieert het attribuutveld waaruit de
pixelwaarden moeten worden ingesteld

Gevorderde parameters

Label Naam Type Beschrijving
Ingebrande
waarden
toevoegen
aan bestaande
rasterwaarden

ADD [Booleaanse
waarde]
Standaard: False

Indien False worden pixels toegewezen aan
de geselecteerde waarde van het veld. Indien
True wordt de geselecteerde waarde van
het veld toegevoegd aan de waarde van de
invoer rasterlaag.

Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: ‘’

Extra GDAL opties voor opdrachtregel
toevoegen
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Uitvoer

Label Naam Type Beschrijving
Gerasteriseerd OUTPUT [raster] De overschreven invoer rasterlaag

Pythoncode

ID algoritme: gdal:rasterize_over

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Rasteriseren (overschrijven met vaste waarde)

Overschrĳft delen van een rasterlaag met vaste waarden. De te overschrĳven pixels worden gekozen, gebaseerd op de
opgegeven (overlappende) vectorlaag.
Dit algoritme is afgeleid van de GDAL rasterize utility.

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Invoer rasterlaag INPUT_RASTER [raster] Invoer rasterlaag
Een vaste waarde
om te branden

BURN [getal]
Standaard: 0.0

De te branden waarde

Gevorderde parameters

Label Naam Type Beschrijving
Ingebrande
waarden
toevoegen
aan bestaande
rasterwaarden

ADD [Booleaanse
waarde]
Standaard: False

Indien False worden pixels toegewezen aan
de vaste waarde. Indien True wordt de vaste
waarde toegevoegd aan de waarde van de
invoer rasterlaag.

Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: ‘’

Extra GDAL opties voor opdrachtregel
toevoegen
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Uitvoer

Label Naam Type Beschrijving
Gerasteriseerd OUTPUT [raster] De overschreven invoer rasterlaag

Pythoncode

ID algoritme: gdal:rasterize_over_fixed_value

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Rasteriseren (vector naar raster)

Converteert vectorgeometrieën (punten, lĳnen en polygonen) naar een rasterafbeelding.
Dit algoritme is afgeleid van de GDAL rasterize utility.
Standaard menu: Raster ► Conversie

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Veld te gebruiken
voor ingebrande
waarde
Optioneel

FIELD [tabelveld:
numeriek]

Definieert het attribuutveld van waaruit de
attributen voor de pixels zouden moeten
worden gekozen

Een vaste waarde
om te branden
Optioneel

BURN [getal]
Standaard: 0.0

Een vaste waarde om te branden in een band
voor alle objecten.

Brand waarde die
is uitgenomen uit
de “Z”-waarden
van het object
Optioneel

USE_Z [Booleaanse
waarde]
Standaard: False

Geeft aan dat een brandwaarde zou moeten
worden uitgenomen uit de “Z”-waarden van
het object. Werkt met punten en lĳnen
(lineaire interpolatie langs elk segment).
Voor polygonen werkt het alleen juist als
zĳ vlak zĳn (dezelfde Z-waarde voor alle
punten)

Eenheden grootte
uitvoerraster

UNITS [enumeratie]
Standaard: 0

Te gebruiken eenheden bĳ het definiëren
van de grootte/resolutie van het
uitvoerraster. Één van:

• 0 — Pixels
• 1 — Eenheden voor geoverwĳzingen

Vervolgt op volgende pagina
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Tabel 27.261 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Breedte/Horizontale
resolutie

WIDTH [getal]
Standaard: 0.0

Stelt de breedte in (als eenheden voor
grootte “Pixels” is) of de horizontale
resolutie (als eenheden voor grootte
“Eenheden voor geoverwĳzingen” is) voor
het uitvoerraster. Minimum waarde: 0.0.

Hoogte/Verticale
resolutie

HEIGHT [getal]
Standaard: 0.0

Stelt de hoogte in (als eenheden voor grootte
“Pixels” is) of de verticale resolutie (als
eenheden voor grootte “Eenheden voor
geoverwĳzingen” is) voor het uitvoerraster.

Uitvoer bereik
Optioneel

EXTENT [bereik] Bereik van de uitvoer rasterlaag. Als
het bereik niet is gespecificeerd, zal het
minimale bereik, dat de geselecteerde
verwĳzingsla(a)g(en) bedekt, worden
gebruikt.
Beschikbare methoden zĳn:

• Uit laag berekenen…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

Wĳs een
specifieke waarde
Geen data toe aan
de uitvoerbanden
Optioneel

NODATA [getal]
Standaard: 0.0

Wĳst een specifieke waarde Geen data toe
aan de uitvoerbanden

Gerasteriseerd OUTPUT [raster]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificatie van de uitvoerlaag. Één van:
• Opslaan als tĳdelĳk bestand
• Opslaan als bestand…

Voor Opslaan naar bestand
moet de indeling voor de uitvoer worden
gespecificeerd. Alle GDAL indelingen
voor raster worden ondersteund. Voor
Opslaan als tijdelijk bestand
zal de QGIS standaard indeling voor raster
worden gebruikt.
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Gevorderde parameters

Label Naam Type Beschrijving
Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’

Voor toevoegen van een of meer
opties voor het beheren van het te
maken bestand (kleuren, blokgrootte,
bestandsompressie…). Voor het
gemak kunt u vertrouwen op vooraf
gedefinieerde profielen (bekĳk :ref:` het
gedeelte over opties voor GDAL driver
<gdal_createoptions>`).
Voor Batch-processen en Modelontwerper:
scheid meerdere opties door een teken pipe
(|).

Type
uitvoergegevens

DATA_TYPE [enumeratie]
Standaard: 5

Definieert de indeling voor het
uitvoerraster.
Opties:

• 0 — Byte (8-bit unsigned integer
(quint8))

• 1 — Int16 (16-bit signed integer
(qint16))

• 2 — UInt16 (16-bit unsigned integer
(quint16))

• 3 — UInt32 (32-bit unsigned integer
(quint32))

• 4 — Int32 (32-bit signed integer
(qint32))

• 5 — Float32 (32-bit floating point
(float))

• 6 — Float64 (64-bit floating point
(double))

• 7 — CInt16 (Complex Int16)
• 8 — CInt32 (Complex Int32)
• 9 — CFloat32 (Complex Float32)
• 10 — CFloat64 (Complex Float64)

Beschikbare opties zĳn afhankelĳk van de
versie van GDAL die is ingebouwd in QGIS
(bekĳk menu Help ► Info)

Vooraf
initialiseren
van de uitgevoerde
afbeelding met
waarde
Optioneel

INIT [getal] Initialiseert vooraf de uitvoer
afbeeldingsbanden met deze waarde.
Niet gemarkeerd als de waarde Geen
gegevens in het uitvoerbestand. Dezelfde
waarde wordt in alle banden gebruikt.

Rasteriseren
omdraaien

INVERT [Booleaanse
waarde]
Standaard: False

Brandt de vaste brandwaarde, of de
brandwaarde die is geassocieerd met het
eerste object in alle delen van de afbeelding
die niet binnen de opgegeven polygoon
liggen.

Aanvullende
parameters
opdrachtregel
Optioneel

EXTRA [tekenreeks]
Standaard: ‘’

Extra GDAL opties voor opdrachtregel
toevoegen
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Uitvoer

Label Naam Type Beschrijving
Gerasteriseerd OUTPUT [raster] Uitvoer rasterlaag

Pythoncode

ID algoritme: gdal:rasterize

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

27.2.7 Vector geoprocessing

Buffer vectors

Maak buffers rondom de objecten van een vectorlaag.

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] De invoer vectorlaag
Geometry column
name

GEOMETRY [string]
Standaard:
‘geometrie’

De naam van de te gebruiken
geometriekolom van de invoerlaag

Bufferafstand DISTANCE [number]
Default: 10.0

Minimum: 0.0

Samensmelten op
attribuut
Optional

FIELD [tablefield: any]
Default: None

Te gebruiken veld voor samensmelten

Resultaten
samensmelten

DISSOLVE [boolean]
Default: False Indien ingesteld wordt het resultaat

ontbonden.
Indien er geen veld is ingesteld
voor ontbinden, worden alle buffers
ontbonden tot één object.

Produceer één
object voor elke
geometrie voor
alle soorten
collecties van
geometrie in het
bronbestand

EXPLODE_COLLECTIONS[boolean]
Default: False

Vervolgt op volgende pagina
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Tabel 27.262 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Buffer OUTPUT [vector: polygon]

Default: [Save
to temporary
file]

Specificeer de uitvoer bufferlaag. Één van:
• Save to a Temporary File
• Save to File…

Advanced parameters

Label Naam Type Beschrijving
Additional
creation options
Optional

OPTIONS [string]
Default: ‘’ (no
additional options)

Additional GDAL creation options.

Outputs

Label Naam Type Beschrijving
Buffer OUTPUT [vector: polygon] De uitvoer bufferlaag

Python code

ID algoritme: gdal:buffervectors

import processing
processing.run("algorithm_id", {parameter_dictionary})

The algorithm id is displayed when you hover over the algorithm in the Processing Toolbox. The parameter dictionary
provides the parameter NAMEs and values. See Processing algoritmes gebruiken vanaf de console for details on how
to run processing algorithms from the Python console.

Vector op bereik clippen

Verkleint een OGR-ondersteund vectorbestand tot een opgegeven bereik.
This algorithm is derived from the GDAL ogr2ogr utility.

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] De invoer vectorlaag

Vervolgt op volgende pagina
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Tabel 27.264 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Bereik clippen EXTENT [extent] Definieert het begrenzingsvak dat zou

moeten worden gebruikt voor het uitvoer
vectorbestand. Het moet zĳn gedefinieerd
in coördinaten voor het doel-CRS.
Available methods are:

• Calculate from layer…: uses extent
of a layer loaded in the current
project

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Use map canvas extent
• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Enter the coordinates as xmin,
xmax, ymin, ymax

Clipped (extent) OUTPUT [same as input]
Default: [Save
to temporary
file]

Specificeer de uitvoerlaag (geclipt). Één
van:

• Save to a Temporary File
• Save to File…

Advanced parameters

Label Naam Type Beschrijving
Additional
creation options
Optional

OPTIONS [string]
Default: ‘’ (no
additional options)

Additional GDAL creation options.
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Outputs

Label Naam Type Beschrijving
Clipped (extent) OUTPUT [same as input] De uitvoer (geclipte) laag. Standaard

indeling is “ESRI Shapefile”.

Python code

ID algoritme: gdal:clipvectorbyextent

import processing
processing.run("algorithm_id", {parameter_dictionary})

The algorithm id is displayed when you hover over the algorithm in the Processing Toolbox. The parameter dictionary
provides the parameter NAMEs and values. See Processing algoritmes gebruiken vanaf de console for details on how
to run processing algorithms from the Python console.

Vector op maskerlaag clippen

Verkleint een door GDAL ondersteunde vectorlaag met een polygoon maskerlaag.
This algorithm is derived from the GDAL ogr2ogr utility.

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] De invoer vectorlaag
Mask layer MASK [vector: polygon] Laag die moet worden gebruikt als bereik

om te clippen voor de invoer vectorlaag.
Clipped (mask) OUTPUT [same as input]

Default: [Save
to temporary
file]

De uitvoer (masker) laag. Één van:
• Save to a Temporary File
• Save to File…

Advanced parameters

Label Naam Type Beschrijving
Additional
creation options
Optional

OPTIONS [string]
Default: ‘’ (no
additional options)

Additional GDAL creation options.
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Outputs

Label Naam Type Beschrijving
Clipped (mask) OUTPUT [same as input] De uitvoer (masker) laag. Standaard

indeling is “ESRI Shapefile”.

Python code

ID algoritme: gdal:clipvectorbypolygon

import processing
processing.run("algorithm_id", {parameter_dictionary})

The algorithm id is displayed when you hover over the algorithm in the Processing Toolbox. The parameter dictionary
provides the parameter NAMEs and values. See Processing algoritmes gebruiken vanaf de console for details on how
to run processing algorithms from the Python console.

Dissolve

Smelt (combineer) geometrieën die dezelfde waarde voor een opgegeven attribuut / veld hebben samen. De
geometrieën voor de uitvoer zĳn meerdelig.

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] De samen te smelten invoerlaag
Veld voor
samensmelten
Optional

FIELD [tablefield: any] Het voor het samensmelten te gebruiken
veld van de invoerlaag

Geometry column
name

GEOMETRY [string]
Standaard:
‘geometrie’

De naam van de te gebruiken
geometriekolom van de invoerlaag voor
samensmelten.

Samengesmolten OUTPUT [same as input]
Default: [Save
to temporary
file]

Specify the output layer. One of:
• Save to a Temporary File
• Save to File…

Advanced parameters
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Label Naam Type Beschrijving
Produceer één
object voor elke
geometrie voor
alle soorten
collecties van
geometrie in het
bronbestand

EXPLODE_COLLECTIONS[boolean]
Default: False

Produceer één object voor elke geometrie
voor alle soorten collecties van geometrie in
het bronbestand

Attributen voor
invoer behouden

KEEP_ATTRIBUTES[boolean]
Default: False

Alle attributen uit de invoerlaag behouden

Ontbonden
objecten tellen

COUNT_FEATURES [boolean]
Default: False

Tel het aantal samengesmolten objecten en
neem dat op in de uitvoerlaag.

Oppervlakte
en omtrek van
samengesmolten
objecten
berekenen

COMPUTE_AREA [boolean]
Default: False Oppervlakte en omtrek van ontbonden

objecten berekenen
neem ze op in de uitvoerlaag

Min/max/som/gemiddelde
voor attribuut
berekenen

COMPUTE_STATISTICS[boolean]
Default: False

Bereken statistieken (min, max, som en
gemiddelde) voor de gespecificeerde
numerieke attributen en neem dat op in de
uitvoerlaag

Numerieke
attribuut om
statistieken mee te
berekenen
Optional

STATISTICS_ATTRIBUTE[tablefield:
numeric]

Het numerieke attribuut om statistieken
over te berekenen

Additional
creation options
Optional

OPTIONS [string]
Default: ‘’ (no
additional options)

Additional GDAL creation options.

Outputs

Label Naam Type Beschrijving
Samengesmolten OUTPUT [same as input]

De uitvoer meerdelige geometrie laag
(met ontbonden

geometrieën)

Python code

ID algoritme: gdal:dissolve

import processing
processing.run("algorithm_id", {parameter_dictionary})

The algorithm id is displayed when you hover over the algorithm in the Processing Toolbox. The parameter dictionary
provides the parameter NAMEs and values. See Processing algoritmes gebruiken vanaf de console for details on how
to run processing algorithms from the Python console.
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Verspringing boog

Verschuift lĳnen met een gespecificeerde afstand. Positieve afstanden verschuiven lĳnen naar links, en negatieve
afstanden zullen ze naar rechts verschuiven.

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: line] De invoer lĳnlaag
Geometry column
name

GEOMETRY [string]
Standaard:
‘geometrie’

De naam van de te gebruiken
geometriekolom van de invoerlaag

Afstand
verspringing
(naar linkerkant:
positief, naar
rechterkant:
negatief)

DISTANCE [number]
Default: 10.0

Verspringing boog OUTPUT [vector: line]
Default: [Save
to temporary
file]

Specificeer de uitvoer lĳnlaag. Één van:
• Save to a Temporary File
• Save to File…

Advanced parameters

Label Naam Type Beschrijving
Additional
creation options
Optional

OPTIONS [string]
Default: ‘’ (no
additional options)

Additional GDAL creation options.

Outputs

Label Naam Type Beschrijving
Verspringing boog OUTPUT [vector: line] De uitvoerlaag voor verspringing boog

Python code

ID algoritme: gdal:offsetcurve

import processing
processing.run("algorithm_id", {parameter_dictionary})

The algorithm id is displayed when you hover over the algorithm in the Processing Toolbox. The parameter dictionary
provides the parameter NAMEs and values. See Processing algoritmes gebruiken vanaf de console for details on how
to run processing algorithms from the Python console.
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Enkelzijdige buffer

Maakt een buffer aan één zĳde (rechts of links) van de lĳnen in een lĳn vectorlaag.

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: line] De invoer lĳnlaag
Geometry column
name

GEOMETRY [string]
Standaard:
‘geometrie’

De naam van de te gebruiken
geometriekolom van de invoerlaag

Bufferafstand DISTANCE [number]
Default: 10.0

Zĳde buffer BUFFER_SIDE [enumeration]
Default: 0

One of:
• 0 — Rechts
• 1 — Links

Samensmelten op
attribuut
Optional

FIELD [tablefield: any]
Default: None

Te gebruiken veld voor samensmelten

Alle resultaten
samensmelten

DISSOLVE [boolean]
Default: False Indien ingesteld wordt het resultaat

ontbonden.
Indien er geen veld is ingesteld
voor ontbinden, worden alle buffers
ontbonden tot één object.

Produceer één
object voor elke
geometrie voor
alle soorten
collecties van
geometrie in het
bronbestand

EXPLODE_COLLECTIONS[boolean]
Default: False

Enkelzĳdige
buffer

OUTPUT [vector: polygon]
Default: [Save
to temporary
file]

Specificeer de uitvoer bufferlaag. Één van:
• Save to a Temporary File
• Save to File…

Advanced parameters

Label Naam Type Beschrijving
Additional
creation options
Optional

OPTIONS [string]
Default: ‘’ (no
additional options)

Additional GDAL creation options.
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Outputs

Label Naam Type Beschrijving
Enkelzĳdige
buffer

OUTPUT [vector: polygon] De uitvoer bufferlaag

Python code

ID algoritme: gdal:onesidebuffer

import processing
processing.run("algorithm_id", {parameter_dictionary})

The algorithm id is displayed when you hover over the algorithm in the Processing Toolbox. The parameter dictionary
provides the parameter NAMEs and values. See Processing algoritmes gebruiken vanaf de console for details on how
to run processing algorithms from the Python console.

Punten langs lijnen

Maakt een punt op elke lĳn van een lĳn vectorlaag op een afstand van het begin. De afstand wordt opgegeven als een
fractie van de lengte van de lĳn.

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: line] De invoer lĳnlaag
Geometry column
name

GEOMETRY [string]
Standaard:
‘geometrie’

De naam van de te gebruiken
geometriekolom van de invoerlaag

Afstand vanaf
begin van de lĳn
weergegeven als
een fractie van de
lengte van de lĳn

DISTANCE [number]
Standaard: 0.5
(midden van de lĳn)

Punten langs lĳn OUTPUT [vector: point]
Default: [Save
to temporary
file]

Specificeer de uitvoer puntenlaag. Één van:
• Save to a Temporary File
• Save to File…
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Advanced parameters

Label Naam Type Beschrijving
Additional
creation options
Optional

OPTIONS [string]
Default: ‘’ (no
additional options)

Additional GDAL creation options.

Outputs

Label Naam Type Beschrijving
Points along line OUTPUT [vector: point] De uitvoer puntlaag

Python code

ID algoritme: gdal:pointsalonglines

import processing
processing.run("algorithm_id", {parameter_dictionary})

The algorithm id is displayed when you hover over the algorithm in the Processing Toolbox. The parameter dictionary
provides the parameter NAMEs and values. See Processing algoritmes gebruiken vanaf de console for details on how
to run processing algorithms from the Python console.

27.2.8 Vector diversen

Virtuele vector bouwen

Maakt een virtuele laag die een set vectorlagen bevat. De virtuele laag van uitvoer zal niet worden geopend in het
huidige project.
Dit algoritme is speciaal nuttig in het geval dat een ander algoritme meerdere lagen nodig heeft, maar slechts één vrt
accepteert waarin de lagen worden gespecificeerd.

Parameters

Label Naam Type Beschrijving
Invoer
databronnen

INPUT [vector: elke] [lĳst] Selecteer de vectorlagen die u wilt
gebruiken om de virtuele vector te bouwen

“Verenigd” VRT
maken

UNIONED [Booleaanse
waarde]
Standaard: False

Selecteren als u alle vectors wilt verenigen
tot één enkel bestand vrt

Virtuele vector OUTPUT [hetzelfde als
invoer]
Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer de uitvoerlaag die alleen de
duplicaten bevat. Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…
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Uitvoer

Label Naam Type Beschrijving
Virtuele vector OUTPUT [vector: elke] De uitvoer virtuele vector, gemaakt uit de

gekozen bronnen

Pythoncode

ID algoritme: gdal:buildvirtualvector

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

SQL uitvoeren

Voert een eenvoudige of complexe query met syntaxis van SQL uit op de bronlaag. Het resultaat van de query zal
worden toegevoegd als een nieuwe laag.
Dit algoritme is afgeleid van de GDAL ogr2ogr utility.

Parameters

Basis parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] OGR ondersteunde invoer vectorlaag
SQL-expressie SQL [tekenreeks] Definieert de query voor SQL, bĳvoorbeeld

SELECT * FROM my_table WHERE
name is not null.

SQL-dialect DIALECT [enumeratie]
Standaard: 0

Het te gebruiken dialect van SQL. Één van:
• 0 — Geen
• 1 — OGR SQL
• 2 — SQLite

Resultaat SQL OUTPUT [vector: elke] Specificatie van de uitvoerlaag. Één van:
• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Voor Opslaan naar bestand
moet de indeling voor de uitvoer worden
gespecificeerd. Alle GDAL indelingen
voor vector worden ondersteund. Voor
Opslaan als tijdelijk bestand
zal de standaard indeling voor uitvoer
vectorlaag worden gebruikt.
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Gevorderde parameters

Label Naam Type Beschrijving
Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’ (geen
aanvullende opties)

Aanvullende opties voor maken GDAL

Uitvoer

Label Naam Type Beschrijving
Resultaat SQL OUTPUT [vector: elke] Vectorlaag gemaakt door de query

Pythoncode

ID algoritme: gdal:executesql

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Naar PostgreSQL exporteren (beschikbare verbindingen)

Importeert vectorlagen in een database van PostgreSQL op basis van een beschikbare verbinding. De verbinding moet
eerder correct zĳn gedefinieerd. Zorg er voor dat de keuzevakken ‘Gebruikersnaam opslaan’ en ‘Wachtwoord opslaan’
zĳn geselecteerd. Dan kunt u het algoritme gebruiken.
Dit algoritme is afgeleid van de GDAL ogr2ogr utility.

Parameters

Label Naam Type Beschrijving
Database (naam
verbinding)

DATABASE [tekenreeks] De database van PostgreSQL waarmee
verbonden moet worden

Invoerlaag INPUT [vector: elke] OGR ondersteunde vectorlaag die naar de
database geëxporteerd moet worden

Vorm coderen
Optioneel

SHAPE_ENCODING [tekenreeks]
Standaard: ‘’

Stelt de toe te passen codering voor de
gegevens in

Vervolgt op volgende pagina
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Tabel 27.271 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Uitvoer type
geometrie

GTYPE [enumeratie]
Standaard: 0

Definieert het type geometrie voor de
uitvoer. Één van:

• 0 —
• 1 — NONE
• 2 — GEOMETRY
• 3 — POINT
• 4 — LINESTRING
• 5 — POLYGON
• 6 — GEOMETRYCOLLECTION
• 7 — MULTIPOINT
• 8 — MULTIPOLYGON
• 9 — MULTILINESTRING

Een CRS voor
uitvoer toewĳzen
Optioneel

A_SRS [crs]
Standaard: Geen

Definieert het CRS voor de uitvoer van de
tabel van de database

Opnieuw
projecteren naar
dit CRS bĳ uitvoer
Optioneel

T_SRS [crs]
Standaard: Geen

Projecteert opnieuw/transformeert naar dit
CRS bĳ uitvoer

Bron-CRS
overschrĳven
Optioneel

S_SRS [crs]
Standaard: Geen

Overschrĳft het CRS van de invoerlaag

Schema (naam
schema)
Optioneel

SCHEMA [tekenreeks]
Standaard: ‘public’

Definieert het schema voor de tabel van de
database

Tabel om te
exporteren (laat
leeg om laagnaam
te gebruiken)
Optioneel

TABLE [tekenreeks]
Standaard: ‘’

Definieert een naam voor de tabel die
zal worden geïmporteerd in de database.
Standaard is de naam van de tabel de naam
van het invoer vectorbestand.

Primaire sleutel
(nieuw veld)
Optioneel

PK [tekenreeks]
Standaard: ‘id’

Definieert welk attribuutveld de primaire
sleutel van de tabel van de database zal zĳn

Primaire sleutel
(bestaand veld,
gebruikt als
bovenstaande
optie leeg is)
Optioneel

PRIMARY_KEY [tabelveld: elk]
Standaard: Geen

Definieert welk attribuutveld in de
geëxporteerde laag de primaire sleutel van
de tabel van de database zal zĳn

Naam
geometriekolom
Optioneel

GEOCOLUMN [tekenreeks]
Standaard: ‘geom’

Definieert in welk attribuutveld van de
database de informatie over de geometrie
zal staan

Dimensies vector
Optioneel

DIM [enumeratie]
Standaard: 0 (2D)

Definieert of het te importeren
vectorbestand 2D- of 3D-gegevens heeft.
Één van:

• 0 — 2
• 1 — 3

Tolerantie
afstand voor
vereenvoudiging
Optioneel

SIMPLIFY [tekenreeks]
Standaard: ‘’

Definieert een afstand voor de tolerantie
voor de vereenvoudiging van de te
importeren vectorgeometrieën. Standaard
is er geen vereenvoudiging.

Vervolgt op volgende pagina
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Tabel 27.271 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Maximale afstand
tussen 2 knopen
(verdichten)
Optioneel

SEGMENTIZE [tekenreeks]
Standaard: ‘’

De maximale afstand tussen twee
knooppunten. Gebruikt om tussenliggende
punten te maken. Standaard is er geen
verdichting.

Objecten in
bereik selecteren
(gedefinieerd in
invoerlaag CRS)
Optioneel

SPAT [bereik]
Standaard: Geen

U kunt objecten selecteren uit een
opgegeven bereik die in de tabel voor
uitvoer zullen komen.
Beschikbare methoden zĳn:

• Uit laag berekenen…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

Invoerlaag met
behulp van
bovenstaand
(rechthoekig)
bereik clippen
Optioneel

CLIP [Booleaanse
waarde]
Standaard: False

De invoerlaag zal worden geclipt tot het
bereik dat u eerder hebt opgegeven

Objecten
selecteren
met behulp
van argument
voor SQL
“WHERE” (Bĳv:
column=”waarde”)
Optioneel

WHERE [tekenreeks]
Standaard: ‘’

Definieert met een SQL-argument
“WHERE” welke objecten op de invoerlaag
zouden moeten worden geselecteerd

“n” objecten
per transactie
groeperen
(Standaard:
2000)
Optioneel

GT [tekenreeks]
Standaard: ‘’

U kunt de invoerobjecten groeperen in
transacties waar n de grootte definieert.
Standaard beperkt n de grootte van de
transacties tot 20000 objecten.

Bestaande tabel
overschrĳven
Optioneel

OVERWRITE [Booleaanse
waarde]
Standaard: True

Als er in de database een tabel is met
dezelfde naam, en als deze optie is ingesteld
op True, zal de tabel worden overschreven.

Vervolgt op volgende pagina
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Tabel 27.271 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Aan bestaande
tabel toevoegen
Optioneel

APPEND [Booleaanse
waarde]
Standaard: False

Indien geselecteerd / True zullen de
vectorgegevens worden toegevoegd aan
een bestaande tabel. Nieuwe velden die
worden gevonden in de invoerlaag worden
genegeerd. Standaard zal een nieuwe tabel
worden gemaakt.

Aan bestaande
tabel en nieuwe
velden aan
bestaande tabel
toevoegen
Optioneel

ADDFIELDS [Booleaanse
waarde]
Standaard: False

Indien geactiveerd zullen de vectorgegevens
worden toegevoegd aan een bestaande tabel,
er zal geen nieuwe tabel worden gemaakt.
Nieuwe velden die worden gevonden in de
invoerlaag worden aan de tabel toegevoegd.
Standaard zal een nieuwe tabel worden
gemaakt.

Kolom-
/tabelnamen
niet wassen
Optioneel

LAUNDER [Booleaanse
waarde]
Standaard: False

Met deze optie kunt u het standaard gedrag
voorkomen (converteren van kolomnamen
naar kleine letters, verwĳderen van spaties
en andere ongeldige tekens).

Geen ruimtelĳke
index maken
Optioneel

INDEX [Booleaanse
waarde]
Standaard: False

Voorkomt dat een ruimtelĳke index voor
de tabel voor uitvoer zal worden gemaakt.
Standaard wordt een ruimtelĳke index
toegevoegd.

Doorgaan na
mislukking,
mislukte object
overslaan
Optioneel

SKIPFAILURES [Booleaanse
waarde]
Standaard: False

Bevorderen naar
Meerdelig
Optioneel

PROMOTETOMULTI [Booleaanse
waarde]
Standaard: True

Stelt type geometrie voor de objecten in de
uitvoertabel in op meerdelig

Breedte en precisie
van attributen
voor invoer
behouden
Optioneel

PRECISION [Booleaanse
waarde]
Standaard: True

Vermĳdt aanpassen van veldattributen om
te voldoen aan de invoergegevens

Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’ (geen
aanvullende opties)

Aanvullende opties voor maken GDAL

Uitvoer

Dit algoritme heeft geen uitvoer.

Pythoncode

ID algoritme: gdal:importvectorintopostgisdatabaseavailableconnections

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.
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Naar PostgreSQL exporteren (nieuwe verbinding)

Importeert vectorlagen in een database van PostgreSQL. Een nieuwe verbinding naar de database van PostGIS moet
zĳn gemaakt.
Dit algoritme is afgeleid van de GDAL ogr2ogr utility.

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] OGR ondersteunde vectorlaag die naar de

database geëxporteerd moet worden
Vorm coderen
Optioneel

SHAPE_ENCODING [tekenreeks]
Standaard: ‘’

Stelt de toe te passen codering voor de
gegevens in

Uitvoer type
geometrie

GTYPE [enumeratie]
Standaard: 0

Definieert het type geometrie voor de
uitvoer. Één van:

• 0 —
• 1 — NONE
• 2 — GEOMETRY
• 3 — POINT
• 4 — LINESTRING
• 5 — POLYGON
• 6 — GEOMETRYCOLLECTION
• 7 — MULTIPOINT
• 8 — MULTIPOLYGON
• 9 — MULTILINESTRING

Een CRS voor
uitvoer toewĳzen
Optioneel

A_SRS [crs]
Standaard: Geen

Definieert het CRS voor de uitvoer van de
tabel van de database

Opnieuw
projecteren naar
dit CRS bĳ uitvoer
Optioneel

T_SRS [crs]
Standaard: Geen

Projecteert opnieuw/transformeert naar dit
CRS bĳ uitvoer

Bron-CRS
overschrĳven
Optioneel

S_SRS [crs]
Standaard: Geen

Overschrĳft het CRS van de invoerlaag

Host
Optioneel

HOST [tekenreeks]
Standaard:
‘localhost’

Naam van de host van de database

Poort
Optioneel

PORT [tekenreeks]
Standaard: 5432

Poortnummer waar de database van
PostgreSQL naar luistert

Gebruikersnaam
Optioneel

USER [tekenreeks]
Standaard: ‘’

Gebruikersnaam die is gebruikt om in te
loggen op de database

Naam database
Optioneel

DBNAME [tekenreeks]
Standaard: ‘’

Naam van de database

Wachtwoord
Optioneel

PASSWORD [tekenreeks]
Standaard: ‘’

Wachtwoord dat hoort bĳ Gebruikersnaam
om te verbinden met de database

Schema (naam
schema)
Optioneel

SCHEMA [tekenreeks]
Standaard: ‘public’

Definieert het schema voor de tabel van de
database

Vervolgt op volgende pagina
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Tabel 27.272 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Tabelnaam,
laat leeg om
naam invoer te
gebruiken
Optioneel

TABLE [tekenreeks]
Standaard: ‘’

Definieert een naam voor de tabel die
zal worden geïmporteerd in de database.
Standaard is de naam van de tabel de naam
van het invoer vectorbestand.

Primaire sleutel
(nieuw veld)
Optioneel

PK [tekenreeks]
Standaard: ‘id’

Definieert welk attribuutveld de primaire
sleutel van de tabel van de database zal zĳn

Primaire sleutel
(bestaand veld,
gebruikt als
bovenstaande
optie leeg is)
Optioneel

PRIMARY_KEY [tabelveld: elk]
Standaard: Geen

Definieert welk attribuutveld in de
geëxporteerde laag de primaire sleutel van
de tabel van de database zal zĳn

Naam
geometriekolom
Optioneel

GEOCOLUMN [tekenreeks]
Standaard: ‘geom’

Definieert in welk attribuutveld de
informatie over de geometrie moet worden
opgeslagen

Dimensies vector
Optioneel

DIM [enumeratie]
Standaard: 0 (2D)

Definieert of het te importeren
vectorbestand 2D- of 3D-gegevens heeft.
Één van:

• 0 — 2D
• 1 — 3D

Tolerantie
afstand voor
vereenvoudiging
Optioneel

SIMPLIFY [tekenreeks]
Standaard: ‘’

Definieert een afstand voor de tolerantie
voor de vereenvoudiging van de te
importeren vectorgeometrieën. Standaard
is er geen vereenvoudiging.

Maximale afstand
tussen 2 knopen
(verdichten)
Optioneel

SEGMENTIZE [tekenreeks]
Standaard: ‘’

De maximale afstand tussen twee
knooppunten. Gebruikt om tussenliggende
punten te maken. Standaard is er geen
verdichting.

Objecten in
bereik selecteren
(gedefinieerd in
invoerlaag CRS)
Optioneel

SPAT [bereik]
Standaard: Geen

U kunt objecten selecteren uit een
opgegeven bereik die in de tabel voor
uitvoer zullen komen.
Beschikbare methoden zĳn:

• Uit laag berekenen…: gebruikt het
bereik van een laag die in het huidige
project is geladen

• Berekenen uit kaart afdruklay-
out…: gebruikt het bereik van een
afdruklay-out kaart-item in het
actieve project

• Berekenen uit Favoriete plaats…:
gebruikt het bereik van een
opgeslagen Favoriete plaats

• Huidige bereik van kaartvenster
gebruiken

• Tekenen in kaartvenster: klik en
sleep een rechthoek die het gebied
beperkt tot dat waarmee rekening
moet worden gehouden

• Voer de coördinaten in als xmin,
xmax, ymin, ymax

Vervolgt op volgende pagina
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Tabel 27.272 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Invoerlaag met
behulp van
bovenstaand
(rechthoekig)
bereik clippen
Optioneel

CLIP [Booleaanse
waarde]
Standaard: False

De invoerlaag zal worden geclipt tot het
bereik dat u eerder hebt opgegeven

Velden die
moeten worden
opgenomen (laat
leeg om alle velden
te gebruiken)
Optioneel

FIELDS [tekenreeks] [lĳst]
Standaard: []

Definieert te behouden velden uit het
geïmporteerde vectorbestand. Als niets is
geselecteerd zullen alle velden worden
geïmporteerd.

Objecten
selecteren
met behulp
van argument
voor SQL
“WHERE” (Bĳv:
column=”waarde”)
Optioneel

WHERE [tekenreeks]
Standaard: ‘’

Definieert met een SQL-argument
“WHERE” welke objecten zouden moeten
worden geselecteerd voor de tabel voor
uitvoer

“n” objecten
per transactie
groeperen
(Standaard:
2000)
Optioneel

GT [tekenreeks]
Standaard: ‘’

U kunt de invoerobjecten groeperen in
transacties waar n de grootte definieert.
Standaard beperkt n de grootte van de
transacties tot 20000 objecten.

Bestaande tabel
overschrĳven
Optioneel

OVERWRITE [Booleaanse
waarde]
Standaard: True

Als er in de database een tabel is met
dezelfde naam, en als deze optie is ingesteld
op True, zal de tabel worden overschreven.

Aan bestaande
tabel toevoegen
Optioneel

APPEND [Booleaanse
waarde]
Standaard: False

Indien geselecteerd / True zullen de
vectorgegevens worden toegevoegd aan
een bestaande tabel. Nieuwe velden die
worden gevonden in de invoerlaag worden
genegeerd. Standaard zal een nieuwe tabel
worden gemaakt.

Aan bestaande
tabel en nieuwe
velden aan
bestaande tabel
toevoegen
Optioneel

ADDFIELDS [Booleaanse
waarde]
Standaard: False

Indien geactiveerd zullen de vectorgegevens
worden toegevoegd aan een bestaande tabel,
er zal geen nieuwe tabel worden gemaakt.
Nieuwe velden die worden gevonden in de
invoerlaag worden aan de tabel toegevoegd.
Standaard zal een nieuwe tabel worden
gemaakt.

Kolom-
/tabelnamen
niet wassen
Optioneel

LAUNDER [Booleaanse
waarde]
Standaard: False

Met deze optie kunt u het standaard gedrag
voorkomen (converteren van kolomnamen
naar kleine letters, verwĳderen van spaties
en andere ongeldige tekens).

Geen ruimtelĳke
index maken
Optioneel

INDEX [Booleaanse
waarde]
Standaard: False

Voorkomt dat een ruimtelĳke index voor
de tabel voor uitvoer zal worden gemaakt.
Standaard wordt een ruimtelĳke index
toegevoegd.

Doorgaan na
mislukking,
mislukte object
overslaan
Optioneel

SKIPFAILURES [Booleaanse
waarde]
Standaard: False

Vervolgt op volgende pagina
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Tabel 27.272 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Bevorderen naar
Meerdelig
Optioneel

PROMOTETOMULTI [Booleaanse
waarde]
Standaard: True

Stelt type geometrie voor de objecten in de
uitvoertabel in op meerdelig

Breedte en precisie
van attributen
voor invoer
behouden
Optioneel

PRECISION [Booleaanse
waarde]
Standaard: True

Vermĳdt aanpassen van veldattributen om
te voldoen aan de invoergegevens

Aanvullende
opties voor maken
Optioneel

OPTIONS [tekenreeks]
Standaard: ‘’ (geen
aanvullende opties)

Aanvullende opties voor maken GDAL

Uitvoer

Dit algoritme heeft geen uitvoer.

Pythoncode

ID algoritme: gdal:importvectorintopostgisdatabasenewconnection

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

Vectorinformatie

Maakt een bestand met informatie dat de informatie vermeldt over een door OGR ondersteunde gegevensbron. De
uitvoer zal worden weergegeven in een venster ‘Resultaten’ en kan worden weggeschreven naar een HTML-bestand.
De informatie bevat het type geometrie, aantal objecten, het ruimtelĳke bereik, informatie over de projectie en nog
veel meer.
Dit algoritme is afgeleid van de GDAL ogrinfo utility.

Parameters

Label Naam Type Beschrijving
Invoerlaag INPUT [vector: elke] Invoer vectorlaag
Alleen uitvoer als
samenvatting
Optioneel

SUMMARY_ONLY [Booleaanse
waarde]
Standaard: True

Info over
metadata
onderdrukken
Optioneel

NO_METADATA [Booleaanse
waarde]
Standaard: False

Vervolgt op volgende pagina

27.2. GDAL algoritme provider 1523

https://gdal.org/programs/ogrinfo.html


QGIS Desktop 3.28 User Guide

Tabel 27.273 – Vervolgd van vorige pagina
Label Naam Type Beschrijving
Laaginformatie OUTPUT [html]

Standaard:
[Opslaan naar
tijdelijk
bestand]

Specificeer het HTML uitvoerbestand dat
de informatie uit het bestand bevat. Één van:

• Opslaan naar tĳdelĳk bestand
• Opslaan als bestand…

Als er geen HTML-bestand is gedefinieerd
zal de uitvoer worden weggeschreven naar
een tĳdelĳk bestand

Uitvoer

Label Naam Type Beschrijving
Laaginformatie OUTPUT [html] Het HTML uitvoerbestand dat de

informatie uit het bestand bevat.

Pythoncode

ID algoritme: gdal:ogrinfo

import processing
processing.run("algorithm_id", {parameter_dictionary})

Het ID voor het algoritme wordt weergegeven als u over het algoritme gaat met de muisaanwĳzer in de Toolbox
van Processing. Het woordenboek voor de parameters verschaft de NAME’s en waarden van de parameters. Bekĳk
Processing algoritmes gebruiken vanaf de console voor details over hoe algoritmes van Processing uit te voeren vanuit
de console voor Python.

27.3 OTB toepassingsprovider

OTB (Orfeo ToolBox) is een bibliotheek voor het verwerken van afbeeldingen voor gegevens van remote sensing.
Het verschaft ook toepassingen die functionaliteiten voor het verwerken van afbeeldingen. De lĳst met toepassingen
en hun documentatie zĳn beschikbaar in het OTB CookBook
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Plug-ins

28.1 QGIS-plugins

QGIS is ontworpen met een architectuur voor plug-ins. Dit maakt het toevoegen van nieuwe functionaliteit en functies
aan de toepassing eenvoudiger. Enkele van de mogelĳkheden in QGIS zĳn in feite geïmplementeerd als plug-ins.

28.1.1 Bron- en externe plug-ins

Plug-ins voor QGIS worden geïmplementeerd ofwel als bronplug-ins of als externe plug-ins.
Bronplug-insworden beheerd door het ontwikkelteam van QGIS en zĳ maken automatisch deel uit van elke distributie
van QGIS. Ze worden geschreven in één van de twee talen, C++ of Python.
De meeste externe plug-ins worden momenteel in Python geschreven. Zĳ worden ofwel opgeslagen in de ‘Officiële’
QGIS Repository op https://plugins.qgis.org/plugins/ of in externe opslagplaatsen en worden onderhouden door de
individuele auteurs. Gedetailleerde documentatie over het gebruik, minimale versie van QGIS, thuispagina, auteurs en
andere belangrĳke informatie wordt verschaft voor de ‘Officiële’ opslagplaats. Voor andere externe opslagplaatsen zou
documentatie beschikbaar kunnen zĳn in de externe plug-ins zelf. Over het algemeen is documentatie voor externe
plug-ins niet opgenomen in deze handleiding.

Ga, om een plug-in te installeren of te activeren, naar het menu Plug-ins en selecteer Plug-ins beheren en
installeren…. Geïnstalleerde externe plug-ins van Python worden geplaatst in de map python/plugins van het
pad van het actieve gebruikersprofiel.
Paden naar aangepaste bibliotheken voor plug-ins voor C++ mogen ook worden toegevoegd onder Extra ► Opties ►
Systeem.
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28.1.2 Het dialoogvenster Plug-ins

De tab Extra

Aan de onderzĳde van het linkerpaneel is de tab Extra de belangrĳkste plaats waar u kunt configureren welke
plug-ins mogen worden weergegegven in uw toepassing. U kunt de volgende opties gebruiken:

• Bĳ het opstarten op updates controleren. Wanneer een nieuwe plug-in of een bĳgewerkte plug-in beschikbaar
is, zal QGIS Elke keer als QGIS opstart, Een keer per dag, Elke 3 dagen, Elke week, Elke 2 weken of Elke maand.
informeren.

• Ook de experimentele plug-ins tonen. QGIS zal u plug-ins laten zien in een vroeg stadium van hun
ontwikkeling, die over het algemeen nog niet geschikt zĳn voor gebruik voor productie. Voor deze plug-ins
kunt u ofwel de stabiele of de experimentele versie installeren, en op elk moment schakelen tussen de een en
de ander.

• Ook niet meer onderhouden plug-ins tonen. Deze plug-ins worden meestal niet meer onderhouden omdat
ze functies in QGIS hebben vervangen, een gebrek aan ontwikkelaars, ze vertrouwen op functies die net langer
beschikbaar zĳn in QGIS…Ze zĳn over het algemeen niet geschikt voor gebruik voor productie en verschĳnen
grĳs in de lĳst plug-ins.

Standaard verschaft QGIS u in het gedeelte Plugin Repositories, zĳn officiële opslagplaats met de URL https:/
/plugins.qgis.org/plugins/plugins.xml?qgis=version (waar <version> de exacte versie
weergeeft die u gebruikt). Klik, om externe opslagplaatsen van auteurs toe te voegen, op Toevoegen… en vul in
het formulier Opslagplaatsen voor plug-ins een naam en de URL in. De URL mag van de types protocol http://
of file:// zĳn.
De standaard opslagplaats voor QGIS is een open opslagplaats en u heeft geen authenticatie nodig. U zou uw eigen
opslagplaats voor plug-ins kunnen maken en een authenticatie kunnen eisen (basisauthenticatie, PKI). U kunt meer
informatie voor ondersteuning voor authenticatie voor QGIS vinden in het hoofdstuk Authenticatie.
Als u één of meer van de toegevoegde opslagplaatsen niet meer wilt, kunnen zĳ worden uitgeschakeld op de tab Extra
via de knop Bewerken…, of volledig worden verwĳderd met de knop Verwĳderen.

Fig. 28.1: De tab Extra
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Bladeren door de plug-ins

De tabs

De bovenste tabs in het dialoogvenster Plug-ins verschaft u een lĳst met lĳsten van plug-in, gebaseerd op hun status
van installeren, maken of updaten. Afhankelĳk van de instellingen voor de plug-ins, kunnen de beschikbare tabs zĳn:

• Alles: geeft alle beschikbare plug-ins in de ingeschakelde opslagplaatsen weer

• Geïnstalleerd: geeft zowel de plug-ins weer die u hebt geïnstalleerd als de plug-ins van de bron die standaard
zĳn geïnstalleerd en die u niet kunt verwĳderen

• Niet geïnstalleerd: geeft niet geïnstalleerde of nog niet geïnstalleerde plug-ins in de ingeschakelde
opslagplaatsen weer

• Nieuw: geeft de plug-ins weer die zĳn uitgegeven na de laatste Bĳ het opstarten op updates controleren

• Op te waarderen: geeft geïnstalleerde plug-ins weer die een meer recente versie hebben gepubliceerd in de
opslagplaats

• Ongeldig: geeft alle geïnstalleerde plug-ins weer die momenteel defect zĳn om welke reden dan ook
(ontbrekende afhankelĳkheid, fouten bĳ lagen, niet compatibele functies met versie van QGIS…)

Aan de bovenzĳde van de tabs helpt een functie Zoeken u te zoeken naar elke plug-in die informatie voor metadata
gebruikt (auteur, naam, beschrĳving, tag,…).

Fig. 28.2: Zoeken naar een plug-in vanaf de tab Alles

28.1. QGIS-plugins 1527



QGIS Desktop 3.28 User Guide

De plug-ins

Selecteer een plug-in en u zult enige metadata zien weergegeven in het rechter paneel:
• informatie over of de plug-in experimenteel is of een experimentele versie beschikbaar heeft (als Ook de

experimentele plug-ins tonen is geselecteerd)
• overzicht en beschrĳving
• aantal stemmen (u kunt op uw voorkeurs-plug-in stemmen!)
• tags
• enkele handige koppelingen zoals de thuispagina, tracker en opslagplaats van de code
• auteur(s)
• beschikbare versie(s) met een link naar de pagina om te downloaden in de opslagplaats, of pad naar lokale map
voor geïnstalleerde plug-ins

Het dialoogvenster Plug-ins installeren en beheren stelt u in staat te interacteren met de laatste versie van de plug-ins.
Indien ingeschakeld kan de experimentele versie alleen worden weergegeven als die meer recent is dan de laatste
stabiele versie. Afhankelĳk van de actieve tab, of de geselecteerde plug-in is geïnstalleerd, zult u enkele van de
volgende opties worden aangeboden:

• Installeren: installeert de laatste stabiele versie van de geselecteerde plug-in
• Experimental plug-in installeren: installeert de experimentele versie van de geselecteerde plug-in
• Plug-in opnieuw installeren: installeert dezelfde stabiele versie van de plug-in, bĳv. nadat het laden ervan was
mislukt

• Experimentele plug-in opnieuw installeren: installeert dezelfde experimentele versie van de plug-in, bĳv. nadat
het laden ervan was mislukt

• Plug-in bĳwerken: upgradet de geselecteerde plug-in naar zĳn laatste stabiele versie
• Experimentele plug-in bĳwerken: upgradet de geselecteerde plug-in naar zĳn experimentele versie
• Alles opwaarderen: upgradet alle geïnstalleerde plug-ins naar hun meer recente stabiele of experimentele versie
(afhankelĳk of hun eerder geïnstalleerde versie stabiel of experimenteel was).

• Plug-in afwaarderen: vervangt de experimentele versie van de plug-in naar zĳn eerdere stabiele versie
• Experimentele plug-in afwaarderen: vervangt een experimentele versie van de plug-in naar zĳn laatst
gepubliceerde experimentele versie. Dit zou kunnen gebeuren bĳ het experimenteren met een nog niet
gepubliceerde versie.

• Plug-in de-installeren: verwĳdert de geïnstalleerde plug-in uit het gebruikersprofiel

Een geïnstalleerde plug-in geeft een keuzevak weer aan zĳn linkerkant. Deselecteer die om de plug-in tĳdelĳk uit
te schakelen.
Klik met rechts op een plug-in in de lĳst en u zult de lĳst met plug-ins kunnen sorteren op verschillende metadata.
De nieuwe volgorde is van toepassing op alle tabs. Opties voor sorteren zĳn:

• Sorteren op naam

• Sorteren op downloads

• Sorteren op aantal stemmen

• Sorteren op status

• Sorteren op by Datum gemaakt

• Sorteren op by Datum bĳgewerkt

1528 Hoofdstuk 28. Plug-ins



QGIS Desktop 3.28 User Guide

Tab Installeren vanuit ZIP

De tab Installeren vanuit ZIP verschaft een widget bestandsselectie om plug-ins te importeren in een ingepakte
indeling, bĳv. plug-ins die direct zĳn gedownload uit hun opslagplaats. Versleutelde bestanden worden ondersteund.

Fig. 28.3: De tab Installeren vanuit ZIP

28.2 QGIS bronplug-ins gebruiken

28.2.1 Plug-in DB Manager

De plug-in DB Manager is bedoeld als hoofdgereedschap om alle indelingen van ruimtelĳke databases die worden
ondersteund door QGIS (PostGIS, SpatiaLite, GeoPackage, Oracle Spatial, Virtuele lagen) in één gebruikersinterface
te integreren en te beheren. De plug-in DB Manager verschaft verschillendemogelĳkheden. U kunt lagen uit de QGIS
Browser in de DB Manager slepen en het zal uw laag in uw ruimtelĳke database importeren. U kunt tabellen tussen
ruimtelĳke databases slepen en neerzetten en zĳ zullen worden geïmporteerd.
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Fig. 28.4: Dialoogvenster DB Manager

Het menu Database stelt u in staat te verbinden met een bestaande database, het venster SQL te starten en de plug-in
DBManager te verlaten. Als u eenmaal verbonden bent met een bestaande database verschĳnen aanvullend de menu’s
Schema (relevant voor DBMS-en, zoals PostGIS / PostgreSQL) en Tabel.
Het menu Schema bevat gereedschappen om schema’s te maken en te verwĳderen (alleen lege) en, indien topologie
beschikbaar is (bĳv., PostGIS topologie), een TopoViewer te starten.
Het menu Tabel stelt u in staat tabellen te maken en te verwĳderen en tabellen en views te bewerken. Het is
ook mogelĳk om tabellen leeg te maken en tabellen tussen schema’s te verplaatsen. U kunt Vacuum uitvoeren
voor de geselecteerde tabel. Vacuum verzamelt eenvoudigweg niet gebruikte ruimte en maakt die beschikbaar voor
hergebruik, en analyze werkt statistieken bĳ die worden gebruikt om de meest efficiënte manier te bepalen om een
query uit te voeren.Wĳzigingen loggen… stelt u in staat ondersteuning voor het loggen van wĳzigingen toe te voegen
aan een tabel. Tenslotte kunt u Laag/Bestand importeren… en Naar bestand exporteren….

Notitie: Met de DB Manager is het mogelĳk om opmerkingen toe te voegen aan tabellen en kolommen van een
database van PostgreSQL.

Het venster Providers vermeldt alle bestaande databases die worden ondersteund door QGIS. Met een dubbelklik
kunt u met de database verbinden. Met de rechter muisknop kunt u bestaande schema’s en tabellen hernoemen en
verwĳderen. Tabellen kunnen ook aan het kaartvenster van QGIS worden toegevoegd met het contextmenu.
Indien verbonden met een database biedt het hoofd venster van de DB Manager vier tabs. De tab Info verschaft
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informatie over de tabel en de geometrie daarvan, als ook over bestaande velden, voorwaarden en indexen. Het stelt
u in staat om een ruimtelĳke index te maken voor de geselecteerde tabel. De tab Tabel geeft de tabel weer en de tab
Voorbeeld rendert de geometrieën als voorbeeld. Wanneer u een SQL-venster opent, zal het in een nieuwe tab worden
geplaatst.

Met het venster SQL werken

U kunt de DB Manager gebruiken om query’s van SQL uit te voeren op uw ruimtelĳke database. Query’s kunnen
worden opgeslagen en geladen, en daar zal de SQL-querybouwer u helpen bĳ het formuleren van uw query’s. U kunt
zelfs de ruimtelĳke uitvoer bekĳken door Als nieuwe laag laden te selecteren en Kolom(men met unieke waarden
(ID’s) , Geometriekolom en Laagnaam (voorvoegsel) specificeren. Het is mogelĳk om een gedeelte van de SQL te
accentueren en alleen dat gedeelte uit te voeren als u op Ctrl+R drukt of klikt op de knop Uitvoeren.
De knop Querygeschiedenis slaat de laatste 20 query’s van elke database en provider op.
Dubbelklikken op een item zal de tekenreeks toevoegen aan het venster van SQL.

Fig. 28.5: SQL-query’s in het SQL-venster van DB Manager uitvoeren

Notitie: Het venster SQL kan ook worden gebruikt om Virtuele lagen te maken. Selecteer in dat geval, in plaats van
een database, Project-lagen onder Virtuele Lagen vóór het openen van het venster SQL. Zie Virtuele lagen maken
voor instructies over de te gebruiken syntaxis voor SQL.
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28.2.2 Plug-in Geometrieën controleren

Geometrieën controleren is een krachtige bronplug-in om de geldigheid van een geometrie op een laag te controleren
en te repareren. Het is beschikbaar in het menu Vector ( Geometrieën controleren…).

De controles configureren

Het dialoogvenster Geometrieën controleren geeft verschillende gegroepeerde instellingen weer op de eerste tab (Set-
up):

• Invoer vectorlaag: om de lagen te selecteren die gecontroleerd moeten worden. Het keuzevak Alleen
geselecteerde objecten kan worden gebruikt om het controleren van de geometrieën te beperken tot de
geselecteerde objecten.

• Toegestane typen geometrie geeft u de mogelĳkheid om het type geometrie voor de invoerla(a)g(en) te beperken
tot:

– Punt

– Multipunt

– Lĳn

– Multilĳn

– Polygoon

– Multipolygoon
• Geldigheid geometrie. Afhankelĳk van de types geometrie kunt u kiezen uit:

– Zelf kruisend

– Duplicaat knopen

– Eigen contacten

– Polygoon met minder dan 3 knopen.
• Eigenschappen geometrieën. Afhankelĳk van de types geometrie kunt u kiezen uit:

– Polygonen en multipolygonen mogen geen gaten bevatten

– Meerdelige objecten moeten bestaan uit meer dan één deel

– Lĳnen moeten geen uitschieters hebben

• Voorwaarden geometrie. Stelt u in staat enkele voorwaarden toe te voegen om de geometrieën te valideren met:

– Minimale lengte segment (kaarteenheden)

– Minimum hoek tussen segmenten (graden)

– Minimale gebied polygoon (vierkante kaarteenheden)

– Geen splinters polygonen met een Maximale dikte en een Max. gebied (vierkante
kaarteenheden)

• Controles topologie. Afhankelĳk van de types geometrie, zĳn veel verschillende opties beschikbaar:

– Controle op duplicaten

– Controle op objecten binnen andere objecten
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– Controle op overlap kleiner dan

– Controle op gaten kleiner dan

– Punten moeten zĳn bedekt door lĳnen

– Punten moeten netjes binnen een polygoon liggen

– Lĳnen moeten niet kruisen met andere lĳnen

– Lĳnen moeten niet kruisen met objecten op de laag

– Polygonen moeten grenzen van de laag volgen

• Tolerantie. U kunt de tolerantie voor de controles definiëren in kaarteenheden.
• Uitvoervectorlagen geeft de keuzes:

– Invoerlagen aanpassen

– Nieuwe lagen maken

Wanneer u tevreden bent met de configuratie, kunt u op de knop Uitvoeren drukken.
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Fig. 28.6: De plug-in Geometrieën controleren

De plug-in Geometrieën controleren kan de volgende fouten vinden:
• Zelf kruisend: een polygoon die zichzelf kruist
• Duplicaat knopen: twee duplicaat knopen in een segment
• Gaten: gat in een polygoon
• Lengte segment: een lengte van het segment die kleiner is dan een drempelwaarde
• Minimum hoek: twee segmenten met een hoek die kleiner is dan een drempelwaarde
• Minimum gebied: gebied van polygoon is kleiner dan een drempelwaarde
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• Splinter polygoon: deze fout komt uit bĳzonder kleine polygonen (met een klein gebied) met een grote omtrek
• Duplicaten van objecten
• Object binnen object
• Overlap: overlappende polygonen
• Gaten: gaten tussen polygonen

De volgende afbeelding toont de verschillende controles die worden uitgevoerd door de plug-in.

Fig. 28.7: Enkele controles die worden ondersteund door de plug-in

De resultaten analyseren

De resultaten verschĳnen op de tweede tab (Resultaat) en als een overzichtslaag van de fouten in het kaartvenster (de
naam heeft het standaard voorvoegsel checked_). Een tabel vermeld de Resultaat Geometrie controleren met één
fout per rĳ en kolommen die bevatten: de laagnaam, een ID, het type fout, dan de coördinaten van de fout, een waarde
(afhankelĳk van het type fout) en tenslotte de kolom met de oplossing die de oplossing voor de fout aangeeft. Aan
de onderzĳde van de tabel kunt u de fout Exporteren naar verschillende bestandsindelingen. U heeft ook een telling
voor het totale aantal fouten en gerepareerde.
U kunt een rĳ selecteren om de locatie van de fout te zien. U kunt dit gedrag wĳzigen door een andere actie te
selecteren uit Fout (standaard), Object, Niet verplaatsen, en Geselecteerde objecten accentueren.
Onder de actie Zoomen bĳ het klikken op de rĳ kunt u:

• Geselecteerde objecten in attributentabel weergeven

• Geselecteerde fouten repareren met standaardoplossing
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• Geselecteerde fouten repareren, prompt voor methode van oplossing. U zult een venster zien waarin u de
methode voor de oplossing kunt kiezen, waaronder:

– Samenvoegen met naastgelegen polygoon met langste gedeelde rand
– Samenvoegen met naastgelegen polygoon met grootste gebied
– Samenvoegen met naastgelegen polygoon met identieke waarde voor attribuut, als die er is, of laat zoals
het is

– Object verwĳderen
– Geen actie

• Instellingen oplossen fouten stelt u in staat de standaardmethode voor het oplossen te wĳzigen, afhankelĳk
van het type fout

Tip: Meerdere fouten repareren
U kunt meerdere fouten repareren door meer dan één rĳ te selecteren in de tabel met de actie CTRL + klik.

Tenslotte kunt u nog kiezen Te gebruiken attribuut bĳ samenvoegen van objecten op waarde van een attribuut.

28.2.3 MetaSearch Catalog Client

Introductie

MetaSearch is een plug-in voor QGIS om te werken met metadata catalogus services, die zowel de standaarden OGC
API - Records als OGC Catalog Service voor het web (CSW) ondersteunen.
MetaSearch verschaft een eenvoudige en intuïtieve benadering en gebruikersvriendelĳke interface om catalogussen
met metadata te doorzoeken binnen QGIS.

Fig. 28.8: Zoeken en resultaten van services in MetaSearch
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Werken met Metadata-catalogussen in QGIS

MetaSearch is standaard opgenomen in QGIS, met al zĳn afhankelĳkheden, en kan worden ingeschakeld vanuit Plug-
ins beheren en installeren in QGIS.

OGC API - Records

OGC API - Records is een OGC (Open Geospatial Consortium) standaard voor het ontdekken van georuimtelĳke
bronnen op het web.

CSW (Catalog Service for the Web)

CSW (Catalog Service for the Web) is een OGC (Open Geospatial Consortium) specificatie die algemene interfaces
definieert om metadata over gegevens, services, en andere potentiële bronnen te ontdekken, door te bladeren en te
bevragen.

Opstarten

Klik op het pictogram of selecteerWeb►MetaSearch►MetaSearch in het hoofdmenu vanQGIS omMetaSearch
op te starten. Het dialoogvenster MetaSearch zal verschĳnen. De GUI bestaat uit drie tabs: Services, Zoek en
Instellingen.
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Catalogus-services beheren

Fig. 28.9: Catalogus-services beheren

De tab Services stelt de gebruiker in staat alle beschikbare catalogus-services te beheren. MetaSearch verschaft een
standaard lĳst van Catalogus-services, die kunnen worden toegevoegd door op de knop Standaard services toevoegen
te drukken.
Klik op het keuzevak voor selecteren om alle vermelde items voor Catalog Service te zoeken.
Een item Catalog Service toevoegen:

1. Klik op de knop Nieuw

2. Voer een Naam in voor de service, als ook de URL (eindpunt). Onthoud dat voor OGC CSW 2.0.2 Catalogs,
alleen de basis-URL is vereist (geen volledige GetCapabilities-URL). Voor OGC API - Records Catalogs zou
de URL het pad naar het eindpunt van de collectie moeten zĳn
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3. Als de Catalog authenticatie vereist, voer dan de van toepassing zĳnde gegevens voor Gebruikersnaam en
Wachtwoord in.

4. Klik op OK om de service aan de lĳst met items toe te voegen.
Een bestaand item Catalog Service bewerken:

1. Selecteer het item dat u wilt bewerken
2. Klik op de knop Bewerken

3. En pas de waarden voor Naam of URL aan
4. Klik op OK.

Selecteer, om een item Catalogus-service te verwĳderen, het item dat u wilt verwĳderen en klik op de knop
Verwĳderen. U zult worden gevraagd het verwĳderen te bevestigen.
MetaSearch staat het laden en opslaan van verbindingen naar een XML-bestand toe. Dit is handig wanneer u
instellingen tussen toepassingen moet delen. Hieronder staat een voorbeeld van de bestandsindeling XML.

<?xml version="1.0" encoding="UTF-8"?>
<qgsCSWConnections version="1.0">

<csw type="OGC CSW 2.0.2" name="Data.gov CSW" url="https://catalog.data.gov/
↪→csw-all"/>

<csw type="OGC CSW 2.0.2" name="Geonorge - National CSW service for Norway"␣
↪→url="https://www.geonorge.no/geonetwork/srv/eng/csw"/>

<csw type="OGC CSW 2.0.2" name="Geoportale Nazionale - Servizio di ricerca␣
↪→Italiano" url="http://www.pcn.minambiente.it/geoportal/csw"/>

<csw type="OGC CSW 2.0.2" name="LINZ Data Service" url="http://data.linz.govt.
↪→nz/feeds/csw"/>

<csw type="OGC CSW 2.0.2" name="Nationaal Georegister (Nederland)" url="http://
↪→www.nationaalgeoregister.nl/geonetwork/srv/eng/csw"/>

<csw type="OGC CSW 2.0.2" name="RNDT - Repertorio Nazionale dei Dati␣
↪→Territoriali - Servizio di ricerca" url="http://www.rndt.gov.it/RNDT/CSW"/>

<csw type="OGC CSW 2.0.2" name="UK Location Catalogue Publishing Service" url=
↪→"http://csw.data.gov.uk/geonetwork/srv/en/csw"/>

<csw type="OGC CSW 2.0.2" name="UNEP/GRID-Geneva Metadata Catalog" url="http://
↪→metadata.grid.unep.ch:8080/geonetwork/srv/eng/csw"/>
</qgsCSWConnections>

Een lĳst met items laden:
1. Klik op de knop Laden. Een nieuw venster zal openen.
2. Klik op de knop Bladeren en navigeer naar het XML-bestand met items dat u wilt laden.
3. Klik op Openen. De lĳst met items zal worden weergegeven.
4. Selecteer de items die u uit de lĳst wilt toevoegen en klik op Laden.

Klik op de knop Service Info om informatie over de geselecteerde Catalog Service weer te geven, zoals een identificatie
voor de service, service provider en contactinformatie. Als u het ruwe antwoord in XML API wilt bekĳken, klik op
de knop Antwoord van Ruwe API. Een afzonderlĳk venster zal openen dat de informatie van de server in de indeling
ruwe JSON of XML weergeeft.
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Zoeken in Catalogus-services

Fig. 28.10: Zoeken in Catalogus-services

De tab Zoeken stelt de gebruiker in staat Catalogus-services te bevragen op gegevens en services, verschillende
zoekparameters in te stellen en resultaten te bekĳken.
De volgende parameters voor het zoeken zĳn beschikbaar:

• Sleutelwoorden: vrĳe tekst sleutelwoorden om te zoeken;
• Van: de Catalogus-service die bevraagd moet worden
• Kaartbereik: het ruimtelĳk gebied waarop gefilterd moet worden, gedefinieerd door Xmax, Xmin, Ymax, en

Ymin. Klik op Stel globaal in om een globale zoekactie uit te voeren, klik op Kaartbereik om een zoekactie uit
te voeren in het zichtbare gebied of voer handmatig de waarden in.

Klikken op de knop Zoek zal de geselecteerde Metadata Catalog doorzoeken. Zoekresultaten worden weergegeven in
een lĳst en kunnen worden gesorteerd door op de kolomkop te klikken. U kunt door de zoekresultaten navigeren met
de richtingsknoppen onder de zoekresultaten.
Selecteer een resultaat en:

• Klik op de knop Zoekresultaten als ruwe API antwoord weergeven om een venster te openen met het antwoord
van de service in de indeling ruwe JSON of XML.
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• Als het record van de metadata een geassocieerd begrenzingsvak heeft, zal een voetafdruk van het
begrenzingsvak worden weergegeven op de kaart.

• Dubbelklik op het record om de metadata van het record weer te geven met geassocieerde koppelingen voor
toegang. Klikken op een koppeling opent de koppeling in de webbrowser van de gebruiker.

• Als het record een ondersteunde webservice (WMS/WMTS, WFS, WCS, ArcGIS REST Service, etc.) is, zal
de knopGegevens toevoegenworden ingeschakeld. Bĳ het klikken op deze knop zalMetaSearch verifiëren of dit
een geldig OWS is. De service zal dan worden toegevoegd aan de van toepassing zĳnde lĳst met verbindingen
in QGIS, en het toepasselĳke dialoogvenster voor de verbinding zal verschĳnen.

Fig. 28.11: Metadata record weergeven
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Instellingen

Fig. 28.12: Instellingen voor MetaSearch

U kunt MetaSearch fĳn afstemmen met de volgende Instellingen:
• Server time-out: bĳ het doorzoeken van metadata catalogi, het aantal seconden voor het blokkeren van de
verbindingspoging. Standaardwaarde is 10.

• Verificatie SSL uitschakelen: optie om verificatie van SSLK uit te schakelen.
• Resultaten van aanroepen: bĳ het doorzoeken van metadata catalogi, het aantal resultaten om per pagina weer
te geven. Standaardwaarde is 10.
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Catalog Server-fouten

In sommige gevallen zal de Catalog werken in een webbrowser, maar niet in MetaSearch. Dat kan zĳn vanwege
de configuratie/instellingen van de Catalog-server. Providers van Catalog-server zouden er voor moeten zorgen dat
URL’s consistent en up to date zĳn in hun configuratie (dit komt veel voor in HTTP -> HTTPS-scenario’s voor
doorsturen). Bekĳk het pycsw FAQ item voor een uitgebreidere uitleg van het probleem en de oplossing. Hoewel het
FAQ-item specifiek voor pycsw is, kan het in het algemeen ook van toepassing zĳn op andere Catalog-servers.

28.2.4 Plug-in Offline bewerken

Voor het verzamelen van gegevens is het een veel voorkomende situatie om offline in het veld te werken met een
laptop of een mobiele telefoon. Bĳ het terugkeren op het netwerk dienen de wĳzigingen te worden gesynchroniseerd
met het hoofd-gegevensbron (bĳv. een database van PostGIS). Als verschillende personen tegelĳkertĳd op dezelfde
gegevensset werken, is het moeilĳk om bewerkingen met de hand samen te voegen, zelfs als mensen niet dezelfde
objecten wĳzigen.

De plug-in Offline bewerken automatiseert het synchroniseren door de inhoud van de databron te kopiëren naar een
database van SpatiaLite of GeoPackage en de offline bewerkingen op te slaan in toegewezen tabellen. Nadat opnieuw
is verbonden met het netwerk, is het mogelĳk de offline bewerkingen door te voeren naar de hoofd-gegevensset.
De plug-in gebruiken:

1. Open een project met enkele vectorlagen (bĳv. uit een Esri Shapefile, PostGIS- of WFS-T-databron).
2. Er van uitgaande dat u de plug-in al ingeschakeld hebt (zie Bron- en externe plug-ins), ga naar Database ►

Offline bewerken ► Converteer naar offline project. Het dialoogvenster voor eponiemen opent.
3. Selecteer het Type opslag. Het kan het type voor database GeoPackage of SpatiaLite zĳn.
4. Gebruik de knop Bladeren om de locatie van de database an te geven waarin deOffline gegevensmoeten worden

opgeslagen. Het kan een bestaand bestand zĳn of een nieuw te maken.
5. Selecteer, in het gedeelte Externe lagen selecteren, de lagen die u wilt opslaan. De inhoud van de lagen wordt

opgeslagen naar tabellen van de database.

Notitie: Omdat indelingen van de doeldatabase geen eigen ondersteuning voor lĳsten hebben, transformeert
de plug-in Offline bewerken {string, number} lĳstvelden naar velden tekenreeks, waarbĳ de waarden worden
gescheiden door komma’s. Dit maakt het lezen en bewerken van de inhoud van deze velden mogelĳk indien
offline.
Als u zowel het veld uit de originele laag als dat van de offline-laag zou willen afhandelen, kunt u vertrouwen
op de expressiefuncties try() en array, bĳv.:

try(array_contains("field",1),array_contains(string_to_array("field"),1))

6. U kunt selecteren Alleen geselecteerde objecten synchroniseren als er een selectie aanwezig iswat het mogelĳk
maakt om alleen met een subset te werken en op te slaan. Het kan onbetaalbaar zĳn in het geval van hele grote
lagen.
Dat is alles!

7. Sla uw project op en breng het naar het veld.
8. Bewerk de lagen offline.

9. Upload, na opnieuw te zĳn verbonden, de wĳzigingen via Database► Offline bewerken► Synchroniseren.

Notitie: Lagen die offline worden gebruikt zĳn gemarkeerd met het pictogram in het paneel Lagen.
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Fig. 28.13: Een offline project aanmaken
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28.2.5 Plug-in Topologie Checker

Fig. 28.14: De plug-in Topologie Checker

Topologie beschrĳft de relaties tussen punten, lĳnen en polygonen die de objecten vertegenwoordigen van een
geografische regio.Met de plug-in Topologie Checker kunt u uw vectorbestanden nakĳken en de topologie controleren
door middel van verschillende regels voor de topologie. Deze regels controleren met ruimtelĳke relaties of uw
objecten ‘Equal’, ‘Contain’, ‘Cover’, ‘CoveredBy’, ‘Cross’ zĳn, ‘Disjoint’, ‘Intersect’, ‘Overlap’, ‘Touch’ zĳn of ‘Within’
elkaar liggen. Het is afhankelĳk van uw individuele vragen welke regels voor topologie uw wilt toepassen op uw
vectorgegevens (bĳv:, normaal gesproken zult u geen uitschieters in lĳnlagen accepteren, maar als zĳ doodlopende
straten weergeven wilt u ze niet verwĳderen uit uw vectorlaag).
QGIS heeft een ingebouwde mogelĳkheid voor het bewerken van topologie, die geweldig is voor het maken van
nieuwe objecten zonder fouten. Maar bestaande gegevensfouten en door de gebruiker geïntroduceerde fouten zĳn
moeilĳk te vinden. Deze plug-in helpt u dergelĳke fouten te vinden met behulp van een lĳst met regels.
Het is zeer eenvoudig om regels voor topologie te maken met behulp van de plug-in Topologie Checker.
Voor puntlagen zĳn de volgende regels beschikbaar:

• Moet zĳn bedekt door: Hier kunt u een vectorlaag kiezen uit uw project. Punten die niet zĳn bedekt door de
opgegeven vectorlaag verschĳnen in het veld ‘Fout’.

• Moet zĳn bedekt door eindpunten van: Hier kunt u een lĳnlaag kiezen uit uw project.
• Moet liggen binnen: Hier kunt u een polygoonlaag kiezen uit uw project. De punten moeten binnen een
polygoon liggen. Anders schrĳft QGIS een ‘Fout’ voor het punt.

• Moet geen duplicaten hebben: Wanneer een punt twee of meer malen wordt weergegeven, zal het verschĳnen
in het veld ‘Fout’.

• Moet geen ongeldige geometrieën hebben: Controleert of de geometrieën geldig zĳn.
• Moet geen geometrieën met meerdere delen hebben: Alle punten die bestaan uit meerdere delen worden
weggeschreven naar het veld ‘Fout’.
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Voor lĳnlagen zĳn de volgende regels beschikbaar:
• Eindpunten moeten zĳn bedekt door: Hier kunt u een puntlaag selecteren uit uw project.
• Moet geen uitlopers hebben: Dit zal de uitschieters in de lĳnlaag weergeven.
• Moet geen duplicaten hebben: Wanneer een lĳnobject twee of meer keer wordt weergegeven, zal het
verschĳnen in het veld ‘Fout’.

• Moet geen ongeldige geometrieën hebben: Controleert of de geometrieën geldig zĳn.
• Moet geen geometrieën met meerdere delen hebben: Soms is een geometrie in feite een verzameling van
enkele (ééndelige) geometrieën. Een dergelĳke geometrie wordt een geometrie met meerdere delen genoemd.
Als het slechts één type eenvoudige geometrie bevat, noemen we het multi-punt, multi-lĳn of multi-polygoon.
Alle lĳnen met meerdere delen worden weggeschreven naar het veld ‘Fout’.

• Moet geen pseudo’s hebben: Een eindpunt van een lĳngeometrie zou moeten zĳn verbonden met de
eindpunten van twee andere geometrieën. Als het eindpunt slechts is verbonden met één eindpunt van een
andere geometrie wordt het eindpunt een pseudo-knoop genoemd.

Voor polygoonlagen zĳn de volgende regels beschikbaar:
• Moet bevatten: Polygoonlaag moet ten minste één puntgeometrie uit de tweede laag bevatten.
• Moet geen duplicaten hebben: Polygonen uit dezelfde laag moeten geen identieke geometrieën hebben.
Wanneer een polygoonobject twee of meer keer wordt weergegeven, zal het verschĳnen in het veld ‘Fout’..

• Moet geen gaten hebben: Aaneensluitende polygonen zouden geen gaten tussen hen moeten vormen.
Administratieve grenzen zouden als voorbeeld kunnen worden genoemd (Polygonen van staten van de VS
hebben geen gaten ertussen…).

• Moet geen ongeldige geometrieën hebben: Controleert of de geometrieën geldig zĳn. Enkele regels die
definiëren of een geometrie geldig is zĳn:

– Polygoon-ringen moeten zĳn gesloten.
– Ringen die gaten definiëren zouden binnen ringen moeten liggen die de buitenste grenzen definiëren.
– Ringen mogen zichzelf niet kruisen (zĳ mogen elkaar niet raken noch kruisen).
– Ringen mogen andere ringen niet raken, uitgezonderd op een punt.

• Moet geen geometrieën met meerdere delen hebben: Soms is een geometrie in feite een verzameling van
enkele (ééndelige) geometrieën. Een dergelĳke geometrie wordt een geometrie met meerdere delen genoemd.
Als het slechts één type eenvoudige geometrie bevat, noemen we het multi-punt, multi-lĳn of multi-polygoon.
Een land dat bĳvoorbeeld bestaat uit meerdere eilanden kan worden weergegeven als een multi-polygoon.

• Moet niet overlappen: Aaneensluitende polygonen zouden geen gemeenschappelĳk gebied moeten delen.
• Moet niet overlappen met: Aaneensluitende polygonen uit één laag zouden geen gemeenschappelĳk gebied
moeten delen met polygonen uit een andere laag.

Hieronder staat de lĳst met bronplug-ins die worden geleverd met QGIS. Zĳ zĳn niet noodzakelĳkerwĳze standaard
ingeschakeld.
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Pictogram Plug-in Omschrijving Verwijzing handleiding

DB Manager Uw databases beheren binnen QGIS Plug-in DB Manager

Geometrie
controleren

Fouten in geometrieën van vector controleren
en repareren

Plug-in Geometrieën
controleren

GRASS 7 GRASS-functionaliteit Integratie van GRASS GIS

GRASS GIS provider GRASS GIS Processing-functionaliteit Integratie van GRASS GIS

MetaSearch Catalog
Client

Werken met Metadata Catalogue Services
(CSW)

MetaSearch Catalog
Client

Offline bewerken Offline bewerken en synchroniseren met
database

Plug-in Offline bewerken

OrfeoToolbox
provider

OrfeoToolbox Processing provider OTB toepassingsprovider

Processing Framework Processing ruimtelĳke gegevens QGIS framework
Processing

SAGA GIS provider SAGA GIS Processing provider SAGA

Topology Checker Topologische fouten zoeken in vectorlagen Plug-in Topologie
Checker

Notitie: Om de bronplug-ins GRASS 7, GRASS GIS provider, OrfeoToolbox provider of SAGA
GIS provider te kunnen gebruiken, moeten zĳ zĳn geconfigureerd. Informatie is hier te vinden.

28.3 QGIS Python-console

Zoals u later in dit hoofdstuk zult zien is QGIS ontworpen met een architectuur voor plug-ins. Plug-ins kunnen worden
geschreven in Python, een zeer beroemde taal in de geo-ruimtelĳke wereld.
QGIS brengt een API voor Python (bekĳk PyQGIS Developer Cookbook voor enkele voorbeelden van code) om
de gebruiker interactief te kunnen laten werken met zĳn objecten (lagen, object of interface). QGIS heeft ook een
console voor Python.
De QGIS Python Console is een interactieve shell voor het uitvoeren van opdrachten in Python. Het heeft ook een
bestandsbewerker voor Python die u in staat stelt uw scripts voor Python te bewerken en op te slaan. Zowel de console
als de bewerker zĳn gebaseerd op het pakket PyQScintilla2. Ga naar Plug-ins ► Python Console (Ctrl+Alt+P)
om de console te openen.

28.3.1 De interactieve console

De interactieve console is samengesteld uit een werkbalk, een gebied voor invoer en een voor uitvoer.
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Werkbalk

De werkbalk biedt de volgende gereedschappen:

• Console wissen om het gebied voor uitvoer leeg te maken;

• Opdracht uitvoeren beschikbaar in het gebied voor invoer: hetzelfde als drukken op Enter;

• Editor tonen: schakelt met de zichtbaarheid van de De Codebewerker;
• Opties…: opent een dialoogvenster om de eigenschappen voor de console te configureren (bekĳk Instellingen

voor Python-console);

• Help…: bladert door de huidige documentatie.

Console

De belangrĳkste mogelĳkheden van de console zĳn:
• Automatisch aanvullen van code, accentueren van syntaxis en tips voor aanroepen voor de volgende API’s:

– Python
– PyQGIS
– PyQt5
– QScintilla2
– osgeo-gdal-ogr

• Ctrl+Alt+Space om de lĳst van Automatisch aanvullen te bekĳken, indien ingeschakeld in de Instellingen
voor Python-console;

• Codesnippers uitvoeren vanuit het gebied voor invoer door te typen en op Enter te drukken of op Opdracht
uitvoeren;

• Codesnippers uitvoeren vanuit het gebied voor uitvoer met behulp van Geselecteerde ingeven uit het
contextmenu of door te drukken op Ctrl+E;

• Bladeren door de Opdrachtgeschiedenis vanuit het invoergebied met behulp van de pĳltoetsen Omhoog en
Omlaag en de opdracht uitvoeren die u wilt;

• Ctrl+Shift+Space om de Opdrachtgeschiedenis te bekĳken: dubbelklikken op een rĳ zal de opdracht
uitvoeren. Tot het dialoogvenster Opdrachtgeschiedenis kan ook toegang worden verkregen vanuit het
contextmenu van het invoergebied;

• De opdrachtgeschiedenis opslaan en leegmaken. De geschiedenis zal worden opgeslagen in het bestand
~console_history.txt in de map van het actieve gebruikersprofiel;;

• Open documentatie QGIS C++ API door te typen _api;
• Open documentatie QGIS Python API door te typen _pyqgis.
• PyQGIS Cookbook openen door te typen _cookbook.

Tip: Uitgevoerde opdrachten uit het uitvoergebied opnieuw gebruiken
U kunt codesnippers uitvoeren vanuit het uitvoergebied door enige tekst te selecteren en te drukken op Ctrl+E. Het
maakt niet uit of de geselecteerde tekst de prompt voor de interpreter bevat (>>>, ...).

1548 Hoofdstuk 28. Plug-ins

https://api.qgis.org/api/3.28/
https://qgis.org/pyqgis/3.28/


QGIS Desktop 3.28 User Guide

Fig. 28.15: De Python-console

28.3.2 De Codebewerker

Gebruik de knop Editor tonen om het widget editor in te schakelen. Het maakt het mogelĳk bestanden van Python
te bewerken en op te slaan en biedt geavanceerde functionaliteiten om uw code te beheren (code voorzien van
opmerkingen en opmerkingen verwĳderen, syntaxis controleren, de code delen via GitHub.org en nog veel meer).
Belangrĳkste mogelĳkheden zĳn:

• Automatisch aanvullen van code, accentueren van syntaxis en tips voor aanroepen voor de volgende API’s:
– Python
– PyQGIS
– PyQt5
– QScintilla2
– osgeo-gdal-ogr

• Ctrl+Alt+Space om de lĳst van Automatisch aanvullen te bekĳken.
• Codesnippers delen via GitHub.
• Ctrl+4 Controleren van syntaxis.
• Zoekbalk (open die met de standaard sneltoets voor de omgeving van de desktop, gewoonlĳk Ctrl+F):

– Gebruik de standaard sneltoets voor de omgeving van desktop om de vorige/volgende te zoeken (Ctrl+G
en Shift+Ctrl+G);

– Automatisch de eerste overeenkomst zoeken bĳ het typen in het zoekvak;
– Initiële zoekreeks instellen om te zoeken bĳ het openen van Zoeken;
– Drukken op Esc sluit de zoekbalk.

• Object inspecteren: een browser voor klassen en functies;
• Ga naar een definitie van een object met een muisklik (vanuit Object inspecteren);

• Codesnippers uitvoeren met de opdracht Geselecteerde ingeven in het contextmenu;

• Het gehele script uitvoeren met de opdracht Script uitvoeren (dit maakt een byte-gecompileerd bestand
met de extensie .pyc).
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Notitie: Een script geheel of gedeeltelĳk uitvoeren vanuit de Codebewerker voert het resultaat uit naar het gebied
voor uitvoer in de Console.

Fig. 28.16: De Python consolebewerker

Tip: De opties opslaan
U dient de Python Console te sluiten met de knop Sluiten om de status van de widgets van de console op te slaan. Dit
stelt u in staat de geometrie op te slaan om te worden hersteld bĳ de volgende start.
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Ondersteuning

29.1 Mailinglijsten

QGIS is constant in ontwikkeling. Mocht u hulp nodig hebben of tegen fouten aanlopen, meld u dan aan op
de mailinglĳst qgis-users. Uw vragen zullen dan door meerdere mensen worden gelezen en ook anderen kunnen
profiteren van de antwoorden.

29.1.1 QGIS gebruikers

Deze mailinglĳst wordt gebruikt voor algemene vragen en discussies over QGIS en vragen over installatie en gebruik.
U kunt zich aanmelden voor de qgis-users mailinglĳst via de volgende link: https://lists.osgeo.org/mailman/listinfo/
qgis-user

29.1.2 QGIS ontwikkelaars

Indien u een ontwikkelaar bent die problemen van een meer technische aard tegenkomt, wilt u misschien deelnemen
aan de mailinglĳst qgis-developer. Deze lĳst is ook een plaats waar mensen deelnemen en aan QGIS gerelateerde UX
(User Experience) / gebruiksproblemen verzamelen en bespreken. Hier is de link: https://lists.osgeo.org/mailman/
listinfo/qgis-developer

29.1.3 QGIS gemeenschapsteam

Op deze lĳst komen onderwerpen als documentatie, ondersteuning, gebruikershandleiding en aan QGIS gerelateerde
websites aan bod. Ook wordt hier informatie uitgewisseld over blogs, mailinglĳsten en vertalingen. Wil je
meehelpen aan een van de handleidingen? Meld je dan aan voor deze lĳst: https://lists.osgeo.org/mailman/listinfo/
qgis-community-team
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29.1.4 QGIS vertalingen

Deze mailinglĳst is voor vertalingen en vertalers. Als u mee wilt werken aan de vertalingen van de toepassing QGIS,
website, handleidingen of de grafische gebruikersinterface (GUI). U kunt zich op deze lĳst abonneren via: https:
//lists.osgeo.org/mailman/listinfo/qgis-tr

29.1.5 QGIS Project Steering Committee (PSC)

Deze lĳst wordt gebruikt voor discussie over problemen van het Steering Commitee, die met name gaat over het
algemene management, de aansturing en het richting geven van QGIS. U kunt zich abonneren op deze lĳst via:
https://lists.osgeo.org/mailman/listinfo/qgis-psc

29.1.6 QGIS gebruikersgroepen

Sommige gemeenschappen van QGIS hebben zich georganiseerd in QGIS gebruikersgroepen om QGIS lokaal te
promoten en bĳ te dragen aan de ontwikkeling ervan. Deze groepen zĳn plekken om lokale onderwerpen te bespreken,
regionale of nationale gebruikersdagen te organiseren, organiseren van het sponsoren van mogelĳkheden… De lĳst
van huidige gebruikersgroepen is beschikbaar op https://qgis.org/nl/site/forusers/usergroups.html
U bent van harte welkom om deel te nemen aan deze lĳsten. Vergeet echter niet ook bĳ te dragen aan de lĳst door
vragen te beantwoorden en uw ervaringen te delen.

29.2 Matrix / IRC

Matrix (https://matrix.org) is een project voor gedecentraliseerd chatten. QGIS heeft een ruimte toegankelĳk onder
het alias #qgis:osgeo.org (naast andere) die een brug maakt met het libera.chat #qgis IRC-kanaal.
Matrix gebruiken

1. Maak een account (op matrix.org is het gemakkelĳkst, maar als u een account voor OSGeo hebt kunt u ook
uw ID van OSGEO gebruiken als Matrix ID)

2. Installeer een cliënt (Elements is het gemakkelĳkst, maar bekĳk Matrix-cliënten voor meer), OF stuur uw
browser naar https://matrix.to/#/#qgis:osgeo.org

IRC gebruiken:
1. Installeer een IRC-cliënt
2. Verbind met irc://irc.libera.chat/#qgis of stuur uw browser naar https://web.libera.chat/?channels=#qgis

29.3 Commerciële ondersteuning

Commerciële ondersteuning voor QGIS is ook beschikbaar. Bekĳk de website https://qgis.org/nl/site/forusers/
commercial_support.html voor meer informatie.
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29.4 Meldingen Volgsysteem

Hoewel de mailinglĳst qgis-users de juiste plek is voor vragen als ‘Hoe doe ik XYZ met QGIS?’ is het handig om
gevonden fouten in QGIS te kunnen rapporteren. U kunt foutmeldingen indienen op de QGIS bug tracker.
Houdt er rekening mee dat fouten die jĳ belangrĳk vindt niet altĳd de hoogste prioriteit zullen krĳgen. Sommige
fouten vereisen een complexe, tĳdrovende oplossing en ontwikkelaars zĳn niet altĳd beschikbaar.
Verzoeken om nieuwe functionaliteit kunnen ook worden aangedragen in het meldingen volgsysteem. Plaats een
melding altĳd in het Engels en kies als type Feature request.
Wanneer u een bug gevonden hebt en die zelf hebt gerepareerd, kunt u een Pull Request indienen op het Github QGIS
Project.
Lees Bugs, mogelĳkheden en problemen en submit_patch voor meer details.

29.5 Blog

De gemeenschap QGIS heeft ook een Engelstalig weblog op https://plugins.qgis.org/planet/ waarop interessante
artikelen te lezen zĳn voor gebruikers en ontwikkelaars. Er bestaan ook vele andere blogs over QGIS, en u wordt
uitgenodigd om bĳ te dragen met uw eigen blog over QGIS!

29.6 Plug-ins

De website https://plugins.qgis.org is het officiële webportaal voor QGIS plug-ins. Daar vindt u een lĳst van alle
stabiele en experimentele plug-ins voor QGIS, die beschikbaar zĳn via de ‘Official QGIS Plugin Repository’.

29.7 Wiki

Er is een engelstalige wiki beschikbaar op https://github.com/qgis/QGIS/wiki. Hier kun je waardevolle informatie
vinden maar ook plaatsen over ontwikkeling, uitrol, links naar downloads, vertaaltips enzovoort. Bekĳk ‘m, je kunt
er pareltjes aan informatie vinden!
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Deelnemers

QGIS is een open bron-project, ontwikkeld door een team van toegewĳde vrĳwilligers en organisaties. We streven er
naar om een warme gemeenschap te zĳn voor mensen van alle rassen, afkomst, geslacht en levenswĳze. U kunt op
elk moment meedoen.

30.1 Auteurs

Hieronder zĳn mensen vermeld die hun tĳd en energie spendeerden aan het schrĳven, nakĳken en bĳwerken van de
gehele documentatie voor QGIS.

Tim Sutton Yves Jacolin Jacob Lanstorp Gary E. Sherman Richard Duivenvoorde
Tara Athan Anita Graser Arnaud Morvan Gavin Macaulay Luca Casagrande
K. Koy Hugo Mercier Akbar Gumbira Marie Silvestre Jürgen E. Fischer
Fran Raga Eric Goddard Martin Dobias Diethard Jansen Saber Razmjooei
Ko Nagase Nyall Dawson Matthias Kuhn Andreas Neumann Harrissou Sant-anna
Manel Clos David Willis Larissa Junek Paul Blottière Sebastian Dietrich
Chris Mayo Stephan Holl Magnus Homann Bernhard Ströbl Alessandro Pasotti
N. Horning Radim Blazek Joshua Arnott Luca Manganelli Marco Hugentobler
Andre Mano Mie Winstrup Frank Sokolic Vincent Picavet Jean-Roc Morreale
Andy Allan Victor Olaya Tyler Mitchell René-Luc D’Hont Marco Bernasocchi
Ilkka Rinne Werner Macho Chris Berkhout Nicholas Duggan Jonathan Willitts
David Adler Lars Luthman Brendan Morely Raymond Nĳssen Carson J.Q. Farmer
Jaka Kranjc Mezene Worku Patrick Sunter Steven Cordwell Stefan Blumentrath
Andy Schmid Vincent Mora Alexandre Neto Hien Tran-Quang Alexandre Busquets
João Gaspar Tom Kralidis Alexander Bruy Paolo Cavallini Milo Van der Linden
Peter Ersts Ujaval Gandhi Dominic Keller Giovanni Manghi Maximilian Krambach
Anne Ghisla Dick Groskamp Uros Preloznik Stéphane Brunner QGIS Koreaanse vertaler
Zoltan Siki Håvard Tveite Matteo Ghetta Salvatore Larosa Konstantinos Nikolaou
Tom Chadwin Larry Shaffer Nathan Woodrow Martina Savarese Godofredo Contreras
Astrid Emde Luigi Pirelli Thomas Gratier Giovanni Allegri GiordanoPezzola
Paolo Corti Tudor Bărăscu Maning Sambale Claudia A. Engel Yoichi Kayama
Otto Dassau Denis Rouzaud Nick Bearman embelding ajazepk
Ramon Andrei zstadler icephale Rosa Aguilar
Patrice Pineault Jörn Gutzeit Felix Feckler Benoît de Mezzo Étienne Trimaille

Vervolgt op volgende pagina
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Tabel 30.1 – Vervolgd van vorige pagina
Andrea Giudiceandrea Julien Cabieces roya0045 Sebastian Gutwein Jessica Veenstra
Ryan Welfle Martin Pergler Ivan Ivanov muranamihdk Loïc Bartoletti
Tomasz Taraś Ian Maddaus Jürnjakob Dugge Roman Bug Damiano Lombardi
Marc Ducobu Philip Albrecht Dennis Milechin Cody Martin Savinaud Mickaël
Stefan Uhrig Ariadni-Karolina Alexiou Björn Hinkeldey Benjamin Riley MorriganR
Thayer Young Shane Carey Ian Turton Emma Hain Germán Carrillo
Jakob Miksch Nicolas Boisteault Bertrand Rix Jorge Rosales

30.2 Vertalers

QGIS is een meertalige toepassing en publiceert daarom ook documentatie die is vertaald in verscheidene talen. Vele
andere talen worden nog vertaald en zullen worden uitgegeven zodra zĳ een redelĳk percentage van de vertaling
bereiken. Als u wilt helpen bĳ het verbeteren van een taal of een verzoek voor een nieuwe taal in wilt dienen, bekĳk
dan https://qgis.org/nl/site/getinvolved/index.html.
De huidige vertalingen werden mogelĳk gemaakt door:

1556 Hoofdstuk 30. Deelnemers

https://qgis.org/nl/site/getinvolved/index.html


QGIS Desktop 3.28 User Guide

Taal Deelnemers
Bahasa
Indonesia

Emir Hartato, I Made Anombawa, Januar V. Simarmata, Muhammad Iqnaul Haq Siregar, Trias
Aditya

Chinees
(Traditioneel)

Calvin Ngei, Zhang Jun, Richard Xie

Chinees
(vereenvoudigd)

Xu Baocai

Nederlands Carlo van Rĳswĳk, Dick Groskamp, Diethard Jansen, Raymond Nĳssen, Richard
Duivenvoorde, Willem Hoffman

Fins Matti Mäntynen, Kari Mikkonen
Frans Arnaud Morvan, Augustin Roche, Didier Vanden Berghe, Dofabien, Etienne Trimaille, Francis

Gasc, Harrissou Sant-anna, Jean-Roc Morreale, Jérémy Garniaux, Loïc Buscoz, Lsam, Marc-
André Saia, Marie Silvestre, Mathieu Bossaert, Mathieu Lattes, Mayeul Kauffmann, Médéric
Ribreux, Mehdi Semchaoui, Michael Douchin, Nicolas Boisteault, Nicolas Rochard, Pascal
Obstetar, Robin Prest, Rod Bera, Stéphane Henriod, Stéphane Possamai, sylther, Sylvain Badey,
Sylvain Maillard, Vincent Picavet, Xavier Tardieu, Yann Leveille-Menez, yoda89

Galicisch Xan Vieiro
Duits Jürgen E. Fischer, Otto Dassau, Stephan Holl, Werner Macho
Hindi Harish Kumar Solanki
Italiaans Alessandro Fanna, Anne Ghisla, Flavio Rigolon, Giuliano Curti, Luca Casagrande, Luca

Delucchi, Marco Braida, Matteo Ghetta, Maurizio Napolitano, Michele Beneventi, Michele
Ferretti, Roberto Angeletti, Paolo Cavallini, Stefano Campus

Japans Baba Yoshihiko, Minoru Akagi, Norihiro Yamate, Takayuki Mizutani, Takayuki Nuimura,
Yoichi Kayama

Koreaans OSGeo Korean Chapter
Pools Andrzej Świąder, Borys Jurgiel, Ewelina Krawczak, Jakub Bobrowski, Mateusz Łoskot, Michał

Kułach, Michał Smoczyk, Milena Nowotarska, Radosław Pasiok, Robert Szczepanek, Tomasz
Paul

Portugees Alexandre Neto, Duarte Carreira, Giovanni Manghi, João Gaspar, Joana Simões, Leandro
Infantini, Nelson Silva, Pedro Palheiro, Pedro Pereira, Ricardo Sena

Portugees
(Braziliaans)

Arthur Nanni, Felipe Sodré Barros, Leônidas Descovi Filho, Marcelo Soares Souza, Narcélio
de Sá Pereira Filho, Sidney Schaberle Goveia

Roemeens Alex Bădescu, Bogdan Pacurar, Georgiana Ioanovici, Lonut Losifescu-Enescu, Sorin Călinică,
Tudor Bărăscu

Russisch Alexander Bruy, Artem Popov
Spaans Carlos Dávila, Diana Galindo, Edwin Amado, Gabriela Awad, Javier César Aldariz, Mayeul

Kauffmann, Fran Raga
Oekraïens Alexander Bruy

30.3 Statistieken van vertalingen

Inspanningen voor het vertalen van QGIS 3.22 Long Term Release zĳn hieronder geproduceerd. Alleen talen die
tenminste 5% hebben bereikt, ten tĳde van het uitgeven van de versie, worden hier gepubliceerd.
Laatst bĳgewerkt: 2023-12-26

Aantal tekenreeksen Aantal doeltalen Algehele verhouding van vertalingen
29206 58 14.9%

30.3. Statistieken van vertalingen 1557



QGIS Desktop 3.28 User Guide

Taal Verhouding
vertalingen (%)

Taal Verhouding
vertalingen (%)

Taal Verhouding
vertalingen (%)

Albanees 1.11 Arabisch 4.63 Azerbaĳaans 0.87
Baskisch 1.89 Bengaals 1.05 Bulgaars 3.41
Burmees 0.97 Catalaans 2.03 Chinees

vereenvoudigd
29.71

Chinees
traditioneel

2.19 Kroatisch 0.98 Tsjechisch 6.73

Deens 1.58 Nederlands 100.0 Ests 2.24
Fins 2.22 Frans 85.34 Galicisch 1.35
Georgisch 0.98 Duits 22.97 Grieks 1.24
Hebreeuws 1.68 Hindi 1.19 Hongaars 19.16
Igbo 0.87 Indonesisch 3.64 Italiaans 100.0
Japans 99.93 Kabyle 0.97 Koreaans 86.8
Litouws 11.46 Macedonisch0.99 Maleis 0.9
Malayalam 0.97 Marathi 1.01 Mongools 0.98
N’ko 2.52 Noors

Bokmål
3.75 Panjabi

(Punjabi)
0.0

Perzisch 0.68 Pools 2.74 Portugees
(Braziliaans)

70.57

Portugees
(Portugees)

8.55 Roemeens 34.84 Russisch 15.44

Servisch 0.13 Slowaaks 2.43 Sloveens 3.66
Spaans 99.96 Zweeds 1.94 Tagalog 0.97
Tamil 1.41 Telugu 0.88 Thais 0.98
Turks 3.36 Oekraïens 3.67 Urdu 0.86
Vietnamees 1.11
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Appendices

31.1 Appendix A: GNU General Public License

Version 2, June 1991
Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place - Suite 330, Boston, MA 02111-1307,
USA
Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.
Preamble
The licenses for most software are designed to take away your freedom to share and change it. By contrast, the
GNU General Public License is intended to guarantee your freedom to share and change free software–to make sure
the software is free for all its users. This General Public License applies to most of the Free Software Foundation’s
software and to any other program whose authors commit to using it. (Some other Free Software Foundation software
is covered by the GNU Library General Public License instead.) You can apply it to your programs, too.
When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed
to make sure that you have the freedom to distribute copies of free software (and charge for this service if you wish),
that you receive source code or can get it if you want it, that you can change the software or use pieces of it in new
free programs; and that you know you can do these things.
To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to
surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the
software, or if you modify it.
For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients all
the rights that you have. You must make sure that they, too, receive or can get the source code. And you must show
them these terms so they know their rights.
We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you legal
permission to copy, distribute and/or modify the software.
Also, for each author’s protection and ours, we want to make certain that everyone understands that there is no
warranty for this free software. If the software is modified by someone else and passed on, we want its recipients to
know that what they have is not the original, so that any problems introduced by others will not reflect on the original
authors’ reputations.
Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redistributors
of a free program will individually obtain patent licenses, in effect making the program proprietary. To prevent this,
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we have made it clear that any patent must be licensed for everyone’s free use or not licensed at all.
The precise terms and conditions for copying, distribution and modification follow. TERMS AND CONDITIONS
FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice placed by the copyright holder
saying it may be distributed under the terms of this General Public License. The “Program”, below, refers to
any such program or work, and a “work based on the Program”means either the Program or any derivative work
under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim or with
modifications and/or translated into another language. (Hereinafter, translation is included without limitation
in the term “modification”.) Each licensee is addressed as “you”.
Activities other than copying, distribution and modification are not covered by this License; they are outside its
scope. The act of running the Program is not restricted, and the output from the Program is covered only if its
contents constitute a work based on the Program (independent of having been made by running the Program).
Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program’s source code as you receive it, in any medium,
provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and
disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any warranty;
and give any other recipients of the Program a copy of this License along with the Program.
You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty
protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the
Program, and copy and distribute such modifications or work under the terms of Section 1 above, provided
that you also meet all of these conditions:
a) You must cause the modified files to carry prominent notices stating that you changed the files and the

date of any change.
b) You must cause any work that you distribute or publish, that in whole or in part contains or is derived

from the Program or any part thereof, to be licensed as a whole at no charge to all third parties under the
terms of this License.

c) If themodified program normally reads commands interactively when run, youmust cause it, when started
running for such interactive use in the most ordinary way, to print or display an announcement including
an appropriate copyright notice and a notice that there is no warranty (or else, saying that you provide a
warranty) and that users may redistribute the program under these conditions, and telling the user how
to view a copy of this License. (Exception: if the Program itself is interactive but does not normally print
such an announcement, your work based on the Program is not required to print an announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived
from the Program, and can be reasonably considered independent and separate works in themselves, then this
License, and its terms, do not apply to those sections when you distribute them as separate works. But when
you distribute the same sections as part of a whole which is a work based on the Program, the distribution
of the whole must be on the terms of this License, whose permissions for other licensees extend to the entire
whole, and thus to each and every part regardless of who wrote it.
Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you;
rather, the intent is to exercise the right to control the distribution of derivative or collective works based on
the Program.
In addition, mere aggregation of another work not based on the Program with the Program (or with a work
based on the Program) on a volume of a storage or distribution medium does not bring the other work under
the scope of this License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable
form under the terms of Sections 1 and 2 above provided that you also do one of the following:
a) Accompany it with the complete corresponding machine-readable source code, which must be distributed

under the terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,
b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no

more than your cost of physically performing source distribution, a complete machine-readable copy of
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the corresponding source code, to be distributed under the terms of Sections 1 and 2 above on a medium
customarily used for software interchange; or,

c) Accompany it with the information you received as to the offer to distribute corresponding source code.
(This alternative is allowed only for noncommercial distribution and only if you received the program in
object code or executable form with such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to it. For an
executable work, complete source codemeans all the source code for all modules it contains, plus any associated
interface definition files, plus the scripts used to control compilation and installation of the executable.
However, as a special exception, the source code distributed need not include anything that is normally
distributed (in either source or binary form) with the major components (compiler, kernel, and so on) of the
operating system on which the executable runs, unless that component itself accompanies the executable.
If distribution of executable or object code is made by offering access to copy from a designated place, then
offering equivalent access to copy the source code from the same place counts as distribution of the source
code, even though third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this
License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will
automatically terminate your rights under this License. However, parties who have received copies, or rights,
from you under this License will not have their licenses terminated so long as such parties remain in full
compliance.

5. You are not required to accept this License, since you have not signed it. However, nothing else grants you
permission to modify or distribute the Program or its derivative works. These actions are prohibited by law if
you do not accept this License. Therefore, by modifying or distributing the Program (or any work based on the
Program), you indicate your acceptance of this License to do so, and all its terms and conditions for copying,
distributing or modifying the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically
receives a license from the original licensor to copy, distribute or modify the Program subject to these terms
and conditions. You may not impose any further restrictions on the recipients’ exercise of the rights granted
herein. You are not responsible for enforcing compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not
limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) that
contradict the conditions of this License, they do not excuse you from the conditions of this License. If you
cannot distribute so as to satisfy simultaneously your obligations under this License and any other pertinent
obligations, then as a consequence you may not distribute the Program at all. For example, if a patent license
would not permit royalty-free redistribution of the Program by all those who receive copies directly or indirectly
through you, then the only way you could satisfy both it and this License would be to refrain entirely from
distribution of the Program.
If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of
the section is intended to apply and the section as a whole is intended to apply in other circumstances.
It is not the purpose of this section to induce you to infringe any patents or other property right claims or
to contest validity of any such claims; this section has the sole purpose of protecting the integrity of the
free software distribution system, which is implemented by public license practices. Many people have made
generous contributions to the wide range of software distributed through that system in reliance on consistent
application of that system; it is up to the author/donor to decide if he or she is willing to distribute software
through any other system and a licensee cannot impose that choice.
This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this
License.

8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copyrighted
interfaces, the original copyright holder who places the Program under this License may add an explicit
geographical distribution limitation excluding those countries, so that distribution is permitted only in or among
countries not thus excluded. In such case, this License incorporates the limitation as if written in the body of
this License.
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9. The Free Software Foundation may publish revised and/or new versions of the General Public License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address
new problems or concerns.
Each version is given a distinguishing version number. If the Program specifies a version number of this License
which applies to it and “any later version”, you have the option of following the terms and conditions either of
that version or of any later version published by the Free Software Foundation. If the Program does not specify
a version number of this License, you may choose any version ever published by the Free Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are
different, write to the author to ask for permission. For software which is copyrighted by the Free Software
Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our decision will
be guided by the two goals of preserving the free status of all derivatives of our free software and of promoting
the sharing and reuse of software generally.

NO WARRANTY
11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NOWARRANTY FOR THE

PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE
STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE
PROGRAM “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY
AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE
DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR
CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING
WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR
REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES,
INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES
ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT
NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES
SUSTAINEDBYYOUORTHIRD PARTIES ORA FAILUREOF THE PROGRAMTOOPERATEWITH
ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES.

QGIS Qt exception for GPL
In addition, as a special exception, theQGISDevelopment Team gives permission to link the code of this programwith
the Qt library, including but not limited to the following versions (both free and commercial): Qt/Non-commerical
Windows, Qt/Windows, Qt/X11, Qt/Mac, and Qt/Embedded (or with modified versions of Qt that use the same
license as Qt), and distribute linked combinations including the two. You must obey the GNUGeneral Public License
in all respects for all of the code used other than Qt. If you modify this file, you may extend this exception to your
version of the file, but you are not obligated to do so. If you do not wish to do so, delete this exception statement
from your version.

31.2 Appendix B: GNU Free Documentation License

Version 1.3, 3 November 2008
Copyright 2000, 2001, 2002, 2007, 2008 Free Software Foundation, Inc
https://www.fsf.org/
Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.
Preamble
The purpose of this License is to make a manual, textbook, or other functional and useful document “free” in the
sense of freedom: to assure everyone the effective freedom to copy and redistribute it, with or without modifying it,
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either commercially or noncommercially. Secondarily, this License preserves for the author and publisher a way to
get credit for their work, while not being considered responsible for modifications made by others.
This License is a kind of “copyleft”, which means that derivative works of the document must themselves be free
in the same sense. It complements the GNU General Public License, which is a copyleft license designed for free
software.
We have designed this License in order to use it for manuals for free software, because free software needs free
documentation: a free program should come with manuals providing the same freedoms that the software does. But
this License is not limited to software manuals; it can be used for any textual work, regardless of subject matter
or whether it is published as a printed book. We recommend this License principally for works whose purpose is
instruction or reference.
1. APPLICABILITY AND DEFINITIONS
This License applies to any manual or other work, in any medium, that contains a notice placed by the copyright
holder saying it can be distributed under the terms of this License. Such a notice grants a world-wide, royalty-free
license, unlimited in duration, to use that work under the conditions stated herein. The Document, below, refers to
any such manual or work. Any member of the public is a licensee, and is addressed as “you”. You accept the license
if you copy, modify or distribute the work in a way requiring permission under copyright law.
A “Modified Version” of the Document means any work containing the Document or a portion of it, either copied
verbatim, or with modifications and/or translated into another language.
A “Secondary Section” is a named appendix or a front-matter section of the Document that deals exclusively with
the relationship of the publishers or authors of the Document to the Document’s overall subject (or to related matters)
and contains nothing that could fall directly within that overall subject. (Thus, if the Document is in part a textbook of
mathematics, a Secondary Section may not explain any mathematics.) The relationship could be a matter of historical
connection with the subject or with related matters, or of legal, commercial, philosophical, ethical or political position
regarding them.
The “Invariant Sections” are certain Secondary Sections whose titles are designated, as being those of Invariant
Sections, in the notice that says that the Document is released under this License. If a section does not fit the above
definition of Secondary then it is not allowed to be designated as Invariant. The Document may contain zero Invariant
Sections. If the Document does not identify any Invariant Sections then there are none.
The “Cover Texts” are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover Texts, in
the notice that says that the Document is released under this License. A Front-Cover Text may be at most 5 words,
and a Back-Cover Text may be at most 25 words.
A “Transparent” copy of the Document means amachine-readable copy, represented in a format whose specification
is available to the general public, that is suitable for revising the document straightforwardly with generic text editors
or (for images composed of pixels) generic paint programs or (for drawings) some widely available drawing editor,
and that is suitable for input to text formatters or for automatic translation to a variety of formats suitable for input
to text formatters. A copy made in an otherwise Transparent file format whose markup, or absence of markup, has
been arranged to thwart or discourage subsequent modification by readers is not Transparent. An image format is not
Transparent if used for any substantial amount of text. A copy that is not “Transparent” is called Opaque.
Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input format,
LaTeX input format, SGML or XML using a publicly available DTD, and standard-conforming simple HTML,
PostScript or PDF designed for human modification. Examples of transparent image formats include PNG, XCF and
JPG. Opaque formats include proprietary formats that can be read and edited only by proprietary word processors,
SGML or XML for which the DTD and/or processing tools are not generally available, and the machine-generated
HTML, PostScript or PDF produced by some word processors for output purposes only.
The “Title Page” means, for a printed book, the title page itself, plus such following pages as are needed to hold,
legibly, the material this License requires to appear in the title page. For works in formats which do not have any
title page as such, “Title Page” means the text near the most prominent appearance of the work’s title, preceding the
beginning of the body of the text.
The “publisher” means any person or entity that distributes copies of the Document to the public.
A section “Entitled XYZ” means a named subunit of the Document whose title either is precisely XYZ or contains
XYZ in parentheses following text that translates XYZ in another language. (Here XYZ stands for a specific
section name mentioned below, such as “Acknowledgements”, “Dedications”, “Endorsements”, or “History”.)
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To “Preserve the Title” of such a section when you modify the Document means that it remains a section “Entitled
XYZ” according to this definition.
The Document may include Warranty Disclaimers next to the notice which states that this License applies to the
Document. TheseWarranty Disclaimers are considered to be included by reference in this License, but only as regards
disclaiming warranties: any other implication that these Warranty Disclaimers may have is void and has no effect on
the meaning of this License.
2. VERBATIM COPYING
You may copy and distribute the Document in any medium, either commercially or noncommercially, provided that
this License, the copyright notices, and the license notice saying this License applies to the Document are reproduced
in all copies, and that you add no other conditions whatsoever to those of this License. You may not use technical
measures to obstruct or control the reading or further copying of the copies you make or distribute. However, you
may accept compensation in exchange for copies. If you distribute a large enough number of copies you must also
follow the conditions in section 3.
You may also lend copies, under the same conditions stated above, and you may publicly display copies.
3. COPYING IN QUANTITY
If you publish printed copies (or copies in media that commonly have printed covers) of the Document, numbering
more than 100, and the Document’s license notice requires Cover Texts, you must enclose the copies in covers that
carry, clearly and legibly, all these Cover Texts: Front-Cover Texts on the front cover, and Back-Cover Texts on the
back cover. Both covers must also clearly and legibly identify you as the publisher of these copies. The front cover
must present the full title with all words of the title equally prominent and visible. You may add other material on the
covers in addition. Copying with changes limited to the covers, as long as they preserve the title of the Document and
satisfy these conditions, can be treated as verbatim copying in other respects.
If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed (as many as
fit reasonably) on the actual cover, and continue the rest onto adjacent pages.
If you publish or distribute Opaque copies of the Document numbering more than 100, you must either include a
machine-readable Transparent copy along with each Opaque copy, or state in or with each Opaque copy a computer-
network location from which the general network-using public has access to download using public-standard network
protocols a complete Transparent copy of the Document, free of added material. If you use the latter option, you
must take reasonably prudent steps, when you begin distribution of Opaque copies in quantity, to ensure that this
Transparent copy will remain thus accessible at the stated location until at least one year after the last time you
distribute an Opaque copy (directly or through your agents or retailers) of that edition to the public.
It is requested, but not required, that you contact the authors of the Document well before redistributing any large
number of copies, to give them a chance to provide you with an updated version of the Document.
4. MODIFICATIONS
You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and 3 above,
provided that you release the Modified Version under precisely this License, with the Modified Version filling the
role of the Document, thus licensing distribution and modification of the Modified Version to whoever possesses a
copy of it. In addition, you must do these things in the Modified Version:
A. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those of

previous versions (which should, if there were any, be listed in the History section of the Document). You may
use the same title as a previous version if the original publisher of that version gives permission.

B. List on the Title Page, as authors, one or more persons or entities responsible for authorship of themodifications
in the Modified Version, together with at least five of the principal authors of the Document (all of its principal
authors, if it has fewer than five), unless they release you from this requirement.

C. State on the Title page the name of the publisher of the Modified Version, as the publisher.
D. Preserve all the copyright notices of the Document.
E. Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.
F. Include, immediately after the copyright notices, a license notice giving the public permission to use the

Modified Version under the terms of this License, in the form shown in the Addendum below.

1564 Hoofdstuk 31. Appendices



QGIS Desktop 3.28 User Guide

G. Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given in the
Document’s license notice.

H. Include an unaltered copy of this License.
I. Preserve the section Entitled “History”, Preserve its Title, and add to it an item stating at least the title, year,
new authors, and publisher of the Modified Version as given on the Title Page. If there is no section Entitled
“History” in the Document, create one stating the title, year, authors, and publisher of the Document as given
on its Title Page, then add an item describing the Modified Version as stated in the previous sentence.

J. Preserve the network location, if any, given in the Document for public access to a Transparent copy of the
Document, and likewise the network locations given in the Document for previous versions it was based on.
These may be placed in the “History” section. You may omit a network location for a work that was published
at least four years before the Document itself, or if the original publisher of the version it refers to gives
permission.

K. For any section Entitled “Acknowledgements” or “Dedications”, Preserve the Title of the section, and preserve
in the section all the substance and tone of each of the contributor acknowledgements and/or dedications given
therein.

L. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. Section numbers
or the equivalent are not considered part of the section titles.

M. Delete any section Entitled “Endorsements”. Such a section may not be included in the Modified Version.
N. Do not retitle any existing section to be Entitled “Endorsements” or to conflict in title with any Invariant Section.
O. Preserve any Warranty Disclaimers.

If the Modified Version includes new front-matter sections or appendices that qualify as Secondary Sections and
contain no material copied from the Document, you may at your option designate some or all of these sections as
invariant. To do this, add their titles to the list of Invariant Sections in the Modified Version’s license notice. These
titles must be distinct from any other section titles.
You may add a section Entitled “Endorsements”, provided it contains nothing but endorsements of your Modified
Version by various parties—for example, statements of peer review or that the text has been approved by an
organization as the authoritative definition of a standard.
You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as a Back-Cover
Text, to the end of the list of Cover Texts in the Modified Version. Only one passage of Front-Cover Text and one
of Back-Cover Text may be added by (or through arrangements made by) any one entity. If the Document already
includes a cover text for the same cover, previously added by you or by arrangement made by the same entity you
are acting on behalf of, you may not add another; but you may replace the old one, on explicit permission from the
previous publisher that added the old one.
The author(s) and publisher(s) of the Document do not by this License give permission to use their names for publicity
for or to assert or imply endorsement of any Modified Version.
5. COMBINING DOCUMENTS
Youmay combine the Document with other documents released under this License, under the terms defined in section
4 above for modified versions, provided that you include in the combination all of the Invariant Sections of all of the
original documents, unmodified, and list them all as Invariant Sections of your combined work in its license notice,
and that you preserve all their Warranty Disclaimers.
The combined work need only contain one copy of this License, and multiple identical Invariant Sections may be
replaced with a single copy. If there are multiple Invariant Sections with the same name but different contents, make
the title of each such section unique by adding at the end of it, in parentheses, the name of the original author or
publisher of that section if known, or else a unique number. Make the same adjustment to the section titles in the list
of Invariant Sections in the license notice of the combined work.
In the combination, you must combine any sections Entitled “History” in the various original documents, forming one
section Entitled “History”; likewise combine any sections Entitled “Acknowledgements”, and any sections Entitled
“Dedications”. You must delete all sections Entitled “Endorsements”.
6. COLLECTIONS OF DOCUMENTS
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You may make a collection consisting of the Document and other documents released under this License, and replace
the individual copies of this License in the various documents with a single copy that is included in the collection,
provided that you follow the rules of this License for verbatim copying of each of the documents in all other respects.
You may extract a single document from such a collection, and distribute it individually under this License, provided
you insert a copy of this License into the extracted document, and follow this License in all other respects regarding
verbatim copying of that document.
7. AGGREGATIONWITH INDEPENDENT WORKS
A compilation of the Document or its derivatives with other separate and independent documents or works, in or on
a volume of a storage or distribution medium, is called an “aggregate” if the copyright resulting from the compilation
is not used to limit the legal rights of the compilation’s users beyond what the individual works permit. When the
Document is included in an aggregate, this License does not apply to the other works in the aggregate which are not
themselves derivative works of the Document.
If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the Document is less
than one half of the entire aggregate, the Document’s Cover Texts may be placed on covers that bracket the Document
within the aggregate, or the electronic equivalent of covers if the Document is in electronic form. Otherwise they must
appear on printed covers that bracket the whole aggregate.
8. TRANSLATION
Translation is considered a kind of modification, so you may distribute translations of the Document under the terms
of section 4. Replacing Invariant Sections with translations requires special permission from their copyright holders,
but you may include translations of some or all Invariant Sections in addition to the original versions of these Invariant
Sections. You may include a translation of this License, and all the license notices in the Document, and anyWarranty
Disclaimers, provided that you also include the original English version of this License and the original versions of
those notices and disclaimers. In case of a disagreement between the translation and the original version of this
License or a notice or disclaimer, the original version will prevail.
If a section in the Document is Entitled “Acknowledgements”, “Dedications”, or “History”, the requirement (section
4) to Preserve its Title (section 1) will typically require changing the actual title.
9. TERMINATION
You may not copy, modify, sublicense, or distribute the Document except as expressly provided under this License.
Any attempt otherwise to copy, modify, sublicense, or distribute it is void, and will automatically terminate your
rights under this License.
However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated (a)
provisionally, unless and until the copyright holder explicitly and finally terminates your license, and (b) permanently,
if the copyright holder fails to notify you of the violation by some reasonable means prior to 60 days after the cessation.
Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies
you of the violation by some reasonable means, this is the first time you have received notice of violation of this
License (for any work) from that copyright holder, and you cure the violation prior to 30 days after your receipt of
the notice.
Termination of your rights under this section does not terminate the licenses of parties who have received copies or
rights from you under this License. If your rights have been terminated and not permanently reinstated, receipt of a
copy of some or all of the same material does not give you any rights to use it.
10. FUTURE REVISIONS OF THIS LICENSE
The Free Software Foundation may publish new, revised versions of the GNU Free Documentation License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new
problems or concerns. See http://www.gnu.org/copyleft/.
Each version of the License is given a distinguishing version number. If the Document specifies that a particular
numbered version of this License “or any later version” applies to it, you have the option of following the terms
and conditions either of that specified version or of any later version that has been published (not as a draft) by the
Free Software Foundation. If the Document does not specify a version number of this License, you may choose any
version ever published (not as a draft) by the Free Software Foundation. If the Document specifies that a proxy can
decide which future versions of this License can be used, that proxy’s public statement of acceptance of a version
permanently authorizes you to choose that version for the Document.
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11. RELICENSING
“Massive Multiauthor Collaboration Site” (or “MMC Site”) means any World Wide Web server that publishes
copyrightable works and also provides prominent facilities for anybody to edit those works. A public wiki that anybody
can edit is an example of such a server. A “Massive Multiauthor Collaboration” (or “MMC”) contained in the site
means any set of copyrightable works thus published on the MMC site.
“CC-BY-SA” means the Creative Commons Attribution-Share Alike 3.0 license published by Creative Commons
Corporation, a not-for-profit corporation with a principal place of business in San Francisco, California, as well as
future copyleft versions of that license published by that same organization.
“Incorporate” means to publish or republish a Document, in whole or in part, as part of another Document.
An MMC is “eligible for relicensing” if it is licensed under this License, and if all works that were first published
under this License somewhere other than thisMMC, and subsequently incorporated in whole or in part into theMMC,
(1) had no cover texts or invariant sections, and (2) were thus incorporated prior to November 1, 2008.
The operator of an MMC Site may republish an MMC contained in the site under CC-BY-SA on the same site at any
time before August 1, 2009, provided the MMC is eligible for relicensing.
ADDENDUM: How to use this License for your documents
To use this License in a document you have written, include a copy of the License in the document and put the
following copyright and license notices just after the title page:

Copyright © YEAR YOUR NAME.
Permission is granted to copy, distribute and/or modify this document
under the terms of the GNU Free Documentation License, Version 1.3
or any later version published by the Free Software Foundation;
with no Invariant Sections, no Front-Cover Texts, and no Back-Cover Texts.
A copy of the license is included in the section entitled "GNU
Free Documentation License".

If you have Invariant Sections, Front-Cover Texts and Back-Cover Texts, replace the “with … Texts.” line with this:

with the Invariant Sections being LIST THEIR TITLES, with the
Front-Cover Texts being LIST, and with the Back-Cover Texts being LIST.

If you have Invariant Sections without Cover Texts, or some other combination of the three, merge those two
alternatives to suit the situation.
If your document contains nontrivial examples of program code, we recommend releasing these examples in parallel
under your choice of free software license, such as the GNU General Public License, to permit their use in free
software.

31.3 Appendix C: QGIS bestandsindelingen

31.3.1 QGS/QGZ - De QGIS indeling voor projectbestand

De indeling QGS is een XML-indeling voor het opslaan van projecten van QGIS. De indeling QGZ is een
gecomprimeerd (zip) archief dat een bestand QGS en een bestand QGD bevat. Het bestandQGD is de geassocieerde
database van SQLite van het project van QGIS, dat hulpgegevens bevat voor het project. Als er geen hulpgegevens
zĳn, zal het bestand QGD leeg zĳn.
Een bestand QGIS bevat alles wat nodig is om een project op te slaan, inclusief:

• projecttitel
• project-CRS
• de boom voor de lagen
• instellingen voor snappen
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• relaties
• het bereik van het kaartvenster
• projectmodellen
• legenda
• docks voor kaartweergave (2D en 3D)
• de lagen met koppelingen naar onderliggende gegevenssets (gegevensbronnen) en ander laageigenschappen,
inclusief bereik, SRS, koppelingen, stĳlen, renderer, modus Blenden, transparantie en meer.

• projecteigenschappen
De afbeeldingen hieronder geven de tags op het bovenste niveau weer in een bestand QGS en de uitgebreide tag
ProjectLayers.

Fig. 31.1: De tags op het bovenste niveau in een bestand QGS

1568 Hoofdstuk 31. Appendices



QGIS Desktop 3.28 User Guide

Fig. 31.2: De uitgebreide tag ProjectLayers op het bovenste niveau van een bestand QGS

31.3.2 QLR - Het QGIS Laag-definitiebestand

Een Laag-definitiebestand (QLR) is een XML-bestand dat een aanwĳzer bevat naar de gegevensbron van de laag in
aanvulling op de informatie voor de stĳl van QGIS voor de laag.
Het geval voor gebruik van dit bestand is eenvoudig: Hebben van één enkel bestand voor het openen van een
gegevensbron en inbrengen van alle gerelateerde informatie voor de stĳl. QLR-bestanden stellen u in staat de
onderliggende gegevensbron te maskeren in een gemakkelĳk te openen bestand.
Een voorbeeld voor het gebruiken van QLR is voor het openen van lagen van MS SQL. In plaats van naar het
dialoogvenster voor de verbinding van MS SQL te gaan, verbinden, selecteren, laden en tenslotte opmaken, kunt
u eenvoudigweg een .qlr-bestand toevoegen dat verwĳst naar de juiste laag voor MS SQL, waarin alle benodigde stĳl
is opgenomen.
In de toekomst zou een .qlr-bestand verwĳzingen naar meer dan één laag kunnen bevatten.
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Fig. 31.3: De tags op het bovenste niveau in een bestand QLR

31.3.3 QML - De QGIS indeling voor stijlbestand

QML is een XML-indeling voor het opslaan voor opmaak van de laag.
Een QML-bestand bevat alle informatie die QGIS kan afhandelen voor het renderen van objectgeometrieën, inclusief
symbooldefinities, grootten en rotaties, labellen, transparantie en modus Blenden en meer.
De afbeelding hieronder geeft de tags op het bovenste niveau weer in een bestand QML (met alleen renderer_v2
en zĳn tag symbol uitgebreid).
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Fig. 31.4: De tags op het bovenste niveau van een QML-bestand (alleen de tag renderer_v2 met zijn tag symbol is
uitgebreid)

31.4 Appendix D: QGIS R script syntaxis

Bĳgedragen door Matteo Ghetta - mogelĳk gemaakt door Scuola Superiore Sant’Anna
Schrĳven van scripts voor R in Processing kan een beetje ingewikkeld zĳn vanwege de speciale syntaxis.
Elk script van R voor processing begint met de Inputs en deOutputs, voorafgegaan door dubbele tekens hash (##).
Voor de invoeren, mag de groep met algoritmes, waarin het script moet worden geplaatst, worden gespecificeerd. Als
de groep al bestaat, zal het algoritme daaraan worden toegevoegd, anders zal een nieuwe groep worden gemaakt. In
het voorbeeld hieronder is de naam van de groep My group:
##My Group=group
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31.4.1 Invoer

Alle gegevens en parameters voor de invoer moeten worden gespecificeerd. Er zĳn verschillende soorten invoer:
• vector: ##Layer = vector

• vector field: ##F = Field Layer (waar Layer de naam is van een invoer vectorlaag waartoe het veld
behoort)

• raster: ##r = raster

• table: ##t = table

• number: ##Num = number

• string: ##Str = string

• boolean: ##Bol = boolean

• elementen in een keuzemenu. De items moeten worden gescheiden door puntkomma’s ;:
##type=selection point;lines;point+lines

31.4.2 Uitvoer

Net als voor de invoer dient elke uitvoer te worden gedefinieerd aan het begin van het script:
• vector: ##output= output vector

• raster: ##output= output raster

• table: ##output= output table

• plots: ##output_plots_to_html (##showplots in eerdere versies)
• Weergeven van uitvoer voor R in Resultaten bekĳken, plaats > voor de opdracht waarvan u de uitvoer wilt
weergeven.

31.4.3 Overzicht van syntaxis voor scripts van R in QGIS

Een aantal typen parameter voor in- en uitvoer worden aangeboden.
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Typen parameters voor invoer

Parameter Voorbeeld van
syntaxis

Teruggeven van objecten

vector Layer = vector sf object (of SpatialDataFrame object, als ##load_vector_using_rgdal is
gespecificeerd)

vector point Layer = vector point sf object (of SpatialDataFrame object, als ##load_vector_using_rgdal is
gespecificeerd)

vector line Layer = vector line sf object (of SpatialDataFrame object, als ##load_vector_using_rgdal is
gespecificeerd)

vector
polygon

Layer = vector polygon sf object (of SpatialPolygonsDataFrame object, als
##load_vector_using_rgdal wordt gebruikt)

meerdere
vector

Layer =multiple vector sf object (of SpatialDataFrame objects als ##load_vector_using_rgdal is
gespecificeerd)

tabel Layer = table dataframe conversie van csv, standaard object van de functie read.
csv

veld Field = Field Layer naam van het geselecteerde veld, bĳv. "Area"
raster Layer = raster RasterBrick object, standaard object van pakket raster
meerdere
raster

Layer = multiple raster RasterBrick objecten, standaard object van pakket raster

getal N = number gekozen integer of floating number
tekenreeks S = string string toegevoegd in het vak
longstring LS = longstring string toegevoegd in het vak, zou langer kunnen zĳn dan een normale

tekenreeks
selectie S = selection

first;second;third
string van het geselecteerde item uit d ekeuzelĳst

crs C = crs string van het gekozen resulterende CRS, in de indeling:
"EPSG:4326"

bereik E = extent Object Extent van het pakket raster, u kunt waarden uitnemen zoals
E@xmin

punt P = point indien aangeklikt op de kaart, heeft u de coördinaten van het punt
bestand F = file pad van het gekozen bestand, bĳv. “/home/matteo/file.txt”
map F = folder pad van de gekozen map, bĳv. “/home/matteo/Downloads”

Een parameter kan OPTIONAL zĳn, wat betekent dat hĳ kan worden genegeerd.
Voor het instellen van een invoer als optioneel, voegt u de string optional toe voor de invoer, bĳv:

##Layer = vector
##Field1 = Field Layer
##Field2 = optional Field Layer

Typen parameters voor uitvoer

Parameter Voorbeeld van syntaxis
vector Output = output vector
raster Output = output raster
tabel Output = output table
bestand Output = output file

Notitie: U kunt plots opslaan als png vanuit Processing Resultaten bekĳken of u kunt er voor kiezen om het plot
direct op te slaan vanuit de interface van het algoritme.
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Tekst van het script

De tekst van het script volgt de syntaxis van R en het paneel Log kan u helpen als er iets mis is met uw script.
Onthoud dat u alle aanvullende bibliotheken in het script moet laden:

library(sp)

31.4.4 Voorbeelden

Voorbeeld met uitvoer als vector

Laten we een algoritme nemen uit de online collectie dat willekeurige punten maakt uit het bereik van een invoerlaag:

##Point pattern analysis=group
##Layer=vector polygon
##Size=number 10
##Output=output vector
library(sp)
spatpoly = as(Layer, "Spatial")
pts=spsample(spatpoly,Size,type="random")
spdf=SpatialPointsDataFrame(pts, as.data.frame(pts))
Output=st_as_sf(spdf)

Uitleg (per regel in het script):
1. Point pattern analysis is de groep van het algoritme
2. Layer is de invoer **vector**laag
3. Size is een numerieke parameter met een standaard waarde van 10
4. Output is de **vector**laag die zal worden gemaakt door het algoritme
5. library(sp) laadt de bibliotheek sp
6. spatpoly = as(Layer, "Spatial") vertaalt naar een sp object
7. Roep de functie spsample van de bibliotheek sp aan en voer die uit met de hierboven gedefinieerde invoer

(Layer en Size)
8. Maak een object SpatialPointsDataFrame met de functie SpatialPointsDataFrame
9. Maak de vector uitvoerlaag met de functie st_as_sf

Dat is alles! Voer eenvoudigweg het algoritme uit met een vectorlaag die aanwezig is in de legenda van QGIS, kies
het aantal willekeurige punten. De resulterende laag zal aan uw kaart worden toegevoegd.

Voorbeeld met uitvoer als raster

Het volgende script zal basis normale Kriging uitvoeren om een rasterkaart met geïnterpoleerde waarden te maken uit
een gespecificeerd veld van de invoer punt vectorlaag door de functie autoKrige te gebruiken van het pakket voor
R automap. Het zal eerst het model voor Kriging berekenen en dan een raster maken. Het raster wordt gemaakt
met de functie aster van het rasterpakket voor R:

##Basic statistics=group
##Layer=vector point
##Field=Field Layer
##Output=output raster
##load_vector_using_rgdal
require("automap")
require("sp")

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)
require("raster")
table=as.data.frame(Layer)
coordinates(table)= ~coords.x1+coords.x2
c = Layer[[Field]]
kriging_result = autoKrige(c~1, table)
prediction = raster(kriging_result$krige_output)
Output<-prediction

Door ##load_vector_using_rgdal te gebruiken zal de invoer vectorlaag beschikbaar worden gemaakt als
een object SpatialDataFrame, waarmee we vermĳden dat het moet worden vertaald vanuit een object sf.

Voorbeeld met uitvoer als tabel

Laten we het algoritme Summary Statistics bewerken zodat de uitvoer een tabelbestand (csv) is.
De tekst vor het script is het volgende:

##Basic statistics=group
##Layer=vector
##Field=Field Layer
##Stat=Output table
Summary_statistics<-data.frame(rbind(

sum(Layer[[Field]]),
length(Layer[[Field]]),
length(unique(Layer[[Field]])),
min(Layer[[Field]]),
max(Layer[[Field]]),
max(Layer[[Field]])-min(Layer[[Field]]),
mean(Layer[[Field]]),
median(Layer[[Field]]),
sd(Layer[[Field]])),

row.names=c("Sum:","Count:","Unique values:","Minimum value:","Maximum value:",
↪→"Range:","Mean value:","Median value:","Standard deviation:"))
colnames(Summary_statistics)<-c(Field)
Stat<-Summary_statistics

De derde regel specificeert het Vector Field in invoer en de vierde regel vertelt het algoritme dat de uitvoer een tabel
zou moeten zĳn.
De laatste regel zal het object Stat , gemaakt in het script, nemen en het naar een csv-tabel converteren.

Voorbeeld met uitvoer naar het scherm

We kunnen het voorgaande voorbeeld gebruiken en in plaats van een tabel te maken, het resultaat afdrukken in
Resultaten bekĳken:

##Basic statistics=group
##Layer=vector
##Field=Field Layer
Summary_statistics<-data.frame(rbind(
sum(Layer[[Field]]),
length(Layer[[Field]]),
length(unique(Layer[[Field]])),
min(Layer[[Field]]),
max(Layer[[Field]]),
max(Layer[[Field]])-min(Layer[[Field]]),
mean(Layer[[Field]]),
median(Layer[[Field]]),
sd(Layer[[Field]])),row.names=c("Sum:","Count:","Unique values:","Minimum value:",

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)
↪→"Maximum value:","Range:","Mean value:","Median value:","Standard deviation:"))
colnames(Summary_statistics)<-c(Field)
>Summary_statistics

Het script is exact hetzelfde als dat hierboven met slechts twee bewerkingen:
1. er wordt geen uitvoer gespecificeerd (de vierde regel is verwĳderd)
2. de laatste regel begint met > wat Processing zegt om het object af te drukken in Identficatieresultaten

Voorbeeld met plot

Voor het maken van plots moet u de parameter ##output_plots_to_html gebruiken, zoals in het volgende
script:

##Basic statistics=group
##Layer=vector
##Field=Field Layer
##output_plots_to_html
####output_plots_to_html
qqnorm(Layer[[Field]])
qqline(Layer[[Field]])

Het script gebruikt een veld (Field) van een vectorlaag (Layer) als invoer enmaakt eenQQPlot (om de normaliteit
van de verdeling te testen).
Het plot wordt automatisch toegevoegd aan Resultaten bekĳken van Processing.

31.5 Appendix E: QGIS application netwerkverbindingen

Dit is een lĳst van de vooraf geconfigureerde/geautomatiseerde netwerkverbindingen die QGIS maakt. Sommige
van de verbindingen worden door de gebruiker geïnitieerd, omdat ze een actie van de gebruiker vereisen voordat ze
gebeuren, andere gebeuren automatisch.
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Naam Doel UX-
modus

Server Informatie
verzonden naar
server

Informatie opgeslagen op
server

qgis.org
Python
API
help

Browser
PyQGIS-
documentatie

Door
gebruiker
geïnitieerd

https://qgis.
org/pyqgis/%1/
search.html?q=
%2

IP, versie
van QGIS,
besturingssysteem

IP in log van server

version.qgis.org
Controleren
op
nieuwe
versie

Vertel de
gebruiker
over de
beschikbaarheid
van nieuwe
versies van
QGIS

Automatisch https://version.
qgis.org

IP, versie
van QGIS,
besturingssysteem

IP in log van server

feed.qgis.org
QGIS
Feed

Ophalen van
nieuws over
QGIS vanuit de
feed

Automatisch https:
//feed.qgis.org

IP, versie
van QGIS,
taalcode, laatst
gedownloade
tĳdstempel,
besturingssysteem

IP in server log; versie van
QGIS, besturingssysteem en
IP worden samengevoegd
en gebruikt om enkele
statistieken te verzamelen

plugins.qgis.org
Controleren
op
updates
voor
plug-ins

Vertel de
gebruiker over
updates voor
plug-ins

Gebruiker
geïnitieerd/automatisch
(te
configureren)

https://plugins.
qgis.org

IP, versie
van QGIS,
besturingssysteem

IP in log van server

Lĳst
met
plug-ins

De lĳst met
plug-ins
ophalen

Door
gebruiker
geïnitieerd

https://plugins.
qgis.org

IP, versie
van QGIS,
besturingssysteem

IP in log van server

Installeren
van
plug-ins

Een pakket
voor een plug-
in downloaden
en installeren

Door
gebruiker
geïnitieerd

https://plugins.
qgis.org

IP, versie
van QGIS,
besturingssysteem

Verhoog de teller voor
downloaden van plug-ins
met één

Stĳlen Vermeld door
gebruiker
bĳgedragen
stĳlen

Door
gebruiker
geïnitieerd

https://plugins.
qgis.org/styles

IP, versie
van QGIS,
besturingssysteem

Verhoog de teller voor
downloaden met één

3e
partĳen
TerreingegevensProduceer een

DEM voor
3D-weergaven

Door
gebruiker
geïnitieerd

https://s3.
amazonaws.
com/
elevation-tiles-prod/
terrarium/{z}/{x}/{y}.png

IP, versie
van QGIS,
besturingssysteem

bekĳk Amazon TOS

Google
Map
Geocoder

Geocodering
services

Door
gebruiker
geïnitieerd

https://maps.
googleapis.
com/maps/api/
geocode/json

IP, versie
van QGIS,
besturingssysteem

Bekĳk Google Maps API
TOS

Nominatim
Geocoder

Geocodering
services

Door
gebruiker
geïnitieerd

https:
//nominatim.
qgis.org/ui/
search.html

IP, versie
van QGIS,
besturingssysteem

Geodetisch
raster

Voeg een nieuw
raster voor
PROJ toe

Door
gebruiker
geïnitieerd

https:
//cdn.proj.org

IP, versie van
PROJ

Toegangslogs worden na één
dag permanent verwĳderd
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